Working with Projects

1

Working with Tags

2

Creating Process Pictures

3

Process Picture Dynamics

4

Setting up a Message System

5

Archiving Process Values

6

User archive

7

Working with Cross
Reference

8

Documentation of
Configuration and Runtime
Data

9

SIMATIC HMI
WinCC V7.3
WinCC: Working with WinCC
System Manual

Print of the Online Help

06/2014

A5E34373625-AA

Creating Page Layouts

10

Creating Line Layouts

11

COM Provider in the Layout
Editor

12

Setting Up Multilingual
Projects

13

Structure of the User
Administration

14

Integration of WinCC in
SIMATIC Manager

15

SmartTools

16

Legal information
Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.
DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.
WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.
CAUTION
indicates that minor personal injury can result if proper precautions are not taken.
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:
WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended or
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described.
Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E34373625-AA
Ⓟ 08/2014 Subject to change

Copyright © Siemens AG 2014.
All rights reserved

Table of contents
1

Working with Projects.................................................................................................................................35
1.1

Working with Projects..................................................................................................................35

1.2

Opening WinCC Explorer............................................................................................................36

1.3

Closing WinCC Explorer..............................................................................................................39

1.4
1.4.1
1.4.2
1.4.3
1.4.4
1.4.5
1.4.6

The WinCC Explorer...................................................................................................................41
The WinCC Explorer...................................................................................................................41
Windows of the WinCC Explorer.................................................................................................41
Menu Bar of the WinCC Explorer................................................................................................44
Toolbar of the WinCC Explorer...................................................................................................47
Status Bar and Title Bar of WinCC Explorer...............................................................................48
Search Function..........................................................................................................................49

1.5
1.5.1
1.5.2
1.5.3
1.5.4
1.5.4.1
1.5.4.2
1.5.5
1.5.5.1
1.5.5.2
1.5.5.3
1.5.5.4
1.5.5.5
1.5.5.6
1.5.5.7
1.5.5.8
1.5.5.9
1.5.5.10
1.5.5.11

The WinCC Configuration Studio................................................................................................52
Introduction..................................................................................................................................52
System requirements..................................................................................................................52
Interface......................................................................................................................................53
How to operate the navigation area ...........................................................................................55
Operating the navigation area.....................................................................................................55
Copying, pasting and deleting data in the navigation area.........................................................57
How to operate the data area......................................................................................................58
Operating the data area..............................................................................................................59
Data entry in the data area..........................................................................................................60
Filtering in the data area..............................................................................................................63
Fast search in data area..............................................................................................................67
Selecting cells, areas, rows and columns...................................................................................69
Search and replace in the data area...........................................................................................69
Sorting in the data area...............................................................................................................72
Copying and pasting in the data area..........................................................................................73
Undoing an action.......................................................................................................................73
Importing data records................................................................................................................74
Exporting data records................................................................................................................74

1.6
1.6.1
1.6.2
1.6.3
1.6.4
1.6.4.1
1.6.4.2

Project Types..............................................................................................................................76
Single-User Project.....................................................................................................................76
Multi-User Project........................................................................................................................76
Client Project...............................................................................................................................77
Changing Project Type................................................................................................................79
How to Change a Single-User Project into a Multi-User Project.................................................79
How to Change a Multi-User Project to a Single-User Project....................................................79

1.7
1.7.1
1.7.2
1.7.3
1.7.4
1.7.5

Creating and Editing Projects......................................................................................................81
Preparation to Create a Project...................................................................................................81
WinCC Project with "Basic Process Control"..............................................................................83
How to Create a Project..............................................................................................................85
How to Specify the Computer Properties....................................................................................88
How to use multiuser engineering...............................................................................................90

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

3

Table of contents

4

1.7.6
1.7.7
1.7.7.1
1.7.7.2
1.7.7.3
1.7.7.4
1.7.8
1.7.9
1.7.9.1
1.7.9.2
1.7.9.3
1.7.9.4
1.7.9.5
1.7.9.6
1.7.9.7

How to support multiple picture windows....................................................................................94
Setting Time in WinCC................................................................................................................97
Setting Time in WinCC................................................................................................................97
How to Set the Time Base in the Project...................................................................................100
How to Set the Time Base for Controls.....................................................................................101
How to Set the Time Base for Runtime Documentation............................................................102
Online Configuration..................................................................................................................104
Loading Online Changes...........................................................................................................108
Loading Online Changes...........................................................................................................108
Requirements for Loading Online Changes..............................................................................110
Use and Limitations of Load Online Changes...........................................................................112
Run Diagnosis of Online Change Loading................................................................................115
How to Activate Load Online Changes......................................................................................117
How to Download Load Online Changes..................................................................................119
How to Reset Load Online Changes.........................................................................................123

1.8
1.8.1
1.8.2
1.8.3
1.8.4
1.8.5

Determining the Global Design.................................................................................................125
Global Design of the Objects.....................................................................................................125
The Elements of the Global Design...........................................................................................126
How to work with global object designs.....................................................................................127
How to edit your own global design...........................................................................................130
How to determine the global design of the objects....................................................................135

1.9
1.9.1
1.9.2
1.9.3
1.9.4
1.9.5
1.9.5.1
1.9.5.2
1.9.5.3
1.9.5.4
1.9.5.5
1.9.5.6
1.9.5.7
1.9.5.8
1.9.5.9
1.9.5.10
1.9.5.11
1.9.5.12
1.9.5.13

Making Settings for Runtime.....................................................................................................137
Settings for Runtime..................................................................................................................137
How to Set Up a Startup List.....................................................................................................139
How to Assign Hotkeys in the Project.......................................................................................142
Effect of External Applications at Runtime................................................................................143
Setting up Runtime....................................................................................................................145
How to set up Runtime..............................................................................................................145
How to change the computer name..........................................................................................146
How to configure the applications available in Runtime............................................................148
How to Change the default settings for Language, Time and Key Combinations.....................149
How to specify favorite process pictures...................................................................................151
How to set up the system dialogs..............................................................................................152
How to change the language in Runtime..................................................................................154
How to navigate in process pictures in Runtime.......................................................................155
How to define hotkeys for operation and screen navigation.....................................................157
How to define a picture as the start picture in Runtime.............................................................160
How to configure the cursor control in Runtime........................................................................162
How to Activate Zoom Functions in Runtime............................................................................164
How to make computer-specific settings for runtime.................................................................166

1.10
1.10.1
1.10.2
1.10.3
1.10.4

Activating Project.......................................................................................................................170
Activating Project.......................................................................................................................170
How to Start Runtime................................................................................................................170
How to Set Up Autostart............................................................................................................173
How to Exit Runtime..................................................................................................................174

1.11
1.11.1
1.11.2
1.11.3
1.11.4

Copying and Duplicating Projects.............................................................................................177
Copying and Duplicating Projects.............................................................................................177
How to Copy a Project...............................................................................................................177
How to Duplicate a Project for Redundant Servers...................................................................180
How to duplicate a redundant project at runtime.......................................................................183

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

1.12
1.12.1
1.12.2
1.12.3
1.12.4
1.12.5
2

Appendix...................................................................................................................................185
Editors and Functions in WinCC Explorer.................................................................................185
WinCC status and control in the system tray............................................................................188
WinCC diagnostics window and license information.................................................................189
Illegal Characters......................................................................................................................191
File Structure of a Project..........................................................................................................195

Working with Tags....................................................................................................................................197
2.1

Tag management......................................................................................................................197

2.2

The Tag Management editor.....................................................................................................198

2.3

Working in the "Tag Management" editor..................................................................................201

2.4
2.4.1
2.4.1.1
2.4.1.2
2.4.1.3
2.4.1.4
2.4.1.5
2.4.1.6
2.4.1.7
2.4.1.8
2.4.1.9
2.4.2
2.4.2.1
2.4.2.2
2.4.2.3
2.4.2.4
2.4.2.5
2.4.2.6
2.4.2.7
2.4.2.8
2.4.2.9
2.4.2.10
2.4.2.11
2.4.2.12
2.4.2.13
2.4.2.14
2.4.3
2.4.4

Basics of Tag Management.......................................................................................................205
Tags..........................................................................................................................................205
Tags..........................................................................................................................................205
Internal Tags.............................................................................................................................206
Process Tags............................................................................................................................207
Properties of a tag.....................................................................................................................209
Structure Types and Structure Tags.........................................................................................211
Data types of structure tags......................................................................................................214
Properties of a structure tag......................................................................................................214
Tag Groups...............................................................................................................................215
Communication Driver...............................................................................................................216
Tag types...................................................................................................................................216
Tag Types.................................................................................................................................216
Binary Tags...............................................................................................................................217
Signed 8-bit value......................................................................................................................218
Unsigned 8-bit value..................................................................................................................219
Signed 16-bit value....................................................................................................................220
Unsigned 16-bit value................................................................................................................221
Signed 32-bit value....................................................................................................................222
Unsigned 32-bit value................................................................................................................223
Floating-point number 32-bit IEEE 754.....................................................................................224
Floating-Point Number 64-Bit IEEE 754....................................................................................225
Text Tag 8-Bit Character Set and Text Tag 16-Bit Character Set.............................................227
Raw Data Tag...........................................................................................................................227
Text Reference..........................................................................................................................228
Date/time...................................................................................................................................229
Selecting tags in WinCC............................................................................................................230
Displaying status information in Runtime..................................................................................233

2.5
2.5.1
2.5.1.1
2.5.1.2
2.5.1.3
2.5.1.4
2.5.2
2.5.2.1
2.5.2.2
2.5.2.3
2.5.2.4

Configuration in Tag Management............................................................................................234
Creating communication drivers and connections.....................................................................234
How to add a new communication driver..................................................................................234
How to create a new connection...............................................................................................235
How to set system parameters for a connection.......................................................................236
How to set the connection parameters......................................................................................237
Creating Tags............................................................................................................................238
Creating Tags............................................................................................................................238
Creating Internal Tags...............................................................................................................239
How to Create a Process Tag...................................................................................................240
How to edit the properties of a tag............................................................................................241

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

5

Table of contents

2.5.2.5
2.5.2.6
2.5.3
2.5.3.1
2.5.3.2
2.5.3.3
2.5.3.4
2.5.3.5
2.5.4
2.5.4.1
2.5.4.2
3

6

Creating structure types and structure tags..............................................................................241
Tag groups................................................................................................................................247
Editing Tags..............................................................................................................................249
Editing Tags..............................................................................................................................249
Copying, Moving and Deleting Tags.........................................................................................249
How to Rename Tags................................................................................................................251
How to edit tags in Runtime......................................................................................................252
In this way, you display the value, status and quality code for tags..........................................253
Importing and exporting tags.....................................................................................................254
Importing data records..............................................................................................................254
How to export tags....................................................................................................................254

Creating Process Pictures........................................................................................................................257
3.1

Creating Process Pictures.........................................................................................................257

3.2

How to start the Graphics Designer..........................................................................................258

3.3
3.3.1
3.3.2
3.3.3
3.3.4
3.3.5
3.3.6
3.3.7

The Graphics Designer in the WinCC Explorer.........................................................................259
The Graphics Designer in the WinCC Explorer.........................................................................259
The shortcut menu in the Navigation window............................................................................261
How to configure the object selection........................................................................................264
How to configure the control selection......................................................................................266
The pop-up menu in the Data Window......................................................................................269
Displaying the properties of a picture file..................................................................................271
Displaying the configured dynamics of a process picture.........................................................273

3.4
3.4.1
3.4.2
3.4.3
3.4.4
3.4.5
3.4.5.1
3.4.5.2
3.4.5.3
3.4.5.4
3.4.5.5
3.4.5.6
3.4.5.7
3.4.5.8
3.4.5.9
3.4.5.10
3.4.5.11
3.4.5.12
3.4.5.13
3.4.5.14
3.4.5.15
3.4.5.16
3.4.5.17
3.4.6
3.4.6.1
3.4.6.2
3.4.6.3
3.4.7

Elements and Basic Settings of the Graphics Designer............................................................277
Elements and Basic Settings of the Graphics Designer............................................................277
The Coordinate System of a Process Picture...........................................................................277
The Coordinate System of an Object........................................................................................279
The Rectangle Surrounding the Object.....................................................................................281
The Start Screen of the Graphics Designer..............................................................................283
The Start Screen of the Graphics Designer..............................................................................283
Alignment palette.......................................................................................................................286
Layer palette..............................................................................................................................287
Color palette..............................................................................................................................289
Object palette............................................................................................................................290
Font palette...............................................................................................................................290
Standard palette........................................................................................................................291
Status bar..................................................................................................................................293
Zoom palette.............................................................................................................................294
Output window...........................................................................................................................294
Library.......................................................................................................................................294
Controls.....................................................................................................................................295
Dynamic Wizard........................................................................................................................296
Process pictures........................................................................................................................296
Standard....................................................................................................................................298
Styles.........................................................................................................................................299
Tags..........................................................................................................................................299
The Central Color Palette..........................................................................................................300
The central color palette............................................................................................................300
How to define the central color palette......................................................................................302
How to export and import color palettes....................................................................................304
The Basic Settings of the Graphics Designer............................................................................307

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

3.4.7.1
3.4.7.2
3.4.7.3
3.4.7.4
3.4.7.5
3.4.7.6
3.4.7.7
3.4.8

The Basic Settings of the Graphics Designer............................................................................307
How to Set the Grid...................................................................................................................307
This is how you set the options.................................................................................................309
Making layers invisible..............................................................................................................313
Showing and hiding layers and objects.....................................................................................314
Managing the default settings of objects...................................................................................317
Changing the default trigger......................................................................................................319
Customizing the Working Environment.....................................................................................321

3.5
3.5.1
3.5.2
3.5.3
3.5.4
3.5.5
3.5.6
3.5.7
3.5.8
3.5.9
3.5.10
3.5.11
3.5.12
3.5.12.1
3.5.12.2
3.5.12.3
3.5.13
3.5.13.1
3.5.13.2
3.5.13.3
3.5.13.4

Working with Pictures................................................................................................................323
Working with Pictures................................................................................................................323
How to create a new picture......................................................................................................324
How to save the pictures...........................................................................................................325
How to open a picture...............................................................................................................325
How to Copy the Picture............................................................................................................326
How to Rename a Picture.........................................................................................................327
How to Delete a Picture.............................................................................................................328
How to export graphics..............................................................................................................330
How to set the picture properties...............................................................................................331
How to configure a picture background.....................................................................................331
How to protect pictures with a password...................................................................................333
Working with Layers..................................................................................................................334
Working with Layers..................................................................................................................334
How to assign a layer................................................................................................................338
How to use the layers palette....................................................................................................339
Working with Multiple Pictures..................................................................................................339
Working with Multiple Pictures..................................................................................................339
How to transfer picture properties to another picture................................................................340
How to transfer objects to another picture.................................................................................341
How to copy objects to another picture.....................................................................................342

3.6
3.6.1
3.6.2
3.6.3
3.6.4
3.6.5
3.6.6
3.6.7
3.6.8
3.6.9
3.6.10
3.6.11
3.6.12
3.6.13
3.6.14
3.6.15
3.6.16

Working with Faceplate Types..................................................................................................344
Working with Faceplate types...................................................................................................344
How to create a Faceplate type.................................................................................................346
How to create a Faceplate type.................................................................................................347
How to insert the individual objects of the Faceplate type........................................................348
Configuration of a Faceplate type.............................................................................................348
Properties of a Faceplate type..................................................................................................349
How to link object properties with a properties node.................................................................352
How to link faceplate tags with a properties node.....................................................................354
Event of a Faceplate type..........................................................................................................356
How to configure the events of a Faceplate type......................................................................357
Definition of the Faceplate tags of a Faceplate type.................................................................359
How to edit the Faceplate tags of a Faceplate type..................................................................360
Making a Faceplate type dynamic.............................................................................................361
How to use a Faceplate instance..............................................................................................362
How to update a Faceplate instance.........................................................................................365
How to protect faceplate types with a password.......................................................................366

3.7
3.7.1
3.7.2
3.7.3
3.7.4

Working with Controls...............................................................................................................368
Working with Controls...............................................................................................................368
Short Description of the WinCC Controls and Additional Controls............................................368
This is how you insert an ActiveX control as a smart object:....................................................370
This is how you insert a .NET or WPF control as a smart object..............................................371

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

7

Table of contents

3.7.5
How to insert a control from the selection window....................................................................373
3.7.6
How to Resize a Control............................................................................................................374
3.7.7
How to Position a Control..........................................................................................................376
3.7.8
How to configure the control selection......................................................................................377
3.7.9
This is how you change the registration of an ActiveX control..................................................380
3.7.10 How to Change the Properties of a Control...............................................................................382
3.7.11 ActiveX controls.........................................................................................................................383
3.7.11.1 Siemens HMI Symbol Library....................................................................................................383
3.7.11.2 WinCC AlarmControl.................................................................................................................392
3.7.11.3 WinCC Digital/Analog Clock Control.........................................................................................393
3.7.11.4 WinCC FunctionTrendControl...................................................................................................398
3.7.11.5 WinCC Gauge Control...............................................................................................................399
3.7.11.6 WinCC Media Control................................................................................................................409
3.7.11.7 WinCC OnlineTableControl.......................................................................................................413
3.7.11.8 WinCC OnlineTrendControl.......................................................................................................413
3.7.11.9 WinCC RulerControl..................................................................................................................414
3.7.11.10 WinCC Slider Control...........................................................................................................414
3.7.11.11 WinCC UserArchiveControl..................................................................................................422
3.7.11.12 WinCC WebBrowser Control................................................................................................422
3.7.12 .NET controls.............................................................................................................................423
3.7.13 WPF controls.............................................................................................................................424
3.8
3.8.1
3.8.2
3.8.3
3.8.3.1
3.8.3.2
3.8.3.3
3.8.3.4
3.8.3.5
3.8.3.6
3.8.3.7
3.8.3.8
3.8.3.9
3.8.3.10
3.8.3.11
3.8.3.12
3.8.3.13
3.8.3.14
3.8.3.15
3.8.3.16
3.8.3.17
3.8.3.18
3.8.4
3.8.4.1
3.8.4.2
3.8.4.3
3.8.4.4
3.8.4.5
3.8.4.6
3.8.4.7
3.8.4.8

8

Working with Objects.................................................................................................................425
Working with Objects.................................................................................................................425
How to change the default setting of object types.....................................................................426
Basic Static Operations.............................................................................................................428
Basic Static Operations.............................................................................................................428
How to insert an object into a picture........................................................................................429
How to Rename Objects...........................................................................................................430
How to select an object.............................................................................................................432
Multiple Selection of Objects.....................................................................................................433
How to Select Multiple Objects..................................................................................................435
How to position objects.............................................................................................................437
How to Align Multiple Objects....................................................................................................439
How to scale an object..............................................................................................................440
How to mirror the objects..........................................................................................................442
How to rotate the objects...........................................................................................................443
How to delete objects................................................................................................................445
How to cut objects.....................................................................................................................446
How to copy objects..................................................................................................................447
How to insert the contents of the clipboard...............................................................................448
How to duplicate objects...........................................................................................................449
How to change the position of an object...................................................................................450
You can change the text contents of objects.............................................................................452
Basic Dynamic Operations........................................................................................................454
Basic Dynamic Operations........................................................................................................454
How to make attributes dynamic...............................................................................................454
How to configure events............................................................................................................456
How to configure a dynamic dialog...........................................................................................457
How to configure a C action......................................................................................................459
How to configure a VBS action..................................................................................................461
How to Configure a Tag Connection.........................................................................................463
You can link the tag connection of objects................................................................................465

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

3.8.4.9
3.8.5
3.8.5.1
3.8.5.2
3.8.5.3
3.8.5.4
3.8.6
3.8.6.1
3.8.6.2
3.8.6.3
3.8.6.4
3.8.6.5
3.8.6.6
3.8.6.7
3.8.6.8
3.8.6.9
3.8.6.10
3.8.6.11
3.8.6.12
3.8.6.13
3.8.6.14
3.8.7
3.8.7.1
3.8.7.2
3.8.7.3
3.8.7.4
3.8.7.5
3.8.7.6
3.8.7.7
3.8.7.8
3.8.7.9
3.8.7.10
3.8.7.11
3.8.7.12
3.8.7.13
3.8.7.14
3.8.7.15
3.8.7.16
3.8.7.17
3.8.7.18
3.8.7.19
3.8.7.20
3.8.7.21
3.8.8
3.8.8.1
3.8.8.2
3.8.8.3
3.8.8.4
3.8.8.5
3.8.8.6
3.8.9
3.8.9.1

How to Configure a Direct Connection......................................................................................468
The Properties of an Object......................................................................................................470
The Properties of an Object......................................................................................................470
The "Object Properties" Window...............................................................................................471
Property Groups and Attributes.................................................................................................479
Special Runtime Settings..........................................................................................................505
Working with Standard Objects.................................................................................................512
Working with Standard Objects.................................................................................................512
How to Draw a Line...................................................................................................................515
How to Draw a Polygon.............................................................................................................518
How to Draw a Polyline.............................................................................................................520
How to Draw an Ellipse.............................................................................................................524
How to Draw a Circle.................................................................................................................526
How to Draw an Ellipse Segment..............................................................................................527
How to Draw a Pie Segment.....................................................................................................530
How to draw an Ellipse Arc.......................................................................................................532
How to Draw a Circular Arc.......................................................................................................535
How to Draw a Rectangle..........................................................................................................537
How to Draw a Rounded Rectangle..........................................................................................539
How to Insert Static Text...........................................................................................................541
How to use the connector..........................................................................................................543
Working with Smart Objects......................................................................................................546
Working with Smart Objects......................................................................................................546
How to Insert an Application Window........................................................................................550
How to insert a picture window..................................................................................................552
How to insert a control...............................................................................................................556
How to Insert an OLE Object.....................................................................................................558
I/O Field.....................................................................................................................................561
Bar.............................................................................................................................................572
How to insert a graphic object...................................................................................................579
Status display............................................................................................................................582
Text list......................................................................................................................................589
How to insert multiline text........................................................................................................597
How to insert a combobox.........................................................................................................598
How to insert a list box..............................................................................................................600
How to insert a Faceplate instance...........................................................................................603
How to insert a .NET control.....................................................................................................604
How to insert a WPF control......................................................................................................605
How to Insert a 3D Bar..............................................................................................................607
How to Insert a Group Display..................................................................................................609
How to Configure the Extended Status Display........................................................................614
How to Configure the Extended Analog Display.......................................................................620
Format Function of the Analog Display.....................................................................................624
Working with Windows Objects.................................................................................................625
Working with Windows Objects.................................................................................................625
Button........................................................................................................................................627
How to insert a check box.........................................................................................................631
How to insert an radio box.........................................................................................................634
How to insert a round button.....................................................................................................636
Slider.........................................................................................................................................638
Working with Tube Objects.......................................................................................................642
Working with tube objects.........................................................................................................642

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

9

Table of contents

3.8.9.2
3.8.9.3
3.8.9.4
3.8.9.5
3.8.10
3.8.10.1
3.8.10.2
3.8.10.3
3.8.11
3.8.11.1
3.8.11.2
3.8.11.3
3.8.11.4

How to insert a polygone tube...................................................................................................643
How to insert a T-piece.............................................................................................................644
How to insert a double T-piece..................................................................................................645
How to insert a tube bend.........................................................................................................646
Quick Object Configuration.......................................................................................................647
Quick Object Configuration.......................................................................................................647
Selecting a tag...........................................................................................................................649
Selecting pictures......................................................................................................................650
Working with Combined Objects...............................................................................................653
Working with Combined Objects...............................................................................................653
Working with Groups.................................................................................................................654
Working with Customized Objects.............................................................................................657
Working with the library.............................................................................................................682

3.9
3.9.1
3.9.2
3.9.3
3.9.3.1
3.9.3.2
3.9.3.3
3.9.3.4
3.9.3.5
3.9.3.6
3.9.3.7
3.9.4
3.9.4.1
3.9.4.2
3.9.4.3
3.9.5
3.9.5.1
3.9.5.2
3.9.5.3

Process Pictures in Runtime.....................................................................................................689
Process Pictures in Runtime.....................................................................................................689
How to activate / deactivate Runtime........................................................................................689
Menus and Toolbars..................................................................................................................690
User-defined menus and toolbars.............................................................................................690
How to Create a Menu..............................................................................................................693
How to Create a Toolbar...........................................................................................................695
How to configure menus and toolbars in a picture....................................................................697
How to configure menus and toolbars in a picture window.......................................................697
Control elements of the "Menus and Toolbars" editor...............................................................698
How to define the font for the various languages......................................................................700
Virtual keyboard........................................................................................................................702
Virtual keyboard - General Information.....................................................................................702
How to configure the activation of the virtual keyboard.............................................................703
How to operate the virtual keyboard..........................................................................................704
Setting up Mouseless Operation of a Picture............................................................................706
How to set up a picture for mouseless operation......................................................................706
Defining the Alpha cursor's tab sequence.................................................................................707
Specifying the tab sequence of the tab order cursor.................................................................709

3.10
Object properties.......................................................................................................................712
3.10.1 "Axis" Property Group...............................................................................................................712
3.10.1.1 Axis Section (AxisSection)........................................................................................................712
3.10.1.2 Alignment..................................................................................................................................712
3.10.1.3 Bar Scaling (ScalingType)........................................................................................................712
3.10.1.4 Label Each (Long StrokesText Each)........................................................................................713
3.10.1.5 Exponent Display (Exponent)....................................................................................................713
3.10.1.6 Large Tick Marks (LongStrokesBold)........................................................................................713
3.10.1.7 Large Tick Marks Length (LongStrokesSize)............................................................................714
3.10.1.8 Decimal Places (RightComma).................................................................................................714
3.10.1.9 Zero Point (ZeroPoint)...............................................................................................................714
3.10.1.10 Only Large Tick Marks (LongStrokesOnly)..........................................................................714
3.10.1.11 Scale (Scaling).....................................................................................................................715
3.10.1.12 Scale Marks (ScaleTicks).....................................................................................................715
3.10.1.13 Digits to the Left of the Decimal Point (LeftComma)............................................................715
3.10.2 "Output / Input" Property Group................................................................................................715
3.10.2.1 Number of Visible Lines (NumberLines)....................................................................................715
3.10.2.2 Output Format (OutputFormat)..................................................................................................716
3.10.2.3 Output Value (OutputValue)......................................................................................................716

10

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

3.10.2.4 Bit Number (BitNumber)............................................................................................................716
3.10.2.5 Data Format (DataFormat)........................................................................................................716
3.10.2.6 Input value.................................................................................................................................717
3.10.2.7 Field Type (BoxType)................................................................................................................717
3.10.2.8 List Type (ListType)...................................................................................................................717
3.10.2.9 Clear on Invalid Input (ClearOnError)........................................................................................718
3.10.2.10 Clear on New Input (ClearOnNew)......................................................................................718
3.10.2.11 Selected Boxes (Process)....................................................................................................718
3.10.2.12 Selected Box (Process)........................................................................................................718
3.10.2.13 Apply on Exit (AssumeOnExit).............................................................................................719
3.10.2.14 Apply on Complete Input (AssumeOnFull)...........................................................................719
3.10.2.15 Hidden Input (HiddenInput)..................................................................................................719
3.10.2.16 Assignments (Assignments).................................................................................................719
3.10.3 "Picture" Property Group...........................................................................................................720
3.10.3.1 Picture (PictureName)...............................................................................................................720
3.10.3.2 Picture Referenced (PicReferenced).........................................................................................720
3.10.3.3 Picture Transparent Color (PicTransColor)...............................................................................721
3.10.3.4 Picture Transparent Color On (PicUseTransColor)...................................................................721
3.10.4 "Pictures" Property Group.........................................................................................................721
3.10.4.1 Picture Off Referenced (PicUpReferenced)..............................................................................721
3.10.4.2 Picture Off Transparent Color (PicUpTransparent)...................................................................722
3.10.4.3 Picture Off Transparent Color On (PicUpUseTransColor)........................................................722
3.10.4.4 Picture Deact. Referenced (PicDeactReferenced)....................................................................722
3.10.4.5 Picture Deact. Transparent Color (PicDeactTransparent).........................................................722
3.10.4.6 Picture Deact. Transparent Color On (PicDeactUseTransColor)..............................................723
3.10.4.7 Picture On Referenced (PicDownReferenced)..........................................................................723
3.10.4.8 Picture On Transparent Color (PicDownTransparent)..............................................................723
3.10.4.9 Picture On Transparent Color On (PicDownUseTransColor)....................................................723
3.10.4.10 Picture Status Off (PictureUp)..............................................................................................724
3.10.4.11 Picture Status Deactivated (PictureDeactivated).................................................................724
3.10.4.12 Picture Status On (PictureDown).........................................................................................724
3.10.4.13 X picture alignment (PictAlignment).....................................................................................724
3.10.5 "Flashing" Property Group.........................................................................................................725
3.10.5.1 Flashing (EnableFlashing).........................................................................................................725
3.10.5.2 Flashing Background Active (FlashBackColor).........................................................................725
3.10.5.3 Flashing Line Active (FlashBorderColor)...................................................................................725
3.10.5.4 Flashing Border Active (FlashBorderColor)...............................................................................726
3.10.5.5 Flashing Text Active (FlashForeColor)......................................................................................726
3.10.5.6 Flash Frequency (FlashRate)....................................................................................................726
3.10.5.7 Background Flash Frequency (FlashRateBackColor)...............................................................727
3.10.5.8 Line Flash Frequency (FlashRateBorderColor).........................................................................727
3.10.5.9 Border Flash Frequency (FlashRateBorderColor).....................................................................727
3.10.5.10 Text Flash Frequency (FlashRateForeColor).......................................................................728
3.10.5.11 Flashing Background Color Off (BackFlashColorOff)..........................................................728
3.10.5.12 Flashing Background Color On (BackFlashColorOn)..........................................................728
3.10.5.13 Flashing Line Color Off (BorderFlashColorOff)....................................................................729
3.10.5.14 Flashing Line Color On (BorderFlashColorOn)....................................................................729
3.10.5.15 Flashing Border Color Off (BorderFlashColorOff)................................................................729
3.10.5.16 Flashing Border Color On (BorderFlashColorOn)................................................................730
3.10.5.17 Flashing Text Color Off (ForeFlashColorOff).......................................................................730
3.10.5.18 Flashing Text Color On (ForeFlashColorOn).......................................................................730
3.10.6 The property group "Control Properties"...................................................................................731

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

11

Table of contents

3.10.6.1 A................................................................................................................................................731
3.10.6.2 B................................................................................................................................................735
3.10.6.3 C................................................................................................................................................742
3.10.6.4 D................................................................................................................................................755
3.10.6.5 E................................................................................................................................................757
3.10.6.6 F................................................................................................................................................761
3.10.6.7 G................................................................................................................................................763
3.10.6.8 H................................................................................................................................................764
3.10.6.9 I.................................................................................................................................................769
3.10.6.10 L...........................................................................................................................................769
3.10.6.11 M..........................................................................................................................................770
3.10.6.12 O..........................................................................................................................................782
3.10.6.13 P...........................................................................................................................................791
3.10.6.14 R...........................................................................................................................................793
3.10.6.15 S...........................................................................................................................................795
3.10.6.16 T...........................................................................................................................................810
3.10.6.17 U...........................................................................................................................................859
3.10.6.18 V...........................................................................................................................................862
3.10.6.19 X/Y.......................................................................................................................................876
3.10.7 The "Display" property group....................................................................................................883
3.10.7.1 Display Options (DisplayOptions)..............................................................................................883
3.10.7.2 Global Shadow..........................................................................................................................883
3.10.7.3 Global Color Scheme ...............................................................................................................883
3.10.7.4 Object Transparency.................................................................................................................883
3.10.7.5 [V6.2] Windows Style................................................................................................................884
3.10.7.6 WinCC style...............................................................................................................................884
3.10.8 "Colors" Property Group............................................................................................................884
3.10.8.1 Colors - 3D to H.........................................................................................................................884
3.10.8.2 Colors - I to R............................................................................................................................889
3.10.8.3 Colors - S to Z...........................................................................................................................891
3.10.9 "Filling" Property Group.............................................................................................................893
3.10.9.1 Dynamic Filling (Filling).............................................................................................................893
3.10.9.2 Fill Level (FillingIndex)...............................................................................................................894
3.10.9.3 Filling direction (FillingDirection)...............................................................................................894
3.10.10 "Geometry" Property Group......................................................................................................894
3.10.10.1 Geometry - A to B................................................................................................................894
3.10.10.2 Geometry - C to Z................................................................................................................901
3.10.11 "Limits" Property Group.............................................................................................................908
3.10.11.1 Limits - A..............................................................................................................................908
3.10.11.2 Limits - Bar color..................................................................................................................914
3.10.11.3 Limits - Bar fill color..............................................................................................................923
3.10.11.4 Limits - Bar fill style..............................................................................................................925
3.10.11.5 Limits - C to T.......................................................................................................................927
3.10.11.6 Limits - U to Z.......................................................................................................................934
3.10.12 The "Background picture" property group.................................................................................947
3.10.12.1 BackPictureName................................................................................................................947
3.10.12.2 Show as (Back Picture Alignment).......................................................................................948
3.10.13 "Message Types" Property Group.............................................................................................948
3.10.13.1 Display Text (MCText).........................................................................................................948
3.10.13.2 Went Out Unacknowledged - Background Flashing (GNQBackFlash)................................948
3.10.13.3 Went Out Unacknowledged - Background Flashing (MCGUBackFlash).............................948
3.10.13.4 Went Out Unacknowledged - Background Color Off (GNQBackColorOff)...........................949

12

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

3.10.13.5 Went Out Unacknowledged - Background Color Off (MCGUBackColorOff)........................949
3.10.13.6 Went Out Unacknowledged - Background Color On (GNQBackColorOn)...........................949
3.10.13.7 Went Out Unacknowledged - Background Color On (MCGUBackColorOn)........................949
3.10.13.8 Went Out Unacknowledged - Text Flashing (GNQTextFlash).............................................950
3.10.13.9 Went Out Unacknowledged - Text Flashing (MCGUTextFlash)..........................................950
3.10.13.10 Went Out Unacknowledged - Text Color Off (GNQTextColorOff)........................................950
3.10.13.11 Went Out Unacknowledged - Text Color Off (MCGUTextColorOff).....................................950
3.10.13.12 Went Out Unacknowledged - Text Color On (GNQTextColorOn)........................................951
3.10.13.13 Went Out Unacknowledged - Text Color On (MCGUTextColorOn).....................................951
3.10.13.14 Came In - Background Flashing (CBackFlash)....................................................................951
3.10.13.15 Came In - Background Flashing (MCKOBackFlash)............................................................951
3.10.13.16 Came In - Background Color Off (CBackColorOff)..............................................................952
3.10.13.17 Came In - Background Color Off (MCKOBackColorOff)......................................................952
3.10.13.18 Came In - Background Color On (CBackColorOn)..............................................................952
3.10.13.19 Came In - Background Color On (MCKOBackColorOn)......................................................952
3.10.13.20 Came In - Text Flashing (CTextFlash).................................................................................952
3.10.13.21 Came In - Text Flashing (MCKOTextFlash).........................................................................953
3.10.13.22 Came In - Text Color Off (CTextColorOff)............................................................................953
3.10.13.23 Came In - Text Color Off (MCKOTextColorOff)...................................................................953
3.10.13.24 Came In - Text Color On (CTextColorOn)............................................................................953
3.10.13.25 Came In - Text Color On (MCKOTextColorOn)...................................................................954
3.10.13.26 Came In Acknowledged - Background Flashing (CQBackFlash).........................................954
3.10.13.27 Came In Acknowledged - Background Flashing (MCKQBackFlash)...................................954
3.10.13.28 Came In Acknowledged - Background Color Off (CQBackColorOff)...................................954
3.10.13.29 Came In Acknowledged - Background Color Off (MCKQBackColorOff)..............................955
3.10.13.30 Came In Acknowledged - Background Color On (CQBackColorOn)...................................955
3.10.13.31 Came In Acknowledged - Background Color On (MCKQBackColorOn)..............................955
3.10.13.32 Came In Acknowledged - Text Flashing (CQTextFlash)......................................................955
3.10.13.33 Came In Acknowledged - Text Flashing (MCKQTextFlash)................................................956
3.10.13.34 Came In Acknowledged - Text Color Off (CQTextColorOff)................................................956
3.10.13.35 Came In Acknowledged - Text Color Off (MCKQTextColorOff)...........................................956
3.10.13.36 Came In Acknowledged - Text Color On (CQTextColorOn)................................................956
3.10.13.37 Came In Acknowledged - Text Color On (MCKQTextColorOn)...........................................957
3.10.13.38 Using global alarm classes (UseGlobalAlarmClasses)........................................................957
3.10.13.39 Message Type (MessageClass)...........................................................................................957
3.10.14 The "Object" Property Group.....................................................................................................958
3.10.14.1 Layer (Layer)........................................................................................................................958
3.10.14.2 Faceplate Type FPT.............................................................................................................958
3.10.14.3 Window Contents (Application)............................................................................................958
3.10.14.4 Object Name (ObjectName).................................................................................................959
3.10.14.5 Template (Template)............................................................................................................959
3.10.15 "Font" Property Group...............................................................................................................960
3.10.15.1 Bold (FontBold)....................................................................................................................960
3.10.15.2 Format (Format)...................................................................................................................960
3.10.15.3 Index (Index)........................................................................................................................960
3.10.15.4 Italic (FontItalic)....................................................................................................................961
3.10.15.5 Text Orientation (Orientation)...............................................................................................961
3.10.15.6 Text (Text)............................................................................................................................961
3.10.15.7 Underline (FontUnderline)....................................................................................................962
3.10.15.8 X alignment (AlignmentLeft).................................................................................................962
3.10.15.9 Y alignment (AlignmentTop).................................................................................................962
3.10.15.10 Font (FontName)..................................................................................................................962

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

13

Table of contents

3.10.15.11 Font Size (FontSize)............................................................................................................963
3.10.16 "Miscellaneous" Property Group...............................................................................................963
3.10.16.1 Others - A to B....................................................................................................................963
3.10.16.2 Others - C to O....................................................................................................................969
3.10.16.3 Others - P to S....................................................................................................................974
3.10.16.4 Others - T to Z......................................................................................................................981
3.10.17 "Lock" Property Group...............................................................................................................985
3.10.17.1 Lock Display (LockStatus)....................................................................................................985
3.10.17.2 Lock Display Text (LockText)...............................................................................................986
3.10.17.3 Lock Background Color (LockBackColor)............................................................................986
3.10.17.4 Lock Text Color (LockTextColor).........................................................................................986
3.10.18 "Styles" Property Group............................................................................................................986
3.10.18.1 3D Border Width (BackBorderWidth)...................................................................................986
3.10.18.2 Bar Pattern (FillStyle2).........................................................................................................987
3.10.18.3 Border Weight (BackBorderWidth).......................................................................................987
3.10.18.4 Display as DropDownList.....................................................................................................987
3.10.18.5 Latch Down (Toggle)............................................................................................................987
3.10.18.6 Box Alignment (BoxAlignment)............................................................................................987
3.10.18.7 Fill Pattern (FillStyle)............................................................................................................988
3.10.18.8 Fill Pattern (FillStyle)............................................................................................................988
3.10.18.9 Pressed (Pressed)...............................................................................................................988
3.10.18.10 Background (Background)...................................................................................................989
3.10.18.11 Light Effect (LightEffect).......................................................................................................989
3.10.18.12 Line Style (BorderStyle).......................................................................................................989
3.10.18.13 Line End Style (BorderEndStyle).........................................................................................990
3.10.18.14 Line Weight (BorderWidth)...................................................................................................990
3.10.18.15 Line connection type (LineJoinStyle)...................................................................................990
3.10.18.16 Pattern alignment (Fill Style Alignment)...............................................................................991
3.10.18.17 Draw Border Inside (DrawInsideFrame)...............................................................................991
3.10.18.18 Border Style (BorderStyle)...................................................................................................991
3.10.18.19 Border Width (BorderWidth).................................................................................................992
3.10.18.20 Dividing Line Style (ItemBorderStyle)..................................................................................992
3.10.18.21 Dividing Line Weight (ItemBorderWidth) .............................................................................992
3.10.18.22 Windows Style (WindowsStyle)............................................................................................992
3.10.19 "Connected Objects" Property Group........................................................................................993
3.10.19.1 Connection point index of source object (TopConnectedConnectionPointIndex)................993
3.10.19.2 Connection point index of target object (BottomConnectedConnectionPointIndex)............993
3.10.19.3 Object name of source object (TopConnectedObjectName)...............................................993
3.10.19.4 Object name of target object (BottomConnectedObjectName)............................................993
3.10.19.5 Change Orientation (Orientation).........................................................................................994
3.10.19.6 Connection Type (ConnectorType)......................................................................................994
3.10.20 "Assignment" Property Group...................................................................................................994
3.10.20.1 Using global settings (UseGlobalSettings)...........................................................................994
3.10.20.2 Message Types for Button 1 (Button1MessageClasses).....................................................995
3.10.20.3 Message Types for Button 2 (Button2MessageClasses).....................................................995
3.10.20.4 Message Types for Button 3 (Button3MessageClasses).....................................................995
3.10.20.5 Message Types for Button 4 (Button4MessageClasses).....................................................995
3.10.20.6 Message Types for Button 5 (Button5MessageClasses).....................................................996
3.10.20.7 Message Types for Button 6 (Button6MessageClasses).....................................................996
3.10.20.8 Message Types for Button 7 (Button7MessageClasses).....................................................996
3.10.20.9 Message Types for Button 8 (Button8MessageClasses).....................................................997
3.10.21 "Status" Property Group............................................................................................................997

14

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

3.10.21.1
3.10.21.2
3.10.21.3
3.10.21.4
3.10.21.5
3.10.21.6
3.10.21.7
3.10.21.8
3.10.21.9
3.10.21.10
3.10.21.11
3.10.21.12
3.10.21.13
3.10.21.14
3.10.21.15
3.10.21.16
3.10.21.17
3.10.21.18
3.10.21.19
3.10.21.20
3.10.21.21
3.10.21.22
3.10.21.23
3.10.21.24
3.10.21.25
3.10.21.26
3.10.21.27
3.10.21.28
3.10.21.29
3.10.21.30
3.10.21.31
3.10.21.32
3.10.21.33
3.10.21.34
3.10.21.35
3.10.21.36
3.10.21.37
3.10.21.38
3.10.21.39
4

Current Status (Index)..........................................................................................................997
Bit Selection 0 (BitSelect0)...................................................................................................997
Bit Selection 1 (BitSelect1)...................................................................................................998
Bit Selection 2 (BitSelect2)...................................................................................................998
Bit Selection 3 (BitSelect3)...................................................................................................998
Flash Picture........................................................................................................................999
Flash Picture (FlashPicture).................................................................................................999
Flash Picture Referenced (FlashPicReferenced).................................................................999
Flash Picture Transparent Color (FlashPicTransColor).......................................................999
Flash Picture Transparent Color On (FlashPicUseTransColor).........................................1000
Flashing Flash Picture Active (FlashFlashPicture).............................................................1000
Flash Picture Flash Frequency(FlashRateFlashPic)..........................................................1000
Basic Picture (BasePicture)...............................................................................................1001
Basic Picture (BasePicture)...............................................................................................1001
Basic Picture Referenced (BasePicReferenced)...............................................................1001
Basic Picture Transparent Color (BasePicTransColor)......................................................1001
Basic Picture Transparent Color On (BasePicUseTransColor)..........................................1002
Highest Index (MaxIndex)..................................................................................................1002
Index (Index)......................................................................................................................1002
Priority Bit 16 (PrioBit16)....................................................................................................1002
Priority Bit 17 (PrioBit17)....................................................................................................1002
Priority Bit 18 (PrioBit18)....................................................................................................1003
Priority Bit 19 (PrioBit19)....................................................................................................1003
Priority Bit 20 (PrioBit20)....................................................................................................1003
Priority Bit 21 (PrioBit21)....................................................................................................1004
Priority Bit 22 (PrioBit22)....................................................................................................1004
Priority Bit 23 (PrioBit23)....................................................................................................1004
Priority Bit 24 (PrioBit24)....................................................................................................1004
Priority Bit 25 (PrioBit25)....................................................................................................1005
Priority Bit 26 (PrioBit26)....................................................................................................1005
Priority Bit 27 (PrioBit27)....................................................................................................1005
Priority Bit 28 (PrioBit28)....................................................................................................1005
Priority Bit 29 (PrioBit29)....................................................................................................1006
Priority Bit 30 (PrioBit30)....................................................................................................1006
Priority Bit 31 (PrioBit31)....................................................................................................1006
Status Word Bit 0 (BitPosition0).........................................................................................1006
Status Word Bit 1 (BitPosition1).........................................................................................1007
Status Word Bit 2 (BitPosition2).........................................................................................1007
Status Word Bit 3 (BitPosition3).........................................................................................1007

Process Picture Dynamics......................................................................................................................1009
4.1

Types of Dynamization............................................................................................................1009

4.2

Using tag prefixes and server prefixes....................................................................................1011

4.3
4.3.1
4.3.2
4.3.3
4.3.4

Trigger Types..........................................................................................................................1013
Trigger Types..........................................................................................................................1013
Cyclic Triggers.........................................................................................................................1013
Tag Triggers............................................................................................................................1014
Event-Driven Triggers.............................................................................................................1016

4.4
4.4.1
4.4.2

Dynamic Wizard......................................................................................................................1017
Dynamizing Using Dynamic Wizard........................................................................................1017
Picture Functions.....................................................................................................................1018

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

15

Table of contents

5

16

4.4.3
4.4.4
4.4.5
4.4.6
4.4.7
4.4.8

Picture Components................................................................................................................1022
Import Functions......................................................................................................................1023
Standard Dynamics.................................................................................................................1023
Color Dynamics with Table......................................................................................................1027
System Functions....................................................................................................................1030
SFC.........................................................................................................................................1031

4.5
4.5.1
4.5.2
4.5.3

Dynamizing by Means of Tag Connection...............................................................................1033
Dynamizing by Means of Tag Connection...............................................................................1033
How to Configure a Tag Connection.......................................................................................1033
Example: Dynamic Filling of Rectangle...................................................................................1034

4.6
4.6.1
4.6.2
4.6.3
4.6.4

Dynamizing by Means of Direct Connection...........................................................................1036
Dynamizing by Means of Direct Connection...........................................................................1036
Application Examples of Direct Connection............................................................................1036
How to Configure a Direct Connection....................................................................................1038
Example: Picture Change in Picture Window..........................................................................1039

4.7
4.7.1
4.7.2
4.7.3
4.7.4
4.7.5
4.7.6
4.7.7
4.7.8

Dynamizing Using the Dynamic Dialog...................................................................................1042
Dynamizing Using the Dynamic Dialog...................................................................................1042
How to Configure Dynamization Using the Dynamic Dialog...................................................1043
Creating Expressions..............................................................................................................1045
Defining a Valid Range............................................................................................................1049
Monitoring Tag Status.............................................................................................................1053
Monitoring Quality Code..........................................................................................................1054
Editing Triggers.......................................................................................................................1056
Example: Color Change Depending on Position.....................................................................1058

4.8
4.8.1
4.8.2
4.8.3
4.8.4
4.8.5
4.8.6

Dynamizing Using VBS Action................................................................................................1061
Dynamizing Using VBS Action................................................................................................1061
Working with VBS Actions.......................................................................................................1062
Action Editor in Graphics Designer.........................................................................................1063
Working in Action Editor..........................................................................................................1066
How to Configure a VBS Action..............................................................................................1068
Editing Triggers.......................................................................................................................1070

4.9
4.9.1
4.9.2
4.9.3
4.9.4
4.9.5
4.9.6

Dynamizing Using C Action.....................................................................................................1073
Dynamizing Using C Action.....................................................................................................1073
Working with C Actions...........................................................................................................1074
How to Configure a C Action...................................................................................................1075
How to Apply Functions in the Action Code............................................................................1077
Editing Triggers.......................................................................................................................1079
Importing and Exporting Actions.............................................................................................1081

Setting up a Message System................................................................................................................1083
5.1

WinCC Alarm Logging.............................................................................................................1083

5.2

Message System in WinCC.....................................................................................................1084

5.3
5.3.1
5.3.2
5.3.3
5.3.4

Principles of the Message System..........................................................................................1090
Principles of the Message System..........................................................................................1090
"Alarm Logging" editor.............................................................................................................1091
Working in the Alarm Logging areas.......................................................................................1094
Tips and tricks.........................................................................................................................1098

5.4

Configuring the Message System...........................................................................................1101

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

5.4.1
5.4.2
5.4.2.1
5.4.2.2
5.4.2.3
5.4.2.4
5.4.3
5.4.3.1
5.4.3.2
5.4.3.3
5.4.3.4
5.4.3.5
5.4.3.6
5.4.4
5.4.4.1
5.4.4.2
5.4.4.3
5.4.4.4
5.4.4.5
5.4.4.6
5.4.4.7
5.4.4.8
5.4.5
5.4.5.1
5.4.5.2
5.4.5.3
5.4.5.4
5.4.5.5
5.4.5.6
5.4.5.7
5.4.5.8
5.4.5.9
5.4.5.10
5.4.5.11
5.4.6
5.4.6.1
5.4.6.2
5.4.6.3
5.4.6.4
5.4.6.5
5.4.6.6
5.4.6.7
5.4.6.8
5.4.6.9
5.4.7
5.4.7.1
5.4.7.2
5.4.8
5.4.8.1
5.4.8.2
5.4.8.3
5.4.8.4

Configuring the Message System...........................................................................................1101
Working with Message Blocks.................................................................................................1101
Working with Message Blocks.................................................................................................1101
Description of System Blocks..................................................................................................1102
How to select message blocks for use....................................................................................1104
How to change properties of a message nlock.......................................................................1105
Working with Message Classes..............................................................................................1107
Working with Message Classes..............................................................................................1107
How to Add Message Classes................................................................................................1107
How to insert the copy of a message class.............................................................................1108
How to change the properties of a message class..................................................................1109
How to Delete Message Classes............................................................................................1110
System Message Classes.......................................................................................................1110
Working with message types...................................................................................................1111
Working with message types...................................................................................................1111
How to Add Message Types for the Message Class...............................................................1112
How to insert copies of a message type..................................................................................1113
How to change the properties of a message type...................................................................1113
How to Configure the Acknowledgment of a Message Type...................................................1114
How to Configure the Status Texts of a Message Type..........................................................1116
How To Configure Colors for the Display................................................................................1118
How to delete message types.................................................................................................1119
Working with messages..........................................................................................................1120
Working with messages..........................................................................................................1120
The properties of a message...................................................................................................1121
How to Create a Message.......................................................................................................1125
How to Edit Multiple Messages...............................................................................................1126
How to Delete a Message ......................................................................................................1127
Tags of a Single Message.......................................................................................................1128
How to Specify Message Text for a Message.........................................................................1131
How to Insert Process Values in User Text Blocks.................................................................1133
How to Link a Picture to a Message........................................................................................1134
How to Configure the Hiding of Messages..............................................................................1135
Importing and Exporting Messages.........................................................................................1139
Working with Message Groups...............................................................................................1141
Message groups......................................................................................................................1141
Working with Message Groups...............................................................................................1141
How to Create a User-Defined Message Group......................................................................1142
How to Change the Properties of a Message Group...............................................................1143
Tags of a message group........................................................................................................1144
How to Add a Message to a User-Defined Message Group...................................................1150
How to add another user-defined message group to a user-defined message group............1150
How to Remove a Message from a User-Defined Message Group........................................1151
How to Delete a User-Defined Message Group......................................................................1152
Working with system messages..............................................................................................1152
How To Use System Messages..............................................................................................1152
Description of WinCC System Messages................................................................................1155
Working with analog alarms....................................................................................................1167
Working with the Limit Value Monitoring.................................................................................1167
Messages of the Limit Value Monitoring.................................................................................1167
How to create a new analog alarm..........................................................................................1168
How to use message blocks for analog alarms.......................................................................1169

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

17

Table of contents

18

5.4.8.5
5.4.8.6
5.4.8.7
5.4.8.8
5.4.9
5.4.9.1
5.4.10
5.4.10.1

How to configure an analog alarm...........................................................................................1169
How to display the messages of the analog alarm..................................................................1171
How to delete an analog alarm................................................................................................1172
Examples of Configuring a Limit Value...................................................................................1172
Working with AS messages.....................................................................................................1175
AS messages..........................................................................................................................1175
Working with operator messages............................................................................................1178
Operator messages.................................................................................................................1178

5.5
5.5.1
5.5.2
5.5.2.1
5.5.2.2
5.5.2.3
5.5.2.4
5.5.2.5
5.5.2.6
5.5.3
5.5.3.1
5.5.3.2
5.5.3.3
5.5.3.4
5.5.3.5
5.5.4

Message Archiving..................................................................................................................1180
Message Archiving in WinCC..................................................................................................1180
Configuration of Message Archiving........................................................................................1181
Configuration of Message Archiving........................................................................................1181
How to Configure Messages for Archiving..............................................................................1183
How to Configure a Message Archive.....................................................................................1183
How to Configure the Archive Backup.....................................................................................1187
How to link an archive.............................................................................................................1189
How to disconnect an archive.................................................................................................1190
Output of Message Archive Data............................................................................................1191
Output of Message Archive Data in Runtime..........................................................................1191
How to Display Archived Messages in Runtime......................................................................1192
How to Configure Reloading of Messages Following a Power Failure....................................1194
How to Configure a Message Archive Report.........................................................................1195
Direct Access to the Archive Database...................................................................................1197
Message Server......................................................................................................................1198

5.6
5.6.1
5.6.2
5.6.2.1
5.6.2.2
5.6.2.3
5.6.2.4
5.6.2.5
5.6.2.6
5.6.2.7
5.6.2.8
5.6.2.9
5.6.2.10
5.6.2.11
5.6.3
5.6.3.1
5.6.3.2
5.6.3.3
5.6.3.4
5.6.3.5
5.6.3.6
5.6.4
5.6.4.1
5.6.4.2
5.6.4.3
5.6.4.4
5.6.4.5

Display of Messages during Runtime......................................................................................1201
WinCC AlarmControl...............................................................................................................1201
Configuring the AlarmControl..................................................................................................1202
How to configure the AlarmControl.........................................................................................1202
How to configure the message blocks.....................................................................................1203
How to specify message window contents..............................................................................1205
How to configure the display for the table...............................................................................1209
How to configure the toolbar and the status bar .....................................................................1213
How to Configure a Hit List of Messages................................................................................1216
How to configure operator messages......................................................................................1219
How to export runtime data.....................................................................................................1222
How to define the effect of the online configuration................................................................1224
SQL statements for filtering messages in AlarmControl..........................................................1226
How to make the toolbar for the AlarmControl dynamic..........................................................1228
Operation during runtime.........................................................................................................1229
Operating the AlarmControl in runtime....................................................................................1229
How to Select Messages.........................................................................................................1234
How to Lock and Unlock Messages........................................................................................1236
How to Perform an Emergency Acknowledgement.................................................................1239
How to Sort the Display of Messages.....................................................................................1240
How to Hide and Unhide Messages........................................................................................1243
AlarmControl example project.................................................................................................1244
Examples of configuring an AlarmControl...............................................................................1244
How to Configure the Message System..................................................................................1245
How to Configure Single Messages........................................................................................1247
How to configure the AlarmControl in the Graphics Designer.................................................1248
How to Configure Buttons for Changing Message Tags.........................................................1254

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

6

5.6.4.6
5.6.4.7

Example of making the toolbar of the AlarmControl dynamic.................................................1255
How to operate the example on AlarmControl........................................................................1255

5.7
5.7.1
5.7.2
5.7.2.1
5.7.2.2
5.7.2.3
5.7.2.4
5.7.2.5
5.7.2.6
5.7.2.7
5.7.3
5.7.3.1
5.7.3.2
5.7.3.3
5.7.3.4
5.7.3.5
5.7.3.6
5.7.3.7
5.7.3.8
5.7.4

Before WinCC V7: Display of Messages during Runtime.......................................................1257
WinCC Alarm Control..............................................................................................................1257
Configuration of the Alarm Control..........................................................................................1258
Configuration of the WinCC Alarm Control..............................................................................1258
How to Configure the Message System..................................................................................1259
How to Configure Single Messages........................................................................................1262
How to Configure the Alarm Control in the Graphics Designer...............................................1264
How to Configure Buttons for Changing Message Tags.........................................................1270
How to Configure a Hit List of Messages................................................................................1271
How to Activate the Example for Alarm Control......................................................................1277
Operation during runtime.........................................................................................................1278
Operation of Alarm Control during Runtime............................................................................1278
How to Select Messages.........................................................................................................1281
How to Lock and Unlock Messages........................................................................................1283
How to Hide and Show Messages..........................................................................................1287
How to Perform an Emergency Acknowledgement.................................................................1289
How to Sort the Display of Messages.....................................................................................1291
Standard Functions for Operation of WinCC Alarm Control....................................................1293
Example of the Use of Standard Functions.............................................................................1295
SQL Statements for Filtering of Messages in Alarm Control...................................................1299

Archiving Process Values.......................................................................................................................1303
6.1

Archiving Process Values........................................................................................................1303

6.2

Process Value Archiving in WinCC.........................................................................................1304

6.3
6.3.1
6.3.2
6.3.3
6.3.3.1
6.3.3.2
6.3.3.3
6.3.3.4
6.3.3.5
6.3.4
6.3.4.1
6.3.4.2
6.3.4.3
6.3.4.4
6.3.4.5
6.3.4.6
6.3.4.7
6.3.5
6.3.5.1
6.3.5.2
6.3.5.3
6.3.5.4
6.3.5.5
6.3.5.6
6.3.5.7

Basics of Process Values Archiving........................................................................................1306
Basics of Process Values Archiving........................................................................................1306
Process Value Archiving for Multi-User Projects.....................................................................1306
Process Values and Tags.......................................................................................................1308
Process Values and Tags.......................................................................................................1308
External and Internal Tags......................................................................................................1309
Process-controlled tags...........................................................................................................1309
Structure of a Telegram with Raw Data Tags.........................................................................1310
Diagnostic Tags of Tag Logging Runtime...............................................................................1313
Properties in Tag Logging.......................................................................................................1314
Properties of a cycle time........................................................................................................1314
Properties of a time series.......................................................................................................1315
Properties of a process value archive.....................................................................................1316
Properties of a compressed archive........................................................................................1317
Properties of binary and analog archive tags..........................................................................1318
Properties of process-controlled tags......................................................................................1321
Properties of compressed tags................................................................................................1322
Archiving Methods...................................................................................................................1323
Archiving Methods...................................................................................................................1323
Cycles and Events...................................................................................................................1324
Continuous cyclic process value archiving..............................................................................1325
Cyclic-Selective Process Value Archiving...............................................................................1326
Acyclic Process Value Archiving.............................................................................................1327
Process-Controlled Process Value Archiving..........................................................................1328
Swinging Door algorithm for process value archiving.............................................................1329

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

19

Table of contents

20

6.3.5.8
6.3.6
6.3.7
6.3.8

Compressed Archive...............................................................................................................1332
Storing Process Values...........................................................................................................1334
Swapping Out Process Values................................................................................................1335
Significance of Archive Value Flags........................................................................................1337

6.4
6.4.1
6.4.2
6.4.3
6.4.4
6.4.4.1
6.4.4.2
6.4.4.3
6.4.5
6.4.5.1
6.4.5.2
6.4.5.3
6.4.5.4
6.4.6
6.4.6.1
6.4.6.2
6.4.6.3
6.4.6.4
6.4.6.5
6.4.6.6
6.4.6.7
6.4.7
6.4.7.1
6.4.7.2
6.4.7.3
6.4.8
6.4.8.1
6.4.8.2
6.4.8.3

Configuration of Process Value Archiving...............................................................................1339
Configuration of Process Value Archiving...............................................................................1339
Tag Logging editor..................................................................................................................1339
Working in the Tag Logging areas..........................................................................................1342
Cycle times and time series....................................................................................................1345
Times for acquisition and archiving.........................................................................................1345
How to Configure a New Cycle Time......................................................................................1346
How to configure a new time series........................................................................................1347
Configuring Archives...............................................................................................................1348
Configuring Archives...............................................................................................................1348
How to Configure a Process Value Archive............................................................................1348
How to configure the data buffer.............................................................................................1349
How to Configure Compressed Archives................................................................................1350
Creating Archive Tags.............................................................................................................1351
Creating Archive Tags.............................................................................................................1351
How to create an archive tag...................................................................................................1352
How to configure the properties of an archive tag...................................................................1353
How to Create a Process-Controlled Tag................................................................................1353
How to configure the properties of a process-controlled tag...................................................1355
How to Create a Compressed Tag..........................................................................................1355
How to configure the properties of a compressed tag.............................................................1357
Configuring archives................................................................................................................1358
Calculating memory requirements...........................................................................................1358
How to Configure Archive........................................................................................................1359
How to Assign Archive Tags to Archive Types........................................................................1361
Archive backup........................................................................................................................1363
How to Configure an Archive Backup......................................................................................1363
How to Link an Archive Backup...............................................................................................1366
How to Disconnect an Archive Backup...................................................................................1368

6.5
6.5.1
6.5.2
6.5.2.1
6.5.2.2
6.5.2.3
6.5.2.4
6.5.3
6.5.3.1
6.5.4
6.5.4.1
6.5.4.2
6.5.4.3
6.5.4.4

Output of Process Values........................................................................................................1370
Output of Process Values........................................................................................................1370
Process Value Output in Process Pictures..............................................................................1371
Process value output in process pictures................................................................................1371
Process Value Output in Table Format...................................................................................1373
Process Value Output in the Form of Trends in Process Pictures..........................................1410
Process Value Output as a Function of Another Tag..............................................................1465
Process value output in reports...............................................................................................1504
Process value output in reports...............................................................................................1504
Process value output before WinCC V7..................................................................................1506
Process value output in process pictures before WinCC V7...................................................1506
Before WinCC V7: Process Value Output in Table Format.....................................................1508
Before WinCC V7: Process Value Output in the Form of Trends in Process Pictures............1529
Before WinCC V7: Process Value Output as a Function of Another Tag................................1565

6.6

Direct Access to the Archive Database...................................................................................1616

6.7
6.7.1

Function Call Templates..........................................................................................................1618
Function Call Templates..........................................................................................................1618

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

6.7.2
6.7.3
6.7.4
6.7.5
6.7.6
6.7.6.1
6.7.6.2
6.7.6.3
7

Function During Start of Archiving...........................................................................................1618
Function for Conversion of Tag Values...................................................................................1619
Function to Start Archiving......................................................................................................1620
Function to Stop Archiving......................................................................................................1620
Appendix.................................................................................................................................1620
Action for Swap-Out................................................................................................................1620
Action upon Sending...............................................................................................................1621
Action upon Reception............................................................................................................1622

User archive...........................................................................................................................................1623
7.1
7.1.1
7.1.2
7.1.3
7.1.4
7.1.5
7.1.6
7.1.7

Basics......................................................................................................................................1623
Introduction to archives/user archives.....................................................................................1623
Properties of a user archive....................................................................................................1624
Properties of a user archive field.............................................................................................1626
Properties of a view.................................................................................................................1627
Properties of a user archive column........................................................................................1628
User archives and redundancy................................................................................................1629
Overview of unusable names..................................................................................................1630

7.2
7.2.1
7.2.2
7.2.2.1
7.2.2.2
7.2.2.3
7.2.2.4
7.2.2.5
7.2.2.6
7.2.2.7
7.2.2.8
7.2.2.9
7.2.2.10
7.2.2.11
7.2.3
7.2.3.1
7.2.3.2
7.2.3.3
7.2.3.4
7.2.3.5
7.2.3.6
7.2.3.7
7.2.4
7.2.4.1
7.2.4.2
7.2.5
7.2.5.1
7.2.5.2
7.2.5.3

Configurations in the user archive...........................................................................................1632
The "User Archive" editor........................................................................................................1632
Configuration of a User Archive..............................................................................................1634
How to create a user archive...................................................................................................1634
How to edit properties of a user archive..................................................................................1635
How to configure the communication to tags..........................................................................1636
How to configure the control tags............................................................................................1636
Example for the use of control tags.........................................................................................1637
How to specify the authorizations for the archive....................................................................1641
How to create user archive fields............................................................................................1642
How to edit properties of a user archive field..........................................................................1643
How to edit the position of a user archive field........................................................................1643
How to configure multilingual text............................................................................................1644
How to make changes in the user archive..............................................................................1644
Configuring a view...................................................................................................................1645
How to create a view...............................................................................................................1645
How to edit properties of a view..............................................................................................1645
How to create the user archive columns of a view..................................................................1646
How to edit properties of a user archive column.....................................................................1646
How to edit the position of a user archive column...................................................................1647
How to display the data of a view............................................................................................1648
Example for relation................................................................................................................1648
Export and import....................................................................................................................1649
How to export the configuration data of the user archive........................................................1649
How to import the configuration data of the user archive........................................................1650
Runtime data...........................................................................................................................1651
How to edit the Runtime data in the user archive....................................................................1651
How to export runtime data of the user archive.......................................................................1651
How to import runtime data of the user archive.......................................................................1652

7.3
7.3.1
7.3.2
7.3.2.1

Data communication with automation systems.......................................................................1654
SIMATIC interfaces.................................................................................................................1654
Data communication with S7 via raw data tags.......................................................................1654
How to configure data communication via raw data tags........................................................1654

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

21

Table of contents

22

7.3.2.2
7.3.2.3
7.3.2.4
7.3.2.5
7.3.2.6
7.3.2.7
7.3.2.8
7.3.2.9
7.3.2.10

Data format differences between WinCC and S5/S7..............................................................1657
Sending jobs and data from S7 to WinCC...............................................................................1658
Receiving data and processing acknowledgment in S7..........................................................1659
Structure of the message frame header..................................................................................1659
Job Header..............................................................................................................................1660
Data of the job.........................................................................................................................1660
The acknowledgement header................................................................................................1661
Description of the job types.....................................................................................................1662
Description of the error codes.................................................................................................1662

7.4
7.4.1
7.4.2
7.4.3
7.4.4
7.4.4.1
7.4.4.2
7.4.4.3
7.4.4.4
7.4.4.5
7.4.4.6
7.4.4.7
7.4.4.8
7.4.4.9
7.4.4.10
7.4.4.11
7.4.4.12
7.4.4.13
7.4.4.14
7.4.4.15
7.4.4.16
7.4.4.17
7.4.5
7.4.5.1
7.4.5.2
7.4.5.3
7.4.5.4
7.4.5.5
7.4.5.6
7.4.5.7
7.4.5.8
7.4.5.9
7.4.5.10
7.4.5.11
7.4.5.12
7.4.6
7.4.6.1
7.4.6.2
7.4.6.3
7.4.6.4
7.4.6.5
7.4.6.6
7.4.6.7

User archive functions.............................................................................................................1664
General information.................................................................................................................1664
How to use the functions of the user archive..........................................................................1664
Example of a user archive script.............................................................................................1667
Functions for Configuring User Archives.................................................................................1676
Functions for Configuring User Archives.................................................................................1676
uaAddArchive..........................................................................................................................1676
uaAddField..............................................................................................................................1677
uaGetArchive...........................................................................................................................1677
uaGetField...............................................................................................................................1678
uaGetNumArchives.................................................................................................................1679
uaGetNumFields.....................................................................................................................1679
UaQueryConfiguration.............................................................................................................1680
uaReleaseConfiguration..........................................................................................................1680
uaRemoveAllArchives.............................................................................................................1681
uaRemoveAllFields.................................................................................................................1682
uaRemoveArchive...................................................................................................................1682
uaRemoveField.......................................................................................................................1683
uaSetArchive...........................................................................................................................1683
uaSetField...............................................................................................................................1684
Structure of the field configuration "uaCONFIGFIELD"...........................................................1685
Structure of the user archive configuration "uaCONFIGARCHIVE"........................................1685
General runtime functions.......................................................................................................1687
General runtime functions.......................................................................................................1687
uaConnect...............................................................................................................................1687
uaDisconnect...........................................................................................................................1688
uaGetLocalEvents...................................................................................................................1688
uaIsActive................................................................................................................................1689
uaOpenArchives......................................................................................................................1689
uaOpenViews..........................................................................................................................1690
uaQueryArchive.......................................................................................................................1690
uaQueryArchiveByName.........................................................................................................1691
uaReleaseArchive...................................................................................................................1692
uaSetLocalEvents...................................................................................................................1692
uaUsers...................................................................................................................................1693
Archive-specific runtime functions...........................................................................................1693
Archive-specific runtime functions...........................................................................................1693
uaArchiveClose.......................................................................................................................1695
uaArchiveDelete......................................................................................................................1695
uaArchiveExport......................................................................................................................1696
uaArchiveGetCount.................................................................................................................1697
uaArchiveGetFieldLength........................................................................................................1697
uaArchiveGetFieldName.........................................................................................................1698

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

7.4.6.8
7.4.6.9
7.4.6.10
7.4.6.11
7.4.6.12
7.4.6.13
7.4.6.14
7.4.6.15
7.4.6.16
7.4.6.17
7.4.6.18
7.4.6.19
7.4.6.20
7.4.6.21
7.4.6.22
7.4.6.23
7.4.6.24
7.4.6.25
7.4.6.26
7.4.6.27
7.4.6.28
7.4.6.29
7.4.6.30
7.4.6.31
7.4.6.32
7.4.6.33
7.4.6.34
7.4.6.35
7.4.6.36
7.4.6.37
7.4.6.38
7.4.7
7.4.7.1
7.4.7.2

uaArchiveGetFields.................................................................................................................1698
uaArchiveGetFieldType...........................................................................................................1699
uaArchiveGetFieldValueDate..................................................................................................1700
uaArchiveGetFieldValueDouble..............................................................................................1700
uaArchiveGetFieldValueFloat..................................................................................................1701
uaArchiveGetFieldValueLong..................................................................................................1702
uaArchiveGetFieldValueString................................................................................................1702
uaArchiveGetFilter...................................................................................................................1703
uaArchiveGetID.......................................................................................................................1703
uaArchiveGetName.................................................................................................................1704
uaArchiveGetSort....................................................................................................................1705
uaArchiveImport......................................................................................................................1705
uaArchiveInsert.......................................................................................................................1706
uaArchiveMoveFirst.................................................................................................................1706
uaArchiveMoveLast.................................................................................................................1707
uaArchiveMoveNext................................................................................................................1707
uaArchiveMovePrevious..........................................................................................................1708
uaArchiveOpen........................................................................................................................1708
uaArchiveReadTagValues.......................................................................................................1709
uaArchiveReadTagValuesByName.........................................................................................1709
uaArchiveRequery...................................................................................................................1710
uaArchiveSetFieldValueDate..................................................................................................1711
uaArchiveSetFieldValueDouble...............................................................................................1711
uaArchiveSetFieldValueFloat..................................................................................................1712
uaArchiveSetFieldValueLong..................................................................................................1713
uaArchiveSetFieldValueString.................................................................................................1713
uaArchiveSetFilter...................................................................................................................1714
uaArchiveSetSort....................................................................................................................1715
uaArchiveUpdate.....................................................................................................................1715
uaArchiveWriteTagValues.......................................................................................................1716
uaArchiveWriteTagValuesByName.........................................................................................1717
Troubleshooting functions ...................................................................................................1717
uaGetLastError........................................................................................................................1717
uaGetLastHResult...................................................................................................................1719

7.5
7.5.1
7.5.2
7.5.2.1
7.5.2.2
7.5.2.3
7.5.2.4
7.5.2.5
7.5.2.6
7.5.2.7
7.5.3
7.5.3.1
7.5.3.2
7.5.3.3
7.5.3.4

WinCC UserArchiveControl.....................................................................................................1720
WinCC UserArchiveControl.....................................................................................................1720
Configuring the UserArchiveControl........................................................................................1721
How to configure the UserArchiveControl...............................................................................1721
How to define the contents of the UserArchiveControl............................................................1723
How to configure the display for the table...............................................................................1726
How to configure the toolbar and the status bar .....................................................................1730
How to export runtime data.....................................................................................................1734
How to define the effect of the online configuration................................................................1735
How to make the toolbar for the UserArchiveControl dynamic................................................1737
Operation in runtime................................................................................................................1738
Operating the UserArchiveControl in runtime..........................................................................1738
To process the data in the UserArchiveControl:......................................................................1741
How to select the data of the user archive..............................................................................1742
How to sort the display of user archive data...........................................................................1744

7.6
7.6.1

Before WinCC V7: WinCC User Archives Table Element.......................................................1746
Functionality............................................................................................................................1746

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

23

Table of contents

7.6.2
7.6.2.1
7.6.2.2
7.6.2.3
7.6.2.4
7.6.3
7.6.3.1
7.6.3.2
7.6.3.3
7.6.3.4
7.6.3.5
7.6.3.6
7.6.3.7
7.6.3.8
7.6.4
7.6.4.1
7.6.4.2
7.6.4.3
7.6.4.4
7.6.4.5
7.6.4.6
7.6.5
7.6.5.1
7.6.5.2
7.6.5.3
7.6.5.4
7.6.5.5
7.6.5.6
8

9

24

Configuration of User Archives Table Element.......................................................................1747
Configuring a User Archives Table Element...........................................................................1747
Place the User Archive Table Element in a process screen...................................................1748
Define properties of the User Archives Table Element...........................................................1749
Delete the User Archives Table Element................................................................................1751
Properties of WinCC User Archives Table Element................................................................1751
Properties of WinCC User Archives Table Element................................................................1751
"General" tab...........................................................................................................................1753
"Columns" tab..........................................................................................................................1755
"Toolbar" Tab..........................................................................................................................1756
"Status Bar" Tab......................................................................................................................1758
"Filter/ Sorting" tab..................................................................................................................1759
"Fonts" Tab..............................................................................................................................1761
"Colors" tab.............................................................................................................................1762
Configuring a Form View.........................................................................................................1762
Configuring a Form View.........................................................................................................1762
Insert "Text" form field.............................................................................................................1764
Insert "Edit" form field..............................................................................................................1765
Insert "Button" form field..........................................................................................................1766
Edit form fields subsequently..................................................................................................1767
Delete form fields....................................................................................................................1767
User Archives Table Elements in Runtime..............................................................................1767
Table of User Archives Table Element....................................................................................1767
The User Archives Table Element Form.................................................................................1768
Toolbar of WinCC User Archives Table Element....................................................................1769
Operating the Control using Dynamized Objects....................................................................1773
List of properties for the User Archives Table Element...........................................................1776
Overview of the dynamizable properties in the layout.............................................................1779

Working with Cross Reference...............................................................................................................1781
8.1

The functionality of Cross Reference......................................................................................1781

8.2

How to filter the lists of the Cross Reference..........................................................................1785

8.3

How to jump to a place of use.................................................................................................1786

8.4

How to link tags in the pictures................................................................................................1787

8.5

How to export the lists of Cross Reference.............................................................................1789

8.6

Example: Filtering and jumping to places of use.....................................................................1791

8.7

Example: Linking of tags.........................................................................................................1795

8.8

Configuration instructions for tags and picture names in actions............................................1798

Documentation of Configuration and Runtime Data...............................................................................1799
9.1

Documentation of Configuration and Runtime Data................................................................1799

9.2

How to Set Up Reports in the Page Layout.............................................................................1801

9.3

How to Create Reports in Line Layout....................................................................................1803

9.4
9.4.1
9.4.2
9.4.3

Print Jobs in WinCC................................................................................................................1805
Print Jobs in WinCC................................................................................................................1805
Print Job Properties.................................................................................................................1806
Selecting the Print Range........................................................................................................1809

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

10

9.4.4

Defining a Printer.....................................................................................................................1811

9.5
9.5.1
9.5.2
9.5.3
9.5.4
9.5.5
9.5.6
9.5.7
9.5.8
9.5.9
9.5.10
9.5.11
9.5.12
9.5.13
9.5.14
9.5.15
9.5.16
9.5.17
9.5.18
9.5.19

Project Documentation............................................................................................................1815
Introduction to Project Documentation....................................................................................1815
How to Output Project Documentation....................................................................................1816
How to Open a Project Documentation Preview.....................................................................1818
How to Create a New Print Job...............................................................................................1819
How to Change an Existing Print Job......................................................................................1821
Project documentation in the WinCC Explorer/Tag Management...........................................1823
Project Documentation in the Graphics Designer...................................................................1824
Project Documentation in Alarm Logging................................................................................1827
Project Documentation in Tag Logging...................................................................................1828
Project Documentation in Global Script...................................................................................1829
Project Documentation in the Text Library..............................................................................1831
Project Documentation in the User Administrator...................................................................1832
Project documentation in the Cross Reference.......................................................................1833
Project Documentation in the Time Synchronization Editor....................................................1834
Project documentation in the horn...........................................................................................1834
Project Documentation in the Picture Tree Manager..............................................................1835
Project Documentation in Lifebeat Monitoring.........................................................................1836
Project Documentation in the OS Project Editor.....................................................................1837
Project Documentation in the Component List Editor..............................................................1838

9.6
9.6.1
9.6.2
9.6.3
9.6.4
9.6.5
9.6.6
9.6.6.1
9.6.6.2
9.6.6.3
9.6.6.4
9.6.7
9.6.8
9.6.9
9.6.9.1
9.6.9.2
9.6.9.3
9.6.9.4
9.6.9.5
9.6.9.6
9.6.9.7
9.6.9.8
9.6.9.9

Runtime Documentation..........................................................................................................1840
Introduction to Runtime Documentation..................................................................................1840
How to Create Layouts for Runtime Documentation...............................................................1844
How to create print jobs for the Runtime documentation........................................................1846
How to Change Output Options in Runtime............................................................................1848
Dynamizable Parameters for Runtime Documentation...........................................................1851
Reporting Messages in Runtime.............................................................................................1856
Reporting Messages in Runtime.............................................................................................1856
How to Output Runtime Data from the Message Lists............................................................1857
How to Output Online Data with Message Sequence Report.................................................1858
How to Create a User-Defined Message Sequence Report....................................................1861
Reporting Process Values in Runtime.....................................................................................1862
How to Output Data from User Archives.................................................................................1863
Reporting Data from Other Data Sources...............................................................................1865
Reporting Data from Other Data Sources...............................................................................1865
How to Output Data from an ODBC Database in a Report.....................................................1865
How to Output Data from a CSV Table in a Log.....................................................................1867
Example of the Output of CSV Files in a Report.....................................................................1868
Requirements to be Met by a CSV File for Reporting.............................................................1871
How to Output a Hard Copy by Means of a Log Object..........................................................1874
How to Output a Hard Copy by Means of a Key Combination................................................1875
Output Parameters for Hard Copy...........................................................................................1877
How to Output Data from a COM Server in a Report..............................................................1882

9.7
9.7.1
9.7.2
9.7.3

Appendix.................................................................................................................................1884
System Layouts for Project Documentation............................................................................1884
System Layouts and Print Jobs for Runtime Documentation..................................................1887
Filter criteria for alarm output..................................................................................................1889

Creating Page Layouts...........................................................................................................................1893
10.1

Creating Page Layouts............................................................................................................1893

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

25

Table of contents

10.2

How to Start the Page Layout Editor.......................................................................................1894

10.3
The Page Layout Editor...........................................................................................................1895
10.3.1 The Page Layout Editor...........................................................................................................1895
10.3.2 The Standard Toolbar.............................................................................................................1897
10.3.3 The Object Palette...................................................................................................................1899
10.3.3.1 The Object Palette...................................................................................................................1899
10.3.3.2 Standard Objects.....................................................................................................................1900
10.3.3.3 Objects for the Runtime Documentation.................................................................................1904
10.3.3.4 COM Server Objects...............................................................................................................1905
10.3.3.5 Objects for the Project Documentation....................................................................................1906
10.3.4 The Style Palette.....................................................................................................................1907
10.3.5 The Alignment Palette.............................................................................................................1908
10.3.6 The Zoom Palette....................................................................................................................1910
10.3.7 The Color Palette....................................................................................................................1911
10.3.8 The Font Palette......................................................................................................................1912
10.3.9 The Status Bar........................................................................................................................1913
10.3.10 Customizing the Working Environment...................................................................................1913
10.3.10.1 Customizing the Working Environment..............................................................................1913
10.3.10.2 How to Create Custom Colors...........................................................................................1914
10.3.10.3 How to Show and Hide the Toolbar and Palettes..............................................................1915
10.3.10.4 How to Arrange the Toolbar and Palettes..........................................................................1915
10.3.10.5 How to Change the Standard Toolbar................................................................................1916
10.3.10.6 The Basic Settings of the Page Layout Editor....................................................................1918
10.4
10.4.1
10.4.2
10.4.3
10.4.4
10.4.5

Working with Layouts..............................................................................................................1924
Working with Layouts..............................................................................................................1924
Layout File Operations............................................................................................................1925
How to Display the Layout Properties.....................................................................................1929
Changing Predefined Layouts.................................................................................................1930
Working with Multiple Layouts.................................................................................................1932

10.5
Working with Objects...............................................................................................................1935
10.5.1 Working with Objects...............................................................................................................1935
10.5.2 The coordinate system in the Report Designer.......................................................................1935
10.5.3 The Rectangle Surrounding the Object...................................................................................1937
10.5.4 How to Paste an Object into a Layout.....................................................................................1939
10.5.5 How to Edit Objects.................................................................................................................1940
10.5.6 Multiple Selection of Objects...................................................................................................1942
10.5.6.1 Multiple Selection of Objects...................................................................................................1942
10.5.6.2 How to Select Multiple Objects................................................................................................1944
10.5.6.3 How to Align Multiple Objects..................................................................................................1945
10.5.7 The Properties of an Object....................................................................................................1947
10.5.7.1 The Properties of an Object....................................................................................................1947
10.5.7.2 The Object Properties Window................................................................................................1947
10.5.7.3 How to Change an Attribute....................................................................................................1953
10.5.7.4 How to Transfer Object Properties..........................................................................................1954
10.5.7.5 How to Rename Objects.........................................................................................................1955
10.5.7.6 The Colors Property Group.....................................................................................................1956
10.5.7.7 The Geometry Property Group................................................................................................1958
10.5.7.8 The Font Property Group........................................................................................................1961
10.5.7.9 The Miscellaneous Property Group.........................................................................................1962
10.5.7.10 The Styles Property Group.................................................................................................1964

26

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

10.5.8 Working with Standard Objects...............................................................................................1966
10.5.8.1 Working with Standard Objects...............................................................................................1966
10.5.8.2 Working with Static Objects.....................................................................................................1966
10.5.8.3 Working with Dynamic Standard Objects................................................................................1995
10.5.8.4 Working with System Objects..................................................................................................2008
10.5.8.5 Working with the Layout Object...............................................................................................2010
10.5.9 Working with Objects for the Runtime Documentation............................................................2011
10.5.9.1 Working with Objects for the Runtime Documentation............................................................2011
10.5.9.2 Modify output options for WinCC Online Table Control...........................................................2012
10.5.9.3 Modify output options for WinCC Online Trend Control..........................................................2017
10.5.9.4 Modify output options for WinCC Function Trend Control.......................................................2022
10.5.9.5 Modify output options for WinCC Alarm Control......................................................................2026
10.5.9.6 Change output options for WinCC UserArchiveControl..........................................................2031
10.5.9.7 Changing Output Options for Message Reports from Alarm Logging.....................................2032
10.5.9.8 Changing Output Options for User Archive Tables.................................................................2038
10.5.9.9 How to Change the Output Options for CSV Provider Tables.................................................2043
10.5.9.10 How to Change the Output Options for CSV Provider Trends...........................................2045
10.5.10 Working with Objects for the Project Documentation..............................................................2046
10.5.10.1 Working with Objects for the Project Documentation.........................................................2046
10.5.10.2 How to Call up the Selection Dialogs.................................................................................2048
10.5.10.3 How to Change Output Options for Single Message from Alarm Logging CS...................2050
10.5.10.4 How to Change the Output Options for the Selection of User Archives.............................2051
10.5.10.5 How to Change the Output Options for the Selection of Views..........................................2053
10.5.10.6 How to Change the Output options for the Selection of the Picture Statistics...................2055
10.5.10.7 How to Change the Output Options for the Selection of Attributes....................................2057
10.5.10.8 How to Change the Output Options for the Selection of Object Statistics.........................2059
10.5.10.9 How to Change the Output Options for the Selection of Action types................................2061
10.5.10.10 How to Change the Output Options for the Selection of Archives from Tag Logging........2062
10.5.10.11 How to Change the Output Options for the Selection of the Archive Tags from Tag
Logging..............................................................................................................................2065
10.5.10.12 How to Change the Output Options for the Language Selection from the Text Library.....2068
10.5.10.13 How to Change the Output Options for the Tag Table of WinCC Explorer........................2070
10.5.10.14 How to Change the Output Options for the Selection of Connection List..........................2072
10.5.10.15 How to Change the Output Options for the Dynamic Texts...............................................2074
10.5.10.16 How to Change the Output Options for the Dynamic Metafiles..........................................2075
10.5.10.17 How to Change the Output Options for the Dynamic Tables without Data Selection........2076
10.6
10.6.1
10.6.2
11

Appendix.................................................................................................................................2078
Requests to a CSV File for Reporting.....................................................................................2078
Filter Criteria for the Alarm Output..........................................................................................2080

Creating Line Layouts.............................................................................................................................2083
11.1

Creating Line Layouts.............................................................................................................2083

11.2

How to Start the Line Layout Editor.........................................................................................2084

11.3
11.3.1
11.3.2
11.3.3
11.3.4
11.3.5
11.3.6

The Line Layout Editor............................................................................................................2086
The Line Layout Editor............................................................................................................2086
The Standard Toolbar.............................................................................................................2088
The Page Size and Margins Areas..........................................................................................2089
The Header and Footer Areas.................................................................................................2090
The Table Area........................................................................................................................2090
The Time Range......................................................................................................................2091

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

27

Table of contents

11.4
11.4.1
11.4.2
11.4.3
11.4.4
11.4.5
12

13

28

Working with the Line Layout Editor........................................................................................2092
Working with the Line Layout Editor........................................................................................2092
How to Set the Page Size.......................................................................................................2092
How to Create Headers and Footers.......................................................................................2093
How to Create a Table in the Line Layout...............................................................................2094
How to Change the Output Options for the Message Sequence Report................................2096

COM Provider in the Layout Editor.........................................................................................................2101
12.1

COM Provider in the Layout Editor..........................................................................................2101

12.2

Working with COM Server Objects..........................................................................................2102

12.3

How to Output Data from a COM Server in a Report..............................................................2103

12.4

Example of an integration of a COM server............................................................................2104

12.5

Details of the COM Interface for Reporting.............................................................................2105

Setting Up Multilingual Projects..............................................................................................................2109
13.1

Setting Up Multilingual Projects...............................................................................................2109

13.2
13.2.1
13.2.2
13.2.3
13.2.4
13.2.5
13.2.6
13.2.7
13.2.8
13.2.9

Language support in WinCC...................................................................................................2110
Language support in WinCC...................................................................................................2110
Language expressions in WinCC............................................................................................2111
Configuring Multiple Languages..............................................................................................2114
How to Create a Multilingual Project.......................................................................................2117
How to Switch the Language of the Operating System...........................................................2118
How to Change Languages in WinCC.....................................................................................2120
Fonts in Multilingual Projects...................................................................................................2121
Prohibited Characters in WinCC.............................................................................................2122
Configuring with Non-Latin Fonts............................................................................................2123

13.3
13.3.1
13.3.2
13.3.3
13.3.3.1
13.3.3.2
13.3.3.3
13.3.3.4
13.3.3.5
13.3.4
13.3.5

Text export and text import with the Text Distributor...............................................................2125
Text export and text import in the Text Distributor..................................................................2125
How to export language-dependent texts................................................................................2126
Structure of the Export Files....................................................................................................2128
Export File Overview...............................................................................................................2128
Construction of files with text from the Text Library................................................................2129
Construction of files with text records from the "Graphics Designer" editor............................2130
Structure of the "_Languages" Files........................................................................................2132
Status bar for the export and import........................................................................................2133
How to edit and translate exported text files...........................................................................2133
How to import language-dependent texts................................................................................2135

13.4
13.4.1
13.4.2
13.4.3
13.4.4
13.4.4.1
13.4.4.2
13.4.5
13.4.5.1
13.4.5.2
13.4.5.3

The WinCC Configuration Studio............................................................................................2139
Introduction..............................................................................................................................2139
System requirements..............................................................................................................2139
Interface..................................................................................................................................2140
How to operate the navigation area .......................................................................................2142
Operating the navigation area.................................................................................................2142
Copying, pasting and deleting data in the navigation area.....................................................2144
How to operate the data area..................................................................................................2145
Operating the data area..........................................................................................................2146
Data entry in the data area......................................................................................................2147
Filtering in the data area..........................................................................................................2150

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

13.4.5.4 Fast search in data area..........................................................................................................2154
13.4.5.5 Selecting cells, areas, rows and columns...............................................................................2156
13.4.5.6 Search and replace in the data area.......................................................................................2156
13.4.5.7 Sorting in the data area...........................................................................................................2159
13.4.5.8 Copying and pasting in the data area......................................................................................2160
13.4.5.9 Undoing an action...................................................................................................................2160
13.4.5.10 Importing data records.......................................................................................................2161
13.4.5.11 Exporting data records.......................................................................................................2161

14

13.5
13.5.1
13.5.2
13.5.3
13.5.4

Text Management with the "Text Library" Editor.....................................................................2163
Text management with the "Text Library" editor.....................................................................2163
Operator's overview of the Text Library..................................................................................2165
This is how you perform an external translation of the texts...................................................2167
Multilingual messages ............................................................................................................2168

13.6
13.6.1
13.6.2
13.6.3
13.6.4
13.6.5

Multilingual Pictures in the "Graphics Designer" Editor...........................................................2171
Multilingual pictures in the "Graphics Designer" editor............................................................2171
Language-dependent properties of picture objects.................................................................2172
How to export and import text from pictures............................................................................2174
How to configure picture objects for more languages in the "Graphics Designer" editor........2175
Configuring a Text List in Multiple Languages........................................................................2177

13.7
13.7.1
13.7.2
13.7.3
13.7.4
13.7.5
13.7.6

Reports for Multilingual Projects..............................................................................................2179
Reports for Multilingual Projects..............................................................................................2179
Layout and layout file..............................................................................................................2179
How to change or create layouts.............................................................................................2180
How to change or create print jobs .........................................................................................2183
How to create the multilingual project documentation.............................................................2185
Multilingual logs in runtime......................................................................................................2186

13.8

Displaying Regional Date and Time........................................................................................2187

13.9
13.9.1
13.9.2
13.9.3

Languages in Runtime............................................................................................................2189
Languages in Runtime............................................................................................................2189
How to Set the Runtime Computer Starting Configuration......................................................2190
Configuring Language Changes..............................................................................................2190

13.10
13.10.1
13.10.2
13.10.3
13.10.4
13.10.5

Example of Configuration........................................................................................................2193
Example of Configuration........................................................................................................2193
Example: How to Configure a Multilingual Graphic Object......................................................2193
Example: How to Configure Language Changes....................................................................2194
Example: How to Change Language in Runtime....................................................................2196
Example: How to translate the text records in different linguistic regions...............................2200

Structure of the User Administration.......................................................................................................2203
14.1

Setting up user administration.................................................................................................2203

14.2

Overview of the configuration steps........................................................................................2206

14.3
14.3.1
14.3.2
14.3.3
14.3.4
14.3.4.1
14.3.4.2

The WinCC Configuration Studio............................................................................................2207
Introduction..............................................................................................................................2207
System requirements..............................................................................................................2207
Interface..................................................................................................................................2208
How to operate the navigation area .......................................................................................2210
Operating the navigation area.................................................................................................2210
Copying, pasting and deleting data in the navigation area.....................................................2212

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

29

Table of contents

14.3.5 How to operate the data area..................................................................................................2213
14.3.5.1 Operating the data area..........................................................................................................2214
14.3.5.2 Data entry in the data area......................................................................................................2215
14.3.5.3 Filtering in the data area..........................................................................................................2218
14.3.5.4 Fast search in data area..........................................................................................................2222
14.3.5.5 Selecting cells, areas, rows and columns...............................................................................2224
14.3.5.6 Search and replace in the data area.......................................................................................2224
14.3.5.7 Sorting in the data area...........................................................................................................2227
14.3.5.8 Copying and pasting in the data area......................................................................................2228
14.3.5.9 Undoing an action...................................................................................................................2228
14.3.5.10 Importing data records.......................................................................................................2229
14.3.5.11 Exporting data records.......................................................................................................2229

15

30

14.4
14.4.1
14.4.2
14.4.3
14.4.4
14.4.4.1
14.4.4.2
14.4.4.3
14.4.4.4

Administering authorizations...................................................................................................2231
Adding authorizations..............................................................................................................2231
Deleting authorizations............................................................................................................2231
Plant-specific authorizations....................................................................................................2232
Overview of Authorizations......................................................................................................2234
Default Authorizations.............................................................................................................2234
System authorizations.............................................................................................................2236
Basis Process Control Authorizations.....................................................................................2237
PCS 7 system authorizations..................................................................................................2238

14.5
14.5.1
14.5.2
14.5.3
14.5.4
14.5.5

Administering users.................................................................................................................2239
Creating a user group..............................................................................................................2239
Setting up users......................................................................................................................2239
Administrating users................................................................................................................2241
Administrating user groups......................................................................................................2243
Administering users for web access........................................................................................2244

14.6

Configuring automatic logout...................................................................................................2245

14.7

Configuring logon with a tag....................................................................................................2246

14.8

Configuring operator authorization..........................................................................................2248

14.9

Logging on as user..................................................................................................................2249

14.10

Logon with a chip card............................................................................................................2250

14.11
14.11.1
14.11.2
14.11.3
14.11.4
14.11.5
14.11.6
14.11.7

Central user administration with SIMATIC Logon...................................................................2251
Overview of SIMATIC Logon...................................................................................................2251
Windows settings for SIMATIC Logon.....................................................................................2252
How to use SIMATIC Logon with WinCC................................................................................2253
How to configure an electronic signature................................................................................2255
Creating an electronic signature in a VBS action....................................................................2256
Creating an electronic signature in a C action.........................................................................2258
Notes on WinCC/PCS7-OS integration...................................................................................2261

Integration of WinCC in SIMATIC Manager............................................................................................2263
15.1

Integration of WinCC in SIMATIC Manager............................................................................2263

15.2

Advantages and Prerequisites of Integration..........................................................................2264

15.3
15.3.1
15.3.2

Managing WinCC Projects and Objects in the SIMATIC Manager.........................................2266
Managing WinCC Projects and Objects in the SIMATIC Manager.........................................2266
WinCC Application..................................................................................................................2269

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

15.3.2.1
15.3.2.2
15.3.2.3
15.3.2.4
15.3.2.5
15.3.2.6
15.3.3
15.3.3.1
15.3.3.2
15.3.3.3
15.3.3.4
15.3.3.5
15.3.4
15.3.5
15.3.6
15.3.7
15.3.7.1
15.3.7.2
15.3.7.3
15.3.7.4
15.3.7.5
15.3.7.6
15.3.8
15.3.9

WinCC Application..................................................................................................................2269
How to Create a WinCC Application.......................................................................................2270
How to Set the Path to the Target Computer..........................................................................2273
How to Select the Standby Computer.....................................................................................2277
How to Load the Project on the Target Computer...................................................................2280
How to Create a Reference to a WinCC Application...............................................................2281
Operator Station OS................................................................................................................2284
Operator Station OS................................................................................................................2284
How to Create an Operator Station.........................................................................................2285
How to Set the Path to the Target Computer..........................................................................2285
How to Load the Project on the Target Computer...................................................................2289
How to Configure a Reference to an OS.................................................................................2290
How to Import a WinCC Project with the SIMATIC Manager..................................................2291
Handling WinCC Projects Between STEP 7 Projects and Libraries........................................2293
Accepting Language Settings from SIMATIC Managers.........................................................2294
Working With WinCC Objects.................................................................................................2295
Working With WinCC Objects.................................................................................................2295
How to Create WinCC Objects................................................................................................2296
How to Handle WinCC Objects...............................................................................................2296
How to Import WinCC Objects................................................................................................2298
Setting Up and Monitoring of Server Assignment...................................................................2298
How to Create Model Solutions of WinCC Projects or WinCC Objects...................................2301
How to Open the WinCC Project.............................................................................................2303
Starting a Simulation in STEP 7..............................................................................................2304

15.4
15.4.1
15.4.2
15.4.2.1
15.4.2.2
15.4.2.3
15.4.2.4
15.4.3
15.4.4
15.4.5

Transferring Tags, Texts and Reports to WinCC....................................................................2306
Transferring Tags, Texts and Reports to WinCC....................................................................2306
Compiling OS..........................................................................................................................2307
Compiling OS..........................................................................................................................2307
How to Compile the Entire OS................................................................................................2308
How to Compile Changes........................................................................................................2313
Compilation log........................................................................................................................2317
How to Display Transferred Tags............................................................................................2318
Displaying Transferred Messages and Texts..........................................................................2319
How to Configure Messages in STEP7...................................................................................2321

15.5

Compiling and Loading Objects..............................................................................................2325

15.6

How to use multiuser engineering in SIMATIC Manager........................................................2328

15.7
15.7.1
15.7.2
15.7.2.1
15.7.2.2
15.7.2.3
15.7.2.4
15.7.3
15.7.3.1
15.7.3.2
15.7.3.3

Selection of STEP 7 Symbols.................................................................................................2330
Selection of STEP 7 Symbols.................................................................................................2330
Tag Selection Dialog...............................................................................................................2331
Tag Selection Dialog...............................................................................................................2331
How to Display STEP 7 Symbols............................................................................................2332
How to Select STEP 7 Symbols..............................................................................................2334
How to Transfer STEP 7 Symbols...........................................................................................2336
Tag Bar....................................................................................................................................2339
Tag Bar....................................................................................................................................2339
How to Display STEP 7 Symbols............................................................................................2340
How to Select STEP 7 Symbols..............................................................................................2342

15.8
15.8.1
15.8.2

Diagnostic Support..................................................................................................................2344
Diagnostic Support..................................................................................................................2344
Network Entry Jump................................................................................................................2344

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

31

Table of contents

15.8.2.1
15.8.2.2
15.8.3
15.8.4
15.8.4.1
15.8.4.2
16

Network Entry Jump................................................................................................................2344
How to Configure the Network Entry Jump.............................................................................2345
Network Return.......................................................................................................................2348
Jump to Hardware Diagnosis..................................................................................................2351
Jump to Hardware Diagnosis..................................................................................................2351
How to Configure the Entry Jump into the Hardware Diagnostics..........................................2351

SmartTools.............................................................................................................................................2357
16.1

Overview.................................................................................................................................2357

16.2
16.2.1
16.2.2
16.2.3
16.2.4
16.2.5
16.2.6
16.2.7
16.2.8
16.2.9
16.2.10

Tag simulator...........................................................................................................................2358
The Tag simulator...................................................................................................................2358
Using the tag Simulator...........................................................................................................2358
Functions of the simulator.......................................................................................................2359
Installing the simulator.............................................................................................................2360
Adding/deleting tags................................................................................................................2361
Parameter assignment of the functions...................................................................................2361
Activating/deactivating tags.....................................................................................................2362
Display of the tags...................................................................................................................2362
Loading/saving simulation data...............................................................................................2362
FAQ.........................................................................................................................................2363

16.3
Dynamic Wizard Editor............................................................................................................2364
16.3.1 Dynamic Wizard Editor............................................................................................................2364
16.3.2 Overview.................................................................................................................................2364
16.3.3 Installation of the Dynamic Wizard Editor................................................................................2366
16.3.4 Structure..................................................................................................................................2367
16.3.4.1 Structure..................................................................................................................................2367
16.3.4.2 Toolbar....................................................................................................................................2368
16.3.4.3 Editor window..........................................................................................................................2369
16.3.4.4 Help Editor...............................................................................................................................2370
16.3.4.5 Output window.........................................................................................................................2371
16.3.5 Structure of a Dynamic Wizard function..................................................................................2372
16.3.5.1 Structure of a Dynamic Wizard function..................................................................................2372
16.3.5.2 Dynamic Wizard dialog............................................................................................................2372
16.3.5.3 Integrating header files and DLLs...........................................................................................2373
16.3.5.4 Language-dependent definitions.............................................................................................2373
16.3.5.5 Wizard flags.............................................................................................................................2374
16.3.5.6 Property list.............................................................................................................................2375
16.3.5.7 System interface......................................................................................................................2376
16.3.5.8 Global variables.......................................................................................................................2377
16.3.5.9 Options list...............................................................................................................................2377
16.3.5.10 Trigger list..........................................................................................................................2380
16.3.5.11 Display of parameter assignment.......................................................................................2382
16.3.5.12 Wizard Functions for parameter input................................................................................2383
16.3.5.13 Wizard functions for generating dynamics.........................................................................2408
16.3.5.14 Wizard WinCC functions....................................................................................................2420
16.3.5.15 Wizard progress functions..................................................................................................2424
16.3.5.16 Wizard Windows functions.................................................................................................2427
16.3.6 Examples.................................................................................................................................2433
16.3.6.1 Examples.................................................................................................................................2433
16.3.6.2 Demo Wizard...........................................................................................................................2433
16.3.6.3 Dynamic motor........................................................................................................................2436

32

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Table of contents

16.4
16.4.1
16.4.2
16.4.3
16.4.4

Documentation Viewer............................................................................................................2440
WinCC Documentation Viewer................................................................................................2440
Installing WinCC Documentation Viewer.................................................................................2440
Description..............................................................................................................................2441
Creating the .emf file(s)...........................................................................................................2442

16.5
16.5.1
16.5.2
16.5.3
16.5.4
16.5.5
16.5.6
16.5.7
16.5.8

WinCC CrossReferenceAssistant...........................................................................................2443
WinCC CrossReferenceAssistant...........................................................................................2443
Installation of the CrossReferenceAssistant............................................................................2443
General....................................................................................................................................2443
Known functions (script management)....................................................................................2444
Project selection......................................................................................................................2448
File selection...........................................................................................................................2449
Conversion..............................................................................................................................2450
Expanded settings...................................................................................................................2451

Index.......................................................................................................................................................2453

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

33

Working with Projects
1.1

1

Working with Projects

Content
Before you can monitor and control a process, you must first create a project in WinCC. You
define all necessary elements and settings in this project.
This section shows you
● How to open and close WinCC and the WinCC Explorer
● The structure of the WinCC Explorer
● The types of project in WinCC
● How to create a project and work with it
● How to activate and deactivate a project
● How to copy a project
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1.2

Opening WinCC Explorer

Introduction
When you start WinCC, the WinCC Explorer normally is opened.
After installation, WinCC is entered in the start menu of the operating system. You can start
WinCC with the entry "WinCC Explorer".
The WinCC Explorer can also be opened from the desktop or using the Windows Explorer.
Note
If you only have a Runtime license installed on a computer, you can only work in the WinCC
Explorer or in a WinCC editor for one hour. If the WinCC Explorer or a WinCC editor remains
open for more than one hour, WinCC changes to the demonstration mode.

Principle
You can open the WinCC Explorer in the following ways:
● from the Windows Start menu
● by clicking the WinCCExplorer.exe file in the Windows Explorer
● using a shortcut from the Windows Desktop
● in the Windows Explorer using the <PROJECT>.MCP
● with Autostart
● with a project that opens in Autostart
You can start WinCC only once on a computer. If you attempt to open the WinCC Explorer
when it is already open, this will be prevented without an error message. You can continue to
work normally in the open WinCC Explorer.

Start Mode of the WinCC Explorer
Open project
When you start WinCC the first time, the WinCC Explorer is opened without a project.
Whenever you start WinCC again, the last project you had open will be opened again.
With the key combination <SHIFT> + <ALT>, you can prevent WinCC from opening a project
immediately. Press the <SHIFT> key and the <ALT> key while WinCC is opening. Keep the
keys pressed until the window of the WinCC Explorer is displayed. The WinCC Explorer opens
without opening a project.
Activated Project
If the project was activated when you exited WinCC Runtime, it will be opened in Runtime
again when you restart WinCC.
If you close a project and open another project that was opened the last time in the activated
state, WinCC once again opens the project in Runtime.

36

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Projects
1.2 Opening WinCC Explorer
With the key combination <SHIFT> + <CTRL>, you can prevent WinCC activating Runtime
immediately. Press the <SHIFT> key and the <CTRL> key while WinCC is opening. Keep the
keys pressed until the project is open and displayed fully in the WinCC Explorer. WinCC opens
the last project without starting Runtime.

Opening WinCC Explorer
Windows Start Menu
You can open the WinCC Explorer from the Windows Start menu. Select the entry "WinCC
Explorer" in the "SIMATIC" > "WinCC" folder. WinCC Explorer is opened.
Windows Explorer
You can start WinCC with the WinCCExplorer.exe start file. The WinCCExplorer.exe file can
be found in the Windows Explorer in your installation path in WinCC\bin.
Windows Desktop
You can create a shortcut for the WinCCExplorer.exe file. You then place this shortcut on the
desktop of the computer.
Opening a Project in the Windows Explorer
You can start WinCC by opening a WinCC project in the Windows Explorer. Open the
<PROJECT>.MCP file in the installation path of the project.
You can only start a project from the Windows Explorer when WinCC has not yet started.
Autostart
You can also start WinCC using Autostart when the computer starts up. Create a shortcut to
the WinCCExplorer.exe file and move this shortcut to the Autostart folder of your computer.
Each time you start the Windows system, WinCC will also be started automatically.
Opening the WinCC Explorer with a Project Open
You can close the WinCC Explorer without closing the open project. You can reopen the WinCC
Explorer from the Windows Start menu or by clicking a shortcut on the desktop. This also
applies even if you open a project using Autostart only in Runtime.

Remote WinCC Startup
You can start WinCC of another computer in the network. You find more detailed information
in the WinCC Information System under Configurations > Multi-User Systems > Remote
Configuration.

Open project
File > Open
In the WinCC Explorer, you open a project with the Open command in the File menu. In the
Open window, select the project folder and open the <PROJECT>.MCP project file.
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File > Last File
In the File menu, you can open one of the last files opened with the Last File command. Up to
eight projects are displayed.
"Open" Button
You can open a project with the

button in the toolbar.

Opening a Project with Autostart
You can open a specific project using Autostart when your computer starts up. To do this, use
the Autostart tool of WinCC.
Note
If you open a project while another project is active in Runtime, Runtime is deactivated and
the previously active project is closed.
Note
WinCC project file cannot be opened
Lock mechanisms in WinCC prevent projects from being opened during a long-lasting
process.
A lock mechanism takes effect each time a WinCC project is opened. The
"ProjectOpened.Ick" text file is created in the project folder.
A second lock mechanism takes effect in the following situation:
● An OS is downloaded in SIMATIC Manager
● A WinCC project is duplicated using Project Duplicator
The "wincc.lck" text file is created in the project folder.
The opening lock is retained if termination of this process was prevented, for example,
because a program was aborted, or the PC was restarted. The project folder contains the
"ProjectOpened.Ick" and "wincc.lck" text files with a readable process ID.
If all processes are completed, you can delete the "ProjectOpened.Ick" and "wincc.lck" files.

See also
Editors and Functions in WinCC Explorer (Page 185)
How to Start Runtime (Page 170)
Closing WinCC Explorer (Page 39)
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1.3

Closing WinCC Explorer

Introduction
When you close the WinCC Explorer, you normally close the project that was last open at the
same time.
If Runtime is activated, or if you have opened a WinCC editor, you can close the WinCC
Explorer separately. The project remains open and active if it was already active. Open editors
are not closed. You can open the WinCC Explorer again from the Windows Start menu or from
a shortcut on the desktop.
You can close the WinCC Explorer regardless of whether a project is open. The relevant
WinCC processes continue to run in the background. When you open the WinCC Explorer
again, WinCC does not need to reload the project data and the Explorer takes less time to
open.

General procedure
You can exit WinCC in the following ways:
● With the Exit command in the WinCC Explorer menu bar
● With the Shut Down command in the WinCC Explorer menu bar
● With the Close button
● When you shut down Windows
● With a C action in the activated project
Note
After starting, WinCC always opens the last project that was open before you exited. If
the project was activated when you exited WinCC, it will be opened in Runtime again.

Closing WinCC Explorer
File > Exit
Close the WinCC Explorer with the Exit command in the File menu. The Exit WinCC Explorer
dialog box is opened.
In the list box, you can select one of the following options:
Selection

WinCC Action

Close project and exit WinCC
Explorer

If active, the project is also deactivated and closed. The WinCC
Explorer and all open WinCC editors are closed.

Exit WinCC Explorer

Only the WinCC Explorer closes. The project remains open and
active if it was already active. WinCC editors remain open.
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File > Shut Down
In the File menu of the menu bar, select the Shut Down command. Depending on your
computer configuration, you can exit WinCC with Shut Down and at the same time shut down
the computer.
Close Button
You can close the WinCC Explorer with the

button in the top right corner of the window.

Exiting Windows
When you exit Windows or log off the current user, WinCC closes completely.
C Action in the Activated Project
You can, for example, configure a button in the project with which you can exit WinCC or
Windows. To do this, use the Exit WinCC or Exit WinCC or Windows dynamic wizards.

See also
How to Exit Runtime (Page 174)
Opening WinCC Explorer (Page 36)
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1.4

The WinCC Explorer

1.4.1

The WinCC Explorer

Introduction
When you start WinCC, the WinCC Explorer is opened. With the WinCC Explorer, you can
● Create a project
● Open a project
● Manage project data and archives
● Open editors
● Activate or deactivate a project.

See also
Activating Project (Page 170)
Editors and Functions in WinCC Explorer (Page 185)
Closing WinCC Explorer (Page 39)
Opening WinCC Explorer (Page 36)

1.4.2

Windows of the WinCC Explorer

Introduction
In the WinCC Explorer, you work in the navigation window and in the data window.
In these windows, you can open the context-sensitive help for each element with the right
mouse button. If a project is active in Runtime, a tooltip is available for elements of the tag
management in the data window.
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①
②
③
④
⑤
⑥

Menu bar
Toolbar
Navigation window
Tooltip
Data Window
Status bar

Navigation window
The navigation window contains the list of editors and functions in the WinCC Explorer. You
can open an element in the navigation window by double-clicking it or using the shortcut menu.
You open the shortcut menu with the right mouse button. The Open command is displayed.
Additional commands for selection are displayed depending on the element.
For the editors Graphics Designer and Report Designer > Layouts you can show the
Information column of the data window using the Display Column Information option. The entry
in this column shows how the corresponding object was created.
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Method of Creating the Object

Entry in the Information column

Object has been created using WinCC Explorer.

<No entry>

Object has been created using WinCC Explorer
and then imported to SIMATIC Manager using the
Import WinCC Objects function.

Created by SIMATIC Manager

Object has been created using SIMATIC Manager. Created by SIMATIC Manager

If you click the plus character in front of the Tag Management or Structure Tag entries, you
expand the folder tree. In these folders, you can navigate, create, or move objects.
The Graphics Designer and Global Script editors also have subdirectories. If you click one of
these editors, WinCC displays these directories. The Report Designer contains the two folders
Layouts and Print Job. Global Script contains the two folders Actions and Standard Functions.
For more detailed information on the editors, refer to the relevant sections of the WinCC
Information System.

Data Window
If you click an Editor or a folder in the navigation window, the data window displays the elements
belonging to the editor or folder. The information displayed varies from editor to editor.
Double-click an element in the data window to open it. Depending on the element, WinCC
performs one of the following actions:
● Opens an object in the appropriate editor.
● Opens the Properties dialog of an object.
● Displays the next level of a folder path.
Right-click an element to call up the shortcut menu where you can select the Properties dialog
of the element. With some editors, other commands are displayed that you can select.
You can rename the elements in the data window with the <F2> key or by clicking the selected
name.

Tooltips
If Runtime is activated, WinCC displays information on tags and connections in the form of a
tooltip. For more detailed information, refer to the WinCC Information System under Working
with Tags.

See also
Editors and Functions in WinCC Explorer (Page 185)
Status Bar and Title Bar of WinCC Explorer (Page 48)
Toolbar of the WinCC Explorer (Page 47)
Menu Bar of the WinCC Explorer (Page 44)
Search Function (Page 49)
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1.4.3

Menu Bar of the WinCC Explorer

Introduction
The menu bar of the WinCC Explorer includes most of the commands that you can use in the
Windows Explorer. Commands that you cannot use in the current situation are disabled
(displayed in gray).
Some commands are available only when you open the Shortcut menu of an element in a
window.
Some commands can be activated using the key combinations (shortcut keys) familiar from
Windows.
The following tables provide brief information on the commands in the menu bar. The Online
Help (section) column indicates the relevant sections in the WinCC Information System that
contain more detailed information.

File Menu
The File menu includes the following commands:
Command

Key combination

Function

Online help (section)

New

<CTRL+N>

Creates a new project.

Working with Projects >
Creating and Editing Projects

Open

<CTRL+O>

Opens an existing project.

Working with Projects >
Creating and Editing Projects

Close

---

Closes an open project.

Working with Projects >
Creating and Editing Projects

Activate

---

Starts an open project in Runtime.

Working with Projects >
Activate project

Print Project
Documentation

---

Prints the project documentation.

Documentation of
Configuration and Runtime
Data > Project Documentation

View Project
Documentation

---

Starts the print preview of the project
documentation.

Documentation of
Configuration and Runtime
Data > Project Documentation

Project Documentation
- Setup

---

Sets up the project documentation for
printing.

Documentation of
Configuration and Runtime
Data > Project Documentation

Recent File

---

Displays the most recently opened projects
up to a maximum of eight. You can select
one of the projects and open it.

Working with Projects >
Creating and Editing Projects

Exit

<ALT+F4>

Opens a dialog in which you can close the
WinCC Explorer.

Working with projects >
Closing the WinCC Explorer

Shut Down

---

Exits WinCC and shuts down the computer. Working with projects >
Closing the WinCC Explorer
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Edit Menu
The Edit menu includes the following commands:
Command

Key combination

Function

Online help (section)

Undo

<CTRL+Z>

Undoes the last action. This command is not
available for all actions.

---

Cut

<CTRL+X>

Cuts the selected object. With Paste, the object
can be moved to another location.

---

Copy

<CTRL+C>

Copies the selected object to the clipboard.

---

Paste

<CTRL+V>

Pastes a copied or cut object.

---

Delete

<DEL>

Deletes a selected element.

---

Properties

---

Displays the Properties dialog of a selected
element.

Refer to the description of the
relevant editor.

View Menu
The View menu includes the following commands:
Command

Key combination

Function

Online help (section)

Toolbars

---

Displays or hides the toolbar.

Working with Projects > The
WinCC Explorer

Status bar

---

Displays or hides the status bar.

Working with Projects > The
WinCC Explorer

Large Symbols ---

Displays the elements in the data window as
large symbols.

---

Small Symbols ---

Displays the elements in the data window as
small symbols.

---

List

---

Displays the elements in the data window as a
list of names.

---

Details

---

Displays the elements in the data window as a
list of names with additional information, for
example date modified and file type.

Refer to the description of the
relevant editor.

Refresh

<F5>

Refreshes the view in the data window.

---

Tools Menu
The Tools menu includes the following commands:
Command

Key combination

Function

Online help (section)

Language

---

Changes the user interface language of the
WinCC Explorer and editors.

Structure of Multi-language
Projects > Language Support in
WinCC

Converting
Project Data

---

Converts pictures and scripts from projects that
were created with previous versions.

Create Process Pictures > The
Graphics Designer in WinCC
Explorer
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Command

Key combination

Function

Online help (section)

Status of
Driver
Connections

---

Displays the status of logical connections in the
project.

Communication Diagnostics>
Channel Diagnostics

Status of
Server
Connections

---

Displays the communication in a multi-user
system in the WinCC client or in the WinCC
server for a server-server communication.

Working with Projects > The
WinCC Explorer

Green = Connection status: Established, data
communication active.
The communication between the computers
and not the redundancy status is displayed
here. Multiple green symbols do not mean
multiple master servers.
Gray = Connection status: Established, no data
exchange.
Red = Connection status: Disconnected.
? = Status unknown.
Status of
Client
Connections

---

Working with Projects > The
WinCC Explorer

Displays the current status of all servers and
clients involved in a WinCC server.
Green = Connection status: Established, data
communication active.
The communication between the computers
and not the redundancy status is displayed
here. Multiple green symbols do not mean
multiple master servers.
Gray = Connection status: Established, no data
exchange.
Red = Connection status: Disconnected.
? = Status unknown.

Help Menu
The Help menu includes the following commands:
Command

Key combination

Function

Online help (section)

Contents
and Index

<F1>

Opens the WinCC information system.

---

Direct Help

<SHIFT+F1>

Activates the direct help (What's this?).

---

Use Help

---

Tips on working with help.

---

About
WinCC
Explorer

---

Displays the installed version and the installed
components of WinCC.

---
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See also
Editors and Functions in WinCC Explorer (Page 185)
Activating Project (Page 170)
Closing WinCC Explorer (Page 39)
Opening WinCC Explorer (Page 36)
Windows of the WinCC Explorer (Page 41)
Status Bar and Title Bar of WinCC Explorer (Page 48)
Toolbar of the WinCC Explorer (Page 47)

1.4.4

Toolbar of the WinCC Explorer

Introduction
Using the buttons in the toolbar, you can activate commands. You can also hide the toolbar
in the WinCC Explorer by selecting the View menu in the menu bar and clicking the Toolbar
command.

Buttons in the Toolbar

The toolbar in the WinCC Explorer contains buttons with the following functions:
Icon

Tooltip

Description

New

Creates a new project.

Open

Opens a project.

Deactivate

Exits Runtime.

Activate

Starts the project in Runtime.

Cut

Cuts a selected object. The object is deleted at its original location as soon
as it is pasted elsewhere.

Copy

Copies an object to the clipboard. The object can be duplicated at the same
location or a comparable location in the path.

Paste

Pastes a cut or copied object.

Large
Symbols

Elements in the data window are displayed as large symbols.

Small
Symbols

Elements in the data window are displayed as small symbols.

List

Elements in the data window are displayed as a list of names only.

Details

Elements in the data window are displayed as a list with detailed information.
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Icon

Tooltip

Description

Properties

Opens the Properties dialog of an element.

Help

Activates the direct help for an element you then left click.

For more information on the commands, refer to chapter Menu Bar.

See also
Activating Project (Page 170)
Opening WinCC Explorer (Page 36)
Windows of the WinCC Explorer (Page 41)
Status Bar and Title Bar of WinCC Explorer (Page 48)
Menu Bar of the WinCC Explorer (Page 44)

1.4.5

Status Bar and Title Bar of WinCC Explorer

Introduction
The status bar and title bar contain general information on the project and settings in the editor.

Title bar
The current path of the open WinCC project is displayed.

Status bar

48

Field

Description

Status

Displays tips on editing and displays the current path of a file.

Number of configured tags /
Number of power tags

Number of configured external tags / Number of tags covered by
a license.
The number of tags and licenses is displayed in WinCC Explorer
only when you select tag management and the structure types.

Object(s)

Number of objects of the selected editor, for example, the number
of pictures with the Graphics Designer.
The number of tags and licenses is displayed in WinCC Explorer
when you select tag management and the structure types.

CAPS

SHIFT function is active (upper case).
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Field

Description

NUM

The numeric pad on the right of the keyboard is active.

SCRL

The Windows Scroll function is active.

See also
Windows of the WinCC Explorer (Page 41)
Toolbar of the WinCC Explorer (Page 47)
Menu Bar of the WinCC Explorer (Page 44)

1.4.6

Search Function

Starting the Search Function
You can start a search in the navigation window and in the data window of the WinCC Explorer.
by selecting the Find... command in the shortcut menu of the project, the computer, or the tag
management. The Find dialog opens.

Searchable elements
You can search for the following elements in a project:
● Client computers
● Server computers
● Driver connections
WinCC: Working with WinCC
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● Channel units
● Connections
● Tag groups
● Tags
You can restrict the search to individual element types. Select the required element type on
the Additional Options tab in the Type list box. In the Parameter Text field, you can specify an
individual parameter as an additional search criterion.

Searching by Name
On the Name tab, you can enter the name of the required element in the Find What list box.
If you have made several searches, you can display the list of terms you have searched for in
the Find What list box.
The entries you make for searches are not case-sensitive.
Wildcard
The "*" character can be used as a wildcard. This replaces any number of characters at the
beginning or end of the name.
If you enter "var*", all elements whose names start with "var", are displayed, e.g.
● "Variable_2" tag,
● "variablegroup_tank" tag group,
● a computer with the name "VAR0516".
In the same way, you could enter "*tank" to search for all elements whose name ends with
"tank".

Searching by Date
In the Date of Change tab, you can search for elements created or modified during a specific
period.

Starting and Stopping a Search
Once you have specified all options for the search, start the search with the Start button. Click
the Stop button if you want to stop the search.
If you double-click an object that has been found, you change to the path in which this object
is located in the WinCC Explorer.
To delete all search information you have entered, click the New Search button. You can then
formulate a new search.
To close the "Search" window, click the
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See also
Editors and Functions in WinCC Explorer (Page 185)
Windows of the WinCC Explorer (Page 41)
Status Bar and Title Bar of WinCC Explorer (Page 48)
Toolbar of the WinCC Explorer (Page 47)
Menu Bar of the WinCC Explorer (Page 44)
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1.5

The WinCC Configuration Studio

1.5.1

Introduction

Introduction
WinCC Configuration Studio provides a simple and efficient means of configuring bulk data
for WinCC projects. The user interface is divided into two areas: a navigation area similar to
Microsoft Outlook and a data area similar to Microsoft Excel. This setup lets you configure bulk
data for a WinCC project, while taking operational benefits that you already from spreadsheet
programs. The WinCC Configuration Studio replaces the previous procedure for the following
editors and functions:
● Tag management
● Tag Logging
● Alarm Logging
● Text Library
● User Administrator
● Horn
● User Archive
This chapter will provide you with an overview of the functionality and operation of
WinCC Configuration Studio.

1.5.2

System requirements

Introduction
System requirements for WinCC Configuration Studio are the same as for WinCC. Since
WinCC Configuration Studio is an integral component of the WinCC configuration system, you
cannot use WinCC Configuration Studio without WinCC.

Compatibility
WinCC Configuration Studio is compatible with all WinCC versions 7.2 and higher.
Note
WinCC Configuration Studio is an integral component of the WinCC configuration system.
Separate Installation is not possible.
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1.5.3

Interface

Introduction
The user interface consists of a navigation area and a data area with tables. More information
about the user interface is provided in the following chapters.

Introduction
The user interface consists of a navigation area with navigation bar, the data area with tables
and the "Properties" area.

①
②
③
④
⑤
⑥
⑦

Menu bar
Fast search in data area
Navigation area
Data area
"Properties" window
Navigation bar
Information bar with information on the status of the editor, selected input language, and number of data records in
the data area.

Menu bar
With the menu bar, you can activate the following functions:
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● "File > Exit": Exit Configuration Studio.
● "Edit > Copy": Copy selected data.
● "Edit > Paste": Paste previously copied data.
Additional information on copying and pasting data is available under Copying and pasting
in the data area (Page 73).
● "Edit > Import": Import data records
Additional information on importing data records is available under Importing data records
(Page 74).
● "Edit > Export": Export data records
Additional information on importing data records is available under Exporting data records
(Page 74).
● "View > Input language": Switch the input language. You are offered all languages available
on your system in a selection menu.
Additional information on configuring multilingual projects is available under Language
support in WinCC (Page 2110).
● "View > Color scheme": Change the color scheme of the Configuration Studio.
● "? > Contents and Index": Call the online help
● "? > Info about WinCC Configuration Studio": Information on version and system.
Fast search in data area
Use the "Search (Find)" field to look for entries in the data area. If one or more fields were
selected in the data area, the search is limited to the selected fields. For additional information
on fast search, refer to Fast search in data area (Page 67).
Navigation area
The objects of the selected editor or the selected function are displayed in the navigation area
as tree view. The structure of the tree view includes all elements that are displayed in the data
area.
For information on operating the navigation area, see How to operate the navigation area
(Page 55).
Data area
The data area consists of a table view that you will be familiar with from spreadsheet programs.
The data records of the selected editor or the selected function are configured in the data area.
For information on operating the data area, see How to operate the data area (Page 58).
"Properties" window
The data records of the selected editor or the selected function can be edited in the "Properties"
window. Details on operation of the "Properties" window are described in the corresponding
sections of the respective editors or functions.

See also
Fast search in data area (Page 67)
Importing data records (Page 74)
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Exporting data records (Page 74)
Copying and pasting in the data area (Page 73)
How to operate the navigation area (Page 55)
How to operate the data area (Page 58)
Language support in WinCC (Page 2110)

1.5.4

How to operate the navigation area

1.5.4.1

Operating the navigation area

Introduction
You access the navigation area of an editor or a function with the navigation bar.
The navigation area displays the tree view of the selected editor or the selected function. Select
an element from the tree view in the navigation area to display the corresponding data records
in the data area.

Navigation bar
You can access all available editors and functions by means of buttons in the navigation bar.

You access hidden buttons with a mouse click on the corresponding symbol in the bottom part
of the navigation bar.
Symbol

Editor/Function
Tag management
Alarm Logging
Tag Logging
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Symbol

Editor/Function
Text Library
User Administrator
Horn
User Archive

Showing or hiding buttons in the navigation bar
You use the drop-down menu in the bottom part of the navigation bar to show or hide buttons
in the navigation bar.
1. Click on the symbol for the drop-down menu.

The drop-down menu opens.
2. Select "Show additional buttons" to show buttons.
Or:
Select "Show fewer buttons" to hide buttons.

Opening an editor
Click the required editor in the navigation bar or select "Open" from the shortcut menu.

Opening individual editors
To open a required editor in a new window, open the shortcut menu of the editor in the
navigation bar.
1. Right-click on the required editor in the navigation bar.
2. Select "Open in new window" in the shortcut menu.
The editor opens in a new window.

Releasing the editor
You must release the editor after finishing your work so that other users can work with the
editor in a project.
1. Right-click on the editor in the navigation bar.
2. Select "Release" in the shortcut menu.
The editor is released. Other users can now edit the data in the project.
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Tree view

Select all data records
Select the top element from the tree view ( for example ""Tag Management") to display all
configured data records of the editor or the function in the data area.
Show structured data records
The structured display of the data records in the tree structure depends on the selected editor.

1.5.4.2

Copying, pasting and deleting data in the navigation area

Introduction
You can copy, paste, and delete elements in the tree view of the navigation area.

Procedure
Copying and pasting an element in the tree view
1. You can copy the element to the clipboard by selecting it from the tree view and clicking
"Copy" in the shortcut menu.
Alternative procedure: Select the element and then press the <CTRL + C> keystroke
2. You paste the element to the corresponding position by selecting the element below the
paste position and clicking "Paste" in the shortcut menu.
Alternative procedure: Select the element below the paste position and then press <CTRL +
V>.
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Deleting elements from the tree view
1. Select the element to delete in the tree view and then click "Delete" in the shortcut menu
to delete it.
Alternative procedure: Select the element to delete in the tree view and press the <DEL>
key.

1.5.5

How to operate the data area

Operator controls in the data area

Number

58

①
②
③
④

Name

Description

"Mark all" button

Click this button to select all displayed data records in the data area.

Title bar of the data area

Indicates the directory that stored the displayed data records.

Column headers

The data records are sorted in the data area by information type, e.g. name or data
type. You can sort/filter the data records based on this information and hide/show
selected columns.

Line number

Consecutive numbering of the lines.
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1.5.5.1

Operating the data area

Introduction
The following options are available in the data area:
● Entering and changing data in the respective editors
● Configuring structure types
● Filtering, finding, copying and importing data records
Note
All inputs and changes in the data area become effective without saving and have an
immediate effect in Runtime.

Cell types in the data area
The data area contains two cell types:
● Cells for text input (or text display)
● Cells with check box input (or check box display)
Cells can be edited, or are read only. There are two types of read only cells:
● Cull write protection (e.g. ID, last change, etc.)
● Context-dependent write protection (e.g. address of internal tags)
Text input cells can be distinguished based on their data type and available input options.

Data input options
You can enter data in the data area in three different ways:
● Input in the text field
● Drop-down list
● Automatic continuation ("drag-down")
An additional input dialog is provided for cells of the "Address" column, see Data input help by
means of dialog.
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1.5.5.2

Data entry in the data area

Entering data in the text field
Introduction
You can use the text field to enter data in the data area. Several data types are available for
the text fields:
Data type

Valid entries

Text

All entries, except line break

Multi-line text

All entries

Unsigned integer

Numerical input only

Signed integer

Input of numbers and characters "+" and "–"

Floating-point number

Input of numbers, characters "+" and "–", decimal
point, and the "e" or "E" character for exponential
notation

Input restrictions
● WinCC DataGridControl validate compliance with data input restrictions and rejects
incorrect entries. Users are informed accordingly by means of tool tip.
● Specific cells are subject to additional input restrictions on character basis. Data typedependent limitations are checked by the WinCC DataGridControl at the time data is
entered; invalid entries are rejected. Users are informed accordingly by means of tool tip.

Procedure
1. Select the table cell for text input.
2. Enter the text in the cell.

Data entry via drop-down list
Introduction
You can select the cell data from a drop-down list. A drop-down list is offered for the following
columns:
● Data type
● Format change
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● Connection
● Group

Procedure
1. Select a table cell
2. Click the icon

to open the drop-down list.

3. Select the entry from the drop-down list.

Note
The drop-down list content may be context-specific.
Example: Only the groups that are available for the set connection will be available.

Automatic continuation ("drag-down")
Introduction
You can drag the small fill box to selected cells to accelerate the filling of cells with data sets.
Position the mouse pointer over the bottom right corner of a table cell. Transformation of the
mouse pointer indicates that automatic continuation is available.

Note
● Automatic continuation is only possible for cells below the pointer position.
● Automatic continuation only completes text in the table cells if these text are already
contain numerical values.
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Procedure
1. Select the table cells for continuation.
2. Drag the small fill box over the cells to be filled automatically and then release the mouse
button.
The table cells will be filled automatically with corresponding values.

Assisted data entry by means of dialog
Introduction
An input dialog is provided for the cells in the "Address" table column.
Note
The settings you can make are determined by the communication driver used for the
respective connection. For more information about the optional connection settings, refer to
the documentation of the communication driver.
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Procedure
1. Select the cell from the table column.
2. Set the values in the input dialog.
3. Click the "OK" button to confirm your entries.

1.5.5.3

Filtering in the data area

Filtering in the data area
Introduction
A filter can be set for each column of the data area. The filter criterion is set using the shortcut
menu of the respective table column.
Note
The filter functions are not case sensitive with respect to the cell contents.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
You have the following options for setting the filter criterion:
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● Filtering using the filter list box
● Filtering using the text filter

Filtering using the filter list box
Introduction
The filter list box is one means of setting the filter criterion. The filter list box lists all cell contents
of the respective table column.

Procedure
1. Right-click the column header to open the shortcut menu.
2. Click "Filter".

3. Select the filter criteria for the table column by activating the corresponding check boxes.

4. Click "OK" to confirm your entries.

Filtering by means of text filter
Introduction
The shortcut menu of the text filter provides additional options for setting filter criteria for
columns with .
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Procedure
1. Right-click a column header and select the "Filter" shortcut menu command.
2. Select the "Text filter" entry.
3. The submenu provides the following options:

Filter option

Description

Matches...

Use this filter option to filter column entries by text
elements that match or mismatch the criterion.

Mismatches...
Begins with...
Ends with...
Contains...
Does not contain...

Use this filter option to filter column entries by text
elements that match or mismatch the start or end
criterion
Use this filter option to filter column entries by text
elements that match or mismatch the content
criterion.

User-defined filter...

4. Select the option and enter the corresponding text elements in the next dialog.
5. Click "OK" to confirm your entries und to run the filter.

Filtering by means of number filter
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter option

Description

Equal to...

You may use this filter option to to synchronize the
column entries with defined values.

Unequal to...
Greater than...
Greater than or equal to...
Less than...

Use this option to filter out column entries that
match or mismatch the greater than/less than
value criterion.

Less than or unequal to..
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

Filtering by date
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter options

Description

Equivalent to...

Use this filter option to display all entries made on
a specific date.

Before...

Use this filter option to display all entries made
before or after a specific date.

After...
Today
Yesterday

Use this filter option to display all entries made
today, yesterday, or last week.

This week
Last week
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

1.5.5.4

Fast search in data area

Introduction
You can run a fast search of data records in the "Name" column. Matches are highlighted in
color while you are entering the search text, while mismatching data records are hidden.
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Performing the fast search
Note
The fast search function is only used to scan data records in the "Name" table column.
Note
Search text input is not case sensitive.
1. Click in the search box in the title bar of the data area.

2. Enter a search term.
Data records that mismatch your entry are hidden in the data area. Matches are highlighted
in color.
3. Select the data record.
4. You can return to the normal view of the data area by deleting the entry and clicking the
icon in the search box.

Refining the fast search
You can refine the fast search using the following search options:

Search option

Description

Matches search text

This search option returns data records that match the search
text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option returns data records that contain the
search text at any position.
This search option is set by default.
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1. Open the search option by means of the

drop-down menu.

2. Left click the search option to select it.
3. Enter a search string.
The hitlist will be displayed.

1.5.5.5

Selecting cells, areas, rows and columns
You can select cells, areas, rows, columns or all data in the data area in order to, for example,
copy the selected data or paste contents. Specific applications are described in the
documentation of the corresponding editors.

Selection

Action

One individual cell

Select the cell with a mouse click or use the arrow keys to get
to the respective cell.

One cell area

Select the first cell of the area and drag the mouse pointer to
the last cell while pressing the mouse button, or hold down
the Shift key while pressing the arrow buttons to expand the
selection.

One large cell area

Select the first cell of the area and keep the Shift key pressed
while selecting the last cell of the area. You can scroll down
to make the last cell visible.

All cells in the data area

Click the "Select All" button.

You can also select one cell in the data area and press <Ctrl
+ A>.
Cells that are not next to each other

Select the first cell and keep the <Ctrl> key pressed while
selecting additional cells.

Columns

Click the column header with the mouse button. To select
additional columns, keep the <Ctrl> key pressed while
clicking additional column headers.

Lines

Click the line number with the mouse button. To select
additional lines, keep the <Ctrl> key pressed while clicking
additional line numbers.

1.5.5.6

Search and replace in the data area

Introduction
You can find and replace text in the data records managed in Configuration Studio. You may
also continue in the data area while the "Find and Replace" dialog is open.
You can refine your search using the following search options:
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Search option

Description

Matches search text

This search option only returns data records that match the
search text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option only returns data records that contain the
search text at any position.
This search option is set by default.

Procedure
Note
The current selection in the data area specifies the location for the search and/ or replace
operation:
● Select any cell to run the search in all data records.
● Select all cells of this area to find a specific area.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
Text search
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + F> key combination.
The "Find and Replace" dialog opens with the selected "Find" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Select a search option in the "Search result" field to refine your search.
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5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.

Finding and replacing text.
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + H> key combination.
The "Find and Replace" dialog opens with the selected "Replace" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Enter the string that is to replace the search result in the "Replace with" field.
Leave the "Replace with" blank if you only want to delete the string defined in the "Find
what" field,
5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.
7. Click "Replace" to replace only the marked match.
Note
A click on "Replace all" replaces all matches without the output of further messages.
8. Click "Replace all" to replace all matches.
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1.5.5.7

Sorting in the data area

Introduction
You can sort text in one or several columns by text (characters A to Z, or Z to A), by numbers
(ascending or descending), or by data and time (oldest to most recent, or most recent to oldest).
The sorting order is inherited by all nodes in the tree view. You can modify or cancel sorting
orders.
Numerical values are treated separately in the sorting order. This ensures that the numeral 1
is followed by the numeral 2, and not the numeral 10, in a sorted column.

Procedure
Sorting using the shortcut menu of the table column
1. Right-click the table header of the column to be sorted.
2. Select the sorting option from the shortcut menu.
– Ascending sorting order
– Descending sorting order

Sorting using the table header
1. The data records are sorted in ascending order with double-click on a column header.
The column representing the sorting order origin is marked by an icon next to the column
header .

X

2. Click the column header once again to set the ascending sorting order.

72

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Projects
1.5 The WinCC Configuration Studio

Note
● Press "CTRL" when double-clicking to include multiple columns in the sorting operation.
The sorting order is indicated by a number in the table header of the column. The sorting
order number is only displayed if more than one column is sorted.

1.5.5.8

Copying and pasting in the data area

Introduction
In WinCC Configuration Studio, you can copy text from table cells and paste these to different
table cells. This lets you exchange data between WinCC Configuration Studio and other
programs such as text editors or spreadsheet programs. You may also copy and paste data
records within WinCC Configuration Studio.
Note
It is not possible to cut an entire table row from the data area.

Procedure
Copying and pasting in the data area
1. Select the data records to copy.
2. Select "Copy" from the shortcut menu, or press <CTRL+C>.
3. Click the position in the data area where you want to paste the data records.
4. Select "Paste" from the shortcut menu, or press <CTRL+V>.
Copying and pasting in external applications
1. Select the data records to copy to the external application and then select "Copy" from the
shortcut menu, or press <CTRL + C>.
2. Open the external application where you want to paste the data records.
3. Click the position in the external application area where you want to paste the data records.
4. Use the commands of the external application to paste the data records from the clipboard.

1.5.5.9

Undoing an action
You can undo entries and changes in the data area with the <Ctrl + Z> shortcut.
Note
Certain actions cannot be undone. These exceptions are described in the respective editors.
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1.5.5.10

Importing data records

Introduction
You can import data records from third-party applications or other WinCC projects in the
WinCC Configuration Studio. These data records must be available in "Office Open XML
Workbook" format. Files of this format have the ".xlsx" extension and can be opened and edited
in spreadsheet programs.
Note
You cannot undo the import of data records.

Requirements
● The data records you load may not be in use by any other application.
● The connections contained in the data records must be available by their name in
WinCC Configuration Studio.

Procedure
1. Select the required editor in the navigation area.
2. Select "Import" from the shortcut menu of the editor.
The "Select file" dialog opens.
3. Select the file to import.
The data records will be loaded. A progress bar is displayed.

1.5.5.11

Exporting data records
You can either export all data records of a node selected in the navigation area during export
or only export the data records selected in the data area.
Exporting all data records of the node
1. Select the required node in the navigation area.
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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Exporting selected data records
1. Select the required data records in the data area.
For selection options, see Selecting cells, areas, rows and columns (Page 69).
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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1.6

Project Types

1.6.1

Single-User Project

Introduction
If you only want to work with one computer in a WinCC project, create a single-user project.
The WinCC project runs on one computer that functions as the server for processing the data
and as an operator input station. Other computers cannot access the project.

General procedure
The computer on which you create the single-user project is configured as a server.
The computer is connected to the programmable controller via the process communication.

Redundancy
You can also create a single-user project as a redundant system. In this case, you configure
a single-user project with a second redundant server.

Archive Server
You can also create an archive server for a single-user project. In this case, you configure a
single-user project and a second server on which the data of the single-user project is archived.

See also
Multi-User Project (Page 76)

1.6.2

Multi-User Project

Introduction
If you only want to work with several computers in a WinCC project, create a multi-user project.
For a multi-user system, there are two basic options:
● Multi-user system with one or more servers:
Several servers with one or more clients. One client accesses several servers. The Runtime
data is distributed on different servers. The configuration data is on the servers and on the
clients.
● Multi-user system with only one server:
One server with one or more clients. All data is on the server.
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General procedure
You create a multi-user project on the server. The server is connected to the programmable
controller via the process communication.
In the multi-user project, you configure the clients that access the server. In a second step,
you create the required client projects on the relevant computers.
If you want to work with several servers, duplicate the multi-user project on the second server.
Adapt the duplicated project accordingly. You can also create a second multi-user project on
the second server that is independent of the project on the first server.
A server can also access another server in the role of client. You can use this option, for
example, when you use an archive server or a file server.

See also
Single-User Project (Page 76)
Client Project (Page 77)

1.6.3

Client Project

Introduction
If you create a multi-user project, you must then create the clients that access the server. You
create a client program on the computer that will be used as a client.
For a WinCC client, there are two basic options:
● Multi-user system with one or more servers:
The client accesses several servers. The Runtime data is distributed on different servers.
The configuration data on the multi-user projects is on the relevant servers. There may be
local configuration data in the client projects on the clients: Pictures, scripts and tags.
● Multi-user system with only one server:
The client only attempts to access one specific server. All data is located on the server and
is referenced on the clients.
An archive server or a file server can also access another server in the role of client.
Note
The WinCC client replaces the clients and multi-clients that were used in WinCC up to version
V5.1. Depending on the configuration, a WinCC client takes over the role of a V5.1 client or
a V5.1 multi-client.
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General procedure
You create a multi-user project on the server. The server is connected to the programmable
controller via the process communication. In the multi-user project, you create the clients that
access the server.
If you configure a multi-user system with only one server, you do not create a separate client
project on the WinCC client.
If you configure a multi-user system with several servers, you must create a separate client
project on each client. This also applies when you only want to access one server but require
additional configuration data on the client.

Multi-User System with One or More Servers
To access more than one server, you create a client project on the client. You specify the
project properties on the WinCC client.
On the server, you create packages using the Serverdata component. The packages contain
all important configuration data of the multi-user project. You load the packages on the WinCC
client.
You only need to create and compile the packages once manually. If the configuration data
on a server is modified, WinCC automatically generates the required packages. The packages
can be downloaded to the clients automatically or manually.

Central Server Configuration for a Multi-User System with One Server
If you want to configure a client that accesses only one server, specify all settings in the multiuser system on the server. When you edit the startup list of the client, you should only start
applications that are actually required on the client.
You do not create a separate project on the client. You start the server project using remote
access. You find more detailed information in the WinCC Information System under
Configurations > Multi-User Systems.

Web Client
You can configure a client that accesses the server over the intranet or over the Internet. If
you require this type of access, you create a Web client with the WinCC Web Navigator option.

See also
Multi-User Project (Page 76)
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1.6.4

Changing Project Type

1.6.4.1

How to Change a Single-User Project into a Multi-User Project

Introduction
You can change a project you created as a single-user project to a multi-user project.
This can, for example, be useful when you want to create and test an entire project before
running it in a multi-user system.

Procedure
1. Select the project name in the navigation window of the WinCC Explorer. Open the "Project
Properties" dialog in the shortcut menu.
2. Go to the General tab and select the Multi-User Project project type in the Type list box.
Click "OK" to confirm.
3. The "Change Project Type" dialog opens with the message: "The project type has been
changed. Do you want to delete the startup list?"
If you want to include the startup list in the modified project, select "No".
If you want to create a new startup list, select "Yes". After changing the project type, create
the startup list.
4. A dialog opens with the message: "The changes to the project type will take effect when
the project is closed and reopened on all computers on which the project is currently open."
Click "OK" to confirm.
5. Close the project in the WinCC Explorer and open it again. WinCC then accepts the
changed project type.
6. Create the required clients under the Computer component. Create the WinCC clients you
require and adapt the configuration.

See also
How to Change a Multi-User Project to a Single-User Project (Page 79)
How to Set Up a Startup List (Page 139)
Single-User Project (Page 76)
Multi-User Project (Page 76)

1.6.4.2

How to Change a Multi-User Project to a Single-User Project

Introduction
You can change a project you created as a multi-user project to a single-user project. The
clients you created are not included because only one computer is created in a single-user
project.
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This can, for example, be useful when you want to use an existing configuration for a new
project.

Procedure
1. Select the project name in the navigation window of the WinCC Explorer. Open the "Project
Properties" dialog in the shortcut menu.
2. Go to the General tab and select the "Single-User Project" project type in the Type list box.
Click "OK" to confirm.
3. The Project Properties dialog opens with the message: A change from a multi-user to a
single-user or client project will delete all configured client computers from the computer
list. Click OK to perform this change or Cancel to keep the multi-user project. Click "OK" to
confirm.
4. The "Change Project Type" dialog opens with the message: "The project type has been
changed. Do you want to delete the startup list?"
If you want to include the startup list in the modified project, select "No".
If you want to create a new startup list, select "Yes". After changing the project type, create
the startup list.
5. A dialog opens with the message: "The changes to the project type will take effect when
the project is closed and reopened on all computers on which the project is currently open."
Click "OK" to confirm.
6. Close the project in the WinCC Explorer and open it again. WinCC then accepts the
changed project type.
7. Adapt the computer properties and the configuration.

See also
How to Change a Single-User Project into a Multi-User Project (Page 79)
How to Set Up a Startup List (Page 139)
Single-User Project (Page 76)
Multi-User Project (Page 76)
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1.7

Creating and Editing Projects

1.7.1

Preparation to Create a Project

Introduction
You don't yet need detailed planning to create a WinCC project. To create the WinCC project
efficiently, you should nevertheless give some initial thought to the structure of the project.
Depending on the size of the planned project and number of configuration engineers involved,
it may be useful to make certain settings and decide on certain rules.
This chapter contains information on some of the elements in a project that you should specify
before you start the configuration work:
● Project Type
● Project Path
● Naming conventions
● Tag groups
● Picture Hierarchy
● Faceplate types
● Reusing project sections

Project Type
Before you start to plan your project, you should already know whether you require a singleuser system or multi-user system. If you are planning a project with WinCC clients or Web
clients, make sure you know the factors affecting performance.

Project Path
A WinCC project does not need to be created on the same partition on which you installed
WinCC. It is sometimes better to create a separate partition for a project. When you create a
partition, make sure you have adequate space for the anticipated amounts of data. If you
archive a lot of data, the WinCC project can take up several gigabytes of space.
A separate partition also ensures that the WinCC project and all data contained in it are not
lost if there is a system crash.
Note
WinCC projects should not be saved to compressed drives or directories.
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Naming Conventions
Using naming conventions can make it easier to handle large projects. You can increase the
clarity in your project particularly if you use conventions for naming tags, pictures, or functions
in your project. Note the restrictions applying to names outlined in chapter Illegal Characters.
Project name
Changing the name of a project once it has been created involves a number of steps. It is
advisable to decide on a suitable name before creating the project.
Tags
You can give tags a prefix that identifies the tag type or the connection assigned to the tag.
You could, for example, give all text tags the prefix "txt_" and internal tags the prefix "int_".
If you develop a company standard, the prefixes should be the same for all projects.
Pictures
You can specify prefixes for pictures, for example to identify plant pictures and system pictures.
If you create a large number of pictures, you can include continuous numbers in the picture
names.
Functions
With functions, it is useful to introduce a prefix for your company standard. This makes it clear
at a glance which functions are required for the standard.

Tag groups
To structure tags, you can create tag groups. In WinCC, you cannot nest groups but can only
create one level with tag groups.

Picture Hierarchy
If you want to reduce the configuration time, you should plan the picture hierarchy in your
project before you start the project. It is advisable to work out an overview of the pictures you
need to create. Using a basic picture and the tag prefix, you can structure navigation within
your project.

Faceplate types
You can configure, save and reuse individual objects or groups of objects as faceplate types
in different pictures as faceplate instances. Thus, you can avoid always recompiling and
configuring frequently used picture elements.

Reusable Project Sections
You can take various project sections from existing WinCC projects. These include pictures,
tags, functions, and actions.
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Standard project
If you do not want to repeatedly take data from an existing WinCC project, you should create
a standard project. In this project, you can configure basic project sections to suit your needs.
When you create a new WinCC project, you can simply copy the standard project and then
work with the copy. This saves you time during configuration.

See also
File Structure of a Project (Page 195)
Illegal Characters (Page 191)
Settings for Runtime (Page 137)

1.7.2

WinCC Project with "Basic Process Control"

Introduction
WinCC projects can be created and managed in PCS 7 within the framework of Totally
Integrated Automation. The result is connections between the configuration of operator
stations and automation systems with the WinCC configuration. You run the WinCC
configuration in the SIMATIC Manager and in the WinCC Explorer.
The WinCC Explorer with the "Basic Process Control" option offers various editors, many of
which you use intensively for configuring the operator station (OS). Much data in the WinCC
project is already assigned by the configuration of the engineering station (ES). If necessary,
you can configure the configuration using the editors of the WinCC Explorer.

Requirement
● The "Basic Process Control" option must be installed on all computers in a WinCC project
with multiple computers.

Overview of Basic Process Control in a WinCC Project
The following editors of Basic Process Control determine the appearance and behavior of the
operator station:
● OS Project Editor
● Time Synchronization
● Lifebeat monitoring
● Horn
● Picture Tree Manager
● Component List Editor
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OS Project Editor - Configuration of the runtime system and message system
When an OS project is created in the PCS 7 ES, the OS Project Editor is called automatically
and initialized with default settings with reference to the runtime system and the message
system. Only if you want a configuration other than the default configuration do you have to
start the OS Project Editor in the WinCC Explorer and configure your desired project settings.
If you create a new WinCC project with Basic Process Control, you must start the OS Project
Editor. The OS Project Editor must run before the User Administrator is opened, otherwise the
User Administrator will be initialized with the authorization levels of WinCC.
The OS Project Editor creates the picture construction in overview area, work area, and button
area as well as basic data in the WinCC server or client projects. The areas in the picture
hierarchy are displayed automatically in the overview area of Runtime. In Runtime, the Split
Screen Manager manages the display data, the picture compositions, and the picture changes
according to the picture hierarchy. The picture change is configured with the standard functions
of the Split Screen Manager.
All necessary data for the message configuration and the message display is created by the
OS Project Editor. There is no need to configure a WinCC Alarm Control. You can change the
default settings for display of the message system on the operator station in the OS Project
Editor.
WinCC Explorer displays the system pictures contained in the basic data with "@" prefix at
the "Graphics Designer" editor. You can hide the system pictures in WinCC Explorer. Select
the "Graphics-Runtime" tab in the properties dialog of the computer and activate the "Use
prefix" option in the "Hide system pictures" field. The text field on the right must contain the
"@" prefix.

Time Synchronization - Time synchronization via LAN and Industrial Ethernet Bus
To ensure time synchronization for all operator stations, you have to configure the time
synchronization using the "Time Synchronization" editor for every operator station.

Lifebeat Monitoring - Lifebeat monitoring for all automation systems and operator stations
The lifebeat monitoring function monitors functionality of all automation systems and operator
stations and creates a process control message, if necessary. You configure the lifebeat
monitoring in WinCC using the "Lifebeat Monitoring" editor.

Horn - Acoustic and optical signal generator for certain messages
The "Horn" editor is used to control optical and acoustic signaling devices or the output from
audio files when messages come in.

Picture Tree Manager - Management of the system hierarchy with the respective pictures
The "Picture Tree Manager" is used to manage a hierarchy of systems, subsystems and
Graphics Designer pictures. Using the Picture Tree Manager, the hierarchy of the group
displays can also be recalculated or updated.
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Component List Editor - Configuration of entry point pictures and areas for the measuring points
You can see all components that you have inserted in the ES configuration in the Component
List Editor. You can create new measuring points yourself using the Component List Editor.
You allocate components to the pictures and areas in the Component List Editor. This allows
the system operator to switch directly to this picture using the "Loop in Alarm" function in the
message list and the "Picture from measuring point" button.

1.7.3

How to Create a Project

Introduction
If you want to create a new project, you must first make several basic settings in WinCC. Based
on these settings, WinCC creates a project that you can edit immediately.

Principle
Follow the steps outlined below when creating a project:
● Define project type
● Specify the project name and project folder
● If required, enter the name of the configuration engineer, the project version, and a comment
● Defining computer properties
● Specify the settings for Runtime
You can specify the computer properties and the settings for Runtime immediately after
creating the project or during configuration. For more detailed information, refer to sections
Defining Computer Properties and Settings for Runtime.
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Procedure
1. In the toolbar of the WinCC, click the
The "WinCC Explorer" dialog opens.

button.

2. Select the required project type and confirm with "OK".
The "Create new project" window opens.

3. Enter the project name in the "Project Name" box. If you want the name of the project folder
to be different from the project name, enter the required folder name in the "New Subfolder"
box.
4. In the "Folder" list box under "Project Path", select the path in which you want to create the
project folder.
5. Confirm with "Create".
WinCC creates a project with the specified name and opens it in WinCC Explorer.
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6. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the shortcut menu.
The "Project Properties" dialog opens.

7. In the General tab, you go to the name of the configuration engineer, a project version, and
a comment. Change the project type in the Type list box.
8. Click "OK" to close the dialog.

Alternative procedure
You can create a new project in the following ways:
● When you first start WinCC
● In the menu bar of the WinCC Explorer in the File menu with the New command
● With the shortcut key <CTRL+N>

Activating Runtime on ES
To activate Runtime for an integrated project on the ES, you can centrally release this option
for the project. In WinCC Explorer, select the Project Properties option in the shortcut menu
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of the current project. Activate the "Allow activation on ES" check box in the "Options" tab.
For more information, refer the Online Help related to WinCC integration in SIMATIC Manager.
NOTICE
Activating Runtime and synchronizing UserArchive Runtime data
The UserArchive-Server is also started whenever you launch the "User Archive" editor on
the ES. The server synchronizes the Runtime data with the redundant partner. The standby
server will therefore receive the Runtime data of the ES. This operation leads to inconsistency
of the Runtime data.
Activate this check box only if you are actually going to use the ES as Runtime server.
Note
To test integrated WinCC projects, use the "Start OS Simulation" function. This approach will
safely exclude negative impacts on system runtime.
Activation of integrated WinCC projects on the ES is not appropriate in this context.

See also
Settings for Runtime (Page 137)
Opening WinCC Explorer (Page 36)
How to Specify the Computer Properties (Page 88)
Preparation to Create a Project (Page 81)
Managing WinCC Projects and Objects in the SIMATIC Manager (Page 2266)
Starting a Simulation in STEP 7 (Page 2304)

1.7.4

How to Specify the Computer Properties

Introduction
When you create a project, you must adapt the properties of the computer on which the project
will be activated.
In a multi-user system, you must adapt the properties individually for each computer you create.
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Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.
WinCC displays the list of computers in the data window.
2. Select the computer and then click the Properties command in the shortcut menu.
The Computer Properties dialog is opened.

3. Check whether the correct computer is entered in the Computer Name input box. You will
find the name of the computer in the Windows Control Panel under "System" on the
"Computer Name" tab.
4. Click "Use Local Computer Name" to adapt the computer name to the local computer name.
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5. When you insert a multi-location project, the Computer type area shows whether the
computer is projected as a server or a client.
If you have already inserted other computers in the project, then the same are displayed
in the Client Name or Server Name area. The labeling of the box depends on whether you
are displaying the computer properties of a server or of a client.
6. Click "OK" to close the dialog.
Note
If the field Computer Name does not contain the correct computer name, Graphics
Designer opens a picture in the English configuration language, regardless of the
language settings. You may reset the desired language in Graphics Designer.

Changing computer name
You can change the computer name in a project. Before WinCC accepts the modified computer
name, you must close and reopen the project.

See also
How to Create a Project (Page 85)
Effect of External Applications at Runtime (Page 143)
Settings for Runtime (Page 137)
Opening WinCC Explorer (Page 36)

1.7.5

How to use multiuser engineering

Introduction
Under certain circumstances, multiple users can edit a project simultaneously from different
computers and use different resources.
For versions up to WinCC V7.2, it was only possible for multiple configuration clients to edit
the same project simultaneously with remote configuration if the client computers were entered
for the server.
If you are using integrated operation with SIMATIC Manager, note the additional information
under "Integration of WinCC in SIMATIC Manager > How to use multiuser engineering in
SIMATIC Manager".
Note
Process Historian does not support multiuser engineering.
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Advantages of multiuser engineering compared with the configuration client
● The configuration computer does not have to be entered on the server.
● You do not need to configure user authorizations in the User Administrator.
● The computer can be connected to all WinCC project types
– Single-user project
– Multi-user project
– A client with its own project
● You can only activate Runtime if the project is on the local computer and has not already
been opened by another computer. Accordingly, the project can no longer be opened on
another computer when Runtime is activated.

How to make multiuser engineering possible
Requirement:
● No clients are entered in the computer list of the server.
● The editors must be closed on all computers involved when multiuser engineering is
activated.
Procedure:
1. In the shortcut menu of the project name in WinCC Explorer, select "Properties".
2. On the "Options" tab, select the check box "Multiuser engineering".
The computers connected to the project can now use various different project resources.

Sequence of multiuser engineering
When one computer has opened certain resources, the other computer can no longer open
these resources. This especially applies to database-based resources. The other computer
can always open the project properties dialog. Only the "Options" tab is shown in this dialog
to access the resources dialog.
Other computers have read-only access to some database-based resources, but do not
receive an update after changes. These changes are only displayed when the resource is
opened once again.
For editors that are using file-based resources, such as pictures or reports, only the files already
open are locked for editing on the other computers.
You use the resources dialog to determine which resources are already reserved and which
computers access the project. Select the "Options" tab and click "Resources". The "Multiuser
resources" dialog opens. Select the "Display reserved resources of all users" check box to get
an overview of all used resources and computers.
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Multiuser engineering cannot be deactivated if a project is opened by multiple users. To disable
multiuser engineering, only one computer may access the project. If a computer blocks
disabling of multiuser engineering due to a connection problem, you can release the computer.
Note
If a new print job is created on a computer, the print job is not immediately visible in WinCC
Explorer. The change is only visible once the editor has been closed and opened again.

Releasing resources that cannot be edited
You may have to release resources under certain circumstances to continue working with
them, for example if the connection is interrupted.
There are two ways to release resources:
● The project is closed and re-opened remotely. Opening the project automatically releases
all resources of the non-connected computer that are still pending. The resources used by
the other computers are not affected by release.
● You can release individual resources with the resources dialog. Before releasing resources,
you must make sure that none of them are currently in use by any other users. Release
must therefore be coordinated with all users involved so that the users close the
configuration dialogs / the editor on the relevant computers. This leaves only the noneditable resources in the dialog.
NOTICE
Release resources only in case of an emergency
Only release resources via the dialog in specific cases, for example when a computer can
no longer be reached due to an interrupted connection. Otherwise you may release resources
that are currently being used.
Simultaneous access to the same resources is not permitted, as release means that the
resources can no longer be managed.
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Using the resources dialog to release non-editable resources
1. On the "Options" tab in the project properties, click the "Resources" button. The "Multiuser
resources" dialog opens.
2. Select the "Show reserved resources of all users" check box to view a list of all resources
used by users and computers involved in the project. Only the non-editable resources are
displayed.

Note
To refresh the dialog display, deselect and then re-select the check box "Show reserved
resources of all users".
3. Select the resources to be released. Click the "Release" button. This forces the release of
the selected resources.

Releasing a computer with a connection problem
NOTICE
Only release a computer that actually has connection problems
Only release a computer via the dialog if there are actually connection problems, for example
if the network card of the computer is defective. Otherwise, the result could be a loss of data
in the WinCC project.
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1. On the "Options" tab in the project properties, click the "Resources" button. The "Multiuser
resources" dialog opens.
2. Select the "Show reserved resources of all users" check box to view a list of all computers
and resources used.
3. Select the "Project open" row on the computer to be released. Click the "Release" button.
This forces the release of the selected computer.

Releasing the resources of individual editors in the Configuration Studio
For large WinCC projects, the configuration engineer wants to have multiple editors open in
one instance of the Configuration Studio so that the comprehensive data is loaded and the
engineer has rapid access to it during configuration. This will, however, reserve the resources
of these editors.
The configuration engineer can release a resource in the Configuration Studio for the following
scenario. The other computer or user wants to access an editor whose data has been loaded
to the configuration engineer's computer but is not currently being edited by the engineer.
In the Configuration Studio, the configuration engineer then selects the option "Release" in the
shortcut menu in the navigation area to unload the data. The resource is now released and
can be used by another computer. You can release each editor that is reserved but not currently
in use using the shortcut menu.

1.7.6

How to support multiple picture windows

Introduction
WinCC supports independent picture windows. Independent picture windows can be can be
used and positioned absolutely without being connected to the respective process picture.
With the respective hardware and the support of the operating system, you can control more
monitors to handle processes with greater scope and differentiation.
For example, you can visualize the process on monitors 1 to 3 and use monitor 4 to display
another view of the process with an Excel list.
The main window, in which you have configured the individual picture window, is no longer
required. You can hide it to increase the impact of more independent runtime windows.
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Procedure
1. Configure more picture windows with the desired process pictures in the start picture.
2. Open the properties for each picture window with a double click.
The "Object Properties" dialog is opened.

3. Set the attribute "Independent window" to "Yes".
4. Define the display for the configured picture window with window mode:
– Standard: configured size in the configured position
– Center: configured size in the central position
– Maximize: display adapted to the size of the monitor
5. If you want to use more monitors:
Select the desired monitor for the picture window with the "Monitor number" attribute.
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6. If you want to hide the main window:
Select "Properties" in the WinCC Explorer of the shortcut menu of the computer, select the
respective computer and click on "Properties".
The "Computer Properties" dialog opens.

7. Activate check box "Hide main window" on the "Graphics Runtime" tab under "Independent
picture window".

Results
In runtime, the selected process pictures appear in several picture windows that are to be
controlled independent of one another.

96

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Projects
1.7 Creating and Editing Projects

See also
How to insert a picture window (Page 552)

1.7.7

Setting Time in WinCC

1.7.7.1

Setting Time in WinCC

Introduction
In WinCC Runtime, you can display data with the date/time information in the local valid time
or in coordinated universal time. It is normally practical to display the local time of your
workstation location. If you wish to display a time zone-independent time, use coordinated
universal time.
When you create a new project, WinCC uses the local time zone as the default. Internally,
WinCC works with the coordinated universal time as a time base and converts to the selected
time zone for the displayed time.
You set the time base for the entire project on one computer. In a multi-user system, you can
set the time base individually on each computer.
Additionally, you may configure if the date and time format can be configured at the individual
components or if it should be forced centrally by the WinCC project at all components in ISO
8601 format.
Note
Changing the time zone can have effects on date changes.
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Multi-User System with Three Servers

The local time zone is displayed in the stations in Los Angeles, New York, and Tokyo.
Data is collected from the stations in the center in Berlin. With the default setting, the operator
sees all data in the local Berlin time. To be able to compare the data more easily in discussions
with the stations, bus operators change over to UTC.
Note
The use of UTC is always advisable when you want to display or edit time-dependent data
from different time zones on one computer. If, for example, you want to display messages
from different time zones on one client, UTC should be selected in the Alarm Control of this
client so that the messages are sorted in the correct chronological order and appear correctly
in the single-line message window.

Possible Settings
For runtime displays, the following settings are available. The settings are configured in the
properties of the computer on the "Parameters" tab.
Selection

Meaning

Local time zone (LOC)

During Runtime, time information is displayed in the local time zone of
the client or server.
For this display, UTC is converted to the local time zone. 1)
The local time zone is the default when you create a new project. The
individual objects use the default setting Apply Project Settings.

Coordinated Universal Time
(UTC)

During Runtime, coordinated universal time is displayed. UTC stands
for Universal Time Coordinated.
UTC is not dependent on time zones and is used internationally. This
time corresponds to the Greenwich Mean Time (Central European Time
minus an hour). In UTC, there is no daylight saving time.
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Selection

Meaning

Time zone of server

In Runtime, the local time zone of the server is displayed. In single-user
systems, this time corresponds to the time of the local time zone. During
display of the local time zone in ISO 8601 format, no deviations to UTC
time are shown.
Note:
We recommend using this setting only in projects migrated from WinCC
V5.x.

Apply Project Settings 2)

This option is available only for layouts and controls.
The object adopts the time zone selected in the project settings.

1)

You set the local time zone in the Control Panel of your computer under "Date/Time".

We recommend applying the "Apply Project Settings" setting to all objects and only changing it in
certain cases. This setting facilitates the project-wide conversion of the time zone.

2)

PLC clock setting
You can set the time base for communication with the automation system:
● UTC (Coordinated Universal Time) Default setting
● Local winter time (all year): Available for compatibility reasons
The settings are configured in the properties of the computer on the "Parameters" tab.

Central Date and Time Formatting in ISO 8601 format
In the computer properties of the WinCC project, you may configure if the date and time format
should be configured at the individual components or if it should be forced centrally by the
WinCC project at all components in ISO 8601 format.
The following conditions apply to ISO 8601 format.
● The date is always displayed in YYYY-MM-DD format.
● The time is shown in 24-hour format.
● UTC times are identified with suffix Z, e.g. 17:01:03.099Z.
● The time of the local time zone is displayed as local time plus the offset to UTC, e.g.
17:01:03.099+01:30.
● The display of time is specified by the time format hh:mm:ss. Only the additional display of
milliseconds is optional for the components. The time display is then in the format
hh:mm:ss.msc, e.g. 17:01:03.099.
Note
If the central display of date and time in ISO 8601 format is forced, this takes effect on
configurable time formats and time display throughout the project, e.g. in Controls, Reports
or in Alarm Logging on system message blocks Time and Date.
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See also
Opening WinCC Explorer (Page 36)
Preparation to Create a Project (Page 81)
How to Set the Time Base for Runtime Documentation (Page 102)
How to Set the Time Base for Controls (Page 101)
How to Set the Time Base in the Project (Page 100)
Displaying Regional Date and Time (Page 2187)

1.7.7.2

How to Set the Time Base in the Project

Introduction
The time basis applicable as default setting for the entire project is entered in the Computer
Properties dialog. This setting applies to all objects displayed on this computer in Runtime.
The exceptions to this are objects for which you have set a separate time base.
You may also use this dialog to set whether or not central date and time formatting according
to ISO 8601 should be forced in all components.
Note
You can also change the time base setting in Runtime. To update the display in Runtime,
you must reselect the corresponding picture or report.
If the central display of date and time in ISO 8601 format is forced, this takes effect on
configurable time formats and time display throughout the project, e.g. in ActiveX Controls,
Reports or in Alarm Logging on system message blocks Time and Date.

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.
WinCC displays the list of computers in the data window.
2. Select the computer and then click the Properties command in the shortcut menu.
The Computer Properties dialog is opened.
3. Click the Parameters tab.
4. Select required time base in the Time Basis for Time Display in Runtime list box.
5. In the Central Date and Time Formatting area, choose if the format for date and time may
be configured at individual components, such as Alarm Control, or if the format in
accordance with ISO 8601 should be forced at all components.
6. Click "OK" to close the dialog.
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See also
How to Set the Time Base for Runtime Documentation (Page 102)
Preparation to Create a Project (Page 81)
How to Set the Time Base for Controls (Page 101)
Setting Time in WinCC (Page 97)

1.7.7.3

How to Set the Time Base for Controls

Introduction
For some controls, you can assess the time base individually.
In the default setting, the control takes the time base from the project properties. The Apply
Project Settings setting makes sure that you always see the same time zone in your controls
as in the rest of the project. With this setting, you can change the time base for all controls in
one action in the computer properties.
If you change the time base of a control, the modified setting is retained. You can no longer
change the time base of the controls in one action in the computer properties. To adapt to
control to the display in run-time again, you must modify the properties manually or change
the Apply Project Settings setting.

Controls
You can adapt the time base individually for the following controls:
● WinCC Online Table Control
● WinCC Online Trend Control
● WinCC Function Trend Control
● WinCC Alarm Control
● WinCC User Archives Table Control

Time Base for Controls
The following settings are available for the time base:
● Apply Project Settings (default)
● Time zone of server
● Local time zone
● Coordinated Universal Time (UTC)
Note
You can also change the time base setting in Runtime.
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Procedure
1. Open the Properties dialog of the control.
2. Select the General tab or the Time Axis tab for the Online Trend Control.
3. Select the required time base in the selection window under Time Base.
4. Click "OK" to close the dialog.

Time Format in Controls
If the central date and time format in ISO 8601 format is forced in the Computer Properties
dialog, this also has an effect on the configurable time formats and time displays in the controls.

WinCC User Archives Table Control
For the User Archives Table Control, sets the time base for the LastAccess field in the General
tab. The time of the last access is displayed in the Last Access column.

WinCC Digital/Analog Clock Control
The Digital/Analog Clock Control always displays the local computer time. The displayed time
is not influenced by the time base of the project.

See also
Preparation to Create a Project (Page 81)
How to Set the Time Base for Runtime Documentation (Page 102)
How to Set the Time Base in the Project (Page 100)
Setting Time in WinCC (Page 97)

1.7.7.4

How to Set the Time Base for Runtime Documentation

Introduction
In the log system of WinCC, you have dynamic objects available which allow you to output
Runtime data into a report. You can set the time base of the dynamic objects individually in
the properties.
WinCC accepts the time base from the project properties as default setting. The Apply Project
Settings setting makes sure that you always see the same time zone in your reports as in the
rest of the project. With this setting, you can change the time base for all dynamic objects in
one action in the computer properties.
If you change the time base of a dynamic object, the modified setting is retained. You can no
longer change the time base of the object in one action in the computer properties. To adapt
the reports to the display in Runtime again, you must modify the settings in the object properties
manually or change the Apply Project Settings.
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Reports
You can change the time base of the following objects:
● Archive reports (Alarm Logging Runtime)
● Message reports (Alarm Logging Runtime)
● User archive tables (User Archive Runtime)
● Tag tables (Tag Logging Runtime)
● Trends (Tag Logging Runtime)
● Message sequence report tables (in the Line Layout Editor)
● Message sequence report tables (in the Page Layout Editor)

Time Base for Line Layouts and Page Layouts
The Runtime documentation states when an event, such as a message, occurred. If you
change the time base output, WinCC converts the time stamps of the messages into the new
time base.
You can select the following settings as the time base:
● Apply Project Settings (default)
● Time zone of server
● Local time zone
● Coordinated Universal Time (UTC)
Note
You can also change the time base setting in Runtime.
Exception: You cannot change the time base of message sequence reports in Runtime.

Procedure for Page Layouts
1. Open the required page layout in the page layout editor.
2. Double-click the dynamic object you want to edit.
The "Object Properties" dialog is opened.
3. On the tab Connect, select the object in the navigation window.
4. In the table in the right window, select the Time Base entry and click the Edit button.
The Time Base Entry dialog is displayed.
5. Select the required time base and confirm with "OK".
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Procedure for Line Layouts
1. Open the desired line layout in the line layout editor.
2. Click in the Table area on the Time Base... button.
The Time Base Entry dialog is displayed.
3. Select the required time base and confirm with "OK".

Selection for Layouts
In the filter criteria for alarm output, WinCC always uses the time base of the corresponding
dynamic object.

Start Time and Selected Time Range for Print Jobs
The start time and the selected time range of the data to be printed is always shown in local
computer time. The start time and the selected time range are not influenced by the time base
of the project nor by the time base of a dynamic object.

Time Format in Reports
If the central date and time format in ISO 8601 format is forced in the Computer Properties
dialog, this also has an effect on time displays in the reports.

See also
Preparation to Create a Project (Page 81)
How to Set the Time Base for Controls (Page 101)
How to Set the Time Base in the Project (Page 100)
Setting Time in WinCC (Page 97)

1.7.8

Online Configuration

Introduction
You can edit a project in a single-user system or a multi-user system during Runtime.
Remember, however, that some configuration tasks are not possible.
WinCC also provides the Load Online Changes function. With the Load Online Changes
function, you can edit a project on one computer while it is running on another computer in
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Runtime. When configuring with Load Online Changes, there are other restrictions than those
that apply to online configuration.
Note
In time-critical projects, remember that online configuration can affect the response of your
project over time.

Limitations
For more detailed information on the possibilities for online data editing, refer to the description
of the relevant editor in the WinCC Information System.
You can edit the following elements while the project is activated in Runtime:
Element

Create

Delete

Edit

Remarks

Project name /
Project properties

---

---

No

---

Computer

Yes

No

No

---

Computer properties

---

---

Yes

Edit:
Modifications only become effective in Runtime
after the project has been deactivated and
Runtime restarted.

Time base
(computer properties)

---

---

Yes

Edit:
Depending on the configuration, a modification
in a picture is updated in Runtime after the
picture has been reselected.

User cycle
(project properties)

---

---

No

---

Tags
(tag management)

Yes

Yes

Yes

Delete/Edit:
Only possible with external tags when the
channel used supports the function. This
currently applies only to the S7 channel

Tag groups
(tag management)

Yes

Yes

Yes

Delete:
Only valid when the contained tags can be
deleted.

Structure types

Yes

Yes

Yes

Delete:
Only possible if the structure type does not
contain structure tags.
Edit:
Only possible as long as no structure tag has
been set up under the structure type.

Structure tags
(structure types)

Yes

Yes

Yes

Delete:
Only valid when the associated structure tag
elements can be deleted.

Connections
(tag management)

Yes

Yes

Yes

Changes to a connection can lead to loss of
data.
Delete/Edit:
Currently only valid for the S7 channel.
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Element

Create

Delete

Edit

Remarks

Channels
(tag management)

No

No

No

---

Channel units
(tag management)

No

No

No

---

Text entries
(Text Library)

Yes

Yes

Yes

---

Pictures
(PDL files,
Graphics Designer)

Yes

Yes

Yes

A picture is updated at Runtime only after
reselection.

Library, color palette
(Graphics Designer)

Yes

Yes

Yes

---

Archives, archive tags
(Tag Logging, User
Archives)

Yes

Yes

Yes

Edit:
Archiving cycle cannot be modified

Reports, layouts
(Report Designer)

Yes

Yes

Yes

Create/Delete/Edit:
Only valid for the Runtime documentation.

Scripts
(Global Script)

Yes

Yes

Yes

---

Access rights
(User Administrator)

Yes

Yes

Yes

---

Other files

Yes

Yes

Yes

---

Packages
(server data)

Yes

Yes

Yes

---

Messages
(Alarm Logging)

---

---

---

Refer to the Online Configuration with
Messages table below.

Configuring messages online
Element

Attribute

Create

Delete

Edit

Remarks

Yes

Yes

Yes

Edit:
Valid for most attributes.
Exceptions are listed
individually:

● Number

---

---

No

---

● User-defined message
group

---

---

Yes

---

● Class

---

---

Yes

The message is updated
immediately.

● Type

---

---

Yes

If the acknowledgment
requirement is changed, the
message is deleted.
If the message class is changed
but not the acknowledgment
requirement, the message is
updated immediately.

Single messages
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Element

Attribute

Create

Delete

Edit

Remarks

● Triggered on falling edge

---

---

Yes

If you change the attribute, the
message is deleted.

---

---

Yes

Updated in Runtime only when
the status of the message
changes.

● Info text

---

---

Yes

The message is updated
immediately.

● User text block

---

---

Yes

Updated in Runtime only when
the status of the message
changes.

Message groups
from message
classes/message
types

No

No

No

---

User-defined
message groups

Yes

Yes

Yes

---

Analog alarm

Yes

Yes

Yes

Edit:
If the "Message" attribute is
modified, the message is
deleted.

System blocks

Yes

Yes

Yes

Create/Delete/Edit:
A picture is only updated in
Runtime when the
corresponding picture is
reselected.
Create/Delete:
Reconfiguration in OCX
necessary.

User text blocks

Yes

Yes

Yes

Create/Delete/Edit:
A picture is only updated in
Runtime when the
corresponding picture is
reselected.
Create/Delete:
Reconfiguration in OCX
necessary.

Process value blocks

Yes

Yes

Yes

Create/Delete/Edit:
A picture is only updated in
Runtime when the
corresponding picture is
reselected.
Create/Delete:
Reconfiguration in OCX
necessary.

Message classes

Yes

No

Yes

---

● Message tag
● Message bit
● Norm DLL
● Controls the central
signaling device
● Will be archived
● Priority

● Process value block
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Element

Attribute

Create

Delete

Edit

Remarks

Yes

No

Yes

Edit:
Valid for most attributes.
Exceptions are listed
individually:

---

---

Yes

Updated in Runtime only when
the status of the message
changes or when you reselect
the picture.

---

---

Yes

If you modify a message so that
acknowledgment is no longer
mandatory, the message is
deleted.

Raw data tags

Yes

Yes

Yes

Edit/Delete:
The message is deleted.

Tags

---

Yes

Yes

Edit/Delete:
The message is deleted.

Message types

● Class names
● Status text
● Acknowledgment theory

See also
Use and Limitations of Load Online Changes (Page 112)
Loading Online Changes (Page 108)

1.7.9

Loading Online Changes

1.7.9.1

Loading Online Changes

Introduction
With the Load Online Changes function, you can edit a project on one computer while it is
running on another computer in Runtime. Load online changes work under multi-user systems
and distributed systems under the same conditions as the use in multi-user systems.
The computer on which you configure will be referred to as the configuring station in the
following description. The computer on which Runtime is activated will be referred to as the
Operator Station.
If you want to use the changes on the operator station, start a download of the changed data.
The project is updated in Runtime.
You can test the modified project on the configuring station before you user modifications in
Runtime. You can update the project at any time.
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Working with load online changes is possible only when you maintain a consistent project.
Note
In time-critical projects, remember that downloading changes online can affect the response
of your project over time.

Application Scenarios
During various phases, for example commissioning, operation, or maintenance, you will
normally find it necessary to make changes to an existing project. These changes can then
be adopted in the activated project; in other words, online.
You can download changes online in the following situations:
● Continuous automation tasks:
All modifications are made online from a central configuration station. As a result, you do
not need to make a configuration changes directly on site. It is also possible to add, modify,
and delete Runtime objects, for example tags, alarms, and archives without deactivating
WinCC.
● Testing modifications in a protected environment:
The configuring station can be used to run intended modifications offline before they are
loaded in the activated project. The configuration planner can, therefore, test the
modifications in a protected environment before adopting them in active operation. This
allows configuration errors to be detected before they can cause problems in the process
or stop the plant.
● Simultaneous loading of modifications which influence each other:
Configuration changes often relate to settings which are linked to each other. Such
modifications should be downloaded consistently and take effect at the same time.
This case occurs, for example, when a calculated value of an archive representation is
added. In may be necessary to create new tags and add them to a new archive. Finally,
the archive will be displayed in a picture. In the situation, if the information is not adopted
as a unit, this will lead to error messages.
Note
If Load Online Changes is to be used in redundant systems, STEP7 or PCS7 is required.
More information is available in the chapter" Advantages and requirements of integration".

General procedure
A project runs on the operator station during Runtime. Load Online Changes is automatically
activated. The menus for Load Online Changes cannot be operated in WinCC Explorer.
You edit a copy of the project on a second computer, the configuration station. Activate the
load online changes function in the WinCC Explorer on the configuration station. From this
point onwards, WinCC records all changes made in the project. Online configurations on the
configuration station are not, however, recorded.
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When you have completed your modifications in the project, start the online download of the
changes. This exports the modified data to the operator station. The project is updated in
Runtime.
I the case of multi-user systems, WinCC generates packages after each download. Depending
on the settings selected, the packages can be automatically imported by the clients.

See also
Online Configuration (Page 104)
How to Download Load Online Changes (Page 119)
How to Reset Load Online Changes (Page 123)
How to Activate Load Online Changes (Page 117)
Use and Limitations of Load Online Changes (Page 112)
Requirements for Loading Online Changes (Page 110)
Run Diagnosis of Online Change Loading (Page 115)
Advantages and Prerequisites of Integration (Page 2264)

1.7.9.2

Requirements for Loading Online Changes

Introduction
Make sure that you use the function for downloading changes online only with consistent
projects:
● Before activating the Load Online Changes function, the projects on the configuring station
and on the operator station must be synchronized to the same project state.
● The project on the engineering station must be tested and run correctly when Load Online
Changes is started.
● You can only configure changes that can be recorded by the Load Online Changes function.
If the download changes online function cannot record a configuration, a warning is
displayed. If you configure the change despite this warning, the Load Online Changes
function is reset. The changes can no longer be transferred.
If you edit an inconsistent project, you take the risk that the activated project will no longer run
correctly following the download. You can then only correct errors in Runtime in the deactivated
status.
Note
If you edit a WinCC project which was created using the SIMATIC Manager, there will be no
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects
created in WinCC and subsequently imported into SIMATIC Manager by using the function
"Importing WinCC objects". This type of project is also called a TIA project.
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item
Load Online Changes in WinCC Explorer is displayed.
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Synchronizing Project to the Same Status
Synchronize the project on the computers participating so they have the same data before
activating Load Online Changes. You can do this by copying the current version of your project
from the operator station to the configuring station using the Project Duplicator.
If the project is edited on the configuring station, observe the following:
● The project must not be modified on the operator station.
● The project must not be edited either on the configuring station or on the operator station
from another computer.
● The configuration on the operator station must also not be modified by scripts.
● In the case of a client/server system, the Notify after Export check box must be deactivated
in the Implicit Update menu on the configuring station in WinCC Explorer/Serverdata.

Configuring with Load Online Changes Activated
Edit the project on the configuring station only when the Load Online Changes function is
activated. Only configure changes that can be recorded by the download changes online
function.

Keeping the Project Consistent
Test your edited project on the configuring station before starting Load Online Changes.
This ensures that fully functional data is transferred to the operator station and that no errors
occur in the activated project.

Configuring in multiple partial steps
You can configure the changes that are to be entered n the online change shop in multiple
partial steps. For this, exit WinCC after every configuration session if you have switched on
the online changes shop. During the next configuration session, the project will be started in
the same status and can be processed further. After completing the partial configurations,
download the modified project in one step to the operator station.

Quantity structure
Using the Load Online Changes function, you should not configure and transfer more than 500
tags, archive tags, and messages. The Load Online Changes function is not intended or
suitable for transferring mass data.
New segments are created in the archive manager if you make changes to existing archive
variables. This can decrease performance of the load online changes feature. No additional
segments are created when adding or removing variables in the TagLogging Editor.
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Configure major modifications in several steps. After configuration, transfer each partial
package to the operator station.
Note
Load Online Changes can also be switched off on the configuring station. However, Load
Online Changes should only be switched off when no configuration modifications need to be
carried out online and prefer to execute a complete download onto the OS. Do not select
Turn Off if Load Online Changes should be interrupted. The consistency of the project can
then no longer be guaranteed.

See also
How to Activate Load Online Changes (Page 117)
How to Download Load Online Changes (Page 119)
How to Reset Load Online Changes (Page 123)
Use and Limitations of Load Online Changes (Page 112)
Run Diagnosis of Online Change Loading (Page 115)

1.7.9.3

Use and Limitations of Load Online Changes

Introduction
When Load Online Changes is active, not all configurations can be executed which are possible
when Load Online Changes is deactivated.

Basic Limitations
Opened Files
In the case of Load Online Changes, no open files are transferred, e.g. screens which are
open in Graphics Designer at that moment. After the download, an entry is made in the
message window of the Progress dialog. Close all applications and editors except Load Online
Changes and start the transfer again.
Project in Runtime
The project must not be active in Runtime on the configuring station.
WinCC server
Observe the following procedure during download of Load Online Changes to a server:
The respective WinCC project should be open on all clients with an imported server package.
You can also perform the download if the corresponding project is not open on all clients. You
must then wait at least 10 minutes after confirmation of the last dialog of Load Online Changes
before opening the project on the client.
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Redundant Systems
You can only use Load Online Changes in redundant systems when certain requirements have
been met. If Load Online Changes should be used in redundant systems, you require SIMATIC
Manager, or STEP 7 or PCS 7.
You must always start the download of Load Online Changes via the master server. This will
also perform a download of Load Online Changes on the standby server. Starting the download
from the standby server is not possible.
Changes to user archive configuration data, such as deleted fields in the archive, cannot be
transferred with an online download of changes to a redundant server pair.

Files and Elements
Load Online Changes supports editing of the following elements:
Element

Create

Delete

Edit

Remarks

Project name,
Project properties

---

---

No

---

Computer

Yes

No

No

---

Computer properties

---

---

No

---

Time base
(computer properties)

---

---

No

---

User cycle
(project properties)

---

---

No

---

Tags
(tag management)

Yes

Yes

Yes

Delete/Edit:
Only possible with external tags when the
channel used supports the function. Currently
only valid for the S7 channel.

Tag groups
(tag management)

Yes

Yes

Yes

Delete:
Only valid when the contained tags can be
deleted.

Structure types

Yes

Yes

Yes

Delete:
Only possible if the structure type does not
contain structure tags.
Edit:
Only possible as long as no structure tag has
been set up under the structure type.

Structure tags
(structure types)

Yes

Yes

Yes

Delete:
Only possible if the associated structure tag
elements can be deleted.

Connections
(tag management)

Yes

Yes

Yes

Changes to a connection can lead to loss of
data.
Delete/Edit:
Currently only valid for the S7 channel.

Channels
(tag management)

No

No

No

---

Channel units
(tag management)

No

No

No

---
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Element

Create

Delete

Edit

Remarks

Text entries
(Text Library)

Yes

Yes

Yes

---

Pictures
(PDL files, Graphics
Designer)

Yes

Yes

Yes

A picture is updated at Runtime only after
reselection.

Library, color palette
(Graphics Designer)

---

---

No

---

Messages
(Alarm Logging)

Yes

Yes

Yes

The processing of message blocks and
message groups from message classes is not
supported. The processing of user-defined
message groups is supported.
Deletion of message classes is not supported.

Archives, archive tags
(Tag Logging, User
Archives)

Yes

Yes

Yes

Reports, layouts
(Report Designer)

Yes

Yes

Yes

---

Scripts
(Global Script)

Yes

Yes

Yes

---

Access rights
(User Administrator)

Yes

Yes

Yes

---

Other files

Yes

Yes

Yes

The files must be in the project directory or one
of the following subdirectories: GraCS, Library,
ScriptLib, PRT, Textbib.

Support for WinCC Web Navigator
Load Online Changes supports the transfer of published pictures and scripts of WinCC Option
Web Navigator, if the Web Navigator Server is installed on configuration station and operator
station.

See also
Online Configuration (Page 104)
How to Download Load Online Changes (Page 119)
How to Reset Load Online Changes (Page 123)
How to Activate Load Online Changes (Page 117)
Loading Online Changes (Page 108)
Requirements for Loading Online Changes (Page 110)
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1.7.9.4

Run Diagnosis of Online Change Loading

Introduction
After downloading changes online, you should check that all changes have been adopted
correctly in the project on the operator station. You can export the error messages that occurred
during download to a diagnosis file.

Log files for diagnostics of the online download of changes
The following log files are created in the WinCC diagnostics folder:
Engineering Station:
● DlDiagnosisSetMode.log
● DlDownloadES_<Name of the target computer>
● DlDiagnosisError.log
Operator Station:
● DlDiagnosisSetMode.log
● DlDownloadOS
● DlDiagnosisError.log

Notes on Diagnostics and Configuration
There are various reasons for a change not being adopted in the activated project.
Behavior

Procedure / Configuration

Changes to picture are not displayed
(PDL file)

Reselect the picture in Runtime

Changes in a script are not displayed

Save the script again in the Global Script editor and reselect
the picture in Runtime

Changes to a control are not displayed

Reconnect the control in the Graphics Designer

Correction required in the configuration If there is an error in the configuration, correct the error on
the configuring station with Load Online Changes activated.
Transfer the corrected project data to the operator station
again with the download changes online function.
Network failure during the download

If the network fails during the download, the download
changes online function can only update some of the
recorded data. The Runtime project is therefore inconsistent.
Start the download again. The operator station must remain
in Runtime. Load Online Changes is full executed once
again. Ignore the fault messages displayed.
No further configurations may be completed on the
configuring station as long as Load Online Changes is not
concluded.
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Export error messages to a diagnosis file
You can export the error messages that have occurred while loading online changes to a
diagnosis file.
1. When loading is complete, click "Export ....".

This will open the "Save As" dialog.
2. Select the desired directory and enter a meaningful file name.
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3. Click on the "Save" button. The file is written to the selected directory.

See also
How to Download Load Online Changes (Page 119)
How to Reset Load Online Changes (Page 123)
How to Activate Load Online Changes (Page 117)
Use and Limitations of Load Online Changes (Page 112)
Requirements for Loading Online Changes (Page 110)

1.7.9.5

How to Activate Load Online Changes

Introduction
As soon as Load Online Changes has been activated on the configuring station, WinCC detects
all configured changes. If you want to use the changes on the operator station, start a download
of the changed data. The project is updated in Runtime.
Before activating the Load Online Changes, copy the project to the configuring station. Use
the Project Duplicator for this. This prevents inconsistency. The project can be duplicated from
the operator station while Runtime is active. When the copied project is opened on the
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configuring station, Runtime is started automatically. If Runtime is terminated, Load Online
Changes remains activated. Reset Load Online Changes first to ensure the changes are
assumed when the project is restarted.
NOTICE
Ensure that the project is consistent.
Ensure that configuration only takes place on the configuring station on which Load Online
Changes is active.
If you edit an inconsistent project, you take the risk that the activated project will no longer
run correctly following the download. You can then only correct errors in Runtime in the
deactivated status.

Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.
2. When the project has been copied, select the Reset option in the shortcut menu before
starting with the changes.
3. Also select Turn On in the shortcut menu.
Load Online Changes is activated and immediately records all changes made in the project.
If a change is made that cannot be recorded by Load Online Changes, the following dialog is
displayed:

It is possible that the change is necessary and that the project would otherwise be inconsistent
and cause errors in Runtime. In this case, confirm with Yes. Reset the download changes
online function and continue to configure without it.
Note
If you edit a WinCC project which was created using the SIMATIC Manager, there will be no
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects
created in WinCC and subsequently imported into SIMATIC Manager by using the function
"Importing WinCC objects". This type of project is also called a TIA project.
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item
Load Online Changes in WinCC Explorer is displayed.
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See also
How to Copy a Project (Page 177)
How to Download Load Online Changes (Page 119)
How to Reset Load Online Changes (Page 123)
Use and Limitations of Load Online Changes (Page 112)
Loading Online Changes (Page 108)
Requirements for Loading Online Changes (Page 110)

1.7.9.6

How to Download Load Online Changes

Introduction
If you want to adopt the changes recorded by the download online changes function in an
activated project, start a download. This exports the modified data from the configuring station
to the operator station. The project is updated in Runtime.
The changes can be transferred to several operator stations. A condition for this is that the
same project status prevails on all target systems.
Before downloading, make sure that the modified project is fault-free. Test the changes on the
configuring station in Runtime.
If you are editing a multi-user project, WinCC generates the required packages on the operator
station after each download. The automatic package update is used to by the clients to import
the changes as packages and to load them. To do this, select the "Server data" item in WinCC
Explorer on the OS client, and activate the Notify After Export check box in the Implicit Update
menu.
If the package is changed by the server in a redundant multi-user system, so that the clients
are automatically updated, reregister the preferred server on the clients, or reassign the
preferred server by reloading of the clients.

Requirements
● The project was copied from the operator station with the Project Duplicator before
activating the Load Online Changes function.
● The project can only be edited with the Load Online Changes function active at all times.
● The project on the configuring station is consistent and has been tested in Runtime.
● The unchanged project is activated in Runtime on the operator station.
● The operator station should perform as few operations as possible while the download of
Load Online Changes takes place. In time-critical projects, remember that Load Online
Changes can affect the response of your project over time.
● Use the configuring station to check that the files to be transferred are not open.
● All WinCC editors must be closed on the configuring station.
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Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.
2. Select the Start Download command in the shortcut menu.
The Remote Computer dialog is opened.

3. Click the

button to select the operator station on which you want to update the project.

4. To transfer the changes to several operator stations, deactivate the check box "Reset after
download" before the download. After downloading to the first operator station, the same
data are available for a further download.
5. Start the download with OK.
The Progress Dialog dialog is opened. The window contains a progress bar for the entire
download and a second progress bar for the current action.
6. If the Reset After Download check box is selected, a reset occurs after Load Online
Changes.
7. After the download, close the Progress Dialog dialog with OK.
Note
After Load Online Changes has been reset, the file with the recorded data is deleted. If
transfer of the changes should be made to an operator station, the entire project must be
copied from the configuring station. In this case, Runtime must be terminated on the operator
station and WinCC closed.
If you edit a WinCC project which was created using the SIMATIC Manager, there will be no
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects
created in WinCC and subsequently imported into SIMATIC Manager by using the function
"Importing WinCC objects". This type of project is also called a TIA project.
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item
Load Online Changes in WinCC Explorer is displayed.
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Canceling the Download
The downloading process can be stopped. This should only be done in exceptional
circumstances, e.g. when the procedure threatens to take too much time. Only part of the
project changes are updated, according to the following sequence:
1. Connections
2. Tag groups, tags, structures
3. Texts
4. Messages
5. Archives, archive tags
6. User Administrator
7. Pictures
8. Scripts
9. Reports
If only a part of the download is completed, the project on the operator station is not fully
functional:
● A tag, for example, has been deleted. The tag management has been updated but the
pictures were not transferred in which the tags are displayed.
● A screen jump, for example has been configured but does not function. One screen was
transferred but not the other.
Changes already transferred are not reset on the operator station.
Following a cancellation, the Load Online Changes download can be restarted. The download
is then completed fully.
Pay attention to the following during the download:
● The operator station remains in Runtime.
● Ignore the fault messages displayed.
● No further configurations may be completed on the configuring station as long as Load
Online Changes has not been concluded.

Monitoring the Download Process
You can configure a message or use an internal tag that indicate the start and finish of the
download on the operator station.
Monitoring with control center options
If you have configured the WinCC system messages in the message system, downloading
changes online triggers the following OS process control messages:
Load online changes

Message no.

Message text

Download started

1012242

Delta loading was started

Download ended

1012243

Delta loading ended
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The messages can only be displayed when the process control options of WinCC are installed.
Monitoring via the internal tags "@DeltaLoaded", "@SFCDeltaLoaded" and
"@SFCDeltaLoaded"
The system tags "@DeltaLoaded", "@SFCDeltaLoaded" and "@DeltaCompiled" indicate the
download status as follows:
@DeltaLoaded
Value

is set

0

at the start of the download on the configuration station and on the operator station

1

at the start of the online change loading on the operator station, directly before sending the
process control message "1012242"

2

when canceling the online change load on the operator station

2

at the finish of the online change loading on the operator station, directly before sending the
process control message "1012243"

On the configuration station, "@DeltaLoaded" is always "0". On the operator station, the value
depends on the delta loading process. The value is not changed during the activation or
deactivation.
@SFCDeltaLoaded
Value

is set

0

at the start of the transfer of the SFC database on the operator station in the course of the
online change loading

1

at the finish of the transfer of the SFC database on the operator station in the course of the
online change loading

On the configuration station, "@SFCDeltaLoaded" is not set. On the operator station,
"@SFCDeltaLoaded" is used to synchronize the SFC clients. The SFC clients must terminate
access to the SFC database before the download. The value is not changed during the
activation or deactivation.
@DeltaCompiled
Value

is set

0

Initial value

1

OS compiling of change is running

2

OS compiling of change has been completed

You can monitor the OS compiling of changes using "@DeltaCompiled" system tag.

See also
Process Control Runtime: Message system
"Melde-Projektierung" tab
How to Activate Load Online Changes (Page 117)
How to Reset Load Online Changes (Page 123)
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Run Diagnosis of Online Change Loading (Page 115)
Integration of WinCC in SIMATIC Manager (Page 2263)

1.7.9.7

How to Reset Load Online Changes

Introduction
When you deactivate the Load Online Changes function, all changes recorded by the function
are deleted. If you want to record your changes again with the Load Online Changes function,
you must Runtime it again.
By resetting the download changes online function, you avoid an unwanted configuration being
transferred to an operator station. You can undo changes you have made and re-edit your
project with the Load Online Changes function activated.

Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.
2. Select the Reset command in the shortcut menu.
The following dialog is displayed:

3. Click on OK to confirm.
The recorded changes are deleted in the download changes online function and can no
longer be downloaded.
Note
If you edit a WinCC project which was created using the SIMATIC Manager, there will be no
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects
created in WinCC and subsequently imported into SIMATIC Manager by using the function
"Importing WinCC objects". This type of project is also called a TIA project.
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item
Load Online Changes in WinCC Explorer is displayed.
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See also
How to Download Load Online Changes (Page 119)
How to Activate Load Online Changes (Page 117)
Use and Limitations of Load Online Changes (Page 112)
Loading Online Changes (Page 108)
Requirements for Loading Online Changes (Page 110)
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1.8

Determining the Global Design

1.8.1

Global Design of the Objects

Introduction
In WinCC, you have numerous options for changing the way your projects appear in Runtime.
To do this, you choose from a series of predetermined and self-created designs. The design
contains colors, patterns and other optical effects.
You determine the global design in the project properties.

Global Designs
WinCC provides the following designs for the projects:
● WinCC Classic
The standard design as you know it from WinCC V6.2. This new design does not support
all new program elements as of WinCC V7.0.
● WinCC Simple
Simple design in light blue color tones.
● WinCC Glass
Design in dark blue color tones with a glass-like shimmer effect.
● WinCC 3D
Design in gray to black color tones with relief-like 3D design of the objects.
In addition to the provided designs, you can create, edit, rename and delete your own designs.

Design Features
The design contains determinations on the following properties of the objects:
● For all objects:
– Shadow
– Hover (changes the view temporarily, as long as the mouse pointer is over the object)
● Different for the different groups of object types:
– Style
– Color scheme
The design features of the global design cannot be used in full for all object types.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

125

Working with Projects
1.8 Determining the Global Design

Settings in the Object Properties
If nothing else is set in the object properties, the settings of the selected global design apply
to all graphical objects in the project.
Note
As soon as an attribute is determined by a global design, it remains static and can no longer
be made dynamic. Even a dynamization that has already been performed remains without
effect.
You can deactivate the global shadow and the global color scheme for an object in the object
properties.
For the Windows objects "Button", "Round Button and "Slider Object", you can accept the
global design or activate the user-defined settings. Alternatively, you can also accept the
display style of the Windows operating system for the button and the slider object.

Settings in the Computer Properties
The global design requires the recommended hardware equipment. You can improve the
computer's reaction behavior by switching off certain elements of the global design in the
WinCC computer properties.

See also
How to make computer-specific settings for runtime (Page 166)

1.8.2

The Elements of the Global Design

Introduction
The global design determines the uniform optical design of the process pictures. If you are
designing your own design, you have different options in the individual object groups.

Design Features of a Global Design
A global design has the following design features for the individual object types:
Object group

Objects

Style

Color scheme

Simple

Geometric object
(standard objects)

Single

Fill color (fill pattern color)
Background color
Fill pattern

Tubes
(tube objects)

Windows

Background color
(line color)

Background
(process picture)

Single

Fill color (fill pattern color)
Background color
Fill pattern
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Object group

Objects

Smart

Single
Text objects
(I/O field, combo box, list box, multi- Windows
line text)
Style 1

Text color (font color)
Fill color (fill pattern color)
Background color
Fill pattern

Bar graph
(3D bar)

Single

Text color (font color)
Fill color (fill pattern color)
Background color
Fill pattern

Button

Single
Color gradient
Rectangular
Aero glass

Text color (font color)
Background color

Round Button

Single
3D style
Aero glass
Sphere

Text color (font color)
Background color

Scroll bar
(Slider object)

Single
Color gradient
Rectangular
Aero glass

Background Color

Check/radio box
(check box, radio box)

Single

Text color (font color)
Fill color (fill pattern color)
Background color
Fill pattern

Display gauge / clock

Single
Color gradient
3D style

Text color (font color)
Fill color (fill pattern color)
Background color

Runtime controls

Single
Windows

Text color (font color)
Fill color (fill pattern color)
Background color

Menus/toolbars

Windows
Color gradient

Text color (font color)
Background color

Windows

Controls

Toolbar

1.8.3

Style

Color scheme

How to work with global object designs

Introduction
You can use global designs in WinCC. In addition to the provided designs, the designs that
you create on your own are also available.

Working with Designs
You can display the settings for the provided designs and edit your own designs. To adapt
your own current design, edit the design elements shadow, hover effect and color scheme.
You also have the following options:
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Function
Import design

Integrates another design in WinCC. Select the required design in the file
selection dialog.

Export design

Saves a selected design in XML format to use a design in another project.

Add new design

Adds a new design with an automatically assigned name to the list of designs.

Delete current design

Deletes the selected self-created design from the design bar.

Rename current design

Opens a dialog for renaming the current, self-created design.

Note
"WinCC Classic" ensures compatibility with WinCC versions before WinCC V7.0. For this
design only certain color settings are available. No other configuration options are offered.
If you configure changes in another global design, such as a central color palette, and then
change to the design "WinCC Classic", the changes are accepted and not reverted.
During export/import of the "WinCC Classic" design, only the color settings from this design
will be loaded.
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the shortcut menu. The "Project Properties" dialog opens.

2. On the "User Interface and Design" tab, click "Edit" next to "Active Design". The "Global
Design Properties" dialog opens.
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All existing designs are displayed in the upper bar. The preview shows how the objects will
appear for the selected objects.
To select a design for the current project, click its symbol and confirm with "OK".

1.8.4

How to edit your own global design

Introduction
You can determine the design of the objects globally, i.e. project-wide. You can select from
provided designs or create and activate your own designs.
The provided designs cannot be changed. You can only edit the designs that you create
yourself.
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the shortcut menu.
The "Project Properties" dialog opens.

2. On the "User Interface and Design" tab, click "Edit" next to "Active Design".
The "Global Design Settings" dialog opens.
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3. Click on
"Add new design".
A new design appears in the design bar.
4. Click on
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"Rename current design" and give the design a new name.
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5. If necessary, activate the shadow view and click on the "Shadow" button.
The "Shadow Settings" dialog is opened.

6. Set the shadow offset and the shadow color.
When you check "Synchronize", the offset in x and in y always remains the same.
7. Click "OK" to confirm the changes.
The "Global Design Settings" dialog opens again.
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8. If necessary, activate the hover effect and click on the "Hover" button.
The "Hover Settings" dialog is opened. The hover effect changes the object when the mouse
pointer is moved over it.

9. Set the desired hover effect:
– Increase brightness - when the mouse pointer moves over the object, the entire object
becomes brighter
– Inner glow - when the mouse pointer is moved over the object, the inside of the object
glows in the selected color
– Outer glow - when the mouse pointer is moved over the object, the edge of the object
glows in the selected color
10.Click "OK" to confirm the changes.
The "Global Design Settings" dialog opens again.
11.Under "Display", select the desired object group or the desired design element and set its
style and the associated color scheme.
12.Click "OK" to confirm the changes.
13.Click on "Apply" to save.
14.Click "OK" to close the dialog.
The created design is displayed in the preview.
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1.8.5

How to determine the global design of the objects

Introduction
You can determine the design of the objects globally, i.e. project-wide. You can select from
provided designs or create and activate your own designs.

Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the shortcut menu.
The "Project Properties" dialog opens.
2. On the "User Interface and Design" tab, click "Edit" next to "Active Design".
The "Global Design Properties" dialog opens.

3. Under "Designs", click on the desired design and confirm with "OK".
The selected design is displayed in the preview.
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Your Own Designs
You can edit your own designs in any manner. In particular, you can individually determine the
following settings:
● Global shadow
● Hover effect
● Style of an object group
● Color scheme of an object group
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1.9

Making Settings for Runtime

1.9.1

Settings for Runtime

Verifying Data Execution Prevention (DEP)
You need to verify and possibly adjust the performance options for data execution prevention
(DEP) prior to the initial start of Runtime.
1. Select the Control Panel in Start > Run.
2. Double-click "System" to open the system properties dialog.
3. Click "Settings" in the "Performance" field of the "Advanced" tab.
4. Select the "Data Execution Prevention" tab in the "Performance Options" dialog.
5. Activate the "Turn on DEP for essential Windows programs and services only" option if not
already active.
6. Click "Apply" and then confirm your entries with "OK".

Runtime settings
When starting Runtime, WinCC uses the settings that have been specified in the Computer
Properties dialog.
WinCC adopts the default settings for Runtime in every project. There are, however, some
settings you must make yourself.
You can change the settings for Runtime at any time. If a project is running in Runtime, while
you edit the settings, you must exit Runtime and restart. The changes are then applied.
Before you activate a project, you can specify the following settings.

Startup Tab
Entry

Function

Start sequence of WinCC Runtime

Applications that are loaded in Runtime

Additional tasks/ applications

Programs or tasks to start with WinCC Runtime (e.g. MS
Excel)
Make sure that you only start tasks that you actually need on
the computer.
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Parameters Tab
Entry

Function

Language Settings in Runtime

Runtime language

Default Language at Runtime

Runtime uses the text from this language if no text is available
in the set runtime language.

Start Information

<no function assigned>

Disable Keys

Prevent the use of certain combinations of keys

Time base for the clock shown in
Runtime

Base for setting the time in WinCC

PLC Time Setting

Valid time setting for the PLC

Central time and date formatting

Determines whether date and time are displayed in
accordance with ISO8601 everywhere or whether the format
can be set locally.

Graphics Runtime Tab
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Entry

Function

Project file

Shows the path and name of the current project file

Start Picture

PDL file opened as the starting picture in Runtime

Independent picture windows

Makes it possible to hide the main window in order to let
picture windows appear like independent windows

Start configuration of Menu and
Toolbars

Comfiguration file with customized menus and toolbars

Window Attributes

Appearance of the window in Runtime

Turn Off

Prevents operator input in windows and switches off memoryintensive picture operations

Hide system pictures

Restrict access to system pictures

Independent picture windows

Makes it possible to hide the main window in order to let
picture windows appear like independent windows

Cursor control: Behavior

Navigation with the cursor in the picture

Cursor control: Keys

Navigation with the cursor in the picture

Hotkeys

Key combinations for operator input and screen navigation
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Runtime Tab
Entry

Function

VBS Debug Options Graphics/Global
Script:
Start Debugger
(only suitable for test and startup
purposes)

Starts the debugger in Runtime, when the first picture is
selected with a VBS script.

VBS Debug Options Graphics/Global
Script:
Display Errors Dialog
(only suitable for test and startup
purposes)

Opens a dialog in Runtime if a VBS error occurs and allows
you to start the debugger. Script processing is interrupted.

Design settings

Makes it possible to switch off certain design options to
improve the response behavior of the computer.

Runtime options

Makes it possible to activate the monitor keyboard and
system dialogs

Picture Cache

Path for the temporary storage of pictures

Mouse Pointer

Actions of the mouse pointer in the picture

See also
How to Start Runtime (Page 170)
How to Set the Time Base in the Project (Page 100)
Effect of External Applications at Runtime (Page 143)
How to Assign Hotkeys in the Project (Page 142)
How to Set Up a Startup List (Page 139)
How to Specify the Computer Properties (Page 88)

1.9.2

How to Set Up a Startup List

Introduction
When you activate a project, additional program modules required for execution in Runtime
are loaded. In the startup list, you specify which applications will be started when you activate
a project.
Depending on the configuration, WinCC itself enters some applications in the startup list.
Graphics Runtime is always started and is activated by default.
To achieve better performance, you should only start applications that you actually require in
Runtime.
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Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.
WinCC displays the list of computers in the data window.
2. Select the computer and then click the Properties command in the shortcut menu.
The Computer Properties dialog is opened.
3. Click the Startup tab.

4. Activate the applications to be loaded when Runtime starts in the Start sequence of the
WinCC Runtime list box.
The activated modules are marked with a check mark in front of the entry in the list. With
the Edit button, you can open a dialog in which you can enter start parameters for an
application.
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5. If you want to open additional programs or tasks when you start Runtime, click the Add
button.
The Add Application dialog is opened.

6. Enter the application and the full path in the Application input box. You can locate the file
using the Browse button.
7. If required, select the start parameters, the working folder for the application, and the
window properties.
Click OK to confirm.
The added application is entered in the Additional Tasks/Applications box. With the Remove
button, you can delete an application from the startup list.
8. Select an application and click the Up and Down buttons. This is how you specify the order
in which the applications are started. The list of additional applications is read out from top
to bottom.
9. Click "OK" to close the dialog.

Multi-user system
In a multi-user system, make sure that you only start tasks on the client that the client really
needs.

See also
How to Specify the Computer Properties (Page 88)
How to set up Runtime (Page 145)
How to Start Runtime (Page 170)
Settings for Runtime (Page 137)
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1.9.3

How to Assign Hotkeys in the Project

Introduction
You can assign the following shortcut keys for your project:
● Logon opens a window to log on a user in Runtime
● Logoff opens a window to log off a user in Runtime
● Hardcopy opens a dialog for printing the screen in Runtime
● "System menu" opens the system dialogs in Runtime

Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the shortcut menu.
The "Project Properties" dialog opens.
2. Select the Hotkeys tab and choose the required action in the Actions list box.

3. Click in the Previously Assigned to input box. Press the required key combination.
WinCC indicates the actuated buttons.
4. Click the Assign button.
WinCC activates the keystroke for calling the action.
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5. Assign other shortcut keys to any other actions you require.
6. Click "OK" to close the dialog.

See also
How to Start Runtime (Page 170)
Preparation to Create a Project (Page 81)
Settings for Runtime (Page 137)

1.9.4

Effect of External Applications at Runtime

Introduction
There are numerous applications that can place a heavy load on a computer. These
applications have nothing to do with WinCC but affect the system resources.

Cyclic Printing
Printing large amounts of data can utilize a lot of resources. You should defined cyclic print
jobs so that they do not all start at the same time in Runtime.

Using Virus Scanners
The following virus scanners have been approved as of WinCC V7.2:
● Trend Micro "Office Scan" Client-Server Suite V10.6
● Symantec Endpoint Protection V12.1 (Norton Antivirus)
● McAfee VirusScan Enterprise V8.8
Note
When using a virus scanner, make sure that the computer has sufficient system resources.
Updates started automatically over the network can cause load on the system.

Screen saver
Using a screen saver takes up processor time. This can lead to overload on the system.
Defective screen savers that do not free up parts of the work memory significantly reduce the
useable work memory.
The Windows Start Action Screen Saver can be used.
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Optimizing Processor Utilization
During continuous operation, the usable work memory becomes badly fragmented after a time.
To allow Windows to reorganize the work memory, the average utilization of the processor
should be below 75 %. You can check the processor utilization in the Windows System Monitor.
If you cannot achieve processor utilization less than 75 %, you should upgrade your computer.

Defragmenting a Hard Disk
Using the Windows file system frequently can result in an unfavorable organization of the disk
memory, e.g. if changed data are saved during commissioning.
To avoid loss of performance, the hard disk drive should be optimized regularly.
NOTICE
Deactivating automatic optimization
When operating WinCC in Runtime, make sure that no automatic optimization is activated.
The time required for these activities can serious detrimental effects on WinCC performance.

Deactivating Power Management
To allow the WinCC Runtime system to operate correctly, power management must be
deactivated in the BIOS setup and in the Control Panel of Windows.
If power management is activated, you may encounter problems when archiving process data
and messages. The function can lead to a lack of resources when virtual memory is accessed.
Fast reactions to operator input are then no longer possible.

FindFast.exe
The Microsoft FindFast.exe application is used to accelerate searches for documents.
When configuring with WinCC, it is possible that FindFast.exe takes up a considerable
percentage of processor capacity. You should therefore remove Microsoft Indexing from the
Autostart folder of the operating system.

See also
Preparation to Create a Project (Page 81)
Settings for Runtime (Page 137)
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1.9.5

Setting up Runtime

1.9.5.1

How to set up Runtime

Introduction
To test a WinCC project in Runtime, first setup the project's applications and operator functions
that available in Runtime. These project settings must be adjusted for every computer on which
the project should run.
Using the "Computer properties" dialog, which is opened from WinCC Explorer, you can make
the following project settings:
● "General" tab
Configure computer name and computer type
● "Startup" tab
Define modules and applications, which are to be started using the command "Activate
Runtime".
● "Parameter" tab
Change default settings for Language and Time in Runtime and lock certain key
combinations
● "Graphics Runtime" tab
Change default settings for the use of process pictures in Runtime
● "Runtime" tab
User-specific settings for all WinCC projects on this computer

Requirement
● A project must be opened.

Open the "Computer properties" dialog
1. Select the entry "Computer" in the navigation window of the WinCC Explorer.
All computers that are available for the current project, will be displayed in the data window.
2. In WinCC Explorer's data window, double-click the desired computer.
The "Computer Properties" dialog will open.

See also
How to change the computer name (Page 146)
How to configure the applications available in Runtime (Page 148)
How to Specify the Computer Properties (Page 88)
How to Set Up a Startup List (Page 139)
How to Change the default settings for Language, Time and Key Combinations (Page 149)
How to define hotkeys for operation and screen navigation (Page 157)
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How to define a picture as the start picture in Runtime (Page 160)
How to configure the cursor control in Runtime (Page 162)
How to Activate Zoom Functions in Runtime (Page 164)
How to make computer-specific settings for runtime (Page 166)
Activating Project (Page 170)
The Graphics Designer in the WinCC Explorer (Page 259)
Virtual keyboard - General Information (Page 702)
How to set up a picture for mouseless operation (Page 706)
Process Pictures in Runtime (Page 689)

1.9.5.2

How to change the computer name

Introduction
To test a WinCC project in Runtime, the local computer name must be entered as a computer
name in the project.
The computer name is changed on the "General" tab in the "Computer properties" dialog.

Requirement
● A project must be opened.
● The "Computer properties" dialog must be open.
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Procedure
1. Click the "General" tab.

2. Enter the name of the computer in the "Computer name" field.
3. In the "Computer Type" area, define which function is performed by this computer.
4. Confirm your entry with "OK".
The changed computer name will not be applied until WinCC is restarted.

See also
How to set up Runtime (Page 145)
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1.9.5.3

How to configure the applications available in Runtime

Introduction
The "Runtime" command is used to load additional program modules, which are required for
the execution of Runtime. To ensure the maximum performance, activate only the applications
that are actually needed in Runtime.
The applications, which will be available in Runtime, are configured on the "Startup" tab in the
"Computer properties" dialog.
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Start sequence of WinCC Runtime
Select the modules that should be loaded while activating Runtime. The activated modules
will be identified by a tick in front of each associated entry in the list.
Click the "Edit" button to modify the start parameter for a selected Runtime module.

Additional Tasks / Applications
In addition to the modules given in the upper area, other applications can be also be linked to
start with the "Runtime" command.
Click the "Add" button to add the required applications to the list. You can clear an entry from
the list by selecting it and then clicking on "Remove".
Click the "Edit" button to modify the start parameter for a selected application.
To change the sequence in which the individual applications are started, use the "Up" and
"Down" buttons to rearrange the selected entries in the list. The list of additional applications,
which should be started, is read from top to bottom.

Note
Each module requires computing power. Therefore, make certain that you only activate the
modules that will be needed in Runtime.

See also
How to set up Runtime (Page 145)

1.9.5.4

How to Change the default settings for Language, Time and Key Combinations

Introduction
The configured language and the display mode for the time can be preset before activating
Runtime. It is also possible to lock specific key-combinations.
The default settings for language, time and key-combinations are configured on the
"Parameters" tab in the "Computer properties" dialog.
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Language Settings in Runtime
Select the language with which the project should be activated in Runtime on the selected
computer.

Default language at Runtime
Select the alternate language in which the text of graphics objects is supposed to be displayed
if the respective translations do not exist in the language specified under "Language Setting
at Runtime".
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Disable Keys
To prevent operator errors in Runtime, Windows-typical key-combinations can be locked.
Activate a check box to lock the respective key combination in Runtime.

PLC Time Setting
Select the time setting that is valid for the PLC. A detailed description can be found in the
chapter entitled "Time Settings in WinCC".

Time base for the time shown in Runtime
Select the mode for displaying the time in Runtime and in the report system. The following
options are available "Local time zone", "Coordinated world time (UTC)" and "Server's time
zone".

Central date and time formatting
Specify if date and time formatting should be configured at the components or if it should be
forced at all components using the ISO 8601 format. A detailed description can be found in
the chapter entitled "Time Settings in WinCC".

See also
Setting Time in WinCC (Page 97)
How to set up Runtime (Page 145)

1.9.5.5

How to specify favorite process pictures

Introduction
In WinCC Explorer you can mark process pictures as favorites. You can select these marked
process pictures in Runtime by means of system dialogs, "Favorites".

Procedure
1. Left-click the "Graphics Designer" entry in the navigation window of WinCC Explorer.
The data window displays all process pictures of the current project (PDL format).
2. Right-click the selected process picture and then select the "Mark picture(s) as favorite".

Alternative Procedure
You may mark multiple process pictures simultaneously as favorites:
Press <CTRL> while left-clicking the process pictures to be marked as favorites.
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Result
The selected process picture is identified with a star symbol. You can select the process picture
in the runtime system dialogs by clicking "Favorites".

1.9.5.6

How to set up the system dialogs

Introduction
Activate access to the system dialogs in RT prior to the start of runtime. Make the two following
settings for the project:
● Activate the system dialogs
●

Specify the hotkey or activation action

You can activate the system dialogs in a project for all computers, or for a single computers
only.
Note
The system dialogs are not available in PCS 7 environments.
Note
Runtime system dialogs:
The system dialogs are called in Runtime by means of hotkey or activation action.
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Procedure
1. Right-click the project name in the navigation window of WinCC Explorer and then select
"Properties" from the shortcut menu.
The "Project Properties" dialog opens.
2. Click the "User interface and design" tab and set the "Activate Runtime System Dialogs"
check box.

3. Specify a hotkey or activation action in the "HotKeys" tab. (Page 157)
4. Click "OK" to close the dialog.
Proceed as follows to activate the system dialogs on single computers:
1. Open the "Computer properties" dialog.
2. Select the "Runtime" tab.
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3. Set the "Activate Runtime System Dialogs" check box.

4. Click "OK" to close the dialog.

Result
You can call the system dialogs by means of hotkey or activation action after the start of
Runtime.

1.9.5.7

How to change the language in Runtime

Introduction
After the start of runtime, you can change the language in the process pictures by calling the
system dialogs. The languages are displayed with their national flag.
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Requirements
● System dialogs are activated
● Hotkeys or activation actions are available.
● Runtime has started.

Procedure
1. Launch the system dialogs by pressing the defined hotkey, or by means of activation action
on the touch screen.
Note
The "Languages" button is only displayed in the system dialogs if more than one language
was configured in the text library.
2. Click "Languages" in the system dialogs.
The language menu opens.

3. Click the flag icon to select the language.
The language-dependent parts of the process pictures are no displayed in runtime in the
selected language.

See also
How to set up the system dialogs (Page 152)

1.9.5.8

How to navigate in process pictures in Runtime

Introduction
After the start of runtime, you can use the system dialogs to navigate in process pictures.

Requirements
● System dialogs are activated
● Hotkeys or activation actions are specified.
● Runtime has started.
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Procedure
1. Launch the system dialogs by pressing the defined hotkey, or by means of activation action
on the touch screen.
The system dialogs provide the following options for process picture navigation:
Button

Description
"Start picture": Calls the process picture that is
defined s start picture.

"Forward": Navigates to the next process picture.

"Back" Navigates to the previously called process
picture.

"Favorites" Displays a selection of the process
pictures that were marked as favorites.

Note
Favorites view in the system dialogs:
The "Favorites" button is hidden in the system dialogs if no process pictures were marked as
favorites.
You can run a preview of the favorites in the favorites view using the mouse wheel or
touchscreen input.
Visualization
You may toggle between the 3D and 2D views, depending on the graphics adapter that you
are using.
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See also
How to set up the system dialogs (Page 152)
How to change the language in Runtime (Page 154)

1.9.5.9

How to define hotkeys for operation and screen navigation

Introduction
You can operate the process pictures even if you cannot control them with a mouse. Key
combinations must be defined for the required operating functions.
You specify the most important shortcut keys for operation without a mouse in Runtime in the
"Computer properties" dialog on the "Graphics Runtime" tab.
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Procedure
1. Click in the entry field for the desired function to activate it for the entry of a shortcut key
(combination).
2. Press the required shortcut key and keep it pressed.
You can use <Ctrl>, <Alt> or <SHIFT> as shortcut keys.
3. Also press the key that is to call up the function.
The selected key combination is displayed in the input field, e.g. <Alt+F>.
4. Click the input field again to change your entry.
You can also use individual keys or one of the function keys <F1> to <F12> instead of a key
combination.
Note
You may not configure the function key <F12> as system-wide shortcut key.
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Hotkey
Changes made to the shortcut keys are first effective after the system has been restarted.
Window On Top
This shortcut key is used to navigate between multiple picture windows, which are configured
in a main picture. The shortcut key activates the next picture window for an operation.
Tab or Alpha Cursor
This shortcut key toggles the "Cursor Mode" attribute. You can use it to operate a process
picture with the alpha cursor and the tab order. A TAB sequence must be configured for both
types of cursor.
Runtime Cursor On/Off
By default, the selected object in Runtime will not be highlighted. Use this shortcut key to
activate a Runtime cursor that highlights the currently selected object with a frame.
Note
You cannot use the keys <Del> and <Home> as shortcut key.

Screen navigation
In the "Screen navigation" area you configure shortcut keys that let you make a simple switch
between the process pictures called up last. Process pictures will be recorded in a temporary
list whenever they are called. Use the "Forward" or "Backward" function to scroll through this
list.
Note
You may also use the system dialogs in Runtime to navigate through pictures.
Note
Screen navigation is blocked if a button with the action of a picture change is configured in
one of the pictures which is triggered with the event "Press keyboard" or "Release keyboard".
The configured action is executed instead of navigating through the pictures using the set
shortcut keys.
You specify the maximum permitted number of entries in this list with "Picture buffer size". If
this number is exceeded, the oldest entry will be replaced when a new picture is called.
You can define shortcut keys for the following functions:
● "Forward": Calls up the next configured process picture.
● "Backward": Calls up the previously configured process picture.
● "Start picture": Calls the picture that has been defined as the start picture.
● "Stored Picture": Calls up the picture identified last with the function "Store picture".
● "Store picture": Memory function for the currently displayed picture.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

159

Working with Projects
1.9 Making Settings for Runtime

Note
With the default value for "Picture Buffer Size", the list will record the calls for a maximum of
30 pictures. As a rule, it is not reasonable to substantially increase this value, since the
switchover can only be done in single steps. You can achieve more efficient screen navigation
using picture modules.

See also
How to set up the system dialogs (Page 152)
How to configure the cursor control in Runtime (Page 162)
How to set up Runtime (Page 145)
Virtual keyboard - General Information (Page 702)
How to set up a picture for mouseless operation (Page 706)

1.9.5.10

How to define a picture as the start picture in Runtime

Introduction
Runtime can only be started, when one of the project's process pictures has been defined as
the start picture. This start picture will be displayed when Runtime is activated from WinCC
Explorer.
The start picture is defined on the "Graphics Runtime" tab card in the "Computer properties"
dialog.
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Requirement
● A project must be opened.
● The "Computer properties" dialog must be open.

Procedure
In the "Start picture" field, enter the name of the desired picture file in the PDL format or click
the "Find..." button to select it.
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Alternative Procedure
1. Click in the navigation window of the WinCC Explorer with the left-hand mouse button on
the entry "Graphics Designer".
All pictures of the current project are displayed in the data window (format PDL).
2. Now right click the desired picture and select "Define screen as start screen".
The selected picture is entered into the "Start picture" field in the tab "Graphics Runtime".

See also
How to set up Runtime (Page 145)
The pop-up menu in the Data Window (Page 269)

1.9.5.11

How to configure the cursor control in Runtime

Introduction
In process pictures with objects arranged in a tabular form, it is possible to define a cursor
control to permit mouseless navigation between the configured objects.
The shortcut keys for the cursor control and the behavior of the cursor are set on the "Graphics
Runtime" tab in the "Computer properties" dialog.

162

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Projects
1.9 Making Settings for Runtime

Reaction
Specify how the cursor should react in a table of listed objects, once it has reached the last
object in a line or column: This requires all objects are assembled as a complete table. The
table cannot have gaps. The height and width of the objects must be identical and the objects
must be arranged vertically and horizontally to the exact pixel.
Normal
The cursor returns to the first object in the same line or column.
Normal without rollback
The cursor remains positioned on the last object in the line or column.
Extended
The cursor continues to the first object in the next line or column.
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keys
Four shortcut keys can be defined here for cursor control in Runtime.
First select the desired combination key by placing a tick in the associated check box. Then
press a key for the desired cursor direction in the corresponding entry field.
Select the option "Turn on during activation", if the shortcut keys for cursor control should
always be available in Runtime.

See also
How to set up Runtime (Page 145)
Virtual keyboard - General Information (Page 702)

1.9.5.12

How to Activate Zoom Functions in Runtime

Introduction
Zooming in Runtime is supported by three techniques:
● Decluttering
Layers and the objects stored there can be shown and hidden. Limit values for masking
and unmasking of objects are specified in menu "Tools>Settings" on the "Hide/Show" tab
of Graphics Designer.
● Extended Zooming
The view of the process picture in Runtime may be zoomed in or out using the mouse wheel.
Hold the <CTRL> key down while turning the mouse wheel. If you turn the mouse wheel
away from the palm of your hand, you increase the zoom factor.
● Panning
If a picture has a zoom factor that shows the picture with scrollbars, you can move a picture
cutout within the document. A navigation crosshair appears upon clicking on the mouse
wheel. Moving the mouse pointer scrolls in the desired direction. The distance between
mouse pointer and navigation crosshair determines the scrolling speed. Another click will
deactivate panning.

Conditions for Using Zoom Function:
● a mouse driver by Logitech or Microsoft Intellimouse
● the mouse wheel must be set to "Autoscroll".
Both functions Decluttering and Extended Zooming may be turned off in the "Graphics
Runtime" tab of the "Computer Properties" dialog. Activate the checkboxes of both respective
entries in the area "Turn off". In the default setting the checkboxes are deactivated, i.e. the
functions Decluttering and Extended Zooming are turned on.

Configuring Extended Zooming Picture-Specific
The function Extended Zooming may be turned on or off picture-specific. The setting is
specified in the object properties of the selected picture in the "Miscellaneous" property group.
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If you turn of the function Extended Zooming for a process picture, Extended Zooming must
also be turned on for all process pictures in the "Graphics Runtime" tab of the "Computer
Properties" dialog.

A detailed description of the zoom function may be found in Chapter "Showing and Hiding
Layers and Objects".

Note
WinCC Controls cannot be decluttered, except for "WinCC Slider Control", "WinCC Clock
Control" and "WinCC Gauge Control".
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See also
How to set up Runtime (Page 145)
Showing and hiding layers and objects (Page 314)
Elements and Basic Settings of the Graphics Designer (Page 277)
Zoom palette (Page 294)

1.9.5.13

How to make computer-specific settings for runtime

Introduction
Some additional functions for WinCC Runtime can be activated in the Runtime tab in the
Computer Properties dialog.
The following settings can be made:
● Set debug options for Visual Basic scripts in Graphics Designer
● Set debug options for Visual Basic scripts in Global Script
● Restrict global design effects
● Activate Runtime options
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● Use picture cache
● Change mouse pointer

Start Debugger
If the function "Start Debugger" is activated, the debugger is started when you start the first
VB script in Runtime. A debugger for Visual Basic must be installed. The function speeds up
the troubleshooting during the planning phase.
The option "Start Debugger" can be activated separately for VBS in pictures of the Graphics
Designer and in Global Script.

Display Errors Dialog
If the function "Display error dialog" is activated, an error dialog with information on the error
that occurred is displayed when an error occurs in VBS. You can start a debugger using a
button in the error dialog. A debugger for Visual Basic must be installed.
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The option "Display error dialog" can be activated separately for VBS in pictures of the Graphics
Designer and in Global Script.

Design settings
The global design requires the recommended hardware equipment. You can improve the
computer's reaction time by switching off certain elements of the global design:
● Using "WinCC Classic" design: WinCC Runtime appears in the WinCC Classic Design
regardless of the settings in the project properties. Not all WinCC program elements can
be used in WinCC Classic Design.
● Deactivating shadow: The shadow is generally switched off in the process pictures.
● Deactivating background/progressions: Switches off the background picture and the color
progressions.

Runtime options
Monitor keyboard
A tick in the "Enable monitor keyboard" check box will cause the virtual keyboard to be activated
when WinCC Runtime is started. For further information, please see the section entitled
"Monitor keyboard".
Runtime system dialogs
The system dialogs for the individual computers are activated with the "Activate the runtime
system dialogs" check box.
Hardware accelerated graphics representation (Direct2D):
Direct2D is used to display the graphics. Soft shadows are displayed.
Direct2D can be disabled for individual computers for performance reasons even if Direct2D
is enabled in the project settings.
Direct2D is always disabled in the following cases:
● In the case of integrated operation in the SIMATIC Manager
● When Basic Process Control is used (process control options)
● In process pictures containing ActiveX controls
Operating system requirements for the use of Direct2D:
● Windows 7 SP1 incl. Update KB2670838
● Windows Server 2008 R2 SP1 incl. Update KB2670838
● Windows 8.1

Picture cache
To show Runtime pictures, WinCC usually accesses the connected WinCC server and calls
up the current pictures there. Use "Picture cache" to store the WinCC pictures locally on the
computers. The option only makes sense for WinCC clients that are connected with a WinCC
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server using a telecommunication connection. The client does not have to permanently load
the pictures.
The required pictures must be saved on the client computer which should use the picture cache:
1. On the client computer, create the folder "PDLCache" in the folder <installation directory
\bin>. This folder is stored as standard directory in the WinCC project.
2. If you select a different folder, enter this folder in the "Path" field. Enter the path to the
directory in which the folder "PDLCache" is located.
3. In the folder "PDLCache", create a folder named after the server prefix of the server.
4. Copy the pictures to the server prefix folder.
Example:
● Path for picture storage: C:\WinCCProjekt\Pictures\PDLCache\<server prefix>
● Entry in "Properties" field: C:\WinCCProjekt\Pictures\
You have the following selection with the "Use cache" selection field:
Selection

Function

Never

The picture cache is not used.

Preferred

Changed pictures are read by the server. Pictures that are not changed are read from the picture cache.

Always

Pictures are always read from the picture cache.

Note
If a picture is changed on the WinCC server, you have to update the picture manually in the
picture cache.

Mouse pointer
Use the "mouse pointer" to configure other cursor representation for operation of WinCC
Runtime. With the
button, open the file selection dialog and navigate to the place where
the cursor is saved. Select the desired cursor. The cursor data must be available in the "cur"
or "ani" file format.

See also
Global Design of the Objects (Page 125)
How to set up Runtime (Page 145)
Virtual keyboard - General Information (Page 702)
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1.10

Activating Project

1.10.1

Activating Project

Introduction
If you want to operate and monitor a process, you have to activate the respective project.
WinCC starts Runtime and activates communication with the programmable controller. All
process data is stored in the Runtime databases.
In this chapter, you will learn
● the settings you can make in Runtime
● how to Runtime a project
● how to deactivate a project
● how to Runtime a project automatically when you boot your computer
Note
When you start WinCC or open a project, holding down the keys <CRTL>+<SHIFT>
prevents WinCC from activating Runtime at the same time.
If you keep the key combination <Alt+Shift> pressed when you start WinCC, you prevent
WinCC from opening a project at the same time. This also prevents Runtime being started
at the same time.

See also
How to Exit Runtime (Page 174)
How to Set Up Autostart (Page 173)
How to Start Runtime (Page 170)
Settings for Runtime (Page 137)

1.10.2

How to Start Runtime

Introduction
When you start Runtime, you activate your project. All configured processes are started and
run if the status of the system permits. You can also activate your project on a test system.
You may receive error messages, however, it processes cannot run as intended on the test
system.
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Principle
You can start Runtime in several ways:
● From the toolbar of the WinCC Explorer
● From the menu bar of the WinCC Explorer
● When you start WinCC
● From Autostart when you start the Windows system
During configuration you can call individual pictures in Runtime:
● From the toolbar of the Graphics Designer
● From the menu bar of the Graphics Designer

Requirements
● The computer must have the required Runtime license installed.
● The DEP settings must have been verified.
● The correct computer name must be entered in the project.
● A picture must be specified as the start picture.
Note
On project activating, free memory space of at least 100 MB must be available.

Procedure
1. Open the required project in the WinCC Explorer.
2. Click the toolbar button
.
The "Activate DATABASENAME" dialog opens. WinCC displays the applications that will
be started. The WinCC Runtime window opens with the settings you selected in the
Computer Properties dialog.
Note
During start of WinCC or during opening of a project, holding down the key combination
<SHIFT>+<CTRL> prevents that WinCC activates the project immediately.
When starting WinCC, if you hold down the keys <SHIFT>+<ALT>, you prevent WinCC
opening a project immediately. This also prevents Runtime being started at the same time.
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Alternative Procedures
Menu Bar of the WinCC Explorer
Open the File menu in the menu bar and select the Activate command. As long as Runtime is
activated, WinCC displays a check mark beside the Activate command.
When you start WinCC
You can exit WinCC while a project is activated. When you restart WinCC again, WinCC opens
the project and starts Runtime immediately.
Autostart when You Start the Windows System
You can also start WinCC using Autostart when the computer starts up. You can also specify
that WinCC starts immediately in Runtime.
Graphics Designer
You can call a picture opened in the Graphics Designer in Runtime. If Runtime is already open,
the picture replaces the current screen.
You can use this function in the following situations:
● You want to test a picture in Runtime.
● You want to update a picture in an activated project without any delay.
Click the toolbar

button to start Runtime.

In the menu bar, you can start Runtime in the File menu with the Activate Runtime command.
Note
You cannot exit Runtime from Graphics Designer. Exit Runtime in WinCC Explorer.

Multi-User Systems
In a multi-user system you must start Runtime on all servers first. Once all projects are activated
you start Runtime on the WinCC clients.
Redundant Systems
When you start a project in a redundant system, you must first start Runtime on the master
server. You can then start Runtime on the standby server.
Activating the project remotely
In a multi-user system, you can activate a project on a computer from another computer. You
must have the necessary access rights. You find more detailed information in the WinCC
Information System under Configurations > Multi-User Systems.

See also
How to Set Up Autostart (Page 173)
How to Exit Runtime (Page 174)
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Settings for Runtime (Page 137)
Opening WinCC Explorer (Page 36)

1.10.3

How to Set Up Autostart

Introduction
When you boot your computer, WinCC can be started with a selected project. Specify the
project to be opened using the "AutoStart Configuration" tool.

Variants of Autostart
When you set up Autostart, you have the following options:
Setting in Autostart

Action when the Windows system starts

Opening a Project

WinCC starts up. The project is opened in the WinCC Explorer.
If the project was activated when you last exited, Runtime starts.

Add an alternative / redundant
project

If you wish to start a client with redundant servers using autostart,
also enter the alternative/redundant project into the autostart
configuration. If the server is not available, the alternative project
is started after a certain amount of time.

Activate project at startup

WinCC starts up. The project is started in Runtime. the WinCC
Explorer is not opened.
If the autostart configuration of the client has set the check box
Activate Project at Startup and the server is in CS and is available,
the server and then the client will be activated.

Allow "Cancel" on activation

WinCC starts up. If the project is started in Runtime, you can use
the "Cancel" button to cancel activation of it.

Note
In the case of autostart on a client without a separate project, the user needs the "Configure
remote" WinCC system authorization. The project is opened implicitly in the background on
the client during autostart.
After the overall loading from the Engineering Station (ES) to the Operator Station (OS), you
must reconfigure autostart on the client for safety reasons. You must enter user name and
password again.
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Procedure
1. Open the Windows start menu and select "SIMATIC > WinCC" and then the "Autostart"
command.
The "AutoStart Configuration" dialog opens.
button beside the Project box.
2. Select the required project by clicking the
The project file and its full path are entered in the box.
3. If you want the project to be opened in Runtime, check the "Activate project at startup" box.
4. Click the "Activate Autostart" button.
The next time you boot the computer, WinCC starts automatically and the selected project
is opened.

Removing WinCC from Autostart
If you no longer want WinCC to start when you boot the computer, you can remove the project
from Autostart.
Open the "AutoStart Configuration" dialog and click the "Deactivate Autostart" button. WinCC
is removed from Autostart. The project path remains registered in the Project box.
Note
If you have configured Autostart for a project, the project is also restarted when the "SIMATIC
WinCC CCProjectMgr" service is restarted.

See also
Opening WinCC Explorer (Page 36)
How to Start Runtime (Page 170)

1.10.4

How to Exit Runtime

Introduction
When you exit Runtime, you deactivate your project. All active processes are stopped.

General procedure
You can exit Runtime in several ways:
● From the toolbar of the WinCC Explorer
● From the menu bar of the WinCC Explorer
● When you close a project
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● When you close the WinCC Explorer
● With a C Action in the activated project

Procedure
1. Change to the WinCC Explorer.
button in the toolbar.
2. Click the
The Deactivate DATABASENAME dialog is opened. WinCC displays the applications that
will be exited. The WinCC Runtime window is closed.

Alternative procedure
Menu bar of the WinCC Explorer
Open the File menu in the menu bar and select the Activate command. WinCC removes the
check mark beside the command indicating that Runtime is activated.
Closing the Project
You can close the project running in Runtime. This deactivates the project.
Closing the WinCC Explorer
You can close WinCC while a project is activated. This deactivates the project.
Note
After starting, WinCC always opens the last project that was open before you exited. If the
project was activated when you exited WinCC, it will be opened in Runtime again.
C Action in the Activated Project
You can, for example, configure a button in the project with which you can exit Windows. To
do this, use the Exit WinCC Runtime and Exit WinCC dynamic wizards.

Multi-user systems
In a multi-user system, you can deactivate a project in any order on the servers and clients. If
you first exit Runtime on a server, the boxes with the missing process values in the client
projects are deactivated (gray). As soon as you start the corresponding server again, WinCC
adopts the current values in the client project.

Deactivating a Project from a Remote Computer
In a multi-user system, you can deactivate a project on a computer from another computer.
You must have the necessary access rights. You find more detailed information in the WinCC
Information System under Configurations > Multi-User Systems.
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See also
How to Start Runtime (Page 170)
Closing WinCC Explorer (Page 39)
Dynamizing Using Dynamic Wizard (Page 1017)
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1.11

Copying and Duplicating Projects

1.11.1

Copying and Duplicating Projects

Introduction
You copy or duplicate a project with all important data onto the local or another computer using
the Project Duplicator.
A project can be copied using the "Save As ..." feature in the following cases:
● You want the same project to be edited on several computers.
● You want a project to run in a multi-user system on several computers.
● You want to edit a project and use the download changes online function.
● You want to archive a project as a backup.
After you have copied the project, you can save it to a storage medium.
You duplicate a project in the following case:
● You want a project to be duplicated on a redundant server.

See also
How to duplicate a redundant project at runtime (Page 183)
How to Duplicate a Project for Redundant Servers (Page 180)
How to Copy a Project (Page 177)

1.11.2

How to Copy a Project

Introduction
You can copy the configuration data of a closed project.
Note
The copying of variables or structure types from an open project to another project is not
allowed. For example, you open an old project and copy a structure type and the structure
variables. Then you open a new project and add the structure type and the structure variables.
Make regular backups of a project during configuration. This allows you to go back to a
previous version of the project and continue from there.
If you modify a project later, you should also make a backup on completion of each change.
If necessary, you can then revert to the original version without having to edit the project
again.
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Principle
Select the project you want to copy in the Project Duplicator.
Enter the folder into which the project will be copied. In the description below, this folder is
called the target folder.
The target folder can be on the same computer or on another computer in the network for
which you have access rights. The project folder is created in the target folder. When you copy
it, you can change the name of the project. The project folder is created with the project name.
You can only copy the entire project and the entire folder structure. The "ArchiveManager"
folder will not be copied.
After the project has been copied, you can open and edit or activate it immediately. If you open
the project on another computer, you must change the computer name.
Note
If the Duplicate or Save As ... options of the Project Duplicator are used, the same WinCC
version must be installed on the target computer.
Projects created using SIMATIC Manager should not be copied using the Project Duplicator.
Copying to a storage medium
You cannot copy a project directly to a data medium. If you want to copy a project to an external
data medium for archiving, copy the project to a local folder. Then copy this folder to the data
medium.
If you compress the project files before copying, for example in a ZIP archive, you need less
space on the data medium. This approach also prevents each file from becoming read-only
after copying.

Copying a project with project-based access protection
SIMATIC STEP 7 must be installed in order to create a copy of a WinCC project with projectbased access protection.
When you click the "Save As" button in the "WinCC Project Duplicator" dialog, you have to
enter the password for the STEP 7 project.
If SIMATIC STEP 7 is not installed or you enter the wrong password, the Project Duplicator
aborts with an error message.

Requirements
● The project to be copied must be closed. Another project may remain open on the source
computer and may run in Runtime.
● The target folder has been created.
● You have access rights for the target folder.
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● No WinCC project must be open on the target computer since write-protected or systemaccessed data cannot be overwritten by the Project Duplicator.
● The target computer has enough free space on the hard disk.

Procedure
1. In the Windows start menu, select "Project Duplicator" under "SIMATIC > WinCC > Tools".
The WinCC Project Duplicator is opened.

2. Enter the project you want to duplicate in the "Select the source project that is to be
duplicated" field. Enter the path and the <PROJECT>.MCP project file directly or search
for them by clicking the
button.
3. Click the Save As... button. The "Saves a WinCC project" dialog is opened.

4. Select the folder to which you want to copy your project and enter the name of the project
in the "File name" field.
If you wish to save a copy of the project with a different name, enter the new name. The
project files are renamed accordingly when the project is copied.
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5. Click on the "Save" button.
The "Copy ..." window opens. When copying, the Project Duplicator displays the files and
folders with a progress bar. Use the "Cancel" button to stop the copying.
6. Close the Project Duplicator with the Close button.
7. If you have copied the project to another computer, the original computer name is still
entered in the project properties. Correct the computer name in the project properties when
the project is opened for the first time. The modified computer name is adopted after you
close and open the project again.

Alternative procedure
You can also copy a project in the SIMATIC Manager using the "Download to CPU" feature.
For more detailed information, refer to the WinCC Information System under "Working with
WinCC > Integration of WinCC in the SIMATIC Manager".

Copying a multi-user project
If you copy a multi-user project to another computer, you must adapt the computer name after
opening the project.
If you have already created packages in the copied project, the old computer name will be
used when the packages are generated. Before the packages are created, correct the
computer name in the "Symbolic computer name" and "Physical computer name" fields.

1.11.3

How to Duplicate a Project for Redundant Servers

Introduction
The two redundant servers must be set up to be functionally identical with regard to their
hardware and software. After completing the WinCC configuration and after every change in
the WinCC project, use the WinCC Project Duplicator to generate the redundant partner
project.
The Project Duplicator performs the following:
● Copying of all associated project data, such as pictures, scripts and archives to the
redundant partner.
● Configuring all the required settings on the target computer, if the computer is already
configured for the use of WinCC Redundancy.
You must change computer-specific settings manually afterward.
Note
To transfer a project to a redundant server, you cannot use the Windows Explorer.
You can save minor changes using the function for downloading changes online in SIMATIC
Manager and then transfer them to the servers in runtime.
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Principle
Select the project you want to duplicate in the Project Duplicator.
Specify the target computer and folder in which the project is duplicated. The project folder is
created in this target folder.
You cannot duplicate a project on the local computer. You always duplicate a project on another
computer in the network to which you have access rights.
Depending on the status of the project, you can copy the configuration data and the runtime
data into the selected folder:
Project Status

Configuration Data

Runtime Data

Project closed

+

+

Project open and deactivated

+

-

Project in Runtime

+

-

You can only duplicate the entire project and the entire folder structure. You cannot exclude
any data or folders from the duplicate operation.

Requirements
● The WinCC Redundancy option is installed on both computers.
● The target folder for the duplication is created on the target computer and is made available
for access.
● You have access rights for the target folder.
● The target computer has enough free space on the hard disk.
● The correct WinCC version must be installed on the target computer. The computer must
be started.
● Runtime is deactivated on the target computer.
● The project is closed on the target computer.
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Procedure
1. In the Windows start menu, select the "Project Duplicator" entry in the "SIMATIC > WinCC
> Tools" folder. The WinCC Project Duplicator is opened.

2. Enter the project you want to duplicate in the "Select the source project that is to be
duplicated" box. Enter the path and the <PROJECT>.MCP project file directly or search by
clicking the
button.
3. Enter the path where the duplicated project will be stored in the "Store duplicated project
for redundancy partner at" box. Enter the folder path and the <PROJECT>.MCP project file
directly or search by clicking the
button.
4. Click the Duplicate button.
The "Copy" window is opened. During duplication, the Project Duplicator displays the files
and folders with a progress bar. Use the "Cancel" button to stop duplication.
After duplicating the "Notes on the Project Duplicator" window is opened. WinCC indicates
the settings that you still need to check.
Note
If you duplicate an open WinCC project on the source computer, no progress bar will be
displayed.
5. Close the Project Duplicator with the Close button.
6. Check the settings in the duplicated project and change them if necessary.
7. Check the following:
– The computer name.
– The settings in the Redundancy Editor.
– If necessary, the settings in the editors.

Duplicating a project with project-based access protection
SIMATIC STEP 7 must be installed in order to transfer a WinCC project with project-based
access protection to a redundant server.
When you click the "Duplicate" button in the "WinCC Project Duplicator" dialog, you have to
enter the password for the STEP 7 project.
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If SIMATIC STEP 7 is not installed or you enter the wrong password, the Project Duplicator
aborts with an error message.

1.11.4

How to duplicate a redundant project at runtime

Introduction
If you edit a redundant project, you can also update the project on the redundant server during
operation.
You can save minor changes with the Save Online Changes function and then transfer them
to the servers. You should also refer to the documentation on the topic of "Load Online
Changes".

Duplication using the Project Duplicator
Some configuration cannot be saved by the download online changes function. In this case,
you must generate a duplicate of the project to the redundant server using the Project
Duplicator.
Note
No Redundancy
For changes during normal operation, you must deactivate one of the partner servers. During
this time, no redundancy is available.

Requirements
● The target folder has been created.
● You have access rights for the target folder.
● The redundant server on which the copied project will be stored has enough free hard disk
space.

Procedure
This chapter describes how to use this function in a redundant system with the two servers
Server1 and Server2.
1. Exit Runtime on the redundant Server1 and close the project.
2. Make the configuration changes on Server2 in Runtime and save the changes.
3. Start the Project Duplicator on Server2.
4. Use the "Duplicate" button to duplicate the project on Server1 to the target folder of the
project deactivated under "1." and overwrite the project.
5. Open the project on Server1.
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6. Check the settings.
7. Start Runtime and wait for the redundancy synchronization.
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1.12

Appendix

1.12.1

Editors and Functions in WinCC Explorer

Introduction
You can see the installed WinCC editors and functions in the navigation window of the WinCC
Explorer. The editor belonging to an option is only visible in the navigation window when the
option is installed.
Some tools and some WinCC options are not displayed in the WinCC Explorer. You can open
the tools in the Windows Start menu in the Simatic folder under WinCC > Tools. You can open
some of the editors of the WinCC options independently of WinCC. For more detailed
information, refer to the help on the specific options.

Opening an Editor
You can open an editor in the WinCC Explorer in the following ways:
● Using the shortcut menu of the editor in the data window or in the navigation window
● By double-clicking the editor in the navigation window

List of Editors and Functions
The following two tables list all editors and functions that you can open using the WinCC
Explorer.
The tables contain the following information:
● Object:
Name of the editor or function in the WinCC Explorer.
● Use:
Information on what the object is used for.
● Online Help:
Refers to the relevant chapters in the WinCC Information System that contain more detailed
information on the object.
● Import/Export Tools:
Refers to tools which can be used to import or export data.
● Switch language:
Indicates whether or not foreign languages can be configured.
● Online Configuration:
Indicates whether or not the object can be used while the project is active in Runtime. You
find information on restrictions regarding online configuration in chapter Online
Configuration and in the description of the editors.
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Object

Usage

Online Help 1)

Import/Export
Tools

Language
Switching

Online
configuration

Computer

Computer name and
properties, project
properties (client and
servers)

Working with projects

---

Yes

Yes 2)

Tag Management

Tag Management:
Creating and editing tags
and Communication
drivers

Working with tags

WinCC
Configuration
Studio

---

Yes 2)

Structure types

Creating and editing
structure types and
structure tags

Process picture
dynamics

WinCC
Configuration
Studio

---

Yes 2)

Graphics Designer Creating and editing
process pictures

Creating Process
Pictures

Export function
of the editor

Yes

Yes

Menus and
toolbars

Configure user-defined
menus and toobars for
process pictures

Creating Process
Pictures

---

Yes

Yes

Alarm Logging

Configuring messages
and archiving events

Setting up an Alarm
System

WinCC
Configuration
Studio

Yes

Yes 2)

Tag Logging

Logging and archiving tags Working with process
values

WinCC
Configuration
Studio

---

Yes

Report Designer

Configuring reports and
report layouts

Documentation of
Configuration and
Runtime Data

---

Yes

Yes 2)

Global Script

Making a project dynamic
with C functions and
actions

ANSI-C for creating
functions and actions

Export function
of the editor

Yes

Yes

Text Library

Creating and editing
language-dependent user
texts

Setting up multilingual
projects

WinCC
Configuration
Studio

Yes

Yes

Text Distributor

Exporting and importing
language-dependent text

Setting up multilingual
projects

Export and
Import function
of the Editor

Yes

Yes

User Administrator Managing access
permissions for users and
user groups

Setting up user
administration

WinCC
Configuration
Studio

Yes

Yes

Cross Reference

Localizing, displaying, and
rewiring the location at
which objects are used

Working with cross
reference lists

---

---

Yes

Load online
changes

Transferring edited data to
the operator station

Working with projects

---

---

Yes 2)

Server data

Creating and editing
packages for multi-user
systems

Configurations >
Multi-user Systems

---

---

Yes

You will find the chapters listed in the WinCC Information System in the book Working with
WinCC.

1)

2)
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Options
Object

Usage

Online Help

Import/
Export
Tools

Language
Switching

Online
configuration

WebNavigator

Operating and monitoring
using Internet/intranet

Options >
WebNavigator

---

Yes

---

DataMonitor

Displaying archive values in
Internet/intranet

Options >
WebNavigator >
DataMonitor

---

Yes

---

Redundancy

Operating two servers at the
same time in a redundant
system

Configurations >
Redundant Systems

---

---

Yes

User archive

Configurable database
system for data from
technical processes, for
example for recipes and
setpoints

Options > User
Archives

WinCC
Yes
Configuratio
n Studio

Yes

OS Project Editor

Initializing and configuring
Options for Process
the Runtime user interface
Control > OS Project
and alarm systems in PCS 7 Editor

---

---

---

Time synchronization

Options for Process
Synchronizing the time of
day on all clients and servers Control > Time
synchronization

---

---

Yes

Horn

Indicating message-relevant
events on signal modules
and PC sound cards

WinCC
--Options for Process
Control > Audio alarm Configuratio
n Studio

Yes

Picture Tree Manager Managing picture
hierarchies and name
hierarchies

Options for Process
Control > Picture
Tree Manager

Text Library Yes

Yes

Lifebeat monitoring

Permanent monitoring of the
system

Options for Process
Control > Lifebeat
Monitoring

---

---

---

Component List
Editor

Allocating entry point
pictures and areas to the
measuring points

Options for Process
Control >
Component List
Editor

---

---

---

ProAgent

Configuring process
diagnostics to detect and
eliminate problems

Options > ProAgent

---

---

Yes

See also
Windows of the WinCC Explorer (Page 41)
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1.12.2

WinCC status and control in the system tray

Introduction
WinCC shows the "SIMATIC WinCC" symbol in the Taskbar Notification Area, the so-called
tray area. This symbol provides information on the project status. The WinCC project can be
activated and deactivated via the symbol's shortcut menu.

Project status
The following table shows which project status goes with which symbol:
SIMATIC WinCC® symbol

Status
● WinCC is not active.
● No project is open.
WinCC changes the status:
● WinCC opens a project.
● WinCC activates a project.
● WinCC deactivates a project.
● WinCC closes a project.
Project is open.
The project is activated.
Project is activated and the server has the "Fault" status.

Control Options via the Pop-up Menu
You can control an open project depending on its status. The shortcut menu of the "SIMATIC
WinCC" symbol provides the following control options:
● Start Graphics Runtime.
● End Graphics Runtime.
● Activate project.
● Deactivate project.
● Open diagnostics window.

SIMATIC WinCC® Window
To open the "SIMATIC WinCC" window, click on the "SIMATIC WinCC" symbol.
Example: Window with Runtime activated
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The window shows the following information:
● Project name
● Project type
● Project status
● Computer List
The local computer is represented in blue.

Computer List
The computer list contains all computers on the network. If the project is activated, the
connection status of all existing computers is shown.
The following table shows the icons of the connection status and their meaning:
Icon

Status
● No connection
● Connection disconnected
● Local computer
● Redundant partner server
Connected
● With standby server
● With master server, but standby server is the preferred server
Connected
● With master server
● With standby server as preferred server

1.12.3

WinCC diagnostics window and license information

Introduction
The diagnostics window provides information on the diagnostics of the local computer and
connected servers.
The "WinCC Diagnostics" dialog shows WinCC e.g. invalid licenses of the local computer and
the connected servers.
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Diagnostics window
Open the diagnostics window using the shortcut menu of the

icon in the tray area.

The diagnostics window shows diagnostics information for the local computer and the
connected computers:
● Information
● License messages
● Warnings
● Error
Control Options
Use the "Computer" and "Diagnosis type" buttons to sort the contents of the displayed
diagnostics.
For detailed information on a message, double-click on the desired message.
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Information on Invalid Runtime Licenses
WinCC shows invalid Runtime licenses of the local computer and all connected servers in a
dialog that requires acknowledgement. The name of the concerned computer is listed in
brackets.

You can only use the "Details" button locally on the computer with the invalid license.
Use the "Details" button to start the Automation License Manager. The Automation License
Manager provides further information and installs the required licenses.

1.12.4

Illegal Characters

Introduction
Depending on the language and components, only certain characters are permitted in names.
In WinCC, you can use all characters of the ASCII character set. We do, however, recommend
that you avoid special national characters. Above all, you should avoid special characters in
object names, if the object names are used in scripts.
The following table lists the characters that must not be used in WinCC components, identifiers,
and names.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

191

Working with Projects
1.12 Appendix

Illegal characters in WinCC
Component

Illegal characters

WinCC project:
Names of WinCC projects

.,;:!?"'
+=/\@*
[]{}<>
Space
Case-sensitive
National special characters, for example umlauts (ä, ü etc.)
are not permitted.

Tags:
Tag names

:?"'
\*$%
Space
Not case-sensitive
"@" is used only in system tags.
The period is used as a separator in structure tags.

Tags:
Names of process tags in Tag Logging

: ?"'
\*%>
Space

Tags:
Names of archive tags in Tag Logging

: ?"'
\*%>
Space

Tags:
Names of tag groups

?'
\
Space
Not case-sensitive

Structure types:
Names of structure types, structure
elements and structure instances

.:?'
\@*%
Space
A structure tag may not be named "EventState".

Graphics Designer:
Names of pictures (PDL files)

:?"'
/\¦*
<>

Graphics Designer:
Names of objects in pictures

/
The name can be no longer than 180 characters.
If you use special characters, the maximum number of
characters is further restricted.
Avoid using special characters if the object name is used in
scripts.
For more detailed information, refer to the documentation on
VBS in the section Testing with the Debugger > Action and
Procedure Names in the Debugger.
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Graphics Designer:
Text list object type

Restriction for assigned and referenced texts:
;

Graphics Designer:
Names in the Dynamic Wizard

%

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Projects
1.12 Appendix
Component

Illegal characters

Graphics Designer:
Faceplate

The following applies to the names of properties (Properties)
and events (Events):
!"§$%&/=@
.,;-_#*~+°^
()[]{}<>
ÄÖÜäöü
Space
Leading numbers

Alarm Logging:
Names of message blocks, message
classes, message types and message
texts

'
ENTER key
Line feed

Tag Logging:
Archive name

.,;:!?"'^´`~
-+=/\*#%&§°
()[]{}<>
Space

Tag logging / trend control:
Labeling time axis and value axis

Single "&" character is not displayed.
Double "&" character is displayed once.

:?"
Report Designer:
Names in the page layout and line layout / \ *
<>
User Administrator:
User names

'
/\
Not case-sensitive

User Administrator:
Group names

The number of characters is limited to 24 characters.

User Administrator:
Passwords

'
\
Case-sensitive

User Administrator:
User authorizations

'
\

User archives:
Names for archives, fields, views and
columns

.,;:!?"'^´`~
-+=/\@*#$%&§°
()[]{}<>
Space
The first character must be a letter.

Server data:
Names of packages

,
/\
National special characters, for example umlauts (ä, ü etc.)
are not permitted.
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Illegal characters for basic settings
Component

Illegal characters

Computer name

.,;:!?"'^´`~_
-+=/\¦@*#$%&§°
()[]{}<>
Space
Only uppercase relevant
The first character must be a letter.
The first 12 characters of the computer name must be unique.

DNS host names

,;:!?"'^´`~
_+=/\¦@*#$%&§°
()[]{}<>
Space

Folder path:
Names of folders

:?"'
/*
<>

WinCC Explorer

Restrictions depending on individual components

Communication:
Names of connections under a channel
unit

Restrictions in relation to the SQL database

Communication / OPC:
Used names

.:?"'
\*%
Space

Web client:
Used names

.,;:!?"'^´`~
-+=/\@*#$%&§°
()[]{}<>
Space

Illegal characters for integrating in the SIMATIC Manager
Component

Illegal characters

SIMATIC Manager:
Names of WinCC projects

.,;:!?"'
+=/\@*%
[]{}<>
Space

OS compilation:
AS-OS connection names

.:?"'
\*%
Space

PCS7:
Hierarchy folder

."
/\%

See also
Preparation to Create a Project (Page 81)
File Structure of a Project (Page 195)
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1.12.5

File Structure of a Project

Introduction
In a WinCC project, you find additional information in certain folders and files. By default,
WinCC projects are stored in the path Siemens\WinCC\WinCCProjects\<Project>.

Imported Files
Imported files, for example graphics, scripts, texts, programs, OCS files are located within the
folder structure.

Data storage
The table lists the most important data and folders.
Path

File

Type

Function

<Project folder>

---

Folder

Contains all
files created
for the project.

<Project folder>\GraCS

---

Folder

Contains all
pictures and
picture files of
a project.

<Project folder>
\CommonArchiving

---

Folder

Contains all
databases for
archiving.

<Project folder>

<Project>.MCP

Project
file

Starts WinCC
and opens the
project in the
WinCC
Explorer.

<Project folder>

<Project>.MDF

Database Configuration
database

<Project folder>

<Project>RT.MDF

Database Runtime
database,
database
management
(master
database)

<Project folder>

<Computer>_<Project>_ALG_JJJJMMT
THHMM.MDF

Database Runtime Data
Alarm Logging

<Project folder>

<Computer>_<Project>_TLG_F_JJJJMM Database Runtime data
TTHHMM.MDF
Tag Logging
fast
(acquisition
cycle < 1 min)
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Path

File

<Project folder>

<Computer>_<Project>_TLG_S_JJJJMM Database Runtime data
TTHHMM.MDF
Tag Logging
slow
(acquisition
cycle > 1 min)

Type

Function

Siemens\WinCC\bin

WinCC_SQL.MDF

Database Empty
Runtime
database that
can, when
necessary, be
copied to the
project and
renamed.
Created when
you create a
new project.

Siemens\WinCC

*.LOG

Log files

<Project folder>

UAEditor.loc

Temporar Created when
y file
the editor's
user archives
are opened.
Must be
deleted if the
editor is not
closed
correctly.

Reports:
setup, system
status, error
messages.

See also
Preparation to Create a Project (Page 81)
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Working with Tags
2.1

Tag management

Introduction
Tag Management handles the tags and communication drivers used in the project.
Tag Management is an editor in the WinCC Configuration Studio.
You open the editor by double-clicking on the "Tag Management" entry

in WinCC Explorer.

Usage
Tags with values supplied by the process are referred to in WinCC as process tags, raw data
tags, or external tags. In the case of process tags, Tag Management determines the
communication driver by means of which WinCC communicates with the automation system
and how the exchange of data takes place. The associated tags are created in the folder
structure of this communication driver.
Tags not supplied with values by the process, known as internal tags, are created in the
"Internal Tags" folder.
For a better overview, tags can be arranged in groups.
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2.2

The Tag Management editor

The Tag Management editor
The Tag Management editor is divided into three areas:
● Navigation area
– Tree view showing objects as folders
– Navigation bar for switching between the editors
● Table area
– Creation and editing of multiple objects
● Properties area
– Properties of a selected object
– "What's this?" for the selected property

① Navigation area
The navigation area displays the Tag Management objects in a tree view.
The folders of the top level are:
● Tag Management
● Structure tags
The elements assigned to a selected folder are displayed in the table area (e.g. groups,
structure types, communication drivers, connections...).
A shortcut menu is available for each folder. This provides commands for the folder and
commands such as "Copy / Paste" and "Export…".
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WinCC creates a new folder in the navigation area for each communication driver that is set
up. Under the communication driver folder, you will find a channel unit, its connections and the
associated tag groups and process tags.
Tag Management uses the following icons:
Icon

Meaning
Tag Management
Internal Tags
Communication drivers
Channel unit
Connection
Tag group
Tag
Structure type

② Selection of the editors
The navigation bar is displayed in the area below the tree view. From here, you have access
to additional WinCC editors (e.g. Alarm Logging, Tag Logging). You can adapt the display of
the navigation bar.

③ Table area
The table displays the elements that are assigned to the folder selected in the tree view. You
can, for example, display all tags or the tags of a selected group only.
You create new tags, groups and structures in the table area.
You can edit the properties of objects in the table.
Additional functions are available in the table area via the shortcut menu of the column headers:
● Sort
● Filtering
● Hide column, show additional columns
Note
Inconsistent entries have a colored background in the table window. In the event of
inconsistent configuration, a note is displayed which describes the incorrect configuration.
Tabs are displayed below the table depending on the selected folder. You can use these tabs
to display the lower-level elements in table format.
Navigation keys allow you to select tabs. You select a tab by clicking on it, with the navigation
keys, or from the shortcut menu of the navigation keys.
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④ What's this?
Displays an explanation of the selected property. You can drag this area to zoom in and out.

⑤ Properties
Here, the properties of a selected object are displayed and can be edited.
Status bar
At the bottom edge of the editor is the status bar.
Here, you will find the following information:
● Status of the system (ready, etc.), status of Caps Lock key, NUM Lock key, etc.
● Current input language
● Number of objects (e.g. tags, groups…) in the selected folder
● Number of selected objects if this is more than one
● Display of the zoom status, slider for zooming in and out of the display
Alternatively, you can change the size of the display by pressing the <Ctrl> key while
moving the mouse wheel.
Tooltip
In Runtime, you can view the status information on connections as a tooltip. To view it, move
the mouse pointer in the data window to the connection you want.

200

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Tags
2.3 Working in the "Tag Management" editor

2.3

Working in the "Tag Management" editor

Working in the "Tag Management" editor
You work and navigate in the "Tag Management" editor as you would in the overall
Configuration Studio. Configuration is user-friendly and supports the configuration engineer
during editing. The handling is similar to that for a spreadsheet program.

Working with the navigation area
Individual folders of the tree view are expanded or collapsed by clicking the

buttons.

Shortcut menus with additional functions are offered for individual folders. New groups and
structure types, for example, can be created using the shortcut menu. You can insert new
drivers and connections using the shortcut menu.
You can show or hide the navigation area by clicking the

buttons.

Working with the table area
Creating a new object
You create new tags in the table area. Additional objects, such as new connections or groups,
can also be created in the table area.
To create a new object, you edit the cell identified by a yellow icon.

Enter the name of the object.
Input and editing
Properties of an object, such as a tag, can be edited in the table area.
The following options are available:
● Option:
Click in the box to set the check mark or to remove the check mark.
Option activated
Option deactivated
● Text input:
The text cursor is displayed after you have clicked in the box. You can now enter text. Then
press the ENTER key or click anywhere. The text cursor is no longer visible and the text is
saved.
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● Selection from a drop-down list:
Click the button to select from a list of specified properties.

Make a selection.
● Open another dialog:
Click the button. A dialog with additional selection options is displayed. The input is not
accepted by the system until you close this dialog.

You can make entries in these fields directly above the keyboard. An invalid input is rejected.
Editing several objects
You enter recurring texts by selecting an entry and dragging down the bottom right corner of
the selection while keeping the left mouse button pressed.

The cells are automatically filled with the respective entry. Option boxes apply the selected
option of the marked cell. Numeric values are incremented.
When you select an area in the table area which only contains check boxes, the commands
"Select all" and "Deselect all" are available from the shortcut menu. This also applies if you
select multiple rows or the complete table and the first column contains check boxes.
Filtering tags with the "Find" search field
Use the "Find" search field to filter entries according to the specifications in a column. The first
column is selected by default. You can select any other column.
You make the settings for the search in the menu of the search field.

You can, for example, display all tags that contain the string "user".
Delete the filter by clicking the button
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Use the "Search in" command to select the properties to which the filter is applied.
Shortcut menu of the column header
The shortcut menu of the column header includes these options:

● Sort: The table can be sorted according to the selected column.
● Filter: To filter the table for entries of a property, select the "Filter" command.
● Cut, Copy, Paste: These functions can be applied to all information of the selected column.
If you cannot paste the copied information to a column, you will be notified by a message.
● Find and replace: Function within the selected column.
● Delete: All entries in the column are deleted. This is not available for all properties.
● Hide, Show: The selected column can be hidden in the table area. Currently hidden columns
can be shown.
● Pin / Unpin: To always show columns when scrolling horizontally, select a column and select
the command "Pin". The column and all columns shown to the left remain visible while
scrolling. To scroll the pinned columns horizontally, select "Unpin".
Inconsistent entries
If an entered value is faulty or inconsistent, you will see a corresponding note, for example:
● Invalid entries are created when you edit several entries by dragging a cell.
The cell for the message number may have a red background in the table area and in the
"Properties" area.
Undoing and restoring
Press <Ctrl+Z> to undo the last input or action.
Press <Ctrl+Y> to restore a previously undone setting.
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These commands are also available in the main menu of the WinCC Configuration Studio.
Note
Some actions cannot be undone.

Working with the "Properties" area
The properties of the selected object are displayed in the "Properties" area.
You can edit the properties here just as you would in the table area.
To display the properties of a group, connection or a structure, select it in the tree view.
To display the properties of individual tags, groups, etc., select them in the table view.
You can show or hide groups of properties by clicking the

buttons to get a better overview.

You show or hide the "Properties" area by clicking the

buttons.

Deleting objects
1. Select the object to be deleted in the navigation area.
2. From the shortcut menu, select the "Delete" command.
Alternative procedure
1. Select the rows of the objects in the table area.
2. Press <DEL> or select "Delete" from the shortcut menu.
Deletion of objects takes effect immediately.
In many situations, you can undo the action by pressing <Ctrl+Z>.
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2.4

Basics of Tag Management

2.4.1

Tags

2.4.1.1

Tags

Introduction
Data are passed on in a WinCC project by means of tags. A tag has a data address and a
symbolic name, which is used in the project. The data address is used in communication with
the automation system.
WinCC works with two kinds of tags:
● Process tags
● Internal Tags
WinCC simplifies tag handling by means of two other object types:
● Tag groups
● Structure types

Naming conventions
Note
WinCC is case-sensitive in handling the names of tags.
You cannot create tags whose names differ only with respect to case in the editor.
Note
You may not create tags with a name starting with @. Tags with an @ prefix are created only
by WinCC and PCS 7.
When naming tags, you must respect certain conventions:
● Tag names must be unique throughout the entire project.
● Tag names are not to exceed 128 characters. This limit applies to the entire expression
"Structure tag name + dot + structure type element name" for structure tag elements.
● You must not use certain characters in tag names. The characters that cannot be included
in a name can be found in the WinCC Information System under "Working with projects" >
"Valid characters".
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Updating Tags
In the case of process tags, the current tag values are transferred over the communication
connection between WinCC and the connected automation systems in Runtime. In this
instance, WinCC accesses the data area on the automation system that is defined in the tag
properties. The current value of the process tag is made available by WinCC in Tag
Management after it has been transferred for further processing and evaluation. Conversely,
WinCC can also write data back to the automation system.
In WinCC you set the frequency of data transfer and of updating in the display. Remember
while you are configuring that periodic updating of tags results in severe loading of the system
and can have an adverse effect on performance.

Importing tags
You can import tags that have been exported from another WinCC project.
You can import tags from external applications. The data must be available in "Office Open
XML Workbook" format with the "xlsx" file extension.

2.4.1.2

Internal Tags

Definition
Internal tags are not connected to the process.
You use Internal tags to manage data within a project or to transfer data to an archive.
A corresponding setting of the "Runtime persistency" property lets you set retention of the
internal tags on closing Runtime. The value saved is used as start value for the restart of
Runtime.
You can set the following properties for internal tags:
● Name
● Data type
● Updates project-wide/on local computers (only relevant with multi-user projects without
additional client projects)
● Limits
● Start value
● Runtime persistency
● Tag synchronization (Online synchronization the internal tags in the server project with the
redundant partner)

Usable data types
You can use the following data types for internal tags:
● Binary tag
● Signed 8-bit value
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● Unsigned 8-bit value
● Signed 16-bit value
● Unsigned 16-bit value
● Signed 32-bit value
● Unsigned 32-bit value
● Floating-point number 32-bit IEEE 754
● Floating-point number 64-bit IEEE 754
● Text tag, 8-bit character set
● Text tag, 16-bit character set
● Raw data tag
● Text reference
● Date/time

System tags
WinCC applications create tags required for internal administration of the project. The names
of these tags begin with an "@" character. You cannot delete or rename these tags. You can
evaluate, but not change, the value of the tag.
Exceptions to this rule are tags created with the "Redundancy" option. They can be set by
means of scripts, for example:
● @RM_MASTER
● @RM_MASTER_NAME
Note
You may not create tags with a name starting with @. Tags with an @ prefix are created only
by WinCC and PCS 7.

2.4.1.3

Process Tags

Definition
You use process tags for communication between WinCC and the automation system.
The properties of process tags depend on the communication driver being used. Therefore,
create process tags in Tag Management also under a specific communication driver, its
channel unit and its connections.
You can set the following properties for process tags:
● Name
● Data type
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● Address on the channel unit
● Format adaptation
● Limits
● Start value
● Substitute value
● Scaling
Note
Process tags are also referred to "external tags" on the system.

Usable data types
You can use the following data types for process tags:
● Binary tag
● Signed 8-bit value
● Unsigned 8-bit value
● Signed 16-bit value
● Unsigned 16-bit value
● Signed 32-bit value
● Unsigned 32-bit value
● Floating-point number 32-bit IEEE 754
● Floating-point number 64-bit IEEE 754
● Text tag, 8-bit
● Text tag, 16-bit character set
● Raw data tag
● Date/time

Licensing of Power Tags
For WinCC, you purchase licenses to be able to use a certain number of process tags and
archive tags.
Power tags are licensed process tags. With a license covering 2048 power tags, for example,
you can operate a WinCC project in Runtime in which up to 2048 process tags are used on a
computer. The number of licensed and configured process tags will be seen in the status bar
of WinCC Explorer.
Licenses are divided into the following types:
● "RC": for configuration and Runtime of a certain number of process tags
● "RT": only for Runtime of a certain number of process tags
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Note
The process tags required for the System Info channel need no licenses. Thus, the tags are
not entered in the license count.

2.4.1.4

Properties of a tag

Introduction
You can edit the properties of a tag in the "Properties" area of the Tag Management editor.
In the table area, the following properties can additionally be shown:
● Value: Shows the current value of the tag
● Tag status
● Quality code

Properties of a tag
Selection
Displays the object type and the name of the selected object.
General
Name

Name of the tag, can be edited here

ID

ID, cannot be edited

Data type

Selection from drop-down list with all the available data types, see Tag types
(Page 216)

Length

Length of the tag in WinCC, determined by the data type

Format adaptation

Selection from drop-down list with the format adaptations that are available for the
selected data type.

AS length

Length of the tag in the automation system, results from the selected format
adaptation.

Address

Depends on connection. A dialog for entering the address data opens.
For system tags, such as specification of the representation format, selection of a
drive, selection of the CPU

Assignment
Communication driver

Display, depends on the selected connection

Channel unit
Connection

Selection from drop-down list with the created communication drivers and the
"Internal tags" connection

Group

Selection from drop-down list with the groups created under the selected connection
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Linear scaling
Linear scaling is only available for process tags. You cannot scale internal tags.
Linear scaling

Select the "Linear scaling" option.
With the help of linear scaling, you can map the values of process tags in WinCC
onto any second range of values.
You use linear scaling when you want to display a process value differently from
how it was supplied by the automation system. The process value itself is not
modified. This can be practical, for example, if you want to use the process value
as a percentage or for calculations.
Example: A temperature sensor measures the resistance in the system and
transfers the values in ohms. Specific values correspond to specific temperatures.
Wit the help of linear scaling, you can automatically convert the resistance values
to the temperature scale. This ensures that the measured resistance is immediately
displayed as temperature in the project.

AS value range from

Low and high value of the value range in the automation system.

AS value range to
OS value range from

Low and high value of the value range in WinCC.

OS value range to

Limits
Low limit

Enter limit values to prevent the value of a tag from being outside the defined limits.

High limit

If, for example, a process value exceeds a limit, the value is grayed out and
processing stops.

Start value

Value assumed at the start of Runtime.
Specified text for text tags, for example.
If a start value has been configured, the start value is returned at the first reading
of a process tag, even if a process value already exists. This accelerates the
opening of the picture when Runtime is started and when the picture is changed.
To prevent this behavior, you need to configure a direct read call using the
corresponding functions in VBS and C.
If you want to specify both a start value and a substitute value, check the settings
in the "Use substitute value" area.

Substitute value

Value assumed when the corresponding option under "Use substitute value" is
selected.

Use substitute value
Here, you determine when WinCC is to use the substitute value. In this case, the current
process value from the automation system is not accepted.
Substitute value at low limit
Substitute value at high limit

WinCC uses the substitute value as soon as the process value violates the
specified high or low limit.
If you have set a high or low limit in an input/output field, you cannot enter any value
outside these limits.
WinCC ignores incorrect entries and therefore does not set a substitute value. The
substitute value is only set by WinCC when an incorrect process value is read.

210

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Tags
2.4 Basics of Tag Management
Substitute value as start value

WinCC sets the substitute value when the project is activated and there is no
current process value. If a start value has already been defined, it is not possible
to select "Substitute value as start value".

Substitute value on communication
error

WinCC sets the substitute value when the connection to the automation system is
disturbed and there is no valid process value.

Options
Computer-local

Option selected: The tag is updated only locally on the computer.
Option not selected: The tag is updated throughout the project.

Synchronization

Option selected: Value of an internal tag is synchronized to the value on the
redundant partner.

Runtime persistency

Option selected: Value is saved when closing Runtime and restored on restart.

Various
Time stamp of the last change to the properties of the tags.
Structure tag element
Display only when a structure tag element is highlighted, cannot be edited.
Structure type

Information on the structure of the selected instance.

Structure tag
Structure type element
Structure type element number

2.4.1.5

The number can be changed by arranging the structure type elements in the
navigation area.

Structure Types and Structure Tags

Definition
In WinCC Configuration Studio, you create a structure type in the navigation area of the Tag
Management editor.
WinCC Structure types simplify the creation of several tags having identical properties.
Name

Definition

Structure type

A structure type denotes a scheme that is used in WinCC to create a certain group of tags.
A structure type contains at least one structure element.
Structure types are created and displayed in the "Structure tags" folder in the navigation
area.

Structure element

A structure element is a component of a structure type. It is used as a template when
creating a structure tag with the help of a structure type.
Structure elements are created and displayed in the folder of a structure type in the
navigation area.
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Name

Definition

Structure tag

A structure tag is a tag that was created with the help of a structure type. The template of
a structure tag is a structure element.
The name of a structure tag consists of the name of the structure instance and the name
of the structure element being used. Both parts of the name are separated by a dot.
Structure tags are created and displayed in the table area on the "Structure tags" tab.

Structure tag element

If a structure type is used to create the tags defined therein, a structure instance (a
structure tag element) results. The structure tag elements created with the same structure
type are displayed for the selected structure type in the table area.
Structure tag elements are not configured. They are generated automatically when you
create structure tags.
The name of a structure instance is also referred to as the tag prefix.

Principle
You define a tag structure when you create a structure type.
You create a structure type in the "Tag Management" editor. There, you create a structure
element for each tag. You assign those properties to a structure element which the tag created
by that structure element should possess.
When creating a tag, assign a created structure type as data type. The structure types available
are displayed in the "Data type" selection window after the standard data types. WinCC creates
a structure tag element under the associated structure type and the structure tags in Tag
Management. The created structure tags are defined by the structure elements of this type.
You can define structure elements for internal tags and process tags in the same structure
type. When a structure tag element is created under the connection of a communication driver,
the process tags defined in the structure type are created under the connection. But internal
tags are created in tag management under "Internal tags".

Modifying structure types
If you have used a structure type to create a structure tag element, you can no longer modify
the properties of this structure type. You must first delete the structure tag elements. In doing
so, you also delete all associated structure tags. After that, you can change the properties of
the structure type and structure elements and create a structure tag element again.
You can modify the properties of structure instances and structure tags later. If you rename a
structure tag, then rename the associated structure tag elements at the same time.

Usage
If a certain tag configuration occurs several times in your system, use structure types. In this
instance, for example, several temperature controllers can be involved that are always set up
according to the same principle.
Determine which tags you require for the temperature controller.
Then create a TEMPERATURE structure type in which each tag is represented by a structure
element, for example ELEMENT_1, ELEMENT_2, ELEMENT_3. When you create a new
structure instance with this structure type, WinCC automatically generates all structure tags
for the corresponding temperature controller.
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You use the created structure tags when, for example, you configure pictures which you would
like to integrate by means of picture windows.
Structure types in picture windows
You configure a picture, TEMP_REGLER.PDL, for the temperature controller. Connect the
objects in the picture, e.g. an I/O field, to structure elements instead of tags.
To do this, you have to enter the names of the structure elements manually, since you cannot
enter elements directly in a dialog. Alternatively, you can connect structure tags you have
created and delete the first part of the name, which is determined by the structure instance.
You link e.g. the structure tags of the structure REGLER_A. In the tag name displayed, e.g.
REGLER_A.ELEMENT_1, delete the REGLER_A and the linking point in the input field.
Configure a picture window and integrate the picture TEMP_REGLER.PDL. Open the object
properties of the picture window. Accept one of the created structure instances with a dot
behind the name, e.g. "REGLER_A.", as the tag prefix.
Configure a second picture window with the picture TEMP_REGLER.PDL and the next
structure instance, e.g. REGLER_B, as tag prefix, e.g. "REGLER_B.".
In Runtime, WinCC composes the names of the required structure tags from the following
elements:
● Tag prefixes of the picture window
● Names of the structure elements linked in the pictureTEMP_REGLER.PDL
Then the first picture window displays the state of regulator A and the second picture window
the state of regulator B.

Naming conventions
Note
WinCC is case-sensitive in handling the names of tags.
You cannot create tags whose names differ only with respect to case in the editor.
Note
You may not create tags with a name starting with @. Tags with an @ prefix are created only
by WinCC and PCS 7.
When naming, you must respect certain conventions:
● Tag names must be unique throughout the entire project.
● Tag names are not to exceed 128 characters. This limit applies to the entire expression
"Structure tag name + period + structure tag element name" for structure tags.
● There are certain characters which you cannot use in the names of structure types, structure
elements and structure tags. You can find a list of characters that are not permitted in a
name in the WinCC Information System under "Working with Projects" > "Prohibited
characters".
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2.4.1.6

Data types of structure tags

Data types
The data type for the tag automatically precedes the name of a structure element in WinCC.
This data type corresponds to a certain tag type, e.g. the BYTE data type, the tag type Unsigned
8-bit value.
If you want to address a structure tag with a script, then you have to use the C function for this
data type.
The following designations are used:
Tag type

Data type

Associated C function

Binary tag

BIT

GetTagBit

Signed 8-bit value

CHAR

GetTagSByte

Unsigned 8-bit value

BYTE

GetTagByte

Signed 16-bit value

SHORT

GetTagSWord

Unsigned 16-bit value

WORD

GetTagWord

Signed 32-bit value

LONG

GetTagSDWord

Unsigned 32-bit value

DWORD

GetTagDWord

Floating-point number 32-bit IEEE 754

FLOAT

GetTagFloat

Floating-point number 64-bit IEEE 754

DOUBLE

GetTagDouble

Text tag, 8-bit character set

TEXT8

GetTagChar

Text tag, 16-bit character set

TEXT16

GetTagChar

Text reference (internal tags only)

TEXTREF

GetTagChar

Further information can be found in the section "Tag Types" and in the description of the internal
functions for ANSI-C.
Note
BIT tags have a fixed length of one word in a structure. Therefore, bit positions 0 to 15 are
the only positions possible. This length of two bytes has to be taken into account for the offset
value of the following element.

2.4.1.7

Properties of a structure tag

Introduction
The properties of a structure type, except for the name, cannot be edited.
The properties of structure type elements and structure tags correspond to those of tags. See
section "Properties of a tag".
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Properties of structure tag elements
The properties of a structure tag element are determined by the properties of the structure
type element and the structure tag. Individual properties of a structure tag element can be
edited.
Object

Properties

Structure type element

● "External" option
● Data type: Tag type, in this case
● Length, format adaptation
● Linear scaling, limits, substitute values
● Options

Structure tag

● Data type: Structure type element, in this case
● Address
● Assignment

Structure tag element

Overwriting of the values for the selected instance:
● Address
● Linear scaling
● Limits, substitute values
● Options

2.4.1.8

Tag Groups

Definition
You can assemble your tags into tag groups in Tag Management.
Create a tag group as folder under "Internal Tags" or under the connection to a channel unit.
Subgroups are not possible.

Usage
When creating a large number of tags in your project, group them according to subject.
You can create, for example, a tag group for every picture in your project. You create the tags
you use in one of your pictures in the appropriate group.
In this way, WinCC makes it easier for you to assign and retrieve tags.

Naming conventions
Note
WinCC is case-sensitive in handling the names of tags.
You cannot create tags whose names differ only with respect to case in the editor.
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The names of tag groups must be unique in the whole project. You must not use the same
name simultaneously for tags and tag groups.
You must not use certain characters in the names of tag groups. You can find a list of characters
that are not permitted in a name in the WinCC Information System under "Working with
Projects" > "Prohibited characters".

2.4.1.9

Communication Driver

Establishing Communication
A communication driver is used for communication by WinCC with the connected automation
system. The communication drivers supported by WinCC are listed in the WinCC Information
System under "Communication".
The documentation on the different channels contains detailed information about creating
channel units and connections.

Licensing of Communication Drivers
If you wish to use a communication driver, you must install the corresponding license on the
computer.

Deleting Communication Driver
When you delete a communication driver, WinCC automatically deletes all tags created for
this communication driver. Should you still require tags, move these tags to a different
communication driver. Use the "Cut" and "Paste" commands for this purpose. After moving
them, check the addresses of the moved tags.
Note
If a communication driver was created in WinCC with "Compile OS" using the SIMATIC
Manager, you cannot delete the communication driver in WinCC Explorer.

2.4.2

Tag types

2.4.2.1

Tag Types

Introduction
When you create a tag, you assign one of the possible data types to the tag.
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This data type depends on the type of data for which you would like to use the tag.
Note
If you modify the data type of an existing process tag, the previously defined tag address is
deleted. This reason for this is that the PLC address changes when the data type is modified.

Format adaptation
The data type of a tag in WinCC can differ from the data type used in the automation system.
You can then set that WinCC converts the data type of a tag for transfer to the automation
system.
Tag types with format adaptation

Tag types without format adaptation

Signed 8-bit value

Text reference

Unsigned 8-bit value

Binary tag

Signed 16-bit value

Text tag, 8-bit character set

Unsigned 16-bit value

Text tag, 16-bit character set

Signed 32-bit value

Raw data type

Unsigned 32-bit value

Structure types

Floating-point number 32-bit IEEE 754
Floating-point number 64-bit IEEE 754

Detailed information on format adaptation is available in the WinCC Information System under
"Communication" > "Process communication" > "WinCC Process communication" > "External
tags".

2.4.2.2

Binary Tags

Definition
The data type "binary tag" corresponds to one bit. A binary tag can assume the values TRUE
or "1" and FALSE or "0".
The binary tag is stored as a byte on the system.
Note
Some communication drivers cannot transfer single bits. The use of binary tags can result in
degraded performance with these communication drivers. Note the help on the respective
communication driver in the WinCC Information System under "Communication".

Bit
The data type "binary tag" is also referred to as "Bit".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

217

Working with Tags
2.4 Basics of Tag Management

Format adaptation
There is no format adaptation for the data type "binary tag".

2.4.2.3

Signed 8-bit value

Definition
The data type "Signed 8-bit value" has a length of one byte and a sign (plus or minus).

Char/Signed Byte
The data type "Signed 8-bit value" is also referred to as "Char" or "Signed Byte".

Format adaptation
If you create a new tag with the data type "Signed 8-bit value", "CharToSignedByte" is
displayed by default in the "Format adaptation" box. The range of numbers is -128 to +127.
The following format adaptations are possible for the data type "Signed 8-bit value":
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Number range

CharToSignedByte

-128...+127
(no conversion)

CharToUnsignedByte

0...127

CharToUnsignedWord

0...127

CharToUnsignedDword

0...127

CharToSignedWord

-128...+127

CharToSignedDword

-128...+127

CharToMSBByte

-128...+127

CharToMSBWord

-128...+127

CharToMSBDword

-128...+127

CharToBCDByte

0...99

CharToBCDWord

0...127

CharToBCDDword

0...127

CharToSignedBCDByte

-9...+9

CharToSignedBCDWord

-128...+127

CharToSignedBCDDword

-128...+127

CharToExtSignedBCDByte

-79...+79

CharToExtSignedBCDWord

-128...+127

CharToExtSignedBCDDword

-128...+127

CharToAikenByte

0...99

CharToAikenWord

0...127

CharToAikenDword

0...127

CharToSignedAikenByte

-9...+9
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2.4.2.4

Format adaptation

Number range

CharToSignedAikenWord

-128...+127

CharToSignedAikenDword

-128...+127

CharToExcessByte

0...99

CharToExcessWord

0...127

CharToExcessDword

0...127

CharToSignedExcessByte

-9...+9

CharToSignedExcessWord

-128...+127

CharToSignedExcessDword

-128...+127

Unsigned 8-bit value

Definition
The data type "Unsigned 8-bit value" has a length of one byte and no sign.

Byte/Unsigned Byte
The data type "Unsigned 8-bit value" is also referred to as "Byte" or "Unsigned Byte".

Format adaptation
If you create a new tag with the data type "Unsigned 8-bit value", "ByteToUnsignedByte" is
displayed by default in the "Adapt format" box. The range of numbers is 0 to 255.
The following format adaptations are possible for the data type "Unsigned 8-bit value":
Format adaptation

Number range

ByteToUnsignedByte

0...255
(no conversion)

ByteToUnsignedWord

0...255

ByteToUnsignedDword

0...255

ByteToSignedByte

0...127

ByteToSignedWord

0...255

ByteToSignedDword

0...255

ByteToBCDByte

0...99

ByteToBCDWord

0...255

ByteToBCDDword

0...255

ByteToAikenByte

0...99

ByteToAikenWord

0...255

ByteToAikenDword

0...255

ByteToExcessByte

0...99

ByteToExcessWord

0...255

ByteToExcessDword

0...255
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2.4.2.5

Signed 16-bit value

Definition
The data type "Signed 16-bit value" has a length of two byte and a sign (plus or minus).

Short/Signed Word
The data type "Signed 16-bit value" is also referred to as "Short" or "Signed Word".

Format adaptation
If you create a new tag with the data type "Signed 16-bit value", "ShortToSignedWord" is
displayed by default in the "Adapt format" box. The range of numbers is -32768 to +32767.
The following format adaptations are possible for the data type "Signed 16-bit value":
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Number range

ShortToSignedWord

-32768...+32767
(no conversion)

ShortToUnsignedByte

0...255

ShortToUnsignedWord

0...32767

ShortToUnsignedDword

0...32767

ShortToSignedByte

-128...+127

ShortToSignedDword

-32768...+32767

ShortToMSBByte

-127...+127

ShortToMSBWord

-32767...+32767

ShortToMSBDword

-32768...+32767

ShortToBCDByte

0...99

ShortToBCDWord

0...9999

ShortToBCDDword

0...32767

ShortToSignedBCDByte

-9...+9

ShortToSignedBCDWord

-999...+999

ShortToSignedBCDDword

-32768...+32767

ShortToExtSignedBCDByte

-79...+79

ShortToExtSignedBCDWord

-7999...+7999

ShortToExtSignedBCDDword

-32768...+32767

ShortToAikenByte

0...99

ShortToAikenWord

0...9999

ShortToAikenDword

0...32767

ShortToSignedAikenByte

-9...+9

ShortToSignedAikenWord

-999...+999

ShortToSignedAikenDword

-32768...+32767

ShortToExcessByte

0...99

ShortToExcessWord

0...9999
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2.4.2.6

Format adaptation

Number range

ShortToExcessDword

0...32767

ShortToSignedExcessByte

-9...+9

ShortToSignedExcessWord

-999...+999

ShortToSignedExcessDword

-32768...+32767

Unsigned 16-bit value

Definition
The data type "Unsigned 16-bit value" has a length of two byte and no sign.

Word/Unsigned Word
The data type "Unsigned 16-bit value" is also referred to as "Word" or "Unsigned Word".

Format adaptation
If you create a new tag with the data type "Signed 16-bit value", "WordToUnsignedWord" is
displayed by default in the "Adapt format" box. The range of numbers is 0 to 65535.
The following format adaptations are possible for the data type "Unsigned 16-bit value":
Format adaptation

Number range

WordToUnsignedWord

0...65535
(no conversion)

WordToUnsignedByte

0...255

WordToUnsignedDword

0...65535

WordToSignedByte

0...127

WordToSignedWord

0...32767

WordToSignedDword

0...65535

WordToBCDByte

0...99

WordToBCDWord

0...9999

WordToBCDDword

0...65535

WordToAikenByte

0...99

WordToAikenWord

0...9999

WordToAikenDword

0...65535

WordToExcessByte

0...99

WordToExcessWord

0...9999

WordToExcessDword

0...65535

WordToSimaticCounter

0...999

WordToSimaticBCDCounter

0...999
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2.4.2.7

Signed 32-bit value

Definition
The data type "Signed 32-bit value" has a length of four byte and a sign (plus or minus).

Long / Signed Dword
The data type "Signed 32-bit value" is also referred to as "Long" or "Signed Dword".

Format adaptation
If you create a new tag with the data type "Signed 32-bit value", "LongToSignedDword" is
displayed by default in the "Format adaptation" box. The range of numbers is -2147483647 to
+2147483647.
The following format adaptations are possible for the data type "Signed 32-bit value":
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Number range

LongToSignedDword

-2147483647...+2147483647
(no conversion)

LongToUnsignedByte

0...255

LongToUnsignedWord

0...65535

LongToUnsignedDword

0...2147483647

LongToSignedByte

-128...+127

LongToSignedWord

-32768...+32767

LongToMSBByte

-127...+127

LongToMSBWord

-32767...+32767

LongToMSBDword

-2147483647...+2147483647

LongToBCDByte

0...99

LongToBCDWord

0...9999

LongToBCDDword

0...99999999

LongToSignedBCDByte

-9...+9

LongToSignedBCDWord

-999...+999

LongToSignedBCDDword

-9999999...+9999999

LongToExtSignedBCDByte

-79..+79

LongToExtSignedBCDWord

-7999...+7999

LongToExtSignedBCDDword

-79999999...+79999999

LongToAikenByte

0...99

LongToAikenWord

0...9999

LongToAikenDword

0...99999999

LongToSignedAikenByte

-9...+9

LongToSignedAikenWord

-999...+999

LongToSignedAikenDword

-9999999...+9999999

LongToExcessByte

0...99
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2.4.2.8

Format adaptation

Number range

LongToExcessWord

0...9999

LongToExcessDword

0...99999999

LongToSignedExcessByte

-9...+9

LongToSignedExcessWord

-999...+999

LongToSignedExcessDword

-9999999...+9999999

LongToSimaticTimer

10...9990000

LongToSimaticBCDTimer

10...9990000

Unsigned 32-bit value

Definition
The data type "Unsigned 32-bit value" has a length of four byte and no sign.

Dword / Unsigned Dword
The data type "Unsigned 32-bit value" is also referred to as "Dword" or "Unsigned Dword".

Format adaptation
If you create a new tag with the data type "Signed 32-bit value", "DwordToUnsignedDword" is
displayed by default in the "Adapt format" box. The range of numbers is 0 to 4294967295.
The following format adaptations are possible for the data type "Unsigned 32-bit value":
Format adaptation

Number range

DwordToUnsignedDword

0...4294967295
(no conversion)

DwordToUnsignedByte

0...255

DwordToUnsignedWord

0...65535

DwordToSignedByte

0...127

DwordToSignedWord

0...32767

DwordToSignedDword

0...2147483647

DwordToBCDByte

0...99

DwordToBCDWord

0...9999

DwordToBCDDword

0...99999999

DwordToAikenByte

0...99

DwordToAikenWord

0...9999

DwordToAikenDword

0...99999999

DwordToExcessByte

0...99

DwordToExcessWord

0...9999

DwordToExcessDword

0...99999999
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Format adaptation

Number range

DwordToSimaticTimer

10...9990000

DwordToSimaticBCDTimer

10...9990000

DwordToSimaticLTimeOfDay

2.4.2.9

Floating-point number 32-bit IEEE 754

Definition
The data type "Floating-point number 32-bit IEEE 754" has a length of four bytes and a sign
(plus or minus).

Float
The data type "Floating-point number 32-bit IEEE 754" is also referred to as "Float".

Format adaptation
If you create a new tag with the data type "Floating-point number 32-bit IEEE 754",
"FloatToFloat" is displayed by default in the "Adapt format" box. The number range is
+-3.402823e+38.
Note
Only the first seven digits are considered for each format adaptation "FloatTo...Dword". The
float data type only allows seven digits. If you use an S7 connection, the number range for
the format adaptation "FloatToFloat" is +-3.402823e+38.
The following format adaptations are possible for the "Floating-point number 32-bit IEEE 754"
data type:
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Number range

FloatToFloat

+-3.402823e+38
(no conversion)

FloatToUnsignedByte

0...255

FloatToUnsignedWord

0...65535

FloatToUnsignedDword

0 to 4.294967e+09

FloatToSignedByte

-128...+127

FloatToSignedWord

-32768...+32767

FloatToSignedDword

-2.147483e+09 to +2.147483e+09

FloatToDouble

+-3.402823e+38

FloatToMSBByte

-127...+127

FloatToMSBWord

-32767...+32767

FloatToMSBDword

-2.147483e+09 to +2.147483e+09

FloatToBCDByte

0...99
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2.4.2.10

Format adaptation

Number range

FloatToBCDWord

0...9999

FloatToBCDDword

0 to 9.999999e+07

FloatToSignedBCDByte

-9...+9

FloatToSignedBCDWord

-999...+999

FloatToSignedBCDDword

-9999999...+9999999

FloatToExtSignedBCDByte

-79...+79

FloatToExtSignedBCDWord

-7999...+7999

FloatToExtSignedBCDDword

-7.999999e+07 to +7.999999e+07

FloatToAikenByte

0...99

FloatToAikenWord

0...9999

FloatToAikenDword

0 to 9.999999e+07

FloatToSignedAikenByte

-9...+9

FloatToSignedAikenWord

-999...+999

FloatToSignedAikenDword

-9999999...+9999999

FloatToExcessByte

0...99

FloatToExcessWord

0...9999

FloatToExcessDword

0 to 9.999999e+07

FloatToSignedExcessByte

-9...+9

FloatToSignedExcessWord

-999...+999

FloatToSignedExcessDword

-9999999...+9999999

FloatToS5Timer

10...9990000

FloatToS5Float

+-1.701411e+38

FloatToSimaticTimer

10...9990000

FloatToSimaticBCDTimer

10...9990000

Floating-Point Number 64-Bit IEEE 754

Definition
The "Floating-point number 64-bit IEEE 754" data type is eight bytes long and is signed (plus
or minus).

Double
The "Floating-point number 64-bit IEEE 754" data type is also referred to as "Double".
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Format adaptation
If you create a new tag with the "Floating-point number 64-bit IEEE 754" data type, the "Type
Conversion" box will display the "DoubleToDouble" by default. The number range is
+-1.79769313486231e+308.
Note
For every "DoubleToFloat" format adaptation, only the first seven places are considered. The
float data type only allows seven digits.
The following format adaptations are possible for the "Floating-point number 64-bit IEEE 754"
data type:
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Format adaptation

Number range

DoubleToDouble

+-1.79769313486231e+308
(no conversion)

DoubleToUnsignedByte

0...255

DoubleToUnsignedWord

0...65535

DoubleToUnsignedDword

0...4294967295

DoubleToSignedByte

-128...+127

DoubleToSignedWord

-32768...+32767

DoubleToSignedDword

-2147483647...+2147483647

DoubleToFloat

+-3.402823e+38

DoubleToMSBByte

-127...+127

DoubleToMSBWord

-32767...+32767

DoubleToMSBDword

-2147483647...+2147483647

DoubleToBCDByte

0...99

DoubleToBCDWord

0...9999

DoubleToBCDDword

0...99999999

DoubleToSignedBCDByte

-9...+9

DoubleToSignedBCDWord

-999...+999

DoubleToSignedBCDDword

-9999999...+9999999

DoubleToExtSignedBCDByte

-79...+79

DoubleToExtSignedBCDWord

-7999...+7999

DoubleToExtSignedBCDDword

-79999999...+79999999

DoubleToAikenByte

0...99

DoubleToAikenWord

0...9999

DoubleToAikenDword

0...99999999

DoubleToSignedAikenByte

-9...+9

DoubleToSignedAikenWord

-999...+999

DoubleToSignedAikenDword

-9999999...+9999999

DoubleToExcessByte

0...99

DoubleToExcessWord

0...9999

DoubleToExcessDword

0...99999999

DoubleToSignedExcessByte

-9...+9
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2.4.2.11

Format adaptation

Number range

DoubleToSignedExcessWord

-999...+999

DoubleToSignedExcessDword

-9999999...+9999999

DoubleToS5Timer

10...9990000

DoubleToS5Float

+-1.701411e+38

DoubleToSimaticTimer

10...9990000

DoubleToSimaticBCDTimer

10...9990000

Text Tag 8-Bit Character Set and Text Tag 16-Bit Character Set

Definition
Text tags are distinguished by the character set that has to be displayed:
● With the data type "Text tag 8-bit character set" each character displayed in this tag has a
length of one byte. With the 8-bit character set, the ASCII character set can be displayed
for example.
● With the data type "Text tag 16-bit character set" each character displayed in this tag has
a length of two byte. You require a tag of this type to display the Unicode character set, for
example.

Process Tag with the Text Tag Data Type
For process tags with the data type "Text tag 8-bit character set" or "Text tag 16-bit character
set" you must specify the length of the text tag. A text tag that is required to accommodate 10
characters later must be ten long for the "8-bit character set" and 20 long for the "16-bit
character set".

Format adaptation
There is not format adaptation for the data types "Text tag 8-bit character set" and "Text tag
16-bit character set".

2.4.2.12

Raw Data Tag

Definition
You can create external and internal tags of the "Raw data type" type in the WinCC tag
management. The format and the length of a raw data tag are not fixed. Its length can be in
the range from 1 and 65535 bytes. It is either defined by the user or results from a specific
application.
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The contents of a raw data tag are not fixed. Only senders and receivers can interpret the
contents of a raw data tag. They are not interpreted by WinCC.
Note
A raw data tag cannot be displayed within the "Graphics Designer".

Potential Applications within WinCC
Raw data tags can be used in the following modules within WinCC:
● "Alarm Logging": For data exchange with the message blocks on the automation system
with message and acknowledgement processing of the message system.
● "Global Script": In scripts for data exchanged with the help of functions "Get/SetTagRaw".
● "Tag Logging": For process controlled archiving with process controlled tags in the process
value archive.
● "User Archive": For transferring jobs, data, processing acknowledgements between WinCC
and the automation systems.
Note
If the raw data tag is displayed in the I/O box, the conventions of the string must conform
with a closing "\0" character.

"Properties address"
The "Properties address" is not the same for all communication drivers with external raw data
tags because the parameters of the tag address and the supported raw data tag type depend
on the communication driver used.

Format adaptation
There is no format adaptation in WinCC for the "raw data type".

2.4.2.13

Text Reference

Definition
With tags having the Text reference data type, you refer to an entry in the WinCC Text Library.
You can only configure text references as internal tags.
You will use text references, for e.g., to display a text from the text library for an object; the
text will change according to the language setting when you switch languages. You assign the
corresponding text ID of the entry in the Text Library to the tag.
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Creating a Text Reference
You create a tag with the Text reference data type as an internal tag.
In the "Tag Properties" dialog box, select the "Start value" check box on the Limits/Reporting
tab. Enter the text ID from the Text Library as the start value.
Note
In a multi-user system, WinCC uses for text output the language of the computer on which
the text reference was created.

Format adaptation
Format adaptation does not take place for the "Text reference" data type.

2.4.2.14

Date/time

Definition
The "Date/Time" data type has a length of 8 bytes as a floating-point number 64-bit IEEE 754.
The tag takes the date and time and is implemented as a floating-point number, the integer
component of which is the number of days before or after midnight on December 30, 1899,
and the decimal point of which is the time on this day divided by 24.
For example, midnight December 31, 1899 is represented as 1.0, 6 o'clock in the morning on
January 1, 1900 is represented as 2.25; midnight December 29, 1899 is represented as -1.0,
and 6 o' clock in the morning December 29, 1899 is represented as -1.25.

Format adaptation
If you create a new tag with the data type "Date/Time", "DateTimeToDateTime" is displayed
by default in the "Format adaptation" box.
The following format adaptations are possible for the "Date/Time" data type:
Format adaptation

Number range

DateTimeToDateTime

±1.79769313486231e+308, (no conversion)
The minimum OLE automation date is midnight on January 1, 0100.
The maximum date is the last second of December 31, 9999.

DateTimeToSimaticDateAndTime

TIA system interface: Date_And_Time, PLC: DT,
BCD coded. Restriction year: 1990-2089.

DateTimeToSimaticDateAndLTime

Time interval.
TIA system interface: LTime, PLC: LTIME.
Signed 64-bit integer,
includes time interval in nanoseconds (292 years 4 month 11 days 23 hours 47 min
16 sec 854 ms 775 μs 807 ns)
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Format adaptation

Number range

DateTimeToSimaticDTL

An extended time/date structure that summarizes a time period or time and date
as separate integers:
typedef structure DTL
uint year;

// 1970 .. 2554

usint month;

// 01 .. 12

usint day;

// 01 .. 31

usint weekday;

// 1 .. 7 // Sunday to Saturday

usint hour;

// 00 .. 23

usint minute;

// 00 .. 59

usint second;

// 00 .. 59

udint: nanoseconds;

// 0 .. 999 999 999

end
DateTimeToSimaticDate

Unsigned 16-bit integer, days since 01/01/1990
0 … 65535

DateTimeToSimaticTimeOfDay

Unsigned 32-bit integer, milliseconds since 00:00 h
0 … 86399999 Milliseconds

DateTimeToSimaticLTimeOfDay

Unsigned 64-bit integer, nanoseconds since 00:00 h
0 … 86399999999999 Nanoseconds

2.4.3

Selecting tags in WinCC

Working with the tag selection dialog
The tag selection dialog opens as soon as you connect up a tag in an editor of WinCC.

WinCC Configuration Studio:The tag selection dialog is displayed as soon as you click in a
selection field of a tag.
If the required tag does not exist yet, you can switch to the "Tag Management" editor to create
the tag. The tag selection dialog remains open. Once the tag is created, it is displayed in the
tag selection dialog.
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When you open the tag selection dialog from other editors, for example Graphics Designer,
you have the option of creating a new tag or editing an existing one directly from the dialog.

Graphics Designer: You can display the tag selection dialog continuously. Call up the entry
"View" > "Toolbars..." in the menu bar. Select the check box next to the entry "Tags".
Global Script editor: Open the tag selection dialog with the entry "Edit" > "Tag dialog".
In the tag selection dialog, you can either display all tags of the project or navigate in the
directory structure. You select a highlighted tag with the "OK" button.
Drag and drop
You can connect a tag to an object or object attribute using drag-and-drop. When using dragand-drop, there are two locations where you can drop the tag:
● Over a picture:
If a tag is dragged directly into the picture via drag-and-drop, an input field to which the tag
is directly interconnected is automatically generated.
● Over an attribute in the "Object properties" dialog, Properties tab:
Drop the tag over an attribute in the "Object properties" dialog, Properties tab. This attribute
is then dynamized by the tag.
The attribute to be dynamized is specified in the case of objects which have a simplified
configuration dialog. The table shows the objects and the dynamized attribute:
Object

Attribute

I/O Field

Output value

Bar

Process connection

Status display

Current status

Text list

Output value

Check box

Selected boxes

Option button

Selected boxes

Slider object

Process connection
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Filter
Note
The search operation in the tag selection dialog can take some time when there is a large
number of tags. Searching lasts about one minute with 15,000 tags.
It is helpful to use the filter to make a preselection in the tag selection dialog.
Using the filter function, you can reduce the selected number of tags or symbols so as to search
more efficiently.
Use the placeholders "*" and "?" in the search. You can only use alphanumeric characters
when searching for names. WinCC saves the last 20 search criteria you entered.
Example
The following internal tags have been created in WinCC, for example: "var1"; "var2"; "var3";
"smv2" and "apm1". Enter "a*" as search criterion and exit the filter function with the <Tab>
key. WinCC now displays all tags whose name starts with "a". Which means the tag "apm1"
in the folder "List of all tags".

Data source
This function is available when you are working with WinCC integrated in STEP 7.
In this box you can select the data source from which you would like to attach a tag.
'WinCC Tags" data source
Note
In certain situations the tag selection dialog sets a filter to the data type of the tag.
WinCC display all configured internal tags and process tags. You can create new tags with
the function "Create new tag". You can edit existing WinCC tags with the function "Edit tag".
"ES Tags" data source
WinCC displays all PCS 7 process tags. PCS 7 process tags are all operable and visible CFC
and SFC modules which were configured in the PCS 7 Engineering System. "CFC" stands for
"Continuous Function Chart". "SFC" stands for "Sequential Function Chart". You can update
the attributes of the displayed tag by operating the "Update ES Tags" button. This is necessary
only when an attribute is modified in the PCS 7 Engineering System while the tag selection
dialog is open. Attributes are items such as name, type or comment relating to a process tag.
More information on this is available in the section "Integration in the SIMATIC Manager" and
in the "Process Control System PCS7 Operator Station" device manual.
"Update ES Tags" button
The button
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You can use this button to update the CFC/SFC connections. CFC/SFC stands for "Continuous
Function Chart/Sequential Function Chart". When you extend STEP 7 connections, you can
update the corresponding engineering station with this function.
"STEP 7 Symbols" data source
WinCC displays all the inputs, outputs, and bit memories in the STEP 7 symbol list and all the
global data blocks. The symbol lists and the data blocks are created in SIMATIC Manager. In
this case, data blocks themselves cannot be mapped. Only the parameters of the prevailing
data block displayed in the data window can be mapped.
"Transfer data" button
The button

is available when you have selected the data source "STEP 7 Symbols".

With the function "Transfer data" WinCC accepts the selected symbols or parameters of data
blocks in the WinCC database.

2.4.4

Displaying status information in Runtime

Introduction
Status information on tags and connections is displayed in the Tag Management editor.

Status information in Runtime
Tooltip in the navigation area
WinCC shows the status information relating to a connection as a tooltip when you hover the
mouse over a connection in the data window.
Displaying the current value of tags
Show the "Value" column in the table area using the shortcut menu.
Displaying quality code
Quality codes provide encoded information about the status and quality of a tag.
Show the "Quality Code" column in the table area using the shortcut menu.
An overview of the quality codes is available in the WinCC Information System under
"Communication" > "Diagnostics of communication" > "Tag Quality Codes".
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2.5

Configuration in Tag Management

2.5.1

Creating communication drivers and connections

2.5.1.1

How to add a new communication driver
In WinCC Configuration Studio, you add a communication driver in the navigation area of the
Tag Management editor.

Introduction
A communication driver is used for communication between WinCC and the connected
automation system.
You can find information about supported WinCC communication drivers in the WinCC
Information System under "Communication".
Channel units are provided by the communication driver. You then set up the connections.

Procedure
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1. Select the "Tag Management" folder in the navigation area.
2. Select the "Add New Driver" from the shortcut menu.
3. Select the communication driver from the list that is displayed.
The selected driver appears as a new folder in the navigation area. Subfolders for the
available channel units are displayed in the folder.
Note
Deleting a communication driver
To delete a communication driver, select the driver in the navigation area. From the shortcut
menu, select the "Delete" command.
Channel units cannot be individually deleted or created.

2.5.1.2

How to create a new connection
In WinCC Configuration Studio, you set up a connection in the navigation area of the Tag
Management editor.

Procedure

1. Select the folder of a channel unit in the navigation area. Channel units are provided by
communication drivers.
2. Select the "New Connection" command from the shortcut menu.
The connection appears as a new folder in the navigation area.
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3. Enter a descriptive name for the connection.
– In the navigation area: Select the "Rename" command from the shortcut menu.
– In the table area: Change the name in the "Name" column on the "Connections" tab.
– Change the name under "General" in the "Properties" area.
4. You can now create process tags or tag groups for a connection.

Alternative procedure
1. Select the folder of a channel unit in the navigation area.
2. Select the "Connections" tab in the table area.
3. Click in the top free cell of the "Name" column. The cell is identified by a yellow icon.
4. Enter a name.
The connection is created.

Creating multiple connections
1. Select the lowest full cell in the "Name" column in the table area.
2. Drag down the selection of the cell with the bottom right handle while keeping the mouse
button pressed.
A new connection is created in each row over which you drag the selection.

2.5.1.3

How to set system parameters for a connection
In WinCC Configuration Studio, you define the system parameters of a channel unit in the
navigation area of the Tag Management editor.

System parameters
Note
The settings you can make are determined by the communication driver used for the
respective connection.
You can find more detailed information about the possible settings for a connection in the
documentation of the communication driver.
System parameters can be adjusted for some channel units.
Example for the system parameters of a channel unit:
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How to set the system parameters
1. Select the folder of a channel unit in the navigation area and then select "System
parameters" in the shortcut menu.
The "System Parameters" dialog opens.
2. Make your settings in the "System Parameters" dialog.

2.5.1.4

How to set the connection parameters
In WinCC Configuration Studio, you define the connection parameters of a connection in the
navigation area of the Tag Management editor.

Connection parameters
Note
The settings you can make are determined by the communication driver used for the
respective connection.
You can find more detailed information about the possible settings for a connection in the
documentation of the communication driver.
Example for connection parameters of a channel unit:
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How to set the connection parameters
1. Select the folder of the connection in the navigation area and then select "Connection
parameters" in the shortcut menu.
The "Connection parameters" dialog opens
2. Make your settings in the "Connection parameters" dialog.

2.5.2

Creating Tags

2.5.2.1

Creating Tags

Introduction
This section describes how you create tags and structures:
● Process tags
● Internal tags
● Structure types
● Tag groups
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Detailed instructions on format adaptation is available in the WinCC Information System under
"Communication" > "Process communication" > "WinCC Process communication" > "External
tags".
Note
Tags that you create are available immediately.
Changes, for example to properties, are written directly and without explicit saving to the
database and therefore take effect immediately in Runtime.

2.5.2.2

Creating Internal Tags
In WinCC Configuration Studio, you create tags in the table area of the Tag Management editor.

Introduction
You use internal tags to transfer data within your project.
You can create internal tags in groups or move them to groups once they have been created.
Note
Updating with a client without its own project
Usually, the "Project-wide update" or "Computer-local update" settings do not have any effect.
Internal tags which you create on a server are always updated for the whole project. Internal
tags which you create on a WinCC Client are always updated for the local computer.
The setting is only relevant if you configure a client without its own project.

Procedure
1. Select the "Internal Tags" folder in the "Tag Management" editor.
If necessary, select one of the groups subordinate to the "Internal tags" folder.

2. Click the "Tags" tab below the table area.
3. Click in the top free cell of the "Name" column.
4. Enter the name for the tag.
In doing so, pay due consideration to the name conventions in the section "Tag
Management and Tags" > "Tags".
5. Set the data type in the "Data type" field.
WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

239

Working with Tags
2.5 Configuration in Tag Management
6. Specify limits, the start value and substitute value as necessary.
A start value is set if no process value is available when the project is activated.
7. Activate the "Runtime persistency" option to retain the value of the internal tag on closing
Runtime.
The value saved is used as start value for the restart of Runtime. The start value configured
is only used at the first start of Runtime and after the data type was changed.

2.5.2.3

How to Create a Process Tag
In WinCC Configuration Studio, you create tags in the table area of the Tag Management editor.

Introduction
You use process tags for communication between WinCC and the automation system.
You can create process tags in groups or move them to groups once they have been created.

Requirement
● You have installed a communication driver and created at least one connection below it.

Procedure
1. In the Tag Management editor, select the folder of the communication driver for which you
would like to create a process tag.
2. Open the folder of the desired channel unit.
3. Select the corresponding connection.

4. Click the "Tags" tab below the table area.
5. Click in the top free cell of the "Name" column.
6. Enter the name for the tag. In doing so, pay due consideration to the name conventions in
the section "Tag Management and Tags" > "Tags".
7. Set the data type in the "Data type" field.
8. If necessary, modify the set format adaptation and set Linear Scaling if required.
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9. Set the address of the tag.
For this purpose, click in the "Address" field and then on the
button.
The "Address Properties" dialog box opens. After entering the address, close the dialog
box by clicking "OK".
The address properties depend on the channel unit you selected. You can find more
information on addressing a process tag in the WinCC Information System under
"Communication" in the respective communication driver.
10.Specify limits, the start value and substitute value as necessary.
A start value is set if no process value is available when the project is activated.

2.5.2.4

How to edit the properties of a tag
The properties of tags are displayed in the table area and in the "Properties" area in the Tag
Management editor.

Displaying and editing properties
Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
1. In the navigation area, select the "Tag Management" folder to display all tags in the table
area.
2. In the navigation area, select the folder of a group, a connection or a channel unit to display
the assigned tags.
3. In the tag area, select a row to display and edit the properties of the tags in the "Properties"
area.
To display tags in the table area, you may need to select the "Tags" tab.
4. To edit multiple tags at the same time, you can use, for example, the "Select and pull
selection down" function or the shortcut menu commands "Deselect all" and "Select all". In
the table area, you can use the shortcut menu of a column header to show or hide specific
columns (and therefore properties). You can display tags clearly using filtering and sorting
options.

2.5.2.5

Creating structure types and structure tags

How to configure structure types
Introduction
You can use structure types to create multiple tags as structure tag elements simultaneously
in one step. You can create internal tags and process tags in doing so.
With respect to configuration in the editors, structure tag elements do not differ from other tags.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

241

Working with Tags
2.5 Configuration in Tag Management

Procedure
Note
Perform all settings before applying the structure type for creating tags. You can then modify
the properties of the created structure tags later.
To modify the properties of a structure type, you must first delete all associated structure tags.
1. Create a structure type, see "How to Create a Structure Tag (Page 242)".
2. Create a structure type element, see "How to create a structure type element (Page 243)".
3. Create a structure tag, see "How to create a structure tag (Page 245)".
WinCC generates the structure tag elements. Integrate them into the project.
For every element created in the structure type, WinCC generates a structure tag element
with the appropriate properties. The name of the structure tag is composed of the name of
the structure instance and the name of the structure element, separated by a dot.

Creating Internal Tags
When creating an internal tag, the structure types available to you are those that do not contain
structure elements for process tags.
Structure types, in which structure elements are defined for process tags, can only be used
when you create tags under the connection of a channel unit.
You can create structure tags with a structure type, in which only structure elements for internal
tags are defined, under the connection of a channel unit. The structure instance is displayed
under structure types; the associated structure tags under "Internal tags". No entry appears
under the connection in the data window. If you try to delete a connection, a message appears
however that there are still elements which will also be deleted. If this message is confirmed,
the structure instance and the structure tags will also be deleted.

Update
If you create internal structure tags in a multi-user project, you can use the setting "Projectwide update" or "Computer-local update". This setting is only then relevant if you do not create
an individual client project on the WinCC clients.
Define the required update with the created structure tags. The setting in the structure instance
is not transferred when creating the associated structure tag.

How to Create a Structure Tag
In WinCC Configuration Studio, you create structure types in the navigation area of the Tag
Management editor.

Introduction
Once the structure type is created, you create the individual structure type elements. You
assign the structure type to structure tags as data type. In this way, you generate the tags
defined in the structure type.
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Procedure

1. Select the "Structure tags" folder in the "Tag Management" editor.
2. Select the "New Structure Type" from the shortcut menu.
You have created a new structure type.
3. Change the name of the structure type. Adhere to the naming conventions.
– In the navigation area: Select the "Rename" command from the shortcut menu.
– In the table area: Change the name in the "Name" column on the "Structure type
elements" tab.
– Change the name under "General" in the "Properties" area.

Alternative procedure
1. Select the "Structure tags" folder in the navigation area.
2. Select the "Structure types" tab in the table area.
3. Click in the top free cell of the "Name" column. The cell is identified by a yellow icon.
4. Enter a name.
You have successfully created the structure type.
Creating multiple structure types
1. Select the lowest full cell in the "Name" column in the table area.
2. Drag down the selection of the cell with the bottom right handle while keeping the mouse
button pressed.
A new structure type element is created in each row over which you drag the selection.

How to create a structure type element
In WinCC Configuration Studio, you create structure type elements in the navigation area of
the Tag Management editor.
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Procedure

1. Select the folder of a structure type in the "Tag Management" editor.
2. Select the "New Structure Type Element" from the shortcut menu.
A new structure type element is created.
3. Change the name of the structure type element. Adhere to the naming conventions.
– In the navigation area: Select the "Rename" command from the shortcut menu.
– In the table area: Change the name in the "Name" column on the "Structure type
elements" tab.
– Change the name under "General" in the "Properties" area.

Alternative procedure
1. Select the folder of a structure type in the navigation area.
2. Select the "Structure type elements" tab in the table area.
3. Click in the top free cell of the "Name" column. The cell is identified by a yellow icon.
4. Enter a name.
The structure type element is created.

Creating multiple structure types
1. Select the lowest full cell in the "Name" column in the table area.
2. Drag down the selection of the cell with the bottom right handle while keeping the mouse
button pressed.
A new structure type element is created in each row over which you drag the selection.
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Arranging structure type elements
You can change the order of the structure type elements in the navigation area.
1. Select the structure type element that you want to move.
2. Select "Move up" or "Move down" in the shortcut menu.
The selected item is moved to a new location.

How to create a structure tag
In WinCC Configuration Studio, you set up structure tags in the table area of the Tag
Management editor.

Introduction
After you have defined the structure for the structure tags by configuring structure types and
the corresponding structure type elements, you can create structure tags in the table area.
The instances of the tags (structure tag elements) are generated automatically.

Procedure

1. Select the structure for which you want to create tags in the navigation area.
2. Select the "Structure tags" tab in the table area.
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3. Enter the name for the tag in the top free field of the "Name" column.
Adhere to the naming conventions.
4. Edit the properties of the tag in the table area or in the "Properties" area.
– Under "Connection", select whether the tag is an internal tag or a process tag.
– For process tags, set Linear scaling as necessary.
– Change the given format adaptation for process tags as necessary.
You can select a channel unit from the "Use additional format adaptations from"
selection box. WinCC then also features the format adaptations that are supported by
that channel unit.
– Check the "AS offset" value for process tags. This value defines the offset of the structure
element relative to the start address in bytes. The offset value of a new or copied element
is incremented automatically. You may customize the settings.

Creating multiple structure tags
1. Select the lowest full cell in the "Name" column in the table area.
2. Drag down the selection of the cell with the bottom right handle while keeping the mouse
button pressed.
A new structure tag is created in each row over which you drag the selection.

Structure tag elements
The structure tag elements are generated based on the configured structure tags and the
configured structure type elements. You can find a list of them in the "Structure tag elements"
tab in the table area.

How to edit the properties of structure tags
In WinCC Configuration Studio, you edit the properties of structure tags in the table area or in
the "Properties" area of the Tag Management editor.

Introduction
Structure types are created using the "Tag Management" editor in the Configuration Studio.
When creating a structure type, you create the individual structure type elements. You assign
a structure type as data type when you create a structure tag. In this way, you create the
structure tag elements defined by the structure type.
The properties of a structure tag element are determined by the properties of the structure
type element and the structure tag.

Displaying and editing properties
The properties of structure type elements, structure tags and structure tag elements are
displayed in the table area and in the "Properties" area.
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Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
1. In the navigation area, select the "Structure tags" folder to display all tags in the table area.
2. In the navigation area, select the folder of a structure type to display the assigned elements.
3. Select the corresponding tab in the table area:
– Structure type elements
– Structure tags
– Structure tag elements
4. In the table area, select a row to display and edit the properties in the "Properties" area.
5. To edit multiple elements at the same time, you can use, for example, the "Select and pull
selection down" function or the shortcut menu commands "Deselect all" and "Select all". In
the table area, you can use the shortcut menu of a column header to show or hide specific
columns (and therefore properties). You can display tags clearly using filtering and sorting
options.
6. Change the given format adaptation for process tags as necessary.
7. Check the "AS offset" and "AS offset bit" properties for process tags. This value defines
the offset of the structure element relative to the start address in bytes. The offset value of
a new or copied element is incremented automatically. You may customize the settings.

2.5.2.6

Tag groups

How to Create a Tag Group
Introduction
You create tag groups in the "Tag Management" editor.
You create tag groups for internal tags directly in the folder "Internal tags". You create tag
groups for process tags in the folder of a connection.
You can create tags in a tag group. You can assign existing tags to a group. A tag group cannot
contain another tag group.

Procedure
1. In the navigation area, select the folder in which you want to create the tag group.
2. Select "New Group" in the shortcut menu.
3. Change the name of the group. Adhere to the naming conventions.
– In the navigation area: Select the "Rename" command from the shortcut menu.
– In the table area: Change the name in the "Name" column on the "Groups" tab.
– Change the name under "General" in the "Properties" area.
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Alternative procedure
1. Select a folder in the navigation area.
2. Select the "Groups" tab in the table area.
3. Click in the top free cell of the "Name" column. The cell is identified by a yellow icon.
4. Enter a name.
The group is created with this symbol

.

Creating multiple groups
1. Select the lowest full cell in the "Name" column in the table area.
2. Drag down the selection of the cell with the bottom right handle while keeping the mouse
button pressed.
A new group is created in each row over which you drag the selection.

How to assign tags to a group
Introduction
Groups are an efficient means of managing and calling tags. A tag can only be assigned to
one group. This assignment can be changed at any time. Before you can assign tags to a
group, you first need to create this group.

Assigning tags to a group
1. Select the column of a tag in the table area.
2. If you want to assign the tag to a different connection or to the "Internal tags", select the
connection from the drop-down list in the "Connection" field in the properties area under
"Assignment".
3. Under "Assignment" in the "Group" field of the properties area, select the group to which
the tag should be assigned from the drop-down list.
The groups which were created under the corresponding connection or the "Internal tags"
folder are available.
The tag is assigned to the group.
It is not possible to assign tags to a group by means of cut and paste.
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2.5.3

Editing Tags

2.5.3.1

Editing Tags

Introduction
This section informs you of the possibilities of editing tags, tag groups and structure types:
● Copy
● Move
● Delete
● Rename
● Edit in Runtime
● Display value, quality code and tag status
Note
If a tag was created in WinCC with "Compile OS" using the SIMATIC Manager, you cannot
edit the tag in WinCC Explorer.
Note
Changes, for example to properties, are written directly and without explicit saving to the
database and therefore take effect immediately in Runtime.

2.5.3.2

Copying, Moving and Deleting Tags

Introduction
The shortcut menu in the navigation area and in the table area lets you edit tags, groups and
selected areas:
● Copy
● Cut
● Paste
● Delete
You can thus edit tag groups or structure type elements, for example, in the navigation area.
If the action cannot be performed, a message appears.
Alternatively, you use the keyboard shortcuts <Ctrl+C> (copy) and <Ctrl+V> (paste).
In the table area, you use the shortcut menu to edit rows, columns or selected areas.
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In the table area, you can also create copies of an object by selecting an object in the "Name"
column and dragging the selection at the bottom right corner while keeping the left mouse
button pressed.

Copying Tags, Tag Groups and Structure Types
Note
If a tag was created in WinCC with "Compile OS" using the SIMATIC Manager, you cannot
copy or delete the tag in WinCC Explorer.
If you wish to configure several tags with identical properties, for example, you can copy an
existing tag and paste it at the desired position. WinCC automatically increments numeric
values at the end of the name.
Examples
Selected tags

Copied tag

VarOne

VarOne_1
VarOne_2

VarOne_2
VarOne_3

VarOne_4
VarOne_5

VarOne_1
VarOne_3
VarOne_5

VarOne_7
VarOne_9
VarOne_11

Moving Tags and Tag Groups
Note
If you move a tag between the tag management "Internal tags" and a communication driver
or between communication drivers, you have to adapt the properties of the tag afterwards.
If you want to move tags or tag groups, edit the "Connection" or "Group" property.
You can move tags:
● from one tag group to another tag group
● from the connection of a communication driver to the connection of another communication
driver
● from tag management "Internal tag" to a communication driver
● from a connection of a communication driver to the tag management "Internal tags"
Structure types and structure tag elements cannot be moved.
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Deleting tags
Note
When deleting tags, data inconsistencies may result in other parts of the project which could
lead to errors or faults.
1. Select the row of a tag in the table area and select "Delete" from the shortcut menu.
Alternatively, press <DEL>.
If you select individual fields instead of a row, the corresponding contents are deleted, not
the tag.
2. To delete all tags of a group, select the group in the navigation area and the "Delete"
command from the shortcut menu.
If you delete a connection, a structure type or a structure type element, all assigned tags are
deleted.

2.5.3.3

How to Rename Tags

Introduction
Note
If a tag was created in WinCC with "Compile OS" using the SIMATIC Manager, you cannot
edit the tag in WinCC Explorer.
You can rename the following elements in Tag Management:
● Tags, structure tags
● Tag groups
● Structure types, structure type elements
● Connections

Upper/lower case text
WinCC is case-sensitive in handling the names of tags.
You cannot create tags whose names differ only with respect to case in the editor.

Procedure
1. Select a tag, tag group, connection, or structure type in the navigation area.
2. Select the "Rename" command from the shortcut menu.
The item can now be renamed.
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Alternative procedure
● Press the <F2> function key in the navigation area.
● Click the "Name" field in the table area or in the "Properties" area and enter the new name.
If the selected object cannot be renamed (for example, because an object already exists with
the same name), you receive a message.

Special features with structure types
If you change the name of a structure tag or a structure type element, the name of the
respective structure tag element automatically changes at the same time.
If you change the name of a structure type, this has no impact on the lower-level objects.

2.5.3.4

How to edit tags in Runtime

Introduction
If you have activated a project, you can edit tags in parallel. There are a few constraints.

Editing in Runtime
Note
If a tag was created in WinCC with "Compile OS" using the SIMATIC Manager, you cannot
edit the tag in WinCC Explorer.
You can edit the following elements in Runtime:
Tags

Tag groups

Structure types

Structure instances

X

X

X

X

Create
Address

X

---

---

X

Cut

X 2)

---

---

---

Copy

X 2)

X

X

X

Paste

X

X

X

X

Delete

X

Modify properties
Rename

X

---

X

X

X

X3)

X

X 1) 2)

X

---

X

1) 2)

1)

Possible with external tags only if the channel supports the function. This currently only
applies to the channel "SIMATIC S7 Protocol Suite".

1)

Does not apply to structure tags.

2)

3)
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2.5.3.5

In this way, you display the value, status and quality code for tags

Introduction
You can display the current value, the status and the quality code of tags in the table area of
the Tag Management editor.

Procedure
1. In the navigation area, select the folder to which the corresponding tags are assigned.
2. Select the "Tag Management" or "Structure tags" folder to display all tags of this folder in
the table area.
3. Select the "Tags" or "Structure tag elements" tab in the table area.
4. Click in a column header and select the column to be shown, for example "Value", from the
shortcut menu.
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The corresponding column is shown in the table area. You can read the current values here.
Note
The tag values are updated regularly in Runtime. If tag values are shown permanently, this
could strongly impede the performance of the system.

2.5.4

Importing and exporting tags

2.5.4.1

Importing data records

Introduction
You can import data records from third-party applications or other WinCC projects in the
WinCC Configuration Studio. These data records must be available in "Office Open XML
Workbook" format. Files of this format have the ".xlsx" extension and can be opened and edited
in spreadsheet programs.
Note
You cannot undo the import of data records.

Requirements
● The data records you load may not be in use by any other application.
● The connections contained in the data records must be available by their name in
WinCC Configuration Studio.

Procedure
1. Select the required editor in the navigation area.
2. Select "Import" from the shortcut menu of the editor.
The "Select file" dialog opens.
3. Select the file to import.
The data records will be loaded. A progress bar is displayed.

2.5.4.2

How to export tags

Introduction
You can export tags and the structures in which tags are embedded. The exported tags are
either saved as text files (*.txt) or as Excel workbooks (*.xlsx).
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Preparation for export
● Select the folder you wish to export in the navigation area.
● Select the rows of individual tags or tag groups you want to export in the table area.
To do so, select the row numbers of the items.
Press the <Shift> key at the same time to select consecutive items.
Press the <Ctrl> key at the same time to select non-consecutive items.

Procedure
1. Select the objects you want to export.
2. Select "Export" in the shortcut menu.
3. Select the file format (text or Excel workbook).
The selected objects are written to a file.
A message confirms that the export was completed successfully.
Note
Select the "Edit > Export" command from the main menu to export all tags of Tag
Management.

Structure of the export file
The format of the export file is either Unicode text or an Excel workbook. All dependencies are
also exported.
Unicode text
The individual properties are separated by tabs; the lines are separated by line breaks (CRLF) .
Depending on the selected export, the file lists tags, tag groups, structure types, connections,
etc. with all the properties.
You can open and edit the file in spreadsheet programs (such as MS Excel).
Excel workbook
Tags, tag groups, structure types, etc. are represented on separate worksheets in Microsoft
Excel 2010 format.
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Creating Process Pictures

Contents
The Graphics Designer is an editor for creating process pictures and making them dynamic.
This chapter will show you
● how to use the "Graphics Designer" editor
● how to create and edit process pictures
● how to adapt the object properties to the requirements of your project
● how to configure and use objects of the Object Palette and library
● how to combine and configure objects of the Object Palette
● how to integrate and configure controls in process pictures
● how to test process pictures in Runtime
Chapter "Object properties" describes the properties of the objects of the Graphics Designer.
How to make process pictures dynamic is described in detail in the chapter "Making Process
Pictures Dynamic".
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3.2

How to start the Graphics Designer

Introduction
The Graphics Designer can only be started for the project currently opened in the WinCC
Explorer.

Requirements
● A project must be opened.

Procedure
The Graphics Designer can be opened in the following ways:
● Navigation window of WinCC Explorer
Select the command "Open" in the shortcut menu of the entry "Graphics Designer".
The Graphics Designer is started and a new picture is opened.
● Navigation window of WinCC Explorer
Double-click the "Graphics Designer" entry in the navigation window.
The Graphics Designer is started and a new picture is opened.
● Data window of WinCC Explorer
Select the entry "Graphics Designer" in the navigation window. The pictures available in
the project are shown in the data window. Select the command "Open picture(s)" in the
shortcut menu of a picture.
The Graphics Designer is started and the selected picture is opened.

See also
The pop-up menu in the Data Window (Page 269)
The shortcut menu in the Navigation window (Page 261)
The Graphics Designer in the WinCC Explorer (Page 259)
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3.3

The Graphics Designer in the WinCC Explorer

3.3.1

The Graphics Designer in the WinCC Explorer

Introduction

For working with the Graphics Designer, the WinCC Explorer offers the following functions and
configuration options:
● Starting Graphics Designer
● Opening, creating, renaming and deleting a picture
● Specifying a picture as a start picture or marking it as a favorite
● Properties of the picture
● Configuring object libraries and ActiveX controls
● Converting libraries and pictures from older program versions
● Configuring and starting Runtime
You can call commands via the toolbar and the shortcut menus in the navigation and data
windows.
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Picture types in the Graphics Designer
The following types of pictures are differentiated:
Process picture
Faceplate type that can be inserted as an instance in a process picture
Process picture with faceplate instances that are affected by type changes
Process picture marked as a favorite. In Runtime you can select the picture as a favorite
by means of the system dialogs.

You can find additional information on faceplate types in the section "Working with faceplate
types".

Converting Project Data
You can import data and files from projects that were created with previous versions into the
WinCC project and thereby access existing configuration data. To do this, you need to adapt
screens and script files, for example, to the current version of WinCC and convert them to the
current format.
NOTICE
Conversion is irrevocable
Conversion of data cannot be undone.
The conversion starts immediately, as soon as you have selected the entry. No confirmation
prompt appears.
Note
It is not possible to convert an individual picture or library object.
System pictures that you have set as invisible in the computer properties on the "Graphics
Runtime" tab are not converted.
Converting pictures and libraries can take some time.
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Procedure
1. In the WinCC Explorer, select the menu command "Tools > Convert project data".
2. Select the project data to be converted:
– Pictures and faceplates
– Global libraries
– Project libraries
– Page layouts and line layouts
– C and VB project functions and actions
– C and VB standard functions
– Data for Basic Process Control
3. Confirm with "OK".
The selected data is converted to the current version of WinCC.

See also
How to configure the control selection (Page 266)
How to configure the object selection (Page 264)
Displaying the properties of a picture file (Page 271)
Displaying the configured dynamics of a process picture (Page 273)
How to start the Graphics Designer (Page 258)
How to set up Runtime (Page 145)
How to activate / deactivate Runtime (Page 689)
The shortcut menu in the Navigation window (Page 261)
The pop-up menu in the Data Window (Page 269)

3.3.2

The shortcut menu in the Navigation window

Introduction
A shortcut menu permits rapid access to frequently required functions.
The navigation window is the left-hand window in the WinCC Explorer. The shortcut menu can
be used to modify the components of the opened project. The shortcut menu of the Graphics
Designer enables you to create new pictures or integrate controls.
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Requirements
● A project must be opened.

Procedure
1. Right-click the entry "Graphics Designer".
The shortcut menu is opened.
2. Select one of the entries from the shortcut menu.

Opening
Selecting the "Open" command creates a new picture with the name "NewPdl1" in "PDL" format
and opens it with the Graphics Designer.

New picture
Selecting the command "New picture" creates a new picture in "PDL" format. The new picture
is displayed in the data window. The new picture is automatically assigned a sequential name.
You can change the name following this. This dialog is described in detail in the section "The
shortcut menu in the data window".
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Graphic OLL
The "Object OLL" dialog is opened. This dialog indicates which object libraries are available
for the Graphics Designer. The object selection can be configured for the current project. You
can use the "Find..." button to use objects from other object libraries in your current project.
This dialog is described in detail in the section "How to configure the object selection".

Selecting ActiveX controls
The "Select OCX Controls" dialog is opened. This dialog shows all the ActiveX Controls that
are registered in the operating system. A red check mark indicates the controls that are shown
in the object palette of the Graphics Designer in the "Controls" tab. You can make other controls
available for the Graphics Designer. You can integrate Windows controls or third-party controls
and use them in the project.
The "Select OCX Controls" dialog is described in detail in the section "How to configure the
control selection of the object palette".

Display Column Information
The Display Column Information entry in the data window of WinCC Explorer is used to show
the Information column. The entry in this column shows how the corresponding picture was
created.
Type of object creation

Entry in the Information column

Picture has been created using WinCC Explorer.

<No entry>

Picture has been created using WinCC Explorer
and then imported to SIMATIC Manager using the
Import WinCC Objects function.

Created by SIMATIC Manager

Picture has been created using SIMATIC Manager. Created by SIMATIC Manager

Editing the Favorites sequence
Favorite pictures are marked with an asterisk in the data window. The order of these favorites
can be changed with this entry. "How to specify the process pictures as favorites" describes
in detail how to specify pictures as favorites.

Properties
The "Properties" window provides an overview of the most important properties and settings
of the Graphics Designer.

See also
How to configure the control selection (Page 266)
How to specify favorite process pictures (Page 151)
How to configure the object selection (Page 264)
How to start the Graphics Designer (Page 258)
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The pop-up menu in the Data Window (Page 269)
The Graphics Designer in the WinCC Explorer (Page 259)

3.3.3

How to configure the object selection

Introduction
The object selection available in the Graphics Designer can be configured for the current
project. Other object libraries can be imported using the "Browse" button. It is possible, for
example, to integrate other button or text objects and then use them in the project.

Requirements
A project must be opened.

Opening the "Object OLL" dialog
Right-click in the navigation window on the entry "Graphics Designer". Select the entry
"Graphic OLL" from the shortcut menu.
This "Object OLL" dialog indicates which object libraries are available for the Graphics
Designer. The availability of object libraries can be changed as required.

Available Graphic OLLs
All of the object libraries registered in WinCC in the left-hand area of the dialog.
Selected Graphic OLLs
The right-hand area of the dialog lists all the object libraries that have been selected for use
in the Graphics Designer.
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Arrow buttons
Use the arrow buttons to move object libraries in the relevant arrow direction.
Button "Find"
Click the "Find" button to add other object libraries to WinCC.
Button "Preview"
Select the desired OLL file in one of the two upper areas. Click the "Preview" button to display
the content of the selected object library as a preview.

Configuring the Graphic OLL
In the Graphics Designer, only the object libraries listed in the area "Selected Graphic OLLs"
are available. Use the arrow buttons to move a selected object library in the relevant arrow
direction. You can also select a number of OLL files if you click the desired files while holding
down the <SHIFT> or <CTRL> keys.
The arrow buttons have the following function:
Moves the selected OLL file from the left-hand area into the right-hand area
Moves the selected OLL file from the right-hand area into the left-hand area.
Moves all the OLL files displayed in the left-hand area into the right-hand area.
Moves all the OLL files displayed in the right-hand area into the left-hand area.

Adding Graphic OLLs
You can use the "Object OLL" dialog to link other object libraries in WinCC by copying them
from a floppy disk or from another directory into the area "Available Graphic OLLs".
1. Click the "Find" button.
The "Disk" dialog opens.

2. Enter the path of the requested source directory.
3. Confirm your selection by clicking "OK".
The selected OLL files will be displayed in the left area of the dialog "Object OLL".
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Note
Object libraries are WinCC files of the format OLL and they are located in the subfolder "Bin"
of the WinCC installation directory.
Additional object libraries can be purchased through your WinCC sales partner.

See also
How to start the Graphics Designer (Page 258)
The shortcut menu in the Navigation window (Page 261)
The Graphics Designer in the WinCC Explorer (Page 259)

3.3.4

How to configure the control selection

Introduction
The "Controls" tab in the "Standard" selection window of the Graphics Designer contains a
selection of controls in the folders "ActiveX controls", ".NET controls" and "WPF controls". You
can insert these controls directly into a picture.
You can configure the selection of controls available in the tab yourself:
● Change the selection of the ActiveX controls in the dialog "Select OCX Controls". You can
add any of the ActiveX controls registered in the operating system to the list of controls and
remove individual controls from the selection.
● Change the selection of the .NET controls in the dialog "Select .NET Object".
● Change the selection of the WPF controls in the dialog "Select WPF Object".
Note
The use of controls from third party providers can lead to errors as well as drops in
performance or system blockage. The user of the software is responsible for problems
caused by the deployment of external controls.
We recommend a thorough test before implementation.
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Configuring ActiveX controls
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the
"ActiveX Controls" folder. The "Select OCX Controls" dialog is opened.

In the area "Available OCXs (Number)", the "Select OCX Controls" dialog shows all the
ActiveX Controls that are registered in the operating system. The exact number is shown
in the title of the area after the registration has been read in. A red check mark indicates
those controls that are available in the "Controls" tab dialog of the Object Palette. The path
and the program ID of the selected ActiveX Controls are displayed in the area "Details".
You can open the "Select OCX Controls" dialog also from the WinCC Explorer. Click on
the entry "Graphics Designer" in the navigation window and select the entry "Select ActiveX
Control" in the shortcut menu.
2. To add an ActiveX control in the "Controls" tab, select the required control in the area
"Available OCX Controls".
A red check mark indicates that the control is added to the "Controls" tab.
3. To remove an ActiveX control deactivate the control in question in the area "Available OCX
Controls".
The red check mark disappears.
4. Confirm your changes by clicking "OK".
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Configuring .NET objects and WPF objects
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the
".NET Controls" folder or the "WPF Controls" folder.
The dialog "Select .NET Object" or "Select WPF Object" opens.

In the area "Available Controls (Number)", the dialog shows all the .NET objects or WPF
objects on your computer. The precise number is displayed in the title of the area. A red
check mark indicates those controls that are available in the "Controls" tab dialog of the
Object Palette. The assembly, .NET version and path of the selected object are displayed
in the area "Details".
2. To add a control in the "Controls" tab, select the required control in the area "Available
Controls".
A red check mark indicates that the control is added to the "Controls" tab.
3. To remove a control deactivate the control in question in the area "Available Controls".
The red check mark disappears.
4. Confirm your changes by clicking "OK".

See also
The Graphics Designer in the WinCC Explorer (Page 259)
The shortcut menu in the Navigation window (Page 261)
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3.3.5

The pop-up menu in the Data Window

Introduction
A shortcut menu permits rapid access to frequently required functions. All of the functions listed
in the shortcut menu can also be started using the menu bar.
The data window is the right-hand window in the WinCC Explorer. Using the shortcut menu,
the clicked picture can be opened, renamed or deleted, for example. In the data window, a
picture can also be defined as the welcome screen.

Requirements
A project must be opened.

Procedure
1. In the navigation window of the WinCC Explorer, left-click on the entry "Graphics Designer".
All the pictures (PDL) and faceplate types (FPT) of the current project are displayed in the
data window.
2. Right-click one of the displayed pictures.
The shortcut menu is opened.
3. Select one of the entries from the shortcut menu.
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Opening (a) picture(s)
The selected picture is opened in the Graphics Designer. If necessary, the Graphics Designer
is started.

Rename picture
You can rename the selected picture in the WinCC Explorer provided it is not opened in the
Graphics Designer. The file format "PDL" is kept.
Enter the new file name into the text field of the "New name:" dialog. on Click "OK" to confirm
your entries.
Note
If you rename a picture in the WinCC Explorer, the new picture name must not correspond
to the name of an object that already exists in the picture. The software does not check for
whether the new name already exists. Using a name that already exists can lead to conflicts
during access via VBA or dynamization.

Delete picture(s)
The selected picture is deleted provided it is not opened in the Graphics Designer.
If you select the entry "Delete picture" for a picture, a confirmation prompt appears. As soon
as you confirm deletion of the picture with "OK", the picture is removed from the project.
Note
Deletion of pictures can not be undone.
If you create pictures using the SIMATIC Manager, these cannot be renamed or deleted in
WinCC Explorer. This also applies to WinCC pictures created in WinCC and subsequently
imported into SIMATIC Manager by using the function "Import WinCC objects". You can
recognize these pictures from the "Created by SIMATIC Manager" entry in the Information
column of the data window.

Define screen as start screen
The selected picture is defined as the start screen in Runtime. The selected picture is entered
in the "Start screen" field in the "Graphics Runtime" tab of the "Computer properties" dialog.

Marking (a) picture(s) as a favorite
The selected picture is identified as a favorite with an asterisk. You can use the system dialogs
to select the process pictures marked as favorites in Runtime.

Confirm all type changes
All the effects from changing the properties and event of the faceplate types on the given
faceplate instances are confirmed for the selected Graphics Designer pictures.
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The affected pictures are saved again. The status of the faceplate instances is reset. The red
cross is no longer displayed when the picture is opened in the Graphics Designer, WinCC
Explorer or in Runtime.
The following actions are combined in one menu command with "Confirm all type changes":
● Open each affected picture
● Confirm the type change via the "Faceplate instances with type change" dialog
● Save the pictures
Use the menu command when you are sure that the changes to the faceplate type will have
no effect on the instances.

Properties
The "Properties" window provides an overview of the most important properties of the selected
picture file. The "Preview" tab shows a preview of the picture and the file properties. A second
tab contains statistics on the configured dynamic properties of the picture.

See also
Working with Faceplate types (Page 344)
Displaying the properties of a picture file (Page 271)
Displaying the configured dynamics of a process picture (Page 273)
How to start the Graphics Designer (Page 258)
How to set up Runtime (Page 145)
The shortcut menu in the Navigation window (Page 261)
The Graphics Designer in the WinCC Explorer (Page 259)

3.3.6

Displaying the properties of a picture file

Introduction
If the entry "Graphics Designer" is selected in the navigation window of the WinCC Explorer,
all the pictures of the current project are displayed in the data window. The entry "Properties"
in the pop-up menu of a picture opens the "Properties" dialog. The "Properties" dialog has two
tabs that provide an overview of the most important picture properties.
The "Preview" tab shows a preview of the selected process picture as well as the statistical
characteristics of the picture file.
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Requirements
● A project must be opened.
● In the navigation window of the WinCC Explorer, the entry "Graphics Designer" must be
selected.
● For a complete display of the properties, the desired picture should not be opened in the
Graphics Designer.

Displaying statistical characteristics
Right-click one of the pictures in the data window and select the entry "Properties" from the
pop-up menu. Select the "Preview" tab.
The picture properties can also be opened using the menu bar of the WinCC Explorer.

Creation date
The date and time the picture was created are shown in the "Created on" field.

Date of change
The date and time the picture was last edited are shown in the "Last change on" field.
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File size
Shows the size of the PDL file in bytes.

Picture size
Shows the dimensions of the picture as "width by height" in pixels.

No. of objects
Shows the number of objects contained in the picture. The displayed value is calculated from
the total number of all configured single, group and customized objects. Also included in the
calculation are the single objects contained in groups.

See also
The Graphics Designer in the WinCC Explorer (Page 259)
The shortcut menu in the Navigation window (Page 261)
The pop-up menu in the Data Window (Page 269)
Displaying the configured dynamics of a process picture (Page 273)

3.3.7

Displaying the configured dynamics of a process picture

Introduction
If the entry "Graphics Designer" is selected in the navigation window of the WinCC Explorer,
all the pictures of the current project are displayed in the data window. The entry "Properties"
in the pop-up menu of a picture opens the "Properties" dialog. The "Properties" dialog has two
tabs that provide an overview of the most important picture properties.
With the functions of the "Dynamics" tab dialog, details of all dynamics defined for the selected
picture can be displayed.

Requirements
● A project must be opened.
● In the navigation window of the WinCC Explorer, the entry "Graphics Designer" must be
selected.
● For a complete display of the picture properties, the desired picture should not be opened
in the Graphics Designer.
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Displaying configured dynamics
Right-click one of the pictures in the data window and select the entry "Properties" from the
pop-up menu. Select the "Dynamics" tab.
The picture properties can also be opened using the menu bar of the WinCC Explorer.

The first time the "Dynamics" tab is opened, the entry "Statistics" is the default setting as type
of dynamics. The overview list displays all the types of dynamics and the frequency of their
configuration in the selected picture. Double-clicking calls the detailed view for the different
types of dynamics.

Type of dynamics
From the selection list "Type of Dynamics" select a dynamization for which you want to display
statistics on the use.

"Statistics" button
This button displays all the types of dynamics with the number of uses in the data window. The
contents of the data window and the selection list "Type of Dynamics" are reset.

Number
The "Number" field shows the total number of dynamics configured in the selected picture for
the selected type of dynamics.
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Overview list
All the objects of the selected picture for which the selected type of dynamics is configured
are shown in the overview list line by line. The columns of the overview list contain the
corresponding settings for these objects. The number and content of the columns depend on
the selected type of dynamics.
The sort order of the table can be changed by clicking on the column header.

Types of dynamics and their meaning
Type of dynamics

Meaning

Tag connections

When a tag is connected to a property of an
object, the value of the tag is transferred directly
to the object property.

Indirect tag connections

When a tag is connected to a property of an
object, the value of the tag is interpreted as the
tag name.

Cyclic actions (C)
Cyclic actions (VBS)

With a cyclic trigger the action is executed when
the triggering event occurs.

Tags in cyclic actions (C)
Tags in cyclic actions (VBS)

The action is executed when the value of one of
the trigger tags has changed.

Pictures in cyclic actions (C)
Pictures in cyclic actions (VBS)

Picture change at a cyclic action, for example:
C:
OpenPicture("NewImage.pdl"); Refer to the
WinCC encoding rules.
VBS:
HMIRuntime.BaseScreenName="NewImage"

Event-triggered actions (C)
Event-triggered actions (VBS)

The action that is connected to an event is
executed when the event occurs.

Tags in event-triggered actions (C)
Tags in event-triggered actions (VBS)

An event-triggered action contains tags in the
script.

Pictures in event-triggered actions (C)
Pictures in event-triggered actions (VBS)

Picture change in an event-triggered action.

Direct connections

If an event occurs in Runtime, the value of a
source element is used for a target element.

Dynamic dialogs (Outproc)

The dynamization of the tags runs in a separate
task if the criteria for "Dynamic dialogs (Inproc)"
are not given.

Tags in dynamic dialogs

The tags that are used in dynamic dialogs when
printing.

Dynamic dialogs (Inproc)

The functions of the script, which execute the
functionality of the dynamic dialog configuration,
run in the process context of the Graphics
Runtime.
Criteria for "Inproc":
- Use of just one tag as the trigger tag
- No additional function calls

Tags in the general cyclic part (VBS)

The tags are declared in the cyclic part in the
declaration area of the VBS Editor.
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Type of dynamics

Meaning

Pictures in the general cyclic part (VBS)

The pictures are declared in the cyclic part in the
declaration area of the VBS Editor.

Tags in the general event part (VBS)

The tags are declared in the event in the
declaration area of the VBS Editor.

Pictures in the general event part (VBS)

The pictures are declared in the event in the
declaration area of the VBS Editor.

See also
Displaying the properties of a picture file (Page 271)
The pop-up menu in the Data Window (Page 269)
The shortcut menu in the Navigation window (Page 261)
The Graphics Designer in the WinCC Explorer (Page 259)
Basic Dynamic Operations (Page 454)
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3.4

Elements and Basic Settings of the Graphics Designer

3.4.1

Elements and Basic Settings of the Graphics Designer

Introduction
The Graphics Designer is a combination of a graphics program and a tool for representing
processes. Based on the Windows standard, the Graphics Designer provides functions for the
creation and dynamic modification of process pictures. The familiar Windows program interface
makes it easy to begin using the complex program. Direct Help provides fast answers to
questions. The user can set up a personalized working environment.
This chapter contains information on the structure of the Graphics Designer, on the elements
and basic settings of the program.

See also
Customizing the Working Environment (Page 321)
The Basic Settings of the Graphics Designer (Page 307)
The Start Screen of the Graphics Designer (Page 283)

3.4.2

The Coordinate System of a Process Picture

Introduction
In the Graphics Designer, the basis for setting positions and specifying sizes is a twodimensional coordinate system. The two axes of the coordinate system, x-axis and y-axis, are
perpendicular to one another and intersect at the coordinate origin.
The coordinate origin lies with the coordinates (X = 0 / Y = 0) in the top left corner of the desktop.
Starting from the coordinate origin, the horizontal x-axis runs in positive direction towards the
right-hand border of the desktop. The vertical y-axis points in a positive direction towards the
lower border of the desktop. The X and Y values of the current position of the mouse pointer
are displayed in the status bar of the Graphics Designer. The values for X and Y rise when the
mouse pointer is moved from the top left to the bottom right on the desktop. The coordinates
are shown in pixels.
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The position and size of objects of a picture are determined by the coordinates that an object
has in the coordinate system. For example, the position of the object origin is set by the
attributes "Position X" and "Position Y". The object origin therefore has the coordinates X =
"Position X" / Y = "Position Y". The values of these attributes describe the distance of the object
origin from the coordinate axes.

Definition of origin
The origin is defined as the point of an area or an object that is used as the reference point for
entering position and size. For the creation of process pictures in the Graphics Designer, the
following reference points are of significance:
Coordinate origin
The "coordinate origin" is the top left corner of the desktop.
Coordinates: X = 0 / Y = 0
Picture origin
The "picture origin" is the top left corner of a process picture.
Coordinates: X = 0 / Y = 0
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If the picture on the work area is not displayed as a window but maximized, the picture origin
is the same as the coordinate origin.
Object origin
The "object origin" is the top left corner of the rectangle surrounding the object.
Coordinates: X = "Position X" / Y = "Position Y"

See also
Working with Objects (Page 425)
Status bar (Page 293)
The Rectangle Surrounding the Object (Page 281)
The Coordinate System of an Object (Page 279)

3.4.3

The Coordinate System of an Object

Introduction
The validity of the normal coordinate system is canceled for displays within an object. The
following special forms are used for the internal coordinate system of an object:
● 2D coordinate system of an object
● 3D coordinate system of an object

2D coordinate system of an object
The two-dimensional coordinate system of an object differs from that of a process picture in
the direction of the y-axis:
The positive direction of the Y-axis points upward.
The positive direction of the X-axis points to the right.

3D coordinate system of an object
For display in the object "3D bar", a three-dimensional coordinate system is used. In addition
to the horizontal x-axis and the vertical y-axis, this three-dimensional coordinate system has
a z-axis that points into the picture level. The coordinate system for the spatial representation
of the 3D bar can be customized with the following attributes:
● "Display axis"
Determines the coordinate axis, where the value scale displayed by the 3D bar runs.
● "Bar direction"
Determines the direction for the "Display axis", which the positive axis section points to.
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● "Alpha"
Determines the angle for the depth display of the Z-axis.
● "Beta"
Determines the angle for the depth display of the X-axis.

The following graphic illustrates the three adjustable display axes.
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See also
How to Insert a 3D Bar (Page 607)
Status bar (Page 293)
The Rectangle Surrounding the Object (Page 281)
The Coordinate System of a Process Picture (Page 277)

3.4.4

The Rectangle Surrounding the Object

Introduction
The rectangle surrounding an object is defined as a rectangular frame which lies on the outer
border lines of an object. The rectangle surrounding the object itself is not visible in the
Graphics Designer. As soon as you select an object, selection marks are shown however.
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These handles serve as grab points for changing the object size with the mouse. The handles
mark the center axes and corner points of the rectangle surrounding the object.
Note
If the object has 100% transparency, the selections marks are invisible as well.

The significance of the rectangle surrounding the object for determining the position is
illustrated with a circular or ellipse-shaped object as an example:
The position of an object is defined as the position of its origin in the coordinate system. The
object origin has the coordinates ("Position X"m "Position Y") and is defined as the upper left
corner of the rectangle surrounding the object. Specified in this way, the position of a circular
or ellipse-shaped object is set clearly.

The handles of the rectangle surrounding the object
The handles of the rectangle surrounding the object appear as soon as you select an object.
You can change the size of an object by shifting a selection mark to a new position with the
mouse.
As soon as the mouse pointer is positioned to a selection mark, it switches into a double arrow.
The alignment of the double arrow indicates the directions in which the handle can be moved:
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● Horizontal double arrow
You change the width of the object using the selection marks on the horizontal center axis.
● Vertical double arrow
You change the height of the object using the selection marks on the vertical center axis.
● Diagonal double arrow
The selection marks on the corners of the object can be used to change the height and
width of the object.
Note
You can change the overall size of circular objects. These have no selection marks for
the center axes.

See also
Working with Objects (Page 425)
How to scale an object (Page 440)
How to Select Multiple Objects (Page 435)
Multiple Selection of Objects (Page 433)
How to select an object (Page 432)
The Coordinate System of an Object (Page 279)
The Coordinate System of a Process Picture (Page 277)

3.4.5

The Start Screen of the Graphics Designer

3.4.5.1

The Start Screen of the Graphics Designer

Introduction
When you open the Graphics Designer, the screen with the default settings and an empty
picture in the "PDL" file format appears.
Use the "Process Pictures" selection window to open pictures and faceplates you wish to edit.
Several open pictures and faceplates are arranged in color-coordinated tabs above the
workspace.

Structure of the working environment in the Graphics Designer
The Graphics Designer consists of the following components:
● Workspace
● Menu bar
● Palettes
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● Selection window
● Status bar

Note
Use the scroll bars to move the visible area for large pictures.
The Graphics Designer offers operation with the mouse wheel. Click the mouse wheel. The
mouse pointer changes and you can move the visible picture area simply by moving the
mouse.
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The palettes and selection windows
● Alignment palette: For aligning multiple objects.
● Layer palette: For showing and hiding individual layers.
● Color palette: For quickly changing the color of an object.
● Object palette: For selecting a picture or object, for example, to change the properties.
● Font palette: For changing the font and font size, font color and border color.
● Default palette: For creating and saving documents, activating Runtime and further basic
functions.
● Status bar: For displaying the coordinates, the object type and the language setting.
● Zoom palette: For setting the zoom factor.
● Output window: For displaying faulty picture configurations during saving.
● Library: For selecting completed objects from libraries.
● Controls: For integrating elements for controlling and monitoring system processes.
● Dynamic Wizard: For making objects dynamic with pre-prepared C actions.
● Object properties: For checking and assigning statistical and dynamic object properties.
● Process pictures: For opening additional pictures and faceplates of the project.
● Standard: For selecting basic objects that are used often, for example, I/O field or static
text.
● Styles: For changing the line type, line thickness, line ends and fill patterns.
● Tags: For fast assignment of tags to objects that can be made dynamic.
● Reset: All settings of the Graphics Designer are reset to their original state.
In the default setting all elements except the tag selection window are displayed. You can show
or hide the individual elements by using "View > Toolbars".

Layout of palettes and selection windows
You can layout the palettes and selection windows in accordance with your requirements:
● You can position the palettes in the toolbar or freely floating
● You can position the selection windows using

:

– Undock
– Docking
– Document in tab format
– Automatically in background
– Hiding
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See also
Elements and Basic Settings of the Graphics Designer (Page 277)
Status bar (Page 293)
Tags (Page 299)
Font palette (Page 290)
Color palette (Page 289)
Zoom palette (Page 294)
Layer palette (Page 287)
Alignment palette (Page 286)
Dynamic Wizard (Page 296)
Styles (Page 299)
Controls (Page 295)
Standard palette (Page 291)
Standard (Page 298)

3.4.5.2

Alignment palette

Introduction
The functions of the Alignment Palette can be used to process a number of objects together.
You can also call up these functions from the "Arrange > Align" menu.
You show or hide the alignment palette with "View > Toolbars". To the left of the Alignment
Palette is a handle, which you can use to move the palette to any position on the screen.

Requirements
● You have selected at least two objects.

Overview
The Alignment Palette contains the following functions for processing the objects in a multiple
selection:
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Buttons

Function

Reference object

Align:
If you have selected the objects using a
The selected objects are aligned on the left, right, selection border (lasso) with the mouse, the
top or bottom.
object located the furthest towards the outside
is used as reference.
If you have selected the objects with the
<SHIFT> key and left-click, the first selected
object is used as reference.
If you have selected the objects with <Ctrl+A>,
the reference object of the original selection
applies; otherwise that on the outermost object.
Center:
The selected objects are centered horizontally
or vertically.

The reference is the shared center axis of the
selected objects, independent of the type of
selection.

Distribute:
The selected objects are distributed evenly,
horizontally or vertically.
The outermost objects remain unchanged.

No reference object

Adjust width or height:
The width or height of the selected objects is
adjusted to match each other.

If you have selected the objects using a
selection border (lasso) with the mouse, the
object with the largest width or height is used
as reference.
If you have selected the objects with the
<SHIFT> key and left-click, the first selected
object is used as reference.
If you have selected the objects with <Ctrl+A>,
the reference object of the original selection
applies; otherwise the object with the greatest
width or height.

Adjust width and height:
The width and height of the selected objects are
adjusted to match each other.

The reference object is then the object
configured first in the multiple selection.

See also
How to Align Multiple Objects (Page 439)
How to Select Multiple Objects (Page 435)
Multiple Selection of Objects (Page 433)
The Start Screen of the Graphics Designer (Page 283)

3.4.5.3

Layer palette

Introduction
In order to simplify the processing of individual objects in complex process pictures, the
Graphics Designer allows you to work with layers. For example, you can distribute the contents
of a process picture across up to 32 layers. You can display or hide the layers individually. In
the default setting all layers are visible; the active layer is layer 0.
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You display or hide the layer palette with "View > Toolbars". To the left of the palette is a handle,
which you can use to move the palette to any position on the screen.

Making layers visible / invisible
Pressed buttons indicate the visible layers. Click a button to make the layer visible or invisible.

Active layer
The active layer is set in the selection list of the layer palette.

Renaming layers
The "Settings" menu on the "Visible Layers" tab is used to rename layers. Double-click the
required layer; you can then enter a new name.

Assigning objects to layers
The assignment of an object to a layer can be changed in the "Object Properties" window.
Note
The following WinCC controls are displayed in separate windows and cannot be integrated
in the picture layer system:
● WinCC OnlineTableControl
●
●
●
●
●
●
●

WinCC OnlineTrendControl
WinCC UserArchiveControl
WinCC AlarmControl
WinCC FunctionTrendControl
WinCC RulerControl
.Net Control
Application window

You can assign a layer to these controls, but this setting will be ignored in Runtime.

See also
How to use the layers palette (Page 339)
Working with Layers (Page 334)
The Start Screen of the Graphics Designer (Page 283)
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3.4.5.4

Color palette

Introduction
Depending on the selected object, the Color Palette enables fast changes to the line or fill
color. It offers 16 standard colors matching the colors of the Microsoft standard programs.

You can move the color palette as you wish on the screen and show or hide it with "View >
Toolbars".
Note
The controls do not support working with the color palette.

Requirement
● The "Global color scheme" is set to "No" in the respective object properties under "Display".

Use color palette
Depending on the selected object, a mouse click on a color in the palette has the following
effect:
● In the case of closed objects (e.g. rectangle) and text objects:
– Click: The background color changes
– Ctrl + Click: The fill pattern color changes
– Shift + Click: The border color changes
– Shift + Ctrl + Click: The border background color changes
● In the case of open objects (e.g. polyline):
– Click: The line background color changes
– Shift + Click: The line color changes
● If no object is selected:
– Click: The background color of the active process picture changes
– Ctrl + Click: The fill pattern color of the active process picture changes

Using the color selection dialog
In addition to the 16 basic colors from the color palette, you can create additional colors. You
can either define these colors directly or select and use a color from the central color palette.
The

button opens the "Color selection" dialog with two tabs:
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● You assign a user-defined color to the object. Specify the desired color using the color
square, the color circle and the scrollbars or enter the values directly.
● You assign a color from the central color palette to the object. Select a color range and a
palette color. If you have selected a color from the central color palette, this color is changed
automatically if also changed on the color palette.

See also
"Colors" Property Group (Page 487)
The Start Screen of the Graphics Designer (Page 283)

3.4.5.5

Object palette

Introduction
In the object palette, you select a picture or objects of a picture in order to modify properties
or edit objects, for example.

The buttons of the object palette
Icon

Function
Places the selected object within the layer in the foreground. Objects in the foreground cover objects behind
them.
Places the selected object within the layer in the background. Objects in the background are covered by objects
in the foreground.
Copies line and color properties of an object to transfer them to another object.
Assigns properties of an object to another object. This function is only active if you have copied the properties.
Mirrors a selected object on its vertical center axis. If a number of objects have been selected, the center axis
of the individual objects applies in each case.
Mirrors a selected object on its horizontal center axis. If a number of objects have been selected, the center
axis of the individual objects applies in each case.
Rotates a selected object by 90° clockwise around its center point. If a number of objects have been selected,
the center point of the individual objects applies in each case.

3.4.5.6

Font palette

Overview

You can change the following text properties with the font palette:
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● Character set
● Character set size
● Border color
● Background color
● Font color
If you click on "Additional" during selection of the background color, for example, and
specify a color from the project palette in the color selection dialog, a bar appears at the color
in the font palette. The color index from the color palette is then displayed for the background
color in the object properties.
You can show or hide the font palette by using "View > Toolbars" and positioning it anywhere
on the screen.
Other text characteristics such as text in italics or bold print can be set in the "Object Properties"
window.
Note
Default setting of the text properties
You can adapt the default settings of the text properties for each text object through the object
properties, see section "The basic settings of the Graphics Designer".
Or you change the default setting through the font palette:
1. Select a text object in the object palette.
2. Change the properties in the font palette.
3. Insert the text object. The changed text characteristics then apply to all other objects of
the same type.

See also
Managing the default settings of objects (Page 317)
"Font" Property Group (Page 495)

3.4.5.7

Standard palette

Introduction
The buttons of the standard palette include common commands such as "Save" and special
buttons of the Graphics Designer such as "Activate Runtime".
You can display or hide the standard palette with "View > Toolbars". At the left of the palette
is a handle, which you can use to move the palette to any position on the screen.
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The buttons of the standard palette
Icon

Function

Key combination

Create a new process picture.

<Ctrl+N>

Creates a new Faceplate type.

<Ctrl+T>

Opens an existing process picture.

<Ctrl+O>

Saves the active process picture.

<Ctrl+S>

Starts Runtime, for example to test the active process picture. This
function is only available if a process picture has been opened.

-

Cuts out the selected object and copies the object into the clipboard. This
function is only available if an object has been selected.

<Ctrl+X>

Copies the selected object onto the clipboard. This function is only
available if an object has been selected.

<Ctrl+C>

Pastes the content of the clipboard into the active process picture. This
function is not available if the clipboard is empty.

<Ctrl+V>

Undoes the last actions (maximum of 30). This function is only available
if an action has been performed beforehand.

<Ctrl+Z>

Redoes the last undone action. This function is only available if an action
has been undone beforehand.

<Ctrl+Y>

Prints the content of the active process picture. This function is only
available if a process picture has been opened.

<Ctrl+P>

Hides and shows the grid in the active window.

-

Switches the function "Snap to Grid" on and off.

-

Opens the "Object Properties" window.

-

Opens the "Library" window. Finished devices can be stored in the libraries
of the Graphics Designer so that they can be inserted later in another
process picture. There are a great many standard forms available in the
libraries, for example electrical circuits.

-

Opens the VBA Editor.

<Alt+F11>

Activates the direct help (What's this?).

<SHIFT+F1>

See also
The Start Screen of the Graphics Designer (Page 283)
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3.4.5.8

Status bar

Introduction
The status bar contains information about:
● The language currently set
● The designation of the active object
● The position of the active object in the picture
● Keyboard settings
You can display or hide the status bar with "View > Toolbars".

Overview

● <F1> is used to call up the direct help of the selected icon or window.
● The language currently selected in the Graphics Designer is displayed.
● The designation of the selected object is displayed. If a number of objects have been
selected, "Multiple Selection" is displayed.

● Coordinates of the selected object
At "X:250 Y:40" the selected object lies 250 pixels to the right and 40 pixels below the origin
of coordinates. The values are updated automatically during the movement of an object,
thus making exact placement easier.
● Size of the selected object
At "X:50 Y:50" the selected object is 50 pixels wide and 50 pixels high. The values are
updated automatically during the size change of an object, thus making exact scaling easier.

● CAPS: "Caps locked". <CAPS LOCK> was pressed. The text is entered in upper-case
characters.
● NUM: <NUM> was pressed. The numerical keyboard is activated
● SCR: "Scroll locked" <SCROLL LOCK> was pressed.

See also
Working with Standard Objects (Page 512)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Start Screen of the Graphics Designer (Page 283)
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3.4.5.9

Zoom palette

Overview
You select the required zoom factor with the zoom palette. Use the icons for zooming in or out
or enter a percentage value.

To zoom in a section of the process picture select the "Zoom section". Then drag the frame to
the required size. The aspect ratio of the process picture window is maintained.
Note
You can define the minimum and maximum zoom factor individually for all layers. For
example, you can place detailed representations on a separate layer and only display the
representations above a specific zoom factor. Additional information is available in the section
"Showing and hiding layers and objects".
Use the scroll bars to move the visible area with a large zoom factor.
The Graphics Designer offers operation with the mouse wheel. Click the mouse wheel. The
mouse pointer changes and you can move the visible picture area simply by moving the
mouse.

See also
Showing and hiding layers and objects (Page 314)
The Start Screen of the Graphics Designer (Page 283)

3.4.5.10

Output window

Overview
The output window displays information, errors and warnings regarding the configuration when
saving a picture. Double-clicking a message selects the respective picture object, for example,
or the property of the object that contains the respective script.
You can copy the entries in the output window to the clipboard.

3.4.5.11

Library

Overview
The library of the Graphics Designer is a versatile tool for saving and managing graphic objects
that can be used for creating process pictures.
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Global library
The "Global Library" offers a variety of pre-defined graphic objects that you can insert into a
picture as library objects and configure as required. Graphic objects such as machines and
plant components, measuring equipment, operator control elements and buildings are
thematically organized in folders.
Project Library
The "Project Library" enables a project-specific library to be built. The objects can sorted by
subjects by creating folders and subfolders.
Detailed information is available under "Working with objects/Working with combined objects/
Working with the library".

See also
Working with the library (Page 682)

3.4.5.12

Controls

Introduction
The "Controls" selection window displays those control objects used often by default.
You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.

Overview
The following control groups are differentiated:
● ActiveX controls are used for monitoring and visualization of measured values and system
parameters.
● .NET controls are control elements from any supplier with the .NET Framework as of 2.0
from Microsoft.
● WPF Controls are control elements from any supplier with the .NET Frameworks as of 3.0
from Microsoft.
You can integrate additional controls by using the "Add/Remove" pop-up menu.
When some control objects are selected, you may be able to open additional dialog and
configuration windows.
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See also
How to configure the object selection (Page 264)
The Start Screen of the Graphics Designer (Page 283)
Working with Standard Objects (Page 512)
Working with Smart Objects (Page 546)
Working with Windows Objects (Page 625)
Working with Controls (Page 368)

3.4.5.13

Dynamic Wizard

Overview
The Dynamic Wizard provides a large number of predefined C Actions to support configuration
of frequently recurring processes. The C Actions are sorted in topics in the form of tabs. The
content of the individual tabs can vary depending on the selected object type.
You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.

You can find a detailed description of the Dynamic Wizard in the section "Making Process
Pictures Dynamic".

See also
Dynamic Wizard (Page 1017)
The Start Screen of the Graphics Designer (Page 283)

3.4.5.14

Process pictures

Introduction
The "Process pictures" selection window displays all pictures and faceplates from the "GraCS"
folder of the project. The content of the selection window is updated as soon as you copy new
files to the folder.
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You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.

Overview
Double-click an entry in the selection window to open the selected picture. You can select
several entries.
Use the file filter in case of many pictures. Enter a letter string. The selection window
immediately only displays pictures with the filtered letter string.

If the selection window has the focus and you press "Ctrl+C", the (filtered) list is copied to the
clipboard. You can then insert the list into editors, such as Excel.
Drag&Drop gives you the following options for pictures and faceplates:
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● When you drag a ".pdl" file into a picture, a button with the pre-configured picture change
at mouse click is created.
● When you drag a ".pdl" file into a picture while pressing the "Alt" key, a picture window with
the picture file is created.
● When you drag a ".fpt" file into a picture, a faceplate instance is created in the picture.

3.4.5.15

Standard

Introduction
The "Standard" selection window makes available various object types that are often used for
the process pictures.
You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.

Overview
The following object groups are differentiated:
● Standard objects: e.g. line, polygon, circle, rectangle, static text
● Smart objects: e.g. application window, picture window, I/O field, bars, status display
● Windows objects: e.g. button, check box, option group, slider object
● Tube objects
You can read about how to configure the Object Palette yourself in the chapter "Configuring
object selection".

Using the objects
Select the required object from the selection list. Drag-and-drop this object into the picture of
the Graphics Designer. The object can be moved freely within the picture window using the
mouse.

See also
The Start Screen of the Graphics Designer (Page 283)
Working with Smart Objects (Page 546)
Working with Windows Objects (Page 625)

298

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.4 Elements and Basic Settings of the Graphics Designer
Working with Tube Objects (Page 642)
Working with Standard Objects (Page 512)
How to configure the object selection (Page 264)

3.4.5.16

Styles

Introduction
In the "Styles" selection window you can change the line type, line thickness, line ends and fill
patterns.
You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.

Overview
● Line type: Contains different line representations such as dashed or dotted.
● Line thickness: Determines the line thickness. The line weight is specified in pixels.
● Line ends: You have the ends of lines displayed, for example, as arrows or rounded.
● Fill pattern: Provides the option of displaying closed objects with a transparent or checkered
background.

Displaying the Current Settings
If an object has been selected, the specified style properties of the object are highlighted in a
bold font.

See also
The Start Screen of the Graphics Designer (Page 283)

3.4.5.17

Tags

Introduction
The "Tags" selection window enables fast linking of process tags to objects.
You display or hide the selection window with "View > Toolbars". The selection window can
be moved to any position on the screen.
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Overview
The "Tags" selection window contains a list of all of the tags available in the project as well as
a list of the internal tags. You can use filters, change the view and update the connectors.
With the mouse button pressed, the tags in the right-hand window can be dragged to attributes
of an object in the "Object Properties" window.

See also
The Start Screen of the Graphics Designer (Page 283)
Basic Dynamic Operations (Page 454)
Selecting a tag (Page 649)
You can link the tag connection of objects (Page 465)

3.4.6

The Central Color Palette

3.4.6.1

The central color palette

Introduction
In WinCC, you can work with a central color palette. This requires assigning certain index
colors of your choice. You can then not only assign explicit colors but color indices from the
central color palette as well in the Graphics Designer.

Central color palette for objects
If you use the central color palette, you can change the colors in many objects at the same
time with just a few steps. Requirements for this are:
● "WinCC Classic" is not set as the global design.
● The central color palette is defined.
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● The "Global color scheme" is set to "No" in the object properties under "Display".
● Colors from the central color palette are selected in the object properties.
As soon as you change the central color palette in the project settings, it affects those object
elements in the objects that have colors assigned from the central color palette.

Note
The central color palette may contain a maximum of 10 color areas each with 20 colors. It
does not have to be fully defined.

Working with palettes
You have the following options with color palettes:
● Create color palette
WinCC does not initially provide a central color palette. You create the color palette yourself.
● Edit color palette
You can add or change colors in the color palette at any time.
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● Use color palette
When selecting the color for an object element, you can select a color index from the central
palette.
● Delete color palette
You can delete an existing color palette.
● Export color palette
You can export the color palette from your project as an XML file.
● Import color palette
You can import a color palette into your project from elsewhere.

See also
How to define the central color palette (Page 302)
How to export and import color palettes (Page 304)
"Colors" Property Group (Page 487)

3.4.6.2

How to define the central color palette

Introduction
The central color palette contains indices for assigning certain colors. If you change the central
color palette, you also change all of the indexed colors from the central color palette used in
the objects along with it.
The central color palette is divided into a maximum of 10 color ranges of 20 colors each.
Note
The central color palette does not have to be completely defined.
In order to edit a central color palette, proceed in the same way as for defining the palette.
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the pop-up menu.
The "Project properties" dialog opens.
2. Click on "Edit" on the "Surface & Design" tab next to "Central color palette".
The "Color selection" dialog box is opened.

3. Click on
"Add color range".
The 20 square boxes of the color palette fill with numbers, the color indices.
4. Click on
"Rename color range" and instead of the automatic name definition, enter a
name that means something to you.
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5. Define the desired color by moving the three scroll-bars for red, green and blue to the
desired values.
Alternative procedures:
– Click on the color square or in the color circle and define the brightness on the scale.
– Enter the RGB value directly or via the HTML code.
6. Determine the transparency of the color.
7. Click on the "To palette" button and then in the respective box.
The color is transferred to the box.
8. Repeat steps 5 and 7 until the color range is full.
9. Click on
area.

"Add color range" to open the next color range and repeat steps 2 to 7 for this

10.Repeat this step until you have defined all required color ranges.
11.Confirm with "OK".

Results
The central color palette is defined. If you have changed the central color palette, all of the
colors selected from the central color palette are also changed in the objects.

See also
The central color palette (Page 300)

3.4.6.3

How to export and import color palettes

Introduction
The central color palette contains indices that are assigned to certain colors. If you change the
central color palette, you also change all indexed colors used in the objects from the central
color palette.
The central color palette is subdivided into a maximum of 10 color areas each with 20 colors.
Note
The central color palette does not need to be fully defined.
You can make a central color palette that you have created available to another project by
exporting or you can import the palette from another project into your project. To export or
import a color palette, proceed as follows:
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the
Properties command in the pop-up menu.
The "Project properties" dialog will open.
2. On the "User Interface and Design" tab, click "Edit" next to "Central Color Palette".
The "Color Selection" dialog box opens.

3. To export the current central color palette, click on

"Export palette".

4. Enter the path and name of the XML file in the dialog and confirm with "OK".
The color palette is exported.
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5. To import a palette, click on
"Import palette", select the desired XML file in the file
selection dialog and click "Open".
The dialog box for importing the palettes appears.

6. Select one of the three options.
Note
If the attachment of the imported palette exceeds the total maximum number of colors,
the excess colors will not be imported.
The palette is imported.
All indexed colors, i.e. those selected from the central color palette, are then automatically
changed in the objects.

Attaching a Color Palette That is Too Large
The following example shows the attachment of a color palette that is too large.
Example:
Your palette has five color areas, i.e. 100 indexed colors. You want to import a color palette
with seven color areas, i.e. 140 indexed colors.
Result:
The first five color areas of the palette to be imported are imported; the last two color areas of
the palette are not imported.

See also
The central color palette (Page 300)
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3.4.7

The Basic Settings of the Graphics Designer

3.4.7.1

The Basic Settings of the Graphics Designer

Introduction
The following basic settings of the Graphics Designer can be customized:
● Displaying and setting the grid
● Visibility and zoom factors of the individual layers
● Default objects configuration
● General settings and options

Opening the "Settings" window
In the "Options" menu, select the "Settings..." command. A window with the tabs for the various
setting options opens.
As an alternative, you can also open the window using the entries "Grid" or "Layers" in the
"View" menu.

See also
Elements and Basic Settings of the Graphics Designer (Page 277)
Customizing the Working Environment (Page 321)
Working with Layers (Page 334)
Changing the default trigger (Page 319)
Managing the default settings of objects (Page 317)
Showing and hiding layers and objects (Page 314)
Making layers invisible (Page 313)
This is how you set the options (Page 309)
How to Set the Grid (Page 307)

3.4.7.2

How to Set the Grid

Introduction
To enable exact work, you can make a background grid appear. If required, you can enable
the option "Snap to grid". Then, all objects that are created or moved are automatically aligned
to the grid.
Showing the grid and aligning to the grid can be set via the Standard Toolbar. The grid width
is set via the basic settings of the Graphics Designer.
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The set grid properties are not saved with the process picture. When opening again or when
a new picture is created, the default settings of the program are used once again.

Opening the "Settings" window
In the "Extras" menu bar, select the "Settings..." menu. Click the "Grid" tab.
As an alternative, you can also open the window using the entries "Grid" or "Layers" in the
"View" menu.

Snap to Grid
If the check box is enabled, objects are aligned to the grid points when they are created,
inserted and moved. Objects that have already been created are only aligned to the grid when
they are moved.

Display grid
When the check box is enabled, the grid points are shown.

Width in pixels
Horizontal spacing of the grid points. Maximum distance: 100 pixels
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Height in pixels
Vertical spacing of the grid points. Maximum distance: 100 pixels
With a large grid width, objects are aligned to the left or upper grid points, as the case may be.

Alternative procedure
All grid properties can be changed in the "Object Properties" window of the active process
picture. The color of the grid can also be changed there.
Note
The minimum grid spacing that can be displayed on the screen is 10 pixels. If you want to
set a smaller value, you can align objects to this grid. On the screen, however, the grid spacing
displayed is the first multiple of the grid value that is greater than or equal to ten.
Example: You set 6 pixels as grid spacing; a grid or 12 pixels is shown on the screen. Objects
can be placed on one grid point or between two grid points.

See also
How to insert an object into a picture (Page 429)
The Basic Settings of the Graphics Designer (Page 307)

3.4.7.3

This is how you set the options

Introduction
Different program settings can be changed and saved.
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Opening the "Settings" window
In the menu bar, select "Tools" and click on "Settings...". The window with the tabs for the
various setting options opens. Click on the "Options" tab.

Save settings on exit
If this check box is enabled, the changes you have made in the "Settings" window are saved
when you exit from the program. If the check box is disabled, the changed settings are lost.
The default setting is that the check box is enabled.
Note
The "Save settings on exit" check box must be enabled for the settings in this dialog to be
retained when you exit from the program.

Issue performance warnings
Cyclic triggers can lead to a high system load.
If the check box is enabled, a warning is issued in the event of a system overload as soon as
the picture is to be saved. This warning contains the name of the object and the attribute that
has been made dynamic and has led to the overload. If the check box is disabled, you do not
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receive a warning, i.e. also no indication of the cause of the overload. The default setting is
that the check box is enabled.

Disable all VBA events
If the check box is enabled, the configured VBA events to monitor the VBA actions is not
triggered. The default setting is that the check box is disabled.

Use configuration dialog
If the check box is activated, the "Configuration Dialog" window opens automatically if the
inserted object has a configuration dialog.
Objects with configuration dialog:
● Smart objects: Control, I/O field, bars, graphic object, status display, text list
● Windows objects: Button, Slider object
If the check box is not enabled, the objects are inserted with the default settings.
Independent of whether the check box is enabled, the configuration dialog can be opened at
any time via the context-sensitive menu. Right-click the object and select the entry
"Configuration Dialog..." in the shortcut menu.

Display tips and tricks
If the check box is enabled, every time the Graphics Designer is started a tip on creating or
optimizing process pictures is displayed. The default setting is that the check box is disabled;
no tips and tricks are displayed when the program is started.

Display information in case of changes in faceplate type
If the check box is selected, the "Faceplate instances with type change" dialog box is shown
with all faceplate instances that are to be checked. The dialog opens in Graphics Designer
when you want to save a picture with faceplate instances that are affected by a change in typespecific properties and events.
Check all scripts linked with the faceplate instance, as a complete, automatic adjustment of
the scripts in the instances cannot be guaranteed.
When you have checked the scripts and adjusted them as necessary, select the check box in
front of the instance in the dialog. This hides the red crosses over invalid faceplate instances.

Object selection
Objects can be selected by clicking or by drawing a selection border. This selection border is
also referred to as a 'lasso'. You can specify whether the lasso must fully enclose the objects
or whether contact with the lasso is sufficient to select an object.
With the Option "Surrounding", the complete objects must lie in the selection border (lasso);
with the Option "Touching", it is sufficient that an object touches the selection border (lasso).
The default setting is that the "Surrounding" option is selected.
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Copy and paste objects
If the option "In active layer" is selected, copied objects are pasted into the active layer,
independent of the layer from which they have been copied.
If the option "in present layer(s)" is selected, copied objects are inserted into the layer from
which they were copied. If a number of objects are selected and copied from different layers,
each individual object retains the layer to which it was allocated.

OCX display
If the check box is activated, ActiveX controls in the Graphics Designer are shown in your
activated look. Setting the OCX representation only has an effect when process pictures are
being created, not in Runtime. The default setting is that the representation of ActiveX Controls
is enabled.

Directly edit properties
Attributes of objects can be changed via the object properties. Whether a value can be entered
directly in the "Object Properties" window or whether a dialog box is to be opened is specified
using the "Directly edit properties" check box.
If the check box is enabled, the value of an attribute can be changed by double-clicking on the
attribute in the "Object Properties" window. If the check box is not enabled, double-clicking
opens a window for value input. The default setting is that the check box is enabled; digits and
text can be entered directly in the "Object Properties" window.

Always reset object type selection
If the check box is enabled, the mouse pointer turns back into the selection mouse pointer
after an object has been inserted. However, if you want to insert a number of objects of the
same type, you can disable the check box. Then, the active object type remains active after
an object has been inserted, and the same object can be quickly inserted a number of times.
You then do not have to reselect the object type for each object to be inserted. The default
setting is that the check box is enabled.

See also
How to select an object (Page 432)
Changing the default trigger (Page 319)
Layer palette (Page 287)
Working with Layers (Page 334)
Working with Objects (Page 425)
The Basic Settings of the Graphics Designer (Page 307)
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3.4.7.4

Making layers invisible

Introduction
You can make the individual layers of a picture visible or invisible. This shows or hides the
objects of the various layers.
The settings can be made independently of one another for CS (Configuration System) and
RT (Runtime). The different visibility of the layers has the advantage that you can include more
information in the picture than is visible in Runtime.
When a picture is opened, all layers in the Configuration System are always visible. The
settings of the layers that were invisible during the editing are not stored when the Graphics
Designer is terminated.
You can rename a layer after double-clicking it.
The settings in this tab are retained when you exit from the program if the "Save settings on
exit" check box is enabled in the "Options" tab.

Opening the "Settings" window
In the "Extras" menu bar, select the "Settings..." menu. Click on the "Visible Layers" tab.
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Layers window
You can make the individual layers of a picture visible or invisible. When the check box is
enabled, the corresponding layer is visible. The active layer always remains visible.

All layers visible / invisible
Clicking on one of the buttons makes all layers visible or invisible. If you click "All invisible",
only the active layer remains visible. Depending on the setting "Apply to", the buttons change
the layers in the CS and/or in Runtime. The active layer always remains visible.

Language
You can change the names of the layers for each language. Set the language and rename the
layers in the 'Layers' window.

See also
Showing and hiding layers and objects (Page 314)
Layer palette (Page 287)
Working with Layers (Page 334)
Working with Objects (Page 425)
The Basic Settings of the Graphics Designer (Page 307)

3.4.7.5

Showing and hiding layers and objects

Introduction
Whether layers and objects are shown or hidden can be made dependent on the current zoom
factor. For example, it is possible to show details as of a certain zoom factor and not before.
Each layer can be assigned its own minimum and maximum zoom. It is also possible to show
only objects whose display size lies within a defined range.
The settings in this tab are retained when you exit from the program if the "Save settings on
exit" check box is enabled in the "Options" tab.
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Opening the "Settings" window
In the "Extras" menu bar, select the "Settings..." menu. Click the "Show/hide layers" tab.

Setting zoom ranges for individual layers
Double-click the digits in the columns "Min Zoom" or "Max Zoom" to set the zoom range in
which the contents of a layer is to be displayed. The zoom range is specified in %. The minimum
value is 2%, the maximum value 800%.
Activate the "Layers" check box under "Activate show/hide".
Note
If you have set the zoom ranges for the layers and want to zoom in on the process picture
when processing, disable the "Layers" check box. The set zoom ranges for the layers are
disabled but are retained, and you see all the details of the picture.
Example
The coarse display lies on Layer 8; the detail display of an area lies on Layer 10. Layer 8 is
displayed in the zoom range between 80% and 800%; Layer 10 is displayed in the zoom range
between 100% and 800%, see figure below. With this setting, the details of Layer 10 are only
shown when the user zooms in to the picture by over 100%.
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Setting the size range for the display of objects
If objects are only to be displayed in the range between a minimum and maximum display size,
you can define the size range. The display size is independent of the object size: An object is
shown within the zoom factors that show the object in the set size.
Enable the "Object Size" check box and enter the minimum and maximum size in pixels. When
you confirm this input with "OK", only objects in this display size are displayed.
Note
If you have set the display size and want to zoom in on the process picture when processing,
disable the "Object size" check box. The settings are disabled but are retained, and you see
all the details of the picture.

Adopting selected zoom value for all layers
If you want to change the zoom range for all layers, set it in the upper window for a layer and
click the "MinZoom" or "MaxZoom" button. The layer from which the zoom ranges are adopted
must be selected. Enable the "Layers" check box to display the settings.

See also
Making layers invisible (Page 313)
Zoom palette (Page 294)
Layer palette (Page 287)
Working with Layers (Page 334)
Working with Objects (Page 425)
The Basic Settings of the Graphics Designer (Page 307)
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3.4.7.6

Managing the default settings of objects

Introduction
In the Graphics Designer, the various object types have default properties. If an object from
the Object Palette is inserted in a picture, the object adapts to these default settings.

Working with default objects
You can adapt default settings for individual object types to meet your needs. Ideally you adapt
the default settings before you begin creating a process picture. In this way, the extent of later
adaptations, such as for frequently used objects, can be limited.
If you want to represent a complex process and need numerous process pictures with identical
property settings for it, it is appropriate to create a "master picture". You define the object
settings in this picture and use it as a template for all individual process pictures.
All information on the default setting for object types is contained in a file with the format "PDD".
By default this is the "Default.pdd" file in the "GraCS" project folder. You can use the "Default
Objects Configuration" tab to select the following options for default settings of object types:
● Saving the default settings immediately or automatically when terminating the Graphics
Designer
● Loading default settings of a different project into the current project
● Changing the file name and folder path for saving the PDD file
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Opening the "Settings" window
In the "Extras" menu bar, select the "Settings..." menu. Click on the "Default Objects
Configuration" tab.

Saving default settings of objects
1. In the "File name" field click the button
The "Default objects" dialog is opened.

.

2. Select the PDD file in which you want to save the changes and confirm your selection with
"OK".
By default, the PDD file of a project is stored in the "GraCS" folder.
3. In the "Save" field, click the "Save Now" button.
The changed default settings are saved in the selected PDD file.
4. Enable the "Save Configuration on Exit" check box if you want the default object
configuration to be saved when you exit from the Graphics Designer.
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Loading default settings of objects
button in the "File" field.
1. Click the
The "Default objects" dialog is opened.
2. Select the PDD file you would like to load and confirm your selection with "OK".
By default, the PDD file of a project is stored in the "GraCS" folder.
3. Click on the button "Load now".
The default objects configuration is imported from the selected PDD file into the current
project.
4. You can now save the loaded default settings in the current project folder:
.
In the "File" field click the button
The "Default objects" dialog opens.
5. Select the PDD file of the current project and confirm your selection with "OK".
6. In the "Save" field, click the "Save Now" button.
The imported default settings of the objects are saved in the PDD file of the current project.
Note
The default settings for objects do not apply across all projects. The changed default settings
only apply to the pictures of the currently opened WinCC project. The basic settings of the
Graphics Designer are not changed.

See also
Changing the default trigger (Page 319)
How to Change an Attribute (Page 476)
How to change the default setting of object types (Page 426)
Controls (Page 295)
The Properties of an Object (Page 470)
The Basic Settings of the Graphics Designer (Page 307)

3.4.7.7

Changing the default trigger

Introduction
The set trigger specifies the update cycle in Runtime. Each attribute of an object that has been
made dynamic can be assigned an individual update cycle. The value for the default trigger is
the default update cycle for all objects. If you want to update a lot of objects in a cycle of 2
seconds, for example, set the default trigger to 2 s. You then no longer need to change the
trigger setting for tag connection of the individual attributes.
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Opening the "Settings" window
In the "Extras" menu bar, select the "Settings..." menu. Click on the "Default Objects
Configuration" tab.

Selecting the default trigger
Open the dropdown list box and select a value.
Picture cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update
Cycle of the picture object. This cycle provides the option of defining the cycles of all the
actions, tag connections and dynamic dialogs used in a picture centrally.
Window Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update
Cycle of the Picture Window object. This values applies to all actions, tag links and dynamic
dialogs, which were configured with the trigger type "Window cycle".
Upon change
This trigger updates the object every time a change is made. In the case of external tags, there
might be a brief delay; internal tags lead to an immediate update.
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Time values (250 ms - 1 h)
This trigger updates the object in the set cycle.
User cycle (1 - 5)
You can set this trigger as required.
Define user cycles as follows:
1. Right-click the project name in the navigation window of the WinCC Explorer.
2. In the context-sensitive menu, select the entry "Properties".
3. Select the "Update Cycles" tab.
4. Select one of the user cycles and redefine it.
Note that the configured user cycles are based on a 250 ms time pattern. If you set 800 ms,
for example, a 750 ms cycle is actually used.
You have to restart the Graphics Designer to make your individual user cycles available.
Note
The shorter the set update cycles, the higher the system load. To prevent an overload, the
update should not take place more often than necessary.

See also
How to change the default setting of object types (Page 426)
Managing the default settings of objects (Page 317)
Trigger Types (Page 1013)
Quick Object Configuration (Page 647)
The Basic Settings of the Graphics Designer (Page 307)

3.4.8

Customizing the Working Environment

Introduction
The Graphics Designer provides a great many possibilities to customize the working
environment. For example, you can change the toolbars and palettes. You can define your
own colors and change the basic settings of the program.
Positioning viewlets
You can drag viewlets in the Graphics Designer to a desired location and dock them there.
If you drop a viewlet directly above the central position symbol, it is inserted in the selected
window as a new tab.
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Showing/hiding toolbars and viewlets
To show or hide individual toolbars or viewlets, select the menu command "View > Toolbars".
Enable or disable the required element.
Restoring the factory settings
To restore the factory settings of the Graphics Designer, select the menu command "View >
Toolbars > Reset".
Saving settings
Please bear in mind that the default setting of the Graphics Designer is such that changes to
the working environment are saved when you exit from the program. If you do not want to save
the settings, open the "Extras" menu, then "Settings..."; select the "Options" tab and disable
the "Save settings on exit" check box.

See also
Elements and Basic Settings of the Graphics Designer (Page 277)
The Basic Settings of the Graphics Designer (Page 307)
The Start Screen of the Graphics Designer (Page 283)
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3.5

Working with Pictures

3.5.1

Working with Pictures

Introduction
In Graphics Designer, a picture is a file in the form of a sheet of drawing paper. You can adapt
the size of the sheet of drawing paper. A sheet of drawing paper has 32 layers, which you can
use to improve the organization of the drawing. The files are saved in the project folder under
"GraCS" in the "PDL" format. You can distribute the complete process to be displayed across
several individual pictures that are interconnected. You can integrate the call of other
applications and files in a process picture.
The more complex the process to be configured, the more detailed the planning must be.

Project Planning Notes
● Plan the structure of the process display: How many pictures are required in which
hierarchy?
Example: subprocesses can be shown in individual pictures, which are then merged into a
main picture.
● Plan the navigation within a picture and between the individual pictures: Operating
sequence, buttons and hotkeys should be uniform in all pictures.
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● Create a Master picture in which the picture properties, default settings and object settings
are defined. This Master picture should then be used as the template for each individual
picture.
● Use the program functions: Process pictures can be efficiently created by using libraries,
copying and transferring properties and by working with layers and multiple pictures.
● Configure each picture in the size in which it is displayed on the target computer. This avoids
changes in the picture layout.
● Use only fonts that are available on the target computer.
Note
If you save a process picture, the system creates a backup in file format "*.sav" in the
project folder in the "GraCS" directory. In order to restore the process picture from the
backup, change the file format from "*.sav" to "*.pdl".
If you save a Faceplate type, the system creates a backup in file format "*.saf" in the
project folder in the "GraCS" directory. In order to restore the Faceplate type from the
backup, change the file format from "*.saf" to "*.fpt".

See also
Working with Objects (Page 425)
Working with Multiple Pictures (Page 339)
Working with Layers (Page 334)
How to set the picture properties (Page 331)
How to export graphics (Page 330)
How to Delete a Picture (Page 328)
How to Rename a Picture (Page 327)
How to Copy the Picture (Page 326)
How to open a picture (Page 325)
How to save the pictures (Page 325)
How to create a new picture (Page 324)

3.5.2

How to create a new picture

Introduction
Depending on the selected method of working, you either create a new picture using the default
settings or take your Master picture and save this under a new file name. The advantage of
working with a master picture is that all of the changes that you make while creating it will then
be kept consistently throughout the project.
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Creating a new picture
In the Graphics Designer, either select "New" in the "File" menu or click
created with the default settings.

. A new picture is

You can also create a new picture by using the pop-up menu in WinCC Explorer's navigation
window.

See also
Working with Pictures (Page 323)
How to set the picture properties (Page 331)
How to save the pictures (Page 325)

3.5.3

How to save the pictures

Introduction
Files are saved in Graphics Designer in the usual Windows manner.

Procedure
● An active picture can either be saved via the button
or with the key combination <CTRL+S>.

, with the menu entry "File", "Save",

● To save the active picture under a new file name, select "Save As" in the "File" menu.
● To save all of the open pictures, select "Save All" in the "File" menu.

See also
Working with Pictures (Page 323)
How to Copy the Picture (Page 326)

3.5.4

How to open a picture

Introduction
Picture files are opened in Graphics Designer in the usual Windows manner.

Opening Picture
in the Graphics Designer or select the entry "File", "Open" in the menu
Click on the button
bar. Select a PDL format file.
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You can also open a picture in WinCC Explorer by double-clicking on a PDL format file. This
will start Graphics Designer, if necessary, and then open the picture.
Note
Pictures may only be opened and edited in Graphics Designer. Pictures may not be opened
in Windows Explorer or any similar program.

See also
Working with Pictures (Page 323)

3.5.5

How to Copy the Picture

Introduction
If you want to transfer the settings that you have made in a picture to another one, simply save
the old picture under a different name and delete or change the new picture's contents.

Saving a picture under a different name
To do this, select "Save As..." from the "File" menu. Enter a new file name in the windows
"Save as".

Note
It is not possible to copy a picture and then insert it with a different file name in WinCC
Explorer. To accomplish this, use Windows Explorer.
If you copy a picture created with the SIMATIC Manager using "Save As", you may rename
or delete this copy in WinCC Explorer. This also applies to WinCC pictures created in WinCC
and subsequently imported into the SIMATIC Manager by using the function "Import WinCC
objects".
Note
If you rename a picture in the WinCC Explorer, the new picture name must not correspond
to the name of an object that already exists in the picture. The software does not check for
whether the new name already exists. Using a name that already exists can lead to conflicts
during access via VBA or dynamization.
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See also
How to open a picture (Page 325)
How to Delete a Picture (Page 328)
How to Rename a Picture (Page 327)
Working with Pictures (Page 323)

3.5.6

How to Rename a Picture

Introduction
A picture can only be renamed in WinCC Explorer.
Of course, you can save a picture with a different name; but the picture will still be in the project
directory with its old file name.

Rename picture
Close the picture that you want to rename.
Start the WinCC Explorer and right-click the picture.
Select the entry "Rename picture" in the pop-up menu and enter a new name.
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Note
If you rename a picture in the WinCC Explorer, the new picture name must not correspond
to the name of an object that already exists in the picture. The software does not check for
whether the new name already exists. Using a name that already exists can lead to conflicts
during access via VBA or dynamization.
Note
If you create pictures using the SIMATIC Manager, these cannot be renamed in WinCC
Explorer. This also applies to WinCC pictures created in WinCC and subsequently imported
into SIMATIC Manager by using the function "Import WinCC Object". You can recognize these
pictures from the "Created by SIMATIC Manager" entry in the Information column of the data
window.

See also
How to Copy the Picture (Page 326)
How to open a picture (Page 325)
How to Delete a Picture (Page 328)
Working with Pictures (Page 323)
The shortcut menu in the Navigation window (Page 261)

3.5.7

How to Delete a Picture

IntroductionError! Bookmark not defined.
A picture can only be deleted in WinCC Explorer.

Deleting Picture
Close the picture that you want to delete.
Start the WinCC Explorer and right-click the picture.
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Select the entry "Delete picture" in the pop-up menu and confirm the confirmation prompt with
"OK".

Note
If you create pictures using the SIMATIC Manager, these cannot be deleted in WinCC
Explorer. This also applies to WinCC pictures created in WinCC and subsequently imported
into SIMATIC Manager by using the function "Import WinCC objects". You can recognize
these pictures from the "Created by SIMATIC Manager" entry in the Information column of
the data window.

See also
How to Copy the Picture (Page 326)
How to open a picture (Page 325)
How to Rename a Picture (Page 327)
Working with Pictures (Page 323)
The shortcut menu in the Navigation window (Page 261)
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3.5.8

How to export graphics

Introduction
You can export graphics in the following formats from the Graphics Designer:
● "EMF" (Enhanced Metafile). Dynamic settings and some object-specific properties are lost
with the export, because they are not supported by the graphic format.
● "PDL". The dynamizations are retained when a PDL file is exported. You can then insert
the exported picture into a picture window or open it as a file.
Note
Check exported pictures for both completeness and interpretation errors by the importing
program before editing them further in other programs.

Special features
● Some programs do not use the same graphic filters. It is possible that some programs will
not be able to open a graphic that was exported from Graphics Designer. Furthermore,
fonts and object information will also sometimes be incorrectly interpreted by other
programs. If the screen must appear precisely as it is in Graphics Designer, but your
program displays it incorrectly, you can solve this problem by making a screenshot.
● When exporting a picture created with the Graphics Designer, all object properties
dynamics of the individual objects are lost.

Procedure
1. Select the objects that you want to export. If you do not select an object, the entire picture
will be exported.
2. Open the "Tools" menu and select the entry "Settings". The "Save as metafile" window is
opened.
By default, the "GraCS" folder of the WinCC project is displayed as the storage location.
You can export the file to any other folder.
3. Enter the file name.
4. Select the file type to be exported, "EMF" or "PDL".
5. Confirm your entries with "Save".

See also
Working with Pictures (Page 323)
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3.5.9

How to set the picture properties

Introduction
In Graphics Designer, a process picture is treated as an object and is called a Picture Object.
You can adapt the properties and dynamics of the picture at any time. If no object has been
selected in the picture, the "Object Properties" window will display the properties of the Picture
Object.

Procedure
1. Make certain that no object is selected in the picture. Open the window "Object properties"
in the toolbar. As an alternative, the "Object Properties" window
by clicking the button
can also be opened via the pop-up menu or by selecting "Properties" in the "View >
Properties" menu.
2. Check whether the picture properties are displayed. The entry with the file name of the
selected picture object is displayed in the object palette.
3. You may edit the attributes contained in the "Properties" or "Event" tabs similar to editing
object attributes. For more information, refer to the section "How to edit an attribute".

See also
Working with Pictures (Page 323)
The Properties of an Object (Page 470)
The "Object Properties" Window (Page 471)
How to Change an Attribute (Page 476)
Displaying the configured dynamics of a process picture (Page 273)
Displaying the properties of a picture file (Page 271)
How to transfer picture properties to another picture (Page 340)

3.5.10

How to configure a picture background

Introduction
You can use a picture file as a background for a process picture. The background picture and
the respective parameters belong to the properties of the picture.
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Insert background picture
1. Make sure that no object is selected in the picture on which you click in the background
picture. The entry with the selected "picture object" is then displayed in the object palette.
in the toolbar.
2. Open the window "Object properties" by clicking the button
As an alternative, the "Object Properties" window can also be opened via the shortcut menu
or by selecting "Properties" in the "View > Properties" menu.
3. Click on the "Background picture" property.
4. Double click on "Picture".
5. Select the desired background picture in the "Picture" dialog.
Use "Find" to open the file selection dialog for loading other pictures into the selection. You
can use the following file types as backgrounds:
EMF, WMF, DB, BMP, GIF, JPG, JPEG, ICO and SVG 1).
6. Select the layout for the background picture after double clicking on "Show as":
– Normal: The background picture is centered in the original size.
– Stretched (window): If the Runtime window is larger than the configured process picture,
the background picture is scaled to the size of the Runtime window. Otherwise, the
background picture is scaled to the size of the process picture.
– Tiled: The process picture is arranged with the picture in the original size.
– Stretched (Picture): The background picture is scaled to the configured size of the
process picture.
7. Close the Properties dialog.
The current picture is provided with the selected background.
1)

SVG: Not possible with the global design "WinCC Classic".

Delete background picture
1. Make sure that no object is selected in the picture. The entry with the selected "picture
object" is then displayed in the object palette.
in the toolbar.
2. Open the window "Object properties" by clicking the button
As an alternative, the "Object Properties" window can also be opened via the shortcut menu
or by selecting "Properties" in the "View" menu.
3. Click on the "Background picture" property.
4. Double-click on the "Picture".
5. Click on "Cancel selection" in the dialog and confirm with "OK".
The background picture is removed from the picture.
6. Close the Properties dialog.
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3.5.11

How to protect pictures with a password

Introduction
A process picture can be assigned a password. This measure protects your VBA scripts against
unauthorized access, for example.

Creating a password
1. Make certain that no object is selected in the picture.
2. Open the "Object properties" window using the shortcut menu or the "View" > "Properties"
menu.
3. Check whether the picture properties are displayed. The entry with the file name of the
selected picture object is displayed in the object palette.
4. You may edit the attributes contained in the "Properties" or "Event" tabs similar to editing
object attributes. For more information, refer to the section "How to edit an attribute".
5. Click the "Miscellaneous" property.
6. Double-click "Password protection".

7. Enter a password that consists of at least six characters.
8. Repeat your password entry.
9. Click "OK".
The current picture is now protected by a password that is requested the next time the picture
is opened.

Removing a password
1. Make certain that no object is selected in the picture.
2. Open the "Object properties" window using the shortcut menu or the "View" > "Properties"
menu.
3. Check whether the picture properties are displayed. The entry with the file name of the
selected picture object is displayed in the object palette.
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4. You may edit the attributes contained in the "Properties" or "Event" tabs similar to editing
object attributes. For more information, refer to section "Editing attributes".
5. Click the "Miscellaneous" property.
6. Double-click "Password protection".

7. Set the "Remove password" check box.
The current picture is no longer protected by password.

3.5.12

Working with Layers

3.5.12.1

Working with Layers

Introduction
In the Graphics Designer, a picture consists of 32 layers in which objects can be inserted. The
position of an object in a picture is set when it is assigned to a layer. Objects of layer 0 are
located at the background of the picture, while objects of layer 31 are located in the foreground.
Not all objects in the Graphics Designer observe the layer technique, for example ActiveX
Controls.

Objects in the layer
Objects are always inserted in the active layer, but can be quickly moved to another layer. You
can change the assignment to a layer by using the "Layer" attribute in the "Object Properties"
window.
In addition, you can change the positioning of the objects with respect to each other within a
layer. Four functions are available for this purpose in the "Arrange > Within the Layer" menu.
When creating a process picture, the objects of a level are by default arranged in the order in
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which they were configured. The object inserted first lies at the very back of the level, each
additional object is inserted one position toward the front.
Note
You can define the level to insert a copied object into with the Graphics Designer settings.
More information on these settings can be found under topic "Create process pictures >
Elements and basic settings of the Graphics Designer > The basic settings of the Graphics
Designer > How to set options" in section "Copying and inserting objects".

Principle of the layer technique
When a picture is opened, all 32 layers of the picture will be displayed. You cannot change
this setting. You can hide all layers except the active layer with the layer palette. This allows
you to explicitly edit objects of the active layer. Layers are particularly useful when preparing
pictures that contain many different types of object types.
For example, you could place all of the "Bar" objects on Layer 1 and all of the "I/O Field" objects
on Layer 2. If you later decide to change the font color of all of the I/O fields, you can now
display just Layer 2 and then select all of the objects on this layer. The time-consuming
selection of individual I/O fields scattered throughout the picture is thus unnecessary.
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Note
The following WinCC controls are displayed in separate windows and cannot be integrated
in the picture layer system:
● WinCC OnlineTableControl
● WinCC OnlineTrendControl
● WinCC UserArchiveControl
● WinCC AlarmControl
● WinCC FunctionTrendControl
● WinCC RulerControl
● .Net Control
● WinCC Web Control
● Application window
You can assign a layer to these controls, but this setting will be ignored in Runtime.

See also
How to change the default setting of object types (Page 426)
Working with Layers (Page 334)
Layer palette (Page 287)
How to change the position of an object (Page 450)
How to use the layers palette (Page 339)
How to assign a layer (Page 338)
This is how you set the options (Page 309)
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3.5.12.2

How to assign a layer

Introduction
The "Object Properties" window is used to set the layer in which an object is placed.

Assigning Layers
1. Select an object.
2. Open the "Object Properties" window.
3. Select the object type and double-click the "Layer" attribute.
4. Enter the name of the required layer.
Moving several objects on different layers to one layer
If you want to move objects located on Layers 2, 5 and 7 to Layer 9, for example, use multiple
selection.
1. Display only Layers 2, 5 and 7.
2. Select the objects.
3. In the "Object Properties" window assign Layer 9 to the "Multiple selection" object type. All
of the objects are then moved to Layer 9.

See also
How to assign a layer (Page 338)
Making layers invisible (Page 313)
Showing and hiding layers and objects (Page 314)
How to use the layers palette (Page 339)
Layer palette (Page 287)
Working with Layers (Page 334)
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3.5.12.3

How to use the layers palette

Introduction
With the aid of the Layers palette, it is possible to display only those layers that are actually
used for editing a picture. Up to 31 layers can be hidden if need be. The active layer remains
visible.

Making layers visible / invisible
Click on one of the buttons on the Layers palette. When the button is pressed, the
you display Layers 16-31; with
Layers 0-15.
corresponding layer is visible. With

Select the Active Layer
Open the drop-down list and select an active layer.

Renaming layers
Layers are renamed in the "Visible Layers" tab in the "Options > Settings..." menu. Doubleclick a layer there and enter a new name.

See also
Making layers invisible (Page 313)
How to assign a layer (Page 338)
Showing and hiding layers and objects (Page 314)
How to change the default setting of object types (Page 426)
Layer palette (Page 287)
Working with Layers (Page 334)

3.5.13

Working with Multiple Pictures

3.5.13.1

Working with Multiple Pictures

Introduction
Multiple process pictures are quite useful when working with complex processes. These
process pictures are then linked to each other and one picture can be integrated in another.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

339

Creating Process Pictures
3.5 Working with Pictures
Graphics Designer supports a number of features which ease the process of working with
multiple pictures.
● The properties of a picture can transferred to another picture.
● Objects can be transferred from one picture to another.
● Objects can be copied from one picture to another.

See also
Working with Pictures (Page 323)
How to copy objects to another picture (Page 342)
How to transfer objects to another picture (Page 341)
How to transfer picture properties to another picture (Page 340)

3.5.13.2

How to transfer picture properties to another picture

Introduction
With the exception of the display of the grid and the grid width, you can transfer the properties
of a picture to other pictures with the aid of the "Pipette".

Procedure
1. Open the picture with the properties you want to copy. Objects may not be selected.
in the object palette.
2. Click
The picture properties are copied.
3. Open picture to which the properties should be assigned. Objects may not be selected.
in the object palette.
4. Click
The properties are assigned.
You can alternatively call up the functions for copying and assigning properties through the
"Edit > Properties" menu.

See also
How to transfer objects to another picture (Page 341)
How to copy objects to another picture (Page 342)
Working with Multiple Pictures (Page 339)
Working with Pictures (Page 323)
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3.5.13.3

How to transfer objects to another picture

Introduction
Use "Cut" and "Paste" to cut out a selected object and transfer it to the clipboard. From the
clipboard you can paste the object into any picture. You can insert the object several times,
even into different pictures.
Multiple selection
You can simultaneously cut out several selected objects and paste them into another picture.

Requirements
● Select an object of any type.

Procedure
1. Press <Ctrl+X> or click

in the standard palette to cut out the selected object.

2. Open the picture into which you want to insert the object from the clipboard.
in the standard palette.
3. Press <Ctrl+V> or click
The current contents of the clipboard are inserted into the active picture and selected.
4. Repeat this step to insert further copies of the contents.

Alternative handling with drag-and-drop
Select the object to be transferred and drag it with the left mouse button depressed to another
picture.
Note
Objects from other applications can also be inserted via the clipboard.
The positions "X" and "Y" of the inserted object are each 20 pixels higher than in the original
object.
The inserted object receives the object name of the original object but is supplemented by a
continuous number.

See also
How to duplicate objects (Page 449)
How to cut objects (Page 446)
How to insert the contents of the clipboard (Page 448)
How to delete objects (Page 445)
How to copy objects to another picture (Page 342)
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3.5.13.4

How to copy objects to another picture

Introduction
Use the "Copy" and "Paste" commands to copy a selected object to the clipboard and then
paste it into any picture. When copying to the clipboard you can insert the object several times,
even into different pictures.
Multiple selection
You can copy several selected objects simultaneously and paste them into another picture.

Requirement
● Select an object of any type.

Procedure
1. Press <Ctrl+C> or click
clipboard.

in the standard palette to copy the selected object to the

2. Open the picture into which you want to insert the object from the clipboard.
in the standard palette.
3. Press <CTRL+V> or click
The current contents of the clipboard are pasted into the active picture and selected.
4. Repeat this step to insert further copies of the contents.
Note
Objects from other applications can also be inserted via the clipboard.
The positions "X" and "Y" of the inserted object are each 20 pixels higher than in the original
object.
The inserted object receives the object name of the original object but is supplemented by a
continuous number. No special characters are used in the object name.

See also
How to duplicate objects (Page 449)
How to cut objects (Page 446)
How to insert the contents of the clipboard (Page 448)
How to delete objects (Page 445)
How to transfer objects to another picture (Page 341)
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3.6

Working with Faceplate Types

3.6.1

Working with Faceplate types

Introduction
A faceplate is a standardized picture object that you create centrally as a type in a project.
WinCC saves the faceplate type in a fpt file. Afterward, you can insert the faceplate type as a
faceplate instance in a process picture. You edit the faceplate instance like any individual
object in the Graphics Designer.
The use of faceplate types reduces the configuration work required, because one faceplate
type can be used in multiple pictures and the instances can be changed centrally via the
faceplate type.
You can use Unicode in faceplates.

Properties and events of faceplate types
Faceplate types have two types of properties and events:
● Type-specific properties and events
These properties and events can only be changed in the faceplate type. Type-specific
properties and events are the properties and events of the individual objects, which cannot
be configured in the faceplate instances.
● Instance-specific properties and events
You configure these properties and events in the faceplate instances.
When creating the faceplate type, define whether a property is type- or instance-specific in a
configuration dialog.
If you insert a faceplate type as an instance in a process picture, the instance-specific
properties and events are allocated with the predefined values from the faceplate type. You
can then adapt the instance-specific properties and events individually to the process picture.
The following picture shows the use of the type- and instance-specific properties in the
faceplate instances.
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The changes of the type-specific properties are not updated automatically in the faceplate
instances. You get the changes in the instances by closing and reloading the respective
process picture.
Note
The following menu functions of the Graphics Designer are not available to you when editing
a faceplate type.
● Activating runtime
● Customized object
● Tag connection

Copying a faceplate type
If you want to copy a faceplate type from a project into another, you must first copy the fpt file
of the faceplate type in the Windows Explorer into the project folder of the new project.
Afterwards, you can insert the instances of the faceplate type into the new project as normal.

Copying and inserting individual objects of a faceplate type
If you are copying individual objects of a faceplate type into a process picture, all dynamics of
this object are deleted. This prevents e.g. the use of invalid scripts with faceplate tags in a
process picture.
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If you are copying objects from a process picture into a faceplate type, all dynamics of this
object are deleted. This prevents e.g. the use of invalid scripts with WinCC tags in a faceplate
type.
Note
The faceplate instance and the corresponding faceplate type must be located in the currently
open project. If you open a "PDL" file from another previously edited project in the Graphics
Designer with the menu command "Last Files", the faceplate instances are shown in white,
since the associated faceplate types are located in another project directory.

Do not modify the file name of a faceplate type
You must not modify the file name of the faceplate type at a later time, as it is used for the
faceplate instance.
To create an instance of a renamed faceplate type, you first have to open the type in Graphics
Designer and then save it again.

Select "Save as..." to create a new faceplate type
By saving a faceplate type under a new name with "Save as...", you generate a copy of the
faceplate type with a new ID. The faceplate instances use this ID and the file name to identify
the faceplate type. The instances of a faceplate type are not linked to the copy of the faceplate
type. Changes in the copied faceplate type are not mapped to the instances.

3.6.2

How to create a Faceplate type

Introduction
A Faceplate type is the template for the Faceplate instances. The Faceplate type is created
centrally in the project. You define which properties and events can be configured in the
Faceplate type and which can be configured in the Faceplate instance in the Faceplate type.
The Faceplate type is a combination of individual objects from the "Standard" selection window
of the Graphics Designer.
Note
You cannot use the object types "connector", "customized object", "application window",
"picture window", "OLE object", "faceplate instance", the icons of the HMISymbol library and
all of the controls.

Procedure
1. Creating a Faceplate type.
2. Inserting and configuring individual objects of the Faceplate type.
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3. Configuring a Faceplate type.
4. Creating Faceplate tags.
5. Making a Faceplate type dynamic.

See also
How to create a Faceplate type (Page 347)
How to insert the individual objects of the Faceplate type (Page 348)
Configuration of a Faceplate type (Page 348)
Properties of a Faceplate type (Page 349)
How to link object properties with a properties node (Page 352)
Event of a Faceplate type (Page 356)
How to configure the events of a Faceplate type (Page 357)
Definition of the Faceplate tags of a Faceplate type (Page 359)
How to edit the Faceplate tags of a Faceplate type (Page 360)
Making a Faceplate type dynamic (Page 361)

3.6.3

How to create a Faceplate type

Requirement
● Faceplate.oll is integrated in the object palette of the Graphics Designer.
● The Graphics Designer is open.

Procedure
1. Select the "New Faceplate type" command from the "File" menu.
A new picture will be created with format *.fpt.
2. Select the "Save" command on the "File" menu.
3. Save the Faceplate type in the project folder.
The Faceplate type is created.
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3.6.4

How to insert the individual objects of the Faceplate type

Introduction
A faceplate type is a combination of objects from the "Standard" selection window of the
Graphics Designer. You can insert and configure these individual objects like the objects in a
normal WinCC picture.
Note
You cannot use the object types "connector", "customized object", "application window",
"picture window", "OLE object", "faceplate instance", the icons of the HMISymbol library and
all of the controls.

Requirement
● A faceplate type is opened in the Graphics Designer.

Procedure
1. Insert the individual objects of the faceplate type from the object palette.
2. Position the individual objects in the desired position.
3. Configure the object properties of the individual objects.
Note
The configured object properties, which you later do not define as instance-specific in the
configuration dialog, are the type-specific properties of this faceplate type.
4. Select the "Save" command in the "File" menu to save the changes in the faceplate type.
You can find additional information on inserting and configuring the individual objects of the
Graphics Designer in the section "Working with objects".

3.6.5

Configuration of a Faceplate type

Introduction
In the faceplate type configuration dialog, specify the properties, faceplate tags and events
that you want to configure in the faceplate instances. The "Object Properties" window of the
Faceplate instance shows only the properties and events defined in the configuration dialog.
You call the configuration dialog in the "Edit" menu with the "Configure Faceplate type"
command.
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"Properties" Tab
In the "Properties" tab, define the properties and faceplate tags that you want to configure in
the instances. You may link each instance-specific property with several object properties or
faceplate tags.

"Events" Tab
You define the events that should be able to be configured in the instances in the "Events" tab.
You can only connect each instance-specific event with a single event of the individual objects.

See also
Properties of a Faceplate type (Page 349)
How to link object properties with a properties node (Page 352)
Event of a Faceplate type (Page 356)
How to configure the events of a Faceplate type (Page 357)

3.6.6

Properties of a Faceplate type

Introduction
In the "Properties" tab, define the properties that you want to configure in the instances. You
may link each instance-specific property node with several object properties and/or faceplate
tags. Only the name of the property node is displayed in the object properties of the faceplate
instance. Changes to the value of a property node are applied to all object/faceplate tag
properties that are linked in Runtime to this property node. Changes to the value of object/
faceplate tag properties in Runtime are applied to the instance properties.
Note
You cannot assign the object properties "Layer", "Left", and "Top" to a property node.
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Selected Properties
This area contains the instance-specific property nodes for the Faceplate type. You may assign
one or several object/faceplate tag properties to each one of these property nodes. Only the
name of the property node is shown in the object properties of the instances. Changes to the
value of a property node are applied to all object/faceplate tag properties that are linked to this
property node.

Objects
This area contains all objects contained in the faceplate type, or the "Faceplate tags" entry
(related to the currently opened faceplate type). Select the object, or "Faceplate tags" entry,
for which you want to display the available properties or faceplate tags in the "Object properties"
area.

Object Properties
This area contains all available properties or faceplate tags for the object selected in the
"Objects" area, or the "Faceplate tags" entry. You can define instance-specific object properties
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or faceplate type tags by dragging the selected property/faceplate tag to the corresponding
properties node in the "Selected properties" area.
Note
It is best practice to group the object properties or faceplate tags in the property nodes. You
should e.g. not group line thickness together with background color.
Enter a unique name for the property node. There are no language-dependent names for the
property nodes.
Note
You may assign an object/faceplate tag property only to one properties node.
You can only make the properties of an individual object dynamic in the Faceplate type that
are not assigned to a property node.
You can only assign a property node with properties of an individual object that you have not
made dynamic in the Faceplate type.

Special aspects of the property node
You have four options when creating the property nodes:
● Linking the property nodes with the object properties.
● Linking the properties node with faceplate tags.
● Linking the properties node with object/faceplate tag properties.
● Creating an "empty" properties node without link to object/faceplate tag properties.
In order to use an "empty" property node, the following configuration steps are required:
● Make property nodes dynamic with the dynamic capabilities that are available in the
Faceplate type.
When scripting, you access the "empty" property nodes in the Faceplate type by way of
SmartTags.
● Connect property nodes in the Faceplate instance with Variable.
The variable can be used to trigger the OnChanged event of the property node.
● Configure the event on an OnChanged event of the property node in the Faceplate instance.
The event is executed if e.g. the value of the property node is changed with a script in the
Faceplate type.

See also
How to link object properties with a properties node (Page 352)
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3.6.7

How to link object properties with a properties node

Introduction
Define the properties that you want to configure at the instances in the "Properties" tab. You
may link each instance-specific properties node to multiple object properties. The properties
of the faceplate instance only display the name of the properties node. Changes to the value
of the property node are applied to all of the properties of the objects linked to this property.

Requirements
● The configuration dialog is open.
● The "Properties" tab is selected.

Adding object properties
1. Click "Add property" to add a properties node in the "Selected properties" area.
2. You may rename the property node using the shortcut menu.
Continue at step 8 if you want to configure a properties node without link to the the objects.
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3. In the "Objects" area, select an object at which you want to define an instance-specific
property.
The properties available for the selected object are listed in the "Object properties" area.
4. Select the property from the "Object properties" area.
5. Drag-and-drop the selected property to the properties node in the "Selected properties"
area.
The object property is arranged under the properties node.
Note
You may assign several object properties to each properties node. Arrange the object
properties in appropriate groups. Only the name of the properties node is displayed in the
object properties of the faceplate instance. Changes to the value of the property node are
applied to all object properties linked to this properties node.
6. Repeat steps 1 to 5 until the "Selected properties" area contains all selected properties.
7. Click "Apply".
Your configuration data will be saved and activated.
8. Click "OK".
The configuration dialog is closed.
9. Select the "Save" command from the "File" menu to save your changes to the faceplate
type.

Deleting object properties
1. In the "Selected properties" area, select the property or property nodes that you want to
delete.
2. Select the "Delete" command from the shortcut menu of the selected property or property
node.
The selected property or property node will be removed from the selection.
3. Click "Apply".
Your configuration data will be saved and activated.
4. Click "OK".
The configuration dialog is closed.
5. Select the "Save" command in the "File" menu to save your changes to the faceplate type.

Editing the object properties of the faceplate type
You may always assign a different object property to an instance-specific property of a
faceplate type. You need to check and possibly adapt existing faceplate instances.
A red cross is displayed at the instance in the pictures containing the respective faceplate type
instances.

See also
How to use a Faceplate instance (Page 362)
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3.6.8

How to link faceplate tags with a properties node

Introduction
In the "Properties" tab, specify the properties that you want to configure at the instances. You
may link each instance-specific properties node with several object properties and/or faceplate
tags. Only the name of the properties node is displayed in the object properties of the Faceplate
instance.

Requirements
● A Faceplate type is open.
● The faceplate type is assigned at least one faceplate tag.
● The "Configure faceplate type" configuration dialog is open.
● The "Properties" tab is selected.
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Linking faceplate tags with a properties node
1. Click the "Faceplate tags" entry in the "Objects" area to display the faceplate tags in the
"Object properties" area.
2. Select the faceplate tag and drag-and-drop it to the properties node in the "Selected
properties" area.
The faceplate tag is arranged under the properties node.
3. You can rename the properties nodes using the shortcut menu.
Note
You may assign several faceplate tags to each properties node. Arrange the tags in
appropriate groups.
4. Repeat steps 1 to 3 until the "Selected properties" area contains all selected faceplate tags.
5. Click "Apply".
Your configuration data will be saved and activated.
6. Click "OK".
The configuration dialog is closed.
7. Select "File" > "Save" to save your changes to the faceplate type.

Removing faceplate tags from properties nodes
1. In the "Selected properties" area, select the faceplate tag or properties nodes that you want
to remove.
2. Select the "Delete" command from the shortcut menu of the selected faceplate tag or
property node.
The selected faceplate tag or property node will be removed from the selection.
3. Click "Apply".
Your configuration data will be saved and activated.
4. Click "OK".
The configuration dialog is closed.
5. Select "File" > "Save" to save your changes to the faceplate type.
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3.6.9

Event of a Faceplate type

Introduction
You define the events that should be made available in the instances in the "Events" tab.

"Selected events" area
This area contains the instance-specific event nodes for the faceplate type. Each of these
event nodes assign exactly one event to the individual objects. Only the name of the event
node is shown in the "Name" tab for the object properties of the instances. The event of the
individual object is triggered by triggering the event linked to the event node.

"Object" area
This area contains all objects included in the faceplate type. Select an object for which you
want to show the available events in the "Object Events" area.
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"Object events" area
This area contains all available events for the object selected in the "Objects" area. In order
to define an event as instance-specific, drag the desired event with Drag & Drop into the
"Selected events" area on the respective event node.
Note
Enter a unique name for the event node. There are no language-dependent names for the
event nodes.

See also
How to configure the events of a Faceplate type (Page 357)

3.6.10

How to configure the events of a Faceplate type

Introduction
You define the events that should be able to be configured in the instances in the "Events" tab.
Every instance-specific event node can be connected with only one event of the individual
object. Only the name of the event node is shown in the object properties of the faceplate
instance. By changing the value of the event node, all of the events of the individual objects
connected with the event nodes are changed.
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Requirements
● The configuration dialog must be open.
● The "Events" tab has been selected.

Adding events
1. Click on "Add event" to add an event node in the "Selected events" area.
2. Rename the event nodes using the context menu when required.
3. Select an object in the "Objects" area for which you want to define an event as instancespecific.
The events available for the selected object are displayed in the "Object Events" area.
4. Select the desired event in the "Object Events" area.
5. Drag the desired event using Drag & Drop onto the event node in the "Selected events"
area.
Note
Every event node can only be assigned to a single event of the individual objects.
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6. Repeat steps 1 to 5 until all desired events are in the "Selected events" area.
7. Click "Apply".
The configurations that have been defined are accepted.
8. Click on "Exit".
The configuration dialog is closed.
9. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Deleting events
1. Select the event or the event node that you want to delete in the "Selected events" area.
2. Select the "Delete" command from the context menu of the selected event or the selected
event node.
The selected event or the selected event node is deleted from the selection.
3. Click "Apply".
The configurations that have been defined are accepted.
4. Click on "Exit".
The configuration dialog is closed.
5. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Subsequently changing the event of the faceplate type
You can assign another event to an instance-specific event of a faceplate type at a later point
in time. You need to check and possibly adapt existing faceplate instances.
A red cross is shown on the instance in the pictures with affected instances of the faceplate
type.

See also
How to use a Faceplate instance (Page 362)

3.6.11

Definition of the Faceplate tags of a Faceplate type

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use
faceplate tags for object dynamization. These faceplate tags are only valid for this faceplate
type. The faceplate tags can only be edited in the faceplate type.
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"Faceplate tags" configuration dialog

The configuration dialog "Faceplate tags" is called up in the "Edit" menu with the "Edit
Faceplate tags" command.
You can configure the following for the tags:
● Name
● Data type
● Start value
● Lower limit
● Upper limit

See also
How to edit the Faceplate tags of a Faceplate type (Page 360)

3.6.12

How to edit the Faceplate tags of a Faceplate type

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use
faceplate tags for object dynamization. These faceplate tags are only valid for this faceplate
type. The faceplate tags can only be edited in the faceplate type.
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Requirements
● A Faceplate type is opened in the Graphics Designer.

Add Tags
1. Select the "Edit Faceplate tags" command from the "Edit" menu.
The "Faceplate tags" dialog opens.
2. Double click on "Add...".
A new tag is created with default values.

Editing Tags
1. Double click on a created tag.
The input fields are activated in the lower portion of the window.
Note
The active input fields depend on the data type of the tags.
2. Enter the desired values in the input fields.
3. Click on "Accept" to accept the changes.
4. Click "Exit" to close the dialog box.
5. Select the "Save" command in the "File" menu to save the changes in the Faceplate type.

Deleting tags
1. Select the tags to be deleted.
2. Clock on the "Delete selected tags" to delete the tags.
The selected tags are deleted.
3. Select the "Save" command in the "File" menu to save the changes in the Faceplate type.

3.6.13

Making a Faceplate type dynamic

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use
faceplate tags for object dynamization. Not all dynamization options are available in WinCC.
The dynamizations that you perform in a faceplate type are only valid for this faceplate type.
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Available dynamizations
The following dynamizations are possible:
● VB Scripts
● Variable connection to the faceplate variables

Dynamization with VB scripts
You cannot use VB scripts to access data outside of the faceplate type. The "HMIRuntime"
component in the faceplate type was thus removed. None of the features of HMIRuntime are
therefore available in the faceplate type. However, you cannot debug scripts in faceplate types.
The new "SmartTags" component was added in the faceplate type. With "SmartTags", you
can access the faceplate variables and the properties of the faceplate type. You can find
additional information on "SmartTags" in the VBS reference under the "SmartTags Object"
topic.
Use "ScreenItems" to access the individual objects of a faceplate type. You can find additional
information on "ScreenItems" in the VBS reference under the "ScreenItems Object (Listing)"
topic.

Dynamizing through a tag connection
You can only use the faceplate tags for tag connections in a faceplate type. Otherwise do just
the same as you would for a normal process picture. For more information on variable
connections refer to the section headed "Dynamizing through a tag connection".

See also
Dynamizing by Means of Tag Connection (Page 1033)
Dynamizing Using VBS Action (Page 1061)

3.6.14

How to use a Faceplate instance

Introduction
You insert the faceplate type as a faceplate instance in a process picture. You configure the
instance-specific properties in the process picture.
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Requirement
● The Graphics Designer is open.

Procedure
1. Select the "New" command on the "File" menu.
A picture is opened in format *.pdl.
2. Insert the "Faceplate" object from the object palette into the picture with a double click.
An "Open dialog" is opened.
3. Select the desired faceplate type.
The faceplate instance is inserted in the picture.
The selected faceplate type is listed under the "Faceplate type FPT" attribute in the object
properties.
Note
If you select no faceplate types or an invalid faceplate type, the faceplate object is deleted
from the picture.
4. Select "Properties" in the context menu of the faceplate instance.
The "Object properties" dialog box opens.
5. Configure the instance-specific properties in the "Properties" tab.
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6. Configure the instance-specific events in the "Events" tab.

7. Close the "Object properties" dialog box.
The configurations that have been defined are accepted.

Effects of the faceplate type change on the given instances
You can change properties and events of the faceplate type, even if an instance of the faceplate
type already exists. A red cross is shown on the instance in the pictures with affected instances.
A compete automatic adjustment of the scripts in the instances cannot be ensured after
changing the type-specific properties and events of the faceplate. Scripts can then no longer
be executed, or no longer executed correctly. A faulty operation can be triggered without this
being indicated to the user.
Therefore, check all scripts linked with the faceplate instance.
When you want to save a picture with faceplate instances that are affected by changing the
type-specific properties and events, the following dialog is displayed with all the faceplate
instances to be checked.
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When you have checked the scripts and, if necessary, adjusted these, select the check box
in front of the instance. The red cross on the unchecked or invalid faceplate instance is then
hidden.
In the Graphics Designer you can set the option to have this dialog displayed when saving the
picture. Use the menu command "Options/Settings" to open the "Options" tab and select the
check box "Show information at faceplate type change".

See also
How to link object properties with a properties node (Page 352)
How to configure the events of a Faceplate type (Page 357)

3.6.15

How to update a Faceplate instance

Introduction
The changes of type-specific properties in the Faceplate type are not updated in Faceplate
instances if the respective process picture of the Faceplate instance is open. You get the
changes in the instances by closing and reloading the respective process picture.
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Requirements
● A Faceplate type is created.
● An instance of the Faceplate type is inserted in a process picture.

Procedure
1. Select the "Open type" command from the "File" menu.
The "Open" dialog box is opened.
2. Select the desired Faceplate type.
3. Change the desired type-specific properties and events of the individual objects.
4. Select the "Save" command in the "File" menu to accept the changes in the Faceplate type.
5. Close the pictures in which the instances of the Faceplate type are contained.
6. Load the pictures into the Graphics Designer again.
The changes to the Faceplate type are accepted in the Faceplate instances.

3.6.16

How to protect faceplate types with a password

Introduction
A faceplate type can be assigned a password. This measure protects your VBA scripts against
unauthorized access, for example.

Creating a password
1. No objects may be selected in the faceplate type when editing its properties.
2. Open the "Object properties" window using the shortcut menu, or the "View" > "Properties"
menu.
3. Verify that the faceplate type properties are displayed: The "Background picture" entry must
be displayed in the object type field in the top line of the window. The drop-down list box
next to it displays the file name of the faceplate type.
4. You may edit the attributes contained in the "Properties" or "Event" tabs similar to object
attributes. For more information, refer to chapter "Editing attributes".
5. Click the "Miscellaneous" property.
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6. Double-click "Password protection".

7. Enter a password that consists of at least six characters.
8. Repeat your password entry.
9. Click "OK".
The current faceplate type is now protected by a password that is requested the next time the
picture is opened.

Removing passwords
1. No objects may be selected in the faceplate type when editing its properties.
2. Open the "Object properties" window using the shortcut menu, or the "View" > "Properties"
menu.
3. Verify that the faceplate type properties are displayed: The "Background picture" entry must
be displayed in the object type field in the top line of the window. The drop-down list box
next to it displays the file name of the faceplate type.
4. You may edit the attributes contained in the "Properties" or "Event" tabs similar to object
attributes. For more information, refer to chapter "Editing attributes".
5. Click the "Miscellaneous" property.
6. Double-click "Password protection".

7. Set the "Remove password" check box.
The current faceplate type is no longer protected by password.
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3.7

Working with Controls

3.7.1

Working with Controls

Contents
ActiveX controls offer the option of integrating elements for controlling and monitoring system
processes into a process picture. WinCC supports the following types of controls:
● ActiveX controls
ActiveX controls are control elements from any provider that can be used by other programs
via a defined interface based on OLE.
● .NET controls
.NET controls are control elements from any supplier with the .NET Frameworks as of 2.0
from Microsoft.
● WPF controls
WPF Controls are control elements from any supplier with the .NET Frameworks as of 3.0
from Microsoft.
The size and properties that a control accepts in Runtime are defined in the Graphics Designer.
All ActiveX controls registered in the operating system and the .NET and WPF Controls on
your system are available for use in WinCC.
However, this chapter only covers the use of ActiveX controls provided by WinCC. The ActiveX
controls provided by WinCC can be changed as required and embedded dynamically in the
process.
This chapter shows you:
● how to register ActiveX controls in the operating system
● how to embed and configure controls in process pictures with the Graphics Designer
● how to use controls.

3.7.2

Short Description of the WinCC Controls and Additional Controls

Introduction
Controls are used for the monitoring and visualization of measured values and system
parameters. By appropriate dynamics they can be employed as control elements of the process
control.
While installing WinCC, a number of ActiveX controls will also be installed: The WinCC
controls.
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Overview
Detailed descriptions of the following WinCC controls can be viewed via the links in the menu
bar.
Control

Abbreviation

Function

Siemens HMI Symbol Library Symbol Library

The Symbol Library contains a comprehensive collection of readymade symbols for the display of systems and system components
in process pictures.

WinCC AlarmControl

AlarmControl

The AlarmControl can be used to display messages during
runtime.

WinCC Digital/Analog Clock
Control

Clock Control

The Clock Control can be used to integrate a time display into a
process picture.

WinCC
FunctionTrendControl

FunctionTrendControl

The FunctionTrendControl can be used to display the values of
tags as functions of other tags and compare the trend with the
setpoint trend.

WinCC Gauge Control

Gauge Control

The Gauge Control can be used to display the monitored
measurement values in the form of an analog measurement clock.

WinCC Media Control

Media Control

The Media Control can be used to play media files.

WinCC OnlineTableControl

OnlineTableControl

The OnlineTableControl can be used to display values from
archive tags in tabular form.

WinCC OnlineTrendControl

OnlineTrendControl

The OnlineTrendControl can be used to display values from tags
and archive tags as trends.

WinCC RulerControl

RulerControl

RulerControl displays the evaluation of process data in a statistics
or ruler window.

WinCC Push Button Control

Push Button Control

The Push Button Control can be used to start execution of a
command.

WinCC Slider Control

Slider Control

The Slider Control can be used to display the monitored
measurement values in the form of a slider control.

WinCC UserArchiveControl

UserArchiveControl

The UserArchiveControl provides options to access user archives
and views of the user archives.

WinCC WebBrowser Control

Display function

The WinCC WebBrowser Control displays static Web contents or
CHM documents in process pictures.

See also
How to Resize a Control (Page 374)
How to Change the Properties of a Control (Page 382)
This is how you change the registration of an ActiveX control (Page 380)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to insert a control from the selection window (Page 373)
This is how you insert an ActiveX control as a smart object: (Page 370)
The "WinCC Digital/Analog Clock" Control' (Page 393)
The "WinCC Gauge" Control (Page 399)
The "WinCC Slider" Control (Page 414)
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WinCC AlarmControl (Page 1201)
WinCC OnlineTrendControl (Page 1410)
WinCC FunctionTrendControl (Page 1465)
WinCC OnlineTableControl (Page 1373)
WinCC UserArchiveControl (Page 1720)
WinCC Media Control (Page 409)
The "Siemens HMI Symbol Library" Control (Page 383)

3.7.3

This is how you insert an ActiveX control as a smart object:

Introduction
You insert an ActiveX Control from the "Default" selection window into a process picture. You
can insert controls as a smart object or from the "Controls" tab.
If you insert the ActiveX Control as a smart object, select the ActiveX Control from the "Insert
a Control" dialog during the insertion process. The dialog shows all the ActiveX Controls that
are registered in the operating system.
Note
The use of ActiveX Controls from third party providers can lead to errors as well as drops in
performance or system blocks. The user of the software is responsible for problems caused
by the deployment of external ActiveX Controls.
We recommend testing for safe operation before implementation.
ActiveX controls which have not been certified must operate in accordance with the Microsoft
specification. In a conflict occurs, the user is obliged to submit evidence of compliance with
the specification.
At the end of the insertion process a configuration dialog is usually opened, in which you adapt
the properties of the control. You can also open this dialog later by double-clicking the control.
Detailed description of the configuration dialog can be found in the descriptions of the related
controls.
WinCC uses the designation of the control linked with a sequential number as the object name
by default. You can change this name with the "Object name" attribute in the "Object
Properties" window.

Procedure
1. In the Object Palette, click the smart object "Control".
2. Place the mouse pointer at the position in the picture where you want to insert the ActiveX
Control.
The mouse pointer changes into a crosshair with an object symbol attached.
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3. Drag the control to the desired size with the mouse.
The "Insert a Control" dialog opens.

4. Select one of the ActiveX Controls that are registered in the operating system. Confirm your
selection with "OK".
With some controls, the corresponding configuration dialog is automatically opened. In any
case, you can open the configuration dialog with a double-click or via the shortcut menu.
5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK".
The insertion process for the "Control" object is finished.

Alternative procedure
Double-click the "Control" smart object in the "Default" selection window in order to insert it
with the default properties into the process picture. Select the desired control in the "Insert a
Control" dialog.

See also
How to Change the Properties of a Control (Page 382)
This is how you change the registration of an ActiveX control (Page 380)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to Resize a Control (Page 374)
How to insert a control from the selection window (Page 373)
Short Description of the WinCC Controls and Additional Controls (Page 368)

3.7.4

This is how you insert a .NET or WPF control as a smart object

Introduction
Insert a .NET or WPF Control from the "Standard" selection window into a process picture.
You can insert these controls as a smart object or from the "Controls" tab.
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When inserting the control as a smart object, select the required control in the "Insert a Control"
dialog. All the controls which were configured for selection are displayed here.
Note
Possible problems with third-party controls
The user of the software is responsible for problems caused by the deployment of external
controls.
We recommend testing for safe operation before implementation.
At the end of the insertion process a configuration dialog is usually opened, in which you adapt
the properties of the control. You can also open this dialog later by double-clicking the control.
WinCC uses the designation of the control linked with a sequential number as the object name
by default. You can change this name with the "Object name" attribute in the "Object
Properties" window.

Procedure
1. Click the ".NET Control" or "WPF Control" smart object in the "Standard" selection window.
2. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Drag the control to the desired size with the mouse.
The "Insert a Control" dialog with the controls from the "Global Assembly Cache" is opened.

4. Select the required control and confirm with "OK".
5. Choose the desired type in the "Select type" dialog.
The associated configuration dialog now opens for some controls.
6. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK".
The insertion process for the ".NET Control" or "WPF Control" object is finished.
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Alternative insertion procedure
1. Double-click the ".NET Control" or "WPF Control" smart object in the "Standard" selection
window in order to insert it with the default properties into the process picture.
2. Select the required control in the "Insert control" and "Insert type" dialogs.
Note
Some inserted WPF controls only work properly when the associated .dll files are in the
"assemblies" folder. The storage location, e.g."C:\Program Files\Common Files\Siemens
\assemblies", depends on the WinCC installation path and the operating system.

3.7.5

How to insert a control from the selection window

Introduction
You insert a control into a process picture from the "Default" selection window as a smart object
or from the "Controls" selection window. ActiveX controls, .NET controls and WPF controls are
available.
After installation of WinCC the "Controls" selection window displays a default selection of
WinCC controls under the ActiveX controls. No controls are initially listed under ".NET controls"
and "WPF controls". You can configure this control selection if necessary.
When inserting the control, select the required control at the beginning of the insertion process
in order to insert it directly into a process picture.
At the end of the insertion process a configuration dialog is usually opened, in which you adapt
the properties of the control. You can also open this dialog later by double-clicking the control.
WinCC uses the designation of the control linked with a sequential number as the object name
by default. You can change the name with the "Object name" attribute in the "Object Properties"
window.

Requirement
● You have display the "Controls" selection window with "View > Toolbars".

Procedure
1. Select the required control in the "Controls" selection window.
2. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Drag the control to the desired size with the mouse.
The associated configuration dialog now opens for some controls.
4. Adapt the settings of the configuration dialog as required and confirm your entry with "OK".
The insertion process for the selected control is finished.
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Alternative procedure
Double-click the required control in the selection window in order to insert it with the default
properties into the process picture.

See also
How to Change the Properties of a Control (Page 382)
This is how you change the registration of an ActiveX control (Page 380)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to Resize a Control (Page 374)
This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)

3.7.6

How to Resize a Control

Introduction
The size of an object is defined by the geometry of the rectangle surrounding the object. The
rectangle surrounding the control is symbolized when selecting an object by showing the
handles.
Controls can be resized by:
● dragging the handle to a new position
● Changing the values of the "Width" and "Height" attributes in the window "Object properties"
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Requirements
● Select a control.

Procedure
1. Position the cursor on the handle of the selected control.
The mouse pointer will change to a double arrow. The alignment of the double arrow
indicates the directions in which you can move the handle:
– Horizontal double arrow
The handles on the horizontal center axis can be used to change the width of the control.
– Vertical double arrow
The handles on the vertical center axis can be used to change the height of the control.
– Diagonal double arrow
The handles on the corners of the control can be used to change the height and width
of the control.
2. Use the mouse to drag the handle to the position you want.
In the settings of the Graphics Designer if the Snap to Grid function is activated, the control
can only be scaled with the mouse according to the settings for the grid.

See also
This is how you change the registration of an ActiveX control (Page 380)
How to Change the Properties of a Control (Page 382)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to insert a control from the selection window (Page 373)
This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)
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3.7.7

How to Position a Control

Introduction
The position of a control is defined by the coordinates of the control origin. The left upper corner
of the rectangle surrounding the control is called the object origin. Controls can be positioned
by:
● dragging the control to a new position
● moving the selected control with the aid of the arrow keys for cursor control
● Changing the "Position X" and "Position Y" attributes in the "Object Properties" window

Requirements
● Select a control.

Procedure
1. Position the cursor on the selected control.
The mouse pointer changes to a crosshair with arrowheads.
2. Click the control and hold down the left mouse button.
The cursor changes into an arrow with an outline icon (small rectangle with broken line).
3. Move the cursor.
The rectangle surrounding the control is displayed as broken and shows a possible new
position for the control. The control initially maintains its original position.
In the settings of the Graphics Designer if the Snap to Grid function is activated, the control
can only be positioned with the mouse according to the settings for the grid.
4. Release the mouse button.
The control is moved to the position previously displayed by the broken line of the rectangle
surrounding the object. The mouse pointer again changes into a crosshair with arrow ends.

See also
How to configure the control selection (Page 377)
How to Change the Properties of a Control (Page 382)
This is how you change the registration of an ActiveX control (Page 380)
How to Resize a Control (Page 374)
How to insert a control from the selection window (Page 373)
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This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)

3.7.8

How to configure the control selection

Introduction
The "Controls" tab in the "Standard" selection window of the Graphics Designer contains a
selection of controls in the folders "ActiveX controls", ".NET controls" and "WPF controls". You
can insert these controls directly into a picture.
You can configure the selection of controls available in the tab yourself:
● Change the selection of the ActiveX controls in the dialog "Select OCX Controls". You can
add any of the ActiveX controls registered in the operating system to the list of controls and
remove individual controls from the selection.
● Change the selection of the .NET controls in the dialog "Select .NET Object".
● Change the selection of the WPF controls in the dialog "Select WPF Object".
Note
The use of controls from third party providers can lead to errors as well as drops in
performance or system blockage. The user of the software is responsible for problems
caused by the deployment of external controls.
We recommend a thorough test before implementation.
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Configuring ActiveX controls
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the
"ActiveX Controls" folder. The "Select OCX Controls" dialog is opened.

In the area "Available OCXs (Number)", the "Select OCX Controls" dialog shows all the
ActiveX Controls that are registered in the operating system. The exact number is shown
in the title of the area after the registration has been read in. A red check mark indicates
those controls that are available in the "Controls" tab dialog of the Object Palette. The path
and the program ID of the selected ActiveX Controls are displayed in the area "Details".
You can open the "Select OCX Controls" dialog also from the WinCC Explorer. Click on
the entry "Graphics Designer" in the navigation window and select the entry "Select ActiveX
Control" in the shortcut menu.
2. To add an ActiveX control in the "Controls" tab, select the required control in the area
"Available OCX Controls".
A red check mark indicates that the control is added to the "Controls" tab.
3. To remove an ActiveX control deactivate the control in question in the area "Available OCX
Controls".
The red check mark disappears.
4. Confirm your changes by clicking "OK".
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Configuring .NET objects and WPF objects
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the
".NET Controls" folder or the "WPF Controls" folder.
The dialog "Select .NET Object" or "Select WPF Object" opens.

In the area "Available Controls (Number)", the dialog shows all the .NET objects or WPF
objects on your computer. The precise number is displayed in the title of the area. A red
check mark indicates those controls that are available in the "Controls" tab dialog of the
Object Palette. The assembly, .NET version and path of the selected object are displayed
in the area "Details".
2. To add a control in the "Controls" tab, select the required control in the area "Available
Controls".
A red check mark indicates that the control is added to the "Controls" tab.
3. To remove a control deactivate the control in question in the area "Available Controls".
The red check mark disappears.
4. Confirm your changes by clicking "OK".

See also
How to Change the Properties of a Control (Page 382)
This is how you change the registration of an ActiveX control (Page 380)
How to Position a Control (Page 376)
How to Resize a Control (Page 374)
How to insert a control from the selection window (Page 373)
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This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)
.NET controls (Page 423)
WPF controls (Page 424)

3.7.9

This is how you change the registration of an ActiveX control

Introduction
ActiveX Controls must be configured in the operating system, in order to be available for
applications. Normally the registration is a component of the installation procedure. For
troubleshooting or also for upgrading of individual controls, you can also perform a registration
or deregistration manually. In WinCC you can edit the registration in the following dialogs:
● Dialog "Select OCX Controls"
Use the button "Deregister OCX" and "Register OCX" ....
● Dialog "Insert a Control"
Use the buttons "Register..." and "Deregister".
The procedure for changing the registration is the same in both dialogs. We will describe it
below in the example of the Insert a Control dialog.
Note
You can use these buttons to change the settings of the operating system. Changes are made
immediately.
Before the deregistration of an ActiveX control, check in which path the related OCX file is
saved on the hard disk. How to facilitate a repeated registration of this control.

Deregistering ActiveX Control
1. Insert a Control as a Smart Object.
The "Insert a Control" dialog is opened.
2. Select the desired Control in the selection list.

3. Check the details under the selection list (path and name).
4. Click on the button "Deregister".
The selected control is deregistered and deleted from the selection list. The related OCX
file is maintained in the specified path on the hard disk.
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Registering ActiveX Control
1. Insert a Control as a smart object.
The "Insert a Control" dialog opens.
2. Click the "Register..." button.
You can use the Open dialog to open a browser window for the selection of the desired
OCX file.

3. Select the desired OCX file.
During the installation, WinCC Controls are normally copied into the folder "...\Siemens
\WinCC\BIN".
4. Click "OK" to confirm your choice.
The selected control is registered in the operating system and displayed in the selection
list of the "Insert a Control" dialog.

See also
How to Change the Properties of a Control (Page 382)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to Resize a Control (Page 374)
How to insert a control from the selection window (Page 373)
This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)
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3.7.10

How to Change the Properties of a Control

Introduction
The properties of a control can be adopted according to your needs by:
● Changing the attributes in the "Object Properties" dialog
● Changing the settings in the Configuration dialog

Opening the "Object Properties" Window
In the pop-up menu of a control select the entry "Properties", in order to open the "Object
Properties" dialog. The change of an attribute is executed immediately.
The detailed description of the "Object Properties" dialog is found in chapter "The Window
Object Properties".

Opening the Configuration Dialog
Double-click a control to open the related configuration dialog. Select a tab to carry out the
desired changes. Click on "Accept" in order to assign the new settings to the control. Confirm
your configuration with "OK" to close the dialog.
The configuration dialogs are explained in the detailed description of the related control.

See also
How to Resize a Control (Page 374)
This is how you change the registration of an ActiveX control (Page 380)
How to configure the control selection (Page 377)
How to Position a Control (Page 376)
How to insert a control from the selection window (Page 373)
This is how you insert an ActiveX control as a smart object: (Page 370)
Short Description of the WinCC Controls and Additional Controls (Page 368)
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3.7.11

ActiveX controls

3.7.11.1

Siemens HMI Symbol Library

The "Siemens HMI Symbol Library" Control
Introduction
The control "Siemens HMI Symbol Library" contains a comprehensive collection of prepared
symbols. These symbols can be used for the display of systems and system components in
process pictures.

Inserting Symbols of the Symbol Library
The symbols of the Symbol Library are inserted into a picture as a control from the "Standard"
selection window or from the library of the Graphics Designer:
● As a smart object
The "Control" smart object is inserted from the "Standard" tab. The Symbol Library is
selected in the dialog "Insert a Control".
The selection of the desired symbol is done after the insertion procedure in the configuration
dialog which is opened by double-clicking the control.
● From the "Controls" tab
The "Siemens HMI Symbol Library" control is inserted directly from the "Controls" tab.
The selection of the desired symbols is done after the insertion procedure in the
configuration dialog which is opened by double-clicking the control.
● From the library of the Graphics Designer
The control Siemens HMI Symbol Library is integrated as a unique folder into the library of
the Graphics Designer.
The desired symbol is selected directly and inserted from the library. The properties of the
symbols can be changed in the configuration dialog, which is opened by double-clicking
the symbol.
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Changing the Symbols of the Symbol Library
The properties of the symbols of the Symbol Library can be changed in the window "Object
Properties" and in the configuration dialog "Properties of Siemens HMI Symbol Library".
The window "Object Properties" is opened from the pop-up menu of the inserted object. The
dialog "Properties of Siemens HMI Symbol Library" is opened by double-clicking the symbol
to be changed.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)
How to Change the Colors (Page 390)
How to Change the Display Options (Page 388)
How to Change the Alignment (Page 386)
How to Select a Symbol from the Symbol Library (Page 384)

How to Select a Symbol from the Symbol Library
Introduction
You can use the "Symbols" tab in the Properties of Siemens HMI Symbol Library dialog to
replace the displayed symbol with another. The picture contents of the selected symbols is
changed by the selection of another symbol of the Symbol Library. The other properties of the
selected symbols are not changed.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the
symbol to be changed.
● Select the "Symbols" tab.

Preview
In the area at the top left, the symbol selected in the selection will be displayed. All settings of
the "Siemens HMI Symbol Library" dialog are displayed in the preview.

Categories
In the area at the bottom left all categories containing symbols of the Symbol Library are
displayed.
Select the category that contains the desired symbol. All symbols of the selected category are
displayed in the selection.
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Selection
The right area displays all the symbols available for the selected category.
Position the mouse pointer on a symbol, to show a short description.
Click on the desired symbol to select it. The selected symbol is displayed in the preview.

See also
How to Change the Colors (Page 390)
The "Siemens HMI Symbol Library" Control (Page 383)
How to Change the Display Options (Page 388)
How to Change the Alignment (Page 386)

How to Change the Alignment
Introduction
You can use the "Style" tab in the Properties of Siemens HMI Symbol Library dialog to set
different options. The display and the alignment of the selected symbols can be customized.
In the area at the top left, the symbol selected in the "Symbols" tab is displayed. All settings
of the "Siemens HMI Symbol Library" dialog are displayed in the preview.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the
symbol to be changed.
● Select the "Style" tab.

Alignment
In the bottom left area the alignment of the symbol in the current picture can be changed. The
symbol can be mirrored and rotated.
Mirroring
Open the drop-down list box and select the desired mirroring type.
The picture content is mirrored on the horizontal or vertical central axis of the symbol
respectively. Objects can be mirrored both horizontally and vertically.
Rotation
Open the drop-down list box and select the desired angle for the rotation.
The rotation of the picture contents is done around the central axis of the symbol. The rotation
is done counter-clockwise in steps of 90, 180 and 270 degrees.
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See also
The "Siemens HMI Symbol Library" Control (Page 383)
How to Change the Colors (Page 390)
How to Change the Display Options (Page 388)
How to Select a Symbol from the Symbol Library (Page 384)

How to Change the Display Options
Introduction
You can use the "Style" tab in the Properties of Siemens HMI Symbol Library dialog to set
different options. The display and the alignment of the selected symbols can be customized.
In the area at the top left, the symbol selected in the "Symbols" tab is displayed. All settings
of the "Siemens HMI Symbol Library" dialog are displayed in the preview.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the
symbol to be changed.
● Select the "Style" tab.

Display
Open the drop-down list box and select the desired appearance form for the picture contents.

Original
The appearance form of the symbol corresponds to the multi-colored display in the selection
of the "Symbols" tab.
Shadow
Lines of the color "Black" are maintained as contour lines. Elements of the symbols in other
colors are displayed as light grades of the current foreground color.
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Solid
Lines of the color "Black" are maintained as contour lines. All the elements of the symbol in
other colors are assigned the color value of the current foreground color.
Outline
Lines of the color "Black" are maintained as contour lines. All the elements of the symbol in
other colors are assigned the color value of the current background color.

Background
Open the drop-down list box and select the desired background type.
The background can be displayed either "Nontransparent" or "Transparent".

Customizing
Click on the control box next to the "Customize" option, in order to enable or to disable the
option.
When selecting the "Customize" option, the picture contents are adapted to the object size of
the selected symbol.

Display Mouse Pointer
Click on the control box next to the Customize option, in order to enable or to disable the option.
When selecting the Display Mouse Pointer option, the mouse pointer is not hidden in Runtime,
if it is placed on the symbol.

See also
The "Siemens HMI Symbol Library" Control (Page 383)
How to Change the Colors (Page 390)
How to Change the Alignment (Page 386)
How to Select a Symbol from the Symbol Library (Page 384)

How to Change the Colors
Introduction
Using the "Color" tab in the Properties of Siemens HMI Symbol Library dialog you can set
different color settings for the display of the selected symbol.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the
symbol to be changed.
● Select the "Color" tab.

Properties
Select the color attribute you wish to change.
The "Flashing Color" acquires the symbol in the flashing status. The flashing is only visible in
Runtime. With the "Background Color" you can display the background of the symbol for the
background type "Nontransparent". In the appearance forms of "Shadow" and "Solid", the
symbol is shown in the Foreground Color.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in
the "Color Palette" section.
The "Standard Colors" color group contains the 16 standard colors of the operating system.
The "Windows System Colors" color group contains the colors which are set in the operating
system currently as the display options at system start.
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Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color
attribute.

Editing Custom Colors
Click this button to access the "Colors" dialog. Depending on the graphic settings of the
operating system you can define the desired color freely.

See also
The "Siemens HMI Symbol Library" Control (Page 383)
How to Change the Display Options (Page 388)
How to Change the Alignment (Page 386)
How to Select a Symbol from the Symbol Library (Page 384)

3.7.11.2

WinCC AlarmControl

Overview
With the WinCC AlarmControl you can have the messages displayed in a message window in
Runtime. Each message is displayed in a separate message line in the table. The content of
the message line depends on the message blocks to be displayed.
For more information, refer to Display of messages during Runtime (Page 1201).
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3.7.11.3

WinCC Digital/Analog Clock Control

The "WinCC Digital/Analog Clock" Control'
Introduction
With the "WinCC Digital/Analog Clock Control" you can integrate a time display into a process
picture. In Runtime the current system time of the operating system is displayed. The time can
be displayed as analog or digital. In addition, the digital display contains the current date.

Inserting a Clock Control
The Clock Control is inserted from the "Standard" selection window into a picture:
● As a smart object
The "Control" smart object is inserted from the "Standard" tab. The Clock Control is selected
in the dialog "Insert a Control".
● From the "Controls" tab
The Clock Control is inserted directly from the "Controls" tab.
The properties of the control are changed in the configuration dialog "Properties of the WinCC
Digital/Analog Clock Control" or in the window "Object Properties".

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)
How to Change the Background Picture of the Clock Control (Page 397)
How to Change the Color of the Clock Control (Page 396)
How to Change the Font of the Digital Clock Control Display (Page 395)
How to Change the Appearance of the Clock Control (Page 394)
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How to Change the Appearance of the Clock Control
Introduction
In the "General" tab, you have the option to set the general appearance of the clock control.
In addition, the geometry of the pointers can be changed.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.
● Click on the "General" tab.

Pointer width in %
For the analog display you can set the width of the second, minute and hour pointer. The values
are understood as percent share of the pointer length.
You can only set the pointer width in the classic design. The static values and the configured
dynamic properties have no effect on the new design.

Pointer length in %
For the analog display you can set the length of the second, minute and hour pointer. The
values are understood as percent share of the radius of the dial.

Analog display
Choose between analog and digital display of the clock.

Dial
Hide or unhide the hour marks for the analog display.

Square
Select whether the analog clock is to be displayed in square shape.

Line pointer
Specify whether for the analog display only the border or also the filling color of the pointer will
be displayed.
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Background style
Select "Nontransparent" in order to display the analog clock with a frame. With "Transparent
border" the colored dial is displayed without a border. Select "Transparent", in order to display
the analog clock without background.

See also
The "WinCC Digital/Analog Clock" Control' (Page 393)
How to Change the Background Picture of the Clock Control (Page 397)
How to Change the Color of the Clock Control (Page 396)
How to Change the Font of the Digital Clock Control Display (Page 395)

How to Change the Font of the Digital Clock Control Display
Introduction
You can use the "Font" tab to adapt the font to the digital display of the clock. This setting has
no effect on the analog display of the Clock Control.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.
● Select the "Font" tab.

Properties
The currently selected property is shown.

Font
Select the desired font for the digital display of the clock from the drop-down list box. You can
use any of the fonts registered in the operating system.

Font size
Select the desired font size for the digital display of the clock from the drop-down list box.
Alternatively, enter the font size directly in the field. The value is specified in points (pt).
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Display
Select one or more display options.
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.

See also
The "WinCC Digital/Analog Clock" Control' (Page 393)
How to Change the Background Picture of the Clock Control (Page 397)
How to Change the Color of the Clock Control (Page 396)
How to Change the Appearance of the Clock Control (Page 394)

How to Change the Color of the Clock Control
Introduction
You can use the "Color" tab to adapt the color to the digital display of the clock. For the digital
display of the Clock Controls only the color attribute "Foreground color" (font color) is relevant.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.
● Select the "Color" tab.

Properties
Select the color attribute you wish to change.
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Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in
the "Color Palette" section.
The "Standard Colors" color group contains the 16 standard colors of the operating system.
The "Windows System Colors" color group contains the colors which are set in the operating
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color
attribute.

Editing Custom Colors
Click this button to access the "Colors" dialog. Depending on the graphic settings of the
operating system you can define the desired color freely.

See also
The "WinCC Digital/Analog Clock" Control' (Page 393)
How to Change the Background Picture of the Clock Control (Page 397)
How to Change the Font of the Digital Clock Control Display (Page 395)
How to Change the Appearance of the Clock Control (Page 394)

How to Change the Background Picture of the Clock Control
Introduction
You can use the "Picture" tab, to assign a background picture to the analog or digital display
of the clock. The current picture is shown in the "Preview" area.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.
● Select the "Picture" tab.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

397

Creating Process Pictures
3.7 Working with Controls

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which
you want to assign the selected property.
Pictures in the following formats can be inserted:
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

Deleting
Click the "Clear" button to move on from the opening picture.

See also
The "WinCC Digital/Analog Clock" Control' (Page 393)
How to Change the Color of the Clock Control (Page 396)
How to Change the Font of the Digital Clock Control Display (Page 395)
How to Change the Appearance of the Clock Control (Page 394)

3.7.11.4

WinCC FunctionTrendControl

Overview
The WinCC FunctionTrendControl can be used to display the values of tags as functions of
other tags and compare trends with a setpoint trend.
Additional information is available under Outputting process values as a function of other
tags (Page 1465)
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3.7.11.5

WinCC Gauge Control

The "WinCC Gauge" Control
Introduction
The "WinCC Gauge" control is used to display the monitored measurement values in the form
of an analog measurement clock. Warning and danger areas as well as the extreme values of
the pointer movement can be marked in colors.

Inserting Gauge Control
The Gauge Control is inserted from the "Standard" selection window into a picture:
● As a smart object
The "Control" smart object is inserted from the "Standard" tab. The Control is selected in
the dialog "Insert a Control".
● From the "Controls" tab
The Gauge Control is inserted directly from the "Controls" tab.

Changing Important Properties
The properties of the control are changed in the configuration dialog "Properties of the WinCC
Gauge Control" or in the window "Object Properties".
The following attributes can be changed only in the window "Object Properties":
Labeling
Enter a text to be displayed, for example the type of the controlled value on the gauge. As a
standard, you must enter the label "SIMATIC".
Unit text
Enter a text to display, for example, the physical unit of the displayed value on the gauge. By
default, this field is blank.
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Unit offset
Specify the position for the display of the physical unit on the gauge. The value is given in
decimal format. The value is the percent share of the object height, starting from the topmost
border line of the rectangle encompassing the object.

See also
How to Configure the Scale of the Gauge Control (Page 402)
Short Description of the WinCC Controls and Additional Controls (Page 368)
How to Assign Pictures to the Gauge Control (Page 408)
How to Change the Colors of the Gauge Control (Page 406)
How to Change the Font of the Gauge Control (Page 405)
How to Mark Special Value Ranges (Page 404)
How to change the Appearance of the Gauge Control (Page 400)

How to change the Appearance of the Gauge Control
Introduction
On the "General" tab, you have the option to adapt the general appearance of the Gauge
Control.
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Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Click the "General" tab.

Center Point Size
Specify the radius for the display of the center point The value is given in decimal format as
percent share of the diameter of the gauge.

Labeling Offset
Specify the position for the labeling of the gauge. The value is given in decimal format. The
value is the percent share of the object height, starting from the topmost border line of the
rectangle encompassing the object.

Slave Pointer
For the maximum and the minimum pointer movement a marker function can be activated,
which marks the real measurement area in Runtime with colored lines:
● A green line marks the minimum pointer movement.
● A red line marks the maximum pointer movement.

Square
Select whether the gauge is to be displayed in square shape.
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Background Style
Select "Nontransparent" in order to display the gauge clock with a frame. "Transparent Border"
hides the frame. With "Transparent", only the scale of the gauge will be displayed.

See also
The "WinCC Gauge" Control (Page 399)
How to Assign Pictures to the Gauge Control (Page 408)
How to Change the Colors of the Gauge Control (Page 406)
How to Change the Font of the Gauge Control (Page 405)
How to Mark Special Value Ranges (Page 404)
How to Configure the Scale of the Gauge Control (Page 402)

How to Configure the Scale of the Gauge Control
Introduction
On the "General" tab, you can set the measuring range to be monitored. In addition, you can
configure the display of the scale.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Click on the "General" tab.
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Minimum value
Enter the lower limit value of the measuring range. This value is shown as the min. scale value.

Maximum value
Enter the upper limit value of the measuring range. This value is shown as the max. scale
value.

Value
Specify a start value for the pointer of the gauge. If process driver connections are missing,
this value is shown in Runtime.

Minimum Angle
Enter the angle for the display at the scale start. The value is entered in degrees.

Maximum Angle
Enter the angle for the display at the scale end. The value is entered in degrees.

Tick Width
Enter the distance of the main tick marks as the difference of two neighboring measurements.
The area between two main tick marks is divided by default by a wider tick mark of half the
length.

Scale Width
Specify the length of the main tick marks and thus the width of the scale. The value is given
in decimal format as percent share of the radius of the gauge.

Scale Offset
Specify the outer radius of the scale. The value is given in decimal format as percent share of
the radius of the gauge.

Tick Text Offset
Specify the inner radius of the scale labeling. The value is given in decimal format as percent
share of the radius of the gauge.

Decimal point
The values of the scale labeling can be displayed as whole numbers or as decimal numbers
with one decimal place.
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See also
How to Assign Pictures to the Gauge Control (Page 408)
How to Change the Colors of the Gauge Control (Page 406)
How to Change the Font of the Gauge Control (Page 405)
How to Mark Special Value Ranges (Page 404)
How to change the Appearance of the Gauge Control (Page 400)

How to Mark Special Value Ranges
Introduction
You can use the "General" tab to highlight special range of values in the scale in colors.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Click on the "General" tab.

Danger
Set the limit value for the start of the danger area.
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Warning
Set the limit value for the start of the warning area.

Danger Display
The scale area starting at the limit value "Danger" can be shown in the "Danger color" (default
color: red).

Warning Display
The scale area starting at the limit value "Warning" can be shown in the "Warning color" (default
color: yellow).

Normal Display
The scale area ending at the limit value "Warning" can be shown in the "Normal color" (default
color: green).

See also
The "WinCC Gauge" Control (Page 399)
How to Assign Pictures to the Gauge Control (Page 408)
How to Change the Colors of the Gauge Control (Page 406)
How to Change the Font of the Gauge Control (Page 405)
How to Configure the Scale of the Gauge Control (Page 402)
How to change the Appearance of the Gauge Control (Page 400)

How to Change the Font of the Gauge Control
Introduction
You can use the tab "Font" to adapt the fonts for the different labeling elements of the gauge.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Select the "Font" tab.
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Properties
Select the font attribute you wish to change.
Select "Labeling font", in order to change the font for the name of the gauge. "Unit font" changes
the font for the display of the physical unit. You can configure the scale labeling with the "Scale
text font".

Font
Select from the drop-down list box the desired font for the selected labeling attribute. You can
use any of the fonts registered in the operating system.

Font size
Select from the drop-down list box the desired font size for the selected labeling attribute.
Alternatively, enter the font size directly in the field. The value is specified in points (pt).

Display
Select one or more display options.
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.

See also
The "WinCC Gauge" Control (Page 399)
How to Assign Pictures to the Gauge Control (Page 408)
How to Change the Colors of the Gauge Control (Page 406)
How to Mark Special Value Ranges (Page 404)
How to Configure the Scale of the Gauge Control (Page 402)
How to change the Appearance of the Gauge Control (Page 400)

How to Change the Colors of the Gauge Control
Introduction
You can use the "Color" tab to adapt the color for the display of the Gauge Control.
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Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Select the "Color" tab.

Properties
Select the color attribute you wish to change.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in
the "Color Palette" section.
The "Standard Colors" color group contains the 16 standard colors of the operating system.
The "Windows System Colors" color group contains the colors which are set in the operating
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color
attribute.

Editing Custom Colors
Click this button to access the "Colors" dialog. Depending on the graphic settings of the
operating system you can define the desired color freely.

See also
The "WinCC Gauge" Control (Page 399)
How to Assign Pictures to the Gauge Control (Page 408)
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How to Change the Font of the Gauge Control (Page 405)
How to Mark Special Value Ranges (Page 404)
How to Configure the Scale of the Gauge Control (Page 402)
How to change the Appearance of the Gauge Control (Page 400)

How to Assign Pictures to the Gauge Control
Introduction
You can use the tab "Picture" to assign a background and a frame image to the Gauge.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.
● Select the "Picture" tab.

Properties
Select the property for which you want to change the picture assignment. The current picture
is shown in the "Preview" area.
With the "background picture" option you can assign an image to the circular background of
the gauge. With the "Frame picture" option you can assign an image to the rectangular
background of the Control.

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which
you want to assign the selected property.
Pictures in the following formats can be inserted:
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

Deleting
Click the "Clear" button to move on from the opening picture.
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See also
How to Change the Font of the Gauge Control (Page 405)
The "WinCC Gauge" Control (Page 399)
How to Change the Colors of the Gauge Control (Page 406)
How to Mark Special Value Ranges (Page 404)
How to Configure the Scale of the Gauge Control (Page 402)
How to change the Appearance of the Gauge Control (Page 400)

3.7.11.6

WinCC Media Control

WinCC Media Control
Introduction
You can use WinCC to also integrate multimedia files as controls into your pictures. This is
what WinCC Media Control is used for.
The WinCC Media Control can display the following file formats: GIF, BMP, JPG, JPEG, PNG.
WinCC Media Control can be used conditionally to play back the following file formats: ASF,
WMV, AVI, MPG, MPEG, MP4, QT, MOV. The control can only play the formats that the
MediaPlayer plays.
Note
Video file requirements
Install the Microsoft feature "Desktop Experience" to enable the playback of video files in
Windows Server 2008 RS SP1.
For more information related to this topic, refer to the Microsoft documentation on the Internet.
Note
In addition to the data format, playback of multimedia files also depends on the video and
audio codes installed on the computer.
Note
Data loss when coping the project
When copying the project to another computer, please note the following:
The files specified in the WinCC Media Control are not copied along with the project if they
are linked dynamically and not specified with UNC path.
You will need to add the files to the project again.
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Inserting WinCC Media Control
Insert the WinCC Media Control from the "Standard" selection window into a picture:
● Drag the smart object "Control" on the "Standard" tab into the picture and select the WinCC
Media Control.
● Double-click "WinCC Media Control" on the "Controls" tab.
A placeholder for the WinCC Media Control is inserted in the picture:

Double-click the WinCC Media Control to open the related configuration dialog. Enter the
required information on the file to be played and for display of the Media Control.
The WinCC Media Control will then be displayed differently:

Runtime
The user can display or play the specified multimedia file with the help of the control elements
in Runtime.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)
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This is how you configure the WinCC Media Control:
Introduction
The WinCC Media Control can be used to display or play multimedia files in Runtime.
Note
Video file requirements
Install the Microsoft feature "Desktop Experience" to enable the playback of video files in
Windows Server 2008 RS SP1.
For more information related to this topic, refer to the Microsoft documentation on the Internet.
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Procedure
1. Double-click the object "WinCC Media Control".
The "Properties of WinCC Media Control" dialog is opened.

Note
If you want to dynamize the attributes, you have to open the object properties with the
"Properties" entry in the shortcut menu.
2. Enter the path and file name of the file to be displayed or played under "General" or look
for the file after clicking the button "...".
Depending on the media type entered, you can select different options.
3. For pictures, set whether the picture should be adapted to the control or whether the control
should be adapted to the picture.
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4. For films, set the playback format and playback options.
The option "Skip interval" is used to set the interval for forward or backward skip.

5. On the "View" tab, define the display of the WinCC Media Control for playing multimedia
files.
In runtime the WinCC Media Control is displayed with the selected display and operator
controls.

3.7.11.7

WinCC OnlineTableControl

Overview
With the WinCC OnlineTableControl you can have the values of tags and archive tags
displayed in tables. You have many options of configuring the representation of the tables.
For more information refer to Outputting process values in table form in process pictures
(Page 1373).

3.7.11.8

WinCC OnlineTrendControl

Overview
With the WinCC OnlineTrendControl you can have the values of tags and archive tags
displayed as trends. You have many options of configuring the representation of the trends.
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For more information refer to Outputting process values in trend form in process pictures
(Page 1410).

3.7.11.9

WinCC RulerControl

Overview
With WinCC RulerControl the evaluation of process data is displayed in a statistics window or
ruler window.
You can use the WinCC RulerControl with the following controls:
● WinCC OnlineTrendControl
● WinCC OnlineTableControl
● WinCC FunctionTrendControl
For more information refer to How to configure a ruler window / statistics window / statistics
section window (Page 1387).

3.7.11.10 WinCC Slider Control
The "WinCC Slider" Control
Introduction
The "WinCC Slider" control can be used to display the monitored measurement values in the
form of a slider control. The current value can be displayed under the slider and the controlled
measurement area can be displayed as scale labeling.

414

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.7 Working with Controls

Inserting Slider Control
The Slider Control is inserted from the "Standard" selection window into a picture:
● As a smart object
The "Control" smart object is inserted from the "Standard" tab. The Slider Control is selected
in the dialog "Insert a Control".
● From the "Controls" tab
The Slider Control is inserted directly from the "Controls" tab.
The properties of the control are changed in the configuration dialog "Properties of the WinCC
Slider Control" or in the window "Object Properties".

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Colors of the Slider Control (Page 420)
How to Change the Fonts of the Slider Control (Page 419)
How to Change the 3D Effects of the Slider Control (Page 418)
How to change the measuring range and the label of the Slider Control (Page 416)
How to Change the Appearance of the Slider Control (Page 415)

How to Change the Appearance of the Slider Control
Introduction
On the "General" tab, you have the option to adapt the general appearance of the Slider Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Click on the "General" tab.

Axis Label
The tick marks of the scale can be labeled with measurement values. The step size is set
depending on the specified measurement area and the size of the control automatically.
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Scaling
On the left side of the slider tick marks can be shown for the display of a scale.

Position Text
The value of the current position of the slider can be displayed under the slider.

Slider
The slider can be hidden.

Bar Graph
The display of the sliding areas above and below the slider can be hidden.

Transparent
The background of the control can be displayed transparent. The configured background color
is hidden.

See also
The "WinCC Slider" Control (Page 414)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Colors of the Slider Control (Page 420)
How to Change the Fonts of the Slider Control (Page 419)
How to Change the 3D Effects of the Slider Control (Page 418)
How to change the measuring range and the label of the Slider Control (Page 416)

How to change the measuring range and the label of the Slider Control
Introduction
On the "General" tab, you can set the measuring range to be monitored. In addition, you can
also enter a function description as a label of the Slider Control.
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Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Click on the "General" tab.

Labeling
Enter a text to be displayed, for example the type of the controlled value at the slider. As a
standard, you must enter the label "SIMATIC".

Minimum value
Enter the lower limit value of the measuring range. This value is shown as the min. scale value
of the slider control.

Maximum value
Enter the upper limit value of the measuring range. This value is shown as the max. scale
value of the slider control.

Value
Specify a start value for the position of the slider gauge. If the Process Driver Connection is
missing, the slider is displayed at this position in Runtime.

See also
The "WinCC Slider" Control (Page 414)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Colors of the Slider Control (Page 420)
How to Change the Fonts of the Slider Control (Page 419)
How to Change the 3D Effects of the Slider Control (Page 418)
How to Change the Appearance of the Slider Control (Page 415)
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How to Change the 3D Effects of the Slider Control
Introduction
On the "3D Effects" tab, you can choose the style and width for the 3D display of borders and
scales.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Select the "3D-Effects" tab.

Style
Select a style for the display of the inner and outer frame as well as the scale.
The border of the Slider Control consists of the three elements outer frame, border and inner
frame. A 3D effect is created by the two-colored display of the outer and inner frames as well
as the tick marks of the scaling.
The styles "Depressed" and "Raised" can be distinguished by the changed alignment of the
two color attributes "Upper Frame color" and "Bottom Frame Color". The "Border" style for the
scale has the effect that the elements are displayed single-colored.

Width
Enter a value for the width of the border elements in pixel(s).

See also
How to Change the Fonts of the Slider Control (Page 419)
The "WinCC Slider" Control (Page 414)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Colors of the Slider Control (Page 420)
How to change the measuring range and the label of the Slider Control (Page 416)
How to Change the Appearance of the Slider Control (Page 415)
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How to Change the Fonts of the Slider Control
Introduction
You can use the tab "Font" to adapt the fonts for the different labeling elements of the Slider
Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Select the "Font" tab.

Changing Configuration

Properties
Select the font attribute you wish to change.
With the "Position font" option, you can change the display of the value, which is displayed by
the current position of the slider. A change of the attribute "Font" affects the labeling of the
control and the scale.

Font
Select from the drop-down list box the desired font for the selected labeling attribute. You can
use any of the fonts registered in the operating system.

Font size
Select from the drop-down list box the desired font size for the selected labeling attribute.
Alternatively, enter the font size directly in the field. The value is specified in points (pt).

Display
Select one or more display options.
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.
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See also
How to Change the Appearance of the Slider Control (Page 415)
The "WinCC Slider" Control (Page 414)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Colors of the Slider Control (Page 420)
How to Change the 3D Effects of the Slider Control (Page 418)
How to change the measuring range and the label of the Slider Control (Page 416)

How to Change the Colors of the Slider Control
Introduction
You can use the "Color" tab to adapt the color for the display of the Slider Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Select the "Color" tab.

Properties
Select the color attribute you wish to change.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in
the "Color Palette" section.
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The "Standard Colors" color group contains the 16 standard colors of the operating system.
The "Windows System Colors" color group contains the colors which are set in the operating
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color
attribute.

Editing Custom Colors
Click this button to access the "Colors" dialog. Depending on the graphic settings of the
operating system you can define the desired color freely.

See also
The "WinCC Slider" Control (Page 414)
How to Assign Pictures to the Slider Control (Page 421)
How to Change the Fonts of the Slider Control (Page 419)
How to Change the 3D Effects of the Slider Control (Page 418)
How to change the measuring range and the label of the Slider Control (Page 416)
How to Change the Appearance of the Slider Control (Page 415)

How to Assign Pictures to the Slider Control
Introduction
On the "Picture" tab, you can assign pictures to the Slider Control for the display of the
background and the slider.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.
● Select the "Picture" tab.

Changing Configuration
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Properties
Select the property for which you want to change the picture assignment. The current picture
is shown in the "Preview" area.
With the "Background picture" option, you can assign an image to the background of the
Control. With "Slider picture", you have the option to display an image on the slider.

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which
you want to assign the selected property.
Pictures in the following formats can be inserted:
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

Deleting
Click the "Clear" button to move on from the opening picture.

See also
The "WinCC Slider" Control (Page 414)
How to Change the Colors of the Slider Control (Page 420)
How to Change the Fonts of the Slider Control (Page 419)
How to Change the 3D Effects of the Slider Control (Page 418)
How to change the measuring range and the label of the Slider Control (Page 416)
How to Change the Appearance of the Slider Control (Page 415)

3.7.11.11 WinCC UserArchiveControl
Overview
The WinCC UserArchiveControl provides options to access user archives and views of the
user archives in Runtime. You have many options of configuring the representation of the
table.
For more information refer to WinCC UserArchiveControl (Page 1720).

3.7.11.12 WinCC WebBrowser Control
Overview
The WinCC WebBrowser Control displays static Web contents or CHM documents in process
pictures.
Contents with scripting functionality are not supported.
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You may disable the right mouse button in the WinCC WebBrowser as follows to prevent the
WinCC client from accessing the shortcut menu: Use the Microsoft "Group Policy Object Editor"
(Gpedit.msc) to set the shortcut menu to "Disabled" in "\Windows Components\Internet
Explorer\Browser menus".

3.7.12

.NET controls

Introduction
The .NET Framework 2.0 and 3.0 from Microsoft is installed together with WinCC. This makes
it possible for you to integrate .NET applications (assemblies) as controls in your pictures. This
is what the container for the .NET controls is used for.
Note
The user of the software is responsible for problems caused by the deployment of external
controls.
We recommend testing for safe operation before implementation.

Inserting a .NET control
You insert a .NET control from the "Standard" selection window into a process picture. You
can insert the control as a smart object or from the "Controls" tab.
● When inserting the control as a smart object, select the required control in the "Insert a
Control" dialog. All the controls which were configured for selection are displayed here.
After selecting the control, define the type.
At the end of the insertion process a configuration dialog is usually opened, in which you
adapt the properties of the control. You can also open this dialog later by double-clicking
the control.
● When you insert the control from the "Controls" tab, only the controls which you added to
the "Controls" tab are available. Click the required control and draw a rectangular in the
picture for the control. Then define the type.
Configure the control selection with the "Add .NET Object" dialog.
Note
For multi-user projects, the ".Net Control" must be saved locally on each client. You have
saved a ".Net Control" on the server under "C:\Controls" and added a ".Net Control" to the
project. Then you have to save the ".Net Control" to the associated clients under "C:\Controls"
or under "C:\Program Files\Common Files\Siemens\Assemblies". Create the "Assemblies"
folder.

See also
How to configure the control selection (Page 377)
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3.7.13

WPF controls

Introduction
Together with WinCC, the Microsoft .NET Framework 3.0 is also installed. This enables you
to integrate .WPF files as controls in your pictures. This is what the container for the WPF
(Windows Presentation Foundation) controls is used for.
Note
The user of the software is responsible for problems caused by the deployment of external
controls.
We recommend testing for safe operation before implementation.

Inserting a .WPF control
You insert a WPF control from the "Standard" selection window into a process picture. You
can insert the control as a smart object or from the "Controls" tab.
● When inserting the control as a smart object, select the required control in the "Insert a
Control" dialog. All the controls which were configured for selection are displayed here.
Then define the type.
At the end of the insertion process a configuration dialog is usually opened, in which you
adapt the properties of the control.. You can also open this dialog later by double-clicking
the control.
● When you insert the control from the "Controls" tab, only the controls which you added to
the "Controls" tab are available. Click the required control and draw a rectangular in the
picture for the control. Then define the type.
Configure the control selection in the Object Palette with the "Add WPF Object" dialog.
Note
Some inserted WPF controls only work properly when the associated .dll files are in the
"assemblies" folder. The storage location, e.g."C:\Program Files\Common Files\Siemens
\assemblies", depends on the WinCC installation path and the operating system.

See also
How to configure the control selection (Page 377)
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3.8

Working with Objects

3.8.1

Working with Objects

Introduction
You will find the following information in this chapter:
● The basic functions of the Graphics Designer for working with objects
● The features of the individual objects
● How to use objects to create process pictures
● How to specifically change object properties

Objects in Graphics Designer
"Objects" in the Graphics Designer are the predefined graphic elements that enable efficient
creation of process pictures. You can easily insert all objects into a picture from the "Standard"
selection window. The objects are made available in four object groups:
Standard objects

Smart objects

Windows objects

Tube objects

Line
polygon
polygon line
ellipse
circle
ellipse segment
circle segment
ellipse arc
circle arc
rectangle
rounded rectangle
static text
connector

Application window
Picture window
Control
OLE object
I/O Field
Bar
Graphic object
Status display
Text list
Multi-line text
Combo box
List box
Faceplate instance
.NET control
WPF control
3D bar
Group display
Status display (Extended)
Analog display (Extended)
DataSet

Button
Check box
Radio box
Round button
Slider object

Polygon tube
T-piece
Double T-piece
Tube bend
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Combined Objects
You can combine the objects with one another by creating a "Group" or a "Faceplate type"
from a multiple selection.
● You can prepare a Faceplate type can for reuse as a Faceplate instance in other process
pictures or projects.
● You can insert a group into the project library and prepare it as a "Library object" for reusing
in other process pictures or projects.
Note
Line display when zooming in "WinCC Classic" design
If you have set the "WinCC Classic" design, all occurrences of a dashed line with a line
thickness of "1" are shown as a solid in the Graphics Designer when zooming over 100%.
This effect is dictated by the graphics system of Microsoft. The effect does not occur if the
line thickness is greater than "1" or the zoom is less than 100% or if another design is defined.

See also
How to change the default setting of object types (Page 426)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Combined Objects (Page 653)
Working with Controls (Page 368)

3.8.2

How to change the default setting of object types

Introduction
In the Graphics Designer, the various object types have default properties. If an object is
inserted in a picture, the object adopts these default settings.
You can adapt default settings for individual object types to your requirements. We recommend
that you make predefined settings for objects with multiple application before creating a
process picture. This is how to limit the scope for later adaptation.
There is an extensive description on backing up default settings in the chapter The" Graphics
Designer Basic Settings".
This section shows the general procedure to view the default setting for the object types.
Changing the default properties is based on changing the individual attributes of an object.
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There is an extensive description on changing attributes can be found in the chapter "The
Properties of an Object".
Note
You can also define the design and colors of object types for an entire project. More
information on this is found under "Global object design" and "How to change the color
scheme of an object type".
Note
The default setting for the object types applies across the project. The changed default
settings only apply to the pictures of the currently opened WinCC project. The basic settings
of the Graphics Designer are not changed here.

Requirements
● A picture must be opened. This picture can also be empty.

Procedure
1. Right-click in the "Standard" selection window on the object type whose default settings
you want to change.
2. Choose the "Properties" option from the shortcut menu.
The "Object properties" window opens. The name if the object type with the additional
"Default" is displayed toolbar of this window.
3. Select the property group in the "Properties" tab that contains the attribute you want to
change.
Changing attributes in described extensively in the section "Change attribute".

See also
How to Change an Attribute (Page 476)
Managing the default settings of objects (Page 317)
The "Object Properties" Window (Page 471)
Controls (Page 295)
Elements and Basic Settings of the Graphics Designer (Page 277)
Working with Objects (Page 425)
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3.8.3

Basic Static Operations

3.8.3.1

Basic Static Operations

Introduction
To create a process picture, the required objects must first be inserted from the "Standard"
selection window of the Graphics Designer into a picture. These objects are then dynamically
linked suitably to a process to use the process picture to control and monitor processes.
This chapter introduces the basic static operations with which objects are inserted and
arranged in the picture.

See also
How to position objects (Page 437)
Working with Objects (Page 425)
Basic Dynamic Operations (Page 454)
You can change the text contents of objects (Page 452)
You can link the tag connection of objects (Page 465)
How to change the position of an object (Page 450)
How to duplicate objects (Page 449)
How to insert the contents of the clipboard (Page 448)
How to copy objects (Page 447)
How to cut objects (Page 446)
How to delete objects (Page 445)
How to rotate the objects (Page 443)
How to mirror the objects (Page 442)
How to scale an object (Page 440)
How to Align Multiple Objects (Page 439)
How to Select Multiple Objects (Page 435)
Multiple Selection of Objects (Page 433)
How to select an object (Page 432)
How to Rename Objects (Page 430)
How to insert an object into a picture (Page 429)
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3.8.3.2

How to insert an object into a picture

Introduction
You insert the objects that map a process or a subprocess in a process picture in the Graphics
Designer into a picture from the "Standard" selection window.

In the Graphics Designer, the various object types have default properties. When they are
inserted the objects import these default properties (except for individual geometric properties).
After insertion the properties of an object can be modified. In the same way the default settings
for the object types can be modified as required.
When inserting an object, an object name is automatically assigned. The name of the object
type is linked with a continuous number as the object name. No special characters are used
in the object name. You change the object name using the "Object Name" attribute.

Requirements
● The display of the "Standard" window must be enabled.

Procedure
The example of the standard object "Rectangle" is used here to show the general procedure
as to how to insert an object in a picture. Some object types require additional steps. You can
learn more about these additional steps in the detailed description of the individual objects.
1. Open the picture into which you want to insert an object.
2. Click the standard object "Rectangle" in the "Standard" window.
3. Place the mouse pointer at the position in the picture where you want to insert the rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rectangle to the required size.
As soon as you release the mouse, the rectangle is added.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

429

Creating Process Pictures
3.8 Working with Objects

Alternative operation
Double-click the required object in the "Standard" window. The new object is inserted close to
the picture origin. The properties of the new object correspond to the default settings for the
selected object type.

Inserting an I/O field via tags
Use drag-and-drop to place the required tag from the tag selection dialog in the process picture.
The Graphics Designer creates an I/O field with this tag connection.

See also
How to Rename Objects (Page 430)
How to select an object (Page 432)
How to position objects (Page 437)
How to scale an object (Page 440)
How to delete objects (Page 445)
How to copy objects (Page 447)
How to copy objects to another picture (Page 342)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Rectangle Surrounding the Object (Page 281)
Controls (Page 295)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.3

How to Rename Objects

Introduction
The "Object Name" attribute specifies the name of an object in the picture. The object name
is unique within a picture. The name of the object is used for example in configuring C actions
to call the object.
When an object is inserted, the object name assigned as standard is the description of the
object type with a consecutive number. This name can be changed using the "Object Name"
attribute.
Note
Avoid special characters in object names of these object names are used in scripts.
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Requirements
● Select an object of any type.

Procedure
1. Open the "Object Properties" window.
2. On the "Properties" tab select the entry for the selected object type to which the property
groups of the object are subordinate.
3. Double-click the "Object name" attribute.
The "Text entry" dialog will open.
4. Enter the new name.
5. Click "OK" to confirm your entries.

See also
How to insert an object into a picture (Page 429)
How to select an object (Page 432)
Illegal Characters (Page 191)
Controls (Page 295)
Basic Static Operations (Page 428)
Working with Objects (Page 425)
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3.8.3.4

How to select an object

Introduction
To change the properties of an object, you have to select the object.

Requirements
● The active picture must contain at least one object.

Procedure
1. Position the cursor on the required object.
2. Click the object.
The mouse pointer changes to a crosshair with arrow points.
The handles of the rectangle surrounding the object appear.

Alternative procedure
1. Open the "Object Properties" window.
2. On the toolbar of the window, open the drop-down list field to select the object.
3. Select the required object.
The handles of the object are displayed.

See also
How to select an object (Page 432)
How to Select Multiple Objects (Page 435)
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Multiple Selection of Objects (Page 433)
The Rectangle Surrounding the Object (Page 281)
Controls (Page 295)
The "Object Properties" Window (Page 471)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.5

Multiple Selection of Objects

Introduction
In order to change the properties of several objects at the same time, you must select all desired
objects. You do this using "Multiple selection".
All attributes of the selected objects are shown in the "Object properties" window for a multiple
selection. For an attribute however, a value is only displayed if it is the same for all selected
objects that have this attribute.
Along with "selection borders" and the "reference object", a multiple selection has two
characteristics which play an important role, for example for the common alignment of the
selected objects. These characteristics are however not visible in the Graphics Designer.
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Selection Frame of a Multiple Selection
The selection border encloses all objects in a multiple selection, comparable to the rectangle
surrounding individual objects. The selection border is known as a lasso.

The position and size of the selection border are dependent on the position of the selected
object. The midpoint of the selection border corresponds to the common midpoint of the
selected objects. The limit line of the selection border touches the outer edges of those objects
which have the greatest distance from the common midpoint.
The selection border is not visible. After finishing the multiple selection, only the handles of
the individual objects will be shown.

Reference object of a multiple selection
One of the selected objects has to be used as a reference object for aligning objects of the
multiple selection: For example, if the "Same width" function is selected in the Alignment
palette, then all selected objects will be set to the same width as the respective reference
object.
The object to be used as a reference object depends on the type of multiple selection and on
the function selected in the alignment palette:
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Selection type

Selection borders

<Shift> + left mouse button

<Ctrl + A>

Function

Reference object is:

Reference object is:

Reference object is:

Aligning

the outermost object

the object selected first

the reference object that is used
until the selection;
otherwise the outermost object

Center

the common center axis of the selected object

Distribute

No reference object

Match width or
height

the object with the greatest
width or height

Match width and
height

the first configured, therefore the oldest object in the multiple selection

the object selected first

the reference object used until the
selection;
otherwise the object with the
greatest width or height

See also
How to Select Multiple Objects (Page 435)
How to Align Multiple Objects (Page 439)
Working with Combined Objects (Page 653)
Alignment palette (Page 286)
The Rectangle Surrounding the Object (Page 281)

3.8.3.6

How to Select Multiple Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed
must be selected. You do this using "Multiple selection". In the Graphics Designer, you can
make the multiple selection of objects using the following procedures:
● multiple selection by clicking with the pressed <Shift> key
● multiple selection by dragging a selection border with the mouse
● multiple selection with key combination <Ctrl+A>
Note
With each of these three procedures, you can remove an object that was selected in the
multiple selection by mistake by clicking on it with the <Shift> key pressed.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

435

Creating Process Pictures
3.8 Working with Objects

Prerequisites
● The active picture contains at least two objects.

Multiple selection with <Shift> and click
1. Hold down <SHIFT>.
2. Click the relevant objects, working in succession.
The handles of the rectangle surrounding the object appear for every selected object.
The mouse pointer will change to a crosshair with arrow points when it is positioned over
a selected object.

Multiple selection with the mouse
You can also make a multiple selection with the mouse only. This is done by dragging a
selection border around the desired objects with the mouse. The result depends on the setting
for the type of object selection:
● "Surrounding object selection"
All objects inside the displayed frame are selected.
● "Touching object selection"
All objects touched by the frame will be selected, in addition to those inside of it.
The procedure described here is for the "surrounding object selection" type.
1. Position the cursor on the picture close to one of the required objects.
2. Hold down the mouse button and drag a frame around the objects you want.
As soon as you release the mouse button, the selection marks for the rectangles
surrounding the objects will be shown for every selected object.

Multiple selection with <Ctrl+A>
1. Select one or more objects.
2. Press <Ctrl+A>.
– If no object was selected, all objects of the picture are selected.
– If at least one object was selected, all objects of the same type are selected like the
selected objects.
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Reference object
The object to be used as a reference object depends on the type of selection and on the function
selected in the alignment palette:
Selection type

Selection borders

<Shift> + click

<Ctrl + A>

Function

Reference object is:

Reference object is:

Reference object is:

Aligning

the outermost object

the object selected first

the reference object that is
used until the selection;
otherwise the outermost
object

Center

the common center axis of the selected object

Distribute

No reference object

Match width or height

the object with the greatest
width or height

Match width and height

the first configured, therefore the oldest object in the multiple selection

the object selected first

the reference object used
until the selection;
otherwise the object with the
greatest width or height

See also
Alignment palette (Page 286)
How to select an object (Page 432)
The Rectangle Surrounding the Object (Page 281)
Multiple Selection of Objects (Page 433)

3.8.3.7

How to position objects

Introduction
The position of an object is defined by the coordinates of the object origin. The left upper corner
of the rectangle surrounding the control is called the object origin.
You can position objects by:

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

437

Creating Process Pictures
3.8 Working with Objects
● dragging the object to a new position
● moving the selected object with the aid of the arrow keys for cursor control
● Changing the "Position X" and "Position Y attributes"

Multiple selection
You can move several selected objects at the same time.

Requirements
● Select an object of any type.

Procedure
1. Position the mouse pointer over the selected object.
The mouse pointer changes to a crosshair with arrow points.
2. Click the object and hold the left mouse button.
The cursor changes into an arrow with an outline icon (small rectangle with broken line).
3. Move the mouse pointer.
The rectangle surrounding the object is displayed as broken and shows a possible new
position for the object.
The object itself initially keeps its original position.
4. Release the mouse button.
The object is moved to the position previously displayed by the broken line of the rectangle
surrounding the object.
The mouse pointer turns into crosshairs with arrow points.
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Alternative operation
Move the selected object using the arrow keys for cursor control or change the value for the
geometric "Position X" and "Position Y" attributes in the "Object Properties" window.
Note
In the settings of the Graphics Designer if the "Snap to grid" function is activated, the object
can only be positioned with the mouse according to the settings for the grid.

See also
The Rectangle Surrounding the Object (Page 281)
Working with Objects (Page 425)
Basic Static Operations (Page 428)
The Coordinate System of an Object (Page 279)
The Coordinate System of a Process Picture (Page 277)
How to Set the Grid (Page 307)
How to position objects (Page 437)
How to select an object (Page 432)

3.8.3.8

How to Align Multiple Objects

Introduction
You can arrange the objects of a multiple selection together in the picture by using the functions
of the alignment palette. A detailed description of these functions can be found in the section
"Alignment palette".

Align
The selected objects are aligned on the border line of the selection frame (up, down, left, right).
Center
The selected objects are centered on a middle axis of the selection frame (horizontally,
vertically).
Distribute
The selected objects are distributed evenly across the height or width of the selection frame
(horizontally, vertically).
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Match
The size of the reference object is assigned to the selected objects (height, width or height
and width).

Requirements
● Select at least two objects of any type.

Procedure
In the "Alignment Palette" click the required icon or in the "Arrange > Align" menu select the
required entry.
The alignment or the size of the selected objects is changed.

See also
How to position objects (Page 437)
How to Select Multiple Objects (Page 435)
Alignment palette (Page 286)
Multiple Selection of Objects (Page 433)
The Coordinate System of a Process Picture (Page 277)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.9

How to scale an object

Introduction
The size of an object is defined by the geometry of the rectangle surrounding the object. The
rectangle surrounding the object is symbolized when selecting an object by showing the
selection markers.
You can scale objects by:
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● dragging the handle to a new position
● changing the values of the "Width" and "Height" attributes

Multiple selection
You cannot scale several selected objects simultaneously using the mouse. To do this, the
objects must be grouped.

Requirements
● Select an object of any type.

Procedure
1. Position the mouse pointer over a handle of the selected object.
The mouse pointer changes into a double arrow. The alignment of the double arrow
indicates the directions in which you can move the handle:
– "Horizontal double arrow"
The width of the object can be changed using the handles on the horizontal center axis.
– "Vertical double arrow"
The handles on the vertical center axis can be used to change the height of the object.
– "Diagonal double arrow"
The handles on the corners of the object can be used to change the height and width
of the object.
2. Use the mouse to drag the handle to the position you want.
If the "Snap to grid" function is activated in the settings of the Graphics Designer, the object
can only be scaled with the mouse according to the settings for the grid.
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Alternative operation
Change the values for the geometric "Width" and "Height" attributes in the "Object Properties"
window.

See also
How to select an object (Page 432)
How to position objects (Page 437)
How to Set the Grid (Page 307)
The Rectangle Surrounding the Object (Page 281)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.10

How to mirror the objects

Introduction
You can mirror objects on their horizontal or vertical center axis. The mirroring of an object
can cause its geometric attributes to change. Mirroring can also change the alignment of
elements contained in the object such as text or check boxes.
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Multiple selection
You can mirror several selected objects at the same time. The mirroring occurs on the
horizontal or vertical middle axis of the individual objects.

Requirements
● Select any type of object except circle, application window, picture window, Control, OLE
object, status display, 3D bar, group display and round button.

Procedure
In the standard palette click the toolbar button
●

to mirror the selected object on its horizontal center axis

●

to mirror the selected object on its vertical center axis

Alternatively you can use the entries "Horizontal" and "Vertical" on the "Arrange / Mirror" menu.

See also
How to select an object (Page 432)
How to rotate the objects (Page 443)
Multiple Selection of Objects (Page 433)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Rectangle Surrounding the Object (Page 281)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.11

How to rotate the objects

Introduction
You can rotate objects around their center point. The rotation is clockwise and in steps of 90
degrees.
The rotation of an object can cause its geometric attributes to change. Rotation can also
change the alignment of elements in an object such as a text.
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Multiple selection
You can rotate several selected objects at the same time. The objects are each rotated around
their center point.

Requirements
● Select any type of object except circle, application window, picture window, Control, OLE
object, status display, 3D bar, group display and round button.

Procedure
In the standard palette, click
90 degrees.

to rotate the object clockwise around its center axis. It rotates

Alternatively, you can select the "Rotate entry" in the "Arrange "menu.

See also
Working with Objects (Page 425)
Basic Static Operations (Page 428)
The Rectangle Surrounding the Object (Page 281)
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The Coordinate System of an Object (Page 279)
The Coordinate System of a Process Picture (Page 277)
Multiple Selection of Objects (Page 433)
How to mirror the objects (Page 442)
How to select an object (Page 432)

3.8.3.12

How to delete objects

Introduction
The "Delete" command removes a selected object from a picture.
Multiple selection
You can delete several selected objects at the same time.

Requirements
● Select an object of any type.

Procedure
Press <DEL> to remove the selected object from the picture.
Alternatively you can use the "Delete" entry on the popup menu or on the "Edit" menu.
Note
You can easily correct operating steps unintentionally carried out:
in the standard palette to undo the last executed action. You can undo the last 30
Click
editing steps by repeatedly clicking this button.
Use

in the standard palette to redo the last executed action.

See also
How to cut objects (Page 446)
How to copy objects (Page 447)
How to insert the contents of the clipboard (Page 448)
How to duplicate objects (Page 449)
How to insert an object into a picture (Page 429)
How to select an object (Page 432)
How to Select Multiple Objects (Page 435)
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Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.3.13

How to cut objects

Introduction
The "Cut command" copies a selected object into the clipboard of the operating system. The
object itself is removed from the picture.
Multiple selection
You can cut out several selected objects at the same time.

Requirements
● Select an object of any type.

Procedure
Use the key combination <CTRL+X> to remove the selected object from the picture and copy
it to the clipboard.
Alternatively, you can click
menu or in the "Edit" menu.

in the standard palette or use the "Cut" command in the context

Note
You can easily correct operating steps unintentionally carried out:
Click
in the standard palette to undo the last executed action. You can undo the last 30
editing steps by repeatedly clicking this button.
Use

in the standard palette to redo the last executed action.

See also
Working with Objects (Page 425)
Basic Static Operations (Page 428)
How to Select Multiple Objects (Page 435)
How to select an object (Page 432)
How to insert an object into a picture (Page 429)
How to duplicate objects (Page 449)
How to insert the contents of the clipboard (Page 448)
How to copy objects (Page 447)
How to delete objects (Page 445)
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3.8.3.14

How to copy objects

Introduction
The "Copy command" copies a selected object into the clipboard of the operating system. The
advantage of copying to the clipboard is that you can insert the object several times, even into
different pictures.
Multiple selection
You can copy several selected objects at the same time.
Note
When inserting a copied object, an object name is automatically assigned. The name of the
original object is used as object name and linked with a continuous number. No special
characters are used in the object name. You change the object name using the "Object Name"
attribute.

Requirements
● Select an object of any type.

Procedure
Use the shortcut <CTRL+C> to copy the selected object to the clipboard.
Alternatively, you can click
in the standard palette or use the "Copy" command in the context
menu or in the "Edit" menu.

See also
Working with Objects (Page 425)
How to copy objects to another picture (Page 342)
Basic Static Operations (Page 428)
How to Select Multiple Objects (Page 435)
How to select an object (Page 432)
How to insert the contents of the clipboard (Page 448)
How to cut objects (Page 446)
How to Rename Objects (Page 430)
How to duplicate objects (Page 449)
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3.8.3.15

How to insert the contents of the clipboard

Introduction
You can use the "Paste" command to insert the current contents of the clipboard into the active
picture as often as required. If an object was copied to the clipboard, for example, you can
insert any number of copies of the object into different pictures using this command.

Requirements
● The clipboard must have contents.

Procedure
1. Press the shortcut <CTRL+V>.
The current contents of the clipboard are inserted into the active picture and selected.
2. Repeat this step to insert further copies of the contents.
in the standard palette or use the "Paste" command in the
Alternatively, you can click
context menu or in the "Edit" menu.
Note
Objects from other applications can also be inserted via the clipboard of the operating system.
Position X and Position Y of the inserted object are each 20 pixels higher than Position X and
Y of the original object.
The inserted object receives the object name of the original object but is supplemented by a
continuous number.

See also
How to copy objects (Page 447)
How to duplicate objects (Page 449)
How to cut objects (Page 446)
How to delete objects (Page 445)
How to select an object (Page 432)
How to Select Multiple Objects (Page 435)
Basic Static Operations (Page 428)
Working with Objects (Page 425)
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3.8.3.16

How to duplicate objects

Introduction
Use the "Duplicate" command to make a copy of the selected objects directly in the active
picture. The object itself is not modified. The selected object is not copied to the operating
system clipboard.
Multiple selection
You can duplicate several selected objects at the same time.

Requirements
● Select an object of any type.

Procedure
Select "Duplicate" on the popup menu or on the "Edit" menu to make a copy of the selected
object directly in the active picture.
Note
Position X and Position Y of the inserted duplicate are each 20 pixel greater than Position X
and Y of the original object.
The duplicated object receives the object name of the original object but is supplemented by
a continuous number.

See also
How to copy objects (Page 447)
How to cut objects (Page 446)
How to insert the contents of the clipboard (Page 448)
How to delete objects (Page 445)
How to select an object (Page 432)
How to Select Multiple Objects (Page 435)
Basic Static Operations (Page 428)
Working with Objects (Page 425)
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3.8.3.17

How to change the position of an object

Introduction
In the Graphics Designer, a picture consists of 32 layers in which the objects can be inserted.
By default the objects are inserted in the level predefined for the respective object type.
The position of the objects to one another can however also be changed within a level. This
is important for example if several objects overlap and thereby over each other.

When creating a process picture the objects of a level are by default arranged in the order in
which they were configured. The object inserted first lies at the very back of the level, each
additional object is inserted one position toward the front.
Multiple selection
You can change the position of multiple selected objects simultaneously.
The modification always applies to the reference object relative to the position of the unselected
objects. An individual position behind the reference object is assigned to each selected object.
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Requirements
● The active picture should contain at least two objects of any type which partially overlap.
● Both objects must be on the same level.
● Select one of these objects.

Procedure
Use one of the following shortcuts to change the position of the selected object:
● <CTRL> and <+> = "All the way to the front"
The selected object is positioned in front of all the other objects contained in the picture.
● <CTRL> and <-> = "All the way to the back"
The selected object is positioned behind all the other objects contained in the picture.
● <+> = "one to the front"
The selected object moves up one position to the front.
● <-> = "one to the back"
The selected object moves back one position.

Alternative operation
● Select the required entry on the "Arrange / Within the Level" menu to change the position
of the selected object.
● In the object palette, click
In the object palette, click

to position the selected object in the very front.
to position the selected object in the very back.

Note
Some objects of the "Control" type generally are in the foreground.

See also
Working with Objects (Page 425)
Basic Static Operations (Page 428)
Working with Layers (Page 334)
Layer palette (Page 287)
How to change the default setting of object types (Page 426)
How to Select Multiple Objects (Page 435)
How to select an object (Page 432)
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3.8.3.18

You can change the text contents of objects

Introduction
The "Linking" command is used to reconfigure the text contents of attributes for all selected
objects. All configured texts are listed in a dialog and can be edited directly or using the "Find"
and "Replace" functions.

Open the "Find and Replace Texts" dialog.
Select all the objects whose text contents you want to change. If you do not select an object,
all the objects in the active picture are evaluated.
In the "Edit" menu select "Linking / Text" or from the popup menu of the selection or of the
active picture.
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Sort text contents
The three-columned upper area of the dialog lists the texts configured in the objects selection
and the associated attributes and objects.
Click the column name to sort the list according to texts, properties or objects.

Directly edit text contents
1. In the "Text" column, select the text contents to be changed.
2. Click the text once to activate the edit function.
3. Enter the new text contents and confirm this by pressing <ENTER>.

Find
You can select certain text contents using the "Find" function in the lower area of the dialog:
● Click "Select All" if you want to change the text contents displayed.
● Enter the text or parts of text you want to search for in the search field. You can also activate
the options "Find whole words only" and "Match case". All text contents which so not meet
the search criteria are hidden.

Replace
You can replace the selected text contents using the "Replace" function in the lower area of
the dialog. Enter the new text in the field and click "Replace".
Note
The "Replace" function replaces only the part of the text contents displayed in the "Find" field.
Note
Grouped objects can only be linked if there are no grouped objects in the group itself.

See also
You can link the tag connection of objects (Page 465)
How to Select Multiple Objects (Page 435)
Basic Static Operations (Page 428)
Working with Objects (Page 425)
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3.8.4

Basic Dynamic Operations

3.8.4.1

Basic Dynamic Operations

Introduction
To create a process picture, the required objects must first be inserted from the "Standard"
selection window of the Graphics Designer into a picture. These objects are then dynamically
linked suitably to a process to use the process picture to control and monitor processes.
This chapter introduces the basic dynamic operations provided in the Graphics Designer to
make objects dynamic:
● Creating dynamic attributes
● Configuring Events
There is an extensive description of this topic in the chapter "Making Process Pictures
Dynamic".

See also
How to make attributes dynamic (Page 454)
How to configure events (Page 456)
How to configure a dynamic dialog (Page 457)
How to configure a C action (Page 459)
How to configure a VBS action (Page 461)
How to Configure a Tag Connection (Page 463)
You can link the tag connection of objects (Page 465)
How to Configure a Direct Connection (Page 468)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.4.2

How to make attributes dynamic

Introduction
You can make certain attributes dynamic in the "Object properties" dialog on the "Properties"
tab.
By linking the attributes with dynamic dialogs, VBS actions, C actions or tags, the properties
of an object can be dynamically adapted to the requirements of the processes to be displayed.
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Certain attributes cannot be made dynamic because a change has no effect in runtime. These
attributes have no dynamics icon.
Note
As soon as an attribute is defined with a global design, it is static and can no longer be made
dynamic. Pre-defined dynamics have no effect.
The "Dynamic" column of the "Properties" tab displays the type of configured dynamics for the
selected attribute and is marked by one of the following icons:
Dynamics icon

Type of dynamics

White bulb

No dynamics

Green bulb

Dynamics with a tag

Red lightning

Dynamics via a dynamic dialog

Green lightning with attached abbreviation "VB"

Dynamics with a VBS action

Green lightning with attached abbreviation "C"

Dynamics with a C action

Yellow lightning with attached abbreviation "C"

Dynamics with a C action not yet translated

There is an extensive description of this topic in the chapter "Making Process Pictures
Dynamic".

Prerequisites
● You have selected an object

Procedure
1. Open the "Object properties" dialog and select the "Properties" tab.
2. Select the property group containing the attribute to be made dynamic.
3. Right-click the Dynamic icon of the required attribute in the "Dynamics" column.
4. Select the required dynamics type on the popup menu.
The associated dialog box opens.
There is a brief description of the dynamics types in this chapter.

See also
Global Design of the Objects (Page 125)
How to configure a dynamic dialog (Page 457)
How to configure a C action (Page 459)
How to configure a VBS action (Page 461)
How to Configure a Tag Connection (Page 463)
You can link the tag connection of objects (Page 465)
How to configure events (Page 456)
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The "Object Properties" Window (Page 471)
Basic Dynamic Operations (Page 454)
Working with Objects (Page 425)

3.8.4.3

How to configure events

Introduction
The "Event" tag in the "Object Properties" window allows events to be configured.
By linking the events with direct connections, VBS actions or C acions, certain actions can be
triggered in Runtime by the operation of an object.
The "Action" column of the "Event" tab displays the type of configured dynamics for the selected
event and is marked by one of the following icons.

Action icon

Type of dynamics

White lightning

There is no action for the event.

Blue lightning

There is an action via direct connection for the event.

Green lightning with attached abbreviation "VB"

There is a VBS action for the event.

Green lightning with attached abbreviation "C"

There is a C action for the event.

Yellow lightning with attached abbreviation "C"

There is a C action not yet translated for the event.

There are events which cannot be made dynamic because a change in Runtime has no effect.
They have no action icon.
There is an extensive description of this topic in the chapter "Making Process Pictures
Dynamic".

Requirements
● Select an object.

Procedure
1. Open the "Object Properties" window and select the "Event" tab.
2. Select the event group containing the event to be configured.
3. Right-click the action icon of the required event in the Action column.
4. Select the required dynamics type on the pop-up menu.
The associated dialog opens.
There is a brief description of the dynamics types in this chapter.
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See also
How to configure a C action (Page 459)
How to configure a VBS action (Page 461)
How to Configure a Direct Connection (Page 468)
How to make attributes dynamic (Page 454)
The "Object Properties" Window (Page 471)
Basic Dynamic Operations (Page 454)
Working with Objects (Page 425)

3.8.4.4

How to configure a dynamic dialog

Introduction
A dynamic dialog is used to achieve high Runtime performance when making attributes
dynamic. A C action is automatically generated from the dynamic dialog. This can however be
extended later. The advantage of higher Runtime performance is then lost.
A dynamic dialog is created with the "Value range" dialog which is described briefly here. More
detailed information on this topic can be found under "Dynamics with the Dynamic dialog".
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Opening the "Value range" dialog
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics column, "select
the "Dynamic Dialog" Box entry from the popup menu of the attribute to be made dynamic.

Event Name
The "Event Name" field displays the name of the selected trigger event which defines the
update cycle for the value to be calculated.
The trigger event is configured using the "Change trigger" dialog. You can configure or rename
the "Tag", "Default cycle", "Picture cycle" and "Window cycle" events in this dialog.
Click the button

to open the "Change trigger" dialog.

Expression/Formula
Specify the formula with which the new value of the attribute should be calculated in Runtime.
Click the button
in order to create the formula from the configured tags, global script
functions and operators. Click "Check" to check the formula for errors.
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Result of the Expression/Formula
This field displays the calculated value or value range. The evaluation of the event depends
on the set data type.

Data type
Select the data type for the evaluation of the event. The options "Analog", "Bool", "Bit" and
"Direct are available".

Evaluate tag status
Activate this check box to view the current values of the tags in the formula.

Evaluate quality code
Activate this check box to monitor the quality code of a WinCC tag in Runtime.

See also
Dynamizing Using the Dynamic Dialog (Page 1042)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Creating Expressions (Page 1045)
Defining a Valid Range (Page 1049)
Monitoring Tag Status (Page 1053)
Monitoring Quality Code (Page 1054)

3.8.4.5

How to configure a C action

Introduction
You can use a C action to make attributes and events dynamic. The powerful script language
ANSI-C opens almost endless options for dynamics. However, the Runtime performance
achieved is lower than with other dynamic types. Therefore, before using a C action check
whether the required dynamics can also be implemented with another dynamic type.
A C action is created with the "Edit action" dialog which is briefly described here. More detailed
information on this topic can be found under "Dynamics with a C Action".

Open "Edit action" dialog
Attribute
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select
the "C Action" entry from the popup menu of the attribute to be made dynamic.
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Event
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the "C
Action" entry from the pop-up menu of the event to be made dynamic.

Toolbar
The toolbar of the "Edit action" dialog also contains the following buttons in addition to the
familiar icons:
Icon

Name

Description

Create Action

Checks the program codes of the C action for errors

Tag selection

Selects tags which should be evaluated in the C action

Selection of picture

Selects the picture in PDL format which is to be evaluated in the C action

Import an Action

Imports an existing C action.
C actions are saved in the ACT file format.

Exporting an Action

Exporting the new or modified C action.
C actions are saved in the file format ACT.

Event Name
The "Event Name" field displays the name of the selected trigger event which defines the
update cycle for the value to be calculated.
The trigger event is configured using the "Change trigger" dialog. You can configure or rename
the "Tag", "Default cycle", "Picture cycle" and "Window cycle" events in this dialog.
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Click

to open the "Change trigger" dialog.

Editor window
The editor window shows and edits the program code of the C action. Functions, tags and
pictures can be inserted and modified at the respective current cursor position.

Function selection
The function selection shows the Global Script functions available in the project in the form of
a directory tree. You can use these functions to create the C actions.
Double-click the required function to configure the contained parameters with the Set
"Parameters" dialog. Confirm the new parameters by clicking "OK" to insert the function with
the new values at the position of the cursor in the editor window.

See also
Dynamizing Using C Action (Page 1073)

3.8.4.6

How to configure a VBS action

Introduction
You can use a VBS action to make attributes and events dynamic. The script language of a
VBS action is Visual Basic.
A VBS action is created with the "Edit VBS action" dialog which is briefly described here. More
detailed information on this topic can be found under "Dynamics with a VBS Action".

Open "Edit VBS action" dialog
Attribute
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select
the "VBS Action" entry from the popup menu of the attribute to be made dynamic.
Event
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the
"VBS Action" entry from the pop-up menu of the event to be made dynamic.
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Toolbar
The toolbar of the "Edit VBS action" dialog also contains the buttons described below in addition
to the familiar icons. The composition of the icons on the toolbar varies according to the types
of attribute or event for which a VBS action was configured.
Icon
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Name

Description

Hide declaration section

Hides the declaration section with "Option explicit"

Show declaration section

Shows the declaration section with "Option explicit"

Uncomment

Changes marked program lines into commentary lines

Remove comment

Deletes the commentary marking of a program line

Syntax Check

Checks the program codes of the VBS action for errors

Tag dialog

Selects tag which is evaluated in the VBS action

Tag dialog with extended return parameter

Tag selection in a dialog with extended return parameters

Object selection

Select an object with a property that is evaluated in the VBS
action

Selection of picture

Selects a picture in "PDL" format that is evaluated in the VBS
action
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Event Name
The "Event Name" field displays the name of the selected trigger event that defines the update
cycle for the value to calculate.
The trigger event is configured using the "Change trigger" dialog. You can configure or rename
the "Tag", "Default cycle", "Picture cycle" and "Window cycle" events in this dialog.
Click

to open the "Change trigger" dialog.

Editor window
The editor window shows and edits the program code of the VBS action. Visual Basic modules,
tags and pictures can be inserted and modified at the respective current cursor position.

Module selection
The module selection displays Visual Basic modules already available in the form of a directory
tree. There are three tabs in which "Project modules", "Standard modules" and "Code
templates" are made available. You can use these modules to create the VBS actions.

See also
Activating Project (Page 170)
Dynamizing Using VBS Action (Page 1061)

3.8.4.7

How to Configure a Tag Connection

Introduction
You can make attributes dynamic using a tag connection. Connecting an attribute to a process
tag for example enables the change of the measurement value to be displayed graphically.
All tags available in the project can be selected in the "Tags – Project: ..." dialog that is
described briefly here. More detailed information on the topic can be found under "Making
Dynamic using Tag Connection and "under "Tag Management".

"Tags – Project:" dialog ..." Open
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select
the "Tag" entry from the shortcut menu of the attribute to be made dynamic.
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Filter
If there is a large number of configured tags, the search procedure can take some time. For
instance, for 15,000 tags the search procedure takes about a minute.
By specifying a filter, you can narrow the scope of the search and reduce the duration of the
search procedure. You can achieve a significant increase in efficiency if you configure tags
with the aid of a tag prefix.

Data source
You can use the "Data Source" window to select the tags it is intended to display.

Tag groups
The selected tag group including its sub-folders is displayed in the left-hand area in the form
of a folder tree.
Directories and subdirectories can be opened or closed by clicking on the "+" or "-" icons. The
tags available for the selected entry are shown in the tag display.

Tag display
The right-hand area contains all the tags that are available for the entry. The tag display is
divided into 4 columns showing the tag name, type and parameter, and the point in time at
which the tag was last changed. Tags can be sorted by clicking on the respective column
heading.

Procedure
1. Select the required filter. An asterisk means that no filter is to be used or no filter has been
defined.
2. Select one or more data sources.
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3. Open the desired tag group in the left-hand window area.
4. Select the desired tag from the right-hand window area.
5. Confirm your selection with "OK".
The dialog "Tags - project: ..." closes.
The selected tag is assigned to the selected object and you can continue with the
configuration.

I/O field: Simplified tag connection
Use drag-and-drop to place the required tag from the tag selection dialog in the process picture.
The Graphics Designer creates an I/O field with this tag connection.

See also
Dynamizing by Means of Tag Connection (Page 1033)

3.8.4.8

You can link the tag connection of objects

Introduction
The "Linking" command is used to reconfigure the tag connection for all selected objects. The
tag connections configured for the selection are listed in a dialog and can be linked directly or
with the aid of the "Find" and "Replace" functions.

Open "Linking of the Tag Connection" dialog
Select all the objects whose tag connection contents you want to link.
From the "Edit" menu select "Linking / Tag Connection" or from the popup menu of the selection.
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Linking tags at the places of use

Tag selection
The left area of the "Places of Use" tab shows a list of the tags configured in the object selection.
All objects are assigned to these tags in the form of a folder tree which contains the dynamics
of the respective tag.
Select a tag or object. The detail view shows the current tag connections.
Detail view
The right area of the "Places of Use" tab shows the current tag connections for the selected
tag or object. You can link these tag connections:
Right-click the required tag connection to call the "Linking" command. The "Linking a Tag"
dialog opens.
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Enter the name of the new tag or click the associated button to select a tag.

Linking tags by finding and replacing

Find
The left area of the "Find and Replace" tag shows the names of all tags configured in the object
selection. There are three search options available to select certain tag names:
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● Click "Select All" if you want to link the texts displayed.
● Select a tag name and click the button
, if you only wish to change the connections to
this tag. All remaining tag names are hidden.
● Enter the tag names or parts of names you want to search for in the search field. You can
also activate the options "Find whole words only" and "Match case". All tags which so not
meet the search criteria are hidden.
Replace
In the right area of the "Find and Replace" tab you can enter the name of the new tag with
which the selected tag names should be replaced. Alternatively you can click the associated
button to select the required tag.
Click "Preview" to view and check the planned replacement.
Click "Replace" to link the selected tag connections as in the preview.
Note
The "Replace" function replaces only the part of the tag names contents displayed in the
"Find" text field of the area.
Note
Grouped objects can only be linked if there are no grouped objects in the group itself.

See also
You can change the text contents of objects (Page 452)
How to Configure a Tag Connection (Page 463)
How to Select Multiple Objects (Page 435)
Basic Static Operations (Page 428)
Working with Objects (Page 425)

3.8.4.9

How to Configure a Direct Connection

Introduction
Events can be made dynamic using a direct connection. A direct connection offers the quickest
dynamics in the picture and acheives the hightest Runtime performance. However the direct
connection can only be used within a process picture and only one connection can be created.
A direct connection is created with the "Direct Connection" dialog which is briefly described
here. More detailed information on this topic can be found under "Dynamics with a Direct
Connection".
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Opening the "Direct Connection" dialog
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the
"Direct Connection" entry from the popup menu of the event to be made dynamic.

Source
You can select a constant, object property or a tag as the data source:
Constant
Click the associated buton or select a picture of the PDL format which provides the constant.
Object property
Select the object and an attribute of the object whose value should be used as the data source.
Tag
Click the associated button and select the required tag. Define whether the update of the tags
should be done permanently (directly) or only when called (indirectly).

Objective
You can select "Current window", "Object in Picture" or "Tag" as the target which should take
the value of the data source:
Current window
Select this option if you want to assign the value of the data source to the active picture.
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Object in the picture
Select the object and attribute of this object to which you want to assign the value of the data
source.
Tag
Click the associated button and select the required tag which should take the value of the data
source. Define whether the update of the tags should be done permanently (directly) or only
when called (indirectly). If required, you can activate the output of a operator message.

See also
Dynamizing by Means of Direct Connection (Page 1036)

3.8.5

The Properties of an Object

3.8.5.1

The Properties of an Object

Introduction
Form, appearance and visibility, position and process connection of an object are determined
by the "Object properties". These properties can be changed as required in the Graphics
Designer.
The properties of an object are described by a large number of "attributes". An object property
can be changed by assigning a new value to its attribute.
The "Object Properties" window on the "Properties" tab contains all the attributes of a selected
object or a multiple selection of objects. The attributes are divided into property groups, such
as "geometry" or "Colors". The type and number of the available property groups and attributes
are dependent on the type of the selected objects. So, for example, the "Font" property group
is only shown for the object types which can be displayed with text.
With a multiple selection it is possible that individual property groups for one specific object
type are summarized to a shared property group. All attributes of the summarized property
groups available in this group are contained under the "User defined" label.
As an alternative to changing the attributes in the "Object properties" window, objects can also
be adjusted with the mouse and keyboard or by using the toolbar and palettes. However, in
this way only certain object properties, such as the basic geometric size, color and line style,
can be changed.

See also
Elements and Basic Settings of the Graphics Designer (Page 277)
Working with Objects (Page 425)
Special Runtime Settings (Page 505)
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Property Groups and Attributes (Page 479)
The "Object Properties" Window (Page 471)

3.8.5.2

The "Object Properties" Window

The "Object Properties" Window
Introduction
In the Graphics Designer, the "Object Properties" window represents the central dialog for
changing object properties.
To create process pictures it is firstly important to adapt the static values of attributes to for
example define the shape, appearance, position or operability of an object.
The "Object Properties" window allows process pictures to be made dynamic. You can
dynamically adapt the properties of an object to the requirements of the process to be displayed
by linking the attributes with dynamic dialogs or C actions, for example. You can find a
description of dynamizing in the section "Making Process Pictures Dynamic".
The "Object Properties" window is divided into the "Properties and "Event" tabs:

You can change the position and size of the window freely.
A description of the selected property is available through the "F1" key and the "Direct help"
context menu.

Positioning the "Object Properties" window flexibly

Window docking is a useful tool for the flexible arrangement of the "Object Properties" window:
● Undocking so that the window is displayed permanently in the foreground
● Docking
● Document in tab format
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● Automatically in background
● Hiding

See also
How to Change an Attribute (Page 476)
How to Transfer Object Properties (Page 478)
How to change the default setting of object types (Page 426)
The "Properties" Tab in the "Object Properties" Window (Page 472)
"Events" tab in the "Object Properties" window (Page 474)
The Properties of an Object (Page 470)

The "Properties" Tab in the "Object Properties" Window
Introduction
In the "Object Properties" window, the "Properties" tab represents the central dialog to change
static values of a selected object.

You can change the width of both window areas and the columns in the attribute display by
moving the vertical separation lines.

Properties folder
The left area shows the selected object with its property groups in a directory tree. The selected
object is displayed as a directory.
If you select multiple objects or a user object, this directory only contains the shared property
groups of the individual objects contained therein. For a selected group the common property
groups are listed first followed by the individual objects with their property groups in subfolders.
It is not possible to change the entries in the property directory. You can open and close folders
and subfolders by clicking the "+" or "-" symbols. The attributes available for the selected entry
are shown in the attribute display.
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Attribute display
The right-hand area contains all the attributes that are available for the entry. The attribute
display is divided into five columns that display the static values and the dynamic attributes of
the selected object.
You can edit the displayed values with a double-click or by opening the shortcut menu in the
respective column.
Columns of the attribute display
Column

Function

Description

Attribute

Attribute name

All available attributes of the selected property group are displayed.
The attribute name cannot be changed. You can change the static value of the
attribute by double-clicking the name of the attribute.

Static

Static value of the attribute The current value of the attribute is shown for the selected object. The value is
displayed as a number, text or graphic display, depending on the type of
attribute.
You can change the value or name of the attribute by double-clicking it. For
more information, refer to the section "How to edit an attribute".

Dynamic

Dynamization of attribute

The type of dynamic response is displayed and highlighted by one of the
following icons:
white bulb = no dynamization
green bulb = dynamization with one tag
red lightning flash = dynamization by means of dynamic dialog
green lightning flash = dynamization with C action
yellow lightning flash = dynamics with C action that has not yet been compiled
You can right-click to open a context menu in which you can set the desired
dynamization.
Additional information is available in the section "Making Process Pictures
Dynamic".

Update

Update cycle of the
attribute

The setting for the update cycle is displayed when dynamization of the attribute
is set. You can change the update cycle of the attribute by double-clicking the
value.

Indir.

Indirect attribute
addressing

You can dynamize an attribute directly or indirectly:
Directly: The attribute is dynamized directly with the content of the tag.
Indirectly: The attribute is linked to a tag of the type "String" that references
another tag. The attribute is dynamized with the content of the referenced tag.
You can activate indirect addressing of the attribute by double-clicking the check
box, provided the attribute is dynamized with a tag. Further information can be
found in chapter "Making Process Picture Dynamic".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

473

Creating Process Pictures
3.8 Working with Objects

Font styles to display dynamics and events
Dynamics and events are particularly highlighted with the aid of different font styles. The
following font styles are used:
● bold
Once you have assigned a dynamic response or event to an attribute of the selected object,
this attribute is displayed in bold in the attributes view. The associated property group in
the property folder and the selected object in object selection of the toolbar are also
displayed in bold.
● italics
The target of a direct connection that was configured for an event is displayed in italics in
the attributes view. The target object is also displayed in italics in the object selection of
the toolbar.
● bold and italic
If a selected dynamic object is the target of a direct connection, the attribute in the attributes
view and the object in the object selection are displayed in bold and italics.

See also
How to Change an Attribute (Page 476)
How to Transfer Object Properties (Page 478)
How to change the default setting of object types (Page 426)
"Events" tab in the "Object Properties" window (Page 474)
The "Object Properties" Window (Page 471)

"Events" tab in the "Object Properties" window
Introduction
In the "Object Properties" window the "Event" tab represents the central dialog for configuring
events. Configuring events is described extensively in the chapter "Making Process Pictures
Dynamic".
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You can change the width of both window areas and the columns in the event display by moving
the vertical separation lines.

Event folder
The left area shows the selected object in a directory tree. This directory shows entries such
as "Mouse" or "Keyboard" to configure events for the operation of the entire object.
The "Property Topics" displays all property groups of the selected object. You can also
configure an event for each individual attribute of a property group. If several individual objects
are contained in the selected object, this structure is repeated for each individual object.
It is not possible to change the entries in the event directory. You can open and close folders
and subfolders by clicking the "+" or "-" symbols. The configurable events for the selected entry
are shown in the event display.

Event display
The right-hand area contains all the events that are available for the entry. The event display
is divided into two columns that display the events and the linked actions.
You can change the displayed actions by double-clicking or opening the context menu in the
"Action" column.
Columns of the event display
Column

Function

Description

Execute with

Event type

Displays all events which are available for the selected object and are assigned to the
selected entry.
You cannot change the name of the event. You can change the configured action by
double-clicking the name of the attribute.

Action

Action selection

The action that is executed when the event occurs is displayed. The selected action is
marked by one of the following symbols:
White lightning flash = No action for this event.
Blue lightning flash = One action exists for this event via a direct connection.
Green lightning flash = C action exists for this event.
Yellow lightning flash = C action exists for this event; not yet compiled.
You may change the configured action by double-clicking in the "Execute with" column
or by calling the shortcut menu in the "Action" column. Further information can be found
in chapter "Making Process Picture Dynamic".

Triggering events
Event

Execute with

Description

Mouse

Mouse click

Is triggered if the cursor is on the object when the mouse button is pressed and released.

Mouse

Click left/right

Is triggered when pressing the mouse button directly on the object.

Mouse

Release left/right

Is triggered when releasing the mouse button for the object the cursor was over when
the mouse button was pressed.
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Event

Execute with

Description

Keyboard

Pressing

Is triggered when pressing a key on the keyboard. The keys <F10> and <ALT+PRINT>
must not be used for process operation.

Keyboard

Releasing

Is triggered when releasing a key on the keyboard. The keys <F10> and <ALT+PRINT>
must not be used for process operation.

Focus

Focus change

Occurs during focus reception and focus change, caused by C action, VBS action or
selection of an object using (TAB sequence) or mouse click.

Miscellaneou
s

object change

Occurs if at least one object attribute changes.

Object
attributes

Change

Most of the object attributes have the "Change" event so that it is possible to react
specifically to the change of a specific attribute. The event occurs if the attribute value
changes. The action linked to this event is logged on individually. With "Close Picture",
all actions logged on at this point are logged off individually. This results in an increased
system load. To keep the system load low, use this event type sparingly and only there
where it is absolutely necessary to react to the change. This is the case for example
when inputting a value in the I/O field.

See also
How to Change an Attribute (Page 476)
How to Transfer Object Properties (Page 478)
How to change the default setting of object types (Page 426)
The "Properties" Tab in the "Object Properties" Window (Page 472)
The "Object Properties" Window (Page 471)

How to Change an Attribute
Introduction
The properties of an object are defined in the Graphics Designer with values which the
attributes of the object possess. Every change to an object made with the mouse, for example,
changes the value of the accompanying attributes.
The "Object Properties" window on the "Properties" tab shows all the attributes of a selected
object or a multiple selection of objects. The attributes are assigned to so-called "property
groups". The type and number of the available property groups and attributes are dependent
on the type of the selected objects. So, for example, the "Font" property group is only shown
for the object types which can be displayed with text.
You can change an object property by assigning a new value to its attribute.
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Procedure
1. Open the "Object Properties" window.
2. On the "Properties" tab, select the required property group.
3. Double-click the required attribute.
A dialog to input or select the new value opens or the value is automatically changed by
double-clicking.

Attribute change via the "Value Input" dialog
Enter a new value in the "Value" Input dialog and confirm this by clicking "OK".
Alternatively, you can directly enter the new value by double-clicking on the "Static" column.

Attribute change via the "Text Input" dialog
In the "Text Input" dialog, click the "Text input" field to enter the new text.
For text with multiple lines, you can make a line break with the key combination <SHIFT
+ENTER> or <CTRL+M>. Confirm you entry with "OK".
Alternatively, you can directly enter the new value by double-clicking on the "Static" column.

Attribute change via a switchover
If there are two values available for an attribute, for example the choice between "Yes" and
"No", each double-click causes a switchover between these two values.
Alternatively, you can cause the switchover by double-clicking on the "Static" column.

Attribute change via a selection dialog
Selection in the form of buttons
Click on one of the offered buttons to set the new value.
Alternatively, you can select the new value in the drop-down list after double-clicking the
"Static" column.
Selecting a color
In the selection dialog, select one of the 16 standard colors or open the palette with the
customized colors. In this palette, you can freely define additional colors.
Alternatively, you can select the color selection by double-clicking on the "Static" column.
Selecting a picture
Select a picture from the picture selection or open a selection window using the "Find" button
via which you can add other pictures to the picture selection. Confirm you selection with "OK".
Alternatively, you can directly enter the name of the new picture by double-clicking on the
"Static" column.
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See also
The "Object Properties" Window (Page 471)
The Start Screen of the Graphics Designer (Page 283)
The "Properties" Tab in the "Object Properties" Window (Page 472)
Property Groups and Attributes (Page 479)
How to Transfer Object Properties (Page 478)

How to Transfer Object Properties
Introduction
The properties of an object can be transferred to another object with the "eyedropper". In the
Graphics Designer, you can use the following buttons to transfer object properties:
●

, to copy properties of the selected object

●

, to apply copied properties to a selected object

These buttons are located in the "Object Palette" toolbar. Alternatively, these functions can be
selected via the "Edit / Properties" menu.
With the exception of the user object, you can copy the properties of any object using the
eyedropper. You can also transfer the copied properties to any object such as to a multiple
selection, a group or a user object. The properties are transferred without changing the
geometric attributes of the object. With different object types, only those attributes which both
object types possess are changed.

Procedure
1. Select the object whose properties you want to copy.
in the object palette.
2. Click
The properties of the selected object are copied.
3. Select the object to which you want to assign the copied properties.
in the object palette.
4. Click
The selected object is displayed with the new properties, but without changing its geometric
attributes. With different object types, only those attributes which both object types possess
are changed.

See also
How to Change an Attribute (Page 476)
How to change the default setting of object types (Page 426)
The "Object Properties" Window (Page 471)
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3.8.5.3

Property Groups and Attributes

Property Groups and Attributes
Introduction
On the "Properties" tab of the "Object properties" dialog all property groups are displayed which
are available for the selected object. If you select one of these properties, the associated
attributes for the selected object are listed in the attribute display.
You change the properties of an object by allocating the respective attributes with new values.
If you make an attribute dynamic, it will be changed dynamically in runtime.
Note
As soon as an attribute is defined with a global design, it is static and can no longer be made
dynamic. Pre-defined dynamics have no effect.
This chapter introduces all property groups and the associated attributes. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
An extensive description of the individual attributes can be found in the "Direct help" which can
be called from the pop-up menu of the required attribute.

See also
"Geometry" Property Group (Page 490)
"Colors" Property Group (Page 487)
"Styles" Property Group (Page 500)
"Font" Property Group (Page 495)
"Flashing" Property Group (Page 484)
"Miscellaneous" Property Group (Page 496)
"Filling" Property Group (Page 489)
The "Display" property group (Page 486)
"Picture" Property Group (Page 482)
"Pictures" Property Group (Page 483)
"Status" Property Group (Page 504)
"Axis" Property Group (Page 480)
"Limits" Property Group (Page 492)
"Output / Input" Property Group (Page 481)
"Message Types" Property Group (Page 493)
"Lock" Property Group (Page 500)
"Connected Objects" Property Group (Page 502)
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"Assignment" Property Group (Page 503)
The Properties of an Object (Page 470)
How to Change an Attribute (Page 476)

"Axis" Property Group
Introduction
The "Axis" property group contains attributes which you can use to change the properties of
the bar.

Requirements
The "Axis" property group is only available for the "Bar" object.

Overview
The following table contains all attributes of the "Axis" property group and a brief description
of their function.
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Attribute

Function

Axis Section

Distance between the large tick marks
(difference between two adjacent axis labels)

Alignment

Arrangement of the scale in relation to the bar
(top/bottom or left/right)

Bar Scaling

Type of scale division
(for example, linear or logarithmic)

Label Each

Number of labeled large tick marks
(each, every other, every third, etc.)

Exponent Display

Permits numerical display with exponents

Large Tick Marks

Style for displaying the large tick marks of a scale
(bold or normal)

Length of Large Tick Marks

Length of the large tick marks of a scale. The length of the short tick
marks corresponds to 50% of the value set here.
(Unit: Pixels)

Digits to the Right of the
Decimal Point

Number of digits to the right of the decimal point for displaying numerical
values in the scale

Zero Point

Position of the zero point in relation to the distance of the scale end
values
(Unit: Percentage)

Only Large Tick Marks

Specifies whether only the large tick marks are displayed in the scale
or if the short tick marks are also displayed.

Scale

Permits the display of a scale for displaying the values

Scale Marks

Number of bar segments that are separated by the large tick marks of
the scale

Digits to the Left of the
Decimal Point

Number of digits to the left of the decimal point for displaying numerical
values in the scale
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See also
How to Change an Attribute (Page 476)
How to insert a bar (Page 572)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Output / Input" Property Group
Introduction
The "Output / Input" property group contains attributes with which you can set the properties
of input and output values.

Requirements
The "Output / Input" property group is only available for the following objects: I/O field, text list,
check box and radio box.

Overview
The following table shows all the attributes of the "Output / Input" property group. The function
of an attribute is described briefly and the object types for which the attribute is available are
listed.
Attribute

Function

Object type

Number of visible lines

Defines how many lines the selection list should
contain

Text list

Output Format

Format indication for the display of the output value I/O field

Output value

Default value for the display in Runtime if the
associated tag is not linked or updated

Bit Number

Number of the relevant bit in the output value

Text list

Data Format

Data type of the field contents
(binary, decimal, string, hexadecimal)

I/O field

Input Value

Enables the display of the input value via direction
connection, even after acceptance with "OK".

I/O field

Field Type

Defines the function type of the field

I/O field, text list

List Type

Type of text list
(binary, decimal, bit)

Text list

Clear on Invalid Input

Defines whether the field content is automatically
deleted if input is incorrect

I/O field

Clear on New Input

Defines whether the existing field contents are
deleted when the input field is activated

I/O field

Selected Boxes

Informs the system about which fields are active

Check box

Selected Box

Informs the system about which field is activated

Radio box
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Attribute

Function

Object type

Apply on Exit

Defines whether the specified data are applied on
exiting the field.

I/O field, text list

Apply on Full Input

Defines whether the field is automatically exited
and the data applied simultaneously as soon as
the predefined number of characters have been
entered

I/O field

Hidden Input

Defines whether the input is visible immediately or
replaced by "*"

I/O field

Assignments

Assignment between the output value and the
output value to be actually output

Text list

See also
How to Change an Attribute (Page 476)
How to insert an I/O field (Page 561)
How to add a text list (Page 589)
How to insert a check box (Page 631)
How to insert an radio box (Page 634)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Picture" Property Group
Introduction
The "Picture" property group contains attributes with which you can change the properties of
the picture to be displayed.

Prerequisites
The "Picture" property group is only available for the object "Graphic Object".

Overview
The following table shows all attributes of the "Picture" property group and brief description of
their function.
Attribute

Function

Picture

Picture displayed in the Graphic Object

Picture referenced

Defines whether the picture itself or only a reference to the picture is
incorporated

Picture Transparent Color

Defines which color of the picture is set to "transparent"

Picture Transparent Color On Permits the "Transparent Color function"
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See also
How to Change an Attribute (Page 476)
How to insert a graphic object (Page 579)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Pictures" Property Group
Introduction
The "Pictures" property group contains attributes with which you can change the properties of
the pictures to be displayed for different states.

Prerequisites
The "Pictures" property group is only available for the objects "Button" and "Round Button".

Overview
The following table shows all attributes of the "Pictures" properties group. The functionality of
an attribute is described briefly and assigned to the object types for which the attribute is
available.
Attribute

Function

Object type

Picture Off Referenced

For the "Off" state, defines whether the picture itself or only a
reference to the picture are incorporated

Button, round button

Picture Off Transparent Color For the "Off" state, defines which color of the picture is set to
"Transparent"

Button, round button

Picture Off Transparent
Color On

Permits the "Transparent Color" function for the "Off" state

Button, round button

Picture Deact. Referenced

For the "Deactivated" state, defines whether the picture itself or only Round Button
a reference to the picture are incorporated

Picture Deact. Transparent
Color

For the "Deactivated" state, defines which color of the picture is set
to "Transparent"

Picture Deact. Transparent
Color On

Permits the "Transparent Color" function for the "Deactivated" state Round Button

Picture On Referenced

For the "On" state, defines whether the picture itself or only a
reference to the picture are incorporated

Button, round button

Picture On Transparent Color For the "On" state, defines which color of the picture is set to
"Transparent"

Button, round button

Picture On Transparent
Color On

Permits the "Transparent Color" function for the "On" state

Button, round button

Picture Status Off

Picture displayed for the "Off" state

Button, round button

Picture Status Deactivated

Picture displayed for the "Deactivated" state

Round Button
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Attribute

Function

Object type

Picture Status On

Picture displayed for the "On" state

Button, round button

Picture alignment

Defies the picture alignment and scaling

Button, round button

See also
How to Change an Attribute (Page 476)
How to insert a round button (Page 636)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Flashing" Property Group
Introduction
The "Flashing" property group contains attributes with which you can change the flashing of
object elements. The settings of the "Flashing" property group can only be seen in Runtime.

Prerequisites
The "Flashing" property group is available for all objects except application windows, picture
windows, multiline text, combobox, list box, control, OLE object and 3D bar.
If you have selected a global design in the project, it is possible to have the color attributes of
the "Flashing" property group only become effective if the "Global color scheme" is set to "No"
under "Display".

Overview
The following table shows all the attributes of the "Flashing" property group. The function of
an attribute is described briefly and the object types for which the attribute is available are
listed.
Attribute
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Function

Object type

Flashing
Activates flashing of the background
Background Active

Polygon, ellipse, circle,
ellipse segment, pie
segment, rectangle, rounded
rectangle, static text,
I/O field, bar, graphics object,
text list
all Windows objects

Flashing Line
Active

Activates flashing of the line

all standard objects,
bar, graphics object, status
display,
all Windows objects

Flashing Border
Active

Activates flashing of the border

I/O field, Text List
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Attribute

Function

Object type

Flashing Text
Active

Activates flashing of the font

Static text,
I/O field, text list,
button, check box, radio box

Flash frequency

Frequency for the flashing of the group display

Group Display

Background Flash
Frequency

Frequency for the flashing of the background

Polygon, ellipse, circle,
ellipse segment, pie
segment, rectangle, rounded
rectangle, static text,
I/O field, bar, graphics object,
text list
all Windows objects

Line Flash
Frequency

Frequency for the flashing of the line

all standard objects,
bar, graphics object, status
display,
all Windows objects

Border Flash
Frequency

Frequency for the flashing of the border

I/O field, bar, text list

Text Flash
Frequency

Frequency for the flashing of the text

Static text,
I/O field, text list,
button, check box, radio box

Flashing
Background Color
Off

Color for the flash state "Off"

Polygon, ellipse, circle,
ellipse segment, pie
segment, rectangle, rounded
rectangle, static text,
I/O field, bar, graphics object,
text list
all Windows objects

Flashing
Background Color
On

Color for the flash state "On"

Polygon, ellipse, circle,
ellipse segment, pie
segment, rectangle, rounded
rectangle, static text,
I/O field, bar, graphics object,
text list
all Windows objects

Flashing Line
Color Off

Color for the flash state "Off"

all standard objects,
bar, graphics object, status
display,
all Windows objects

Flashing Line
Color On

Color for the flash state "On"

all standard objects,
bar, graphics object, status
display,
all Windows objects

Flashing Border
Color Off

Color for the flash state "Off"

I/O field, bar, text list

Flashing Border
Color On

Color for the flash state "On"

I/O field, bar, text list
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Attribute

Function

Object type

Flashing Text
Color Off

Color for the flash state "Off"

Static text,
I/O field, text list,
button, check box, radio box

Flashing Text
Color On

Color for the flash state "On"

Static text,
I/O field, text list,
button, check box, radio box

See also
How to Change an Attribute (Page 476)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

The "Display" property group
Introduction
The "Display" property group contains attributes with which you can change the optical
appearance of the objects.

Requirements
The "Display" properties group is available for all objects of the object palette besides the
following Smart objects: application window, picture window, control, OLE object, Faceplate
instance, .NET control and WPF control.

Overview
The following table shows all attributes in the "Display" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
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Attribute

Function

Object type

Global shadow

Takes over the global setting for
a shadow underlying the object

Single objects, I/O Field, bar,
graphic object, status display,
text list, multiline text,
combobox, list box, 3D bar,
group display, status display,
analog display, button, check
box, radio box, round button,
slider object, polygon tube, Tpiece, double T-piece, tube bend

Global color scheme

Takes on the global color
scheme

Single objects, I/O Field, bar,
graphic object, text list, button,
check box, radio box, round
button, slider object, polygon
tube, T-piece, double T-piece,
tube bend
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Attribute

Function

Object type

Object transparency

Defines the transparency of the
objects between 0 (not
transparent) and 100
(completely transparent).
100% transparent or invisible
objects can also be operated in
Runtime.

Single objects, I/O Field, bar,
graphic object, text list, 3D bar,
button, check box, radio box,
round button, slider object,
polygon tube, T-piece, double Tpiece, tube bend

[V6.2] Windows Style

Shows the objects in the
Windows style of WinCC V6.2

Button, Slider object

WinCC style

Defines the design of the objects

button, round button, slider
object

Display options

Defines the type of display.

Button, round button

"Colors" Property Group
Introduction
The "Colors" property group contains attributes which you can use to change the color settings
of objects.
Note
Either define the color directly in the "Color selection" dialog or select an indexed color from
the central color palette if a central color palette is defined.

Requirements
The "Colors" property group is available for all objects except application windows, picture
windows, Control and OLE object.
If you have selected a global design in the project, it is possible to have certain attributes of
the "Colors" property group only become effective if the "Global color scheme" is set to "No"
under "Display".

Overview
The following table shows all attributes in the "Colors" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

3D Border Color Top

Color of the left and upper part of the 3D border

Button, round button

3D Shadow Color

Color of the right and lower part of the 3D border

Button, round button

List Background Color

Background color of the non-selected entries in the
selection list

Text list

List Font Color

Font color of the non-selected entries in the selection list

Text list

Bar Color

Color of the bar to display the current value

Bar

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

487

Creating Process Pictures
3.8 Working with Objects
Attribute

Function

Object type

Bar Background Color

Color of the bar background

Bar

High Limit Color

Color of the upper and right arrow key

Slider object

Low Limit Color

Color of the lower and left arrow key

Slider object

Fill pattern color

Color of the fill pattern

Polygon, ellipse, circle, ellipse
segment, pie segment, rectangle,
rounded rectangle, static text,
I/O field, bar, graphics object, text
list, combo box, list box, all
Windows objects

Background color

Fill color of the object

Polygon, ellipse, circle, ellipse
segment, pie segment, rectangle,
rounded rectangle, static text,
I/O field, bar, graphics object, text
list, multi-line text, combo box, list
box, 3D bar,
all Windows objects

Button Color

Color of the regulator

Slider object

Line color

Color of the line

all standard objects except static
text,
graphics object, status display,
all Windows objects, all tube
objects

Line background color

Background color of line

all standard objects,
graphics object, status display,
all Windows objects

High Limit Background
Color

Color of the upper and right slider surface

Slider object

Border color

Color of the border

Static text,
I/O field, bar, text list, multi-line
text, combo box, list box, 3D bar,
round button

Border Background Color Background color of the border

I/O Field, bar, multi-line text,
combo box, list box, text list, round
button

Font color

Color of the text in an object

Static text,
I/O field, text list, multi-line text,
combo box,
list box, button, check box, radio
box, round button

Selection Background
Color

Background color in the selected entry of the selection list

Text list

Selection Font Color

Color of the font in the selected entry of the selection list

Text list

Scale Color

Color to display the scale and label

Bar

Trend Color

Color of the trend display which is displays the trend of the
measurement value in the form of a small arrow at the lower
end of the bar

Bar

Dividing Line Color

Color of the dividing lines in the selection list

Text list
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Attribute

Function

Object type

Dividing Line Background
Color

Background color of the dividing lines in the selection list

Text list

Low Limit Background
Color

Color of the lower and left slider surface

Slider object

See also
The central color palette (Page 300)
How to Change an Attribute (Page 476)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Filling" Property Group
Introduction
The "Filling" property group contains attributes, which you can control the dynamic filling of
objects.

Requirements
The "Filling" property group is available for all objects: Polygon, ellipse, circle, ellipse segment,
circlular segment, rectangle, round rectangle, static text, graphic object, button, check box,
option group, round button and slider.

Overview
The following table shows all the attributes of the "Filling" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

Dynamic filling

Permits dynamic filling of objects with closed
border line

All the objects mentioned
above

Fill level

Height of the object filling with closed border line
as a percentage of the object height

All the objects mentioned
above

Fill direction

Direction of the object filling with closed border line

All the objects mentioned
above

See also
How to Change an Attribute (Page 476)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)
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"Geometry" Property Group
Introduction
The "Geometry" property group contains attributes, which you can use to change the geometric
properties of objects.

Requirements
The "Geometry" property group is available for all objects.

Overview
The following table shows all attributes in the "Geometry" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
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Attribute

Function

Object type

Current value X

Horizontal position of the currently selected corner
point, relative to the image origin.
(Unit: Pixels)

Polygon, polyline, connector

Current value Y

Vertical position of the currently selected corner
point, relative to the image origin.
(Unit: Pixels)

Polygon, polyline, connector

Alpha

Depth angle Alpha for the 3D effect
(Unit: Degree)

3D Bar

Start angle

Start angle for the display of segment or arc objects Ellipse arc, ellipse segment,
(Unit: Degree)
circular arc, pie segment,
tube bend

Number of corners Number of corner points

Polygon, polyline, polygon
tube

Number of boxes

Number of available selection fields

Check Box, Radio Box

Number of rows

Number of rows of text displayed

Combobox, list box

Alignment

Direction of movement of the slider control
(Value: horizontal or vertical)

Slider

Bar Width

Width of the 3D bar
(Unit: Pixels)

3D Bar

Bar Height

Height of the 3D bar
(Unit: Pixels)

3D Bar

Bar direction

Direction of the positive bar axis
(top, bottom, left, right)

Bar, 3D bar

Bar depth

Depth of the 3D bar
(Unit: Pixels)

3D Bar

Base X

Horizontal distance from the right bar edge to the
left object field edge

3D Bar

Base Y

Vertical distance from the lower bar edge to the
upper object field edge

3D Bar

Beta

Depth angle Beta for the 3D effect
(Unit: Degree)

3D Bar
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Attribute

Function

Object type

Width

Distance between the left and right borderline
of an object
(Unit: Pixels)

All objects except application
and picture windows

Width Button 1-8

Individual width for each of the eight buttons (1-8) Group Display
(Unit: Pixels)

Display axis

Coordinate axis on which the measurement values
are displayed as 3D bars

3D Bar

Corner radius X

Radius of the corner rounding
(Unit: Percentage)

Rounded rectangle

Corner radius Y

Radius of the corner rounding
(Unit: Percentage)

Rounded rectangle

End angle

End angle for the display of segment or arc objects Ellipse arc, ellipse segment,
(Unit: Degree)
circular arc, pie segment,
tube bend

Window width

Distance between the left and right borderline
(Unit: Pixels)

Application window, picture
window

Window height

Distance between the top and bottom border line
(Unit: Pixels)

Application window, picture
window

Same size

Display type of the four buttons

Group display

Height

Distance between the top and bottom border line
of an object
(Unit: Pixels)

All objects except application
and picture windows

Index

Number of the currently selected corner points

Polygon, polyline, connector,
polygon tube

Position X

Horizontal distance of the object origin from the
image origin
(Unit: Pixels)

All objects

Position Y

Vertical distance of the object origin from the
image origin
(Unit: Pixels)

All objects

Radius

Radius of a circular object
(Unit: Pixels)

Circle, circular arc, pie
segment, round button

Radius X

Horizontal radius of an elliptical object
(Unit: Pixels)

Ellipse, ellipse arc, ellipse
segment, tube bend

Radius Y

Vertical radius of an elliptical object
(Unit: Pixels)

Ellipse, ellipse arc, ellipse
segment, tube bend

Rotation
reference X

Horizontal coordinates of the reference point
around which an object is shown to rotate in
Runtime (Unit: Percentage)

Line, Polygon, Polyline,
Static Text

Rotation
reference Y

Vertical coordinates of the reference point around Line, Polygon, Polyline,
which an object is shown to rotate in Runtime (Unit: Static Text
Percentage)

Rotation angle

Angle around which an object is shown to rotate
in Runtime (Unit: Degree)

Line, Polygon, Polyline,
Static Text

Rotation angle

Orientation of a T-piece upwards, left, downwards
or right (unit: degrees). The values 0, 90, 180 and
270 are permitted. Other entries are rounded to
the multiple of 90.

T-piece

Angle settings

Type of depth display for the 3D effect

3D Bar
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See also
How to Change an Attribute (Page 476)
Setting Up Rotation of Objects (Page 506)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Limits" Property Group
Introduction
The "Limits" property group contains attributes with which you can set limit values and the
monitoring of limit values.

Requirements
The "Limits" property group is only available for the following objects. I/O field, bar and 3D bar

Overview
The following table shows all the attributes of the "Limits" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
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Attribute

Function

Object type

Type
(AH, WH, TH, RH4, RH5,
AL, WL, TL, RL4, RL5)

Type of display for the specified limit value
(percent or absolute)

Bar

Bar color (0 - 10)

Color the 3D bar takes when the specified limit is
reached

3D bar

Bar color
(AH, WH, TH, RH4, RH5,
AL, WL, TL, RL4, RL5)

Color the bar takes when the specified limit is
reached

Bar

Limit (0 – 10)

Value of the specified limit

3D bar

Limit Marker

Permits the display of the limit values on the scale Bar

High Limit Value

Upper limit to display a value in the I/O field

I/O field

Upper limit
(AH, WH, TH, RH4, RH5)

Value of the specified upper limit

Bar

Low Limit Value

Lower limit to display a value in the I/O field

I/O field

Lower limit
(AL, WL, TL, RL4, RL5)

Value of the specified lower limit

Bar

Monitor (0 – 10)

Activates monitoring of the specified limit

3D bar

Monitor
(AH, WH, TH, RH4, RH5,
AL, WL, TL, RL4, RL5)

Activates monitoring of the specified limit

Bar
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See also
How to Change an Attribute (Page 476)
How to insert an I/O field (Page 561)
How to insert a bar (Page 572)
How to Insert a 3D Bar (Page 607)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

The "Background picture" property group
Introduction
The "Background picture" properties group contains attributes with which you can change the
picture file used and the respective display for the background picture of the process picture.

Prerequisites
The "Background picture" property group is available for the process picture.

Overview
The following table shows all attributes in the "Background picture" property group. The
functionality of the attribute is briefly described.
Attribute

Function

Picture

File name of the background picture
Files of format EMF, WMF, DB, BMP, GIF, JPG, JPEG and ICO are suitable

Show as

Display of the picture in relation to the process picture and Runtime window

"Message Types" Property Group
Introduction
The "Message Types" property group contains attributes with which you can set the display
of messages depending on message type and message class.

Requirements
The "Message Types" property group is only available for the object "Group Display".
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Overview
The following table contains all attributes of the "Message Types" property group and brief
description of their function.
Attribute

Function

Display Text

Label of buttons depending on the displayed message type

Went Out Unacknowledged – Permits flashing background when a message goes out
Background Flashing
unacknowledged
Went Out Unacknowledged – Background color for the flash state Off
Background Color Off
Went Out Unacknowledged – Background color for the flash state On
Background Color On
Went Out Unacknowledged – Permits flashing font when a message goes out unacknowledged
Text Flashing
Went Out Unacknowledged – Color of the text for the flash state Off
Text Color Off
Went Out Unacknowledged – Color of the text for the flash state On
Text Color On
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Came in –
Background flashing

Permits flashing background when a message comes in

Came in –
Background Color Off

Background color for the flash state Off

Came in –
Background Color On

Background color for the flash state On

Came in –
Text flashing

Permits flashing text when a message comes in

Came in –
Text Color Off

Color of the text for the flash state Off

Came in –
Text Color On

Color of the text for the flash state On

Came in acknowledged –
Background flashing

Permits flashing background when a message comes in acknowledged

Came in acknowledged –
Background Color Off

Background color for the flash state Off

Came in acknowledged –
Background Color On

Background color for the flash state On

Came in acknowledged –
Text flashing

Permits flashing text when a message comes in acknowledged

Came in acknowledged –
Text Color Off

Color of the text for the flash state Off

Came in acknowledged –
Text Color On

Color of the text for the flash state On

Message type

Defines the message type (for example AL, AH, WL, etc.) for which the
attributes of the "Message Types" property group are configured
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See also
How to Change an Attribute (Page 476)
How to Insert a Group Display (Page 609)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Font" Property Group
Introduction
The "Font" property group contains attributes which you can use to change the appearance
of text in objects.

Prerequisites
The "Font" property group is only available for the following objects: Static text, I/O field, bar,
text list, group display, multiline text, combobox, list box, button, check box and radio box.

Overview
The following table shows all attributes in the "Font" property group. The function of an attribute
is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

Bold

Text is displayed in boldface

Static text,
I/O field, bar, text list, group
display
button, check box, radio box

Index

Number of the label field displayed in the dialog

Check box, radio box,
combobox, list box

Italic

Text is displayed in italics

Static text,
I/O field, text list, group
display,
button, check box, radio box

Text orientation

Horizontal or vertical arrangement of the text in the
object

Static text,
I/O field, text list,
button, check box, radio box

Text

Object label for current index

Static text,
button, check box, radio box,
multiline text, combobox, list
box

Underline

Text is displayed underlined

Static text,
I/O field, text list, group
display,
button, check box, radio box
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Attribute

Function

Object type

X alignment

Horizontal alignment of the text in the object

Static text,
I/O field, text list, group
display,
button, check box, radio box

Y alignment

Vertical alignment of the text in the object

Static text,
I/O field, text list, group
display,
button, check box, radio box

Font

Font of the text

Static text,
I/O field, bar, text list, group
display
multiline text, combobox, list
box, button, check box, radio
box

Font size

Font size of the text in points

Static text,
I/O field, bar, text list, group
display
multiline text, combobox, list
box, button, check box, radio
box

See also
How to Change an Attribute (Page 476)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Miscellaneous" Property Group
Introduction
The "Miscellaneous" property group contains attributes which you can use to change the
miscellaneous settings of objects.

Requirements
The "Miscellaneous" property group is available for all objects.
The availability of the attributes depends on the type of selected objects. Only the attributes
which the selected object has will be displayed.
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Overview
The following table shows all attributes in the "Miscellaneous" property group. The function of
an attribute is described briefly and the object types for which the attribute is available are
listed.
Attribute

Function

Object type

Update cycle

Type and frequency of the update

Picture window, picture object

Display

Activates the display of an object

All objects

Display names

User-defined name of the process picture

Picture object

Display options

Specifies if a button is assigned to a graphic, text, or both

Button

Operator control enable

Release to operate an object

All objects
except:
application window
picture window

Operator input message

Defines whether a message is output following operation

I/O field, text list, combo box, list
box, check box, radio box, slider

Operator activities report

Defines whether the reason for an operation should be
logged

I/O field, text list, combo box, list
box, slider

Operation steps

Defines how many steps the slider is moved on the slider
surface when the mouse is clicked

Slider

User value 1-4

Any 32-Bit value which for example can be used for a script
evaluation

Group display

Authorization

User-specific authorization to operate an object

all objects
except:
application window
picture window
control

Adapt picture

Permits adaptation of the picture size to the window size

Picture window

Picture name

Defines the name of the picture to be shown

Picture window

Picture offset X

Horizontal coordinate to define a picture section

Picture window

Picture offset Y

Vertical coordinate to define a picture section

Picture window

Picture Status Off

Defines the picture displayed when a button is not pressed Button

Picture status on

Defines the picture displayed when a button is pressed

Button

Bit pattern group display

System-internal Output Value

Group display

Cursor mode

Specifies if a process picture is operated in Runtime using
the alpha cursor or the tab order cursor.

Picture object

Cursor control

Defines whether the Alpha cursor automatically jumps to
the next field of the TAB order following input in a field

I/O field
text list

Date of last change

Indicates the date when the process picture was last saved. Picture object

Immediate input

Defines whether when jumping to the object it should
change directly to input mode

I/O field
text list

Extended operation

Defines whether the slider jumps to the minimum or
maximum value when the mouse is clicked on the slider
surface

Slider

Extended zooming

The view of the process picture in Runtime may be zoomed
in or out using the mouse wheel.

Picture object

Change color

Defines whether the color changes segment-by-segment or
for the entire bar when the limit value is reached

Bar
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Attribute

Function

Object type

Adapt size

Permits adaptation of the window size to the picture size

Picture window

Window mode

Defines the position and scaling of the picture window

Picture window

Sizeable

Permits the operator to change the window size

Application window
Picture window

Hotkey

Defines a key or key combination as an alternative
operation to a mouse action

Button

Hysteresis

Permits display with hysteresis

Bar

Hysteresis Range

Defines the hysteresis in percentage of the display range

Bar

Maximum value

Absolute value to display the largest value

Bar
3D bar
slider

Maximizable

Permits the enlargement of a window to the maximum
screen size

Application window
Picture window

Menu/Toolbar
configuration

Enables the assignment of an MTL file with the layout of
menu and toolbars

Picture window

Minimum value

Absolute value to display the smallest value

Bar
3D bar
slider

Average value

Forms an average value across the last 10 values

Bar

Monitor number

Defines the monitor, on which the picture window will be
displayed

Picture window

Zero point value

Absolute value to display the zero point

Bar
3D bar

Password protection

Specifies a password for the process picture or faceplate
type

Picture object
Faceplate type

Process driver connection Default values for the display in Runtime if the associated
tag is not linked or updated

Bar
3D bar
slider

Acknowledgment mask

Specifies which events require acknowledgment. Graphics
objects which display an alarm flash for events that require
acknowledgment and are steady on for events that do not
require acknowledgment.

Group display
Extended status display,
extended analog display

Border

Display of a window with or without a border

Application window
Picture window

Adapt border

Dynamic adaptation of the field border to the text size

Static text
I/O field
text list
button
check box
radio box

Scroll bar

Permits a scroll bar in the window

Picture window

Scroll bar position X

Horizontal move of picture scroll bar in picture window with
scroll bar

Picture window

Scroll bar position Y

Vertical move of picture scroll bar in picture window with
scroll bar

Picture window

Group relevant

Defines the consideration to form a group display

Group display

Group value

Collect value of the current state of the active message
classes

Group display
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Attribute

Function

Object type

Closable

Permits a window to be closed

Application window
Picture window

Selected box

Defines the number of the highlighted of displayed text field

Combo box, list box

Selected text

Shows certain text with the "Selected box" attribute

Combo box, list box

Server name

Display under which name an embedded object is
registered in the operating system

Control
OLE object

Server prefix

Name of the server from which the picture to be shown is
called

Picture window

Scaling factor

Zoom factor to display the picture in the window

Picture window

Scaling mode

Scaling and display of components of the faceplate instance Faceplate instance, user object
or the internal objects of the user object

Configured languages

Displays the languages configured for the selected object

Static text, button, check box,
radio box, multiline text, combo
box, list box

Text reference

Defines whether the language-dependent assignment texts
are managed in the text library or directly in the object

Text list

Title

Activates the title bar of a window

Application window
Picture window

Tooltip text

Describing text which appears in Runtime as soon as the
cursor is positioned on the object

all objects except:
application window
picture window
control

Trend

Permits the display of the trend of a measurement value

Bar

Heading

Headline displayed in the title bar of the picture window

Picture window

Independent window

Defines whether the picture window can be used in position
and scaling independent of the process picture

Picture window

Tag prefix

Name extension prefixed on all tag in the picture

Picture window

Visualize tag status

Determines of the object is grayed out when a bad quality
code or tag status is detected.

Bars, I/O field, group display, text
list, 3D bar, status display
(extended), analog display
(extended)

Movable

Permits a window to be moved

Application window
Picture window

Foreground

Defines whether a window is pinned on top

Application window
Picture window

See also
How to Change an Attribute (Page 476)
How to configure the display of windows (Page 507)
How to Configure Logging and Operator Authorizations (Page 508)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)
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"Lock" Property Group
Introduction
The "Lock" property group contains attributes with which you can change the properties to
display locked measuring points.

Requirements
The "Lock" property group is only available for the object "Group Display".

Overview
The following table contains all attributes of the "Lock" property group and a brief description
of their function.
Attribute

Function

Lock Display

Permits viewing a locked measuring point

Lock Display Text

Label of the buttons for a locked measuring point

Lock Background Color

Background color of the buttons for a locked measuring point

Lock Text Color

Font color of the buttons for a locked measuring point

See also
How to Change an Attribute (Page 476)
How to Insert a Group Display (Page 609)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Styles" Property Group
Introduction
The "Styles" property group contains attributes which you can use to change the style for the
appearance of objects.

Requirements
The "Styles" property group is available for all objects except application windows, picture
windows, Control and OLE object.
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Overview
The following table shows all attributes in the "Styles" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

3D border weight

Line weight of the 3D border
(unit: pixel)

Group display
button, round button

Bar pattern

Pattern to display the bar surface, for example
solid or broken

Bar

Border weight

Width of the border of a slider control
(unit: pixel)

Slider

Display as dropdown list

Display as single object with arrow button for drop- Text list
down

Corners

Representation of the corners of an object, e.g.
round, flat or pointed
(associated with the "Line style" attribute)

all standard objects,
graphics object, status
display,
all Windows objects

Latch down

Saves the last selected switch positioned
("Pressed" or "Not pressed")

Button, round button,

Box alignment

Arrangement of the buttons relative to the
describing text

Check box, radio box

Fill pattern

Pattern for the display of background areas, for
example solid or hatched

Polygon, ellipse, circle,
ellipse segment, pie
segment, rectangle, rounded
rectangle, static text,
I/O field, bar, graphics object,
text list, combo box, list box,
all Windows objects

Pressed

Start position of the switch

Button, round button

Background

Display of the background

3D bar

Light effect

Display of the sides of a 3D bar with different
brightness

3D bar

Line end

Representation of the line ends of an object, e.g.
round, flat or pointed
(associated with the "Line style" attribute)

all standard objects,
graphics object, status
display,
all Windows objects

Line style

Display type of a line, for example dotted or dashed all standard objects,
graphics object, status
display,
all Windows objects

Line end style

Display type for the end points of a line

Line, polyline, connector

Line weight

Thickness of a line
(Unit: pixel)

all standard objects,
graphics object, status
display,
all Windows objects,
all tube objects

Line connection
type

Type of transition at a corner point

Polygon tube
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Attribute

Function

Object type

Draw Border
Inside

Ellipse, circle, ellipse
segment, circular segment,
ellipse arc, circle arc,
rectangle, round rectangle,
static text, graphic object,
status display, all Window
objects

Border style

Display type of a border line, for example dotted
or broken

I/O field, bar, multiline text,
combo box, list box, multiline
text, 3D bar

Border width

Thickness of a border line
(unit: pixel)

I/O field, bar, multiline text,
combo box, list box, multiline
text, 3D bar

Dividing line style

Display type of the dividing lines of a selection list,
for example dotted or broken

Text list

Dividing line
weight

Thickness of the separation lines in a selection list Text list
(Unit: pixel)

See also
How to Change an Attribute (Page 476)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Connected Objects" Property Group
Introduction
The "Connected Objects" property group contains attributes which can be used to change the
connection between two objects by means of the "Connector" object.

Requirements
The "Connected Objects" property group is only available for the "Connector" object.

Overview
The following table shows all attributes of the "Connected Objects" property group and a brief
description of their function.
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Attribute

Function

Object name of the source object

Specifies the object that is connected to the start of the
connector

Connection point index of the source
object

For the start of the connector, specifies at which connection
point of the source object the connection is created
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Attribute

Function

Object name of the target object

Specifies the object that is connected to the end of the
connector

Connection point index of the target
object

For the end of the connector, specifies at which connection
point of the target object the connection is created

Change orientation

Reverses the definition of the connector "Start" and "End"
with the current assignments

Connection Type

Specifies whether an automatic or basic direct connection
should be created between the objects.

See also
How to Change an Attribute (Page 476)
How to use the connector (Page 543)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Assignment" Property Group
Introduction
The "Assignment" property group contains attributes you use to assign message types to
buttons of the group display object. The display of message types is configured in the "Message
Types" property group.

Requirements
The "Assignment" property group is only available for the "Group Display" object.

Overview
The following table shows all attributes of the "Assignment" property group and a brief
description of their function.
Attribute

Function

Message Types for Button 1

Specifies one or several message events for the first button
of the group display object.

Message Types for Button 2

Specifies one or several message events for the second
button of the group display object.

Message Types for Button 3

Specifies one or several message events for the third button
of the group display object.

Message Types for Button 4

Specifies one or several message events for the fourth button
of the group display object.

Message Types for Button 5

Specifies one or several message events for the fifth button
of the group display object.
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Attribute

Function

Message Types for Button 6

Specifies one or several message events for the sixth button
of the group display object.

Message Types for Button 7

Specifies one or several message events for the seventh
button of the group display object.

Message Types for Button 8

Specifies one or several message events for the eighth
button of the group display object.

See also
How to Change an Attribute (Page 476)
How to Insert a Group Display (Page 609)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

"Status" Property Group
Introduction
The "Status" property group contains attributes with which you can change the properties of
the status display.

Requirements
The "Status" property group is only available for the object "Status Display".

Overview
The following table shows all attributes of the "Status" property group and brief description of
their function.
Attribute

Function

Current status

Status set to display a basic picture or a flash picture

Flash Picture

Picture to be displayed as a flash picture

Flash Picture Referenced

Defines whether the picture itself or only a reference to the picture is
incorporated

Flash Picture Transparent
Color

Defines which color of the flash picture is set to "transparent"

Flash Picture Transparent
Color On

Permits the "Transparent Color" function for the flash picture

Flashing Flash Picture Active Activates flashing of the flash picture
Flash picture flash frequency Frequency for the flashing of the flash picture
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Basic Picture

Picture to be displayed as basic picture

Basic Picture Referenced

Defines whether the picture itself or only a reference to the picture is
incorporated
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Attribute

Function

Basic Picture Transparent
Color

Defines which color of the basic picture is set to "Transparent"

Basic Picture Transparent
Color On

Permits the "Transparent Color" function for the basic picture

See also
How to Change an Attribute (Page 476)
How to insert a status display (Page 582)
The Properties of an Object (Page 470)
Property Groups and Attributes (Page 479)

3.8.5.4

Special Runtime Settings

Special Runtime Settings
Introduction
To display and operate individual objects in Runtime, there are different attributes available
whose change is only visible in Runtime:
● Rotation of objects
● Display of windows
● Operation and logging
● Multiple picture windows
The objects can also be displayed as transparent right to invisible in runtime.
These settings are described extensively below.

See also
Property Groups and Attributes (Page 479)
How to Configure Logging and Operator Authorizations (Page 508)
How to configure the display of windows (Page 507)
Setting Up Rotation of Objects (Page 506)
How to support multiple picture windows (Page 509)
How to define the visibility of objects (Page 512)
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Setting Up Rotation of Objects
Introduction
A rotation around a reference point can be configured for objects of the type line, polygon,
polyline or static text.
The rotation of an object is only visible in Runtime.
The coordinates of the reference point and the configured start position are defined by the
attributes "Rotation reference X", "Rotation reference Y" and "Rotation angle in the "Geometry"
property group.

Rotation reference X, Rotation reference Y
The attribute "Rotation reference X" and "Rotation reference Y" define the horizontal and
vertical distance of the reference point from the object origin.
The values are specified in percent. The object width or object height correspond to a value
of 100%. The reference point value can be outside the selection rectangle. This means that
both negative values and values higher than 100% are possible.

Rotation angle
The "Rotation Angle" attribute defines the rotation of an object around the reference point.
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The Rotation Angle is specified in degrees. The configured start point corresponds to a value
of 0°. The position of an object deviates from its configured start position by the value of the
"Rotation Angle" attribute.

See also
The Properties of an Object (Page 470)
Special Runtime Settings (Page 505)
How to Draw a Polyline (Page 520)
How to Draw a Polygon (Page 518)
How to Draw a Line (Page 515)

How to configure the display of windows
Introduction
The "Application Window" and "Picture Window" objects are displayed in Runtime as a window
in a process picture. The properties of this window display can be changed as required with
the attributes described here. Some of these attributes are available for other object types.

Adapt Size
The "Adapt Size" attribute specifies whether or not a picture window adapts to the size of the
embedded picture in Runtime.

Sizeable
The "Sizeable" attribute specifies whether or not the size of a window can be changed in
Runtime.

Border
The "Border" attribute specifies whether or not a window is displayed with a border.

Scroll Bar
The "Scroll Bar" attribute specifies whether or not a picture window is displayed with a scroll
bar if required. A scrollbar is only visible in Runtime.

Can Be Closed
The "Can Be Closed" attribute specifies whether or not a window can be closed in Runtime.
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Title
The "Title" attribute specifies whether a window is displayed in Runtime with or without a title
bar.

Heading
The "Heading" attribute specifies which text appears in the title of a picture window.

Movable
The "Movable" attribute specifies whether or not a window can be moved in Runtime.

Foreground
The "Foreground" attribute specifies whether or not a window lies in the foreground. This
setting is independent of the layer to which the window is assigned.

See also
The Properties of an Object (Page 470)
Special Runtime Settings (Page 505)
"Miscellaneous" Property Group (Page 496)
How to insert a picture window (Page 552)
How to Insert an Application Window (Page 550)

How to Configure Logging and Operator Authorizations
Introduction
In WinCC to operate a process picture you can define user-specific authorization for the
contained objects. Each Operation may be logged and sent to the message system. The
associated settings can be changed with the attributes described here.

Display
The "Display" attribute specifies whether or not an object is displayed in Runtime.

Operator-Control Enable
The "Operator-Control Enable" attribute specifies whether or not an object can be operated in
Runtime.
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Operator Input Message
The "Operator Input Message" attribute specifies whether a message is displayed after an
operation for some objects. The object must be connected to a tag. Following an operation, a
message is generated, sent to the message system, and is archived. Using the message
system, a message may be output in a message line, for example.

Operator Activities Report
The "Operator Activities Report" attribute specifies whether or not the reason for an operation
is to be logged by the operator. The Operator Activities Report is archived in the message
system.

Authorization
The User Administrator editor is used in WinCC to assign authorizations for the users. An
authorization can be assigned for every object in the Graphics Designer. The object can only
be operated by those users with the corresponding authorization.
Note
An object can only receive an operator authorization as a "Whole". A customized object can
have an operator authorization but its subordinate objects cannot.

Cursor Control
The "Cursor Control" attribute specifies whether the Alpha Cursor automatically jumps to the
next field in the TAB sequence after an entry has been made in a field. This function enables
rapid input in different fields without having to use the tab key to jump.

Hotkey
As an alternative to operation with the mouse, a button can also be triggered using the
keyboard. To do so, a hotkey must be set.

See also
The Properties of an Object (Page 470)
Special Runtime Settings (Page 505)
"Miscellaneous" Property Group (Page 496)

How to support multiple picture windows
Introduction
WinCC supports independent picture windows. Independent picture windows can be can be
used and positioned absolutely without being connected to the respective process picture.
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With the respective hardware and the support of the operating system, you can control more
monitors to handle processes with greater scope and differentiation.
For example, you can visualize the process on monitors 1 to 3 and use monitor 4 to display
another view of the process with an Excel list.
The main window, in which you have configured the individual picture window, is no longer
required. You can hide it to increase the impact of more independent runtime windows.

Procedure
1. Configure more picture windows with the desired process pictures in the start picture.
2. Open the properties for each picture window with a double click.
The "Object Properties" dialog is opened.

3. Set the attribute "Independent window" to "Yes".
4. Define the display for the configured picture window with window mode:
– Standard: configured size in the configured position
– Center: configured size in the central position
– Maximize: display adapted to the size of the monitor
5. If you want to use more monitors:
Select the desired monitor for the picture window with the "Monitor number" attribute.
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6. If you want to hide the main window:
Select "Properties" in the WinCC Explorer of the shortcut menu of the computer, select the
respective computer and click on "Properties".
The "Computer Properties" dialog opens.

7. Activate check box "Hide main window" on the "Graphics Runtime" tab under "Independent
picture window".

Results
In runtime, the selected process pictures appear in several picture windows that are to be
controlled independent of one another.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

511

Creating Process Pictures
3.8 Working with Objects

See also
How to insert a picture window (Page 552)

How to define the visibility of objects
Introduction
The visibility of objects is controlled with the "Object transparency" property. The operability
of an object does not depend on its visibility. Even a completely transparent, or invisible, object
can be controlled in runtime.

Procedure
1. Select "Properties" in the shortcut menu.
The "Properties" dialog opens.
2. Define the object transparency as a percentage in the "Display" property group.
0% means no transparency, therefore complete visibility.
100% means complete transparency, therefore invisibility of the object.
The text and fields of the graphic objects are only transparent at 100%.
Note
The transparency of the object is shown in the Graphics Designer as well as later in
runtime.

Finding objects again
A 100% transparent object cannot be seen in the project as well as in runtime. The selection
marks for the rectangle surrounding the object are also not seen in the project.
Use the setting with the knowledge that operation of an invisible object is still possible.
In order to have an overview of which objects belong to the process picture in the project,
select the "View Project Documentation" command in the "File" menu.
Existing, invisible objects are also included in the project documentation. The position of the
objects in the process picture are indicated in the schematic overview graphic.

3.8.6

Working with Standard Objects

3.8.6.1

Working with Standard Objects

Introduction
The standard objects include geometric shapes and static text. The geometric shapes draw
the individual elements of the process picture. For example, static text can be used for labels.
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In the Graphics Designer, the various object types have default properties. When they are
inserted the objects import these default properties (except for individual geometric properties).
After insertion the properties of an object can be modified. In the same way the default settings
for the object types can be modified as required.

Overview
Icon

Object

Description

Line

The line is an open object. The length and angle of a line are
determined by the height and width of the rectangle around the
object. The line ends, for example, can be shown as arrows or
points.

Polygon

The polygon is a closed object that can be filled with a color or
pattern. A polygon can have any number of corners. The corners
are numbered in their sequence of creation and can be modified
individually or deleted.

Polyline

The polyline is an open object. Even if the start and finish point
have the same coordinates, the area cannot be filled. A polyline
can have any number of corners. The corners are numbered in
their sequence of creation and can be modified individually or
deleted. The line ends of a polyline can for example be shown as
arrows or points.

Ellipse

The ellipse is a closed object that can be filled with a color or
pattern. The height and width of an ellipse can be modified as
desired to allow it to be aligned horizontally or vertically.

Circle

A circle is a closed object that can be filled with a color or pattern.
A circle can be resized at will.
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Icon

Object

Description

Ellipse segment

The ellipse segment is a closed object that can be filled with a
color or pattern. The height and width of an ellipse segment can
be modified as desired to allow it to be aligned horizontally or
vertically.

Pie segment

The pie segment is a closed object that can be filled with a color
or pattern. A pie segment can be resized at will.

Ellipse arc

The ellipse arc is an open object. The height and width of an
ellipse arc can be modified as desired to allow it to be aligned
horizontally or vertically.

Circular arc

The circular arc is an open object. A circular arc can be resized
at will.

Rectangle

The rectangle is a closed object that can be filled with a color or
pattern. The height and width of a rectangle can be modified as
desired to allow it to be aligned horizontally or vertically.

Rounded rectangle

The rounded rectangle is a closed object that can be filled with a
color or pattern. The height and width of a rounded rectangle can
be modified as desired to allow it to be aligned horizontally or
vertically. The corners of a rounded rectangle can be rounded as
much as desired.

Static text

The field for static text is a closed object that can be filled with a
color or pattern. The static text is entered into a field of any desired
size. One-line or multiline text can be input for all design
languages.

Connector

The connector is a linear object whose ends can be connected
with the connection points of other objects. The number and
arrangement of the connection points depend on the specific
object type. If connected objects are moved, the connector's
length and direction are automatically adapted and the
connection is retained.

See also
How to Draw a Line (Page 515)
How to Draw a Polygon (Page 518)
How to Draw a Polyline (Page 520)
How to Draw an Ellipse (Page 524)
How to Draw a Circle (Page 526)
How to draw an Ellipse Arc (Page 532)
How to Draw a Circular Arc (Page 535)
How to Draw an Ellipse Segment (Page 527)
How to Draw a Pie Segment (Page 530)
How to Draw a Rectangle (Page 537)
How to Draw a Rounded Rectangle (Page 539)
How to Insert Static Text (Page 541)
How to use the connector (Page 543)
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How to change the default setting of object types (Page 426)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
Controls (Page 295)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Rectangle Surrounding the Object (Page 281)
Working with Combined Objects (Page 653)
Working with Objects (Page 425)

3.8.6.2

How to Draw a Line

Introduction
The line is an open object. The length and angle of a line are determined by the height and
width of the rectangle around the object. The line ends, for example, can be shown as arrows
or points.
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Drawing a line
1. Open the picture into which you want to insert a line.
2. Click the "Line" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the line.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the line to the length and direction you want.
When you release the mouse button, the line is finished.
Alternatively, you can double-click the line in the "Standard" selection window. A line with
default object properties is then inserted near the picture origin.

Changing a line
Select an object of the line type if you wish to carry out one of the following changes:
Actions with the mouse
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the frame color in the font palette to change the line color.
Use the color palette to change the line background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Configuring the Line Style
Line style
The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or
dashed representation is possible.
A line with line width of 1 pixel can be displayed in two colors. To do so, you must select a
broken line style and assign another color to the background of the line. If the line color is
identical to the line background color in the "Colors" property group, breaks in the line are
invisible.
Five line styles are available for selection.
Line ends
The "Line ends" attribute determines the appearance of the line ends. The definition of the
attribute applies to both ends of the line. Select one of the three following options:
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● A round end sets the center of a circle at the end point of the line. The diameter of the circle
adapts to the line width.
● A rectangular end sets the center of a square at the end point of the line. The width and
the height of the square adapt to the line width.
● A flat end terminates the line at its end points.

Configuring line end style
The "Line End Style" attribute specifies the style of the ends of a line object. The ends of a line
object can have different shapes. For example, a line can begin with a dot and end with an
arrow.

Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".

See also
Setting Up Rotation of Objects (Page 506)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.3

How to Draw a Polygon

Introduction
The polygon is a closed object that can be filled with a color or pattern. A polygon can have
any number of corners. The corners are numbered in their sequence of creation and can be
modified individually or deleted.

Drawing a polygon
1. Open the picture in which you want to insert a polygon.
2. Click the "Polygon" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a polygon.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Click the selected starting point with the left mouse button.
5. Click any other desired corner of the polygon with the left muse button.
6. Click once with the right mouse button to correct the last drawn section of the polygon.
7. Finish the polygon by double-clicking the left mouse button.
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Alternatively, you can double-click the polygon in the "Standard" selection window. A polygon
with default object properties is then inserted near the picture origin.

Changing a polygon
● Select an object of the polygon type if you wish to carry out one of the following changes:
Actions with the mouse
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the frame color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Changing corners
The positions of the corners can be changed with the attributes "Current Value X" and "Current
Value Y" in the "Object Properties" window. The position number of the current selected corner
is shown by the "Index" attribute in the "Geometry" property group. Changing the value
specified here enables targeted selection of a corner. A change of the "Index" attribute for the
current selected corner also changes the displayed value of the attributes "Current Value X"
and "Current Value Y".
You can also change corners by actions with the mouse:
Moving corners
Position the mouse pointer on the corner that is to be moved and drag it to the desired position
with the mouse button held down.
Inserting corners
Hold down the <ALT> key and insert another corner by double-clicking on a corner. The
additional corner is inserted between the clicked corner and the previously created corner.
Deleting corners
Position the mouse pointer on the corner that you want to delete. Hold down the <CTRL> key
and delete the corner by double-clicking on the left mouse button.

Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".
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See also
Setting Up Rotation of Objects (Page 506)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)

3.8.6.4

How to Draw a Polyline

Introduction
The polyline is an open object. Even if the start and finish point have the same coordinates,
the area cannot be filled. A polyline can have any number of corners. The corners are
numbered in their sequence of creation and can be modified individually or deleted. The line
ends of a polyline can for example be shown as arrows or points.

Drawing a polyline
1. Open the picture into which you want to insert a polyline.
2. Click the "Polyline" standard object in the "Standard" selection window.
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3. Place the mouse pointer at the position in the picture where you want to insert a polyline.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Click the selected starting point with the left mouse button.
5. Click every other desired corner of the polyline with the left mouse button.
6. Click once with the right mouse button to correct the last drawn section of the polyline.
7. Finish the polyline by double-clicking the left mouse button.
Alternatively, you can double-click the polyline in the "Standard" selection window. A polyline
with default object properties is then inserted near the picture origin.

Changing a polyline
Select an object of the polyline type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the line color.
Use the color palette to change the line background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Changing corners
The positions of the corners can be changed with the attributes "Current Value X" and "Current
Value Y" in the "Object Properties" window. The position number of the current selected corner
is shown by the "Index" attribute in the "Geometry" property group. Changing the value
specified here enables targeted selection of a corner. A change of the "Index" attribute for the
current selected corner also changes the displayed value of the attributes "Current Value X"
and "Current Value Y".
You can also change corners by actions with the mouse:
Moving corners
Position the mouse pointer on the corner that is to be moved and drag it to the desired position
with the mouse button held down.
Inserting corners
Hold down the <ALT> key and insert another corner by double-clicking on a corner. The
additional corner is inserted between the clicked corner and the previously created corner.
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Deleting corners
Position the mouse pointer on the corner that you want to delete. Hold down the <CTRL> key
and delete the corner by double-clicking on the left mouse button.

Configuring the Line Style
Line style
The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or
dashed representation is possible.
A line with line width of 1 pixel can be displayed in two colors. To do so, you must select a
broken line style and assign another color to the background of the line. If the line color is
identical to the line background color in the "Colors" property group, breaks in the line are
invisible.
Five line styles are available for selection.
Line ends
The "Line ends" attribute determines the appearance of the line ends. The definition of the
attribute applies to both ends of the line. Select one of the three following options:
● A round end sets the center of a circle at the end point of the line. The diameter of the circle
adapts to the line width.
● A rectangular end sets the center of a square at the end point of the line. The width and
the height of the square adapt to the line width.
● A flat end terminates the line at its end points.
Corners
The "Corners" attribute define the appearance of the corner intersections of where lines meet.
The definition applies to all the corners of the object. Select one of the three following options:
● A round corner sets the center of a circle at the intersection of two line ends. The diameter
of the circle adapts to the line width.
● The two outer corner points of the line connection are linked by a straight line. This flattening
effect causes the corners to appear beveled.
● A pointed corner corresponds to the real corner intersection of the meeting lines.
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Configuring line end style
The "Line End Style" attribute specifies the style of the ends of a line object. The ends of a line
object can have different shapes. For example, a line can begin with a dot and end with an
arrow.

Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".

See also
Setting Up Rotation of Objects (Page 506)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.5

How to Draw an Ellipse

Introduction
The ellipse is a closed object that can be filled with a color or pattern. The height and width of
an ellipse can be modified as desired to allow it to be aligned horizontally or vertically.

Drawing an ellipse
1. Open the picture into which you want to insert an ellipse.
2. Click the "Ellipse" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the ellipse.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the ellipse to the size and direction you want.
When you release the mouse button, the ellipse is finished.
Alternatively, you can double-click the ellipse in the "Standard" selection window. An ellipse
with default object properties is then inserted near the picture origin.
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If you hold down the <SHIFT> key when drawing the ellipse, the "Ellipse" object is created in
the shape of a circle.

Changing an ellipse
Select an object of the Ellipse type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to rotate the object.
Use the font palette to change the frame color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.6

How to Draw a Circle

Introduction
A circle is a closed object that can be filled with a color or pattern. A circle can be resized at
will.

Drawing a circle
1. Open the picture into which you want to insert a circle.
2. Click the "Circle" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a circle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the circle to the size and direction you want.
When you release the mouse button, the circle is finished.
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Alternatively, you can double-click the circle in the "Standard" selection window. A circle with
default object properties is then inserted near the picture origin.

Changing a circle
Select an object of the circle type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the font palette to change the frame color.
Use the color palette to change the background color.
Use the elements in the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)

3.8.6.7

How to Draw an Ellipse Segment

Introduction
The ellipse segment is a closed object that can be filled with a color or pattern. The height and
width of an ellipse segment can be modified as desired to allow it to be aligned horizontally or
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vertically. An ellipse segment is by default a quarter ellipse and can be configured after it has
been created.

Drawing an ellipse segment
1. Open the picture in which you want to insert a ellipse segment.
2. Click the "Ellipse segment" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you wish to position the center
point of the ellipse segment.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the ellipse segment to the size and direction you want.
When you release the mouse button, the ellipse segment insertion is finished.
5. The start and end points of the ellipse segment are shown by small gray squares. Position
the mouse pointer over one of these squares.
The mouse pointer changes to a crosshair with arrow points with either an A (start angle)
or E (end angle) above it.
6. Drag the start or end point to the desired position while holding down the mouse button.
Alternatively, you can double-click the ellipse segment in the "Standard" selection window. An
ellipse segment with default object properties is then inserted near the picture origin.
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If you hold down the <SHIFT> key while drawing, the "Ellipse Segment" object is created in
the shape of a pie segment.

Changing an ellipse segment
Select an object of the ellipse segment type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the line color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Adjusting the size of the ellipse segment
The length of the ellipse segment is set by the "Start Angle" and "End Angle" attributes. They
specify the angle in degrees by which the start and end angle of the object deviate from the
zero position (0°).
The start and end points of the ellipse segment are shown by small gray squares. Place the
mouse pointer on one of these squares. The mouse pointer changes to a crosshair with arrow
points with either an A (start angle) or E (end angle) above it. Drag the start or end point to the
desired position while holding down the mouse button.
Note
Even if the values of the start and end angle are identical, an ellipse segment does not turn
into a closed ellipse.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.8

How to Draw a Pie Segment

Introduction
The pie segment is a closed object that can be filled with a color or pattern. A pie segment can
be resized at will. A pie segment is by default a quarter circle and can be configured after it
has been created.

Drawing a pie segment
1. Open the picture in which you want to insert a pie segment.
2. Click the "Pie segment" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you wish to position the center
point of the pie segment.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the pie segment to the size and direction you want.
When you release the mouse button, the pie segment insertion is finished.
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5. The start and end points of the pie segment are shown by small gray squares. Position the
mouse pointer over one of these squares.
The mouse pointer changes to a crosshair with arrow points with either an A (start angle)
or E (end angle) above it.
6. Drag the start or end point to the desired position while holding down the mouse button.
Alternatively, you can double-click the pie segment in the "Standard" selection window. A pie
segment with default object properties is then inserted near the picture origin.

Changing a pie segment
Select an object of the pie segment type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the line color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Configuring size of the pie segment
The size of the pie segment is set by the "Start Angle" and "End Angle" attributes. They specify
the angle in degrees by which the start and end angle of the object deviate from the zero
position (0°).
The start and end points of the pie segment are shown by small gray squares. Place the mouse
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points
with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired
position while holding down the mouse button.
Note
Even if the values of the start and end angle are identical, a pie segment does not turn into
a closed circle.
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See also
How to change the default setting of object types (Page 426)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)

3.8.6.9

How to draw an Ellipse Arc

Introduction
The ellipse arc is an open object. The height and width of an ellipse arc can be modified as
desired to allow it to be aligned horizontally or vertically. An ellipse arc is by default a quarter
ellipse and can be configured after it has been created.
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Drawing an ellipse arc
1. Open the picture in which you want to insert an ellipse arc.
2. Click the "Ellipse arc" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you wish to position the center
point of the ellipse arc.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the ellipse arc to the size and direction you want.
When you release the mouse button, the ellipse arc insertion is finished.
5. The start and end points of the ellipse arc are shown by small gray squares. Position the
mouse pointer over one of these squares.
The mouse pointer changes to a crosshair with arrow points with either an A (start angle)
or E (end angle) above it.
6. Drag the start or end point to the desired position while holding down the mouse button.
Alternatively, you can double-click the ellipse arc in the "Standard" selection window. An ellipse
arc with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when drawing the ellipse, the "Ellipse arc" object is created
in the shape of a circular arc.

Changing an ellipse arc
Select an object of the Ellipse Arc type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the line color.
Use the color palette to change the line background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Setting the length of the ellipse arc
The length of the ellipse arc is set by the "Start Angle" and "End Angle" attributes. They specify
the angle in degrees by which the start and end angle of the object deviate from the zero
position (0°).
The start and end points of the ellipse arc are shown by small gray squares. Place the mouse
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points
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with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired
position while holding down the mouse button.
Note
Even if the values of the start and end angle are identical, an ellipse arc does not turn into a
closed ellipse.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.10

How to Draw a Circular Arc

Introduction
The circular arc is an open object. A circular arc can be resized at will. A circular arc is by
default a quarter circle and can be configured after it has been created.

Drawing a circular arc
1. Open the picture into which you want to insert a circular arc.
2. Click the "Circular arc" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you wish to position the center
point of the circular arc.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the circular arc to the size and direction you want.
When you release the mouse button, the circular arc insertion is finished.
5. The start and end points of the circular arc are shown by small gray squares. Place the
mouse pointer on one of these squares.
The mouse pointer changes to a crosshair with arrow points with either an A (start angle)
or E (end angle) above it.
6. Drag the start or end point to the desired position while holding down the mouse button.
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Alternatively, you can double-click the circular arc in the "Standard" selection window. A
circular arc with default object properties is then inserted near the picture origin.

Changing a circular arc
Select an object of the Circular Arc type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the line color.
Use the color palette to change the line background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Configuring the length of the circular arc
The length of the circular arc is set by the "Start Angle" and "End Angle" attributes. They specify
the angle in degrees by which the start and end angle of the object deviate from the zero
position (0°).
The start and end points of the circular arc are shown by small gray squares. Place the mouse
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points
with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired
position while holding down the mouse button.
Note
Even if the values of the start and end angle are identical, a circular arc does not turn into a
closed circle.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.11

How to Draw a Rectangle

Introduction
The rectangle is a closed object that can be filled with a color or pattern. The height and width
of a rectangle can be modified as desired to allow it to be aligned horizontally or vertically.

Drawing a rectangle
1. Open the picture into which you want to insert a rectangle.
2. Click the "Rectangle" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rectangle to the size and direction you want.
When you release the mouse button, the rectangle is finished.
Alternatively, you can double-click the rectangle in the "Standard" selection window. A
rectangle with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key while drawing, the "Rectangle" object is created in the shape
of a square.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

537

Creating Process Pictures
3.8 Working with Objects

Changing a rectangle
Select an object of the Rectangle type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the frame color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.12

How to Draw a Rounded Rectangle

Introduction
The rounded rectangle is a closed object that can be filled with a color or pattern. The height
and width of a rounded rectangle can be modified as desired to allow it to be aligned horizontally
or vertically. The corners of a rounded rectangle can be rounded as much as desired.

Drawing a rounded rectangle
1. Open the picture into which you want to insert a rounded rectangle.
2. Click the "Rounded rectangle" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the rounded
rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rounded rectangle to the size and direction you
want.
When you release the mouse button, the rounded rectangle is finished.
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Alternatively, you can double-click the rounded rectangle in the "Standard" selection window.
A rounded rectangle with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when drawing the rounded rectangle, the "Rounded
rectangle" object is created in the shape of a square.

Changing a rounded rectangle
Select an object of the rounded rectangle type if you wish to carry out one of the following
changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror or rotate the object.
Use the font palette to change the frame color.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Changing corner radii
The radii for rounding the corners of the rounded rectangle are specified with the "corner radius
X" and "corner radius Y" attributes. They define the horizontal or vertical distance between the
corners of the rectangle around the object and the starting point of the corner rounding. The
value is specified as a percentage of the half width and the half height of the object.
Note
If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%,
the rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without
rounded corners when either one of the two attributes is set to 0%.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.6.13

How to Insert Static Text

Introduction
The field for static text is a closed object that can be filled with a color or pattern. The static
text is entered into a field of any desired size. One-line or multiline text can be input for all
design languages.

Inserting static text
1. Open the picture in which you want to insert static text.
2. Click the "Static text" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the static text.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the text field to the required size.
The field for the static text is complete as soon as you release the mouse button.
Several marked question marks appear in the field.
5. Overwrite these question marks with the desired text.
For text with multiple lines, you can make a line break with the key combination <SHIFT
+ENTER> or <CTRL+M>.
6. Press <ENTER> to finish text input.
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Alternatively, you can double-click the static text in the "Standard" selection window. Static
text with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when drawing the static text, the "Static text" object is created
in the shape of a square.

Changing static text
Select an object of the rounded rectangle type if you wish to carry out one of the following
changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements of the object palette to mirror or rotate the object.
Use the elements in the font palette to change the appearance of the text and the colors.
Use the color palette to change the background color.
Use the elements in the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Changing the Contents of the Static Text
Double-click the static text to open the input mode for text. The complete text is selected.
Position the insertion point with another click at the position in the text at which you want to
change something.
Line breaks must be entered manually: You can create a line break with either <SHIFT
+ENTER> or <CTRL+M>.
A line break is shown in the "Object Properties" window in the "Static" column as a control
character.

Configuring rotation in Runtime
The static text can be rotated around a reference point in Runtime. The rotation is defined by
the attributes "Rotation Reference X", "Rotation Reference Y" and "Rotation Angle". The
rotation is displayed in Graphics Designer during configuration.
In order to rotate static text in a group object, watch for the following:
The current position and the rotation angle of the object "Static text" in Runtime are always
the result of the current values of properties "RotationReferenceX", "RotationReferenceY" and
"Rotation Angle". The orientation of static text depends on the sequence in which these
properties were applied.
If the rotation references refer to the group object, the display in Runtime may deviate from
the display in the configuration system. This is caused by the fact that the sequence in which
these properties are updated is not always the same due to system constraints. You avoid
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unexpected display problems in Runtime, if you do not dynamize the properties
RotationReferenceX, RotationReferenceY and RotationAngle directly at the group object.
Instead, perform the dynamization directly at the respective object "Static Text" within the group
object.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)

3.8.6.14

How to use the connector

Introduction
The connector is a linear object whose ends can be connected with the connection points of
other objects. Multiple connectors can also be connected together.
The number and arrangement of the connection points depend on the specific object type. If
connected objects are moved, the connector's length and direction are automatically adapted
and the connection is retained.
It is possible to select between two connection types. In the case of "Automatic" connection
type, the connector is comprised of horizontal and vertical parts.

If the connection type "Simple" is selected, the connecting points are connected by a straight
line.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

543

Creating Process Pictures
3.8 Working with Objects
The start and end of a selected connector can be highlighted by small colored rectangles to
show their status:
● Green rectangles identify unconnected ends
● Red rectangles identify connected ends

Inserting a connector
1. Open the picture in which you want to insert a connector.
2. Click the "Connector" standard object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a connector.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the connector to the size and direction you want.
When you release the mouse button, the connector insertion is finished.
The connector is displayed as a selected object with green ends.
Alternatively, you can double-click the connector in the "Standard" selection window. A
connector with default object properties is then inserted near the picture origin.

Changing a connector
Select an object of the connector type if you wish to carry out one of the following changes:
Palettes and toolbars
Use the color palette to change the line background color.
Use the line color in the font palette to change the line color.
Use the color palette to change the line background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Connecting objects
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1. Select the connector with which you would like to connect two objects.
Start and end of the connector are symbolized by small green rectangles.
2. Drag the start of the connector to the first object that you want to connect without releasing
the mouse button.
The red connection points of the object to be connected in the beginning are displayed.
3. Position the start of the connector on the desired connection point of the object.
As soon as the mouse button is released, the connection to the first object is established.
The start of the selected connector is shown as red and the other unconnected end is green.
4. Drag the end of the connector to the second object that you want to connect without
releasing the mouse button.
The red connection points of the object to be connected in the end are displayed.
5. Position the end of the connector on the desired connection point of the second object.
As soon as the mouse button is released, the connection is established. The beginning and
end of the selected connector are now symbolized by red rectangles.
The position of the connected objects can be changed as needed.

Changing a connection
Select the connector and drag one end of the connector to the new position. For example, you
can connect the end to another connection point of the same object, or to a connection point
on a new object.
Alternatively you can change the attributes of the "Connected Objects" property group in the
"Object Properties" window.
The type of connector can be changed within the "Connected objects" property group using
the "Connection type" attribute. Select between the two connection types "Automatic" and
"Simple".

Deleting a connection
Select the desired connector and press <DEL> to delete the "Connector" object.

See also
"Connected Objects" Property Group (Page 502)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)
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3.8.7

Working with Smart Objects

3.8.7.1

Working with Smart Objects

Introduction
Smart objects offer the option of building complex system pictures. The smart objects include
items such as various windows, fields and bars, which offer a variety of dynamic options.
In the Graphics Designer, the various object types have default properties. When added,
objects take on these defaults, with the exception of individual geometric properties. After
inserting the properties you can modify the properties of an object. In the same way, you can
adapt the default settings for the object types as required.
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Overview
Icon

Object

Description

Application window

The application window is an object that can be provided from applications of the
global script and the logging system. In Runtime, these applications open an
application window, transfer information and enable operation.
The size and properties which an application window accepts in Runtime are defined
in the Graphics Designer.

Picture window

The picture window offers the option of displaying other pictures that were created
with the Graphics Designer in the current picture. For example, with dynamics the
contents of a picture window can be continuously updated.
The size and properties that a picture window has in Runtime are defined in the
Graphics Designer.

Control

The Object Control provides the option to integrate system process control and
monitoring elements into a picture. Controls are prefinished objects such as for
example alarm windows, measurement value windows, selection dialogs or buttons.
ActiveX Controls, WinCC Controls and controls from other manufacturers are
available if they are registered in the operating system. These are changed as
required and dynamically integrated into the process.
The size and properties which a control accepts in Runtime are defined in the
Graphics Designer.

OLE object

The OLE object enables files created in other programs to be inserted into a picture.
Therefore all OLE object registered in the operating system can be integrated.
The size and properties which an OLE object accepts in Runtime are defined in the
Graphics Designer.
No changes can be made to OLE objects in Runtime.

I/O field

The I/O Field can be defined as an input field, an output field or a combined input/
output field. The following data formats are available: Binary, decimal, string and
hexadecimal. Limit values such as "Hidden Input" or "Accept on complete input" can
also be specified.
The size and properties which an I/O Field accepts in Runtime are defined in the
Graphics Designer.

Bar

The bar offers the option of displaying values graphically. The values can also be
displayed in a combined view as graphics with freely definable number scale.
The size and properties which a bar accepts in Runtime are defined in the Graphics
Designer.

Graphic object

The graphic object enables graphics created in other programs to be inserted into a
picture. Graphics and pictures of the following formats can be inserted:
EMF, WMF, DIB, BMP (up to 32 Bit), GIF, JPEG, ICO and PNG 1).
The size and properties which a graphic object accepts in Runtime are defined in the
Graphics Designer.
1)

Status display

PNG: Not possible with the global design "WinCC Classic".

The status display offers the option to display almost any number of different states
of an object. The states are implemented via tags whose value corresponds to the
respective state. The states are displayed via the assigned pictures.
The size and properties which a status display accepts in Runtime are defined in the
Graphics Designer.
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Icon

Object

Description

Text list

The text list offers the option of assigning specific values to a text. The text list can
be defined as an input list, an output list or as a combined input/output list. The
following data formats are available: Decimal, binary or bit.
The size and properties which a text list has in Runtime are defined in the Graphics
Designer.

Multiple row text

The Multiline Text object makes it possible to display text over several lines in a
rectangular, scrolling field and to edit it in runtime.
The size and properties which a multiline text takes on in Runtime are defined in the
Graphics Designer.

Combo box

The combobox makes it possible to display a drop-down list of several values and to
use the selection as the input.
The size and properties which a combobox takes on in runtime are defined in the
Graphics Designer.

List box

The list box makes it possible to highlight a scrolling list of several values and to use
the selection as an input.
The size and properties which a list box accepts in Runtime are defined in the
Graphics Designer.

Faceplate instance

You can insert a Faceplate instance into the picture with the Faceplate instance
object. Faceplate types must first be saved on your system.
The size and properties which a Faceplate instance has in runtime are defined in the
Graphics Designer.

.NET Control

You insert a .NET application (Assembly) as a control into your picture with the .NET
control object.
The size and properties which a .NET control takes on in runtime are defined in the
Graphics Designer.

WPF Control

The WPF control object makes it possible to insert a WPF file into your picture as a
control.
The size and properties which a WPF control accepts in Runtime are defined in the
Graphics Designer.

3D bar

The 3D bar graph enables values to be displayed graphically three-dimensionally.
The size and properties which a 3D bar has in Runtime are defined in the Graphics
Designer.
The 3D bar is only available if the "Basic Process Control" optional package was
installed with WinCC.

Group Display

The group display enables the current states of certain message types to be displayed
by hierarchy. Five buttons allow messages to be represented and operated. Using a
group display, you can configure a quick change to represent an error source for
example.
The size and properties which a group display accepts in Runtime are defined in the
Graphics Designer.
The group display is only available if the "Basic Process Control" optional package
was installed with WinCC.

Status display (Ext.) You can use an extended status display to assign "Came In" (+), "Came In
Acknowledged" (+Q) and "Went Out Unacknowledged" (-) and "OK" picture statuses.
The sizes and properties of the extended status display in runtime are defined in the
Graphics Designer.
Extended status display is available only when a PCS 7 OS is installed.
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Icon

Object

Description

Analog display
(Ext.)

The extended analog display is used to display the value of a tag in different colors
depending on the alarm status of a component.
The sizes and properties of the extended analog display in runtime are defined in the
Graphics Designer.
Extended analog display is available only when a PCS 7 OS is installed.

DataSet

DataSet serves as a container for the internal storage of data of the user objects or
faceplate types. The object does not have a graphical user interface in Runtime.

See also
How to Insert an Application Window (Page 550)
How to insert a picture window (Page 552)
How to insert a control (Page 556)
How to Insert an OLE Object (Page 558)
How to insert an I/O field (Page 561)
How to insert a bar (Page 572)
How to insert a graphic object (Page 579)
How to insert a status display (Page 582)
How to add a text list (Page 589)
How to insert multiline text (Page 597)
How to insert a combobox (Page 598)
How to insert a list box (Page 600)
How to insert a Faceplate instance (Page 603)
How to insert a .NET control (Page 604)
How to insert a WPF control (Page 605)
How to Insert a 3D Bar (Page 607)
How to Insert a Group Display (Page 609)
How to change the default setting of object types (Page 426)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
Controls (Page 295)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Rectangle Surrounding the Object (Page 281)
Working with Combined Objects (Page 653)
Working with Objects (Page 425)
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3.8.7.2

How to Insert an Application Window

Introduction
The application window is an object that is provided from applications of the global script and
the logging system. In Runtime, these applications open an application window, transfer
information and enable operation. The size and properties which an application window
accepts in Runtime are defined in the Graphics Designer.

Inserting an application window
1. Open the picture in which you want to insert an application window.
2. Click the "Application window" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the
application window.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the application window to the required size.
The "Window Contents" dialog opens.
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5. In the "Window Contents" dialog select the required display option and confirm your input
with "OK".
The "Template" dialog opens.
6. In the "Template" dialog select a template for the selected display option and confirm your
input with "OK".
The insertion process for the "Application window" object is finished.
Alternatively, you can double-click the "Application window" smart object in the "Standard"
selection window. An application window with the default object properties is then inserted
near the picture origin. The "Window Contents" and "Template" dialogs open. As soon as you
have confirmed your entries with "OK", the insertion process is completed.
If you press and hold down <SHIFT> during the size change, the "Application window" object
takes on the shape of a square.

Changing an application window
Select an object of the application window type if you wish to carry out one of the following
changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Configuring the window contents and template
The contents of the application window are changed with the "Window Contents" and
"Template" attributes.
The "Window Contents" attribute specifies for an application window which application is to be
displayed. The "Template" attribute specifies the template for displaying the window contents.
Depending on the value of the "Window Contents" attribute the following templates are
available:
Window Contents = Global Script
● GSC – diagnostics
The application window is supplied by applications of the Global Script. The results of the
diagnosis system are displayed.
● GSC – Runtime
The application window is supplied by applications of the Global Script. The analysis results
regarding characteristics in Runtime are displayed.
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Window Contents = Print Jobs
● All Jobs
The application window is supplied by the logging system. The available reports are
displayed as a list.
● All Jobs – Context Menu
The application window is supplied by the logging system. The available reports are
displayed as a list. The shortcut menu enables the selection of print options, display of a
print preview as well as a printout of the log.
● Job Detail View
The application window is supplied by the logging system. The available reports are
displayed in a selection menu. Detailed information is displayed for the selected report.
● Selected Jobs – Context Menu
The application window is supplied by the logging system. The available reports are
displayed as a list. This list only contains reports which you have activated the option "Mark
for print job list" in the "Print Job Properties" dialog. The shortcut menu enables the selection
of print options, display of a print preview as well as a printout of the log.

Window display in Runtime
The application window is displayed in Runtime as a separate window within a process picture.
The characteristics of the window display can be configured with attributes of the
"Miscellaneous" property group.

See also
How to configure the display of windows (Page 507)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

3.8.7.3

How to insert a picture window

Introduction
The picture window offers the option of displaying other pictures that were created with the
Graphics Designer in the current picture. For example, you can continuously update the
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contents of a picture window with dynamics. The size and properties that a picture window has
in runtime are defined in the Graphics Designer.

Inserting a picture window
1. Open the picture in which you want to insert a picture window.
2. Click the "Picture window" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a picture
window.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the picture window to the desired size with the mouse.
The insertion process is finished as soon as you release the mouse button.
Alternatively, you can double-click the "Picture window" object in the object palette. A
picture window with default object properties is then inserted near the picture origin.
Note
If you hold down the <Shift> key during insertion, the "Picture Window" object is created
in the shape of a square.
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5. Drag the rectangle surrounding the object to the new position in order to arrange the object
in the picture.
6. Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.

Configuring the picture window
Double click to open the "Object properties" dialog, in which you define the picture to be
displayed and the other attributes of the picture window.
Picture Name
Double-click the "Picture Name" attribute and select the "*.pdl" picture file that you want to
display in the picture window.
Open integrated picture
Use <Ctrl> and double click to immediately open the process picture integrated in the picture
window.
Specify picture zoom area
You can use the "Scaling factor" attribute to set the zoom factor for the display of the picture
in the picture window.
You can display the integrated process picture in the picture window a zoom area (cut-out) as
well. The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset
Y" attributes.
You use the picture offset to define the fixed point for the scaling of the picture as well.
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Independent picture window
WinCC supports many pictures windows and on several monitors. This requires attributes
"Independent picture window", "Window mode" and "Monitor number". More information on
this can be found under "How to support multiple picture windows".
Note
When using the Microsoft ListView Control in a picture window, use the event "MouseUp"
instead of "ItemClick" to call a script.

See also
How to support multiple picture windows (Page 94)
Selecting pictures (Page 650)
How to configure the display of windows (Page 507)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

3.8.7.4

How to insert a control

Introduction
The "Control" object offers the option of integrating system process control and monitoring
elements into a picture. Controls are prefinished objects such as for example alarm windows,
measurement value windows, selection dialogs or buttons. ActiveX Controls, WinCC Controls
and controls from other manufacturers are available if they are registered in the operating
system. These are changed as required and dynamically integrated into the process. The size
and properties which a control accepts in Runtime are defined in the Graphics Designer.
For the detailed description of the controls and their configuration dialogs see "Working with
Controls".
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Requirements
● The use of the configuration dialogs is activated under "Tools > Settings..." on the "Options"
tab.

Procedure
1. Open the picture in which you want to insert a control.
2. Click the "Control" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the control to the required size with the mouse button pressed.
The "Insert a Control" dialog is opened.
The description of this dialog is to be found in the section "Working with controls".
5. Select one of the controls registered in the operating system and confirm your entry with
"OK".
With some controls, the corresponding configuration dialog opens.
The detailed description of the controls and their configuration dialogs can be found in the
section "Working with Controls".
6. Adapt the settings of the configuration dialog according to your needs and confirm the entry
with "OK".
The insertion process for the object "Control" is finished.
Alternatively, you can select the required control directly in the "Control" tab in the "Standard"
selection window. Step 5 of the procedure described above is not used here.
If you hold down the <Shift> key when inserting the control, the "Control" object is created in
the shape of a square.
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See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)
Working with Controls (Page 368)

3.8.7.5

How to Insert an OLE Object

Introduction
The OLE object enables files created in other programs to be inserted into a picture. Therefore
all OLE object registered in the operating system can be integrated. The size and properties
which an OLE object accepts in Runtime are defined in the Graphics Designer. No changes
can be made to OLE objects in Runtime.
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Requirements
● The desired file type must be registered in the operating system.

Inserting Ole object
1. Open the picture into which you want to insert an OLE object and click the smart object
"OLE object" in the "Standard" selection window.
2. Place the mouse pointer at the position in the picture where you want to insert the OLE
object.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Drag the OLE object to the required size with the mouse button pressed.
The "Insert Object" dialog is opened.
4. Select the option "Create from file" or "Create new".
Note
To prevent problems in Runtime, you have to insert a video object in the "AVI" format as a
control object and not as an OLE object in a picture.

Creating an OLE object from file
With the option "Create from file", an already existing file is chosen for display in the selected
OLE object. You edit the file in the OLE object with the program that is registered for editing
the selected file type in the operating system.
1. Select the option "Create from file".
The "Insert Object" dialog shows an input field, the "Browse..." button and the "Link" check
box.
2. Enter the directory path and the name of the required file in the input field. Or click the
"Browse..." button to select the required file with the "Browse" dialog.
3. Select the "Link" check box if the selected file is not copied to the OLE object but is only
used as a reference.
4. Select the "As icon" check box if only an icon is displayed for the associated file type and
not the contents of the selected file.
5. Confirm the input with "OK".
The insertion process for the "OLE" object is finished.

Creating a new OLE object
The "Create new" option selects a file type for a new file that is created in the selected OLE
object. You edit the file in the OLE object with the program that is registered for editing the
selected file type in the operating system.
1. Select the option "Create new".
The "Insert Object" dialog shows a list of all file types registered in the operating system.
2. Select the object type for the file that you want to create in the selected OLE object.
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3. Select the "As icon" check box if only an icon is displayed for the associated file type and
not the contents of the selected file.
4. Confirm the input with "OK".
The insertion process for the "OLE" object is finished.
5. Double-click the OLE object to edit the embedded file in the OLE object.
The program registered in the operating system for editing the associated file type opens
in the Graphics Designer.
6. Finish editing the embedded file by deselecting the OLE object.
The changes are accepted.
Note
An OLE object that you want to edit in a picture must be in the original path. If the object does
not exist there, double-clicking the OLE object may affect the operation of the Graphics
Designer.
After processing an OLE object, it can occur that the toolbars of the Graphics Designer are
no longer displayed. You can prevent this error after processing an OLE object if you first
close the server application (for example Excel or Paint) before exiting the Graphic Designer.
To restore the display of toolbars, proceed as follows:
1. Select all of the objects available in the active picture.
2. Open the "View" menu and select the "Toolbars..." option.
3. In the "Toolbars" dialog, click the "Reset" button.

Changing an OLE object
Select an object of the "OLE object" type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
Quick Object Configuration (Page 647)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)
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3.8.7.6

I/O Field

How to insert an I/O field
Introduction
The I/O Field can be defined as an input field, an output field or a combined input/output field.
The following data formats are available: Binary, decimal, string and hexadecimal. Limit values
such as "Hidden Input" or "Accept on complete input" can also be specified. The size and
properties which an I/O Field accepts in Runtime are defined in the Graphics Designer.

Requirements
● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools /
Settings..." menu.

Inserting an I/O Field
1. Open the picture in which you want to insert an I/O Field.
2. Click the "I/O field" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the I/O field.
The mouse pointer changes into a crosshair with an object symbol attached.
WinCC: Working with WinCC
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4. Drag the I/O field to the desired size with the mouse button pressed.
The "I/O Field Configuration" dialog is opened.
5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "I/O field" is finished.
Alternatively, you can double-click the "I/O field" smart object in the "Standard" selection
window. An I/O Field with default object properties is then inserted near the picture origin. The
"I/O Field Configuration" dialog opens. As soon as you have confirmed your entries with "OK",
the insertion process is completed.
If you press and hold down <SHIFT> during the insertion, the object "I/O field" takes on the
shape of a square.

Inserting a tag as an I/O field
To access a specific tag value via an I/O field, you can insert the tag directly in the process
picture via drag-and-drop.
Procedure
1. Select the required tag in the "Tag" window.
2. Drag the tag into the process picture.
This creates an I/O field that is connected to the tag.
3. Configure the properties of the I/O field.

Changing an I/O Field
Select an object of the I/O Field type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror and rotate the object.
Use the font palette to change the appearance of the text.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.
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See also
How to configure an I/O Field (Page 563)
How to change limit values and type of value input of an I/O field (Page 564)
How to define the output format for the "Binary" data type (Page 566)
How to define the output format for the "Decimal" data type (Page 567)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to define the output format for the "String" data type (Page 570)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

How to configure an I/O Field
Introduction
The "I/O-Field Configuration" dialog opens after the insertion process if the use of configuration
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast
configuration of the important features of the I/O Field.
You can also open the configuration dialog with the object context menu. You change individual
attributes in the "Object Properties" window.

Tag
You can dynamize the I/O field by interconnecting a tag. Depending on the selected field type,
the value of the tag is displayed as output or changed by an input.
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Enter the name of the required tag or click
section for the detailed description.

to open the "Tags" dialog. See the "Select Tag"

Alternatively, you can drag a tag from the tag selection dialog into a process image to create
an I/O field with this tag connection.

Updating
The frequency of updating the display can be configured for the value displayed as output.
Enter the required interval or select an interval from the drop-down list. See the "Changing
update cycle" section for the detailed description.

Field type
The I/O field can be defined as an input field, an output field or a combined input/output field.
Specify the required field type.

Font
You can change the font for displaying input and output values regardless of the selected field
type.
Click on the buttons to open the associated dialogs.

See also
How to insert an I/O field (Page 561)
How to define the output format for the "String" data type (Page 570)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to define the output format for the "Decimal" data type (Page 567)
How to define the output format for the "Binary" data type (Page 566)
How to change limit values and type of value input of an I/O field (Page 564)
Quick Object Configuration (Page 647)
Selecting a tag (Page 649)

How to change limit values and type of value input of an I/O field
Introduction
You can define a value range for input and output of an I/O field using limit values. Values
outside this value range cannot be displayed or input. You can make additional settings that
offer protection against accepting incorrect values for the value input.
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Setting Limit Values
The "High Limit Value" attribute defines the maximum limit value for input and output. The "Low
Limit Value" attribute defines the minimum limit value for input and output. The specified value
depends on the "data format" of the I/O field.
If a value is lower than the low limit value or higher than the high limit value, the following
effects may occur in Runtime:
● Field type = "Input"
The "WinCC Runtime" dialog is opened and displays the error message "The entered value
is outside the configured limits". Confirm the error message with "OK" and enter another
value.
● Field type = "Output"
The display of the value is substituted by the character string "***".
You can change the "Data Format" and "Field Type" attributes in the "Output / Input" property
group. You cannot specify a limit value for the "String" format.

Input value into an I/O Field
1. Double-click the I/O field.
The input mode opens. A placeholder is displayed for every character in accordance with
the set output format. If a value has already been entered, it is displayed as marked.
2. Enter a new value.
3. Depending on the setting of the attributes of the I/O Field, the value is accepted on
completion of input or the input must be finished by pressing <Enter> .

Specifying type of value input
Immediate Input
The "Immediate Input" attribute specifies for input fields whether a direct change is made into
the input mode on jumping to the object.
Clear on New Input
The "Clear on New Input" attribute specifies whether the field contents are cleared when
selecting the input field.
Clear on Invalid Input
The "Clear on Invalid Input" attribute can be used to prevent adoption of an incorrect input
value when the field is left. For example, an input value that does not correspond to the
predefined data format of the input field is incorrect.
Apply on Full
The "Apply on Full" attribute specifies when an input value is applied. If the attribute has the
value "No", the input value is only applied when the input is confirmed with <Enter> . Otherwise
the input value is automatically applied as soon as the preset number of characters has been
entered.
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Apply on Exit
The "Apply on Exit" attribute can also be enabled for a value input in the event that the I/O
Field is exited without prior confirmation or reaching the required number of characters.
Hidden Input
The "Hidden Input" attribute specifies whether the input value is displayed during input as
normal or encrypted. If this attribute has the value "Yes", every character input is replaced with
the "*" character. The value entered and the data format of the value cannot be recognized.

Continue to shoe input value after <Enter>
After confirming the entry with <Enter>, the entered value is deleted. If you configure a direct
connection between the "Input value" attribute and the "Output value" attribute, the input value
continues to be shown after confirming with <Enter>.

See also
How to insert an I/O field (Page 561)
How to define the output format for the "String" data type (Page 570)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to define the output format for the "Decimal" data type (Page 567)
How to define the output format for the "Binary" data type (Page 566)
How to configure an I/O Field (Page 563)

How to define the output format for the "Binary" data type
Introduction
Four different data formats are available for the input and output of values in an I/O field.
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data
format must be specified for the I/O field to display text.
Based on the specified data format different output formats can be selected or freely defined
for displaying the field contents.
The definition for an output format can be rewritten as a sequence of formatting codes. The
formatting codes act as placeholders for a specific group of characters. For example, if a
formatting code for which only the display of the numbers 0-9 is preset for a specific position
in the display of an I/O field, only letters can be input at this position.
Note
If the value you want to display does not correspond exactly to the definition of the output
format, only three asterisks are displayed. This applies for the length of the entire character
string and also for the type and position of the individual characters.
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Formatting codes - "Binary" data type
1
0

Placeholder for the binary values 0 and 1. The number of the formatting code "1" specifies
the permissible number of positions for displaying a binary value.
If necessary a leading zero is placed before the binary value. The output format can
therefore begin with the formatting code "0", but can only have this once.

Example - "Binary" data type
The 8-digit binary value 10011101 can be displayed as follows:
Output format

Allowed number of positions

Display

11

2

01

011

2 + leading zero

001

1111

4

1101

01111

4 + leading zero

01101

1111111

7

0011101

01111111

7 + leading zero

00011101

1111111111

10

10011101

01111111111

10 + leading zero

010011101

See also
How to insert an I/O field (Page 561)
How to define the output format for the "String" data type (Page 570)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to define the output format for the "Decimal" data type (Page 567)
How to change limit values and type of value input of an I/O field (Page 564)
How to configure an I/O Field (Page 563)

How to define the output format for the "Decimal" data type
Introduction
Four different data formats are available for the input and output of values in an I/O field.
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data
format must be specified for the I/O field to display text.
Based on the specified data format different output formats can be selected or freely defined
for displaying the field contents.
The definition for an output format can be rewritten as a sequence of formatting codes. The
formatting codes act as placeholders for a specific group of characters. For example, if a
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formatting code for which only the display of the numbers 0-9 is preset for a specific position
in the display of an I/O field, only letters can be input at this position.
Note
If the value you want to display does not correspond exactly to the definition of the output
format, only three asterisks are displayed. This applies for the length of the entire character
string and also for the type and position of the individual characters.

Formatting codes - "Decimal" data type
9

,
s
0

e

Placeholder for the binary values 0 and 9. The number of the formatting code "9" specifies
the permissible number of positions for displaying a decimal value. If the actual number
of decimal places exceeds the number specified in the display format, the displayed value
is rounded out.
A comma defines the position for decimal point. The formatting code "," can be at any
position in the output format, but can only be used once.
Positive decimal numbers are displayed with signs. The formatting code "s" must be at
the first position of the output format and must be used only once.
Leading and following zeroes are displayed when the actual number of position before
and after the decimal point is less that the number set in the display format. The formatting
code "0" must be before the first "9" and must be used only once.
The decimal number is displayed in exponential format. The formatting code "e" must be
at the last position of the output format and must be used only once.

Example - "Decimal" data type
The 6-digit decimal number 123.456 can be displayed as follows:

568

Output format

Allowed number of positions

Display

999

3

124

999.9

4

123.5

s999.9

4 + sign

+123.5

999.999

6

123.456

09999.9999

8 + zeroes

0123.4560

s09999.9999

8 + sign + zeroes

+0123.4560

1111111111

10

10011101

9.99999e

6

1.23456e+002
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Note
If a floating point number is saved in the IEEE format of the S5, an output format that allows
the sign and exponent should be used for display in an I/O Field (e.g. s0999.999e).

See also
How to configure an I/O Field (Page 563)
How to change limit values and type of value input of an I/O field (Page 564)
How to define the output format for the "Binary" data type (Page 566)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to define the output format for the "String" data type (Page 570)
How to insert an I/O field (Page 561)

How to define the output format for the "Hexadecimal" data type
Introduction
Four different data formats are available for the input and output of values in an I/O field.
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data
format must be specified for the I/O field to display text.
Based on the specified data format different output formats can be selected or freely defined
for displaying the field contents.
The definition for an output format can be rewritten as a sequence of formatting codes. The
formatting codes act as placeholders for a specific group of characters. For example, if a
formatting code for which only the display of the numbers 0-9 is preset for a specific position
in the display of an I/O field, only letters can be input at this position.

Note
If the value you want to display does not correspond exactly to the definition of the output
format, only three asterisks are displayed. This applies for the length of the entire character
string and also for the type and position of the individual characters.
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Formatting codes - "Hexadecimal" data type
f

0

Placeholder for the letters A-F and a-f and the digits 0-9, which are used to display
hexadecimal numbers. The allowed number of characters is defined by the number of the
formatting code "f" in the output format.
Leading zeros of the hexadecimal value are displayed if the output format begins with the
formatting code "0". The formatting code "0" must be included only once.

See also
How to configure an I/O Field (Page 563)
How to change limit values and type of value input of an I/O field (Page 564)
How to define the output format for the "Binary" data type (Page 566)
How to define the output format for the "Decimal" data type (Page 567)
How to define the output format for the "String" data type (Page 570)
How to insert an I/O field (Page 561)

How to define the output format for the "String" data type
Introduction
Four different data formats are available for the input and output of values in an I/O field.
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data
format must be specified for the I/O field to display text.
Based on the specified data format different output formats can be selected or freely defined
for displaying the field contents.
The definition for an output format can be rewritten as a sequence of formatting codes. The
formatting codes act as placeholders for a specific group of characters. For example, if a
formatting code for which only the display of the numbers 0-9 is preset for a specific position
in the display of an I/O field, only letters can be input at this position.

Note
If the value you want to display does not correspond exactly to the definition of the output
format, only three asterisks are displayed. This applies for the length of the entire character
string and also for the type and position of the individual characters.
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Formatting codes - "String" data type
The allowed length of a character string is defined by the number of formatting codes used
(exception "*").
*
?
a
A
b
B
1-9

h

t

Input of a character string of any length
Input of any character string
Lower-case letters, upper-case letters and digits are allowed
no separators or similar.
Upper-case letters and digits are allowed
no lower case letters, separators or similar.
Lower-case letters and upper-case letters are allowed
no digits, separators or similar.
Only upper-case letters are allowed
no lower case letters, digits, separators or similar.
The formatting codes "1", "2", ..., "9" are used as placeholders for digits.
The selected formatting code also defines the actual digits allowed: For example, if
the "2" is specified, only the digits 0, 1 or 2 can be displayed. The formatting code
"8" allows all digits except for the 9.
Only the digits 0-9 and the letters A-F or a-f are allowed.
The formatting code "h" allows only characters that are required to display
hexadecimal numbers.
The formatting code "t" forces input of a separator at the specified position. These
separators are valid: Slash, colon, comma, period and space.

See also
How to configure an I/O Field (Page 563)
How to change limit values and type of value input of an I/O field (Page 564)
How to define the output format for the "Binary" data type (Page 566)
How to define the output format for the "Decimal" data type (Page 567)
How to define the output format for the "Hexadecimal" data type (Page 569)
How to insert an I/O field (Page 561)
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3.8.7.7

Bar

How to insert a bar
Introduction
The "Bar" object offers the option of displaying values graphically. The values can also be
displayed in a combined view as graphics with freely definable number scale. The size and
properties which a bar accepts in Runtime are defined in the Graphics Designer.
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Requirements
● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools /
Settings..." menu.

Inserting bar
1. Open the picture in which you want to insert a bar.
2. Click the "Bar" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a bar.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the bar to the desired size with the mouse button pressed.
The "Bar Configuration" dialog is opened.
5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "Bar" object is finished.
As an alternative, double-click the "Bar" smart object in the "Standard" selection window. A
bar with default object properties is then inserted near the picture origin. The "Bar
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the
insertion process is completed.
If you press and hold down <SHIFT> during the insertion, you create the "Bar" object in the
shape of a square.

Changing bar
Select an object of the bar type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror and rotate the object.
Use the font palette to change the appearance of the text.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.
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See also
How to configure a bar (Page 574)
How to configure the limits of a bar (Page 575)
How to configure the bar scale (Page 577)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

How to configure a bar
Introduction
The "Bar Configuration" dialog opens after the insertion process if the use of configuration
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast
configuration of the important features of the bar.
You can also open the configuration dialog with the object context menu. You change individual
attributes in the "Object Properties" window.

Tag
You can dynamize the display value of the bar by embedding a tag.
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Enter the name of the required tag or click the tag icon to open the "Tags" dialog. See the
"Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed by the bar.
Enter the required interval or select an interval from the drop-down list. See the "Changing
update cycle" section for the detailed description.

Limits
The two ends of the bar view are specified by the maximum value and the minimum value of
the bar.
Enter the required limits for the bar display. See "How to configure the limits of a bar" for the
detailed description.

Bar direction
Specify the direction of the coordinate axis to which the maximum display value of the bar
points.
See "How to adapt the bar scale" for the detailed description.

See also
Selecting a tag (Page 649)
How to configure the limits of a bar (Page 575)
How to configure the bar scale (Page 577)
How to insert a bar (Page 572)
Quick Object Configuration (Page 647)

How to configure the limits of a bar
Introduction
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
Name

Upper limit (High)

Lower limit (Low)

Alarm limit A
Warning limit W
Tolerance limit T
Reserve 4 R4
Reserve 5 R5

AH – Alarm High
WH – Warning High
TH – Tolerance High
RH4 – Reserve High 4
RH5 – Reserve High 5

AL – Alarm Low
WL – Warning Low
TL – Tolerance Low
RL4 – Reserve Low 4
RL5 – Reserve Low 5

General: Limit X

XH – High Limit Value of limit X

XL – Low Limit Value of limit X
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Upper limit, Lower limit, type
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.

Bar color, Change Color
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.

Monitoring, Limit Marker
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.

Trend
The "Trend" attribute specifies whether or not the trend is displayed.
The trend display enables a fast overview of changes for the bar. If the value displayed in the
scale is exceeded, a small arrow is displayed beside the scale by default. The arrow indicates
that the measured value cannot be displayed on the scale. Another scale can be shown on
the other side of the bar to avoid having to wait for the next update. This arrow shows the trend
of the current movement of the bar.

Hysteresis, Hysteresis Range
So that a color change is not triggered immediately in the case of a slight limit violation, the
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for
the display of the value.
The "Hysteresis" attribute specifies for the "Bar" object whether the display with hysteresis is
permitted or not.
The "Hysteresis Range" attribute specifies for the "Bar" object the hysteresis as a percentage
of the display range.

See also
How to configure a bar (Page 574)
How to configure the bar scale (Page 577)
How to insert a bar (Page 572)

576

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.8 Working with Objects

How to configure the bar scale
Introduction
The "Bar" object can be labeled by showing a scale. The layout and graduation of the scale
and the size and format of the label can be configured by changing the relevant attributes as
required.

Setting scale end values and zero point value
The attribute "Maximum value" defines the absolute value for the display of the highest value.
The attribute "Minimum value" defines the absolute value for the display of the smallest value.
The attribute "Zero point value" defines the absolute value for the zero value of the bar.

Specifying the arrangement the scale
The "Scale" attribute specifies for the "Bar" object whether the bar is labeled with a scale.
The "Bar Direction" attribute specifies for the "Bar" object the direction of the coordinate axis,
which the highest display value of the bar points to.
The "Alignment" attribute defines the arrangement of the scale relative to the bar for the
"Bar" object. Depending on the setting for the "Bar Direction" attribute in the "Geometry"
property group, the scale can be displayed to the left or right or above or below the bar.
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Defining bar segments
The "Scale Marks" attribute specifies the number of segments into which the bar is divided by
the large tick marks of the scale.
The "Axis Section" attribute defines the distance between the large tick marks. The value is
shown as the difference in value between two adjacent large tick marks.

Specifying scale division
The "Zero Point" attribute specifies for the representation of the bar in which position the zero
point value is displayed. The value is specified relative to the spacing of the scale end values
in %. For a value of 0 %, for example, the zero point value is shown at the height of the large
tick mark with the lowest value. The zero point can also be outside of the range represented.
The "Zero Point" attribute is only evaluated if the "Bar Scaling" attribute has the value
"Automatic". The absolute value for the zero point is set with the "Zero Point Value" attribute
in the "Miscellaneous" property group.
The "Bar Scaling" attribute specifies the type of scale division. By selecting suitable scale
divisions, it is possible to emphasize a particular range of values in the bar display.

578

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.8 Working with Objects

Specifying the format of tick marks
The "Large Tick Marks Length" attribute specifies for the "Bar" object whether the sections
between the large tick marks in the scale of the bar are divided by shorter tick marks.
The "Large Tick Marks" attribute specifies whether the large tick marks of the scale are shown
in bold or normal.
The "Length of Large Tick Marks" attribute specifies the length of the large tick marks. The
length of the shorter tick marks corresponds to half of the value specified here. The values are
specified in pixels.

Specifying the format of labeling
The "Label Each" attribute specifies the number of labeled large tick marks. If, for example,
the attribute has the value "3", only every third large tick mark is labeled, starting with the large
tick mark with the lowest value.
The "Exponent Display" attribute shows whether the numerical values of the scale are shown
as exponents or as decimal values without exponents.
The "Decimal Places" attribute specifies the number of digits before the decimal point for the
display of numerical values in the scale.
The "Decimal Places" attribute specifies the number of digits to the right of the decimal point
for the numerical value display in the scale.

See also
How to configure a bar (Page 574)
How to configure the limits of a bar (Page 575)
How to insert a bar (Page 572)

3.8.7.8

How to insert a graphic object

Introduction
The graphic object enables graphics created in other programs to be inserted into a picture.
You can insert graphics or images with the following formats:
EMF, WMF, DIB, BMP (up to 32 Bit), GIF, JPEG, ICO and PNG 1).
1)

If you use the global design "WinCC Classic", the format PNG is not available.

The size and properties that a graphic object has in runtime are defined in the Graphics
Designer.
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Requirements
● The use of the configuration dialogs is activated under "Tools > Settings..." on the "Options"
tab.

Inserting Graphic Object
1. Open the picture in which you want to insert a graphic object.
2. Click the "Graphic object" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a graphic
object.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the graphic object to the required size.
The "Graphic Object Configuration" dialog opens.
5. Select the picture that is displayed in the graphic object.
The description of the configuration dialog can be found in the next section.
6. Click "OK" to confirm your input.
The insertion process for the "Graphic Object" is finished.
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As an alternative, double-click the "Graphic object" smart object in the "Standard" selection
window. A graphic object with default object properties is then inserted near the picture origin.
The "Graphic Object Configuration" dialog opens. The insertion process is finished when you
confirm your inputs with "OK".
If you hold down the <Shift> key during insertion, the "Graphic object" object is created in the
shape of a square.

Configuring a graphic object
The "Graphic object configuration" dialog opens after the insertion process if the use of
configuration dialogs is enabled in the "Options" tab under "Tools > Settings...". It enables fast
configuration of the important features of the graphic object.
You can open the configuration dialog with the pop-up menu for the object. You can change
the individual attributes in the "Object Properties" window.

Preview
The picture selected in the picture selection is displayed as a preview.
Selection of picture
The picture selection shows all pictures in the EMF, WMF, DIB, BMP, GIF, JPEG, ICO and
PNG formats that are in the graphics directory "GraCS" of the current WinCC project.
Select the picture that is displayed in the graphic object. Click on the "Browse ..." button to
insert additional pictures from the picture selection.
See the "Select pictures" section for the detailed description.

Changing Graphic Object
Select an object of the graphic object type if you wish to carry out one of the following changes:
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Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks on the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the "Rotate" element of the object palette to rotate the object.
Use elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.
Note
If the "Picture Transparent Color On" attribute has the value "Yes" for a graphic object, the
available flash frequency is also reduced if necessary.

See also
Selecting pictures (Page 650)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

3.8.7.9

Status display

How to insert a status display
Introduction
The status display offers the option to display almost any number of different states of an
object. The states are implemented via tags whose value corresponds to the respective state.
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The states are displayed via the assigned pictures. The size and properties which a status
display accepts in Runtime are defined in the Graphics Designer.

Requirements
● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools /
Settings..." menu.

Inserting a status display
1. Open the picture in which you want to insert a status display.
2. Click the "Status display" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the status
display.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the status display to the desired size with the mouse button pressed.
The "Status Display Configuration" dialog is opened.
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5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "Status display" object is finished.
As an alternative, double-click the "Status display" smart object in the "Standard" selection
window. A line with default object properties is then inserted near the picture origin. The "Status
Display Configuration" dialog opens. As soon as you have confirmed your entries with "OK",
the insertion process is completed.
If you press and hold down <SHIFT> during the insertion, you create the "Status display" object
in the shape of a square.

Changing a status display
Select an object of the Status Display type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the color palette to change the frame color.
Use elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
How to configure a status display (Page 584)
How to configure states (Page 586)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Standard Objects (Page 512)

How to configure a status display
Introduction
The "Status Display Configuration" dialog opens after the insertion process if the use of
configuration dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. The
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"Status Display Configuration" dialog enables fast configuration of the important features of
the status display.
You can also open the configuration dialog with the object context menu. You change individual
attributes in the "Object Properties" window.

Tag
You can dynamize the value of the status to be displayed by embedding a tag.
Enter the name of the required tag or click the tag icon to open the "Tags" dialog. See the
"Select Tag" section for the detailed description.

Updating
You specify the frequency of updating the display for the status display.
Enter the required interval or select an interval from the drop-down list. See the "Changing
update cycle" section for the detailed description.

Status list
The status list shows the linked pictures and the specified flash frequency for all configured
states.
States can be inserted and every setting can be changed through the context menu. You can
reference the pictures of the picture selection by dragging them with the mouse to the required
position in the status list. See the "How to configure states" section for the detailed description.
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Bit position
You can also assign a status to a specific bit position of the tags.
Click the arrow keys to select a bit position. Click the field "Add" to enter the status of this bit
position in the status list. Click the "Add" button again to add the next highest bit position.
See the "How to configure states" section for the detailed description.

Preview
The picture selected in the picture selection is displayed as a preview.

Selection of picture
The picture selection shows all pictures in the graphics directory "GraCS" of the current WinCC
project. You can insert graphics or images with the following formats: BMP, DIB, ICO, CUR,
EMF, WMF, GIF and JPG.
Use the mouse to drag a picture of the picture selection to the desired position in the status
list in order to assign it to a status as a basic picture or a flash picture. Click the "Browse ..."
button to insert additional pictures from the picture selection.
You will find the detailed description in the section "Select pictures".

See also
Selecting pictures (Page 650)
Selecting a tag (Page 649)
How to configure states (Page 586)
How to insert a status display (Page 582)

How to configure states
Introduction
In Runtime the states are displayed via the assigned pictures. If you have not specified a picture
that you want to display for a status, the symbol for the status display is shown as a placeholder.
If a status that has not been configured occurs in Runtime, the pictures of the prior status are
shown. The settings for the following status are shown if there was no prior status.
You configure the states in the "Status Display Configuration" dialog in the status list.
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The status list is divided into four columns whose width can be changed. Every line of the
status list shows the settings for a specific state. You configure the following settings through
the context menu in the status list:
● Status column
Shows the value of the configured state. You can add or delete states. The command "Clear
List" removes all states to which no picture is assigned.
● Basic Picture column
Shows the name of the picture that is displayed in Runtime when the status happens. You
can delete the basic picture of a status.
● Flash Picture column
Shows the name of the picture that is displayed alternating with the basic picture, if a flash
frequency is set for the flashing attribute. You can delete the flash picture of a status.
● Flashing attribute column
Displays the set flash frequency. You can set the values "No flashing", "Slow", "Medium"
and "Fast".

Inserting a status
Select the position in the "State" column at which you wish to insert a status. Select the entry
"Add" in the context menu. The status for the next free position is inserted.
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Inserting a status as a bit position
Click the arrow key to select a bit position. Click the field "Add" to enter the status of this bit
position in the status list. The value selected as bit position is increased by one position. Click
the "Add" button again to insert the next higher bit position.

Renaming status
Double-click the position in the state column at which you wish to rename a status. Enter the
new value and confirm this by pressing <ENTER>. If the new value is already assigned, no
change is made.

Deleting a status
Select the position in the state column at which you wish to delete a status. Select the entry
"Remove" in the context menu. The status is deleted so long as at least one additional status
is configured.

Clearing a status list
Open the pop-up menu at any status in the state column and select the entry "Clear List". All
states to which no pictures are assigned are cleared.

Assigned pictures
Select the picture in the picture selection that you want to assign a status as basic picture or
flash picture. Drag the picture to the desired position with the mouse. An existing picture is
replaced by the new picture.

Delete pictures
Select the entry "Delete" in the pop-up menu of a configured picture to remove the picture from
the status list.

Changing a flashing attribute
If a status is assigned only one basic picture, the associated flash automatically receives the
"no flashing" attribute. If a basic picture and flash picture are assigned to a status, you can
change the flash with the pop-up menu.

See also
How to configure a status display (Page 584)
How to insert a status display (Page 582)
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3.8.7.10

Text list

How to add a text list
Introduction
The text list offers the option of assigning specific values to a text.
You can use the text list:
● As an input list
● As an output list
● As a combined input / output list
The following data formats are available:
● Decimal
● Binary
● Bit.
The size and properties which a text list has in Runtime are defined in the Graphics Designer.
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Requirements
● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools /
Settings..." menu.

Inserting a text list
1. Open the picture in which you want to insert a text list.
2. Click the "Text list" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the text list.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the text list to the required size with the mouse button pressed.
The "Text List Configuration" dialog is opened.
5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "Text List" object is finished.
As an alternative, double-click the "Text list" smart object in the "Standard" selection window.
A text list with default object properties is then inserted near the picture origin. The "Text List
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the
insertion process is completed.
If you press and hold down <SHIFT> during the insertion, you create the "Text List" object in
the shape of a square.
Note
If you assign a text to a value in the text list, the text must not include a semicolon.
The semicolon is a WinCC control character and is therefore automatically deleted in a text.

Changing a text list
Select an object of the text list type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements of the object palette to mirror or rotate the object.
Use the font palette to change the appearance of the text.
Use the color palette to change the background color.
Use the elements in the style palette to change the display style for the object.

590

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.8 Working with Objects
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
How to configure a text list (Page 591)
How to configure apply values and display text of a text list (Page 592)
How to configure assignments for the "Decimal" type list (Page 593)
How to configure assignments for the "Binary" list type (Page 595)
How to configure assignments for the "Bit" list type (Page 596)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

How to configure a text list
Introduction
The "Text List Configuration" dialog opens after the insertion process if the use of configuration
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. You can also open the
configuration dialog with the object context menu. You change individual attributes in the
"Object Properties" window.
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Tag
You can dynamize the text list by embedding a tag. Depending on the selected field type, the
value of the tag can be displayed as output or changed by an input.
Enter the name of the required tag or click
section for the detailed description.

to open the "Tags" dialog. See the "Select Tag"

Updating
The frequency of updating the display can be configured for the value displayed as output.
Enter the required interval or select an interval from the drop-down list. See the "Changing
update cycle" section for the detailed description.

Field type
You can define the text list as an input list, an output list or as a combined input/output list.
Specify the required field type.

Font
You can change the font for displaying input and output values regardless of the selected field
type.
Click on the buttons to open the associated dialogs.

See also
Selecting a tag (Page 649)
How to configure apply values and display text of a text list (Page 592)
How to configure assignments for the "Decimal" type list (Page 593)
How to configure assignments for the "Binary" list type (Page 595)
How to configure assignments for the "Bit" list type (Page 596)
How to add a text list (Page 589)
Quick Object Configuration (Page 647)

How to configure apply values and display text of a text list
Introduction
You can change the following attributes, among other things, for the "Text list" object using
the object properties.

Changing an output value
The "Output Value" attribute specifies a start value for the output which is displayed in Runtime
in the case of a missing process driver connection or if an update has not yet taken place.
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Activating apply values on exit
The "Apply on Exit" attribute specifies whether the input is applied when you exit the text list
with <TAB> or by clicking the mouse.

Specifying a text reference
The "Text Reference" attribute specifies where the language-dependent assignment texts are
stored. The texts can be managed directly in the object or in the text library where the
translation into other languages is made.

Configuring assignments
The "Assignments" attribute in the "Input/Output" property group allows display texts to be
specified. The display texts are displayed depending on the current "Output Value".
Note
If you assign a text to a value in the text list, the text must not include a semicolon.
The semicolon is a WinCC control character and is therefore automatically deleted in a text.

See also
How to configure a text list (Page 591)
How to configure assignments for the "Decimal" type list (Page 593)
How to configure assignments for the "Binary" list type (Page 595)
How to configure assignments for the "Bit" list type (Page 596)
How to add a text list (Page 589)

How to configure assignments for the "Decimal" type list
Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute
in the "Input/Output" property group allows display texts to be specified. The display texts are
displayed depending on the current "Output Value".
With the "Decimal" list type you can assign specific values or value ranges to display texts.

Requirements
● Select the "Decimal" list type in the "Output/Input" property group.
● Open the "Text list assignments (decimal)" dialog by double-clicking the "Assignments"
attribute.
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Defining new assignments
1. Select a range type from the drop-down list to specify the required value range:
– Single value - a display text is assigned to a single value.
– From value - a display text applies to all values greater than or equal to the specified
value.
– To value - a display text applies to all values less than or equal to the specified value.
– From-to value - a display text applies to all values within the specified range of values.
2. Enter the desired value or value range.
3. Enter the text that you want to display for this value or value range. The text must not include
a semicolon.
4. Click the "Append" button.
The new assignment is input into the assignments list.

Sorting assignments
Select the assignments that you want to sort. Click the "Up" or "Down" button to move these
assignments in the assignments list.

Deleting assignments
Select the assignments that you want to delete in the assignments list and click the "Delete"
button.

See also
How to configure a text list (Page 591)
How to configure apply values and display text of a text list (Page 592)
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How to configure assignments for the "Binary" list type (Page 595)
How to configure assignments for the "Bit" list type (Page 596)
How to add a text list (Page 589)

How to configure assignments for the "Binary" list type
Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute
in the "Input/Output" property group allows display texts to be specified. The display texts are
displayed depending on the current "Output Value".
Display texts are assigned by bit number for the "Binary" list type. You can define up to 32
display texts. If a bit set in the output value is not assigned a display text, three asterisks appear
in the drop-down list.

Requirements
● Select the "Binary" list type in the "Output/Input" property group.
● Open the "Text list assignments (binary)" dialog by double-clicking the "Assignments"
attribute.

Defining new assignments
1. Enter the bit number that you want to assign to a display text.
2. Enter the desired display text. The text must not include a semicolon.
3. Click the "Append" button.
The new assignment is input into the assignments list.
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Sorting assignments
Select the assignments that you want to sort. Click the "Up" or "Down" button to move these
assignments in the assignments list.

Deleting assignments
Select the assignments that you want to delete in the assignments list and click the "Delete"
button.

See also
How to configure a text list (Page 591)
How to configure apply values and display text of a text list (Page 592)
How to configure assignments for the "Decimal" type list (Page 593)
How to configure assignments for the "Bit" list type (Page 596)
How to add a text list (Page 589)

How to configure assignments for the "Bit" list type
Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute
in the "Input/Output" property group allows display texts to be specified. The display texts are
displayed depending on the current "Output Value".
With the "Bit" list type one display text each can be defined for the statuses "1 - Bit set" and
"0 - Bit not set" of the relevant bit in the output value. The "Bit Number" attribute specifies the
number of the relevant bit in the output value.

Requirements
● Select the "Bit" list type in the "Output/Input" property group.
● Open the "Text list assignments (bit)" dialog by double-clicking the "Assignments" attribute.

Defining assignments

Enter the required display text for the states "0" and "1" and confirm the assignments with
"OK". The display text must not include a semicolon.

596

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.8 Working with Objects

See also
How to configure a text list (Page 591)
How to configure apply values and display text of a text list (Page 592)
How to configure assignments for the "Decimal" type list (Page 593)
How to configure assignments for the "Binary" list type (Page 595)
How to add a text list (Page 589)

3.8.7.11

How to insert multiline text

Introduction
The "Multiline Text" object makes it possible to display multiple lines of text in a rectangle in
the picture. If the text is larger than the rectangle, WinCC automatically adds a scroll bar on
the right-hand edge.
If you enable operation, the operator can scroll and edit the text in Runtime. By connecting
variables, you can use the multilined text for entering or outputting text.
You define the size and properties of the "Multiline Text" object in the Graphics Designer.
2EMHFWRULJLQ
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Insert multiline text
1. Open the picture into which you want to insert the object.
2. Click the "Multiline Text" smart object in the "Standard" selection window.
3. Move the cursor to the screen position where you want to insert the "Multiline Text" object.
The mouse pointer changes into a crosshair with an object symbol attached.
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4. Drag the rectangle to the desired size with the mouse.
The insertion process is finished as soon as you release the mouse button.
As an alternative, double click in the Object palette on the smart object "Multiline text".
The object with the default object properties is inserted near the picture origin.
5. Drag the rectangle surrounding the object to the new position in order to arrange the object
in the picture.
6. Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
7. In order to change the background color, use the color palette.
8. Use elements of the Style Palette to change the display style for the object.

Edit multiline text
Select the "Properties" menu point in the shortcut menu of the object and define the attributes
of the "Multiline Text" object in the "Object properties" window.

"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the text
in the "Dialog" window.
"Miscellaneous" property group
If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access
authorization, the operator can scroll the window and edit text in runtime.
Dynamization
If you connect tags to the "Text" attribute, you can use the "Multiline Text" object for entering
and outputting text.

3.8.7.12

How to insert a combobox

Introduction
The combobox makes it possible to select one of many possible text records from a drop-down
list for displaying and inserting in runtime. You can define the texts with tags.
The size and properties which a combobox takes on in runtime are defined in the Graphics
Designer.
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Insert combobox
1. Open the picture into which you want to insert an combobox.
2. Click the "Combobox" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a combobox.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Press the mouse button and drag the combobox to the required size.
The insertion process is finished as soon as you release the mouse button.
Alternatively you can double-click the smart object "Combobox" in the object palette. A
combobox with default object properties is then inserted near the picture origin.
5. Drag the rectangle surrounding the object to the new position in order to arrange the object
in the picture.
6. Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
7. In order to change the background color, use the color palette.
8. Use elements of the Style Palette to change the display style for the object.
Note
The color that backs the respectively selected field in runtime is defined in the operating
system as the color for the "Selected elements" and cannot be changed in WinCC.

Edit combobox
Select the "Properties" menu point in the context menu (pop-up menu) of the object and define
the attributes of the combobox in the "Object properties" window.
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"Geometry" property group
Use the "Number of rows" attribute to define the amount of lines shown in the combobox.
"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the
respective text for each index from "1" to "Number of rows".
"Miscellaneous" property group
The "Selected text" attribute defines the index, the text of which is displayed in the combobox
in runtime.

If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access
authorization, the operator can drop the combobox down and select another text in runtime.

Dynamics
If you connect the respective tags, you can use the combobox:
● For the entry of a predefined text or the respective index.
● For the output of one or many predefined text records.
With other tags, you can predefine the text records dynamically yourself.

3.8.7.13

How to insert a list box

Introduction
The list box make it possible to highlight one of many text records or select it for entry in runtime.
If the list is longer than the list box, scroll bars are added to the list box.
The size and properties that a list box has in runtime are defined in the Graphics Designer.
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Insert list box
1. Open the picture into which you want to insert an list box.
2. Click the "List box" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a list box.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the list box to the desired size.
The insertion process is finished as soon as you release the mouse button.
Alternatively you can double-click the smart object "List box" in the object palette. A list box
with default object properties is then inserted near the picture origin.
5. Drag the rectangle surrounding the object to the new position in order to arrange the object
in the picture.
6. Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
7. In order to change the background color, use the color palette.
8. Use elements of the Style Palette to change the display style for the object.

Edit list box
Select the "Properties" menu point in the shortcut menu of the object and define the attributes
of the list box in the "Object properties" window.
"Geometry" property group
Use the "Number of rows" attribute to define the amount of entries that the list box has. The
number of displayed entries is defined by the height of the list box.
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Make sure that the list box is wide enough for displaying the text. Horizontal scrolling is not
possible. Text that is too long will be cut off.

"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the
respective text for each index from "1" to "Number of rows".
"Miscellaneous" property group
The "Selected box" attribute defines the index, the text of which is highlighted in the list box
when runtime is started.

If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access
authorization, the operator can select another text and highlight it in the list box in runtime.

Note
The color that backs the respectively selected field in runtime is defined in the operating
system as the color for the "Selected elements" and cannot be changed in WinCC.
Dynamization
If you connect tags to the respective attributes, you can use the list box for the following:
● For entering a predefined text record or the respective index
● For outputting one of the predefined text records
You can also make the predefined text records dynamic with the respective text tags.
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3.8.7.14

How to insert a Faceplate instance

Introduction
You can insert a Faceplate instance into your picture with the Faceplate object. Faceplate
types must first exist in the WinCC project.
Faceplates are preconfigured combinations of objects. You save such a combination as a
Faceplate type and can use them again and again as Faceplate instances afterwards.
The size and properties that a Faceplate instance takes on in runtime are defined in the
Graphics Designer.

Insert Faceplate instance
1. Open the picture in which you want to insert a Faceplate instance.
2. Click the "Faceplate instance" smart object in the "Standard" selection window.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Click with the mouse on the point in the picture that you would like to insert the Faceplate
instance.
The file selection dialog opens.
4. Select the desired FPT file.
5. Drag the Faceplate instance to the desired size with the mouse.
As an alternative, double-click the "Faceplate instance" smart object in the "Standard"
selection window and select the Faceplate type. A Faceplate instance with default object
properties is then inserted near the picture origin.

Change Faceplate instance
Select the "Properties" menu point in the context menu (pop-up menu) of the Faceplate
instance and edit the attributes of the Faceplate instance in the "Object properties" window.
The properties that you can change here depend on how the properties of the Faceplate type
are defined. Every Faceplate type has two types of attributes:
● Type-specific attributes: You can change these attributes only in the Faceplate type. After
changes in the Faceplate type, the changes are effective in the Faceplate instance by
reloading the picture.
● Instance-specific attributes: The attributes are predefined in the Faceplate type and can be
changed in the Faceplate instance. A change in the Faceplate type has no effects on
already inserted Faceplate instances.
Other information on Faceplate types are found in chapter "Working with Faceplate types".

See also
Working with Faceplate Types (Page 344)
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3.8.7.15

How to insert a .NET control

Introduction
The .NET framework by Microsoft is also installed with WinCC. This makes it possible for you
to integrate .NET applications (assemblies) as controls in your pictures.
When inserting the Smart object ".NET control" select the desired control in the "Insert control"
dialog. Here, all controls that are available on your system are displayed.
Note
Possible problems when using third-party controls
The user of the software is responsible for problems caused by the deployment of external
controls.
We recommend testing for safe operation before implementation.
At the end of the insertion process a configuration dialog is usually opened, in which you adapt
the properties of the control. You can also open this dialog later by double-clicking the control.
WinCC uses the designation of the control linked with a sequential number as the object name
by default. You can change this name with the "Object name" attribute in the "Object
Properties" window.

Procedure
1. Click the ".NET Control" smart object in the "Standard" selection window.
The mouse pointer changes into a crosshair with an object symbol attached.
2. Click on the position in the picture where you want to insert the control.
The "Insert control" dialog is opened with the controls from the "Global assembly cache".

3. Select the required control and confirm with "OK".
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4. Choose the desired type in the "Select type" dialog.
The associated configuration dialog now opens for some controls.
5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK".
The insertion process for the ".NET control" object is finished.
As an alternative, double-click the ".NET control" smart object in the "Standard" selection
window in order to insert it with the default properties into the process picture. Select the
required control in the "Insert control" and "Insert type" dialogs.

Edit .NET Control
You open the "Object properties" dialog in the context menu of the .NET control with
"Properties". You can define the specific attributes of the selected controls in the "Control
properties" properties group.

3.8.7.16

How to insert a WPF control

Introduction
Together with WinCC, the Microsoft .NET Framework 3.0 is also installed. A component of the
framework is the "Windows Presentation Foundation (WPF)" which is used to describe user
interfaces. This makes it possible to integrate WPF files as controls in your pictures.
When inserting the Smart object "WPF control", select the desired control. Here, all controls
that are available on your system are displayed.
Note
Possible problems when using third-party controls
The user of the software is responsible for problems caused by the deployment of external
controls.
We recommend testing for safe operation before implementation.
At the end of the insertion process a configuration dialog is usually opened, in which you adapt
the properties of the control. You can also open this dialog later by double-clicking the control.
WinCC uses the designation of the control linked with a sequential number as the object name
by default. You can change this name with the "Object name" attribute in the "Object
Properties" window.
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Procedure
1. Click the "WPF Control" smart object in the "Standard" selection window.
The mouse pointer changes into a crosshair with an object symbol attached.
2. Click on the position in the picture where you want to insert the control.
The "Insert control" dialog is opened with the "PresentationFramework 3.0" entry.

3. Select the "PresentationFramework 3.0" and confirm with "OK".
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4. Choose the desired type in the "Select type" dialog.
The associated configuration dialog now opens for some controls.
5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK".
The insertion process for the "WPF Control" object is finished.
As an alternative, double-click the "WPF Control" smart object in the "Standard" selection
window in order to insert it with the default properties into the process picture. Select the
required control in the "Insert control" and "Insert type" dialogs.

Edit WPF control
You open the "Object properties" dialog in the context menu of the WPF control with
"Properties". You can define the specific attributes of the selected controls in the "Control
properties" properties group.

3.8.7.17

How to Insert a 3D Bar

Introduction
The 3D bar graph enables values to be displayed graphically three-dimensionally. The size
and properties which a 3D bar has in Runtime are defined in the Graphics Designer.
The 3D bar is only available if the "Basic Process Control" optional package was installed with
WinCC.
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Inserting a 3D bar
1. Open the picture in which you want to insert a 3D bar.
2. Click the "3D bar" smart object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a 3D bar.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the 3D bar to the size and direction you want.
When you release the mouse button, the insertion process is finished.
As an alternative, double-click the "3D bar" smart object in the "Standard" selection window.
A 3D bar with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when drawing the picture window, the "3D bar" object is
created in the shape of a square.
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Changing a 3D bar
Select an object of the 3D bar type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the color palette to change the background color.
Use elements of the style palette to change the style for visualization of the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.
Note
The 3D bar is always surrounded by a rectangular frame. Do not use a black background.
The arrows indicating that an area has been exceeded are not visible at this time.

Configuring limits of the 3D bar
You can define up to 11 limit values using the attributes "Limit N" (N = 0 to 10) for the "3D bar"
object. You can use the "Bar Color N" attributes to specify a color change for each limit value.
If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is activated.
A display value is displayed in the "Bar Color N" as long as the value is lower than the value
of the "Limit N". A black arrow at the ends of the bar representation symbolizes display values
that are lower than "Limit 0" or higher than "Limit 10".

See also
"Limits" Property Group (Page 492)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)

3.8.7.18

How to Insert a Group Display

Introduction
The group display enables the current states of certain message types to be displayed by
hierarchy. Up to eight buttons permit display and operation of messages. Using a group display,
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it is possible for example to implement a quick change to represent an error source. The size
and properties which a group display accepts in Runtime are defined in the Graphics Designer.
The group display is only available if the "Basic Process Control" optional package was
installed with WinCC.

Inserting group display
1. Open the picture in which you want to insert a group display.
2. Click the "Group Display" smart object in the "Standard" selection window.
3. Place the mouse pointer onto the position in the picture where you want to insert the group
display.
The mouse pointer is transformed into a cross-hair with attached object icon.
4. Hold down the mouse button and drag the handle to resize the group display.
The insert operation is completed as soon as you release the mouse button.
As an alternative, double-click the "Group Display" smart object in the "Standard" selection
window. A group display with default object properties is then inserted near the picture origin.
You can press the <SHIFT> key while inserting to create a square "Group Display" object.

Changing group display
Select an object of the group display type if you wish to carry out one of the following changes:
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Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the color palette to change the background color.
Use elements of the style palette to change the style for visualization of the object.
Attributes
Open the "Object Properties" window to change the current values of the desired attributes.
Note
Autonomous group displays for ORing UP by means of the picture hierarchy
Group display objects that have been created automatically by the system for ORing UP must
not be used in a group.

Default settings of group display
If you insert a picture into the group display, the group display will have five buttons. 11
message types and their respective colors and texts are assigned to those five buttons. You
may change the assignment and may configure three additional buttons. The default settings
of graphic objects are changed by using the property dialog (right mouse button) of the default
object selected in the "Standard" selection window.

Dynamizing the group display
The group display object is triggered by a tag which represents the message status. You can
use this tag to display the group display states in the other WinCC components . Other types
of dynamization are not possible.

Connect a group display with a PCS 7 measuring point
To configure the link to the tag, use the Dynamic Wizard "Link Group Display with PCS 7
Measuring Point". Start the wizard and define the required settings. The group display "Group
value" attribute is linked to the "EventState" structure tag of the PCS 7 measuring point
concerned.
The individual bits of this tag are interpreted in PCS 7 as follows:
Status information of PCS 7 tag "EventState":
Bit in double word

Message class

Message type

Bit 31 (MS bit)

Alarm

AH

Bit 30

Alarm

AL

Bit 29

Warning

WH
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Bit in double word

Message class

Message type

Bit 28

Warning

WL

Bit 27

Tolerance

TH

Bit 26

Tolerance

TL

Bit 25

AS Process control message

Fault

Bit 24

AS Process control message

Error

Bit 23

Maintenance request

Maintenance request

Bit 22

Process message

PM

Bit 21

Not assigned

Not assigned

Bit 20

Operator request

OR

Bit 19

Operator input message

OM

Bit 18

Status message

Automation system (AS)
status

Bit 17

Status message

Status OS

Bit 16

Measuring point locked

X

Acknowledgment information of PCS 7 tag "EventState":
Bit in double word

Message class

Message type

Bit 15

Alarm

AH acknowledged

Bit 14

Alarm

AL acknowledged

Bit 13

Warning

WH acknowledged

Bit 12

Warning

WL acknowledged

Bit 11

Tolerance does not require acknowledgment for PCS 7 *

TH acknowledged *

Bit 10

Tolerance does not require acknowledgment for PCS 7 *

TL acknowledged *

Bit 9

AS Process control message

Fault acknowledged

Bit 8

AS Process control message

Fault acknowledged

Bit 7

Maintenance request

MR acknowledged

Bit 6

Process message

PM acknowledged

Bit 5

Not assigned

Not assigned

Bit 4

Operator request acknowledgment not required for PCS 7

-

Bit 3

Operator input message acknowledgment not required for PCS
7

-

Bit 2

Status message acknowledgment not required for PCS 7

-

Bit 1

Status message acknowledgment not required for PCS 7

-

Bit 0 (LS-bit)

Measuring point block acknowledgment not required for PCS 7 -

* With new projects as of WinCC V7.01, you can configure messages of the "Tolerance"
message class as mandatory acknowledgement messages. The option is selected in the OS
Project Editor.
You may assign any of the 16 message types to any bit and thereby change the default settings.
Configuration is performed in the "Message type" property in "Message Types" property group.
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Connecting a group display with a custom tag
Independent of PCS 7, you may connect a group display with a tag. In this tag you assign
individual bits on a need basis.
1. Open the group display shortcut menu and select "Properties".
2. Select "Miscellaneous" in the "Properties" tab.
3. Open the shortcut menu in the "Group value" line, "Dynamic" column and select "Tag...".
The tag must be a signed 32-bit variable.
4. Select one of the tags from the process layer or from the internal tags in the "Select tag"
window.
5. Activate the "Upon Change" update cycle in the "Current" column.
If an internal tag is used, it should have the start value 65535 (0x0000FFFF). In this manner,
you can ensure that at the start - from the view of the group display - there are no
unacknowledged messages.
For individually configured group displays, the supplied PCS7 settings for acknowledgment
sample of "17" or "3089" is most likely not suitable for your project and must be adjusted.
You can thus influence the quitting pattern via the ""@EventQuit" tag.

Configuring Message Types
The "Message Types" property group contains attributes with which you can set the display
of messages depending on the 16 message types. For example, each message type may be
visualized by an appropriate label and by color changes of the button.

Assigning message types to buttons
In the "Assignment" object property of the group display you assign message types to the
buttons. Enter the respective bit numbers in the group value.
The buttons may have multiple assignments:
● with bit numbers corresponding to message classes. These are separated by "/".
● with bit numbers corresponding to message types. These are separated by ",".
The sequence of entries determines their priority. The earliest entry is displayed with the
highest priority in case of concurrent events.
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Lock display
The "Lock" property group contains attributes with which you can change the view of locked
measuring points. The "Lock display" attribute specifies for a group display whether or not a
locked measuring point is displayed. The lock applies to all buttons of the group display,
independent of which other events in the hierarchy are pending.
In the default settings for the group display, the fifth button is reserved for display of status
"Measuring point locked" by using "Group value bit 16". This allows to display not only pending
events in the hierarchy but also those locked in subordinate measuring points.

See also
"Message Types" Property Group (Page 493)
"Lock" Property Group (Page 500)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Smart Objects (Page 546)
Influencing the quitting pattern using EventQuit tag

3.8.7.19

How to Configure the Extended Status Display

Introduction
Extended status display is available only when a PCS 7 OS is installed.
You can use the extended status display to define statuses on the basis of the group value
and/or up to four control tags. You assign pictures to the statuses.
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The group value is triggered by a tag which represents the message status. Other types of
dynamizing are not possible. The group value is usually interconnected with a PCS 7
EventState.
You can use any numerical tag from the WinCC Tag Management as a status tag.
The alarm status results from the evaluation of the bits of the group value. If the group value
contains multiple bits, the priority determines which status is displayed. For the bits of the group
value, you assign pictures for the "Came In" (+), "Came In Acknowledged" (+Q) and "Went
Out Unacknowledged" (-) statuses. In addition, you can assign a basic picture and a flashing
picture for the "OK" status.

Configuration steps
You configure the extended status display in several steps:
1. Specify how many tags you want to use. Connect these tags to the appropriate object
properties "Status1" to "Status4" of the extended status display.
2. For status value generation, determine the bit assignment of the status value in accordance
with a bit position of the utilized tags "Status1" to "Status4".
3. If you want to consider the alarm statuses of the group value, you determine the bits of the
group value to be used. Connect the "Group value" property to a tag. In PCS 7, this is
usually the "EventState" tag of a process tag.
4. Specify the priorities for the messaging characteristics in Runtime.
5. Assign basic and flashing pictures to the utilized bits of the status value or the combination
of utilized bits from the status value and group value.
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Procedure
1. Open the Graphics Designer, go to the Object Palette/Smart Objects and select the object
"Status Display (extended)".
2. Move the object into the working area using a drag-and-drop operation. This opens the
configuration dialog box for the extended status display.
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3. In the "Bit selection" area, form an individual status value from a maximum of 4
interconnectable status words.
Example A: The status value is formed solely from the "two to the power of four" bit of the
tag interconnected with the "Status1" property.

Example B: You want to use the inputs of the four binary variables "Status1" to "Status4"
to form the status value.

4. If you want to combine the status value formation with the alarm statuses of the group value,
select the "Use group value for display" check box.
5. Select the bits that you want to use for the extended status display from the group value.
Use the arrow keys to move a selected bit between the two lists. The default allocation
corresponds with the PCS7 standard.
6. Specify the priority order of the utilized bits for the evaluation of the group value. The entries
in the "Used Bits" list show the order of the priorities. The top entry has the highest priority
(priority 1). Select one entry at a time in the "Used bits" list and change the priority by clicking
"Priority higher" or "Priority lower". All entries in the "Unused bits" list have the priority "0".
The icons in the "Used bits" and "Unused bits" lists always reflect the PCS 7 standard,
regardless of any project-specific deviation.
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7. Assign the used bits in the "Assign pictures" tab. The Index is formed from the status value
formation or the combination of status value and group value. You can specify the basic
picture and flash picture for each combination. If a flash picture is configured, the basic
picture and the flash picture will be displayed alternately in Runtime. You can use your own
pictures, but these must be located in the "GraCS" directory of the project or in a
subdirectory of "GraCS".

8. In the index list, click the status to which you want to assign pictures.
9. The file selection list displays the graphic files of the selected file type, either from the
"GraCS" directory of the project or from the subdirectory specified in the "Used directory
for pictures" box. If no subdirectory is specified or if the subdirectory does not include any
pictures, the pictures in the "GraCS" directory are taken into consideration.
Double-click on the required graphic file. You assign the basic picture with the first doubleclick, and the flash picture with the second double-click.
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10.If you want to delete a picture from a status, select the status in the table and select the
appropriate menu command from the shortcut menu.
11.Click on the "OK" or "Apply" button. The settings will be applied.
12.Connect the utilized tags to the extended status display. Open the object properties.
13.Select the property "Status1" in the properties group "Other". Select the "Tag..." command
from the shortcut menu of the "Dynamic" column. Select the tag from the "Select tag"
window. If using multiple tags, interconnect these with the "Status2" to "Status4" properties.
14.Connect the tag for the group value in the object properties of the extended status display.
Select the property "Group value" in the properties group "Other". Select the "Tag..."
command from the shortcut menu of the "Dynamic" column. The tag must be a signed 32bit variable. Select one of the tags from the process layer or from the internal tags in the
"Select tag" window.

Export/import configuration
You can save and forward the configured picture assignments for the extended status display
by exporting the configuration as an XML file. This is also how you import an existing
configuration. You cannot import a configuration of the extended status display that you have
exported prior to WinCC V6.2.

Behavior of message priorities in Runtime
When a queued event is acknowledged, it goes to the background regardless of its priority.
Events with lower priority that have not yet been acknowledged are displayed prior to events
of higher priority that have already been acknowledged.
Lower priority events are not displayed so long as a higher priority event is displayed as
"Unacknowledged Outgoing".

Special settings in the properties dialog box
The extended status display has been modified for optimum compatibility with how the group
display behaves.
If the "Group Relevant" attribute is set to "Yes" in the object properties, the status tag
interconnected under "Group value" enters into the ORing UP of the group display hierarchy.
If the "Group Value" attribute is not interconnected, then you must set "Group Relevant" to
"No". The process alarm "Group display: tag .EventState not found" would otherwise not be
triggered in Runtime.
Property "Other/Acknowledgment mask"
To ensure consistent runtime response, we recommend that you configure the
acknowledgment mask for the group display and the extended status display in exactly the
same way.
For the extended status display, the supplied PCS7 settings for acknowledgment sample of
"17" or "3089" prior to WinCC V7.01 is possibly not suitable for your project and must be
adjusted.
Property "Other/Outgoing state visible"
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You use the "Outgoing state visible" property to specify whether an outgoing state is visible or
not.
Note
If you change the status value formation or add or remove the group value for the display,
this changes the possible statuses available on the "Assign pictures" configuration page. A
notice warns you that all picture assignments configured so far will be lost. If you wish to
retain the picture assignments, you must export and save the existing configuration.

3.8.7.20

How to Configure the Extended Analog Display

Introduction
Extended analog display is available only when a PCS 7 OS is installed.
The extended analog display enables you to display the value of a tag in runtime in various
colors according to the alarm statuses of a block. The alarm status results from the evaluation
of the bits of the group value. The group value is controlled by a tag. Other types of dynamizing
are not possible. If the group value contains multiple bits, the priority determines which status
is displayed.

Display options
The following display options are available for the bits of the group value with regard to the
"Came In", "Came In Acknowledged" and "Went Out Unacknowledged" statuses:
● Background color
● Font color
● Flashing and color-flashing of the background and the text
For the "OK" and "Simulation" statuses, you can configure both a background color and a text
color in the properties dialog or the configuration dialog. The flashing color is the same for both
statuses. You specify whether or not both statuses are to exhibit flashing response in the
"Flashing" property in the properties dialog box.

Configuration steps
You configure the extended status display in several steps:
1. Specify the bits of the group value to be used.
2. Specify the priorities for the messaging characteristics in Runtime.
3. If you do not want to accept the default settings, specify the display options of the message
types for the utilized bits. Independent of the bits of the group value, you can configure the
colors for the "OK" and "Simulation" statuses.
4. Connect the "Value" and "Group value" properties to one tag each.
5. If necessary, configure a simulation tag and the display options for the value of the tags.
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Procedure
1. Open the Graphics Designer, go to the Object Palette/Smart Objects and select the object
"Analog Display (Extended)."
2. Move the object into the working area using a drag-and-drop operation. This opens the
configuration dialog box for the extended analog display.

3. Select the bits that you want to use for the extended analog display from the group value.
Use the arrow keys to move a selected bit between the two lists. The default allocation
corresponds with the PCS7 standard.
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4. Specify the priority order of the utilized bits for the evaluation of the group value. The entries
in the "Used Bits" list show the order of the priorities. The top entry has the highest priority
(priority 1). Select one entry at a time in the "Used bits" list and change the priority by clicking
"Priority higher" or "Priority lower." All entries in the "Unused bits" list have the priority "0."
The icons in the "Used bits" and "Unused bits" lists always reflect the PCS 7 standard, even
if there are user-defined settings. These settings are indicated under "Format/color."
5. To configure the display for the statuses of a bit, you select the bit from the "Used bits" list.
You then select the status from the "Status" list, for whose value you want to change the
pre-configured color settings.
6. Click the desired color in the color matrix. The first click changes the background color and
the second click changes the text color/foreground color.
7. If the value and/or the background to be displayed for the utilized bit and the selected status
is to flash, select the appropriate check box. Specify the flashing colors, as appropriate.
8. If you want to change the format of the value to be displayed, open the object properties
of the extended analog display. In the "Text" properties group, double-click the "Format"
property and enter the desired format.
If you want to output the value as text, double-click "Value as text" in the properties group
"Other", or activate the "Display value as text" check box in the configuration dialog box.
9. Configure the display options for additional bits.
10.Click "OK." The settings will be applied.
11.Connect the tags for the value that you want to display and for the group value in the object
properties of the extended analog display.
12.Select the "Value" property in the "Other" properties group for this purpose. Select the
"Tag..." command from the shortcut menu of the "Dynamic" column. Select the tag from
the "Select tag" window.
13.Select the property "Group value" in the properties group "Other." Select the "Tag..."
command from the shortcut menu of the "Dynamic" column. The tag must be a signed 32bit variable. Select one of the tags from the process layer or from the internal tags in the
"Select tag" window.

Configuring a simulation
You can configure a simulation for the purpose of replicating a specific situation using different
text and background colors. The "Simulation" and "Simulation bit" properties will only be
evaluated if the status is "O.K.".
1. Select the "Simulation" property in the object properties of the extended analog display.
Select the "Tag..." command from the shortcut menu of the "Dynamic" column. Select the
tag from the "Select tag" window.
2. Double-click the "Simulation bit" property in the extended analog display "Other" properties
group. In the edit box, enter the simulation tag bit that is to be evaluated.
3. In the "Colors" properties group, specify the text and background colors for the simulation.
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Export/import configuration
You can forward the configured settings for the extended analog display by exporting the
configuration as an XML file. This is also how you import existing configurations. You cannot
import a configuration of the extended analog display that you have exported prior to WinCC
V6.2.

Behavior of message priorities in Runtime
When a queued event is acknowledged, it goes to the background regardless of its priority.
Events with lower priority that have not yet been acknowledged are displayed prior to events
of higher priority that have already been acknowledged.
Lower priority events are not displayed so long as a higher priority event is displayed as
"Unacknowledged Outgoing."

Special settings in the properties dialog box
The extended analog display has been modified for optimum compatibility with how the group
display behaves.
If the "Group Relevant" attribute is set to "Yes" in the object properties, the status tag
interconnected under "Group value" enters into the ORing UP of the group display hierarchy.
If the "Group Value" attribute is not interconnected, then you must set "Group Relevant" to
"No." The process alarm "Group display: tag .EventState not found" would otherwise not be
triggered in Runtime.
Property "Other/Acknowledgment mask"
To ensure consistent runtime response, we recommend that you configure the
acknowledgment mask for the group display and the extended analog display in exactly the
same way.
For the extended analog status display, the supplied PCS7 settings for acknowledgment
sample of "17" or "3089" prior to WinCC V7.01 is possibly not suitable for your project and
must be adjusted.
Property "Other/Outgoing state visible"
You use the "Outgoing state visible" property to specify whether an outgoing state is visible or
not.
Note
The quality code can only be evaluated by the extended analog display if the object property
"Value" is made dynamic directly with a tag.

See also
Format Function of the Analog Display (Page 624)
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3.8.7.21

Format Function of the Analog Display

Formatting options
You format the value of the tag that will be displayed in the extended analog display as follows:
Formatting characters

Display

No characters

Displays the number without formatting.

(0)

Displays a digit or zero.
If the expression contains a digit at a position that is occupied by a 0 in the format string,
the digit is displayed. Otherwise a zero is output.
If the number has less digits than the zeros in the format expression (on both sides of
the decimal point), the leading or trailing zeros are displayed.
If the number has more decimal places after the decimal point than the zeros in the format
expression, the decimal places are rounded to the number of zeros.
If the number has more places before the decimal point than zeros in the format
expression, the additional places are displayed just as they are.

(#)

Displays a digit or no output.
If the expression contains a digit at a position that is occupied by a # placeholder in the
format string, the digit is displayed. Otherwise nothing is displayed at this position. This
symbol behaves like a 0 placeholder. However, leading or trailing zeros are not displayed
if the format expression contains more # placeholders before or after the decimal
separator than there are digits in the number.

(.)

Placeholder for the decimal separator.
In many locales a comma is used as decimal point, and in others a point is used. The
placeholder for the decimal separator determines how many places are displayed to the
left and right of the decimal separator.
If the format expression contains only # placeholder to the left of this symbol, numbers
smaller than 1 begin with a decimal character.
If you require decimal numbers always to be displayed with a leading zero, you must
specify a 0 placeholder for the first digit to the left of the decimal point. The character
that is actually output as the decimal separator depends on the system settings for the
number format.

(%)

Placeholder for percent.
The expression is multiplied by 100. The percent sign (%) is inserted at the position it
occupies in the format string.

(,)

Thousands separator
In many locales a comma is used as the thousands separator, and in others a point is
used. The thousands separator divides thousands from hundreds in a number containing
four digits or more. A thousands separator is output if the format expression contains the
appropriate placeholder and this placeholder is itself surrounded by placeholders for
digits (0 or #). Two thousands separators in succession or a thousands separator
immediately left of the decimal separator even if no decimal places are specified will
cause the number to be divided by 1000 and rounded off.
Example: You can use the format string "##0,," in order to output "100 million" as "100".
Numbers smaller than 1 million are then shown as 0.
Two consecutive placeholders for the thousands separator that are not placed
immediately to the left of the decimal separator are interpreted as a normal thousands
separator and output as such. The character that is actually output as the thousands
separator depends on the system settings for the number format.
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Formatting characters

Display

( ( E- E+ e- e+ )

Scientific format.
If the format expression contains at least one digit placeholder (0 or #) to the right of the
symbol E-, E+, e- or e+, then the number is displayed in scientific notation or exponential
notation. The letter E or e is inserted between the number and the exponent. The number
of digit placeholders to the right of the symbol determines the number of places in the
exponent. When the symbol is E- or e- a minus sign is output immediately alongside a
negative exponent. When the symbol is E+ or e+ a minus sign is likewise output
immediately alongside a negative exponent, but a plus sign is output beside a positive
exponent.

-+$()

Displaying a literal character
If you want to output characters other than those specified here, you must enter a back
slash (\) before the character concerned or enter the character in quote marks (" ").

(\)

Displaying the next character in the format string
Many characters in the format expression have a special meaning and can only be
displayed as literal characters if a back slash (\) is entered in front of them. The back
slash is not displayed. A back slash has the same effect as enclosing the following
character in quote marks. You indicate a back slash with two back slashes (\\).
Examples of characters that cannot be displayed as literal characters are the letters for
formatting the date and time (a, c, d, h, m, n, p, q, s, t, w, y, / and :) as well as the
characters for formatting numbers (#, 0, %, E, e, comma and dot) and strings (@, &, <,
> and !).

( ( "ABC" )

Displays a character string in quote marks (" "). Before you can enter text from the code
in the Format format string, you must enclose it in quotation marks with Chr(34). 34 is
the character code for quotation marks (").

3.8.8

Working with Windows Objects

3.8.8.1

Working with Windows Objects

Introduction
The Windows objects are elements familiar from Windows applications: button, check box,
radio box and slider. You can also configure a round button. The objects can be modified and
made dynamic in many ways. They enable you to operate process events and to control
processes.
In the Graphics Designer, the various object types have default properties. When they are
inserted the objects import these default properties (except for individual geometric properties).
After inserting the properties you can modify the properties of an object. In the same way, you
can adapt the default settings for the object types as required.
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Overview
Icon

Object

Description

Button

The button enables process operation. It is used for example to acknowledge
messages. A button has the two states "On" and "Off". In addition you can define
whether a button should appear pressed by default, and whether it should latch when
pressed. A button is integrated into the process by providing the corresponding
attributes with dynamics.

Check box

The check box enables the operator to select several options and to check the
corresponding check boxes. It is also possible to activate the check box by default so
that the operator only changes the predefined value as required. A check box is
integrated into the process by providing the corresponding attributes with dynamics.

Radio box

The option box enables the operator to selected one of the presented options and to
activate the corresponding options field. It is also possible to activate the option boxes
by default so that the operator only changes the predefined value as required. An option
box is integrated into the process by providing the corresponding attributes with
dynamics.

Round button

The round button enables process operation. A round button has three states: "On",
"Off" and "Deactivated". In addition you can define whether a round button should
appear pressed by default, and whether it should latch when pressed. A round button
is integrated into the process by making the corresponding attributes dynamic.

Slider

The slider is a slide controller and can be used to control processes. For example, it
can be used for infinitely variable changes to a value. A slider is integrated into the
process by providing the corresponding attributes with dynamics.

See also
How to insert a button (Page 627)
How to insert a check box (Page 631)
How to insert an radio box (Page 634)
How to insert a round button (Page 636)
How to insert a slider (Page 638)
How to change the default setting of object types (Page 426)
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Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
Controls (Page 295)
The Coordinate System of a Process Picture (Page 277)
The Coordinate System of an Object (Page 279)
The Rectangle Surrounding the Object (Page 281)
Working with Combined Objects (Page 653)
Working with Objects (Page 425)

3.8.8.2

Button

How to insert a button
Introduction
The button enables process operation. A button is used for such actions as acknowledging
messages or for navigation in Runtime. A button has the two possible states "On" and "Off".
In addition you can define whether a button should appear pressed by default, and whether it
should latch when pressed. A button is integrated into the process by providing the
corresponding attributes with dynamics.
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Inserting a button
1. Open the picture in which you want to insert a button.
2. Click the "Button" Windows object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a button.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the button to the desired size with the mouse button pressed.
The "Button Configuration" dialog is opened.
5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "Button" object is finished.
As an alternative, double-click the "Button" Windows object in the "Standard" selection window.
A button with default object properties is then inserted near the picture origin. The "Button
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the
insertion process is completed.
If you press and hold down <SHIFT> during the insertion, you create the "Button" object in the
shape of a square.

Changing a button
Select an object of the button type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the element "Rotate" of the object palette to rotate the object.
Use the color palette to change the background color.
Use the elements in the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
How to configure a button (Page 629)
How to configure a hotkey for navigation in Runtime (Page 630)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
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The Properties of an Object (Page 470)
Working with Windows Objects (Page 625)

How to configure a button
Introduction
The "Button Configuration" dialog opens at the end of the insertion process if the use of
configuration dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. The
dialog enables fast configuration of the important features of the button.
You can also open the configuration dialog with the object context menu. You change individual
attributes in the "Object Properties" window.

Text
The button can display a text that describes its function.
Enter the required text. Only one text line is available in the configuration dialog. You can enter
multiline text in the "Text" attribute in the "Object Properties" window. You can find the detailed
description in the "Changing field labels with the "Text" attribute" section.

Font
Click the buttons to open the dialogs for font changes.
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Operation
In order to operate the button you can assign an authorization and define a hotkey that allows
operation with one key or shortcut.
Click the buttons to open the corresponding dialogs. You can find the detailed description of
the dialogs in the "How to define a hotkey for navigation in Runtime" section.

Change Picture on Mouse Click
With this function you configure an event for the selected button. The specified process picture
is displayed when you click the button in Runtime.
to open the "Pictures:" dialog to select
Enter the name of the picture to be displayed or click
a picture. The "Pictures" Dialog shows all pictures in "PDL" format in the "GraCS" graphic folder
of the current WinCC project.
There is an extensive description of this topic in the chapter "Making Process Pictures
Dynamic".
Note
You must not use the "Change Picture on Mouse Click" function in the Basic Process Control
area. Use the "SSMChangeWorkField" function for opening a picture in the working area.
Use the "SSMOpenTopField" function to open an additional picture window.

See also
Selecting a tag (Page 649)
How to configure a hotkey for navigation in Runtime (Page 630)
How to insert a button (Page 627)
Quick Object Configuration (Page 647)

How to configure a hotkey for navigation in Runtime
Introduction
The "Button" object is used to open a configured event. Objects of the "Button" type can, for
example, be used for navigation between multiple pictures.

Configuring change picture
The picture change is configured with a constant for the "Mouse click" event as direct
connection. If the button is clicked with the mouse, the display of the process picture specified
here is opened.
You can configure the name of the picture that you want to display in the "Insert Button" dialog.
Alternatively you can also change the configured direct connection in the "Events" tab of the
"Object Properties" window. You can find the detailed description in "Making Process Pictures
Dynamic".
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Setting hotkeys
As an alternative to operation with the mouse, a button can also be triggered using the
keyboard. You have to specify a hotkey for this purpose.
Double-click the "Hotkey" attribute in the "Miscellaneous" property group. Select one of the
displayed function keys with the mouse or enter a key or shortcut. If a hotkey is defined for a
button, an arrow is displayed in the object properties next to the "Hotkey" attribute.
Note
If a group is operated with a hotkey, the hotkey must only be assigned to the single object
"Button" in the group. A hotkey that you assign to the entire group does not have any effect
in Runtime.

Setting authorizations
The "User Administrator" editor is used in WinCC to assign authorizations for the users. You
can assign an authorization for every object in the Graphics Designer. Meaning that only a
user with the appropriate authorization can operate this object.
Double-click the "Authorization" attribute in the "Miscellaneous" property group. Select one of
the available authorizations.
Note
To operate the button in Runtime, the "Operator-Control Enable" and "Display" attributes
must have the value "Yes". The value of the "Authorization" attribute must contain the access
authorization of the current user.

See also
How to configure a button (Page 629)
How to insert a button (Page 627)

3.8.8.3

How to insert a check box

Introduction
The check box enables the operator to select several options and to check the corresponding
check boxes. Check boxes can be activated by default so the user changes the default values
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only as required. A check box is integrated into the process by providing the corresponding
attributes with dynamics.

Inserting a check box
1. Open the picture in which you want to insert a check box.
2. Click the "Check box" Windows object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the check box.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the check box to the size and direction you want.
When you release the mouse button, the check box insertion is finished.
As an alternative, double-click the "Check box" Windows object in the "Standard" selection
window. A check box with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when drawing the picture window, the "Check box" object
is created in the shape of a square.

Changing a check box
Select an object of the check box type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.

632

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.8 Working with Objects
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror and rotate the object.
Use the font palette to change the appearance of the text.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Specifying the number of boxes
The "Number of Boxes" attribute specifies the total number of boxes for the selected object.
For each object, a maximum number of 32 boxes can be set.
At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value
for the "Index" attribute in the "Font" property group. Changing the value can have the following
effects:
Increasing the number
New fields are inserted under the field with the highest value in the "Index" attribute. The default
labeling of the new filed can be changed using the "Text" attribute in the "Font" property group.
Reducing the number
All fields for which the value of the "Index" attribute is greater than the new number are deleted.

Specifying selected boxes
The "Selected Boxes" attribute sets which fields in a check box are to be shown as enabled.
Multiple boxes can be enabled simultaneously.
Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding
bit must have the value "1". The 32-bit word contains the information for all fields of the check
box. The value of the "Selected Boxes" attribute is specified in hexadecimals.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Windows Objects (Page 625)
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3.8.8.4

How to insert an radio box

Introduction
The option box enables the operator to selected one of the presented options and to activate
the corresponding options field. One of the option groups can be activated by default so the
user changes the default values only as required. An option box is integrated into the process
by providing the corresponding attributes with dynamics.

Inserting a radio box
1. Open the picture in which you want to insert an option group.
2. Click the "Radio box" Windows object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the radio box.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the radio box to the size and direction you want.
When you release the mouse button, the insertion process is finished.
As an alternative, double-click the "Radio box" Windows object in the "Standard" selection
window. A radio box with default object properties is then inserted near the picture origin.
If you hold down the <SHIFT> key when inserting the radio box, the "Radio box" object is
created in the shape of a square.
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Changing a radio box
Select an object of the option group type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to the new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the elements in the object palette to mirror and rotate the object.
Use the font palette to change the appearance of the text.
Use the color palette to change the background color.
Use the elements of the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

Specifying the number of boxes
The "Number of Boxes" attribute specifies the total number of boxes for the selected object.
For each object, a maximum number of 32 boxes can be set.
At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value
for the "Index" attribute in the "Font" property group. Changing the value can have the following
effects:
Increasing the number
New fields are inserted under the field with the highest value in the "Index" attribute. The default
labeling of the new filed can be changed using the "Text" attribute in the "Font" property group.
Reducing the number
All fields for which the value of the "Index" attribute is greater than the new number are deleted.

Specifying selected boxes
The "Selected Box" attribute sets which option field in an option group is displayed as activated.
Only one of the boxes can be enabled.
Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding
bit must have the value "1". The 32-bit word contains the information for all fields of the check
box. The value of the "Selected Box" attribute is specified in hexadecimals.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
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The Properties of an Object (Page 470)
Working with Windows Objects (Page 625)

3.8.8.5

How to insert a round button

Introduction
The round button enables process operation. For example, it is used to acknowledge
messages. A round button has the three possible states "On", "Off" and "Deactivated". In
addition you can define whether a round button should appear pressed by default, and whether
it should latch when pressed. A round button is integrated into the process by making the
corresponding attributes dynamic.

Inserting a round button
1. Open the picture in which you want to insert a round button.
2. Click the "Round button" Windows object in the "Standard" selection window.
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3. Place the mouse pointer at the position in the picture where you want to insert a round
button.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the round button to the size and direction you want.
When you release the mouse button, the insertion process is finished.
As an alternative, double-click the "Round button" smart object in the "Standard" selection
window. A round button with default object properties is then inserted near the picture origin.

Changing a round button
Select an object of the round button type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the color palette to change the background color.
Use elements of the style palette to change the style for visualization of the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Windows Objects (Page 625)
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3.8.8.6

Slider

How to insert a slider
Introduction
The slider is a slide controller and can be used to control processes. You can, for example,
use a slider for continuous and smooth changes to a value. A slider is integrated into the
process by providing the corresponding attributes with dynamics.

Inserting a slider
1. Open the picture in which you want to insert a slider.
2. Click the "Slider" Windows object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert a slider.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the slider to the desired size with the mouse button pressed.
The "Slider Configuration" dialog is opened.
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5. Enter the required values into the fields of the configuration dialog.
You will find the description of the configuration dialog in the next section.
6. Confirm the input with "OK".
The insertion process for the "Slider" object is finished.
As an alternative, double-click the "Silder" Windows object in the "Standard" selection window.
A slider with default object properties is then inserted near the picture origin. The "Slider
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the
insertion process is completed.
If you hold down <SHIFT> during the insertion, the "Slider" object is created in the shape of a
square.

Changing a slider
Select an object of the slider type if you wish to carry out one of the following changes:
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the picture.
Drag the selection marks for the rectangle surrounding the object to a new position in order to
resize the object.
Palettes and toolbars
Use the element "Rotate" of the object palette to rotate the object.
Use the color palette to change the background color.
Use the elements in the style palette to change the display style for the object.
Attributes
Open the "Object Properties" window to change the current values of the required attributes.

See also
How to configure a slider (Page 640)
How to configure the value range and operation of a slider (Page 641)
Basic Static Operations (Page 428)
Basic Dynamic Operations (Page 454)
The Properties of an Object (Page 470)
Working with Windows Objects (Page 625)
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How to configure a slider
Introduction
The "Slider Configuration" dialog opens after the insertion process if the use of configuration
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. The dialog enables
fast configuration of the important features of the slider.
You can also open the configuration dialog with the object context menu. You change individual
attributes in the "Object Properties" window.

Tag
You can dynamize the slider by embedding a tag.
Enter the name of the required tag or click the tag icon to open the "Tags" dialog. See the
"Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed by the slider.
Enter the required interval or select an interval from the drop-down list. See the "Changing
update cycle" section for the detailed description.

Limits
The two holders of the slider are specified by the maximum value and the minimum value of
the slider. Setting operation steps specifies the number of increments by which the slider is
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moved when the mouse is clicked on the slider.
Enter the required limits and the number of operation steps for displaying the slider.

Alignment
Specify whether the slider is moved horizontally or vertically.

See also
Selecting a tag (Page 649)
How to configure the value range and operation of a slider (Page 641)
How to insert a slider (Page 638)
Quick Object Configuration (Page 647)

How to configure the value range and operation of a slider
Introduction
You can configure the value range of the required operation steps and the appearance of the
"Slider" object as required by changing the relevant attributes.

Setting scale end values and zero point value
● The "Maximum value" attribute specifies the absolute value for displaying the highest value.
● The "Minimum value" attribute specifies the absolute value for displaying the lowest value.
● The "Zero point value" attribute specifies the absolute value for the zero point of the bar.

Operation Steps
The "Operation Steps" attribute specifies for the slider the number of steps the slider is moved
in the corresponding direction with one mouse-click the slide surface.
The number of times you have to click on the slide surface for it to move from one end to the
other is calculated as follows: ("Maximum value" – "Minimum value") / "Operating steps".
Example:
Where maximum value = 100, minimum value = 0 and operation steps = 25 the slide surface
must be clicked four times to move the slider from one end to the other.

Alignment
The "Alignment" attribute defines for the "Slider" object whether the movement of the slider is
in a horizontal or vertical direction.
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WinCC style
The "WinCC style" defines how the style for the display of the objects is set:
● User-defined in Graphics Designer
● Through the globally set design
● Through the default settings of the operating system

See also
How to insert a slider (Page 638)
How to configure a slider (Page 640)

3.8.9

Working with Tube Objects

3.8.9.1

Working with tube objects

Introduction
With WinCC you can recreate in your process pictures systems of interconnected tubes, tanks
and other objects.
To do this, select suitable objects from the library and connect them with each other using the
tube objects. Due to the provided fill pattern, the tubes appear three-dimensionally and thus
allow the creation of intuitively well ascertainable pictures.

Tube objects
WinCC provides the following tube objects:
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Tube objects

Function

Polygon Tube

Tube made of a polyline

T-piece

T-shaped branch in four possible orientations
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Tube objects

Function

Double T-piece

Cross-shaped connector

Tube Bend

Cross- or elliptical-shaped bend of any radian

You create your system from these tube objects and the objects in the object library, e.g. tanks
and valves.

See also
How to insert a polygone tube (Page 643)
How to insert a T-piece (Page 644)
How to insert a double T-piece (Page 645)
How to insert a tube bend (Page 646)

3.8.9.2

How to insert a polygone tube

Introduction
WinCC has tube objects for simulating pipe systems. Using the polygon tube, you create pipes
with as many bends as is required. You can round off the corner points or display them as
angled corners.
The polygon tube is an open polygon: Even if you select the same start and end point, the
ends will not be connected with one another.
2EMHFWRULJLQ
5HFWDQJOHVXUURXQGLQJWKHREMHFW
/LQHZHLJKW
&RUQHUSRLQW
,QGH[

&RUQHUSRLQW
,QGH[
&RUQHUSRLQW
,QGH[
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,QGH[
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,QGH[

:LGWK

A polygon tube can have any number of corners. The corner points are numbered in the order
of their creation. You can move them individually.
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Procedure
1. Open the picture in which you want to insert a polygon tube.
2. Click the "Polygon tube" tube object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to begin the polygon
tube.
The mouse pointer changes into a cross with arrows pointing inward.
4. Click the selected starting point with the left mouse button.
5. Click every other desired corner of the polygon tube with the left mouse button.
Click with the right mouse button to correct the last drawn section of the polygon tube.
6. In order to complete the polygon tube, double click on the desired end point.
7. In order to move an individual corner point at a later point in time, drag the small square
next to the end point to the desired point.

Object properties
Use the "Line connection type" attribute in the "Styles" property group to set the type of corner
display:
● Square: No rounding on the corner points
● Round: Arc-formed corner rounding
Use the "Line width" attribute to set the width of the tube display.

3.8.9.3

How to insert a T-piece

Introduction
WinCC has tube objects for simulating pipe systems. You can create a T-shaped tube
connection with the T-piece.
2EMHFWRULJLQ
5HFWDQJOHVXUURXQGLQJWKHREMHFW
/LQHZHLJKW

+HLJKW

:LGWK

You can give the T-piece any of four possible orientations.
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Procedure
1. Open the picture into which you want to insert a T-piece.
2. Click the "T-piece" tube object in the "Standard" selection window.
The mouse pointer changes to a hollow T.
3. Position the mouse point at the position in the picture where you want to insert the T-piece
and click on the desired position.
The T-piece is inserted. You can change the position and size using the mouse.
Change the orientation using the properties of the T-piece.

Object properties
Use the "Line width" attribute in the "Styles" property group to set the width of the tube display.
Set the orientation of the T-piece in degrees using the "Rotation Angle" attribute in the
"Geometry" property group. This determines whether the "leg" of the "T" points downwards
(0), to the left (90), upwards (180) or to the right (270). The entered value is automatically
rounded to a multiple of "90".

3.8.9.4

How to insert a double T-piece

Introduction
WinCC has tube objects for simulating pipe systems. Use the double T-piece to construct a
tube-crossing.
2EMHFWRULJLQ
5HFWDQJOHVXUURXQGLQJWKHREMHFW
/LQHZHLJKW
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:LGWK
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Procedure
1. Open the picture in which you want to insert a double T-piece.
2. In the "Standard" selection window, click the tube object "Double T-piece".
The mouse pointer changes to a hollow cross.
3. Position the mouse pointer on the place in the picture that you want to put the double Tpiece and click on the desired point.
The double T-piece is inserted. You can adapt it in position and size.

Object properties
Use the "Line width" attribute in the "Styles" property group to set the width of the tube display.

3.8.9.5

How to insert a tube bend

Introduction
WinCC has tube objects for simulating pipe systems. Use the tube bend to create a bend in a
piece of pipe.
You can set the size, the shape as a circular arc or elliptical arc and circular dimensions of the
tube bend to your requirements.
2EMHFWRULJLQ
5HFWDQJOHVXUURXQGLQJWKHREMHFW
/LQHZHLJKW

6WDUWSRLQW
(QGSRLQW

+HLJKW

:LGWK

Procedure
1. Open the picture in which you want to insert a tube bend.
2. Click the "Tube bend" tube object in the "Standard" selection window.
3. Place the mouse pointer at the position in the picture where you want to insert the tube
bend.
The mouse pointer changes to a hollow quarter-ellipse.
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4. Click on the selected position.
The tube bend is inserted with certain start parameters: As a circular arc with equal width
and height in the first quadrant with a circular dimension 90° = ½ π.
5. Adapt the tube bend in position, size and shape.
If the width and height are not equal, the circular arc becomes an elliptical arc.
6. Mirror or rotate the quarter bend to change the orientation.
7. To move the start or end point at a later point in time, drag the small square next to the
affected point in the desired direction.
This changes the circular dimensions of the tube bend.

Object properties
Geometry of the tube bend
Define the size and shape of the tube bend with the attributes under "Geometry". The "Start
angle" and "End angle" attributes determine the circular dimensions.
The attributes are independent from one another.
● If you change the "Width" and "Height", the "RadiusX" and "RadiusY" change with them
automatically. Start and end angle remain.
● If the start and end angle change, the "Width" and "Height" change with them automatically.
"RadiusX" and "RadiusY" remain.
● If you change "RadiusX" and "RadiusY", the "Width" and "Height" change with them
automatically. Start and end angle remain.
Tube width
Use the "Line width" attribute in the "Styles" property group to set the width of the tube display.

3.8.10

Quick Object Configuration

3.8.10.1

Quick Object Configuration

Introduction
Configuration dialogs are provided in the Graphics Designer for the fast configuration of
individual objects. The important features of an object can be set in the configuration dialogs.
If the use of configuration dialogs is enabled in the "Options" tab of the "Tools/Settings..." menu,
the associated dialog opens when an object is inserted.
You can also open the "Configuration dialog" with the object context menu.
Different configuration dialogs are available for the following objects:
● I/O field
● Bar
● Graphic object
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● Status display
● Text list
● Button
● Slider object

Brief description of features that can be set
Feature

Description

Updating

Specifies the frequency with which the display of the value shown is to be updated. I/O field, bar,
status display, text
list, slider

Object type

Alignment

Specifies whether the slider is moved horizontally or vertically.

Slider

Bar direction

Specifies the direction of the coordinate axis to which the maximum value of the
bar points.

Bar

Operation

Specifies an "authorization" for operation of the button. In addition you can define
a "Hotkey" that allows operation with one key or shortcut.

Button

Bit position

Assigns a specific bit position of the tag to a state.

Status display

Picture change
with preview

Shows all pictures in the "GraCS" graphic folder of the current WinCC project.

Graphic object,
status display

Change Picture on
Mouse Click

Configures an event for the selected button. The selected process picture is
displayed when you click the button in Runtime.

Button

Field type

Specifies whether the selected object is used to input, output or input and output
values.

I/O field, text list

Limits

Defines both ends of the bar display and both holders of the slider through the
"Maximum value" and "Minimum value". Define the number of operating steps for
the slider with which the slider is moved at a mouse click.

Bar, slider

Font

Change the font options for displaying the button and display values.

I/O field, text list,
button

Text

Specifies the text for the button. You can enter multiline text by changing the "Text"
attribute in the "Object Properties" window.

Button

Tag

Dynamizes the selected object by embedding a tag. With an I/O field and text list
the value of the tag can be displayed as output or changed by an input depending
on the selected field type.

I/O field, bar,
status display, text
list, slider

Status list

Shows the linked pictures and the specified flash frequency for all the configured
states. You can add states and change settings using the context menu.

Status display

See also
How to configure a slider (Page 640)
How to configure a button (Page 629)
How to configure a text list (Page 591)
How to configure a status display (Page 584)
How to insert a graphic object (Page 579)
How to configure a bar (Page 574)
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How to configure an I/O Field (Page 563)
Selecting pictures (Page 650)
How to configure states (Page 586)
Selecting a tag (Page 649)

3.8.10.2

Selecting a tag

Introduction
Tags are a central element for dynamizing process pictures. By linking a process tag to an
object, such things as the change in a measured value can be represented graphically. More
details about the use of tags can be found in the chapter called "Tag Management".
The "Tag" dialog contains all tags available in the project.

You can change the width of both window areas and the columns in the tag display by moving
the vertical separation lines.
Filter
If there is a large number of configured tags, the search procedure can take some time. For
instance, for 15,000 tags the search procedure takes about a minute.
You limit the scope of the search by specifying a filter. You can achieve a significant increase
in efficiency if you configure tags with the aid of a tag prefix.
Data source
You can use the "Data source" window to select the tags to be displayed.
Tag groups
The selected tag group including its subfolders is displayed in the left-hand area in a directory
tree.
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You can open and close folders and subfolders by double-clicking or by clicking the "+" or "-"
symbols. The tags available for the selected entry are shown in the tag display.
Tag display
The right-hand area contains all the tags that are available for the entry. The tag display
includes, among other things, the tag name, the type and the time when the tag was last
changed. Sort the tags by clicking the respective column header.

Procedure
1. Select the required filter. An asterisk means that no filter is used or no filter has been defined.
2. Select one or more data sources.
3. Open the desired tag group in the left-hand window area.
4. Select the desired tag from the right-hand window area.
5. Confirm your selection with "OK". The "Tag" dialog closes. The selected tag is assigned to
the selected object.

See also
Quick Object Configuration (Page 647)
Working with Windows Objects (Page 625)
Working with Smart Objects (Page 546)

3.8.10.3

Selecting pictures

Introduction
You can integrate pictures in some objects of the Graphics Designer. Depending on the object
the integrated pictures have different file formats:
Object

Formats

How pictures are linked

Picture window

PDL

The "Picture Name" selection dialog is opened via the window "Object
Properties" > "Miscellaneous" property group > "Picture Name" attribute

Graphic object

BMP, DIB, ICO,
CUR, EMF,
WMF, GIF, JPG

The "Picture" selection dialog is opened via the window "Object Properties" >
"Picture" property group > "Picture" attribute or the configuration dialog

Status display

BMP, DIB, EMF,
WMF

The "Picture" selection dialog is opened via the window "Object Properties" >
"Status" property group > "Basic picture" and "Flash picture" attribute or the
configuration dialog

Button

BMP, DIB, ICO,
CUR, EMF,
WMF, GIF, JPG

The "Picture" selection dialog is opened via the "Object Properties" window, >
"Miscellaneous" property group > "Picture Status On" and "Picture Status Off"
attributes

Round button

BMP, DIB, ICO,
CUR, EMF,
WMF, GIF, JPG

The "Picture" selection dialog is opened via the "Object Properties" window, >
"Pictures" property group > "Picture Status On", "Picture Status Off" and "Picture
Status Deactivated" attributes
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The "Picture Name" selection dialog

The "Picture Name" selection dialog displays all the PDL files in the current project. A file that
you wish to integrate in the picture window must belong to the current WinCC project.

The "Picture" selection dialog

The "Picture" selection dialog lists the pictures that are available in the project. The pictures
are located in the "GraCS" graphic folder of the current WinCC project. To add further pictures
to the current project use the "Browse ..." button to open another selection dialog.
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Configuration dialog
The appearance of a configuration dialog depends on the selected object. Here the
configuration dialog of the graphic object as an example:

The picture selection lists the pictures that are available in the project. The pictures are located
in the "GraCS" graphic folder of the current WinCC project. To add further pictures to the current
project use the "Browse ..." button to open another selection dialog.

Find Picture
You can use this dialog to switch to any folder in order to select one or more pictures and add
them to the current project. The pictures are then displayed in the selection of pictures in the
selection dialog.
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Note
You have to copy referenced graphic files to the "GraCS" graphic folder for the current WinCC
project in order for them to be available on a target computer. If you use the Browse ..." button
in the picture selection, the selected graphic files are automatically copied to the "GraCS"
graphic folder.
You select several pictures by holding down the <SHIFT> key and clicking the first and the
last picture.
You select individual pictures by holding down the <CTRL> key and clicking the individual
pictures.

See also
Quick Object Configuration (Page 647)
Working with Windows Objects (Page 625)
Working with Smart Objects (Page 546)

3.8.11

Working with Combined Objects

3.8.11.1

Working with Combined Objects

Introduction
You combine the objects in the Graphics Designer by forming a group or a customized object
from a multiple selection. In addition you can insert a group or a combined object into the
project library. This makes the group or the combined object available as a library object for
re-use in other process pictures or projects.
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Overview
Object

Description

Group

You can combine a multiple selection of objects into a group. You can edit a group of objects like
a single object in the Graphics Designer. In addition you can edit the objects in the group individually.
Unlike multiple selection, the selection marks of the individual objects in a group are not shown.
The selection marks cover the entire group. The selection frame of the multiple selection becomes
the rectangle around all the objects of the group.

Customized object

A customized object allows the properties and events that are displayed in the "Object Properties"
window to be configured individually. You edit a customized object like an individual object in the
Graphics Designer.
As in a group the selection marks of the individual objects are no longer shown after creation of a
customized object. The selection marks surround the entire customized object. The selection frame
of the multiple selection becomes the rectangle around all the objects of the customized object.

Library object

The library of the Graphics Designer is used for saving and managing graphic objects that can be
used for creating process pictures.
● The "Global Library" offers a variety of pre-defined graphic objects that you can insert into a
picture as library objects and configure as required.
● The "Project Library" enables a project-specific library to be built.

See also
Working with the library (Page 682)
Working with Customized Objects (Page 657)
Multiple Selection of Objects (Page 433)
Working with Objects (Page 425)

3.8.11.2

Working with Groups

How to group objects
Introduction
You combine the objects of a multiple selection into a group with the "Group" command.
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Requirements
● Select at least two objects of any type, except for "Control" and "OLE objects".

Procedure
1. Open the pop-up menu of the multiple selection or the "Edit" menu.
2. Select the entry "Group / Grouping".
The selected objects are combined into a group. The selection frame of the multiple
selection becomes the rectangle around the group. Selection marks are shown for the group
only.
Note
You can combine single groups into larger groups with the "Group" command. This allows a
group hierarchy to be built up. Groups can be ungrouped in the reverse order of grouping.

Autonomous group displays for ORing UP by means of the picture hierarchy
Group display objects that have been created automatically by the system for ORing UP must
not be used in a group.

See also
Working with Objects (Page 425)
The Rectangle Surrounding the Object (Page 281)
Multiple Selection of Objects (Page 433)
How to ungroup a group (Page 657)
How to change the properties of a group (Page 655)

How to change the properties of a group
Introduction
You can edit a group in the Graphics Designer like all other objects.
The following elements are shown as components of the "Group" object type in the "Object
Properties" window:
● Property groups and attributes that have at least one of the selected objects.
● All objects in the group with their own property groups and attributes.

Effects when a common object is changed
Changing a common group attribute affects all single objects that have this attribute.
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For some attributes this effect has special rules that only apply to the group.
● If the origin of a group is moved, the values of the individual objects are adapted to the new
coordinates. The attributes "Position X" and "Position Y" of the individual objects do not
change relative to the origin of the group.
● If you change the size of a group, the "Height" and "Width" attributes of the individual objects
are adjusted by percentage to match the resize.
● If you have specified a rotation for single objects of a group in Runtime, these settings are
matched to the size of the group. The reference points for the rotation refer to the origin of
the group, not the origin of the single object. In Runtime, the objects for which no rotation
is specified remain unchanged.
● Linear objects that are in a group with surface objects always take the color that was last
selected for the background color or the line color in the properties of the group.
● If a group is operated with a hotkey, the hotkey must only be assigned to the single object
"Button" in the group. A hotkey assigned to the entire group will not work in Runtime.

Requirements
● Select a group.

Procedure
1. Open the "Object Properties" window.
2. Select the property group in the "Properties" tab that contains the attribute you want to
change.
Note
You can also edit the objects included in a group individually by changing their attributes. The
objects are displayed in the "Object Properties" window with their property groups as a
component of the "Group" object type.

See also
How to group objects (Page 654)
How to ungroup a group (Page 657)
The Properties of an Object (Page 470)
Multiple Selection of Objects (Page 433)
The Rectangle Surrounding the Object (Page 281)
Working with Objects (Page 425)
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How to ungroup a group
Introduction
Use the "Ungroup" command to split a group into its individual objects. The individual objects
are then shown as a multiple selection.

Requirements
● Select a group.

Procedure
1. Open the pop-up menu or the "Edit" menu.
2. Select "Group / Ungroup".
The group selection marks are hidden.
The individual objects of the group are shown as a multiple selection.
Note
You can combine single groups into larger groups with the "Group" command. This allows a
group hierarchy to be built up. Groups can be ungrouped in the reverse order of grouping.

See also
How to group objects (Page 654)
Multiple Selection of Objects (Page 433)
The Rectangle Surrounding the Object (Page 281)
Working with Objects (Page 425)
Working with Combined Objects (Page 653)

3.8.11.3

Working with Customized Objects

Working with Customized Objects
Overview
A customized object allows the properties and events that are displayed in the "Object
Properties" window to be configured individually.
You edit a customized object like an individual object in the Graphics Designer. The selection
marks of the individual objects are no longer shown after creation of a customized object. The
selection marks surround the entire customized object. The selection frame of the multiple
selection becomes the rectangle around all the objects of the customized object.
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Special features of customized objects
● The "Undo" function is not available for editing a customized object.
● Configured events of the single objects are deleted when the customized object is created.
● If editing mode is exited without an object being selected, the customized object is deleted.
When edit mode is exited, only the selected objects are imported into the customized object.
● Assigning hotkeys and specifying a TAB sequence for objects within the customized object
is not supported.
● If you integrate a group display in a customized object, the attributes "group value", "group
relevant" and "bit pattern group display" are available for the customized object to capture
and acknowledge states.
● It is not possible to create an attribute name twice. These attributes are preassigned by the
system (standard attributes). If you delete the attributes of a customized object, these
attribute names cannot be used in a user-specific attribute. Additional information on
standard attributes is available under "ScreenItem Object".
● User-specific attribute names of the customized object must not contain special characters.
● Use the "Configuration Dialog Customized Object" to display the properties for the
customized object. If you delete a standard property in "Configuration Dialog Customized
Object", this property is not displayed on the Graphics Designer user interface. Access to
the property is still possible using VBS. This relates to the following properties:
"ObjectName", "Layer", "Left", "Top", "Width", "Height", "Visible", "Enabled" and
"PasswordLevel".
● Properties with the prefix "@" are not electronically numbered (enum) by VBA. Therefore,
these properties are not edited by VBA either.
● Properties with the prefix "@" are not addressed by VBS.
● When addressing the user-specific properties of a customized object, the spelling used in
the VBS must correspond to the spelling in the Configuration dialog. Particular attention
must be paid to upper/lower case.
● The property name is dependent on the language set. In the case of customized objects
with multilanguage, user-specific properties, the language must be set in the "Configuration
Dialog Customized Object" before editing the customized object. Then you can select the
required language.
Note
You have to dynamize the text properties of the text object to allow changes from external
sources so the language change can function.

See also
How to create a customized object (Page 659)
How to configure the property groups of the customized object (Page 662)
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
Events of a customized object (Page 668)
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How to configure the events of a customized object (Page 669)
How to edit a customized object (Page 670)
How to delete a customized object (Page 671)
Working with Objects (Page 425)
Working with Combined Objects (Page 653)
Example: How to create a compressor as a customized object (Page 672)
Properties of a Customized Object (Page 660)
Multiple Selection of Objects (Page 433)

How to create a customized object
Introduction
The objects of a multiple selection are combined into a customized object with the command
"Customized Object / create..." in the context menu or the "Edit" menu. You can also create a
customized object from a single object.
The following object types cannot be included in a customized object:
● Application window
● Picture window
● OLE object
● Group or other customized object

Requirements
● Select at least two objects in the picture.

Procedure
1. Open the pop-up menu or the "Edit" menu.
2. Select the entry "Customized object / create...".
The "Configuration Dialog Customized object" dialog is opened.
3. Configure the available properties and events of the customized object.
For more information on the configuration of a customized object see section "The
Configuration of a Customized Object".
4. Confirm your configuration with "OK".
The selected objects are combined into a customized object.
The selection border of the multiple selection becomes the rectangle around the customized
object.
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See also
How to edit a customized object (Page 670)
How to delete a customized object (Page 671)
Example: How to create a compressor as a customized object (Page 672)
Working with Objects (Page 425)
Multiple Selection of Objects (Page 433)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)

Properties of a Customized Object
Introduction
You define a selection of the available property groups and attributes in the "Properties" tab.
You can edit the name and the configured language of an available attribute. Every attribute
of the customized object can also be linked to attributes of the included single objects.

Configuration dialog
Object type
The type of the selected customized object is displayed. Enter the name you require.
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Language
You can configure the customized object and the attributes of the selected properties for
different languages.
Select the required attribute and click
to select one of the languages installed in WinCC.
Selected Properties
This area contains the property groups and attributes that are displayed as properties of the
customized object in the "Object Properties" window. You can add or remove property groups
and attributes from the selection as required.
Click the "+" or "-" symbols to show or hide subordinate entries.
The detailed description can be found in the following chapters: "Configuring property groups
of a customized object" and "Configuring attributes of a customized object".
Objects
This area contains all objects included in the customized object.
Select an object for which you want to show the available attributes in the "Properties" area.
Properties
This area contains all available attributes for the object selected in the "Objects" area.
Double-click the required attribute to insert it into the assigned position in the "Selected
Properties" area. The detailed description can be found in "Inserting or deleting attributes of a
customized object".
Note
An object can only receive an operator authorization as a "Whole". A customized object can
have an operator authorization but its subordinate objects cannot.

Object Properties dialog
"Inherit Status" attribute
The statuses of the "Display" and "Operator-Control Enable" properties of the user object can
be inherited by the individual objects of the customized object. The "Inherit status" property
determines whether a change in the outer "Display" and "Operator-Control Enable" properties
is passed on to the inner objects.
Example 1
You have configured the "Inherit status" properties for the customized object with "Yes" and
"Display" as "Visible".
One object of the customized object has the property "invisible".
If the customized object is made invisible and then again visible, then all objects of the
customized object are shown as visible even if one object of the customized object has the
property "invisible".
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Example 2
You have configured the "Inherit status" property for the customized object with "No" and
"Display" as "Visible".
The customized object is now switched to invisible. If you then set the property of an inner
object to "Visible", the inner object is not visible. The inner object only becomes visible if the
customized object is changed to visible.

See also
How to configure the property groups of the customized object (Page 662)
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
Events of a customized object (Page 668)

How to configure the property groups of the customized object
Introduction
Only the property groups that are listed in the "Selected Properties" area are shown for the
customized object in the "Object Properties" window. You configure the selection of the
property groups with the "Theme Selection" dialog. You can change the predefined name of
the user-defined property groups.

All Themes
All property groups that are made available for the customized object are listed in the left
section of the dialog.
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Selected Themes
All property groups that you have selected for the customized object are listed in the right
section of the dialog.
Arrow buttons
Use the arrow buttons to move property groups in the direction of the arrow:
Moves the selected property groups from the left to the right section.
Moves the selected property groups from the right to the left section.

Requirements
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the
selected customized object.
● There must be at least one property group in the "Selected Themes" area.

Selecting property groups
1. Select the "Theme Selection..." entry in the pop-up menu of the "Selected Properties" area".
The "Theme Selection" dialog opens.
2. Select the desired property groups and move them with the arrow buttons.
3. Confirm your configuration with "OK".

Renaming property groups
You can also use user-defined property groups for a customized object. By default they contain
the name "User-defined" and a sequential number that you can change.
1. Select "Rename" in the pop-up menu of the property group.
The name of the property group can now be edited.
2. Enter the new name for the property group.
3. Confirm your entry with <ENTER>.

See also
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)
Events of a customized object (Page 668)
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How to add and delete attributes of a customized object
Introduction
Attributes of the customized object that you want to show in the "Object Properties" window
can be added or deleted from the selection in the "Selected Properties" area of the
configuration dialog.

Requirements
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the
selected customized object.

Adding attributes
1. Select an object in the "Objects" area from which you want to provide an attribute for the
customized object.
The available attributes of the selected object are shown in the "Properties" area.
2. Double-click the required attribute in the area "Properties".
The selected attribute is added at the relevant position in the "Selected Properties" area.
The attribute name is extended by the object name of the object.
3. Repeat steps 1 and 2 until all desired attributes are in the "Selected Properties" area.
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Alternatively you can drag attributes to the desired position in the "Selected Properties" area
with the mouse.
Note
The attributes of the customized object are automatically assigned to the associated property
group. The default assignments cannot be changed.

Deleting attributes
1. Select the attributes of the customized object that you want to delete in the "Selected
Properties" area.
2. Select "Delete" in the pop-up menu of the selected attribute.
The selected attribute is removed from the selection.

See also
How to configure the property groups of the customized object (Page 662)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)
Events of a customized object (Page 668)
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How to configure the properties of attributes of the customized object
Introduction
You can change the properties of the attributes available in the customized object for display
in the "Object Properties" window. The properties of the attributes can bee configured with the
"Properties" dialog.

Current language
Displays the language for which the attribute is configured.
Attribute Name
Displays the attribute names under which the attribute is registered in WinCC. The "OLE
Automation Name" must be unique. A change of the attribute name affects all languages
configured for the attribute.
Name of Property
Property names with which the attribute is displayed in the "Object Properties" window.

Requirements
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the
selected customized object.

Procedure
1. Select the attribute of the customized object whose properties you want to configure in the
"Selected Properties" area.
2. Select "Properties..." in the pop-up menu of the selected attribute.
Opens the "Properties" dialog.
3. Change the settings and confirm your input with "OK".
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See also
How to configure the property groups of the customized object (Page 662)
How to add and delete attributes of a customized object (Page 664)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)
Events of a customized object (Page 668)

Linking a Customized Object with a Structure Tag
Introduction
Customized object may be linked with a structure tag with an open tag dialog in Graphics
Designer simply by using Drag&Drop. Using the object properties of two text fields, structure
type and unique identification of the object are characterized using the structure tag.

Prerequisites
● A structure type and at least one structure tag must be configured.
● In the customized object, you have added two objects "Static Text" with the property "Text"
in "Selected Properties" to "UserDefined2".
● In Graphics Designer, the tag dialog must be open. Using the menu "View/Toolbars..." you
activate the tag dialog.

Procedure
1. In "Configuration Dialog Customized Object" in the area "Selected Properties", select one
of the static texts for the Customized Object.
2. In the dialog "Properties" for "Attribute Name", enter the name "StructureType".
3. In "Configuration Dialog Customized Object" in the area "Selected Properties", select the
second static text for the Customized Object.
4. In the dialog "Properties" for "Attribute Name", enter the name "tagname".
5. Confirm your settings with "OK".
6. In the "Object Properties" dialog of the Customized Object, enter under attribute
"StructureType" the name of the structure type as text.
7. Dynamize the desired properties with an element of a valid structure tag.
8. If you now select the Customized Object, the open tag dialog will only display the available
tags of the assigned structure type.
9. Using Drag&Drop, you connect the desired structure tag from the tag dialog with the
customized object. The structure tag is entered into the object property "tagname".
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Duplicate customized object may be assigned a tag of the same structure type using
Drag&Drop.

See also
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)

Events of a customized object
Introduction
You configure the events available for the customized object with the "Event" tab. You can
also make "Object Events" available for the included single objects.

Selected Events
This area contains the event groups "Mouse", "Keyboard", "Focus", "Miscellaneous" and
"Object Events". You assign the events configured for the customized object to these event
groups. All events that you configure for the single objects in the customized object are
assigned to the "Object Events" event group.
Click the "+" or "-" symbols to show or hide subordinate entries.
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Objects
This area contains all objects included in the customized object.
Select an object for which you want to show the available events in the "Properties" area.

Event
This area contains all available events for the object selected in the "Objects" area.
Double-click the required event to insert it into the assigned position in the "Selected Events"
area.

See also
Properties of a Customized Object (Page 660)
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
How to configure the property groups of the customized object (Page 662)

How to configure the events of a customized object
Introduction
The events available for the customized object are configured with the "Events" tab. You can
also make "Object Events" available for the included single objects.

Requirements
● Select a customized object.
● Open the "Configuration Dialog Customized object" from the pop-up menu and select the
"Events" tab.

Adding events
1. In the "Objects" area, select an object for which you want to configure an event in the
customized object.
The events available for the selected object are displayed in the "Events" area.
2. Double-click the required event in the "Event" area.
The selected event is inserted into the respective event group in the "Selected Events"
area. The event name is extended by the object name of the object.
3. Repeat steps 1 and 2 until all desired events are in the "Selected Events" area.
4. Confirm your configuration with "OK".
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Alternatively you can drag events to the desired position in the "Selected events" area with the
mouse.
Note
The events configured for the customized object are automatically assigned to the associated
event group. The default assignments cannot be changed.

Deleting events
1. Select the event of the customized object that you want to delete in the "Selected Events"
area.
2. Select "Delete" in the context menu of the selected event.
The selected event is removed from the selection.

See also
How to configure the property groups of the customized object (Page 662)
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
Working with Customized Objects (Page 657)
Properties of a Customized Object (Page 660)
Events of a customized object (Page 668)

How to edit a customized object
Introduction
The edit mode for the customized object is activated with the "Customized object / Edit ..."
function. In edit mode the properties of all included single objects can be separately changed.
Single objects can be added or deleted. A single object contained in a customized object is
edited as described in "Working with objects".
The selection marks of the single objects are shown as gray squares with a white border in
edit mode. When edit mode is exited, only the selected objects are imported into the
customized object.
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Prerequisites
● Select a customized object.

Activating edit mode
1. Open the pop-up menu or the "Edit" menu.
2. Select "Customized object / Edit...".
The Edit mode will be activated.
Like multiple selection of objects, selection marks for the single objects contained in the
customized object are shown. The selection marks are shown as gray squares with a white
border in edit mode.

Exit edit mode
1. Open the pop-up menu or the "Edit" menu.
2. Select "Customized object / Exit edit".
Edit mode is deactivated.
When edit mode is exited, only the selected objects are imported into the customized object.
If no object is selected, the customized object is discarded.

See also
Working with Customized Objects (Page 657)
Working with Objects (Page 425)
How to delete a customized object (Page 671)
How to create a customized object (Page 659)

How to delete a customized object
Introduction
A customized object can be split into its component objects with the command "Customized
Object / Delete" in the pop-up menu or the "Edit" menu. The individual objects are then shown
as a multiple selection.

Prerequisites
● Select a customized object.

Procedure
1. Open the pop-up menu or the "Edit" menu.
2. Select "Customized Object / Delete".
The selection marks of the customized object are hidden.
The individual objects of the customized object are shown as a multiple selection.
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See also
How to create a customized object (Page 659)
Multiple Selection of Objects (Page 433)
The Rectangle Surrounding the Object (Page 281)
Working with Customized Objects (Page 657)
Working with Combined Objects (Page 653)

Example: How to create a compressor as a customized object
Introduction
A customized object that can be used to display a compressor is to be prepared for a system
design. Only specific properties should be configurable to allow multiple use of the
"Compressor" customized object in the design.
The "Compressor" customized object should have the check-back messages "On", "Off",
"Approach" and "Retract". The "On" and "Off" states must be visualized by a change in a
background color. The "Approach" and "Retract" states must be displayed by flashing lines.
The following example implements this task step-by-step.
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Procedure
1. Create a graphic to show the compressor.

The compressor is created from the following standard objects: 2 circles, 3 lines and a static
text.
2. Select all objects from which the customized object must be created.
Select "Customized Object / Create..." in the multiple selection context menu.

The "Configuration Dialog Customized object" dialog opens.
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3. The "Configuration Dialog Customized Object" shows all the single objects contained in the
customized object with their properties and events.
Select the "Properties" tag.

In this example the "UserDefined2" property group is used to define the desired properties
and events of the customized object.
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4. Select "Rename" in the shortcut menu of the "UserDefined2" property group.

In this example the term "Settings" is entered as the new name of the "UserDefined2"
property group.
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5. The "On" and "Off" states must be visualized by changing the background color of Circle1:
Select the object "Circle1".
Drag the "Background color" property by Drag&Drop to the "Settings" property group.

The customized object now has the "Circle1.Background Color" attribute in the "Settings /
Background Color" property group.
6. Select "Properties..." in the shortcut menu of the attribute "Circle1.Background color".
The "Properties" dialog opens.

Enter a name for the dynamics of the attribute by C or VBS actions in the "Attribute Name"
field. The "Name of Property" field contains the exact name of the attribute for the display
in the "Object Properties" window and can also be changed.
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7. The "Approach" and "Retract" states must be displayed by flashing lines:
The line colors of all objects, which flashing is to be configured for, can be combined into
an attribute of the customized object.
Select the desired objects in sequence and drag the property "Line Color" via Drag&Drop
into the property group ""Settings".

The customized object now has the "Object.Line Color" attributes in the "Settings / Line
Color" property group.
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8. Repeat this process for all attributes that the customized object requires.

In this example the attributes "Flashing Line Color On", "Flashing Line Color Off" and
"Flashing Line Active" are added to various single objects.
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9. Select the "Events" tab to configure the required events for the customized object.

In this example only the "Mouse Action" event is configured.
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10.Select the event "Mouse".
Select the "CustomizedObject1" object that is to respond to the desired event. If the event
is to be configured for a contained single object, select the single object only.
Double-click the event "Mouse click".

The customized object now has the "CustomizedObject1.Mouse Action" event in the
"Mouse" event group.
Add more events in the same manner.
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11.The customized object should have the name "myCompressor":
Select the "Properties" tab.
Enter the name "myCompressor" in the field "Object type".
Click the entry "Customized Object" in the "Selected Properties" area to accept the name.

Confirm the configuration with "OK" to finish creating the "myCompressor" customized
object.
The configuration dialog "Configuration Dialog Customized object" will be closed.
12.Select the new customized object in your process picture.
Open the window "Object Properties" to check the configuration of the customized object.
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The "Settings" property group only shows the properties and events that you defined in the
"Configuration Dialog Customized Object".

See also
How to create a customized object (Page 659)
How to configure the property groups of the customized object (Page 662)
How to add and delete attributes of a customized object (Page 664)
How to configure the properties of attributes of the customized object (Page 666)
How to configure the events of a customized object (Page 669)
How to edit a customized object (Page 670)
How to delete a customized object (Page 671)
Events of a customized object (Page 668)
Properties of a Customized Object (Page 660)

3.8.11.4

Working with the library

Working with the library
Introduction
The library of the Graphics Designer is a versatile tool for saving and managing graphic objects
that can be used for creating process pictures.
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Global library
The "Global Library" offers a variety of pre-defined graphic objects that you can insert into a
picture as library objects and configure as required. Graphic objects such as machines and
plant components, measuring equipment, operator control elements and buildings are
thematically organized in folders.
The global library contains a comprehensive symbol library in the "Siemens HMI Symbol
Library" folder. It contains objects that are different from the other library objects.
You can add user-defined objects to the "Global Library" to make the objects available for other
projects as well. These objects must not be linked with dynamics to prevent errors when
embedding them in other projects.
Project Library
The "Project Library" enables a project-specific library to be built. The objects can sorted by
subjects by creating folders and subfolders.
You store user-defined objects here as a copy and make them available for multiple use.
Because the Project Library is only available for the current project, you can only include
dynamized objects in this library. The names of user-defined objects inserted into the library
can be freely selected.

Open library
You can show and hide the library of the Graphics Designer by using the
icon in the standard
palette. The display of the library objects can be configured with the elements of the toolbar.

Backup library objects
The project library is only available for the current project. If you have added user-defined
objects to the Project Library, you have to back up the Project Library.
In WinCC the library objects are stored in different folder paths:
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● All information on the global library is by default saved in the "\aplib" subfolder of the WinCC
installation folder.
● Objects of the project library as components of the current project are stored in the "\library"
subfolder of the project folder.
To be able to use the user-defined configurations of the project library in other projects, you
have to copy the contents of the relevant folder to the corresponding folder of the target project.
It is also recommended that you create a backup copy of the "\library" folder and update it
regularly.

Types of library objects
Two different object types are used as library objects in the global library. Accordingly a library
object that has been inserted into a picture is changed in various configuration dialogs:
Customized objects
The folders "System Modules", "Displays", "Operation" and "Symbols" contain pre-defined
customized objects.
If such a library object is inserted into a picture, changes can be executed in the "Object
Properties" window and in the "Configuration Dialog Customized Object". Both dialogs can be
opened from the pop-up menu of the inserted object.
Controls
The "Siemens HMI Symbol Library" folder contains an extensive symbol library whose
elements you can also insert as a control into a picture.
When you insert such a library object into a picture, carry out the changes in the "Object
Properties" window and in the "Properties of Siemens HMI Symbol Library" dialog. You open
the "Properties of Siemens HMI Symbol Library" dialog by double-clicking the inserted object.
The detailed description of the "Siemens HMI Symbol Library" is available in the section
"Working with Controls".

See also
Working with Combined Objects (Page 653)
How to import objects into the library (Page 687)
How to import library objects into a picture (Page 686)
The Library Toolbar (Page 684)

The Library Toolbar
Introduction
You can make the following settings with the tools in the toolbar of the "Library" dialog:
● Creating and deleting folders for sorting the library objects by topic.
● Copying, moving and deleting library objects or inserting them into the current picture.
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● Adding user-defined objects to the library.
● Adapting the display for the library objects.

Overview

Icon

Name

Function

New folder

Creates a new subfolder in the selected folder.
Folders can be renamed or deleted from their shortcut menu.

Cut

The "Cut" command is used to copy a selected library object to the operating system
clipboard. The library object is removed from the library.

Copying

The "Copy" command is used to copy a selected library object to the operating system
clipboard. The library object itself is not changed.

Paste

The "Paste" command can be used to add the current contents of the clipboard to the
selected library folder as often as desired.

Delete

The "Delete" command removes a selected library object from the current library folder.

Giant Icons

The "Giant Icons" command shows the library objects in the current folder as large
symbols.
No detailed information is shown except for the name of the object.
If the preview is activated, the symbol for the picture contents of the library object is
used.

Large Icons

The "Large Icons" command shows the library objects in the current folder as mediumsized symbols.
No detailed information is shown except for the name of the object.
If the preview is activated, the symbol for the picture contents of the library object is
used.

Small Icons

The "Small Icons" command shows the library objects in the current folder as a list
with small symbols.
No detailed information is shown except for the name of the object.
If the preview is activated, the symbol for the picture contents of the library object is
used.

List

The "List" command shows the library objects in the current folder as a list with small
symbols.
Besides the name of the object, the file size and the date of the last modification are
displayed as detailed information.
If the preview is activated, the symbol for the picture contents of the library object is
used.

Preview

The picture contents of the library objects are used for the symbolic display of the
library object.
If the preview is not activated, a default symbol is shown.

See also
Working with the library (Page 682)
How to import objects into the library (Page 687)
How to import library objects into a picture (Page 686)
The Library Toolbar (Page 684)
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How to import library objects into a picture
Introduction
You can insert library objects in a picture by dragging them with the mouse or by using the
clipboard.
When a library object is added to a picture, the object name is by default a combination of the
name of the object type and a sequential number. You can change the name with the "Object
name" attribute in the "Object Properties" window.

Requirement
● A picture must be opened.

Procedure
in the standard palette of the Graphics Designer.
1. Click
The "Library" dialog is opened.
2. Select a subfolder of the global library or the project library in the left section of the dialog.
The library objects in this subfolder are shown in the right section of the dialog.
3. Select a library object and drag it with the mouse to the required position in the picture.
When you release the mouse button, the insertion procedure is finished.

Alternative procedure
in the standard palette of the Graphics Designer.
1. Click
The "Library" dialog is opened.
2. Select a subfolder of the global library or the project library in the left section of the dialog.
The library objects in this subfolder are shown in the right section of the dialog.
3. Select the desired library object.
.
4. In the toolbar of the "Library" dialog, click
The library object is copied to the clipboard of the operating system.
5. Click
in the standard palette of the Graphics Designer.
The library object is inserted into the current picture from the clipboard.

See also
How to import objects into the library (Page 687)
How to Rename Objects (Page 430)
The Library Toolbar (Page 684)
Working with the library (Page 682)
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How to import objects into the library
Introduction
You can add the objects contained in a picture to the library by dragging them with the mouse
or by using the clipboard. If required, create new folders and subfolders and assign a
corresponding name to the inserted library object for easier repeated use in the future.
You can add user-defined objects to the "Global Library" to make the objects available for other
projects as well. These objects must not be linked with dynamics to prevent errors when
embedding them in other projects.
You can also include dynamized objects into the "Project Library" because the objects are only
available for the current project.

Requirement
● A picture must be opened.

Procedure
in the standard palette of the Graphics Designer.
1. Click
The "Library" dialog is opened.
2. Select or create a subfolder of the global library or the project library in the left section of
the dialog.
The library objects in this subfolder are shown in the right section of the dialog.
3. Select the object in the active picture that you want to add to the selected folder of the
library.
4. Hold down the mouse button and drag the selected object into the library folder.
When you release the mouse button, the check box insertion is finished.
5. If you want to assign a name to the new library object, select "Rename" in the context menu
of the new library object.
The name of the library object becomes editable.
6. Enter the new name and confirm this by pressing <ENTER>.

Alternative procedure
in the standard palette of the Graphics Designer.
1. Click
The "Library" dialog is opened.
2. Select or create a subfolder of the global library or the project library in the left section of
the dialog.
The library objects in this subfolder are shown in the right section of the dialog.
3. Select the object in the active picture that you want to add to the selected folder of the
library.
in the standard palette of the Graphics Designer.
4. Click
The selected object is copied to the clipboard.
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5. In the toolbar of the "Library" dialog, click
.
The new library object will be inserted into the selected library folder from the clipboard of
the operating system.
6. If you want to assign a name to the new library object, select "Rename" in the context menu
of the new library object.
The name of the library object becomes editable.
7. Enter the new name and confirm this by pressing <ENTER>.

See also
How to import library objects into a picture (Page 686)
The Library Toolbar (Page 684)
Working with the library (Page 682)
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3.9

Process Pictures in Runtime

3.9.1

Process Pictures in Runtime

Introduction
The behavior of process pictures that you created and dynamized with the Graphics Designer
can be tested in Runtime. Some object properties, such as the rotation or flashing of an object,
can only be displayed in Runtime.
In this chapter, you will learn to
● activate and deactivate Runtime
● configure user-defined menus and toolbars
● configure the on-screen keyboard
● configure mouseless operation for Runtime

See also
Activating Project (Page 170)
How to activate / deactivate Runtime (Page 689)
How to set up Runtime (Page 145)
How to set up a picture for mouseless operation (Page 706)
Virtual keyboard - General Information (Page 702)

3.9.2

How to activate / deactivate Runtime

Introduction
Activate Runtime in WinCC Explorer or in Graphics Designer. When it is activated in WinCC
Explorer, Runtime starts with the predefined start picture. If it is activated in Graphics Designer,
the active picture is opened in Runtime. You can only deactivate Runtime in the WinCC
Explorer.

Requirements
● A project must be opened.
● The local computer's name must be entered as the computer name in the project.
● A process picture, which is found in the project, must be defined as the start picture.
● Changes in a picture can only be displayed in Runtime if you save the picture before
activating Runtime.
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Activating runtime
Program modules additionally required for Runtime are loaded with the "Activate Runtime"
command.
WinCC Explorer
Click

in the toolbar to open Runtime with the predefined start picture.

Alternatively select "Activate" in the "File" menu. When Runtime is activated this is indicated
by a check mark in front of the entry "Activate".
Graphics Designer
Click

in the standard palette to open Runtime with the active picture.

Alternatively select "Activate Runtime" in the "File" menu.
Note
In Runtime, you can find out the name of the current picture and the graphic object. Press
and hold down "Shift+Ctrl+Alt" and move the mouse pointer over a graphic object in the
picture. A tooltip displays the picture name and the name of the graphic object. You cannot
find out the name of an ActiveX control.

Deactivating Runtime
You can only deactivate Runtime in the WinCC Explorer.
Click
in the toolbar to deactivate Runtime.
The modules for the execution of Runtime are deactivated. The "WinCC Runtime" program
window is closed.
Alternatively select "Activate" in the "File" menu. The check mark in front of the "Activate" entry
is removed.

See also
How to set up Runtime (Page 145)
Process Pictures in Runtime (Page 689)

3.9.3

Menus and Toolbars

3.9.3.1

User-defined menus and toolbars

Introduction
In the "Menus and Toolbars" editor you can configure customized menus and toolbars. The
customized menus and tool bars can be displayed in the basic picture of a project and also in
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the picture windows. You connect menu items and symbols using procedures from Global
Script VBS.

Usage
You used customized menus and toolbars, for e.g. to implement a picture navigation. The
customized menus and toolbars are displayed in the basic picture of the project. You can thus
shift from any picture to the pictures that you have configured the picture change using menu
commands and symbols.

Principle
You save the customized menus and toolbars in configuration files. For each configuration file,
you can:
● Save a menu
● Save any number of toolbars
● Connect a maximum of 1250 scripts to menu items and icons
A maximum of 20
menus and toolbars can be loaded simultaneously
In WinCC Explorer you can specify the configuration file as the "Start configuration" in the
"Graphics Runtime" tab in the "Computer properties".
In the Graphics Designer, you can connect the configuration file via the "Menu/Toolbar
configuration" object property in the "Picture window" smart object..
Note
Customized menus and toolbars in the WebNavigator
If you have indicated a configuration file in the "Start Configuration", the customized menus
and toolbars are also displayed in the WebNavigator.

Configuration Options for Customized Menus and Toolbars
Operator authorization
You can assign authorizations to customized menus and toolbars and their elements. The
elements are automatically disabled if a logged in user does not have the required
authorization.
Inactive or invisible elements
Further, you can disable or hide customized menus and toolbars and their elements. You can
also exchange the configuration file, for e.g. in case of user change during runtime, if you save
the modified functional scope in a new configuration file.
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Language-dependent configuring
In the "Menus and Toolbars" editor you can configure language-dependent texts for menus
and toolbars. For this, switch to the language in the Menus and Toolbars editor. Then re-enter
the language-dependent texts.

Connect menu command or icon to procedure
Use the following syntax to connect a procedure from the global script to a menu item or icon:
Sub <Procedurename> (ByVal Item)
Tag declarations
'Instructions
End Sub
The transfer parameter "Item" shows the object that the user has clicked. Use the "User data"
field in the "Menus and Toolbars" editor to apply a parameter to the procedure.
The following example shows the "ActivateScreen" procedure that executes the picture
change. Enter the picture name in the "User Data" field:
Sub ActivateScreen (ByVal Item)
Dim objScreen
Dim strScreenName
' "UserData" contains the screen name specified
' in editor menus and toolbars.
strScreenName = Item.Userdata
HMIRuntime.BaseScreenName = strScreenName
End Sub
Note
When a procedure is changed in the "Menus and toolbars" editor, the configuration file must
be opened again and saved.
In addition to saving in the VBS editor, when the project module is changed the corresponding
configuration must be opened again and saved in the "Menus and toolbars" editor. The
change is then applied in Runtime. It is only when saved that the information regarding the
necessary project modules is transferred to the configuration file.

Change Customized Menus or Toolbars at Runtime
You can dynamize the "Menu/Toolbar configuration" property in a picture window. There is
also the possibility of changing the configuration of the basic picture and the picture window
with VBS.
The following example shows a procedure that applied the configuration file to be loaded as
parameter.
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Sub ChangeMenuToolbarConfigFile (ByVal strMTConfigFile)
HMIRuntime.MenuToolBarConfig = strMTConfigFile
End Sub
Note
Updating Changed Configuration in Runtime
A changed VB script that is connected with "Menus and toolbars" is only updated after
Runtime is restarted.
If you change the properties of "Menus and toolbars" in Runtime, the changes are only applied
in the following cases:
● After a picture change, if the configuration change does not affect the basic picture.
● When you load another configuration file and reload the modified configuration file.

3.9.3.2

How to Create a Menu

Introduction
In each picture, a menu is placed at the top margin. You can configure one menu bar for each
configuration file.

Menu structure
The configuration options for a menu element depend on the position where the menu is
located in the menu structure.
The following picture shows a typical menu structure with different menu elements:

The following table explains the function of the menu elements shown in the picture:
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Menu element

Function

MainMenu

Represents a menu bar.

Clean

Displays a menu item. You can add menu commands, separators or other menu
items (as sub-menus) in a menu item.

Sort

Represents a menu command. Assign a procedure that is run when you click
on the menu command to a menu command. You can enter a parameter (for
e.g. picture frame) that is to be transferred to the procedure under "User Data".

Requirement
● The menu structure is yet to be planned.
● The Menus and Toolbars editor is open.
● The tab "Menus" is displayed.

Procedure
1. Add the required number of menu elements.
2. Assign the menu elements to the desired hierarchy levels.
3. Enter a Name and a Text for each menu element.
4. For each menu element, select a procedure that is run while clicking a menu element. Enter,
if required, a transfer parameter for the procedure under "User data".
5. Define, if required, for each element whether it is "visible" or "active" during runtime and
whether an authorization to operate is necessary.
6. While configuring a multi-lingual user interface, select the desired target language and enter
the Texts for the menu elements.
7. Select "File > Save" to save the configuration.
Select "File > Save As" to save the configuration under a new name.

Results
The figure below shows the above example menu in Runtime:
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Changing Configuration
1. Select the "File > Open" command to load a configuration file.
2. Change the menu elements.
3. Save the configuration.

3.9.3.3

How to Create a Toolbar

Introduction
You can configure any number of tools for each configuration file. For each toolbar you can
define the placement position of the toolbar in the picture. Further, you can also define whether
the user should have the option of freely placing the toolbar.

Requirement
● The toolbar structure is yet to be planned.
● The Menus and Toolbars editor is opened.
● The tab "Toolbars" is displayed.

Procedure
1. To add a new toolbar, select the "Edit > Add Toolbar" command.
2. Enter a Name and a Text for each toolbar.
3. Select an "Alignment" and the "Mode" and define the "Masking color", if required.
4. Define, if required, whether the toolbar is "visible or "active" during runtime and whether an
authorization is required for operation.
5. To add a new icon to the toolbar, select the "Edit > Add Toolbar element" command.
6. Configuring the icon:
– Depending on the toolbar configuration, enter a text for the icon and/or select a picture.
– If required, also enter a tooltip text that is to be displayed at runtime as help for the icon.
– For the icon, select the procedure that is to be run when the icon is clicked. Under "User
data" enter a transfer parameter for the procedure.
– Define, if required, whether the icon is "visible or "active" during runtime and whether
an authorization is required for operation.
7. Select "File > Save" to save the configuration.
Select "File > Save As" to save the configuration under a new name.
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Results
The following picture shows a toolbar with three icons that are labeled with a text.

The following picture shows the toolbar at runtime:

696

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.9 Process Pictures in Runtime

3.9.3.4

How to configure menus and toolbars in a picture

Introduction
For each project you can save a configuration file with configured menus and toolbars. The
customized menus and toolbars are displayed in each basic picture at the configured position.
You can use VBScript to load other configuration files at runtime. You can e.g. load different
configuration files depending on the selected picture or from users that are logged in.

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.
WinCC displays the list of computers in the data window.
2. Select the computer and then click the Properties command in the pop-up menu.
The "Computer properties" dialog will open.
3. Click "Search" in the "Start configuration menu and toolbars" area of "Graphics Runtime"
tab.
4. Select the configuration file in the file selection dialog.
5. Click "OK" to close all dialogs.

Results
When you activate a project, all customized menus and toolbars will be displayed in the basic
picture of the project.

3.9.3.5

How to configure menus and toolbars in a picture window

Introduction
Independent of the start configuration, you can load, in a picture window, an additional
configuration file with user-defined menus and toolbars.
The customized menus and toolbars of the picture window and the start configuration can thus
be displayed in the picture window.
Note
The "Configuration of menu/toolbars" attribute can be made dynamic using the
"MenuToolBarConfig" name.

Requirements
● The picture is opened.
● Picture window can be configured.
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Procedure
1. Open the object properties of the configured picture window.
2. Select the "Others" property group.
3. Double-click the "Configuration of menu/toolbars" attribute and select the desired
configuration file in the file selection dialog.

Results
The customized menus and toolbars are displayed in the picture window during runtime.

3.9.3.6

Control elements of the "Menus and Toolbars" editor

Common features
The toolbars, menus and their elements have the following properties:
Properties

Function

Explanation

Name

Defines the name of the element.

Use the internal name to uniquely
identify the element.

Text

Defines the text that is displayed in the
menu or toolbar.

The text is language-dependent.

Active

defines whether the element is active
(enabled).

Visible

defines whether the element is visible

Use these settings if you have
already configured the structure of
the menus and toolbars; however,
not all elements are capable of
functioning.

Authorization

Defines the authorization required to
operate the element at runtime.

The element is disabled
automatically when the logged-in
user does not have the
authorization.

Properties of Menus and Toolbars
The following properties are available only for menus and toolbars:
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Properties

Function

Explanation

Fixed (only toolbar)

Determines whether the toolbar is fixed

If the toolbar is not fixed, the user
can move it to any margin of the
window (docked) or it can also be
displayed as a separate window
("floating").

Alignment (only
toolbar)

Defines the toolbar position.

Possible positions are:

Mode (only toolbar)

Defines the display type for the element
in the toolbar.

Top, right, left or bottom
Possible display types are:
Text, picture or text+picture
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Properties

Function

Explanation

Picture size

Defines the picture size in pixels for the
icon.

The selected picture is automatically
scaled to the defined picture size.

Masking Color

Indicates which icon color is to be
replaced by the background color of the
menu or toolbar.

Use the masking color if you use, for
e.g. round, symbols.

Properties of menu items and icons
The following properties are available only for menu items and icons:
Properties

Function

Explanation

Tooltip text (only
toolbar)

Defines the help text for the icon.

The help text is displayed if the user
points with the mouse on the icon.

Separator

Configuring the element as separator.

Use separators to optically
demarcate the function groups from
each other.

User Data

Contains the value that is transferred
during procedure call.

You can enter, for e.g. the picture
name that is transferred to the
procedure as parameter.

Script

Defines the procedure that is run when
the element is clicked.

Use "..." to open a selection dialog.
Use "R" to remove the procedure.

Picture

Defines the icon displayed for the
element.

Use "..." to open a selection dialog
where you can select a picture.

Commands for Changing the Structure of Menus and Toolbars
Command

Icons in the
Toolbar

Function

Paste Element

Adds a new menu item under the selected menu
item.

Add toolbar

Adds a new toolbar.

Add icon

Adds a new icon to the selected toolbar.

Delete object

Deletes the selected object.

Moves Object Up

Moves up an element within a layer.

Move Object Down

Moves down an element within a layer.

Move Object Left

Moves a menu item to one higher layer.

Move Object Right

Moves a menu item to one lower layer.

Reduce

Closes the highlighted part of the tree when the
tree part has been opened.

Expand

Opens the highlighted part of the tree when the
tree part is closed.
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3.9.3.7

How to define the font for the various languages

Introduction
You can define the font and text size for the menus and toolbars for each language individually.

Requirements
● The WinCC Explorer is open.

Procedure
1. Select item "Font settings" command from the "Menus and Toolbars" context menu.
The "Font settings" dialog opens.

2. Select the language for which you want to define a font.
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3. Click on "Font".
The "Font" dialog box will open.

4. Select the font and text size.
5. Click "OK".
The changes that have been made are shown in the "Font settings" dialog.

6. Repeat steps 2 to 5 for all languages for which you want to define the font.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

701

Creating Process Pictures
3.9 Process Pictures in Runtime

3.9.4

Virtual keyboard

3.9.4.1

Virtual keyboard - General Information

Introduction
The monitor keyboard is a virtual keyboard on the screen of the HMI device. The operator can
click the keys shown on the screen, for example, to fill in an input field.

Properties of the monitor keyboard
● The monitor keyboard has keys for entering numerical or alphanumeric characters.
● The key labels shown on the monitor keyboard are set to agree with the Regional Settings
in the Windows Control Panel. In other words, an English keyboard will not have any special
characters for German or French. The layout of the letters on the keyboard is also in part
different.
to change
If several keyboard layouts have been installed, you can click
the keyboard layout.
The illustration shows a German monitor keyboard for entering alphanumeric values.

Activating the monitor keyboard
The monitor keyboard can be either displayed automatically for an input or activated by the
operator when needed by pressing a key. The monitor keyboard can only be hidden using the
"X" button in the monitor keyboard's title bar or by clicking on a place outside of an entry field.
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Monitor keyboard - position on screen
The default position of the monitor keyboard is in the center of the screen. The monitor
keyboard can be positioned, maximized and minimized on the screen like any other window.
Note
Disabling keystrokes
Use the monitor keyboard provided in WinCC instead of the Windows "On-Screen Keyboard",
for example, so that you can disable the <CTRL+ALT+DEL> keystrokes.

See also
How to configure the activation of the virtual keyboard (Page 703)
How to operate the virtual keyboard (Page 704)

3.9.4.2

How to configure the activation of the virtual keyboard

Introduction
You can configure the behavior of the monitor keyboard as follows:
● The monitor keyboard is displayed automatically for an input and then hidden once the
input is finished.
● The monitor keyboard can be displayed manually when the operator presses a key. The
monitor keyboard can only be hidden using a button in its title bar.

Display monitor keyboard automatically for input
The monitor keyboard will always be shown in WinCC Runtime as soon as the operator has
selected an input field. Once the entry has been completed, the keyboard will be automatically
hidden again.

Procedure
1. In WinCC Explorer double-click "Computer" and then right click in the project window on
the right to open the shortcut menu with the properties of the computer.
2. On the "Runtime" tab, use the check box "Monitor keyboard".

Press a key to display the monitor keyboard
In this configuration, the operator can call up the monitor keyboard and use it not only for
making entries in WinCC Runtime, but also to work in other applications, such as Excel.
Connect the action for starting the monitor keyboard to a button in a WinCC picture. If the
operator clicks on the button in Runtime, the monitor keyboard will remain on the screen even
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after a switching to another application or exiting from WinCC. To close it, the operator must
use the button in the monitor keyboard's title bar.

Prerequisite
● Start the Graphics Designer and open a picture.

Procedure
1. Configure a button by dragging the Windows "Button" object from the "Standard" window
into the picture. Label the button in the Configuration dialog with the appropriate text.
2. Click the "Dynamic Wizard" tab and then the "System Functions" tab. Double-click the "Start
other applications" function. The configured button must be selected in the picture while
you perform the above step.
3. In the Wizard, select a trigger which is to be used to start the monitor keyboard.
4. To select the application for starting the monitor keyboard, click the
page of the wizard. The file selection dialog opens.

button on the next

5. Go to the "Programs/Common Files/Siemens/bin" folder. Select the
"CCOnScreenKeyboard.exe" application.
6. Exit from the Wizard and save the picture.

Result
The operator can use this button to display the monitor keyboard permanently. To close it, the
operator must use the button in the monitor keyboard's title bar.
If the "Use monitor keyboard" check box is selected in addition to display of the keyboard by
means of the button, only users with administrator rights can access applications outside of
WinCC Runtime by means of the monitor keyboard.

See also
How to operate the virtual keyboard (Page 704)
Virtual keyboard - General Information (Page 702)

3.9.4.3

How to operate the virtual keyboard

Entering alphanumeric values
To enter character strings and numerical values, WinCC automatically displays an
alphanumeric monitor keyboard in Runtime as soon as you select an input field or double-click
a cell or enter values in a WinCC Control in editing mode.
Once the entry has been completed, the keyboard will be automatically hidden again.
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Keyboard levels
The alphanumeric monitor keyboard has several levels:
● the normal level
● the shifted level for entering uppercase and special characters
● the Alt Gr level for entering special characters
● the function key level for accessing the function keys F1 to F12

Alphanumeric values can be entered character by character using the monitor keyboard's
buttons. You confirm the entered value with the enter key and the monitor keyboard is hidden.

Entering numerical values
To enter numerical values, click the "123" button to display the numeric monitor keyboard.
Once the entry has been completed, the keyboard will be automatically hidden again.

Numeric values can be entered character by character using the monitor keyboard's buttons.
You confirm the entered value with the enter key and the monitor keyboard is hidden.
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Disable keys and key combinations
The following key combinations and keys can also be disabled for the monitor keyboard in
WinCC:
● CTRL+ALT+DEL
● CTRL+ESC
● CTRL+SHIFT+ESC
● ALT+TAB
● Windows Buttons
1. In WinCC Explorer double-click "Computer" and then right click in the project window on
the right to open the shortcut menu with the properties of the computer.
2. In the "Parameters" tab, activate the check box "Disable Keys". This will disable all of the
key-combinations described above and the keys on the monitor keyboard.

See also
Virtual keyboard - General Information (Page 702)

3.9.5

Setting up Mouseless Operation of a Picture

3.9.5.1

How to set up a picture for mouseless operation

Introduction
Graphic objects such as buttons or I/O fields must be operated in Runtime to influence the
processes. Operation via the keyboard can be convenient and ensures that all necessary
entries are made. The user moves from one graphic object to the next in a specified order in
order to enter values, for example.

Requirement
● The graphic objects must be enabled for operation.
● Operator authorization must be assigned for the graphic objects.

Mouseless operation
Mouseless operation is specified using cursor mode:
● "Alpha cursor": The user only moves to "I/O field" and "Text list" objects.
● "Tab Order": The user moves to specified object types where entry is supported.
Cursor mode must be specified before starting Runtime for the process picture. However, you
can toggle the mode in Runtime.
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Combining the alpha and tab order cursors in a picture
The cursor mode can be toggled in Runtime if a hotkey has been specified for this. The operator
can then switch between using the alpha or tab order cursor in Runtime. The tab sequence
must be specified for both types of cursor.

Moving from one object to the next in Runtime
The tab sequence is used to specify the order in which graphic objects are operated in Runtime.
You can display and, if necessary, change the tab sequence. Individual objects can be
removed from or restored to the tab sequence.
By default, the cursor is moved with the <TAB> key or <SHIFT+TAB> for the reverse order.
Operation via hotkeys can also be specified.

See also
Defining the Alpha cursor's tab sequence (Page 707)
Specifying the tab sequence of the tab order cursor (Page 709)
How to define hotkeys for operation and screen navigation (Page 157)
How to Assign Hotkeys in the Project (Page 142)
How to configure the cursor control in Runtime (Page 162)
How to set up Runtime (Page 145)
Virtual keyboard - General Information (Page 702)
Process Pictures in Runtime (Page 689)

3.9.5.2

Defining the Alpha cursor's tab sequence

Introduction
In mouseless operation in Runtime, the alpha cursor will only access I/O field and text list
object types.

Procedure
1. In the Graphics Designer, select "Sequence" in menu "Edit/TAB Sequence/Alpha Cursor".
If the "Sequence" entry is not active, the picture does not contain any I/O field or text list
objects.
2. All I/O fields and text lists are automatically allocated a number in the top left corner. The
numbers are displayed in a box in WinCC Classic design and in a circle in all other designs.
3. In the picture, click on the object that you want to move to first. Then click on the other
objects according to the desired tab sequence.
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4. To conclude the entry, click on the desktop.
5. Check whether the "Cursor Mode" property is set to "Alpha Cursor" for the process picture.
To do this, click a free area in the picture and select the "Properties" entry in the pop-up
menu. If necessary, change the "Cursor Mode" property to "Alpha Cursor" in the
"Miscellaneous" property group.

Results
In the following example, in Runtime the cursor first moves to the I/O field (1) and then to the
text list (2).

Changing the tab sequence
In order that you do not have to sort all objects again when changing the tab sequence, the
Graphics Designer offers the following options:
● Specify new sequence
Press and hold down the <SHIFT> key while clicking on an object. Release the <SHIFT>
key. The object is allocated the number "1" for the tab sequence. Then click on all the
objects in the desired tab sequence.
● Change the sequence
Press and hold down the <CTRL> key while clicking on the object that should be allocated
the number. Release the <CTRL> key. Now click on the object that should be next in the
sequence.
● Remove an object from/restore an object to the sequence
Press and hold down the <SHIFT+CTRL> keys while clicking on an object. The object is
removed from the tab sequence. The number of the object will be replaced by an asterisk.
The objects with higher numbers will be automatically renumbered.
Removed objects with an asterisk can be restored to the sequence using <SHIFT+CTRL>.
The objects are allocated a number again.
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See also
Specifying the tab sequence of the tab order cursor (Page 709)
How to set up a picture for mouseless operation (Page 706)

3.9.5.3

Specifying the tab sequence of the tab order cursor

Introduction
Every object can be accessed in Runtime with the tab order cursor.

Specifying object types
1. First specify which types of objects should be operable.
2. In the Graphics Designer, select "Settings" in menu "Edit/TAB Sequence/Tab Order".
3. In the "Object Types" dialog, activate the object types for the tab sequence.

4. Click "OK".

Results
All activated object types are automatically allocated a number in the top left corner. The
numbers are displayed in a box in WinCC Classic design and in a circle in all other designs.
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In the following example, in Runtime the cursor first moves to the I/O field (1), to the text list
(2), and then to the bar (3).

Specifying the sequence of the tab order cursor
1. In the Graphics Designer, select "Sequence" in menu "Edit/TAB Sequence/Tab Order". If
the "Sequence" entry is not active, the picture does not contain any objects of the type that
were specified in the "Object Types" dialog.
2. In the picture, click on the object that you want to move to first. Then click on the other
objects according to the desired tab sequence.
3. To conclude the entry, click on the desktop.
4. Check whether the "Cursor Mode" property is set to "Tab Order" for the process picture.
To do this, click a free area in the picture and select the "Properties" entry in the pop-up
menu. If necessary, change the "Cursor Mode" property to "Tab Order" in the
"Miscellaneous" property group.
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Changing the tab sequence
In order that you do not have to sort all objects again when changing the tab sequence, the
Graphics Designer offers the following options:
● Specify new sequence
Press and hold down the <SHIFT> key while clicking on an object. Release the <SHIFT>
key. The object is allocated the number "1" for the tab sequence. Then click on all the
objects in the desired tab sequence.
● Change the sequence
Press and hold down the <CTRL> key while clicking on the object that should be allocated
the number. Release the <CTRL> key. Now click on the object that should be next in the
sequence.
● Remove an object from/restore an object to the sequence
Press and hold down the <SHIFT+CTRL> keys while clicking on an object. The object is
removed from the tab sequence. The number of the object will be replaced by an asterisk.
The objects with higher numbers will be automatically renumbered.
Removed objects with an asterisk can be restored to the sequence using <SHIFT+CTRL>.
The objects are allocated a number again.

See also
Defining the Alpha cursor's tab sequence (Page 707)
How to set up a picture for mouseless operation (Page 706)
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3.10

Object properties

3.10.1

"Axis" Property Group

3.10.1.1

Axis Section (AxisSection)
Axis Section (AxisSection)
The "Axis Section" attribute defines the distance between the large tick marks for the "Bar"
object. The value is specified as the difference in value between two neighboring large tick
marks.
There is a free choice of value. A meaningful limit is provided by the minimum value and
maximum value of the scale.

0

The spacing between the large tick marks is set automatically according to the setting of the "Bar Scaling" attribute.

The "Axis Section" attribute can be made dynamic with the name "AxisSection".

3.10.1.2

Alignment
Alignment
The "Alignment" attribute defines the arrangement of the scale relative to the bar for the "Bar"
object. Depending on the setting for the "Bar Direction" attribute in the "Geometry" property
group, the scale can be displayed to the left or right or above or below the bar.
The possibilities for arrangement of the scale relative to the bar depend on the value of the
"Bar Direction" attribute in the "Geometry" property group.

Above / Below

The scale is displayed above or below the bar.

Left / Right

The scale is displayed to the left or right of the bar.

The "Alignment" attribute can be made dynamic with the name "Alignment".

3.10.1.3

Bar Scaling (ScalingType)
Bar Scaling (ScalingType)
The "Bar Scaling" attribute specifies the type of scale division for the "Bar" object. By selecting
suitable scale divisions, it is possible to emphasize a particular range of values in the bar
display.

Linear

The large tick marks are evenly distributed across the scale.
The spacing between the large tick marks corresponds to the value of the "Axis Section" attribute.

Logarithmic

The distribution of the large tick marks on the scale follows a logarithmic function.
The representation of low values is strongly emphasized.

Negative logarithmic

The distribution of the large tick marks on the scale follows a negative logarithmic function.
The representation of high values is strongly emphasized.
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Automatic (linear)

The large tick marks are evenly distributed across the scale.
The spacing between the large tick marks is set automatically.

Tangent

The distribution of the large tick marks on the scale emphasizes the representation of the low
and high values.

Square

The distribution of the large tick marks on the scale follows a square function.
The representation of high values is emphasized.

Cubic

The distribution of the large tick marks on the scale follows a cubic function. The representation
of high values is emphasized.

The "Bar Scaling" attribute can be made dynamic with the name "ScalingType".

3.10.1.4

Label Each (Long StrokesText Each)
Label Each (Long StrokesText Each)
The "Label Each" attribute specifies the number of labeled large tick marks for the "Bar" object.
If, for example, the attribute has the value "3", only every third large tick mark is labeled, starting
with the large tick mark with the lowest value.
There is a free choice of value. A meaningful limit results from the number of large tick marks.

0

The large tick marks are not labeled

1

Each large tick mark is labeled

5

Every fifth large tick mark is labeled

The "Label Each" attribute cannot be made dynamic.

3.10.1.5

Exponent Display (Exponent)
Exponent Display (Exponent)
The "Exponent Display" attribute specifies for the "Bar" object whether the numerical values
of the scale are shown exponentially or as decimal values without exponent.
The representation of decimal values can be defined with the attributes "Decimal Places" and
"Digits to the Left of the Decimal Point".

Yes

The numerical values of the scale are displayed exponentially.

No

The numerical values of the scale are displayed as decimal values without exponent.

The "Exponent display" attribute can be made dynamic with the name "Exponent".

3.10.1.6

Large Tick Marks (LongStrokesBold)
Large Tick Marks (LongStrokesBold)
The "Large Tick Marks" attribute specifies for the "Bar" object whether the large tick marks of
the scale are shown in bold or as normal.

Normal

The large tick marks of the scale are displayed normally.

Bold

The large tick marks of the scale are displayed in bold.
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The "Large Tick Marks" attribute can be made dynamic with the name "LongStrokesBold".

3.10.1.7

Large Tick Marks Length (LongStrokesSize)
Large Tick Marks Length (LongStrokesSize)
The "Large Tick Marks Length" attribute specifies the length of the large tick marks for the
"Bar" object. The length of the shorter tick marks corresponds to half of the value specified
here. The values are specified in pixels.
If the "Only Large Tick Marks" attribute has the value "Yes", no shorter tick marks are displayed.
There is a free choice of value.
The "Only Large Tick Marks" attribute can be made dynamic with the name "LongStrokesSize".

3.10.1.8

Decimal Places (RightComma)
Decimal Places (RightComma)
The "Decimal Places" attribute specifies for the "Bar" object the number of digits after the
decimal point for the display of numerical values in the scale.

0 - 20

The value can be chosen freely within the specified limits.

The "Decimal Places" attribute can be made dynamic with the name "RightComma".

3.10.1.9

Zero Point (ZeroPoint)
Zero Point (ZeroPoint)
The "Zero Point" attribute specifies for the representation of the bar in which position the zero
point value is displayed. The value is specified relative to the spacing of the scale end values
in %. For a value of 0 %, for example, the zero point value is shown at the height of the large
tick mark with the lowest value. The zero point can also be outside of the range represented.
The "Zero Point" attribute is only evaluated if the "Bar Scaling" attribute has the value
"Automatic". The absolute value for the zero point is set with the "Zero Point Value" attribute
in the "Miscellaneous" property group.
There is a free choice of value.
The "Zero Point" attribute can be made dynamic with the name "ZeroPoint".

3.10.1.10 Only Large Tick Marks (LongStrokesOnly)
Only Large Tick Marks (LongStrokesOnly)
The "Only Large Tick Marks" attribute specifies for the "Bar" object whether the sections
between the large tick marks in the scale of the bar are divided by shorter tick marks.
The length of the large tick marks is specified with the "Large Tick Marks Length" attribute.
The length of the shorter tick marks corresponds to half of the value specified here.
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Yes

In the scale of the bar, only large tick marks are displayed.

No

In the scale of the bar, the sections between the large tick marks are divided by shorter tick marks.

The "Only Large Tick Marks" attribute can be made dynamic with the name "LongStrokesOnly".

3.10.1.11 Scale (Scaling)
Scale (Scaling)
The "Scale" attribute specifies for the "Bar" object whether the bar is labeled with a scale.
Yes

The bar is displayed with a scale.

No

The bar is displayed without a scale.

The "Scale" attribute can be made dynamic with the name "Scaling".

3.10.1.12 Scale Marks (ScaleTicks)
Scale Marks (ScaleTicks)
The "Scale Marks" attribute specifies for the "Bar" object the number of segments into which
the bar is divided by the large tick marks of the scale.
0 - 100

The "Bar" object can be divided into a maximum of 100 segments.

=0

The optimum number of segments is set automatically.

The "Scale Marks" attribute can be made dynamic with the name "ScaleTicks".

3.10.1.13 Digits to the Left of the Decimal Point (LeftComma)
Digits to the Left of the Decimal Point (LeftComma)
The "Digits to the Left of the Decimal Point" attribute specifies for the "Bar" object the number
of digits before the decimal point for the display of numerical values in the scale.
0 - 20

The value can be chosen freely within the specified limits.

The "Digits to the Left of the Decimal Point" attribute can be made dynamic with the name
"LeftComma".

3.10.2

"Output / Input" Property Group

3.10.2.1

Number of Visible Lines (NumberLines)
Number of Visible Lines (NumberLines)
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The "Number of Visible Lines" attribute specifies the number of lines displayed in the selection
list of a text list. If the amount of configured text is larger than this value, the selection list
receives a vertical scroll bar in Runtime.
There is a free choice of value.
The " Number of Visible Characters" attribute can be made dynamic with the name
"NumberLines".

3.10.2.2

Output Format (OutputFormat)
Output Format (OutputFormat)
The "Output Format" attribute specifies the format for the display of an output value in the I/O
field. The available format definitions depend on the value of the "Data Format" attribute.
The following data formats are available for the input and output of values in an I/O field:
● Numerical values can be processed in binary, decimal, or hexadecimal format.
● For the display of text, assign the "String" data format.
● For the "Date/Time" data format, the date and/or time as well as the time span in
milliseconds can be displayed.
The "Output Format" can be dynamized using the "OutputFormat" name.

3.10.2.3

Output Value (OutputValue)
Output Value (OutputValue)
The "Output Value" attribute specifies a start value for the output which is displayed in Runtime
in the case of a missing process driver connection or if an update has not yet taken place.
It must be possible to display the output value with the format specifications specified with the
"Output Format" attribute. If this is not the case, three asterisks are displayed instead of the
output value.
There is a free choice of value.
The "Output Value" attribute can be made dynamic with the name "OutputValue".

3.10.2.4

Bit Number (BitNumber)
Bit Number (BitNumber)
The "Bit Number" attribute specifies the number of the relevant bit in the output value.

0 - 31

The value can be chosen freely within the specified limits.

The "Bit Number" attribute can be made dynamic with the name "BitNumber".

3.10.2.5

Data Format (DataFormat)
Data Format (DataFormat)
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The "Data Format" attribute defines the data type for a value to be displayed.
Five different data formats are available for the input and output of values in an I/O field:
● Numerical values can be processed in binary, decimal, or hexadecimal format.
● For the display of text, assign the "String" data format.
● The "Date/Time" format is used to display the date and/or time as well as the time span
depending on the output format.
It must be possible to display the output value with the format specified by means of "Output
Format" attribute. If this is not the case, three asterisks are displayed instead of the output
value.
The "Data Format" attribute cannot be made dynamic.

3.10.2.6

Input value
Input value
The "Input value" attribute defines the value to be entered in the I/O field by the user. The value
is not displayed in the I/O field when the property is set.
If you want the value to be displayed in the I/O field after confirmation with the <Return> key,
configure a direct connection between the properties "input value" and "output value". The
direct connection is only practical when no tag is connected to the output value, but the user
can nevertheless query the specified value, for example, through a script.
The "Input value" attribute can be made dynamic with the name "InputValue".

3.10.2.7

Field Type (BoxType)
Field Type (BoxType)
The "Field Type" attribute defines the application area for I/O fields or fields of a text list.

Input

The field is only used for the input of values.

Edition

The field is only used for the output of values.

Input/Output

The field can be used for the input and output of values.

The "Field Type" attribute can be made dynamic with the name "BoxType".

3.10.2.8

List Type (ListType)
List Type (ListType)
The "List Type" attribute defines the data type for the "Text List" object.
Depending on the selected list type, a distinction is made in the specification of display texts
for test lists defined with the "Assignment" attribute.
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Decimal

Display texts are assigned for certain value ranges.

Binary

Display texts are assigned for each bit number.

Bit

One display text can be assigned for each of the statuses "1 bit set" and "0 - bit not
set".

The "List Type" attribute cannot be made dynamic.

3.10.2.9

Clear on Invalid Input (ClearOnError)
Clear on Invalid Input (ClearOnError)
The "Clear on Invalid Input" attribute can be used to prevent adoption of an incorrect input
value when the field is left. An input value is bad, for example, when it does not correspond to
the predefined data format of the input field.

Yes

An incorrect input value is deleted automatically on leaving the field.

No

An incorrect input value is not deleted automatically on leaving the field.

The "Clear on Invalid Input" attribute can be made dynamic with the name "ClearOnError".

3.10.2.10 Clear on New Input (ClearOnNew)
Clear on New Input (ClearOnNew)
The "Clear on New Input" attribute specifies whether the current field contents are
automatically deleted when an input field is selected.
Yes

The field contents are deleted automatically when the field is selected.

No

The field contents not are deleted automatically when the field is selected.

The "Clear on New Input" attribute can be made dynamic with the name "ClearOnNew".

3.10.2.11 Selected Boxes (Process)
Selected Boxes (Process)
The "Selected Boxes" attribute sets which fields in a check box are to be shown as enabled.
Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding
bit must have the value "1". The 32-bit word contains the information for all fields of the check
box. The value of the "Selected Boxes" attribute is specified in hexadecimals.
The "Selected Boxes" attribute can be made dynamic with the name "Process".

3.10.2.12 Selected Box (Process)
Selected Box (Process)
The "Selected Box" attribute sets which option field in an option group is displayed as activated.
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Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding
bit must have the value "1". The 32-bit word contains the information for all fields of the check
box. The value of the "Selected Box" attribute is specified in hexadecimals.
The "Selected Box" attribute can be made dynamic with the name "Process".

3.10.2.13 Apply on Exit (AssumeOnExit)
Apply on Exit (AssumeOnExit)
The "Apply on Exit" attribute can be used to activate application of a value if the user leaves
the I/O field or the text list without prior confirmation or before the required number of characters
is reached.
The "Apply on Exit" attribute has no effect if the "Apply on Full" attribute has the value "Yes"
in the I/O field.
Yes

The field contents are accepted automatically when the field is selected.

No

The input value is only accepted when the input is confirmed by the ENTER (return) key.

The "Apply on Exit" attribute can be made dynamic with the name "AssumeOnExit".

3.10.2.14 Apply on Complete Input (AssumeOnFull)
Apply on Complete Input (AssumeOnFull)
The "Apply on Complete Input" attribute specifies when an input value is applied.
Yes

The input value is automatically applied as soon as the preset number of characters has been entered.

No

The entered value is only applied when the input is confirmed by the ENTER (return) key

The "Apply on Complete Input" attribute can be made dynamic with the name "AssumeOnFull".

3.10.2.15 Hidden Input (HiddenInput)
Hidden Input (HiddenInput)
The "Hidden Input" attribute specifies whether the input value is displayed during input as
normal or encrypted.
Yes

Each entered character is replaced in the display with the "*" character. The value entered and the data format
of the value cannot be recognized.

No

Each entered character is displayed as normal.

The "Hidden Input" attribute can be made dynamic with the name "HiddenInput".

3.10.2.16 Assignments (Assignments)
Assignments (Assignments)
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The "Assignments" attribute enables specification of display texts that are displayed depending
on the current "Output Value" in the text list. The type of assignment depends on the selected
"List Type".
List Type
Decimal

Display texts are assigned for certain value ranges. The following criteria can be used to define the value
range:
"Single Value" - A display text is assigned to a single value.
"From Value" - A display text applies to all values greater than or equal to that specified here.
"To Value" - A display text applies to all values lesser than or equal to that specified here.
"From To Value" - A display text applies to all values of the value range specified here.

List Type
Binary

Display texts are assigned for each bit number. Up to 32 display texts can be defined. If a bit set in the
output value is not assigned a display text, three asterisks appear in the drop-down list.

List Type Bit

One display text can be assigned for each of the statuses "1 - bit set" and "0 - bit not set" of the bit relevant
in the output value.

Note
When you assign a text to a value in the text list, this text may not contain a semicolon";".
The semicolon is a WinCC control character and will be automatically deleted in a text.
The "Assignments" attribute cannot be made dynamic.

3.10.3

"Picture" Property Group

3.10.3.1

Picture (PictureName)
Picture (PictureName)
The "Picture" attribute specifies which picture is displayed in a graphic object. Pictures with
the following formats can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
If no picture that you want to display is defined for a graphic object, the symbol for the graphic
object is shown as a placeholder.
The graphic object should be the same size as the selected picture; otherwise, its display is
distorted.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in
the "Picture Selection" dialog.
The "Picture" attribute can be made dynamic with the name "PictureName".

3.10.3.2

Picture Referenced (PicReferenced)
Picture Referenced (PicReferenced)
The "Picture Referenced" attribute specifies whether the picture itself or only the reference in
the form of a cross-reference to the picture is integrated.
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Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Picture Referenced" attribute cannot be made dynamic.

3.10.3.3

Picture Transparent Color (PicTransColor)
Picture Transparent Color (PicTransColor)
The "Picture Transparent Color" attribute specifies the transparent color of the picture to be
displayed. Transparent colors can only be displayed for pictures in BMP or DIB format. The
"Picture Transparent Color On" attribute must have the value "Yes".
The "Picture Transparent Color" attribute can be assigned dynamic properties by means of
the name "PicTransColor".

3.10.3.4

Picture Transparent Color On (PicUseTransColor)
Picture Transparent Color On (PicUseTransColor)
The "Picture Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed. Transparent colors can only be displayed
for pictures in BMP or DIB format.

Yes

The "Picture Transparent Color On" attribute is enabled.

No

The "Picture Transparent Color On" attribute is disabled.

The "Picture Transparent Color On" attribute can be assigned dynamic properties by means
of the name "PicUseTransColor".

3.10.4

"Pictures" Property Group

3.10.4.1

Picture Off Referenced (PicUpReferenced)
Picture Off Referenced (PicUpReferenced)
The "Round button" object can have three different states: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. The attributes "Picture Off
Referenced", "Picture On Referenced" and "Picture Deact. Referenced" determine for the
various states whether the pictures or only references to the pictures are integrated.

Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Picture Off Referenced" attribute cannot be made dynamic.
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3.10.4.2

Picture Off Transparent Color (PicUpTransparent)
Picture Off Transparent Color (PicUpTransparent)
The "Picture Off Transparent Color" attribute specifies the transparent color of the picture to
be displayed in "Off" state. Transparent colors can only be displayed for pictures in BMP or
DIB format.
The "Picture Off Transparent Color On" attribute must have the value "Yes".
The "Picture Off Transparent Color" attribute can be assigned dynamic properties by means
of the name "PicUpTransparent".

3.10.4.3

Picture Off Transparent Color On (PicUpUseTransColor)
Picture Off Transparent Color On (PicUpUseTransColor)
The "Picture Off Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed in "Off" state. Transparent colors can only
be displayed for pictures in BMP or DIB format.

Yes

The "Picture Off Transparent Color On" attribute is enabled.

No

The "Picture Off Transparent Color On" attribute is disabled.

The "Picture Off Transparent Color On" attribute can be assigned dynamic properties by means
of the name "PicUpUseTransColor".

3.10.4.4

Picture Deact. Referenced (PicDeactReferenced)
Picture Deact. Referenced (PicDeactReferenced)
The "Round button" object can have three different states: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. The attributes "Picture Off
Referenced", "Picture On Referenced" and "Picture Deact. Referenced" determine for the
various states whether the pictures or only references to the pictures are integrated.

Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Picture Deact. Referenced" cannot be made dynamic.

3.10.4.5

Picture Deact. Transparent Color (PicDeactTransparent)
Picture Deact. Transparent Color (PicDeactTransparent)
The "Picture Deact. Transparent Color" specifies the transparent color for the picture to be
displayed in "Deactivated" state. Transparent colors can only be displayed for pictures in BMP
or DIB format.
The "Picture Deact. Transparent Color On" attribute must have the value "Yes".
The "Picture Deact. Transparent Color" attribute can be assigned dynamic properties by means
of the name "PicDeactTransparent".

722

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties

3.10.4.6

Picture Deact. Transparent Color On (PicDeactUseTransColor)
Picture Deact. Transparent Color On (PicDeactUseTransColor)
The "Picture Deact. Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed in "Deactivated" state. Transparent colors
can only be displayed for pictures in BMP or DIB format.

Yes

The "Picture Deact. Transparent Color On" attribute is enabled.

No

The "Picture Deact. Transparent Color On" attribute is disabled.

The "Picture Deact. Transparent Color On" attribute can be assigned dynamic properties by
means of the name "PicDeactUseTransColor".

3.10.4.7

Picture On Referenced (PicDownReferenced)
Picture On Referenced (PicDownReferenced)
The "Round button" object can have three different states: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. The attributes "Picture Off
Referenced", "Picture On Referenced" and "Picture Deact. Referenced" determine for the
various states whether the pictures or only references to the pictures are integrated.

Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Picture On Referenced" attribute cannot be made dynamic.

3.10.4.8

Picture On Transparent Color (PicDownTransparent)
Picture On Transparent Color (PicDownTransparent)
The "Picture On Transparent Color" attribute specifies the transparent color of the picture to
be displayed in "On" state. Transparent colors can only be displayed for pictures in BMP or
DIB format.
The "Picture On Transparent Color On" attribute must have the value "Yes".
The "Picture On Transparent Color" attribute can be assigned dynamic properties by means
of the name "PicDownTransparent".

3.10.4.9

Picture On Transparent Color On (PicDownUseTransColor)
Picture On Transparent Color On (PicDownUseTransColor)
The "Picture On Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed in "On" state. Transparent colors can only
be displayed for pictures in BMP or DIB format.

Yes

The "Picture On Transparent Color On" attribute is enabled.

No

The "Picture On Transparent Color On" attribute is disabled.
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The "Picture On Transparent Color On" attribute can be assigned dynamic properties by means
of the name "PicDownUseTransColor".

3.10.4.10 Picture Status Off (PictureUp)
Picture Status Off (PictureUp)
A round button can have one of three statuses: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. Pictures with the following formats
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.
The "Picture Status Off" attribute can be made dynamic with the name "PictureUp".

3.10.4.11 Picture Status Deactivated (PictureDeactivated)
Picture Status Deactivated (PictureDeactivated)
A round button can have one of three statuses: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. Pictures with the following formats
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
The "Picture Status Deactivated" attribute can be made dynamic with the name
"PictureDeactivated".
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.

3.10.4.12 Picture Status On (PictureDown)
Picture Status On (PictureDown)
A round button can have one of three statuses: "On", "Off" or "Deactivated".
For each status, a picture to be displayed can be selected. Pictures with the following formats
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
The "Picture Status On" attribute can be made dynamic with the name "PictureDown".
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.

3.10.4.13 X picture alignment (PictAlignment)
Picture Alignment
The "Picture alignment" attribute defines the position and scaling of the picture placed on the
button or round button.
centered

The picture is positioned, centered in the original proportions.

Left justified

The picture is positioned with original proportions, with left justification on the left side of the button.
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Right justified

The picture is positioned with original proportions, with right justification on the right side of the button.

Stretched

The picture is scaled to a square and is adapted to the size of the button.

The attribute "Picture alignment" can be made dynamic with the name "PictAlignment".

3.10.5

"Flashing" Property Group

3.10.5.1

Flashing (EnableFlashing)
Flashing (EnableFlashing)
The "Flashing" attribute shows whether the value for status "OK" and "Simulation" appears
flashing or not in the extended analog display in Runtime.
So that the flashing is visible in Runtime, the font flashing color must be different to the
background flashing color.

Yes

Flashing for status "OK" and "Simulation" in Runtime is enabled.

No

Flashing for status "OK" and "Simulation" in Runtime is disabled.

The "Flashing" attribute can be made dynamic with the name "EnableFlashing".

3.10.5.2

Flashing Background Active (FlashBackColor)
Flashing Background Active (FlashBackColor)
The "Flashing Background Active" attribute specifies whether in Runtime a background is to
appear as flashing or not.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows
Style" attribute must be set to "No".

Yes

The background of the object flashes in Runtime.

No

The background of the object does not flash in Runtime.

The "Flashing Background Active" attribute can be made dynamic with the name
"FlashBackColor".

3.10.5.3

Flashing Line Active (FlashBorderColor)
Flashing Line Active (FlashBorderColor)
The "Flashing Line Active" attribute specifies whether in Runtime a line is to appear as flashing
or not.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic.
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Yes

The line of the object flashes in Runtime.

No

The line of the object does not flash in Runtime.

The "Flashing Line Active" attribute can be made dynamic with the name "FlashBorderColor".

3.10.5.4

Flashing Border Active (FlashBorderColor)
Flashing Border Active (FlashBorderColor)
The "Flashing Border Active" attribute specifies whether in Runtime a border is to appear as
flashing or not.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".

Yes

The border of the object flashes in Runtime.

No

The border of the object does not flash in Runtime.

The "Flashing Border Active" attribute can be made dynamic with the name
"FlashBorderColor".

3.10.5.5

Flashing Text Active (FlashForeColor)
Flashing Text Active (FlashForeColor)
The "Flashing Text Active" attribute specifies whether in Runtime a text is to appear as flashing
or not.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic.

Yes

The text in the object flashes in Runtime.

No

The text in the object does not flash in Runtime.

The "Flashing Text Active" attribute can be made dynamic with the name "FlashForeColor".

3.10.5.6

Flash Frequency (FlashRate)
Flash Frequency (FlashRate)
The "Flash Frequency" attribute defines at what speed the messages flash in the group display,
the extended status display, and in the extended analog display in Runtime. The frequencies
"slow", "medium" and "fast" can be set. The flash frequency depends on the system
performance.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".
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Slow

The messages flash slowly in Runtime.

Medium

The messages flash at medium speed in Runtime.

Fast

The messages flash quickly in Runtime.

The "Flash Frequency" attribute can be made dynamic with the name "FlashRate".

3.10.5.7

Background Flash Frequency (FlashRateBackColor)
Background Flash Frequency (FlashRateBackColor)
The "Background Flash Frequency" attribute specifies the speed at which a background
flashes in Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash
frequency depends on the system performance.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows
Style" attribute must be set to "No".

Slow

The background of the object flashes slowly in Runtime.

Medium

The background of the object flashes in Runtime at medium rate.

Fast

The background of the object flashes quickly in Runtime.

The "Background Flash Frequency" attribute can be made dynamic with the name
"FlashRateBackColor".

3.10.5.8

Line Flash Frequency (FlashRateBorderColor)
Line Flash Frequency (FlashRateBorderColor)
The "Line Flash Frequency" attribute specifies the speed at which a line flashes in Runtime.
The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends on the
system performance.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows
Style" attribute must be set to "No".

Slow

The line of the object flashes slowly in Runtime.

Medium

The line of the object flashes in Runtime at medium speed.

Fast

The line of the object flashes quickly in Runtime.

The "Line Flash Frequency" attribute can be made dynamic with the name
"FlashRateBorderColor".

3.10.5.9

Border Flash Frequency (FlashRateBorderColor)
Border Flash Frequency (FlashRateBorderColor)
The "Border Flash Frequency" attribute specifies the speed at which a border flashes in
Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends
on the system performance.
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To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".
Slow

The border of the object flashes slowly in Runtime.

Medium

The border of the object flashes in Runtime at medium speed.

Fast

The border of the object flashes quickly in Runtime.

The "Border Flash Frequency" attribute can be made dynamic with the name
"FlashRateBorderColor".

3.10.5.10 Text Flash Frequency (FlashRateForeColor)
Text Flash Frequency (FlashRateForeColor)
The "Text Flash Frequency" attribute specifies the speed at which a text flashes in Runtime.
The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends on the
system performance.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".
Slow

The text in an object flashes slowly in Runtime.

Medium

The text in an object flashes in Runtime at medium speed.

Fast

The text in an object flashes quickly in Runtime.

The "Text Flash Frequency" attribute can be made dynamic with the name
"FlashRateForeColor".

3.10.5.11 Flashing Background Color Off (BackFlashColorOff)
Flashing Background Color Off (BackFlashColorOff)
The "Flashing Background Color Off" attribute specifies the color a background assumes in
flash status "Off". The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Background Color Off" attribute can be made dynamic with the name
"BackFlashColorOff".

3.10.5.12 Flashing Background Color On (BackFlashColorOn)
Flashing Background Color On (BackFlashColorOn)
The "Flashing Background Color On" attribute specifies the color a background assumes in
flash status "On". The flashing is only visible in Runtime.
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To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Background Color On" attribute can be made dynamic with the name
"BackFlashColorOn".

3.10.5.13 Flashing Line Color Off (BorderFlashColorOff)
Flashing Line Color Off (BorderFlashColorOff)
The "Flashing Line Color Off" attribute specifies the color a line assumes in flash status "Off".
The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Line Color Off" attribute can be made dynamic with the name
"BorderFlashColorOff".

3.10.5.14 Flashing Line Color On (BorderFlashColorOn)
Flashing Line Color On (BorderFlashColorOn)
The "Flashing Line Color On" attribute specifies the color a line assumes in flash status "On".
The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Line Color On" attribute can be made dynamic with the name
"BorderFlashColorOn".

3.10.5.15 Flashing Border Color Off (BorderFlashColorOff)
Flashing Border Color Off (BorderFlashColorOff)
The "Flashing Border Color Off" attribute specifies the color a border assumes in flash status
"Off". The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
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The "Flashing Border Color Off" attribute can be made dynamic with the name
"BorderFlashColorOff".

3.10.5.16 Flashing Border Color On (BorderFlashColorOn)
Flashing Border Color On (BorderFlashColorOn)
The "Flashing Border Color On" attribute specifies the color a border assumes in flash status
"On". The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Border Color On" attribute can be made dynamic with the name
"BorderFlashColorOn".

3.10.5.17 Flashing Text Color Off (ForeFlashColorOff)
Flashing Text Color Off (ForeFlashColorOff)
The "Flashing Text Color Off" attribute specifies the color a text assumes in flash status "Off".
The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Text Color Off" attribute can be made dynamic with the name
"ForeFlashColorOff".

3.10.5.18 Flashing Text Color On (ForeFlashColorOn)
Flash Text Color On (ForeFlashColorOn)
The "Flashing Text Color On" attribute specifies the color a text assumes in flash status "On".
The flashing is only visible in Runtime.
To make the flashing visible in Runtime, the flashing color of the status "On" must differ from
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme"
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Text Color On" attribute can be made dynamic with the name
"ForeFlashColorOn".
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3.10.6

The property group "Control Properties"

3.10.6.1

A

Activate property
Activate
The data to be displayed in the message window are only requested from the message server
if you set this attribute. Instead of setting this attribute, it is advisable to change the value
dynamically in order to reduce picture activation times.
The attribute can be assigned dynamic properties by means of the name Activate . The data
type is BOOLEAN.

AllServer property
All servers - AllServer
Selects all servers whose packages were loaded and on which "Alarm Logging Runtime" is
activated in the startup list.
Value

Explanation

TRUE

All servers are activated.

FALSE

Activates only the servers entered in "Server selection".

The attribute can be assigned dynamic properties by means of the name AllServer. The data
type is BOOLEAN.

ApplyProjectSettings property
Apply project settings - ApplyProjectSettings
Activates the project settings derived from "Alarm Logging".
Value

Explanation

TRUE

The "Apply project settings" check box is selected. The message blocks configured in "Alarm Logging"
and their properties are activated in AlarmControl. The message blocks are displayed with these
properties in the message window.

FALSE

The "Apply project settings" check box is deactivated. You can add or remove message blocks, or edit
their properties.

The attribute can be assigned dynamic properties by means of the name
ApplyProjectSettings. The data type is BOOLEAN.
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ArchiveName property
Name - ArchiveName
Specifies the user archive or view to be displayed. Open the "Package Browser" dialog for
configuring an archive or a view by clicking the button.
The attribute can be assigned dynamic properties by means of the name ArchiveName. The
data type is STRING.

ArchiveType property
Type - ArchiveType
Specifies whether the selected user archive is an archive or a view. The field cannot be edited.
The attribute can be assigned dynamic properties by means of the name ArchiveType. The
data type is LONG.

AspectRatio property
AspectRatio
Specifies if the aspect ratio is kept in movies.
The attribute can be assigned dynamic properties by means of the name AspectRatio. The
data type is BOOLEAN.

Stretch
Stretch
Specifies the stretch for the icon.
Value

Explanation

TRUE

The screen content is set to fit the object size of the selected icon.

FALSE

The screen content is not set to fit the object size of the selected icon.

The attribute can be assigned dynamic properties by means of the name Stretch. The data
type is BOOLEAN.
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AutoCompleteColumns property
Show empty columns - AutoCompleteColumns
Adds empty columns if the Control width is greater than the width of columns configured.
Value

Explanation

TRUE

Enables the display of empty columns.

FALSE

Disables the display of empty columns.

The attribute can be assigned dynamic properties by means of the name
AutoCompleteColumns. The data type is BOOLEAN.

AutoCompleteRows property
Show empty rows - AutoCompleteRows
Enables the insertion of empty rows if the Control length is greater than the number of rows
configured.
Value

Explanation

TRUE

Enables the display of empty rows.

FALSE

Disables the display of empty rows.

The attribute can be assigned dynamic properties by means of the name
AutoCompleteRows. The data type is BOOLEAN.

AutoPosition property
Automatic positioning - AutoPosition
Defines whether to position the RulerControl exactly below the source control.
The following settings are available:
Value

Explanation

TRUE

The RulerControl is positioned exactly below the source control.

FALSE

The RulerControl is displayed in accordance with your configuration of the control position.

The attribute can be assigned dynamic properties by means of the name AutoPosition. The
data type is BOOLEAN.
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AutoScroll property
Auto scrolling - AutoScroll
Defines the behavior of the message window after a new message events.
You can only select message lines if "Auto scrolling" is disabled.
Value

Explanation

TRUE

If "AutoScroll" is activated, a new activated message is appended to the list displayed in the message window
and selected automatically. The visible area of the message window is shifted as required.

FALSE

New message events are not selected if "Autoscroll" is disabled. The visible area of the message window is
not changed.

The attribute can be assigned dynamic properties by means of the name AutoScroll. The data
type is BOOLEAN.

AutoSelectionColors property
Automatic selection coloring - AutoSelectionColor
Enables the display of default system colors as selection color for cells and rows.
Value

Explanation

TRUE

The system colors are in use.

FALSE

The custom colors are used.

The attribute can be assigned dynamic properties by means of the name
AutoSelectionColors. The data type is BOOLEAN.

AutoSelectionRectColor property
Automatic color assignment - AutoSelectionRectColor
Defines a system color for the selection border.
Value

Explanation

TRUE

The system color is in use.

FALSE

The custom color is used.

The attribute can be assigned dynamic properties by means of the name
AutoSelectionRectColors. The data type is BOOLEAN.
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AutoShow property
Show/hide automatically - AutoShow
Enables/disables automatic activation of the RulerControl on the display if you selected the
button functions for the ruler, statistics range and for statistics in the source control.
The RulerControl is hidden again if you are no longer using the ruler, statistics range and
statistics functions.
Value

Explanation

TRUE

The RulerControl is displayed automatically.

FALSE

The RulerControl is not displayed automatically.

The attribute can be assigned dynamic properties by means of the name AutoShow. The data
type is BOOLEAN.

Autostart property
Autostart
Specifies if movies are started automatically.
The attribute can be assigned dynamic properties by means of the name Autostart. The data
type is BOOLEAN.

3.10.6.2

B

BackColor property
Background - BackColor
Specifies the background color of the control. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name BackColor. The data
type is LONG.

Flash Color (BlinkColor)
Flash Color (BlinkColor)
Specifies the icon color in flashing state by means of "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name BlinkColor. The data
type is LONG.
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Flash rate (BlinkSpeed)
Flash rate (BlinkSpeed)
Specifies the length of the icon flash interval in Runtime.
The following settings are available:
Value

Description

Comments

250

Fast

Flash interval of 250 ms.

500

Medium

Flash interval of 500 ms.

1000

Slow

Flash interval of 1000 ms.

The attribute can be assigned dynamic properties by means of the name BlinkSpeed. You can
also use other values. The data type is LONG.

Flash mode (BlinkMode)
Flash mode (BlinkMode)
Specifies the flash mode of the icon in runtime.
The following settings are available:
Value

Description

Comments

0

No flashing

The icon does not flash.

1

Hidden

The icon flashes in the background color.

2

Shadow

The icon flashes with shading in the foreground color.

3

Solid

The icon flashes in the foreground color.

The attribute can be assigned dynamic properties by means of the name BlinkMode. The data
type is LONG.

BlockAlign property
Block alignment - BlockAlign
Defines the mode of aligning the caption of blocks in column headers.
The following settings are available:
Value

Description

Explanation

0

left

The block caption is left justified.

1

centered

The block caption is aligned to center.

2

right

The block caption is right justified.

The attribute can be assigned dynamic properties by means of the name BlockAlign. The data
type is LONG.
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BlockAutoPrecisions property
Decimal places automatic - BlockAutoPrecisions
Enables automatic setting of the decimal precision.
Value

Explanation

TRUE

The decimal precision is defined automatically. The value in the "Decimal places" field is disabled.

FALSE

The value in the "Decimal places" field is enabled.

The attribute can be assigned dynamic properties by means of the name
BlockAutoPrecisions. The data type is BOOLEAN.

BlockCaption property
Caption - BlockCaption
Defines the caption of the column header in the control for the selected message block.
The caption is active in all Runtime languages.
The attribute can be assigned dynamic properties by means of the name BlockCaption. The
data type is STRING.

BlockCount property
BlockCount
Specifies the number of blocks to be made available as columns for the control.
The attribute can be assigned dynamic properties by means of the name BlockCount. The
data type is LONG.

BlockDateFormat property
Date format - BlockDateFormat
Defines the date format for visualization.
The following date formats are available:
Value

Explanation

Automatic

The date format is set automatically.

dd.MM.yy

Day.Month.Year, e.g. 24.12.07.

dd.MM.yyyy

Day.Month.Year, e.g. 24.12.2007.

dd/MM/yy

Day/Month/Year, e.g. 24/12/07.

dd/MM/yyyy

Day/Month/Year, e.g. 24/12/2007.
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The attribute can be assigned dynamic properties by means of the name BlockDateFormat.
The data type is STRING.

BlockExponentialFormat property
Exponential notation - BlockExponentialFormat
Specifies exponential notation for the display of values of a selected block.
Value

Explanation

TRUE

The values are displayed with exponential notation.

FALSE

The values are displayed with decimal notation.

The attribute can be assigned dynamic properties by means of the name
BlockExponentialFormat. The data type is BOOLEAN.

BlockHideText property
Content as text - BlockHideText
Enables the textual display of the content of a selected block.
Value

Explanation

TRUE

The content is not displayed in text format. The option is disabled.

FALSE

The content is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name BlockHideText. The
data type is BOOLEAN.

BlockHideTitleText property
Title as text - BlockHideTitleText
Enables the display of the header of a selected block in text format.
Value

Explanation

TRUE

The header is not displayed in text format. The option is disabled.

FALSE

The header is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name BlockHideTitleText.
The data type is BOOLEAN.
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BlockId property
BlockId
Default assignment of the ID number and of the block in WinCC RulerControl:
Value

Description

0

No block

1

Name

2

Index

3

Designation

4

Display

5

Tag name Y

6

Tag name X

7

Y value

8

X value/time stamp

9

Y value (LL)

10

Time stamp (LL)

11

Y value (UL)

12

Time stamp (UL)

13

Minimum

14

Minimum - Time stamp

15

Maximum

16

Maximum - Time stamp

17

Average

18

Standard deviation

19

Integral

20

Weighted mean value

21

Duration

22

Number of values

The attribute can be assigned dynamic properties by means of the name BlockID. The data
type is LONG.

BlockIndex property
BlockIndex
References a block. Using this attribute you can assign the values of other attributes to a
specific block.
Values between 0 and "BlockCount" minus 1 are valid for "BlockIndex". Attribute "BlockCount"
defines the number of available blocks.
The attribute can be assigned dynamic properties by means of the name BlockIndex. The data
type is LONG.
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BlockLength property
Length in characters - BlockLength
Specifies the column width for a selected block.
The attribute can be assigned dynamic properties by means of the name BlockLength. The
data type is LONG.

BlockName property
Object name - BlockName
Displays the name of the block selected. You cannot edit this name.
The attribute can be assigned dynamic properties by means of the name BlockName. The
data type is STRING.

BlockPrecisions property
Decimal places - BlockPrecisions
Specifies the number of decimal places of the values in the selected column. You can only
enter the value if the "Automatic" option is disabled.
The attribute can be assigned dynamic properties by means of the name BlockPrecisions. The
data type is SHORT.

BlockShowDate property
Display date - BlockShowDate
Specifies if the "Time" block is displayed with time and date in a field.
Value

Explanation

TRUE

The date and time are displayed. The date format is defined in the "Date format" field.

FALSE

The time is displayed.

The attribute can be assigned dynamic properties by means of the name BlockShowDate. The
data type is BOOLEAN.

BlockShowIcon property
Content as icon - BlockShowIcon
Enables the display of the content of a selected block as icon. This function is only available
in WinCC Alarm Control.
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Value

Explanation

TRUE

The content is visualized as icon.

FALSE

The content is not visualized as icon.

The attribute can be assigned dynamic properties by means of the name BlockShowIcon. The
data type is BOOLEAN.

BlockShowTitleIcon property
Title as icon - BlockShowTitleIcon
Enables the display of the header of a selected block as icon. This function is only available
in WinCC Alarm Control.
Value

Explanation

TRUE

The header is displayed as icon.

FALSE

The header is not displayed as icon.

The attribute can be assigned dynamic properties by means of the name BlockShowTitleIcon.
The data type is BOOLEAN.

BlockTimeFormat property
Time format - BlockTimeFormat
Defines the time format to be used for visualization.
The following time formats are available:
Value

Explanation

Automatic

The time format is set automatically.

HH:mm:ss.ms

Hours:Minutes:Seconds, e.g. 15:35:44.240.

hh:mm:ss tt

Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.

hh:mm:ss.ms tt

Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The attribute can be assigned dynamic properties by means of the name BlockTimeFormat.
The data type is STRING.

BlockUseSourceFormat property
Use source format - BlockUseSourceFormat
Specifies that the format is inherited from the interconnected control. Here the size of the
control, the zoom factor and the value range are taken into consideration to display the optimal
number of decimal places.
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Value

Explanation

TRUE

The formats are derived from the interconnected control.

FALSE

The formats configured in Ruler Control are used, for example, the display of a precisely specified number of
decimal places.

The attribute can be assigned dynamic properties by means of the name
BlockUseSouceFormat. The data type is BOOLEAN.

BorderColor property
Border color - BorderColor
Specifies the border color. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name BorderColor. The
data type is LONG.

BorderWidth property
Border width - BorderWidth
Specifies the line weight of the border in pixels.
The attribute can be assigned dynamic properties by means of the name BorderWidth. The
data type is LONG.

3.10.6.3

C

Caption property
Text - Caption
Defines the text of the window caption.
The attribute can be assigned dynamic properties by means of the name Caption. The data
type is STRING.
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CellCut property
Shorten contents - CellCut
Shortens cell contents if the cell width is insufficient.
Value

Explanation

TRUE

Enables shortening of cell contents.

FALSE

Disables shortening of cell contents.

The attribute can be assigned dynamic properties by means of the name CellCut. The data
type is BOOLEAN.

CellSpaceBottom property
CellSpaceBottom
Defines the bottom margin of the table cells.
The attribute can be assigned dynamic properties by means of the name CellSpaceBottom.
The data type is LONG.

CellSpaceLeft property
CellSpaceLeft
Defines the left indent of the table cells.
The attribute can be assigned dynamic properties by means of the name CellSpaceLeft . The
data type is LONG.

CellSpaceRight property
CellSpaceRight
Defines the right indent of the table cells.
The attribute can be assigned dynamic properties by means of the name CellSpaceRight . The
data type is LONG.

CellSpaceTop property
CellSpaceTop
Defines the top margin of the table cells.
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The attribute can be assigned dynamic properties by means of the name CellSpaceTop . The
data type is LONG.

Closeable property
Closeable
Defines whether the control can be closed in Runtime.
Value

Explanation

TRUE

The control can be closed in Runtime.

FALSE

The control cannot be closed in Runtime.

The attribute can be assigned dynamic properties by means of the name Closeable. The data
type is BOOLEAN.

Column
ColumnAdd property
Apply - ColumnAdd
Copies the selected column from the list of existing columns to the list of selected columns.
The attribute can be assigned dynamic properties by means of the name ColumnAdd. The
data type is STRING.

ColumnAlias property
ColumnAlias
Defines the alias specified in the user archive for the column name.
The attribute can be assigned dynamic properties by means of the name ColumnAlias. The
data type is STRING.

ColumnAlign property
Alignment - ColumnAlign
Specifies the mode of alignment of a selected column.
The following settings are available:
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Value

Description

Explanation

0

left

The selected column is aligned left.

1

centered

The selected column is aligned to center.

2

right

The selected column is aligned right.

The attribute can be assigned dynamic properties by means of the name ColumnAlign. The
data type is LONG.

ColumnAutoPrecisions property
Decimal places automatic - ColumnAutoPrecisions
Enables automatic setting of the decimal precision.
Value

Explanation

TRUE

The decimal precision is defined automatically. The value in the "Decimal places" field is disabled.

FALSE

The value in the "Decimal places" field is enabled.

The attribute can be assigned dynamic properties by means of the name
ColumnAutoPrecisions. The data type is BOOLEAN.

ColumnCaption property
Caption - ColumnCaption
Sets the caption for a selected column.
The attribute can be assigned dynamic properties by means of the name ColumnCaption. The
data type is STRING.

ColumnCount property
ColumnCount
Defines the number of columns configured.
The attribute can be assigned dynamic properties by means of the name ColumnCount. The
data type is LONG.

ColumnDateFormat property
Date format - ColumnDateFormat
Defines the date format for visualization.
The following date formats are available:
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Value

Explanation

Automatic

The date format is set automatically.

dd.MM.yy

Day.Month.Year, e.g. 24.12.07.

dd.MM.yyyy

Day.Month.Year, e.g. 24.12.2007.

dd/MM/yy

Day/Month/Year, e.g. 24/12/07.

dd/MM/yyyy

Day/Month/Year, e.g. 24/12/2007.

The attribute can be assigned dynamic properties by means of the name ColumnDateFormat.
The data type is STRING.

ColumnDMVarName property
ColumnDMVarName
Defines the name of the tag you assigned to the column in the user archive.
The attribute can be assigned dynamic properties by means of the name
ColumnDMVarName. The data type is STRING.

ColumnExponentialFormat property
Exponential notation - ColumnExponentialFormat
Sets exponential notation for the display of values of a selected column.
Value

Explanation

TRUE

The values are displayed with exponential notation.

FALSE

The values are displayed with decimal notation.

The attribute can be assigned dynamic properties by means of the name
ColumnExponentialFormat. The data type is BOOLEAN.

ColumnFlagNotNull property
ColumnFlagNotNull
Specifies whether the user archive field assigned to the column must have a value.
Value

Explanation

Yes

The column must have a value.

No

The column can have a value.

The attribute cannot be dynamized.

ColumnFlagUnique property
ColumnFlagUnique
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Specifies whether the user archive field assigned to the column must have a unique value.
Values in this column must not be redundant.
Value

Explanation

TRUE

The column must have a unique value.

FALSE

The column must not have a unique value.

The attribute cannot be dynamized.

ColumnHideText property
Content as text - ColumnHideText
Defines textual display of the contents of a selected column.
Value

Explanation

TRUE

The content is not displayed in text format. The option is disabled.

FALSE

The content is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name ColumnHideText.
The data type is BOOLEAN.

ColumnHideTitleText property
Text header - ColumnHideTitleText
Sets textual display of the header of a selected column.
Value

Explanation

TRUE

The header is not displayed in text format. The option is disabled.

FALSE

The header is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name
ColumnHideTitleText. The data type is BOOLEAN.

ColumnIndex property
ColumnIndex
References a control column. Using this attribute you can assign the values of other properties
to a specific column.
Values between 0 and "ColumnCount" minus 1 are valid for "ColumnIndex"; the attribute
"ColumnCount" defines the number of available columns.
The "ColumnIndex" attribute can be assigned dynamic properties by means of attribute
ColumnIndex. The data type is LONG.
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ColumnLeadingZeros property
With leading zeros - ColumnLeadingZeros
Enables the display of values with leading zeros for the column selected. Use "Number of
digits" or "ColumnLeadingZeros" to specify the number of leading zeros. The maximum
number is "11". No leading zeros are displayed with the value "0". The "With leading zeros"
option is deactivated.
The attribute can be assigned dynamic properties by means of the name
ColumnLeadingZeros. The data type is LONG.

ColumnLength property
Length in Characters - ColumnLength
Specifies the width of a selected column.
The attribute can be assigned dynamic properties by means of the name ColumnLength. The
data type is LONG.

ColumnMaxValue property
ColumnMaxValue
Defines the maximum column value specified in the user archive.
The attribute can be assigned dynamic properties by means of the name ColumnMaxValue.
The data type is STRING.

ColumnMinValue property
ColumnMinValue
Defines the minimum column value specified in the user archive.
The attribute can be assigned dynamic properties by means of the name ColumnMinValue.
The data type is STRING.

ColumnName property
ColumnName
Defines the name of the column which is referenced by means of "ColumnIndex" attribute.
The attribute can be assigned dynamic properties by means of the name ColumnName. The
data type is STRING.
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ColumnPosition property
ColumnPosition
Displays the field position defined in the user archive.
The attribute can be assigned dynamic properties by means of the name ColumnPosition. The
data type is LONG.

ColumnPrecisions property
Decimal places - ColumnPrecisions
Specifies the number of decimal places of the values in the selected column. You can only
enter the value if the "Automatic" option is disabled.
The attribute can be assigned dynamic properties by means of the name ColumnPrecisions.
The data type is SHORT.

ColumnReadAccess property
ColumnReadAccess
Defines authorizations for read access to the column as specified in the user archive. The
number corresponds with the number assigned to the authorization in the "User Administrator"
editor.
The attribute cannot be dynamized.

ColumnReadonly property
Write protected - ColumnReadonly
Sets the write protection of a selected column.
Value

Explanation

TRUE

This column is write protected.

FALSE

This column is not write protected. You can edit the column values in Runtime by activating the "Change"
option in the General" tab.

The attribute can be assigned dynamic properties by means of the name ColumnReadonly.
The data type is BOOLEAN.
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ColumnRemove property
Remove - ColumnRemove
Cuts selected columns from the list of selected columns and pastes these to the list of available
columns.
The attribute can be assigned dynamic properties by means of the name ColumnRemove. The
data type is STRING.

ColumnRepos property
Up/Down - ColumnRepos
Changes the order of columns. "Up" and "Down" move the column selected up or down in the
list. This moves the column towards the front or towards the back.
The attribute can be assigned dynamic properties by means of the name ColumnRepos. The
data type is LONG.

ColumnResize property
Width can be resized - ColumnResize
Enables changes to the width of columns.
Value

Explanation

TRUE

You can change the width of the columns.

FALSE

You cannot change the width of the columns.

The attribute can be assigned dynamic properties by means of the name ColumnResize. The
data type is BOOLEAN.

ColumnSrollbar property
Column scroll bars - ColumnScrollbar
Enables the display of column scroll bars.
The following settings are available:
Value

Description

Explanation

0

No

Column scroll bars are not displayed.

1

as required

Column scroll bars are displayed if vertical space requirements of the control are greater
than the actually available display area.

2

always

Column scroll bars are always displayed.
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The attribute can be assigned dynamic properties by means of the name ColumnScrollbar.
The data type is LONG.

ColumnShowDate property
Display date - ColumnShowDate
Specifies if the "Time" block is displayed with time and date in a field.
Value

Explanation

TRUE

The date and time are displayed. The date format is defined in the "Date format" field.

FALSE

The time is displayed.

The attribute can be assigned dynamic properties by means of the name ColumnShowDate.
The data type is BOOLEAN.

ColumnShowIcon property
Content as icon - ColumnShowIcon
Enables the display the contents of a selected column by means of icon. This function is only
available in WinCC Alarm Control.
Value

Explanation

TRUE

The content is visualized as icon.

FALSE

The content is not visualized as icon.

The attribute can be assigned dynamic properties by means of the name ColumnShowIcon.
The data type is BOOLEAN.

ColumnShowTitleIcon property
Header as icon - ColumnShowTitleIcon
Specifies the display of the header of a selected column by means of icon. This function is
only available in WinCC Alarm Control.
Value

Explanation

TRUE

The header is displayed as icon.

FALSE

The header is not displayed as icon.

The attribute can be assigned dynamic properties by means of the name
ColumnShowTitleIcon. The data type is BOOLEAN.
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ColumnSort property
ColumnSort
Defines the sorting order of the user archive column referenced in the "ColumnIndex" attribute.
The following settings are available:
Value

Description

Explanation

0

No

No sorting

1

Ascending

Ascending order, starting at the lowest value.

2

Descending

Descending order, starting at the highest value.

The attribute can be assigned dynamic properties by means of the name ColumnSort . The
data type is LONG.

ColumnSortIndex property
ColumnSortIndex
Defines the sorting order of the column referenced in "ColumnIndex". The sorting criterion is
removed from "ColumnSort" if you set a "0" value..
The attribute can be assigned dynamic properties by means of the name ColumnSortIndex.
The data type is LONG.

ColumnStartValue property
ColumnStartValue
Defines the column start value specified in the user archive.
The attribute can be assigned dynamic properties by means of the name ColumnStartValue.
The data type is STRING.

ColumnStringLength property
ColumnStringLength
Displays the string length of the column as defined in the user archive.
The attribute can be assigned dynamic properties by means of the name
ColumnStringLength. The data type is LONG.
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ColumnTimeFormat property
Time format - ColumnTimeFormat
Defines the time format to be used for visualization.
The following time formats are available:
Value

Explanation

Automatic

The time format is set automatically.

HH:mm:ss.ms

Hours:Minutes:Seconds, e.g. 15:35:44.240.

hh:mm:ss tt

Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.

hh:mm:ss.ms tt

Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The attribute can be assigned dynamic properties by means of the name
ColumnTimeFormat. The data type is STRING.

ColumnTitleAlign property
Column title alignment - ColumnTitleAlign
Specifies the type of column title alignment.
The following settings are available:
Value

Description

Explanation

0

left

The column titles are left justified.

1

centered

The column titles are centered.

2

right

The column titles are right justified.

3

Same as table
content

The column titles are justified to fit the corresponding column content.

The attribute can be assigned dynamic properties by means of the name ColumnTitleAlign.
The data type is LONG.

ColumnTitles property
Show column title - ColumnTitles
Enables the display of the column header.
Value

Explanation

TRUE

The column header is displayed.

FALSE

The column header is not displayed.

The attribute can be assigned dynamic properties by means of the name ColumnTitles. The
data type is BOOLEAN.
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ColumnType property
Type - ColumnType
Displays the data type set in the user archive for a selected column.
The attribute can be assigned dynamic properties by means of the name ColumnType. The
data type is LONG.

ColumnVisible property
ColumnVisible
Enables the display of a column referenced by means of "ColumnIndex" attribute.
Value

Explanation

TRUE

The column is displayed.

FALSE

The column is not displayed.

The attribute can be assigned dynamic properties by means of the name ColumnVisible . The
data type is BOOLEAN.

ColumnWriteAccess property
ColumnWriteAccess
Defines authorizations for write access to the column as specified in the user archive. The
number corresponds with the number assigned to the authorization in the "User Administrator"
editor.
The attribute cannot be dynamized.

ConnectTrendWindows property
Connect trend windows - ConnectTrendWindows
Enables the connection of trend windows configured. You must have configured several trend
windows.
The connected trend windows have the following properties:
● They can have a common X axis.
● They have a scroll bar.
● They have a ruler.
● The zoom functions for a trend window affect the connected trend windows.
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Value

Description

TRUE

All trend windows configured are connected.

FALSE

The trend windows are displayed separately.

The attribute can be assigned dynamic properties by means of the name
ConnectTrendWindows. The data type is BOOLEAN.

3.10.6.4

D

DefaultMsgFilterSQL property
DefaultMsgFilterSQL
Defines an SQL statement for a fixed selection of messages.
The SQL statements of "DefaultMsgFilterSQL" and "MsgFilterSQL" are linked logically by
"AND" operation if you define additional custom selections by means of "MsgFilterSQL"
attribute.
The attribute can be assigned dynamic properties by means of the name
DefaultMsgFilterSQL. The data type is STRING.

DefaultSort property
Default sorting order - DefaultSort
Defines the default sorting order in table columns.
The following settings are available:
Value

Description

Explanation

0

Ascending

The list is updated starting with the bottom line.

1

Descending

The list is updated starting with the top line.

The attribute can be assigned dynamic properties by means of the name DefaultSort. The data
type is LONG.

DefaultSort2 property
DefaultSort2
Use this function to define the sorting method in table columns if not using the default "Date/
time/number" sorting order. Instead, you defined a message block in the "DefaultSort2Column"
object property to sort the columns based on the "message block/date/time/number" order.
The following settings are available:
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Value

Description

Explanation

0

Ascending

The list is updated starting with the bottom line.

1

Descending

The list is updated starting with the top line.

The attribute can be assigned dynamic properties by means of the name DefaultSort2. The
data type is LONG.

DefaultSort2Column property
DefaultSort2Column
Use this function to define the sorting method in table columns if not using the default "Date/
time/number" sorting order.
Define a message block by its object name.
The table columns are now sorted based on the "message block/date/time/number" order.
The attribute can be assigned dynamic properties by means of the name
DefaultSort2Column. The data type is STRING.

DisplayOptions property
Show messages - DisplayOptions
Select the messages to be displayed.
The following selection options are available:
Value

Designation

0

All messages

1

Only displayed messages

2

Only hidden messages

The attribute can be assigned dynamic properties by means of the name DisplayOptions. The
data type is LONG.

DoubleClickAction property
Action on double-click - DoubleClickAction
Sepcifies the action to be executed in Runtime by double-clicking on a message line.
The following settings are available:
Value

Description

Explanation

0

none

No action.

1

Loop-in-alarm

Calls the "Loop-in-alarm" function.
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Value

Description

Explanation

2

Open comments dialog

Calls the "Comments dialog" button function.

3

Open Infotext dialog

Calls the "Infotext dialog" button function.

4

Column-dependent

The action is determined by the column in which you double-clicked.

The attribute can be assigned dynamic properties by means of the name DoubleClickAction.
The data type is LONG.

Rotation (Rotation)
Rotation (Rotation)
Specifies anticlockwise rotation around the icon center.
The following settings are available:
Value

Comments

0

The icon is not rotated.

90

The icon is rotated by 90 degrees.

180

The icon is rotated by 180 degrees.

270

The icon is rotated by 270 degrees.

The attribute can be assigned dynamic properties by means of the name Rotation. The data
type is LONG.

3.10.6.5

E

EnableDelete property
Delete - EnableDelete
Enables deletion of data from the user archive in Runtime.
Value

Explanation

TRUE

You can delete data from the user archive in Runtime.

FALSE

You cannot delete data from the user archive in Runtime.

The attribute can be assigned dynamic properties by means of the name EnableDelete. The
data type is BOOLEAN.
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EnableEdit property
Modify - EnableEdit
Enables editing of the data displayed during runtime.
Value

Explanation

TRUE

Enables editing of data during runtime.

FALSE

Disables editing of data during runtime.

The attribute can be assigned dynamic properties by means of the name EnableEdit. The data
type is BOOLEAN.

EnableInsert property
Add - EnableInsert
Enables insertion of data in the user archive in Runtime.
Value

Explanation

TRUE

You can add data to the user archive in Runtime.

FALSE

You cannot add data to the user archive in Runtime.

The attribute can be assigned dynamic properties by means of the name EnableInsert. The
data type is BOOLEAN.

EnablePopupMenu property
EnablePopupMenu
Specifies if the pop-up menu is enabled in the control.
The attribute can be assigned dynamic properties by means of the name EnablePopupMenu.
The data type is BOOLEAN.

ExportDirectoryChangeable property
Directory can be changed - ExportDirectoryChangeable
Enables changing of the directory for data export in Runtime.
Value

Explanation

TRUE

The data export directory can be changed in Runtime.

FALSE

The data export directory cannot be changed in Runtime.
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The attribute can be assigned dynamic properties by means of the name
ExportDirectoryChangeable. The data type is BOOLEAN.

ExportDirectoryname property
Directory - ExportDirectoryname
Defines the directory to which the exported Runtime data is written.
You can select or create the directory using the selection button.
The attribute can be assigned dynamic properties by means of the name
ExportDirectoryname. The data type is STRING.

ExportFileExtension property
ExportFileExtension
Defines the extension of the export file.
Only the file name extension "csv" is currently supported.
The attribute can be assigned dynamic properties by means of the name
ExportFileExtension. The data type is STRING.

ExportFilename property
File name - ExportFilename
Defines the name of the file which is to receive the exported Runtime data.
The attribute can be assigned dynamic properties by means of the name ExportFilename. The
data type is STRING.

ExportFilenameChangeable property
File can be renamed - ExportFilenameChangeable
Enables renaming of the export file in Runtime.
Value

Explanation

TRUE

The export file can be renamed in Runtime.

FALSE

The export file cannot be renamed in Runtime.

The attribute can be assigned dynamic properties by means of the name
ExportFilenameChangeable. The data type is BOOLEAN.
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ExportFormatGuid property
ExportFormatGuid
Default assignment of the ID number and export provider.
The attribute can be assigned dynamic properties by means of the name ExportFormatGuid.
The data type is STRING.

ExportFormatName property
Format - ExportFormatName
Defines the export file format.
Only the "csv" file format is currently available for the export.
The attribute can be assigned dynamic properties by means of the name ExportFormatName.
The data type is STRING.

See also
How to export Runtime data

ExportParameters property
ExportParameters
Specifies the parameters of the selected format by means of the properties dialog.
The attribute can be assigned dynamic properties by means of the name ExportParameters.
The data type is VARIANT.

ExportSelection property
Scope of data export - ExportSelection
Specifies the control's Runtime data to be exported.
The following settings are available:
Value

Description

Explanation

0

all

All Runtime data of the control is exported.

1

Selection

Selected Runtime data of the control is exported.

The attribute can be assigned dynamic properties by means of the name ExportSelection. The
data type is LONG.
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ExportShowDialog property
Show dialog - ExportShowDialog
Enables the display of the export dialog during runtime.
Value

Explanation

TRUE

The dialog is displayed during runtime.

FALSE

The dialog is not displayed during runtime.

The attribute can be assigned dynamic properties by means of the name ExportShowDialog.
The data type is BOOLEAN.

ExportXML property
ExportXML
Only used internally.
The attribute can be assigned dynamic properties by means of the name ExportXML.

3.10.6.6

F

FeatureFullscreen property
FeatureFullscreen
Specifies if the "Full screen" function is available in the control.
The attribute can be assigned dynamic properties by means of the name FeatureFullscreen.
The data type is BOOLEAN.

FeaturePause property
FeaturePause
Specifies if the "Pause" function is available in the control.
The attribute can be assigned dynamic properties by means of the name FeaturePause. The
data type is BOOLEAN.
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FeaturePlay property
FeaturePlay
Specifies if the "Play" function is available in the control.
The attribute can be assigned dynamic properties by means of the name FeaturePlay. The
data type is BOOLEAN.

FeatureStepBackward property
FeatureStepBackward
Specifies if the "Step backward" function is available in the control.
The attribute can be assigned dynamic properties by means of the name
FeatureStepBackward. The data type is BOOLEAN.

FeatureStepForward property
FeatureStepForward
Specifies if the "Step forward" function is available in the control.
The attribute can be assigned dynamic properties by means of the name
FeatureStepForward. The data type is BOOLEAN.

FeatureStop property
FeatureStop
Specifies if the "Stop" function is available in the control.
The attribute can be assigned dynamic properties by means of the name FeatureStop. The
data type is BOOLEAN.

FeatureVolume property
FeatureVolume
Specifies if the "Volume" function is available in the control.
The attribute can be assigned dynamic properties by means of the name FeatureVolume. The
data type is BOOLEAN.
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FileName property
FileName
Specifies the file whose content you want to display or play.
The attribute can be assigned dynamic properties by means of the name FileName. The data
type is STRING.

FilterSQL property
FilterSQL
Defines an SQL statement for a selection of data in the user archive.
The attribute can be assigned dynamic properties by means of the name FilterSQL. The data
type is STRING.

Font property
Name - Font
Sets the font.
The attribute cannot be dynamized.

3.10.6.7

G

GraphDirection property
Write direction - GraphDirection
Defines the direction of the update of axis values.
Value

Description

Explanation

0

From the right

The updated values are displayed starting at the right side of the trend.

1

From the left

The updated values are displayed starting at the left side of the trend.

2

From the top

The updated values are displayed starting at the top of the trend.

3

From the bottom

The updated values are displayed starting at the bottom of the trend.

True type fonts must be used within the trend window if "From the top" or "From the bottom"
is selected for write direction. Only this setting ensures legibility of the labeling of the vertical
axis.
The attribute can be assigned dynamic properties by means of the name GraphDirection. The
data type is LONG.
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GridLineColor property
Color of the row divider / content - GridLineColor
Defines the color of row/column dividers in table contents. The button opens the "Color
selection" dialog.
The attribute can be assigned dynamic properties by means of the name GridLineColor. The
data type is LONG.

GridLineWidth property
Width of dividers - GridLineWidth
Defines the line weight of the row/column dividers in pixels.
The attribute can be assigned dynamic properties by means of the name GridLineWidth. The
data type is LONG.

3.10.6.8

H

Background style (BackStyle)
Background style (BackStyle)
Specifies the style of the background.
The following settings are available:
Value

Description

Comments

0

Transparent

The background is transparent.

1

Opaque

The background is displayed in the specified background color.

The attribute can be assigned dynamic properties by means of the name BackStyle. The data
type is LONG.

Background Color (BackColor)
Background Color (BackColor)
Specifies the icon background color in the "Color selection" dialog. The background color is
displayed in "opaque" style.
The attribute can be assigned dynamic properties by means of the name BackColor. The data
type is LONG.
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HitlistColumnAdd property
HitlistColumnAdd
Transfers the selected message block from the list of available message blocks to the list of
selected message blocks.
The attribute can be assigned dynamic properties by means of the name HitlistColumnAdd .
The data type is STRING.

HitlistColumnCount property
HitlistColumnCount
Specifies the number of message blocks displayed in the hitlist in Runtime.
The attribute can be assigned dynamic properties by means of the name
HitlistColumnCount . The data type is LONG.

HitlistColumnIndex property
HitlistColumnIndex
References a message block selected for the hitlist. Using this attribute you can assign the
values of other attributes to a specific message block of the hitlist.
Values between 0 and "HitlistColumnCount" minus 1 are valid for "HitlistColumnIndex".
Attribute "HitlistColumnCount" defines the number of message blocks selected for the hitlist.
The "HitlistColumnIndex" attribute can be assigned dynamic properties by means of attribute
HitlistColumnRepos. The data type is LONG.

HitlistColumnName property
HitlistColumnName
Displays the name of the message block of the hitlist which is referenced with attribute
"HitlistColumnIndex". You cannot edit this name.
The attribute can be assigned dynamic properties by means of the name
HitlistColumnName . The data type is STRING.

HitlistColumnRemove property
HitlistColumnRemove
Cuts the marked message block from the list of selected message blocks and pastes it to the
list of available message blocks.
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The attribute can be assigned dynamic properties by means of the name
HitlistColumnRemove. The data type is STRING.

HitlistColumnRepos
Up/Down - MessageColumnRepos/HitlistColumnRepos
Resorts the message blocks. The "Up" and "Down" commands move the selected message
block accordingly in the list. This moves the message block in Runtime Control towards the
front or towards the back.
The attribute for the hitlist can be assigned dynamic properties by means of the name
HitlistColumnRepos .
The attribute for the message list can be assigned dynamic properties by means of the name
MessageColumnRepos.
The data type is LONG.

HitlistColumnSort property
HitlistColumnSort
Defines the sorting order of the message block referenced in "HitlistColumnIndex" for the hitlist.
The following settings are available:
Value

Description

Explanation

0

none

No sorting

1

Ascending

Ascending order, starting at the lowest value.

2

Descending

Descending order, starting at the highest value.

The attribute can be assigned dynamic properties by means of the name HitlistColumnSort .
The data type is LONG.

HitlistColumnSortIndex property
HitlistColumnSortIndex
Defines the sorting order of the message block referenced in "HitlistColumnIndex" in the hitlist.
The sorting criterion is removed from "HitlistColumnSort" if you set a "0" value..
The attribute can be assigned dynamic properties by means of the name
HitlistColumnSortIndex. The data type is LONG.
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HitlistColumnVisible
Selected message blocks - MessageColumnVisible/HitlistColumnVisible
Selected message blocks of message list or hitlist that are displayed in Runtime. Defines
whether the message block referenced in "MessageColumnIndex" or "HitlistColumnIndex" is
displayed.
The attribute for the message list can be assigned dynamic properties by means of the name
MessageColumnVisible.
The attribute for the hitlist can be assigned dynamic properties by means of the name
HitlistColumnVisible.
The data type is BOOLEAN.

HitlistDefaultSort property
HitlistDefaultSort
Defines the default sorting order in the table columns of the hitlist.
The following settings are available:
Value

Description

Explanation

0

Ascending

The list is sorted in ascending order based on frequency.

1

Descending

The list is sorted in descending order based on frequency.

The attribute can be assigned dynamic properties by means of the name HitlistDefaultSort.
The data type is LONG.

HitListMaxSourceItems property
Maximum number of data records - HitListMaxSourceItems
Defines the maximum number of data records for statistics.
The attribute can be assigned dynamic properties by means of the name
HitListMaxSourceItems . The data type is LONG.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

767

Creating Process Pictures
3.10 Object properties

HitListMaxSourceItemsWarn property
Warning when maximum is reached - HitListMaxSourceItemsWarn
Enables the output of a warning notice after the valid number of data records was reached.
Value

Explanation

TRUE

A warning is output after the valid maximum number of data records was reached.

FALSE

A warning is not output after the valid maximum number of data records was reached.

The attribute can be assigned dynamic properties by means of the name
HitListMaxSourceItemsWarn. The data type is BOOLEAN.

HitListRelTime property
Time range for statistics - HitListRelTime
Sets a time range for the statistics.
Value

Explanation

TRUE

The time range set for statistics is used if this range was not defined in the selection.

FALSE

The time range is not used.

The attribute can be assigned dynamic properties by means of the name HitListRelTime. The
data type is BOOLEAN.

HitListRelTimeFactor property
Time range - HitListRelTimeFactor
Defines the factor for calculating the time range. Only integer factors are valid.
The attribute can be assigned dynamic properties by means of the name
HitListRelTimeFactor. The data type is LONG.

HitListRelTimeFactorType property
Time range - HitListRelTimeFactorType
Defines the time unit for calculating the time range.
The following time units are available:
Value

Description

0

Minute

1

Hour
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Value

Description

2

Day

3

Week

4

Month

The attribute can be assigned dynamic properties by means of the name
HitListMaxRelTimeFactorType. The data type is LONG.

HorizontalGridLines property
Horizontal - HorizontalGridLines
Defines whether horizontal separating lines will be displayed.
Value

Explanation

TRUE

Enables the display of horizontal dividers.

FALSE

Disables the display of horizontal dividers.

The attribute can be assigned dynamic properties by means of the name
HorizontalGridLines. The data type is BOOLEAN.

3.10.6.9

I

IconSpace property
IconSpace
Defines the spacing between the icons and text in the table cells. The value is active if and
icon and text are displayed.
The attribute can be assigned dynamic properties by means of the name IconSpace. The data
type is LONG.

3.10.6.10 L
LineColor property
Color of window dividers - LineColor
Specifies the color of the window dividers. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name LineColor. The data
type is LONG.
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LineWidth property
Line weight of window dividers - LineWidth
Defines the line weight of the window dividers in pixels.
The attribute can be assigned dynamic properties by means of the name LineWidth. The data
type is LONG.

LoadDataImmediately property
Load archive data - LoadDataImmediately
Defines whether the tag values for the time range to be displayed are loaded from the archives
when the picture is called.
Value

Explanation

TRUE

Loads archived values on picture calls.

FALSE

Loads only current values on picture calls.

The attribute can be assigned dynamic properties by means of the name
LoadDataImmediately. The data type is BOOLEAN.

LongTermArchiveConsistency property
LongTimeArchiveConsistency
If "LongTimeArchiveConsistency" is set to "No", 1000 messages are displayed in the long-term
archive list on the single-user system, server or client for each server, or for each redundant
server pair.
If the "LongTimeArchiveConsistency" is set to "yes", the most recent 1000 messages are
displayed on the client of all servers or redundant server pair in the long-term archive list.
The attribute can be assigned dynamic properties by means of the name
LongTimeArchiveConsistency . The data type is BOOLEAN.

3.10.6.11 M
Mouse pointer (Cursor)
Mouse pointer (Cursor)
Specifies whether or not to display the mouse pointer on the icon at runtime.
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Value

Explanation

TRUE

The mouse pointer is shown at runtime if positioned on the icon.

FALSE

The mouse pointer is hidden at runtime if positioned on the icon.

The attribute can be assigned dynamic properties by means of the name Cursor. The data
type is BOOLEAN.

MessageBlock
MessageBlockAlign property
Alignment - MessageBlockAlign
Aligns the contents of a selected message block in the table.
To change the alignment, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The following settings are available:
Value

Description

Explanation

0

left

Aligns the contents of a selected message block to the left.

1

centered

Aligns the contents of a selected message block to the center.

2

right

Aligns the contents of a selected message block to the right.

The attribute can be assigned dynamic properties by means of the name MessageBlockAlign.
The data type is LONG.

MessageBlockAutoPrecisions property
Automatic decimal places - MessageBlockAutoPrecisions
Enables automatic setting of the number of decimal places.
Value

Explanation

TRUE

The number of decimal places is set automatically. The value in the "Decimal places" field is disabled.

FALSE

The value in the "Decimal places" field is enabled.

The attribute can be assigned dynamic properties by means of the name
MessageBlockAutoPrecisions. The data type is BOOLEAN.
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MessageBlockCaption property
Label - MessageBlockCaption
Defines the label of the column title in the message window for the selected message block.
The label specified is active in all Runtime languages.
To change the label, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The attribute can be assigned dynamic properties by means of the name
MessageBlockCaption. The data type is STRING.

MessageBlockCount property
MessageBlockCount
Defines the number of message blocks which are available for the message list and the hitlist.
The attribute can be assigned dynamic properties by means of the name
MessageBlockCount . The data type is LONG.

MessageBlockDateFormat property
Date format - MessageBlockDateFormat
Defines the date format for displaying messages.
To change the date format, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The following date formats are available:
Value

Explanation

Automatic

The date format is set automatically.

dd.MM.yy

Day.Month.Year, e.g. 24.12.07.

dd.MM.yyyy

Day.Month.Year, e.g. 24.12.2007.

dd/MM/yy

Day/Month/Year, e.g. 24/12/07.

dd/MM/yyyy

Day/Month/Year, e.g. 24/12/2007.

The attribute can be assigned dynamic properties by means of the name
MessageBlockDateFormat. The data type is STRING.

772

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties

MessageBlockExponentialFormat property
Exponential notation - MessageBlockExponentialFormat
Specifies the exponential notation for visualization of the values of a selected message block.
Value

Explanation

TRUE

The values are displayed with exponential notation.

FALSE

The values are displayed with decimal notation.

The attribute can be assigned dynamic properties by means of the name
MessageBlockExponentialFormat. The data type is BOOLEAN.

MessageBlockFlashMode property
Flash mode - MessageBlockFlashMode
Specifies how the content of the selected message block flashes in Runtime when a message
appears. The "Flashing on" option must be selected.
To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
Valu
e

Description

Explanation

0

Standard

The text color switches between the standard color and the flash color when flashing

1

Switch
background
color/text color

The color of the background and the text color switch during flashing. You configure the message
colors for the type of message in the alarm logging editor.

2

Switch message
color/table color

The message colors and the configured table colors switch during flashing. You configure the
message colors for the type of message in the alarm logging editor. Set the table colors in the
"Layout" tab in the AlarmControl.

The attribute can be assigned dynamic properties by means of the name
MessageBlockFlashMode. The data type is LONG.

MessageBlockFlashOn property
Flashing on - MessageBlockFlashOn
Enables flashing of the selected message block in Runtime after a message was activated.
To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
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Value

Explanation

TRUE

Flashing message block content.

FALSE

No flashing message block content.

The attribute can be assigned dynamic properties by means of the name
MessageBlockFlashOn. The data type is BOOLEAN.

MessageBlockHideText property
Content as text - MessageBlockHideText
Enables the textual display of the content of a selected message block.
Value

Explanation

TRUE

The content is not displayed in text format. The option is disabled.

FALSE

The content is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name
MessageBlockHideText. The data type is BOOLEAN.

MessageBlockHideTitleText property
Title as text - MessageBlockHideTitleText
Enables the display of the header of a selected message block in text format.
Value

Explanation

TRUE

The header is not displayed in text format. The option is disabled.

FALSE

The header is displayed in text format. The option is enabled.

The attribute can be assigned dynamic properties by means of the name
MessageBlockHideTitleText. The data type is BOOLEAN.

MessageBlockId property
MessageBlockId
Default assignment of the ID number and message block in WinCC AlarmControl.
The attribute can be assigned dynamic properties by means of the name MessageBlockID.
The data type is LONG.
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MessageBlockIndex property
MessageBlockIndex
References an existing message block. Using this attribute, you can assign a specific message
block values for other attributes.
Values between 0 and "MessageBlockCount" minus 1 are valid for "MessageBlockIndex".
Attribute "MessageBlockCount" defines the number of available message blocks.
The attribute can be assigned dynamic properties by means of the name
MessageBlockIndex. The data type is LONG.

MessageBlockInvertUseMessageColor property
MessageBlockInvertUseMessageColor
Specifies for the message block whether or not the message colors are displayed, contrary to
the central setting for the AlarmControl . For example, the "UseMessageColor" property is set
to "FALSE" for the AlarmControl. You have set the "MessageBlockInvertUseMessageColor"
property to "TRUE" for a message block. This causes the message colors to be displayed for
this message block in Runtime.
Value

Explanation

TRUE

Contrary to the central setting in "UseMessageColor", the message colors are displayed or not displayed
for the message block.

FALSE

Just like the central setting in "UseMessageColor", the message colors are displayed or not displayed
for the message block.

The attribute can be assigned dynamic properties by means of the name
MessageBlockInvertUseMessageColor. The data type is BOOLEAN.

MessageBlockLeadingZeros property
Number of digits - MessageBlockLeadingZeros
Defines the number of leading zeros for the message block content. The maximum number is
"11". A "0" value deactivates the "With leading zeros" option.
To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The attribute can be assigned dynamic properties by means of the name
MessageBlockLeadingZeros. The data type is LONG.
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MessageBlockLength property
Length in characters - MessageBlockLength
Defines the length of the message block selected based on the number of characters.
To change the length, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The attribute can be assigned dynamic properties by means of the name
MessageBlockLength. The data type is LONG.

MessageBlockName property
Object name - MessageBlockName
Displays the object name of the message block selected. You cannot edit this name.
The data type is STRING.

MessageBlockPrecisions property
Decimal places - MessageBlockPrecisions
Specifies the decimal precision of the values of a selected message block. You can only enter
the value if the "Automatic" option is disabled.
The attribute can be assigned dynamic properties by means of the name
MessageBlockPrecisions. The data type is SHORT.

MessageBlockSelected property
Available message blocks - MessageBlockSelected
The available message blocks are blocks that can be used in Runtime for the message list or
hitlist.
Select the "Message blocks" tab to activate existing message blocks as required in the Control.
Select the "Hitlist" and "Message list" tabs to configure the hitlist and message list based on
the available blocks.
To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The attribute can be assigned dynamic properties by means of the name
MessageBlockSelected. The data type is BOOLEAN.
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MessageBlockShowDate property
Show date - MessageBlockShowDate
Enables the display of a date in the "Time" message block in addition to the time.
Value

Explanation

TRUE

Date and time are displayed.

FALSE

The time is displayed.

The attribute can be assigned dynamic properties by means of the name
MessageBlockShowDate. The data type is BOOLEAN.

MessageBlockShowIcon property
Content as icon - MessageBlockShowIcon
Enables the display of the content of a selected message block as icon.
Value

Explanation

TRUE

The content is visualized as icon.

FALSE

The content is not visualized as icon.

The attribute can be assigned dynamic properties by means of the name
MessageBlockShowIcon. The data type is BOOLEAN.

MessageBlockShowTitleIcon property
Title as icon - MessageBlockShowTitleIcon
Enables the display of the title of a selected message block as icon.
Value

Explanation

TRUE

The header is displayed as icon.

FALSE

The header is not displayed as icon.

The attribute can be assigned dynamic properties by means of the name
MessageBlockShowTitleIcon. The data type is BOOLEAN.

MessageBlockTextId property
Text ID - MessageBlockTextId
Specifies the caption of the selected message block using a Text ID which was derived from
the text library. The caption is adapted automatically if a user changes the Runtime language.
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To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The attribute can be assigned dynamic properties by means of the name
MessageBlockTextId. The data type is LONG.

MessageBlockTimeFormat property
MessageBlockTimeFormat
Defines which time format or duration format is used for displaying the messages.
To change the setting, the option "Apply project settings" must be deactivated or
"ApplyProjectSettings" must be set to "FALSE".
The following time formats are available:
Value

Explanation

Automatic

The time format is set automatically.

HH:mm:ss

Hours:Minutes:Seconds, e.g. 15:35:44

HH:mm:ss.ms

Hours:Minutes:Seconds.Milliseconds, e.g. 15:35:44.240.

hh:mm:ss tt

Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.

hh:mm:ss.ms tt

Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The following time duration formats are available:
Value

Explanation

Automatic

The time duration format is determined automatically.

d H:mm:ss

Day Hours:Minutes:Seconds, e.g. 1 2:03:55.

H:mm:ss.

Hours:Minutes:Seconds, e.g. 26:03:55.

m:ss

Minutes:Seconds, Example: 1563:55.

s

Seconds, e.g. 93835.

The attribute can be made dynamic by means of the name MessageBlockTimeFormat. The
data type is STRING.

MessageBlockType property
MessageBlockType
Displays the association of the message block.
The following settings are available:
Value

Description

Explanation

0

System block

The message block belongs to the system block category.

1

Text block

The message block belongs to the user text block category.
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Value

Description

Explanation

2

Process value block

The message block belongs to the process value block category.

3

Hitlist block

The message block belongs to the message blocks of the hitlist.

The attribute can be assigned dynamic properties by means of the name
MessageBlockType . The data type is LONG.

MessageColumnAdd property
MessageColumnAdd
Adds the selected message block from the list of existing message blocks to the list of selected
message blocks.
The attribute can be assigned dynamic properties by means of the name
MessageColumnAdd . The data type is STRING.

MessageColumnCount property
MessageColumnCount
Specifies the number of message blocks to be displayed in the message list in Runtime.
The attribute can be assigned dynamic properties by means of the name
MessageColumnCount . The data type is LONG.

MessageColumnIndex property
MessageColumnIndex
References a message block selected for the message list. Using this attribute you can assign
the values of other attributes to a specific message block of the message list.
Values between 0 and "MessageColumnCount" minus 1 are valid for "MessageColumnIndex".
Attribute "MessageColumnCount" defines the number of message blocks selected for the
message list.
The "MessageColumnIndex" attribute can be assigned dynamic properties by means of
attribute MessageColumnRepos. The data type is LONG.

MessageColumnName property
MessageColumnName
Displays the name of the message block of the message list which is referenced with attribute
"MessageColumnIndex". You cannot edit this name.
The attribute can be assigned dynamic properties with the name MessageColumnName. The
data type is STRING.
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MessageColumnRemove property
MessageColumnRemove
Cuts the marked message block from the list of selected message blocks and pastes it to the
list of available message blocks.
The attribute can be assigned dynamic properties by means of the name
MessageColumnRemove . The data type is STRING.

MessageColumnRepos property
Up/Down - MessageColumnRepos/HitlistColumnRepos
Resorts the message blocks. The "Up" and "Down" commands move the selected message
block accordingly in the list. This moves the message block in Runtime Control towards the
front or towards the back.
The attribute for the hitlist can be assigned dynamic properties by means of the name
HitlistColumnRepos .
The attribute for the message list can be assigned dynamic properties by means of the name
MessageColumnRepos.
The data type is LONG.

MessageColumnSort property
MessageColumnSort
Defines the sorting order of the message block referenced in "MessageColumnIndex" .
The following settings are available:
Value

Description

Explanation

0

no

No sorting

1

Ascending

Ascending order, starting at the lowest value.

2

Descending

Descending order, starting at the highest value.

The attribute can be assigned dynamic properties by means of the name
MessageColumnSort . The data type is LONG.

MessageColumnSortIndex property
MessageColumnSortIndex
Defines the sorting order of the message block referenced in "MessageColumnIndex". The
sorting criterion is removed from "MessageColumnSort" if you set a "0" value.
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The attribute can be assigned dynamic properties by means of the name
MessageColumnSortIndex. The data type is LONG.

MessageColumnVisible property
Selected message blocks - MessageColumnVisible/HitlistColumnVisible
Selected message blocks of message list or hitlist that are displayed in Runtime. Defines
whether the message block referenced in "MessageColumnIndex" or "HitlistColumnIndex" is
displayed.
The attribute for the message list can be assigned dynamic properties by means of the name
MessageColumnVisible.
The attribute for the hitlist can be assigned dynamic properties by means of the name
HitlistColumnVisible.
The data type is BOOLEAN.

MessageListType property
Active list on picture call - MessageListType
Selection field for defining the active list for picture calls.
Value

Description

Explanation

0

Message list

The currently active messages are displayed after a picture was called.

1

Short-term
archive list

A short-term archive list displays the logged messages after the picture was called.
The display is updated immediately on activation of new messages.

2

Long-term
archive list

A long-term archive list displays the logged messages after a picture was called.

3

Lock list

Only the currently locked messages are displayed after a picture was called.

4

Hitlist

The configured statistics data is displayed after a picture was called.

5

List of messages to be
hidden

The messages to be hidden are displayed at the call of a picture.

The attribute can be assigned dynamic properties by means of the name MessageListType.
The data type is LONG.
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Moveable Property
Movable
Defines whether the control can be moved in Runtime.
Value

Explanation

TRUE

The control can be moved in Runtime.

FALSE

The control cannot be moved in Runtime.

The attribute can be assigned dynamic properties by means of the name Moveable. The data
type is BOOLEAN.

MsgFilterSQL property
MsgFilterSQL
Defines one or several SQL statements for the custom selection of messages. Multiple userdefined selections are logically linked by "OR" operation. The SQL statements of
"DefaultMsgFilterSQL" and "MsgFilterSQL" are linked logically by "AND" operation if you
define a default selection by means of "DefaultMsgFilterSQL".
The attribute can be assigned dynamic properties by means of the name MsgFilterSQL. The
data type is STRING.

3.10.6.12 O
Online property
Starting refresh - Online
Enables a refresh of displayed values when calling a picture in Runtime.
Value

Description

TRUE

Enables the refresh of values on picture calls.

FALSE

Disables the refresh of values on picture calls.

The attribute can be assigned dynamic properties by means of the name Online. The data
type is BOOLEAN.

782

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties

OperatorMessageID property
OperatorMessageID
Default assignment of the ID number and trigger event in WinCC OnlineTableControl:
Value

Description

Explanation

5

EditValue

Trigger event "Change archive value"

6

InsertValue

Trigger event "Generate archive value"

The attribute can be assigned dynamic properties by means of the name
OperatorMessageID. The data type is LONG.

OperatorMessageIndex property
OperatorMessageIndex
References the event of an archive value change for an operator message. Using this attribute
you can assign the values of other attributes to a specific operator message.
The following values are available:
Value

Explanation

0

Trigger event "Change archive value"

1

Trigger event "Generate archive value"

The attribute can be assigned dynamic properties by means of the name
OperatorMessageIndex. The data type is LONG.

OperatorMessageName property
Object name - OperatorMessageName
Displays the name that is referenced with the attribute "OperatorMessageIndex" for message
events for operator messages. You cannot edit this name.
The following names are available for message events:
Value

Explanation

Lock

Message event "Lock"

Unlock

Message event "Enable"

Hide

Message event "Hide"

Unhide

Message event "Unhide"

Quit

Message event "Ackn."

The attribute can be assigned dynamic properties by means of the name
OperatorMessageName . The data type is STRING.
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See also
How to configure operator messages

OperatorMessageNumber property
Message number - OperatorMessageNumber
Define a message number for the selected operator message event if you do not want to use
the operator message of WinCC.
The attribute can be assigned dynamic properties by means of the name
OperatorMessageNumber. The data type is LONG.

OperatorMessageSelected property
Operator messages for - OperatorMessageSelected
Activate the message events which trigger operator messages in the list.
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSelected. The data type is BOOLEAN.

OperatorMessageSource1 property
Source - OperatorMessageSource1
Define the message block of an operated message to be added to "Process value block 1" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 1" of the operator message. Select "1" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource1. The data type is STRING.

OperatorMessageSource2 property
Source - OperatorMessageSource2
Define the message block of an operated message to be added to "Process value block 2" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 2" of the operator message. Select "2" at process value as the message lock of
the operated message "User text block 1".
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The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource2. The data type is STRING.

OperatorMessageSource3 property
Source - OperatorMessageSource3
Define the message block of an operated message to be added to "Process value block 3" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 3" of the operator message. Select "3" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource3. The data type is STRING.

OperatorMessageSource4 property
Source - OperatorMessageSource4
Define the message block of an operated message to be added to "Process value block 4" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 4" of the operator message. Select "4" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource4. The data type is STRING.

OperatorMessageSource5 property
Source - OperatorMessageSource5
Define the message block of an operated message to be added to "Process value block 5" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 5" of the operator message. Select "5" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource5. The data type is STRING.
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OperatorMessageSource6 property
Source - OperatorMessageSource6
Define the message block of an operated message to be added to "Process value block 6" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 6" of the operator message. Select "6" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource6. The data type is STRING.

OperatorMessageSource7 property
Source - OperatorMessageSource7
Define the message block of an operated message to be added to "Process value block 7" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 7" of the operator message. Select "7" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource7. The data type is STRING.

OperatorMessageSource8 property
Source - OperatorMessageSource8
Define the message block of an operated message to be added to "Process value block 8" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 8" of the operator message. Select "8" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource8. The data type is STRING.
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OperatorMessageSource9 property
Source - OperatorMessageSource9
Define the message block of an operated message to be added to "Process value block 9" of
the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 9" of the operator message. Select "9" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource9. The data type is STRING.

OperatorMessageSource10 property
Source - OperatorMessageSource10
Define the message block of an operated message to be added to "Process value block 10"
of the operator message configured in Source.
An operator message is to be generated to indicate that a message was locked. The contents
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process
value block 10" of the operator message. Select "10" at process value as the message lock of
the operated message "User text block 1".
The attribute can be assigned dynamic properties by means of the name
OperatorMessageSource10. The data type is STRING.

OperatorMessageSourceType1 property
Transfer as - OperatorMessageSourceType1
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType1. The data type is LONG.
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OperatorMessageSourceType2 property
Transfer as - OperatorMessageSourceType2
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType2. The data type is LONG.

OperatorMessageSourceType3 property
Transfer as - OperatorMessageSourceType3
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType3. The data type is LONG.

OperatorMessageSourceType4 property
Transfer as - OperatorMessageSourceType4
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType4. The data type is LONG.
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OperatorMessageSourceType5 property
Transfer as - OperatorMessageSourceType5
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType5. The data type is LONG.

OperatorMessageSourceType6 property
Transfer as - OperatorMessageSourceType6
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType6. The data type is LONG.

OperatorMessageSourceType7 property
Transfer as - OperatorMessageSourceType7
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType7. The data type is LONG.
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OperatorMessageSourceType8 property
Transfer as - OperatorMessageSourceType8
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType8. The data type is LONG.

OperatorMessageSourceType9 property
Transfer as - OperatorMessageSourceType9
Defines the format for transferring the source.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source as text.

1

Value

Transfer the source as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType9. The data type is LONG.

OperatorMessageSourceType10 property
Transfer as - OperatorMessageSourceType10
Specifies the format of the source content for the transfer.
The following formats are available:
Value

Description

Explanation

0

Text

Transfer the source content in text format.

1

Value

Transfer the source content as value.

The attribute can be assigned dynamic properties by means of the name
OperatorMessageSourceType10. The data type is LONG.
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3.10.6.13 P
PageMode property
Enable paging - PageMode
Enables paging is in the long-term archive list. Allows you to display all messages of the shortterm archive in the long-term archive list. Use the "Messages per page" or
"PageModeMessageNumber" property to determine the number of messages displayed per
page.
The page up/down buttons of the toolbar can be used if paging is enabled.
Value

Explanation

TRUE

Paging is enabled for the long-term archive list.

FALSE

Paging is disabled for the long-term archive list.

The attribute can be assigned dynamic properties by means of the name PageMode. The data
type is BOOLEAN.

PageModeMessageNumber property
Messages per page - PageModeMessageNumber
Defines the number of messages shown per page when paging the long-term archive list.
The attribute can be assigned dynamic properties by means of the name
PageModeMessageNumber. The data type is LONG.

Picture
Picture
Call the configuration dialog for selecting icons.

PercentageAxis property
PercentageAxis
Enables the additional display of an axis with percentage scaling in a trend window for value
axes.
Value

Explanation

TRUE

The display of an axis with percentage scaling is enabled.

FALSE

The display of an axis with percentage scaling is disabled.
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The attribute can be assigned dynamic properties by means of the name PercentageAxis. The
data type is BOOLEAN.

PercentageAxisAlign property
PercentageAxisAlign
Enables axis alignment with percentage scaling in the trend window.
The following settings are available:
Value

Description

Explanation

0

left

The axis with percentage scaling is aligned left.

1

right

The axis with percentage scaling is aligned right.

The attribute can be assigned dynamic properties by means of the name
PercentageAxisAlign. The data type is LONG.

PercentageAxisColor property
PercentageAxisColor
Specifies the color of an axis with percentage scaling. The button opens the "Color selection"
dialog to select the color.
The attribute can be assigned dynamic properties by means of the name
PercentageAxisColor. The data type is LONG.

PictureSizeMode property
PictureSizeMode
Specifies the size adjustment between picture and control.
Value

Designation

Explanation

0

Fit size to content

The control is adapted to the picture size.

1

Fit content to size

The picture is adapted or scaled to the control.

The attribute can be assigned dynamic properties by means of the name PictureSizeMode.
The data type is LONG.

PlayEndless property
PlayEndless
Specifies if movies are played endlessly in the control.
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The attribute can be assigned dynamic properties by means of the name PlayEndless. The
data type is BOOLEAN.

PrintJobName property
Current print job view - PrintJobName
Defines the print job triggered by the print function of the "Print" toolbar button. The
recommended print job is set for the control by default.
Open the "Select Print Job" dialog using the selection button.
The attribute can be assigned dynamic properties by means of the name PrintJobName. The
data type is STRING.

3.10.6.14 R
RowScrollbar property
Row scroll bars - RowScrollbar
Enables the display of row scroll bars.
The following settings are available:
Value

Description

Explanation

0

No

No row scroll bars.

1

as required

Row scroll bars are displayed if horizontal space requirements of the control are greater
than the actually available display area.

2

always

Row scroll bars are always displayed.

The attribute can be assigned dynamic properties by means of the name RowScrollbar. The
data type is LONG.

RowTitleAlign property
Row label alignment - RowTitleAlign
Specifies the type of row label alignment.
The following settings are available:
Value

Description

Explanation

0

left

The row headers are aligned left.

1

centered

The row headers are aligned to center.

2

right

The row headers are aligned right.
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The attribute can be assigned dynamic properties by means of the name RowTitleAlign. The
data type is LONG.

RowTitles property
Show row labels - RowTitles
Enables the display of row labels.
Value

Explanation

TRUE

The row labels are displayed.

FALSE

The row labels are not displayed.

The attribute can be assigned dynamic properties by means of the name RowTitles. The data
type is BOOLEAN.

RTPersistence property
Online configuration at the next picture change - RTPersistence
Enables retention of the online configurations of the control after a picture change.
The following settings are available:
Value

Description

Explanation

0

Discard

The current online configurations are discarded at the next picture change.

1

Retain

The current online configurations are retained at the next picture change.

2

Reset

All online configurations made are lost. The picture is set to the contents found in the
configuration system.

The attribute can be assigned dynamic properties by means of the name RTPersistence. The
data type is LONG.

RTPersistencePasswordLevel property
Operator authorization for online configuration - RTPersistencePasswordLevel
Displays the authorization for online configuration. You can edit the authorization using the
selection button. Authorizations are configured in the "User Administrator" editor.
The attribute can be assigned dynamic properties by means of the name
RTPersistencePasswordLevel . The data type is LONG.
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RTPersistenceType property
Online configuration - RTPersistenceType
Defines how to retain online configurations of WinCC.
The following settings are available:
Value

Description

Explanation

0

Do not retain

Online configurations are not retained. These are lost at the next picture change.

1

Retain during
runtime

Online configurations are retained during runtime. These are lost on exiting.

2

Retain
permanently

Online configurations are retained permanently. These are also available after restart.

The attribute cannot be dynamized.

RulerType property
Window - RulerType
Specifies window to be displayed during runtime. Depending on the window type, only certain
blocks can be used as columns of the WinCC RulerControl.
The following window types can be selected:
Value

Description

Explanation

0

"Ruler"
window

The ruler window shows the coordinate values of the trends on a ruler or values of a
selected row in the table.

1

"Statistics area"
window

The statistics area window shows the values of the low and high limit of trends between
two rulers, or displays the selected range in the table.

2

"Statistics"
window

The statistics window shows the statistic evaluation of trends between two rulers, or it
displays the selected values in the table.

The attribute can be assigned dynamic properties by means of the name RulerType. The data
type is LONG.

3.10.6.15 S
SelectArchiveName property
SelectArchiveName
Opens the dialog for selecting the user archive.
Programmers can set this attribute to allow users to select a user archive by means of a button,
for example.
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The attribute can be assigned dynamic properties by means of the name
SelectArchiveName. The data type is BOOLEAN.

SelectedCellColor property
Background color of selected cell - SelectedCellColor
Specifies the background color of a selected cell. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name SelectedCellColor.
The data type is LONG.

SelectedCellForeColor property
Font color of the selected cell - SelectedCellForeColor
Specifies the font color of the selected cell. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name
SelectedCellForeColor. The data type is LONG.

SelectedRowColor property
Background color of the selected row - SelectedRowColor
Specifies the background color of the selected line. The button opens the "Color selection"
dialog.
The attribute can be assigned dynamic properties by means of the name SelectedRowColor.
The data type is LONG.

SelectedRowForeColor property
Font color of the selected row - SelectedRowForeColor
Specifies the font color of the selected row. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name
SelectedRowForeColor. The data type is LONG.

SelectedTitleColor property
Background selection color - SelectedTitleColor
Specifies the background color of a selected table header. The button opens the "Color
selection" dialog.
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The setting is only active in Runtime if the "Selection color" or "UseSelectedTitleColor" option
is activated.
The attribute can be assigned dynamic properties by means of the name SelectedTitleColor.
The data type is LONG.

SelectedTitleForeColor property
Font selection color - SelectedTitleForeColor
Specifies the font color of the table header selected. The button opens the "Color selection"
dialog.
The setting is only active in Runtime if the "Selection color" or "UseSelectedTitleColor" option
is activated.
The attribute can be assigned dynamic properties by means of the name
SelectedTitleForeColor. The data type is LONG.

SelectionColoring property
Selection colors for - SelectionColoring
Enables the use of selection colors for cells or rows.
The following settings are available:
Value

Description

Explanation

0

None

No selection colors for cells and rows.

1

Cell

Selection color for cell.

2

Row

Selection color for row.

3

Cell and row

Selection colors for cell and row.

The attribute can be assigned dynamic properties by means of the name SelectionColoring.
The data type is LONG.

SelectionRect property
Selection border- SelectionRect
Enables the use of a selection border for selected cells or rows.
The following settings are available:
Value

Description

Explanation

0

None

No selection border is drawn for selected cells or rows.

1

Cell

A selection border is drawn for the selected cell.

2

Row

A selection border is drawn for the selected row.
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The attribute can be assigned dynamic properties by means of the name SelectionRect. The
data type is LONG.

SelectionRectColor property
Color of the selection border - SelectionRectColor
Specifies the color of the selection border. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name SelectionRectColor.
The data type is LONG.

SelectionRectWidth property
Line weight of the selection border - SelectionRectWidth
Defines the line weight of the selection border in pixels.
The attribute can be assigned dynamic properties by means of the name SelectionRectWidth.
The data type is LONG.

SelectionType property
Selectable rows - SelectionType
Defines the number of lines you can select. The following settings are available:
Value

Description

Explanation

0

None

No row selection.

1

Single selection

One row can be selected.

2

Multiple selection

Multiple rows can be selected.

The attribute can be assigned dynamic properties by means of the name SelectionType. The
data type is LONG.

ServerNames property
Server selection - ServerNames
Defines from which servers within a distributed system the message window obtains the
display data.
The attribute can be assigned dynamic properties by means of the name ServerNames. The
data type is STRING.
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ShareSpaceWithSourceControl property
ShareSpaceWithSourceControl
Defines whether the size of the source control in the picture window is adapted so that the
WinCC RulerControl is also displayed in a small picture window.
Value

Explanation

TRUE

The source control in the picture window is adapted.

FALSE

The source control in the picture window is not adapted.

The attribute can be assigned dynamic properties by means of the name
ShareSpaceWithSourceControl. The data type is BOOLEAN.

ShowRuler property
Show ruler - ShowRuler
Enables the display of a ruler for scanning the coordinate points on picture calls.
Value

Explanation

TRUE

Enables the display of a ruler for scanning the coordinate points.

FALSE

Disables the display of a ruler for scanning the coordinate points.

The attribute can be assigned dynamic properties by means of the name ShowRuler. The data
type is BOOLEAN.

ShowRulerInAxis property
ShowRulerInAxis
Enables the display of rulers in the time axis.
Value

Explanation

TRUE

Enables the display of rulers in the time axes.

FALSE

Disables the display of rulers in the time axes.

The attribute can be assigned dynamic properties by means of the name ShowRulerInAxis.
The data type is BOOLEAN.

ShowScrollbars property
Scroll bars - ShowScrollbars
Enables the display of scroll bars.
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The following settings are available:
Value

Description

Explanation

0

No

The display of scroll bars is disabled.

1

as required

Scroll bars are displayed if space requirements of the control are greater than the actual
display area.

2

always

The scroll bars are always displayed.

The attribute can be assigned dynamic properties by means of the name ShowScrollbars. The
data type is LONG.

ShowSlider property
ShowSlider
Specifies if a time slider is displayed in the control.
The attribute can be assigned dynamic properties by means of the name ShowSlider. The data
type is BOOLEAN.

ShowSortButton property
Use sorting button - ShowSortButton
Enables the display of a sorting button above the vertical scroll bar. Click this sorting button
to sort the selected column based on the configured sorting criteria. The sorting button is not
displayed if the table does not contain a vertical scroll bar.
Value

Explanation

TRUE

Enables sorting of a selected column by means of sorting button.

FALSE

The sorting button is not displayed.

The attribute can be assigned dynamic properties by means of the name ShowSortButton .
The data type is BOOLEAN.

ShowSortIcon property
Show sorting icon - ShowSortIcon
Enables the display of the sorting icon.
Value

Explanation

TRUE

Enables the display of the sorting icon.

FALSE

Disables the display of the sorting icon.
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The attribute can be assigned dynamic properties by means of the name ShowSortIcon. The
data type is BOOLEAN.

ShowSortIndex property
Show sorting index - ShowSortIndex
Enables the display of a sorting icon.
Value

Explanation

TRUE

Enables the display of a sorting index.

FALSE

Disables the display of a sorting index.

The attribute can be assigned dynamic properties by means of the name ShowSortIndex. The
data type is BOOLEAN.

ShowStatisticRuler property
ShowStatisticRuler
Enables the display of rulers in the statistics field on picture calls.
Value

Explanation

TRUE

Enables the display of rulers in the statistics field.

FALSE

Disables the display of rulers in the statistics field.

The attribute can be assigned dynamic properties by means of the name ShowStatisticRuler.
The data type is BOOLEAN.

ShowTitle property
Window title - ShowTitle
Defines representation the Control window header.
Value

Designation

Explanation

0

No

No window title.

1

Normal

The window title consists of a WinCC icon and text. The text is entered in the "Text" field.

2

Narrow

The window title consists only of text. The text is entered in the "Text" field.

The attribute can be assigned dynamic properties by means of the name ShowTitle. The data
type is LONG.
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ShowToolbar property
ShowToolbar
Specifies if a toolbar is displayed in the control.
The attribute can be assigned dynamic properties by means of the name ShowToolbar. The
data type is BOOLEAN.

ShowTrendIcon property
ShowTrendIcon
Enables the display of an icon below the value axes. The icon indicates the trend currently
displayed in the foreground.
The attribute can be assigned dynamic properties by means of the name ShowTrendIcon. The
data type is BOOLEAN.

Sizeable property
Sizeable
Enables resizing of the control during runtime.
Value

Explanation

TRUE

The control can be resized during runtime.

FALSE

The control cannot be resized during runtime.

The attribute can be assigned dynamic properties by means of the name Sizeable. The data
type is BOOLEAN.

SkinName property
Style - SkinName
The control style can be defined in this selection field.
The following settings are available:
Value

Designation

Explanation

Project setting

The style corresponds to the project settings in WinCC Explorer.

0

Simple

"Classic" WinCC style

1

Standard

New WinCC V7 style

Basic Process Control

The style is reserved for internal use with Basic Process Control.
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The attribute can be assigned dynamic properties by means of the name SkinName. The data
type is STRING.

SortSequence property
Sorting order by mouse click - SortSequence
Specifies how to change the sorting order by mouse click.
The following sorting orders are available:
Value

Description

Explanation

0

Up/down/none

You can toggle between ascending, descending and no sorting by means of mouse click.

1

Up/down

You can toggle between ascending and descending sorting order by means of mouse click.

The attribute can be assigned dynamic properties by means of the name SortSequence. The
data type is LONG.

SourceControl property
Source - SourceControl
Defines the control to be interconnected with WinCC RulerControl.
The attribute can be assigned dynamic properties by means of the name SourceControl. The
data type is STRING.

SouceControlType property
Type - SourceControlType
Defines the type of control that is interconnected with the WinCC RulerControl in the "Source"
field.
Value

Designation

Explanation

0

None

The RulerControl is not connected to any source.

1

OnlineTrend
Control

The RulerControl is connected with an OnlineTrendControl.

2

OnlineTable
Control

The RulerControl is connected with an OnlineTableControl.

3

FunctionTrend
Control

The RulerControl is connected with a FunctionTrendControl.

The attribute can be assigned dynamic properties by means of the name SourceControlType.
The data type is LONG.
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Flip (Flip)
Flip (Flip)
Specifies flipping of the icon at runtime.
The following settings are available:
Value

Description

Comments

0

None

The icon is not flipped.

1

Horizontal

The object is flipped along the horizontal center axis.

2

Vertical

The object is flipped along the vertical center axis.

3

Both

The object is flipped along the horizontal and vertical center axes.

The attribute can be assigned dynamic properties by means of the name Flip. The data type
is LONG.

StepSeconds property
StepSeconds
Specifies the interval for step forward or step backward in movies.
The attribute can be assigned dynamic properties by means of the name StepSeconds. The
data type is LONG.

Status bar
StatusbarBackColor property
Background color - StatusbarBackColor
Defines the background color of the status bar. The button opens the "Color selection" dialog
to select the color.
For the setting to become active, the "Display" or "StatusbarUseBackColor" option must be
activated.
The attribute can be assigned dynamic properties by means of the name
StatusbarBackColor. The data type is LONG.

StatusbarElementAdd property
New - StatusbarElementAdd
Defines a new, user-defined status bar element. The name set by WinCC can be edited in the
"Object name" field.
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The attribute can be assigned dynamic properties by means of the name
StatusbarElementAdd . The data type is STRING.

StatusbarElementAutoSize property
Automatic - StatusbarElementAutoSize
Enables autosizing of the width of a status bar element selected.
Value

Explanation

TRUE

The width of the selected element is set automatically.

FALSE

The width of the selected element is not set automatically.

The attribute can be assigned dynamic properties by means of the name
StatusbarElementAutoSize. The data type is BOOLEAN.

StatusbarElementCount property
StatusbarElementCount
Defines the number of configurable status bar elements.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementCount. The data type is LONG.

StatusbarElementIconId property
StatusbarElementIconId
Default assignment of the ID number and icon of a status bar element.
The attribute for custom status bar elements can be made assigned dynamic properties by
measn of the name StatusbarElementIconId. The data type is LONG.

StatusbarElementID property
Object ID - StatusbarElementID
Unique ID of the status bar element selected. WinCC assigns this read only ID number.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementID. The data type is LONG.
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StatusbarElementIndex property
StatusbarElementIndex
References a status bar element. Using this attribute you can assign the values of other
attributes to a specific status bar element.
Values between 0 and "StatusbarElementCount" minus 1 are valid for
"StatusbarElementIndex". Attribute "StatusbarElementCount" defines the number of
configurable status bar elements.
The "StatusbarElementIndex" attribute can be assigned dynamic properties by means of
attribute StatusbarElementIndex. The data type is LONG.

StatusbarElementName property
Object name - StatusbarElementName
Displays the object name of the status bar element selected. You can rename the objects of
custom status bar elements.
The "StatusbarElementName" attribute can be assigned dynamic properties by means of
attribute StatusbarElementRename. The data type is STRING.

StatusbarElementRemove property
Remove - StatusbarElementRemove
Removes the selected status bar element. You can only remove user-defined status bar
element from the list.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementRemove. The data type is STRING.

StatusbarElementRename property
StatusbarElementRename
Renames a custom status bar element which is referenced by means of
"StatusbarElementIndex" attribute.
The attribute for custom elements can be assigned dynamic properties by means of the name
StatusbarElementRename. "StatusbarElementRename" also sets a dynamic attribute
"StatusbarElementName". The data type is STRING.
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StatusbarElementRepos property
Up/Down - StatusbarElementRepos
Changes the sorting order of button functions. "Up" and "Down" moves the selected status bar
element up or down in the list. This moves the status bar element of the Control towards the
front or towards the back in Runtime.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementRepos . The data type is LONG.

StatusbarElementText property
StatusbarElementText
Defines the text to be displayed for the status bar element. You can edit the
"StatusbarElementText" attribute for custom elements.
The attribute for custom elements can be assigned dynamic properties by means of the name
StatusbarElementText. The data type is STRING.

StatusbarElementTooltipText property
StatusbarElementTooltipText
Defines the tooltip text for the custom status bar element.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementTooltipText. The data type is STRING.

StatusbarElementVisible property
Status bar elements - StatusbarElementVisible
Activate the elements in the list of status bar elements for their display in Runtime.
Click a list entry to adapt the properties, or to change its position in the status bar of the Control
by means of the "Up" and "Down" buttons.
Value

Explanation

TRUE

The status bar element is displayed.

FALSE

The status bar element is not displayed.

The attribute can be assigned dynamic properties by means of the name
StatusbarElementVisible. The data type is BOOLEAN.
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StatusbarElementUserDefined property
StatusbarElementUserDefined
Indicates whether the project engineer has added the status bar element as a new custom
element.
Value

Explanation

TRUE

The status bar element is user-defined.

FALSE

The status bar element is defined by the system.

The attribute can be assigned dynamic properties by means of the name
StatusbarElementUserDefined. The data type is BOOLEAN.

StatusbarElementWidth property
Width in pixels - StatusbarElementWidth
Shows the width of the status bar element selected in pixels. You can define the width if the
"Automatic" option is not activated.
The attribute can be assigned dynamic properties by means of the name
StatusbarElementWidth. The data type is LONG.

StatusbarFont property
StatusbarFont
Defines the font of the text in the status bar.
The attribute cannot be dynamized.

StatusbarFontColor property
Font color - StatusbarFontColor
Defines the color of the text in the status bar.
The attribute can be assigned dynamic properties by means of the name StatusbarFontColor.
The data type is LONG.
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StatusbarShowTooltips property
Tooltips - StatusbarShowTooltips
Enables the display of tooltips for the status bar elements in Runtime.
Value

Explanation

TRUE

Enables the display of tooltips.

FALSE

Disables the display of tooltips.

The attribute can be assigned dynamic properties by means of the name
StatusbarShowTooltips. The data type is BOOLEAN.
Attribute "StatusbarElementTooltipText" defines the tooltip text.

StatusbarText property
StatusbarText
Default text in the status bar.
The attribute can be assigned dynamic properties by means of the name StatusbarText. The
data type is STRING.

StatusbarUseBackColor property
Display background color - StatusbarUseBackColor
Sets a background color for the status bar.
Value

Explanation

TRUE

Enables the display of the background color of the status bar.

FALSE

Disables the display of a background color for the status bar.

The attribute can be assigned dynamic properties by means of the name
StatusbarUseBackColor. The data type is BOOLEAN.

StatusbarVisible property
Show status bar - StatusbarVisible
Enables the display of the status bar of a control.
Value

Explanation

TRUE

Enables the display of a status bar.

FALSE

Disables the display of a status bar.
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The attribute can be assigned dynamic properties by means of the name StatusbarVisible .
The data type is BOOLEAN.

3.10.6.16 T
TableColor property
Row background color 1 - TableColor
Defines the background color of the rows. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name TableColor. The data
type is LONG.

TableColor2 property
Row background color 2 - TableColor2
Specifies the background color of "Row color 2". The button opens the "Color selection" dialog.
The setting is only active in Runtime if the "Row color 2" or "UseTableColor2" option is
activated. The background colors of "Row color 2" and "Row color 1" are used alternately in
this case.
The attribute can be assigned dynamic properties by means of the name TableColor2. The
data type is LONG.

TableForeColor property
Row font color 1 - TableForeColor
Specifies the font color of the rows. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name TableForeColor. The
data type is LONG.

TableForeColor2 property
Row font color 2 - TableForeColor2
Specifies the font color of "Row color 2". The button opens the "Color selection" dialog.
The setting is only active in Runtime if the "Row color 2" or "UseTableColor2" option is
activated. The font colors of "Row color 2" and "Row color 1" are used alternately in this case.
The attribute can be assigned dynamic properties by means of the name TableForeColor2.
The data type is LONG.
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TimeAxis
TimeAxisActualize property
Refresh - TimeAxisActualize
Enables refreshing of the time axis selected.
Value

Explanation

TRUE

Enables updates of the trend window which is assigned to the time axis.

FALSE

Disables updates of the trend window which is assigned to the time axis. This setting can be useful when
comparing a logged trend with a current trend.

The attribute can be assigned dynamic properties by means of the name TimeAxisActualize.
The data type is BOOLEAN.

TimeAxisAdd property
New - TimeAxisAdd
Creates a new time axis.
The attribute can be assigned dynamic properties by means of the name TimeAxisAdd. The
data type is STRING.

TimeAxisAlign property
Alignment - TimeAxisAlign
Specifies the mode of alignment of a selected time axis.
The following settings are available:
Value

Description

Explanation

0

Bottom

The time axis selected is displayed below the trend.

1

Top

The time axis selected is displayed above the trend.

The attribute can be assigned dynamic properties by means of the name TimeAxisAlign. The
data type is LONG.

TimeAxisBeginTime property
Start time - TimeAxisBeginTime
Defines the start of the time range for a selected time axis.
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The attribute can be assigned dynamic properties by means of the name
TimeAxisBeginTime. The data type is Date.
Use the "yyyy-mm-dd hh:mm:ss" format when setting a dynamic time range.

TimeAxisColor property
Time axis color - TimeAxisColor
Specifies the color of the time axis. The button opens the "Color selection" dialog to select the
color.
The setting is only active if the "Use trend color" option is not activated or if
"TimeAxisInTrendColor" is "FALSE".
The attribute can be assigned dynamic properties by means of the name TimeAxisColor. The
data type is LONG.

TimeAxisCount property
TimeAxisCount
Defines the number of time axes configured.
The attribute can be assigned dynamic properties by means of the name TimeAxisCount. The
data type is LONG.

TimeAxisDateFormat property
Date format - TimeAxisDateFormat
Defines the date format for visualizing a selected time axis.
The following date formats are available:
Value

Explanation

Automatic

The date format is set automatically.

dd.MM.yy

Day.Month.Year, e.g. 24.12.07.

dd.MM.yyyy

Day.Month.Year, e.g. 24.12.2007.

dd/MM/yy

Day/Month/Year, e.g. 24/12/07.

dd/MM/yyyy

Day/Month/Year, e.g. 24/12/2007.

The attribute can be assigned dynamic properties by means of the name
TimeAxisDateFormat. The data type is STRING.
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TimeAxisEndTime property
End time - TimeAxisEndTime
Defines the end of the time range of a selected time axis.
The attribute can be assigned dynamic properties by means of the name TimeAxisEndTime.
The data type is Date.
Use the "yyyy-mm-dd hh:mm:ss" format when setting a dynamic time range.

TimeAxisIndex property
TimeAxisIndex
References a configured time axis. Using this attribute you can assign the values of other
attributes to a specific time axis.
Values between 0 and "TimeAxisCount" minus 1 are valid for "TimeAxisIndex". Attribute
"TimeAxisCount" defines the number of trends configured.
The "TimeAxisIndex" attribute can be assigned dynamic properties by means of attribute
TimeAxisRepos. The data type is LONG.

TimeAxisInTrendColor property
Use trend color - TrendAxisInTrendColor
Sets a trend color for displaying the time axis selected. The color of the first trend is activated
if several trends are displayed in the trend window. Define the order of trends on the "Trends"
tab.
Value

Explanation

TRUE

The trend color is used to display the time axis selected. The setting in the "Color" or "TimeAxisColor" field is
disabled.

FALSE

The time axis selected is displayed in the color set in the "Color" or "TimeAxisColor" field.

The attribute can be assigned dynamic properties by means of the name
TimeAxisInTrendColor. The data type is BOOLEAN.

TimeAxisLabel property
Label - TimeAxisLabel
Defines the label text for a time axis.
The attribute can be assigned dynamic properties by means of the name TimeAxisLabel. The
data type is STRING.
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TimeAxisMeasurePoints property
Number of measurement points - TimeAxisMeasurePoints
Defines the number of measurement points to be displayed at the time axis selected.
The attribute can be assigned dynamic properties by means of the name
TimeAxisMeasurePoints. The data type is LONG.

TimeAxisName property
Object name - TimeAxisName
Specifies the name of a selected time axis.
The "TimeAxisName" attribute can be assigned dynamic properties by means of attribute
TimeAxisRename. The data type is STRING.

TimeAxisRangeType property
Time range setting - TimeAxisRangeType
Specifies the time range for the time axis selected.
Value

Description

Explanation

0

Time range

Defines the start time and the time range for the time axis.

1

Start to end time

Defines the start and end time for the time axis.

2

Number of measurement
points

Defines the start time and the number of measurement points
for the time axis.

The attribute can be assigned dynamic properties by means of the name
TimeAxisRangeType. The data type is LONG.

TimeAxisRemove property
Remove - TimeAxisRemove
Removes the selected time axis from the list.
The attribute can be assigned dynamic properties by means of the name TimeAxisRemove.
The data type is STRING.
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TimeAxisRename property
TimeAxisRename
Renames a time axis which is referenced by means of "TimeAxisIndex" attribute.
The attribute can be assigned dynamic properties by means of the name TimeAxisRename.
"TimeAxisRename" also sets a dynamic attribute "TimeAxisName". The data type is STRING.

TimeAxisRepos property
Up/Down - TimeAxisRepos
Changes the order of the time axes. "Up" and "Down" move the selected time axis up or down
in the list.
The list order determines the time axis position in the trend window. The time axis is moved
away from the trend if the listing is the same and the time axis is further up in the list.
The attribute can be assigned dynamic properties by means of the name TimeAxisRepos. The
data type is LONG.

TimeAxisShowDate property
Show date - TimeAxisShowDate
Enables the display of the date and time at the time axis selected.
Value

Explanation

TRUE

Date and time are displayed. The date format is defined in the "Date format" field.

FALSE

The date is not displayed. Only the time is displayed.

The attribute can be assigned dynamic properties by means of the name TimeAxisShowDate.
The data type is BOOLEAN.

TimeAxisTimeFormat property
Time format - TimeAxisTimeFormat
Defines the time format for visualizing a selected time axis.
The following time formats are available:
Value

Explanation

Automatic

The time format is set automatically.

hh:mm:ss.ms

Hours:Minutes:Seconds, e.g. 15:35:44.240.
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Value

Explanation

hh:mm:ss tt

Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.

hh:mm:ss.ms tt

Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The attribute can be assigned dynamic properties by means of the name
TimeAxisTimeFormat. The data type is STRING.

TimeAxisTimeRangeBase property
Time range - TimeAxisTimeRangeBase
Defines the time unit for calculating the time range.
The following time units are available:
Value

Description

500

500 ms

1000

1 second

60000

1 minute

3600000

1 hour

86400000

1 day

The attribute can be assigned dynamic properties by means of the name
TimeAxisTimeRangeBase. The data type is LONG.

TimeAxisTimeRangeFactor property
Time range - TimeAxisTimeRangeFactor
Defines the factor for calculating the time range. Only integer factors are valid.
The attribute can be assigned dynamic properties by means of the name
TimeAxisTimeRangeFactor. The data type is SHORT.

TimeAxisTrendWindow property
Trend window - TimeAxisTrendWindow
Specifies the trend window for displaying the time axis selected. Define the available trend
windows in the "Trend window" or "TrendWindowAdd" tab.
The attribute can be assigned dynamic properties by means of the name
TimeAxisTrendWindow. The data type is STRING.
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TImeAxisVisible property
Time axis - TimeAxisVisible
The list shows all time axes you created. Click a time axis entry in the list to adapt the properties
and to assign the time axis to a trend window.
Activate the time axes to be displayed in the trend window in the list.
Defines whether the selected time axis is displayed.
Value

Explanation

TRUE

The time axis is displayed.

FALSE

The time axis is not displayed.

The attribute can be assigned dynamic properties by means of the name TimeAxisVisible. The
data type is BOOLEAN.

TimeBase property
Time base - TimeBase
This selection field is used to define the time base for the time stamp in the control.
Value

Designation

0

Local time zone

1

Coordinated Universal Time (UTC)

2

Project setting

The attribute can be assigned dynamic properties by means of the name TimeBase. The data
type is LONG.

TimeColumn
TimeColumnActualize property
TimeColumnActualize
Enables the update of values in the selected column.
Value

Explanation

TRUE

The time column is updated.

FALSE

The time column is not updated. This setting can be useful when comparing tables.

The attribute can be assigned dynamic properties by means of the name
TimeColumnActualize. The data type is BOOLEAN.
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TimeColumnAdd property
New - TimeColumnAdd
Creates a new time column.
The attribute can be assigned dynamic properties by means of the name TimeColumnAdd.
The data type is STRING.

TimeColumnAlign property
Alignment - TimeColumnAlign
Defines the mode of alignment of the time column selected.
The following settings are available:
Value

Description

Explanation

0

left

The time column selected is displayed on the left.

1

Centered

The time column selected is aligned to center.

2

right

The time column selected is displayed on the right.

The attribute can be assigned dynamic properties by means of the name TimeColumnAlign.
The data type is LONG.

TimeColumnBackColor property
Background color - TimeColumnBackColor
Specifies the background color of the time column selected. Use the button to open the "Color
selection" dialog.
The setting is useful if:
● The "Use value column colors" option is not activated or
"TimeColumnUseValueColumnColors" is "FALSE".
● The "Background color" option is activated or "UseColumnBackColor" is "TRUE in the "Use
column color" field of the "General" tab".
The attribute can be assigned dynamic properties by means of the name
TimeColumnBackColor. The data type is LONG.

TimeColumnBeginTime property
Start time - TimeColumnBeginTime
Defines the start of the time range for a selected time column.
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The attribute can be assigned dynamic properties by means of the name
TimeColumnBeginTime. The data type is Date.
Use the "yyyy-mm-dd hh:mm:ss" format when setting a dynamic time range.

TimeColumnCaption property
Caption - TimeColumnCaption
Defines the caption of the time column.
The attribute can be assigned dynamic properties by means of the name
TimeColumnCaption. The data type is STRING.

TimeColumnCount property
TimeColumnCount
Defines the number of time columns configured.
The attribute can be assigned dynamic properties by means of the name TimeColumnCount.
The data type is LONG.

TimeColumnDateFormat property
Date format - TimeColumnDateFormat
Defines the date format for visualizing a selected time column.
The following date formats are available:
Value

Explanation

Automatic

The date format is set automatically.

dd.MM.yy

Day.Month.Year, e.g. 24.12.07.

dd.MM.yyyy

Day.Month.Year, e.g. 24.12.2007.

dd/MM/yy

Day/Month/Year, e.g. 24/12/07.

dd/MM/yyyy

Day/Month/Year, e.g. 24/12/2007.

The attribute can be assigned dynamic properties by means of the name
TimeColumnDateFormat. The data type is STRING.

TimeColumnEndTime property
End time - TimeColumnEndTime
Defines the end of the time range of a selected time column.
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The attribute can be assigned dynamic properties by means of the name
TimeColumnEndTime. The data type is Date.
Use the "yyyy-mm-dd hh:mm:ss" format when setting a dynamic time range.

TimeColumnForeColor property
Font color - TimeColumnForeColor
Specifies the font color of the time column selected. Use the button to open the "Color selection"
dialog.
The setting is useful if:
● The "Use value column colors" option is not activated or
"TimeColumnUseValueColumnColors" is "FALSE".
● The "Font color" option is activated or "UseColumnForeColor" is "TRUE" in the "Use column
color" field of the "General" tab.
The attribute can be assigned dynamic properties by means of the name
TimeColumnForeColor. The data type is LONG.

TimeColumnHideText property
TimeColumnHideText
Sets text format for displaying the content of a time column.
Value

Explanation

TRUE

The content is not displayed in text format.

FALSE

The content is displayed in text format.

The attribute can be assigned dynamic properties by means of the name
TimeColumnHideText. The data type is BOOLEAN.

TimeColumnHideTitleText property
TimeColumnHideTitleText
Sets text format for displaying the time column header.
Value

Explanation

TRUE

The header is not displayed in text format.

FALSE

The header is displayed in text format.

The attribute can be assigned dynamic properties by means of the name
TimeColumnHideTitleText. The data type is BOOLEAN.
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TimeColumnIndex property
TimeColumnIndex
References a configured time column. Using this attribute you can assign the values of other
attributes to a specific time column.
Values between 0 and "TimeColumnCount" minus 1 are valid for "TimeColumnIndex". Attribute
"TimeColumnCount" defines the number of time columns configured.
The "TimeColumnIndex" attribute can be assigned dynamic properties by means of attribute
TimeColumnRepos. The data type is LONG.

TimeColumnLength property
Length in characters - TimeColumnLength
Specifies the width of a selected time column.
The attribute can be assigned dynamic properties by means of the name TimeColumnLength.
The data type is LONG.

TimeColumnMeasurePoints property
Number of measurement points - TimeColumnMeasurePoints
Defines the number of measurement points to be displayed in the time column selected.
The attribute can be assigned dynamic properties by means of the name
TimeColumnMeasurePoints. The data type is LONG.

TimeColumnName property
Object name - TimeColumnName
Specifies the name of a selected time column.
The "TimeColumnName" attribute can be assigned dynamic properties by means of attribute
TimeColumnRename. The data type is STRING.
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TimeColumnRangeType property
Time range setting - TimeColumnRangeType
Defines the time range setting for the time column selected.
Value

Description

Explanation

0

Time range

Defines the start time and time range of the time column.

1

Start to end time

Defines the start and end time for the time column.

2

Number of measurement points

Defines the start time and the number of measurement points for the time
column.

The attribute can be assigned dynamic properties by means of the name
TimeColumnRangeType. The data type is LONG.

TimeColumnRemove property
Remove - TimeColumnRemove
Removes the selected time column from the list.
The attribute can be assigned dynamic properties by means of the name
TimeColumnRemove. The data type is STRING.

TimeColumnRename property
TimeColumnRename
Renames a time column which is referenced by means of "TimeColumnIndex" attribute.
The attribute can be assigned dynamic properties by means of the name
TimeColumnRename. "TimeColumnRename" also sets a dynamic attribute
"TimeColumnName". The data type is STRING.

TimeColumnRepos property
Up/Down - TimeColumnRepos
Repositions the order of time columns and of corresponding value columns. "Up" and "Down"
move the time column selected up or down in the list. This moves the time column and
corresponding value columns in the table towards the front or towards the back.
The attribute can be assigned dynamic properties by means of the name TimeColumnRepos.
The data type is LONG.
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TimeColumnShowDate property
Show date - TimeColumnShowDate
Enables the display of the date and time in the time column selected.
Value

Explanation

TRUE

Date and time are displayed. The date format is defined in the "Date format" field or by using
"TimeColumnDateFormat".

FALSE

The date is not displayed. Only the time is displayed.

The attribute can be assigned dynamic properties by means of the name
TimeColumnShowDate. The data type is BOOLEAN.

TimeColumnShowIcon property
TimeColumnShowIcon
Enables the display of time column contents as icon. This function is only available in WinCC
Alarm Control.
Value

Explanation

TRUE

The content is visualized as icon.

FALSE

The content is not visualized as icon.

The attribute can be assigned dynamic properties by means of the name
TimeColumnShowIcon. The data type is BOOLEAN.

TimeColumnShowTitleIcon property
TimeColumnShowTitleIcon
Enables display of the time column header as icon. This function is only available in WinCC
Alarm Control.
Value

Explanation

TRUE

The header is displayed as icon.

FALSE

The header is not displayed as icon.

The attribute can be assigned dynamic properties by means of the name
TimeColumnShowTitleIcon. The data type is BOOLEAN.

TimeColumnSort property
TimeColumnSort
Defines the sorting order of the time column referenced in "TimeColumnIndex" .
The following settings are available:
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Value

Description

Explanation

0

No

No sorting

1

Ascending

Ascending order, starting at the lowest value.

2

Descending

Descending order, starting at the highest value.

The attribute can be assigned dynamic properties by means of the name TimeColumnSort .
The data type is LONG.

TimeColumnSortIndex property
TimeColumnSortIndex
Defines the sorting order of the time column referenced in "TimeColumnIndex". The sorting
criterion is removed from "TimeColumnSort" if you set a "0" value..
The attribute can be assigned dynamic properties by means of the name
TimeColumnSortIndex. The data type is LONG.

TimeColumnTimeFormat property
Time format - TimeColumnTimeFormat
Defines the time format for visualizing a selected time column.
The following time formats are available:
Value

Explanation

Automatic

The time format is set automatically.

HH:mm:ss.ms

Hours:Minutes:Seconds, e.g. 15:35:44.240.

hh:mm:ss tt

Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.

hh:mm:ss.ms tt

Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The attribute can be assigned dynamic properties by means of the name
TimeColumnTimeFormat. The data type is STRING.

TimeColumnTimeRangeBase property
Time range - TimeColumnTimeRangeBase
Defines the time unit for calculating the time range.
The following time units are available:
Value

Description

500

500 ms

1000

1 second
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Value

Description

60000

1 minute

3600000

1 hour

86400000

1 day

The attribute can be assigned dynamic properties by means of the name
TimeColumnTimeRangeBase. The data type is LONG.

TimeColumnTimeRangeFactor property
Time range - TimeColumnTimeRangeFactor
Defines the factor for calculating the time range. Only integer factors are valid.
The attribute can be assigned dynamic properties by means of the name
TimeColumnTimeRangeFactor. The data type is SHORT.

TimeColumnUseValueColumnColors property
Use value column colors - TimeColumnUseValueColumnColors
Defines whether the selected time column will be displayed in the value column colors.
Value

Explanation

TRUE

The colors of the value column are used to display a selected time column. The settings in the "Font color"
and "Background color" fields are disabled.

FALSE

The colors defined in the "Font color" and "Background color" fields are used to display the selected time
column.

The attribute can be assigned dynamic properties by means of the name
TimeColumnUseValueColumnColors. The data type is BOOLEAN.

TimeColumnVisible property
Time columns - TimeColumnVisible
The list shows the time columns you created. Click a time column entry in the list to adapt the
properties and to define the time range of the time column.
Select the time columns to be displayed in the table from the list.
Defines whether the selected time column is displayed.
The attribute can be assigned dynamic properties by means of the name TimeColumnVisible.
The data type is BOOLEAN.
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TimeStepBase property
Precision - TimeStepBase
Defines the precision of the time stamp displayed in a table.
Calculate the precision by multiplying the factor with the time unit. Enter factor "3" and time
unit "1s" to display all values which were generated within 3 seconds in the same row, for
example.
Value

Description

Explanation

0

Exact

Only values with precisely the same time stamp are displayed in a table row.

100

100 ms

All values generated within 100 milliseconds are grouped in a table row.

250

250 ms

All values generated within 250 milliseconds are grouped in a table row.

500

500 ms

All values generated within 500 milliseconds are grouped in a table row.

1000

1s

All values generated within 1 second are grouped in a table row.

The attribute can be assigned dynamic properties by means of the name TimeStepBase. The
data type is LONG.

TimeStepFactor property
Precision - TimeStepFactor
Defines the precision of the time stamp displayed in a table.
Calculate the precision by multiplying the factor with the time unit. Enter factor "3" and time
unit "1s" to display all values which were generated within 3 seconds in the same row.
The factor entered is disabled if "Exact" is selected for the time unit or "0" is selected for
"TimeStepBase".
The attribute can be assigned dynamic properties by means of the name TimeStepFactor. The
data type is LONG.

TitleColor property
Table header background - TitleColor
Specifies the background color of the table headers. The button opens the "Color selection"
dialog.
The attribute can be assigned dynamic properties by means of the name TitleColor. The data
type is LONG.
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TitleCut property
Shorten contents - TitleCut
Truncates the content of column headers if the column is insufficient.
Value

Explanation

TRUE

The column headers are truncated.

FALSE

The column headers are not truncated.

The attribute can be assigned dynamic properties by means of the name TitleCut . The data
type is BOOLEAN.

TitleDarkShadowColor property
Dark shading color - TitleDarkShadowColor
Specifies the color of the dark side of shading. The button opens the "Color selection" dialog.
The setting is only active if the "Shading Color" option or "TitleStyle" is activated.
The attribute can be assigned dynamic properties by means of the name
TitleDarkShadowColor. The data type is LONG.

TitleForeColor property
Table header font color - TitleForeColor
Specifies the color of the table header. The button opens the "Color selection" dialog.
The attribute can be assigned dynamic properties by means of the name TitleForeColor. The
data type is LONG.

TitleGridLineColor property
Color of the divider / header - TitleGridLineColor
Defines the color of row/column dividers in the table header. The button opens the "Color
selection" dialog.
The attribute can be assigned dynamic properties by means of the name TitleGridLineColor.
The data type is LONG.
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TitleLightShadowColor property
Bright shading color - TitleLightShadowColor
Specifies the color of the bright side of shading. The button opens the "Color selection" dialog.
The setting is only active if the "Shading Color" option or "TitleStyle" is activated.
The attribute can be assigned dynamic properties by means of the name
TitleLightShadowColor. The data type is LONG.

TitleSort property
Sort by column title- TitleSort
Defines how to trigger sorting by column title. You can only sort by column title if the "Autoscrolling" option is deactivated.
Value

Description

Explanation

0

No

Sorting by column title is not possible.

1

With click

Sorting is triggered by clicking in the column header.

2

With double-click

Sorting is triggered by double-clicking in the column title.

The attribute can be assigned dynamic properties by means of the name TitleSort. The data
type is LONG.

TitleStyle property
Shading color - TitleStyle
Specifies whether to set a shading color for the table header.
Value

Description

Explanation

0

Flat

Disables the use of shading colors. Flat header style.

1

Button

Enables the use of shading colors. 3D representation of the header.

The attribute can be assigned dynamic properties by means of the name TitleStyle. The data
type is LONG.

Toolbar
ToolbarAlignment property
Alignment - ToolbarAlignment
Defines the orientation of the Control toolbar.
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The following settings are available:
Value

Description

Explanation

0

Top

The toolbar is aligned to the top edge.

1

Bottom

The toolbar is aligned to the bottom edge.

2

left

The toolbar is aligned to the left edge.

3

right

The toolbar is aligned to the right edge.

The attribute can be assigned dynamic properties by means of the name ToolbarAlignment.
The data type is LONG.

ToolbarBackColor property
Background color - ToolbarBackColor
Specifies the background color of the toolbar. Open the "Color selection" dialog by clicking the
button.
The background color you configured is only displayed if the "Display" option is activated or
"ToolbarUseBackColor" is "TRUE".
The attribute can be assigned dynamic properties by means of the name ToolbarBackColor.
The data type is LONG.

ToolbarButtonActive property
Active - ToolbarButtonActive
Activates a button function in Runtime. Clicking the button in Runtime triggers the
corresponding function.
Value

Explanation

TRUE

The button function is enabled.

FALSE

The button function is disabled. You can assign custom functions to the button by means of scripting.

The attribute can be assigned dynamic properties by means of the name
ToolbarButtonActive. The data type is BOOLEAN.

ToolbarButtonAdd property
New - ToolbarButtonAdd
Creates a new, user-defined button function. The name set by WinCC can be edited in the
"Object name" field.
The attribute can be assigned dynamic properties by means of the name ToolbarButtonAdd .
The data type is STRING.
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ToolbarButtonBeginGroup property
Separator - ToolbarButtonBeginGroup
Inserts a leading separator (vertical line) for the selected button function on the toolbar. These
separators can be used to group the icons of the button functions.
Value

Explanation

TRUE

A separator prefix is inserted for the button function selected.

FALSE

A separator prefix is not inserted for the button function selected.

The attribute can be assigned dynamic properties by means of the name
ToolbarButtonBeginGroup. The data type is BOOLEAN.

ToolbarButtonClick AlarmControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

ID

Button function

1

"Help"

21

"Next message"

2

"Configuration dialog"

22

"Last message"

3

"Message list".

23

"Info text dialog"

4

"Short-term archive list".

24

"Comments dialog"

5

"Long-term archive list"

25

"Loop In Alarm"

6

"Lock List".

26

"Lock message"

7

"Hit List"

27

"Enable message"

8

"List of messages to be hidden"

28

"Hide messages"

9

"Ackn. Central Signaling Devices"

29

'Unhide messages"

10

"Single acknowledgment"

30

"Sort dialog"

11

"Group acknowledgement"

31

"Time base dialog"

18

"Emergency acknowledgement"

32

"Copy rows"

13

"Selection dialog"

33

"Connect backup"

14

"Display options dialog"

34

"Disconnect backup"

15

"Lock dialog"

36

"First page"

17

"Print"

37

"Previous page"

35

"Export data"

38

"Next page"

12

"Autoscroll"

39

"Last page"

19

"First message"

1001

"User-defined 1"

20

"Previous message"

The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.
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ToolbarButtonClick FunctionTrendControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

ID

Button function

1

"Help"

13

"Select time range"

2

"Configuration dialog"

14

"Previous trend"

4

"Zoom area"

15

"Next trend"

5

"Zoom +/-"

16

"Stop"

6

"Zoom X axis +/-"

16

"Start"

7

"Zoom Y axis +/-"

17

"Print"

8

"Shift trend range"

20

"Export data"

9

"Shift axes range"

3

"Ruler"

10

"Original view"

18

"Connect backup"

11

"Select data connection"

19

"Disconnect backup"

12

"Select trends"

1001

"User-defined 1"

The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.

ToolbarButtonClick OnlineTableControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

ID

Button function

1

"Help"

13

"Next column"

2

"Configuration dialog"

14

"Stop"

3

"First data record"

14

"Start"

4

"Previous data record"

15

"Print"

5

"Next data record"

20

"Export data"

6

"Last data record"

16

"Define statistics area"

7

"Edit"

17

"Calculate statistics"

8

"Copy rows"

18

"Connect backup"

9

"Select data connection"

19

"Disconnect backup"

10

"Select columns"

21

"Create archive value"

11

"Select time range"

1001

"User-defined 1"

12

"Previous column"
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The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.

ToolbarButtonClick OnlineTrendControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

ID

Button function

1

"Help"

17

"Select time range"

2

"Configuration dialog"

18

"Previous trend"

3

"First data record"

19

"Next trend"

4

"Previous data record"

20

"Stop"

5

"Next data record"

20

"Start"

6

"Last data record"

21

"Print"

8

"Zoom area"

26

"Export data"

9

"Zoom +/-"

7

"Ruler"

10

"Zoom time axis +/-"

22

"Define statistics area"

11

"Zoom value axis +/-"

23

"Calculate statistics"

12

"Shift trend range"

24

"Connect backup"

13

"Shift axes range"

25

"Disconnect backup"

14

"Original view"

27

"Relative axis"

15

"Select data connection"

1001

"User-defined 1"

16

"Select trends"

The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.

ToolbarButtonClick RulerControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

1

"Help"

2

"Configuration dialog"

3

"Ruler window"

4

"Statistics range"

5

"Statistics"

6

"Print"
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7

"Export data"

1001

"User-defined 1"

The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.

ToolbarButtonClick UserArchiveControl property
ToolbarButtonClick
Triggers the function linked to the toolbar button. Programmers can use the "ID" to call the
corresponding button function.
ID

Button function

ID

Button function

1

"Help"

12

"Read tags"

2

"Configuration dialog"

13

"Write tags"

3

"Select data connection"

14

"Import archive"

4

"First row"

15

"Export archive"

5

"Previous row"

16

"Sort dialog"

6

"Next row"

17

"Selection dialog"

7

"Last row"

18

"Print"

8

"Delete rows"

20

"Export data"

9

"Cut rows"

19

"Time base dialog"

10

"Copy rows"

1001

"User-defined 1"

11

"Insert rows"

The attribute can be assigned dynamic properties by means of the name ToolbarButtonClick.
The data type is LONG.

ToolbarButtonCount property
ToolbarButtonCount
Defines the number of configurable button functions.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonCount. The data type is LONG.

ToolbarButtonEnabled property
ToolbarButtonEnabled
Enables operation of custom toolbar buttons.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonEnabled. The data type is BOOLEAN.
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ToolbarButtonHotKey property
Hotkey - ToolbarButtonHotKey
Shows the hotkey for a button function selected.
You create or edit a hotkey by clicking in the "Hotkey" field and pressing the button or key
shortcut required.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonHotKey. The data type is LONG.

ToolbarButtonID property
Object ID - ToolbarButtonID
Unique ID number for the selected button function. WinCC assigns this read only ID number.
The attribute can be assigned dynamic properties by means of the name ToolbarButtonID.
The data type is LONG.

ToolbarButtonIndex property
ToolbarButtonIndex
References a button function. Using this attribute you can assign the values of other attributes
to a specific button function.
Values between 0 and "ToolbarButtonIndex" minus 1 are valid for "ToolbarButtonCount".
Attribute "ToolbarButtonCount" defines the number of configurable button functions.
The "ToolbarButtonIndex" attribute can be assigned dynamic properties by means of attribute
ToolbarButtonRepos. The data type is LONG.

ToolbarButtonLocked property
ToolbarButtonLocked
Enables/disables the display of the pressed state of a user-defined toolbar button.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonLocked. The data type is BOOLEAN.

ToolbarButtonName property
Object name - ToolbarButtonName
Shows the name for the selected button function. You rename user-defined button functions.
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The "ToolbarButtonName" attribute can be assigned dynamic properties by means of attribute
ToolbarButtonRename. The data type is STRING.

ToolbarButtonPasswordLevel property
Operator authorization - ToolbarButtonPasswordLevel
Shows the authorization for a button function selected. You can edit the authorization using
the selection button.
Authorizations are configured in the "User Administrator" editor.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonPasswordLevel. The data type is LONG.

ToolbarButtonRemove property
Remove - ToolbarButtonRemove
Removes the selected button function from the list. Only user-defined button functions can be
removed.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonRemove. The data type is STRING.

ToolbarButtonRename property
ToolbarButtonRename
Renames a custom toolbar element which is referenced by means of "ToolbarButtonIndex"
attribute.
The attribute for custom elements can be assigned dynamic properties by means of the name
ToolbarButtonRename. "ToolbarButtonRename" also sets a dynamic attribute
"ToolbarButtonName". The data type is STRING.

ToolbarButtonRepos property
Up/Down - ToolbarButtonRepos
Changes the sorting order of button functions. "Up" and "Down" move the button function
selected up or down in the list. This moves the button function in the toolbar of a Control towards
the front or towards the back.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonRepos. The data type is LONG.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

835

Creating Process Pictures
3.10 Object properties

ToolbarButtonTooltipText property
ToolbarButtonTooltipText
Specifies the tooltip text for the button.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonTooltipText. The data type is STRING.

ToolbarButtonUserDefined property
ToolbarButtonUserDefined
Indicates whether the project engineer has added a new user-defined toolbar button.
Value

Explanation

TRUE

The toolbar button is assigned a user-defined function.

FALSE

The toolbar button is defined by the system.

The attribute can be assigned dynamic properties by means of the name
ToolbarButtonUserDefined. The data type is BOOLEAN.

ToolbarButtonVisible property
Button functions - ToolbarButtonVisible
Select the button functions to be displayed in the toolbar from the list.
Click a list entry to adapt the properties, or to change the position in the status bar of the Control
by means of the "Up" and "Down" buttons.
The attribute can be assigned dynamic properties by means of the name
ToolbarButtonVisible . The data type is BOOLEAN.

ToolbarShowTooltips property
Tooltips - ToolbarShowTooltips
Enables the display of tooltips for the button functions in Runtime.
Value

Explanation

TRUE

Enables the display of tooltips.

FALSE

Disables the display of tooltips.

The attribute can be assigned dynamic properties by means of the name
ToolbarShowTooltips. The data type is BOOLEAN.
Attribute "ToolbarButtonTooltipText" defines the tooltip text.
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ToolbarUseBackColor property
Show background color - ToolbarUseBackColor
Enables the display of the background color for a toolbar.
Value

Explanation

TRUE

Enables the display of the background color of a toolbar.

FALSE

Disables the display of the background color of a toolbar.

The attribute can be assigned dynamic properties by means of the name
ToolbarUseBackColor. The data type is BOOLEAN.

ToolbarUseHotKeys property
Hotkeys - ToolbarUseHotKeys
Activates the hotkeys for button functions in Runtime. Insert the hotkeys for button functions
in the "Hotkey" field.
Value

Explanation

TRUE

The hotkeys are activated.

FALSE

The hotkeys are deactivated.

The attribute can be assigned dynamic properties by means of the name
ToolbarUseHotKeys. The data type is BOOLEAN.

ToolbarVisible property
Show toolbar - ToolbarVisible
Enables the display of the Control toolbar.
Value

Explanation

TRUE

Enables the display of the toolbar.

FALSE

Disables the display of the toolbar.

The attribute can be assigned dynamic properties by means of the name ToolbarVisible . The
data type is BOOLEAN.
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Trend
TrendActualize property
Update -TrendActualize
Enables the update of a selected trend.
Value

Explanation

TRUE

Enables updates of the trend selected.

FALSE

Disables updates of the trend selected. This setting can be useful when comparing a logged trend with a current
trend.

The attribute can be assigned dynamic properties by means of the name TrendActualize. The
data type is BOOLEAN.

TrendAdd property
New - TrendAdd
Creates a new trend.
The attribute can be assigned dynamic properties by means of the name TrendAdd. The data
type is STRING.

TrendAutoRangeBeginTagName property
TrendAutoRangeBeginTagName
This attribute sets the low limit tag for the range of values if the range of values is calculated
automatically by means of online tags.
The attribute can be assigned dynamic properties by means of the name
TrendAutoRangeBeginTagName. The data type is STRING.

TrendAutoRangeBeginValue property
TrendAutoRangeBeginValue
This attribute sets the low limit tag for the range of values if the range of values is calculated
based on the configuration of high and low limits.
The attribute can be assigned dynamic properties by means of the name
TrendAutoRangeBeginValue. The data type is DOUBLE.
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TrendAutoRangeEndTagName property
TrendAutoRangeEndTagName
This attribute sets the high limit tag for the range of values if the range of values is calculated
automatically by means of online tags.
The attribute can be assigned dynamic properties by means of the name
TrendAutoRangeEndTagName. The data type is STRING.

TrendAutoRangeEndValue property
TrendAutoRangeEndValue
This attribute sets the high limit tag for the range of values if the range of values is calculated
based on the configuration of high and low limits.
The attribute can be assigned dynamic properties by means of the name
TrendAutoRangeEndValue. The data type is DOUBLE.

TrendAutoRangeSource property
TrendAutoRangeSource
Defines the mode for automatic calculation of the range of values of trend data.
Value

Description

Explanation

0

Display data

The range of values is calculated automatically based on the data displayed.

1

Value range

The range of values is defined based on its configured low and high limit. The low and high
limits are emulated in the "TrendAutoRangeBeginValue" and "TrendAutoRangeEndValue"
attributes.

2

Online tags

The low and high limits of the range of values are derived from the values of connected online
tags. The low and high limits are emulated in the "TrendAutoRangeBeginTagName" and
"TrendAutoRangeEndTagName" attributes.

The attribute can be assigned dynamic properties by means of the name
TrendAutoRangeSource. The data type is LONG.

TrendBeginTime property
Start time - TrendBeginTime
Defines the start time of the time range for data transfer to the selected trend.
The attribute can be assigned dynamic properties by means of the name TrendBeginTime.
The data type is Date.
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TrendColor property
Trend color - TrendColor
Specifies the trend color. Open the "Color selection" dialog by clicking the button.
The attribute can be assigned dynamic properties by means of the name TrendColor. The data
type is LONG.

TrendCount property
TrendCount
Defines the number of configured trends.
The attribute can be assigned dynamic properties by means of the name TrendCount. The
data type is LONG.

TrendEndTime property
End time - TrendEndTime
Defines the end of the time range for data connections of a selected trend.
The attribute can be assigned dynamic properties by means of the name TrendEndTime. The
data type is Date.

TrendExtendedColorSet property
Extended - TrendExtendedColorSet
Enables configuration of the point and fill colors and the display of colors in Runtime.
Value

Explanation

TRUE

The "Point color" and "Fill color" field settings can be configured and are active in Runtime.

FALSE

The "Point color" and "Fill color" field settings cannot be configured and are inactive in Runtime.

The attribute can be assigned dynamic properties by means of the name
TrendExtendedColorSet. The data type is BOOLEAN.
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TrendFill property
Filled - TrendFill
Specifies if the area beneath the trend is to be filled.
Value

Explanation

TRUE

The area beneath the trend is shown filled. You can define the trend color as fill color if the "Advanced"
option is deactivated.
The text background is displayed in the trend color for the trend type "Values". The background color
of the control is used as text color.

FALSE

The trend is not visualized with fill color.

The attribute can be assigned dynamic properties by means of the name TrendFill. The data
type is BOOLEAN.

TrendFillColor property
Fill color - TrendFillColor
Specifies the fill color of the trend. The text fill color is specified for the trend type "Values".
The fill color is used if the "Filled" option is activated or "TrendFill" is "TRUE". Open the "Color
selection" dialog by clicking the button.
The configuration is only possible if the "Advanced" option is activated or
"TrendExtendedColorSet" is "TRUE".
The attribute can be assigned dynamic properties by means of the name TrendFillColor. The
data type is LONG.

TrendIndex property
TrendIndex
References a configured trend. Using this attribute you can assign the values of other attributes
to a specific trend. The index must always be set before you change the properties of a trend
in runtime.
Values between 0 and "TrendIndex" minus 1 are valid for "TrendCount". Attribute "TrendCount"
defines the number of trends configured.
The "TrendIndex" attribute can be assigned dynamic properties by means of attribute
TrendRepos. The data type is LONG.
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TrendLabel property
Label - TrendLabel
Defines the label of the trend selected. The label is displayed in Runtime if the value at attribute
"UseTrendNameAsLabel" is "FALSE".
The attribute can be assigned dynamic properties by means of the name TrendLabel. The data
type is STRING.

TrendLineStyle property
Line style - TrendLineStyle
Defines the line style for trend visualization.
The following settings are available:
Value

Description

Explanation

0

Solid

The trend is visualized as solid line.

1

Dashed

The trend is visualized as dashed line.

2

Dotted

The trend is visualized as dotted line.

3

Dash dot

The trend is visualized as dot-dash line.

4

Dash Dot Dot

The trend is visualized as dash-dot-dot line.

The attribute can be assigned dynamic properties by means of the name TrendLineStyle. The
data type is LONG.

TrendLineType property
Trend type - TrendLineType
Defines how to visualize a trend.
The following settings are available:
Value

Description

Explanation

0

None

Only the dots are displayed.

1

Connect dots
linearly

Visualizes a trend with linear interconnection of points.

2

Stepped

Visualizes a stepped trend and its interconnected points.

3

Values

Can only be configured with OnlineTrendControl.
A value is displayed at each time stamp or at the main grid line of the time axis instead of
trend points.

The attribute can be assigned dynamic properties by means of the name TrendLineType. The
data type is LONG.
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TrendLineWidth property
Line weight - TrendLineWidth
Defines the line weight of the line displayed.
The attribute can be assigned dynamic properties by means of the name TrendLineWidth. The
data type is LONG.

TrendLowerLimit property
TrendLowerLimit
Specifies the low limit of a tag. The values are identified based on the color set in
"TrendLowerLimitColor" if the tag value is less than "TrendLowerLimit". This setting is only
active if the value at attribute "TrendLowerLimitColoring" is "TRUE".
The attribute can be assigned dynamic properties by means of the name TrendLowerLimit.
The data type is DOUBLE.

TrendLowerLimitColor property
TrendLowerLimitColor
Specifies the color of tag values which are less than the value at "TrendLowerLimit". This
setting is only active if the value at attribute "TrendLowerLimitColoring" is "TRUE".
The attribute can be assigned dynamic properties by means of the name
TrendLowerLimitColor. The data type is LONG.

TrendLowerLimitColoring property
TrendLowerLimitColoring
Enables the "TrendLowerLimitColor" attribute for identifying tag values which are less than the
value at "TrendLowerLimitValue".
Value

Explanation

TRUE

Attribute "TrendLowerLimitColor" is active.

FALSE

Attribute "TrendLowerLimitColor" is inactive.

The attribute can be assigned dynamic properties by means of the name
TrendLowerLimitColoring. The data type is BOOLEAN.
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TrendMeasurePoints property
Number of measurement points - TrendMeasurePoints
Defines the number of measurement points for visualization of selected trends.
Defines the number of value pairs provided to the trend from a user archive.
The attribute can be assigned dynamic properties by means of the name
TrendMeasurePoints. The data type is LONG.

TrendName property
Object name - TrendName
Displays the name of the selected trend. The name is defined on the "Trends" tab.
The "TrendName" attribute can be assigned dynamic properties by means of attribute
TrendRename. The data type is STRING.

TrendPointColor property
Point color - TrendPointColor
Defines the color of trend points. Open the "Color selection" dialog by clicking the button.
The configuration is only possible if the "Advanced" option is activated or
"TrendExtendedColorSet" is "TRUE".
The attribute can be assigned dynamic properties by means of the name TrendPointColor.
The data type is LONG.

TrendPointStyle property
Dot type - TrendPointStyle
Defines the dot style for trend visualization.
The following settings are available:
Value

Description

Explanation

0

None

The dots are not displayed.

1

Dots

The trend dots are visualized with a size of one pixel. The setting in the "Dot width"
field is deactivated.

2

Squares

The dots are displayed as square. The setting in the "Dot width" field is active.

3

Circles

The dots are displayed as circles. The setting in the "Dot width" field is active.

The attribute can be assigned dynamic properties by means of the name TrendPointStyle. The
data type is LONG.
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TrendPointWidth property
Dot width - TrendPointWidth
Sets the dot width in pixels. You can only define the dot width for the "square" and "circular"
type.
The attribute can be assigned dynamic properties by means of the name TrendPointWidth.
The data type is LONG.

TrendProvider property
Data source - TrendProvider
Specifies the data source for a selected trend.
The following settings are available:
Value

Description

Explanation

0

None

No data source configured for implementation in Runtime by means of script.

1

Archive tags

Data source with archive tags of a process value archive.

2

Online tags

Data source with online tags derived from tag management.

3

User archive

Data source with columns of a user archive.

The attribute can be assigned dynamic properties by means of the name TrendProvider. The
data type is LONG.

TrendProviderCLSID_FunctionTrend property
TrendProviderCLSID_FunctionTrend
Indicates the data source of the trend selected.
Value

Explanation
No data source configured for implementation in Runtime by means of script.

{416A09D2-8B5A-11D28B81-006097A45D48}

Data source with archive tags of a process value archive.

{A3F69593-8AB0-11D2A440-00A0C9DBB64E}

Data source with online tags derived from tag management.

{2DC9B1C8-4FC1-41B1B354-3E469A13FBFD}

Data source with columns of a user archive.

The attribute can be assigned dynamic properties by means of the name
TrendProviderCLSID. The data type is STRING.
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TrendProviderCLSID_OnlineTrend property
TrendProviderCLSID_OnlineTrend
Indicates the data source of the trend selected.
Value

Explanation
No data source configured for implementation in Runtime by means of script.

{416A09D2-8B5A-11D28B81-006097A45D48}

Data source with archive tags of a process value archive.

{A3F69593-8AB0-11D2A440-00A0C9DBB64E}

Data source with online tags derived from tag management.

The attribute can be assigned dynamic properties by means of the name
TrendProviderCLSID. The data type is STRING.

TrendRangeType property
Time range setting - TrendRangeType
Defines the time range for providing data to the selected trend.
You can only define the number of measuring points if you select user archives as the data
source.
The following configuration options are available:
Value

Description

Explanation

0

Time range

Defines the start time and the time range for the data connection.

1

Start to end time

Defines the start and end time for the data connection.

2

Number of measurement points

Defines the start time and the number of measurement points for the data
connection.

The attribute can be assigned dynamic properties by means of the name TrendRangeType.
The data type is LONG.

TrendRemove property
Remove - TrendRemove
Removes selected trends from the list.
The attribute can be assigned dynamic properties by means of the name TrendRemove. The
data type is STRING.
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TrendRename property
TrendRename
Renames a trend which is referenced by means of "TrendIndex" attribute.
The attribute can be assigned dynamic properties by means of the name TrendRename.
"TrendRename" also sets a dynamic attribute "TrendName". The data type is STRING.

TrendRepos property
Up/Down - TrendRepos
Repositions the trend in the trend window. "Up" and "Down" move the selected trend up or
down in the list. This moves the trend towards the foreground or background for visualization
in Runtime.
The attribute can be assigned dynamic properties by means of the name TrendRepos. The
data type is LONG.

TrendSelectTagName property
TrendSelectTagName
Opens a dialog for selecting the tag name for the source of Y axis data in WinCC
OnlineTrendControl. Programmers can set this attribute to allow users to select a tag name
by means of a button, for example.
The attribute can be assigned dynamic properties by means of the name
TrendSelectTagName. The data type is BOOLEAN.

TrendSelectTagNameX property
TrendSelectTagNameX
Opens a dialog for selecting the tag name for the source of X axis data in WinCC
FunctionTrendControl. Programmers can set this attribute to allow users to select a tag name
by means of a button, for example.
The attribute can be assigned dynamic properties by means of the name
TrendSelectTagNameX. The data type is BOOLEAN.
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TrendSelectTagNameY property
TrendSelectTagNameY
Opens a dialog for selecting the tag name for the source of Y axis data in WinCC
FunctionTrendControl. Programmers can set this attribute to allow users to select a tag name
by means of a button, for example.
The attribute can be assigned dynamic properties by means of the name
TrendSelectTagNameY. The data type is BOOLEAN.

TrendState property
TrendState
Shows the status of the data link of the selected curve in Runtime.
The attribute can be made dynamic with the name TrendState. The data type is LONG.

TrendTagName property
Tag name - TrendTagName
Displays the name of connected tags. Use the Open button to open a dialog for selecting an
online or archive tag.
The attribute can be assigned dynamic properties by means of the name TrendTagName. The
data type is STRING.

TrendTagNameX property
Tag Name X / Column X - TrendTagNameX
Shows the name of interconnected tags or of the column for the X axis. Using the selection
button, select a tag or a column for the data source you configured.
The attribute can be assigned dynamic properties by means of the name TrendTagNameX.
The data type is STRING.

TrendTagNameY property
Tag Name Y / Column Y - TrendTagNameY
Shows the name of interconnected tags or of the column for the Y axis. Using the selection
button, select a tag or a column for the data source you configured.
The attribute can be assigned dynamic properties by means of the name TrendTagNameY.
The data type is STRING.
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TrendTimeAxis property
Time axis - TrendTimeAxis
Defines the time axis to be used for the trend selected. Define the available time axes in the
"Time axes" tab.
The attribute can be assigned dynamic properties by means of the name TrendTimeAxis. The
data type is STRING.

TrendTimeRangeBase property
Time Range - TrendTimeRangeBase
Defines the time unit for calculating the time range.
The following time units are available:
Value

Description

500

500 ms

1000

1 second

60000

1 minute

3600000

1 hour

86400000

1 day

The attribute can be assigned dynamic properties by means of the name
TrendTimeRangeBase. The data type is LONG.

TrendTimeRangeFactor property
Time range - TrendTimeRangeFactor
Defines the factor for calculating the time range. Only integer factors are valid.
The attribute can be assigned dynamic properties by means of the name
TrendTimeRangeFactor. The data type is SHORT.

TrendTrendWindow property
Trend window - TrendTrendWindow
Defines the trend window for visualizing the trend selected. Define the available trend windows
in the "Trend window" tab.
The attribute can be assigned dynamic properties by means of the name
TrendTrendWindow. The data type is STRING.
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TrendUncertainColor property
TrendUncertainColor
Value are in uncertain state if the initial value is unknown after runtime has been activated, or
if a substitute value is used. Set attribute "TrendUncertainColor" to define the color identifier
of these values. The "TrendUncertainColoring" attribute determines whether or not this setting
is evaluated.
The attribute can be assigned dynamic properties by means of the name
TrendUncertainColor. The data type is LONG.

TrendUncertainColoring property
TrendUncertainColoring
Value are in uncertain state if the initial value is unknown after runtime has been activated, or
if a substitute value is used. The "TrendUncertainColoring" attribute is used to enable
identification of such values based on the color set in "TrendUncertainColor".
Value

Explanation

TRUE

The settings of the "TrendUncertainColor" attribute are active.

FALSE

The settings of the "TrendUncertainColor" attribute are inactive.

The attribute can be assigned dynamic properties by means of the name
TrendUncertainColoring. The data type is BOOLEAN.

TrendUpperLimit property
TrendUpperLimit
Specifies the high limit of a tag. The values are identified based on the color set in
"TrendUpperLimitColor" if the tag value exceeds the "TrendUpperLimit". This setting is only
active if the value at attribute "TrendUpperLimitColoring" is "TRUE".
The attribute can be assigned dynamic properties by means of the name TrendUpperLimit.
The data type is DOUBLE.

TrendUpperLimitColor property
TrendUpperLimitColor
Specifies the color of tag values which are less than the value at "TrendLowerLimit". This
setting is only active if the value at attribute "TrendUpperLimitColoring" is "TRUE".
The attribute can be assigned dynamic properties by means of the name
TrendUpperLimitColor. The data type is LONG.
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TrendUpperLimitColoring property
TrendUpperLimitColoring
Enables the "TrendUpperLimitColor" attribute for identifying tag values which are less than the
value at "TrendUpperLimit".
Value

Explanation

TRUE

The setting of the "TrendUpperLimitColor" attribute is active.

FALSE

The setting of the "TrendUpperLimitColor" attribute is inactive.

The attribute can be assigned dynamic properties by means of the name
TrendUpperLimitColoring. The data type is BOOLEAN.

TrendValueAlignment property
Alignment - TrendValueAlignment
Specifies the alignment of the displayed values for the trend type "Values".
The following settings are available depending on the writing direction of the trend:
● The writing direction of the trend is "from right" or "from left"
Value

Description

Explanation

0

Bottom

The values are displayed at the bottom in the trend window.

1

Centered

The values are displayed centered in the trend window.

2

Top

The values are displayed at the top in the trend window.

● The writing direction of the trend is "from top" or "from bottom"
Value

Description

Explanation

0

Left

The values are displayed on the left in the trend window.

1

Centered

The values are displayed centered in the trend window.

2

Right

The values are displayed on the right in the trend window.

The attribute can be assigned dynamic properties by means of the name
TrendValueAlignment. The data type is LONG.

TrendValueAxis property
Value axis - TrendValueAxis
Defines the value axis to be used for the trend selected. Define the available value axes in the
"Value axes" tab.
The attribute can be assigned dynamic properties by means of the name TrendValueAxis. The
data type is STRING.
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TrendValueUnit property
Unit - TrendValueUnit
Specifies a unit for the trend type "Values" that is appended to the displayed value, e.g., "%"
or "°C".
The attribute can be assigned dynamic properties by means of the name TrendValueUnit. The
data type is STRING.

TrendVisible property
Trends - TrendVisible
The list shows all trends you created.
Select the trends to be displayed in the trend window from the list.
Click a trend entry in the list to adapt the properties and to assign axes and trend windows to
the trend.
The attribute can be assigned dynamic properties by means of the name TrendVisible. The
data type is BOOLEAN.

TrendXAxis property
X axis - TrendXAxis
Defines the X axis to be used for the trend selected. Define the available X axes inn the "X
Axes" tab.
The attribute can be assigned dynamic properties by means of the name TrendXAxis. The
data type is STRING.

TrendYAxis property
Y axis - TrendYAxis
Defines the Y axis to be used for the trend selected. Define the available Y axes inn the "Y
Axes" tab.
The attribute can be assigned dynamic properties by means of the name TrendYAxis. The
data type is STRING.
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TrendWindow
TrendWindowAdd property
New - TrendWindowAdd
Creates a new trend window.
The attribute can be assigned dynamic properties by means of the name TrendWindowAdd.
The data type is STRING.

TrendWindowCoarseGrid property
Main grid lines - TrendWindowCoarseGrid
Enables the display of grid lines for the main scale.
Value

Explanation

TRUE

Enables the display of grid lines for the main scale.

FALSE

Disables the display of grid lines for the main scale.

The attribute can be assigned dynamic properties by means of the name
TrendWindowCoarseGrid. The data type is BOOLEAN.

TrendWindowCoarseGridColor property
Color of main scale - TrendWindowCoarseGridColor
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the
button.
The attribute can be assigned dynamic properties by means of the name
TrendWindowCoarseGridColor. The data type is LONG.

TrendWindowCount property
TrendWindowCount
Defines the number of configured trend views.
The attribute can be assigned dynamic properties by means of the name
TrendWindowCount. The data type is LONG.
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TrendWindowFineGrid property
Secondary grid lines - TrendWindowFineGrid
Enables the display of grid lines for the secondary scale.
Value

Explanation

TRUE

Enables the display of grid lines for the secondary scale.

FALSE

Disables the display of grid lines for the secondary scale.

The attribute can be assigned dynamic properties by means of the name
TrendWindowFineGrid. The data type is BOOLEAN.

TrendWindowFineGridColor property
Color of secondary scale - TrendWindowFineGridColor
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the
button.
The attribute can be assigned dynamic properties by means of the name
TrendWindowFineGridColor. The data type is LONG.

TrendWindowForegroundTrendGrid property
Only for foreground trend - TrendWindowForegroundTrendGrid
Enables the display of grid lines only for the foreground trend in the trend window.
Value

Explanation

TRUE

Enables the display of grid lines for the foreground trend in the trend window.

FALSE

Enables the display of grid lines for all trends in the trend window.

The attribute can be assigned dynamic properties by means of the name
TrendWindowForegroundTrendGrid. The data type is BOOLEAN.

TrendWindowGridInTrendColor property
Use trend color - TrendWindowGridInTrendColor
Sets the trend color for the visualization of the grid lines for the main scale.
Value

Explanation

TRUE

The grid is displayed in the trend color.

FALSE

The grid is displayed with the color set in the "Color" field.
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The attribute can be assigned dynamic properties by means of the name
TrendWindowGridInTrendColor. The data type is BOOLEAN.

TrendWindowHorizontalGrid property
For X axis - TrendWindowVerticalGrid
Enables the display of horizontal grid lines.
Value

Explanation

TRUE

The display of horizontal grid lines is enabled.

FALSE

The display of horizontal grid lines is disabled.

The attribute can be assigned dynamic properties by means of the name
TrendWindowHorizontalGrid. The data type is BOOLEAN.

TrendWindowIndex property
TrendWindowIndex
References a configured trend view. Using this attribute you can assign the values of other
attributes to a specific trend view.
Values between 0 and "TrendWindowIndex" minus 1 are valid for "TrendWindowCount".
Attribute "TrendWindowCount" defines the number of trend views configured.
The "TrendWindowIndex" attribute can be assigned dynamic properties by means of attribute
TrendWindowRepos. The data type is LONG.

TrendWindowName property
Object name - TrendWindowName
Defines the name of the trend window selected.
The "TrendWindowName" attribute can be assigned dynamic properties by means of attribute
TrendWindowRename. The data type is STRING.

TrendWindowRemove property
Remove - TrendWindowRemove
Removes the selected trend window from the list.
The attribute can be assigned dynamic properties by means of the name
TrendWindowRemove. The data type is STRING.
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TrendWindowRename property
TrendWindowRename
Renames a trend view which is referenced by means of "TrendWindowIndex" attribute.
The attribute can be assigned dynamic properties by means of the name
TrendWIndowRename. "TrendWindowRename" also sets a dynamic attribute
"TrendWindowName". The data type is STRING.

TrendWindowRepos property
Up/Down - TrendWindowRepos
Changes the sorting order of the trend windows. "Up" and "Down" move the selected trend up
or down in the list.
The sorting order in the list defines the position in the Control. The first trend window is
displayed at the last position, while the last is displayed at the top position.
The attribute can be assigned dynamic properties by means of the name
TrendWindowRepos. The data type is LONG.

TrendWindowRulerColor property
Ruler color - TrendWindowRulerColor
Specifies the ruler color. Open the "Color selection" dialog by clicking the button.
The color can be configured and displayed if "1 - graphic" is set for display of the ruler or
"TrendWindowRulerStyle".
The attribute can be assigned dynamic properties by means of the name
TrendWindowRulerColor. The data type is LONG.

TrendWindowRulerLayer property
Ruler layer - TrendWindowRulerLayer
Defines the representation layer of a ruler in the trend window.
The following settings are available:
Value

Description

Explanation

0

Under grid

The ruler is visualized on a layer under the grid.

1

Between grid and trend

The ruler is positioned on top of the trend and under the grid.

2

On top of trend

The ruler is positioned on top of the trend.
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The attribute can be assigned dynamic properties by means of the name
TrendWindowRulerLayer. The data type is LONG.

TrendWindowRulerStyle property
Ruler - TrendWindowRulerStyle
Defines the appearance of the ruler.
The following settings are available:
Value

Description

Explanation

0

Simple

The ruler is displayed as basic black line.

1

Graphic

The ruler is displayed based on the "color" and "weight" configured.

The attribute can be assigned dynamic properties by means of the name
TrendWindowRulerStyle. The data type is LONG.

TrendWindowRulerWidth property
Ruler width - TrendWindowRulerWidth
Defines the width of the ruler in pixels.
The width can be configured and displayed if "1 - graphic" is set for display of the ruler or
"TrendWindowRulerStyle".
The attribute can be assigned dynamic properties by means of the name
TrendWindowRulerWidth. The data type is LONG.

TrendWindowSpacePortion property
Proportional area - TrendWindowSpacePortion
Specifies the proportion of the trend widow to be used for the selected curve.
The attribute can be assigned dynamic properties by means of the name
TrendWindowSpacePortion. The data type is LONG.

TrendWindowStatisticRulerColor property
Color of ruler for statistics area - TrendWindowStatisticRulerColor
Specifies the color of the ruler for the statistics area. The button opens the "Color selection"
dialog to select the color.
The color can be configured and displayed if "1 - graphic" is set for display of the ruler for the
statistics area or "TrendWindowStatisticRulerStyle".
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The attribute can be assigned dynamic properties by means of the name
TrendWindowStatisticRulerColor. The data type is LONG.

TrendWindowStatisticRulerStyle property
Ruler for statistics area - TrendWindowStatisticRulerStyle
Enables the display of a ruler for defining the statistics area.
The following settings are available:
Value

Description

Explanation

0

Simple

The ruler is displayed as basic black line.

1

Graphic

The ruler is displayed based on the "color" and "weight" configured.

The attribute can be assigned dynamic properties by means of the name
TrendWindowStatisticRulerStyle. The data type is LONG.

TrendWindowStatisticRulerWidth property
Width of ruler for statistics area - TrendWindowStatisticRulerWidth
Defines the width of the ruler for the statistics area in pixels.
The width of the ruler can be configured and displayed if "1 - graphic" is set for display of the
ruler for the statistics area or "TrendWindowStatisticRulerStyle".
The attribute can be assigned dynamic properties by means of the name
TrendWindowStatisticRulerWidth. The data type is LONG.

TrendWindowVerticalGrid property
for Y axis - TrendWindowVerticalGrid
Enables the display of vertical grid lines.
Value

Explanation

TRUE

The display of vertical grid lines is enabled.

FALSE

The display of vertical grid lines is disabled.

The attribute can be assigned dynamic properties by means of the name
TrendWindowVerticalGrid. The data type is BOOLEAN.
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TrendWindowVisible property
Trend window - TimeAxisTrendWindow
The list shows all trend windows you created.
Select the trend windows to be displayed in the control from the list.
Click a list entry to adapt the ruler and grid line properties.
The attribute can be assigned dynamic properties by means of the name
TrendWindowVisible. The data type is BOOLEAN.

3.10.6.17 U
UseColumnBackColor property
Use column color / background - UseColumnBackColor
Specifies the settings to be activated for the background colors of columns.
Value

Explanation

TRUE

The background color settings are active in the "Time columns" or "TimeColumnBackColor" tabs and in the
"Value columns" or "ValueColumnBackColor" tabs.

FALSE

The background color settings are active in the "Display" tab.

The attribute can be assigned dynamic properties by means of the name
UseColumnBackColors. The data type is BOOLEAN.

UseColumnForeColor property
Use column color / font - UseColumnForeColor
Defines the active font color settings for the columns.
Value

Explanation

TRUE

The font color color settings are active in the "Time columns" or "TimeColumnForeColor" tabs and in the "Value
columns" or "ValueColumnForeColor" tabs.

FALSE

The font color settings are active in the "Display" tab.

The attribute can be assigned dynamic properties by means of the name
UseColumnForeColors. The data type is BOOLEAN.
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UseMessageColor property
Show message colors - UseMessageColor
Sets the outputs of messages with colors as agreed by handshake.
Value

Explanation

TRUE

The message colors are displayed.

FALSE

The message colors are not displayed. Instead, the color settings defined for the table content are activated
on the "Display" tab.

The attribute can be assigned dynamic properties by means of the name UseMessageColor.
The data type is BOOLEAN.

UseSelectedTitleColor property
Selection color - UseSelectedTitleColor
Specifies whether to use a selection color for the headers of selected table cells.
Value

Explanation

TRUE

A selection color is used. The "Background" or "SelectedTitleColor" and "Font" or "SelectedTitleForeColor"
settings are active in Runtime.

FALSE

Selection color is not used. The "Background" and "Font" settings are disabled in Runtime.

The attribute can be assigned dynamic properties by means of the name
UseSelectedTitleColor. The data type is BOOLEAN.

UseSourceBackColors property
Apply background colors - UseSourceBackColors
Sets the background color derived from the control defined in the "Source" field.
Value

Explanation

TRUE

The background color from the interconnected control is used.

FALSE

The background color from the interconnected control is not used. The settings on the "Layout" tab are used.

The attribute can be assigned dynamic properties by means of the name
UseSourceBackColors. The data type is BOOLEAN.
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UseSourceForeColors property
Apply font colors - UseSourceForeColors
Sets the font colors derived from the control defined in the "Source" field.
Value

Explanation

TRUE

The font color of the interconnected control is activated.

FALSE

The font color from the connected control is not used. The settings on the "Layout" tab are used.

The attribute can be assigned dynamic properties by means of the name
UseSourceForeColors. The data type is BOOLEAN.

UseTableColor2 property
Row Color 2 - UseTableColor2
Specifies whether to use a second row color for the representation of the table.
Value

Explanation

TRUE

"Row color 2" and "Row color 1" are used alternately.

FALSE

The "Row color 1" settings are used for all rows.

The attribute can be assigned dynamic properties by means of the name UseTableColor2.
The data type is BOOLEAN.

UseTrendNameAsLabel property
UseTrendNameAsLabel
Sets the "TrendName" or "TrendLabel" attribute for labeling the trend in Runtime.
Value

Explanation

TRUE

Sets the "TrendName" attribute for labeling the trend in Runtime.

FALSE

Sets the "TrendLabel" attribute for labeling the trend in Runtime.

The attribute can be assigned dynamic properties by means of the name
UseTrendNameAsLabel. The data type is BOOLEAN.
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3.10.6.18 V
ValueAxis
ValueAxisAdd property
New - ValueAxisAdd
Creates a new value axis.
The attribute can be assigned dynamic properties by means of the name ValueAxisAdd. The
data type is STRING.

ValueAxisAlign property
Alignment - ValueAxisAlign
Specifies the mode of alignment of a selected value axis.
The following settings are available:
Value

Description

Explanation

0

left

The value axis selected is displayed on left side of the trend.

1

right

The value axis selected is displayed on right side of the trend.

The attribute can be assigned dynamic properties by means of the name ValueAxisAlign. The
data type is LONG.

ValueAxisAutoPrecisions property
Decimal places automatic - ValueAxisAutoPrecisions
Enables automatic setting of the decimal precision.
Value

Explanation

TRUE

The decimal precision is defined automatically. The value in the "Decimal places" or
"ValueAxisPrecisions" field is disabled.

FALSE

The value in the "Decimal places" or "ValueAxisPrecisions" field is active.

The attribute can be assigned dynamic properties by means of the name
ValueAxisAutoPrecisions. The data type is BOOLEAN.
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ValueAxisAutoRange property
Value range automatic - ValueAxisAutoRange
Enables automatic calculation of the range of values.
Value

Explanation

TRUE

The range of values is calculated automatically.

FALSE

The range of values is calculated based on the values configured in the "from" and "to" or
"ValueAxisBeginValue" and "ValueAxisEndValue" fields.

The attribute can be assigned dynamic properties by means of the name
ValueAxisAutoRange. The data type is BOOLEAN.

ValueAxisBeginValue property
Value range from - ValueAxisBeginValue
Specifies the start value of the value axis selected. You can configure the value if the
"Automatic" option is disabled or "ValueAxisAutoRange" is "FALSE".
The attribute can be assigned dynamic properties by means of the name
ValueAxisBeginValue. The data type is DOUBLE.

ValueAxisColor property
Value axis color - ValueAxisColor
Specifies the color of the time axis. The button opens the "Color selection" dialog to select the
color.
The setting is only active if the "Use trend color" option is disabled or if "ValueAxisInTrendColor"
is "FALSE".
The attribute can be assigned dynamic properties by means of the name ValueAxisColor. The
data type is LONG.

ValueAxisCount property
ValueAxisCount
Defines the number of value axes configured.
The attribute can be assigned dynamic properties by means of the name ValueAxisCount. The
data type is LONG.
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ValueAxisEndValue property
Value range to - ValueAxisEndValue
Specifies the end value of the value axis selected. You can configure the value if the
"Automatic" option is disabled or "ValueAxisAutoRange" is "FALSE".
The attribute can be assigned dynamic properties by means of the name
ValueAxisEndValue. The data type is DOUBLE.

ValueAxisExponentialFormat property
Exponential notation - ValueAxisExponentialFormat
Sets exponential notation for the display of values of a value axis selected.
Value

Explanation

TRUE

The values are displayed with exponential notation.

FALSE

The values are displayed with decimal notation.

The attribute can be assigned dynamic properties by means of the name
ValueAxisExponentialFormat. The data type is BOOLEAN.

ValueAxisIndex property
ValueAxisIndex
References a value axis. Using this attribute you can assign the values of other attributes to
a specific value axis.
Values between 0 and "ValueAxisCount" minus 1 are valid for "ValueAxisIndex". Attribute
"ValueAxisCount" defines the number of value axes configured.
The "ValueAxisIndex" attribute can be assigned dynamic properties by means of attribute
ValueAxisRepos. The data type is LONG.

ValueAxisInTrendColor property
Use trend color - ValueAxisInTrendColor
Sets the trend color for displaying the value axis selected. The color of the first trend is activated
if several trends are displayed in the trend window. Define the order of trends on the "Trends"
tab.
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Value

Explanation

TRUE

The selected value axis is displayed in the trend color. The setting in the "Color" or "ValueAxisColor" field is
disabled.

FALSE

The value axis selected is displayed in the color set in the "Color" or "ValueAxisColor" field.

The attribute can be assigned dynamic properties by means of the name
ValueAxisInTrendColor. The data type is BOOLEAN.

ValueAxisLabel property
Label - ValueAxisLabel
Specifies the label of a value axis selected.
The attribute can be assigned dynamic properties by means of the name ValueAxisLabel. The
data type is STRING.

ValueAxisName property
Object name - ValueAxisName
Specifies the name of a value axis selected.
The "ValueAxisName" attribute can be assigned dynamic properties by means of attribute
ValueAxisRename. The data type is STRING.

ValueAxisPrecisions property
Decimal places - ValueAxisPrecisions
Specifies the decimal precision for displaying the value axis selected. The value can be
configured and is active in Runtime, if the "Automatic" option is disabled or
"ValueAxisAutoPrecisions" is "FALSE".
The attribute can be assigned dynamic properties by means of the name
ValueAxisPrecisions. The data type is SHORT.

ValueAxisRemove property
Remove - ValueAxisRemove
Removes the selected value axis from the list.
The attribute can be assigned dynamic properties by means of the name ValueAxisRemove.
The data type is STRING.
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ValueAxisRename property
ValueAxisRename
Renames a value axis which is referenced by means of "ValueAxisIndex" attribute.
The attribute can be assigned dynamic properties by means of the name ValueAxisRename.
"ValueAxisRename" also sets a dynamic attribute "ValueAxisName". The data type is STRING.

ValueAxisRepos property
Up/Down - ValueAxisRepos
Changes the order of value axes. "Up" and "Down" move the value axis selected up or down
in the list.
The list order determines the value axis position in the trend window. The axis output position
is moved away from the trend if the value axis is moved further up in the list and the orientation
is the same.
The attribute can be assigned dynamic properties by means of the name ValueAxisRepos .
The data type is LONG.

ValueAxisScalingType property
Scaling - ValueAxisScalingType
Specifies the scaling mode for a selected value axis.
The following settings are available:
Value

Description

Explanation

0

Linear

Enables linear scaling of a value axis selected.

1

Logarithmic

Enables logarithmic scaling of a value axis selected.

2

Logarithmically negated

Enables scaling of a selected value value axis with logarithmic negation.

The attribute can be assigned dynamic properties by means of the name
ValueAxisScalingType. The data type is LONG.

ValueAxisTrendWindow property
Trend window - ValueAxisTrendWindow
Specifies the trend window for displaying the value axis selected. Define the available trend
windows in the "Trend window" tab.
The attribute can be assigned dynamic properties by means of the name
ValueAxisTrendWindow. The data type is STRING.
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ValueAxisVisible property
Value axes - ValueAxisVisible
The list shows all value axes you created. Click a value axis entry in the list to adapt the
properties and to assign the value axis to a trend window.
Activate the value axes to be displayed in the trend windows in the list.
The attribute can be assigned dynamic properties by means of the name ValueAxisVisible .
The data type is BOOLEAN.

ValueColumn
ValueColumnAdd property
New - ValueColumnAdd
Creates a new value column.
The attribute can be assigned dynamic properties by means of the name ValueColumnAdd.
The data type is STRING.

ValueColumnAlign property
Alignment - ValueColumnAlign
Defines the mode of alignment of a selected value column.
The following settings are available:
Value

Description

Explanation

0

left

The selected value column is displayed on the left.

1

Centered

The selected value column is aligned to center.

2

right

The selected value column is displayed on the right.

The attribute can be assigned dynamic properties by means of the name ValueColumnAlign.
The data type is LONG.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

867

Creating Process Pictures
3.10 Object properties

ValueColumnAutoPrecisions property
Automatic - ValueColumnAutoPrecisions
Enables automatic setting of the decimal precision.
Value

Explanation

TRUE

The decimal precision is defined automatically. The value in the "Decimal places" or
"ValueColumnPrecisions" field is disabled.

FALSE

The value in the "Decimal places" or "ValueColumnPrecisions" field is active.

The attribute can be assigned dynamic properties by means of the name
ValueColumnAutoPrecisions. The data type is BOOLEAN.

ValueColumnBackColor property
Background color - ValueColumnBackColor
Specifies the background color of the value column selected. Use the button to open the "Color
selection" dialog.
The setting is only active if the "Background color" option is set or "UseColumnBackColor" is
"TRUE" in the "Use column color" field of the "General" tab.
The attribute can be assigned dynamic properties by means of the name
ValueColumnBackColor. The data type is LONG.

ValueColumnCaption property
Description - ValueColumnCaption
Defines the label of the value column selected.
The attribute can be assigned dynamic properties by means of the name
ValueColumnCaption. The data type is STRING.

ValueColumnCount property
ValueColumnCount
Defines the number of value columns configured.
The attribute can be assigned dynamic properties by means of the name ValueColumnCount.
The data type is LONG.
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ValueColumnExponentialFormat property
Exponential notation - ValueColumnExponentialFormat
Sets exponential notation for the display of values of a value column selected.
Value

Explanation

TRUE

Display with exponential notation.

FALSE

Display with decimal notation.

The attribute can be assigned dynamic properties by means of the name
ValueColumnExponentialFormat. The data type is BOOLEAN.

ValueColumnForeColor property
Font color - ValueColumnForeColor
Specifies the font color of the value column selected. Use the button to open the "Color
selection" dialog.
The setting is only active if the "Font color" option is set or "UseColumnForeColor" is "TRUE"
in the "Use column color" field of the "General" tab.
The attribute can be assigned dynamic properties by means of the name
ValueColumnForeColor. The data type is LONG.

ValueColumnHideText property
ValueColumnHideText
Sets text format for displaying the content of a value column.
Value

Explanation

TRUE

The content is not displayed in text format.

FALSE

The content is displayed in text format.

The attribute can be assigned dynamic properties by means of the name
ValueColumnHideText. The data type is BOOLEAN.
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ValueColumnHideTitleText property
ValueColumnHideTitleText
Sets text format for displaying the value column header.
Value

Explanation

TRUE

The header is not displayed in text format.

FALSE

The header is displayed in text format.

The attribute can be assigned dynamic properties by means of the name
ValueColumnHideTitleText. The data type is BOOLEAN.

ValueColumnIndex property
ValueColumnIndex
References a configured value column. Using this attribute you can assign the values of other
attributes to a specific value column.
Values between 0 and "ValueColumnCount" minus 1 are valid for "ValueColumnIndex".
Attribute "ValueColumnCount" defines the number of value columns configured.
The "ValueColumnIndex" attribute can be assigned dynamic properties by means of attribute
ValueColumnRepos. The data type is LONG.

ValueColumnLength property
Length in characters - ValueColumnLength
Specifies the width of a selected value column.
The attribute can be assigned dynamic properties by means of the name
ValueColumnLength. The data type is LONG.

ValueColumnName property
Object name - ValueColumnName
Specifies the name of a selected value column.
The "ValueColumnName" attribute can be assigned dynamic properties by means of attribute
ValueColumnRename. The data type is STRING.
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ValueColumnPrecisions property
Decimal places - ValueColumnPrecisions
Specifies the decimal precision for displaying the data of a value column selected. The value
can be entered if the "Automatic" option is disabled or "ValueColumnAutoPrecisions" is
"FALSE".
The attribute can be assigned dynamic properties by means of the name
ValueColumnPrecisions. The data type is SHORT.

ValueColumnProvider property
Data source - ValueColumnProvider
Specifies the data source for a selected value column.
The following settings are available:
Value

Description

Explanation

1

Archive tags

Data source with archive tags of a process value archive.

2

Online tags

Data source with online tags derived from tag management.

The attribute can be assigned dynamic properties by means of the name
ValueColumnProvider. The data type is LONG.

ValueColumnProviderCLSID property
ValueColumnProviderCLSID
Indicates the data source of the value column selected.
Value

Explanation

{416A09D2-8B5A-11D28B81-006097A45D48}

Data source with archive tags of a process value archive.

{A3F69593-8AB0-11D2A440-00A0C9DBB64E}

Data source with online tags derived from tag management.

The attribute can be assigned dynamic properties by means of the name
ValueColumnProviderCLSID. The data type is STRING.

ValueColumnRemove property
Remove - ValueColumnRemove
Removes the selected value column from the list.
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The attribute can be assigned dynamic properties by means of the name
ValueColumnRemove. The data type is STRING.

ValueColumnRename property
ValueColumnRename
Renames a value column which is referenced by means of "ValueColumnIndex" attribute.
The attribute can be assigned dynamic properties by means of the name
ValueColumnRename. "ValueColumnRename" also sets a dynamic attribute
"ValueColumnName". The data type is STRING.

ValueColumnRepos property
Up/Down - ValueColumnRepos
Changes the sorting order of the value columns. "Up" and "Down" move the value column
selected up or down in the list.
The sorting order in the list determines the order of value columns after the time column if
several value columns are assigned to the same time column. Higher positions of the value
column in the list moves it to closer proximity towards the time column.
You change the order of time columns and their assigned value columns in the "Time columns"
tab.
The attribute can be assigned dynamic properties by means of the name
ValueColumnRepos. The data type is LONG.

ValueColumnSelectTagName property
ValueColumnSelectTagName
Opens a dialog for selecting the tag name for the data source of the value column in WinCC
OnlineTableControl. Programmers can set this attribute to allow users to select a tag name by
means of a button, for example.
The attribute can be assigned dynamic properties by means of the name
ValueColumnSelectTagName. The data type is BOOLEAN.
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ValueColumnShowIcon property
ValueColumnShowIcon
Enables the display of value column contents as icon.
Value

Explanation

TRUE

The content is visualized as icon.

FALSE

The content is not visualized as icon.

The attribute can be assigned dynamic properties by means of the name
ValueColumnShowIcon. The data type is BOOLEAN.

ValueColumnShowTitleIcon property
ValueColumnShowTitleIcon
Enables display of the value column header as icon.
Value

Explanation

TRUE

The header is displayed as icon.

FALSE

The header is not displayed as icon.

The attribute can be assigned dynamic properties by means of the name
ValueColumnShowTitleIcon. The data type is BOOLEAN.

ValueColumnSort property
ValueColumnSort
Defines the sorting order of the value column referenced in "ValueColumnIndex" .
The following settings are available:
Value

Description

Explanation

0

No

No sorting

1

Ascending

Ascending order, starting at the lowest value.

2

Descending

Descending order, starting at the highest value.

The attribute can be assigned dynamic properties by means of the name ValueColumnSort .
The data type is LONG.
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ValueColumnSortIndex property
ValueColumnSortIndex
Defines the sorting order of the value column referenced in "ValueColumnIndex". The sorting
criterion is removed from "ValueColumnSort" if you set a "0" value..
The attribute can be assigned dynamic properties by means of the name
ValueColumnSortIndex. The data type is LONG.

ValueColumnState property
ValueColumnState
Displays the data connection status of a selected value column in Runtime.
The attribute can be assigned dynamic properties by means of the name ValueColumnState.
The data type is LONG.

ValueColumnTagName property
Tag name - ValueColumnTagName
Displays the name of connected tags. You can change the tag connection using the selection
button.
The attribute can be assigned dynamic properties by means of the name
ValueColumnTagName. The data type is STRING.

ValueColumnTimeColumn property
Time column - ValueColumnTimeColumn
Specifies the time column for displaying the value column selected. Define the available time
columns in the "Time columns" tab.
The attribute can be assigned dynamic properties by means of the name
ValueColumnTimeColumn. The data type is STRING.

ValueColumnVisible property
Value columns - ValueColumnVisible
The list shows all value columns you created. Click a value column entry in the list to adapt
the properties, to assign the value column, and to define the data connection.
Select the value columns to be displayed in the table from the list. Value columns are displayed
if interconnected with a time column.

874

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties
The attribute can be assigned dynamic properties by means of the name
ValueColumnVisible . The data type is BOOLEAN.

VerticalGridLines property
Vertical - VerticalGridLines
Enables the display of vertical dividers.
Value

Explanation

TRUE

Enables the displays of vertical dividers.

FALSE

Disables the display of vertical dividers.

The attribute can be assigned dynamic properties by means of the name VerticalGridLines.
The data type is BOOLEAN.

Foreground color (ForeColor)
Foreground color (ForeColor)
Specifies the foreground color of the icon in the "Color selection" dialog. The icon is displayed
in the foreground color if the "Shadow" and "Solid" foreground mode is set.
The attribute can be assigned dynamic properties by means of the name ForeColor. The data
type is LONG.

Foreground mode (SymbolAppearance)
Foreground mode (SymbolAppearance)
Specifies the appearance of the icon.
The following settings are available:
Value

Description

Comments

0

Original

The appearance of the icon corresponds to the multi-color representation in the
selection of the "Icons" tab.

1

Shadow

"Black" lines are maintained as contour lines. Elements of the symbols in other
colors are displayed as brightness grades of the current foreground color.

2

Solid

"Black" lines are maintained as contour lines. All icon elements of other colors are
assigned the color value of the current foreground color.

3

Outline

Lines of the color "Black" are maintained as contour lines. All the elements of the
symbol in other colors are assigned the color value of the current background color.

The attribute can be assigned dynamic properties by means of the name SymbolAppearance.
The data type is LONG.
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3.10.6.19 X/Y
X/YAxisAdd property
New - X/YAxisAdd
Creates a new X or Y axis.
The X axis attribute can be assigned dynamic properties by means of the name XAxisAdd .
The Y axis attribute can be assigned dynamic properties by means of the name YAxisAdd .
The data type is STRING.

X/YAxisAlign property
Alignment - X/YAxisAlign
Defines the alignment mode for a selected axis.
The following settings are available for the X axis:
Value

Description

Explanation

0

Bottom

The X axis selected is displayed below the trend.

1

Top

The X axis selected is displayed above the trend.

The X axis attribute can be assigned dynamic properties by means of the name XAxisAlign.
The data type is LONG.
The following settings are available for the Y axis:
Value

Description

Explanation

0

left

The X axis selected is displayed on left side of the trend.

1

right

The X axis selected is displayed on right side of the trend.

The Y axis attribute can be assigned dynamic properties by means of the name YAxisAlign.
The data type is LONG.

X/YAxisAutoPrecisions property
Decimal places automatic - X/YAxisAutoPrecisions
Enables automatic setting of the decimal precision.
Value

Explanation

TRUE

The number of decimal places is set automatically. The value in the "Decimal places" or "X/
YAxisPrecisions" field is disabled.

FALSE

The value in the "Decimal places" or "X/YAxisPrecisions" field is active.
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The X axis attribute can be assigned dynamic properties by means of the name
XAxisAutoPrecisions.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisAutoPrecisions.
The data type is BOOLEAN.

X/YAxisAutoRange property
Value range automatic - X/YAxisAutoRange
Enables automatic calculation of the value range of the axis selected.
Value

Explanation

TRUE

The range of values is calculated automatically.

FALSE

The range of values is calculated based on the values configured in the "from" and "to" or "X/YAxisBeginValue"
and "X/YAxisEndValue" fields.

The X axis attribute can be assigned dynamic properties by means of the name
XAxisAutoRange.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisAutoRange.
The data type is BOOLEAN.

X/YAxisBeginValue property
Value range from - X/YAxisBeginValue
Specifies the lower range of values of the axis selected. You can configure the value if the
"Automatic" option is disabled or "X/YAxisAutoRange" is "FALSE".
The X axis attribute can be assigned dynamic properties by means of the name
XAxisBeginValue.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisBeginValue.
The data type is DOUBLE.

X/YAxisColor property
Color XY axis - X/YAxisColor
Specifies the color of the axis selected. The button opens the "Color selection" dialog to select
the color.
The setting is only active if the "Use trend color" field is disabled or "X/YAxisInTrendColor" is
"FALSE".
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The X axis attribute can be assigned dynamic properties by means of the name XAxisColor.
The Y axis attribute can be assigned dynamic properties by means of the name YAxisColor.
The data type is LONG.

X/YAxisEndValue property
Value range to - X/YAxisEndValue
Specifies the upper range of values of the axis selected. You can configure the value if the
"Automatic" option is disabled or "X/YAxisAutoRange" is "FALSE".
The X axis attribute can be assigned dynamic properties by means of the name
XAxisEndValue.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisEndValue.
The data type is DOUBLE.

X/YAxisExponentialFormat property
Exponential notation - X/YAxisExponentialFormat
Enables the exponential notation for visualization of a selected axis.
Value

Explanation

TRUE

The values are displayed with exponential notation.

FALSE

The values are displayed with decimal notation.

The X axis attribute can be assigned dynamic properties by means of the name
XAxisExponentialFormat.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisExponentialFormat.
The data type is BOOLEAN.

X/YAxisInTrendColor property
Use trend color - X/YAxisInTrendColor
Enables the display of an axis selected in the trend color. The color of the first trend is activated
if several trends are displayed in the trend window. Define the order of trends on the "Trends"
tab.
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Value

Explanation

TRUE

The axis selected is displayed in the trend color. The setting in the "Color" or "X/YAxisColor" field is disabled.

FALSE

The axis selected is displayed in the color set in the "Color" or "X/YAxisColor" field.

The X axis attribute can be assigned dynamic properties by means of the name
XAxisInTrendColor.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisInTrendColor.
The data type is BOOLEAN.

X/YAxisLabel property
Label - X/YAxisLabel
Defines the label text for a selected axis.
The X axis attribute can be assigned dynamic properties by means of the name XAxisLabel.
The Y axis attribute can be assigned dynamic properties by means of the name YAxisLabel.
The data type is STRING.

X/YAxisName property
Object name - X/YAxisName
Specifies the name of a selected axis.
Attribute "XAxisName" can be assigned dynamic properties for the X axis by means of
XAxisRename attribute.
Attribute "YAxisName" can be assigned dynamic properties for the Y axis by means of
YAxisRename attribute.
The data type is STRING.

X/YAxisPrecisions property
Decimal places - X/YAxisPrecisions
Specifies the decimal precision for displaying the axis selected. The value can be configured
and is active in Runtime, if the "Automatic" option is disabled or "X/YAxisAutoPrecisions" is
"FALSE".
The X axis attribute can be assigned dynamic properties by means of the name
XAxisPrecisions.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisPrecisions.
The data type is SHORT.
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X/YAxisRemove property
Remove - X/YAxisRemove
Removes the selected axis from the list.
The X axis attribute can be assigned dynamic properties by means of the name
XAxisRemove .
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisRemove .
The data type is STRING.

X/YAxisRepos property
Up/Down - X/YAxisRepos
Changes the sorting order of the axes. "Up" and "Down" move the axis selected up or down
in the list.
The list order determines the axis position in the trend window. The axis output position is
moved away from the trend if the axis is moved further up in the list and the orientation is the
same.
The X axis attribute can be assigned dynamic properties by means of the name XAxisRepos .
The Y axis attribute can be assigned dynamic properties by means of the name YAxisRepos .
The data type is LONG.

X/YAxisScalingType property
Scaling - X/YAxisScalingType
Defines the scaling mode for a selected axis.
The following settings are available:
Value

Description

0

Linear

1

Logarithmic

2

Logarithmically negated

The X axis attribute can be assigned dynamic properties by means of the name
XAxisScalingType.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisScalingType.
The data type is LONG.
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X/YAxisTrendWindow property
Trend window - X/YAxisTrendWindow
Specifies the trend window for a selected axis. Define the available trend windows in the "Trend
window" tab.
The X axis attribute can be assigned dynamic properties by means of the name
XAxisTrendWindow.
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisTrendWindow.
The data type is STRING.

X/YAxisVisible property
X/Y axes - X/YAxisVisible
The list shows all axes you created. Click an axis entry in the list to adapt the properties and
to assign the axis to a trend window.
Activate the axes to be displayed in the trend windows in the list.
The X axis attribute can be assigned dynamic properties by means of the name
XAxisVisible .
The Y axis attribute can be assigned dynamic properties by means of the name
YAxisVisible .
The data type is BOOLEAN.

XAxisCount property
XAxisCount
Defines the number of X axes configured.
The attribute can be assigned dynamic properties by means of the name XAxisCount. The
data type is LONG.

XAxisIndex property
XAxisIndex
References a configured X axis. Using this attribute you can assign the values of other
attributes to a specific X axis.
Values between 0 and "XAxisCount" minus 1 are valid for "Index"; the attribute "XAxisCount"
defines the number of configured X axes.
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The "XAxisIndex" attribute can be assigned dynamic properties by means of attribute
XAxisRepos. The data type is LONG.

XAxisRename property
XAxisRename
Renames the X axis which is referenced by means of "XAxisIndex" attribute.
The attribute can be assigned dynamic properties by means of the name XAxisRename.
"XAxisRename" also sets a dynamic attribute "XAxisName". The data type is STRING.

YAxisCount property
YAxisCount
Defines the number of Y axes configured.
The attribute can be assigned dynamic properties by means of the name YAxisCount. The
data type is LONG.

YAxisIndex property
YAxisIndex
References a configured Y axis. Using this attribute you can assign the values of other
attributes to a specific Y axis.
Values between 0 and "YAxisCount" minus 1 are valid for "Index". Attribute "YAxisCount"
defines the number of configured Y axes.
The "YAxisIndex" attribute can be assigned dynamic properties by means of attribute
YAxisRepos. The data type is LONG.

YAxisRename property
YAxisRename
Renames the Y axis which is referenced by means of "YAxisIndex" attribute.
The attribute can be assigned dynamic properties by means of the name YAxisRename.
"YAxisRename" also sets a dynamic attribute "YAxisName". The data type is STRING.
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3.10.7

The "Display" property group

3.10.7.1

Display Options (DisplayOptions)
Display Options (DisplayOptions)
The "Display options" attribute defines what can be displayed in the object.

Picture or text

Either pictures or text can be displayed in the object.

Picture and text

Pictures and text can be displayed in the object.

Text only

Only text can be displayed in the object.

Picture only

Only pictures can be displayed in the object.

The "Display Options" attribute can be made dynamic with the name "DisplayOptions".

3.10.7.2

Global Shadow
Global Shadow (GlobalShadow)
The "Global shadow" attribute defines whether the object will be displayed with the shadowing
defined in the active design.

yes

Uses the global shadowing defined for this object type.

no

No shadowing.

The attribute "Global shadow" can be made dynamic with the name "GlobalShadow".

3.10.7.3

Global Color Scheme
Global Color Scheme (GlobalColorScheme)
The "Global color scheme" attribute defines whether the colors defined for the current design
in the global color scheme will be used for this object.

yes

Uses the colors from the global color scheme defined for this type of object.

no

Uses the colors from the color scheme defined for this type of object under "Colors".

The attribute "Global color scheme" can be made dynamic with the name
"GlobalColorScheme".

3.10.7.4

Object Transparency
Object Transparency (Transparency)
The "Transparency" attribute defines the percentage to which the object will become
transparent.

0 - 100
(integer)

Defines the percentage of transparency.
0 = no transparency; 100 = complete transparency (invisible)
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The text and fields of the graphic objects are only transparent at "100."
In runtime, a completely transparent object (invisible) is also functional.
The attribute "Transparency" can be made dynamic with the name "Transparency".

3.10.7.5

[V6.2] Windows Style
[V6.2] Windows Style (WindowsStyle)
The attribute "[V6.2] Windows Style" defines whether the object will be shown in Windows style
by WinCC version 6.2. It can only be selected if "WinCC Classic" is chosen as the current
design.

yes

Shows the object using the Windows style from WinCC version 6.2.

no

Shows the object not using the Windows style from WinCC version 6.2.

The "[V6.2] Windows style" attribute can be made dynamic with the name "WindowsStyle".

3.10.7.6

WinCC style
WinCC style (WinCCStyle)
The attribute "WinCC Style" defines the style in which the object will be displayed.

User-defined

Shows the object according to the respective settings.

Global

Shows the object in a globally defined design.

Windows Style

Shows the object in Windows style.

The attribute "WinCC Style" can be made dynamic with the name "WinCCStyle".

3.10.8

"Colors" Property Group

3.10.8.1

Colors - 3D to H

3D Border Color Top (BorderColorTop)
3D Border Color Top (BorderColorTop)
The "3D Border Color Top" attribute defines the color for the left and upper part of a 3D border.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "3D Border Color Top" attribute can be made dynamic with the name "BorderColorTop".

3D Border Color Bottom (BorderColorBottom)
3D Border Color Bottom (BorderColorBottom)
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The "3D Shadow Color" attribute defines the color for the right and lower part of a 3D border.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "3D Shadow Color" attribute can be made dynamic with the name "BorderColorBottom".

List Background Color (UnselBGColor)
List Background Color (UnselBGColor)
The "List Background Color" attribute defines for the "Text list" object the color with which the
entries not selected in the selection list of the background are displayed.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "List Background Color" attribute can be made dynamic with the name "UnselBGColor".

List Font Color (UnselTextColor)
List Font Color (UnselTextColor)
The "List Font Color" attribute defines for the "Text list" object the color with which the text not
selected in the selection list of the background is displayed.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "List Font Color" attribute can be made dynamic with the name "UnselTextColor".

Bar Color (BackColor2)
Bar Color (BackColor2)
The "Bar Color" attribute defines the color with which the current value is displayed for the
"Bar" object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Bar color" attribute can be made dynamic with the name "BackColor2".

Bar Background Color (BackColor3)
Bar Background Color (BackColor3)
The "Bar Background Color" attribute defines the color with which the background of the bar
is displayed for the "Bar" object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Bar background color" attribute can be made dynamic with the name "BackColor3".
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High Limit Color (HighLimitColor)
High Limit Color (HighLimitColor)
The "High Limit Color" attribute defines the color with which the upper or right arrow key is
displayed for the "Slider object" object. The position of the slider is set using the "Alignment"
attribute in the "Geometry" property group.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "High Limit Color" attribute can be made dynamic with the name "HighLimitColor".

Low Limit Color (LowLimitColor)
Low Limit Color (LowLimitColor)
The "Low Limit Color" attribute defines the color with which the lower or left arrow key is
displayed for the "Slider object" object. The position of the slider is set using the "Alignment"
attribute in the "Geometry" property group.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Low Limit Color" attribute can be made dynamic with the name "LowLimitColor".

Fill Pattern Color (FillColor)
Fill Pattern Color (FillColor)
The "Fill Pattern Color" attribute defines the color of the pattern that is displayed on the picture
background.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The selected color is only effective if the "Global color scheme" is set to "No" under "Display".
The "Fill Pattern Color" attribute can be made dynamic with the name "FillColor".

Fill Pattern Color (FillColor)
Fill Pattern Color (FillColor)
The "Fill Pattern Color" attribute defines the color of the pattern that is displayed on a filled
area.
The "Fill Pattern Color" attribute can be made dynamic with the name "FillColor".

Background Flash Color (BackColor)
Background Flash Color (BackColor)
The "Background Flash Color" attribute defines the color used to display the background of
the picture when flashing.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
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The "Background Flash Color" attribute can be made dynamic with the name "BackColor".

Background flashing fill color (OK, simulation) (BackFillColor)
Background flashing fill color (OK, simulation) (BackFillColor)
The "Background flashing fill color (OK, simulation)" attribute defines the background color of
the flashing picture.
Either define a permanent color directly in the "Color selection" dialog, or select an indexed
color from the central color palette if a central color palette is defined.
The "Background flashing fill color (OK, simulation)" attribute can be assigned dynamic
properties by means of the name "BackFillColor".

Background flashing fill pattern (OK, simulation) (BackFillStyle)
Background flashing fill pattern (OK, simulation) (BackFillStyle)
The "Background flashing fill pattern (OK, simulation)" attribute defines the background pattern
of the flashing picture.
There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern.
The "Background flashing fill pattern (OK, simulation)" attribute can be assigned dynamic
properties by means of the name "BackFillColor".

Background Color (BackColor)
Background Color (BackColor)
The "Background Color" attribute defines the color used to display the background.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The selected color is only effective if the "Global color scheme" is set to "No" under "Display".
The "Background Color" attribute can be made dynamic with the name "BackColor".

Background Color (BackColor)
Background Color (BackColor)
The "Background Color" attribute defines the color used to display a filled area.
The "Background Color" attribute can be made dynamic with the name "BackColor".

Background Color (OK) (BackColor_OK)
Background Color (OK) (BackColor_OK)
The "Background Color (OK)" attribute defines the color used to display the background with
the status "OK".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

887

Creating Process Pictures
3.10 Object properties
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Background Color (OK)" attribute can be made dynamic with the name "BackColor_OK".

Background Color (Simulation) (BackColor_Simulation)
Background Color (Simulation) (BackColor_Simulation)
The "Background Color (Simulation)" attribute defines the color used to display the background
with the status "Simulation".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Background Color (Simulation)" attribute can be made dynamic with the name
"BackColor_Simulation".

Background fill color (OK) (BackColor_OK)
Background fill color (OK) (BackColor_OK)
The "Background fill color (OK)" attribute defines the background color used to indicate the
"OK" state.
Either define a permanent color directly in the "Color selection" dialog, or select an indexed
color from the central color palette if a central color palette is defined.
The "Background fill color (OK)" attribute can be assigned dynamic properties by means of
the name "BackFillColor_OK".

Background fill color (simulation) (BackColor_Simulation)
Background fill color (simulation) (BackColor_Simulation)
The "Background fill color (simulation)" attribute defines the background color used to indicate
the active "Simulation" state.
Either define a permanent color directly in the "Color selection" dialog, or select an indexed
color from the central color palette if a central color palette is defined.
The "Background fill color (simulation)" attribute can be assigned dynamic properties by means
of the name "BackFillColor_Simulation".

Background fill pattern (OK) (BackColor_OK)
Background fill pattern (OK) (BackColor_OK)
The "Background fill pattern (OK)" attribute defines the background pattern used to indicate
the "OK" state.
There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern.
The "Background fill pattern (OK)" attribute can be assigned dynamic properties by means of
the name "BackFillStyle_OK".
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Background fill pattern (simulation) (BackColor_Simulation)
Background fill pattern (simulation) (BackColor_Simulation)
The "Background fill pattern (simulation)" attribute defines the background pattern used to
indicate the "Simulation" state.
There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern.
The "Background fill pattern (simulation)" attribute can be assigned dynamic properties by
means of the name "BackFillStyle_Simulation".

3.10.8.2

Colors - I to R

Button Color (ButtonColor)
Button Color (ButtonColor)
The "Button Color" attribute defines the color of a "Slider object" object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Button Color" attribute can be made dynamic with the name "ButtonColor".

Line Color (BorderColor)
Line Color (BorderColor)
The "Line Color" attribute defines the color for representation of a line.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Line Color" attribute can be made dynamic with the name "BorderColor".

Line Background Color (BorderBackColor)
Line background color (BorderBackColor)
The "Line Background Color" attribute defines the color used to display the background of a
broken line.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
In the WinCC Classic design, the background color is only visible when the line weight is "1".
With line weight of "2" or greater, the intermediate areas are shown as being transparent.
The "Line Background Color" attribute can be made dynamic with the name "BorderBackColor".

High Limit Background Color (BackColorTop)
High Limit Background Color (BackColorTop)
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The "High Limit Background Color" attribute defines the color with which the upper or right
area of the slide surface is displayed for the "Slider object" object. The range depends on the
"Alignment" attribute in the "Geometry" property group.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "High Limit Background Color" attribute can be made dynamic with the name
"BackColorTop".

Border Color (BorderColor)
Border Color (BorderColor)
The "Border Color" attribute defines the color for representation of a border line.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Border Color" attribute can be made dynamic with the name "BorderColor".

Border Background Color (BorderBackColor)
Border Background Color (BorderBackColor)
The "Border Background Color" attribute defines the color used to display the background of
a broken border line.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Border Background Color" attribute can be made dynamic with the name
"BorderBackColor".

Grid Color
Grid Color
The "Grid Color" attribute defines the color used to display the grid in the workspace of the
current picture.
The grid is a utility of the Graphics Designer which makes it easier to position objects in a
process picture precisely. The grid lines of the grid are symbolized by display of the intersection
points.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Grid Color" attribute cannot be made dynamic.

Grid Color with Quality Code: "bad" (PaintColor_QualityCodeBad)
Grid color for quality code: "bad" (PaintColor_QualityCodeBad)
The "Grid Color with Quality Code: "bad"" attribute defines the color that the grid will be shown
in when a poor status exists, e.g. if the connection to the server is broken.
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Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Grid Color with Quality Code: "bad"" attribute can be made dynamic with the name
"PaintColor_QualityCodeBad".

Grid Color with Quality Code: "uncertain" (PaintColor_QualityCodeUnCertain)
Grid color for quality code: "uncertain" (PaintColor_QualityCodeUnCertain)
The "Grid Color with Quality Code: "uncertain"" attribute defines the color that indicates that
the grid in an uncertain status.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Grid Color with Quality Code: "uncertain"" attribute can be made dynamic with the name
"PaintColor_QualityCodeUnCertain".

3.10.8.3

Colors - S to Z

Font Flash Color (ForeColor)
Font Flash Color (ForeColor)
The "Font Flash Color" attribute defines the color of a text when flashing. The flashing is only
visible in Runtime.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Flashing Text Color Off" attribute can be made dynamic with the name "ForeColor".

Font Color (ForeColor)
Font Color (ForeColor)
The "Font Color" attribute defines the color of the text in the object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The selected color is only effective if the "Global color scheme" is set to "No" under "Display".
The "Font Color" attribute can be made dynamic with the name "ForeColor".

Font Color (OK) (ForeColor_OK)
Font Color (OK) (ForeColor_OK)
The "Font Color (OK)" attribute defines the color in which the foreground is displayed with the
status "OK".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
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The "Font Color (OK)" attribute can be made dynamic with the name "ForeColor_OK".

Font Color (Simulation) (ForeColor_Simulation)
Font Color (Simulation) (ForeColor_Simulation)
The "Font Color (Simulation)" attribute defines the color in which the foreground is displayed
with the status "Simulation".
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Font Color (Simulation)" attribute can be made dynamic with the name
"ForeColor_Simulation".

Selection Background Color (SelBGColor)
Selection Background Color (SelBGColor)
The "Selection Background Color" attribute defines for the "Text list" object the color with which
the background of the entry selected in the selection list is displayed.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Selection Background Color" attribute can be made dynamic with the name "SelBGColor".

Selection Font Color (SelTextColor)
Selection Font Color (SelTextColor)
The "Selection Font Color" attribute defines for the "Text list" object the color with which the
text selected in the selection list of the background is displayed.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Selection Font Color" attribute can be made dynamic with the name "SelTextColor".

Scale Color (ScaleColor)
Scale Color (ScaleColor)
The "Scale Color" attribute defines the color with which the scale and the label are displayed
for the "Bar" object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Scale Color" attribute can be made dynamic with the name "ScaleColor".

Trend Color (TrendColor)
Trend Color (TrendColor)
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The "Trend Color" attribute defines the color with which the trend display is shown for the "Bar"
object. The trend display shows the tendency of the measured value in the form of a small
arrow at the lower end of the bar.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Trend Color" attribute can be made dynamic with the name "TrendColor".

Dividing Line Color (ItemBorderColor)
Dividing Line Color (ItemBorderColor)
The "Dividing Line Color" attribute defines the color with which the dividing line in the selection
list is displayed for the "Text list" object.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Dividing Line Color" attribute can be made dynamic with the name "ItemBorderColor".

Dividing Line Background Color (ItemBorderBackColor)
Dividing Line Background Color (ItemBorderBackColor)
The "Dividing Line Background Color" attribute defines for the "Text list" object the color with
which the background of a broken line in the selection list is displayed.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Dividing Line Background Color" attribute can be made dynamic with the name
"ItemBorderBackColor".

Low Limit Background Color (BackColorBottom)
Low Limit Background Color (BackColorBottom)
The "Low Limit Background Color" attribute defines the color with which the lower or left area
of the slide surface is displayed for the "Slider object" object. The range depends on the
"Alignment" attribute in the "Geometry" property group.
Either permanently define the color in the "Color selection" dialog or select an indexed color
from the central color palette if a central color palette is defined.
The "Low Limit Background Color" attribute can be made dynamic with the name
"BackColorBottom".

3.10.9

"Filling" Property Group

3.10.9.1

Dynamic Filling (Filling)
Dynamic Filling (Filling)

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

893

Creating Process Pictures
3.10 Object properties
The "Dynamic Filling" attribute specifies whether an object with a closed border line can be
filled.
Yes

The object can be filled.

No

The object cannot be filled.

The "Dynamic Filling" attribute can be made dynamic with the name "Filling".

3.10.9.2

Fill Level (FillingIndex)
Fill Level (FillingIndex)
The "Fill Level" attribute specifies the height up to which an object is filled. The value is entered
as a percentage, in relation to the object height.
The fill level is displayed according to the value of the "Background Color" attribute in the
"Colors" property group. The non-filled background is displayed as "transparent".

0% - 100%

The value can be chosen freely within the specified limits.

The "Fill Level" attribute can be made dynamic with the name "FillingIndex".

3.10.9.3

Filling direction (FillingDirection)
Filling direction (FillingDirection)
The "Filling direction" attribute specifies the filling direction for an object enclosed in a frame
line.

Bottom to top

The object is filled from bottom to top.

Top to bottom

The object is filled from top to bottom.

Left to right

The object is filled from left to right.

Right to left

The object is filled from right to left.

The attribute can be assigned dynamic properties by means of the name FillingDirection. The
data type is LONG.

3.10.10

"Geometry" Property Group

3.10.10.1 Geometry - A to B
Current Value X (ActualPointLeft)
Current Value X (ActualPointLeft)
The "Current Value X" attribute specifies the horizontal position of the currently selected corner.
The value stands in relation to the picture origin and specifies in pixels the distance of the
corner from the left picture border.
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The currently selected corner is uniquely determined by the "Index" attribute. In order to display
the current value X of another corner, the value of the "Index" attribute must be modified.
There is a free choice of value. A meaningful limit results from the picture size.
The "Current Value X" attribute can be made dynamic with the name "ActualPointLeft".

Current Value Y (ActualPointTop)
Current Value Y (ActualPointTop)
The "Current Value Y" attribute specifies the vertical position of the currently selected corner.
The value stands in relation to the picture origin and specifies in pixels the distance of the
corner from the top picture border.
The currently selected corner is uniquely determined by the "Index" attribute. In order to display
the current value Y of another corner, the value of the "Index" attribute must be modified.
The value can be selected. A useful limit is determined by the picture size.
The "Current Value Y" attribute can be made dynamic with the name "ActualPointTop".

Alpha (AngleAlpha)
Alpha (AngleAlpha)
The "Alpha" attribute specifies the depth angle Alpha for the 3D display of the right side of a
3D bar. The values are specified in degrees.
0° - 90°

There is a free choice of value for the depth angle Alpha within the specified limits.

The "Alpha" attribute can be made dynamic with the name "AngleAlpha".

Start Angle (StartAngle)
Start Angle (StartAngle)
For segment or arc objects, the "Start Angle" attribute specifies the angle by which the starting
point of the object deviates from the zero position (0°). The values are specified in degrees.
The start angle can be chosen freely. A meaningful limit results from the definition of a circle.
The "Start Angle" attribute can be made dynamic with the name "StartAngle".

Number of Corners (PointCount)
Number of Corners (PointCount)
The "Number of Corners" specifies the total number of corners for the selected object. The
minimum number of three corners is given.
Changing the "Number of Corners" attribute has the following effects:
Increasing the number: All new corners are placed on the corner with the highest value for the
"Index" attribute. The exact position can be set by dragging with the mouse or changing the
individual position values.
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Reducing the number: All corners are removed for which the value of the "Index" attribute is
higher than the new number of corners.
There is a free choice of value. The minimum number of corners is 3.
The "Number of Corners" attribute can be assigned dynamic properties with the name
"PointCount".

Number of Boxes (BoxCount)
Number of Boxes (BoxCount)
The "Number of Boxes" specifies the total number of boxes for the selected object. For each
object, a maximum number of 32 boxes can be set.
At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value
for the "Index" attribute in the "Font" property group. Changing the value can have the following
effects:
● Increasing the number: New fields are inserted under the field with the highest value in the
"Index" attribute. The standard labeling of the new box can be changed using the "Text"
attribute in the "Font" property group.
● Reducing the number: All fields are removed for which the value of the "Index" attribute is
higher than the new number.
1 - 32

There is a free choice of value within the specified value range.

The "Number of Boxes" attribute can be made dynamic with the name "BoxCount".

Number of rows
Number of rows
The "Number of rows" attribute defines the number of text lines for a combination field and a
list field. You can define a maximum of 100,000 lines.
At the same time, the value of the "Number of rows" attribute specifies the upper limit value
for the "Index" attribute in the "Font" property group. Changing the value can have the following
effects:
● Increasing the number: New lines are added at the bottom. The standard labeling of the
new filed can be changed using the "Text" attribute in the "Font" property group.
● Reducing the number: All lines are removed for which the value of the "Index" attribute is
higher than the new number.
1 - 100 000

There is a free choice of value within the specified value range.

The attribute can be made dynamic with the name "NumberLines".

Alignment (Direction)
Alignment (Direction)
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The "Alignment" attribute defines for the "Slider" object whether the movement of the slider is
in a horizontal or vertical direction.
Horizontal

The movement of the slider is in horizontal direction.

Vertical

The movement of the slider is in vertical direction.

The "Alignment" attribute can be made dynamic with the name "Direction".

Bar Width (BarWidth)
Bar Width (BarWidth)
The "Bar Width" attribute defines for 3D bars the distance between the vertical limitation lines
of the front bar area. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the object size.
=0

The representation of the 3D bar is reduced to a vertical line.

The "Bar Width" attribute can be made dynamic with the name "BarWidth".

Bar Height (BarHeight)
Bar Height (BarHeight)
The "Bar Height" attribute defines for 3D bars the distance between the horizontal limitation
lines of the front bar area. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the object size.
=0

The representation of the 3D bar is reduced to a horizontal line.

The "Bar Height" attribute can be made dynamic with the name "BarHeight".

Bar Direction (Direction)
Bar Direction (Direction)
The "Bar Direction" attribute specifies for the "Bar" object the direction of the coordinate axis
in which the highest display value of the bar points.
Up

The highest display value of the bar points upwards.

Down

The highest display value of the bar points downwards (negative direction).

Left

The highest display value of the bar points to the left (negative direction).

Right

The highest display value of the bar points to the right.

The "Bar Direction" attribute can be made dynamic with the name "Direction".

Bar Direction (Direction)
Bar Direction (Direction)
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The "Bar Direction" attribute specifies for the "3D bar" object whether the highest display value
of the bar points in the positive or negative direction of the coordinate axis. The position of the
3D bar in the coordinate system is specified using the "Display Axis" attribute.
Positive

The highest display value of the 3D bar points towards the positive coordinate axis.

Negative

The highest display value of the 3D bar points towards the negative coordinate axis.

The "Bar Direction" attribute can be made dynamic with the name "Direction".

Bar Depth (BarDepth)
Bar Depth (BarDepth)
The "Bar Depth" attribute defines for the 3D bar the length of the oblique lines for the depth
display. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the object size.
=0

The representation of the 3D bar appears in two dimensions.

The "Bar Depth" attribute can be made dynamic with the name "BarDepth".

Base X (BaseX)
Base X (BaseX)
The "Base X" attribute defines for the 3D bar the distance between the left object border and
the right limitation line of the front bar area. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the object size.
The "Base X" attribute can be made dynamic with the name "BaseX".

Base Y (BaseY)
Base Y (BaseY)
The "Base Y" attribute defines for the 3D bar the distance between the top object border and
the bottom limitation line of the front bar area. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the object size.
The "Base Y" attribute can be made dynamic with the name "BaseY".

Beta (AngleBeta)
Beta (AngleBeta)
The "Beta" attribute specifies the depth angle Beta for the 3D display of the left side of a 3D
bar. The values are specified in degrees.
0° - 90°

There is a free choice of value for the depth angle Beta within the specified limits.

The "Start Angle" attribute can be made dynamic with the name "AngleBeta".
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Picture Width (Width)
Picture Width (Width)
The "Picture Width" attribute defines the width of a process picture. The default value
corresponds to the vertical component of the current screen resolution and is specified in pixels.
If the value for the picture width exceeds the screen resolution, scroll bars appear in Runtime
to enable movement of the picture.
1 to 10500 pixels

The value can be chosen freely within the specified limits. A meaningful limit results from the
screen resolution.

The "Picture Width" attribute can be made dynamic with the name "Width".

Picture Height (Height)
Picture Height (Height)
The "Picture Height" attribute defines the height of a process picture. The default value
corresponds to the horizontal component of the current screen resolution and is specified in
pixels.
If the value for the picture height exceeds the screen resolution, scroll bars appear in Runtime
to enable movement of the picture.
1 - 10000 pixels

The value can be chosen freely within the specified limits. A meaningful limit results from the
screen resolution.

The "Picture Height" attribute can be made dynamic with the name "Height".

Width (Width)
Width (Width)
The "Width" attribute defines the horizontal distance between the left and right limitation line
of an object. The values are specified in pixels.
In the case of the objects "Group Display", "Button" and "Round Button", changing the object
size may make it necessary to adapt the "3D Border Width" attribute in the "Styles" property
group.
0 - 10000

The value can be chosen freely within the specified limits.

The "Width" attribute can be made dynamic with the name "Width".
With the object "Connector", the attribute "Width" cannot be made dynamic.

Button 1 Width (Button1Width)
Button 1 Width (Button1Width)
The "Button 1 Width" attribute defines for the "Group Display" object the width of the first button
from the left. The values are specified in pixels.
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There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 1 Width" attribute can be made dynamic with the name "Button1Width".

Button 2 Width (Button2Width)
Button 2 Width (Button2Width)
The "Button 2 Width" attribute defines for the "Group Display" object the width of the second
button from the left. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 2 Width" attribute can be made dynamic with the name "Button2Width".

Button 3 Width (Button3Width)
Button 3 Width (Button3Width)
The "Button 3 Width" attribute defines for the "Group Display" object the width of the third
button from the left. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 3 Width" attribute can be made dynamic with the name "Button3Width".

Button 4 Width (Button4Width)
Button 4 Width (Button4Width)
The "Button 4 Width" attribute defines for the "Group Display" object the width of the fourth
button from the left. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 4 Width" attribute can be made dynamic with the name "Button4Width".

Button 5 Width (Button5Width)
Button 5 Width (Button5Width)
The "Button 5 Width" attribute defines the width of the fifth button from the left for the "Group
Display" object. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".

900

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 5 Width" attribute can be made dynamic with the name "Button5Width".

Button 6 Width (Button6Width)
Button 6 Width (Button6Width)
The "Button 6 Width" attribute defines the width of the sixth button from the left for the "Group
Display" object. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 6 Width" attribute can be made dynamic with the name "Button6Width".

Button 7 Width (Button7Width)
Button 7 Width (Button7Width)
The "Button 7 Width" attribute defines the width of the seventh button from the left for the
"Group Display" object. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 7 Width" can be made dynamic with the name "Button7Width".

Button 8 Width (Button8Width)
Button 8 Width (Button8Width)
The "Button 8 Width" attribute defines the width of the eighth button from the left for the "Group
Display" object. The values are specified in pixels.
There is a free choice of value. If the button should not be visible, set the width to "0".
Different values for the buttons are only displayed if the "Same Size" attribute has the value
"No".
The "Button 8 Width" attribute can be made dynamic with the name "Button8Width".

3.10.10.2 Geometry - C to Z
Display Axis (Axe)
Display Axis (Axe)
The "Display Axis" attribute defines the position of the 3D bar in the coordinate system.
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X axis

The representation of the 3D bar takes place on the X axis.

Y axis

The representation of the 3D bar takes place on the Y axis.

Z axis

The representation of the 3D bar takes place on the Z axis.

The "Display Axis" attribute can be made dynamic with the name "Axe".

Corner radius (CornerRadius)
Corner radius (CornerRadius)
The "Corner radius" attribute defines the rounding radius of the rectangles which enclose
objects in the extended analog display. The values are defined in pixels.
The range of values which can be displayed for the corner radius depends on the values set
for the "height" and "width" attributes. The maximum corner radius value which can be
displayed is equivalent to 50% of the lower one of the "height" or "width" values. The maximum
value is used if higher values are entered.
The "Corner Radius" attribute can be assigned dynamic properties by means of the name
"CornerRadius".

Corner Radius X (RoundCornerHeight)
Corner Radius X (RoundCornerHeight)
The "Corner Radius X" attribute defines for a rounded rectangle the horizontal distance
between the corner of the rectangle around the object and the starting point of a rounded
corner. The value is specified as a percentage of half the object width.
If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%, the
rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without rounded
corners when either one of the two attributes is set to 0%.
0% - 100%

The value can be chosen freely within the specified limits.

0

No rounded corners; the rounded rectangle has the appearance of a normal rectangle.

100

The Corner Radius X corresponds to half the width of the rounded rectangle.
The start point of the curved section is located at the vertical center line of the object. Both horizontal
limitation lines are displayed as arcs.

The "Corner Radius X" attribute can be made dynamic with the name "RoundCornerHeight".

Corner Radius Y (RoundCornerWidth)
Corner Radius Y (RoundCornerWidth)
The "Corner Radius Y" attribute defines for a rounded rectangle the vertical distance between
the corner of the rectangle around the object and the starting point of a rounded corner. The
value is specified as a percentage of half the object height.
If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%, the
rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without rounded
corners when either one of the two attributes is set to 0%.
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0% - 100%

The value can be chosen freely within the specified limits.

0

No rounded corners; the rounded rectangle has the appearance of a normal rectangle.

100

The Corner Radius Y corresponds to half the height of the rounded rectangle.
The start point of the curved section is located at the vertical center line of the object. Both vertical
limitation lines are displayed as arcs.

The "Corner Radius Y" attribute can be made dynamic with the name "RoundCornerWidth".

End Angle (EndAngle)
End Angle (EndAngle)
For segment or arc objects, the "End Angle" attribute specifies the angle by which the end
point of the object deviates from the zero position (0°). The values are specified in degrees.
There is a free choice of value. A meaningful limit results from the definition of a circle.
The "End Angle" attribute can be made dynamic with the name "EndAngle".

Window Width (Width)
Window Width (Width)
The "Window Width" attribute defines the horizontal distance between the left and right
limitation line of an object. The values are specified in pixels.
0 - 10000

The value can be chosen freely within the specified limits.

The "Window Width" attribute can be made dynamic with the name "Width".

Window Height (Height)
Window Height (Height)
The "Window Height" attribute defines the vertical distance between the top and bottom
limitation line of an object. The values are specified in pixels.
0 - 10000

The value can be chosen freely within the specified limits.

The "Window Height" attribute can be made dynamic with the name "Height".

Same Size (SameSize)
Same Size (SameSize)
The "Same Size" attribute defines whether the buttons of a group display will have the same
width or whether the widths can be defined individually for each button.
Yes

All buttons that have the "Button ... Width" attribute defined as unequal to "0" will be set to the same size within
the overall width of the "Group Display" object. Changing the overall width of the object changes the width of
the all buttons that have a width unequal to 0.

No

The width of the buttons can be defined individually using the "Button ... Width" attributes.
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The "Same Size" attribute can be made dynamic with the name "SameSize".

Height (Height)
Height (Height)
The "Height" attribute defines the vertical distance between the top and bottom limitation line
of an object. The values are specified in pixels.
In the case of the objects "Group Display", "Button" and "Round Button", changing the object
size may make it necessary to adapt the "3D Border Width" attribute in the "Styles" property
group.
0 - 10000

The value can be chosen freely within the specified limits.

The "Height" attribute can be made dynamic with the name "Height".
With the object "Connector", the attribute "Height" cannot be made dynamic.

Index (Index)
Index (Index)
The "Index" attribute indicates the item number of the currently selected corner. Changing the
value specified here enables targeted selection of a corner.
Changing the "Index" attribute also changes the displayed value of the "Current Value X" and
"Current Value Y" attributes. The display of these three attributes only applies to the currently
selected corner in each case.
1 - "Number of Corners"

The value can be chosen freely within the specified limits.

The "Index" attribute can be made dynamic with the name "Index".

Position X (Left)
Position X (Left)
The "Position X" attribute defines the horizontal distance of the object origin from the left picture
border. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the picture size.
The "Position X" attribute can be made dynamic with the name "Left".
With the object "Connector", the value can only be changed with unlinked ends.

Position Y (Top)
Position Y (Top)
The "Position Y" attribute defines the vertical distance of the object origin from the top picture
border. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the picture size.
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The "Position Y" attribute can be made dynamic with the name "Top".
With the object "Connector", the value can only be changed with unlinked ends.

Radius (Radius)
Radius (Radius)
The "Radius" attribute defines the radius of circular objects. The values are specified in pixels.
0 - 5000

The value can be chosen freely within the specified limits.

The "Radius" attribute can be made dynamic with the name "Radius".

Radius X (RadiusWidth)
Radius X (RadiusWidth)
The "Radius X" attribute defines the horizontal radius of elliptical objects. The values are
specified in pixels.
0 - 5000

The value can be chosen freely within the specified limits.

The "Radius X" attribute can be made dynamic with the name "RadiusWidth".

Radius Y (RadiusHeight)
Radius Y (RadiusHeight)
The "Radius Y" attribute defines the vertical radius of elliptical objects. The values are specified
in pixels.
0 - 5000

The value can be chosen freely within the specified limits.

The "Radius Y" attribute can be made dynamic with the name "RadiusHeight".

Grid On
Grid On
The "Grid On" attribute specifies whether a grid is shown in the workspace of the current picture.
The grid is a utility of the Graphics Designer which makes it easier to position objects in a
process picture precisely. The grid lines of the grid are symbolized by display of the intersection
points.
If the additional option "Snap to Grid" is enabled, all objects are automatically aligned

Grid Height
Grid Height
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The "Grid Height" attribute is used to specify the vertical distance for the grid lines of the grid.
The value is specified in pixels.
The grid is a utility of the Graphics Designer which makes it easier to position objects in a
process picture precisely. The grid lines of the grid are symbolized by display of the intersection
points.
The minimum grid height that can be displayed on the screen is 10 pixels. A low value can be
specified, but only the intersection points with a spacing of at least 10 pixels are displayed on
the screen.
With a grid height of 4 pixels, only each third intersection is displayed. The objects can however
also be aligned to the two grid lines between them.

Grid Width
Grid Width
The "Grid Width" attribute is used to specify the horizontal distance for the grid lines of the The
value is specified in pixels.
The grid is a utility of the Graphics Designer which makes it easier to position objects in a
process picture precisely. The grid lines of the grid are symbolized by display of the intersection
points.
The minimum grid width that can be displayed on the screen is 10 pixels. A low value can be
specified, but only the intersection points with a spacing of at least 10 pixels are displayed on
the screen.
With a grid width of 4 pixels, only each third intersection is displayed. The objects can however
also be aligned to the two grid lines between them.

Rotation Reference X (ReferenceRotationLeft)
Rotation Reference X (ReferenceRotationLeft)
The "Rotation Reference X" attribute defines the horizontal coordinates of the reference point
around which the object rotates in Runtime. The value describes the horizontal distance
between the reference point and the origin of the object. The value is indicated in percentages,
whereby the object width corresponds to 100%.
The reference point value can be outside the selection rectangle. This means that both
negative values and values higher than 100% are possible.
The rotation of an object is visible only in Runtime. The direction of rotation depends on the
value of the "Rotation Angle" attribute.
There is a free choice of value. Both negative values and values greater than 100% are
permitted.
Examples:
-100%

The reference point lies to the left of the object origin (distance = one object width).

0%

The vertical coordinates of the reference point and object origin are the same.

50%

The reference point lies on the vertical center axis of the object.
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100%

The reference point lies to the right of the object origin (distance = one object width).

200%

The reference point lies to the right of the object origin (distance = two object widths).

The "Rotation Reference X" attribute can be made dynamic with the name
"ReferenceRotationLeft".

Rotation Reference Y (ReferenceRotationTop)
Rotation Reference Y (ReferenceRotationTop)
The "Rotation Reference Y" attribute defines the vertical coordinates of the reference point
around which the object rotates in Runtime. The value describes the vertical distance between
the reference point and the origin of the object. The value is indicated in percentages, whereby
the object width corresponds to 100%.
The reference point value can be outside the selection rectangle. This means that both
negative values and values higher than 100% are possible.
The rotation of an object is visible only in Runtime. The direction of rotation depends on the
value of the "Rotation Angle" attribute.
There is a free choice of value. Both negative values and values greater than 100% are
permitted.
Examples:
-100%

The reference point lies above the object origin (distance = one object width).

0%

The horizontal coordinates of the reference point and object origin are the same.

50%

The reference point lies on the horizontal center axis of the object.

100%

The reference point lies below the object origin (distance = one object width).

200%

The reference point lies below the object origin (distance = two object widths).

The "Rotation Reference Y" attribute can be made dynamic with the name
"ReferenceRotationTop".

Rotation Angle (RotationAngle)
Rotation Angle (RotationAngle)
The "Rotation Angle" attribute defines the rotation of an object around a reference point. The
value of the rotation angle is specified in degrees; the starting value corresponds to a value of
0°.
The position of the object deviates from its configured start position by the value of the "Rotation
Angle" attribute. The changed orientation of the object is only visible in Runtime.
The coordinates of the reference point are defined with the "Rotation Reference X" and
"Rotation Reference Y" attributes.
-360° - 360°

The value can be chosen freely within the specified limits.

< 0°

The object is rotated counterclockwise.

= 0°

The object is not rotated (display of the configured start position).

> 0°

The object is rotated clockwise.
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The "Rotation Angle" attribute can be made dynamic with the name "RotationAngle".

Rotation Angle (RotationAngle)
Rotation Angle (RotationAngle)
The "Rotation Angle" attribute defines the orientation of a T-piece. The attribute can have one
of four values that are specified in degrees.
The orientation is produced by rotating the T-piece clockwise around the center point by the
specified number of degrees.
If you enter another value, it is automatically converted to modulus 360 and rounded up or
down to the closest permissible value.
0

The standard position of the T-piece is the shape of the letter "T"

90

The "leg" of the "T" points towards the left

180

The "leg" of the "T" points upwards

270

The "leg" of the "T" points to the right

The "Rotation Angle" attribute can be made dynamic with the name "RotationAngle".

Angle Settings (PredefinedAngles)
Angle Settings (PredefinedAngles)
The "Angle Settings" attribute offers three predefined variants for the depth display of a 3D
bar. A fourth variant enables free setting of the two depth angles Alpha and Beta.
If the "Angle Settings" attribute is changed, the "Alpha" and "Beta" attributes receive predefined
values.
Cavalier

Depth display with the values: Alpha = 45° and Beta = 0°

Isonometric

Depth display with the values: Alpha = Beta = 45°

Axionometric

Depth display with the values: Alpha = 10° and Beta = 42°

Freely Defined

There is a free choice of values for Alpha and Beta.

The "Angle Settings" attribute can be made dynamic with the name "PredefinedAngles".

3.10.11

"Limits" Property Group

3.10.11.1 Limits - A
Type AH (TypeAlarmHigh)
Type AH (TypeAlarmHigh)
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The "Type AH" attribute specifies for the "Bar" object whether the value of the Limit AH is
displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of limit AH is accepted as an absolute value in the representation of the bar.

%

The value of limit AH is displayed as a percentage value, starting from the zero point of the bar display.

The "Type AH" attribute can be made dynamic with the name "TypeAlarmHigh".

Type AL (TypeAlarmLow)
Type AL (TypeAlarmLow)
The "Type AL" attribute specifies for the "Bar" object whether the value of the Alarm Low Limit
AL is displayed as an absolute value or as a percentage value, starting from the zero point of
the bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
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Absolute

The value of Alarm Low Limit AL is accepted as an absolute value in the representation of the bar.

%

The value of Alarm Low Limit AL is displayed as a percentage value, starting from the zero point of the
bar display.

The "Type AL" attribute can be made dynamic with the name "TypeAlarmLow".

Type RH4 (TypeLimitHigh4)
Type RH4 (TypeLimitHigh4)
The "Type RH4" attribute specifies for the "Bar" object whether the value of the High Limit RH4
is displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of High Limit RH4 is accepted as an absolute value in the representation of the bar.

%

The value of High Limit RH4 is displayed as a percentage value, starting from the zero point of the bar
display.

The "Type RH4" attribute can be made dynamic with the name "TypeLimitHigh4".

Type RH5 (TypeLimitHigh5)
Type RH5 (TypeLimitHigh5)
The "Type RH5" attribute specifies for the "Bar" object whether the value of the High Limit RH5
is displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of High Limit RH5 is accepted as an absolute value in the representation of the bar.

%

The value of High Limit RH5 is displayed as a percentage value, starting from the zero point of the bar
display.

The "Type RH5" attribute can be made dynamic with the name "TypeLimitHigh5".

Type RL4 (TypeLimitLow4)
Type RL4 (TypeLimitLow4)
The "Type RL4" attribute specifies for the "Bar" object whether the value of the Low Limit RL4
is displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of Low Limit RL4 is accepted as an absolute value in the representation of the bar.

%

The value of Low Limit RL4 is displayed as a percentage value, starting from the zero point of the bar
display.

The "Type RL4" attribute can be made dynamic with the name "TypeLimitLow4".

Type RL5 (TypeLimitLow5)
Type RL5 (TypeLimitLow5)
The "Type RL5" attribute specifies for the "Bar" object whether the value of the Low Limit RL5
is displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
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For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of Low Limit RL5 is accepted as an absolute value in the representation of the bar.

%

The value of Low Limit RL5 is displayed as a percentage value, starting from the zero point of the bar
display.

The "Type RL5" attribute can be made dynamic with the name "TypeLimitLow5".

Type TH (TypeToleranceHigh)
Type TH (TypeToleranceHigh)
The "Type TH" attribute specifies for the "Bar" object whether the value of the Limit TH is
displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of limit TH is accepted as an absolute value in the representation of the bar.

%

The value of limit TH is displayed as a percentage value, starting from the zero point of the bar display.

The "Type TH" attribute can be made dynamic with the name "TypeToleranceHigh".
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Type TL (TypeToleranceLow)
Type TL (TypeToleranceLow)
The "Type TL" attribute specifies for the "Bar" object whether the value of the Limit TL is
displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of limit TL is accepted as an absolute value in the representation of the bar.

%

The value of limit TL is displayed as a percentage value, starting from the zero point of the bar display.

The "Type TL" attribute can be made dynamic with the name "TypeToleranceLow".

Type WH (TypeWarningHigh)
Type WH (TypeWarningHigh)
The "Type WH" attribute specifies for the "Bar" object whether the value of the Limit WH is
displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
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Absolute

The value of limit WH is accepted as an absolute value in the representation of the bar.

%

The value of limit WH is displayed as a percentage value, starting from the zero point of the bar display.

The "Type WH" attribute can be made dynamic with the name "TypeWarningHigh".

Type WL (TypeWarningLow)
Type WL (TypeWarningLow)
The "Type WL" attribute specifies for the "Bar" object whether the value of the Limit WL is
displayed as an absolute value or as a percentage value, starting from the zero point of the
bar display.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Absolute

The value of limit WL is accepted as an absolute value in the representation of the bar.

%

The value of limit WL is displayed as a percentage value, starting from the zero point of the bar display.

The "Type WL" attribute can be made dynamic with the name "TypeWarningLow".

3.10.11.2 Limits - Bar color
Bar Color 0 (Layer00Color)
Bar Color 0 (Layer00Color)
The "Bar Color 0" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 0" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
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The "Bar Color 0" attribute can be made dynamic with the name "Layer00Color".

Bar Color 1 (Layer01Color)
Bar Color 1 (Layer01Color)
The "Bar Color 1" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 1" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 1" attribute can be made dynamic with the name "Layer01Color".

Bar Color 2 (Layer02Color)
Bar Color 2 (Layer02Color)
The "Bar Color 2" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 2" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 2" attribute can be made dynamic with the name "Layer02Color".

Bar Color 3 (Layer03Color)
Bar Color 3 (Layer03Color)
The "Bar Color 3" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 3" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 3" attribute can be made dynamic with the name "Layer03Color".
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Bar Color 4 (Layer04Color)
Bar Color 4 (Layer04Color)
The "Bar Color 4" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 4" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 4" attribute can be made dynamic with the name "Layer04Color".

Bar Color 5 (Layer05Color)
Bar Color 5 (Layer05Color)
The "Bar Color 5" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 5" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 5" attribute can be made dynamic with the name "Layer05Color".

Bar Color 6 (Layer06Color)
Bar Color 6 (Layer06Color)
The "Bar Color 6" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 6" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 6" attribute can be made dynamic with the name "Layer06Color".

Bar Color 7 (Layer07Color)
Bar Color 7 (Layer07Color)
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The "Bar Color 7" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 7" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 7" attribute can be made dynamic with the name "Layer07Color".

Bar Color 8 (Layer08Color)
Bar Color 8 (Layer08Color)
The "Bar Color 8" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 8" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 8" attribute can be made dynamic with the name "Layer08Color".

Bar Color 9 (Layer09Color)
Bar Color 9 (Layer09Color)
The "Bar Color 9" attribute defines for the "3D bar" object the color for the representation of a
display value that is lower than the value of the "Limit 9" attribute.
You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 9" attribute can be made dynamic with the name "Layer09Color".

Bar Color 10 (Layer10Color)
Bar Color 10 (Layer10Color)
The "Bar Color 10" attribute defines for the "3D bar" object the color for the representation of
a display value that is lower than the value of the "Limit 10" attribute.
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You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a
color change. This color setting is activated if the corresponding "Monitoring N" attribute has
the value "Yes".
A display value is output in the Bar Color N as long as it is less than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0
or greater than Limit 10.
The "Bar Color 10" attribute can be made dynamic with the name "Layer10Color".

Bar Color AH (ColorAlarmHigh)
Bar Color AH (ColorAlarmHigh)
The "Bar Color AH" attribute defines for the "Bar" object the color for the representation of a
display value that is higher than the value of the upper limit "Alarm High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color AH" attribute can assogned dynamic properties by means of the name
"ColorAlarmHigh".

Bar Color AL (ColorAlarmLow)
Bar Color AL (ColorAlarmLow)
The "Bar Color AL" attribute defines for the "Bar" object the color for the representation of a
display value that is lower than the value of the lower limit Alarm Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color AL" attribute can assogned dynamic properties by means of the name
"ColorAlarmLow".

Bar Color RH4 (ColorLimitHigh4)
Bar Color RH4 (ColorLimitHigh4)
The "Bar Color RH4" attribute defines for the "Bar" object the color for the representation of a
display value that is higher than the value of the upper limit "Reserve High 4".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color RH4" attribute can assigned dynamic properties by means of the name
"ColorAlarmHigh4".

Bar Color RH5 (ColorLimitHigh5)
Bar Color RH5 (ColorLimitHigh5)
The "Bar Color RH5" attribute defines for the "Bar" object the color for the representation of a
display value that is higher than the value of the upper limit "Reserve High 5".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color RH5" attribute can assigned dynamic properties by means of the name
"ColorAlarmHigh5".

Bar Color RL4 (ColorLimitLow4)
Bar Color RL4 (ColorLimitLow4)
The "Bar Color RL4" attribute defines for the "Bar" object the color for the representation of a
display value that is lower than the value of the lower limit "Reserve Low 4".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color RL4" attribute can assigned dynamic properties by means of the name
"ColorAlarmLow4".

Bar Color RL5 (ColorLimitLow5)
Bar Color RL5 (ColorLimitLow5)
The "Bar Color RL5" attribute defines for the "Bar" object the color for the representation of a
display value that is lower than the value of the lower limit "Reserve Low 5".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color RL5" attribute can assigned dynamic properties by means of the name
"ColorLimitLow5".

Bar Color TH (ColorToleranceHigh)
Bar Color TH (ColorToleranceHigh)
The "Bar Color TH" attribute defines for the "Bar" object the color for the representation of a
display value that is higher than the value of the upper limit "Tolerance High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color TH" attribute can assogned dynamic properties by means of the name
"ColorToleranceHigh".

Bar Color TL (ColorToleranceLow)
Bar Color TL (ColorToleranceLow)
The "Bar Color TL" attribute defines for the "Bar" object the color for the representation of a
display value that is lower than the value of the lower limit "Tolerance Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color TL" attribute can be assigned dynamic properties by means of the name
"ColorToleranceLow".

Bar Color WH (ColorWarningHigh)
Bar Color WH (ColorWarningHigh)
The "Bar Color WH" attribute defines for the "Bar" object the color for the representation of a
display value that is higher than the value of the upper limit "Warning High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color WH" attribute can be assigned dynamic properties by means of the name
"ColorWarningHigh".

Bar Color WL (ColorWarningLow)
Bar Color WL (ColorWarningLow)
The "Bar Color WL" attribute defines for the "Bar" object the color for the representation of a
display value that is lower than the value of the lower limit "Warning Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
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Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
The "Bar Color WL" attribute be assigned dynamic properties by means of the name
"ColorWarningLow".

3.10.11.3 Limits - Bar fill color
Bar fill color 0 (Layer00FillColor)
Bar fill color 0 (Layer00FillColor)
The "Layer00FillColor" attribute defines the color with which the bar is filled in relation to "Limit
0".
The "Layer00FillColor" attribute can be made dynamic with the name "Layer00FillColor".

Layer01FillColor
Layer01FillColor
The "Layer01FillColor" attribute defines the color with which the bar is filled in relation to "Limit
1".
The "Layer01FillColor" attribute can be made dynamic with the name "Layer01FillColor".

Layer02FillColor
Layer02FillColor
The "Layer02FillColor" attribute defines the color with which the bar is filled in relation to "Limit
2".
The "Layer02FillColor" attribute can be made dynamic with the name "Layer02FillColor".

Layer03FillColor
Layer03FillColor
The "Layer03FillColor" attribute defines the color with which the bar is filled in relation to "Limit
3".
The "Layer03FillColor" attribute can be made dynamic with the name "Layer03FillColor".

Layer04FillColor
Layer04FillColor
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The "Layer04FillColor" attribute defines the color with which the bar is filled in relation to "Limit
4".
The "Layer04FillColor" attribute can be made dynamic with the name "Layer04FillColor".

Layer05FillColor
Layer05FillColor
The "Layer05FillColor" attribute defines the color with which the bar is filled in relation to "Limit
5".
The "Layer05FillColor" attribute can be made dynamic with the name "Layer05FillColor".

Layer06FillColor
Layer06FillColor
The "Layer06FillColor" attribute defines the color with which the bar is filled in relation to "Limit
6".
The "Layer06FillColor" attribute can be made dynamic with the name "Layer06FillColor".

Layer07FillColor
Layer07FillColor
The "Layer07FillColor" attribute defines the color with which the bar is filled in relation to "Limit
7".
The "Layer07FillColor" attribute can be made dynamic with the name "Layer07FillColor".

Layer08FillColor
Layer08FillColor
The "Layer08FillColor" attribute defines the color with which the bar is filled in relation to "Limit
8".
The "Layer08FillColor" attribute can be made dynamic with the name "Layer08FillColor".

Layer09FillColor
Layer09FillColor
The "Layer09FillColor" attribute defines the color with which the bar is filled in relation to "Limit
9".
The "Layer09FillColor" attribute can be made dynamic with the name "Layer09FillColor".

Layer10FillColor
Layer10FillColor
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The "Layer10FillColor" attribute defines the color with which the bar is filled in relation to "Limit
10".
The "Layer10FillColor" attribute can be made dynamic with the name "Layer10FillColor".

3.10.11.4 Limits - Bar fill style
Layer00FillStyle
Layer00FillStyle
The "Layer00FillStyle" attribute defines the style of the bar in relation to "Limit 0". For the fill
pattern to become visible, "bar fill color 0" must differ from "bar color 0".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer00FillStyle" attribute can be made dynamic with the name "Layer00FillStyle".

Layer01FillStyle
Layer01FillStyle
The "Layer01FillStyle" attribute defines the style of the bar in relation to "Limit 1". For the fill
pattern to become visible, "bar fill color 1" must differ from "bar color 1".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer01FillStyle" attribute can be made dynamic with the name "Layer01FillStyle".

Layer02FillStyle
Layer02FillStyle
The "Layer02FillStyle" attribute defines the style of the bar in relation to "Limit 2". For the fill
pattern to become visible, "bar fill color 2" must differ from "bar color 2".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer02FillStyle" attribute can be made dynamic with the name "Layer02FillStyle".

Layer03FillStyle
Layer03FillStyle
The "Layer03FillStyle" attribute defines the style of the bar in relation to "Limit 3". For the fill
pattern to become visible, "bar fill color 3" must differ from "bar color 3".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer03FillStyle" attribute can be made dynamic with the name "Layer03FillStyle".
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Layer04FillStyle
Layer04FillStyle
The "Layer04FillStyle" attribute defines the style of the bar in relation to "Limit 4". For the fill
pattern to become visible, "bar fill color 4" must differ from "bar color 4".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer04FillStyle" attribute can be made dynamic with the name "Layer04FillStyle".

Layer05FillStyle
Layer05FillStyle
The "Layer05FillStyle" attribute defines the style of the bar in relation to "Limit 5". For the fill
pattern to become visible, "bar fill color 5" must differ from "bar color 5".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer05FillStyle" attribute can be made dynamic with the name "Layer05FillStyle".

Layer06FillStyle
Layer06FillStyle
The "Layer06FillStyle" attribute defines the style of the bar in relation to "Limit 6". For the fill
pattern to become visible, "bar fill color 6" must differ from "bar color 6".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer06FillStyle" attribute can be made dynamic with the name "Layer06FillStyle".

Layer07FillStyle
Layer07FillStyle
The "Layer07FillStyle" attribute defines the style of the bar in relation to "Limit 7". For the fill
pattern to become visible, "bar fill color 7" must differ from "bar color 7".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer07FillStyle" attribute can be made dynamic with the name "Layer07FillStyle".

Layer08FillStyle
Layer08FillStyle
The "Layer08FillStyle" attribute defines the style of the bar in relation to "Limit 8". For the fill
pattern to become visible, "bar fill color 8" must differ from "bar color 8".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
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The "Layer08FillStyle" attribute can be made dynamic with the name "Layer08FillStyle".

Layer09FillStyle
Layer09FillStyle
The "Layer09FillStyle" attribute defines the style of the bar in relation to "Limit 9". For the fill
pattern to become visible, "bar fill color 9" must differ from "bar color 9".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer09FillStyle" attribute can be made dynamic with the name "Layer09FillStyle".

Layer10FillStyle
Layer10FillStyle
The "Layer10FillStyle" attribute defines the style of the bar in relation to "Limit 10". For the fill
pattern to become visible, "bar fill color 10" must differ from "bar color 10".
There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed.
The "Layer10FillStyle" attribute can be made dynamic with the name "Layer10FillStyle".

3.10.11.5 Limits - C to T
Limit 0 (Layer00Value)
Limit 0 (Layer00Value)
The "Limit 0" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 0.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in the bar color N as long as it is lower than the value of the Limit
N. A black arrow at the ends of the bar display symbolizes display values that are lower than
Limit 0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 0" attribute can be made dynamic with the name "Layer00Value".

Limit 1 (Layer01Value)
Limit 1 (Layer01Value)
The "Limit 1" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 1.
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For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 1" attribute can be made dynamic with the name "Layer01Value".

Limit 2 (Layer02Value)
Limit 2 (Layer02Value)
The "Limit 2" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 2.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 2" attribute can be made dynamic with the name "Layer02Value".

Limit 3 (Layer03Value)
Limit 3 (Layer03Value)
The "Limit 3" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 3.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 3" attribute can be made dynamic with the name "Layer03Value".
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Limit 4 (Layer04Value)
Limit 4 (Layer04Value)
The "Limit 4" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 4.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 4" attribute can be made dynamic with the name "Layer04Value".

Limit 5 (Layer05Value)
Limit 5 (Layer05Value)
The "Limit 5" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 5.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 5" attribute can be made dynamic with the name "Layer05Value".

Limit 6 (Layer06Value)
Limit 6 (Layer06Value)
The "Limit 6" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 6.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
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There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 6" attribute can be made dynamic with the name "Layer06Value".

Limit 7 (Layer07Value)
Limit 7 (Layer07Value)
The "Limit 7" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 7.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 7" attribute can be made dynamic with the name "Layer07Value".

Limit 8 (Layer08Value)
Limit 8 (Layer08Value)
The "Limit 8" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 8.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 8" attribute can be made dynamic with the name "Layer08Value".

Limit 9 (Layer09Value)
Limit 9 (Layer09Value)
The "Limit 9" attribute defines for the "3D bar" object the limit value up to which a display value
is displayed with Bar Color 9.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
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change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 9" attribute can be made dynamic with the name "Layer09Value".

Limit 10 (Layer10Value)
Limit 10 (Layer10Value)
The "Limit 10" attribute defines for the "3D bar" object the limit value up to which a display
value is displayed with Bar Color 10.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "3D bar".
The "Limit 10" attribute can be made dynamic with the name "Layer10Value".

Limit Marker (Marker)
Limit Marker (Marker)
The "Limit Marker" attribute specifies for the "Bar" object whether the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Display elements

The configured and monitored limits are marked by marking arrows.

Do Not Display

The configured and monitored limits are not marked by marking arrows.

The "Limit Marker" attribute can be made dynamic with the name "Marker".

High Limit Value (LimitMax)
High Limit Value (LimitMax)
The "High Limit Value" attribute defines for the "I/O field" object the maximum limit value for
input and output. The specified value depends on the "data format" of the I/O field.
If a value is higher than the upper limit value, the following effects are possible in Runtime:
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Field type = "Input": The "WinCC Runtime" dialog is opened and displayed the error message
"The entered value is outside the configured limits".
Confirm the error message with "OK" and enter another value.
Field type = "Output": The display of the value is substituted by the character string "***".
The "Data Format" and "Field Type" attributes can be changed in the "Output / Input" property
group.
There is a free choice of value depending on the "data format" of the I/O field.
The "High Limit Value" attribute can be made dynamic with the name "LimitMax".

Limit AH (AlarmHigh)
Limit AH (AlarmHigh)
The "Limit AH" attribute defines for the "Bar" object the upper limit value for the alarm limit
"Alarm High". If the display value exceeds the value specified here, it is displayed in the Bar
Color AH.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Limit AH" attribute can be made dynamic with the name "AlarmHigh".

High Limit RH4 (LimitHigh4)
High Limit RH4 (LimitHigh4)
The "High Limit RH4" attribute defines for the "Bar" object the upper limit value for the limit
"Reserve High 4". If the display value exceeds the value specified here, it is displayed in the
Bar Color RH4.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
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The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "High Limit RH4" attribute can be made dynamic with the name "LimitHigh4".

High Limit RH5 (LimitHigh5)
High Limit RH5 (LimitHigh5)
The "High Limit RH5" attribute defines for the "Bar" object the upper limit value for the limit
"Reserve High 5". If the display value exceeds the value specified here, it is displayed in the
Bar Color RH5.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "High Limit RH5" attribute can be made dynamic with the name "LimitHigh5".

Limit TH (ToleranceHigh)
Limit TH (ToleranceHigh)
The "Limit TH" attribute defines for the "Bar" object the upper limit value for the tolerance limit
"Tolerance High". If the display value exceeds the value specified here, it is displayed in the
Bar Color TH.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Limit TH" attribute can be made dynamic with the name "ToleranceHigh".

Limit WH (WarningHigh)
Limit WH (WarningHigh)
The "Limit WH" attribute defines for the "Bar" object the upper limit value for the warning limit
"Warning High". If the display value exceeds the value specified here, it is displayed in the Bar
Color WH.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Limit WH" attribute can be made dynamic with the name "WarningHigh".

3.10.11.6 Limits - U to Z
Monitoring 0 (Layer00Checked)
Monitoring 0 (Layer00Checked)
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For the "3D bar" object, the "Monitoring 0" attribute activates the monitoring of Limit 0.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 0 is monitored. The display value is displayed with bar color 0 until Limit 0 is exceeded.

No

Limit 0 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 0" attribute can be made dynamic with the name "Layer00Checked".

Monitoring 1 (Layer01Checked)
Monitoring 1 (Layer01Checked)
For the "3D bar" object, the "Monitoring 1" attribute activates the monitoring of limit 1.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 1 is monitored. The display value is displayed with bar color 1 until Limit 1 is exceeded.

No

Limit 1 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 1" attribute can be made dynamic with the name "Layer01Checked".

Monitoring 2 (Layer02Checked)
Monitoring 2 (Layer02Checked)
For the "3D bar" object, the "Monitoring 2" attribute activates the monitoring of limit 2.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 2 is monitored. The display value is displayed with bar color 2 until Limit 2 is exceeded.

No

Limit 2 is not monitored. A color change only takes place when the next monitored limit is exceeded.
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The "Monitoring 2" attribute can be made dynamic with the name "Layer02Checked".

Monitoring 3 (Layer03Checked)
Monitoring 3 (Layer03Checked)
For the "3D bar" object, the "Monitoring 3" attribute activates the monitoring of limit 3.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 3 is monitored. The display value is displayed with bar color 3 until Limit 3 is exceeded.

No

Limit 3 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 3" attribute can be made dynamic with the name "Layer03Checked".

Monitoring 4 (Layer04Checked)
Monitoring 4 (Layer04Checked)
For the "3D bar" object, the "Monitoring 4" attribute activates the monitoring of limit 4.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 4 is monitored. The display value is displayed with bar color 4 until Limit 4 is exceeded.

No

Limit 4 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 4" attribute can be made dynamic with the name "Layer04Checked".

Monitoring 5 (Layer05Checked)
Monitoring 5 (Layer05Checked)
For the "3D bar" object, the "Monitoring 5" attribute activates the monitoring of limit 5.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
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A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 5 is monitored. The display value is displayed with bar color 5 until Limit 5 is exceeded.

No

Limit 5 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 5" attribute can be made dynamic with the name "Layer05Checked".

Monitoring 6 (Layer06Checked)
Monitoring 6 (Layer06Checked)
For the "3D bar" object, the "Monitoring 6" attribute activates the monitoring of limit 6.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 6 is monitored. The display value is displayed with bar color 6 until Limit 6 is exceeded.

No

Limit 6 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 6" attribute can be made dynamic with the name "Layer06Checked".

Monitoring 7 (Layer07Checked)
Monitoring 7 (Layer07Checked)
For the "3D bar" object, the "Monitoring 7" attribute activates the monitoring of limit 7.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 7 is monitored. The display value is displayed with bar color 7 until Limit 7 is exceeded.

No

Limit 7 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 7" attribute can be made dynamic with the name "Layer07Checked".

Monitoring 8 (Layer08Checked)
Monitoring 8 (Layer08Checked)
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For the "3D bar" object, the "Monitoring 8" attribute activates the monitoring of limit 8.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 8 is monitored. The display value is displayed with bar color 8 until Limit 8 is exceeded.

No

Limit 8 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 8" attribute can be made dynamic with the name "Layer08Checked".

Monitoring 9 (Layer09Checked)
Monitoring 9 (Layer09Checked)
For the "3D bar" object, the "Monitoring 9" attribute activates the monitoring of limit 9.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 9 is monitored. The display value is displayed with bar color 9 until Limit 9 is exceeded.

No

Limit 9 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring 9" attribute can be made dynamic with the name "Layer09Checked".

Monitoring 10 (Layer10Checked)
Monitoring 10 (Layer10Checked)
For the "3D bar" object, the "Monitoring 10" attribute activates the monitoring of limit 10.
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is
activated.
A display value is displayed in Bar Color N as long as it is lower than the value of Limit N. A
black arrow at the ends of the bar display symbolizes display values that are lower than Limit
0 or higher than Limit 10.
Yes

Limit 10 is monitored. The display value is displayed with bar color 10 until Limit 10 is exceeded.

No

Limit 10 is not monitored. There is no color change.
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The "Monitoring 10" attribute can be made dynamic with the name "Layer10Checked".

Monitoring AH (CheckAlarmHigh)
Monitoring AH (CheckAlarmHigh)
The "Monitoring AH" attribute defines for the "Bar" object the monitoring of the alarm limit
"Alarm High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit AH is monitored. The display value is displayed with the bar color AH as soon as it exceeds the Limit AH.

No

Limit AH is not monitored. No color change takes place.

The "Monitoring AH" attribute can be made dynamic with the name "CheckAlarmHigh".

Monitoring AL (CheckAlarmLow)
Monitoring AL (CheckAlarmLow)
The "Monitoring AL" attribute defines for the "Bar" object the monitoring of the alarm limit "Alarm
Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
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Yes

Limit AL is monitored. The display value is displayed with the bar color AL as soon as it falls below the Alarm
Low Limit AL.

No

Limit AL is not monitored. No color change takes place.

The "Monitoring AL" attribute can be made dynamic with the name "CheckAlarmLow".

Monitoring RH4 (CheckLimitHigh4)
Monitoring RH4 (CheckLimitHigh4)
The "Monitoring RH4" attribute defines for the "Bar" object the monitoring of the limit "Reserve
High 4".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit RH4 is monitored. The display value is displayed with the bar color RH4 as soon as it exceeds the High
Limit RH4.

No

Limit RH4 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring RH4" attribute can be made dynamic with the name "CheckLimitHigh4".

Monitoring RH5 (CheckLimitHigh5)
Monitoring RH5 (CheckLimitHigh5)
The "Monitoring RH5" attribute defines for the "Bar" object the monitoring of the limit "Reserve
High 5".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.

940

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit RH5 is monitored. The display value is displayed with the bar color RH5 as soon as it exceeds the High
Limit RH5.

No

Limit RH5 is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring RH5" attribute can be made dynamic with the name "CheckLimitHigh5".

Monitoring RL4 (CheckLimitLow4)
Monitoring RL4 (CheckLimitLow4)
The "Monitoring RL4" attribute defines for the "Bar" object the monitoring of the limit "Reserve
Low 4".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit RL4 is monitored. The display value is displayed with the bar color RL4 as soon as it falls below the Low
Limit RL4.

No

The limit RL4 is not monitored. A color change only takes place when the value falls below the next monitored
limit.

The "Monitoring RL4" attribute can be made dynamic with the name "CheckLimitLow4".

Monitoring RL5 (CheckLimitLow5)
Monitoring RL5 (CheckLimitLow5)
The "Monitoring RL5" attribute defines for the "Bar" object the monitoring of the limit "Reserve
Low 5".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit RL5 is monitored. The display value is displayed with the Bar Color RL5 as soon as it falls below the Low
Limit RL5.

No

Limit RL5 is not monitored. A color change only takes place when the value falls below the next monitored
limit.

The "Monitoring RL5" attribute can be made dynamic with the name "CheckLimitLow5".

Monitoring TH (CheckToleranceHigh)
Monitoring TH (CheckToleranceHigh)
The "Monitoring TH" attribute defines for the "Bar" object the monitoring of the tolerance limit
"Tolerance High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit TH is monitored. The display value is displayed with the Bar Color TH as soon as it exceeds the Limit
TH.

No

Limit TH is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring TH" attribute can be made dynamic with the name "CheckToleranceHigh".

942

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties

Monitoring TL (CheckToleranceLow)
Monitoring TL (CheckToleranceLow)
The "Monitoring TL" attribute defines for the "Bar" object the monitoring of the tolerance limit
"Tolerance Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit TL is monitored. The display value is displayed with the Bar Color TL as soon as it falls below the Limit
TL.

No

Limit TL is not monitored. A color change only takes place when the value falls below the next monitored limit.

The "Monitoring TL" attribute can be made dynamic with the name "CheckToleranceLow".

Monitoring WH (CheckWarningHigh)
Monitoring WH (CheckWarningHigh)
The "Monitoring WH" attribute defines for the "Bar" object the monitoring of the warning limit
"Warning High".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
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Yes

Limit WH is monitored. The display value is displayed with the Bar Color WH as soon as it exceeds the Limit
WH.

No

Limit WH is not monitored. A color change only takes place when the next monitored limit is exceeded.

The "Monitoring WH" attribute can be made dynamic with the name "CheckWarningHigh".

Monitoring WL (CheckWarningLow)
Monitoring WL (CheckWarningLow)
The "Monitoring WL" attribute defines for the "Bar" object the monitoring of the warning limit
"Warning Low".
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
Yes

Limit WL is monitored. The display value is displayed with the Bar Color WL as soon as it falls below the Limit
WL.

No

Limit WL is not monitored. A color change only takes place when the value falls below the next monitored limit.

The "Monitoring WL" attribute can be made dynamic with the name "CheckWarningLow".

Low Limit Value (LimitMin)
Low Limit Value (LimitMin)
The "Low Limit Value" attribute defines for the "I/O field" object the minimum limit value for
input and output. The specified value depends on the "data format" of the I/O field.
If a value is lower than the low limit value, the following effects are possible in Runtime:
Field type = "Input": The "WinCC Runtime" dialog is opened and displayed the error message
"The entered value is outside the configured limits".
Confirm the error message with "OK" and enter another value.
Field type = "Output": The display of the value is substituted by the character string "***".
The "Data Format" and "Field Type" attributes can be changed in the "Output / Input" property
group.
There is a free choice of value depending on the "data format" of the I/O field.
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The "Low Limit Value" attribute can be made dynamic with the name "LimitMin".

Alarm Low Limit AL (AlarmLow)
Alarm Low Limit AL (AlarmLow)
The "Alarm Low Limit AL" attribute defines for the "Bar" object the lower limit value for the
alarm limit "Alarm Low". If the display value falls below the value specified here, it is displayed
in bar color AL.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color as soon as, starting from the zero
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment-wise or for the entire display.
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers receive the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Alarm Low Limit AL" attribute can be made dynamic with the name "AlarmLow".

Low Limit RL4 (LimitLow4)
Low Limit RL4 (LimitLow4)
The "Low Limit RL4" attribute defines for the "Bar" object the lower limit value for the limit
"Reserve Low 4". If the display value falls below the value specified here, it is displayed in bar
color RL4.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
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limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Low Limit RL4" attribute can be made dynamic with the name "LimitLow4".

Low Limit RL5 (LimitLow5)
Low Limit RL5 (LimitLow5)
The "Limit RL5" attribute defines for the "Bar" object the lower limit value for the limit "Reserve
Low 5". If the display value falls below the value specified here, it is displayed in bar color RL5.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Low Limit RL5" attribute can be made dynamic with the name "LimitLow5".

Limit TL (ToleranceLow)
Limit TL (ToleranceLow)
The "Limit TL" attribute defines for the "Bar" object the lower limit value for the tolerance limit
"Tolerance Low". If the display value falls below the value specified here, it is displayed in bar
color TL.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
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The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Limit TL" attribute can be made dynamic with the name "ToleranceLow".

Limit WL (WarningLow)
Limit WL (WarningLow)
The "Limit WL" attribute defines for the "Bar" object the lower limit value for the warning limit
"Warning Low". If the display value falls below the value specified here, it is displayed in bar
color WL.
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a
lower (Low) limit value. The limits are termed:
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are
displayed as absolute values or as percentage values.
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit
X. The display value is shown in the corresponding color, starting from the zero point of the
bar display, as soon as it is higher than the corresponding Upper Limit XH or lower than the
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies
whether this color change is to take place segment by segment or for the entire bar display.
The color change can only be displayed for a Limit X if the "Monitoring X" attribute has the
value "Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored
limits are indicated by marking arrows. These limit markers are shown in the bar color of the
corresponding limit and are displayed on the side of the bar opposite the scale.
There is a free choice of value. A meaningful limit results from the value range that is to be
displayed with the object "Bar".
The "Limit WL" attribute can be made dynamic with the name "WarningLow".

3.10.12

The "Background picture" property group

3.10.12.1 BackPictureName
BackPictureName
The "Picture" attribute defines the name of the file that is used as the background image in the
process picture. The file must exist in the \GraCS subdirectory. If you assign the attribute in
the properties dialog, you can select it from any directory. The selection creates a copy in the
\GraCS directory.
Files of format EMF, WMF, DB, BMP, GIF, JPG, JPEG and ICO are suitable.
The "Picture" attribute can be made dynamic with the name "BackPictureName".
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3.10.12.2 Show as (Back Picture Alignment)
Show as (Back Picture Alignment)
The "Show as" attribute defines the method of displaying the background image of the process
picture.
Normal

The background picture is centered in the original size. When opening the picture in runtime,
it remains in the location.

Stretched (window)

The background picture is scaled to the runtime window and process picture of the larger of
the two windows. In runtime, it is scaled to the size of the runtime window and is scaled when
you resize the picture.

Tiled

Graphics Designer and process picture are exhibited with the picture in its original size.

Stretched (picture)

The background picture is scaled to the configured size of the process picture. When opening
the picture in runtime, it retains its size.

The "Show as" attribute can be made dynamic with the name "BackPictureAlignment".

3.10.13

"Message Types" Property Group

3.10.13.1 Display Text (MCText)
Display Text (MCText)
The "Display Text" attribute is used to specify the type of text for the representation of a
message of the selected "Message Type".
The "Display Text" attribute can be made dynamic with the name "MCText".

3.10.13.2 Went Out Unacknowledged - Background Flashing (GNQBackFlash)
Went Out Unacknowledged - Background Flashing (GNQBackFlash)
The "Went Out Unacknowledged - Background Flashing" attribute specifies for the selected
message type and the status "Went Out Unacknowledged" whether the background of the
value to be displayed flashes when a message goes out unacknowledged.
Yes

When a message goes out unacknowledged, the background of value to be displayed flashes.

No

When a message goes out unacknowledged, the background of the displayed value flashes.

The "Went Out Unacknowledged - Background Flashing" attribute can be made dynamic using
the name "GNQBackFlash."

3.10.13.3 Went Out Unacknowledged - Background Flashing (MCGUBackFlash)
Went Out Unacknowledged - Background Flashing (MCGUBackFlash)
The "Went Out Unacknowledged - Background Flashing" attribute specifies for the selected
message type whether the background of the button flashes when a message goes out
unacknowledged.
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Yes

When a message goes out unacknowledged, the background of the button flashes.

No

When a message goes out unacknowledged, the background of the button does not flash.

The "Went Out Unacknowledged - Background Flashing" attribute can be made dynamic using
the name "MCGUBackFlash".

3.10.13.4 Went Out Unacknowledged - Background Color Off (GNQBackColorOff)
Went Out Unacknowledged - Background Color Off (GNQBackColorOff)
The "Went Out Unacknowledged - Background Color Off" attribute specifies for the selected
message type and the status "Went Out Unacknowledged" which color the background of the
value to be displayed assumes for flashing status "Off" when a message goes out
unacknowledged.
The "Went Out Unacknowledged - Background Color Off" attribute can be made dynamic using
the name "GNQBackColorOff".

3.10.13.5 Went Out Unacknowledged - Background Color Off (MCGUBackColorOff)
Went Out Unacknowledged - Background Color Off (MCGUBackColorOff)
The "Went Out Unacknowledged - Background Color Off" attribute specifies for the selected
message type which color the background of the button assumes for the flashing status "Off"
when a message goes out unacknowledged.
The "Went Out Unacknowledged - Background Color Off" attribute can be made dynamic using
the name "MCGUBackColorOff".

3.10.13.6 Went Out Unacknowledged - Background Color On (GNQBackColorOn)
Went Out Unacknowledged - Background Color On (GNQBackColorOn)
The "Went Out Unacknowledged - Background Color On" attribute specifies for the selected
message type and the status "Went Out Unacknowledged" which color the background of the
value to be displayed assumes for flashing status "On" when a message goes out
unacknowledged.
The "Went Out Unacknowledged - Background Color On" attribute can be made dynamic using
the name "GNQBackColorOn".

3.10.13.7 Went Out Unacknowledged - Background Color On (MCGUBackColorOn)
Went Out Unacknowledged - Background Color On (MCGUBackColorOn)
The "Went Out Unacknowledged - Background Color On" attribute specifies for the selected
message type which color the background of the button assumes for the flashing status "On"
when a message goes out unacknowledged.
The "Went Out Unacknowledged - Background Color On" attribute can be made dynamic using
the name "MCGUBackColorOn".
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3.10.13.8 Went Out Unacknowledged - Text Flashing (GNQTextFlash)
Went Out Unacknowledged - Text Flashing (GNQTextFlash)
The "Went Out Unacknowledged - Text Flashing" attribute specifies for the selected message
type and the status "Went Out Unacknowledged" whether the text of the value to be displayed
flashes when a message goes out unacknowledged.
Yes

When a message goes out unacknowledged, the text of the message flashes.

No

When a message goes out unacknowledged, the text of the message does not flash.

The "Went Out Unacknowledged - Text Flashing" attribute can be made dynamic using the
name "GNQTextFlash."

3.10.13.9 Went Out Unacknowledged - Text Flashing (MCGUTextFlash)
Went Out Unacknowledged - Text Flashing (MCGUTextFlash)
The "Went Out Unacknowledged - Text Flashing" attribute specifies for the selected message
type whether the text of the button flashes when a message goes out unacknowledged.
Yes

When a message goes out unacknowledged, the text of the button flashes.

No

When a message goes out unacknowledged, the text of the button does not flash.

The "Went Out Unacknowledged - Text Flashing" attribute can be made dynamic using the
name "MCGUTextFlash".

3.10.13.1 Went Out Unacknowledged - Text Color Off (GNQTextColorOff)
0
Went Out Unacknowledged - Text Color Off (GNQTextColorOff)
The "Went Out Unacknowledged - Text Color Off" attribute specifies for the selected message
type and the status "Went Out Unacknowledged" which color the text of the button assumes
for flashing status "Off" when a message goes out unacknowledged.
The "Went Out Unacknowledged - Text Color Off" attribute can be made dynamic using the
name "GNQTextColorOff".

3.10.13.1 Went Out Unacknowledged - Text Color Off (MCGUTextColorOff)
1
Went Out Unacknowledged - Text Color Off (MCGUTextColorOff)
The "Went Out Unacknowledged - Text Color Off" attribute specifies for the selected message
type which color the text of the button assumes for the flashing status "Off" when a message
goes out unacknowledged.
The "Went Out Unacknowledged - Text Color Off" attribute can be made dynamic using the
name "MCGUTextColorOff".
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3.10.13.1 Went Out Unacknowledged - Text Color On (GNQTextColorOn)
2
Went Out Unacknowledged - Text Color On (GNQTextColorOn)
The "Went Out Unacknowledged - Text Color On" attribute specifies for the selected message
type and the status "Went Out Unacknowledged" which color the text of the button assumes
for flashing status "On" when a message goes out unacknowledged.
The "Went Out Unacknowledged - Text Color On" attribute can be made dynamic using the
name "GNQTextColorOn".

3.10.13.1 Went Out Unacknowledged - Text Color On (MCGUTextColorOn)
3
Went Out Unacknowledged - Text Color On (MCGUTextColorOn)
The "Went Out Unacknowledged - Text Color On" attribute specifies for the selected message
type which color the text of the button assumes for the flashing status "On" when a message
goes out unacknowledged.
The "Went Out Unacknowledged - Text Color On" attribute can be made dynamic using the
name "MCGUTextColorOn".

3.10.13.1 Came In - Background Flashing (CBackFlash)
4
Came In - Background Flashing (CBackFlash)
The "Came In - Background Flashing" attribute specifies for the selected message type and
status "Came In" whether the background of the value to be displayed flashes.
Yes

When the message comes in, the background of the displayed value flashes.

No

When the message comes in, the background of the displayed value does not flash.

The "Came In - Background Flashing" attribute can be made dynamic using the name
"CBackFlash".

3.10.13.1 Came In - Background Flashing (MCKOBackFlash)
5
Came In - Background Flashing (MCKOBackFlash)
The "Came In - Background Flashing" attribute specifies for the selected message type
whether the background of the button flashes when a message comes in.
Yes

When the message comes in, the background of the button flashes.

No

When the message comes in, the background of the button does not flash.

The "Came In - Background Flashing" attribute can be made dynamic using the name
"MCKOBackFlash".
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3.10.13.1 Came In - Background Color Off (CBackColorOff)
6
Came In - Background Color Off (CBackColorOff)
The "Came In - Background Color Off" attribute specifies for the selected message type which
color the background of the value to be displayed assumes for flashing status "Off" when a
message comes in.
The "Came In - Background Color Off" attribute can be made dynamic using the name
"CBackColorOff".

3.10.13.1 Came In - Background Color Off (MCKOBackColorOff)
7
Came In - Background Color Off (MCKOBackColorOff)
The "Came In - Background Color Off" attribute specifies for the selected message type which
color the background of the button assumes for the flashing status "Off" when a message
comes in.
The "Came In - Background Color Off" attribute can be made dynamic using the name
"MCKOBackColorOff".

3.10.13.1 Came In - Background Color On (CBackColorOn)
8
Came In - Background Color On (CBackColorOn)
The "Came In - Background Color On" attribute specifies for the selected message type which
color the background of the value to be displayed assumes for flashing status "On" when a
message comes in.
The "Came In - Background Color On" attribute can be made dynamic using the name
"CBackColorOn".

3.10.13.1 Came In - Background Color On (MCKOBackColorOn)
9
Came In - Background Color On (MCKOBackColorOn)
The "Came In - Background Color On" attribute specifies for the selected message type which
color the background of the button assumes for the flashing status "On" when a message
comes in.
The "Came In - Background Color On" attribute can be made dynamic using the name
"MCKOBackColorOn".

3.10.13.2 Came In - Text Flashing (CTextFlash)
0
Came In - Text Flashing (CTextFlash)
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The "Came In - Text Flashing" attribute specifies for the selected message type and status
"Came In" whether the text of the value to be displayed flashes.
Yes

When the message comes in, the text of the value to be displayed flashes.

No

When the message comes in, the text of the value to be displayed does not flash.

The "Came In - Text Flashing" attribute can be made dynamic using the name "CTextFlash".

3.10.13.2 Came In - Text Flashing (MCKOTextFlash)
1
Came In - Text Flashing (MCKOTextFlash)
The "Came In - Text Flashing" attribute specifies for the selected message type whether the
text of the button flashes when a message comes in.
Yes

When the message comes in, the text of the button flashes.

No

When the message comes in, the text of the button does not flash.

The "Came In - Text Flashing" attribute can be made dynamic using the name
"MCKOTextFlash".

3.10.13.2 Came In - Text Color Off (CTextColorOff)
2
Came In - Text Color Off (CTextColorOff)
The "Came In - Text Color Off" attribute specifies for the selected message type which color
the text of the button assumes for flashing status "Off" when a message comes in.
The "Came In - Text Color Off" attribute can be made dynamic using the name "CTextColorOff".

3.10.13.2 Came In - Text Color Off (MCKOTextColorOff)
3
Came In - Text Color Off (MCKOTextColorOff)
The "Came In - Text Color Off" attribute specifies for the selected message type which color
the text of the button assumes for the flashing status "Off" when a message comes in.
The "Came In - Text Color Off" attribute can be made dynamic using the name
"MCKOTextColorOff".

3.10.13.2 Came In - Text Color On (CTextColorOn)
4
Came In - Text Color On (CTextColorOn)
The "Came In - Text Color On" attribute specifies for the selected message type which color
the text of the button assumes for flashing status "On" when a message comes in.
The "Came In - Text Color On" attribute can be made dynamic using the name "CTextColorOn".
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3.10.13.2 Came In - Text Color On (MCKOTextColorOn)
5
Came In - Text Color On (MCKOTextColorOn)
The "Came In - Text Color On" attribute specifies for the selected message type which color
the text of the button assumes for the flashing status "On" when a message comes in.
The "Came In - Text Color On" attribute can be made dynamic using the name
"MCKOTextColorOn".

3.10.13.2 Came In Acknowledged - Background Flashing (CQBackFlash)
6
Came In Acknowledged - Background Flashing (CQBackFlash)
The "Came In Acknowledged - Background Flashing" attribute specifies for the selected
message type and the status "Came In Acknowledged" whether the background of the value
to be displayed flashes when the arrival of a message is acknowledged.
Yes

The background of the value to be displayed flashes when the arrival of a message is acknowledged.

No

The background of the value to be displayed does not flash when the arrival of a message is acknowledged.

The "Came In Acknowledged - Background Flashing" attribute can be made dynamic using
the name "CQBackFlash".

3.10.13.2 Came In Acknowledged - Background Flashing (MCKQBackFlash)
7
The "Came In Acknowledged - Background Flashing" attribute specifies for the selected
message type whether the background of the button flashes when the arrival of a message is
acknowledged.
Yes

The background of the button flashes when the arrival of a message is acknowledged.

No

The background of the button does not flash when the arrival of a message is acknowledged.

The "Came In Acknowledged - Background Flashing" attribute can be made dynamic using
the name "MCKQBackFlash".

3.10.13.2 Came In Acknowledged - Background Color Off (CQBackColorOff)
8
Came In Acknowledged - Background Color Off (CQBackColorOff)
The "Came In Acknowledged - Background Color Off" attribute specifies for the selected
message type and the status "Came In Acknowledged" which color the background of the
value to be displayed assumes for flashing status "Off" when the arrival of a message is
acknowledged.
The "Came In Acknowledged - Background Color Off" attribute can be made dynamic using
the name "CQBackColorOff".
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3.10.13.2 Came In Acknowledged - Background Color Off (MCKQBackColorOff)
9
Came In Acknowledged - Background Color Off (MCKQBackColorOff)
The "Came In Acknowledged - Background Color Off" attribute specifies for the selected
message type which color the background of the button assumes for the flashing status "Off"
when the arrival of a message is acknowledged.
The "Came In Acknowledged - Background Color Off" attribute can be made dynamic using
the name "MCKQBackColorOff".

3.10.13.3 Came In Acknowledged - Background Color On (CQBackColorOn)
0
Came In Acknowledged - Background Color On (CQBackColorOn)
The "Came In Acknowledged - Background Color On" attribute specifies for the selected
message type and the status "Came In Acknowledged" which color the background of the
value to be displayed assumes for flashing status "On" when the arrival of a message is
acknowledged.
The "Came In Acknowledged - Background Color On" attribute can be made dynamic using
the name "CQBackColorOn".

3.10.13.3 Came In Acknowledged - Background Color On (MCKQBackColorOn)
1
Came In Acknowledged - Background Color On (MCKQBackColorOn)
The "Came In Acknowledged - Background Color On" attribute specifies for the selected
message type which color the background of the button assumes for the flashing status "On"
when the arrival of a message is acknowledged.
The "Came In Acknowledged - Background Color On" attribute can be made dynamic using
the name "MCKQBackColorOn".

3.10.13.3 Came In Acknowledged - Text Flashing (CQTextFlash)
2
Came In Acknowledged - Text Flashing (CQTextFlash)
The "Came In Acknowledged - Text Flashing" attribute specifies for the selected message type
and the status "Came In Acknowledged" whether the text of the value to be displayed flashes
when the arrival of a message is acknowledged.
Yes

The text of the value to be displayed flashes when the arrival of a message is acknowledged.

No

The text of the value to be displayed does not flash when the arrival of a message is acknowledged.

The "Came In Acknowledged - Text Flashing" attribute can be made dynamic using the name
"CQTextFlash".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

955

Creating Process Pictures
3.10 Object properties

3.10.13.3 Came In Acknowledged - Text Flashing (MCKQTextFlash)
3
Came In Acknowledged - Text Flashing (MCKQTextFlash)
The "Came In Acknowledged - Text Flashing" attribute specifies for the selected message type
whether the text of the button flashes when the arrival of a message is acknowledged.
Yes

The text of the button flashes when the arrival of a message is acknowledged.

No

The text of the button does not flash when the arrival of a message is acknowledged.

The "Came In Acknowledged - Text Flashing" attribute can be made dynamic using the name
"MCKQTextFlash".

3.10.13.3 Came In Acknowledged - Text Color Off (CQTextColorOff)
4
Came In Acknowledged - Text Color Off (CQTextColorOff)
The "Came In Acknowledged - Text Color Off" attribute specifies for the selected message
type and the state "Came In Acknowledged" which color the text of the value to be displayed
assumes for flashing status "Off" when the arrival of a message is acknowledged.
The "Came In Acknowledged - Text Color Off" attribute can be made dynamic using the name
"CQTextColorOff".

3.10.13.3 Came In Acknowledged - Text Color Off (MCKQTextColorOff)
5
Came In Acknowledged - Text Color Off (MCKQTextColorOff)
The "Came In Acknowledged - Text Color Off" attribute specifies for the selected message
type which color the text of the button assumes for the flashing status "Off" when the arrival
of a message is acknowledged.
The "Came In Acknowledged - Text Color Off" attribute can be made dynamic using the name
"MCKQTextColorOff".

3.10.13.3 Came In Acknowledged - Text Color On (CQTextColorOn)
6
Came In Acknowledged - Text Color On (CQTextColorOn)
The "Came In Acknowledged - Text Color On" attribute specifies for the selected message
type and the status "Came In Acknowledged" which color the text of the value to be displayed
assumes for flashing status "On" when the arrival of a message is acknowledged.
The "Came In Acknowledged - Text Color On" attribute can be made dynamic using the name
"CQTextColorOn".
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3.10.13.3 Came In Acknowledged - Text Color On (MCKQTextColorOn)
7
Came In Acknowledged - Text Color On (MCKQTextColorOn)
The "Came In Acknowledged - Text Color On" attribute specifies for the selected message
type which color the text of the button assumes for the flashing status "On" when the arrival
of a message is acknowledged.
The "Came In Acknowledged - Text Color On" attribute can be made dynamic using the name
"MCKQTextColorOn".

3.10.13.3 Using global alarm classes (UseGlobalAlarmClasses)
8
Using global alarm classes (UseGlobalAlarmClasses)
Defines whether to use ob globally configured alarm classes to visualize message events. The
property is only relevant to PCS7 projects.
Yes

Activates the global settings made in PCS7 alarm editor for visualizing the message events.

No

Visualization of the message events is defined locally for each message class.

The property cannot be assigned dynamic functionality.

3.10.13.3 Message Type (MessageClass)
9
Message Type (MessageClass)
The "Message Type" attribute shows all message types that can be configured for the group
display and the extended analog and status display. They configure the type of message using
a bit in the group value.
For each message type, you can configure the following attributes for the statuses "Came in",
"Came in acknowledged" and "Went unacknowledged":
● Font color
● Background color
● Flashing text
● Flashing background
A change of attribute applies to the selected message type.
The "Message Type" attribute can be made dynamic with the name "MessageClass".
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3.10.14

The "Object" Property Group

3.10.14.1 Layer (Layer)
Layer (Layer)
The "Layer" attribute specifies the position of an object in the picture.
In the Graphics Designer, a picture consists of 32 layers in which the objects can be inserted.
Objects of the layer 0 are located at the screen background, while objects of the layer 32 are
located in the foreground.
Depending on certain events, the Layer object can be used with VBScript to obtain access to
the properties of a complete layer in order, for example, to hide or unhide a layer with operating
elements according to the operator authorization. More information is available in the VBS
Reference in the Information System.
0 - 31

There is a free choice of layer for each object.

The "Layer" attribute cannot be changed in Runtime. However, layers can be hidden or
unhidden in Runtime.
The following WinCC controls are displayed in separate windows and cannot be integrated in
the picture layer system:
● WinCC OnlineTableControl
● WinCC OnlineTrendControl
● WinCC UserArchiveControl
● WinCC AlarmControl
● WinCC FunctionTrendControl
● WinCC RulerControl
● .Net Control
● WinCC Web Control
● Application window
You can assign a layer to these controls, but this setting will be ignored in Runtime.

3.10.14.2 Faceplate Type FPT
Faceplate Type FPT
The "Faceplate type" attribute shows the file name of the respective faceplate type.
The attribute is defined by selecting the faceplate type and cannot be changed.
The "Faceplate type" attribute cannot be made dynamic.

3.10.14.3 Window Contents (Application)
Window Contents (Application)
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The "Window Contents" attribute specifies for an application window which application is to be
displayed. Application windows can be supplied from applications of the Global Script and the
report system. In Runtime, these applications open an application window, transfer information
and enable operation.
Global Scripts

The application window is supplied by applications of the Global Script.

Print Jobs

The application window is supplied by the report system.

The "Window Contents" attribute cannot be made dynamic.

3.10.14.4 Object Name (ObjectName)
Object Name (ObjectName)
The "Object Name" attribute specifies the name of an object in the picture. The object name
is unique within a picture and, for example, is used in the project engineering of C actions for
the call instruction of the object.
When an object is inserted, the object name assigned as standard is the description of the
object type with a consecutive number. This name can be changed using the "Object Name"
attribute.
There is a free choice of object name and it can have a length of up to 128 characters without
restriction.
The "Object Name" attribute cannot be made dynamic.

3.10.14.5 Template (Template)
Template (Template)
The "Template" attribute specifies for an application window which template is to be used for
display of the window contents. The available templates depend on the value of the "Window
Contents" attribute.
Application windows can be supplied from applications of the Global Script and the report
system.
GSC Diagnostics

The application window is supplied by applications of the Global Script. The results of the
diagnosis system are displayed.

GSC Runtime

The application window is supplied by applications of the Global Script. The analysis results
regarding characteristics in Runtime are displayed.

All Jobs

The application window is supplied by the report system. The available reports are displayed as
a list.

All Jobs – Shortcut Menu

The application window is supplied by the report system. The available reports are displayed as
a list. The shortcut menu enables the selection of print options, display of a print preview as well
as a printout of the log.

Job Detail View

The application window is supplied by the report system. The available reports are displayed in
a selection menu. Detailed information is displayed for the selected report.

Selected Jobs - Shortcut
Menu

The application window is supplied by the logging system. The available reports are displayed
as a list. This list only contains reports which you have activated the option "Mark for print job
list" in the "Print Job Properties" dialog. The shortcut menu enables the selection of print options,
display of a print preview as well as a printout of the log.
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The "Template" attribute cannot be made dynamic.

3.10.15

"Font" Property Group

3.10.15.1 Bold (FontBold)
Bold (FontBold)
The "Bold" attribute specifies whether or not the text in an object is displayed as bold.
Yes

The text is displayed in bold face.

No

The text is not displayed in bold face.

The "Bold" attribute can be made dynamic with the name "FontBold".

3.10.15.2 Format (Format)
Format (Format)
The "Format" attribute shows in which format the value of the analog display is displayed.
No Character

Displays the number without formatting.

(0)

Displays a digit or a zero.

(#)

Displays a digit or no output.

(.)

Placeholder for decimal character.

(%)

Placeholder for percentage.

(,)

Thousand separator.

( ( E- E+ e- e+ )

Scientific format.

-+$()

Display of a literal character.
Display the next character in the format character sequence.

( ( "ABC" )

Displays the string in inverted commas (" ").

The "Format" attribute can be made dynamic with the name "Format".

3.10.15.3 Index (Index)
Index (Index)
The "Index" attribute is a help attribute that is used in the "Object properties" dialog for
accessing text of fields or lines of the object.
● The number of the fields of an object is defined with the "Number of Boxes" attribute in the
"Geometry" properties group to determine the supply of values for the "Index" attribute.
● The number of the lines of an object is defined with the "Number of rows" attribute in the
"Geometry" properties group to determine the supply of values for the "Index" attribute.
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Use the "Index" attribute to set the position number of the field or the line that you want to
display or edit. The content of the field or the line is shown as a value of the "Text" attribute.
Changing the "Index" attribute also changes the displayed value of the "Text" attribute.
1 - "Number of Boxes"

Check Box, Radio Box

1 - "Number of rows"

Combination field, List field

The "Index" attribute can be made dynamic with the name "Index".

3.10.15.4 Italic (FontItalic)
Italic (FontItalic)
The "Italic" attribute specifies whether or not the text in an object is displayed in italics.
Yes

The text is displayed in italic.

No

The text is not displayed in italic.

The "Italic" attribute can be made dynamic with the name "FontItalic".

3.10.15.5 Text Orientation (Orientation)
Text Orientation (Orientation)
The "Text Orientation" attribute specifies whether a text appears with a vertical or horizontal
orientation. Changing the attribute only changes the position of the text within an object, while
the object itself remains unchanged.
Horizontal

The orientation of the text is from left to right.

Vertical

The orientation of the text is from top to bottom.

The "Text Orientation" attribute can be made dynamic with the name "Orientation".

3.10.15.6 Text (Text)
Text (Text)
The "Text" attribute specifies the text for a text field. Here, for example, buttons can be labeled.
In the case of the objects "Check Box" and "Option Group", each text field is selected
individually via the "Index" attribute.
Line breaks must be entered manually: You can create a line break with either <SHIFT
+ENTER> or <CTRL+M>.
A line brake is shown in the "Object Properties" window in the "Static" column as a control
character.
A text of any length can be entered. A meaningful limit results from the object size.
The "Text" attribute can be made dynamic with the name "Text".
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3.10.15.7 Underline (FontUnderline)
Underline (FontUnderline)
The "Underline" attribute specifies whether or not the text in an object is displayed as
underlined.
Yes

The text is displayed as underlined.

No

The text is not displayed as underlined.

The "Underline" attribute can be made dynamic with the name "FontUnderline".

3.10.15.8 X alignment (AlignmentLeft)
X alignment (AlignmentLeft)
The "X Alignment" attribute specifies the horizontal alignment of a text in an object. Changing
the attribute only changes the position of the text within an object, while the object itself remains
unchanged.
On left

The text is aligned to the left in the object.

centered

The text is centered horizontally in the object.

right

The text is aligned to the right in the object.

The "X Alignment" attribute can be made dynamic with the name "AlignmentLeft".

3.10.15.9 Y alignment (AlignmentTop)
Y alignment (AlignmentTop)
The "Y Alignment" attribute specifies the vertical alignment of a text in an object. Changing the
attribute only changes the position of the text within an object, while the object itself remains
unchanged.
top

The text is aligned to the top of the object.

centered

The text is centered vertically in the object.

bottom

The text is aligned to the bottom of the object.

The "Y Alignment" attribute can be made dynamic with the name "AlignmentTop".

3.10.15.1 Font (FontName)
0
Font (FontName)
The "Font" attribute specifies in which font a text appears. You can use every font that is
installed in the Windows operating system.
If a selected font is not available on a system, the text is automatically displayed in "Arial".
Any of the fonts installed in the Windows operating system can be selected.
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The "Font" attribute can be made dynamic with the name "Font Name".

3.10.15.1 Font Size (FontSize)
1
Font Size (FontSize)
The "Font Size" attribute specifies in which font size a text appears. The values are specified
in points.
The "Font Size" attribute can be made dynamic with the name "FontSize".

3.10.16

"Miscellaneous" Property Group

3.10.16.1 Others - A to B
Update Cycle (UpdateCycle)
Update Cycle (UpdateCycle)
The "Update Cycle" attribute defines the type and the frequency for updating a process picture.
The value specified here corresponds to the "picture cycle", which can be set as the update
cycle for individual objects. In this case, the display of these objects will be updated at the
same time as the display of the process picture.
The "Update Cycle" attribute cannot be made dynamic.

Update Cycle (UpdateCycle)
Update Cycle (UpdateCycle)
The "Update Cycle" defines the type and the frequency of the update for a picture window.
The "Update Cycle" attribute cannot be made dynamic.

Display (Visible)
Display (Visible)
The "Display" attribute specifies whether or not a process picture is displayed in Runtime.
Yes

The process picture is displayed in Runtime.

No

The process picture is not displayed in Runtime.

The "Display" attribute can be made dynamic with the name "Visible".

Display (Visible)
Display (Visible)
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The "Display" attribute specifies whether or not an object is displayed in Runtime.
Yes

The object is displayed in Runtime.

No

The object is not displayed in Runtime.

The "Display" attribute can be made dynamic with the name "Visible".

Display name (DisplayName)
Display name (DisplayName)
Specifies the user-defined name of the process picture. The attribute is of type "Multilingual
String". You can specify names for all languages installed in WinCC.
The "Display name" attribute can be dynamized with the "DisplayName" name.

Display Options (DisplayOptions)
Display Options (DisplayOptions)
The "Display Options" attribute specifies whether a button will be allocated with a picture or
text or both.
0

Picture or text: If a picture exists, the button is assigned with the picture, otherwise it is assigned with text.

1

Picture and text

2

Text only

3

Picture only

The "Display Options" attribute can be made dynamic with the name "DisplayOptions".

Assembly Info
Assembly Info
Displays the information of the object registered in the Global Assembly Cache. The
information is made up of "Assembly", "Version", "Culture" and "PublicKeyToken".
If the object is not registered in the Global Assembly Cache, the path of the object is only
displayed in "Assembly".
The "Assembly Info" attribute cannot be made dynamic.

Operator-Control Enable (Operation)
Operator-Control Enable (Operation)
The "Operator-Control Enable" attribute specifies whether or not a process picture can be
operated in Runtime.
In order to be able to operate a process picture, the operator must have the relevant
authorization. You specify this with the "Authorization" attribute.
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Yes

The process picture can be operated in Runtime.

No

The process picture cannot be operated in Runtime.

The "Operator-Control Enable" attribute can be made dynamic with the name "Operation".

Operator-Control Enable (Operation)
Operator-Control Enable (Operation)
The "Operator-Control Enable" attribute specifies whether or not an object can be operated in
Runtime.
In order to be able to operate an object, the operator must have the relevant authorization.
You specify this with the "Authorization" attribute.
Yes

The object can be operated in Runtime.

No

The object cannot be operated in Runtime.

The "Operator-Control Enable" attribute can be made dynamic with the name "Operation".

Operator Input Message (OperationMessage)
Operator Input Message (OperationMessage)
The "Operator Input Message" attribute specifies whether or not a message is displayed after
operation of the object. The object must be connected to a tag.
If the attribute "Operator Input Message" has been set to "yes", a message is generated upon
operation, sent to the message system and archived. Using the message system, a message
may be output in a message line, for example.
So that the operator can enter a reason for the operation after its completion, the "Operator
Activities Report" attribute must be enabled. The reason for the operator input is displayed as
a comment for the operator input message in the long-term archive list.
Yes

An operator output message is displayed.

No

An operator output message is not displayed.

The "Operator Input Message" attribute can be made dynamic with the name
"OperationMessage".

Operator Actions Report (OperationReport)
Operator Actions Report (OperationReport)
The "Operator Activities Report" attribute specifies whether the reason for an operation will be
logged by the operator. The operator activities report is archived in the message system. The
reason for the operator input is displayed as a comment for the operator input message in the
long-term archive list.
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Yes

The reason for the operation is logged. On operation of the object, a dialog opens in Runtime in which the
operator can enter a text.

No

The reason for the operation is not logged.

The "Operator Activities Report" attribute can be made dynamic with the name
"OperationReport".

Operation Steps (SmallChange)
Operation Steps (SmallChange)
The "Operation Steps" attribute specifies for the slider the number of steps the slider is moved
in the corresponding direction with one mouse-click on the slide surface.
The number of times to click on the slider surface for the slider to move from one end to the
other is calculated as follows: ("maximum value" - "minimum value") / "operation steps".
Example: Where maximum value = 100, minimum value = 0, operation steps = 25 the slider
surface must be clicked four times to move the slider from one end to the other.
With one mouse-click on the slide surface, the slider can be set to the minimum or maximum
value if the "Extended Operation" attribute has the value "Yes".
There is a free choice of value.
The "Operation Steps" attribute can be made dynamic with the name "SmallChange".

User Value (UserValue1)
User Value (UserValue1)
The "User Value 1" to "User Value 4" attributes make it possible to enter sample values for a
group display. Any values can be entered and, for example, evaluated in a script. In Runtime,
the entered user values are neither displayed nor evaluated.
0 (232-1)

The value can be chosen freely within the specified limits.

The "User Value 1" attribute can be made dynamic with the name "UserValue1".
The "User Value 2" attribute can be made dynamic with the name "UserValue2", etc.

Authorization (PasswordLevel)
Authorization (PasswordLevel)
The User Administrator editor is used in WinCC to assign authorizations for the users. In the
Graphics Designer, an authorization can be assigned for each process picture, which means
that this process picture can only be operated by those users who have the corresponding
authorization.
So that a process picture can be operated, the "Operator-Control Enable" attribute must have
the value "Yes".
The "Authorization" attribute can be made dynamic with the name "PasswordLevel".
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Authorization (PasswordLevel)
Authorization (PasswordLevel)
The User Administrator editor is used in WinCC to assign authorizations for the users. In the
Graphics Designer, an authorization can be assigned for each object, which means that this
object can only be operated by those users who have the corresponding authorization.
So that an object can be operated, the "Operator-Control Enable" attribute must have the value
"Yes".
The "Authorization" attribute can be made dynamic with the name "PasswordLevel".

Preferred picture target (PreferredTarget)
Preferred picture target (PreferredTarget)
The "Preferred picture target" attribute specifies where the picture change is carried out by the
Favorites browser.
Yes

The picture change is carried out in this picture screen. In the case of nested picture screens the picture change
is carried out at the innermost picture screen with the "Yes" setting.

No

The picture change is carried out in the main screen.

The "Preferred picture target" attribute can be made dynamic with the name "PreferredTarget".

Adapt Picture (AdaptPicture)
Adapt Picture (AdaptPicture)
The "Adapt Picture" attribute specifies whether or not the picture displayed in a picture window
adapts to the size of the picture window in Runtime.
Yes

The picture adapts to the size of the picture window in Runtime.

No

The picture does not adapt to the size of the picture window in Runtime.

The "Adapt Picture" attribute cannot be made dynamic.

Picture Status Off (PictureUp)
Picture Status Off (PictureUp)
A button can have one of two statuses: "On" or "Off".
For each status, a picture to be displayed can be selected. Pictures with the following formats
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.
The "Picture Status Off" attribute can be made dynamic with the name "PictureUp".

Picture Status On (PictureDown)
Picture Status On (PictureDown)
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A button can have one of two statuses: "On" or "Off".
For each status, a picture to be displayed can be selected. Pictures with the following formats
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.
The "Picture Status On" attribute can be made dynamic with the name "PictureDown".

Picture Name (PictureName)
Picture Name (PictureName)
The "Picture Name" attribute specifies which picture is displayed in a picture window. Only
pictures of the format PDL that belong to the current project can be inserted.
If no picture to be displayed is defined for a picture window, the picture window is not displayed
in Runtime.
The "Picture Name" attribute can be made dynamic with the name "PictureName".

Picture Offset X (OffsetLeft)
Picture Offset X (OffsetLeft)
A process picture that is embedded in a picture window can only be displayed as a zoom area.
The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset Y"
attributes.
The "Picture Offset X" specifies the horizontal coordinates for the origin of the zoom area. The
values are specified in pixels.
There is a free choice of value. A meaningful limit results from the size of the integrated picture.
The "Picture Offset X" attribute can be made dynamic with the name "OffsetLeft".

Picture Offset Y (OffsetTop)
Picture Offset Y (OffsetTop)
A process picture that is embedded in a picture window can only be displayed as a zoom area.
The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset Y"
attributes.
The "Picture Offset Y" specifies the vertical coordinates for the origin of the zoom area. The
values are specified in pixels.
There is a free choice of value. A meaningful limit results from the size of the integrated picture.
The "Picture Offset Y" attribute can be made dynamic with the name "OffsetTop".

Bit Pattern Group Display (SignificantMask)
Bit Pattern Group Display (SignificantMask)
The value of the attribute is an internal system output value. The value is updated if the group
display is clicked for a loop-in-alarm.
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The "Bit Pattern Group Display" attribute should not be made dynamic by the user.

3.10.16.2 Others - C to O
Control Type
Control Type
Displays the name space of the control.
The "Control type" attribute cannot be made dynamic.

Cursor Mode
Cursor mode
The "Cursor Mode" attribute specifies whether a process picture is operated in Runtime by
means of an "Alpha Cursor" or a "Tab Order".
The cursor mode can be toggled in Runtime if a hotkey is configured for the toggle.
Alpha-Cursor

Operation in Runtime is by means of the Alpha Cursor.

Tab order cursor

Operation in Runtime is by means of Tab Order.

The "Cursor Mode" attribute cannot be made dynamic.

Cursor Control (CursorControl)
Cursor Control (CursorControl)
The "Cursor Control" attribute specifies whether the Alpha Cursor automatically jumps to the
next field in the TAB sequence after an entry has been made in a field. This function enables
rapid input in different fields without having to use the tab key to jump.
Yes

The cursor automatically jumps to the next field of the TAB sequence after the input has been made.

No

The cursor does not automatically jump to the next field of the TAB sequence after the input has been made.

The "Cursor Control" attribute can be made dynamic with the name "CursorControl".

Date of Last Change
Date of last change
The "Date of Last Change" attribute shows the date on which the process picture was last
saved.
The "Date of Last Change" attribute cannot be made dynamic.

Immediate Input (EditAtOnce)
Immediate Input (EditAtOnce)
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The "Immediate Input" attribute specifies for input fields whether or not a direct change is made
into the input mode on jumping to the object.
Yes

When the focus moves to the object, the input mode is immediately active.

No

When the focus moves to the object, the input mode is not immediately active.

The "Immediate Input" attribute can be made dynamic with the name "EditAtOnce".

Extended Operation (ExtendedOperation)
Extended Operation (ExtendedOperation)
The "Extended Operation" attribute specifies whether the slider jumps on the slide surface in
one step to the minimum value or maximum value when clicked.
Yes

With one mouse-click on the slide surface, the slider jumps to the minimum value or maximum value.

No

With a mouse-click on the slide surface, the slider is moved in the corresponding direction by the value set in
the "Operation Steps" attribute.

The "Extended Operation" attribute can be made dynamic with the name "ExtendedOperation".

Extended Zooming (ExtendedZoomingEnable)
Extended Zooming (ExtendedZoomingEnable)
The "Extended Zooming" specifies whether the picture can be zoomed in on or out of for the
selected process picture with the mouse wheel. Requirements for using the zoom function:
● a mouse driver by Logitech or Microsoft Intellimouse
● the mouse wheel must be set to "Autoscroll".
● The "Extended Zooming" function must be enabled in the "Graphics Runtime" tab of the
"Computer Properties" dialog for all process pictures.
Yes

The mouse wheel can be used to zoom in on or out of the picture. Press the <CTRL> key in Runtime, while
you turn the mouse wheel. If you turn the mouse wheel away from the palm of your hand, you increase the
zoom factor.

No

Rotating the mouse wheel does not zoom in on or out of the picture, even if extended zooming is enabled for
all process pictures.

The "Extended Zooming" attribute can be made dynamic with the name
"ExtendedZoomingEnable".

Change Color (ColorChangeType)
Change Color (ColorChangeType)
The "Change Color" attribute specifies for the "Bar" object whether a color change is run
segment-wise or for the entire bar. With segment-wise display, for example, it is possible to
visualize which limits are exceeded by the displayed value.
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Total

When a limit is reached, the entire bar changes color.

Segment

When a limit is reached, the bar changes segment by segment. The color allocation takes place
in accordance with the settings in the "Limits" property group.

The "Change Color" attribute can be made dynamic with the name "ColorChangeType".

Adapt Size (AdaptSize)
Adapt Size (AdaptSize)
The "Adapt Size" attribute specifies whether or not the picture window adapts to the size of
the embedded picture in Runtime.
Yes

The picture window adapts to the size of the picture in Runtime.

No

The picture window does not adapt to the size of the picture in Runtime.

The "Adapt Size" attribute cannot be made dynamic.

Windows Position Mode
Windows Position Mode
The "Window mode" attribute defines the position and scaling of the picture window on the
screen. It is only effective if the "Independent window" attribute is set to "Yes".
Standard
Center
Maximize

The picture window is positioned in its original size in the configured position
on the screen.
The picture window is positioned in its original size, centered on the screen.
The picture window is scaled to the size of the screen.

Outgoing State Visible (AlarmGoneVisible)
Outgoing State Visible (AlarmGoneVisible)
The attribute "Outgoing State Visible" defines for an object whether an outgoing state is visible
or not.
Yes

The outgoing state is visible

No

The outgoing state is suppressed

The "Outgoing State Visible" attribute can be made dynamic with the name
"AlarmGoneVisible".

Sizeable (Sizeable)
Sizeable (Sizeable)
The "Sizeable" attribute specifies whether or not the size of a window can be changed in
Runtime.
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Yes
No

The size of the window can be changed in Runtime.
The size of the window cannot be changed in Runtime.

The "Sizeable" attribute cannot be made dynamic.

Hotkey (Hotkey)
Hotkey (Hotkey)
As an alternative to operation with the mouse, a button can also be triggered using the
keyboard.
To do so, a hotkey must be set.
If a hotkey has been defined for a button, an arrow is displayed in the object properties beside
the "Hotkey" attribute.
The "Hotkey" attribute cannot be made dynamic.

Hysteresis (Hysteresis)
Hysteresis (Hysteresis)
So that a color change is not triggered immediately in the case of a slight limit violation, the
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for
the display of the value.
The "Hysteresis" attribute specifies for the "Bar" object whether the display with hysteresis is
permitted or not.
Set the hysteresis value with the "Hysteresis Range" attribute.
Yes

Display with hysteresis.

No

Display without hysteresis.

The "Hysteresis" attribute can be made dynamic with the name "Hysteresis".

Hysteresis Range (HysteresisRange)
Hysteresis Range (HysteresisRange)
So that a color change is not triggered immediately in the case of a slight limit violation, the
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for
the display of the value.
The "Hysteresis Range" attribute specifies for the "Bar" object the hysteresis as a percentage
of the display range.
The "Hysteresis Range" attribute can be made dynamic with the name "HysteresisRange".

Maximum Value (Max)
Maximum Value (Max)
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The "Maximum Value" attribute specifies the absolute value for display of the largest value for
bars, 3D bars and sliders.
The hysteresis range is only taken into account if the "Hysteresis" attribute has the value "Yes".
There is a free choice of value.
The "Maximum Value" attribute can be made dynamic with the name "Max".

Can Be Maximized (MaximizeButton)
Can Be Maximized (MaximizeButton)
The "Can Be Maximized" attribute specifies whether or not a window can be enlarged to the
maximum screen size in Runtime.
The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value
"Yes".
Yes

The window can be maximized in Runtime.

No

The window cannot be maximized in Runtime.

The "Can Be Maximized" attribute cannot be made dynamic.

Menu/Toolbar Configuration (MenuToolBarConfig)
Menu/Toolbar Configuration
Defines the configuration file using the user-defined menus and toolbars that are displayed in
the picture screen.
The "Menu/Toolbar Configuration" attribute can be made dynamic using the
""MenuToolBarConfig"" name.

Minimum Value (Min)
Minimum Value (Min)
The "Minimum Value" attribute specifies the absolute value for display of the smallest value
for bars, 3D bars and sliders.
There is a free choice of value.
The "Minimum Value" attribute can be made dynamic with the name "Min".

Average Value (Average)
Average Value (Average)
The "Average Value" attribute specifies whether or not a mean value of the last 10 values is
formed for the "Bar" object. A value has to change for a new average value to be formed. The
average value is reset when you change the picture. If only one value exists after you change
the picture, for example, the following average value is formed: (5+0+0+0+0+0+0+0+0+0)/
10=0,5.
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Yes

An average value of the last 10 values is formed.

No

An average value is not formed.

The "Average Value" attribute can be made dynamic with the name "Average".

Monitor number (WindowMonitorNumber)
Monitor number (WindowMonitorNumber)
The "Monitor number" attribute specifies the monitor that displays the picture window. This
requires that your system supports more than one monitor.
The attribute is only effective if the "Independent window" attribute is set to "Yes".
1-n

The number of the monitor in the operating system on which the picture window is displayed.

Zero Point Value (ZeroPointValue)
Zero Point Value (ZeroPointValue)
The "Zero Point Value" attribute specifies the absolute value for the zero point of bars or 3D
bars.
The display of the zero point value on the scale is specified using the "Zero Point" attribute in
the "Axis" property group.
There is a free choice of value within the limits of "minimum value" and "maximum value".
The "Zero Point Value" attribute can be made dynamic with the name "ZeroPointValue".

3.10.16.3 Others - P to S
Password protection
The "Password protection" attribute can be assigned to any process picture or faceplate type.
enabled

The process picture or faceplate type is protected by password.

disabled

The process picture or faceplate type is not protected by password.

The "Password protection" attribute cannot be assigned dynamic properties.

Process Driver Connection (Process)
Process Driver Connection (Process)
If an object of the type "Bar", "3D Bar" or "Slider" is not embedded using a tag in the process,
the object accesses a preset value in Runtime and displays this value.
The "Process Driver Connection" attribute specifies the default setting for the value to be
displayed.
There is a free choice of value.
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The "Process Driver Connection" attribute can be made dynamic with the name "Process".

Acknowledgment Sample (EventQuitMask)
Acknowledgment Sample (EventQuitMask)
The events "Operator request" and "Measuring point blocked" are not acknowledgeable events
in the PCS 7 environment. Using the "@EventQuit" tag and the "Acknowledgment mask"
attribute of the group display in Runtime, these events are automatically indicated as
acknowledged to prevent flashing during the calculation of the group displays and the display
of the area overview. The start value of the attribute is then 0x00000011 (17). The value of the
"Acknowledgment mask" attribute should be identical for all group display objects, extended
analog display and extended status display, and for the "@EventQuit" tag.
You can set the acknowledgment behavior of "Tolerance" in the OS Project Editor.
By setting other acknowledgment bits, you can indicate other events as being acknowledged
as well with the display of the group display object and the extended analog and status display.
In the projects prior to WinCC V7.01 the events "ToleranceLow", "ToleranceHigh", "Operator
Request" and "Measuring point blocked" are not acknowledgeable events in the PCS 7
environment. By default the tag has the start value 0x00000C11 (3089). These are precisely
the acknowledgment bits for "ToleranceLow", "ToleranceHigh", "Operator Request" and
"Measuring point blocked."

Border (WindowBorder)
Border (WindowBorder)
The "Border" attribute specifies whether or not an application window or picture window is to
be displayed with a border.
If the "Sizeable" attribute for a window is set to the value "Yes", the "Border" attribute
automatically assumes the value "Yes".
So that the picture window is displayed in Runtime, a picture must be embedded.
Yes

The window is displayed with a border.

No

The window is displayed without a border.

The "Border" attribute cannot be made dynamic.

Adapt Border (AdaptBorder)
Adapt Border (AdaptBorder)
The "Adapt Border" attribute defines for objects that contain text whether the field border adapts
dynamically to the text size.
The dynamic change of the text in the field can cause the field size to change continuously in
Runtime.
The performance in Runtime is higher if the "Adapt Border" attribute has the value "No".
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Yes

The field border resizes dynamically to fit the text size.

No

The field border retains its size regardless of the text.

The "Flash Picture" attribute cannot be made dynamic.

Scroll Bars (ScrollBars)
Scroll Bars (ScrollBars)
The "Scroll Bars" attribute specifies whether or not a picture window is displayed with a scroll
bar if required. This setting is only visible in Runtime.
The "Scroll Bars", "Adapt Size" and "Adapt Picture" attributes can influence one another.
Yes

The picture window is displayed in Runtime with scroll bars if the picture to be displayed does not fit in the
picture window.

No

The picture window is always displayed in Runtime without scroll bars, even if the picture to be displayed does
not fit in the picture window.

The "Scroll Bars" attribute cannot be made dynamic.

Scroll Bar Position X (ScrollPositionX)
Scroll Bar Position X (ScrollPositionX)
The "Scroll Bar Position X" attribute specifies the horizontal movement of the scroll bar position
in a picture window with the scroll bar. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the size of the integrated picture.
The "Scroll Bar Position X" can be made dynamic with the name "ScrollPositionX".

Scroll Bar Position Y (ScrollPositionY)
Scroll Bar Position Y (ScrollPositionY)
The "Scroll Bar Position Y" attribute specifies the vertical movement of the scroll bar position
in a picture window with the scroll bar. The values are specified in pixels.
There is a free choice of value. A meaningful limit results from the size of the integrated picture.
The "Scroll Bar Position Y" attribute can be made dynamic with the name "ScrollPositionY".

Group Relevant (Relevant)
Group Relevant (Relevant)
All displays in a class can be grouped hierarchically into a group display. This makes possible
a rapid overview of alarms, warnings and malfunctions.
The "Group Relevant" attribute specifies for the object whether or not the object is taken into
account for the formation of the group, extended analog or status display.
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Yes

The object is taken into account for the formation of the group display.

No

The object is not taken into account for the formation of the group display.

The "Group Relevant" attribute can be made dynamic with the name "Relevant".

Collect Value (CollectValue)
Collect Value (CollectValue)
All displays in a class can be grouped hierarchically into a group display. This makes possible
a rapid overview of alarms, warnings and malfunctions.
The "Collect Value" attribute specifies as an initial value the current status of the active
message classes in each case.
So that an object of the group display type is taken into account for the formation of the group,
extended analog or status display, the "Group Relevant" attribute must have the value "Yes".
When a new group display is inserted, it has the collect value 65535 as start value. In this
manner, you can ensure that at the start - from the view of the group display - there are no
unacknowledged messages.
The group value is controlled by a tag. Other types of dynamization are not possible.

Use Group Value for Display (UseEventState)
Use Group Value for Display (UseEventState)
The "Use Group Value for Display" attributed defines for the extended status display whether
the group value is evaluated for the display of the statuses.
If the group value is used, you can assign pictures for the individual alarm statuses.
Yes

The group value is taken into consideration for the display of the extended status display.

No

The group value is not taken into consideration for the display of the extended status display.

The attribute "Use Group Value for Display" can be made dynamic with the name
"UseEventState".

Can be Closed (CloseButtton)
Can be Closed (CloseButtton)
The "Can Be Closed" attribute specifies whether or not a window can be closed in Runtime.
The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value
"Yes".
Yes

The window can be closed in Runtime.

No

The window cannot be closed in Runtime.

The "Can Be Closed" attribute cannot be made dynamic.
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Selected text (SelText)
Selected text (SelText)
The "Selected text" attribute shows the text defined with the "Selected box" attribute, which is
highlighted in the object.
You cannot directly change the "Selected text" attribute. You change the "Selected text"
attribute by changing the "Selected box" attribute or the text itself in the "Font" properties group.
The "Selected text" attribute can be made dynamic with the name "SelText".

Selected box (SelIndex)
Selected box (SelIndex)
The "Selected box" attribute defines the index, the text of which is highlighted in the
combination field or the list field.
1 - Number of rows

Index of the highlighted field

The "Selected Box" attribute can be made dynamic with the name "SelIndex".

Server Prefix (ServerPrefix)
Server Prefix (ServerPrefix)
Pictures that are embedded can be stored on any server in a multi-client system. Either the
server is specified directly on embedding a picture, or assigned later via the object properties
of the picture window.
The "Server Prefix" attribute specifies on which server the picture to be displayed in the picture
window is located.
Changes to the server prefix only take effect when the picture is loaded once again. When the
picture is changed, this occurs automatically, otherwise the picture name must be reassigned.
The "Server Prefix" attribute can be made dynamic with the name "ServerPrefix".

ServerName (ServerName)
ServerName (ServerName)
The "ServerName" attribute indicates under which name an embedded object is registered in
the Windows operating system. A change of the registration is not possible in the Graphics
Designer.
The "ServerName" attribute cannot be made dynamic.

Simulation (Simulation)
Simulation (Simulation)
With the "Simulation" attribute, you define the linking with any tag which is used for simulation.
The "Simulation" attribute can be made dynamic with the name "Simulation".
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Simulation Bit (SimulationBit)
Simulation Bit (SimulationBit)
The "Simulation Bit" attribute shows the bit position of the linked simulation tags that are used
for evaluation.
The value of the simulation tag is only evaluated with the alarm status "OK".
The "Simulation Bit" attribute can be made dynamic with the name "SimulationBit".

Scaling Factor (Zoom)
Scaling Factor (Zoom)
The "Scaling Factor" attribute sets the zoom factor for the display of the picture in the picture
window. The values are specified as a percentage.
1 - (231-1)

The value can be chosen freely within the specified limits.

The "Scaling Factor" attribute can be made dynamic with the name "Zoom".

Customized object scaling mode (ScalingMode)
Scaling mode (ScalingMode)
The "Scaling mode" attribute specifies how the internal objects of the customized object are
displayed when the customized object is scaled.
proportional

The internal objects are scaled proportionally with respect to size, font size, and position.
Controls do not support proportional scaling.

Not proportional

The internal objects are only repositioned with their size. The font size is not scaled. (default
setting)

The "Scaling mode" attribute cannot be dynamized.
Note
The scaling mode is not taken into consideration in editing mode. The customized object is
displayed in its original size.

Faceplate scaling mode (ScalingMode)
Scaling Mode
The "Scaling mode" attribute defines the size to display the objects of the faceplate instance.
proportional

The faceplate type is scaled in proportion with the size of the faceplate instance.

1:1

The faceplate type is displayed in its original size when you insert a faceplate instance if the
scaling mode of the default faceplate instance is set to "1 : 1".

Not proportional

The faceplate type is not scaled in proportion to the size of the faceplate instance.
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The "Scaling mode" attribute cannot be made dynamic.

Configured Languages (DataLanguage)
Configured Languages (DataLanguage)
The "Configured Languages" attribute specifies in which language variant an entry in a text
object is displayed.
The "Configured Languages" attribute can only be modified if the individual languages have
been set beforehand in the "View" "Languages" menu. With the "Configured Languages"
attribute, configured languages can only be deleted, not added.
The "Configured Languages" attribute cannot be made dynamic.

Status (ProcessValue)
Status (ProcessValue)
With the "Status" attribute, you define the linking with any tag.
The "Status" attribute can be made dynamic with the name "ProcessValue".

Status1 (Process)
Status1 (Process)
In the "Status1" attribute, you can preset the first tag used for the calculation of the status value
for the extended status display. In the configuration dialog of the extended status display, you
can define the bit position taken into account for the status value calculation of this tag. This
results in the statuses, to which you can then assign pictures.
The "Status1" attribute can be made dynamic with the name "Process".

Status2 (Process1)
Status2 (Process1)
In the "Status2" attribute, you can preset the second tag used for the calculation of the status
value for the extended status display. In the configuration dialog of the extended status display,
you can define the bit position taken into account for the status value calculation of this tag.
This results in the statuses, to which you can then assign pictures.
The "Status2" attribute can be made dynamic with the name "Process1".

Status3 (Process2)
Status3 (Process2)
In the "Status3" attribute, you can preset the third tag used for the calculation of the status
value for the extended status display. In the configuration dialog of the extended status display,
you can define the bit position taken into account for the status value calculation of this tag.
This results in the statuses, to which you can then assign pictures.
The "Status3" attribute can be made dynamic with the name "Process2".
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Status4 (Process3)
Status4 (Process3)
In the "Status4" attribute, you can preset the fourth tag used for the calculation of the status
value for the extended status display. In the configuration dialog of the extended status display,
you can define the bit position taken into account for the status value calculation of this tag.
This results in the statuses, to which you can then assign pictures.
The "Status4" attribute can be made dynamic with the name "Process3".

3.10.16.4 Others - T to Z
Tag (tag)
Tag (tag)
The "Tag" attribute is used for the Tool Graphic Object Update Wizard and is not evaluated
for the object.
The "Tag" attribute can be made dynamic with the name "tag".

Tagname (tagname)
Tagname (tagname)
The attribute "Tag Name" is used for the Tool Graphic Object Update Wizard and is not
evaluated for the object.
The "Tag Name" attribute can be made dynamic with the name "tagname."

Tagtype (tagtype)
Tagtype (tagtype)
The "Tag Type" attribute is used for the Tool Graphic Object Update Wizard and is not
evaluated for the object.
The "Tag Type" attribute can be made dynamic with the name "tagtype."

Text Reference (LanguageSwitch)
Text Reference (LanguageSwitch)
The "Text Reference" attribute specifies where the language-dependent assignment texts are
stored:
Yes

The texts are managed in the text library. They are translated into other languages in the text library.

No

The texts are managed directly in the object.

The "Text Reference" attribute cannot be made dynamic.
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Title (Caption)
Title (Caption)
The "Title" attribute specifies whether a window is displayed in Runtime with or without a title
bar.
The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value
"Yes".
Yes

In Runtime, the window is displayed with a title bar.

No

In Runtime, the window is displayed without a title bar.

The "Title" attribute cannot be made dynamic.

Tooltip text (ToolTipText)
Tooltip text (ToolTipText)
The "Tooltip text" attribute specifies the tooltip text to display in Runtime by positioning the
mouse pointer on the object. The tooltip text can be entered for all available languages.
To define a tooltip text which contains the special character "&", enter three successive
commercial ampersands, e.g. Save &&& Close
Two "&" have the effect of underlining the next character. This is only possible for one character
per tooltip text. If you use the "&&" several times in a text, only the character after the last use
of "&&" is underlined.
One "&" has no function.
The "Tooltip text" attribute can be assigned dynamic properties by means of the name
"ToolTipText".

Trend (trend)
Trend (trend)
The attribute "Trend" is used for the Tool Graphic Object Update Wizard and is not evaluated
for the object.
The "Trend" attribute can be made dynamic with the name "trend."

Trend (Trend)
Trend (Trend)
The trend display enables a fast overview of changes for the bar. As standard, when the values
shown in the scale are exceeded, a small arrow is displayed beside the scale to indicate that
the measured value cannot be displayed on the scale. In order to avoid having to wait for the
next update, an additional arrow can be shown on the other side of the bar to show the trend
of the current movement of the bar.
The "Trend" attribute specifies whether or not the trend is displayed.
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Yes

The trend is displayed.

No

The trend is not displayed.

The "Trend" attribute can be made dynamic with the name "Trend".

Caption (CaptionText)
Caption (CaptionText)
The "Caption" attribute specifies which text appears in the title of a picture window.
The "Caption" attribute can be made dynamic with the name "CaptionText".

Independent window
Independent window
The "Independent window" attribute defines whether the display of the picture window in
runtime depends on the process picture in which the picture window was configured.
Yes

Size and position of the picture window are independent of the process picture and only defined by the "Window
mode" attribute

No

Size and position of the picture window change with the shift or scaling of the process picture

Tag Prefix (TagPrefix)
Tag Prefix (TagPrefix)
WinCC offers a wide variety of possibilities to define and structure tags. For a picture window,
a tag prefix can be assigned to precede all tags that are used in the picture. In this way, a
picture that is embedded in a picture window retains access to its own tags while another
accesses other tags.
The "Tag Prefix" attribute specifies the prefix that is placed before all tags present in the picture.
Changes to the tag prefix only take effect when the picture is loaded once again. When the
picture is changed, this occurs automatically, otherwise the picture name must be reassigned.
The prefix can be freely defined, but must match the name of the structure tags. It must end
with a period, for example "Structure2.".
The "Tag Prefix" attribute can be made dynamic with the name "TagPrefix".
The TagPrefix property is not available for the controls.

Visualize tag status (ShowBadTagState)
Visualize tag status (ShowBadTagState)
The "Visualize tag status" attribute defines whether the graphic object is grayed out when a
bad QualityCode or tag status is detected. For the two objects "extended analog display" and
"extended status display", the attribute determines whether the settings for the attributes "Grid
Color with Quality code: "bad" and "Grid Color with Quality code: "uncertain" are used.
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Yes

If the quality code or the the tag status are poor, the object is grayed out or the settings for the grid color are
used.

No

If the quality code or the the tag status are poor, the object is not grayed out or the settings for the grid color
are not used.

The "Visualize tag status" attribute can be made dynamic with the name "ShowBadTagState".

Movable (Moveable)
Movable (Moveable)
The "Movable" attribute specifies whether or not a window can be moved in Runtime.
Yes

The window can be moved in Runtime.

No

The window can not be moved in Runtime.

The "Movable" attribute cannot be made dynamic.

Directory for pictures (PictureDirectory)
Directory for pictures (PictureDirectory)
Specifies the name of the subdirectory that is created in the "GraCS" directory of the WinCC
project. If pictures are stored in the subdirectory, they are available for the extended status
display. If no subdirectory is specified or the subdirectory does not contain any pictures, the
pictures in the "GraCS" directory are taken into consideration.
The "Directory for pictures" attribute can be dynamized with the name "PictureDirectory".

Foreground (OnTop)
Foreground (OnTop)
The "Foreground" attribute specifies whether or not a window lies in the foreground. This
setting is independent of the layer in which the window lies.
If two windows overlap, and they both have the value "Yes" for the "Foreground" attribute, the
settings exclude one another.
Yes

The window is always in the foreground.

No

The window is not always in the foreground.

The "Foreground" attribute cannot be made dynamic.

Web-enabled
Web-enabled
Identifies the picture object or faceplate type as executable in the Web browser.
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Value (OutputValue)
Value (OutputValue)
With the attribute "Value", you define the linking with any analog/text tag. The analog display
represents the value of this tag in the configured colors depending on the alarm state.
The "Value" attribute can be made dynamic with the name "OutputValue".

Value as Text (UseValueText)
Value as Text (UseValueText)
The attribute "Value as Text" shows whether a text tag is linked instead of a formatted analog
value.
Yes

The value is linked with a text tag.

No

The value is not linked with a text tag

The "Value as Text" attribute can be made dynamic with the name "UseValueText".

Inherit status [WinCC V6]
Inherit status [WinCC V6]
The statuses of the "Display" and "Operator-Control Enable" properties of the user object can
be inherited by the individual objects of the customized object.
Example: You have configured the "Inherit status" properties for the customized object with
"Yes" and "Display" as "Visible". One object of the customized object has the property
"invisible". If the customized object is now made invisible and then visible again, then all objects
of the customized object are shown as visible even if one object of the customized object has
the property "invisible".
The "Inherit Status" attribute cannot be made dynamic.

3.10.17

"Lock" Property Group

3.10.17.1 Lock Display (LockStatus)
Lock Display (LockStatus)
The "Lock Display" attribute defines for the marked group display whether a locked measuring
point should be displayed. The lock applies to all the buttons of the group display.
The attributes "Lock Display Text", "Lock Text Color" and "Lock Background Color" are only
evaluated if the attribute "Lock Display" has the value "Yes".
Yes

A locked measuring point is displayed as locked.

No

A locked measuring point is not displayed as locked. The queued message classes are displayed normally.

The "Lock Display" attribute can be made dynamic with the name "LockStatus".
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3.10.17.2 Lock Display Text (LockText)
Lock Display Text (LockText)
The "Lock Display Text" attribute specifies the text that is displayed as button label for a locked
measuring point. The value applies to all the buttons of the selected group display.
The "Lock Display Text" attribute is only evaluated if the "Lock Display" attribute has the value
"Yes".
The "Lock Display Text" attribute can be made dynamic with the name "LockText".

3.10.17.3 Lock Background Color (LockBackColor)
Lock Background Color (LockBackColor)
The "Lock Background Color" attribute specifies the background color that the buttons assume
for a locked measuring point. The value applies to all the buttons of the selected group display.
The "Lock Background Color" attribute is only evaluated if the "Lock Display" attribute has the
value "Yes".
The "Lock Background Color" attribute can be made dynamic with the name "LockBackColor".

3.10.17.4 Lock Text Color (LockTextColor)
Lock Text Color (LockTextColor)
The "Lock Text Color" attribute specifies the color that the button labels assume for a locked
measuring point. The value applies to all the buttons of the selected group display.
The "Lock Text Color" attribute is only evaluated if the "Lock Display" attribute has the value
"Yes".
The "Lock Text Color" attribute can be made dynamic with the name "LockTextColor".

3.10.18

"Styles" Property Group

3.10.18.1 3D Border Width (BackBorderWidth)
3D Border Width (BackBorderWidth)
The "3D Border Width" attribute defines the line width of a 3D border. The values are specified
in pixels.
=0

The object has no 3D border.

>0

There is a free choice of value depending on the object size.

The "3D Border Width" attribute can be made dynamic with the name "BackBorderWidth".

986

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Process Pictures
3.10 Object properties

3.10.18.2 Bar Pattern (FillStyle2)
Bar Pattern (FillStyle2)
The "Bar Pattern" attribute specifies the fill pattern for display of the bar area.
So that the fill pattern becomes visible, the color of the fill pattern must differ from that of the
background. The "Solid" fill pattern fills the object with the set background color; the
"Transparent" fill pattern defines that neither a background nor a fill pattern are displayed.
There is a choice of 45 fill patterns.
The "Bar Pattern" attribute can be made dynamic with the name "FillStyle2".

3.10.18.3 Border Weight (BackBorderWidth)
Border Weight (BackBorderWidth)
The "Border Weight" attribute defines the width of the border of a slider. The values are
specified in pixels.
=0

The object has no border.

>0

There is a free choice of value depending on the object size.

The "Border Width" attribute can be made dynamic with the name "BackBorderWidth".

3.10.18.4 Display as DropDownList
Display as drop-down list
The "Display as DropDownList" attribute displays all entries of the text box in a drop-down box.
The "Display as DropDownList" attribute cannot be made dynamic.

3.10.18.5 Latch Down (Toggle)
Latch Down (Toggle)
The "Latch Down" attribute specifies whether or not a button or round button latches down.
The setting of the "Latch Down" attribute is only visible in runtime.
The initial position of the button can be set using the "Pressed" attribute.
Yes

The button latches down in the new switch setting when pressed. In order to release it, it must be pressed
again.

No

On pressing, the button jumps back to the initial position.

The "Latch Down" attribute can be made dynamic with the name "Toggle".

3.10.18.6 Box Alignment (BoxAlignment)
Box Alignment (BoxAlignment)
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The "Box Alignment" attribute defines the arrangement of the buttons in a check box or option
group. The buttons can be arranged to the right or left of the descriptive text.
The descriptive text of the buttons can be aligned using the "Text Orientation", "X Alignment"
and "Y Alignment" attributes in the "Font" property group.
Aligned Left
Aligned Right

The buttons appear in the field aligned left.
The buttons appear in the field aligned right.

The "Box Alignment" attribute can be made dynamic with the name "BoxAlignment".

3.10.18.7 Fill Pattern (FillStyle)
Fill Pattern (FillStyle)
The "Fill Pattern" attribute specifies the pattern for display of the picture background. So that
the fill pattern becomes visible, the color of the fill pattern must differ from that of the
background.
There is a choice of 49 fill patterns. The "Solid" fill pattern 1 fills the object with the set
background color; the "Transparent" fill pattern 2 defines that neither a background nor a fill
pattern are displayed.
The "Fill Pattern" attribute can be made dynamic with the name "FillStyle".

3.10.18.8 Fill Pattern (FillStyle)
Fill Pattern (FillStyle)
The "Fill Pattern" attribute specifies the pattern for display of the background areas. So that
the fill pattern becomes visible, the color of the fill pattern must differ from that of the
background.
There is a choice of 49 fill patterns. The "Solid" fill pattern 1 fills the object with the set
background color; the "Transparent" fill pattern 2 defines that neither a background nor a fill
pattern are displayed.
The "Fill Pattern" attribute can be made dynamic with the name "FillStyle".

3.10.18.9 Pressed (Pressed)
Pressed (Pressed)
The "Pressed" attribute specifies whether a button or round button is displayed in the initial
position as "pressed" or "not pressed".
The "Latch Down" attribute specifies whether or not a button latches down when pressed.
Yes

The button or round button has the initial position "pressed".

No

The button or round button has the initial position "not pressed".

The "Pressed" attribute can be made dynamic with the name "Pressed".
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3.10.18.1 Background (Background)
0
Background (Background)
The "Background" attribute specifies whether a 3D bar is displayed with or without a
background.
Yes

The background of the 3D bar is visible.

No

The background of the 3D bar is not visible.

The "Background" attribute can be made dynamic with the name "Background".

3.10.18.1 Light Effect (LightEffect)
1
Light Effect (LightEffect)
The "Light Effect" attribute specifies whether or not the 3D bar is displayed as illuminated.
Yes

The 3D bar is displayed spatially by means of a bright/dark contrast.

No

The 3D bar is displayed as normal.

The "Light Effect" attribute can be made dynamic with the name "LightEffect".

3.10.18.1 Line Style (BorderStyle)
2
Line Style (BorderStyle)
The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or
dashed representation is possible.
A line with line width of 1 pixel can be displayed in two colors. To do so, you must select a
broken line style and assign another color to the background of the line. If the line color is
identical to the line background color in the "Colors" property group, breaks in the line are
invisible.
There is a choice of 5 line styles.
The "Line Style" attribute can be made dynamic with the name "BorderStyle".
Line termination
The "Line termination" attribute determines the appearance of the line termination. The
definition of the attribute applies to both ends of the line. Select one of the three following
options:
● A round termination sets the center of a circle at the end point of the line. The diameter of
the circle adapts to the line width.
● A rectangular termination set the center of a square at the end point of the line. The width
and height of the square adapts to the line width.
● A flat termination ends the line at its end points.
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Corners
The "Corners" attribute define the appearance of the corner intersections of where lines meet.
The definition applies to all the corners of the object. Select one of the three following options:
● A round corner sets the center of a circle at the intersection of two line ends. The diameter
of the circle adapts to the line width.
● The two outer corner points of the line connection are linked by a straight line. This flattening
effect causes the corners to appear beveled.
● A pointed corner corresponds to the real corner intersection of the meeting lines.
The "Line termination" and "Corners" attributes cannot be dynamized.

3.10.18.1 Line End Style (BorderEndStyle)
3
Line End Style (BorderEndStyle)
The "Line End Style" attribute specifies in which style the ends of a line appear. The ends of
a line can be designed differently. It is possible, for example, that a line begins with a dot and
ends with an arrow.
There is a choice of 7 line end styles.
The "Line End Style" attribute can be made dynamic with the name "BorderEndStyle".

3.10.18.1 Line Weight (BorderWidth)
4
Line Weight (BorderWidth)
The "Line Weight" attribute specifies the width of a line. The value is specified in pixels.
In order to display a line in two colors, select the broken line style and assign the "Line color"
and "Line background color" attributes with different colors. In Design WinCC Classic, only
one line can be displayed with a 1 pixel line weight.
0 - 100

There is a free choice of value within the limits. With line weight 0, no line is visible.

The "Line weight" attribute can be made dynamic with the name "BorderWidth".

3.10.18.1 Line connection type (LineJoinStyle)
5
Line connection type (LineJoinStyle)
The "Line connection type" attribute defines the way that corners are displayed in a tube
polygon.
Angle

The tubes are joined at corner points without rounding

Round

The tubes are rounded at the outside corner points.

The attribute "Line connection type" can be made dynamic with the name "LineJoinStyle".
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3.10.18.1 Pattern alignment (Fill Style Alignment)
6
Pattern alignment (Fill Style Alignment)
The "Pattern alignment" attribute defines the alignment of the fill pattern for the process picture.
Normal

The fill pattern refers to the process picture. In runtime, no scaling is performed when opening the
picture.

Stretched (window)

The fill pattern refers to the window in the Graphics Designer. In runtime, scaling is performed when
opening the picture.

The "Pattern alignment" attribute can be made dynamic with the name "FillStyleAlignment".

3.10.18.1 Draw Border Inside (DrawInsideFrame)
7
Draw Border Inside (DrawInsideFrame)
For all line thicknesses greater than 1, the "Draw Border Inside" attribute defines whether the
border lines are to be drawn inside the object frame or symmetrically on the frame.
The following objects have the "Draw Border Inside" attribute:
Ellipse, circle, ellipse segment, circlular segment, ellipse arc, circle arc, rectangle, round
rectangle, static text, graphic object, status display, button, checkbox, radio box, slider object.
Yes

The border lines are drawn inside the object frame.

No

The border lines are drawn symmetrically on the object frame.

The "Draw Border Insider" attribute cannot be made dynamic.

3.10.18.1 Border Style (BorderStyle)
8
Border Style (BorderStyle)
The "Border Style" attribute specifies the style in which a border appears. For example, a dotted
or dashed representation is possible.
A border with border width 1 pixel can be displayed in two colors. To do so, you must select
a broken border style and assign another color to the background of the border. If the border
color is identical to the border background color in the "Colors" property group, breaks in the
border are invisible.
There is a choice of 5 border styles.
The "Border Style" attribute can be made dynamic with the name "BorderStyle".
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3.10.18.1 Border Width (BorderWidth)
9
Border Width (BorderWidth)
The "Border Width" attribute specifies the width of a border. The values are specified in pixels.
A border with border width 1 pixel can be displayed in two colors. To do so, you must select
a broken border style and assign another color to the background of the border. If the border
color is identical to the border background color in the "Colors" property group, breaks in the
border are invisible.
0 - 100

There is a free choice of value within the limits.
With border width 0, no border is visible.

The "Border Width" attribute can be made dynamic with the name "BorderWidth".

3.10.18.2 Dividing Line Style (ItemBorderStyle)
0
Dividing Line Style (ItemBorderStyle)
The "Dividing Line Style" attribute specifies in which style the separation lines in a selection
list appear. For example, a dotted or dashed representation is possible. The setting of the
"Dividing Line Style" attribute is only visible in runtime.
If a broken dividing line style (e.g. dashed, dotted) is chosen, only the dividing line weights 0
pixel and 1 pixel can be displayed.
There is a choice of 5 dividing line styles.
The "Dividing Line Style" attribute can be made dynamic with the name "ItemBorderStyle".

3.10.18.2 Dividing Line Weight (ItemBorderWidth)
1
Dividing Line Weight (ItemBorderWidth)
The "Dividing Line Weight" attribute specifies the width of a dividing line. The values are
specified in pixels. The setting of the "Dividing Line Weight" attribute is only visible in Runtime.
If a broken dividing line style (e.g. dashed, dotted) is chosen, only the dividing line weights 0
pixel and 1 pixel can be displayed.
0 - 10

There is a free choice of value within the limits. With dividing line weight 0, no dividing line is visible.

The "Dividing Line Weight" attribute can be made dynamic with the name "ItemBorderWidth".

3.10.18.2 Windows Style (WindowsStyle)
2
Windows Style (WindowsStyle)
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The "Windows Style" attribute specifies for the "Button" or "Slider" objects whether the style
for the display of the objects in the Graphics Designer is set or taken from the default settings
of the Windows operating system.
A change to the "Border Width" or "Background Color" attributes sets the value of the "Windows
Style" attribute to "No" if the new values do not match the default settings
Yes

The objects are displayed according to the default settings of the Windows operating system. Attributes that
do not match the Windows style are ignored.

No

The objects are displayed according to the settings of the Graphics Designer.

The "Windows Style" attribute can be made dynamic with the name "WindowsStyle".

3.10.19

"Connected Objects" Property Group

3.10.19.1 Connection point index of source object (TopConnectedConnectionPointIndex)
Index of the Connection Point of the First Object Connected
(TopConnectedConnectionPointIndex)
The "Index of the Connection Point of the First Object Connected" attribute specifies for the
start of the connector at which connection point of the object the connection is formed.
The "Index of the Connection Point of the First Object Connected" attribute can be made
dynamic with the name "TopConnectedConnectionPointIndex".

3.10.19.2 Connection point index of target object (BottomConnectedConnectionPointIndex)
Index of the Connection Point of the Object Connected at the End
(BottomConnectedConnectionPointIndex)
The "Index of the Connection Point of the Object Connected at the End" attribute specifies for
the end of the connector at which connection point of the object the connection is formed.
The "Index of the Connection Point of the Object Connected at the End" attribute can be made
dynamic with the name "BottomConnectedConnectionPointIndex".

3.10.19.3 Object name of source object (TopConnectedObjectName)
Object Name of the First Object Connected (TopConnectedObjectName)
The "Object Name of the First Object Connected" attribute specifies the object that is
connected to the start of the connector.
The "Object Name of the First Object Connected" attribute can be made dynamic with the
name "TopConnectedObjectName".

3.10.19.4 Object name of target object (BottomConnectedObjectName)
Object Name of the Object Connected at the End (BottomConnectedObjectName)
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The "Object Name of the Object Connected at the End" attribute specifies the object that is
connected to the end of the connector.
The "Object Name of the Object Connected at the End" attribute can be made dynamic with
the name "BottomConnectedObjectName".

3.10.19.5 Change Orientation (Orientation)
Change Orientation (Orientation)
The "Change Orientation" attribute reverses the definition of "Start" and "End" of the connector,
including the current assignments
The "Change Orientation" attribute can be made dynamic with the name "Orientation".

3.10.19.6 Connection Type (ConnectorType)
Connection Type (ConnectorType)
The "Connection Type" attribute defines the type of connector. It is possible to select between
two connection types.
Automatic

Both objects are connected by a polyline made up of horizontal and vertical parts.

Simple

Both objects are connected by a straight line between the connecting points.

The "Connection Type" can be dynamized with the name "ConnectorType".

3.10.20

"Assignment" Property Group

3.10.20.1 Using global settings (UseGlobalSettings)
Using global settings (UseGlobalSettings)
Specify whether to use global settings to assign message events to the buttons visualized in
the group view. Configure the display of message events in the "Message types" property
group. The property is only relevant to PCS7 projects.
Yes

Activates the settings made in PCS7 alarm editor for the assignment of message events to the buttons in
the group display. The bit numbers in the group value are assigned to the respective buttons.

No

The message type are assigned locally to the buttons in the group display.

The sequence of the assignment defines the priority. If there are more than one selected event
for one button, the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The property cannot be assigned dynamic functionality.
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3.10.20.2 Message Types for Button 1 (Button1MessageClasses)
Message Types for Button 1 (Button1MessageClasses)
Define one or more message events for displaying the first button in the group display. This is
done by entering the numbers of the bits in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, separate the numbers with a comma. The
sequence of the assignment defines the priority. If there are more than one selected event for
one button, the event that has been entered first is displayed.
One event can be displayed simultaneously in more than one button.
The "Message Types for Button 1" attribute can be assigned dynamic properties with the name
"Button1MessageClasses".

3.10.20.3 Message Types for Button 2 (Button2MessageClasses)
Message Types for Button 2 (Button2MessageClasses)
For displaying both buttons, define one or more message events in the group display. This is
done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, separate the numbers with a comma. The
sequence of the assignment defines the priority. If there are more than one selected event for
one button, the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 2" attribute can be assigned dynamic properties with the name
"Button2MessageClasses".

3.10.20.4 Message Types for Button 3 (Button3MessageClasses)
Message Types for Button 3 (Button3MessageClasses)
For displaying the third button, define one or more message events in the group display. This
is done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, separate the numbers with a comma. The
sequence of the assignment defines the priority. If there are more than one selected event for
one button, the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 3" attribute can be assigned dynamic properties with the name
"Button3MessageClasses".

3.10.20.5 Message Types for Button 4 (Button4MessageClasses)
Message Types for Button 4 (Button4MessageClasses)
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For displaying the fourth button, define one or more message events in the group display. This
is done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, separate the numbers with a comma. The
sequence of the assignment defines the priority. If there are more than one selected event for
one button, the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 4" attribute can be assigned dynamic properties with the name
"Button4MessageClasses".

3.10.20.6 Message Types for Button 5 (Button5MessageClasses)
Message Types for Button 5 (Button5MessageClasses)
For displaying the fifth button, define one or more message events in the group display. This
is done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, separate the numbers with a comma. The
sequence of the assignment defines the priority. If there are more than one selected event for
one button, the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 5" attribute can be assigned dynamic properties with the name
"Button5MessageClasses".

3.10.20.7 Message Types for Button 6 (Button6MessageClasses)
Message Types for Button 6 (Button6MessageClasses)
For displaying the sixth button, define one or more message events in the group display. This
is done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, delimit the numbers with a comma. The order
of assignment defines the priority. If there are more than one selected event for one button,
the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 6" attribute can be assigned dynamic properties with the name
"Button6MessageClasses".

3.10.20.8 Message Types for Button 7 (Button7MessageClasses)
Message Types for Button 7 (Button7MessageClasses)
For displaying the seventh button, define one or more message events in the group display.
This is done by entering the number of the bit in the collect value. The display of the message
events is configured in the "Message Types" property group.
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If you want to assign several message events, delimit the numbers with a comma. The order
of assignment defines the priority. If there are more than one selected event for one button,
the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 7" attribute can be assigned dynamic properties with the name
"Button7MessageClasses".

3.10.20.9 Message Types for Button 8 (Button8MessageClasses)
Message Types for Button 8 (Button8MessageClasses)
For displaying the eighth button, define one or more message events in the group display. This
is done by entering the number of the bit in the collect value. The display of the message events
is configured in the "Message Types" property group.
If you want to assign several message events, delimit the numbers with a comma. The order
of assignment defines the priority. If there are more than one selected event for one button,
the event that has been entered first is displayed.
The same event can be visualized simultaneously in several buttons.
The "Message Types for Button 8" attribute can be assigned dynamic properties with the name
"Button8MessageClasses".

3.10.21

"Status" Property Group

3.10.21.1 Current Status (Index)
Current Status (Index)
The "Current Status" attribute shows the identification number of the currently selected status.
Changing the value specified here selects the individual statuses of a status display to specify
the settings of the other attributes in the "Status" property group.
4,294,967,296 different states can be shown for a status display. The permitted value range
is from 0 to 4.294.967.295 (= 232 - 1).
The "Current Status" attribute can be made dynamic with the name "Index".

3.10.21.2 Bit Selection 0 (BitSelect0)
Bit Selection 0 (BitSelect0)
"Bit Selection 0" indicates the status tag that you have defined for the first bit of the status
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".
0

The first bit of the status value is not evaluated. No status tag is used.

1

Status tag "Status1" is used for the status value of the first bit.

2

Status tag "Status2" is used for the status value of the first bit.
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3

Status tag "Status3" is used for the status value of the first bit.

4

Status tag "Status4" is used for the status value of the first bit.

The "Bit Selection 0" attribute can be made dynamic with the name "BitSelect0".

3.10.21.3 Bit Selection 1 (BitSelect1)
Bit Selection 1 (BitSelect1)
"Bit Selection 1" indicates the status tag that you have defined for the second bit of the status
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".
0

The second bit of the status value is not evaluated. No status tag is used.

1

Status tag "Status1" is used for the status value of the second bit.

2

Status tag "Status2" is used for the status value of the second bit.

3

Status tag "Status3" is used for the status value of the second bit.

4

Status tag "Status4" is used for the status value of the second bit.

The "Bit Selection 1" attribute can be made dynamic with the name "BitSelect1".

3.10.21.4 Bit Selection 2 (BitSelect2)
Bit Selection 2 (BitSelect2)
"Bit Selection 2" indicates the status tag that you have defined for the third bit of the status
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".
0

The third bit of the status value is not evaluated. No status tag is used.

1

Status tag "Status1" is used for the status value of the third bit.

2

Status tag "Status2" is used for the status value of the third bit.

3

Status tag "Status3" is used for the status value of the third bit.

4

Status tag "Status4" is used for the status value of the third bit.

The "Bit Selection 2" attribute can be made dynamic with the name "BitSelect2".

3.10.21.5 Bit Selection 3 (BitSelect3)
Bit Selection 3 (BitSelect3)
"Bit Selection 3" indicates the status tag that you have defined for the fourth bit of the status
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".
0

The fourth bit of the status value is not evaluated. No status tag is used.

1

Status tag "Status1" is used for the status value of the fourth bit.

2

Status tag "Status2" is used for the status value of the fourth bit.

3

Status tag "Status3" is used for the status value of the fourth bit.

4

Status tag "Status4" is used for the status value of the fourth bit.

The "Bit Selection 3" attribute can be made dynamic with the name "BitSelect3".
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3.10.21.6 Flash Picture
Flash picture
The "Flash Picture" attribute specifies which flash picture is to be displayed for the currently
selected status. Pictures with the following formats can be inserted: EMF, WMF, DIB, BMP.
If no flash picture has been defined for the selected status, the symbol for the status display
is shown as a placeholder during flashing. The flashing is only visible in Runtime.
The "Flashing Flash Picture Active" attribute must have the value "Yes".
The flash picture should have the same picture size as the basic picture, otherwise, its display
is distorted.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in
the "Picture Selection" dialog.
The "Flash Picture" attribute cannot be made dynamic.

3.10.21.7 Flash Picture (FlashPicture)
Flash Picture (FlashPicture)
The "Flash Picture" attribute specifies which flash picture is to be displayed for the currently
selected status. Pictures with the following formats can be inserted: EMF, WMF, BMP, GIF,
JPG.
The flashing is only visible in Runtime.
The flash picture should have the same picture size as the basic picture, otherwise, its display
is distorted.
The "Flash Picture" attribute can be made dynamic with the name "FlashPicture".

3.10.21.8 Flash Picture Referenced (FlashPicReferenced)
Flash Picture Referenced (FlashPicReferenced)
The "Status Display" object can have an almost infinite number of different statuses.
For each status, you can choose a basic picture and a flash picture. The "Flash Picture
Referenced" attribute specifies whether the flash picture for the selected status itself or only
the reference in the form of a cross-reference to the picture is integrated.
Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Flash Picture Referenced" attribute cannot be made dynamic.

3.10.21.9 Flash Picture Transparent Color (FlashPicTransColor)
Flash Picture Transparent Color (FlashPicTransColor)
The "Flash Picture Transparent Color" attribute specifies the transparent color of the flashing
picture. Transparent colors can only be displayed for pictures in BMP or DIB format.
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The "Flash Picture Transparent Color" attribute can be assigned dynamic properties by means
of the name "FlashPicTransColor".

3.10.21.1 Flash Picture Transparent Color On (FlashPicUseTransColor)
0
Flash Picture Transparent Color On (FlashPicUseTransColor)
The "Flash Picture Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed. Transparent colors can only be displayed
for pictures in BMP or DIB format.
Yes

The "Flash Picture Transparent Color On" attribute is enabled.

No

The "Flash Picture Transparent Color On" attribute is disabled.

The "Flash Picture Transparent Color On" attribute can be assigned dynamic properties by
means of the name "FlashPicUseTransColor".

3.10.21.1 Flashing Flash Picture Active (FlashFlashPicture)
1
Flashing Flash Picture Active (FlashFlashPicture)
The "Flashing Flash Picture Active" attribute specifies whether in runtime only the basic picture
is displayed or the basic picture and the flash picture alternate in the display.
If no flash picture has been defined, a symbol is displayed as placeholder in runtime.
Yes

In Runtime, the basic picture and flash picture alternate in the display.

No

Only the basic picture is displayed in Runtime.

The "Flashing Flash Picture Active" attribute can be made dynamic with the name
"FlashFlashPicture".

3.10.21.1 Flash Picture Flash Frequency(FlashRateFlashPic)
2
Flash Picture Flash Frequency(FlashRateFlashPic)
The "Flash Picture Flash Frequency" attribute specifies how quickly the basic picture and flash
picture alternate in Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash
frequency depends on the system performance.
The "Flashing Flash Picture Active" attribute must have the value "Yes".
Slow

In Runtime, the basic picture and flash picture alternate slowly.

Medium

In Runtime, the basic picture and flash picture alternate at medium speed.

Fast

In Runtime, the basic picture and flash picture alternate quickly.

The "Flash Picture Flash Frequency" attribute can be made dynamic with the name
"FlashRateFlashPic".
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3.10.21.1 Basic Picture (BasePicture)
3
Basic Picture (BasePicture)
The "Basic Picture" attribute specifies which picture is to be displayed for the currently selected
status. Pictures with the following formats can be inserted: EMF, WMF, DIB, BMP.
If no picture that you want to display is defined for a status, the symbol for the status display
is shown as a placeholder.
In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the
"Picture Selection" dialog.
The "Basic Picture" attribute cannot be made dynamic.

3.10.21.1 Basic Picture (BasePicture)
4
Basic Picture (BasePicture)
The "Basic Picture" attribute shows which picture is to be displayed for the currently selected
status. Pictures with the following formats can be inserted: EMF, WMF, BMP, GIF, JPG.
If no picture that you want to display is defined for a status, the symbol for the status display
is shown as a placeholder.
The "Basic Picture" attribute can be made dynamic with the name "BasePicture".

3.10.21.1 Basic Picture Referenced (BasePicReferenced)
5
Basic Picture Referenced (BasePicReferenced)
The "Status Display" object can have an almost infinite number of different statuses.
For each status, you can choose a basic picture and a flash picture. The "Basic Picture
Referenced" attribute specifies whether the basic picture for the selected status itself or only
the reference in the form of a cross-reference to the picture is integrated.
Yes

Only the reference of the picture is integrated and saved.

No

The picture itself is integrated and saved.

The "Basic Picture Referenced" attribute cannot be made dynamic.

3.10.21.1 Basic Picture Transparent Color (BasePicTransColor)
6
Basic Picture Transparent Color (BasePicTransColor)
The "Basic Picture Transparent Color" attribute specifies the transparent color of a picture.
Transparent colors can only be displayed for pictures in BMP or DIB format.
The "Basic Picture Transparent Color" attribute can be assigned dynamic properties by means
of the name "BasePicTransColor".
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3.10.21.1 Basic Picture Transparent Color On (BasePicUseTransColor)
7
Basic Picture Transparent Color On (BasePicUseTransColor)
The "Basic Picture Transparent Color On" attribute specifies whether the "Transparent Color"
function is to be used for the picture to be displayed. Transparent colors can only be displayed
for pictures in BMP or DIB format.
Yes

The "Basic Picture Transparent Color On" attribute is enabled.

No

The "Basic Picture Transparent Color On" attribute is disabled.

The "Basic Picture Transparent Color On" attribute can be assigned dynamic properties by
means of the name "BasePicUseTransColor".

3.10.21.1 Highest Index (MaxIndex)
8
Highest Index (MaxIndex)
The "Highest Index" attribute shows the highest index of all configurable alarm and status
combinations.
The "Highest Index" attribute can be made dynamic with the name "MaxIndex".

3.10.21.1 Index (Index)
9
Index (Index)
The "Index" attribute shows the index of the currently selected state. By changing the value
specified here, you can define the object properties for this index in the property group "Status".
The "Index" attribute can be made dynamic with the name "Index".

3.10.21.2 Priority Bit 16 (PrioBit16)
0
Priority Bit 16 (PrioBit16)
The "Priority Bit 16" indicates the priority of bit 16 (measuring point locked) in the collect value
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If several bits are queued in the collect value, the status is determined by the priority.
The "Priority Bit 16" attribute can be made dynamic with the name "PrioBit16".

3.10.21.2 Priority Bit 17 (PrioBit17)
1
Priority Bit 17 (PrioBit17)
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The "Priority Bit 17" indicates the priority of bit 17 (OS status) in the collect value for the alarm
evaluation for the extended analog and status display. The alarm evaluation starts at the
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority
0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 17" attribute can be made dynamic with the name "PrioBit17".

3.10.21.2 Priority Bit 18 (PrioBit18)
2
Priority Bit 18 (PrioBit18)
The "Priority Bit 18" indicates the priority of bit 18 (AS status) in the collect value for the alarm
evaluation for the extended analog and status display. The alarm evaluation starts at the
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority
0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 18" attribute can be made dynamic with the name "PrioBit18".

3.10.21.2 Priority Bit 19 (PrioBit19)
3
Priority Bit 19 (PrioBit19)
The "Priority Bit 19" indicates the priority of bit 19 (operator input message) in the collect value
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 19" attribute can be made dynamic with the name "PrioBit19".

3.10.21.2 Priority Bit 20 (PrioBit20)
4
Priority Bit 20 (PrioBit20)
The "Priority Bit 20" indicates the priority of bit 20 (operator instruction) in the collect value for
the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 20" attribute can be made dynamic with the name "PrioBit20".
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3.10.21.2 Priority Bit 21 (PrioBit21)
5
Priority Bit 21 (PrioBit21)
The "Priority Bit 21" indicates the priority of bit 21 (system message) in the collect value for
the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 21" attribute can be made dynamic with the name "PrioBit21".

3.10.21.2 Priority Bit 22 (PrioBit22)
6
Priority Bit 22 (PrioBit22)
The "Priority Bit 22" indicates the priority of bit 22 (process message) in the collect value for
the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 22" attribute can be made dynamic with the name "PrioBit22".

3.10.21.2 Priority Bit 23 (PrioBit23)
7
Priority Bit 23 (PrioBit23)
The "Priority Bit 23" indicates the priority of bit 23 (maintenance instruction) in the collect value
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 23" attribute can be made dynamic with the name "PrioBit23".

3.10.21.2 Priority Bit 24 (PrioBit24)
8
Priority Bit 24 (PrioBit24)
The "Priority Bit 24" indicates the priority of bit 24 (AS control technology error) in the collect
value for the alarm evaluation for the extended analog and status display. The alarm evaluation
starts at the highest priority (priority 1). Bits that are not used for the alarm evaluation are
assigned priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 24" attribute can be made dynamic with the name "PrioBit24".
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3.10.21.2 Priority Bit 25 (PrioBit25)
9
Priority Bit 25 (PrioBit25)
The "Priority Bit 25" indicates the priority of bit 25 (AS control technology fault) in the collect
value for the alarm evaluation for the extended analog and status display. The alarm evaluation
starts at the highest priority (priority 1). Bits that are not used for the alarm evaluation are
assigned priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 25" attribute can be made dynamic with the name "PrioBit25".

3.10.21.3 Priority Bit 26 (PrioBit26)
0
Priority Bit 26 (PrioBit26)
The "Priority Bit 26" indicates the priority of bit 26 (tolerance low) in the collect value for the
alarm evaluation for the extended analog and status display. The alarm evaluation starts at
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 26" attribute can be made dynamic with the name "PrioBit26".

3.10.21.3 Priority Bit 27 (PrioBit27)
1
Priority Bit 27 (PrioBit27)
The "Priority Bit 27" indicates the priority of bit 27 (tolerance high) in the collect value for the
alarm evaluation for the extended analog and status display. The alarm evaluation starts at
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 27" attribute can be made dynamic with the name "PrioBit27".

3.10.21.3 Priority Bit 28 (PrioBit28)
2
Priority Bit 28 (PrioBit28)
The "Priority Bit 28" indicates the priority of bit 28 (warning low) in the collect value for the
alarm evaluation for the extended analog and status display. The alarm evaluation starts at
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 28" attribute can be made dynamic with the name "PrioBit28".
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3.10.21.3 Priority Bit 29 (PrioBit29)
3
Priority Bit 29 (PrioBit29)
The "Priority Bit 29" indicates the priority of bit 29 (warning high) in the collect value for the
alarm evaluation for the extended analog and status display. The alarm evaluation starts at
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned
priority 0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 29" attribute can be made dynamic with the name "PrioBit29".

3.10.21.3 Priority Bit 30 (PrioBit30)
4
Priority Bit 30 (PrioBit30)
The "Priority Bit 30" indicates the priority of bit 30 (alarm low) in the collect value for the alarm
evaluation for the extended analog and status display. The alarm evaluation starts at the
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority
0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 30" attribute can be made dynamic with the name "PrioBit30".

3.10.21.3 Priority Bit 31 (PrioBit31)
5
Priority Bit 31 (PrioBit31)
The "Priority Bit 31" indicates the priority of bit 31 (alarm high) in the collect value for the alarm
evaluation for the extended analog and status display. The alarm evaluation starts at the
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority
0.
If the group value contains multiple bits, the priority determines which status is displayed.
The "Priority Bit 31" attribute can be made dynamic with the name "PrioBit31".

3.10.21.3 Status Word Bit 0 (BitPosition0)
6
Status Word Bit 0 (BitPosition0)
The "Status Word Bit 0" indicates the bit position of the selected tag for bit 0 of the status value.
The content is only evaluated, if a tag is selected for bit selection 0. The tags are defined in
the "Miscellaneous" property group under "Status1" to "Status4".
Enter a value from 0 to 31. Each value can only be assigned once.
The "Status Word Bit 0" attribute can be made dynamic with the name "BitPosition0".
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3.10.21.3 Status Word Bit 1 (BitPosition1)
7
Status Word Bit 1 (BitPosition1)
The "Status Word Bit 1" indicates the bit position of the selected tag for bit 1 of the status value.
The content is only evaluated, if a tag is selected for bit selection 1. The tags are defined in
the "Miscellaneous" property group under "Status1" to "Status4".
Enter a value from 0 to 31. Each value can only be assigned once.
The "Status Word Bit 1" attribute can be made dynamic with the name "BitPosition1".

3.10.21.3 Status Word Bit 2 (BitPosition2)
8
Status Word Bit 2 (BitPosition2)
The "Status Word Bit 2" indicates the bit position of the selected tag for bit 2 of the status value.
The content is only evaluated, if a tag is selected for bit selection 2. The tags are defined in
the "Miscellaneous" property group under "Status1" to "Status4".
Enter a value from 0 to 31. Each value can only be assigned once.
The "Status Word Bit 2" attribute can be made dynamic with the name "BitPosition2".

3.10.21.3 Status Word Bit 3 (BitPosition3)
9
Status Word Bit 3 (BitPosition3)
The "Status Word Bit 3" indicates the bit position of the selected tag for bit 3 of the status value.
The content is only evaluated, if a tag is selected for bit selection 3. The tags are defined in
the "Miscellaneous" property group under "Status1" to "Status4".
Enter a value from 0 to 31. Each value can only be assigned once.
The "Status Word Bit 3" attribute can be made dynamic with the name "BitPosition3".
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4

Types of Dynamization

Introduction
WinCC offers various ways of dynamizing the objects of a process picture.
Basically, there are two types of dynamization.
● Dynamic objects change their appearance and position depending on, for example, a
process value. An example of a dynamic object is a bar whose length is influenced by a
current temperature, a pointer instrument with a moving pointer, or an object which changes
color depending on the position of a workpiece.
● Operator-controllable objects react to events, e.g. a mouse-click, and enable the operator
to actively intervene in the process. Operator-controllable objects can be, for example,
buttons, sliders, or I/O fields used for entering certain process parameters.
Note
If you copy a dynamized object in the Graphics Designer, the dynamics are also copied.
The copied object will then be affected by the dynamics in just the same way as the original
object.
Graphics Designer will permit identical object names in a picture which differ only in lower
and upper case letters. For dynamization of objects in a picture, however, you must assign
a unique nomenclature. Differentiation of object names by upper and lower cases alone
shall not be sufficient.

Dynamizing by Means of Direct Tag Connection
When a tag is connected to a property of an object, the value of the tag is transferred directly
to the object property. This means, for example, that the value of a tag can be directly
influenced by an I/O field.
Dynamization by means of tag connection is indicated in the Object Properties dialog with the
icon and the name of the tag.

Dynamizing by Means of Indirect Tag Connection
When a tag is connected to a property of an object, the value of the tag is interpreted as the
tag name. The value of this tag is transferred to the object property. You configure an indirect
tag connection by double-clicking the box in the "Indirect" column of the "Object Properties"
dialog.
Dynamization by means of tag connection is indicated in the Object Properties dialog with the
icon and the name of the tag. The indirect tag connection is indicated with the icon
in
the "Indirect" column of the "Object Properties" dialog.
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Dynamizing by Means of Direct Connection
Direct connection is used for reacting to events. If the event occurs in Runtime, the value of a
source element is used for a target element. The values of the source element and target
element can be defined by:
● a constant
● a WinCC tag
● the value of an object property
Dynamizing by means of direct connection is indicated in the Object Properties dialog with the
icon.

Dynamizing Using Dynamic Dialog
The Dynamic dialog is used for dynamizing an object property. You should use the Dynamic
dialog if you want to map the value of a tag to a value which can be interpreted by the operator.
For example, you can use the Dynamic dialog to map the value range of a tag to color values.
Dynamizing using the Dynamic dialog is indicated in the Object properties dialog with the
icon.

Dynamizing Using VBS Action
VBS actions are used to dynamize an object property or to react to events. You should use
VBS actions if, for example, you want to process several input parameters in one action or you
want to execute conditional instructions (if ... then ...).
Dynamization with a VBS action is indicated with the

icon in the "Object Properties" dialog.

Dynamizing Using C Action
C actions are used to dynamize an object property or to react to events. You should use C
actions if, for example, you want to process several input parameters in one action or you want
to execute conditional instructions (if ... then ...).
Dynamization with a C action is indicated with the
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icon in the "Object Properties" dialog.
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4.2

Using tag prefixes and server prefixes

Introduction
WinCC offers a wide variety of possibilities to define and structure tags. For a picture window,
a tag prefix can be assigned to precede all tags that are used in the picture.
Pictures that are embedded can be stored on any server in a multi-user system. Either the
server is specified directly on embedding a picture with the server prefix, or assigned later via
the object properties of the picture window. Tags can also be requested from other servers
with the server prefix.

TagPrefix Property
Use "TagPrefix" to define or return the tag prefix that is added to all tags, which are contained
in the picture window object, or that returns a tag prefix. In this way, a picture that is embedded
in a picture window retains access to its own tags while another picture accesses other tags.
Example: In a picture window the "temperature" tag is requested on an object. If the "Motor1."
tag prefix is assigned to the picture window, the tag "Motor1.Temperature" is requested.
Note
The TagPrefix property is only provided for "WinCC Gauge Control" and "WinCC Slider
Control" where controls are concerned.

ServerPrefix Property
Use "ServerPrefix" to determine in a multi-user system:
● the server where the picture to be displayed in the picture window is located.
● the server, from which the tags are read.
Note
No check is made as to whether the server prefix matches the server which is actually
available.
When changing the computer name of the server, you need to adapt the server prefix
manually. When changing a computer name, you should retain the symbolic computer
name that was set when the package was created. This makes it easier to manually adapt
the server prefix.

Requesting tags without prefix
The example below shows a reason for requesting tags without prefix.
You want to read the local user using the "@CurrentUser" tag. In a multi-user system, or if the
faceplate technology is used, the tag names are always preceded by a server prefix or a tag
prefix. You can use the following tag add-ons to switch off the prefix in order to read the
"@CurrentUser" tag.
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● "@NOTP" switches off the tag prefix.
● "@NOSP" switches off the server prefix.
● "@NOP" switches off the tag prefix and the server prefix.
The add-ons cannot be used in the "TagPrefix" or "ServerPrefix" properties of a picture window
or basic picture.
The add-ons are available in all dynamization types. It only makes sense to switch off the
server prefix in the case of clients with their own project.
If a standard server is set up on a multi-user system, you cannot use the "@NOP" and
"@NOSP" add-ons.
Tag prefixes will only function for tags.

Example
The following VBScript reads the "@CurrentUser" tag without tag prefix and outputs the content
as a trace in a diagnostics window.

'VBS311
Dim tag
tag = HMIRuntime.Tags("@NOTP::@CurrentUser").Read
HMIRuntime.Trace "CurrentUser: " & tag & vbNewLine

Note
The setting of the prefix only becomes effective when newly supplying the picture name. This
means you must either set the prefix before picture selection or newly supply the picture name
if the picture is not changed.
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4.3

Trigger Types

4.3.1

Trigger Types

Introduction
Triggers are used to execute actions at runtime. To do this, a trigger is linked to an action,
forming the triggering event for calling the action. Actions without triggers will not be carried
out.
The following triggers are available for the dynamization of objects:
● Cyclic Triggers
● Cyclic Triggers Based on Window Cycle
● Cyclic Triggers Based on Picture Cycle
● Tag triggers
● Event-Driven Triggers
Note
It is important to remember that the cycle time has a major effect on the performance of
the project. All the actions of a picture must be completed within their cycle time. Apart
from the runtimes of the actions, the times required for requesting the tag values and the
reaction times of the automation systems must also be taken into consideration. You
should only set trigger events with a cycle time under one second if variables which change
rapidly have to be queried.

4.3.2

Cyclic Triggers

Introduction
Cyclic triggers are a means of processing periodic actions in WinCC. In the case of a cyclic
trigger, the action is executed when the trigger event occurs, e.g. every 20 seconds.

Principle of Operation
When actions with a cyclical trigger are configured in a picture, each tag is requested
individually following selection of the picture.
The start of the first time interval coincides with the start of Runtime. The length of the interval
is determined by the cycle. Cycles between 250 ms and 1 h can be selected. Self-defined user
cycles are also available.
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The action is always executed when the triggering event occurs.
Note
Depending on the system, it cannot be guaranteed that an action with a cyclic trigger is carried
out at exactly the specified time.
Cyclic Triggers Based on Window Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update
Cycle of the Picture Window object. This cycle provides the option of defining the cycles of all
the actions used in a picture window centrally.
Cyclic Triggers Based on Picture Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update
Cycle of the picture object. This cycle provides the option of defining the cycles of all the actions
used in a picture centrally.

Recommendation
In order that the WinCC project has a high level of performance, it is advantageous to dispense
with actions which have a cyclical trigger and to realize periodic actions in the automation
system.

4.3.3

Tag Triggers

Introduction
Tag triggers consist of one or more specified tags. The action which is connected to such a
trigger is executed if a change in the value of one of these tags was detected when the query
was launched.

Principle of Operation
When actions with tag triggers are configured in a picture, all the tag triggers related to an
action are requested block by block when the picture is selected.
The beginning of the first interval coincides with the point at which the picture is first selected.
The length of the interval is determined by the cycle. Query cycles between 250 ms and 1 h
can be selected. Self-defined user cycles are also available.
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The action is only executed when the value of the tag triggers has changed.
Note
If a tag briefly changes within a query cycle and then resumes its original value, the action is
not executed.
Note
Reaction in case of non-existing variables
A C/VBS action is not executed after screen selection if a non-existing tag is requested. The
object is shown regardless. However, a dynamic dialog is executed once after screen
selection. The object is not shown.
Upon change
You can also configure a tag trigger so that the action is executed whenever the tag value is
changed.
The "On change" mode setting for process tags corresponds to a cyclic read request with a
cycle time of 1 second.
Note
If the WinCC diagnostics tags are used as action triggers, this form of the tag trigger should
not be used. Diagnostics tags can change very quickly. Since every change could trigger the
action, it can lead to high system utilization.

Recommendation
Tag triggers should be used in order that the WinCC project has a high performance level:
● With cyclic actions, the action is always executed, e.g. every 2 seconds. The tag trigger
only executes the action if a change in the value of the tag has been detected. This reduces
the load on the system and increases performance.
● When a picture is selected, all of the tags contained in tag triggers are known and can be
requested all at the same time by the automation system. The best possible optimization
can thus be achieved from the channel.
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4.3.4

Event-Driven Triggers

Introduction
Actions which are connected to an event are executed whenever this event occurs. Events
can be, for example, mouse control, keyboard control, or changes in focus.
If the "Mouse Action" event is connected to an action, this action is also triggered by a
configured hotkey.

Mode of Operation
The action is only executed when the object's triggering event is triggered. If the event occurs,
all the tags contained in the action are registered. Process tags are subsequently updated at
a cycle time of 1 s.

Recommendation
Event-driven triggers are not suitable for bulk configuration in the case of dynamizing with Cactions because each action must be logged on and off individually by the action control.
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4.4

Dynamic Wizard

4.4.1

Dynamizing Using Dynamic Wizard

Introduction
With the Dynamic Wizard, you can dynamize an object using C actions. When you execute a
wizard, preconfigured C actions and trigger events are defined and transferred to the object
properties. If necessary, you can change the C actions in the object properties using the Events
tab.

Dynamic Wizard

The preconfigured C actions are divided into the following groups:
● System functions
● Standard dynamics
● Picture components
● Import functions
● Picture functions
● SFC
The available groups and the wizards contained in the groups depend on the WinCC
installation type, the project type, and the selected object.
Note
You can use the "Toolbars..." item in the "View" menu of the Graphics Designer to show or
hide the Dynamic Wizard.
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See also
SFC (Page 1031)
System Functions (Page 1030)
Standard Dynamics (Page 1023)
Import Functions (Page 1023)
Picture Components (Page 1022)
Picture Functions (Page 1018)

4.4.2

Picture Functions

Updating Picture Objects
This wizard updates all user objects with type identification contained in the current WinCC
picture or in the project.
The wizard is part of the Graphic Object Update functionality.
Note
The Wizard functionality is only available in a PCS7-OS.

Changing User Object Connection
This wizard is used to change the individual connections of user objects at a later stage, e.g.
connection to a different AS block instance.
The wizard is part of the Graphic Object Update functionality.
Note
The Wizard functionality is only available in a PCS7-OS.

Picture Selection in Process Window
With this wizard you can create an action used to change a picture in the process window. The
name of the picture to be displayed is specified in the wizard.
Note
This wizard is only available if the WinCC Basic Process Control and SFC Visualization option
is installed and the project has been processed with the OS Project Editor.
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Picture Selection Via Measurement Point
With this wizard you can create an action used to select a picture by means of a measurement
point which you must select. The name of the measurement point and of the picture to be
displayed is specified in the wizard.
Note
This wizard is only available if the WinCC Basic Process Control and SFC Visualization option
is installed and the project has been processed with the OS Project Editor.

Picture Selection Via Group Display
With this wizard you can create an action used to select a picture by means of a group display.
If an alarm occurs in Runtime, the location (graphic) of this alarm is displayed.
Note
This wizard is only available if the WinCC Option Basic Process Control is installed, the project
has been processed with the OS Project Editor, and a group display has been selected.

Picture Navigation
This wizard creates an action which performs the selected picture navigation when the trigger
occurs at the selected object.
The following picture navigation functions can be selected:
● Display Start Picture
● Display Previous Picture
● Display Next Picture
● Display Stored Picture
● Store Picture
Note
This wizard is only available if the project has not been processed with the OS - Project
Editor.
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Picture Change in Working Area
With this wizard you can create an action used to change a picture in the working area. The
name of the picture to be displayed is specified in the wizard.
Note
This wizard is only available if the WinCC Basic Process Control is installed and the project
has been processed with the OS Project Editor.

Picture Change in Window
This wizard is used to change the content of a window object in a Graphics Designer picture.
Note
This wizard is only available if the project has not been processed with the OS - Project Editor.

Simple Picture Change
With this wizard you can create an action used to change a picture. The name of the picture
to be displayed is specified in the wizard.
Note
This wizard is only available if the project has not been processed with the OS - Project Editor.

Picture Object Export
This wizard exports user objects with type identifier contained in the current picture and in the
project into an Excel table (.csv format). Information such as the object type and connection
information is exported.
The wizard is part of the Graphic Object Update functionality.
Note
The Wizard functionality is only available in a PCS7-OS.

Display Error Box
The wizard creates an action which displays a dialog. The type of dialog, info box, question
box, or emergency box, and the title and text of the dialog must be specified in the wizard.
The action which calls the error box is not resumed until the box has been closed. Other actions
which have been configured under the same trigger type in the same application are not
triggered while the box is open.
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If one of the buttons in the dialog is clicked in Runtime, the action is given a return value which
you can evaluate in your script:
Button
OK
Cancel
Yes
No

Return value
1
2
6
7

Note
This wizard is only available if the project has not been processed with the OS - Project Editor.

Picture Object Import
This wizard imports user objects into WinCC pictures. The required information is normally
read from a file that has earlier been generated and modified using the Dynamic Wizard "Export
Picture Objects".
The wizard is part of the Graphic Object Update functionality.
Note
The Wizard functionality is only available in a PCS7-OS.

Display WinCC Dialog
With this wizard you can display any picture of the Graphics Designer in a picture window. The
name of the picture to be displayed and the appearance of the picture window is set in the
wizard.
Note
This wizard is only available if the project has not been processed with the OS - Project Editor.

See also
Dynamizing Using Dynamic Wizard (Page 1017)
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4.4.3

Picture Components

Creating faceplate as type - V 1.14
This wizard is used to configure the assignment between the object properties of the picture
and the structural components of a structured data type.
● Supply output value of an I/O field every second with .actual value
● Provide data to the process connection of a bar graph at intervals of two seconds.
Temperature
Here .actual value and .temperature are components of a structured data type
The original picture has become a type picture.
Note
This wizard is only available if the project has not been processed with the OS - Project Editor.
The WebNavigator does not support the basic faceplate technology of the wizard.

Creating instances in the plant picture - V 1.14
With this wizard you can create a picture window in a parent picture and then call a type picture
in this picture window. When doing so, you specify which tag of a structured data type the
picture window works with and at which position the picture window is placed. The instance
wizard enables the positioning of picture windows in several ways:
● as a fixed component in the picture
● as a displayable component which can be called using a button
● as several displayable components which can each be called using a button
● as a fixed component with a selectable name .he name of the component can be preassigned with a tag.
Note
This wizard is only available if the project has not been edited using the OS - Project Editor.
The WebNavigator does not support the basic faceplate technology of the wizard.

Picture Module Technology
The documentation concerning the Picture module technology explains the WinCC screen-inscreen technology. An example project illustrates how to create and modify a picture module.

See also
Dynamizing Using Dynamic Wizard (Page 1017)
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4.4.4

Import Functions

Import Messages
With this wizard you can import a COROS LS-B message list into WinCC. You will find further
information in the WinCC Information System under WinCC Documentation, Smart Tools,
Migration of COROS LS-B to WinCC.

Import S5L, Tag Only
With this wizard you can import a COROS LS-B tag list into WinCC. You will find further
information in the WinCC Information System under WinCC Documentation, Smart Tools,
Migration of COROS LS-B to WinCC.

Import S7 S5 ASLI
With this wizard you can read the assignment list of STEP 5 and STEP 7 into WinCC. You will
find further information in the WinCC Information System under WinCC Documentation, Smart
Tools, Importing Assignment List.

See also
Dynamizing Using Dynamic Wizard (Page 1017)

4.4.5

Standard Dynamics

Operative with Authorization
With this Wizard you may generate an action to check the authorization level of a user.

Link picture component with measuring point
Using the "Link Picture Component with Measuring Point" wizard you can link an existing
picture component with the measuring points existing in the project.
Perform the following steps to establish such a link:
1. Open a picture with the desired picture component in Graphics Designer.
2. Select this picture component (mark the header, not the object contained within the picture
component).
3. Select the "Standard Dynamics" tab in the "Dynamic Wizard" and start the wizard by double
clicking it.
4. Follow the instructions in the Dynamic Wizard dialogs.
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5. Using the tag selection dialog, the wizard will offer you all measuring points corresponding
to the structure tag of the selected picture component. Select the desired measuring point.
6. Start the action by clicking the Finish button.
The wizard will link the objects of the picture component with the structure tags of the selected
measuring point.
Note
The Wizard function is only available in a PCS 7 OS. One block icon must have been selected.

Set/Reset Bit
Using this wizard you may create an action to set or reset the bit of a tag. The tag to be changed
as well as the bit number will be displayed during the wizard run

Color Dynamics - Create a New Instance
Dynamizations done using the "Color dynamics with table" wizard can also contain references
to structure tags. For example: there can be a reference to a structure tag "Engine1" for a user
object to display an engine. To copy this object, for e.g. for displaying another engine, then
the references to the structure tag "Engine1" are to be modified.
The wizard does the required changes by switching all references to "Engine1" to the new
structure instance that is to be mentioned. This affects all dynamizations established through
tag links or scripts. Excluded are dynamizations established through Dynamic Dialog.
Note
This wizard is only available if the project has not been edited using the OS Project Editor.

Color Dynamics With Table
Color attributes of graphics objects may be controlled during runtime by using a table. Each
table entry may be assigned a color and a logical expression. The logical expression is a link
of bit information of one or several tags from the WinCC Tag Management. The table is
prioritized. The top table entry has the highest priority, the lowest table entry the lowest priority.
If several expressions are valid during Runtime, the one with the highest priority will be used.
After selecting a graphics object in Graphics Designer the wizard is ready to start. Initially the
wizard lists all object properties from which a dynamic color property may be selected.
Afterwards the update timer for the tag trigger is set. All used tags are entered as triggers.
Upon reselection of the wizard, the settings for any color dynamization previously made are
displayed again.
Note
This wizard is only available if the project has not been edited using the OS Project Editor.
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Set/Reset Several Bits
Using this wizard you may create an action to set or reset several bits of a tag. The tag to be
changed as well as the number of the bits will be displayed during the wizard run.

Network Entry Point
Using this wizard you may implement a direct network entry point during runtime, triggered by
an object event to be configured.
If the event occurs the program editor is started from STEP 7. At the same time a direct entry
is made into the respective network.
In order to use the wizard, the following prerequisites must be met:
● the WinCC project with the picture to which entry is supposed to be made and the STEP 7
project must be on the same computer
● the WinCC project must be created as a subdirectory of the STEP 7 project (STEP 7-Project
\wincproj\WinCC project)
● the S7 tags are mapped onto the WinCC tags
For the current object you specify an event which will trigger the entry. For e.g. "Click with the
left mouse key" on a button. In addition, the selected WinCC tag will be linked with an attribute
of the current object, for example the background color of the button. This attribute is controlled
by the contents of the WinCC tag upon modification of tag value.
Once the triggering event occurs on the respective object during runtime, e.g., click with the
left mouse button, the program editor (KOP, FUP, AWL) is started from STEP 7 and direct
entry is made into the network defined by the selected tag.
Note
Not all operator authorizations are displayed after the language is changed
The operator authorization is set up for each language in multi-language projects and errors
may occur when you change the language. Restart WinCC Explorer and User Administrator
to ensure the correct display of operator authorizations.

Move Object
The object properties "Position X" and "Position Y" can be linked with tags in the course of the
wizard so that the position of the object can be dynamized.
Note
This wizard is only available if the project has not been edited using the OS Project Editor.
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Fill Object
With this wizard you may create an action to dynamize the fill level of an object through a tag.
During the wizard run you may also define the tags as well as upper and lower limits for fill
levels 0% and 100%.
Note
This wizard is only available if the project has not been edited using the OS Project Editor.

Dynamize Prototype
With this wizard you may dynamize the object properties through a structure tag element.

Dynamic Entity of Prototype
You can use this wizard to link an object property or user object edited using "Dynamize
Prototype" in Runtime with a tag of a structured data type.
The wizard can only be used if the selected object has the "tagname" property in the correct
upper and lower case.
You can only use the wizard together with the "Link Prototype with Structure or Rename
Existing Ones" wizard.

Link Prototype with Structure or Rename Existing Ones
With this wizard you may link object properties to a structure or may rewire the link with a
structure.
The following options may be selected:
● Change Object Name: The structure name is assumed as the object name.
● Check Structures: Checks if the stated structure is known.
● Remove Server Prefix: Removes server prefix from tag name.
This wizard makes all necessary changes by modifying all references to the new structure
entity. This affects all dynamizations established through actions, direct links, or dynamic
dialog.
You can only use the wizard together with the "Dynamic Entity of Prototype" wizard.

Link Group Display with Picture
The wizard is only offered for selection if a picture component or group display is marked in
Graphics Designer.
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With this wizard you may link the selected group display to a picture which is linked to additional
group displays/picture components. In the selected group display in Runtime, you will see a
display of the message states for the linked picture.
Note
This wizard is only available if the WinCC Basic Process Control is installed, the project has
been processed with the OS Project Editor, and a group display has been selected.

Connect a group display with a PCS 7 process tag
The wizard is only offered for selection if a picture component or group display is marked in
Graphics Designer.
With this wizard you may link an existing group display to the measuring points available in
the project.
Note
This wizard is only available if the WinCC Basic Process Control is installed, the project has
been processed with the OS Project Editor, and a group display has been selected.

Actual Value Bar
Issues the tag content as actual value on a bar. Cycle time, tag name, minimum and maximum
value, and zero of the bar display may be entered during the wizard run.
Note
This wizard is only available if a bar has been selected.

See also
Color Dynamics with Table (Page 1027)
Dynamizing Using Dynamic Wizard (Page 1017)

4.4.6

Color Dynamics with Table

Dialog for the Creation of Color Dynamics
This dialog is used to define color changes which are controlled by tag states. The color can
be determined by a single tag or by the logical combination of several tags.
AND and OR conditions are available as logical operations.
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A maximum of 10 color definitions are possible. These are then processed in the listed
sequence. Entries which are at the top of the table have a higher priority than entries which
are at the bottom of the table. The last entry in the table is always the "Default" entry. Its priority
cannot be changed.

Creating Color Change Table
Before new color conditions can be added, a new row must be inserted using the "New" button.
The empty entry is then automatically highlighted and can be changed in the editing area for
expressions. The editing area is below the table.
"Properties" button. All the bit masks in the selected row are displayed in sequence. They
can be changed.
"Color" button. This button opens the color selection dialog. The color selection dialog can
also be opened by double-clicking the selected row.
"New List Entry" button. This button inserts a new row in the table.
"Delete List" button. All entries in the table are deleted, except for the entry "Other" (table
area).
"Delete Highlighted Entry" button. The highlighted row is deleted.
"Up" button. The selected row is moved up in the table and is thus given a higher priority.
"Down" button. The selected row is moved down in the table and is thus given a lower
priority.
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Editing Expression
"Delete Entire Expression" button. Deletes the entire expression.
"Delete the Last Part of the Expression" button. Deletes the last part of the expression.
"Accept Expression in the Table" button. Transfers the expression into the highlighted table
row.
"Tag Selection" button. Opens the tag selection dialog. All tags of the Bit, Byte, Word, and
DWord type are displayed. When the tags have been selected, the tag bit mask appears in
which the bits to be checked are set.
"And" button. If permitted syntactically, a logical AND operation is attached to the
expression.
"Or" button. If permitted syntactically, a logical OR operation is attached to the expression.
"Open Parenthesis" button. If permitted syntactically, an opening parenthesis is attached
to the expression.
"Close Parenthesis" button. If permitted syntactically, a closing parenthesis is attached to
the expression.
Note
It is not possible to edit the expression manually.

Dialog for Creating Tag Bit Mask
This dialog is used to enter the tag bits to be checked.
Up to four bytes (only one bit in the case of binary tags) of the tag value are displayed. The
states to be checked are entered here. An 'x' means that the bit is ignored.
If '0' or '1' is entered, the state of the bits concerned is checked accordingly.

See also
Dynamizing Using Dynamic Wizard (Page 1017)
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4.4.7

System Functions

Start Other Applications
With this wizard you can create an action which starts another application. The path and name
of the application to be started is entered in the wizard.

Hardcopy
With this wizard you can create an action for making a hardcopy of the screen.

Set Up Redundant Connection
With this wizard you can create an action for SIMATIC S7 Protocol Suite which performs a
dynamic connection switch.
Further information can be found in the description of S7 Protocol Suite.
Note
This wizard is only available if the project has not been edited using the OS Project Editor.

Language Switch
With this function you can create an action which switches the Runtime language.

Exit WinCC
With this wizard you can create an action which closes WinCC. The action only acts on the
computer on which the action is executed (this also applies to multi-user systems).
Note
This wizard is only available if the project has not been edited using the OS Project Editor.

Exit WinCC or Windows
With this wizard you can create an action which closes WinCC or the operating system. You
can specify how the operating system is to be closed (Exit, Restart, Relogin). The action only
acts on the computer on which the action is executed (this also applies to multi-user systems).
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Exit WinCC Runtime
With this wizard you can create an action which closes Runtime. The action only acts on the
computer on which the action is executed (this also applies to multi-user systems).
Note
This wizard is only available if the project has not been edited using the OS Project Editor.

See also
Dynamizing Using Dynamic Wizard (Page 1017)

4.4.8

SFC

Introduction
The Sequential Function Chart (SFC) is a process control which is used to control the sequence
of processes.
You can use the "SFC Visualization" software package using the WinCC configurations for
SFC visualization and to use and observe the SFC plans and SFC instances in runtime.
The help becomes available when SFC is installed.
Note
You can find information about the Dynamic Wizard and SFC in the SFC documentation by
searching for "Dynamic Wizard".

Configuring SFC Control
You can use this wizard to link an existing "PCS 7 SFC Control" with a SFC-Plan or SFCInstance existing in the project.

Requirement
● A "PCS 7 SFC Control" has been selected

Procedure
1. Open a picture with a "PCS 7 SFC Control" in Graphics Designer and select this control.
2. Select the "SFC" tab in the "Dynamic Wizard" and start the wizard by double clicking
"Configure SFC Control".
3. Follow the instructions in the Dynamic Wizard dialogs.
4. The wizard offers all the available SFCs via the SFC selection dialog. Select an SFC.
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5. Select the required representation for this SFC.
6. Start the action by clicking the "Next" button and confirm it by clicking "Finish". The wizard
connects "PCS 7 SFC Control" with the selected SFC.
Note
The Wizard functionality is only available in a PCS7-OS.

Configure SFC Browser
You can use this wizard to dynamize a graphic object, say a button, to open the SFC browser
at runtime using configured operations and to select and display a SFC plan or a SFC instance.
For additional information, see "SFC Visualization" in the PCS 7 description.
Note
The Wizard functionality is only available in a PCS7-OS.

Configure SFC Button
You can use this wizard to dynamize a graphic object, say a button, to select and display a
SFC plan or a SFC instance during runtime using configured operations.
For additional information, see "SFC Visualization" in the PCS 7 description.
Note
The Wizard functionality is only available in a PCS7-OS.

See also
Dynamizing Using Dynamic Wizard (Page 1017)
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4.5

Dynamizing by Means of Tag Connection

4.5.1

Dynamizing by Means of Tag Connection

Introduction
When a tag is connected to a property of an object, the value of the tag is transferred directly
to the object property. This means, for example, that the value of a tag can be directly
influenced by an I/O field.
You should always use this type of dynamization if you want to transfer the value of a tag
directly to an object property.

See also
Example: Dynamic Filling of Rectangle (Page 1034)
How to Configure a Tag Connection (Page 1033)
Types of Dynamization (Page 1009)

4.5.2

How to Configure a Tag Connection

Requirement
● Start Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object to be dynamized.
2. Click the Properties tab.
3. In the left-hand window area, select the property group to which the property you want to
dynamize belongs.
4. In the right-hand window area, select the property which you want to dynamize.
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5. Right-click the
up menu.

icon belonging to this property and select the Tag... command in the pop-

The tag selection dialog is displayed.
6. Select the tag which you want to link to the property.
7. Close the tag selection dialog using the OK button.
Dynamization by means of tag connection is indicated in the Object Properties dialog by
the
icon and the name of the tag. The default trigger set in the Graphics Designer is
used as the update cycle.
8. Check the update cycle and, if necessary, make changes using the pop-up menu.

Alternative Operation
You can also configure a tag connection by dragging a tag from the Tags toolbar onto the
icon.
You can also configure a tag connection by double-clicking the
can then be entered directly in the entry field.

icon. The name of the tag

You can also configure a tag connection to the Output Value object property by dragging a tag
from the Tags toolbar onto the object in the Graphics Designer picture.

See also
Example: Dynamic Filling of Rectangle (Page 1034)
Dynamizing by Means of Tag Connection (Page 1033)

4.5.3

Example: Dynamic Filling of Rectangle

Introduction
A process tag directly influences the fill level of a rectangle. In the example, the process tag
is simulated by an internal tag whose values you can change by means of an I/O field.
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Requirement
● Configure a "FillLevel" tag of data type "Unsigned 8-Bit Value".
● Start Graphics Designer and open a picture.
● Insert an I/O field into the picture and connect it to the "FillLevel" tag.
● Insert a rectangle into the picture.

Procedure
1. Open the "Object Properties" dialog of the rectangle and click the "Properties" tab.
2. In the left-hand window area, select the "Filling" property group.
3. In the right-hand window area, double-click the "Dynamic Filling" property. "Yes" now
appears in the "Static" column.
symbol belonging to the "Fill Level" property and select the "Tag..."
4. Right-click the
command in the context menu.

The tag selection dialog is displayed.
5. In the tag selection dialog, select the "FillLevel" tag and close the tag selection dialog using
the "OK" button.
6. Dynamization by means of tag connection is indicated in the "Object Properties" dialog with
the
symbol and the name of the tag. The default trigger set in the Graphics Designer is
used as the update cycle.
7. Save the picture and activate Runtime using the

button.

8. In Runtime you can change the value of the tag using the I/O field. If, for example, you enter
the value 30 in the I/O field, the bottom third of the rectangle is filled with the background
color of the rectangle. The top two thirds of the rectangle are transparent.

See also
Dynamizing by Means of Tag Connection (Page 1033)
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4.6

Dynamizing by Means of Direct Connection

4.6.1

Dynamizing by Means of Direct Connection

Introduction
Direct connection can be used as a reaction to events. If the event occurs in Runtime, the
'value' of a source element (Source) is used for a target element (Target).
Constants, tags, or the attributes of the objects in the picture are available as sources.
Tags or the dynamizable attributes of objects and windows or tags can be used as targets.
The advantages of direct connection are the simple configuration and the time response in
Runtime. Direction connection has the best performance of all dynamization types.

Copying Objects
If in the Graphics Designer you copy an object whose properties are dynamized with a direct
connection, the dynamizations are also copied.
If the direct connection in the original object relates to an object property of this object, the
direct connection in the copied object relates to the corresponding property of the copied object.
If the direct connection in the original object relates to an object property of a third object, this
third object is influenced by the direct connection of the copied object in exactly the same way
as the direct connection of the original object.

See also
Example: Picture Change in Picture Window (Page 1039)
How to Configure a Direct Connection (Page 1038)
Application Examples of Direct Connection (Page 1036)
Types of Dynamization (Page 1009)

4.6.2

Application Examples of Direct Connection

Constants As Source of Direct Connection
If a constant is selected as the source of the direct connection, a character string can be entered
in the entry field.
The table below explains the effect that the entries have on various target elements.
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Source

Objective

"picture1.pdl" Current window /
picture name

Explanation
If the event occurs, a picture change is performed. The
picture with the name "picture1.pdl" is displayed in the
window.

"picture1"

Button1 / text

If the event occurs, the object "Button1" is labeled "picture1".

50

Rectangle1 / width

If the event occurs, the object "Rectangle1" is displayed with
a width of 50 pixels.

50

Tag, direct with
operator message

If the event occurs, the tag is assigned the value 50. An
operator message is sent at the same time.

Note
You can also use the
button to configure a picture change. This button opens the picture
selection dialog in which all configured pictures are displayed.

Object Properties As Source of Direct Connection
The table below explains the effects of various direct connections when an object property is
used as the source.
Source

Objective

Explanation

Circle1 / fill
pattern

Rectangle1 / fill pattern

If the event occurs, the fill pattern of the object "Rectangle1"
is adapted to the fill pattern of the object "Circle1".

Circle / width

Current window / width

If the event occurs, the width of the window is adapted to the
width of the object "Circle1".

Bar1 / height

Tag, direct

If the event occurs, the height of the object "Bar1" is assigned
to the tag.

Note
The list of objects contains the entry "This object". If you use properties of the currently
selected object as the source or target of the direct connection, this entry is used automatically
when the dialog is closed. The dynamics are also copied when an object is copied. The direct
connection of the object created during copying therefore refers to "This object". The newly
created object is therefore used as the source or target of the direct connection.
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Tags As Source of Direct Connection
The table below explains the effects of various direct connections when a tag is used as the
source.
Source

Objective

Explanation

Tag1, direct

Tag2, indirect with
operator message

If the event occurs, the tag whose name is stored in Tag2 is
given the value of Tag1. An operator message is also sent.

Tag1, direct

Circle1 / radius

If the event occurs, the radius of the object "Circle1" is
changed according to the value of the tag.

See also
Example: Picture Change in Picture Window (Page 1039)
How to Configure a Direct Connection (Page 1038)
Dynamizing by Means of Direct Connection (Page 1036)

4.6.3

How to Configure a Direct Connection

Requirement
● Start the Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object for which you want to configure an action.
2. Click the Event tab.
3. In the left-hand window area, select the event trigger, e.g. mouse, background color, ...
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4. In the right-hand window area, double-click the event type: e.g. mouse click, change, ...
The Direct Connection dialog opens.

5. Set the source of the direct connection.
6. Set the target of the direct connection.
7. In the "Direct Connection" dialog, click the "OK" button. Dynamizing by means of direct
connection is indicated in the Object Properties dialog with the
icon.

See also
Example: Picture Change in Picture Window (Page 1039)
Application Examples of Direct Connection (Page 1036)
Dynamizing by Means of Direct Connection (Page 1036)

4.6.4

Example: Picture Change in Picture Window

Introduction
In a picture window, a picture change is executed by means of a direct connection.
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Requirement
● Start the Graphics Designer.
● Create two pictures "NewPDL1.pdl" and "NewPDL2.pdl". These pictures should contain
objects which allow a distinction to be made between the objects.
● Insert a button into a new picture.
● Insert a picture window into the picture. Enter the picture name "NewPDL1.pdl" in the
"Picture Name" object property.

Procedure
1. Open the "Object Properties" dialog of the button and click the "Event" tab.
2. In the left-hand window area, select the mouse as the event trigger.
3. In the right-hand window area, select Mouse Control as the event type.
symbol belonging to the "Action" and select the "Direct connection..."
4. Right-click the
command in the context menu.

The "Direct Connection" dialog opens.
5. In the "Source" area, select a constant as the source of the direct connection.
Click the
button and double-click the picture "NewPdl2.pdl" in the picture selection
dialog.
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6. In the "Target" area, select the object "PictureWindow1" and the property "Picture Name".

7. In the "Direct Connection" dialog, click the "OK" button. Dynamizing by means of direct
connection is indicated in the "Object Properties" dialog with the
symbol.
8. Save the picture and activate Runtime using the

button.

9. In Runtime, the picture "NewPdl1.pdl" is displayed in the picture window. If you click the
"Button" object, a picture change to the picture "NewPdl2.pdl" takes place in the picture
window.

See also
Dynamizing by Means of Direct Connection (Page 1036)
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4.7

Dynamizing Using the Dynamic Dialog

4.7.1

Dynamizing Using the Dynamic Dialog

Introduction
The Dynamic Dialog is used to dynamize object properties. In Dynamic Dialog you formulate
an expression by using tags, functions, and arithmetic operands. The value of the expression,
the status as well as the quality code of tags used within the expression are used to form the
object property value in Runtime.
The Dynamic Dialog may be used for the following purposes:
● Map the value ranges of a tag into colors
● Monitor single tag bits and map bit value onto colors or texts
● Monitor a Boolean tag and map bit value onto colors or texts
● Monitor tag status
● Monitor tag quality code
Note
If you divide two tags in a dynamic dialog, the decimal places are removed in the result. In
the generated C code, a "LONG" is erroneously placed before the "GetTagDouble".
Remove the "LONG" so that the result of the division is output correctly.
Note
When using several tags or operands, the essential performance advantage of Dynamic
Dialog is lost.

Convert to C Action
An action created with Dynamic Dialog is indicated in the "Object Properties" dialog with the
icon.
The code of this action is displayed if you use the right mouse button to click the
icon in
the "Object Properties" dialog and select the command "C Action..." in the pop-up menu. This
converts the dynamization created with Dynamic Dialog into a C action.
If you save the action or modify the code of the action, the action may no longer be modified
by using the Dynamic Dialog.
Note
The "check_limits" feature generated during conversion of the Dynamic Dialog is reserved
for the Dynamic Wizards.
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See also
Example: Color Change Depending on Position (Page 1058)
Monitoring Quality Code (Page 1054)
Monitoring Tag Status (Page 1053)
Defining a Valid Range (Page 1049)
Creating Expressions (Page 1045)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)

4.7.2

How to Configure Dynamization Using the Dynamic Dialog

Requirement
● Start the Graphics Designer and open a picture.
Note
Specifying triggers
If you do not set a trigger, the trigger event is defaulted by the system. The default values
are dependent upon the contents of the formulated expression.
Output value in the I/O field
The direct connection to a text tag as output value of the I/O field cannot be dynamized using
"Direct" data type in the Dynamic dialog.
Case sensitive tag name
Please note that the tag name is case sensitive.

Procedure
1. Open the "Object properties" dialog of the object to be dynamized.
2. Click the "Properties" tab.
3. In the left window area, select the property group which contains the property to be
dynamized.
4. In the right window area, select the property to be dynamized.
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5. With the right mouse button, click the
symbol belonging to the property and select the
"Dynamic Dialog..." command in the pop-up menu.

6. The Dynamic dialog opens.

7. In the "Language used" section set the corresponding code page for the scripts to be
generated. You can select "Dynamic: Project setting" as the language setting for scripts. C
scripts will then not only use the string transfer parameters with the given code page setting,
for example, French (France), but will react dynamically to the project setting. You can
specify the project setting in the "Project Properties" dialog in the WinCC Explorer.
8. Click the
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9. Specify the data type of the expression result in the "Result Of The Expression/Formula"
area.
The data type determines the options for specifying the expression and defining value
ranges.
10.In the "Expression/Formula" area, specify the expression which is to influence the value of
the object property.
You may enter the expression either directly or add tags, functions and operands to your
button.
expression by using the
11.Click the button "Check" to check the syntax of your expression.
12.Specify the valid ranges in the "Result of Expression/Formula" area.
13.Assign a value to the object properties of each valid range.
14.Specify whether or not to perform an analysis of the tag status of quality code of a tag.
Assign values to the object properties of the desired status or quality codes, if any.
15.Close the tag selection dialog by clicking the "Apply" button.
Dynamizing using the Dynamic dialog is indicated in the "Object properties" dialog with the
symbol.

See also
Example: Color Change Depending on Position (Page 1058)
Monitoring Quality Code (Page 1054)
Monitoring Tag Status (Page 1053)
Defining a Valid Range (Page 1049)
Creating Expressions (Page 1045)
Dynamizing Using the Dynamic Dialog (Page 1042)

4.7.3

Creating Expressions

Introduction
In Dynamic Dialog you formulate an expression by using tags, functions, and arithmetic
operands. The value of the expression is used to formulate the value of the object property
during Runtime.
The options to formulate the expression are dependent upon the desired data type of the
printout result.
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Formulating the Expression for Analog, Boolean, Direct Data Types

Tags
Tags may be entered either directly or by clicking the
button and using the tag selection
dialog. For direct entry, make sure that tag names are included in single quotation marks.
Note
If you enter the name of a tag which cannot be found, the "Missing tags" dialog appears.
Click the "OK" button to define a new tag with this name. Click the "Cancel" button to edit the
tag name.
Click the "Ignore" button to link the attribute with a nonexistent tag. This is useful, for example,
if you work with structure tags in a picture window or subsequently wish to import tags. Check
prior to commissioning that the respective tag is actually found in the system.
Functions
Functions may be entered either directly or by using the
button and the function browser.
You may use all C functions of the Global Script within an expression.
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Operands
Operands may be entered either directly or by using the
button. Within an expression,
operands may be used for addition, subtraction, multiplication or division.
Decimal numbers may be entered directly. Only a period is permissible as the decimal point.
Note
When using several tags or operands, the essential performance advantage of Dynamic
Dialog is lost.

Creating an Expression for Bit Data Types

Tags
Tags may be entered either directly or by clicking the
button and using the tag selection
dialog. For direct entry, make sure that tag names are included in single quotation marks.
Masking Relevant Bits
For 8-bit, 16-bit and 32-bit tags, clicking the
bits.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

button will open a dialog to mask the relevant

1047

Process Picture Dynamics
4.7 Dynamizing Using the Dynamic Dialog

Checking the Expression Syntax
Clicking the "Check" or "Apply" buttons, the syntax of the expression will be checked. You will
receive an error message if the expression contains an error.

Clicking the "Details" button, you will receive additional information on the error message.
Note
Clicking the "Check" or "Apply" buttons will sort the list of value ranges "Result of the
Expression/Formula" in ascending order by range upper limit.

See also
Example: Color Change Depending on Position (Page 1058)
Monitoring Quality Code (Page 1054)
Monitoring Tag Status (Page 1053)
Defining a Valid Range (Page 1049)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)
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4.7.4

Defining a Valid Range

Value Ranges for an Expression of Data Type Analog

For an expression of data type "Analog", you may specify several value ranges. Use the "Add"
button to create new value ranges. A new value range is always created between the most
recently defined value range and the range "Other".
The upper limit of a value range is changed by double-clicking the respective value in column
"Up to".
The applicable value of an object property in a value range is changed by double-clicking the
respective value in the column of the object property.
Settings shown in the picture have the following effect:
● If the value of the tag "Position" is less than or equal to 100, the property "Position X" is set
to 300.
● If the value of the tag "Position" is greater than 100 and less than or equal to 200, the
property "Position X" is set to 500.
● If the value of the tag "Position" is greater than 200, the property "Position X" is set to 0.
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Value Ranges for an Expression of Data Type Boolean

The applicable value of an object property in a value range is changed by double-clicking the
respective value in the column of the object property.
Settings shown in the picture have the following effect:
● If the tag "Position" equals TRUE, the property "Position X" is set to 300.
● If the tag "Position" equals FALSE, the property "Position X" is set to 0.
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Value Ranges for an Expression of Data Type Bit

The applicable value of an object property in a value range is changed by double-clicking the
respective value in the column of the object property.
Settings shown in the picture have the following effect:
● If Bit4 of the tag "Position" is set, the property "Position X" is set to 300.
● If Bit4 of the tag "Position" is not set, the property "Position X" is set to 0.
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Value Ranges for an Expression of Data Type Direct

Settings shown in the picture have the following effect:
● The value of tag "Position" is divided by 10. The result of this calculation is accepted as the
value for the object property to be dynamized.

See also
Defining a Valid Range (Page 1049)
Example: Color Change Depending on Position (Page 1058)
Monitoring Quality Code (Page 1054)
Monitoring Tag Status (Page 1053)
Creating Expressions (Page 1045)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)
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4.7.5

Monitoring Tag Status

Introduction
Dynamizing by using the Dynamic Dialog may also be used to monitor the status of a WinCC
tag in Runtime. Monitoring the tag status will also allow for conclusions on the status of
associated links for external tags.
If you activate the check box "Tag status", the Dynamic Dialog is extended.

The left subarea will display all tags used in the expression.
In the right subarea, you may assign a value for each tag status of the object property to be
dynamized. The applicable value of an object property for a tag status is changed by doubleclicking the respective value in the column of the object property.
Note
If definitions for the value of an object property in the areas "Result of the Expression/Formula"
and "Tag status" contradict each other, the value of the object property is determined by the
definition in area "Tag status".
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See also
Example: Color Change Depending on Position (Page 1058)
Monitoring Quality Code (Page 1054)
Defining a Valid Range (Page 1049)
Creating Expressions (Page 1045)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)

4.7.6

Monitoring Quality Code

Introduction
Dynamizing by using the Dynamic Dialog may also be used to monitor the quality code of a
WinCC tag in Runtime. Monitoring the quality code of external tags will also allow for
conclusions on the quality of associated tags during the process.
If you activate the checkbox "Quality Code", the Dynamic Dialog is extended.
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The left subarea will display all tags used in the expression.
In the right subarea, you may assign a value for each quality code of the object property to be
dynamized. The applicable value of an object property in a quality code is changed by doubleclicking the respective value in the column of the object property.
Note
If definitions for the value of an object property in the "Result of the Expression/Formula" and
"Quality Code" areas contradict each other, the value of the object property is determined by
the definition in "Quality Code" area.

Quality Codes that can be evaluated
In the right-hand portion of the Dynamic dialog, the selection of the supported Quality Codes
is shown. All quality codes are data managers that are not available in the Dynamic dialog are
summarized under the collective signal "bad miscellaneous state" and "uncertain
miscellaneous states".
The Quality Codes that are offered in the Dynamic dialog are found in the following table. This
list of Quality Codes is ordered by descending priority. If an expression is comprised of several
tags, the expression contains the Quality Code of the tags for which the Quality Code is highest
in the table.
Quality Code
(Hex)
0x1C

bad (0x1C) out of service

0x18

bad (0x18) no communication (no usable value)

0x14

bad (0x14) no communication (last usable value)

0x0C

bad (0x0C) device failure

0x08

bad (0x08) not connected

0x04

bad (0x04) configuration error, value not accepted

0x00

bad (0x00) non specific

0x28

bad (0x28) process related, substitute value

0x2B

bad (0x2B) process related, no maintenance

remaining codes from data manager
with "bad" quality

bad miscellaneous states

0x68

uncertain (0x68) maintenance demanded

0x60

uncertain (0x60) simulated value

0x54

uncertain (0x54) engineering unit range violation, no limits set

0x55

uncertain (0x55) engineering unit range violation, low limits set

0x56

uncertain (0x56) engineering unit range violation, high limits
set

0x78

uncertain (0x78) process related, no maintenance

0x4C

uncertain (0x4C) initial value

0x48

uncertain (0x48) substitute set

0x44

uncertain (0x44) last usable value
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Quality Code
(Hex)
0x40

uncertain (0x40) non specific

remaining codes from data manager
with "uncertain" quality

uncertain miscellaneous states

0x02

high limited (0x02)

0x01

low limited (0x01)

See also
Example: Color Change Depending on Position (Page 1058)
Editing Triggers (Page 1056)
Monitoring Tag Status (Page 1053)
Defining a Valid Range (Page 1049)
Creating Expressions (Page 1045)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)

4.7.7

Editing Triggers

Introduction
If you do not set a trigger, the trigger event is defaulted by the system. The default setting
depends on the content of the formulated expression in the Dynamic dialog.
● If the expression contains one or more tags, a tag trigger with the standard cycle set in the
Graphics Designer is used as the trigger. All tags contained in the expression are entered
in the tag list.
● If the expression does not contain any tags, a cyclic trigger with the standard cycle set in
the Graphics Designer is used as the trigger.

Trigger Events
The following trigger events are available in the Dynamic dialog.
● Tag: A tag trigger is used as the trigger. The query can be performed either when a change
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined
user cycles are also available.
● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1
h can be selected. Self-defined user cycles are also available.
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● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the picture object. This cycle provides the option of defining the
cycles of all the actions used in a picture centrally.
● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the Picture Window object. This cycle provides the option of
defining the cycles of all the actions used in a picture window centrally.
Note
It is important to remember that the cycle time has a major effect on the performance of
the project. All the actions of a picture must be completed within their cycle time. Apart
from the runtimes of the actions, the times required for requesting the tag values and the
reaction times of the automation systems must also be taken into consideration. You
should only set trigger events with a cycle time under one second if variables which change
rapidly have to be queried.

Requirement
● Open the Dynamic dialog

Procedure
1. Click the

button in the "Event Name" area.

2. The Change Trigger dialog opens.
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3. Select the desired trigger event in the Event section.
4. Select the desired cycle time in the Cycle section.
5. For the trigger events Standard Cycle, Picture Cycle, and Window Cycle, you can enter a
specific name for your trigger in the Trigger Name field.
6. Click "OK".

See also
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)

4.7.8

Example: Color Change Depending on Position

Introduction
The position of a workpiece is to influence the background color of the workpiece. In the
example, the workpiece is simulated by a rectangle and the position by an internal tag. The
position may be changed by using an I/O field.

Requirement
● Configure a "Position" tag of data type "Unsigned 16-Bit Value".
● Start Graphics Designer and open a picture.
● Insert an I/O field into the picture and connect it to the "Position" tag.
● Insert a rectangle into the picture. Dynamize the "Position X" object property by means of
a tag connection to the "Position" tag.

Procedure
1. Open the "Object properties" dialog of the rectangle and click the "Properties" tab, unless
already activated.
2. In the left-hand window area, select the "Colors" property group.
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3. Use the right mouse button to click the
button next to the property Background color.
From the pop-up menu, select the command "Dynamic Dialog...".

4. The Dynamic dialog opens.

5. In the Expression/Formula area, left-click the
The tag selection dialog opens.

button and select the Tag... command.

6. In the tag selection dialog, select the "Position" tag and close the tag selection dialog using
the "OK" button.
7. Click the Add button in the Result of Expression / Formula area.
The first value range is created.
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8. In the Background color column, double-click the color bar and select green as the
background color.
9. Click the Add button in the Result of Expression / Formula area.
The second value range is created.
10.In the Background color column, double-click the color bar and select yellow as the
background color.
11.Double-click the value "200" in the "to" column. Enter "300" in the value entry dialog.
12.Click the Add button in the Result of Expression / Formula area.
The third value range is created.
13.In the Background color column, double-click the color bar and select red as the background
color.
14.Click the "Accept" button.
15.Dynamizing using the Dynamic dialog is indicated in the Object properties dialog with the
icon. A tag trigger with the standard cycle set in the Graphics Designer is used as the
trigger.
16.Save the picture and activate Runtime using the

button.

17.In Runtime, you may change the X position of the rectangle by using the I/O field. Four
value ranges (0-100, 101-300, 301-500, 501-...) have been defined by Dynamic Dialog
dynamization. The background color of the rectangle changes according to the value range
in which the left-hand edge of the rectangle is located.

See also
Monitoring Quality Code (Page 1054)
Monitoring Tag Status (Page 1053)
Defining a Valid Range (Page 1049)
Creating Expressions (Page 1045)
How to Configure Dynamization Using the Dynamic Dialog (Page 1043)
Dynamizing Using the Dynamic Dialog (Page 1042)
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4.8

Dynamizing Using VBS Action

4.8.1

Dynamizing Using VBS Action

Introduction
Apart from the dynamization options using direct connection, C action, and tags, WinCC also
offers VBS actions for dynamizing graphic objects in Runtime.
You should use VBS actions if
● you want to process several input parameters in an action
● you want to execute conditional instructions (if ... then ...)
● you want to change several object properties in an action
● you want to access selection dialogs of the operating system, e.g. file selection dialog or
color selection dialog
You create VBS actions in the VBS action editor of the Graphics Designer. The action editor
offers a similar range of functions to the VBS editor Global Script. From the Graphics Designer
you can also access procedures which you have created in Global Script.
Actions which you create in the Graphics Designer are always stored with the picture in which
they have been configured. In addition to all configured object properties, the configured VBS
actions are also documented in the project documentation of the Graphics Designer. All of the
VBS actions configured in this picture are displayed if you select a picture in the WinCC
Explorer and call up the Properties dialog using the pop-up menu.
Further information on VBS actions can be found in the chapter "Creating Procedures and
Actions Using VBScript".

Application Scenarios
VBS Action for Dynamizing Object Properties
You use VBS actions for dynamizing an object property. You can dynamize the value of the
object property in Runtime depending on a trigger, a tag, or the status of other object properties.
You should use a VBS action if the options provided by tag connection or the Dynamic dialog
are not sufficient to solve the task in question.
VBS Action for Events
You can use a VBS action to react to an event which occurs at a graphic object. You should
use a VBS action if the options provided by tag connection or the Dynamic dialog are not
sufficient to solve the task in question.
The use of actions to react to changes to object properties influences performance in Runtime.
The event occurs if the value of the object property changes. The action associated with the
event is then started. When a picture is closed, all of the started actions are stopped one by
one. This can cause high system loads.
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See also
Editing Triggers (Page 1070)
How to Configure a VBS Action (Page 1068)
Working in Action Editor (Page 1066)
Action Editor in Graphics Designer (Page 1063)
Working with VBS Actions (Page 1062)
Types of Dynamization (Page 1009)

4.8.2

Working with VBS Actions

Introduction
If you create VBS actions in the Graphics Designer, it is important to note the following
differences compared to actions in Global Script:
● An action in the Graphics Designer is always saved with the picture.
● If you copy a graphic object for which you have configured an action, the action is copied
together with the properties of the graphic object.
● Actions can only be saved in the Graphics Designer if they have the correct syntax.
Therefore use the syntax check before you save an action.
● You cannot create globally applicable procedures in the Graphics Designer.
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Working with Actions
The editor for VBS actions in the Graphics Designer provides the following options:
● Before you save an action, check it to make sure that it is syntactically correct.
button in the toolbar or select the appropriate command from the popTo do so, click the
up menu in the VBS dialog.
● You delete actions from object properties by selecting the corresponding command from
the shortcut menu in the "Object properties" dialog of the graphic object:

If you configure a different type of dynamization at a property or an event, the dynamization
configured previously is automatically deleted.

See also
Editing Triggers (Page 1070)
How to Configure a VBS Action (Page 1068)
Working in Action Editor (Page 1066)
Action Editor in Graphics Designer (Page 1063)
Dynamizing Using VBS Action (Page 1061)

4.8.3

Action Editor in Graphics Designer

Introduction
You create and process VBS actions at graphic objects in the editor for VBS actions in the
Graphics Designer. The action editor offers a similar range of functions to the VBS editor Global
Script.
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Calling Action Editor
You start the editor for VBS actions from the "Object Properties" dialog of a graphic object in
the Graphics Designer. If you configure an action to dynamize an object property, you call the
dialog in the Properties tab. Place the mouse pointer in the "Dynamic" column and select the
"VBS Action" command from the pop-up menu:

If you want to react to an event at a graphic object using an action, you call the dialog in the
Event tab. Place the mouse pointer in the "Action" column and select the "VBS Action"
command from the pop-up menu:
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Layout of Action Editor
The editor for VBS actions offers a similar range of functions to the VBS editor Global Script.

Toolbar (1)
In the toolbar you will find all the commands needed to create actions.
Navigation window (2)
You manage your actions in the navigation window. Here you will also find:
● Project and standard procedures which you have created in Global Script and which you
can insert into your action code (drag and drop).
● Code templates which you can insert into your action or procedure (drag and drop).
Editor window (3)
You write and edit your actions in the Editor window.

See also
Editing Triggers (Page 1070)
How to Configure a VBS Action (Page 1068)
Working with VBS Actions (Page 1062)
Dynamizing Using VBS Action (Page 1061)
Working in Action Editor (Page 1066)
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4.8.4

Working in Action Editor

Declaration Area in Actions
If you create actions in Graphics Designer, you can display the declaration area of the action
button. When creating a new action, the "Option explicit" instruction is
using the
automatically entered in the declaration area and cannot be deleted. The instruction is
necessary as it prevents errors caused by the incorrect notation of tags without declaration.
The instruction requires that tags are always defined in your code with the "Dim" instruction.
Do not use the instruction "Option explicit" in your code as this can cause runtime errors.
In the declaration area, you can also make general settings which you want to use globally for
the current picture, e.g.:
● Tag Definitions
● Procedures which you only want to use in this picture
In the declaration area of the actions, you may define global tags independent of each other
in the areas "Event" and "Properties" of an object. There is no link between global tags of
identical names in both areas.
Note
Always make sure that the procedures in the declaration area have correct syntax, i.e. with
"Sub" - "End Sub". Do not create directly executable codes in the declaration area as this
can cause runtime errors.
Please note that when creating a tag, it must not contain a value (Value = VT_EMPTY).
Initialize the tags after declaration with the corresponding value.
In the general declaration part of screens, no check is made whether a procedure or function
name has already been assigned. Therefore, a name could occur several times and it is not
defined which function will be executed. This is standard behavior of the MS Scripting Engine.
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Intellisense and Highlight Syntax
During text entry, context-sensitive lists appear containing the properties, methods, and objects
possible at the current code position. If you insert an element from the list, the required syntax
is also indicated automatically.
Note
Full intellisense for all objects can only be utilized in the Graphics Designer if the list is
accessed using the object name and the result is assigned to a tag. Otherwise, you are only
offered a list of standard properties.
Example of full intellisense:
Dim Tag
Set Variable = ScreenItems ("Circle1")
Variable.<Intellisense selection>
If picture window limits are exceeded during addressing, it is once again only the standard
properties which are offered since the picture of the picture window is not loaded.

General VBS Functions
Using the pop-up menu in the Editor window you can view a list of the possible VBS standard
functions, e.g. Abs, Array, ... , Year.

Lists of Objects, Properties and Methods
Using the pop-up menu in the editing window you can view a list of the possible objects by
calling the "Object List" command in Graphics Designer.
Use the "Properties/Methods" pop-up menu command to call in a list of possible properties
and methods.
The same lists can be called in with the key combination <CTRL + SPACEBAR> but according
to the context of the script.

Code Templates
In the Code templates tab in the Navigation window of the Editor, you will find a selection of
frequently used instructions, e.g. for loops and conditional instructions. You can insert these
templates into your process code by dragging and dropping or by double-clicking.
If you insert a code template into your code, it is important to note that, for example, conditions
in the templates are identified by "_XYZ_". You must replace these placeholders with the
appropriate information.
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Selection Dialogs
If you use WinCC tags or picture objects in the code, you can open the following selection
dialogs:
●

Opens the tag selection dialog and gives the selected tag name as the return value.

●

Opens a tag selection dialog and returns the tag name with an associated reference.

●

Opens a picture/object browser in which you can select a picture/object whose name is
then used for the return value.

●

Opens a picture selection dialog for pictures and returns the picture name with the server
prefix, if necessary.

Syntax Check
The Action Editor supports you by providing a syntax check which you can perform after the
code has been created. Syntax errors in the code are displayed in the output window of the
editor. You can move to the erroneous point in the code directly by double-clicking the error
in the output window.
Note
The syntax check can only detect syntax errors in the code. Programming errors, such as
missing references, only become visible in Runtime. You should therefore also always check
your scripts in the Runtime environment.

See also
Editing Triggers (Page 1070)
How to Configure a VBS Action (Page 1068)
Working with VBS Actions (Page 1062)
Action Editor in Graphics Designer (Page 1063)
Dynamizing Using VBS Action (Page 1061)

4.8.5

How to Configure a VBS Action

Introduction
In the Graphics Designer you configure VBS actions to
● dynamize an object property. You can, for example, display a fill level according to a tag
value, implement a color change if a tag value is exceeded, or create cyclic actions (e.g.
flashing).
● react to an event which is triggered on an object: This can involve the execution of actions,
for example, on clicking the mouse or a color change following the change of an object
property.
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The procedure is basically the same for both types of action.

Executing Actions in Runtime
An action which you have configured for an event is executed whenever the triggering event
(e.g. mouse click) occurs.
Actions which you have used to dynamize object properties always need a trigger for execution.
Actions without trigger are not executed in Runtime.

Procedure
1. Open the "Object Properties" dialog of the object for which you want to configure an action.
2. Activate the Properties tab if you want to dynamize an object property.
Activate the Event tab if you want to react to an event with an action.
3. Highlight the "Dynamic" column of the object property which you want to dynamize, or the
"Action" column of the event to which you want to react. Select the command "VBS Action"
from the pop-up menu.
The editor for VBS actions is opened.
4. Create the VBS action.
5. Check your action with <F7>. If your action contains syntax errors, they are displayed in
an output window. Correct the code and check it again.
6. If your action is syntactically correct, exit the dialog with OK.
Note
Actions can only be saved in the Graphics Designer if they have the correct syntax. To
save an erroneous action temporarily, you must first remove the comment from the action.

Result
The action is displayed in the Object Properties dialog of the object with the following symbol:

See also
Editing Triggers (Page 1070)
How to Configure a VBS Action (Page 1068)
Working in Action Editor (Page 1066)
Action Editor in Graphics Designer (Page 1063)
Working with VBS Actions (Page 1062)
Dynamizing Using VBS Action (Page 1061)
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4.8.6

Editing Triggers

Introduction
If you configure an action for an event, you do not have to configure a trigger. The event is the
trigger for the action. You have to assign triggers if you configure an action for dynamizing an
object property.
A cyclic trigger with the standard cycle set in the Graphics Designer is used by default as the
trigger.

Trigger Events
The following trigger events are available in the editor for VBS actions.
● Tag: A tag trigger is used as the trigger. The query can be performed either when a change
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined
user cycles are also available.
● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1
h can be selected. Self-defined user cycles are also available. Note that the configured
user cycles are based on a 250 ms time pattern.
● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the picture object. This cycle provides the option of defining the
cycles of all the actions used in a picture centrally.
● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the Picture Window object. This cycle provides the option of
defining the cycles of all the actions used in a picture window centrally.
Note
It is important to remember that the cycle time has a major effect on the performance of
the project. All the actions of a picture must be completed within their cycle time. Apart
from the runtimes of the actions, the times required for requesting the tag values and the
reaction times of the automation systems must also be taken into consideration. You
should only set trigger events with a cycle time under one second if variables which change
rapidly have to be queried.

Automatic Ending of Actions
After a change of picture, busy scripts are automatically stopped 1 minute after the change of
picture.
Scripts that are still busy when Runtime is closed are stopped after 5 seconds.
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Requirement
● Open the editor for VBS actions.

Procedure
button.
1. In the toolbar, click the
The Change Trigger dialog opens.

2. Select the trigger event in the "Event" section.
3. Select the cycle time in the "Cycle" section.
4. In the "Trigger Name" field, you can assign a specific name to your trigger for the "Default
Cycle, "Picture Cycle", and "Window Cycle" trigger events.
5. Click "OK".

See also
How to Configure a VBS Action (Page 1068)
Working in Action Editor (Page 1066)
Action Editor in Graphics Designer (Page 1063)
Working with VBS Actions (Page 1062)
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Dynamizing Using VBS Action (Page 1061)
Trigger Types (Page 1013)
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4.9

Dynamizing Using C Action

4.9.1

Dynamizing Using C Action

Introduction
C actions are used to dynamize an object property or to react to events. When object properties
are dynamized, the value of the object property is determined by the return value of the C
function.
Use C actions if, for example, you want to process several input parameters in one action or
you want to execute conditional instructions (if ... then ...). It is advisable to use C actions
especially if in the case of recipes, for example, you want to access several tags in the
automation system at the same time.

Application Scenarios
C Action for Dynamizing Object Properties
You use C actions for dynamizing an object property. You can dynamize the value of the object
property in Runtime depending on a trigger, a tag, or the status of other object properties. You
should use a C action if the options provided by tag connection or the Dynamic dialog are not
sufficient to solve the task in question.
C Action As Reaction to Events
You can use C actions to react to an event which occurs at a graphic object. You should use
a C action if the options provided by tag connection or the Dynamic dialog are not sufficient to
solve the task in question.
The use of actions to react to changes to object properties influences performance in Runtime.
The event occurs if the value of the object property changes. The action associated with the
event is then started. When a picture is closed, all of the started actions are stopped one by
one. This can cause high system loads.
Note
If C scripts are linked to ActiveX Control events, ensure that the event name in question has
at least 5 characters. If the name is shorter than 5 characters, the C script is not executed.

See also
Types of Dynamization (Page 1009)
Importing and Exporting Actions (Page 1081)
Editing Triggers (Page 1079)
How to Apply Functions in the Action Code (Page 1077)
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How to Configure a C Action (Page 1075)
Working with C Actions (Page 1074)

4.9.2

Working with C Actions

Introduction
If you create C actions in the Graphics Designer, it is important to note the following differences
compared to actions in Global Script:
● An action in the Graphics Designer is always saved with the picture.
● If you copy a graphic object for which you have configured an action, the action is copied
together with the properties of the graphic object.
● Actions can be saved in the Graphics Designer if they can be compiled without error.
● You cannot create functions in the Graphics Designer; you can only call functions in actions
which you have created in Global Script.

Layout of Editor for C Actions

Toolbar
In the toolbar you will find the commands needed to create actions.
Navigation window
The navigation window enables you to access the existing C functions. You can apply these
functions to the function code by double-clicking.
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Edit Window
You write and edit your C actions in the Editor window.
In order to utilize the functions of the "Cross Reference" editor used to locate where tag and
picture names are used, the tag and picture names used in a C action must first be declared.
This is done in the areas "WINCC:TAGNAME_SECTION" and
"WINCC:PICNAME_SECTION". More detailed information can be found under "WinCC
Coding Rules"

See also
Importing and Exporting Actions (Page 1081)
Editing Triggers (Page 1079)
How to Apply Functions in the Action Code (Page 1077)
How to Configure a C Action (Page 1075)
Dynamizing Using C Action (Page 1073)

4.9.3

How to Configure a C Action

Introduction
In the Graphics Designer you configure C actions to
● dynamize an object property. You can, for example, display a fill level according to a tag
value, implement a color change if a tag value is exceeded, or create cyclic actions (e.g.
flashing).
● react to an event which is triggered on an object: This can involve the execution of actions,
for example, on clicking the mouse or a color change following the change of an object
property.
The procedure is basically the same for both types of action.

Processing of Actions in Runtime
An action which you have configured for an event is executed whenever the triggering event
(e.g. mouse click) occurs.
Actions which you have used to dynamize object properties always need a trigger for execution.
Actions without trigger are not executed in Runtime.
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Requirement
● Start the Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object to be dynamized.
2. To dynamize an object property: In the left window area, select the property group. In the
right window area, select the property.
3. To configure a reaction to an event: In the left-hand window area, select the event trigger,
e.g. mouse, background color, etc. In the right window area, select the type of the event:
e.g. mouse click, change, etc.
4. Right-click the associated
menu.

button and select the command C Action... in the pop-up

5. The editor for C actions opens.

6. Formulate the C function.
7. Click the

button and specify the trigger.

8. Select the language for C compilation from the toolbar.
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9. Click
. The function is compiled. This process is indicated in the status bar of the dialog
by the message "Compile Action...".
10.If compilation has been completed without error, the message 0 Error(s), 0 Warning(s) is
displayed in the status bar. Click on the OK button. The "Edit Action" dialog is closed.
Dynamization with C action is indicated in the "Object Properties" dialog by means of the
icon.
11.If compilation has not been completed without error, the number of errors and warnings is
displayed in the status bar. More detailed information about the errors is shown at the
bottom of the Editor window.

12.Correct all errors. Recompile the function. Click "OK" to close the dialog.
Dynamization with C action is indicated in the "Object Properties" dialog by means of the
icon.

See also
Importing and Exporting Actions (Page 1081)
Editing Triggers (Page 1079)
Working with C Actions (Page 1074)
Dynamizing Using C Action (Page 1073)
How to Apply Functions in the Action Code (Page 1077)

4.9.4

How to Apply Functions in the Action Code

Introduction
You can use internal functions, standard functions, or project functions within your action. The
function is always inserted in the action code at the cursor position.
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Requirement
● Open the editor for C actions.

How to Export an Action
1. Place the cursor at the point at which the function is to be inserted.
2. In the navigation window, double-click the function to be inserted.
3. If the function to be inserted has parameters, the Set Parameters dialog opens.

4. This dialog shows a list of all parameters belonging to the function to be inserted, and allows
you to set parameters for this function.
5. In the Value column, click the parameter which you want to set.
6. You can enter tags either directly or using the "..." button and the tag selection dialog.
You can enter objects and object properties either directly or using the "..." button and the
selection dialog for pictures, objects, and object properties.
You can enter pictures either directly or using the "..." button and the picture selection dialog.
If you make direct entries, make sure that you put names within quotation marks.
7. Click the "OK" button.
The parameter assignment dialog is closed and the function is inserted in the action code
at the cursor position.

Alternative Operation
You can also open the Set Parameters dialog using the commands Apply or Parameter
Assignment in the shortcut menu of the functions in the navigation window.

Notes on special functions
The "SetProperty" function should not be used within a C action because it initiates a 'Redraw'
of the picture.

See also
Working with C Actions (Page 1074)
Dynamizing Using C Action (Page 1073)
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4.9.5

Editing Triggers

Introduction
If you configure an action for an event, you do not have to configure a trigger. The event is the
trigger for the action.
You have to assign a trigger if you configure an action for dynamizing an object property. A
cyclic trigger with the standard cycle set in the Graphics Designer is used by default as the
trigger.

Trigger Events
The following trigger events are available in the Edit C Action dialog.
● Tag: A tag trigger is used as the trigger. The query can be performed either when a change
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined
user cycles are also available.
● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1
h can be selected. Self-defined user cycles are also available. Note that the configured
user cycles are based on a 250 ms time pattern.
● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the picture object. This cycle provides the option of defining the
cycles of all the actions used in a picture centrally.
● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object
property Update Cycle of the Picture Window object. This cycle provides the option of
defining the cycles of all the actions used in a picture window centrally.
Note
It is important to remember that the cycle time has a major effect on the performance of
the project. All the actions of a picture must be completed within their cycle time. Apart
from the runtimes of the actions, the times required for requesting the tag values and the
reaction times of the automation systems must also be taken into consideration. You
should only set trigger events with a cycle time under one second if variables which change
rapidly have to be queried.
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Requirement
● Open the editor for C actions in the Graphics Designer.

Procedure
1. In the toolbar, click the

button.

2. Select the trigger event in the "Event" section.
3. Select the cycle time in the "Cycle" section.
4. In the "Trigger Name" field, you can assign a specific name to your trigger for the "Default
Cycle, "Picture Cycle", and "Window Cycle" trigger events.
5. Click "OK".

See also
How to Configure a C Action (Page 1075)
Working with C Actions (Page 1074)
Dynamizing Using C Action (Page 1073)
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4.9.6

Importing and Exporting Actions

Introduction
In order to transfer an action to a different object or object property, you can export and then
import the function code.
When exporting, no check is performed to determine whether or not the function code can be
compiled without error.

Requirement
● Open the editor for C actions.

How to Export an Action
1. In the toolbar, click the

button.

2. The file selection dialog opens.
Enter an appropriate name for the exported file. Click "OK".

How to Import an Action
1. In the toolbar, click the

button.

2. The file selection dialog opens.
Select the file containing the function code to be imported. Click "OK".

See also
Working with C Actions (Page 1074)
Dynamizing Using C Action (Page 1073)
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5.1

5

WinCC Alarm Logging

Content
The message system
● Provides access to comprehensive information about error and operating states
● Allows for the early detection of critical situations
● Enables the prevention or reduction of downtimes
● Enables quality improvement
● Allows for targeted documentation of error and operating states
With the "Alarm Logging" editor, you configure
● Preparation of messages
● Display of messages in runtime
● Acknowledgment of messages
● Archiving of messages
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5.2

Message System in WinCC

Introduction
The message system processes results from functions that monitor actions in the process, on
the automation level and in the WinCC System. The message system indicates detected alarm
events both visually and acoustically and archives them electronically and on paper. Direct
access to the messages and supplementary information for individual messages ensures that
faults are localized and cleared quickly.

Archiving
Changes in the message status are written to configurable archives. The respective message
must be created accordingly.
Archiving takes place in the message archive. Various parameters, such as archive size, time
range, and switchover time, are specified for this. If one of the configured criteria is exceeded,
the oldest messages in the archive at the time are overwritten. The backup of the archiving
databases is specified through additional settings.
Display of messages saved in a message archive takes place in a long-term archive list or a
short-term archive list. Display of messages in the short-term archive list is updated
immediately upon receipt of a new incoming message.

Hiding Messages
Hiding messages reduces the information load for the system user. You can select whether
the messages are to be displayed in the message list, short-term archive list and long-term
archive list. The display depends on the activated "Display Options" option in the dialog. The
possible options are:
● Display All Messages
● Display visible messages (default setting)
● Display Hidden Messages
The hidden messages are displayed in the list of messages to be hidden and can be shown
again.
You can hide messages in two ways:
● Automatic hide: Messages are hidden and shown again later depending on a certain status
of the hide tag. You can configure the condition for hiding or showing using the hide mask
in the message.
● Manual hide: In the message window, you can use a button to define whether you want to
hide a message and, if so, at what time. You can also show the messages again using
another button. The system displays the messages again after a configurable time.

Operator message
An operation in the process can trigger an operator message.
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Single acknowledgment, group acknowledgment
A pending message can be acknowledged in two different ways:
● Messages that are not assigned the "Group Acknowledgment" attribute must be
acknowledged individually.
● Group acknowledgment can be used to collectively acknowledge all messages with the
"Group Acknowledgment" attribute that are visible in the message window.
The message acknowledgment can be logged with information on the acknowledging user
and computer used. This requires that you insert the "User Name" and "Computer Name"
system blocks in the message line of a message in the WinCC AlarmControl. Upon
acknowledgment of a message, the user name and computer name are not displayed in the
message line of the incoming message but rather are displayed in the operator message of
the acknowledgment in the short-term archive list and the long-term archive list. The operator
message must be activated in the WinCC AlarmControl in the "Operator messages" tab.

Events
The message system distinguishes between binary events and monitoring events:
● Binary events are state changes of internal or external tags.
● Monitoring events are not supported directly by Alarm Logging.
Monitoring events include overflow of archives and hard disks, printer messages, server
failure and faulty process communication.

Initial Value Message, New Value Message
● The initial value message is a message of a message class with single-mode
acknowledgment, which is highlighted as the first message of the message class by flashing
in the message window.
● The new value message is a message of a message class with single-mode
acknowledgment or duel-mode acknowledgment, highlighted by flashing in the message
window.

Message types, message classes
● Message classes comprise several message types. The following message classes are
preconfigured in Alarm Logging: "Error", "System, Requires Acknowledgment", and
"System, Without Acknowledgment". You can define up to 16 message classes.
● Messages with the same acknowledgment philosophy are combined into one message
type. All messages of a message type have the same color and background in Runtime.
The display can be adapted separately for each message type. You can create up to 16
message types for each message class. Message types are already configured in the
preconfigured message classes.
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Message blocks
The state change of a message is displayed in a message line in Runtime. You define the
information you want to have displayed in the message line during configuration of the
message blocks:
● System blocks allow for the specification of predefined information that is not freely
utilizable, such as date, time, duration, comment. The value of the message block (for
example, the time) is displayed in the message line.
● User text blocks enable you to assign a message to up to ten different freely definable texts.
The message line will display the content of the text you defined. The message text of a
user text block can display process values. You define the output format for this.
● Using process value blocks, you can display the values of tags in the message line. The
formatting that is used for this cannot be user-defined. You specify the associated tags for
the process value blocks.
When using in multi-user systems the content of a message can be displayed on a client by
configuring the message blocks equally on all servers.

Message event, message status
● Message events refer to the "coming in", "going out", and "acknowledging" of messages.
All message events are stored in the message archive.
● Message states are the possible states of a message: "Came In", "Went Out",
"Acknowledged".

Message window
In Runtime, the changes in message states are indicated in a message window. You can
configure the appearance and operating options of the message window in the Graphics
Designer.
A message window shows a table with all messages that have yet to be displayed. Each
message to be displayed appears in its own line – the message line.
The content of the message window can be influenced by a user-defined filter, for example,
sorting according to message blocks.
Depending on the source of the messages displayed in the message window, a distinction is
made between six types of message windows.
● Message lists are used for displaying currently pending messages.
● Short-term archive lists are used to display messages that are stored in a message archive.
The display of messages is immediately updated when a new message arrives.
● Long-term archive lists are used to display messages that are stored in a message archive.
● All messages in the system that have been locked are displayed in the lock list. Locked
messages can be unlocked by means of a button in the toolbar.
● The hit list contains statistical information on the messages.
● The list of hidden messages shows all messages that to be hidden due to automatic or
manual hide in the message list, in the short-term archive list or the long-term archive list.
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Message, message group
WinCC Alarm Logging distinguishes between two message forms:
● Messages
Each event is assigned a separate message.
● Message groups combine messages. At the same time, message classes and message
types represent message groups containing messages assigned to them.
You can use your user-defined message groups to combine any of the messages into
message groups, which can then be combined to form higher-level message groups. Up
to six layers of lower-level message groups are permitted.
You need a user-defined message group to hide a message automatically.

Messages
The message system is used to chronologically signal and archive events that occur
sporadically during the process via messages at a central location. A message can be caused
by an event or a frame.
The message system distinguishes between three messages:
● Operating messages indicate a status in the process.
● Fault messages indicate an error in the process.
● System messages indicate error messages from other applications.
In Alarm Logging, messages with similar behavior, for example, with the same
acknowledgment philosophy or color assignment of message states, are grouped into
message types.

Frames
Frames originate from either the process or from the process-control monitoring system. They
are exchanged between the controller or the monitoring application and Alarm Logging.
Frames Attributes are saved in raw data tags.

Message tag
In the bit message procedure, the controller signals the occurrence of an event in the process
by means of the message tag. Several messages can be masked via one message tag. A bit
of the message tag can only be used for a single message.
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Message procedure
The message procedure is a result of the configuration of the message. Alarm Logging
supports multiple message procedures:
● In the bit message procedure, the controller signals the occurrence of an event by means
of a message tag. The time stamp (date and time) of the message is assigned by Alarm
Logging.
● With chronological reporting, the controller transmits a frame with the message data when
the event occurs. This is evaluated in Alarm Logging. The time stamp (date and time) of
the message is assigned by the controller.
-If the "Acknowledgment-Triggered Messaging" (QTM) procedure is activated on an AS
S7-400, not every signal change is transmitted to the OS. With the QTM procedure, when
messages occur frequently due to sensor chatter, the AS does not send a new message
about a signal change until the last signaled positive signal change (incoming message)
has been acknowledged in the OS.
● Analog alarms can be used to monitor the course of an analog tag for violation of the high
and low limits or for agreement with comparison values.

Message line
In a message window, each message is displayed in its own message line. The content of the
message line depends on the message blocks to be displayed:
● In the case of system message blocks, the value of the message block is displayed, for
example, date and time.
● In the case of process and user text blocks, the content is displayed, for example, the text
you have defined.

Logging
There are two options available in WinCC AlarmControl for logging messages:
● With message sequence reports, all state changes (came in, went out, acknowledged) from
all currently pending messages are output to a printer.
● The messages in the individual message lists can be printed out directly via Print Current
View button in WinCC AlarmControl.

Locking and unlocking messages
In order to reduce the number of message events, known recurring messages can be locked
and unlocked again. The message system distinguishes between active and passive locking/
unlocking of messages. For active locking, the message source must support the locking/
unlocking of messages with confirmation and a valid date/time stamp. In addition, a general
query of the source must return the currently locked messages. If the message source meets
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these requirements, the messages are actively locked/unlocked; otherwise, the messages of
WinCC are locked/unlocked passively.
● In the case of active locking, a lock request is sent to the message source (for example,
the AS). The message is locked in WinCC only after the source confirms that the message
as locked. Messages are unlocked in the same way. Only messages that have been
configured chronologically on the AS level are locked/unlocked in active mode.
● In the case of passive locking, the message is locked/unlocked in the alarm server of
WinCC. The message source is not involved in this process.

Acknowledgment philosophy
Acknowledgment philosophy refers to the manner in which a message is to be displayed and
processed from the time it "Came In" to the time it "Went Out". Different acknowledgment
philosophies can be implemented in Alarm Logging:
● Single message without acknowledgment
● Single message with incoming acknowledgment
● Single message with dual-mode acknowledgment
● Initial-value message with single-mode acknowledgment
● New-value message with single-mode acknowledgment
● New-value message with dual-mode acknowledgment
● Message without "Went Out" status and without acknowledgment
● Message without "Went Out" status and with acknowledgment

Acknowledgment tag
The acknowledgment tag contains the "Acknowledgment Status". A central signaling device
can be controlled using the acknowledgment tag.

Status tag
The "Came In/Went Out" status and an identifier for messages requiring acknowledgment are
stored in the status tag.
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5.3

Principles of the Message System

5.3.1

Principles of the Message System

Introduction
Messages inform the operator about operating states and error states in the process. They
help identify critical situations early so that downtimes can be avoided.

Structure of a Message
The messages are displayed as lines in a table in Runtime. An individual message is composed
of information that is shown in the fields of the table. These individual pieces of information
are referred to as message blocks.
The message blocks are subdivided into three groups:
● System blocks with system data, for example, date, time, message number and status
● Process value blocks with process values, for example, current fill levels, temperatures or
rotational speeds
● User text blocks with explanatory texts, for example, the message text containing
information on the location and cause of a fault
While the contents of the system blocks are fixed, you can modify the contents of process
value blocks and user text blocks. Selections in system blocks affect only the data display but
not the logging.

Configuration
You make basic settings (input language, color scheme) for all editors in the main menu.
You find basic, frequently recurring procedures in the description "Working with projects".
You configure messages in Alarm Logging.
You configure the message window for displaying messages in Runtime in the form of an
ActiveX control in the Graphics Designer. You can freely configure the appearance and
operating options of the message window according to your requirements.
The Report Designer is used to configure the printout of messages in chronological order and
to log message archives.
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Display of messages in Runtime
In runtime, Alarm Logging records, evaluates, and archives the events coming from the
controllers or process control system and then displays them in a message window.

5.3.2

"Alarm Logging" editor

Introduction
You configure the messages and the message archive in Alarm Logging. You start Alarm
Logging by double-clicking the "Alarm Logging" item in WinCC Explorer.

Structure of the Alarm Logging editor
The Alarm Logging editor has three areas:
● Navigation area
– Tree view showing objects as folders
– Navigation bar for switching between the editors
● Table area
– Creation and editing of multiple objects
● Properties area
– Properties of a selected object
– "What's this?" for the selected property.
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① Navigation area
The navigation area displays the Alarm Logging objects as a tree view.
The folders of the top level are:
● Messages
The message classes and message types are located below this folder.
● Message blocks
● Message groups
● System messages
● Analog alarms
● AS messages
The assigned elements (messages, message blocks, etc.) of a selected folder are displayed
in the table area.
A shortcut menu is available for each folder. This provides commands for the folder and
commands such as "Copy / Paste" and "Export…".
Discrete alarms, system messages, analog alarms and AS messages can be hidden.

② Selection of the editors
The navigation bar is displayed in the area below the tree view. From here, you have access
to additional WinCC editors (e.g., Tag Management, Tag Logging). You can adapt the display
of the navigation bar.

③ Table area
The table displays the elements that are assigned to the folder selected in the tree view. You
can, for example, display all messages or only messages of a selected message class or
message type.
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You create new messages, message groups and analog alarms in the table area.
Message blocks are selected in the table for display in messages. You can edit the properties
of messages and message blocks in the table.
Additional functions are available in the table area via the shortcut menu of the column headers:
● Sort
● Filter
● Hide column, show additional columns
Note
Inconsistent entries have a colored background in the table window. In the event of
inconsistent configuration, a note is displayed which describes the incorrect configuration.
Tabs are displayed below the table depending on the selected folder. You can use these tabs
to display the lower-level elements in table format.
Navigation keys allow you to select tabs. You select a tab by clicking on it, with the navigation
keys, or from the shortcut menu of the navigation keys.

④ What's this?
Displays an explanation of the selected property. You can drag this area to zoom in and out.

⑤ Properties
Here, the properties of a selected object are displayed and can be edited.
Status bar
At the bottom edge of the editor is the status bar.

Here, you will find the following information:
● Status of the system (ready, etc.), status of Caps Lock key, NUM Lock key, etc.
● Current input language
● Number of selected objects if this is more than one.
● Number of objects (e.g. messages, message classes, message types, message blocks,
analog alarms, system messages…) in the selected folder.
● Display of the zoom status, slider for zooming in and out of the display
Alternatively, you can change the size of the display by pressing the <Ctrl> key while
moving the mouse wheel.
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5.3.3

Working in the Alarm Logging areas

Working in the "Alarm Logging" editor
You work and navigate in the "Alarm Logging" editor as you would in the entire Configuration
Studio. Configuration is user-friendly and supports the configuring engineer during editing. The
handling is similar to that of a spreadsheet program.

Working with the navigation area
Individual folders of the tree view are expanded or collapsed by clicking the

buttons.

Shortcut menus with additional functions are offered for individual folders. New message
classes, message types or message groups, for example, can be created from the shortcut
menu.
You can show or hide the navigation area by clicking the

buttons.

Selection
To show or hide specific messages in the table area, select the "Selection" command in the
shortcut menu of the "Messages" folder.
The following messages can be shown or hidden:
● Discrete alarms
● Messages of the analog alarm
● AS messages
● System messages

Working with the table area
Creating a new object
You create new messages in the table area. Additional objects, such as message classes,
message types or message groups, can also be created in the table area as an option.
To create a new object, you edit the cell identified by a yellow icon.

Enter a numerical value (e.g. message number) or text (e.g. object name), depending on the
property.
Input and editing
Properties of an object can be edited in the table area.
The following options are available:
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● Option:
Click in the box to set the check mark or to remove the check mark.
Option activated
Option deactivated
● Text input:
The text cursor is displayed after you have clicked in the box. Enter the text. Press the Enter
key or click anywhere. The text cursor is no longer visible and the text is saved.

● Selection from a drop-down list:
Click the button to select from a list of specified properties.

Make a selection.
● Open another dialog:
Click the button. A dialog with additional selection options is displayed. The input is not
accepted by the system until you close this dialog.

You can make entries in these fields directly above the keyboard. An invalid input is rejected.
Editing multiple messages
You enter recurring texts by selecting an entry and dragging down the bottom right corner of
the selection while keeping the left mouse button pressed.

The cells are automatically filled with the respective entry. Option boxes apply the selected
option of the marked cell. Numerical values are incremented, for example, the bits of a tag.
When you select an area in the table area which only contains check boxes, the commands
"Select all" and "Deselect all" are available from the shortcut menu. This also applies if you
select multiple rows or the complete table and the first column contains check boxes.
Filtering messages with the "Find" search field
Use the "Find" search field to filter entries according to the specifications in a column. The first
column is selected by default. You can select any other column.
You make the settings for the search in the menu of the search field.
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You can, for example, display all messages that start with the number 20 or all analog alarms
that monitor a tag ending in _level.
Delete the filter by clicking the button

.

Use the "Find" command to select the properties (table columns) to which the filter is applied.
Shortcut menu of the column header
The shortcut menu of the column header includes these options:

● Sort: The table can be sorted according to the selected column.
● Filter: To filter the table for entries of a property, select the "Filter" command.
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● Cut, Copy, Paste: These functions can be applied to all information of the selected column.
If you cannot paste the copied information to a column, you will be notified by a message.
● Find and replace: Function within the selected column.
● Delete: All entries in the column are deleted. This is not available for all properties.
● Hide, Show: The selected column can be hidden in the table area. Currently hidden columns
can be shown.
● Pin / Unpin: To always show columns when scrolling horizontally, select a column and select
the command "Pin". The column and all columns shown to the left remain visible while
scrolling. To scroll the pinned columns horizontally, select "Unpin".
Inconsistent entries
If an entered value is faulty or inconsistent, you will see a corresponding note, for example:
● Invalid entries are created when you edit several entries by dragging a cell.
The cell for the message number may have a red background in the table area and in the
"Properties" area, for example:
● A message was deleted even though it is still being used as limit message.
Undoing and restoring
Press <Ctrl+Z> to undo the last input or action.
Press <Ctrl+Y> to restore a previously undone setting.
These commands are also available in the main menu of the WinCC Configuration Studio.

Working with the "Properties" area
The properties of the selected object are displayed in the "Properties" area.
You can edit the properties here just as you would in the table area.
To display the properties of a message class, message type or message group, select it in the
tree view.
To display the properties of individual messages, message blocks or limit messages, select
them in the table view.
You can show or hide groups of properties by clicking the

buttons to get a better overview.

You show or hide the "Properties" area by clicking the

buttons.

Note
Creating tags with open tag selection
If you want to specify a message tag in Alarm Logging and have not created it in Tag
Management yet, you can create it in Tag Management while the dialog for tag selection is
displayed.
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5.3.4

Tips and tricks

Efficient configuration with Alarm Logging
Below are some tips from the real world. These will help you configure with the WinCC
Configuration Studio.

Find next free message number
To find the next free message number:
1. In the navigation area, select the folder with the message type to which the new message
is assigned.
2. Copy a message row in the table area.
3. Paste the row to the top free row as a new message
The message is automatically given the next free recipe message number.
4. Edit the properties of the message if required.

No translation
If you change the input language during configuration, the entries for the texts already
configured may not be available in the new input language. This is indicated by the note "Empty
text" in the corresponding properties fields of the user text blocks. This information reminds
you that translations are not available for the current input language. The "Empty text" message
only appears in the editor and not in Runtime.

Find and replace
If you want to find entries in the entire table, select the "Find" option in the shortcut menu of
the table. If you have already selected an area of the table, the search is limited to this area.
Use the "Find and replace" function to change specific entries in a selected area. You can, for
example, display messages of a range with the "Find" field and then change the message
groups to which selected messages belong in a highlighted area.

1098

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.3 Principles of the Message System

Please keep in mind that the corresponding object (the message group "Plant_unit_604" in the
example) may need to be configured beforehand.

Select all - Deselect all
The shortcut menu in the column header of some properties allows you to select an option for
all objects.
Examples:
● System messages - You can select (use) or deselect all system messages from the shortcut
menu.
● Message blocks - You can select (use) or deselect all message blocks from the shortcut
menu.
● Message groups - You can select or deselect the property "Shared message" for all
messages in a message group.
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Note
Multi-selection possible
If you have first selected multiple cells, the command is executed for all selected cells.
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5.4

Configuring the Message System

5.4.1

Configuring the Message System

Introduction
In Alarm Logging, you can specify the messages and content to be displayed in the message
window. You specify how and where messages are archived.

Basic procedure
The following steps enable efficient configuration:
1. Configure the message blocks in accordance with your requirements.
2. Configure the message classes, message groups and message types.
3. Configure the single messages.
4. Configure the system messages and analog alarms.
5. Configure the data archiving method.
Regardless of this sequence, you can adapt any existing configuration, add additional
configurations or delete existing ones at any time.

5.4.2

Working with Message Blocks

5.4.2.1

Working with Message Blocks

Introduction
The content of a message consists of message blocks. In Runtime, each message block
corresponds to one column in the tabular display of the message window.
There are three groups of message blocks:
● System blocks with system data, for example, date, time, message number, and status
● User text blocks with explanatory texts, for example, message text with information about
the cause of an error or location of the error, maximum 10 per message.
● Process value blocks are used to link the messages to process values, for example, current
fill levels, temperatures, or speeds, maximum 10 per message.

Configuring Message Blocks
● Select the message blocks for use.
● Edit the properties of the message blocks.
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General Properties of Message Blocks
You can display a message requiring acknowledgment or single message blocks as flashing
in Runtime. To do this, the following conditions must be satisfied:
● The "Flashing On" property must be activated in the message type to which the message
is assigned. You configure the property for a selected message type either in the table area
or in the "Properties" area.
● The "Flashing" property must also be enabled in the message block. You configure the
property for a selected message block either in the table area or in the "Properties" area.
If several message blocks or all message blocks in a message are to be displayed flashing,
this property must be enabled in each message block.
● The status texts of the messages are displayed in the "Status" system block. The number
of characters for this system block must be sufficient for the status texts to be displayed in
full.

Maximum number of characters
User text blocks can contain a maximum number of 255 characters.
The display of process value blocks is restricted during runtime to the following:
● Maximum of 32 characters for chronological reporting
● Maximum of 255 characters for bit messaging

5.4.2.2

Description of System Blocks

Introduction
System blocks allow for the display of predefined information that cannot be freely used, such
as date, time and duration.
The value of the message block (for example, the time) is displayed in the message line.

Overview
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System block

Description

Default number
of characters

Date

Date for the "incoming", "outgoing" and "acknowledged" states
of a message.

-

Time

Time of day for "incoming", "outgoing" and "acknowledged".
Accuracy of the WinCC time stamp: 1 s.
Display accuracy: 10 ms.

-
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System block

Description

Default number
of characters

Duration

Period of time between the "incoming" and "outgoing" states
and the acknowledgment of a message. There is only one
column for duration:

-

● The column remains blank for messages with "came in"
status.
● For messages with "gone out" status , the time that elapses
between "came in" and "went out" is displayed.
● When the message is acknowledged, the time between
"came in" and "acknowledged" is displayed.
Daylight Saving
Time/Standard
Time

An "X" in this system block indicates whether daylight saving
time applies.

1

Status

Message status, for example, "Came In" or "Went Out".
The status texts displayed in this system block are configured
in the message type and depend on the window type of the
message window.

1

Acknowledgment
Status

Indicates whether a message has been acknowledged. The
status texts displayed in this system block are configured in the
message type and depend on the window type of the message
window.

1

Number

Message number

3

Class

One of 16 message classes. The text is user-defined.

8

Type

One of 16 message types per message class. The text is user- 2
defined.

AS/CPU-Number

Number of the CPU and AS in which the message is triggered.
During runtime, the value of this system block is not taken from
the AS but rather is taken from the configured data of the single
message. The value has no function in the communication with
the AS.

2

Tag

Tag name for operator message from I/O field (and similar
objects that can output operator messages)

1

Archiving

Indicates whether the message will be archived.

1

Logging

Each message is logged. Logging cannot be changed or
removed.

1

Comment

The "Comment" system block indicates whether there is a
comment for this message. A comment is an entry made by the
user in the event of a message occurrence, for example, "This
message occurred today because...".

1

Info text

Information texts for the message, limited to a maximum of 255
characters, for example, "Message could occur if...". The
system block indicates whether an info text is available for this
message. Info text cannot be edited in Runtime.

1

Loop in Alarm

This field is marked with an "X" when the "Loop In Alarm"
function is activated.

1
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System block

Description

Default number
of characters

Computer name

Indicates the name of the computer:

10

● The name of the computer used by the operator is shown
in the short-term archive list and the long-term archive list,
provided that the user has entered a comment in the longterm archive list and has changed windows.
● After acknowledgment of a message, the computer on
which this has message was acknowledged is shown in the
operator input message in the short-term and long-term
archive lists. The operator input message must be activated
in WinCC Alarm Control on the "Message Lists" tab.
User name

Indicates the name of the user (login name):

10

● The user name is shown the short-term archive list and the
long-term archive list if the user has entered a comment in
the long-term archive list and has changed windows.
● After acknowledgment of a message, the user who was
logged on to WinCC at time of acknowledgment is identified
in the operator input message in the short-term archive list
and the long-term archive list. The operator input message
must be activated in WinCC Alarm Control on the "Message
Lists" tab.
Priority

Displays the priority of the message. You can sort the display
of messages by priority. By sorting according to priority, you
can ensure that, in single-line message view, the most
important message (that is, the message with highest priority)
is shown. A message with a lower priority is not displayed, even
if the message is more recent.

3

WinCC does not specify which value corresponds to the
highest priority. When using Basic Process Control or PCS 7,
reserve priority "16" for the messages with the highest priority.
Class priority

3

Used only by PCS 7.
Displays the priority of a message class. You can sort the
display of messages by class priority. If messages are sorted
according to priority, the message of the highest-priority
message class appears first in the display area in a single-line
message display.

Note
If the "ISO 8601-Force format for all components" setting is activated in the "Computer
properties" dialog, the formats configured for system blocks "Date" and "Time" are affected.

5.4.2.3

How to select message blocks for use

Introduction
You select message blocks that are required for the display and archiving of messages.
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Requirement
● The "Alarm Logging" editor is open.

Procedure

1. Select the "Message blocks" folder in the navigation area.
2. Set a check mark for the "Used" property for each message block you are using. Edit in the
table area (1) or in the "Properties" area (2).
3. Click the box again to remove the check mark. The message block is no longer available.

5.4.2.4

How to change properties of a message nlock

Properties of message blocks
The properties of a message block determine how the message is displayed in Runtime.

Procedure
You change the properties of a message block either in the table area or in the "Properties"
area.
Depending on the selected object, individual properties cannot be edited or only to a limited
extent. Properties that cannot be edited have a colored background in the "Properties" area.
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1. In the navigation area, select the "Message blocks" folder or one of the lower-level folders.
2. Select the message block in the table area to edit it in the "Properties" area.
3. You edit a property by clicking the respective box.
Note
All available properties of a selected message block are displayed in the "Properties" area.
Individual properties could be hidden in the table area.

Overview of properties

Property

Description

Used

Indicates whether the message block is used.

Message block

Name of the message block
The name is displayed as property during configuration of a message.

Number of
characters

Number of characters that are available for display of the message block in Runtime

Alignment

Left, centered, right

Flashing

Indicates whether the message block is displayed as flashing in Runtime.

Leading zeros

Only for numerical message blocks:
Indicates whether leading zeros are displayed.

Format

Only for date and time:
Selection of display

Example

Display: Example of date representation

Block type

Display - not editable

Block number

Display - not editable

Creator

Display - not editable

Translation
Displays the name of the message block in the available languages.
You can edit the text here.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.
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5.4.3

Working with Message Classes

5.4.3.1

Working with Message Classes

Introduction
Message classes combine message types in groups. Message classes provide a clear and
structured display.
As of V7.3, the message types assume all the properties of the message classes. The message
classes are retained as the parent of the message types and may continue to be used with
their group tags. These properties can thus be used more flexibly in the message types.

Overview
WinCC provides 16 message classes and two preset system message classes. The following
standard message classes are available:
● Error
● System, requires acknowledgment
● System, without acknowledgment
You configure the following settings for message classes:
● Message types assigned to the message class
● Group tags

5.4.3.2

How to Add Message Classes

Introduction
You add additional message classes to the message system to combine message types in
groups.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Messages" folder in the navigation area.

2. Select "New message class" in the shortcut menu.
A new message class appears as a folder in the tree view.

Alternative procedure
1. Select the "Messages" folder in the navigation area.
2. Click the "Message classes" tab below the table area.
3. Click in the top free cell of the "Name" column.
4. Enter the name for the message class.
A new message class has been created.
Note
Adding all message classes
To add all message classes at once, drag down the selection by more than 16 rows. This
adds all available message classes.

5.4.3.3

How to insert the copy of a message class

Procedure
1. Select the folder for a message class in the navigation area.
2. Select "Copy" from the shortcut menu.
3. Select the "Messages" folder in the navigation area.
4. Select "Paste" in the shortcut menu.
A copy of the message class is created in the tree view.
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Alternative procedure
1. Select the "Messages" folder in the navigation area.
2. Click the "Message classes" tab below the table area.
3. Select a line and select "Copy" from the shortcut menu.
4. Select the top free line and select "Paste" from the shortcut menu.
A copy of the message class is pasted.

5.4.3.4

How to change the properties of a message class

Introduction
You configure the following basic settings for message classes:
● Name of message class
● Tags

Requirement
● You have added the message classes to the message system.

Procedure
1. Select the folder of the message class in the navigation area.
2. Edit the properties of the message class in the "Properties" area.

Properties of a message class
You can freely assign the name of the message class. You can also change the name in the
shortcut menu of the tree view with the "Rename" command.
Message classes use tags such as message groups as group tags.
See also: "Working with Message Groups (Page 1141)".

Translation
Displays the name of the message class in the available languages.
You can edit the text here.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.
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5.4.3.5

How to Delete Message Classes

Introduction
You remove a message class from the message system when you no longer need it for the
configured messages.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the folder of the message class in the navigation area.
2. Select "Delete" in the shortcut menu.
Note
All messages assigned to the message class are deleted.
You cannot remove the "System, requires acknowledgment" and "System, without
acknowledgment" message classes.

5.4.3.6

System Message Classes

Introduction
System messages are messages that are generated internally by the system, such as
messages from operator inputs or on system failures.
WinCC provides system message classes for the processing of system messages. You cannot
expand system message classes. The acknowledgment philosophy of the assigned message
types is preset.
You specify which of the provided system messages are used. See section "Working with
system messages (Page 1152)".

System Message Class Requiring Acknowledgment
The following message types are assigned to the message class "System, requires
acknowledgment":
● Process control system: Messages are generated by the process control system, for
example, during system startup.
● System messages: Messages are generated by the system, for example, when a system
component fails.
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An incoming message that is assigned to the system message class that requires
acknowledgment must be acknowledged in order to remove it from the queue. The message
disappears immediately following an acknowledgment.
Note
The "Went Out" status is not registered or stored in the archive.

System Message Class Without Acknowledgment
The following message types are assigned to the message class "System, without
acknowledgment":
● Process control system: Messages are generated by the process control system, for
example, during system startup.
● Operator input messages: Messages are generated by the operator input, for example,
through operation of a component.
A message that is assigned to the system message class not requiring acknowledgment is not
acknowledged.
Note
Keep in mind that an erroneous operator input will also be logged in an operator input
message.

5.4.4

Working with message types

5.4.4.1

Working with message types

Introduction
Message types combine messages with the same acknowledgment philosophy and the same
color display.
You configure messages within a message type. Message types also combine messages into
groups.
As of V7.3, the message types assume all the properties of the message classes. The message
classes are retained as the parent of the message types and may continue to be used with
their group tags. These properties can thus be used more flexibly in the message types.

Overview
You can configure up to 16 message types in each message class.
WinCC provides the following message types for a new project:
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● "Alarm", "Warning" and "Failure" in the message class "Error".
These message types can be edited or deleted.
● "Process control system" and "System messages" in the message class "System, requires
acknowledgment".
● "Process control system" and "Operator input messages" in the message class "System,
without acknowledgment"
You cannot delete the message types of the system message classes. The
acknowledgment theory is preset. You cannot configure any additional message types in
the system message classes.

5.4.4.2

How to Add Message Types for the Message Class

Introduction
Message classes combine messages with the same acknowledgment philosophy and the
same color display.
You configure the message types within a message class.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the navigation area, select the folder with the message class to which the new message
type is assigned.
2. Select "New message type" in the shortcut menu.
A new message type appears as a folder in the tree view.
Note
You cannot add message types to the "System, requires acknowledgment" and "System,
without acknowledgment" message classes.

Alternative procedure
1. In the navigation area, select the folder with the message class to which the message type
is added.
2. Click the "Message types" tab below the table area.
3. Click in the top free cell of the "Name" column.
4. Enter the name for the message type.
A new message class has been created.
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Note
Adding all message types
To add all message types at once, drag down the selection by more than 16 rows. This adds
all available message types.

5.4.4.3

How to insert copies of a message type

Introduction
If you need several message types for your project whose properties are more or less identical,
create a copy of a message type.
Messages already assigned to the message type are not copied.

Requirement
A message type has been created.

Procedure
1. Select the folder for a message type in the navigation area.
2. Select "Copy" from the shortcut menu.
3. In the navigation area, select the folder of the message class to which the copy is added.
4. Select "Paste" in the shortcut menu.
A copy of the message type is created in the tree structure.

Alternative procedure
1. In the navigation area, select the folder with the message class to which the copy of the
message type is added.
2. Click the "Message types" tab below the table area.
3. Select a line and select "Copy" from the shortcut menu.
4. Select the top free line and select "Paste" from the shortcut menu.
A copy of the message type is pasted.

5.4.4.4

How to change the properties of a message type

Introduction
You configure the properties of a message type in the "Properties" area.
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Requirement
● You have added a message type to a message class.

Procedure
1. Select the folder of the message type in the navigation area.
2. Edit the properties of the message type in the "Properties" area.

Properties of a message type
● General information
"Name" and "ID" can be edited.
● Acknowledgment philosophy, central signaling device
See "How to Configure the Acknowledgment of a Message Type (Page 1114)"
● Status texts
See "How to Configure the Status Texts of a Message Type (Page 1116)"
● Tags
See "Tags of a message group"
● Colors
See "How To Configure Colors for the Display (Page 1118)"
● Translations
Displays the name and the status texts in the available languages.
You can edit texts.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.

5.4.4.5

How to Configure the Acknowledgment of a Message Type

Introduction
For the acknowledgment of a message, you specify how the message is to be displayed and
processed during runtime from "Incoming" status to "Outgoing" status. All messages assigned
to a message type use the same acknowledgment philosophy.

Requirement
● You have selected a message type in the navigation area.
● The properties of the message type are displayed in the "Properties" area.
● You can also select the "Messages" folder or the folder of a message class in the navigation
area and select the "Message types" tab in the table area.

1114

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.4 Configuring the Message System

Basic procedure
In the "Properties" area, you configure the acknowledgment philosophy of a message and the
acknowledgment of a message using the central signaling device.
You can choose between different states for the acknowledgment of a message:
● Single message without acknowledgment
● Single message with incoming acknowledgment
● Single message with dual-mode acknowledgment
● Initial-value message with single-mode acknowledgment
● New-value message with single-mode acknowledgment
● New-value message with dual-mode acknowledgment
● Message without "Went Out" status and with acknowledgment
● Message without "Went Out" status and without acknowledgment

Acknowledgment Theory Options

Some options cannot be combined with other options. To select one of these options, you first
have to undo the previously defined selection.
Option

Description

Acknowledgment Select the option for a single message that must be acknowledged when it comes
came in
in. The message remains pending until it is acknowledged.
Acknowledgment Select the option for a single message with dual-mode acknowledgment. Outgoing
went out
messages of this message class must be acknowledged.
Flashing On

Select the option for a new-value message with single-mode or dual-mode
acknowledgment. The messages of this message class are displayed flashing in
the message window. In order for a message block of a message to flash in runtime,
flashing must be enabled in the properties of the respective message block.

Only for initial
value

Select the option for an initial value message with single-mode acknowledgment.
Only the first message of this message type is displayed flashing in the message
window. The "Flashing On" check box must be selected.

Without status
"went Out"

Select the option for a message without "Went Out" status and with or without
acknowledgment. If this option is selected, the messages do not have "Went Out"
status. If the message only recognizes the "Came In" status, it is not entered in the
message window and is only archived.
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Option

Description

Unique user

If you select the option, the comments in the message window are assigned to the
logged-on user. The user is entered in the "User Name" system block. If no
comment has yet been entered, any user can enter the first comment. After the first
comment has been entered, all other users have only read access to this comment.

Comment

If you select the option, the comment of the incoming message is always displayed
in the user text blocks with the dynamic components "@100%s@", "@101%s@",
"@102%s@" and "@103%s@". The display then depends on the status of the
message in the message list.

Note
If a message type does not need to be acknowledged and is not assigned a "Went Out" status,
it is not displayed in the message window. The message is only archived. If such a message
is used within a message group, the status bit of the message group is no longer affected
when the message occurs.

Acknowledgment of a central signaling device

Option

Description

Acknowledge
button

Central signaling devices that are triggered when a message comes in are
acknowledged by the user by means of a separate acknowledgment button in the
toolbar or by means of a keyboard entry.
The acknowledgment button must be configured in the message window. The
separate acknowledgment button is always available, even if the "Single
acknowledgment" option has been selected in the properties of the message.

Tag for central
horn

The central signaling device is controlled by the tag.
Opens the "Select Tag" dialog so that a tag can be selected for the central horn.

5.4.4.6

How to Configure the Status Texts of a Message Type

Introduction
Message status texts of a message are displayed in the message line in the "Status" and the
"Acknowledgment Status" system blocks.
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Requirement
● You have selected a message type in the navigation area.
● The properties of the message type are displayed in the "Properties" area.

Display in the message window
The display of customizable status texts depends on the type of the selected message window:
Window Type

System block

Display of the status texts from the field

Message list

Status

"Came In", or "Came In and Went Out"

Message list

Acknowledgment
Status

"Acknowledged"

Archive List

Status

"Came In", "Acknowledged" or "Went Out"

Archive List

Acknowledgment
Status

No text is displayed.

Lock list

Status

No text can be configured.
Locked messages are labeled with "Lock". The lock cannot
be configured.

Lock list

Acknowledgment
Status

No text can be configured.
No text is displayed.

Note
The system generates the display of status texts "Ackn System" (system-acknowledged
messages) and "Ackn Reset" (messages acknowledged using emergency acknowledgment).

Configuration of status texts
You configure the texts for individual message states in the "Properties" area.

Option

Description

Came In

Text for "incoming" messages when there is a change to the signaling
operating state

Went Out

Text for "outgoing" messages when there is a change from the signaling
operating state

Acknowledged

Text for acknowledged messages

Came In and Went Out

Text for message that has come in and gone out

WinCC: Working with WinCC
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Note
Status texts are displayed in the message line only up to the number of characters configured
in the system block properties. Therefore, a system block should be long enough for the
longest status text to be displayed.

Translation
The bottom part of the properties includes the display of the status texts in the available
languages.
You can edit the text here.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.

5.4.4.7

How To Configure Colors for the Display

Introduction
You configure the properties of a message type in the "Properties" area or in the table area.
The selected colors are used to display the assigned messages.

Requirement
● You have added a message type to a message class.

Procedure
1. Select the folder of the message type in the navigation area.
2. Edit the properties of the message type in the "Properties" area.

Color selection
For each message type, select the colors with which the assigned messages are displayed in
Runtime. Font color and background color are specified for the states:
● Came in
● Went out
● Acknowledged
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1. Click on one of the property boxes for the color.
2. Click the
button.
The dialog for color selection opens.
3. Alternatively, you can use the keyboard to enter color values:
– Enter three values separated by semicolons. The values between 0 and 255 each
determine the RGB value of the color.
– Enter a single numerical value. The value is interpreted as a hexadecimal value.
The selected color is displayed in front of the numerical values. The selected color is
used for the display of messages of the message type in Runtime.

5.4.4.8

How to delete message types

Introduction
If you no longer need a message type, you can delete it.
Assigned messages are also deleted.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the folder for a message type in the navigation area.
2. Select "Delete" in the shortcut menu.
Note
You cannot remove the "Process control system", "System messages", and "Operator
messages" message types from the "System" message classes.
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5.4.5

Working with messages

5.4.5.1

Working with messages

Introduction
Each message is assigned to an event.
A message is made up of defined message blocks.
You can combine messages in a message group.

Requirement
You have configured message types to which you have assigned messages.

Configuring messages
You can configure messages in the table area of Alarm Logging:
● Create and copy messages
● Delete messages
You edit the properties of a message either
● In the table area
● In the "Properties" area

Displaying messages
Messages are displayed in the table area.
● To display all messages, select the "Messages" folder in the tree view in the navigation
area.
Note that discrete alarms, messages from the analog alarms, AS messages and system
messages may be hidden. You can hide or display these messages from the shortcut menu
of the "Messages" folder using the "Selection" command.
● To display messages of a message class, a message type or a message group, select the
corresponding folder in the tree view in the navigation area.
● To display the system messages, select the folder "System Messages".
● To display the messages of an analog alarm, select the folder "Analog Alarms".
● To display the AS messages, select the "AS messages" folder. This folder is only shown if
AS messages are available in the project.
Make sure that you have selected the "Messages" tab below the table area.

Shortcut menu in the table area
Use the shortcut menu of the table header (top row) to adjust the display of the table.
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Shortcut menu table header

● Sort the table according to the entries of a column.
● Hide the entries for a specific time by setting a filter.
● Hide or show individual table columns.
● Other functions are available, for example Cut, Copy, Paste, Delete etc.
Shortcut menu row number

You edit the message with the shortcut menu of the first table column (sequential row number):
● Copy the messages to create similar messages.
● Delete messages that are no longer required.
● Export selected messages.

5.4.5.2

The properties of a message

Introduction
You specify the properties of a message either in the table area or in the "Properties" area.
You can create and edit a large number of messages in the table area. You can show or hide
individual columns. You can sort or filter messages according to a column.
WinCC: Working with WinCC
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The "Properties" area displays all parameters of a message clearly arranged.

Requirement
● Required message classes and message types have been configured.
● Tags you are going to use have been created.
● Message blocks have been configured.

Display of parameters in the "Properties" area
1. Select a message in the table area by clicking any cell of the message.
Selection
Property

Description

Object type

Not editable

Object name

Message number
Even if several messages are selected in the table area, only one
message is edited in the "Properties" area.

General information
Property

Description

Number

Number of the message.
Letters, spaces and special characters are not accepted in message
numbers.

Message class

Message class of the message.
Selection from a drop-down list is possible.
You can only select from message classes that have already been
created.

Message type

Message type of the message.
Selection from a drop-down list is possible.
You can only select message types that have been assigned to the
selected message class.

Message group

Assignment of the message to a user-defined message group.
Selection from a drop-down list is possible.
You can only select user-defined message groups that have already
been configured.
The field remains empty if the message is not assigned to a userdefined message group.
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Property

Description

Priority

Defines the message priority. Messages can be selected and sorted
based on their priority. The range of values is "0" to "16".
WinCC does not specify which value corresponds to the highest priority.
The value 16 corresponds to the highest priority in the PCS7
environment.

Hide mask

Defines the condition for hiding the message. If the value of the hide
tag number corresponds to a system status in Runtime, the message
is automatically hidden in the message list and in the short-term or longterm archive list. The message must be assigned to a message group
and a hide tag must be configured for the message group.

Tags
Property

Description

Message tag

The message tag contains the bit which is used to trigger the currently
selected message.

Message bit

Number of the message tag bit which is used to trigger the currently
selected message.

Status tag

Tag in which the states of the message ("Came In / Went Out" and
acknowledgment status) are stored.

Status bit

Number of the status tag bit which indicates the message status. The
bit for mandatory acknowledgment is determined automatically.

Acknowledgment tag

Tag that is used as acknowledgment tag.

Acknowledgment bit

Number of the acknowledgment tag bit that is used to acknowledge the
message.

You select tags in the "Tag Selection" dialog. A message appears if you select a tag that is
already in use somewhere else. The input is not accepted. The bit is selected from a dropdown list. Only available bits are offered for selection.
Parameter
Property

Description

Single acknowledgment

The message must be acknowledged separately. It cannot be
acknowledged using a group acknowledgment button.

Central signaling device

The message controls a central signaling device.

Archived

The message is saved to the archive.

Falling edge

For the discrete alarm procedure, you can specify whether the message
is generated at the rising or at the falling signal edge. For all other
message procedures, the message is always generated at the rising
signal edge.
For messages with falling edge, configure the message tag with start
value "1".
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Property

Description

Triggers an action

The message triggers the default function "GMsgFunction" which you
can edit using the "Global Script" editor. The function is available at
"Standard Functions/Alarm" in the function browser of Global Script.

Extended associated value
data

The option controls the evaluation of message events from message
blocks via raw data tags.
Option is activated:
The process values are evaluated in Alarm Logging according to the
data types of the accompanying values defined in the dynamic text parts
and are archived or displayed in the message.
The 12 bytes of the accompanying value can be combined from the
following data types:
● Byte(Y),
● WORD(W), DWORD(X),
● Integer(I), Integer(D),
● BOOL(B), CHAR(C), REAL(R).
Example:
@1Y%d@, @2W%d@, @3W%d@, @3X%d@, @5W%d@, @6Y
%d@. For example, "@2W%d@" references the second associated
value as "WORD".
Regardless of the option, system values can be displayed for specific
message blocks in process value block "10".

You select a parameter by clicking in the option button and thus setting the checkmark

.

Extended
Property

Description

Format DLL

If the message tag is a raw data tag, select the corresponding compiler
program in this field.

Loop In Alarm

A WinCC function is started when the message is output.

Function name

Select the function that is called, for example, to link the message with
a picture.
Default: "OpenPicture"
You can select any other function.

Function parameter

Call parameter, depending on the selected function, freely editable.
Example: Name of a picture that is displayed when called.

AS number

Number of the AS (sublevel controller - PLC) which triggers the
message.
The value is displayed in the message block of the message in Runtime
and does not have any function in the communication with the AS.

CPU number

Number of the CPU which triggers the message.
The value is displayed in the message block of the message in Runtime
and does not have any role in the communication with the AS or CPU.

The following properties are only relevant for messages of an S7 Plus AS
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Address

Address of the message.

Version

Version of the message.

Author ID

ID of the author

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.4 Configuring the Message System
Property

Description

Connection

Name of the connection to the AS that can trigger the message.

Author

Display: Author of the message

User blocks
Property

Description

Message text

Freely editable, maximum 255 characters.

Point of error

Enter the text in the text field.

Info text

To add process values to the text, click in the field of the table area for
button.
"Message text", "Point of error" ... Then click the

Translation
The bottom part of the properties includes the display of the configured user text blocks in the
available languages.
You can edit the text here.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.

5.4.5.3

How to Create a Message

Introduction
You create a message in the table area by entering a number in the top free line of the "Number"
column.

Requirement
● The "Alarm Logging" editor is open.

Create new message
1. In the navigation area, select the folder with the message type to which the new message
is assigned.
2. Click in the next empty line of the "Number" column in the table area.
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3. Enter a number for the message.
The message is created as soon as you click the mouse on another location.
If you enter a number that is already assigned to a message, a corresponding message
appears. The input is not accepted.
4. Alternatively, select a tag in the top free row of the "Message tag" column. This field is also
marked by the yellow icon.
The message is created with the next available message number as soon as you have
selected the message tag.
5. Edit the properties of the message either in the "Properties" area or in the table area.

Create copied message
1. In the table window, select the line number of the messages you want to copy.
2. Select the "Copy" command in the shortcut menu.
Alternative: Press "Ctrl+C".
3. Select the top empty line.
4. Select the "Paste" command in the shortcut menu.
Alternative: Press "Ctrl+V".
5. Copied messages are pasted. The numbers are adapted according to the existing numbers.
6. Edit the properties of the copied messages.

Creating several messages
You can create a large number of messages in the table area based on an existing message.
1. Select the "Number" cell of the lowest entry in the table area.
2. Drag down the bottom right corner of the selection while keeping the mouse button pressed.

New messages are created. The message number is incremented according to the selected
message.

5.4.5.4

How to Edit Multiple Messages

Introduction
A selection of messages can be edited simultaneously.
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Requirement
● The "Alarm Logging" editor is open.

Possible actions
Messages displayed in the table area can be edited at the same time. Each individual property
(e.g. message type, message group membership, message text) can be changed or assigned
for multiple messages.
If messages that are edited together must be displayed in the table area below one another,
use the following options:
● Create several consecutive messages by "pulling down" the message number.
● Sort or filter the table by property using the shortcut menu of the column header.
● Filter the display using the "Find" search box.
You also have the following options:
● Selection of a message type, message class or message group in the tree view.
The assigned messages are displayed in the table area.
● Multiple selection in the table area: To select multiple lines, press the Shift button (selection
of consecutive lines) or the "Ctrl" button (selection of independent areas) while clicking a
line number.
You can apply the functions of the shortcut menu (Copy, Export, etc.) to the selection.

Procedure
1. Select the cell with the property of a message that is to be applied to the next messages.
You can select several properties at the same time.
2. Drag the selection at the bottom right corner of the box across the messages below.
The messages apply the property from the selection.
Numerical values (e.g., message bits) are incremented, if necessary.

5.4.5.5

How to Delete a Message

Introduction
You delete a message in the table area.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the table area, select the lines containing the messages you want to delete.
Click the line number to do so. If you only select individual cells of a message, only the
input for the respective property is deleted.
2. Select "Delete" in the shortcut menu. Alternatively, press the "Del" key.
The message is deleted and removed from the table.
System messages are not deleted. The use of system messages is canceled.

5.4.5.6

Tags of a Single Message

The message tag of a message
Introduction
A message is triggered by means of the message tag. The tag must be of an unsigned tag
type. The structure of message tags is not specified.
You have the following options of configuring message tags:
● Configuring separate message tags for each message.
● Triggering several messages using one message tag. The messages are distinguished by
the message bit. A message tag bit can only be used for a single message.

Procedure
1. Select the message in the table area.
2. Select the tag in the table area or in the "Properties" area. See "The properties of a
message (Page 1121)"
Note
Do not combine any bits of the message tag with other tags of the message, for example,
with a status tag.

Using one tag for multiple messages
1. Create the messages that use one tag below one another in the table area.
2. Select the tag for the first message and usually the message bit 0.
3. Select the cell with the tag and drag the selection down with the mouse.
The selected tag is applied to the messages below. The message bit is incremented
accordingly.
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The status tag of a message
Introduction
There are two important message statuses for a message:
● The "Came In / Went Out" status indicates whether the message is incoming or outgoing.
● The acknowledgment status indicates whether the message requires acknowledgment and
has not yet been acknowledged.
Both statuses of the message are stored in a status tag. Depending on the data type of the
tag, up to 16 messages can be logged to a status tag. Each message occupies 2 bits in the
status tag.

"Acknowledgment bit"
The acknowledgment bit in the status tag changes to "1" as soon as a message requiring
acknowledgment has come in and has not yet been acknowledged. The acknowledgment bit
changes to "0" as soon as a message requiring acknowledgment has been acknowledged.

Position of the bits
The position of the bit for "Incoming/Outgoing" status in the status tag is identified by the status
bit. The position of the "acknowledgment bit" depends on the data type of the status tag.
The distance to the bit with the "Came In / Went Out" status is:
● 4 bits for the "8 bit unsigned" tag
● 8 bits for the "16 bit unsigned" tag
● 16 bits for the "32 bit unsigned" tag
Status tag of data type "32 Bit Unsigned"
If the status tag is of data type "32 bit unsigned" and the status bit = 9,
● bit 9 of the status tag indicates the "Came In / Went Out" state of the message.
● bit 25 of the status tag indicates whether this message requires acknowledgment.
Bits "0-15" correspond accordingly to bits "16-31" of a "32-bit" status tag.

Status tag of data type "16 Bit Unsigned"
If the status tag is of data type "16 bit unsigned" and the status bit = 3,
● bit 3 of the status tag indicates the "Came In / Went Out" state of the message.
● bit 11 of the status tag indicates whether this message requires acknowledgment.
Bits "0-7" correspond accordingly to bits "8-15" of a "16-bit" status tag.
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Status tag of data type "8 Bit Unsigned"
If the status tag is of data type "8 bit unsigned" and the status bit = 3,
● bit 3 of the status tag indicates the "Came In / Went Out" state of the message.
● bit 7 of the status tag indicates whether this message requires acknowledgment.
Bits "0-3" correspond accordingly to bits "4-7" in an "8-bit" status tag.

Configuring the status tags
1. Select the message in the table area.
2. Select the tag in the table area or in the "Properties" area. See "The properties of a
message (Page 1121)"
Note
Do not combine any bits of the status tag with other tags of the message, for example, with
an acknowledgment tag.

Using one tag for multiple messages
1. Create the messages that use one tag below one another in the table area.
2. Select the tag for the first message and usually the message bit 0.
3. Select the cell with the tag and drag the selection down with the mouse.
The selected tag is applied to the messages below. The message bit is incremented
accordingly.

The acknowledgment tag of a message
Introduction
One bit of the acknowledgment tag in messages is used to trigger the acknowledgment and
to display the status. The following rules apply:
● The message was acknowledged if the corresponding acknowledgment bit has the value
"1".
● The message has not yet been acknowledged if the corresponding acknowledgment bit
has the value "0".
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This acknowledgment bit is set when a message is acknowledged in Runtime.
The structure of the acknowledgment tag is not specified. The tags must be an unsigned tag
type. You have the following options of configuring message tags:
● Configuring a separate acknowledgment tag for each message.
● Grouping several messages in a single acknowledgment tag. Messages are distinguished
by means of the acknowledgment bit.
Note
For the acknowledgment of the message using the WinCC Alarm Control, the
acknowledgment bit assigned to the message is set. The acknowledgment bit is reset by
user actions, for example, by clicking a button in the WinCC process picture or by means
of a program in the AS.

Configuring acknowledgment tags
1. Select the message in the table area.
2. Select the tag in the table area or in the "Properties" area. See "The properties of a
message (Page 1121)"
Note
Do not combine any acknowledgment bits of the message with other tags of the message,
for example, with a status tag.

Using one tag for multiple messages
1. Create the messages that use one tag below one another in the table area.
2. Select the tag for the first message and usually the message bit 0.
3. Select the cell with the tag and drag the selection down with the mouse.
The selected tag is applied to the messages below. The message bit is incremented
accordingly.

5.4.5.7

How to Specify Message Text for a Message

Introduction
In a message text of a message you specify, for example, information on the cause of the error.

Settings for configuring message texts
You specify the message text in the "Properties" area or in the table area.
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Info text
Enter an information text containing up to 255 characters. Info texts cannot be changed during
Runtime.
Blocks 1 to 10
Enter a text containing up to 255 characters for each block.
Blocks 1 to 10 represent the respective user text blocks.
You can change the names of the blocks. The names of the first two blocks are preset as
"Message text" and "Point of error".
In the user text block, you can display the field contents of the comment dialog of the message
using format specifications, for example:
● @100%s@ = Computer name
● @101%s@ = Application name (max. 32 characters)
● @102%s@ = User name (max. 16 characters)
● @103%s@ = Comment (max. 255 characters) of message in long-term archive list. For
this, a comment must have been entered in the message.

Requirement
● You have already created messages.
● User text blocks have been selected for use.

Procedure
1. Click in the input field, for example, "Message text", "Point of error"...
You can find the input fields in the "Properties" area under "User text blocks".
2. Enter the text.
3. To insert process values into the user text block, select the "Edit" command from the
shortcut menu of the corresponding input field in the table area.
The dialog for process value block selection and formatting opens. See "How to Insert
Process Values in User Text Blocks".
4. Close the dialog by clicking "OK".

Translation
The bottom part of the properties includes the display of the activated and used user text blocks
in the available languages.
You can edit the text here.
Recommendation: You can also edit the texts that are not available in the input language in
the "Text Library" editor.
No translation
If you change the input language during configuration, the entries for the texts already
configured may not be available in the new input language. This is indicated by the note "Empty
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text" in the corresponding properties fields of the user text blocks. This information reminds
you that translations are not available for the current input language. The "Empty text" message
only appears in the editor and not in Runtime.

5.4.5.8

How to Insert Process Values in User Text Blocks

Introduction
You can insert the value of a process variable in a user text block. The maximum number of
characters is 255.

Settings for configuring process values
You assign the process value to a user block in the dialog for editing a message text.
You make the following settings:
Input

Description

Process value block

Select the process variable, the value of which you want to insert.
You are offered to select:
● The process value blocks selected for use
● Computer name
● Application name
● User name
● Comment

Type

Specifies the format type of the process value to be inserted.
The following selections can be made:
● Text
● Fixed point number (decimal, octal, hexadecimal)
● Floating point number

Number of digits

Defines the number of digits reserved in the user text for the process value.

Accuracy

Defines how many digits of the process value are to be inserted in the user
text.

Align Left

If the number of digits in the process value to be inserted is less than the
number of digits reserved, this function is used to specify whether the process
value is aligned right or left when it is inserted in the user text.

Pad with 0

If this function is activated, floating point numbers are filled in with "0" until
the number of digits specified in the "Precision" text field is reached.

Data output

Input field for text.

Inserting process value

Inserts the selected process value in the selected formatting in the output at
the position where the input cursor is located.

< < > (arrow keys)

Place the input cursor in the process value block you want to move in the
user block.
Click an arrow key to move the process value block within the output.

Example
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Requirement
● You have already created messages.
● You have selected at least one process value block to be used.

Procedure
1. In the table area, select the corresponding user text block, for example, "Message text",
"Point of error, etc.
2. Select the "Edit" command from the shortcut menu of the input field.
The dialog for selection and formatting a process value block opens.

3. Specify the settings and confirm them with "OK".

5.4.5.9

How to Link a Picture to a Message

Introduction
You can display a graphic for a message in Runtime that represents the plant unit of the
process where the message occurred.
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To do this, assign the name of the graphic to a picture function that is triggered in the message
window:
Note
The default setting for the picture function is the WinCC standard function "OpenPicture".
You can specify any function and specify another file as the transfer parameter.
If you wish to use a different function, you should note the following:
● Use a function that accepts a transfer parameter of the type char*, for example: void
MyFunction(char* NameOwnData).
● Use only functions whose return parameter corresponds to the "unsigned char", "short
int", "long int", "float", "double", "bool", or "void" types.

Requirement
● You have already created messages.
● You have configured a graphic in the Graphics Designer.

Procedure
1. Select the message in the table area.
2. Activate the option "Loop In Alarm" in the "Properties" area, section "Extended".
The "OpenPicture" function is the default setting.
3. Select the graphic you want to display as a "function parameter".

5.4.5.10

How to Configure the Hiding of Messages

Introduction
Hiding messages reduces the information load for the system user. You as user can
concentrate better on the messages only if selected messages are shown.

Properties of hidden messages
Hidden messages are:
● In the message list, short-term archive list and long-term archive list, you can select whether
the hidden messages are to be displayed. The display depends on the activated option in
the "Display Options" dialog.
● They are included in the list of messages to be hidden and displayed there.
● They are archived.
● They do not trigger the alarm in Basic Process Control.
● The central messaging tag is not set in WinCC.
● You can manually or automatically unhide messages that are hidden.
WinCC: Working with WinCC
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● Manual hiding forces you to acknowledge messages that need acknowledgment and
triggers an operator input message.
● Automatic hiding does not force you to acknowledge and therefore it also does not trigger
an operator input message.
● In the period when messages requiring confirmation are hidden, the system acknowledges
the outgoing messages. If a message does not have the "gone" status, the system
acknowledges it immediately.

Procedure for hiding
You can hide messages in two ways:
● Automatic hide: Messages are hidden and shown again later depending on a certain system
status of the hide tag. You need to create a user-defined message group with a hide tag.
You add the messages that you want to hide in Runtime to the message group. You can
configure the system states for hiding or showing for each message using the hide mask.
● Manual hide: In the message window, you can use a button to define when you want to
hide a message from one of the three message lists. You can also show the messages
again using another button in the Message window. The system displays the messages
again after a configurable time. Operator input messages can be triggered in manual hide.

Configuration for hiding
You can configure automatic hide and the duration for manual hide in Alarm Logging.
You configure the button for manual hide in WinCC Alarm Control in the Graphics Designer.
Refer to section "How to hide and unhide messages" for details about configuring and operating
in Runtime during manual hide in WinCC Alarm Control.
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Requirement
● The "Alarm Logging" editor is open.

Procedure for automatic hiding
You configure automatic hiding using a user-defined message group.
1. Create a user-defined message group.
2. Select the respective folder in the navigation area.
The properties of the user-defined message group are displayed.

3. Click in the "Hide tag" box under "Tags".
4. Click the

button.

5. Choose the hide tag via the tag selection dialog. You can use an unsigned 8 bit, 16 bit or
32 bit value as a hide tag.
6. Add the messages that you want to hide automatically to the message group.
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7. Define the hide condition for each message of the user-defined message group.
Edit the "Hide mask" property. This way you determine the system statuses of the hide tag
for which the message is hidden.
.
8. Click
The "Hide at the following process cell states" dialog opens.

Select the system statuses. The selected system statuses are displayed in the "Hide mask"
box.
You can also enter the numerical values separated by semicolons in the "Hide mask" field.

Procedure for hiding manually
If the messages are hidden manually, define the duration for hiding messages from the
messages list in the "Alarm Logging" editor.

1. Select the "Messages" folder in the navigation area.
The properties available for manual hiding are displayed in the "Properties" area under
"Hiding manually".
2. Enter the required duration. 30 minutes are preset. The period is interpreted internally in
minutes. You can enter a maximum of 9 days, 23 hours and 59 minutes. This is equal to
239 hours and 59 minutes or 14399 minutes.

1138

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.4 Configuring the Message System

5.4.5.11

Importing and Exporting Messages

How to Export Messages
Introduction
You can select and export messages as you please. The exported messages are either saved
as a text file (*.txt) or as Excel workbook (*.xlsx).

Requirement
● The "Alarm Logging" editor is open.

Preparation for export
● Select the "Messages" folder if you want to export all messages.
● Select a folder if you want to export all messages of a message class, a message type or
a message group.
● Select individual messages you want to export in the table area.
To do so, select the line numbers of the messages.
Press the Shift key to select consecutive messages.
Press the Ctrl key to select non-consecutive messages.

Procedure
1. Select the messages you want to export.
2. Select "Export" in the shortcut menu.
3. Select the file format (text or Excel workbook).
The selected messages are written to a file.
A message confirms that the export was completed successfully.
Note
Select the "Edit > Export" command in the main menu to export the entire configured Alarm
Logging (all messages, message blocks and analog alarms).

Structure of the export file
The format of the export file is either Unicode text or an Excel workbook. All dependencies are
also exported.
Unicode text
The individual properties are separated by tabs; the lines are separated by line breaks (CRLF) .
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Depending on the selected export, the file lists message classes, message types, messages,
etc. with all properties.
You can open and edit the file in spreadsheet programs (such as MS Excel).
Excel workbook
Messages, message types and message classes are represented on separate worksheets in
Microsoft Excel 2010 format.

How to Import Messages
Introduction
You can import previously exported messages in Alarm Logging. You can import messages
from other projects.

Requirement
● The "Alarm Logging" editor is open.
● A text file with messages is available.

Procedure
1. Select the "Import" command in the "Edit" main menu. A dialog for selecting an import file
opens.
2. Select an import file.
3. Click "Import" to import the messages into the message system.
A message confirms that import is complete.

If errors occurred during the import, the message includes a link to the log file in which the
errors are listed
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5.4.6

Working with Message Groups

5.4.6.1

Message groups

Introduction
Message groups are used for higher-level queries and control of a defined number of
messages.

Configuration
In WinCC, there are two types of message groups:
● User-defined message groups
The user-defined message groups are configured using the "Message groups" folder in the
navigation area.
● The groups "Message classes" and "Message types" are already defined.
You configure these message groups by editing the properties of the message class or
message type.

5.4.6.2

Working with Message Groups

Introduction
For message groups consisting of message classes and message types, the associated
messages are the result of the general message configuration. Because the structure of the
message classes and message types is hierarchical and the message class always represents
the top folder for the message types listed below, the resulting message affiliation is as follows.
● All messages that are configured below a message class are part of this group.
● All messages that are configured below a message type are part of this group.
● You can determine the affiliation for user-defined message groups yourself.
The user-defined message groups can be hierarchically structured in six lower-level layers.
Keep in mind that a message can only be assigned to one user-defined message group.
You can use these options to form a wide variety of groups.
The message groups only include tags that process the status and control of the associated
messages as group formation or group control.
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Assignment of Tags
The following tags can be assigned to each message group, message class and message
type:
● The status tag represents the group formation of the message states of all lower-level
messages. The status bit indicates that at least one message has "Came in" status. It is
not reset until all messages have the status "Went out". The acknowledgment bit of the
status tags indicates that at least one message came in which requires acknowledgment.
This bit is not reset until all messages have been acknowledged.
The message status can also be queried by other WinCC components using the status tag.
● Use the lock tag to evaluate the lock of the message group. The lock tag is by default
controlled by the lock dialog in Runtime to lock the message group. The lock status can
also be queried by other WinCC components by means of the lock tag.
● Use the acknowledgment tag to define the acknowledgment of the message group. You
can use the acknowledgment tag to acknowledge the messages of the entire message
group. The acknowledgment can also be controlled by other WinCC components by means
of the acknowledgment tag.
● Hide tags only exist with user-defined message groups. Use the hide tag of a user-defined
message group to define the conditions for single messages of the message group - when
should a message be automatically hidden from the message list, short-term archive list
and long-term archive list.

5.4.6.3

How to Create a User-Defined Message Group

Introduction
You have the following options for creating user-defined message groups:
● Creating a new user-defined message group
● Creating a lower-level, user-defined message group for a user-defined message group

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Message groups" folder in the navigation area.
If you want to subordinate a user-defined message group, select a message group that you
have already created.
2. Select "New Group" in the shortcut menu.
A new user-defined message group is created.
3. Enter a name for the message group.
4. Configure the tags you need for the message group.
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Alternative procedure
1. Select the "Message groups" folder in the navigation area.
If you want to subordinate a user-defined message group, select a message group that you
have already created.
2. Click in the top empty line of the "Name" column in the table area.
3. Enter the name of the new message group in the "Name" input field.
A new message group is created.
4. To subordinate the user-defined message group to an existing user-defined message
group, select the required message group for the "Origin" property.
5. Configure the tags you need for the message group.

5.4.6.4

How to Change the Properties of a Message Group

Introduction
The properties and the assigned tags determine the behavior of the message groups.

Properties of the message groups
General information
Property

Description

Name

Enter text as required.
The names of a user-defined message groups can only be configured in one
language.

Message group
(ID)

Display of ID

Source

Higher-level message group.
Empty if the message group is on the top layer.
Can only be edited for user-defined message group. The message group can be
assigned to a user-defined message group you have already created.

Layer

Only for user-defined message groups:
Indicates the nesting depth. "1" is displayed if the message group is on the top layer.

Author

Display

Tags
Property

Description

Status tag

Tag in which the states of the message group ("Came In / Went Out" and
acknowledgment status) are stored.

Status bit

The two bits of the status tag in which the states of the currently selected message
group are stored.

Lock tag

If you lock a message group via the lock dialog during runtime, the relevant bit is
set in this tag.
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Property

Description

Lock bit

If you use a lock tag for several message groups, you specify the assignment to a
message group using a lock bit.

Acknowledgment
tag

Tag that is used as acknowledgment tag.

Acknowledgment
bit

Acknowledgment tag bit that is used to acknowledge the message.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select a message group in the navigation area.
2. Edit the properties in the table area or in the "Properties" area.

5.4.6.5

Tags of a message group

Tags of a message group
Supply of tags in a message group
Each user-defined message group, message class and message type provides tags. The value
of one of these group tags is the result of a logical OR operation of the corresponding tags of
the lower-level messages and message groups.
Tags of a message group can, for example, be evaluated by scripts. The status and
acknowledgment status of a group can be determined in this way. The lock tag is supplied by
the lock dialog in runtime. The hide tag can be used to automatically show or hide messages
in user-defined message groups.

Status Tag of a Message Group
Introduction
The status tag of a message group describes two message states:
● The "Came In / Went Out" status indicates whether one of the subordinate messages came
in or went out. This can also be another message group.
● The acknowledgment status indicates whether the triggering message of the message
group requires acknowledgment and has not yet been acknowledged.
Both states of the message group are stored in the tag. Depending on the data type of the tag,
up to 16 message groups can be logged to a status tag. Each message group occupies 2 bits
in the status tag.
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If a status bit of a lower-level layer is set in user-defined message groups, the status bit of all
levels above this one is set as well. This means the status is ORed up. The same applies to
the acknowledgment bit.

"Acknowledgment bit"
The acknowledgment bit in the status tag changes to the status "1" as soon as at least one
message that belongs to the message group and that requires acknowledgment came in and
was not acknowledged. The acknowledgment bit changes to the status "0" as soon as all
messages that belong to the message group and that require acknowledgment have been
acknowledged.

Position of the bits
The position of the bit for "Incoming/Outgoing" status in the status tag is identified by the status
bit. The position of the "acknowledgment bit" depends on the data type of the status tag.
The distance to the bit with the "Came in / Went Out" status is:
● 4 bits for the "8 bit unsigned" tag.
● 8 bits for the "16 bit unsigned" tag.
● 16 bits for the "32 bit unsigned" tag.
Status tag of data type "32 Bit Unsigned"
If the status tag is of data type "32 bit unsigned" and the status bit = 9,
● bit 9 of the status tag indicates the "Came In / Went Out" state of the message group.
● bit 25 of the status tag indicates whether the message group contains a message requiring
acknowledgment that has not yet been acknowledged.
Bits "0-15" correspond accordingly to bits "16-31" of a "32-bit" status tag.

Status tag of data type "16 Bit Unsigned"
If the status tag is of data type "16 bit unsigned" and the status bit = 3,
● bit 3 of the status tag indicates the "Came In / Went Out" state of the message group.
● bit 11 of the status tag indicates whether the message group contains a message requiring
acknowledgment that has not yet been acknowledged.
Bits "0-7" correspond accordingly to bits "8-15" of a "16-bit" status tag.
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Status tag of data type "8 Bit Unsigned"
If the status tag is of data type "8 bit unsigned" and the status bit = 3,
● bit 3 of the status tag indicates the "Came In / Went Out" state of the message group.
● bit 7 of the status tag indicates whether the message group contains a message requiring
acknowledgment that has not yet been acknowledged.
Bits "0-3" correspond accordingly to bits "4-7" in an "8-bit" status tag.

Configuration of the status tags for message groups
1. Select the message group in the navigation area.
2. You specify the status tag and the status bit in the "Properties" area.
Note
Do not mix any status tag bits with other tags of the message, such as an acknowledgment
tag.
Note
A configured status tag is not set if the associated message type is configured without the
following properties:
● Acknowledgment came in
● Messages without status "Went Out"

Lock Tag of a Message Group
Introduction
The lock tag of a message group is used to evaluate the locked status of the message group.
Define a lock bit in the lock tag for this purpose.
The structure of the lock tag is not specified. The tags must be an unsigned tag type. You have
the following options of configuring lock tags:
● Configure a separate lock tag for each message group.
● Group several message groups in a single lock tag. Message groups are identified by
means of the lock bit.
If a message group is locked in Runtime by means of the lock dialog, the associated lock bit
is set in the configured tag.
The lock bits are passed down to the layers below. If one layer is locked, all layers below this
layer are locked as well.
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Configuration of the lock tag for message groups
1. Select the message group in the navigation area.
2. Specify the lock tag and the lock bit in the "Properties" area.
Note
Do not mix any lock tag bits of the message with other tags of the message, such as a status
tag.

Acknowledgment Tag of a Message Group
Introduction
The acknowledgment tag of a message group is used to acknowledge all of its single
messages. Define an acknowledgment bit in the acknowledgment tag for this purpose.
The structure of the acknowledgment tag is not specified. The tags must be an unsigned tag
type. You have the following options of configuring acknowledgment tags:
● Configuring a separate acknowledgment tag for each message group.
● Group several message groups in a single acknowledgment tag. Message groups are
distinguished by means of the acknowledgment bit.
The corresponding acknowledgment bit is set to acknowledge the message group in Runtime.
The acknowledgment bit is acknowledged or reset by user actions, for example, by clicking a
button in the WinCC process picture or by means of a program in the AS. The acknowledgment
bit of a layer also acknowledges all lower-level layers.
Note
The acknowledgment bit does not display an acknowledgment via WinCC Alarm Control in
case of a message from a message group.

Configuration of acknowledgment tags for message groups
1. Select the message group in the navigation area.
2. Specify the acknowledgment tag and the acknowledgment bit in the "Properties" area.
Note
Do not combine any acknowledgment tag bits of the message with other tags of the message,
for example, with a status tag.
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Hide Tag of a User-Defined Message Group
Introduction
You use the hide tag of a user-defined message group to automatically hide messages that
are assigned to the message group. In the hide mask of the tag, you specify the system
statuses for which the message of the user-defined message group is hidden.

Overview
Select the hide tag of the message group in the "Properties" area.
In the properties of the message, you use the hide mask to specify the system statuses for
hiding the message. Select the process cell states in the "Hide at the following process cell
states" dialog.

The selected system statuses are entered in the "Hide mask" field.
If the value of the hide tag number corresponds to a system status in runtime, the message is
automatically hidden in the message list and in the short-term or long-term archive list. The
hidden messages are added to the list of hidden messages.

Relation between hide tag and hide mask
The hide mask is made up of configurable system statuses. The hide tag must accept the value
of the system status so that the message can be hidden. You can hide several messages for
a system status, if you configure the hide masks accordingly.
In the following sections you will see five examples for 8, 16 and 32-bit values of the hide tag.
The value of the hide tag corresponds to the respective process cell state.
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● Hide mask empty (zero). Hiding is deactivated. The message is never hidden.

● Hide mask 1. If the hide tag assumes the value "1", the message is hidden.

● Hide mask 1, 3, 4. If the hide tag assumes the value "1", "3" or "4", the message is hidden.

● Hide mask 4, 32. If the hide tag assumes the value "4" or "32", the message is hidden.

● Hide mask 0xFFFFFFFF. If the hide tag has a value greater than zero, the message is
hidden.

Configuring the hide tags
1. Select the user-defined message group in the navigation area.
2. Select the tag under "Hide tag" in the "Properties" area.
3. Select individual messages of the message group.
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4. Click in the "Hide mask" box in the "Properties" area.
The "System status" dialog opens.
5. Specify the value of the hide mask by clicking the corresponding option boxes.
You can also enter the corresponding numerical values separated by commas in the "Hide
mask" field.

5.4.6.6

How to Add a Message to a User-Defined Message Group

Requirement
● The "Alarm Logging" editor is open.
● You have already created a user-defined message group.

Procedure
1. Select a message in the table area.
It does not matter if a message class or a message type is selected in the "Messages"
folder of the tree view.
2. Select the required user-defined message group for the "Message group" property.
Only user-defined message groups that have already been created are available for
selection.

How to assign multiple messages to a user-defined message group
1. Display all messages you want to assign to a user-defined message group one after the
other in the table area.
Use the options to filter the view or sort by columns.
2. Assign the top message to the required user-defined message group.
3. Drag down the selection of the cell with the "Message group" property in the table area.
All messages that you include in your selection are assigned to the message group.

5.4.6.7

How to add another user-defined message group to a user-defined message group

Requirement
● The "Alarm Logging" editor is open.
● You have already created a user-defined message group.

Assigning a user-defined message group to a user-defined message group
User-defined message groups can be combined into a higher-level, user-defined message
group.
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How to assign a user-defined message group to an existing message group
1. Select the user-defined message group you want to assign to an existing message group
in the table area.
2. Select the required message group for the "Origin" property.
Only user-defined message groups that have already been created are available for
selection.
The "Layer" property shows the current layer in the tree structure.

5.4.6.8

How to Remove a Message from a User-Defined Message Group

Requirement
● The "Alarm Logging" editor is open.
● You have already assigned messages to a user-defined message group.

Procedure
1. Select a message in the table area.
It does not matter if a message class or a message type is selected in the "Messages"
folder of the tree view.
2. To assign the message to no user-defined group, delete the content of the "Message group"
property.
The message is retained. The message is not assigned to a user-defined message group.
3. Select "Delete" from the shortcut menu or press the Delete key.
The message is deleted.
4. To assign the message to another user-defined message group, select another userdefined message group for the "Message group" property.
Only user-defined message groups that have already been created are available for
selection.
The message is retained and assigned to a user-defined message group.

How to remove several messages from a user-defined message group
1. Display all messages with an assignment you wish to change one after the other in the
table area.
Use the options to filter the view or sort by columns.
2. Assign the top message to the required user-defined message group or to no message
group.
3. Drag down the selection of the cell with the "Message group" property in the table area.
All messages that you include in your selection are reassigned.
Note
You can also edit several messages with the "Replace" dialog.
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5.4.6.9

How to Delete a User-Defined Message Group

Requirement
● The "Alarm Logging" editor is open.
● You have created a user-defined message group.

Procedure
Note
All assigned messages and subordinated, user-defined message groups are deleted when
you delete a user-defined message group.
To undo the deletion, press Ctrl+Z.
1. In the navigation area, select the user-defined message group you want to delete.
2. Select "Delete" in the shortcut menu.
The user-defined message group with its associated messages is deleted.

5.4.7

Working with system messages

5.4.7.1

How To Use System Messages

Introduction
System messages are triggered by different WinCC components in Runtime. WinCC provides
system messages for this purpose. The WinCC installation directory includes languagespecific files with special system messages, e.g. "LTMDatenEnu.CSV". The system messages
are available in all WinCC installation languages. System messages must be selected for use
when you configure the message system.
System messages are displayed under the separate folder "System messages" and below the
folders of the system message classes.
System messages used are also displayed under the "Messages" folder if "System messages"
are selected in the shortcut menu of the folder under "Selection".
The operator message with message number 1250841 is always provided and used in a new
project.

Requirement
● The "Alarm Logging" editor is open.
● The "System messages" folder is selected in the navigation area.
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Selecting the user text block and language
A user text block is required for displaying system message texts. Select a user text block.
● Select the input language with the "View > Input language" command in the main menu of
WinCC.
● Select the "System messages" folder in the navigation area.
● Under "Message block for message text" in the properties area, select the user text block
in which the message texts are to be entered.
● Under "Language for texts" in the Properties area, select one of the installed languages.
The texts of the selected language are used for the current input language.

Using all system messages

1. Select the "Used" column in the table area.
2. Select the "Select all" command in the shortcut menu of the "Used" column.
All system messages are applied. This process takes some time.
The system messages obtain texts from the language selected for the selected user text
block.
Note
You can edit the properties of system messages to a limited extent.
You cannot edit the numbers of system messages.
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Using individual system messages

1. Select the "System messages" folder in the navigation area.
2. Select the "System messages" tab in the table area.
3. To use a system message, enable the option "Used".
Used system messages are displayed under the "Messages" tab and below the folders of
the system classes.

Using multiple system messages
1. Select the system message lines that you want to use.
2. From the shortcut menu, select the "Select all" command.
If required, you also deselect system messages using the shortcut menu.
Note
When you delete a system message in the table area under the "Messages" tab, it is no
longer used.

Updating used system messages
You can update the system messages to the latest version after installing a new language,
after a system update or after migration. System messages that do not correspond to the
template are highlighted in red in the table area.
1. In the table area, select the system messages that you want to refresh.
If you want to refresh all system messages, select the column "Used".
2. Select the "Update" command in the shortcut menu.
The selected system messages are updated. The system messages obtain texts from the
language selected for the selected user text block.
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Note
System messages from languages installed at a later time
When you install a language at a later time and are already using WinCC system messages,
you must update the system messages.
Incorporating new system messages after a system update or migration
You have to update the system messages following a system update or migration.

5.4.7.2

Description of WinCC System Messages

Introduction
The system messages are listed below.
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System messages are assigned to the default message type when you use a system message
class.
Note
When you assign system messages to a user-defined message class and message type, the
message class and message type must have the same properties as the system message
class.
Note
You can obtain additional information on the system messages in the system message block
"Comment" for the message.

WinCC system messages
Number

Error Message / Description

1000000

WCCRT:Error

1000001

WCCRT:Error loading the object engine

1000002

WCCRT:Channel could not be loaded

1000003

WCCRT:Tag - Violated low limit

1000004

WCCRT:Tag value of the high limit is exceeded

1000005

WCCRT:Format error of tag

1000006

WCCRT:Scale error of tag

1000100

WCCRT:Drive error

1000200

WCCRT:Status

1000201

WCCRT:Object Engine was loaded

1000202

WCCRT:Runtime has been activated

1000203

WCCRT:Runtime has been deactivated

1000204

WCCRT:Connection not established

1000205

WCCRT:Connection established

1000206

WCCRT:Client connection established

1000207

WCCRT: Client connection disconnected

1000208

WCCRT:Client connection broken

1000209

WCCRT:Connection deleted

1000210

WCCRT:Connection modified

1000211

WCCRT:Connection reestablished

1000300

WCCRT:Driver state

1000301

WCCRT: Legitimization of connection has failed. The password is incorrect!

1000302

WCCRT: The PLC is protected. You must configure a password for the connection.

1000303

WCCRT: Legitimization of connection has failed. The password is blocked. Please unblock locally (e.g. on the
display).

1000800

PACKAGE:Import

1000801

PACKAGE:Export
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Number

Error Message / Description

1000802

PACKAGE:Delete

1000803

PACKAGE:New

1000804

PACKAGE:Reload

1000805

PACKAGE:DefaultServer

1000806

PACKAGE:Implicit update

1000807

PACKAGE:Update

1000900

PERFMON: is low

1000901

PERFMON: is OK

1000902

PERFMON: is high

1000903

PERFMON: is OK

1000904

PERFMON: is low

1000905

PERFMON: is OK

1000906

PERFMON: is high

1000907

PERFMON: is OK

1000908

PERFMON: is low

1000909

PERFMON: is OK

1000910

PERFMON: is high

1000911

PERFMON: is OK

1000912

PERFMON: Redundancy loss of the terminal adapter

1000913

PERFMON: Redundancy of the terminal adapter restored

1000914

PERFMON: Terminal adapter connected

1000915

PERFMON: Terminal adapter disconnected

1001000

PDLRT: General error

1001001

PDLRT: Operator action not active

1001002

PDLRT: Wrong picture format

1001003

PDLRT: Picture not found

1001004

PDLRT: No dynamic active in picture

1001005

PDLRT: Tag could not be written

1001006

PDLRT: Dynamic Actions not active

1002000

TLGRT: General error

1002001

TLGRT: Error during initialization

1002002

TLGRT: Error during loading of run-time data

1002003

TLGRT: Error during language switch

1002004

TLGRT: Error during access to database

1002005

TLGRT: Error during creation of run-time objects

1002006

TLGRT: Error during on-line configuration

1002007

TLGRT: Error in client/server environment

1002008

TLGRT: Error in memory management

1002009

TLGRT: Error compiling measured values

1002010

TLGRT: Error processing measured values

1002011

TLGRT: Error archiving measured values

1002012

TLGRT: Error in Format DLL

1002013

TLGRT: Error with user archive option
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1002014

TLGRT: Error in process controlled archiving

1002015

TLGRT: Error in the API

1002016

TLGRT: Error with the application window

1002017

TLGRT: System error

1002018

TLGRT: Database queue overflow

1002019

TLGRT: Notification queue overflow

1002020

TLGRT: Norm DLL queue overflow - data is lost!

1002021

TLGRT: Problems with the connection to the central archive server.

1002022

TLGRT: The problem with the connection to the central archive server was fixed.

1002023

TLGRT:Archive value processed - Archive tag=@10%s@ Time stamp=@1%s@ New value=@2%s@ Old
value=@3%s@

1002024

TLGRT:Archive value generated - Archive tag=@10%s@ Time stamp=@1%s@ Value=@2%s@

1003018

ALGRT:Message does not require acknowledgment.
An attempt was made to acknowledge a message that does not require acknowledgment.

1003019

ALGRT:Message has already been acknowledged
An attempt was made to acknowledge a message that has already been acknowledged.

1003020

ALGRT:Message class for the message not found
The message class associated with the message does not exist.

1003021

ALGRT:Message status cannot be processed
The message status (Came In, Went Out, Acknowledged, ...) could not be interpreted.

1003022

ALGRT:Message is locked
This message occurs if you attempt to trigger a locked message via the API.

1003023

ALGRT:Message date/time-stamp invalid

1003032

ALGRT:Message window template name unknown

The date/time stamp from the AS could not be interpreted.
This error is generated if you delete a message window that is already configured in Graphics Design.
In client/server projects, this message could also be triggered by a communication error in the network.
1003033

ALGRT:Message window could not be created

1003034

ALGRT:Message window data invalid
The configuration data are faulty.

1003048

ALGRT:Bit is outside the tag range.
For example, an attempt was made to trigger the 18th bit of a 16-bit tag.

1003049

ALGRT:No tag change

1003050

ALGRT:Message tag (bit) already occupied by a message

1003051

ALGRT:Acknowledgment tag(bit) already used

1003052

ALGRT:Status tag already occupied by message

The bit of the message tag has already been interconnected to a message.
The acknowledgment tag bit has already been interconnected to a message.
The bit of the status tag has already been interconnected to a message.
1003053

ALGRT:Error during conversion of the variant data type

1003054

ALGRT:Message tag (bit) already occupied-->different type

1003055

ALGRT:Event tag or tag type invalid
The data type of the message tag is invalid. A tag with sign was used, for example.
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1003056

ALGRT: Acknowledgment tag or tag type invalid
The data type of the acknowledgment tag is invalid. A tag with sign was used, for example.

1003057

ALGRT:Status tag or tag type invalid
The data type of the status tag is invalid. A tag with sign was used, for example.

1003058

ALGRT:Handle invalid
This error message can occur during accesses via the API.

1003059

ALGRT: Selection criteria invalid
This error message can occur during accesses via the API.

1003060

ALGRT: Resources DLL for language not found
One of the language-dependent files is missing.

1003061

ALGRT:Error while creating the memory mapped file
This internal error indicates a problem involving the memory.

1003062

ALGRT:Error while creating the synchronization mechanism.
This error occurs when the operating system is overloaded.

1003063

ALGRT:Wrong parameter

1003064

ALGRT:Transfer buffer too small

1003065

ALGRT:This function is not available at this time

1003066

ALGRT:Format DLL send data cannot be evaluated.

1003067

ALGRT:Format DLL. Do not execute function

1003068

ALGRT:No message blocks in the report

This error message can occur during accesses via the API.
This error message can occur during accesses via the API.
This error message can occur during accesses via the API.

Check the message sequence report.
1003069

ALGRT:Invalid log

1003070

ALGRT:Report printout is already active

1003071

ALGRT:Message system Runtime <Server> not installed

1003072

ALGRT:Printout of the message report could not be started.

1003073

ALGRT:Printout of the short-term archive not started.

1003074

ALGRT:Printout of the sequence archive report not started.

1003075

ALGRT:Limit of Messages for Online Configuration exceeds.

1003076

NRMS7:Parameter error for S7 message frame

1003077

NRMS7:Parameter error for ALGRT

1003078

NRMS7:Invalid parameter TLGRT

1003079

NRMS7:Invalid process value blocks

An attempt was made to restart an active report.
The server reports that the project was activated without the Runtime component of Alarm Logging.

The maximum number of messages that can be configured online (default setting is 600) has been exceeded.
A parameter error has occurred on the interface to S7.
A parameter error has occurred on the interface to ALGRT.
A parameter error has occurred on the interface to TLGRT.
The additional data of the messages are faulty.
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1003080

NRMS7:Parameter error at AR_SEND
The structure of the AR-SEND user data is faulty.

1003081

NRMS7:General error
An internal error of unknown cause has occurred.

1003082

NRMS7:Message loss on the automation system

1003083

NRMS7:Link-up and update on PLC active

1003084

NRMS7:Link-up and update on PLC finished

1003085

NRMS7:System modification in RUN (CiR) active

1003086

NRMS7:System modification in RUN (CiR) inactive

1003087

NRMS7:Error while logging on to receive message

1003098

ALGRT:Message archiving overflow - messages will be lost

1003099

ALGRT:[Computer Name]:Locked messages [message number] [message text of locked message]
This message occurs when a message is locked.

1003100

ALGRT:[Computer Name]:Message [message number] unlocked [message text of unlocked message]
This message occurs when a message is unlocked.

1003101

ALGRT:Acknowledgment request for message [message number] was issued
This message occurs when a message is acknowledged.

1003102

ALGRT:[Computer Name]:Message group [message group number] locked
This message occurs when a message group is locked.

1003103

ALGRT:[Computer Name]:Message group [message group number] unlocked

1003104

ALGRT:[Computer Name]:Alarm Message Archive Overflow ended - no more Alarms will be lost

1003105

ALGRT:[Computer Name]:alarm input queue reaches critical count

1003106

ALGRT:[Computer Name]:alarm input queue reaches uncritical count

1003107

ALGRT:[Computer Name]:Message [Message Number] hidden:@1%s@

1003108

ALGRT:[Computer Name]:Message [Message Number] shown:@1%s@

1003109

ALGRT:[Computer name]: The connection to the master was interrupted.

1003110

ALGRT:[Computer name]: Incomplete configuration data for message [message number] detected

1003300

NRMS7PLUS: Modified configuration data for message detected.

1003301

NRMS7PLUS: Error while logging on to receive message.

1003302

NRMS7PLUS:@100%s@:Not all messages could be acknowledged due to temporary resource bottleneck.
Repeat the acknowledgment.

1004000

RPTRT:General error

1004001

RPTRT:PRT_OUT-Folder full.

1004002

RPTRT:Spool folder full

1004003

RPTRT:Report was not printed. PRT_OUT directory full

1004004

RPTRT:Report was not printed. Spool folder full

1004005

RPTRT:Message sequence report is reprinted.

1004006

RPTRT:Spool folder full

1004007

RPTRT:Hardcopy was not printed. Spool folder full

1005000

TXTRT:General error

1005001

TXTRT: Error while logging off Runtime applications.

1005002

TXTRT:Error during connection of the Runtime applications.

This message occurs when a message group is unlocked.
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1005003

TXTRT:Error during initialization of the MMF.
A memory error has occurred.

1005004

TXTRT:Error while loading the MMF.
Error during access to database.

1005005

TXTRT:Error while opening the MMF.
A memory error has occurred.

1005006

TXTRT:An error occurred while creating the Service window.

1005007

TXTRT:No language found.

1005008

TXTRT:Text ID not found.
The requested Text ID could not be found in the text library.

1005009

TXTRT:MMF Read access refused.

1005010

TXTRT:Language not found.
The requested language has not been configured in the text library.

1005011

TXTRT:Language table could not be opened.
Either the data are faulty or the table is locked in the database.

1005012

TXTRT:Text table could not be opened.
Either the data are faulty or the table is locked in the database.

1005013

TXTRT:Invalid Language specified.
The Language ID specified is invalid.

1005014

TXTRT:DBConnect error
No connection to the database could be set up.

1006000

GSCRT:Error

1007000

SCRIPT:Overflow
Overload: either there are too many actions running in a cycle that is too small, or an action is suspended (endless
loop, dialog output). All the other actions are in the queue and cannot be processed.

1007001

SCRIPT:Action error
One of the following errors has occurred:
● Exception in the action (exact cause unknown)
● Exception upon access to the return result (char* associated memory invalid)
● Stack overflow upon execution of the action
● The action contains a division by 0
● The action contains an access to a non-existing symbol
● The action contains an access violation
In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in your script, which allows
for a detailed analysis of errors.

1007002

SCRIPT:Overflow
Internal lists have overflowed.

1007003

SCRIPT:Connection error

1007004

SCRIPT:Action error 1

The connection to the server is broken.
The called function is not known. Check the spelling in the function call and the implementation of the function.
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1007005

SCRIPT:Action error 2
This error can have several causes:
● The action does not contain a P code. Recompile the action.
● The function could not be loaded because, for example, the function name is incorrect.
● The type of the returned value of the function is invalid.
In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in your script, which allows
for a detailed analysis of errors.

1007006

SCRIPT:Tag error
A requested tag was not supplied by WinCC Explorer within 10 s. Check the spelling of the tag name. In the
case of external tags, there may be a communication problem between the WinCC Explorer and the controller.
In WinCC version V4.0 and higher, you have the option to incorporate the OnErrorExecute function into your
script, which allows for a detailed analysis of the error.

1007007

SCRIPT: Info
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1007009

SCRIPT:Error in Thread
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1008000

USERT:Connection to chip card reader paused

1008001

USERT:Incorrect login name/password

1008002

USERT:Incorrect login name/password by chip card

1008003

USERT:Manual Login

1008004

USERT:Login by chipcard

1008005

USERT:Manual Logout

1008006

USERT:Logout by chipcard

1008007

USERT:Automatic Logout by timeout

1008008

USERT: Authorizations of Service users/group effective

1009000

LBMRT:Error

1010000

STRRT:Error

1010001

Storage:included for compatibility with earlier versions

1010002

Storage:included for compatibility with earlier versions

1010003

Storage:included for compatibility with earlier versions

1010004

Storage:included for compatibility with earlier versions

1010005

Storage:included for compatibility with earlier versions

1010006

Storage:included for compatibility with earlier versions

1010007

Storage:included for compatibility with earlier versions

1010008

Storage:included for compatibility with earlier versions

1010101

CAS:Starts archive service

1010102

CAS:Archive service is running

1010103

CAS:Archive service could not be started, error

1010104

CAS:Stops archive service

1010105

CAS:Archive service could not be stopped, error

1010106

CAS:Media backup completed successfully

1010107

CAS:Backup process failed, error

1010108

CAS:Backup medium created

1010109

CAS:Backup medium closed
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1010110

CAS:Backup connected

1010111

CAS:Backup connection failed, error

1010112

CAS:Backup disconnected

1010113

CAS:Backup disconnection failed, error

1010114

CAS:Import of archive started

1010115

CAS:Import of archive failed, error

1010116

CAS:Import of archive completed

1010117

CAS:Archive failed, error

1010118

CAS:Archive completed

1010119

CAS:Starts processing of archive

1010120

CAS:Data backup started

1010121

CAS:Data backup completed successfully

1010122

CAS: No symbolic name could be assigned to the physical server.

1010123

CAS: Caution, License not found: SIMATIC PCS7 StoragePlus Server. Long-term archiving deactivated

1010124

CAS: Archive cannot be verified.

1010130

StoragePlus: Directory cannot be created, error

1010131

StoragePlus: File cannot be moved, error

1011000

CSIG:Group display error at start up

1011001

CSIG:Group display hierarchy not updated

1011002

Group display: Connection fault

1011003

Group display: Tag does not exist

1011101

PTM: Error during startup

1011201

SSM: Error during startup

1011202

The fill level of the project drive is over 80%

1011203

The project was created with the wrong WinCC version

1012001

SYNC:Switched to master operation

1012002

SYNC:Cannot issue time message frame

1012003

SYNC:Time receipt service: Poor or failed signal

1012004

SYNC:Cannot receive time message frame

1012005

SYNC:Cannot receive any time message frame on redundant bus

1012006

SYNC:No time message frame. Switch to redundant device

1012007

SYNC:Can issue time message frame properly

1012008

SYNC:Time reception service functions properly

1012009

SYNC:Can receive time message frame properly

1012010

SYNC:Can receive time message frame properly on redundant bus

1012011

SYNC:Switched to slave operation

1012012

SYNC:Time synchronization deactivated

1012013

SYNC:Time synchronization activated

1012014

SYNC:DCF77 client service has failed

1012015

SYNC:DCF77 client service is working properly

1012016

SYNC:Device switched to master operation

1012017

SYNC:Device switched to slave operation

1012018

SYNC:Device cannot issue time message frame
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1012019

SYNC:Device can issue time message frame properly

1012020

SYNC:Device sets local time

1012021

SYNC:LAN sync: Time synchronization fault on PC

1012022

SYNC:LAN sync: Time synchronization set on PC

1012023

SYNC:LAN sync: Time synchronization established with PC

1012024

SYNC:Configured device name for the time synchronization does not agree with PC installation

1012025

SYNC:LAN sync: Cannot acquire time from the connected WinCC server

1012026

SYNC:Time jump - switched to permanent slave mode

1012027

SYNC:Time jump - time synchronization permanently deactivated

1012028

SYNC:Time reception service not started

1012029

SYNC:Time reception service

1012200

REDRT:Partner station has failed

1012201

REDRT:Partner station restarted

1012202

REDRT:Projects are not functionally identical

1012203

REDRT:Archive synchronization failed

1012204

REDRT:Internal error in Redundancy

1012205

REDRT:Connection to partner disturbed

1012206

REDRT:Connection to the partner has been reestablished

1012207

REDRT:Partner server - WinCC has not been started

1012208

REDRT:Archive synchronization starts

1012209

REDRT:Synchronization finished

1012210

REDRT:Tag Logging is being synchronized

1012211

REDRT:Tag Logging synchronization finished

1012212

REDRT:Alarm Logging is being synchronized

1012213

REDRT:Alarm Logging synchronization finished

1012214

REDRT:User Synchronization launched

1012215

REDRT:User Archive synchronization finished

1012216

REDRT:Synchronization was paused

1012217

REDRT:Partner Server-Project has not been activated

1012218

SWITCH:Client has been switched automatically

1012219

SWITCH:Client has been switched manually

1012220

REDRT:Synchronization is not ready for all User Archives

1012221

REDRT:Synchronization is ready for all User Archives

1012222

SWRED:Main connection disturbed

1012223

SWRED:Main connection operational

1012224

SWRED:Backup connection disturbed

1012225

SWRED:Backup connection operational

1012226

REDRT:Partner Server-Project has been activated

1012227

REDRT:Error: Partner computer is not a server

1012228

REDRT:CAS: Archive synchronization launched

1012229

REDRT: CAS: Archive synchronization finished

1012240

REDRT:RedundancyControl error triggered switching

1012241

REDRT:RedundancyControl: Switch to status
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1012242

DELTALOADER:Delta loading was started

1012243

DELTALOADER:Delta loading ended

1012244

REDRT:Overload during Alarm Logging online update

1012245

REDRT:RedundancyControl: Loss of serial connection

1012246

REDRT:RedundancyControl: Serial connection reestablished

1012247

REDRT: OS server (standby) redundancy error

1012248

REDRT: OS server (standby) redundancy reestablished

1012250

AM:Archive database inconsistency possible

1012251

AM:Internal error

1012252

AM:Backup:Error on writing to backup path

1012253

AM:Backup:Insufficient storage space on destination drive

1012254

AM:No connection to WriteArchiveServer

1012255

AM:No connection to Microsoft Message Queue

1012256

AM:No connection to WinCC project

1012257

AM:No connection to the database

1012258

AM:No connection to text library

1012259

AM:Error on generating TagLogging data

1012260

AM:Error on generating AlarmLogging data

1012261

AM:Caution! Backup will be delayed until restart of partner server.

1012265

AM:Data base verification failed

1012301

CA:No access to SQL Server (loss of data possible)

1012348

AM:Insufficient free memory space on project drive

1012349

REDRT:RedundancyControl: Connection of network card (MAC) address lost

1012350

REDRT:RedundancyControl: Connection via network card (MAC) address established again

1012351

REDRT:RedundancyControl: System blockage detected. Switch to Fault status.

1012352

REDRT:RedundancyControl: System blockage detected. Restart your computer as soon as possible.

1012353

RedundancyControl: Status changed to FAULT, but partner server is not available.

1012354

RedundancyControl: Status changed to FAULT, but server isolation is not activated.

1012355

RedundancyControl: Status changed to FAULT, but server isolation is disabled by @1%s@. Reason: @2%s@

1012356

RedundancyControl: Status changed to FAULT => server is isolated

1012357

RedundancyControl: Status changed to FAULT, but automatic restart is not activated.

1012358

RedundancyControl: Status changed to FAULT, but automatic restart is disabled because network adapter is
disconnected and DHCP is enabled.

1012359

RedundancyControl: Computer restart disabled by @1%s@. Reason: @2%s@

1012360

RedundancyControl: Computer restart canceled because the previous restart took place less than @1%s@ s
ago

1012361

RedundancyControl: Computer restart canceled because no additional restart is permitted for @2%s@ s after
@1%s@ restarts

1012362

RedundancyControl: Computer will be restarted in @1%s@ s

1012363

RedundancyControl: "ERROR" state reset until the partner has reached a stable state

1012400

WEBRT:WebClient connection established

1012401

WEBRT: WebClient connection disconnected

1012500

PHRDY:Start recovery for Process Historian
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1012501

PHRDY:Recovery for Process Historian is complete

1012502

PHRDY:Communication with Process Historian is not available

1012503

PHRDY:Communication with Process Historian is impaired

1012504

PHRDY:Communication with Process Historian is restored

1012505

PHRDY:Process Historian Server offline since @1%s@

1012506

PHRDY:@100%s@:Buffer limit channel @1%s@ exceeded

1012507

PHRDY:@100%s@:Buffer limit channel @1%s@ normal

1012600

Process Historian:Data memory occupied to @1%d@%

1012601

Process Historian:System at full capacity

1012602

Process Historian:@1%s@ @2%s@

1012700

Self-diagnostics: Value @7%s@ of station @10%s@ is invalid.

1012701

Self-diagnostics: Value @7%s@ of station @10%s@ violated the HIGH error limit.

1012702

Self-diagnostics: Value @7%s@ of station @10%s@ violated the LOW error limit.

1012703

Self-diagnostics: Value @7%s@ of station @10%s@ violated the HIGH warning limit.

1012704

Self-diagnostics: Value @7%s@ of station @10%s@ violated the LOW warning limit.

1012705

Self-diagnostics: Value @7%s@ of station @10%s@ no longer violates the error limit.

1012706

Self-diagnostics: Value @7%s@ of station @10%s@ is OK.

1012707

Self-diagnostics: Station @10%s@ causes @2%s@.

1012508

PHRDY:@100%s@:Less than @1%d@ free memory on data carrier '@2%s@' for communication with Process
Historian.

1012509

PHRDY:@100%s@:Communication of Process Historian terminated. Less than @1%d@ free memory on data
carrier '@2%s@'.

1012603

PH:@100%s@:Redundancy restored

1012604

PH:@100%s@:License volume exceeded. Shutdown in @1%d@ days

1012605

PH:@100%s@:PH-Ready @1%s@ failed

1012607

PH:@100%s@:Less than @1%d@ free memory for Process Historian database.

1012608

PH:@100%s@:Less than @1%d@ free memory for "tempdb" database.

1012609

PH:@100%s@:Less than @1%d@ free memory for emergency restore operation.

1012610

PH:@100%s@:New backup for emergency restore operation failed. Too little memory space.

1012611

PH:@100%s@:Unknown error occurred when creating backup for emergency restore operation.

1012612

PH:@100%s@:Memory path @1%s@ not accessible for emergency restore operation.

1016000

IDB: Provider initialization failed for connection:@2%s@

1016001

IDB: Consumer initialization failed for connection:@2%s@

1016002

IDB: Provider data transfer failed for connection:@2%s@

1016003

IDB: Consumer data transfer failed for connection:@2%s@

1016004

IDB: Provider initialization database failed for connection:@2%s@

1016005

IDB: Consumer initialization database failed for connection:@2%s@

1016006

IDB: Provider data transfer database failed for connection:@2%s@

1016007

IDB: Consumer data transfer database failed for connection:@2%s@

1016008

IDB: Provider initialization dynamic database failed for connection:@2%s@

1016009

IDB: Consumer initialization dynamic database failed for connection:@2%s@

1016010

IDB: Provider data transfer dynamic database failed for connection:@2%s@
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1016011

IDB: Consumer data transfer dynamic database failed for connection:@2%s@

12508141 WinCC operator message

5.4.8

Working with analog alarms

5.4.8.1

Working with the Limit Value Monitoring

Introduction
Specify limits or comparison values for the tags and have them monitored. If there is a high or
low limit violation, or if the conditions of the comparison values are met, a message is generated
in runtime.

Analog alarms in Alarm Logging
Analog alarms are available in the tree view in the navigation area.

Configuring analog alarms
1. Specification of the tag to be monitored
2. Assigning a message
3. Specifying limits or comparison values
4. Specifying other properties

5.4.8.2

Messages of the Limit Value Monitoring

Message of analog alarms
Each analog alarm is assigned the number of a message as property. This message is output
if the criteria of the analog alarm are met.
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You can use an existing message if a message tag has not been configured at this message.
You can also enter a message number that has not been assigned yet. A message with this
message number is then created.
If different values are monitored for a tag, you can assign a shared message for these events.
Note
The values of the limit value, hysteresis, and trigger value are stored in process value blocks
1 to 3. The process value blocks 4 to 10 must not be used for a limit monitoring message.

5.4.8.3

How to create a new analog alarm

Requirement
● Tags you are going to monitor have been created.

Procedure
1. Select the "Analog alarms" folder in the navigation area.
2. Click in the top empty line of the "Tag" column in the table area.
3. Click the
button.
The "Tag selection" dialog opens.
4. Select a tag and confirm with "OK".
The dialog closes. A new analog alarm has been created.
5. Specify a new message number that has not yet been used, or enter the message number
of an existing message for which a message tag has not yet been configured.

How to create multiple alarms for one tag
1. Create an analog alarm.
2. Activate the property "Shared message".
3. Select the cell in the "Tag" column in the table area.
4. Drag down the selection of the cell with the mouse.
Multiple analog alarms are created for the tag with a shared message.
5. Specify a new message number that has not yet been used, or enter the message number
of an existing message for which a message tag has not yet been configured.
Note
Cells with a red background in the table area alert you to the fact that inconsistent data is
present. Edit the respective properties.
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5.4.8.4

How to use message blocks for analog alarms

Message blocks of the analog alarm
The analog alarm can supply two message blocks with content. Message blocks can be
supplied with a message text of the analog alarm and of the monitored tag. You specify the
format of the data content in the selected message block in the message.

Requirement
● Message blocks have been selected for use and configured.

How to select the message blocks for supply by means of analog alarms
1. Select the "Analog alarms" folder in the navigation area.
The "Message block for message text" and "Message block for tag" selection fields for the
message blocks are displayed under "General" in the "Properties" area.
2. Select the message block from the drop-down list that the analog alarm is to use for display
of the message text and the monitored tag.
To not display a message text or tag, double-click the input field and delete all characters in
the input field.
Select the same message block for both properties to display the message text and the tag
together.
Example: "Test10 Limit @1%f@ exceeded: @3%f@".
Note
These message blocks are only used if a new message is created in the analog alarm
"Messages" tab. If a message is assigned that is already configured, the properties and
message blocks configured for the message are applied. They are also used for shared
messages.
Messages that were imported from previous versions do not display the tag.

5.4.8.5

How to configure an analog alarm

Introduction
You edit the properties of an analog alarm either in the table area or in the "Properties" area.
Individual columns may be hidden in the table area.

Configuring analog alarms
The properties determine which tag is monitored. Specify the corresponding values. Specify
which message is output when a limit is exceeded, undershot or reached.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1169

Setting up a Message System
5.4 Configuring the Message System

Properties of the analog alarm
Limit
Property

Description

Tag

The tag which is monitored.
The tag must already be available.
Click the box to open the selection dialog.

Shared message

Creates a message with the same message number for all events that occur for
the tag.

Delay time

Specifies the time between occurrence of the event and generation of the
message. The message is only triggered if the corresponding condition has been
met for the entire time period of the delay time.
The delay time can be between 250 milliseconds and 24 hours.
Enter the value "0" for "No delay time".

Unit

Unit for input of the delay time.

Comparison
Property
Comparison

Description
Condition for limit that results in the output of the message.
● High limit: Limit is exceeded.
● Low limit: Limit is undershot.
● Value is same: Limit has been reached.
● Value is different: Limit is greater than or less than

Comparison value

Numerical value for comparison (cannot be edited when "Indirect" option is set)

Comparison tag

Selection of a tag that is compared to the current value (can only be edited when
"Indirect" option is set).

Indirect

Option not set: The tag is compared with a numerical value.
Option set: The tag is compared with the current value of another tag.

Hysteresis
Property

Description

Hysteresis

Value for the hysteresis

Hysteresis in
percent

Option set: The hysteresis value is a percentage value.

Hysteresis with
"Came In"

The hysteresis is taken into consideration when the message comes in.

Hysteresis with
"Went out"

The hysteresis is taken into consideration when the message goes out.

Option not set: The hysteresis value is an absolute numerical value.

If a hysteresis has been defined, messages are not triggered immediately when the limit is
reached. Instead, they are triggered when the actual tag value exceeds or falls below the limit
by the amount of the hysteresis.
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You can specify the hysteresis either as an absolute deviation or as a percentage deviation
from the limit. Depending on the selected setting, the hysteresis will become effective while a
message is generated or revoked.
Message
Property

Description

Message number

Number of the message that is output by the analog alarm.
If the "Shared message" option is enabled, the same message number is entered
for all alarms of a tag.

Consider quality
code

5.4.8.6

When the option is enabled, a value change of the tag is only checked for a limit
violation with a quality code equal to "GOOD". When selecting the option, a limit
message is not created, for example, when there is a bad connection to the
automation system.

How to display the messages of the analog alarm

Messages of the analog alarm
You can display all messages which are output by the analog alarm in the table area.

Procedure
1. Select the "Analog alarms" folder in the navigation area.
2. Select the "Messages" tab in the table area.
All messages which are output by the analog alarm are displayed in the table area.
Alternative procedure
The messages of the analog alarms can also be displayed under the "Messages" folder.
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1. Select the "Messages" folder in the navigation area.
2. Select the "Selection" command in the shortcut menu of the "Messages" folder.
3. Activate the selection "Analog alarm".
The "Messages" tab also displays the messages of the analog alarm.

5.4.8.7

How to delete an analog alarm

Introduction
How to delete an analog alarm

Deleting an analog alarm
1. Select the "Analog alarm" folder in the navigation area.
2. Select the "Limits" tab in the table area.
3. In the table area, select the line number of the analog alarm you want to delete.
You can make multiple selections.
4. Select "Delete" from the shortcut menu or press the Delete key.
The analog alarm is deleted. Tags or messages are not deleted.

5.4.8.8

Examples of Configuring a Limit Value

Introduction
The following examples illustrate how the configuration of limits affects the behavior of the
analog alarm.
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Example of "Absolute hysteresis"

Message no. 4 is triggered (arrives) when the tag to be monitored has exceeded the value
220, because the "Hysteresis ...with came in" is activated here and the comparison value +
hysteresis applies (200+20=220).
Message no. 4 is revoked when the tag to be monitored drops below the value 200, because
"Hysteresis ...with went out" is not activated here.
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Example of "Hysteresis in percent"

Message No. 4 is triggered (arrives) when the tag to be monitored exceeds the value in the
"limit" comparison tag.
Message No. 4 is revoked when the tag to be monitored drops below the value of the "limit"
comparison tag by 10%.
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5.4.9

Working with AS messages

5.4.9.1

AS messages

Displaying AS messages
If there are AS messages in the project, the "AS messages" folder is displayed in the navigation
area.

Messages that communicate via raw data tags with the AS (Format DLL) are shown in the "AS
messages" folder.
If the "AS messages" folder is selected, two tabs are displayed in the table area.
Messages
All AS messages are displayed.
Text lists
These lists display texts, for example, originating from STEP 7 system or user text libraries,
or texts from a message referenced in an S7-1500. These entries are for informational
purposes only, for example, to indicate whether all translations are present.

Integrating messages of the S7-1500 controller in Alarm Logging
With an S7-1500 controller, you must integrate the messages in Alarm Logging.
Requirement:
● The "S7-1500 Channel" must be integrated into the project.
● A connection must be created in the "OMS+" channel unit.
● The connection must be established in Runtime.
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Procedure:
1. Select the connection in the "AS messages" folder.
2. Select "AS messages > Read from AS" from the shortcut menu.
All available messages and texts of the controller are loaded into the "AS messages" or
"AS Text lists" tab in the table area.

3. The messages are not automatically included in Alarm Logging. To transfer the required
messages to the "Messages" tab, activate the respective check box in the "Used" column
of the "AS messages" tab.
The selected messages are now available in Alarm Logging.
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How to edit AS messages without controller connection
You can configure offline independent of a connection to the controller. To do so, you save
the loaded AS messages in a file.
1. Select the connection in the "AS messages" folder.
2. Select "AS messages > Save to file" from the shortcut menu of the connection.
You can then load the AS messages to Alarm Logging in the offline project.
1. Select the connection in the "AS messages" folder.
2. Select "AS messages > Load from file" from the shortcut menu of the connection.
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5.4.10

Working with operator messages

5.4.10.1

Operator messages

Operator messages
An operation in the process can trigger an operator message.
The configuration of an operator message depends on the object being operated and the type
of operation.
Objects with the property "Operator message"
You can activate the "Operator message" property for the respective object in the Graphics
Designer to control certain objects, such as the input of a value in an I/O field.
● The object must be connected to a tag.
● The structure of the message cannot be edited.
● The message number of the operator message is "12508141".
● The operator message contains the value before the operation (old value) in process value
block 2, and the modified value (new value) in process value block 3.
By activating the "Operator Activities Report" attribute, the user can enter the reason for an
operation as a comment on the message in a dialog after performing the operation. The
"Operator Activities Report" comment can be viewed in the long-term archive list using the
"Comment" button. The Comment dialog only shows the old value and new value for the
operator message "12508141".
Own operator message as action
For operating optional graphic WinCC objects, you can configure your own operator message
as a C action or as a VBS action.
● Execute the respective C action as a reaction to the operation event. In this case, the
operation event can be the mouse click on the WinCC object, for example. Configure your
own operator message with the "GCreateMyOperationMsg" default function from the
"Alarms" function group.
● Execute the respective VBS action as a reaction to the operation event. In this case, the
operation event can be the mouse click on the WinCC object, for example. Configure your
own operator message with the "HMIRuntime.Alarms" object.
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Operation of a message
● An operator message is configured in the WinCC Alarm Logging for the operation of a
message, such as acknowledgment, lock/release or hide message. You must use the
WinCC system messages in Alarm Logging for this purpose.
By default, an operator message may contain information on the logged-on user and current
computer. For this purpose, you add the "User name" and "Computer name" system blocks
to the message blocks in the Alarm Logging editor. You add the system blocks to the
selected message blocks on the "Message Lists" tab in the WinCC AlarmControl.
The triggering events for an operator message are activated in the WinCC AlarmControl
on the "Operator Messages" tab. You can also configure the operator message yourself
there.
To display or enter a comment for a selected operator message, a dialog can be opened
in the long-term archive list using the "Comment" button. When the "Comment" system
block is inserted in the message line in the AlarmControl, this message block indicates the
existence of a comment for this message.
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5.5

Message Archiving

5.5.1

Message Archiving in WinCC

Introduction
With the archive management feature in WinCC, you archive process values and messages
for the documentation of operational and fault statuses. The Microsoft SQL Server is used for
archiving.
Messages configured in Alarm Logging are output during runtime when the corresponding
event occurs, for example, a fault or a limit violation. Messages are archived if events known
as message events occur, for example:
● when the message occurs
● when the status of the message changes (e.g., from "Message Came In" to "Message
Acknowledged")
You can save the message events in an archive database and archive it as a message report
on paper. The messages archived in the database can, for example, be output in a message
window in runtime.

Archived Message Data
All data associated with a message, including the configuration data, is saved in the message
archives. You can read out all properties of a message from the archives, including its message
type, time stamp, and texts. A subsequent change to the configuration data of a message
results in the creation of a new archive with the new configuration data. This ensures that the
change has no effect on messages that were archived before the change was made.
Note
The time stamp on archived messages is always in standard UTC format (Coordinated
Universal Time).
Because messages are configured on a language-dependent basis, archives contain a table
with the configuration data for each configured language.

Quantity structure
The following table shows the number of messages that WinCC can process. The actual
number depends on the server in use. The information in the table refers to the following server
configuration:
● Intel Pentium III with 1.4 GHz
● 512 MB RAM
● 40 GB hard disk
● Maximum of 16 clients
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Server

Special archive server

Sustained message load (per second)

10 messages

100 messages

Message flow (per 10 seconds)

2,000 messages

15,000 messages

Note
The values for message flow apply only to archiving. For further processing in Alarm Logging,
additional time must be planned: five minutes must elapse before a new message overload
can be created.

Memory requirements of messages
Configuration data of a message for a single language:
● Theoretical minimum value: approx. 198 bytes
● Theoretical maximum value: approx. 5062 bytes
This value is stored in a segment each time.
Runtime data of a message:
● Message without associated values or comment => Minimum value: approx. 172 bytes
● Messages with maximum associated values and comment => Maximum value: approx.
4012 bytes

5.5.2

Configuration of Message Archiving

5.5.2.1

Configuration of Message Archiving

Introduction
To archive messages, WinCC uses short-term archives of configurable size, which you can
configure with or without backup.

Storing archive files
Archive files are always stored so that they are local to the computer in the associated project.
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Properties of message archives
A WinCC message archive consists of multiple individual segments. You can configure both
the size of the message archive and the size of the individual segments in WinCC:
● The size of the message archive or individual segments, for example: 100 MB message
archive size, 32 MB per individual segment.
● The archiving period of the message archive or individual segments, for example: The
message archive archives all messages which occur within one week, each individual
segment archives the messages which occur within one day. The configuration of the
archiving period is called archive partitioning.

You can always configure both conditions at the same time. If either of the two criteria is
exceeded, the following happens:
1. Criterion for message archive (Database) is exceeded: the oldest messages (i.e. the oldest
individual segment) are deleted.
2. Criteria for individual segment is exceeded: a new individual segment (ES) is created.
A new individual segment is also created when you configure message data online.
Note
When starting Runtime, the system checks whether the configured size of the individual
segment has been calculated to a sufficient size. If the configured size is too small, the system
automatically adapts the segment to the minimum size.

Backing up archived messages
The data of the message archives can be stored in a backup.
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5.5.2.2

How to Configure Messages for Archiving

Introduction
You decide when you configure a message if it is archived.
Note
The default setting for new messages is that they are archived. If you do not want to archive
messages, you have to specify it.

Requirement
The message system is configured.

Procedure
1. Open the "Alarm Logging" editor.
2. Select the message you wish to archive in the table area.
3. Select the "Archived" option in the "Properties" area.
4. Disable the option for messages that are not to be archived.

5.5.2.3

How to Configure a Message Archive

Introduction
You have the option to configure the message archive in Alarm Logging.
Note
Make sure that the archive size does not exceed the free memory space available. The
archive manager does not check the selected settings for plausibility. A high number of linked
database segments can lead to longer waiting periods in the system when starting and ending
Runtime.

Example of memory requirements calculation
The following example shows how to calculate memory requirements for messages across all
segments and for individual segments. For this purpose, you need information about how many
messages come in per second on average. Approximately 4000 bytes per message is included
in the calculation of memory requirements.
General rule: Number of messages/s * 4000 bytes * 60 s/min * 60 min/h * 24 h/day * 31 days/
month * y months.
A rate of 1 message/sec is assumed in the example:
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● The result for the max. size across all segments for 2 months is:
ca. 20 GB (1 message/s * 4000 bytes / message * 60 s/min * 60 min/h * 24 h/day * 31 days/
month * 2 months)
● The result for a single segment per day is:
ca. 330 MB (1 message/s * 4000 bytes / message * 60 s/min * 60 min/h * 24 h/day * 1 day)
You should explicitly set this limit to a higher level, e.g. 700 MB, to achieve an appropriate
daily storage even in the case of a possible message surge.
Configure your message archives accordingly.

Procedure
1. Open the "Alarm Logging" editor.
2. Select the "Messages" folder in the navigation area.
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3. Select "Archive" > "Properties…" in the shortcut menu.

The "AlarmLogging" dialog is opened.
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4. Make the following settings for the archive:
– Time period of all segments and its maximum size. This specification defines the size
of the archive database. If one of the criteria is exceeded, a new segment is started and
the oldest segment is deleted.
– The time period in which messages are archived in an individual segment and its
maximum size. If either of these criteria is exceeded, a new individual segment is started.
When the criterion for "Time period of all segments" is exceeded, the oldest individual
segment is also deleted.
5. In the "Time of the segment change" field, enter the start date and time for the first segment
change.
When a new individual segment begins, the configuration of the time of the segment change
is taken into account.
6. Click "OK" to confirm your entry.
Note
Displaying configuration changes
Changes in Alarm Logging are not visible in Runtime until a segment has been changed.
A segment change is delayed by 30 seconds after the last change in Alarm Logging. After a
maximum of 2 minutes, messages are written into the new archive segment with the changed
configuration data. This means that read access to the changes in the archive will not be
active until this action has been completed. Alternatively, you can deactivate and reactivate
Runtime.
If you modify the archiving size (time range) in Runtime, such modifications take effect only
upon the next segment change.

Example
In the above screen shot, the segment changes for the first time on January 17 at 23:59. The
next time-related segment change occurs at the configured time in the cycle defined in "Time
period covered by a single segment". With the above cycle setting "1 day", the change is made
every day at 23:59. If the cycle is set to "1 month", for example, the segment change takes
place on the 17th day of the next month at 23:59.
The segment is also changed if the configured size ("Max. size of all segments") is exceeded
after the start of Runtime. In this case, the oldest individual segment is also deleted.
Note
After selecting the "Reset" command in the shortcut menu, the Runtime data is deleted from
the archives.
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5.5.2.4

How to Configure the Archive Backup

Principle
Create regular backups of your archive data to ensure seamless documentation of your
process.
Note
Starting the backup
The backup normally starts 15 minutes after the first time-related segment change.
If the start of backup and start of segment should be synchronous with the start of Runtime,
define the start time for the segment change prior to the start of Runtime.
Changing archived messages in Runtime
You can change the displayed message in Runtime using Alarm Control.
If the location of the archive segment where the message is stored has already been changed,
then the modified comment is not accepted in the swapped-out archive. The change is limited
to the local archive segment.
If the archive segment has not yet been swapped out, then the changed comment is accepted
permanently.
Backup behavior with redundant system
Only the current master server swaps out to a local drive.

Procedure
1. Open Alarm Logging in WinCC Explorer.
2. Select the "Messages" folder in the navigation area.
3. Select "Archive" > "Properties…" in the shortcut menu.
The "AlarmLogging" dialog is opened.
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4. Select the "Backup Configuration" tab.

5. Select the "Signing off activated" check box, if the swapped archive data are to receive a
signature. Upon reconnection with WinCC, the signature allows the system to determine
whether any modifications have been made to the archive backup file after its swap-out.
6. Select the "Activate Backup" check box, if the archived data are to be backed up. In addition,
select the "Backup to both paths" check box, if the archived data are to be saved in both
directories, "Destination path" and "Alternative destination path".
7. Enter the destination path in which the backup files are to be stored. Network paths are
also valid as destination paths. The "Alternative destination path" is used in the following
cases, for example:
- The storage space of a backup medium is full.
- The original destination path is not available, for example, due to a network failure.
After the corresponding system messages have been configured, the messages are output
if the specified destination path is not available.
8. Click "OK" to confirm your entry.

Result
The archive backup is stored in the specified destination path.
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Structure of the Archive Backup File
An archive backup consists of two files, with the extensions LDF and MDF. To transfer an
archive backup, for example to another computer, copy the corresponding LDF and MDF files.
The file name is as follows:
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type
identification of the message archive is "ALG". The time period is specified in format
yyyymmddhhmm, for example 200212021118 for December 2, 2002, 11:18 hours.
Underscores ("_") in the project name are displayed as "#".

Signing Off of Archive Backup Files
Upon activated signing off and activated backup, each archive backup file is signed off upon
swapping out. It is thus possible to determine upon reconnection of the file with WinCC whether
or not the file has been changed after swapping.
In order to verify the data, the "Signing activated" check box must be selected.
If you use archive signing-off, the maximum size of a single segment may not exceed 200 MB.

5.5.2.5

How to link an archive

Introduction
To access data in an archive backup during Runtime, link the associated database files to the
project. You can link an archive yourself using the Alarm Logging and WinCC AlarmControl
or have the connection created automatically. The archived messages are displayed in the
message display in Runtime.

Requirement
● The corresponding LDF file and MDF file of the archive backup are in a local directory on
the configuration computer, e.g. hard drive or DVD.
● The project is loaded on the configuring computer and is in Runtime.
● You can only link the archive files on the server.
Note
The messages are only displayed in Runtime if the time window in the message display
has been configured accordingly. Example: You have configured a time window to display
only the messages of the past 24 hours. If you link up to an archive backup containing
messages that are older than 24 hours, these messages are not included in the message
display.

Linking to the Archive Using the Alarm Logging Editor
1. Open Alarm Logging in the WinCC Explorer.
2. Select the "Messages" folder in the navigation area.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1189

Setting up a Message System
5.5 Message Archiving
3. Select "Archive" > "Link archive…" in the shortcut menu.
The dialog for file selection opens.
4. Select the database file and click "Open".
After selecting the file, the message archive is linked to the project.
If signing is activated and you link a modified or unsigned archive file to the project,
acknowledge the link to these files, as the archive files are otherwise not linked. A WinCC
system message is generated and an entry is added to the Windows event log in the
"Application" section.
Note
After having connected an archive in the Alarm Logging Editor, you may not close the editor
until the "Archive Successfully Connected" dialog is displayed.

Linking the archive with WinCC AlarmControl
1. Click

in the WinCC AlarmControl toolbar.

2. In the dialog, use the "..." button to navigate to the path in which the archive files are located.
3. Select the required archive file under "Backups" and click "OK". After selecting the file, the
message archive is linked to the project.

Automatic Linking to an Archive
1. Add the archive files to the "ProjectName\CommonArchiving" directory.
2. In Runtime, the message archive is automatically linked to the project.
If signing has been activated, modified, signed-off archive files are not automatically linked. A
WinCC system message is generated and an entry is added to the Windows event log in the
"Application" section.

Linking an Archive Using a Script
You can link the archive files with the WinCC project by using a script via the VBS object
"AlarmLogs". The archive segments are copied with the "Restore method" to the Common
Archiving directory of the Runtime project. For more information, refer to sections "AlarmLogs
VBS Object" and "VBS Method 'Restore'".

5.5.2.6

How to disconnect an archive

Introduction
If you no longer wish to access the data in an archive during Runtime, disconnect the
associated database files from the project.
You can disconnect an archive with the "Alarm Logging" editor or WinCC AlarmControl. You
must delete linked archives from the "Project name\CommonArchiving" directory or have it
removed by a script with the VBS object "AlarmLogs".

1190

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.5 Message Archiving

Requirement
● Archive backup files are linked.
● The project is loaded on the configuring computer and is in Runtime.
● You can only disconnect linked archive files on the server.

Disconnecting an archive with the "Alarm Logging" editor
1. Open Alarm Logging in the WinCC Explorer.
2. Select the "Messages" folder in the navigation area.
3. Select "Archive" > "Disconnect from archive…" in the shortcut menu.
The dialog for database selection opens.
4. Select the archive file and click "OK".
The archive is no longer linked with the project.

Disconnecting the archive with WinCC AlarmControl
1. Click

in the WinCC AlarmControl toolbar.

2. Select the required archive file in the dialog and click "OK".

Result
The link to the archive file is disconnected. Access is no longer possible to the archived
messages in Runtime.

5.5.3

Output of Message Archive Data

5.5.3.1

Output of Message Archive Data in Runtime

General procedure
Messages stored in message archives can be output in Runtime in the following ways:
● Display the archived messages in a message window; in the event of a power failure, the
messages queued for loading from the archive to the message system are loaded with the
correct time stamp (reloading after power failure).
● Prin archive report.
● Access to message archive database via OLE-DB for output of archived messages.
● Access to the message data via the OPC O&I server.
● If you use the WinCC/DataMonitor, you can evaluate and display archive data with the
DataMonitor.
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● Access via ODK.
● Access by means of suitable client applications.

See also
Direct Access to the Archive Database (Page 1197)
How to Configure a Message Archive Report (Page 1195)
How to Configure Reloading of Messages Following a Power Failure (Page 1194)
How to Display Archived Messages in Runtime (Page 1192)

5.5.3.2

How to Display Archived Messages in Runtime

Introduction
You cannot only display the latest messages with WinCC AlarmControl in Runtime but also
call up messages from the archive. You have the option to display archive messages in a shortterm archive list or long-term archive list. The short-term archive list also contains current
messages.

Requirement
All archived data displayed in Runtime must be stored locally on the archive server. The SQL
server does not permit access to backup files that are located on another computer in the
network, for example.
For additional information on this topic, refer to chapter "Message Server" in this
documentation.
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Procedure
The following procedure describes just the principle steps for the display of archived messages
in Runtime. The exact procedure for configuration of WinCC AlarmControls is described in the
online help under "Setting up a message system/Displaying messages in Runtime".
1. Insert a WinCC AlarmControl into the desired picture in the Graphics Designer.
2. Double-click the control to open the "WinCC AlarmControl Properties" dialog.

3. In the "General" tab, select which list will be shown when the picture opens in the
"Properties" area. To display archived messages, select "Short-term archive list" or "Longterm archive list".
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4. If you want to only display messages from a certain server in a distributed system,
deactivate the "All servers" checkbox. Click on
to select a server. Confirm with "OK".
5. Go to the "Toolbar" tab. Activate the "Display toolbar" check box. Select at least button
function "Short-term archive list" or "Long-term archive list". Confirm with "OK".
Note
When displaying messages in the short-term archive list, the system immediately updates
new incoming messages. This is not the case when the long-term archive list is selected.

Result
In Runtime, click
or
to display messages from the archive in the message list. You can
filter messages from the archive to only display messages of the "Fault" type, for example, or
only messages at specific parts of the plant.

See also
Direct Access to the Archive Database (Page 1197)
How to Configure a Message Archive Report (Page 1195)
How to Configure Reloading of Messages Following a Power Failure (Page 1194)
Output of Message Archive Data in Runtime (Page 1191)

5.5.3.3

How to Configure Reloading of Messages Following a Power Failure

Principle
To display the most recent messages in Runtime following a power failure, configure the
"Reload after power failure" function in the Alarm Logging. In the event of a power failure, a
user-defined number of messages is read from the message archive to reconstruct the most
recent process image.
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Procedure
1. Select the "Messages" folder in the navigation area.
2. Select "Archive" > "Reload after power failure…" in the shortcut menu.
The dialog for "Reload after power failure" opens.

3. Enter the number of messages to be reloaded after a power failure.
4. Select the "Reload Message List After Power Failure" check box so that the message list
is reloaded in Runtime after the system has rebooted.
5. Click "OK" to confirm your entry.

5.5.3.4

How to Configure a Message Archive Report

Introduction
You can output archived messages on a printer and as a file. You configure the log for the
message archive in the Report Designer.

Overview
WinCC provides you with a pre-configured system layout for the log, which you can adjust to
suit your specific needs. You can also create your own log layouts. You have three alternatives
to configure the layout for a message archive:
● Configuration with the layout of the "WinCC Control Runtime Print Provider". The layouts
are available with WinCC V7 and higher. Either the message archive list is printed out in
table format with all messages, or the current display of the message archive list in
AlarmControl is printed out. The output of the archive report is only possible via WinCC
AlarmControl and the "Print" key.
● Configuration with the "WinCC Alarm Control (Classic)" layout. You start printing with the
"Print" key in WinCC Alarm Control. You can also start output of the archive report outside
of Alarm Control.
● Configuration with the layout "Alarm Logging RT". You start the print job outside of Alarm
Control.
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Configuration with the layout of the "WinCC Control Runtime Print Provider"
1. Open the Report Designer in the WinCC Explorer. Open either the "@Alarm Control Table_ENU.RPL" layout in the "English (USA)" language folder for a table printout or the
"@Alarm Control - Picture_ENU.RPL" layout to print out the current display.
2. Double click on "WinCC Control Runtime Print Provider.Table" or "WinCC Control Runtime
Print Provider.Picture" in the open layout. The "Object properties" dialog opens.
3. Configure the layout of the table in the "Properties" tab.
4. Save the configuration in the Report Designer.
5. The layouts of the "WinCC Control Runtime Printprovider" are linked with the matching print
jobs "@AlarmControl - Table" or "@AlarmControl - Picture". Select one of these print jobs
in the "General" tab of the Graphics Designer in the picture with the AlarmControl . If you
click "Print" in Runtime, the messages are printed out according to the configured layout.

Configuration with the "WinCC Alarm Control (Classic)" layout
1. Open the Report Designer in the WinCC Explorer. Open the "@CCAlarmCtrlCP_ENU.RPL" layout, for example, in the language folder "English (USA)".
2. In the open layout double-click the "WinCC Alarm Control (Classic) table". The "Object
properties" dialog opens.
3. Configure the layout of the table in the "Properties" tab.
4. Change the output options for the WinCC Alarm Control. For more detailed information,
refer to Modify output options for WinCC Alarm Control (Page 2026).
5. Save the configuration in the Report Designer.
6. The "@CCAlarmCtrl-CP_ENU.RPL" layout is linked with the "@Report AlarmControl-CP"
print job. Select this print job in the Graphics Designer in the picture with the AlarmControl
in the "General" tab. If you click the "Print" key in Runtime, the messages of the selected
message list are printed out in form of a table.
7. You can also define a print job outside of the Alarm Control, for example, by configuring a
cyclic log output. If all archiving data is to be logged, the output cycles are not to be shorter
than the configured archiving period. For more detailed information, refer to Print Job
Properties (Page 1806).

Configuration with the layout "Alarm Logging RT"
1. Open the Report Designer in the WinCC Explorer. Open the
"@CCAlgRtSequenceArchive_ENU.RPL" layout, for example, in the language folder
"English (USA)".
2. Double click the table "Alarm Logging RT Archive Log" in the open layout. The "Object
properties" dialog opens.
3. Configure the layout of the table in the "Properties" tab.
4. Change the output options for the archive log. For more detailed information, refer to
Changing Output Options for Message Reports from Alarm Logging (Page 2032).
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5. Save the configuration in the Report Designer.
6. The "@CCAlgRtSequenceArchive_ENU.RPL" layout is linked with the "@Report Alarm
Logging RT Sequence archive New" print job. Configure this print job to specify the output
of the archive report. You can, for example, configure a cyclic report output. If all archiving
data is to be logged, the output cycles are not to be shorter than the configured archiving
period. For more detailed information, refer to How to create print jobs for the Runtime
documentation (Page 1846).

See also
Direct Access to the Archive Database (Page 1197)
How to Configure Reloading of Messages Following a Power Failure (Page 1194)
How to Display Archived Messages in Runtime (Page 1192)
Output of Message Archive Data in Runtime (Page 1191)
Changing Output Options for Message Reports from Alarm Logging (Page 2032)
Modify output options for WinCC Alarm Control (Page 2026)
Print Job Properties (Page 1806)
How to create print jobs for the Runtime documentation (Page 1846)

5.5.3.5

Direct Access to the Archive Database

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also
enable you to directly access the WinCC archive databases. Direct access lets you read
process values, for example, for editing in spreadsheet programs.

Access to archive databases with ADO/OLE DB
The process values are partially saved in compressed format to the archive databases. Use
the WinCC OLE DB Provider to access such compressed process values. You can use the
Visual Basic or Visual C++ programming languages, for example.
Note
Note that the table structure may vary in a new WinCC version when directly accessing the
archive database using ADO/OLE DB.
For additional information, refer to the Microsoft MSDN Library "Win32 and COM Development
> Data Access and Storage > Windows Data Access Components SDK" available on the
Internet at:
● http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/
library/default.aspx)
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Access to the archive database using OPC
OPC (OLE for Process Control) provides interfaces for communication with process
automation systems. The OPC interface enables harmonized interconnection of devices and
applications from different manufacturers. You can use WinCC as an OPC client to access
process data or messages of an OPC server. WinCC can be used as OPC server to manage
archive data.
For additonal information, refer to:
● "WinCC Information System", "Communication" > "OPC",
● "WinCC Information System", "System Overview" > "Open Source"
● On the Internet at "http://www.opcfoundation.org"

Access to the archive database using C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions
by means of open source programming interfaces.
For additional information, refer to:
● Documentation on the WinCC Open Development Kit

See also
How to Configure a Message Archive Report (Page 1195)
How to Configure Reloading of Messages Following a Power Failure (Page 1194)
How to Display Archived Messages in Runtime (Page 1192)
Output of Message Archive Data in Runtime (Page 1191)
http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/library/
default.aspx)

5.5.4

Message Server

Introduction
When using WinCC to configure a client/server system, you have the option to configure
different scenarios for message archiving.
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Archiving on WinCC Servers
The messages are archived on every server (2) in a client/server system. All Runtime
applications including archiving run on each server. The clients (1) have access to the message
archives on the servers.

Use this configuration, if each server is dedicated to a certain section of the plant. Each server
thereby monitors a specific section of the plant, and manages its own messaging and archiving
system.

Archiving on archive servers without a process driver connection (server/server communication)
Archiving on a central archive server (3) on which the message archives (and process value
archives, if any) are stored. The only programs run on the archive server are the archiving
applications. The archive server receives the data to be archived from the servers (2). The
clients (1) access the archive server (3) to display archived data. All other Runtime data is
provided by the servers (2):
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Note
This configuration cannot be implemented for message archives in a PCS7 environment, as
messages are generated separately on each server and cannot be brought together on a
single server.
For additional information, refer to the WinCC documentation "Client/Server Systems" and
"Redundancy".

See also
Output of Message Archive Data in Runtime (Page 1191)
Configuration of Message Archiving (Page 1181)
Message Archiving in WinCC (Page 1180)
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5.6

Display of Messages during Runtime

5.6.1

WinCC AlarmControl

Introduction
WinCC AlarmControl is a message window used to display message events. All messages
are displayed in a separate message line. The content of the message line depends on the
message blocks to be displayed.

Lists in the message window
You have the option of viewing six different lists in the message window:
● Message list to view currently activated messages.
● Short-term archive list, to view archived messages. The display is updated immediately
after activation of new messages.
● Long-term archive list, to view archived messages.
● Lock list, to view currently locked messages.
● Hitlist, to view statistics data.
● List of messages to be hidden, to view hidden archived messages.
The figure below shows an example of a message list:
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Note
A message is shown with a crossed-out date and time stamp in the message list if any of the
following events are triggered:
● A locked message is released again. The date and time stamp shows the OS time. This
also applies to chronological reporting.
● A message is reloaded after power failure. This only applies to chronological reporting.
● The AS is restarted. This only applies to chronological reporting.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)

5.6.2

Configuring the AlarmControl

5.6.2.1

How to configure the AlarmControl

Introduction
The messages are displayed in a message window in runtime. You can configure a
corresponding WinCC AlarmControl in Graphics Designer.

Requirement
● A message system has been set up using the "Alarm Logging" editor.
● You configured the necessary message blocks, message classes and the message types
according to requirements configured in "Alarm logging".
● You configured the necessary single messages and message groups and their properties
in "Alarm logging".

Configuration steps
1. Insert the AlarmControl into a picture of Graphic Designer.
2. Configure the basic properties of the AlarmControl in the "General" tab.
– The message window properties
– The general properties of the control
– The time base of the control
– The default sorting order in the table
– Properties of the long-term archive list
– The action to be triggered by double-clicking in the message line
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3. Configure the content of the message lines in the message window. The content of the
message line depends on the configuration of the message blocks. Go to the "Message
blocks" tab.
4. Select the "Message lists" tab to define the message blocks to be shown as columns in the
message window. Use the selection dialog to define the messages to be displayed in the
message window.
5. Configure the layout and properties of the message window in the "Parameter", "Effects"
and "Selection" tabs.
6. Configure the toolbar and the status bar of the message window.
7. Configure a hitlist if you want to view message statistics.
8. Configure the display for the operator input messages to adapt these as required.
9. Save your configuration data.

5.6.2.2

How to configure the message blocks

Introduction
The message content to be displayed in the message line depends on the message blocks
configured. The message blocks configured in the "Alarm logging" editor can be applied without
changes, or be configured in AlarmControl.

Requirement
● You created a message system using the "Alarm Logging" editor.
● In "Alarm logging", you configured the message blocks to be used in the message line.
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Configuring existing message blocks
1. Go to the "Message blocks" tab in AlarmControl. All of the message blocks configured in
the "Alarm logging" editor are listed in "Available message blocks". The message blocks
for the hitlist are also listed.

2. If the "Apply project settings" option is activated, the message blocks and their properties
you configured in "Alarm logging" are activated in the AlarmControl. The message blocks
are displayed with these properties in the message window and can only be changed by
means of the Alarm logging. The message blocks of the hitlist depend on "Alarm logging".
You can configure these message blocks as required.
3. Deactivate the "Apply project settings" option to let you add or remove message blocks for
the message lists, or to configure message block properties. The changed properties are
stored in the picture. Changes to properties made in "Alarm logging" are ignored in this
control.
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4. Activate the check box next to the name of a message block to be used in the message
window in the "Available message blocks" list.
5. A selected message block can be set as criterion in the selection dialog by activating the
"Selectable in selection dialog" option for this message block.

Message block names
1. You can assign the message blocks custom names for the column header in the message
window. Remove the text ID and enter a name in the "Name" field. The name is saved to
the picture in the currently active language.
2. Use a corresponding entry from the text library for multi-lingual functions and for the
message block names in all pictures. Enter an existing text ID from the text library in the
"Text ID" field. The text ID stored in the text library is entered in the "Name" field.

Displaying message blocks
1. Resize the message block width in the message window as required. Enter a value in the
"Length in chars" field.
2. Use the "Display message colors" to determine whether or not to display the message block
colors as in the central setting for the AlarmControl, or otherwise.
3. With activated "Flashing on" option, you can specify that the content of a message block
flashes when a message is output at runtime.
4. Certain message blocks can also visualize the content and header in the column of the
message window as an icon. The content of message block "State", for example, can be
visualized in the message lists by symbols for "Came in", "Came in/Went out", "Came in/
Acknowledged", etc. Define how these message blocks should be displayed in the "Display"
field. The text and icons can be displayed in parallel.
5. You can format certain message blocks. Select the message block from the "Available
message blocks" list. Define the format in the "Format" field.
6. Save the configuration.

5.6.2.3

How to specify message window contents

Introduction
All messages are displayed in a separate message line in the message windows. The content
of the message window is determined by the message blocks and messages selected.

Prerequisite
● You created a message system using the "Alarm Logging" editor.
● You configured the message blocks to be used in the message line.
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Determine the message blocks to be displayed in the message lists.
Define the message window content on the "Message lists" tab.

Procedure
1. Go to the "Message lists" tab.

2. Select the "Available message blocks" list and select the configured message blocks to be
displayed in the message lists. Use the arrow buttons to move these message blocks to
the "Selected message blocks" list. Using the arrow buttons, you can cut selected message
blocks from the message lists and paste these to the "Available message blocks" list.
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3. You can define the sorting order of selected message blocks in the message lists and move
these using the "Up" and "Down" buttons.
4. Save the configuration.

Selecting messages to be displayed in the message lists
Use a selection dialog to select the message to be displayed in the message lists. You can
configure one permanent and several custom selections.
The configured fixed selection is always used during runtime. The custom selections
configured are only used during runtime if activated.
You can also import custom selections. The import is used, for example, to reuse selections
made by the user in other projects or to supply clients with the selections of the server project.
The imported selection replaces the existing selection in this case. Importing selections does
not require an export.
Any activated custom selection used is logically linked with the fixed selection you are using
by means of "AND" operation.

Procedure
1. Click "Edit..." in the "Selection" area to create or edit custom selections. The selection dialog
is opened.
2. Click on "New..." to create a selection or import a selection. Activate the new or existing
selections. For further information on the selection of messages, refer to How to Select
Messages (Page 1234).
3. Click "OK" to close the selection dialog. The activated selections are included in the
message window at the start of runtime.
4. Click on "Edit..." in the "Fixed selection" area to create or edit a fixed selection. The selection
dialog is opened.
5. Select the message blocks. Enter one operand and a text or value in the "Setting" column,
depending on the message block, or select an option.
6. Press "OK" to save the fixed selection and close the selection dialog. The fixed selection
is included in the message window at the start of runtime.

Configuring the sorting order of messages
You configure the sorting order of the columns in the message lists in the "Sorting" field. You
can also define sorting criteria using the toolbar during runtime. Disable the "Auto Scroll" option
to activate the configured sorting order during runtime. Only the default sorting order is
available if "Auto Scroll" is activated.
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Procedure
1. Click "Edit...". The sorting dialog opens.

2. Define a sorting order. For further information on the sorting of messages, refer to How to
Sort the Display of Messages (Page 1240).
3. Click "OK" to close the sorting dialog.
Note
You can change the default sorting order by "date/time/number" to "message block/date/
time/number". Configure the "DefaultSort2Column" and "DefaultSort2" object properties
accordingly. Define a message block and its object name in the "DefaultSort2Column"
object property. Define the ascending or the descending sorting order in the "DefaultSort2"
object property.

See also
How to Select Messages (Page 1234)
How to Sort the Display of Messages (Page 1240)
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5.6.2.4

How to configure the display for the table

How to configure the properties of the table elements
Introduction
You can adjust the properties of the table elements in the WinCC controls to suit requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameter" tab.

2. Specify the properties for
– Column Header
– Row label
– Sorting
– Table Content
3. Save the configuration.
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How to configure the colors of the table elements
Introduction
You can adjust the colors of the table elements in the WinCC controls to suit requirements.

Requirement
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Effects" tab.

2. Define the colors for the background or text here for:
– Table content. You can define different colors for even and odd line numbers to improve
differentiation between both.
– Contents of the table header
– Separating lines in the table and for table headers
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3. Define the color and the line weight in the "General" area in terms of:
– Control borders
– Window dividers for control elements
4. Save the configuration.

How to configure the marking of the selected cells and lines
Introduction
You can customize the marking of the selected cells and rows in the WinCC control to suit
requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Selection" tab.

2. Define whether to select rows or only cells using the mouse.
3. Configure the properties of the selection rectangle that can be displayed around selected
table cells or rows.
4. Configure the marking color for selectable cells and/or rows. The system colors are used
for marking with "Automatic coloring" property.
5. Save the configuration.
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How to configure sorting via the column heading
Introduction
You can adjust the sorting order by means of table column header in the WinCC controls to
suit requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameter" tab.

2. Define whether to enable sorting and the sorting method by column header. In WinCC
AlarmControl, you can only sort by column header if the "Auto-scrolling" is disabled. You
can deactivate "Auto-scrolling" either in the "General" tab, or using the "Autoscroll" toolbar
icon of the WinCC AlarmControl.
3. Determine the sorting order by mouse click on the column header. Select ascending,
descending or no sorting order.
4. Configure the sorting icon and index to be displayed in the column header with right
justification. These show the sorting order and sequence of the columns.
5. Activate the "Use sorting key" to display the sorting icon as sorting button above the vertical
scroll bar. Click this sorting key to activate a configured sorting order for the column
selected. The sorting key is not displayed if a vertical scroll bar is missing.
6. Save the configuration.
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5.6.2.5

How to configure the toolbar and the status bar

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The
status bar contains information pertaining to the current status of the WinCC control. You can
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The WinCC control is assigned the "Configuration dialog" button function for opening the
configuration dialog in Runtime.
● The configuration dialog of the WinCC control is open.
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How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in
Runtime. For information on the button functions, refer to the description of the
corresponding WinCC control at "Operation in runtime".
3. Determine the sorting order for displaying the button functions in the toolbar. Select the
button functions from the list and the move the functions using the "Up" and "Down" buttons.
4. Define a shortcut key for the functions of the toolbar buttons.
5. Any button functions assigned operator authorizations are only available in Runtime to
authorized users.
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6. An activated button function is displayed during runtime if you deactivate its "Active" option,
however, it cannot be operated.
7. You can set separators between the button functions. Activate the "Separator" option for
the button function to be restricted by separator.
8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status Bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required during runtime in the list of status bar elements. For further
information on status bar elements, refer to the descriptions of the corresponding WinCC
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements
from the list and move these using the "Up" and "Down" buttons.
4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a
pixel value for the width.
5. Configure the general properties of the status bar, e.g. alignment or background color.

5.6.2.6

How to Configure a Hit List of Messages

Introduction
The hit list displays statistic calculations for archived messages in the message window. In
addition to statistics, the hit list can display configured message blocks. Modifiable contents
with the format specifications "@...@" are not shown in the user text blocks.

Overview
Customize the hit list columns which consist of message blocks and statistics data.
The following statistic calculations are available for messages:
● Frequency of a message number. The frequency is only increased if the archive contains
a message with "Came In" state. If the frequency of a message number in the selected
message range is "0", an entry does not exist for this message number in statistics data.
● The cumulative duration of a message number for the status:
– "Came In/Came In" (Message block: Sum +/+)
– "Came In/Went Out" (Message block: Sum +/-)
– "Came In/Initial Acknowledgment" (message block: Sum +/*1)
– "Came In/Second Acknowledgment" (message block: Sum +/*2).
● The average duration of a message number for the states:
– "Came In/Came In" (Message block: average +/+),
– "Came In/Went Out" (Message block: Average +/-),
– "Came In/Initial Acknowledgment" (message block: average +/*1)
– "Came In/Second Acknowledgment" (message block: average +/*2).
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Only the "Acknowledgment", "System Acknowledgment" and "Emergency Acknowledgment"
states are included in the statistics calculation of acknowledgment times.
Note
Messages with "Acknowledgment", "System Acknowledgment", "Emergency
Acknowledgment" and "Went Out" states are only included in the calculation of statistic data
if the events available for statistics calculation include a corresponding, previous message
with "Came In" state.
If only one acknowledgment is triggered for a message with initial or second acknowledgment,
the acknowledgment time is included in the calculation of the cumulative and average duration
of the "Came In/Initial Acknowledgment" and "Came In/Second Acknowledgment" states.
If Runtime is stopped/restarted several times and a message is pending during this time, for
example, due to the external discrete alarm procedures or chronological reporting, then the
message is entered several times in the archive with "Came In" state and included several
times in the calculation.

Requirement
● You opened a picture which contains the AlarmControl in Graphics Designer.
● You configured the message blocks to be included in the hit list.
● You activated the "Hit List" button function on the "Toolbar" tab of the AlarmControl.
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Procedure
1. Go to the "Hit list" tab.

2. Select the message blocks to be displayed in the hit list from the list of available message
blocks. Use the arrow buttons to move these message blocks to the "Selected message
blocks" list. You can cut message blocks from the hit list and paste these to the "Available
message blocks" list using the arrow buttons.
3. You can define the sorting order of message blocks in the hit list by selecting and then
moving these using the "Up" or "Down" buttons.
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4. Specify the criteria to be used for displaying messages in the hit list, such as a specific
message class or a specific time range in the "Selection" area of the tab. All times are
included in the calculation of average values if you have not specified a time range. Note
that a long-range selection can adversely affect performance. Click the "Edit..." button to
configure a selection or import it. The imported selection replaces the existing selection in
this case. Importing selections does not require an export. You can also define selection
criteria for the hit list in Runtime using the "Selection dialog" button. For further information
on the selection of messages, refer to "How to select messages".
5. Define the sorting criteria for the hit list columns in the "Sorting" area of the tab, for example,
first descending by date and then ascending by message number. Click the "Edit..." button
to configure a sorting order. You can also define the sorting criteria for the hit list in Runtime
by means of the "Sort dialog" button.
6. In the lower portion of the tab, define the settings in terms of quantity and time limits for the
creation of statistics data.
7. Save the configuration.

Result
The hit list is configured for display in the message window. Call the hit list in Runtime by
in the toolbar.
clicking
The values in the hit list are sorted by frequency in descending order if you have not set any
sorting criteria.
New activated messages are not automatically included in the hit list. To include them, you
must reselect the hit list.

5.6.2.7

How to configure operator messages

Introduction
Operation of a message can trigger an operator message. Operator messages can be
triggered at the following events:
● Lock message
● Release message
● Acknowledge message
● Hide message
● Show message
Configure operator messages in WinCC AlarmControl:
● If you want to use and adapt the default operator messages of WinCC
● If you want to use custom operator messages
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Prerequisite
● You defined the WinCC system messages in the "Alarm logging" editor.
● In the "Alarm logging" editor, you configured the messages editor to be used as operator
messages in WinCC Alarm control.
● You opened Graphics Designer and configured a picture with a WinCC AlarmControl.
● The configuration dialog of the AlarmControl is open.
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Procedure
1. Go to the "Operator input messages" tab.

2. In the list, activate "Operator input message for:" the events which trigger operator
messages.
3. If not using the operator messages from WinCC, enter the message number of the
configured message for every event.
4. Assign the message blocks of the operated message to the process value blocks of the
operator message. The message blocks must be selected in the "Message Blocks" tab.
5. Define whether the contents are transferred as text or value.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1221

Setting up a Message System
5.6 Display of Messages during Runtime

Example
An operator message is to be generated on locking a message. The content of "User text block
1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process value block 1" of
the operator message. This requires that you select "1" under process value as the message
block of operated message "User text block 1".
Note
It is recommend to use message class "System, without acknowledgment" for all operator
messages. Always use message classes that are configured as "without status Went Out".
Note
Operator messages can only be logged if corresponding system messages are set up in the
message archive.

Operator message triggering upon locking and unlocking a message
Operator messages triggered by locking and unlocking messages are always assigned
● a time stamp
● name of the logged on user
● the computer name in the message archive of the alarm server concerned
The time stamp for the message is derived from:
● the message source (e.g., AS), in the case of active locking and unlocking
● the alarm server (OS), in the case of passive locking and unlocking
Actively locked messages are visible and operable on all WinCC servers and clients.

Results
The contents of operated messages are displayed in the updated process value blocks of the
operator message. The process value blocks must have been selected in the "Message Lists"
tab to enable the display of process value blocks of the operator message. The hitlist displays
statistic data of the operator messages.

5.6.2.8

How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set
up operation of the data export during runtime in the configuration dialog.
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Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab.

2. A standard file name and a standard directory are already entered in the "Data export default
settings". In this case for AlarmControl. If necessary, define a file name and a directory for
the export file.
The file name can be made up of the freely defined name and the following placeholder:
@OBJECTNAME - Object name of the controls
@CURRENTDATE - Current date
@CURRENTTIME - Current time
3. CSV is currently available as data format. Click
in the CSV file.

to specify the delimiter and data format

4. Define the scope of the data export:
– All runtime data is exported
– Selected runtime data is exported. This data export is only possible in WinCC controls
with tabular display.
5. Configure the operation of the data export during runtime. Define:
– whether users are allowed to rename the file, or change the directory.
– whether to display the "Data export default settings" dialog in Runtime.
6. If "Show dialog" is deactivated, the data for operation of the "Export data" button function
is immediately exported to the defined export file.
7. Save the configuration.
8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1223

Setting up a Message System
5.6 Display of Messages during Runtime

Results
You can export all or selected data to a defined file at runtime using the

5.6.2.9

button function.

How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the Runtime effects
of the online configuration.
Changes configured in Runtime are saved for the specific user separately from the picture in
the configuration system. The original picture configuration is retained in the configuration
system.
Note
The picture is also replaced at Runtime if you save it in Graphics Designer, or when loading
deltas in online mode. All online changes are lost.
The different configurations are only activated for new users after you performed a picture
change.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults
are only available in the configuration system. The option buttons are not available in
Runtime.
Select one of the three effects of the online configuration:
– "Do not retain". The online configurations are not retained in Runtime. This default
setting disables all options for Runtime users. Online configurations are lost at the next
picture change and on activation/deactivation of the project.
– "Retain during Runtime". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the
project.
– "Retain permanently". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
and on activation/deactivation of the project if the "retain" option is enabled.
3. Define corresponding user authorizations for online configuration.
4. The option buttons of the "Online configuration on next picture change" can be enabled for
operation in the configuration system and at Runtime by setting the "retain at Runtime" and
"retain permanently" defaults. The "reset" operation is only available in Runtime, because
the configuration system contains the original configuration.
Select one of three effects of the online configuration at the next picture change:
– Select "discard" if to discard the online configuration at the next picture change.
– Activate "retain" to activate the online configuration based on default settings at the next
picture change or on activation/deactivation of the project.
– Activate "Reset" if you want to apply the picture saved in the configuration system in
Runtime. All online changes are lost.
5. Save the configuration.

5.6.2.10

SQL statements for filtering messages in AlarmControl

Introduction
WinCC AlarmControl only supports SQL statements which can also be generated using the
selection dialog of the message window. The following conditions apply to WinCC:
● The structure consists of "Field", "Operand", and "Value", with the individual parameters
separated by blanks. For example: DATETIME >= '2007-12-21 00:00:00' AND MSGNR >=
100 (as of 2007-12-21, all messages with message number greater than and equal to 100).
● Strings, date, and time must be passed in single quotation marks.
● In the "DATETIME" argument, the date and time of day are separated by a blank.
Regardless of the time base setting in the object properties, the output of "DATETIME" is
based on the time base "Local Time". The "UTC" setting of the time base is an exception;
the output is then based on the "UTC" time base.

Valid arguments
Name

SQL name

Type

Data

Example

Date/time

DATETIME

Date

'YYYY-MM-DD hh:mm:ss.ms'

DATETIME >= '2007-12-03
16:00:00.000'
Outputs messages as of 12/03/2007,
16.00 hours.

Number

MSGNR

Integer

Message number

MSGNR >= 10 AND MSGNR <= 12
Outputs the messages with message
numbers 10 - 12.
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Name

SQL name

Type

Data

Example

Class

Class

Integer

Message class ID 1-16 and
system message classes 17 + 18

Class = 1
Outputs messages of message class 1.
Class IN ( 1,2 )
Outputs messages of message class 1
and message class 2.

Type

State

Computer name

Type

State

ComputerName

Integer

Integer

Text

Message type ID 1-256 and
system message types 257, 258,
273, 274

Type = 1
Outputs messages of message type 1.

Valid values:
1 = activated messages
2 = deactivated messages
3 = acknowledged messages
4 = blocked messages
10 = hidden messages
11 = displayed messages
16 = messages acknowledged by
the system
17 = Emergency-acknowledged
messages
18 = ackn. central signaling
devices

State = 1

Type IN (1,2,3 )
Outputs messages of message type 1,
message type 2 and message type 3.
State IN(1,2,3,16,17)

Search text for the computer name Computer name LIKE 'PC1234'
Outputs messages whose computer
name corresponds to "PC1234".
Computer name LIKE '%C12%'
Outputs messages whose computer
name corresponds to "C12".

User name

UserName

Text

Search text for the user name

User name LIKE 'User123'
Outputs the messages whose user
name corresponds to "User123".
User name LIKE '%er12%'
Outputs messages whose user name
corresponds to "er12".

Priority

Priority

Integer

Message priority 0 - 16

Priority >= 1 AND Priority =< 5
Outputs messages that have a priority
between 1 and 5.

AS number (AS/ AGNR
CPU number)

Integer

CPU number
(AS/CPU
number)

CPU__NR

Integer

Instance

Instance

AS Number

AGNR >= 2 AND AGNR <= 2
Outputs messages with the AS number
2.

AS subnumber

CPU__NR >= 5 AND CPU__NR <= 5
Outputs messages with AS subnumber
5.

Text
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Name

SQL name

Type

Data

Block: 1
...
Block: 10

Textxx

Text

Search text for block: 1 - Block: 10 Text2 LIKE 'Fault'

Example
Outputs message whose block: 2
corresponds to "Fault".
Text2 LIKE '%Fault%'
Outputs message whose block: 2
contains the "Fault" entry.

Process value: 1 PValuexx
...
Process value:
10

Double

Search value for process value: 1
- Process value: 10

PValue1 >= 0 AND PValue1 <= 50
Outputs messages with process value
between 0 and 50.

Valid operands
● >=, <=, =, >, <
● IN(...) : Several values as an array, separated by commas, e.g.: Class IN(1, 2, 3) AND Type
IN(1, 2,19, 20, 37,38)
● LIKE : The message text must match the string. The message text must only contain the
string if this string is enclosed with "%" characters. The "LIKE" operand is only valid for
"Textxx" arguments.

Invalid arguments and operands
Only the arguments defined in the table and the operands from the list are valid.
Grouping arguments, for example with brackets, is not permitted.
Note
If using SQL statements of versions older than WinCC V7 in the new WinCC AlarmControl
V7, you possibly have to convert the operands and contents for "Textxx" arguments. Only
the "LIKE" operand is used for "Textxx" arguments.

5.6.2.11

How to make the toolbar for the AlarmControl dynamic

Introduction
The default functions for operating the WinCC AlarmControl are no longer supported in the
new WinCC AlarmControl for WinCC V7.0 or higher. However, you can use the dynamic
methods of WinCC to operate the function of a toolbar button by means of script.

Overview
WinCC Controls V7.0 or higher no longer requires special functionality for operating the control
by means of dynamic toolbar. The default functions "AXC_OnBtn..." and "OnBtn..." used
previously are no longer supported.
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If you do not want to operate the message window using the toolbar, you can set the "ID" of a
button to the "ToolbarButtonClick" object property using any dynamic mode.
Determine a toolbar button "ID":
● using the table on page "Operation of the AlarmControl in Runtime".
● by means of the "Object ID" field of the "Toolbars" tab in the configuration dialog of the
AlarmControl.

Example: Open the control configuration dialog
The following options of assigning dynamic properties are available for opening the control
configuration dialog:
● VBScript:
– ScreenItems("Control1").ToolbarButtonClick = 2
– As an alternative to the "ToolbarButtonClick" property, you can use the VBS methods
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog
– Or, with the following notation and support of "Intellisense":
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog
● C script:
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);
● Direct connection
– Enter "2" as source constant in the direct connection dialog.
– Select the "ToolButtonClick" property for the "Control1" object as the "Object in picture"
target.

See also
Operating the AlarmControl in runtime (Page 1229)

5.6.3

Operation during runtime

5.6.3.1

Operating the AlarmControl in runtime

Introduction
You operate the message window at runtime using the toolbar buttons. If you do not want to
operate the message window using the toolbar, you can set the "ID" of a button to the
"ToolbarButtonClick" object property using any dynamic mode.
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Overview
The overview shows all symbols in "standard" style. If you want to create a design of the
controls with "single" style, the display of the symbols corresponds to the AlarmControl before
WinCC V7. You can find an overview on the page: "Before WinCC V7: Display of Messages
during Runtime > Operation during Runtime > Operation of Alarm Control during Runtime".
Icon

Description

ID

"Help"

1

Calls the WinCC AlarmControl help.
"Configuration dialog"

2

Opens the configuration dialog for editing the properties of the AlarmControl.
"Message list"

3

Lists currently active messages.
"Short-term archive list"

4

Lists the archived messages of the short-term archive list.
"Long-term archive list"

5

Shows the messages saved to the long-term archive list.
"Lock list"

6

Shows all messages locked in the system.
"Hitlist"

7

Displays the message blocks and the statistic data you configured on the Hitlist tab
of the AlarmControl.
"List of messages to be hidden"

8

Shows all messages which were hidden automatically or manually in the message
list.
"Ackn. central signaling devices"

9

Acknowledges a visual or acoustic signal generator.
"Single acknowledgment"

10

Acknowledgment of a selected and visible single message. If using the multiple
selection, the selected messages which require single acknowledgment are not
acknowledged.
"Group acknowledgment"

11

Acknowledges all active, visible messages which require acknowledgment in the
message window, unless these require single acknowledgment. If you use the
multiple selection, all marked messages are acknowledged, even if the messages
are hidden.
"Emergency acknowledgment"

18

Emergency acknowledgement of a message requiring acknowledgement. This
function transfers the acknowledgment signal of a selected single message directly
to the AS, even if this message is not activated.
Acknowledgment of inactive messages only refers to messages which were
configured in proper chronological order.
13

"Selection dialog"
Specifies the selection criteria for messages to be displayed in the message window.
The messages which do not meet these criteria are not displayed but are
nevertheless archived.
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"Display options dialog"

14

Specifies the messages to be displayed in the message window.
If the "All messages" option is activated, the message windows shows the hidden
as well as displayed messages.
If the "Only displayed messages" option is activated, only shown messages are
displayed in the message window.
If the "Only hidden messages" option is activated, only hidden messages are
displayed in the message window.
"Lock dialog"

15

Defines the locking criteria. All messages that meet these criteria are neither
displayed, nor archived.
"Print"

17

Start printing of the messages of the selected list. Define the print job in the "General"
tab of the configuration dialog.
"Export data"

35

Use this button to export all or selected runtime data to a CSV file. If the option
"Display dialog" is enabled, a dialog opens in which you can view the export settings
and start the export. You can also select the export file and directory, provided you
have the corresponding authorizations.
If no dialog is displayed, the export of the data to the default file is started
immediately.
"Autoscroll"

12

If "Autoscroll" is activated, the last message in chronological order is selected in the
message window. The visible range of the message window is moved if necessary.
New messages are not selected if "Autoscroll" is disabled. The visible range of the
message window is not modified.
Messages can only be selected explicitly if "Autoscroll" is disabled.
"First message"

19

The first of the currently active messages is selected. The visible range of the
message window is moved if necessary. The button is only available if "Autoscroll"
is disabled.
"Previous message"

20

The message activated previously to the currently selected message is selected.
The visible range of the message window is moved if necessary. The button is only
available if "Autoscroll" is disabled.
"Next message"

21

The next message relative to the currently selected message is selected. The visible
range of the message window is moved if necessary. The button is only available if
"Autoscroll" is disabled.
"Last message"

22

The last of the currently active messages is selected. The visible range of the
message window is moved if necessary. The button is only available if "Autoscroll"
is disabled.
"Infotext dialog"

23

Opens a dialog for viewing infotexts.
"Comments dialog"

24

Opens a text editor for entering comments
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"Loop-in-alarm"

25

Shows a picture for the selected message or triggers a script.
"Lock message"

26

The selected message is locked in the message list and in the message archive list.
"Release message"

27

Enables messages selected in the lock list.
"Hide message"

28

Hides the message you selected in the message list, or in short-term or long-term
archive list. The message is entered in the "List of messages to be hidden".
'Unhide messages"

29

Reactivates the display of messages you selected in the "List of messages to be
hidden" in the message list, or in the short-term or long-term archive list. The
message is removed from the "List of messages to be hidden".
"Sort dialog"

30

Opens a dialog for setting custom sorting criteria for displayed messages.
A custom sorting order has higher priority than the sorting order set at attribute
"MsgCtrlFlags".
"Time base dialog"

31

Opens a dialog for setting the time base for times displayed in the messages.
"Copy rows"

32

Copies the selected messages. You can paste the copy to the table editor or text
editor.
33

"Connect backup"
Use this button to open a dialog for interconnecting selected backup files with WinCC
Runtime.
"Disconnect backup"

34

Use this button to open a dialog for disconnecting selected backup files from WinCC
Runtime.
36

"First page"
Returns you to the first page of the long-term archive list. The button is only available
if paging is enabled in the long-term archive list. You can activate this setting in the
"General" tab of the configuration dialog.
"Previous page"

37

Returns you to the previous page of the long-term archive list. The button is only
available if paging is enabled in the long-term archive list. You can activate this
setting in the "General" tab of the configuration dialog.
"Next page"

38

Opens the next page of the long-term archive list. The button is only available if
paging is enabled in the long-term archive list. You can activate this setting in the
"General" tab of the configuration dialog.
"Last page"

39

Opens the last page of the long-term archive list. The button is only available if
paging is enabled in the long-term archive list. You can activate this setting in the
"General" tab of the configuration dialog.
"User-defined 1"

1001

Shows the first button function created by the user. The button function is userdefined.
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Available status bar elements
The following elements can be output to the status bar of the message window:

Icon

Name

Description

Pending messages

Shows the number of current messages in the message list.
The count includes messages hidden in the message list.

Pending
acknowledgeable
messages

Shows the number of pending messages requiring
acknowledgment.

Number of pending
hidden messages

Shows the number of pending messages that are hidden.

Messages in the list

Shows the number of messages in the current message
window.

Selection

A message selection exists.

Display option

The filter criteria is active. The "Display all messages" or
"Show hidden messages only" option is currently active.

Locked

The lock is set on messages.

Pending hidden
messages

There are hidden messages pending.

Connection status

Shows the status of the connection to the alarm servers:
● No connection errors
● Faulty connections exist
● All connections are faulty

Date

Shows the system date.

Time

Shows the system time.

Time base

Shows the time base used for displaying times.

Possible symbols in the message lists
You can display symbols in the message list to represent certain message blocks. An overview
of meaning of these symbols is provided below.
Symbols in the message list in the "Status" and "Acknowledge status" message blocks:
Icon

Meaning
Message came in in the "Status" message block
Message came in/went out in the "Status"
message block
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Icon

Meaning
Message came in/acknowledged in the "Status"
message block
Message acknowledged in the "Acknowledge
status" message block

Icons in the short-term archive list in message block "Status":
Icon

Meaning
Message came in
Message went out
Message acknowledged
Message acknowledged by system
Message is hidden
Hidden message came in
Hidden message went out
Hidden message acknowledged
Message is displayed again
Emergency acknowledgment of message
Message locked

Icons in the message lists of certain system blocks:
Icon

Meaning
Indicates whether a system block property has
been activated.
The "Comment" system block indicates whether
there is a comment for this message.
The "Infotext" system block indicates whether
there is an infotext for this message.
Indicates whether Loop in Alarm has been
activated at system block "Loop in Alarm"

5.6.3.2

How to Select Messages

Introduction
You can use the selection dialog in Runtime to specify the messages to be displayed in the
message window. You define new selection criteria in the selection dialog, or select an already
existing selection.
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New properties of the selection dialog
The design of the selection dialog was enhanced to improve handling comfort and offers the
following new properties:
● Concise input of selection criteria.
● The "*" and "?" wildcards are supported for setting a criterion.
● Saving a selection enables reuse of the selection without having to reenter the selection
criteria.
● Creating several selections.
● Duplicating a configured selection
● Linking specific selections in terms of a logical "OR" operation.
● A fixed selection is available that cannot be changed in Runtime. The fixed selection and
the active user-defined selections are logically linked by "AND" operation.
● All users are granted full access to all user-defined selections.
● The SQL statements you created by means of scripting, or entered in the object property
"MsgFilterSQL", are written to the list of selections and provided with a comment.
Note
Selection based on the "Acknowledged (emergency)" state is not supported for chronological
reporting.
Selection based on the "Acknowledged (central signaling device)" state is not supported.
Note
Ensuring the display of all messages
Observe the proper use of criteria, operands and settings of selections. Incorrectly linked
criteria can lead to important messages not being displayed in the AlarmControl.
Use the "Apply" button in Runtime to check the selection.
Test all selections separately and before linking these, and then test the linked selections.
Verify that all expected messages are also displayed in combination. This ensures that all
selections are displayed in the AlarmControl.
Note
Displaying messages from the Process Historian in the WinCC Alarm Control
You need to specify a time range in the selection dialog for displaying messages from Process
Historian in AlarmControl. If you did not specify a time range, only messages from the server
are displayed.
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Requirement
● You configured the "Selection dialog" button function on the "Toolbar" tab of the
AlarmControl.
● You activated the message blocks that are available as the selection criteria on the
"Message blocks" tab using the "Selectable in selection dialog" option.
● If a fixed selection is configured, other activated selections and the fixed selection are
logically linked by "AND" operation.

Procedure
1. Click on

in runtime. The "Selections" dialog opens.

2. Click "New..." to create a selection. Alternatively, you can activate existing selections by
clicking in the check box in front of the selection name.
3. When creating a new selection, assign a name to the selection and an expressive comment
to distinguish it from other selections.
4. Click in the first empty row of the "Criterion" column. The list with the selectable system
blocks, configured user text blocks and process value blocks is displayed. Select the
message block.
5. Select the suitable operand using the "Operand" column.
6. Click in the corresponding row of the "Setting" column. Depending on the text block, enter
a text or a value, or select an option.
7. Click "OK". The selection is saved and is listed in the table of selections.
8. You can create other selections or edit, remove or duplicate existing selections in the
selection dialog.
9. In the table, activate the selections to be included in the message window.
10.Click "Apply". The message window shows the selected messages.
11.Click "OK" to close the selection dialog.

5.6.3.3

How to Lock and Unlock Messages

Introduction
Message locking suppresses the display and archiving of messages. You can set a lock for
the following:
● Messages
● Message types
● Message classes
● Message groups
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Persistence of message locking
● The lock of messages is not persistent. Locked messages are unlocked automatically at
the restart of WinCC Runtime. Exceptions are messages that are locked directly in the AS
by means of data blocks (locking via source).
● The locking of message classes and message types remains in force even after a restart
of WinCC Runtime.

Requirement
● You configured the relevant button functions on the "Toolbar" tab of the AlarmControl.

Locking and enabling selected messages using the "Lock message" and "Enable message" button
functions
1. In the message list, select the message row which contains the message to be locked.
2. Click the "Lock message" button

. The message is removed from the message list.

3. You can view the locked message by clicking the "Lock list" button
selected message again by clicking the "Enable message" button
removed from the lock list.

. You can enable the
. The message is

Note
Users who are authorized to lock and enable messages must have been granted both
authorizations in the User Administrator, and these authorizations must be configured
directly one below the other. This is necessary as the authorization level defined below
the authorization for "Lock Messages" in the User Administrator is used automatically as
the authorization for enabling.
Note
If locking/enabling a single message of an Alarm_8P using S7PMC, you lock/enable all 8
messages of this block.

Locking and enabling single messages using the message number
1. Click the "Lock dialog" button

. The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user
projects.
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3. Click the "Add" button. Enter the message number to be locked in the next dialog.

4. You can lock several messages simultaneously. To do this, enter the message numbers
separated by commas. To select the a range of message numbers, enter a range in the
form "5-10". Only uninterrupted message ranges are locked. If there are gaps in the
specified range, the message "Invalid Range" is returned.
5. To enable a locked message, select the message from the list of locked messages and
then click the "Delete".
Note
You can lock and enable up to 50 messages simultaneously.

Locking and enabling of messages based on message class, message type, or message group
1. Click the "Lock dialog" button

. The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user
projects.
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3. In the tree view, select a message class, a message type or a message group you want to
lock. Click the "Lock" button. All messages of the specified message class, message type
or message group are locked.

4. To enable the locked messages, select the message class, message type or message
group and then click the "Enable" button.
Note
The server list contains only those server projects whose "Packages" are loaded on the
computer containing the project where you are configuring the control.

5.6.3.4

How to Perform an Emergency Acknowledgement

Introduction
In exceptional cases, a message can be acknowledged on the basis of its message number.
In this case, the acknowledgment signal is also transferred to the AS if the message is currently
inactive. Acknowledgment of inactive messages only refers to messages which were
configured in proper chronological order.
Note
The emergency acknowledgment function is not intended for general acknowledgment. The
function may only be used in extreme emergency situations.
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Prerequisite
● You configured the "Emergency Acknowledgment" button function on the "Toolbar" tab of
the AlarmControl.

Procedure
1. Click the "Emergency acknowledgment" button
messages" dialog opens.

. The "Emergency acknowledgment of

2. Select a server. In the "Message number" input field, enter the number of the message to
be acknowledged.

3. Click the "Send request" button. In the message window, the message now appears in the
color that you specified for an acknowledged message.
Note
In the dialog for the selection of the servers, only server projects are shown whose
"Package" is loaded onto the computer.

5.6.3.5

How to Sort the Display of Messages

Introduction
During runtime, you can sort the messages in the message window on the basis of message
blocks. You sort the message blocks either via the "Sort Dialog" keyboard function or directly
via the column headers of the message blocks. User-defined sorting is only executed if autoscrolling is disabled. Default sorting is executed if auto-scrolling is enabled.
Examples of message sorting:
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● Descending by date, time and message number. The most recent message is displayed
at the top. This is the default descending setting.
● Messages are displayed based on their priority. To apply this sorting method, you must
have specified the priorities of messages in the "Alarm logging" editor and configured the
"Priority" message block in the WinCC AlarmControl. As a result, in a single-line message
view, only the top-priority message appears in the message window. The messages are
usually shown in chronological order.
● Display of messages in ascending or descending order based on various message blocks,
allowing for user-defined sorting during runtime.
● The "Status" message block is sorted according to the status type and not according to the
configured status texts. If sorting is in ascending order, the messages are sorted in the
following order: "Came In", "Went Out", "Acknowledged", "Locked", "Released", "System
Acknowledgement", "Emergency Acknowledgement" and "Came In/Went Out".
Note
You can also specify the sort criteria during configuration in the AlarmControl by clicking
the "Edit..." button under "Sorting" on the "Message lists" tab. You configure the sort
criteria for the hit list on the "Hit List" tab.

How to sort with the Sort dialog
Prerequisite
● You have configured the button function "Sort dialog" on the "Toolbar" tab of the
AlarmControl.
● You have deactivated the button function "Autoscroll" in the toolbar or option "Autoscrolling" on the "General" tab.
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Procedure
1. Click the "Sort Dialog" button

.

2. In the "Sort By" field, select the message block by which to sort first. Select the relevant
check box to specify sorting in ascending or descending order. If you want to sort by more
than one message block, select the other message blocks in the desired order in the "Then
sort by" lists.

How to sort the displayed message blocks with the column heading
When sorting using the column header, you are able to specify the sort order for more than
four message blocks. A sorting icon and sorting index, displayed with right-justification in the
column heading, show sorting order and sorting sequence of the message blocks.

Prerequisite
● You have permitted the sorting in the list field "Sorting with column heading" by clicking or
double clicking on the WinCC AlarmControl on the "Parameter" tab.
● You have activated the "Show sorting icon" and "Show sorting index" check boxes.
● You have deactivated the button function "Autoscroll" in the toolbar or option "Autoscrolling" on the "General" tab.

Procedure
1. Click the column header of the message block you want to sort by first. The sorting index
"1" is displayed, and the sorting icon points upwards for ascending sort order.
2. If you want to sort in descending order, click the column header again.
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3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the
message block with a third click.
4. If you want to sort on the basis of several message blocks, click the header columns of the
respective message blocks in the desired sequence.

5.6.3.6

How to Hide and Unhide Messages

Introduction
Manual hiding of messages puts lesser information load on the user of the system. You as
user can concentrate better on the messages only if lesser important messages are not shown.

Manual hide process
During manual hide, you as user will decide whether to hide a message by using a button in
the message window. You can show the message again using a button or the system will show
the message after a configurable period. Operator input messages can be triggered in Manual
Hide.

Requirement
● You have configured the button functions "Hide message" and "Unhide message" and "List
of messages to be hidden" on the "Toolbar" tab in WinCC AlarmControl.
● Runtime has been activated and the WinCC AlarmControl is displayed.

Procedure
1. Select the message you want to hide in the message list, short-term archive list or longterm archive list.
button. The message is no longer displayed in the list and is
2. Click the "Hide message"
added to the list of messages to be hidden.
3. Click the "List of messages to be hidden"

button to display the hidden messages.

4. To show these messages again, display the "List of messages to be hidden". Select a
button. The message is removed from the
message and click the "Unhide message"
"List of messages to be hidden" and displayed back in the original list.
5. If you do not take any action to show the hidden messages, the configured duration will
decide when the system has to display back a message and remove it from the "List of
messages to be hidden".
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Runtime response to manual and automatic hiding of messages
Using the manual and automatic hide functions during Runtime has an effect on both the hide
modes:
● If the message is hidden automatically, you can display it again by clicking "Unhide
message".
● Automatic hiding takes priority over manual hiding:
– If the status of the hiding tag occurs for automatic hiding of the message, the message
is shown again, even if the time period for manual hiding has not yet elapsed.
– If a message has the status of the hide tag for automatic hiding, the message remains
hidden, even if the time period for manual hiding has elapsed.

5.6.4

AlarmControl example project

5.6.4.1

Examples of configuring an AlarmControl

Introduction
The following example shows the configuration of a WinCC Alarm Control and the display of
messages in runtime.

Requirement
● A message system has been set up using the "Alarm Logging" editor.

Basic procedure
Alarm Logging
1. Configure the required message blocks, message classes and message types according
to your requirements.
2. Configure the messages and message groups that you require.
Graphics Designer
1. Link the WinCC AlarmControl to a Graphics Designer picture and change the properties of
the control.
2. For the example, configure buttons to trigger and acknowledge messages in the Graphic
Designer.
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5.6.4.2

How to Configure the Message System

Introduction
If you have created a message system, you configure the message system in Alarm Logging
according to your requirements.
The following settings are configured for the AlarmControl example:
● Number of displayable characters in the "Message Text" user text block
● Acknowledgment philosophy for the message type
● Coloring of message states for the "Alarm" and "Warning" message classes

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "User text blocks" folder in the navigation area. The folder is a subfolder of the
"Message blocks" folder.
2. Select the respective message block in the "Table area".
3. Edit the property "Number of characters" in the "Properties" area.

4. Select the folder of the corresponding message type ("Alarm" and "Error") in the navigation
area.
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5. Activate the "Acknowledgment Came In" option in the "Properties" area under
"Acknowledgment philosophy".

6. Select the text and background colors for the message statuses in the "Properties" area
under "Colors".
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5.6.4.3

How to Configure Single Messages

Introduction
In the example, four message are displayed during runtime. You configure these message in
Alarm Logging with the following settings:
No.

Class

Type

Message tag

Message text

Point of error

1

Fault

Alarm

Tank1

Tank 1 empty

Tank 1

2

Fault

Alarm

Tank2

Tank 2 empty

Tank 2

3

Fault

Alarm

Tank3

Tank 3 empty

Tank 3

Requirement
● Configure the three "Binary" type tags "Tank1", "Tank2" and "Tank3" in the Tag
Management.
● The "Alarm Logging" editor is open.

Procedure
1. Select the folder of the "Alarm" message type in the "Error" message class in the navigation
area.
2. Create three new messages in the table area of Alarm Logging.
The messages are assigned to the "Alarm" message type.
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3. The following properties are specified by assigning the "Alarm" message type:
– Acknowledgment philosophy - Acknowledgment Came In
– Central signaling device - Acknowledgment button
This way you can acknowledge the message with an acknowledgment button in the
example project.
4. Specify the following properties for each message in the "Properties" area:
– Message tag = "Tank1" (Tank2, Tank3).
– Message text = "Tank 1 empty" (Tank 2 empty, Tank 3 empty)
– Point of error = Tank 1 (Tank 2, Tank 3)

5.6.4.4

How to configure the AlarmControl in the Graphics Designer

Introduction
Messages are displayed in runtime in WinCC AlarmControl. Configure the AlarmControl in the
Graphics Designer.
The following settings are configured for the example project:
● Keyboard functions in the toolbar
● Selection in the message window
● Selection and order of the message blocks that are displayed in the message window
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Procedure
1. Start Graphics Designer and open a new picture.
2. On the object palette, double-click the "WinCC AlarmControl" on the "Controls tab".
3. The Control is inserted into the picture. Click the Control at the drag point and drag it to the
desired size.
4. Double-click the Control. The "Properties of WinCC AlarmControl" is opened with the
"General" tab.
5. "Normal" is already selected as the window heading. Enter the desired window name in the
"Text" input field.
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6. On the "Toolbar" tab, select the "Display Toolbar" check box. Select the keyboard functions
you require. You need button functions "Configuration dialog", "Message list", "Lock list",
"Single acknowledgment", "Selection dialog", "Autoscroll", "Lock message" and "Enable
message" for the examples.
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7. Select "Single selection" as lines that can be marked and "Line" as selection outline on the
"Marker" tab. Define the marking colors as you wish.

8. Define the other display options as you like on the "Parameter" and "Display" tabs.
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9. Select the available message blocks "Time", User text block 1" and "User text block 2" to
change the format and name on the "Message blocks" tab. You can only change the
message blocks if you have deactivated the "Apply project settings" option. Select the
desired format in the "Format" field for "Time". For "User text block 1", the name "Message
text" and for "User text block 2" the name "Fault location" are already entered.
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10.Define the message blocks and the sequence as columns on the "Message lists" tab. Using
the arrow keys, move the selected message blocks from the list of "Available message
blocks" to the list of "Selected message blocks". Change the order by selecting a message
block and clicking "Up" or "Down".

11.Click "OK" to close the dialog, and save your settings in the Graphics Designer.

Results
The WinCC AlarmControl is configured for the example. If you have activated button function
"Configuration dialog" on the "Toolbar" tab, you can change the display of tables in the control
at any time in runtime.
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5.6.4.5

How to Configure Buttons for Changing Message Tags

Introduction
You have configured three single messages in Alarm Logging. In order to reproduce the
example for the Alarm Control, you configure three buttons in the Graphics Designer that you
use during runtime to set and reset the binary message tags of the individual messages. The
message window shows the message statuses with the configured colors.

Procedure
1. In the object palette of the Graphics Designer, select the "Standard" tab and click the
"Button" object in the "Windows Object" group. Position the cursor in the picture to the spot
where you want to insert the button, and enter the text "Tank1".
2. Select "Properties" in the shortcut menu.
3. Make the "Press left" event dynamic by establishing a direct link between the constant "1"
and the tag "Tank1".

4. Make the "Press right" event dynamic by establishing a direct link between the constant "0"
and the tag "Tank1".
5. Likewise, configure two additional buttons with "Tank2" and "Tank3".
6. Save your settings in the Graphics Designer.
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5.6.4.6

Example of making the toolbar of the AlarmControl dynamic

Introduction
In order to operate a button function of the toolbar of the WinCC AlarmControl from another
location, you must provide the "ToolbarButtonClick" property with the respective "ID".
In principle, any object can be used to operate the AlarmControl. In the following example, the
standard object "Button" is used to acknowledge a message.

Requirement
● You have configured the example project for AlarmControl.
● You have opened the picture with the configured AlarmControl in the Graphics Designer.

Procedure
1. Determine the object name of the AlarmControl based on the object properties of the
control, for example, "Control1".
2. Insert a button object from the Windows objects of the object palette into the picture. Enter
a button text, e.g. "Acknowledge".
3. In order to make the button object dynamic, open the shortcut menu for the properties of
the button object. In the "Event" tab, select the "Mouse" property. Make the attribute "Mouse
click" dynamic with a C action.
4. Select "C action..." with the right mouse button. The "Edit action" window is opened.
5. Insert the following into the right window area:
– // activate toolbar button single acknowledgement (ID: 10)
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 10);
6. Select the language for C compilation from the toolbar.
7. Compile and save the C action.
8. Save your settings in the Graphics Designer.

5.6.4.7

How to operate the example on AlarmControl

Requirement
● You have saved the configured picture in the Graphics Designer.
● You have entered the configured picture as the start screen in the "Computer properties"
dialog on the "Graphics Runtime" tab.
● You have activated "Graphics Runtime", "Alarm Logging Runtime" and "Global Script
Runtime" applications in the startup list of WinCC Explorer using the "Computer properties"
dialog.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1255

Setting up a Message System
5.6 Display of Messages during Runtime

Activating and deactivating Runtime
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu
option in WinCC Explorer.
2. Click on the three buttons with the left mouse button. The respective messages are
incoming and are displayed.
3. Click on the "Tank 1" button with the right mouse button for example. The message is
outgoing. The message status changes, indicated by the changed color.

4. After you have tested other control capabilities, e.g. locking messages, deactivate runtime.
You can deactivate Runtime using the toolbar or the menu bar of WinCC Explorer.

Locking and enabling messages
1. In the message list, select the message line containing the message to be locked, for
example, "Tank1".
2. Click on the

button. The message is removed from the message list.

3. If you click the button

, you will see the locked message in the lock list.

4. You can unlock the selected message in the lock list again by clicking button
message is removed from the lock list.

. The

Acknowledging a message using the acknowledgment button
1. Mark one of the messages that has the "Activated" state, e.g. the message "Tank 3 empty".
2. Now click on the dynamic acknowledgment button. The message is acknowledged. The
message status changes, indicated by the changed color.
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5.7

Before WinCC V7: Display of Messages during Runtime

5.7.1

WinCC Alarm Control

Introduction
WinCC Alarm Control is used as a message window for displaying message events.

Lists in the Message Window
You have the option to view six different lists in the message window:
● Message list showing the currently pending messages.
● Short-term archive list showing archived messages. The display is updated immediately
when new incoming messages occur.
● Long-term archive list showing archived messages.
● Lock list showing the currently locked messages.
● Hit list showing statistics.
● List of hidden messages to show messages that have been archived but are not displayed.

Note
A message is shown with a crossed-out date and time stamp in the message list when any
of the following occur:
● A locked message is unlocked.
● A message is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.
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See also
Configuration of the WinCC Alarm Control (Page 1258)
How to Configure Single Messages (Page 1262)

5.7.2

Configuration of the Alarm Control

5.7.2.1

Configuration of the WinCC Alarm Control

Introduction
Using an example, you will see how to display messages during runtime WinCC Alarm Control.

Requirement
● You have created a message system with the "Alarm Logging" editor.

Basic procedure
In Alarm Logging
1. Configure the required message blocks, message classes and message types according
to your requirements.
2. Configure the single messages and message groups that you require.
In Graphics Designer
1. Link the WinCC Alarm Control to a Graphics Designer picture and change the properties
of the Control.
2. In order to reproduce the message window settings for the example, you must configure
buttons for setting and resetting the message tags in the Graphics Designer.
Note
Standard functions can be used to control the message window. If you do not want to use
the toolbar functions to operate the message window, you can make any of the Graphics
Designer objects dynamic using the appropriate functions.

See also
Standard Functions for Operation of WinCC Alarm Control (Page 1293)
How to Configure the Alarm Control in the Graphics Designer (Page 1264)
How to Configure Single Messages (Page 1262)
How to Configure the Message System (Page 1259)
Configuring the Message System (Page 1101)
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5.7.2.2

How to Configure the Message System

Introduction
If you have created a message system in Alarm Logging, you configure the message system
in Alarm Logging according to your requirements.
The following settings are configured for the Alarm Control example::
● Number of displayable characters in the "Message Text" user text block
● Acknowledgement theory for message class "Error".
● Color assignment for the message statuses of message types "Alarm" and "Warning"
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select "Properties" in the shortcut menu of the "Message Text" user text block, and change
the length of the message block.

2. Select "Properties" in the shortcut menu of the "Error" message class, and select the
"Acknowledgement Came In" check box on the "Acknowledgement" tab.
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3. Select the "Properties" command in the shortcut menus of message type "Alarm" or
"Warning," respectively, and select the text color and background color for the message
statuses.

4. Save the settings in Alarm Logging.
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See also
How to Configure the Alarm Control in the Graphics Designer (Page 1264)
How to Configure Single Messages (Page 1262)
Configuring the Message System (Page 1101)

5.7.2.3

How to Configure Single Messages

Introduction
In the example, four message are displayed during runtime. You configure these message in
Alarm Logging with the following settings:
No.

Class

Type

Message tag

Message text

Location of
fault

1

Fault

Alarm

Tank1

Tank 1 empty

Tank 1

2

Fault

Alarm

Tank2

Tank 2 empty

Tank 2

3

Fault

Alarm

Tank3

Tank 3 empty

Tank 3

4

Fault

Warning

Motor

Motor on

Requirement
● Configure the four "Binary"-type tags "Tank1", "Tank2", "Tank3" and "Motor" in the Tag
Management.
● The "Alarm Logging" editor is open.

Procedure
1. In the Alarm Logging table window, add a new line for each message using the shortcut
menu.
2. Select "Properties" in the shortcut menu of the created message.
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3. On the "Parameters" tab of the "Single Message" dialog, select the class and type indicated
above and connect the message to the respective message tag.

4. On the "Text" tab of the "Single Message" dialog, enter the text indicated above for
"Message Text" and "Point of Error".
5. Likewise, configure three additional messages with "Tank2", "Tank3" and "Motor".
6. Save the settings in Alarm Logging.
Note
You can create the tags used as message tags either in the Tag Management of WinCC
Explorer or directly by selecting the message tag on the "Parameters" tab of Alarm Logging.

See also
How to Configure the Message System (Page 1259)
Configuring the Message System (Page 1101)
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5.7.2.4

How to Configure the Alarm Control in the Graphics Designer

Introduction
During runtime, the message events are displayed in an ActiveX Control, which is inserted
and configured in a picture in the Graphics Designer.
The following settings are configured for the example project:
● Keyboard functions in the toolbar
● Selection in the message window
● Selection and order of the message blocks that are displayed in the message window

Procedure
1. Start Graphics Designer and open a new picture.
2. In the object palette on the "Controls" tab, double-click "WinCC Alarm Control".

3. The Control is inserted into the picture. Click the Control at the drag point and drag it to the
desired size.
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4. Double-click the Control to open the "WinCC Alarm Control Properties" dialog. Enter a name
for the window in the "Window Header" box and select the "Window Header" check box in
order to display the window name during runtime.
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5. On the "Toolbar" tab, select the "Display Toolbar" check box. Select the keyboard functions
you require. For the examples, you need the following keyboard functions: "Message List",
"Lock List", "Selection Dialog", "Lock Dialog", "Emergency Acknowledgement", "Lock/
Unlock Message" and "Sort Dialog".
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6. In the "Selection" group of the "Parameters" tab, select the "Line" option.
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7. On the "Message Blocks" tab, select the "Time" system block and the two user text blocks
"Message Text" and "Point of Error".

1268

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.7 Before WinCC V7: Display of Messages during Runtime
8. On the "Message Lists" tab, specify the message blocks and the order in which they are to
be displayed in the message window. Using the arrow keys, move the selected message
blocks from the list of "Existing Message Blocks" to the list of "Selected Message Blocks".
or
.
Change the order by selecting a message block and clicking

9. Click "OK" to close the dialog, and save your settings in the Graphics Designer.

See also
How to Configure Buttons for Changing Message Tags (Page 1270)
Configuration of the WinCC Alarm Control (Page 1258)
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5.7.2.5

How to Configure Buttons for Changing Message Tags

Introduction
You have configured four single messages in Alarm Logging. In order to reproduce the example
for the Alarm Control, you configure four buttons in the Graphics Designer that you use during
runtime to set and reset the binary message tags of the individual messages. The message
window shows the message statuses with the configured colors.

Procedure
1. In the object palette of the Graphics Designer, select the "Standard" tab and click the
"Button" object in the "Windows Object" group. Position the cursor on the image at the spot
where you want to insert the button, and enter the text "Tank1".
2. Select "Properties" in the shortcut menu.
3. Make the "Left-click" event dynamic by establishing a direct link between the constant "1"
and the tag "Tank1".

4. Make the "Right-click" event dynamic by establishing a direct link between the constant "0"
and the tag "Tank1".
5. Likewise, configure three additional buttons with "Tank2", "Tank3" and "Motor".
6. Save your settings in the Graphics Designer.
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See also
How to Configure the Alarm Control in the Graphics Designer (Page 1264)
Configuration of the WinCC Alarm Control (Page 1258)

5.7.2.6

How to Configure a Hit List of Messages

Introduction
The hit list displays statistics for the archived messages in the message window. In addition
to statistics, a limited selection of configured message blocks can also be displayed in the hit
list. In the case of variable contents, the message blocks display the data for the last incoming
message.
You assemble the columns of the hit list yourself, which consist of the message blocks and
the statistics.
The following statistical calculations are available fro messages:
● Frequency of a message number. The frequency is only increased, if a message with status
"Came In" is included in the archive. If the frequency of a message number in the selected
message range is "0", no entry is made in the statistics for this message number.
● The cumulative duration of a message number in seconds for status "Came In/Came In"(+/
+),"Came In/Went Out"(+/-), the status "Came In/Initial Acknowledgment"(+/*1) or the status
"Came In/Second Acknowledgement"(+/*2).
● The average duration of a message number in seconds for status "Came In/Came In"(+/
+),"Came In/Went Out"(+/-), the status "Came In/Initial Acknowledgment"(+/*1) or the status
"Came In/Second Acknowledgement"(+/*2).
Only the "Acknowledgment", "System Acknowledgment" and "Emergency Acknowledgment"
acknowledgment states are included in the statistics calculation of acknowledgment times.
Note
Messages with the states "Acknowledgment", "System acknowledgment", "Emergency
acknowledgment" and "Went out" are only used for statistics calculation if the results available
for statistics formation show a matching message issued at a preceding time period with the
state "Came in".
If only one acknowledgment shows up with single-mode acknowledgment or dual-mode
acknowledgment, the acknowledgment time for calculation of the cumulated and average
duration for both states "Came In/Initial acknowledgment and "Came In/Second
acknowledgment" are taken into consideration.
If Runtime was deactivated and activated several times and a message was pending during
this time, e.g. due to the external discrete alarm or the chronological order alarm, the message
is entered multiple times in the archive with the state "Came In" and is also counted several
times during calculation.
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Requirement
● You have opened the Graphics Designer is opened and linked an Alarm Control.
● You have selected the message blocks you want to incorporate in the hit list on the
"Message Blocks" tab.
● You have specified the properties of the message blocks that you want to incorporate in
the hit list.
● You have activated the keyboard function "Hit List" on the "Toolbar" tab of the Alarm Control.
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Procedure
1. Double-click the Control. Select the "Hit List" tab.

2. Select the columns you want to display in the hit list. To do so, click
Columns" dialog opens.
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The dialog contains all statistical calculations that are available, as well as a limited number
of configured message blocks. You add the columns to the hit list by making one or more
selections and clicking "OK". If you want to remove columns from the hit list, select the
relevant columns in the "Hit List Columns" list and click
.
3. You can change the order in which the columns are displayed in the hit list by selecting the
column and clicking
or
to move it within the list.
4. Configure the column properties for the statistics data columns. You can rename the
column, change the alignment and the format of the values in the column, and adjust the
width of the column.
5. Columns can be named in two ways: If you are assigning a column name that is identical
every runtime language, enter a name in the edit box. If you want to use multiple languages,
use a text entry in the test library. Click
to select an existing text ID from the text library.
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6. If you want to configure the format of the column, select the "User Defined" check box.
Enter the desired format specification in the edit box or click
. If you have selected the
column for "Frequency" or a summation, the "Integer Formatting Help" dialog opens. For
formatting the averaging calculation, the "Formatting Help Floating-Point Number" dialog
opens.

Specify the format settings. The preview shows the effect of your column format settings.
In the Format Specification box, you can enter additional text in front of and behind the
formatting specification. Click
to confirm your entry. Click "OK" to confirm the format
specification.
7. Using the "Selection" button, specify the criteria to be used for displaying messages in the
hit list, such as a specific message class or a specific time range. If no time range is
specified, all times are taken into account in calculating average values. Note that a longrange selection can adversely affect performance. Alternatively, you can specify the
selection criteria for the hit list during runtime.
8. Using the "Sort..." button, specify the criteria to be used for sorting the columns in the hit
list, for example, first descending by date and then ascending by message number.
Alternatively, you can define the sort criteria for the hit list during runtime using the Sort
dialog or "Sort by Column Header" function.
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9. Using the "Settings..." button, specify limitations regarding the number of messages and
the time range to be taken into account in the statistical calculations for the hit list. This
enables you to avoid adverse impacts on performance.

If no time range is specified in the selection dialog, you can select the relevant check box
and enter a time factor and a time type to be used to generate the statistics. If the check
box is not selected, the time factor is set to "0" and no time filter is applied.
In the "Quantity Limitation" field, specify the maximum number of data records from the
message archive that are to be used to generate the hit list.
Example: You have specified the "Message Class Alarm High" filter in the selection dialog.
For the compilation of the hit list, all alarm messages that meet this criteria are retrieved
from the message server. From this group, the number of data records that is taken into
account in the statistics is limited to the amount you specified in the quantity limitation.
When the maximum number of records is reached, a warning can be issued.
10.Click "OK" or "Apply" to confirm the settings for the hit list. The hit list is now compiled. You
can access the hit list during runtime by clicking
in the toolbar.
If no sort criteria are specified, the values in the hit list are sorted in descending order of
frequency.
New incoming messages are not automatically included in the hit list. To include them, you
must reselect the hit list.

See also
How to Configure the Alarm Control in the Graphics Designer (Page 1264)
Configuration of the WinCC Alarm Control (Page 1258)
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5.7.2.7

How to Activate the Example for Alarm Control

Requirement
Prior to activating the example for the WinCC Alarm Control, you must
● Activate "Graphics Runtime" and "Alarm Logging Runtime" in the startup list of WinCC
Explorer using the "Computer Properties" dialog
● Save the picture you configured in the Graphics Designer and enter it as the startup picture
on the "Graphics Runtime" tab of the "Computer Properties" dialog.

Procedure
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu
option in WinCC Explorer.
2. Click the four buttons. The corresponding messages are displayed. If you now right-click
the "Tank 2" button, the message status changes as indicated by the color assignment.

3. Deactivate runtime by clicking the relevant button in the toolbar or selecting the relevant
menu option in WinCC Explorer.
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5.7.3

Operation during runtime

5.7.3.1

Operation of Alarm Control during Runtime

Introduction
The buttons on the toolbar are used to operate the message window during runtime. If you do
not want to use the toolbar to operate the message window, you can use the functions available
in the "Standard Functions/Alarm" group of the "Global Script" editor.
"Message list"
Shows the currently pending messages.
"Short-term archive list"
Shows the archived messages in the short-term archive list.
"Long-term archive list"
Shows the archived messages in the long-term archive list
"Lock List"
Shows all messages blocked in the system.
"Hit List"
Displays the message blocks and the static information that you have configured on the
hit list tab of Alarm Control.
"Ackn. Central Signaling Devices"
Acknowledges a visual or audio messenger
"Single acknowledgment"
Acknowledges a selected single message
"Group acknowledgement"
Acknowledges all pending visible messages in the message window that require
acknowledgement, unless they require single acknowledgment
"Autoscroll"
If "Autoscroll" has been activated, the latest modified message is selected in the message
window. The visible range of the message window is moved, if necessary.
If "Autoscroll" is not activated, a new message that appears is not selected. The visible
range of the message window is not modified.
Message rows can be selected in a targeted manner only if "Autoscroll" is activated.
"Selection dialog"
Specifies the selection criteria for the messages to be displayed in the message window.
The messages that meet these criteria are not displayed but are nevertheless archived.
"Display options dialog"
Defines which messages are to be displayed in the message window.
If the "Display all messages" option has been activated, the message windows shows the
hidden as well as displayed messages.
If the "Display shown messages only" option is activated, only shown messages are
displayed in the message window.
If the "Display hidden messages only" option is activated, only hidden messages are
displayed in the message window.
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"Lock dialog"
Defines the blocking criteria. All messages that meet these criteria are neither displayed
nor archived.
"Print message report"
Function for generating documentation containing a user-defined selection of messages
"Print current view"
Starts the printout of the messages displayed in the message window. Print job used during
printing can be specified in the control properties on the "General" tab.
In the Parameter dialog of the layouts linked to the print order, select the list of messages
you want to print.
"Emergency acknowledgement"
Emergency acknowledgement of a message requiring acknowledgement. This function is
used to send the acknowledgment signal of a selected single message directly the the
AS, even when the message is not queued.
The acknowledgment of unqueued messages only relates to messages configured in
correct chronological order.
"First message"
The first of the currently pending messages is selected. The visible range of the message
window is moved, if necessary. The button is only available if "Auto scrolling" is deactivated.
"Last message"
The last of the currently pending messages is selected. The visible range of the message
window is moved, if necessary. The button is only available if "Auto scrolling" is deactivated.
"Next message"
The next message (relative to the currently selected one) is selected. The visible range
of the message window is moved, if necessary. The button is only available if "Auto
scrolling" is deactivated.
"Previous message"
The previous message (relative to the currently selected one) is selected. The visible range
of the message window is moved, if necessary. The button is only available if "Auto
scrolling" is deactivated.
"Info text dialog"
Opens a dialog where you can display info texts
"Comments dialog"
Opens a text editor where you can enter comments
This button is only available in the long-term archive window. The configuration of this
function therefore has an effect on the Alarm Control properties only for this window type.
"Loop in alarm"
Shows a picture related to the selected message, or triggers a script.
The function can also be started by double-clicking a message.
"Enable message"
Click this button to unlock a message selected in the lock list.
"Lock message"
A selected message is locked in the current message list and in the message archive list.
"Sort dialog"
Opens a dialog for setting user-defined sort criteria for the displayed messages.
User-defined sort criteria override the sort criteria resulting from the "MsgCtrlFlags"
attribute.
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"Time base dialog"
Opens a dialog for setting the time base for the time data displayed in the messages.
"List of hidden messages"
The list of hidden messages shows all messages that are not visible due to automatic or
manual hide in the message list, in the short-term archive list or the long-term archive list.
"Hide messages"
Hides the message you have selected in the message list, short-term archive list or longterm archive list. The message is entered in the list of hidden messages.
'Unhide messages"
Shows again the message you have selected in the "List of hidden messages" in the
message list, short-term archive list or long-term archive list. The message is removed
from the list of hidden messages.

Possible elements of the status bar

Icon

Description

Date

System date

Time of day

System time

List:

Number of current messages in the message list. The count includes messages
hidden in the message list.

Window:

Number of messages in the window

Ackn:

Number of pending messages requiring acknowledgement
Selection has been made.
Filter criterion is effective, i.e. the "Display all messages" or "Display hidden
messages only" option is currently active.
Lock is set.
There are hidden messages pending.

See also
Standard Functions for Operation of WinCC Alarm Control (Page 1293)
Configuration of the WinCC Alarm Control (Page 1258)
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5.7.3.2

How to Select Messages

Introduction
You can use selection criteria during runtime to define which messages you want to display
in the message window. In the example below, only messages that contain message text
"Motor on" are displayed.

Requirements
● You have configured the relevant keyboard functions on the "Toolbar" tab of the Alarm
Control.

Procedure
1. Click the "Selection Dialog" button

during runtime. The "Selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Message Text". In the
right pane, select the "Search Text" check box and double-click the "Search Text" selection.
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3. The "Text Input" dialog opens. Enter the search text "Tank 1" and click "OK" to confirm.
4. Click "OK" to close the "Specify Selection" dialog. The message window now shows only
the selected messages.

Notes on defining the dialog
For certain message blocks, such as the date and time-of-day system blocks, you specify the
start and end times or a search text in the dialog. The entry must conform to the format required
in the dialog.
In the "Specify Selection" dialog, you can make the following settings:
Array

Description

Text selection if
exact match

If the "Text selection if exact match" check box is not selected, all text blocks
containing the search string are selected.
If the "Text selection if exact match" check box is selected, all text blocks correspond
exactly to the search string are selected.

Persistence in
RT

If the "Persistent in RT" check box is selected, changes in the search criteria are
retained even after a picture change.

Persistence in
CS and RT

If the "Persistent in RT and CS" check box is selected, the modified settings are also
applied to the configuration system. To do this, you must open the picture in Graphics
Designer and save it once again. The changed settings are also used when the
project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS
with PCS 7 projects or TIA projects. When you completely load the ES to the OS,
the changed settings on the OS will be overwritten.
Configure the properties of the controls on the ES.

Delete selection Click this button to delete all configured selection criteria.
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Note
It is not possible to enter text as a selection criterion for a process value. If you want to select
based on the text of a process value block or the displayed process tags, proceed as follows:
1) Insert this process value as a message text of a user text block in a message.
2) During runtime, select the messages based on the text in the "Message Text" text block.
In multi-user systems, you must ensure that contents displayed in the selection dialog on a
client are named identically on all servers.
To select based on the time of day, start and stop values are not automatically adjusted when
the time base of the Alarm Control is changed. For example, a computer located in time zone
"UTC + 1h" has the "Local Time Zone" time base specified in the Control. A selection criterion
based on the time of day 10:00 a.m. to 11:00 a.m. is then applied. If the time base of the
Control is now switched to "UTC" and you want to display the same messages in the Control
as before, the start and stop values of the selection must be changed to 9:00 a.m. and 10:00
a.m., respectively.

See also
Operation of Alarm Control during Runtime (Page 1278)
Configuration of the WinCC Alarm Control (Page 1258)

5.7.3.3

How to Lock and Unlock Messages

Introduction
Message locking suppresses the display and archiving of messages. You can set a lock for
the following:
● Single messages
● Single messages with multiple instances. The selected instance of the message will be
locked.
● Message types
● Message classes
● User-defined message groups
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Persistence of message locking
● The locking of single messages is not persistent. Locked single messages are automatically
unlocked when WinCC Runtime restarts. Exception: messages that are locked directly in
the AS by means of data blocks (locking at source).
● The locking of message classes and message types remains in force even after a restart
of WinCC Runtime.

Requirement
● You have configured the relevant keyboard functions on the "Toolbar" tab of the Alarm
Control.

Locking and Unlocking Selected Messages using Keyboard Function "Lock/Unlock Message"
1. In the message list, select the message line containing the message to be locked, for
example, "Tank1".
2. Click the "Lock/Enable message" button
list.

. The message is removed from the message

3. You can view the locked message by clicking the "Lock list" button
. You can unlock
the selected message again by clicking the "Lock/Enable message" button
. The
message is removed from the lock list.
Note
If a user is authorized to lock and unlock messages, this user must have both authorizations
in the User Administrator, and these authorizations must be configured directly one below
the other. This is necessary, since the unlock authorization for locked messages automatically
uses the authorization level defined in the authorization for "Lock Messages" in the User
Administration.

Note
Locking/unlocking of a single message of an Alarm_8(P) using S7PMC always results in the
locking/unlocking of all 8 single messages of this block.

Locking and enabling single messages using the message number
1. Click the "Lock dialog" button

. The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user
projects.
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3. Click the "Add" button. Enter the message number to be locked in the next dialog.

4. You can lock several messages simultaneously. To do this, enter the message numbers
separated by commas. To select the a range of message numbers, enter a range in the
form "5-10". Only uninterrupted message ranges are locked. If there are gaps in the
specified range, the message "Invalid Range" is returned.
5. To enable a locked message, select the message from the list of locked messages and
then click the "Delete".
Note
You can lock and unlock a maximum of 50 messages simultaneously.

Locking and enabling messages using the message class, message type or user-defined group
message
1. Click the "Lock dialog" button

. The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user
projects.
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3. In the tree structure, select a message class, message type or user-defined message group
that you want to lock. Click the "Lock" button. All messages of the specified message class,
message type or user-defined message group are locked.

4. To enable the locked messages, select the relevant message class, message type or userdefined message group and click the "Enable" button.
Note
The server list contains only those server projects whose "Packages" are loaded on the
computer containing the project where you are configuring the Control.

Operator Message upon Locking a Message
In the Alarm Control, you can specify whether an operator message is generated when a
message is locked or unlocked. You can configure the operator message yourself. It contains
the following information, by default:
● Time stamp
● Logged-on user
● Name of the computer in the message archive of the relevant alarm server
The time stamp for the message comes from the following:
● The message source (e.g., AS), in the case of active locking
● The alarm server (OS), in the case of passive locking
Actively locked messages are visible and operable on all WinCC servers and clients.
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Procedure
1. On the "Message Lists" tab in the properties dialog for the Alarm Control, click the "Operator
Messages..." button.
2. In the "Operator Messages" dialog, select the relevant check boxes if an operator message
is to be triggered when messages are locked or unlocked.
.
3. If you want to configure the content of the operator message yourself, click
In the configuration dialog, enter the number of a message that you have configured
previously in Alarm Logging. You assign the message blocks of the locked message to the
process value blocks of the operator message. These message blocks must be selected
on the "Message Blocks" tab. Click "OK" to confirm your settings.
Note
Operator messages can only be archived if system messages are set up in the message
archive.

See also
Operation of Alarm Control during Runtime (Page 1278)
Configuration of the WinCC Alarm Control (Page 1258)

5.7.3.4

How to Hide and Show Messages

Introduction
Manual hiding of messages puts lesser information load on the user of the system. You as
user can concentrate better on the messages only if lesser important messages are not shown.

Properties of Hidden Messages
Hidden messages are:
● In the message list, short-term archive list and long-term archive list, you can select whether
the hidden messages are to be displayed. The display depends on the activated option in
the "Display Options" dialog.
● They are included in the list of hidden messages and displayed there.
● They are archived.
● They do not trigger the alarm in Basic Process Control.
● You can again show messages that are hidden manually or automatically.
● In manual hide, they are displayed again after a certain defined period.
● Manual hiding forces you to acknowledge messages that need acknowledgement and
triggers an operator input message.
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● Automatic hiding does not force you to acknowledge and therefore it also does not trigger
an operator input message.
● In the period when messages requiring confirmation are hidden, the system acknowledges
the outgoing messages. If a message does not have the "gone" status, the system
acknowledges it immediately.

Hide process
During manual hide, you as user will decide whether to hide a message by using a button in
the message window. You can show the message again using a button or the system will show
the message after a configurable period. Operator input messages can be triggered in Manual
Hide.

Configuring Message Hiding in Alarm Logging
You can configure automatic hide and the duration for manual hide in Alarm Logging. The
configuration process is described in the chapter "How to Configure th Hiding of Messages".

Requirement
● You have configured the key functions "Hide/Show Message" and "List of Hidden
Messages" in the "Toolbar" tab in WinCC Alarm Control.
● Runtime has been activated and the WinCC Alarm Control is displayed.

Procedure
1. Select the message you want to hide in the message list, short-term archive list or longterm archive list.
button. The message is no longer displayed in the list
2. Click the "Hide/Show message"
and is added to the list of hidden messages.
3. Click the "List of Hidden Messages"

button to display the hidden messages.

4. To show these messages again, display the "List of Hidden Messages". Select a message
button. The message is removed from the "List
and click the "Hide/Show Message"
of Hidden Messages" and displayed back in the original list.
5. If you do not take any action to show the hidden messages, the configured duration will
decide when the system has to display back a message and remove it from the "List of
Hidden Messages".
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Runtime Behavior in Mnaual and Automatic Hiding of Messages
Using the manual and automatic hide functions during runtime has an effect on both the hide
types:
● If the message is hidden automatically, you can display it again by clicking "Hide/Show
Message".
● You have manually hidden the message using the "Hide/Show Message" button. The
message is shown again when the hide tag reaches the state for automatic display. The
period for manual hide should not have elapsed.
● You have manually hidden the message using the "Hide/Show Message" button. Further,
the message has the status of the hide tag for automatic hiding. If the period for manual
hide has expired, this message remains hidden.

See also
How to Configure the Hiding of Messages (Page 1135)

5.7.3.5

How to Perform an Emergency Acknowledgement

Introduction
In exceptional cases, a message can be acknowledged on the basis of its message number.
In this case, the acknowledgment signal is sent to the AS even if the message is currently not
pending. Acknowledging messages that are not pending only refers to messages that are
configured in chronological order.
For this reason, the function should only be used in extreme emergency situations.
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Requirement
● You have configured the keyboard function "Emergency Acknowledgment" on the "Toolbar"
tab of the Alarm Control.

Procedure
1. Click the "Emergency acknowledgment" button
for Messages" dialog opens.

. The "Emergency Acknowledgment

2. Select a server. In the "Message Number" box, enter the number of the message to be
acknowledged. Click the "Request" button. In the message window, the message now
appears in the color that you specified for an acknowledged message.

Note
In the dialog for the selection of the servers, only server projects are shown whose "Package"
is loaded onto the computer.

See also
Operation of Alarm Control during Runtime (Page 1278)
Configuration of the WinCC Alarm Control (Page 1258)
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5.7.3.6

How to Sort the Display of Messages

Introduction
During runtime, you can sort the messages in the message window on the basis of message
blocks. You sort the message blocks either via the "Sort Dialog" keyboard function or directly
via the column headers of the message blocks.
Examples for sorting messages:
● Display of messages in descending order by date, time and message number The most
recent message is displayed at the top.
● Display of messages according to priority. To apply this sorting method, you must have
specified the priorities of messages in Alarm Logging and configured the "Priority" message
block in the Alarm Control. As a result, in a single-line message view, only the top-priority
message appears in the message window. A message with a lower priority is not displayed,
even if it is more recent. Normally, the messages are shown in chronological order.
● Display of messages in ascending or descending order based on various message blocks,
allowing for user-defined sorting during runtime.
● The "Status" message block is sorted according to the status type and not according to the
configured status texts. If sorting is in ascending order, the messages are sorted in the
following order: Came In, Went Out, Acknowledged, Locked, Unlocked, System
Acknowledgement, Emergency Acknowledgement, Came In/Went Out.
Note
You can also specify the sort criteria during configuration in the Alarm Control by clicking
the "Sorting..." button on the "Message Lists" tab. You configure the sort criteria for the
hit list on the "Hit List" tab.
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Sorting Using the Sort Dialog
Requirement
● You have configured the "Sort Dialog" keyboard function on the "Toolbar" tab of the Alarm
Control.

Procedure
1. Click the "Sort Dialog" button

.

2. In the "Sort By" field, select the message block by which to sort first. Select the relevant
check box to specify sorting in ascending or descending order. If you want to sort by more
than one message block, select the other message blocks in the desired order in the "Then
By" lists.

Sorting Using the Column Headers of Message Blocks
When sorting using the column header, you can specify the sort order for more than four
message blocks. An arrow and a number are shown in the column header (right-justified). The
arrow indicates the sort direction, i.e. ascending or descending. The number beside the arrow
indicates the sort order of the message blocks.

Requirement
● You have selected the "Sort by Column Header" check box on the "Parameters" tab of the
Alarm Control.
● You have deactivated the "Autoscroll" keyboard function.
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Procedure
1. Click the column header of the message block you want to sort by first. The number "1" is
displayed, and the arrow points upwards for ascending sort order.
2. If you want to sort in descending order, click the column header again.
3. If you want to clear the sorting of the message block, click the column header a third time.
4. If you want to sort on the basis of several message blocks, click the header columns of the
respective message blocks in the desired sequence.
Note
Sorting is not affected by events or changes in the message block configuration. If you have
defined a message block as a sort criterion in the sort dialog and you subsequently delete
this block from the message line, the specified sort order remains in place. In the sort dialog,
a blank field is displayed instead of the deleted message block. If you have not specified
another sort order and the deleted message block is included again in the message block
configuration of the Control, the messages are again shown in the original sort order.

See also
Operation of Alarm Control during Runtime (Page 1278)
Configuration of the WinCC Alarm Control (Page 1258)

5.7.3.7

Standard Functions for Operation of WinCC Alarm Control

Introduction
If you do not want to use the toolbar to operate the message window, you can use the functions
available in the "Standard Functions/Alarm" group of the "Global Script" editor.
Function

Description

AXC_OnBtnAlarmHidingList

Function used to switch the message window to show the list of hidden
messages.

AXC_OnBtnArcLong

This function is used to switch the message window to show the
messages in the long-term archive list.

AXC_OnBtnArcShort

This function is used to switch the message window to show the
messages in the short-term archive list.

AXC_OnBtnComment

This function opens the dialog for entry of a message comment.

AXC_OnBtnEmergAckn

This function is used for an emergency acknowledgement of a
message.

AXC_OnBtnHideUnhideMsg

The function hides the selected message or displays again the hidden
message.

AXC_OnBtnHit

This function is used to switch the message window to show the
messages in the hit list.
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Function

Description

AXC_OnBtnHornAckn

This function can be used to acknowledge a central signaling device
assigned to the selected message.

AXC_OnBtnInfo

This function opens an information window showing the stored
information text.

AXC_OnBtnLoop

You can use this function to change the picture to the configured loopin alarm picture of the selected message.

AXC_OnBtnMsgFirst

This function selects the first message and shifts the visible range in
the message window, if necessary.

AXC_OnBtnMsgLast

This function selects the last message and shifts the visible range in
the message window, if necessary.

AXC_OnBtnMsgNext

This function selects the next message and shifts the visible range in
the message window, if necessary.

AXC_OnBtnMsgPrev

This function selects the previous message and shifts the visible range
in the message window, if necessary.

AXC_OnBtnMsgWin

This function is used to switch the message window to show the
messages in the message list.

AXC_OnBtnPrint

Depending on the current display type (message list, short-term
archive list, long-term archive list), this function is used to generate a
printout of the currently pending or archived messages that meet the
selection criteria. The print layout depends on the type of the message
window.

AXC_OnBtnProtocol

This function starts a printout of the current view of the Control. All
messages meeting the selection criteria are printed.

AXC_OnBtnScroll

This function can be used to change the Autoscroll behavior of the
message window.

AXC_OnBtnSelect

This function opens the selection dialog.

AXC_OnBtnSinglAckn

This function is used for acknowledgement of a selected single
message.

AXC_OnBtnSortDlg

This function opens the dialog for creating a user-defined sort criteria
for the displayed messages.

AXC_OnBtnTimeBase

This function opens the dialog for setting the time base for the time
data displayed in the messages.

AXC_OnBtnVisibleAckn

This function is used for acknowledgement of all messages visible in
the message window.

AXC_OnBtnLock

This function opens the dialog where messages can be locked.

AXC_OnBtnLockWin

This function activates the lock list view.

AXC_OnBtnLockUnlock

This function locks the currently selected message in Alarm Control in
the message list, short-term archive list and long-term archive list
views.
If the lock list view is selected, this function is used to unlock the
currently selected message.

AXC_SetFilter
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This function can be used to define a filter for selection of messages
to be displayed in the message window. The filter criteria must be
defined within the action script.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.7 Before WinCC V7: Display of Messages during Runtime

See also
Example of the Use of Standard Functions (Page 1295)
Operation of Alarm Control during Runtime (Page 1278)
Configuration of the WinCC Alarm Control (Page 1258)

5.7.3.8

Example of the Use of Standard Functions

Introduction
In order to operate the WinCC Alarm Control by means a function, you must configure the
corresponding function. This is done by making objects dynamic with standard functions of
Global Script in the Graphics Designer.
In principle, any object can be used to operate the Alarm Control. In order to achieve similarity
with the toolbar of a message window, the following example will insert a graphic object for
acknowledging a message.

Requirement
● You have configured the example project for Alarm Control.
● You have opened the picture containing the configured Alarm Control in the Graphics
Designer.

Procedure
1. Determine the object name of the Alarm Control based on the object properties of the
Control, for example, "OLE-Control1".
2. Insert a graphic object from the smart objects of the object palette into the picture. Use the
mouse to resize the graphic object to the desired size. In the configuration dialog, select
the picture to be displayed, for example,
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3. In order to make the graphic object dynamic, open the Properties dialog for the object via
the shortcut menu of the graphic object. On the "Events" tab, select the "Mouse" object and
use a C-Action to make the "Mouse Action" attribute dynamic.
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4. In order to enable a single acknowledgement of messages, you must select the
"AXC_OnBtnSinglAckn" function from the "Alarm" standard functions group in the "Edit
Action" window. To do so, double-click the function.

5. The "Set Parameters" window opens. Click "OK" to close the window without changes.
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6. In the "Edit Action" window, replace the string "lpszObjectName" with the object name of
the Alarm Control. In the example, the string is replaced with "OLE-Control1". After
successful creation of the action, click "OK" to close the window.

7. Save your settings in the Graphics Designer.
8. Start Runtime. Click the "Tank 1" button to generate a message. Now, click
. The message is acknowledged, and the color of the message changes.

See also
How to Configure Buttons for Changing Message Tags (Page 1270)
Configuration of the WinCC Alarm Control (Page 1258)
Standard Functions for Operation of WinCC Alarm Control (Page 1293)

1298

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting up a Message System
5.7 Before WinCC V7: Display of Messages during Runtime

5.7.4

SQL Statements for Filtering of Messages in Alarm Control

Introduction
In WinCC Alarm Control, only the SQL statements that can also be generated using the
selection dialog of the message window are permitted. The following conditions apply to
WinCC:
● The structure consists of "Field", "Operand", and "Value", with the individual parameters
separated by blanks. E.g.: DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 (all
messages as of 12/21/2006 with a message number greater than and equal to 100)
● Character strings, date, and time must be passed in single quotation marks.
● In the "DATETIME" argument, the date and time of day are separated by a blank.
Regardless of the time base setting in the object properties, the output of "DATETIME" is
based on the time base "Local Time". The "UTC" setting of the time base is an exception;
the output is then based on the "UTC" time base.
● The length of the SQL statement in WinCC AlarmControl is limited to 4096 characters.
● Only the SQL statements that can also be generated using the selection dialog of the
message window are permitted.

Valid arguments
Name

SQL name

Type

Data

Example

Date/time

DATETIME

Date

'YYYY-MM-DD
hh:mm:ss.msmsms'

DATETIME >= '2007-05-03
16:00:00.000'
Outputs messages as of 05/03/2007,
16:00 hours.

Number

MSGNR

Integer

Message number

MSGNR >= 10 AND MSGNR <= 12
Outputs the messages with message
numbers 10 - 12.

Class/type

CLASS IN
AND TYPE
IN

Integer
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- Message class ID 1-16 and
system message classes 17 + 18
- Message type ID 1-256 and
system message types 257, 258,
273, 274

CLASS IN ( 1 ) AND TYPE IN ( 2 )
Outputs messages of message class 1,
message type 2.
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Name

SQL name

Type

Data

Example

State

STATE

Integer

Value "ALARM_STATE_xx"

STATE IN(1,2,3)

Only the operands "=" and "IN(...)"
are permitted.

Outputs all messages that came in, went
out and were acknowledged.

ALARM_STATE_1
ALARM_STATE_2
ALARM_STATE_3
ALARM_STATE_4
ALARM_STATE_10
ALARM_STATE_11
ALARM_STATE_16
ALARM_STATE_17

Possible value:
1 = incoming messages
2 = outgoing messages
3 = acknowledged messages
4 = locked messages
10 = hidden messages
11 = shown messages
16 = messages acknowledged by the
system
17 = Emergency-acknowledged
messages

Message priority 0 - 16

PRIORITY >= 1 AND PRIORITY =< 5

Priority

PRIORITY

Integer

Outputs messages that have a priority
between 1 and 5.
AS Number

AGNR

Integer

AS Number

AGNR >= 2 AND AGNR <= 2
Outputs messages with the AS number
2.

CPU Number

AGSUBNR

Integer

AG subnumber

AGSUBNR >= 5 AND AGSUBNR <= 5
Outputs messages with AG subnumber
5.

Instance

INSTANCE

Text

Instance

-

Block: 1
...
Block: 10

TEXTxx

Text

Search text for Text1 - Text10

TEXT2 = "Error"
Outputs the messages whose Text2
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the messages whose Text2
corresponds with the text "Error" or
"Fault".
TEXT2 LIKE 'Error'
Outputs the messages whose Text2
includes the text "Error".

Process value: 1 PVALUExx
...
Process value:
10

Double

Search value for PVALUE1PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Outputs process value 1 with start value
0 and stop value 50.

Valid operands
● >= , <= , = , > , <
● IN(...) : Several values as an array, separated by commas, e.g.: CLASS IN( 1 ,2 ,3 ) AND
TYPE IN( 1 ,2 ,19 ,20 ,37 ,38 )
● LIKE : Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1
contains the search text "Error". The operand LIKE is only permitted for Text arguments.
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Invalid arguments and operands
Only the arguments indicated in the table and operands from the list are valid.
The following are not valid:
● The "OR" operand
● Multiple use of the same "Textxx" argument, e.g. "Text1"
● Grouping of arguments, e.g. by means of parentheses.
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Archiving Process Values

Content
WinCC offers the following options:
● Process and archive process values from a plant
● Output process values in the picture or as a log
You configure archives in the "Tag Logging" editor.
This chapter shows you:
● The basics of process value archiving
● How to configure the process value archiving
● How to output process values
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6.2

Process Value Archiving in WinCC

Introduction
The archive system is used for the archiving of process values in Runtime. The archiving
system processes the process values cached in the Runtime database and writes them to the
archive database.

The following WinCC subsystems are involved in the process value archiving:
● Automation system (AS): saves the process values that are sent to WinCC via
communication drivers.
● Data manager (DM): processes the process values and returns them to the archive system
via process tags.
● Archive system: Processes the acquired process values, for example, by forming the
average value. The method of processing depends on the configuration of the archive.
● Runtime database (DB): saves the process values that are to be archived.

Term definitions of archiving
The question of whether and when process values are acquired and archived is dependent
on a variety of parameters. The parameters to be configured for your project depend on the
applied archiving method.
● Acquisition cycle: determines when the value of a process tag is read out in the automation
system. You might configure an acquisition cycle, for example, for the continuous cyclic
archiving of process values.
● Archiving cycle: determines when the processed process value is saved in the archive
database. You might configure an archiving cycle, for example, for the continuous cyclic
archiving of process values.
● Start event: starts process value archiving when a specific event occurs, for example, when
the plant is turned on. You might configure a start event, for example, for a selective cyclic
archiving of process values.
● Stop event: stops process value archiving when a specific event occurs, for example, when
the plant is turned off. You might configure a stop event, for example, for a selective cyclic
archiving of process values.
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● Event-controlled archiving: Process values are archived if a change takes place in a tag
value or in the return value of a script. You can configure event-controlled archiving in
acyclic archiving of process values.
● Archiving process values during changes: Process values are archived only when they
have been changed. You can configure the archiving in acyclic archiving of process values.

Term definitions of archive configuration
The following two archive types are available for archive configuration:
● TagLogging Fast
All archive tags with a cycle time of less than one minute are automatically archived by
WinCC in TagLogging Fast.
● TagLogging Slow
All archive tags with a cycle time of more than one minute are automatically archived by
WinCC in TagLogging Slow.
You can change this default setting for the archive types. In the configuration of "TagLogging
Fast" you can assign different archive tags to the archive types, for example, archive only
process-controlled measured values in "TagLogging Fast".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1305

Archiving Process Values
6.3 Basics of Process Values Archiving

6.3

Basics of Process Values Archiving

6.3.1

Basics of Process Values Archiving

Introduction
The process value archiving serves for compiling, processing and archiving of process data
from an industrial plant. The process data gained can be filtered according to important
economic and technical criteria relating to the operating status of a plant.

Principle of operation
The process values to be archived are compiled, processed and saved in the archive database
in Runtime. Current or previously archived process values can be output in Runtime as a table
or trend. In addition, it is possible to print out archived process values as a protocol.

Configuration
In the "Tag Logging" editor you can configure process value archives as well as compressed
archives, define acquisition and archiving cycles and select the process values to be archived.
WinCC Controls are configured in Graphics Designer to display process data in runtime. The
process data can be output in table or trend curve form.
The protocol output of archived process data is configured as a protocol in Report Designer.
The process value output in the protocol can be in table or trend curve form.

Usage
The process value archiving can, for example, be used for the following tasks:
● Early detection of danger and fault conditions
● Increase of productivity
● Increase of product quality
● Optimization of maintenance cycles
● Documentation of the progress of process values

6.3.2

Process Value Archiving for Multi-User Projects

Introduction
In multi-user projects, process values can be archived by various servers. The following clientserver scenarios illustrate possible configurations.
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Client/Server Scenarios
Scenario 1
Process value archiving runs on several servers (2). Clients (1) can access the process value
archives on the available servers:

Scenario 2
Message and process value archiving runs on one server (3), together with process
communication. All other servers (2) deal with process-oriented tasks (e.g. displaying pictures).
Clients (1) can access all available servers:

Scenario 3
A server (3) without a process driver connection deals solely with message and process value
archiving. The server (3) collects the data from all other servers (2) through server-server
communication and distributes it to the clients (1):
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6.3.3

Process Values and Tags

6.3.3.1

Process Values and Tags

Principle
Process values are data stored in the memory of one of the connected automation systems.
Process values represent the status of a plant or parts thereof, for example, temperatures, fill
levels or states (e.g. motor off). To work with the process values, you define tags in WinCC.
The link between WinCC and the automation systems is provided by process tags, which
correspond to a certain process value in the memory of an automation system. The value of
a process tag is obtained by reading out the process value from the memory of the automation
system. On the other hand, a process value can also be written back to the memory of the
automation system.
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6.3.3.2

External and Internal Tags

Introduction
External tags are used to acquire process values in WinCC. They access a memory address
in the connected automation system. External tags are therefore referred to as process tags.
Internal tags do not have a process link and only carry values within WinCC.
External and internal tags can be stored in archive tags in the process value archive.
Note
As the primary task of process value archiving is the archiving of external tag values, this
documentation refers only to process tags.

Archive Tags
Process values are stored in archive tags in the process value archive. The system
distinguishes between the following types of archive tags:
● Analog archive tags store numerical process values, e.g. the fill level of a tank.
● Binary archive tags store binary process values, e.g. whether a motor is switched on or off.
● Process-controlled tags store process values that have been sent to the archive system as
frames, e.g. process values in a series of measurements.
Archived process values can be compressed. This compression is achieved through the
application of mathematical functions (e.g. averaging). Compressed process values of this
type are stored in compressed tags in a compressed archive.

6.3.3.3

Process-controlled tags

Introduction
Process-controlled tags (frame tags) are needed for the acquisition of quickly changing
process values, or if you want to combine several measuring points from one system.
Note
Process-controlled tags are of the "raw data type" in WinCC and are therefore also referred
to a "raw data tags".

Principle
In the automation system the process values are written to a binary file, and are sent as a
frame to WinCC where they are stored in a raw data tag.
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Archiving process-controlled tags
If you want the acquired process values belonging to a raw data tag to be archived, you need
to configure a process-controlled tag in the process value archive. To enable the archive
system to process the frame in the process-controlled tag, select a format DLL. The format
DLL is supplied with the automation system that you are using and dismantles the frame (e.g.
to ascertain the process values). The process values are then written to the archive database.
A format DLL for the SIMATIC S7 is included as standard in the scope of delivery of WinCC.

6.3.3.4

Structure of a Telegram with Raw Data Tags

Introduction
A frame for the transfer of raw data tags consists of two parts: a header and a body.

Frame header
The header contains general data, i.e. length of the frame. The high byte of data word 0 is not
used by the system and might thus be assigned by the user as required.
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Frame body
In the block status word, the format of the measurement values and the format of the
measurement areas, among other things, are defined. Bit 10 is reserved and will be used in
future versions for switching daylight saving and standard times (daylight saving time = 1).

Time and date are structured in accordance with the definition of the sequential time indication.

To transfer a measurement area, 8 data words are necessary. In these words, the upper and
lower limits of the tag and the archive are specified.

The following section contains a number of sample frame types.
Type 1
Measured value of a process tag + date and time
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Type 2
n measured values of a process tag + date and time of each measured value

Type 3
n measured values of a process tag with date and time, and sampling cycle

Type 4
n measured values of various process tags with time and date
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Type 5
n measured values of various process tags without time and date

6.3.3.5

Diagnostic Tags of Tag Logging Runtime
Tag logging has some diagnostics tags which enable the current archiving rate of the system
to be established.
Diagnostic tags are created as internal tags in the WinCC Explorer and are part of the
"TagLoggingRT" tag group.

@TLGRT_TAGS_PER_SECOND
The tag specifies the average archiving rate of Tag Logging cyclically as an archive tag per
second.

@TLGRT_AVARAGE_TAGS_PER_SECOND
The tag specifies the arithmetic average value of the average archiving rate of Tag Logging
cyclically as an archive tag per second since Runtime as started.

@TLGRT_SIZEOF_NOTIFY_QUEUE
This tag contains the current number of entries in the ClientNotify queue. All local trend and
table windows receive their current data from this queue.
WinCC: Working with WinCC
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@TLGRT_SIZEOF_NLL_INPUT_QUEUE
This tag contains the current number of entries in the queue for the format DLL. This queue
archives values that are transmitted by the raw data tag.

6.3.4

Properties in Tag Logging

6.3.4.1

Properties of a cycle time
In WinCC Configuration Studio, you determine the properties of a cycle time in the navigation
area or in the "Properties" area of the Tag Logging editor.

General
Property

Description

Last change

Display only: Last change to the properties of the cycle time

Timers
Note
An archiving cycle is not always executed each time Runtime is shut down or started up. If
you archive acyclically, for example, archiving only takes place once a value has changed
by a set amount. In such a case, the value in the archive is not up-to-date when Runtime is
shut down. To prevent this from happening, you have the option of additional archiving upon
system startup and shutdown.

Property

Description

Timer name

Enter a meaningful name for the cycle. A meaningful name can be helpful later.

At system startup

Option activated:
Archiving is carried out each time Runtime is started.

At system shutdown

Option activated:
Archiving is always carried out when Runtime is shut down.

Start time

Option activated:
The cycle is first triggered at the specified time. Archiving is carried out at the start time.

Month, day, hour, minute, second

This information determines the first time the acquisition or archiving cycle is triggered.
If the selection for "Day" does not apply in a given month, archiving is carried out on
the last day of the month.
Example: "31" selected, November: Archiving on November 30
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Cycle times
Property

Description

Time factor

Factor by which the time base is multiplied.

Time base

Drop-down list with default base times:
● 500 ms
● Second
● Minute
● Hour
● Day

6.3.4.2

Properties of a time series
In WinCC Configuration Studio, you determine the properties of a time series in the navigation
area or in the "Properties" area of the Tag Logging editor.

General
Property

Description

Last change

Display only: Last change to the properties of the cycle time

Timers
Note
An archiving cycle is not always executed each time Runtime is shut down or started up. If
you archive acyclically, for example, archiving only takes place once a value has changed
by a set amount. In such a case, the value in the archive is not up-to-date when Runtime is
shut down. To prevent this from happening, you have the option of additional archiving upon
system startup and shutdown.

Property

Description

Timer name

Enter a meaningful name for the cycle. A meaningful name can be helpful later.

At system startup

Option activated:
Archiving is carried out each time Runtime is started.

At system shutdown

Option activated:
Archiving is always carried out when Runtime is shut down.

Start time

Option activated:
The cycle is first triggered at the specified time. Archiving is carried out at the start time.

Month, day, hour, minute, second

This information determines the first time the acquisition or archiving cycle is triggered.
If the selection for "Day" does not apply in a given month, archiving is carried out on
the last day of the month.
Example: "31" selected, November: Archiving on November 30
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Time series
Property

Description

Time series base

Drop-down list with default base intervals:
● Daily
● Weekly
● Monthly
● Annually

Every (n) days, weeks, months

Factor that determines the series.
Examples:
● Base "Daily" and "9": Archiving is performed every 9 days.
● Base "Weekly" and "1" and "Weekday(s)" is "Monday": Archiving is performed every
Monday.
● Base "Monthly" and "3" and "Day of month" is "7": Archiving is performed on the
3rd day of every 7th month.
● Base "Annually" and "Day of month" is "5" and "Month" is February: Archiving is
performed every February 5th.

Weekday(s)

Selection of weekday for time series base = weekly

Day in month

Specification of day for time series base = monthly and annually

Month

Selection of month for time series base = annually

6.3.4.3

Properties of a process value archive
In WinCC Configuration Studio, you determine the properties of a process value archive in the
navigation area or in the "Properties" area of the Tag Logging editor.

General
Comment

Enter text as required.

Archiving disabled

Option activated:
The archive is not described and remains unchanged.

Relevant long term

Option activated:
Archive tag is considered to be "relevant long term" by the archive server.

Manual input permitted

If you want to be able to change archived values and add new values manually to the archive
in Runtime, select "Manual input permitted". If manual input is not permitted, no values can
be written to the archive in Runtime from external interfaces such as ODK or OPC, or from
WinCC OnlineTableControl.

Last change

Display only: Time stamp of last change
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General archive properties
Archive name

The name can be edited and can be changed at any time. You may be notified of illegal
characters during the input.

Server name

If you are working with a multi-user system, select the server.

Action at archive start / enable Opens the dialog for selecting a WinCC function. This function is triggered when the archiving
process is started. See also: "Function Call Templates"

Memory location
Memory location

Select between "Hard disk" and "Main memory". See also: "Storing Process Values".

Size in data records

If the archive is saved in the main memory, you can specify the archive size here.

Size in kB/tags

Display only: Size results from the information for "Size in data records".

6.3.4.4

Properties of a compressed archive
In WinCC Configuration Studio, you determine the properties of a compressed archive in the
navigation area or in the "Properties" area of the Tag Logging editor.

General properties
Comment

Enter text as required.

Archiving disabled

Option activated:
The archive is not described and remains unchanged.

Manual input permitted

If you want to be able to change archived values and add new values manually to the archive
in Runtime, select "Manual input permitted". If manual input is not permitted, no values can
be written to the archive in Runtime from external interfaces such as ODK or OPC, or from
WinCC OnlineTableControl.

Last change

Display only: Time stamp of last change

General archive properties
Archive name

The name can be edited and can be changed at any time. You may be notified of illegal
characters during the input.

Server name

If you are working with a multi-user system, select the server.

Action at archive start / enable Opens the dialog for selecting a WinCC function. This function is triggered when the archiving
process is started. See also: "Function Call Templates"
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Compression properties
Processing method

Specify what is to happen to the archived process values after compression.
See also: "Storing Process Values".

Compression time period

All times created in Tag Logging that are "greater than 1 minute" are available as compression
time periods. If the required compression time period is not available, configure a new time
in Tag Logging and then set the compression time period.

Recalculation with manual
input

Select this option if you want newly created or manually changed values in Runtime to be
applied for the relevant period. Settings of the individual compressed tags overwrite the
settings for the compressed archive.

Weighted quality code
Quality code bad

Enter a percentage value to specify the percentage value as of which the
respective status of the process values is archived in the compressed tag.

Quality code uncertain
Quality code good (Cascade)
Quality code good (Non-Cascade)

6.3.4.5

Properties of binary and analog archive tags

Properties of binary and analog archive tags
General
Comment

Enter text as required.

Archiving disabled

Option activated:
Process values are not archived for this tag.

Relevant long term

Option activated:
Archive tag is considered to be "relevant long term" by the archive server.

Manual input permitted

If you want to be able to change archived values and add new values manually to the archive
in Runtime, select "Manual input permitted". If manual input is not permitted, no values can
be written to the archive in Runtime from external interfaces such as ODK or OPC, or from
WinCC OnlineTableControl.

Last change

Display only: Time stamp of last change

General archive properties
Here, the name of the archive containing the configured archive tag is displayed.
General tag properties
Process tag

Tag whose values are saved in the archive tag.

Tag type

Display: binary / analog

Tag name

Name of the archive tag, can be edited.
Default setting: Name of the process tag.
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Tag supply

Selection: Manual / System

Also in tag

You can also write the value of the archive tag in an internal tag to continue using the archived
values for other purposes.
button.
Click on the cell and then on the
The dialog for tag selection opens.

Archiving
Acquisition type

Selection:
● acyclic - event-driven
● acyclic - in case of change
● cyclic - continuous
● cyclic - selective
Depending on this selection, some properties may not be relevant in this section and therefore
cannot be edited.
Archiving is controlled by start and stop events only for the acquisition type "acyclic - eventdriven". Time-based archiving does not take place in this case.
Stop event or stop tag are taken into consideration for acquisition type "acyclic - in case of
change". Tags which change more frequently than every second cannot be archived this way.
You must specify a start and stop event for the acquisition type "cyclic - selective".

Acquisition cycle

Drop-down list with all configured timers.
Determines how often process values are acquired.

Factor for acquisition cycle

Factor by which the acquisition cycle is multiplied.
The result determines the archiving cycle.

Archiving/display cycle

Drop-down list with all configured timers.
Determines how often process values are archived and how often the displays are updated
in Runtime.

Number of values, leader

Input of integer number.
This number of values is acquired in the leader but not archived.

Number of values, trailer

Input of integer number.
This number of values is acquired in the trailer but not archived.

Start event

Opens the dialog for selecting a WinCC function. The function must return the Boolean values
"TRUE" or "FALSE".
Archiving starts as soon as the selected function returns the value "TRUE".

Stop event

Opens the dialog for selecting a WinCC function. The function must return the Boolean values
"TRUE" or "FALSE".
Archiving stops as soon as the selected function returns the value "TRUE".

Start tag

Opens the dialog for selecting a binary tag.
Archiving starts as soon as the selected tag has the value "1".

Stop tag

Opens the dialog for selecting a binary tag.
Archiving stops as soon as the selected tag has the value "1".

Archive after segment
change

Option activated:
The value is archived even if it has not changed in case of a segment change.
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Hysteresis

Input of a value for hysteresis.
If a value is input, process values are only archived if they deviate by this value (absolute or
relative) from the value archived last.

Hysteresis type

Selection:
relative / absolute.

Parameter
Archiving on

(only with binary tags)
Selection of the signal change that triggers archiving.
The option "Always" results in a permanently up-to-date trend display of the value. The value
is archived even if there is no signal change.

Processing

(only with analog tags)
Processing function for the values acquired since the last archiving.
The following selections can be made:
● Current value - archives the currently acquired value
● Mean value
● Sum
● Minimum value
● Maximum value
● Action - permits running of a script for processing the archived values
● Difference

Unit

Input name of any unit.

Action for processing

Opens the dialog for selecting a script. The selected script processes the values acquired
since the last archiving.

Save on error

Selection which value is archived in case of an error:
last value / substitute value.

Display
Scaling tag low limit
Scaling tag high limit

Input of a factor. The factors define a high and a low limit for display of the tags. Values that
violate the high or low limit are not displayed.

Compression
Compression activated

Option activated:
"Swinging Door algorithm" is applied for effective archiving

Tmin (ms)

Positive integer:
Minimum period between two archived values

Tmax (ms)

Positive integer:
Maximum period between two archived values

Deviation absolute / in %

Selection determines type of deviation:
absolute / in percent

Deviation value

Positive floating-point number:
Absolute or relative value of the deviation that is permitted when calculating the gradient using
the algorithm; base value is the last process value saved.
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Low limit

Consistent positive or negative integer:

High limit

The value range is specified by the high and low limit of the compression distribution; relevant
only with relative (in percent) deviation. The input of limit values is deactivated in the case of
absolute deviation.

6.3.4.6

Properties of process-controlled tags

Properties of process-controlled tags
General
Relevant long term

Option activated:
Archive tag is considered to be "relevant long term" by the archive server.

Manual input permitted

If you want to be able to change archived values and add new values manually to the archive
in Runtime, select "Manual input permitted". If manual input is not permitted, no values can
be written to the archive in Runtime from external interfaces such as ODK or OPC, or from
WinCC OnlineTableControl.

Comment

Enter text as required

Last change

Display only: Time stamp of last change

General archive properties
Here, the name of the archive containing the configured archive tag is displayed.
General tag properties
Tag type

Display: Process

Tag name

Internal name of the archive tag specified after selection of a format DLL. Depending on the
format DLL used, IDs can be input for identification of the tags.
If an alias is specified as archive tag name, the internal tag name is used for management
in the process archive and for addressing the archive tags.

Properties of process-controlled tag
Raw data tag

Selection of raw data tag whose values are saved in the archive tag.

Archive tag name

Alias name of the tag, can be freely edited. Is used instead of the tag name.

Format DLL

Selection of the format DLL.
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6.3.4.7

Properties of compressed tags

Properties of compressed tags
General
Comment

Enter text as required.

Archiving disabled

Option activated:
Compressed values are not archived for this tag.

Relevant long term

Option activated:
Archive tag is considered to be "relevant long term" by the archive server.

Manual input permitted

If you want to be able to change archived values and add new values manually to
the archive in Runtime, select "Manual input permitted". If manual input is not
permitted, no values can be written to the archive in Runtime from external
interfaces such as ODK or OPC, or from WinCC OnlineTableControl.

Last change

Display only: Time stamp of last change

General archive properties
Here, the name of the archive containing the configured archive tag is displayed.
General tag properties
Tag name

Name of the compressed tag

Tag supply

Selection: Manual / System

Compression properties
Recalculation with manual input

Option activated:
Values changed manually or created in Runtime are taken into consideration.

Parameters
Processing

Processing function for the values acquired since the last archiving.
The following selections can be made:
● Mean value
● Sum
● Minimum value
● Maximum value
● Difference
● Weighted average value

Unit

Input name of any unit.

Properties of a compressed tag
Source tag

Archive tag whose value is saved in the compressed tag.

Source archive

Display only: Archive in which the source tag is archived.
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Weighted quality code
Quality code bad
Quality code uncertain

Enter a percentage value to specify the percentage value as of which the
respective status of the process values is archived in the compressed tag.

Quality code good (Cascade)
Quality code good (Non-Cascade)

6.3.5

Archiving Methods

6.3.5.1

Archiving Methods

Introduction
Various archiving methods are available for archiving process values. You can therefore
monitor a single process value at any point in time, for example, and make the monitoring
dependent on certain events. You can archive process values that change relatively quickly
without increasing the system load in doing so. You can compress process values already
archived to reduce the data volume.

Archiving methods
The following archiving methods are available in Runtime:
● Cyclical, continuous process value archiving: Continuous process value archiving, for
example, for monitoring a process value.
● Cyclical, selective process value archiving: Action-driven, continuous process value
archiving, for example, for monitoring a process value within a specific period of time.
● Acyclic process value archiving: Event-driven process value archiving, for example,
archiving a current process value when a critical limit value is exceeded.
● Archiving process values After every change: Process values are archived in a acyclic
manner only when they have been changed.
● Process-controlled process value archiving: Archiving of several process tags or of rapidly
changing process values.
● Swinging Door algorithm: Compression of archive values through linear interpolated tag
values.
● Compressed archive: Compression of individual archive tags or of entire process value
archives, for example, the hourly averaging of process values archived every minute.
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6.3.5.2

Cycles and Events

Introduction
Process value archiving is controlled by cycles and events. The acquisition and archiving
cycles enable continuous acquisition and archiving of process values. Furthermore, process
value archiving can also be triggered or ended by events and actions. Cycles and events may
be combined: A process value is for example acquired regularly; archiving is however only
triggered by a binary event.

Acquisition cycle
The acquisition cycle determines the interval at which the process value of a process tag is
read. The shortest possible value is 500 ms. All other values are integer multiples of this value.
The starting point of an acquisition cycle is determined by the run-up time of the WinCC
Runtime.
Note
A short acquisition cycle may lead to a high system load. Use process-controlled tags where
there are frequent or fast process value changes.

Archiving cycle
The archiving cycle determines when a process value is saved in the archive data bank. The
archiving cycle is always an integer multiple of the acquisition cycle. For standard timers, the
starting point of the archiving cycle depends on either the startup time of WinCC Runtime or
the starting point of the timer used. The starting point for calendar-based timers is set in the
time series configuration.
Specifying the start point means that the values are logged with a delay and that the logging
load is distributed. Here are two examples:
● Process values are archived in three cycles: every minute, every two minutes, and every
three minutes. This causes a high archiving load every six minutes. Assign a different
starting point to each of the three cycles. For example, archive every minute at the 15th
second, every two minutes at the 30th second, and every three minutes at the 45th second.
The archiving load is thus distributed.
● Many process values must be archived every ten seconds. In order to distribute the
archiving load you can, for example, configure two "10 second" cycles with different starting
points. Archiving takes place at second 0 or at second 5.
All process values read from the process tags during the time period between acquisition and
archiving will be processed by the archiving function. In the process value archive, you can
use only one of the following archiving functions:
● Actual value: Saves the last acquired process value.
● Total: Saves the sum of all acquired process values.
● Maximum value: Saves the highest of all acquired process values.
● Minimum value: Saves the lowest of all acquired process values.
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● Average value: Saves the mean of all acquired process values.
● Difference: Saves the difference between the process values of two archiving cycles
● Action: The most recently acquired process value is calculated, using a function created in
Global Script.
Note
If the same cycle is used for acquisition and archiving, it does not necessarily mean that
acquisition and archiving are started simultaneously.
There might be a system delay of up to the length of an acquisition cycle between acquisition
and archiving.

Start/Stop Events and Actions
Events start and stop process value archiving. Conditions which trigger an event can be linked
to a tag or to scripts (C, VBS). In WinCC, events / actions are differentiated as follows:
● Binary action: Response to changes in a Boolean process tag. Example: turning on a motor
might start the archiving of a process value.
● Limit value event: Triggered by a limit value being exceeded or reached. Limit value events
might be in absolute or scaled numbers. Example: temperature fluctuations of more than
2% might trigger archiving.
● Time-controlled event: Triggered when a fixed point in time is reached, or a defined period
of time from the start time of the process value archiving has elapsed. Example: a report
is generated after each shift change.

6.3.5.3

Continuous cyclic process value archiving

Introduction
Continuous cyclic process value archiving begins when Runtime is started. The process values
are acquired at fixed cycles and stored in the archive database. Continuous cyclic process
value archiving ends when Runtime is terminated.
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How it works

Each process tag in WinCC (B) corresponds to a certain process value in the memory of one
of the connected automation systems (A). The acquisition cycle (1) controls when the process
value is read from the memory of the connected automation system.
The Runtime component of the archive system (C) processes the process value:
● Whether the process value is archived at all depends on the way you have configured the
system. The process value must change by a certain amount or percentage (2).
● The archiving function (3) determines how the acquired process values are processed, for
example, by averaging.
The archiving cycle (4) determines when the processed process value is written to the archive
database (D).
Note
The update of the controls is based on the archiving cycle. If you have configured a fast
acquisition cycle but a slow archiving cycle, you may get the impression when displaying the
values that no values are archived.
If you want the values in the controls to be updated with the acquisition cycle, activate the
option "Refresh cyclic values" in the "Tag Logging" editor. To do so, select the "Tag logging"
folder in the navigation area.

6.3.5.4

Cyclic-Selective Process Value Archiving

Introduction
The cyclic-selective process value archiving is started in Runtime as soon as a start event
occurs. The process values are subsequently acquired at fixed cycles and stored in the archive
database.
Cyclic process value archiving ends:
● When a stop event occurs
● When you terminate Runtime
● When the start event no longer exists
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Start event and stop event are determined by the value of the configured tag or by the return
value of a script. You configure the tags or scripts in Tag Logging in the properties of the
process value tags in the "Archiving" area.

How it works

Each process tag in WinCC (B) corresponds to a certain process value in the memory of one
of the connected automation systems (A). Process value archiving begins on the occurrence
of the start event (1). The acquisition cycle (2) controls when the process value is read from
the memory of the automation system.
The Runtime component of the archive system (C) processes the process value:
● Whether the process value is archived at all depends on the way you have configured a
hysteresis. The process value must be changed by a certain amount or percentage (3).
● The processing method (4) determines how the acquired process values are processed,
for example, by averaging.
Until the occurrence of the Stop event (6), the archiving cycle (5) determines when the
processed process value is written to the archive database (D).

6.3.5.5

Acyclic Process Value Archiving

Introduction
With acyclic process value archiving, a process value is saved when it changes or depending
on an event in the archive database.
The process value is archived:
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● Either with every change of a process value
● Or in case of event-driven acquisition
– by means of a tag
(binary tag: change of the value (0 / 1), analog tag: rising / falling edge).
– By means of a script if the return value changes in comparison to the last call of the
function.
The value "TRUE" must be returned at the first script call.

How it works

Each process tag in WinCC (B) corresponds to a certain process value in the memory of one
of the connected automation systems (A).
In case of change:
Every change of the process value is read out from the memory of the connected automation
system (2). If you only want to archive a value when it changes to "1" or "TRUE", you must
configure the "signal change 0 -> 1" for archiving of a binary tag.
Event-driven:
The process value is archived if the tag assumes the value "1" and then the value "0" once
again for a configured event or the script receives the return value "TRUE" and then the return
value "FALSE" once again (1).
The Runtime component of the archive system (C) processes the process value.
The actual value of the process value is then written to the archive database (D) (3).
Acyclic process value archiving ends when Runtime is terminated.

6.3.5.6

Process-Controlled Process Value Archiving

Introduction
Process-controlled process value archiving is used for archiving several process tags or rapidly
changing process values. The process values are written to a process-controlled tag, which
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is decoded by the archive system. The process values obtained in this way are then stored in
the archive database.

How it works

Each process tag in WinCC (B) corresponds to a certain process value in the memory of one
of the connected automation systems (A). At the start of runtime, the process values of the
selected process tags are read out (1) and written to the configured process-controlled tag as
binary data.
The runtime component of the archive system (C) processes the process-controlled tag:
● The format DLL (2) is part of the archive system and decodes the binary data of the processcontrolled tag.
The decoded process values are then written to the archive database (D) (3).

6.3.5.7

Swinging Door algorithm for process value archiving

Introduction
Note
When compression is activated, the standard parameters for the archiving are deactivated.
Process values are compressed with the "Swinging Door Algorithm".
With optimum parameter assignment, process values are saved more effectively with the
Swinging Door algorithm than with cyclic acquisition.
The compression is achieved by not saving all the values. The compression therefore involves
some degree of data loss. The values that are actually saved are those that are regarded as
relevant based on the parameter assignment of the algorithm. The values that are not saved
are those that fall within a specified time interval within calculated limits.
Optimum parameter assignment is determined through the following specifications:
● Required accuracy of the archived data
● Required compression
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Because the value range and the sampling rate differ in various use cases, only general
information regarding the parameter assignment can be given here.
The advantage of compression is lost if values are archived too frequently.
The display of the value trend is less accurate if a larger deviation is selected.

Mode of Operation
The first value saved in the process value archive is the base value. If values have already
been stored in the archive, the last archived value is used as the base value.
Values that fall within a continuously recalculated value range are not saved. Only if a value
falls outside this range is the value saved and used as the base point for another calculation
of the value range. In order to regularly save values even when the trend characteristic is
smooth, use the Tmax parameter to specify the maximum duration for which no values are saved.
Continuously calculated value range - compression distribution
Values that fall within the value range are not saved. The compression of the data is achieved
in this manner.

Y











W
(1,3)

Deviation above, below

(2)

Last archive value, base value for calculating the value range

(4, 5) Continuously recalculated limits of the last archive value

The value range corresponds to a triangle that is recalculated with each newly acquired value.
The basis for the value range is the last saved value (2) plus your specified deviation (1,3).
The high limit (4) and the low limit (5) are adapted based on the measured values.
If the value range can no longer be determined because the calculated limits no longer intersect
(triangle is no longer possible), the last valid value (value just prior to the value that violated
the conditions) is saved and applied as the starting value for the calculation of the following
value range.
Minimum and maximum time
By specifying the minimum time Tmin and maximum time Tmax, you can adapt the accuracy of
the archiving to the sampling rate of the values.
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If more than one value is measured within the specified minimum time, only the last value is
considered.
A value is always saved after the maximum time.
Notes on parameter assignment
If necessary, select parameters initially in such a way that only slight compression is achieved
but with high accuracy (small Tmax, small deviation). In this way, you ensure that the data lost
through compression is kept to a minimum. If you find out that unneeded values are being
archived, you can adapt the parameters in such a way that fewer values are saved, thus
optimizing the compression rate.

Parameter
You can specify the following process tag properties for the configuration of the Swinging Door
compression algorithm:
Parameter

Unit

Description

Tips on parameter assignment

T min

Milliseconds

Time period for which measured values
are ignored. Starts at the last acquired
value.

In most use cases, set Tmin to the
smallest possible value. When a
minimum time is specified, data may be
lost.

Values within this time period are
neither saved nor used for calculating
the value range.
T max

Milliseconds

Maximum period between two archived
values. Starts at the last saved value.
After this time, the following value is
always archived. This value is used as
the starting value for calculating the
current value range.

Deviation

Value range

Process value unit

Process value unit

Absolute or relative value of the
deviation that is permitted when
calculating the value range; base value
is the last process value saved.

Use this parameter if values are
frequently acquired and you are sure
that you can ignore them.
Select a multiple of the sampling rate
for the value of Tmax. This parameter
ensures that values are archived
periodically and not just depending on
the process.
Preferably, you should select a
percentage value.
In many use cases, the use of small
percentage deviations provides a good
compromise between compression and
accuracy. In any case, always select a
deviation less than 50%. With absolute
values, the deviation must be less than
half the value range.

Specified by the high and low limit of
compression distribution; relevant only
with relative (percentile) deviation. The
input of limit values is deactivated in the
case of absolute deviation.

You make these settings in the "Compression" area in the "Properties" area of the archive tag.
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Example of a value trend

The graphic shows two trends as an example:
● blue - process values actually measured
● red - values saved with the Swinging Door algorithim
They values used for this example are:
Deviation = 2.5(%) Tmax = 120 s corresponds to 120 times the sampling time.

6.3.5.8

Compressed Archive

Introduction
In order to reduce the volume of data in the archive database, the archive tags for a specified
period can be compressed. To do this a compressed archive is created, which stores each
archive tag in a compressed tag. The archive tags are retained and can be copied, moved or
deleted. The compressed archive is stored in the archive database in the same way as the
process value archive.

How it works
For compression, one of the following functions is applied to the archived process values in a
specified period of time:
● Maximum value: The highest process value is saved in the compressed tag.
● Minimum value: The lowest process value is saved in the compressed tag.
● Average value: The average process value is saved in the compressed tag.
● Weighted average value: Saves the weighted average value of the process values in the
compressed tag. The time span in which a recorded value has the same value is considered
in the calculation of the weighted average value.
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● Total: The sum of all process values is saved in the compressed tag.
● Difference: Saves the difference between the process values of two archiving cycles in the
compressed tag.
What happens to the existing archived process values after compression depends on which
method of compression is used:
● Calculate: the process values of the archive tags of the specified period are read out and
compressed. The process values of the archive tags are retained.
● Calculate and copy: the process values of the archive tags of the specified period are read
out, compressed and copied to the compressed archive.
● Calculate and delete: the process values of the archive tags of the specified period are read
out, compressed and then deleted.
● Calculate, copy, and delete: the process values of the archive tags of the specified period
are read out, compressed and moved to the compressed archive.

Time stamp for a compressed archive
A compressed archive contains the following time stamp, depending on the archiving function
used, when archiving the process value:
● For maximum and minimum values, the time stamp of the respective maximum and
minimum value is archived.
● The time stamp of the compression period is archived for mean value, sum and difference.

Quality codes of tags in the compressed archive
The quality code of tags apply in the compressed archive as follows:
● In standard mode, a tag is always archived with its worst quality code. The status "Bad" will
always be archived in the compressed tag if even just one of the process values has the
status "Bad".
● When using weighted quality codes, you can specify for the status of the quality codes the
percentage from which the respective status of the process values is archived in the
compressed tag. For example, 80% of values must have the status "Good" to be saved as
"Good" in the compressed tag.
The weighting you define is also valid for the substatus of the quality codes. The substatus is
reduced to the respective main status. For example, an archive tag with quality code
"Uncertain" and "4C" status is transformed into quality code "40" in the compressed tag.
You can configure weighted quality codes for the complete compressed archive or for individual
compressed tags. Settings of the individual compressed tags overwrite the settings for the
compressed archive.
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Example
The following examples illustrate the way that the compressed archive works:
● Average value: A process value is archived once every minute and returns 60 values in
one hour. The compression with the average value is performed over a period of one hour.
Every hour, the average value is formed from the 60 values and is stored in the compressed
tag. What happens to the 60 values depends on the compression method described above.
● Weighted average value: A process value is acquired every second and returns 60 values
in one minute. The value is "50" for 40 seconds, the value is "60" for 20 seconds. The
compression with the weighted average value is performed over a period of one minute.
Every minute, the weighted average value of 60 values is archived, therefore, 40x50 +
20x60 / 60 = 53.33.

6.3.6

Storing Process Values

Introduction
Process values can be stored either on hard disk in the archive database or in the main memory
of Tag Logging Runtime.

Storing in Archive Database
The process values to be archived are stored in two separate cyclic archives (A, B) in the
archive database. Each short-term archive consists of a configurable number of data buffers.
The data buffer is defined in terms of size in MB, and a period of time (e.g., one day).

The process values are written continuously in the data buffers (1). When the configured size
of the data buffer is reached or the time periods exceeded, the system switches to the next
one (2). When all the data buffers are full, the process data in the first data buffer is overwritten
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(3). In order that process data is not destroyed by the overwritten process, it can be swapped
(exported).
Tag Logging Fast
Short-term archive A stores the process values whose acquisition cycle is less than or equal
to one minute. These process values are initially saved and compressed in a binary file. When
the binary file has reached a specific size, it is stored in the short-term archive.
Tag Logging Slow
Short-term archive B stores process values whose acquisition cycle is greater than one minute
and compressed archives. The data is written immediately in the short-term archive and not
compressed.
You can adapt the archive configuration to suit your needs.
Note
When starting Runtime, the system tests whether the configured size of a data buffer has
been calculated to a sufficient size. If the configured size is too small, the system automatically
adapts to the minimum size.

Saving in Main Memory
In contrast with storage in the archive database, process values archived in the main memory
are only available for as long as Runtime is active. Storing in the main memory has the
advantage, however, that the values can be written and read out very quickly. The process
values stored in the main memory cannot be swapped out.
Note
Compressed archives cannot be saved in the main memory.

6.3.7

Swapping Out Process Values

Introduction
You can swap out process values from the archive database as a backup. All process values
contained in a data puffer are swapped out. The time of the swapping-out can be configured
as you wish.
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Principle
You configure process value swapping in Tag Logging in the shortcut menu of the "Archive"
folder with the "Archive configuration" command. The swapping-out takes place separately for
"Tag Logging Fast" and "Tag Logging Slow".

On the "Archive Configuration" tab, configure the settings of the individual data buffers and
specify what time period is to be contained in the archive.
On the "Backup Configuration" tab, specify whether you want to create a backup of the archived
process values and where the backup is to be stored.
Note
In Runtime you can change a displayed process value with the OnlineTableControl.
If the location of the archive segment where the process value is stored has already been
changed, then the modified value is not accepted in the shifted archive. The change is limited
to the local archive segment.
If the archive segment has not yet been moved out, then the changed value is accepted
permanently.
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Long-term archive server
The long-term archive server is used for backing up process value archives. Swap files can
be accessed in three different ways:
● Copy swap files onto the configuration computer on which Runtime is run. Link the swap
files to the project in the Alarm Logging or Tag Logging. The archived values are displayed
in Runtime.
● Access via OLE-DB
● Access via DataMonitor Web Edition
To set up a long-term archive server, run the WinCC "Fileserver Setup" on the computer. A
minimum installation of WinCC is then installed on the computer. In order to be able to access
the stored process value archive with ADO/OLE DB, the MS SQL server is also installed.

6.3.8

Significance of Archive Value Flags
For each value written to the archive, Tag Logging will set a flag which provides information
on the tag state.
Representation of this flag is in the form of a 2-word value, coded in decimal form and listed
in the 3rd column of the database archive. This flag must be converted to its hexadecimal
representation for analysis purposes.

The high word contains the WinCC status flag or quality code and the low word contains the
Tag Logging status flags as well as a code for the content of the high word.

Code for High Word Content:
Meaning
0x0

High word contains WinCC status flags

0x1

High word contains quality code

Quality Code
Auto-Hotspot
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WinCC Status Flags
Auto-Hotspot

Tag Logging Status Flags
Name of flag

Value

Meaning

PDE_RT_DAYLIGHT

0x001

Daylight saving time

PDE_RT_SUBSTITUTION

0x002

Substitute value

PDE_RT_TIME_BEVOR_JUMP

0x004

Value prior to time jump

PDE_RT_TIME_BEHIND_JUMP

0x008

Value after time jump

PDE_RT_TIME_OVERLAPPED

0x010

Values during time overlap

PDE_RT_LOAD_SYSTEM

0x020

First value archived after creation of the archive

PDE_RT_RELOAD_SYSTEM

0x040

Initial value after archiving of RT

PDE_RT_CMPCOPY

0x080

Compressed value

PDE_RT_TIME_CHANGED

0x100

Time change took place

PDE_RT_HAND

0x200

Manual tag supply

Examples

1338

Value in database

16842753

Hexadecimal
representation

0101 0001

Coding for high word

0: High word contains WinCC status flag

Tag logging status flag

001: Daylight saving time

WinCC status flag

0101: Link to partner not established; tag initialization value

Value in database

266242

Hexadecimal representation

0004 1002

Coding for high word

1: High word contains quality code

Tag logging status flag

002: Substitute value

Quality code

0004: Configuration error, value not accepted
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6.4

Configuration of Process Value Archiving

6.4.1

Configuration of Process Value Archiving

Introduction
The process value archiving is configured in the "Tag Logging" editor. Specify which process
values are to be archived at what time. WinCC provides you with the process value archive
and the compressed archive for the archiving of process values.

Basic procedure
The configuration procedure for process value archives consists of the following steps:
1. Configure the process value archive: In the "Tag Logging" table area, create a process
value archive and select the process tags. Configure the properties of the archive in the
"Properties" area.
2. Specify the tags whose values are saved in the archive. Specify the archiving method in
the properties.
3. Specify the format DLL and the archive tag name for process-controlled tags.
4. Configure compressed archives, if necessary.
5. Specify the configuration for the archive backup.

6.4.2

Tag Logging editor

Introduction
In the "Tag Logging" editor, the archives, the process values to be archived and the times for
the acquisition and archiving cycles are configured. You configure the configuration of the data
buffer on the hard disk and the swapping out of process values in Tag Logging.
You start the editor with a double-click on the "Tag Logging" item in WinCC Explorer.

Structure of the Tag Logging editor
The Tag Logging editor has three areas:
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● Navigation area
– Tree view showing objects as folders
– Navigation bar for switching between the editors
● Table area
– Creation and editing of multiple objects
● Properties area
– Properties of a selected object
– "What's this?" for the selected property.

① Navigation area
Times and archives are displayed in the tree view.
The assigned elements (cycle times, archives, tags, etc.) of a selected folder are displayed in
the table area.

② Selection of the editors
The navigation bar is displayed in the area below the tree view. From here, you have access
to additional WinCC editors (e.g., Tag Management, Alarm Logging). You can adapt the display
of the navigation bar.

③ Table area
The table displays the elements which are assigned to the selected folder in the tree view:
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● Cycle times and time series are displayed and created here.
● Process value archives and compressed archives are displayed. New archives are created
in the table area.
●

Archive tags or compressed tags are displayed. You can change the properties of the
displayed tags here or add a new archive tag or compressed tag.

Additional functions are available in the table area via the shortcut menu of the column headers:
● Sort
● Filtering
● Hide column, show additional columns
Note
Inconsistent entries have a colored background in the table window. In the event of
inconsistent configuration, a note is displayed which describes the incorrect configuration.
Tabs are displayed below the table depending on the selected folder. You can use these tabs
to display the lower-level elements in table format.
Navigation keys allow you to scroll through tabs. You select a tab by clicking on it or from the
shortcut menu of the navigation keys.

④ What's this?
Displays an explanation of the selected property. You can drag this area to zoom in and out.

⑤ Properties
Here, the properties of a selected object are displayed and can be edited.
Status bar
At the bottom edge of the editor is the status bar.
Here, you will find the following information:
● Status of the system (ready, etc.), status of Caps Lock key, NUM Lock key, etc.
● Current input language
● Number of objects (e.g. archives, tags, timers…) in the selected folder.
● Number of selected objects if this is more than one.
● Display of the zoom status, slider for zooming in and out of the display
Alternatively, you can change the size of the display by pressing the <Ctrl> key while
moving the mouse wheel.
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6.4.3

Working in the Tag Logging areas

Working in the "Tag Logging" editor
You work and navigate in the "Tag Logging" editor as you would in the entire Configuration
Studio. Configuration is user-friendly and supports the configuration engineer during editing.
The handling is similar to that for a spreadsheet program.

Working with the navigation area
Individual folders of the tree view are expanded or collapsed by clicking the

buttons.

Shortcut menus with additional functions are offered for individual folders. The archive
configuration is configured from the shortcut menu.
You can show or hide the navigation area by clicking the

buttons.

Working with the table area
Creating a new object
You create new archives and archive tags in the table area.
To create a new object, you edit the cell identified by a yellow icon.

Enter a text (for example, name of the archive) or select a tag from the selection dialog in line
with the property.
Input and editing
Properties of an object (for example, archive, archive tag or timer) can be edited in the table
area.
The following options are available:
● Option:
Click in the field to set the check mark or to remove the check mark.
Option activated
Option deactivated
● Text input:
The text cursor is displayed after you have clicked in the box. Enter the text. Press the
ENTER key or click anywhere. The text cursor is no longer visible and the text is saved.
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● Selection from a drop-down list:
Click the button to select from a list of specified properties.

Make a selection.
● Open another dialog:
Click the button. A dialog with additional selection options is displayed. The input is not
accepted by the system until you close this dialog.

You can make entries in these fields directly above the keyboard. An invalid input is rejected.
Editing several objects
You enter recurring texts by selecting an entry and dragging down the bottom right corner of
the selection while keeping the left mouse button pressed.

The cells are automatically filled with the respective entry:
● Numerical entries are automatically incremented.
● A numerical suffix which is automatically incremented is appended to text entries.
If the name of a tag does not end with a figure, the same tag is used for all entries when you
drag down the selection.

To create multiple entries with a tag that has a numerical suffix, press <Ctrl> while you drag
down the selection.

Option boxes apply the selected option of the marked cell.
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When you select an area in the table area which only contains check boxes, the commands
"Select all" and "Deselect all" are available from the shortcut menu. This also applies if you
select multiple rows or the complete table and the first column contains check boxes.
Filtering entries with the "Find" search field
Use the "Find" search field to filter entries according to the specifications in a column. The first
column is selected by default. You can select any other column.
You make the settings for the search in the menu of the search field.

Delete the filter by clicking the button

.

Use the "Search in" command to select the properties to which the filter is applied.
Shortcut menu of the column header
The shortcut menu of the column header includes these options:

● Sort: The table can be sorted according to the selected column.
● Filter: To filter the table for entries of a property, select the "Filter" command.
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● Cut, Copy, Paste: These functions can be applied to all information of the selected column.
If you cannot paste the copied information to a column, you will be notified by a message.
● Find and replace: Function within the selected column.
● Delete: All entries in the column are deleted. This is not available for all properties.
● Hide, Show: The selected column can be hidden in the table area. Currently hidden columns
can be shown.
● Pin / Unpin: To always show columns when scrolling horizontally, select a column and select
the command "Pin". The column and all columns shown to the left remain visible while
scrolling. To scroll the pinned columns horizontally, select "Unpin".
Inconsistent entries
If an entered value is faulty or inconsistent, you will see a corresponding note, for example:
● Invalid entries are created when you edit several entries by dragging a cell.
Undoing and restoring
The functions "Undo" and "Restore" are not available in the Tag Logging area.

6.4.4

Cycle times and time series

6.4.4.1

Times for acquisition and archiving

Times for acquisition and archiving
The acquisition and archiving cycles in Tag Logging are based on previously configured times.
Frequently used time cycles are already created by WinCC when you create a new project.
You can configure additional time cycles as needed.
WinCC distinguishes between cycle times and time series.

Cycle time
A new cycle time is calculated on a basis that is multiplied with an integer factor. Cycle times
are independent of the current time. The acquisition and archiving based on a cycle time is
started as configured and repeated cyclically thereafter.
Basic cycles are:
● 1 day
● 1 hour
● 1 minute
● 1 second
● 500 ms (half a second)
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Time series
Time series are based on the calendar. The acquisition and archiving based on a time series
takes place daily, weekly, monthly or annually. The day can be specified as day of the week
or fixed calendar date. The time of the acquisition or archiving on the respective day can either
be specified or depend on the system start.

6.4.4.2

How to Configure a New Cycle Time

Introduction
The cyclical acquisition and archiving cycles are based on these timers.
Frequently used time intervals are provided by WinCC when you create a new project. If you
wish to use timers that deviate from these standard timers, you can configure new timers.
A new time cycle is calculated on a basis that is multiplied by an integer factor:
Cycle time = time factor x time basis.

Procedure
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1. Select the "Cycle times" folder under the "Timers" folder in the navigation area of the "Tag
Logging" editor.
All configured time cycles are displayed in the table area. You can use these time cycles
to configure the acquisition and archiving cycles.
2. To create a new timer, click the top empty cell and enter a name in the "Timer name" column
of the table area.
A new timer is created.
3. Edit the properties of the timer in the "Properties" area.

6.4.4.3

How to configure a new time series

Introduction
Time series are based on the calendar. Acquisition and archiving take place at regular intervals
depending on the calendar date.

Procedure
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1. Select the "Time series" folder under the "Timers" folder in the navigation area of the "Tag
Logging" editor.
All configured time series are displayed in the table area. You can use these time series to
configure the acquisition and archiving cycles.
2. To create a new timer, click the top empty cell and enter a name in the "Timer name" column
of the table area.
A new timer is created.
3. Edit the properties of the timer in the "Properties" area.

6.4.5

Configuring Archives

6.4.5.1

Configuring Archives

Principle
For the configuration of archives, the system distinguishes between the following archive types:
● A process value archive stores process values in archive tags. When configuring the
process value archive you select the process tags that are to be archived and the storage
location.
● A compressed archive compresses archive tags from process value archives. When
configuring the compressed archive you select a calculation method and the compression
time period.

6.4.5.2

How to Configure a Process Value Archive

Introduction
The procedure for configuring a process value archive is broken down into the following steps:
1. Creating process value archive: Create the new process value archive and select the tags
that are to be archived.
2. Configuring the process value archive: Configure the process value archive by selecting
the memory location, etc.

Procedure
Creating process value archive
Note
The following signs cannot be used in archive names:
ä ö ü - Ä Ö Ü # <space>.
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1. Select the "Process Value Archives" folder in the navigation area of the Tag Logging editor.
2. Click the top empty line in the "Archive name" column of the table area and enter the name
of the archive.

You have created the process value archive.
Configuring process value archive
You edit the properties of the archive either in the "Properties" area or in the table area:
1. Select the folder of the archive in the navigation area.
Edit the properties of the archive, for example:
– Action at archive start / enable
– Memory location (hard disk / main memory)
– Size in data records
2. In the table area, add the tags to the archive that are to be saved in the archive:
– Select the "Tags" tab in the table area to add binary or analog tags to the archive.
– Select the "Process-controlled tags" tab to add raw data tags (frame tags).
You must select the format DLL and an archive tag for these tags.
3. Select the line of a tag in the table area.
Edit the properties of the tag in the "Properties" area.

6.4.5.3

How to configure the data buffer

Introduction
In the case of a process value archive, it is possible to define whether the data buffer should
be stored on the hard disk or in the main memory.
In contrast to storage in the logging database, process values logged in main memory are only
available for as long as Runtime is active. Storing in the main memory has the advantage,
however, that the values can be written and read out very quickly. The process values stored
in the main memory cannot be swapped out.

Procedure
Note
Compressed archives can only be stored on the hard disk.
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1. Select the process value archive whose data buffer you wish to configure in the navigation
area.
2. Edit the information in the "Memory location" section in the "Properties" area.
3. If you select "Main memory" as the storage location, enter the "Size in data records" for the
data buffer.

6.4.5.4

How to Configure Compressed Archives

Introduction
The procedure for the configuration of a compressed archive consists of the following steps:
1. Creating compressed archive: Create the new compressed archive and select the tags to
be archived.
2. Configuring compressed archive: Configure the compressed archive by selecting the
memory location, calculation method, etc.
3. Assigning the source tags to a compressed tag: Select the archive tags to be included in
the compressed archive.

Procedure
Creating compressed archive
Note
The following signs cannot be used in archive names:
ä ö ü - Ä Ö Ü # <space>.
1. Select the "Compressed archives" folder in the navigation area of the Tag Logging editor.
2. Click the top empty line in the "Archive name" column of the table area and enter the name
of the archive.

You have created the compressed archive.
Configuring compressed archive
1. You edit the properties of the archive in the "Properties" area or in the table area, for
example:
– Action at archive start / enable
– Compression properties
– Weighting of the quality codes
2. Select an archive tag as source tag and assign it to a compressed tag.
See also: "How to configure the properties of a compressed tag (Page 1357)".
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6.4.6

Creating Archive Tags

6.4.6.1

Creating Archive Tags

Principle
Process values are archived in archive tags. Different archive tags can be used in a process
value archive:
● Binary process values are stored in a binary archive tag.
● An analog archive tag is used for storing numerical process values.
● A process-controlled tag is used for storing process values which have been sent to the
archive system as a frame.
In a compressed archive each compressed process value is stored in a separate compressed
tag.
Several tags can be archived in one archive.
Note
You may suffer data loss if you change the type of process tag to be archived after assigning
it to an archive.
Create a new process tag with a different tag type and assign this process tag to the archive
tag.

Basic procedure
In the case of binary and analog archive tags, you configure the archiving type (e.g., cyclic)
as well as acquisition and archiving cycles. Depending on the archiving type, select events
and actions which trigger or end archiving. Depending on the type of archive tag, configure
the display limits and parameters for processing the process value.
Select the format DLL for process-controlled tags.
Select a compression function when configuring a compressed tag.
Note
In Tag Logging, if you delete, save and subsequently recreate a tag with the same name as
the deleted tag, the values of the deleted tag can no longer be accessed for display or
archiving. Reason: The newly created archive tag is assigned a new ID. The ID of a deleted
archive tag is no longer accessible.
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6.4.6.2

How to create an archive tag

Introduction
You create an archive tag in a previously configured process value archive. You assign a name
for the archive tag and select the process tag that is to be archived. You determine the type
of archiving by editing the properties of the archive tag.

Requirement
● A process value archive is configured.
● Tags whose values are to be archived have been configured.

Creating the archive tag

1. Select the folder of the process value archive in which you want to create the archive tag
in the navigation area.
2. Select the "Tags" tab in the table area.
3. Click in the top empty row of the "Process tag" column in the table area and then on
The dialog for tag selection opens.

.

4. Select the tag whose values are to be saved in the archive tag.
5. Close the dialog by clicking "OK".
The archive tag has been created. It receives the name of the process value tag. You can
change this name.
The "Tag type" column indicates if the tag is a binary or an analog tag.
6. Now edit the properties of the archive tag.
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6.4.6.3

How to configure the properties of an archive tag

Type of archiving
The properties of the archive tag determine how and how often the process values are archived.
Note
The properties of a tag take precedence over properties of the process value archive with
the same name.

Editing properties
1. Select the folder of the archive in which the archive tag is saved in the navigation view.
2. Select the "Tags" tab in the table area.
3. Select the row with the tag whose properties you wish to edit in the table area.
4. Edit the properties in the "Properties" area.
Note
You can also edit the properties in the table area. However, individual columns may be hidden
in the table area. The table area lets you edit several entries at once. Read the general
information on editing in the section "The WinCC Configuration Studio (Page 52)".
Note
If you change the acquisition method for archive tags in Runtime, from "cyclic" to "acyclic",
for example, archiving of these archive tags will be stopped. After deactivation and
reactivation of Runtime, archiving is resumed with the modified settings.

6.4.6.4

How to Create a Process-Controlled Tag

Introduction
For acquisition and archiving of process values that change quickly or of process values from
several measuring points, the values are transmitted from the AS to WinCC via a raw data tag.
Archiving in archive tags takes place via a process-controlled tag by assigning the raw data
tags to the archive tag.

Structure of the Archive Tag Name
When the process-controlled tag is configured, WinCC generates an internal archive tag name.
You can specify an alias in the "Archive tag name" box. If you do not enter an alias, the internal
archive tag name is used for management in the process value archive and addressing the
archive tags in WinCC.
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The structure of the internal archive tag name depends on the selected format DLL. The format
DLL depends on the used PLC.

Procedure

1. Select the folder of the process value archive in which you want to create the archive tag
in the navigation area.
2. Select the "Process-controlled tags" tab in the table area.
3. Click in the top empty line of the "Raw data tag" column in the table area and then on the
button.
The dialog for tag selection opens.
4. Select the tag whose values are to be saved in the archive tag.
5. Close the dialog by clicking "OK".
The archive tag has been created.
6. Now edit the properties of the tag.
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6.4.6.5

How to configure the properties of a process-controlled tag

Type of archiving
Process-controlled tags are archived if the process supplies new values in a raw data tag. Raw
data tags are compiled by a format DLL for archiving in archive tags.
Note
The properties of a tag take precedence over properties of the process value archive with
the same name.
Note
You can also edit the properties in the table area. However, individual columns may be hidden
in the table area. The table area lets you edit several entries at once. Read the general
information on editing in the section "The WinCC Configuration Studio (Page 52)".

Editing properties
1. Select the folder of the archive in which the archive tag is saved in the navigation view.
2. Select the "Process-controlled tags" tab in the table area.
3. Select the row with the tag whose properties you wish to edit in the table area.
4. Edit the properties in the "Properties" area.

6.4.6.6

How to Create a Compressed Tag

Introduction
You create a compressed tag in a previously configured compressed archive. You assign a
name for the compressed tag and select the archive tag that is to be saved in compressed
form. You determine the type of compression by editing the properties of the compressed tag.

Requirement
● Process value archives with archive tags are available.
● A compressed archive has been created.
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Procedure

1. Select the folder of the compressed archive in which you want to create the compressed
tag in the navigation area.
2. Click in the top empty line of the "Source tag" column in the table area and then on the
button.
The dialog for tag selection opens.
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3. Click on the entry of an archive.
All archive tags saved in the archive are displayed.

4. Select the tag whose values are to be saved in the compressed tag.
5. Close the dialog by clicking "OK".
The compressed tag is created by assigning a source tag. The name of the compressed
tag is the same as the source tag when it is created.
Edit the name of the compressed tag either in the table area or in the "Properties" area.
6. Edit the properties of the compressed tag in the "Properties" area.

6.4.6.7

How to configure the properties of a compressed tag

Editing properties
Note
The properties of a tag take precedence over properties of the compressed archive with the
same name.
Note
You can also edit the properties in the table area. However, individual columns may be hidden
in the table area. The table area lets you edit several entries at once. Read the general
information on editing in the section "The WinCC Configuration Studio (Page 52)".
1. Select the folder of the archive in which the compressed tag is saved in the navigation view.
2. Select the row with the tag whose properties you wish to edit in the table area.
3. Edit the properties in the "Properties" area.
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6.4.7

Configuring archives

6.4.7.1

Calculating memory requirements

Introduction
The calculation of memory requirements serves as orientation for the archive configuration of
TagLogging Fast and TagLogging Slow.
● TagLogging Fast logs archive tags at a cycle time of less than one minute.
● TagLogging Slow logs archive tags at a cycle time of more than one minute.

Calculating memory requirements
You need information about how many archive tags are logged per second on average.
Formula for general calculation of the memory requirement:
Memory requirement = Number of archive values/s * x bytes * 60 s/min * 60 min/h * 24 h/day
* 31 days/month * y months
x ≙ bytes across all segments
y ≙ time period in months
Standard practice is to specify a daily or weekly period per segment. A segment change at a
rate faster than 1 day has a negative impact on performance.

Example of TagLogging Fast
You are planning on implementing a period of 2 months. You have calculated a mean rate of
750 archive values/s for TagLogging Fast.
● The maximum size for all segment is derived as follows:
– For a memory requirement of 16 bytes per process value:
ca. 60 GB (750 [archive values/s] * 16 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 30 [days/month] * 2 [months])
– For a memory requirement of 6 bytes per process value:
ca. 22 GB (750 [archive values/s] * 6 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 30 [days/month] * 2 [months])
● Daily value per segment:
– For a memory requirement of 16 bytes per process value:
ca. 1 GB (750 [archive values/s] * 16 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 1 [day])
– For a memory requirement of 6 bytes per process value:
ca. 370 MB (750 [archive values/s] * 6 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 1 [day])
Configure your message archives accordingly for the "TagLogging Fast" archive
configuration.
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Example of TagLogging Slow
You are planning on implementing a period of 2 months. You have calculated a mean rate of
100 archive values/s for TagLogging Slow.
● The maximum size for all segment is derived as follows:
– For a memory requirement of 16 bytes per process value:
ca. 8 GB (100 [archive values/s] * 16 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 30 [days/month] * 2 [months])
– For a memory requirement of 6 bytes per process value:
ca. 3 GB (100 [archive values/s] * 6 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day] *
30 [days/month] * 2 [months])
● Daily value per segment:
– For a memory requirement of 16 bytes per process value:
ca. 130 MB (100 [archive values/s] * 16 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/
day] * 1 [day])
– For a memory requirement of 6 bytes per process value:
ca. 50 MB (100 [archive values/s] * 6 [bytes/value] * 60 [s/min] * 60 [min/h] * 24 [h/day]
* 1 [day])
Configure your message archives accordingly for the "TagLogging Slow" archive configuration.

6.4.7.2

How to Configure Archive

Introduction
You configure the two archive types "TagLogging Fast" and "TagLogging Slow".
● TagLogging Fast archives archive tags with a cycle time of less than or equal to one minute.
● TagLogging Slow logs archive tags at a cycle time of more than one minute.
You can adapt this setting to suit your needs.
Note
The archive size is not to exceed the available memory. The archive manager does not check
the selected settings for plausibility. A high number of linked database segments can lead to
waiting times when starting and ending Runtime.
Note
If you modify the time range under Archiving size in Runtime, the modification does not take
effect until the next segment change.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1359

Archiving Process Values
6.4 Configuration of Process Value Archiving

Procedure

1. Select the "Archives" folder in the navigation area.
2. Select "Archive configuration" > "TagLogging Fast" > "Properties" in the shortcut menu.
The "TagLogging Fast" dialog is opened:

3. Make the following settings for the archives:
– Time period across all segments and their maximum size.
This specification defines the size of the archive database. If one of the criteria is
exceeded, a new segment is started and the oldest segment is deleted.
– The time period in which process values are to be archived in an individual segment
and its maximum size.
If either of these criteria is violated, a new individual segment is started. When the
criterion for "Time period of all segments" is exceeded, the oldest individual segment is
also deleted.
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4. Enter the following under "Time of segment change":
– Start date and start time for the first segment change.
5. Click "OK" to confirm your entries.

Example
In the above screen shot, the segment changes for the first time on April 22 2014 at 06:54.
The next time-related segment change occurs at the configured time in the cycle defined in
"Time period covered by a single segment". The segment is also changed when the configured
size of all segments and one single segment is exceeded. The oldest single segment is only
deleted if the configured size of all segments or the time period of all segments has been
exceeded.

Changing the archive type
The cycle time of archive tags must not be changed in Runtime to exceed the aforementioned
limits. The change of an archive tag from "TagLogging Fast" to "TagLogging Slow" and vice
versa is not possible in Runtime.
If you save tags in a different archive type following a cycle change or reconfiguration, the tags
are read from the valid archive. Previous archive values of this tag are not accessible in
Runtime.
If tags are no longer archived in "Tag Logging Fast" but in "Tag Logging Slow" after a change,
the size of the databases required for these tags may increase considerably.
Note
Runtime data in archives are deleted during a reset in the archive configuration of Tag
Logging. Only previously swapped-out databases remain intact.

6.4.7.3

How to Assign Archive Tags to Archive Types

Introduction
Process value archiving uses the archive types "TagLogging Fast" and "TagLogging Slow" to
save data.
Archive tags are automatically assigned to the respective archive type by WinCC.
You can make global changes for both types of archive.
In Runtime, the setting is not applied until the project is deactivated and runtime is restarted.
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Procedure

1. Select the "Archives" folder in the navigation area.
2. Select "Archive configuration" > "TagLogging Fast" > "Properties" in the shortcut menu.
The "TagLogging Fast" dialog is opened:
3. Click the "Archive Contents" tab.
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4. Select the options that you want to specify as conditions for archiving of archive tags in
TagLogging Fast:
– acyclic archiving for event-controlled acquisition of process values.
– cyclic archiving of the process values with an archiving cycle less than or equal to a
specified limit.
– compressed measured values with an archiving cycle less than or equal to a specified
limit.
– Process-controlled measured values
5. Enter a value for the upper limit of the archiving cycle for cyclical and compressed measured
values.
Result
All archive tags to which these settings apply are archived in the "Tag Logging Fast" archive.
The archive tags to which these settings do not apply are archived in the "Tag Logging Slow"
archive.

6.4.8

Archive backup

6.4.8.1

How to Configure an Archive Backup

Introduction
Create regular backups of your archive data to ensure seamless documentation of your
process.
Note
Starting the backup
The backup normally starts 15 minutes after the first time-related segment change.
If the start of backup and start of segment should be synchronous with the start of Runtime,
define the start time for the segment change prior to the start of Runtime.
Changing archived process value in Runtime
You can change the displayed process value in runtime using Online Table Control.
If the location of the archive segment where the process value is stored has already been
changed, then the modified value is not accepted in the shifted archive. The changed process
value is only stored in the local archive segment.
If the archive segment has not yet been moved out, then the changed value is accepted
permanently.
Backup behavior with redundant system
Only the current master server swaps out to a local drive.
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Procedure

1. Select the "Archives" folder in the navigation area.
2. Select "Archive configuration" > "TagLogging Fast" / "TagLogging Slow" > "Properties" in
the shortcut menu.
The "TagLogging ..." dialog is opened:
3. Click the "Backup Configuration" tab.
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4. Activate the "Signing activated" option if the archive backup files are supposed to contain
a signature. Upon reconnection with WinCC, the signature allows the system to determine
whether the archive backup file was changed after its swap-out.
5. Select the "Activate backup" option, if the archived data are to be backed up. In addition,
select the "Backup to both paths" option, if the archived data are to be saved in both
directories, "Destination path" and "Alternative destination path".
6. Enter the destination path in which the backup files are to be stored. Network paths are
also permitted as destination paths. The "Alternative destination path" is used in the
following cases, for example:
– The storage space of a backup medium is full.
– The original destination path is not available, for example, due to a network failure.
After the corresponding system messages have been configured, the messages are
output if the specified destination path is not available.
7. Click "OK" to confirm your entries.
Result
The archive backup is stored in the specified destination path.

Structure of the Archive Backup File
An archive backup consists of two files, with the extensions LDF and MDF. To transfer an
archive backup to another computer, for example, copy the corresponding LDF and MDF files.
The file name is as follows:
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type is
defined by the archive type:
● TLG_F: "Tag Logging Fast" process value archive
● TLG_S: "Tag Logging Slow" process value archive
The time period is specified in the following format: yyyymmddhhmm, e.g., 200212021118 (for
December 2, 2002, 11:18 AM). Underscores ("_") in the project name are displayed as "#".

Signing Off of Archive Backup Files
If signing and backup are activated, each archive backup file is signed off when swapped out.
It is thus possible to determine upon reconnection of the file with WinCC whether or not the
file has been changed after swapping.
If you use archive signing-off, the maximum size of a single segment may not exceed 200 MB.
In order to verify the data, the "Signing activated" check box must be selected. Longer
verification times result from connecting "Tag Logging Slow" archives. The "Link archive" menu
entry is gray-shaded for the duration of the connection.
For archiving of signed-off data, the following values apply:
Archiving of signed-off data in Runtime

Values/second

Archiving in database for server/single user ("Tag Logging Fast")

1,000

Archiving in database for central archive server (Logging Fast Tag)

5,000
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Archiving of signed-off data in Runtime

Values/second

Archiving in database for server/single user ("Tag Logging Slow")

5001)

Archiving in database for central archive server (Logging Slow Tag)

5001)

For Tag Logging Slow you must expect longer picture selection times for identical quantity
structures than with Tag Logging Fast.

1)

Note
There may be no segment change while you deactivate signing, for example, to establish a
fast connection to the backup files. You must activate signing once again after the connection
is made so that the data to be archived is signed.

6.4.8.2

How to Link an Archive Backup

Introduction
Connect the database files once again with the project to access an archive backup in runtime.
You can link an archive using the Tag Logging editor and WinCC Controls or have the
connection created automatically.

Requirement
● The LDF file and MDF file of the archive backup are in a local directory on the configuration
computer, for example, on the hard drive.
● The project is loaded on the configuration computer and is located in Runtime.
● You can only link the archive files on the server. How you start an action on the server from
a client with a script, is described in the section "Example: How to start an action on the
server (Logging object)".

Displaying the Process Values in Runtime
The archived process values are inserted in runtime in the configured display according to the
time stamp.

Alternative access options to backups
You can use OLE-DB or DataMonitor Web Edition to directly access the long-time archive
server.
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Link archive

1. Select the "Archives" folder in the navigation area.
2. Select "Archive configuration" > "TagLogging Fast" / "TagLogging Slow" > "Link archive"
in the shortcut menu.
The dialog for selecting a file is displayed.
3. Select the database file and click "Open".
The database file is connected with the project. The process values can be displayed
directly in Runtime.
If signing off is activated and you link a modified or unsigned archive backup file to the project,
you must acknowledge the link to these files, as the archive backup files are otherwise not
linked. A WinCC system message is generated and an entry is added to the Windows event
log in the "Application" section.
Longer verification times result from connecting "Tag Logging Slow" archives. The "Link
archive" menu entry is gray-shaded for the duration of the connection.

Linking the archive with WinCC AlarmControl
1. Click

in the WinCC AlarmControl toolbar.

2. In the dialog use the "..." button to navigate to the path in which the backup files are located.
3. Select the required backup file under "Backups" and click "OK".
The database file is connected with the project. The process values can be displayed
directly in Runtime.

Automatic Linking to an Archive
1. Add the archive backup files to the "ProjectName\CommonArchiving" directory.
2. In Runtime, the process value archive is automatically linked to the project.
If signing off has been activated, modified, signed-off archive backup files are not automatically
linked. A WinCC system message is generated and an entry is added to the Windows event
log in the "Application" section.
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Linking an Archive Using a Script
You can link the archive backup files with the WinCC project by using a script via the VBS
object "DataLogs". The archive segments are then copied with the "Restore method" to the
common archiving directory of the Runtime project. You can find more information under
"DataLogs VBS Object" and "VBS Method 'Restore'".

6.4.8.3

How to Disconnect an Archive Backup

Introduction
If you no longer wish to access the data in an archive backup during Runtime, disconnect the
database files from the project.
You can disconnect an archive with the Tag Logging editor or WinCC Controls. You must
delete connected archives from the "Project name\CommonArchiving" directory or have it
removed by a script with the VBS object "DataLogs".

Requirement
● Archive backup files are linked.
● The project is loaded on the configuration computer and is located in Runtime.
● You can only disconnect linked archive files on the server. How you start an action on the
server from a client with a script, is described in the section "Example: How to start an action
on the server (Logging object)".

Disconnect from archive
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1. Select the "Archives" folder in the navigation area
2. Select "Archive configuration" > "TagLogging Fast" / "TagLogging Slow" > "Disconnect from
archive" in the shortcut menu.
The dialog for selecting a file is displayed.
3. Select the database file and click "Open".
The link to the archive file is disconnected. You will no longer have access to the archived
process values in Runtime.

Disconnecting the archive with a WinCC control
1. Click

on the WinCC Control toolbar.

2. Select the required archive file in the dialog and click "OK".
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6.5

Output of Process Values

6.5.1

Output of Process Values

Introduction
You can output process values in process displays and as a report. You can also directly
access the archive database via various interfaces.

Process Value Output in Process Pictures
In Runtime you can output process values in tabular form or as trends. To do this you can load
process values from the archive database or monitor the running process directly.

Process Value Output in Reports
You can print out process values from the archive database as a report. You can also choose
between tabular and graphic output format. In the Report Designer, both output forms are
available as predefined layouts.

Direct Access to the Archive Database
--

See also
Process value output in reports (Page 1504)
Configuration of Process Value Archiving (Page 1339)
Basics of Process Values Archiving (Page 1306)

1370

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values

6.5.2

Process Value Output in Process Pictures

6.5.2.1

Process value output in process pictures

Introduction
You have the option to display archived and current process values in Runtime. WinCC
provides three ActiveX controls that you insert as table windows or trend windows in a process
picture for this.
Note
Maximum data sizes with OnlineTableControl and OnlineTrendControl
The maximum amount of data sent by the Tag Logging server to the controls is 134,217,728
bytes.
When a process value includes 20 bytes, approximately 6.7 million values can be displayed
in the OnlineTableControl or exported to a ".csv" file.
Long screen opening times with OnlineTableControl and OnlineTrendControl
If you link a large number of archives to the project at the start of Runtime, it may take longer
to open and update pictures by means of OnlineTableControl and OnlineTrendControl.

Process Value Output in a Table
To display process values in table format in Runtime, use the WinCC OnlineTableControl. You
can connect the values in the table with archive tags or process tags.
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Process value output in trends
To display process values in trend format in Runtime, use the WinCC OnlineTrendControl.
You can connect the values in the trend with archive tags or process tags.

Process value output as a function of another tag in trends
To output process values as a function of another tag, use the WinCC FunctionTrendControl.
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6.5.2.2

Process Value Output in Table Format

WinCC OnlineTableControl
Overview
Current process values or archived values are displayed in a table with WinCC
OnlineTableControl. The process data is represented in online tags, archive values in archive
tags.
You can arrange the display of the table as you wish.
You can create statistics from them in runtime or you can export the data for further processing.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)

Configuring the OnlineTableControl
How to configure the OnlineTableControl:
Introduction
The values in the table are shown in runtime in an ActiveX control. You can configure a WinCC
OnlineTableControl for this in the Graphics Designer.

Configuration steps
1. Link the WinCC OnlineTableControl to a Graphics Designer picture.
2. Configure the basic properties for the OnlineTableControl on the "General" tab.
3. Configure one or more time columns with the time ranges for the table.
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4. Configure one or more value columns. Assign time columns to the value columns. Every
value column configured must be connected with an online tag or archive tag. Define the
data connection for each value column. Specify the color for limit violations for each value
column as required.
5. Configure the display and properties of the table on the "Parameter", "Display" and "Marker"
tabs.
6. Configure the toolbar and status bar of the table window.
7. If you want to show the statistics values, configure a statistics window as well. Connect the
statistics window with the OnlineTableControl.
8. Save the configurations.

How to configure the time columns for the table
Introduction
You configure the time range in the table display with time columns. A table can have separate
time columns for several value columns or a common time column.

Time range of a table
Basically, there are two different time references in the table:
● Static display. The time range of the table is determined by a pre-defined, fixed time interval,
independent of the current system time.

● Dynamic display. The time range of the table is determined retrospectively from the most
current values. The display is continuously updated. The configured time range follows the
current system time.

You have three different ways to define the time range of a time column for each of the two
time references:

1374

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values
● The table values are displayed within a defined time interval. You define a start time and
an end time. In a dynamic display, the end time corresponds with the current system time.
The time difference between the start time and the end time is the time range for the table.
● The table values are displayed from a start time throughout a defined time range, e.g. 30
minutes from the start time. In the dynamic display, the defined time range up to the current
system time is used, e.g. 30 minutes to the current system time.
● Starting from a start time, a defined number of values are shown, e.g. 100 values from the
start time. With the dynamic display, the last values up to the current system time are shown.
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Requirement
● You have opened the picture with the WinCC OnlineTableControl in the Graphics Designer.

Procedure
1. Define one or more time columns with the "New" button on the "Time columns" tab. The
sequence in the list determines the arrangement of the columns in the table.

2. If you do not want to show a time column in the table, deactivate the time column by clicking
on the checkbox in front of the name in the list. During runtime, you can show it again by
activating the time column in the table.
3. Configure the properties and the formats for time and date for every time column.
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4. Configure a time range for every time column. If you want a dynamic display, activate the
"Update started" option on the "General" tab.
5. Set the time range:
– If you want to define a fixed time interval, select setting "Start to end time" Enter the
date and time for each.
– If you want to define a time period, select the setting "Time range". Define the date and
time for the start time. The time range is the result of a multiplication of the "Factor" and
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and
the time unit in the "Time range" field.
– If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.
6. Save the configuration.
Note
Upon starting Runtime the values to be displayed are either read from the archive or are
set to zero. Define whether the update will start upon opening the picture on the "General"
tab.

How to configure the value columns for the table
Introduction
You can display several value columns in a table. Every value column is connected with a time
column. The value columns can have a common time column.

Requirement
● You have opened the picture with the WinCC OnlineTableControl in the Graphics Designer.
● You have defined time columns.
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Procedure
1. Define one or more value columns with the "New" button on the "Value columns" tab. The
sequence in the list determines the arrangement of the value columns in the table relative
to the assigned time axis.

2. Assign time columns that have been configured already to the value columns. If more than
one value column is to use a common time column, assign the same time column to these
value columns.
3. If you do not want to show a value column in the table, deactivate the value column by
clicking on the check box in front of the name in the list. You can use key function "Column
On/Off/Move" in runtime to display the value column in the table again.
4. Configure the properties and the display for each value column.
5. Define the data source for each value column. Your options are:
– Data source with archive tags of a process value archive
– Data source with online tags from the tag management
6. Click on
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7. Configure the representation of the value columns.
8. Save the configuration.

Configuring colors for limit value violation
1. Click the "Limit values" button if you want limit value violations in a value column to be
highlighted in color. This will open the "Limit values" dialog.

2. Select "Use" for the limit values for which you want color identification.
3. Set the limit value, the background color for the cell and the font color for each limit value
monitoring function.
4. Color identification has the following effect:
– Low limit value. Whenever a table value displayed is less than the value defined in the
"Value" input field, the value and the cell are shown in the configured color. The same
applies for the second low limit value.
– High limit value. Whenever a table value displayed is greater than the value defined in
the "Value" input field, the value and the cell are shown in the configured color. The
same applies for the second high limit value.
– Value with uncertain status. Values whose start value is unknown when runtime is
activated, or for which a substitute value is used, have an uncertain status. These values
are displayed in the configured colors.
5. Save the configuration.
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How to configure the display for the table
How to configure the properties of the table elements
Introduction
You can adjust the properties of the table elements in the WinCC controls to suit requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameter" tab.

2. Specify the properties for
– Column Header
– Row label
– Sorting
– Table Content
3. Save the configuration.
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How to configure the colors of the table elements
Introduction
You can adjust the colors of the table elements in the WinCC controls to suit requirements.

Requirement
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Effects" tab.

2. Define the colors for the background or text here for:
– Table content. You can define different colors for even and odd line numbers to improve
differentiation between both.
– Contents of the table header
– Separating lines in the table and for table headers
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3. Define the color and the line weight in the "General" area in terms of:
– Control borders
– Window dividers for control elements
4. Save the configuration.

How to configure the marking of the selected cells and lines
Introduction
You can customize the marking of the selected cells and rows in the WinCC control to suit
requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Selection" tab.

2. Define whether to select rows or only cells using the mouse.
3. Configure the properties of the selection rectangle that can be displayed around selected
table cells or rows.
4. Configure the marking color for selectable cells and/or rows. The system colors are used
for marking with "Automatic coloring" property.
5. Save the configuration.
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How to configure sorting via the column heading
Introduction
You can adjust the sorting order by means of table column header in the WinCC controls to
suit requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameter" tab.

2. Define whether to enable sorting and the sorting method by column header. In WinCC
AlarmControl, you can only sort by column header if the "Auto-scrolling" is disabled. You
can deactivate "Auto-scrolling" either in the "General" tab, or using the "Autoscroll" toolbar
icon of the WinCC AlarmControl.
3. Determine the sorting order by mouse click on the column header. Select ascending,
descending or no sorting order.
4. Configure the sorting icon and index to be displayed in the column header with right
justification. These show the sorting order and sequence of the columns.
5. Activate the "Use sorting key" to display the sorting icon as sorting button above the vertical
scroll bar. Click this sorting key to activate a configured sorting order for the column
selected. The sorting key is not displayed if a vertical scroll bar is missing.
6. Save the configuration.
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How to configure the toolbar and the status bar
Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The
status bar contains information pertaining to the current status of the WinCC control. You can
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The WinCC control is assigned the "Configuration dialog" button function for opening the
configuration dialog in Runtime.
● The configuration dialog of the WinCC control is open.
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How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in
Runtime. For information on the button functions, refer to the description of the
corresponding WinCC control at "Operation in runtime".
3. Determine the sorting order for displaying the button functions in the toolbar. Select the
button functions from the list and the move the functions using the "Up" and "Down" buttons.
4. Define a shortcut key for the functions of the toolbar buttons.
5. Any button functions assigned operator authorizations are only available in Runtime to
authorized users.
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6. An activated button function is displayed during runtime if you deactivate its "Active" option,
however, it cannot be operated.
7. You can set separators between the button functions. Activate the "Separator" option for
the button function to be restricted by separator.
8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status Bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required during runtime in the list of status bar elements. For further
information on status bar elements, refer to the descriptions of the corresponding WinCC
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements
from the list and move these using the "Up" and "Down" buttons.
4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a
pixel value for the width.
5. Configure the general properties of the status bar, e.g. alignment or background color.

How to configure the Ruler window/Statistics window/Statistics area window
Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a
statistics area window. The ruler window/statistics window/statistics area window are
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:
● WinCC OnlineTrendControl
● WinCC OnlineTableControl
● WinCC FunctionTrendControl
Depending on the data evaluation, there are three different types of windows for displaying
values. The following window types are available:
● The ruler window displays the coordinate values of trends on the ruler.
● The statistics area window shows the values of the lower limit and upper limit of the trends
between two rulers or the selected area in the table. The statistics area window is not
planned for the WinCC FunctionTrendControl.
● The statistics window shows the statistic evaluation of the trends between two rulers or the
selected values in the table. The statistics window is not planned for the WinCC
FunctionTrendControl.
All windows can also display additional information on the connected trends or columns.
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Requirement
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or
FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.
2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.
4. Go to the "General" tab in the field "Source" and select the object name of the control that
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be
operated in runtime, you can change the window type in runtime.
6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the
assigned control. Columns for the basic data and columns that are only for the selected
window type or the assigned control are available. Define the column sequence with buttons
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected
columns, click on the respective blocks.
9. If a special format exists for a block, you can configure the format of the block. Deactivate
the option "Apply from source" if the format settings of the connected control are not to
apply in this case. Define the desired format.
10.Define whether the data for the column and the column heading is to be displays as text or
as an icon in the table under "Display".
11.Save the configuration.

1390

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values
12.Configure the properties and the display of the table for the RulerControl in the "Parameter,"
"Effects" and "Selection" tabs.
For details on configuring the table display, please refer to "Configuration of
OnlineTableControl > How to configure the table display" in the WinCC OnlineTableControl
documentation.
13.You can export the evaluated data. This requires activating the "Export data" key function
on the "Toolbar" tab.
For details on data export, please refer to "Configuration of OnlineTableControl > How to
export runtime data" in the WinCC OnlineTableControl documentation.
14.Configuring the TrendRulerControl is possible in runtime.
For more detailed information, please refer to "Configuration of OnlineTableControl > How
to apply online configuration" in the WinCC OnlineTableControl documentation.

See also
How to define the effect of the online configuration (Page 1395)
How to export runtime data (Page 1393)
How to configure the display for the table (Page 1380)

How to configure operator input messages for archive value changes
Introduction
You can specify that operator input messages are to be triggered when an archive value is
changed or create manually in runtime. You will need to configure corresponding operator
input messages.
An operator input message can display the following information on manual input of an archive
value:
● Time stamp
● Old value
● New value
● Archive tag

Requirement
● You have opened the Graphics Designer and configured a picture with WinCC
OnlineTableControl.
● The configuration dialog of OnlineTableControl is open.
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Procedure
1. Go to the "Operator input messages" tab.

2. In the list, activate "Operator input messages for:" the events which trigger operator input
messages.
3. If you are not using the WinCC operator input messages, enter the message number of the
configured message for each event.
4. Assign the required information on manual input to the process value blocks of the operator
input message.
5. Specify whether the contents are to be transferred as a text or value.
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Example
You want an operator input message with the name of the archive tags and the new value to
be generated when an archive value is changed.
1. Select "Change archive value".
2. The name of the archive tag will be displayed in "Process value block 1" of the operator
input message. Select "Archive tag" as source under process value "1". Select "Text" under
"Transfer as:".
3. The new value will be displayed in "Process value block 2" of the operator input message.
Select "New value" as source under process value "2". Select "Value" under "Transfer as:".

Result
The relevant information on manual input will now be displayed in the configured process value
blocks of the operator input message.
Note
Operator input messages can only be archived if corresponding system messages have been
created in the message archive.

How to export runtime data
Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set
up operation of the data export during runtime in the configuration dialog.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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How to configure the operation of the data export
1. Go to the "Export" tab.

2. A standard file name and a standard directory are already entered in the "Data export default
settings". In this case for AlarmControl. If necessary, define a file name and a directory for
the export file.
The file name can be made up of the freely defined name and the following placeholder:
@OBJECTNAME - Object name of the controls
@CURRENTDATE - Current date
@CURRENTTIME - Current time
3. CSV is currently available as data format. Click
in the CSV file.

to specify the delimiter and data format

4. Define the scope of the data export:
– All runtime data is exported
– Selected runtime data is exported. This data export is only possible in WinCC controls
with tabular display.
5. Configure the operation of the data export during runtime. Define:
– whether users are allowed to rename the file, or change the directory.
– whether to display the "Data export default settings" dialog in Runtime.
6. If "Show dialog" is deactivated, the data for operation of the "Export data" button function
is immediately exported to the defined export file.
7. Save the configuration.
8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results
You can export all or selected data to a defined file at runtime using the
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How to define the effect of the online configuration
Introduction
Users can parameterize the WinCC controls in Runtime. You must define the Runtime effects
of the online configuration.
Changes configured in Runtime are saved for the specific user separately from the picture in
the configuration system. The original picture configuration is retained in the configuration
system.
Note
The picture is also replaced at Runtime if you save it in Graphics Designer, or when loading
deltas in online mode. All online changes are lost.
The different configurations are only activated for new users after you performed a picture
change.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1395

Archiving Process Values
6.5 Output of Process Values

Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults
are only available in the configuration system. The option buttons are not available in
Runtime.
Select one of the three effects of the online configuration:
– "Do not retain". The online configurations are not retained in Runtime. This default
setting disables all options for Runtime users. Online configurations are lost at the next
picture change and on activation/deactivation of the project.
– "Retain during Runtime". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the
project.
– "Retain permanently". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
and on activation/deactivation of the project if the "retain" option is enabled.
3. Define corresponding user authorizations for online configuration.
4. The option buttons of the "Online configuration on next picture change" can be enabled for
operation in the configuration system and at Runtime by setting the "retain at Runtime" and
"retain permanently" defaults. The "reset" operation is only available in Runtime, because
the configuration system contains the original configuration.
Select one of three effects of the online configuration at the next picture change:
– Select "discard" if to discard the online configuration at the next picture change.
– Activate "retain" to activate the online configuration based on default settings at the next
picture change or on activation/deactivation of the project.
– Activate "Reset" if you want to apply the picture saved in the configuration system in
Runtime. All online changes are lost.
5. Save the configuration.

How to make the toolbar for the OnlineTableControl dynamic
Introduction
The default functions for operating the WinCC OnlineTableControl are no longer supported for
the new WinCC OnlineTableControl as of WinCC V7.0. You can use the WinCC types of
dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC Controls as of V7.0 you do not need special functions to implement operation of
the control by assigning dynamic properties to the toolbar. The previously used standard
functions "TlgTableWindowPress..." are no longer supported.
If you do not want to operate the control via the toolbar, you can write the "ID" for the desired
button in the "ToolbarButtonClick" object property with an optional type of dynamics.
The "ID" of a button of the toolbar can be determined:
● with the table on page "Operation of the OnlineTableControl in Runtime".
● in the configuration dialog of the OnlineTableControl on the "Toolbars" tab via field "Object
ID".
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Example: Opening the control configuration dialog
The following options of assigning dynamic properties are available for opening the control
configuration dialog:
● VBScript:
– ScreenItems("Control1").ToolbarButtonClick = 2
– As an alternative to the "ToolbarButtonClick" property, you can use the VBS methods
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog
– Or, with the following notation and support of "Intellisense":
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog
● C script:
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);
● Direct connection
– In the dialog of the direct connection, enter "2" as a constant for the source.
– Select the property "ToolbarButtonClick" for the object "Control1" for the target "Object
in picture".

See also
Operating the OnlineTableControl in runtime (Page 1398)

Operation in Runtime
Operating the OnlineTableControl in runtime
Introduction
In Runtime, the table window is operated by means of the toolbar buttons. If you do not want
to operate the table window via the toolbar, you can write the "ID" for the desired button in the
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview
The overview shows all symbols in "standard" style. If you create a design of the controls with
the "Simple" style, the representation of the symbols is the same as with OnlineTableControl
before WinCC V7. You can find an overview on the page "Before WinCC V7: Output process
values as tables in process pictures > Operation in Runtime > Operation of Online Table
Control in Runtime".
Icon

Description

ID

"Help"

1

Calls up the help on WinCC Online TableControl.
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"Configuration dialog"

2

Opens the configuration dialog, in which you can change the properties of
the Online TableControl.
"First Data Record"

3

This button displays the tag trend over time in the table window, starting with
the first archived value and extending over a defined time range. The button
is only available if the values originate from a process value archive.
"Previous Data Record"

4

This button displays the tag trend of the previous time interval in the table
window, starting from the currently displayed time interval. The button is only
available if the values originate from a process value archive.
"Next Data Record"

5

This button displays the tag trend of the following time interval in the table
window, starting from the currently displayed time interval. The button is only
available if the values originate from a process value archive.
"Last Data Record"

6

This button displays the tag trend over time in the table window, ending with
the last archived value and extending over a defined time range. The button
is only available if the values originate from a process value archive.
"Edit"

7

Upon activating this button, you can double-click any table cell to edit its
contents. This requires stopping the updated display.
"Create archive value"

21

This button opens a dialog for entering a new value and a time stamp. You
must first stop the updated display.
"Copy lines"

8

Copies the content of the selected lines to the clipboard. This requires
stopping the updated display.
"Select data connection"

9

This button opens a dialog for the archive selection and tag selection.
"Select columns"

10

This button opens the dialog for toggling the visible and invisible column
view. You can also change the sequence of the columns in the table.
"Select time range"

11

This button opens the dialog where you can specify the time range to be
displayed in a table window.
"Previous column"

12

This button is used to move the value column in front of the previous value
column. The function refers to the value columns that are assigned with a
time axis.
"Next column"

13

This button is used to move the value column in behind of the next value
column. The function refers to the value columns that are assigned with a
time axis.
"Stop"

14

The updated display is stopped. The data is saved to the clipboard and
added to the table when the button is clicked again.
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"Start"

14

Resume updated display.
"Print"

15

Start the print-out of the values shown in the table. The print job used for
printing is defined in the configuration dialog on the "General" tab.
"Export data"

20

This button is used to export all or the selected runtime data into a "CSV"
file. If the option "Display dialog" is active, a dialog opens in which you can
view the settings for exporting and can start the export. You can select the
export file and directory, provided you are granted corresponding
authorizations.
The data is exported immediately to the default file if this dialog is not
displayed.
"Define statistics area"

16

This button is used to define the time range for calculating the statistics in
the table window.
"Calculate Statistics"

17

The button shows the statistical values in the statistics window. The
displayed values refer to a selected column with the configured calculation
time range. The button is only functional if a statistics window is connected
with the OnlineTableControl.
18

"Connect backup"
This button opens a dialog in which you can connect selected archives with
WinCC Runtime.
"Disconnect backup"

19

This button opens a dialog in which you can disconnect selected archives
from WinCC Runtime.
"User-defined 1"

1001

Shows the first key function created by the user. The function of the button
is user-defined.

Possible elements of the status bar
The following elements can appear in the status bar of the table window:

Icon

Name

Description

Connection status

Shows the status of the data connections:
● No faulty connections
● Faulty connections
● All connections are faulty
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Selected Row

Shows the number of the selected line.

Selected column

Shows the number of the selected column.
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Icon

Name

Description

Date

Shows the system date.

Time

Shows the system time.

Time base

Shows the time base used in the display of times.

Double click on the icon for the connection status to open the window "Status of the data
connections", in which the name, status and tag name of the data connection are listed.

Online configuration of the OnlineTableControl
Introduction
In runtime, you can configure online and change the display of the WinCC OnlineTableControl.
Configuring the WinCC OnlineTableControl defines how to proceed with a picture change or
after ending runtime with online configurations.

Overview
The following buttons functions make online configuration possible in OnlineTableControl:
● With key function "Configuration dialog"
● With key function "Select data connection"
● With key function "Select columns"
● With key function "Select time range"

Key function "Configuration dialog"
Use the key function "Configuration dialog"
example to change the display of the table.
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The key function "Select data connection"
to select the archive tags or online tags for
Use the key function "Select data connection"
the value columns which you want to show in the table:

Field

Description

Value column

Choose the configured value column for which you want to change the data
connection.

Data Source

Define whether the selected value column is supplied with an archive tag or online
tag.

Tag name

Select the tag name for the data connection.

The key function "Select column"
The key function "Select column"
opens a dialog for showing or hiding columns. You can
change the sequence of the value columns that are assigned with a time column. The value
columns can only be moved in reference to the anchored time column.
Note
The first column of a table window cannot be hidden.
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The key function "Select time range"
Select the time range to be displayed for the time columns with key function "Select time range"
. If the columns of a table window are to be displayed with a common time axis, the specified
time range applies to all columns.

Field

Description

Time column

Select the configured time column for which you want to define a time range.

time range

Set the time range:
● If you want to define a fixed time interval, select setting "Start to end time". Enter
the date and time for each.
● If you want to define a time period, select the setting "Time range". Define the date
and time for the start time. The length of the time interval to be displayed is
determined by multiplying the "Factor" by the "Time unit".
● If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.

The entry format of the date and time depends on the runtime language used.

Starting and Stopping Update
Introduction
The update of the column in the table window can be started and stopped with the "Start/Stop"
key function.
Certain key functions, e.g. "Define statistics area", stop the update automatically.
The appearance of the button indicates whether the update is stopped or not:
●

: Update has been stopped. Click on the button to continue updating.

●

: Update has been started. Click on the button to stop updating.
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How to edit a table field in runtime
Introduction
You can change archived values and create new values in OnlineTableControl manually with
the key functions "Edit" and "Create archive value". The modified values are marked with a
flag and archived. You can configure operator input messages to be triggered when an archive
value is changed or created.

Requirement
● You have configured an OnlineTableControl.
● You have activated the key function "Edit" or "Create archive value" for the Control toolbar.
● You have enabled manual input for the linked archive or for individual archive tags in the
"Tag Logging" editor.
● You have activated runtime.

Procedure
1. In OnlineTableControl, click on
continues being archived.
2. Click on

. The updated display is stopped, the process data

to change an archive value.

3. Double click on the desired table field of a value column. Change the value of the cell.
4. Click on

to create an archive value. The "Create archive value" dialog will appear.

5. Select a value column linked to an archive. Enter a value and a time stamp. Click the "Create
archive value" button. The system checks whether the value is within the valid range before
adding it.
6. To continue with the display of runtime data in OnlineTableControl, click
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Result
The modified or newly created values are now marked and archived. "m" for manual input is
displayed in the value column. The values in the compressed archives for the relevant time
range will be recalculated provided you have enable recalculation in the "Tag Logging" editor.
A tooltip with detailed information will appear if you right-click on the cell.

See also
How to configure operator input messages for archive value changes (Page 1391)

How to move the columns in the table
Introduction
The time column is always shown in the first column in the table. The value columns that are
assigned with this time column are displayed next. If there are more than one time columns
configured, the second time column follows with the assigned value columns.

How to change the sequence of the columns in runtime
You can change the sequence of the value columns that are assigned with a time column in
runtime. The value columns can only be moved in reference to the anchored time column. The
sequence of the time columns with the assigned value columns must be defined on the "Time
axes" tab.

Requirement
● You have configured key functions "Select columns", "Previous column" and "Next column".

Procedure
●

changes the sequence of the columns in the dialog. Deactivate the check box in front
of the column name if you do not want to display the column.

●

is used to move the value column behind the next value column. The function refers to
the value columns that are assigned with a time axis.

●

is used to move the value column in front of the previous value column. The function
refers to the value columns that are assigned with a time axis.

How to display archived values
Introduction
Use the buttons in the toolbar of a table window or the corresponding key combinations to
browse through an archive.
The values archived for a tag will be displayed within a time interval. You define the time interval:
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● In the configuration dialog of the Online TableControl on the "Time columns" tab.
● During runtime using the

button.

Buttons for Archived Values
The table displays the tag values within a specified time range, beginning with
the first archived value.
The table displays the tag values within the previous time interval, based on the
currently displayed time interval.
The table displays the tag values within the next time interval, based on the
currently displayed time interval.
The table displays the tag values within the specified time interval, ending with
the last archived value.

Note
The WinCC Online Table Control displays a maximum of 1000 values within a selected time
range.

How to Generate Statistics of Runtime Data
Introduction
You can generate an evaluation of runtime process data in the table window. The evaluated
data is shown in a separate WinCC RulerControl.

Overview
Depending on the data evaluation, there are three different types of windows for displaying
values. The following window types are available:
● The ruler window shows the values of a selected line in the table.
● The statistics area window shows the values of the lower limit and upper limit of the selected
area in the table.
● The statistics window shows the statistical evaluation of the selected values in the table.
Among other things, the statistics include:
– Minimum
– Maximum
– Average
– Standard deviation
– Integral

1406

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values
All windows can also show additional information on the values of the connected columns.

Requirement
● You have configured a WinCC OnlineTableControl.
● You have configured a WinCC RulerControl and connected it with the OnlineTableControl.
● You have selected the window in the RulerControl which shows the desired data.
● You have configured key functions "Set statistics range", "Calculate statistics" and "Start/
Stop". If a display of the values in a ruler window is sufficient, you do not need key functions
"Select statistics area" and "Calculate statistics".
● You require key function "Select time range", if you wish to choose a statistics area outside
of the time range displayed in the table.
● You require key function "Configuration dialog" of the RulerControl if you want to switch
between the statistics window and the ruler window.
● You have activated runtime.

How to show the data in a ruler window
1. In OnlineTableControl, click on
continues being archived.

. The updated display is stopped, the process data

2. Select an line. Data in the columns that you have configured is shown in the ruler window.

3. To continue with the display of runtime data in OnlineTableControl, click
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How to display the data in a statistics area window
1. In OnlineTableControl, click on
continues being archived.

. The updated display is stopped, the process data

2. In order to specify the time period for the calculation, use the mouse to select the table lines
for the desired time frame. For different columns with different time frames you can select
different time ranges for the calculation of statistics.

3. Click
in the toolbar. The evaluated data is displayed in the columns that you have
configured in the statistics area window.

4. If you want an evaluation of data that is not displayed in OnlineTableControl, click on
.
Enter the desired time range for the selected time column in the "Time selection" dialog.
The data for the defined time range is displayed. You can now evaluate this data.
5. To continue with the display in OnlineTableControl, click on
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How to display the data in a statistics window
. The updated display will be stopped but the process
1. In OnlineTableControl, click on
data will continue to be archived.
2. Click on
. In order to specify the time period for the calculation, use the mouse to select
the table lines for the desired time frame. For different columns with different time frames
you can select different time ranges for the calculation of statistics.

3. Click on
. The evaluated data is displayed in the columns that you have configured in
the statistics window.

4. If you want an evaluation of process data that is not displayed in OnlineTableControl, click
on
. Enter the desired time range for the selected time column in the "Time selection"
dialog. The process data for the defined time range is displayed. You can now evaluate
this data.
5. To continue with the display in OnlineTableControl, click on

.

Note
For additional statistical analysis of process data and archiving of results you can write
the scripts yourself.
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6.5.2.3

Process Value Output in the Form of Trends in Process Pictures

WinCC OnlineTrendControl
Introduction
In order to process data in graphic form, WinCC uses Online TrendControl to offer the option
of displaying the data as a trend. The trend display can be configured as you wish. The trends
can display currently incoming values and archived values.

Requirement
The following requirements apply to the display of trends in WinCC Online Trend Control:
● In a WinCC Online Trend Control any number of trends can be displayed in one or more
trend windows. Displaying a maximum of 8 trends is recommended.
● In order to display tags as a function of other tags, use the WinCC Function Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen
resolution and selected size of the trend window. Therefore, when displaying trends, it is
possible that fewer values are displayed in the trend window than actually exist.
If, for example, in an area of 100 pixels 200 measured values are archived, each pixel
represents 2 measured values. The value shown on the screen is that of the most recent data
(most recent time stamp).
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Note
If you have selected too large a time for the graph representation and the random access
memory is not sufficient, a message is displayed in the status line in OnlineTrendControl.
Decrease the values to be displayed by using compression archives.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)

Representation Trend Lines
Representation Trend Lines
Introduction
The WinCC OnlineTrendControl has many ways of displaying the progress of a trend.
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Representation formats
Four representation formats are available to display values graphically:
● No trend
The values are shown as dots. The display of the points can be configured as you wish.

● Connect dots linearly
The trend line is interpolated on a linear basis from the point values. The display of the lines
and points can be configured as you wish.

● Stepped trend
The progress of the trend line is determined from the values as a stepped trend. The display
of the lines and points can be configured as you wish.

● Representing values
The values are displayed as text at each time stamp or at every main gridline on the time
axis. A unit can also be displayed in addition to the values.

The display of the trend can be configured on the "Trends" tab of the OnlineTrendControl.

Write direction
With the write direction option, you can specify where the current values for all trend windows
are to be entered. Normally, the current values are written in the trend window from the right.
All four write directions can be configured. The write direction is configured on the "General"
tab of the OnlineTrendControl.
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Representation Using Common Axes
Introduction
When displaying more than one trend in a trend window, you can assign every trend with its
own axes or use a common time axis and/or value axis for all trends.

Representation Using Different Axes
If the values to be displayed in a trend window differ greatly, a common value axis makes no
sense. The values can be read more easily if different axial scales are used. Individual axes
can be hidden if required.
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Representation Using Common Axes
If the comparability of the trend lines is important, common axes in a trend window is sensible.
Connected trend windows can have a common time axis.

Configuring
The axes are configured on the "Value axis" and "Time axis" tabs of OnlineTrendControl. The
assignment of the axes for the trends can be configured on the "Trends" tab. In this case, you
can assign the individual trends to the same axes.
Note
In OnlineTrendControl, only tags with the same update cycles should be displayed for more
than one trend with a common time axis. In the case of different updating cycles, the length
of the time axis is not identical for all tags. Since the trends are updated at different times
due to the different updating cycles, a minimal different in the end time for the time axis occurs
on each change. As a result, the trends displayed skip slightly to and fro on each change.

Configuring the OnlineTrendControl
How to configure the OnlineTrendControl
Introduction
In runtime, the trends are displayed in an ActiveX control. You can configure a WinCC
OnlineTrendControl for this in the Graphics Designer.
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Configuration steps
1. Insert the OnlineTrendControl into a picture of the Graphics Designer.
2. Configure the basic properties for the OnlineTrendControl on the "General" tab:
– the window properties of the control
– the display of the control
– the write direction of the trend values
– the time base of the control
3. Define one or more trend windows.
4. Configure one or more time axes and value axes with their respective properties. Assign
the axes to the trend windows.
5. Define trends that you want to display in the trend windows. Assign the trends to the trend
windows. The value axis of a trend can only be the value axis of the assigned trend window.
Assign the trends with one or more time axes.
6. Every configured trend must be connected with an online tag or an archive tag. Define the
data connection for each trend.
7. Configure the display for each trend.
8. Configure the toolbar and status bar of the trend window.
9. If you want to display coordinates or statistic values, configure a ruler window, statistics
window or statistics area window as well. Connect the ruler window/statistics window/
statistics area window with the OnlineTrendControl.
10.Save the configurations.

How to create trend windows in OnlineTrendControl
Introduction
The WinCC OnlineTrendControl can contain one or more trend windows. The trend window
provides an area to display trends in.

Overview of the trend window
The trend window has the following properties:
● Every trend window is assigned with at least one trend, which has one time axis and one
value axis.
● The value axis of the trend determines the trend window, in which the trend will be displayed.
● A trend can only be assigned to one trend window.
● Several trends can be displayed in a trend window.
● A trend window can display value axes, independent of the displayed trends. Value axes
and time axes can be hidden in runtime.
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● The sequence of the configured trend window is determined by the position in
OnlineTrendControl. The first trend window in the list of trend windows is displayed in the
lower position, the last trend window is shown in the top position.
● If more than one trend window is configured, the trend windows can be connected. The
connected trend windows have the following properties:
– They can have a common time axis.
– They have a scroll bar.
– They have a ruler.
– The zoom functions for a trend window affect the connected trend windows.
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Procedure
1. Define one or more trend windows with the "New" button on the "trend windows" tab.

2. If you have defined more than one trend window, more configurations are possible:
– Assign every trend window with an area selection in the displayed OnlineTrendControl.
– Define the position of the trend windows with the "Up" and "Down" buttons.
– Define whether the trend window will be connected on the "General" tab.
3. If you want to hide a trend window in runtime, deactivate the checkbox in front of the name
of the trend window in the list. The respective axes are then hidden as well.
4. Configure the gridlines for every trend window.
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5. Configure the display of the ruler. If you want to use a statistics area window, configure the
ruler that will be used with the statistics area as well.
6. If you use "Graphic" for the display of the ruler, you can configure the color and the line
weight of the ruler.
7. Define the level on which to display the ruler in the trend window.
8. Save the configuration.

How to configure the time axes of trend windows
Introduction
The time range for trend display is configured with time axes. Several time axes can be
assigned with one or more trend windows. Connected trend windows may have a common
time axis.

Time range of the trend display
Basically, there are two different time references in the trend display:
● Static display. The time range of the trend display is determined by a pre-defined, fixed
time interval, independent of the current system time.

● Dynamic display. The time range of the trend display is determined retrospectively from the
most current values. The display is continuously updated. The configured time range follows
the current system time.

You have three different ways to define the time range of a time range for each of the two time
references:
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● The trend is displayed within a defined time interval. You define a start time and an end
time. In a dynamic display, the end time corresponds with the current system time. The
time between the start time and the end time is the time range for the trend display.
● The trend is displayed from a start time throughout a defined time range, e.g. 30 minutes
from the start time. In the dynamic display, the defined time range up to the current system
time is used, e.g. 30 minutes to the current system time.
● Starting from a start time, a defined number of values are shown, e.g. 100 values from the
start time. With the dynamic display, the last values up to the current system time are shown.

Requirement
● You have opened a picture with the OnlineTrendControl in the Graphics Designer.
● You have defined one or more trend windows.
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Procedure
1. Define one or more time axes with the "New" button on the "Time axes" tab.

2. Define the positioning of the configured time axes for a trend window. The sequence in the
list of time axes determines the positioning in the trend window. If several time axes are
arranged on the same page of a trend window, the first time axis in the list assumes the
position in the bottom left and the last time axis in the list then assumes the position at the
top right.
3. Assign the time axes to the configured trend windows.
4. If you want to hide a time axis in the trend window, click on the checkbox in front of the
name of the time axis in the list. You can display the axes again in runtime with the key
functions.
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5. Configure the properties and the formats for time and date for every time axis.
6. If the trends in the trend window assigned to the time axis are always updated, activate the
"Update" option. If you e.g. want to compare a current trend display with an earlier trend
display, deactivate the "Update" option for the time axis of the comparison trend.
7. Configure the time range for every time axis:
– If you want to define a fixed time interval, select setting "Start to end time". Enter the
date and time for each.
– If you want to define a time period, select the setting "Time range". Define the date and
time for the start time. The time range is the result of a multiplication of the "Factor" and
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and
the time unit in the "Time range" field.
– If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.
8. Save the configuration.
Note
Upon opening the picture of a trend window in runtime, the trend values to be displayed
are either read from the archive or are set to zero. Define what is to be done via the "Load
archive data" option on the "General" tab.

How to configure the value axes of trend windows
Introduction
You can configure several value axes that you will assign to one or more trend windows.
Configure the value range and the scaling for every value axis.
If you have defined a value axis, the value range and the scaling are pre-configured as follows:
● The value range is based on the current values of the assigned trend.
● The value axis scale is linear to the value range.

Requirement
● You have opened the picture with the OnlineTrendControl in the Graphics Designer.
● You have defined trend windows.
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Procedure
1. Define one or more value axes with the "New" button on the "value axes" tab.

2. Assign the value axes to the configured trend windows.
3. If you want to hide a value axis in the trend window, click on the checkbox in front of the
name of the value axis in the list. You can display the value axes again in runtime with the
key functions.
4. Configure the orientation and the scaling for every value axis.
5. Configure the display of the value axis in trend windows.
6. Deactivate the "Automatic" option in "Value range" if you want to define a fixed value range
for the value axis.
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7. In the "From:" and "To:" input fields enter the minimum and maximum value of the value
range.
8. If you want to define the scaling of the value axis yourself, activate the "Use" option in field
to open the "User scaling" dialog.
"User scaling". Click on
9. Click "Add" to define an area. You must define segments without gaps for the entire
configured value range and assign areas on the value axis. If you have defined a value
range of "0 - 100000" you can divide this value range e.g. into three sections that you can
display as follows on the value axis:

E.g. value range "0 - 50000" is displayed in runtime on the value axis in the "100 - 500"
range.
10.In a ruler window, the key function "Ruler" displays e.g. measurement values. You can have
a name shown as well in the "Y value" of the ruler window next to the measurement value
and the status display "i" and "u". Area names can be assigned for certain value ranges.
11.If you want to display area names, activate the "Display" option in the "Area names" field.
Click on
to open the "Area names" dialog.
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12.Click "Add" to define ranges with the respective names.

13.Save the configuration for the value axis.

How to create trends for the trend window
Introduction
Every trend is assigned with a time axis and a value axis. The value axis assigned to the trend
determines the trend window, in which the trend will be displayed.

Requirement
● You have inserted the OnlineTrendControl into a picture of the Graphics Designer.
● You have configured time axes, value axes and trend windows.
● The following prerequisites apply for the data source:
– If you want to connect data of online tags, you have to have defined process values in
the tag management.
– If you want to connect the data from archive tags, you have to have configured a process
value archive with archive tags.
– If you want to supply the trend values with data in runtime with scripts, you require a
script via the API interface.
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Procedure
1. Go to the "Trends" tab.

2. Use the "New" button to define the desired number of trends.
3. Define the sequence of trends in the trend window using "Up" and "Down" keys.
4. Assign each trend of trend window with a time axis and a value axis.
5. Define the data source for each trend. You can select the following:
– Archive tags of a process value archive
– Online tags from the tag management
– No configured data source to establish a connection in runtime via a script.
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6. Click on

to select a tag for the trend.

7. Configure the value range for the data in which the trend will be displayed. Click the
button in the "Data connection" field. The dialog "Automatic value range" will be opened.

Choose how the value range is defined from the following possibilities:
– Automatically from the displayed data.
– From the defined value range. Enter the values for the lower limit and the upper limit of
the value range.
– From online tags. The lower limit and the upper limit of the value range are made from
the values from connected online tags. Enter a tag name for the lower limit and the upper
limit.
8. Configure the display for each trend. More information can be found on page "How to
configure the display of trends".
9. Save the configuration.

How to configure the display of trends
Introduction
You can adjust the display of trends to suit your requirements in the WinCC controls. The
following WinCC controls are shown in trends:
● WinCC OnlineTrendControl
● WinCC FunctionTrendControl
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Overview
The following trends features can be configured:
● The types of trends and trend lines
● The properties of trend lines
● The colors of the trends, the trend points and the fill color
● Color identification for a limit value violation
Note
Depending on the window size of the control and the line weight, the line style can be
represented differently regardless of the configured line style.

Requirement
● You have opened the Graphics Designer and configured a picture with the above mentioned
WinCC control.
● The configuration dialog of the WinCC control is opened.
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Configuring the types of trends and trend lines
1. Go to the "Trends" tab. Here e.g. in WinCC OnlineTrendControl.

2. Choose a trend under "Trends".
3. Define the type of the trends and trend lines in the "Display" area.
4. If you want to highlight the display of the area under the trend, activate the "Filled" option.
5. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
6. Save the configuration.
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Configuring the properties of trend lines
1. Choose a trend under "Trends".
2. Define the properties of the trend lines in the "Display" area.
3. Define the line weight and the properties of the trend points.
4. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
5. Save the configuration.

Configuring the colors of the trends, the trend points and the fill color
1. Choose a trend under "Trends".
2. Define the colors in the "Display" area.
3. If you want to configure the colors of the trend points and the fill color, activate the
"Extended" option.
4. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
5. Save the configuration.

Configuring the color identification for a limit value violation
1. Choose a trend under "Trends".
2. Click in the "Display" area on the "Limit values" button. This will open the "Limit values"
dialog.

3. Activate the limit values, for which you want a colored identification.
4. Define the color for every activated option.
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5. The colored identification has the following effect:
– Low limit value. Whenever a displayed trend value is below the value defined in the
"Value" input field, the value is shown in the configured color.
– High Limit Value. Whenever a displayed trend value is above the value defined in the
"Value" input field, the value is shown in the configured color.
– Value with uncertain status. Values, whose start value is unknown on activating runtime
or for which a substitute value is used, have an uncertain status. These values are
displayed in the configured colors.
6. Save the configuration.
Note
In WinCC V7 or higher, the display of trend values with uncertain status in trend controls
differs to their display in trend controls in earlier versions of WinCC V7: The trend values
with uncertain status will not be displayed in the control until they have returned to a reliable
state.

How to configure the toolbar and the status bar
Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The
status bar contains information pertaining to the current status of the WinCC control. You can
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The WinCC control is assigned the "Configuration dialog" button function for opening the
configuration dialog in Runtime.
● The configuration dialog of the WinCC control is open.
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How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in
Runtime. For information on the button functions, refer to the description of the
corresponding WinCC control at "Operation in runtime".
3. Determine the sorting order for displaying the button functions in the toolbar. Select the
button functions from the list and the move the functions using the "Up" and "Down" buttons.
4. Define a shortcut key for the functions of the toolbar buttons.
5. Any button functions assigned operator authorizations are only available in Runtime to
authorized users.
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6. An activated button function is displayed during runtime if you deactivate its "Active" option,
however, it cannot be operated.
7. You can set separators between the button functions. Activate the "Separator" option for
the button function to be restricted by separator.
8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status Bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required during runtime in the list of status bar elements. For further
information on status bar elements, refer to the descriptions of the corresponding WinCC
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements
from the list and move these using the "Up" and "Down" buttons.
4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a
pixel value for the width.
5. Configure the general properties of the status bar, e.g. alignment or background color.

How to configure the Ruler window/Statistics window/Statistics area window
Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a
statistics area window. The ruler window/statistics window/statistics area window are
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:
● WinCC OnlineTrendControl
● WinCC OnlineTableControl
● WinCC FunctionTrendControl
Depending on the data evaluation, there are three different types of windows for displaying
values. The following window types are available:
● The ruler window displays the coordinate values of trends on the ruler.
● The statistics area window shows the values of the lower limit and upper limit of the trends
between two rulers or the selected area in the table. The statistics area window is not
planned for the WinCC FunctionTrendControl.
● The statistics window shows the statistic evaluation of the trends between two rulers or the
selected values in the table. The statistics window is not planned for the WinCC
FunctionTrendControl.
All windows can also display additional information on the connected trends or columns.
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Requirement
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or
FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.
2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.
4. Go to the "General" tab in the field "Source" and select the object name of the control that
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be
operated in runtime, you can change the window type in runtime.
6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the
assigned control. Columns for the basic data and columns that are only for the selected
window type or the assigned control are available. Define the column sequence with buttons
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected
columns, click on the respective blocks.
9. If a special format exists for a block, you can configure the format of the block. Deactivate
the option "Apply from source" if the format settings of the connected control are not to
apply in this case. Define the desired format.
10.Define whether the data for the column and the column heading is to be displays as text or
as an icon in the table under "Display".
11.Save the configuration.
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12.Configure the properties and the display of the table for the RulerControl in the "Parameter,"
"Effects" and "Selection" tabs.
For details on configuring the table display, please refer to "Configuration of
OnlineTableControl > How to configure the table display" in the WinCC OnlineTableControl
documentation.
13.You can export the evaluated data. This requires activating the "Export data" key function
on the "Toolbar" tab.
For details on data export, please refer to "Configuration of OnlineTableControl > How to
export runtime data" in the WinCC OnlineTableControl documentation.
14.Configuring the TrendRulerControl is possible in runtime.
For more detailed information, please refer to "Configuration of OnlineTableControl > How
to apply online configuration" in the WinCC OnlineTableControl documentation.

See also
How to export runtime data (Page 1437)
How to define the effect of the online configuration (Page 1439)
How to configure the display of trends (Page 1426)

How to export runtime data
Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set
up operation of the data export during runtime in the configuration dialog.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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How to configure the operation of the data export
1. Go to the "Export" tab.

2. A standard file name and a standard directory are already entered in the "Data export default
settings". In this case for AlarmControl. If necessary, define a file name and a directory for
the export file.
The file name can be made up of the freely defined name and the following placeholder:
@OBJECTNAME - Object name of the controls
@CURRENTDATE - Current date
@CURRENTTIME - Current time
3. CSV is currently available as data format. Click
in the CSV file.

to specify the delimiter and data format

4. Define the scope of the data export:
– All runtime data is exported
– Selected runtime data is exported. This data export is only possible in WinCC controls
with tabular display.
5. Configure the operation of the data export during runtime. Define:
– whether users are allowed to rename the file, or change the directory.
– whether to display the "Data export default settings" dialog in Runtime.
6. If "Show dialog" is deactivated, the data for operation of the "Export data" button function
is immediately exported to the defined export file.
7. Save the configuration.
8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results
You can export all or selected data to a defined file at runtime using the
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How to define the effect of the online configuration
Introduction
Users can parameterize the WinCC controls in Runtime. You must define the Runtime effects
of the online configuration.
Changes configured in Runtime are saved for the specific user separately from the picture in
the configuration system. The original picture configuration is retained in the configuration
system.
Note
The picture is also replaced at Runtime if you save it in Graphics Designer, or when loading
deltas in online mode. All online changes are lost.
The different configurations are only activated for new users after you performed a picture
change.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults
are only available in the configuration system. The option buttons are not available in
Runtime.
Select one of the three effects of the online configuration:
– "Do not retain". The online configurations are not retained in Runtime. This default
setting disables all options for Runtime users. Online configurations are lost at the next
picture change and on activation/deactivation of the project.
– "Retain during Runtime". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the
project.
– "Retain permanently". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
and on activation/deactivation of the project if the "retain" option is enabled.
3. Define corresponding user authorizations for online configuration.
4. The option buttons of the "Online configuration on next picture change" can be enabled for
operation in the configuration system and at Runtime by setting the "retain at Runtime" and
"retain permanently" defaults. The "reset" operation is only available in Runtime, because
the configuration system contains the original configuration.
Select one of three effects of the online configuration at the next picture change:
– Select "discard" if to discard the online configuration at the next picture change.
– Activate "retain" to activate the online configuration based on default settings at the next
picture change or on activation/deactivation of the project.
– Activate "Reset" if you want to apply the picture saved in the configuration system in
Runtime. All online changes are lost.
5. Save the configuration.

How to make the toolbar for the OnlineTrendControl dynamic
Introduction
The default functions for operating the WinCC OnlineTrendControl are no longer supported
for the new WinCC OnlineTrendControl as of WinCC V7.0. You can use the WinCC types of
dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC Controls as of V7.0 you do not need special functions to implement operation of
the control by assigning dynamic properties to the toolbar. The previously used standard
functions "TlgTrendWindowPress..." and "TrendToolbarButton" are no longer supported.
If you do not want to operate the control via the toolbar, you can write the "ID" for the desired
button in the "ToolbarButtonClick" object property with an optional type of dynamics.
The "ID" of a button of the toolbar can be determined:
● with the table on page "Operation of the OnlineTrendControl in Runtime".
● in the configuration dialog of the OnlineTrendControl on the "Toolbar" tab via field "Object
ID".
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Example: Opening the control configuration dialog
The following options of assigning dynamic properties are available for opening the control
configuration dialog:
● VBScript:
– ScreenItems("Control1").ToolbarButtonClick = 2
– As an alternative to the "ToolbarButtonClick" property, you can use the VBS methods
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog
– Or, with the following notation and support of "Intellisense":
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog
● C script:
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);
● Direct connection
– In the dialog of the direct connection, enter "2" as a constant for the source.
– Select the property "ToolbarButtonClick" for the object "Control1" for the target "Object
in picture".

See also
Operating the OnlineTrendControl in runtime (Page 1442)

Operation in Runtime
Operating the OnlineTrendControl in runtime
Introduction
The trend window is operated in runtime via the buttons in the toolbar. If you do not want to
operate the trend window via the toolbar, you can write the "ID" for the desired button in the
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview
The overview shows all symbols in "standard" style. If you create a design of the controls with
the "Simple" style, the representation of the symbols is the same as with OnlineTrendControl
before WinCC V7. You can find an overview on the page "Before WinCC V7: Output process
values as trends in process pictures > Operation in Runtime > Operation of Online Trend
Control in Runtime".
Icon

Description

ID

"Help"

1

Calls up the help on WinCC OnlineTrendControl.
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"Configuration dialog"

2

Opens the configuration dialog, in which you can change the properties of
the OnlineTrendControl.
"First Data Record"

3

This button displays the tag trend over time in the trend window, starting with
the first archived value and extending over a defined time range. The button
is only available if the values originate from a process value archive.
"Previous Data Record"

4

This button displays the tag trend of the previous time interval in the trend
window, starting from the currently displayed time interval. The button is only
available if the values originate from a process value archive.
"Next Data Record"

5

This button displays the tag trend of the following time interval in the trend
window, starting from the currently displayed time interval. The button is only
available if the values originate from a process value archive.
"Last Data Record"

6

This button displays the tag trend over time in the trend window, ending with
the last archived value and extending over a defined time range. The button
is only available if the values originate from a process value archive.
"Zoom area"

8

Define an area by dragging with the mouse in the trend window. This cut-out
of the trend window is made larger. The "Original view" button brings back
the original size of the view.
"Zoom +/-"

9

Zooms in on or out off the trends in the trend window. The left mouse button
increases the size of the trends. By holding the "Shift" button down, the left
mouse button zooms out of the trends. The "Original view" button brings
back the original size of the view.
"Zoom time axis +/-"

10

Zooms in on or out off the time axes in the trend window. The left mouse
button increases the size of the time axes. By holding the "Shift" button down,
the left mouse button zooms out of the time axes. The "Original view" button
brings back the original size of the view.
"Zoom value axis +/-"

11

Zooms in on or out off the value axes in the trend window. The left mouse
button increases the size of the value axes. By holding the "Shift" button
down, the left mouse button zooms out of the value axes. The "Original view"
button brings back the original size of the view.
"Move trend area"

12

This button moves the trends along the time axis and the value axis in the
trend window.
"Move axes area"

13

This button moves the trends along the value axis in the trend window.
"Original view"

14

This button exit the zoomed trend display back to the original view.
"Select data connection"

15

This button opens a dialog for the archive selection and tag selection.
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16

"Select trends"
This button opens the dialog for toggling between visible and invisible trends.
You can also define which trend is displayed in the foreground.
"Select time range"

17

This button opens a dialog where you can specify the time range to be
displayed in a trend window.
"Previous trend"

18

This button is used to display the previous trend of the trend window in the
foreground.
"Next trend"

19

This button is used to display the next trend of the trend window in the
foreground.
"Stop"

20

The updated display is stopped. The data is saved to the clipboard and
added when the button in the trend window is clicked again.
"Start"

20

Resume updated display.
"Print"

21

Click this button to print the trend shown in the trend window. The print job
used for printing is defined in the configuration dialog on the "General" tab.
26

"Export data"
This button is used to export all or the selected runtime data to a "CSV" file.
If the option "Display dialog" is active, a dialog will open in which you can
view the export settings and start the export. You can select the export file
and directory, provided you have the relevant authorizations.
The data will be exported immediately to the default file if this dialog is not
displayed.
"Ruler"

7

The coordinate points of a trend are queried with this button. The trend data
is displayed in the ruler window.
"Define statistics area"

22

This button is used to define the time range for calculating the statistics in
the trend window.
"Calculate Statistics"

23

The button shows the statistical values in the statistics window. The
displayed values refer to a selected trend with the configured calculation
time range. The button is only functional if a statistics window is connected
with the OnlineTrendControl.
"Connect backup"

24

This button opens a dialog in which you can connect selected archives to
WinCC Runtime.
"Disconnect backup"

25

This button opens a dialog in which you can disconnect selected archives
from WinCC Runtime.
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"Relative axis"

27

Switches from displaying the absolute values to the percentage display of
value axis. The high and low limits for the trend correspond with a range of
0 to 100%.
"User-defined 1"

1001

Shows the first key function created by the user. The function of the button
is user-defined.

Possible elements of the status bar
The following elements can appear in the status bar of the trend window:

Icon

Name

Description

Connection status

Shows the status of the data connections:
● No faulty connections
● Faulty connections
● All connections are faulty

Date

Shows the system date.

Time

Shows the system time.

Time base

Shows the time base used in the display of times.

Double-click on the icon for the connection status to open the window "Status of the data
connections", which lists the name, status and tag name of the data connection.
Note
Display of values in runtime
Whole numbers are represented as decimal figures, as the interpolation of two values within
a time range can produce a number with decimal places.
The values displayed for a time can fluctuate as plotting continues. This is a result of the
interpolation of values along the x-axis. To prevent fluctuation of the values, select a larger
time range, for example an hour.

Online configuration of the OnlineTrendControl
Introduction
In runtime, you can configure online and change the display of the WinCC OnlineTrendControl.
Configuring the OnlineTrendControl defines how to proceed with a picture change or after
ending runtime with online configurations.
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Overview
The following buttons functions make online configuration possible in OnlineTrendControl:
● With key function "Configuration dialog"
● With key function "Select data connection"
● With key function "Select trends"
● With key function "Select time range"

Key function "Configuration dialog"
Use the key function "Configuration dialog" to access to the configuration dialog tab, e.g. for
changing the display of the trend.

The key function "Select data connection"
With key function "Select data connection" you select the archive tags or online tags for the
value axes, which you want to show in the trend.

Field

Description

Trend

Choose one of the configured trends.

Data Source

Define whether the selected trend is supplied with an archive tag or online tag.

Tag name

Select the tag name for the data connection.

Key function "Select trends"
The key function "Select trends"
opens a dialog in which you can show or hide trends. You
can move trends to the foreground by changing the sequence of the trends.
Note
The first trend of a trend window can not be hidden.
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Key function "Select time range"
Select the time range to be displayed for the time axes using the key function "Select time
. If the trends in a trend window are to be displayed with a common time axis, the
range"
specified time range applies to all trends.

Field

Description

Time axis

Select the configured time axis for which you want to define a time range.

time range

Set the time range:
● If you want to define a fixed time interval, select setting "Start to end time". Enter
the date and time for each.
● If you want to define a time period, select the setting "Time range". Define the date
and time for the start time. The length of the time interval to be displayed is
determined by multiplying the "Factor" by the "Time unit".
● If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.

The entry format of the date and time depends on the Runtime language used.

Starting and Stopping Update
Introduction
The update of the trend in the trend window can be started and stopped with the "Start/Stop"
key function.
The button indicates whether the update is stopped or not:
●

: Update has been stopped. Click on the button to continue updating.

●

: Update has been started. Click on the button to stop updating.
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How to display the trend in the foreground
Introduction
If more than one trend are to be displayed in a trend window, you can use key functions to
define which trends will be displayed in the foreground.

Requirement
● You have configured key functions "Select trends", "Previous trend" and "Next trend".

Procedure
●

is used to open a dialog for displaying or hiding trends. You can also define which trend
is in the foreground.

●

is used to display the next trend of the trend window in the foreground.

●

is used to display the previous trend of the trend window in the foreground.

How to Determine the Coordinates of a Point
Introduction
Key function "Ruler" is used for using a ruler to determine the coordinates of a point on the
trend. You can zoom in on an area of the trend to make coordinate finding easier. If you click
on the trend with the mouse, several trend parameters are shown in the tooltip for the trend
window.

Requirement
● You have configured a WinCC OnlineTrendControl. In order to highlight the ruler in the
trend window, you can increase the line weight of the ruler on the "Trend window" tab and
configure the color.
● You have configured the "Ruler" key function. If you want to zoom in on a section of the
trend, configure key functions "Zoom area" and "Original view".
● You have configured a WinCC RulerControl and connected it with the OnlineTrendControl.
● You have selected the ruler window in the RulerControl which shows the coordinates.
● You have activated runtime.

How to display the coordinates
1. In OnlineTrendControl, click on

.

2. Move the ruler to the desired position with the mouse.
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3. If you want to zoom in on an area, click on
the mouse.

. Move the ruler to the desired position with

4. If you want to return to the original view, click on

.

Result
A ruler appears in the trend window. The data is displayed in columns in the ruler window along
with the X value/time stamp and the y value that you have configured in WinCC RulerControl.
You can, for example, display the range name you have specified for the value range of the y
value in the OnlineTrendControl.
The displayed values can be assigned an additional attribute in the form of a letter:
● Letter "i." : The displayed value is an interpolated value.
● Letter "u." : The displayed value has an uncertain status. The value is not certain if the initial
value is not known after runtime has been activated, or when a substitute value is used.
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Other values can be determined by positioning the mouse pointer on the ruler and moving it
to the desired position while holding the left mouse button pressed.
Note
The "uncertain" status of a value can also be indicated in the displayed trend characteristic.
You must activate the "Value with uncertain status" option on the "Trends" tab under "Limit
values".

How to use the zoom functions in trend windows
Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view
for trends, axes and various zoom areas of the trend window.

Overview
The following zoom functions are available in the trend window:
● "Zoom area"
● "Original view"
● "Zoom +/-"
● "Zoom time axis +/-"
● "Zoom value axis +/-"
● "Move trend area"

Requirement
● You have configured a WinCC OnlineTrendControl.
● You have configured the buttons for the required zoom functions for the toolbar.
● You have activated runtime.

How to zoom in on a segment of a trend window
1. Click on

. The updated display is stopped.

2. In the trend window, click one corner of the area that you wish to enlarge.
3. Hold down your left mouse button and drag the area you want to enlarge until it reaches
the desired size. If the highlighted area contains at least two measured values, the selected
trend area is displayed in the trend window.
4. Release the left mouse button. The selected segment is magnified. If you want to increase
the size further, repeat the process.
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5. Click on

. The trend window is shown in the originally configured view again.

6. Click on
to restart the update. The values that have been defined earlier are used for
the X axis and the Y axis.

How to zoom in and zoom out of the trends
1. Click on

. The updated display is stopped.

2. Click in the trend window with the left mouse button to zoom in on the trends in the trend
window. If you want to increase the size further, repeat the process.
3. If you want to zoom out of the trends, press the "Shift" button while clicking with the left
mouse button.
4. While zooming in or zooming out with trends, the 50% value of the trends is always in the
middle of the value axes.
5. Click on

. The trend window is shown in the original view again.

6. Click on
to restart the update. The values that have been defined earlier are used for
the X axis and the Y axis.
Note
If you change the value area of a value axis on the "Value Axis" tab in the configuration
dialog while zooming, the visible zoom area is set to the new value area.

How to zoom with time axes and value axes
1. Click on
to zoom in on time axes or on
display is stopped.

to zoom in on value axes. The updated

2. Click in the trend window with the left mouse button to zoom in on the time axes or value
axes. If you want to increase the size further, repeat the process.
3. If you want to zoom out of the time axes or value axes, press the "Shift" button while clicking
with the left mouse button.
4. While zooming with axes, the 50% value of the trend is always in the middle of the axes.
5. Click on

. The trend window is shown in the original view again.

6. Click on
to restart the update. The values that have been defined earlier are used for
the X axis and the Y axis.

How to move the trend area
1. Click on

. The updated display is stopped.

2. While holding the left mouse button down, move the cursor in the desired direction in the
trend window. The displayed area in the trend window is adapted on the time axis and on
the value axis.
3. Clicking on again will restore the original trend window view.
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How to Generate Statistics of Runtime Data
Introduction
You can generate an evaluation of runtime process data in the trend window. The evaluated
data is shown in the WinCC RulerControl.

Overview
Depending on the data evaluation, there are three different types of windows for displaying
values. The following window types are available:
● The ruler window shows the coordinates of a trend on the ruler.
● The statistics area window shows the values of the lower limit and upper limit of the trends.
● The statistics window shows the statistical evaluation of the trends. Among other things,
the statistics include:
– Minimum
– Maximum
– Average
– Standard deviation
– Weighted average value: The time span for which a recorded value has the same value
is included in the calculation of the weighted average value.
– Integral: Calculates the area between each trend and the zero line.
All windows can also show additional information on the values of the connected trends.

Requirement
● You have configured a WinCC OnlineTrendControl. In order to highlight the ruler defining
the statistics area, you can increase the line weight of the ruler on the "Trend window" tab
and configure the color.
● You have configured a WinCC RulerControl and connected it with the OnlineTrendControl.
● You have selected the window in the RulerControl which shows the desired data.
● You have configured key functions "Set statistics range", "Calculate statistics" and "Start/
Stop". If a display of the values in a ruler window is sufficient, you do not need key functions
"Select statistics area" and "Calculate statistics".
● You require key function "Select time range", if you wish to choose a statistics area outside
of the time range displayed in the trend window.
● You require key function "Configuration dialog" if you want to switch between the statistics
windows and the ruler window.
● You have activated runtime.
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How to display the data in a statistics area window
1. Click on

in OnlineTrendControl if the updated display is to be stopped.

2. Click on
. The updated display is stopped, process data continue to be archived. Two
vertical lines are displayed at the left and right edge of the trend window.
3. Move the ruler until the desired area is selected.
4. The evaluated data is displayed in the columns that you have configured in the statistics
area window.

5. If you want an evaluation of data that is not displayed in OnlineTrendControl, click on
.
Enter the desired time range for the selected time axis in the "Time selection" dialog. The
data for the defined time range is displayed. You can now evaluate this data.
6. To continue with the display in OnlineTrendControl, click on

.

How to display the data in a statistics window
1. In OnlineTrendControl, click on
. The updated display will be stopped but the process
data will continue to be archived.
2. Click on
. The updated display is stopped, process data continue to be archived. Two
vertical lines are displayed at the left and right edge of the trend window.
3. Move the ruler until the desired area is selected.
WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1453

Archiving Process Values
6.5 Output of Process Values
4. Click on
. The evaluated data is displayed in the columns that you have configured in
the statistics window.

5. If you want an evaluation of data that is not displayed in OnlineTrendControl, click on
.
Enter the desired time range for the selected time axis in the "Time selection" dialog. The
data for the defined time range will be displayed. You can now evaluate this data.
6. To continue with the display in OnlineTrendControl, click on

.

Note
The displayed values can be assigned an additional attribute in the form of a letter:
● Letter "i." : The displayed value is an interpolated value.
● Letter "u." : The displayed value has an uncertain status. The value is not certain if the
initial value is not known after runtime has been activated, or when a substitute value
is used.
Note
For additional statistical analysis of process data and archiving of results you must write
the scripts yourself.
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How to display archived values
Introduction
Use the buttons in the toolbar of a trend window or the corresponding key combinations to
browse through an archive.
The values archived of a tag are displayed within a time interval in the trend window. The time
interval is defined by entering a time range or by entering a start and end time.

Requirement
● The buttons for browsing in archive are available only if data is supplied through archive
tags.
● You have defined a time range or a start and end time.

Buttons for Archived Values
The progress of a tag over a specified time period, beginning with the first archived value,
is displayed in the trend window.
The progress of a tag within the previous time interval is displayed in the trend window,
starting with the currently displayed time interval.
The progress of a tag within the following time interval is displayed in the trend window,
starting with the currently displayed time interval.
The progress of a tag over a specified time period, ending with the last archived value, is
displayed in the trend window.

Example project for OnlineTrendControl
Example configuration of an OnlineTrendControl
Introduction
The following example shows the configuration of a WinCC OnlineTrendControl with two trends
and the display in runtime. With key function "Configuration dialog" in runtime, you can change
the display of the trends at any time and view the effects immediately.

Configuration steps
1. Insert the OnlineTrendControl into a picture of the Graphics Designer.
2. Configure the OnlineTrendControl properties.
3. Create a trend window.
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4. Configure a time axis with the respective properties. Assign the time axes to the trend
window.
5. Configure two value axis with the respective properties. Assign the value axes to the trend
window.
6. Define two trends and assign the trends to the trend windows. Assign the trends with the
time axis and the value axes.
7. Connect the two trends with an online tag for each.
8. Configure the display for each trend.
9. Save the picture with the OnlineTrendControl in the Graphics Designer.
10.Define the picture as a start picture with the example project.
11.Start runtime.
12.Start the tag simulator to supply the trends with data.
13.Deactivate runtime if you want to end the example project.

How to configure the trend window
Introduction
The example has a trend window embedded in a WinCC OnlineTrendControl. This chapter
shows the configuration of the properties of the control and the trend window.

Requirement
● You have opened a picture in the Graphics Designer.

Procedure
1. Insert a WinCC OnlineTrendControl into the picture from the object palette in the Graphics
Designer. Use the mouse to drag the control to the desired size.
2. Double-click in the control. The configuration dialog opens.
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3. Go to the "General" tab.

4. Select the "Normal" window heading. Activate the "Moveable", "Can Be Closed" and
"Sizeable" options. "From the right" is defined as the writer orientation and updating will
start when the picture is opened.
5. Save the configuration.
6. Go to the "Trend windows" tab. Define a trend window with the "New" button. The gridlines
are displayed during runtime.
7. Configure the display of the ruler. If you use "Graphic" for the display of the ruler, you can
configure the color and the line weight of the ruler.
8. Save the configuration.
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9. Go to the "Toolbar" tab. You require the following key functions to test the example:
– Configuration Dialog
– All key functions for zooming and moving
– Original view
– Ruler
10.Save the configuration.

How to configure the axes of the OnlineTrendControl
Introduction
The trend window of the example has a time axis and two value axes. The last 50 values of
the trend in relation to the current time are shown in the trend window.
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Requirement
● You have defined a trend window.

Procedure
1. Go to the "Time axes" tab. Define a time axis with the "New" button.

2. Assign the time axis to the configured trend window. Select "Bottom" for the alignment of
the time axis.
3. Activate the "Update" option to display the values in relation to the current time.
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4. Select setting "Number of measurement points" in the "Time range" area. You do not have
to define the start time because the last 50 values in relation to the current time will be
displayed in the example. Enter "50" for the number of measurement points in the input
field.
5. Configure the desired format for time and date.
6. Save the configuration.
7. Go to the "Value axes" tab. Define two value axes with the "New" button.

8. Assign the value axes to the configured trend window.
9. Configure the alignment for each value axis. The first value axis should be left-justified, the
second right-justified.
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10.Select "Linear" for the scaling.
11.The option "Automatic" is activated for both value axes in the "Value range" area. The value
range for the value axes is based on the tag values.
12.Save the configuration.

How to configure the trends
Introduction
The trend window in the example shows two trends with a common time axis. Each trend has
its own value axis. The trends receive their data from online tags. The customer display can
be configured individually.

Requirement
● You have defined a trend window.
● You have configured a time axis and two value axes.
● You have created two non-binary tags in tag management.
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Procedure
1. Go to the "Trends" tab. Define two trends with the "New" button.

2. Assign each trend with the configured trend window and the time axes. Trend1 is assigned
with ValueAxis1 and Trend2 with ValueAxis2.
3. Define the data connection for each trend. Select "Online tags".
4. Click on , to select the tags for the trends.
5. Configure the display for each trend as desired. More information on configuration can be
found on page How to configure the display of trends (Page 1426).
6. Save the configuration.
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See also
How to configure the display of trends (Page 1426)

How to start the example on OnlineTrendControl
Introduction
In order to test the example of the OnlineTrendControl in runtime, you must made many
settings in the project.

Requirement
● You have saved the configured picture in the Graphics Designer.
● You have defined the picture in the WinCC Explorer as the start picture via the shortcut
menu.

● You have checked for whether "Graphics Runtime" and "Tag Logging Runtime" are
activated in the "Computer properties" dialog.

Procedure
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu
bar.
2. Start the tag simulator to test the WinCC OnlineTrendControl with the tags.
3. Go to "Start/SIMATIC/WinCC/Tools" on your computer.
4. Select the "WinCC Tag Simulator". The simulation program will open.
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5. Define two tags that you have connected in OnlineTrendControl.
6. Assign the tag with property "Random" and click on the "Active" option.
7. Save the settings in each case.
8. Click the "Start Simulation" button. The simulation is started and the trend supplied with
data.
9. Deactivate runtime if you want to end the example project.

Result
The trends are displayed in runtime with the values that create the tag simulator.

The
button takes you to the configuration dialog, where you can change the display of the
trends as required on the "Trends" tab. You will immediately see the results of your
configuration.
Test all functions for zooming and move the trend or the axes. More information is found under
How to use the zoom functions in trend windows (Page 1450) .
More information on operating the OnlineTrendControl in runtime is found under Operating the
OnlineTrendControl in runtime (Page 1442) .
You can expand the OnlineTrendControl with a ruler window for example. More information
can be found under How to Generate Statistics of Runtime Data (Page 1452) and How to
configure the Ruler window/Statistics window/Statistics area window (Page 1433) .
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6.5.2.4

Process Value Output as a Function of Another Tag

WinCC FunctionTrendControl
Introduction
For a graphic processing of tags, WinCC FunctionTrendControl in WinCC offers the option of
displaying one tag as a function of another tag. For example, temperature may be shown as
a function of pressure.

Requirement
For the display of trends in WinCC FunctionTrendControl the following prerequisites apply:
● You can display as many trends as you need in a WinCC FunctionTrendControl.
Configuring a maximum of 8 trends is recommended.
● A trend can represent a maximum of 10000 value pairs.
● You can use online tags, archive tags or data from user archives for the trends.
● The online tags of a trend must have the identical update cycle.
● The archive tags of a trend must have the same update cycle and must be recorded in a
continuous cycle.
● The representation of tags in the form of functions over time is only possible, if the values
of the trend are supplied through the API interface. In order to display tags as time functions,
use the WinCC OnlineTrendControl.
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Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen
resolution and selected size of the trend window. Therefore, when displaying trends, it is
possible that fewer values are displayed in the trend window than are actually archived.
If, for example, in an area of 100 pixels 200 measured values are archived, each pixel
represents 2 measured values. The value shown on the screen is that of the most recent data
(most recent time stamp).

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)

Display of Trends
Representing Trend Lines
Introduction
The WinCC FunctionTrendControl has many ways of displaying the progress of a trend.
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Representation formats
To display values graphically, three basic representation types are available:
● No trend
The values are shown as dots. The display of the points can be configured as you wish.

● Connect dots linearly
The trend line is interpolated on a linear basis from the point values. The display of the lines
and points can be configured as you wish.

● Stepped trend
The progress of the trend line is determined from the values as a stepped trend. The display
of the lines and points can be configured as you wish.

The display of the trend can be configured on the "Trends" tab of the FunctionTrendControl.

Write direction
With the write direction option, you can specify where the current values for all trend windows
are to be entered. Normally, the current values are written in the trend window from the right.
All four write directions can be configured. The write direction is configured on the "General"
tab of the FunctionTrendControl.

Displaying the trends with logarithmic axes
The axes in the trend window can be scaled on either a logarithmic or a linear basis. No
negative values can be displayed in the display with logarithmic axes. No positive values can
be displayed in the display with negative logarithmic axes. The display with logarithmic axes
is configured on the "X axes" and "Y axes" tabs of the FunctionTrendControl.
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Display with common axes
Introduction
When displaying more than one trend in a trend window, you can assign every trend with its
own axes or use a common time X axis or Y axis.

Representation Using Different Axes
If the values to be displayed in a trend window differ greatly, a common axis makes no sense.
The values can be read more easily if different axial scales are used. Individual axes can be
hidden if required.
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Representation Using Common Axes
If the comparability of the trend lines is important, common axes in a trend window is sensible.
Connected trend windows can have a common axis.

Configuring
The axes are configured on the "X axis" and "Y axis" tabs of the FunctionTrendControl. The
assignment of the axes for the trends can be configured on the "Trends" tab. In this case, you
can assign the individual trends to the same axes.

Configuring the FunctionTrendControl
How to configure the FunctionTrendControl
Introduction
Process values of a tag can be displayed depending on the process values of another tag in
trends. You can configure a WinCC FunctionTrendControl for this in the Graphics Designer.
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Configuration steps
1. Insert the FunctionTrendControl into a picture of the Graphics Designer.
2. Configure the basic properties for the FunctionTrendControl on the "General" tab:
– the window properties of the control
– the display of the control
– the write direction of the trend values
– the time base of the control
3. Define one or more trend windows.
4. Configure one or more X axes and Y axes with their respective properties. Assign the axes
to the trend windows.
5. Define trends that you want to display in the trend windows. Assign the trends to the trend
windows. Assign each trend an X axis and a Y axis that belong to the respective trend
window.
6. Configure the display for each trend.
7. Every configured trend must be connected with an online tag, archive tag or a user archive
via the X axis and Y axis. Define the data supply for the axes of each trend.
8. Configure the toolbar and status bar of the trend window.
9. If you want to display the coordinates of the trends, configure a ruler window as well.
Connect the ruler window with the FunctionTrendControl.
10.Save the configurations.

How to create the trend window in FunctionTrendControl
Introduction
The WinCC FunctionTrendControl can contain one or more trend windows. The trend window
provides an area to display trends in.

Overview of the trend window
The trend window has the following properties:
● Every trend window is assigned with at least one trend, which has one X axis and one Y
axis.
● A trend can only be assigned to one trend window.
● Several trends can be displayed in a trend window.
● A trend window can display X axes and Y axes independent of the displayed trends. X axes
and Y axes can be hidden in runtime.
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● The sequence of the configured trend window is determined by the position in
FunctionTrendControl. The first trend window in the list of trend windows is displayed in
the lower position, the last trend window is shown in the top position.
● If more than one trend window is configured, the trend windows can be connected. The
connected trend windows have the following properties:
– They can have a common X axis.
– They have a scroll bar.
– They have a ruler.
– The zoom functions for a trend window affect the connected trend windows.
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Procedure
1. Define one or more trend windows with the "New" button on the "trend windows" tab.

2. If you have defined more than one trend window, more configurations are possible:
– Assign every trend window with an area selection in the displayed FunctionTrendControl.
– Define the position of the trend windows with the "Up" and "Down" buttons.
– Define whether the trend window will be connected on the "General" tab.
3. If you want to hide a trend window in runtime, deactivate the checkbox in front of the name
of the trend window in the list. The respective axes are then hidden as well.
4. Configure the gridlines for every trend window.
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5. Configure the display of the ruler. If you use "Graphic" for the display of the ruler, you can
configure the color and the line weight of the ruler.
6. Define the level on which to display the ruler in the trend window.
7. Save the configuration.

How to configure the axes of trend windows
Introduction
You can configure several X axes and Y axes that you assign to one or more trend windows.
Configure the value range and the display for each X axis and Y axis.

Requirement
● You have opened the picture with the FunctionTrendControl in the Graphics Designer.
● You have defined trend windows.
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Procedure
1. Define one or more axes with the "New" button on the "X axes" and "Y axes" tabs. Here
e.g. tab "X axes":

2. Assign the X axes and Y axes to the configured trend windows.
3. If you want to hide an X axis or Y axis in the trend window, click on the checkbox in front
of the name of the axis in the list. You can display the axes again in runtime with the key
functions.
4. Configure the orientation and scaling for each X axis and Y axis.
5. Configure the display of the axes in trend windows.
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6. Deactivate the "Automatic" option in "Value range" if you want to define a fixed value range
for the X axis or Y axis.
7. In the "From:" and "To:" input fields enter the minimum and maximum value of the value
range.
8. Save the configuration.

How to create trends for the trend window
Introduction
Every trend is displayed in a trend window with an X axis and a Y axis. The trends can use
the same axes in a trend window.

Requirement
● You have inserted the FunctionTrendControl into a picture of the Graphics Designer.
● You have configured X axes, Y axes and trend window.
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Procedure
1. Go to the "Trends" tab.

2. Use the "New" button to define the desired number of trends.
3. Define the sequence of trends in the trend window using "Up" and "Down" keys.
4. Assign every trend to a trend window. Several trends can be assigned to one trend window.
5. Assign an X axis and a Y axis to every trend. You can only use the axes that belong to the
assigned trend window for the trend.
6. Configure the display for each trend. More information can be found on page "How to
configure the display of trends".
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7. The data connection of the trends are configured on the "Data connection" tab. More
information can be found on page "How to configure the data connection of trends".
8. Save the configuration.

How to configure the display of trends
Introduction
You can adjust the display of trends to suit your requirements in the WinCC controls. The
following WinCC controls are shown in trends:
● WinCC OnlineTrendControl
● WinCC FunctionTrendControl

Overview
The following trends features can be configured:
● The types of trends and trend lines
● The properties of trend lines
● The colors of the trends, the trend points and the fill color
● Color identification for a limit value violation
Note
Depending on the window size of the control and the line weight, the line style can be
represented differently regardless of the configured line style.

Requirement
● You have opened the Graphics Designer and configured a picture with the above mentioned
WinCC control.
● The configuration dialog of the WinCC control is opened.
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Configuring the types of trends and trend lines
1. Go to the "Trends" tab. Here e.g. in WinCC OnlineTrendControl.

2. Choose a trend under "Trends".
3. Define the type of the trends and trend lines in the "Display" area.
4. If you want to highlight the display of the area under the trend, activate the "Filled" option.
5. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
6. Save the configuration.
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Configuring the properties of trend lines
1. Choose a trend under "Trends".
2. Define the properties of the trend lines in the "Display" area.
3. Define the line weight and the properties of the trend points.
4. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
5. Save the configuration.

Configuring the colors of the trends, the trend points and the fill color
1. Choose a trend under "Trends".
2. Define the colors in the "Display" area.
3. If you want to configure the colors of the trend points and the fill color, activate the
"Extended" option.
4. In the small picture in the right-hand margin of the "Display" area, the result of the
configuration is shown.
5. Save the configuration.

Configuring the color identification for a limit value violation
1. Choose a trend under "Trends".
2. Click in the "Display" area on the "Limit values" button. This will open the "Limit values"
dialog.

3. Activate the limit values, for which you want a colored identification.
4. Define the color for every activated option.
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5. The colored identification has the following effect:
– Low limit value. Whenever a displayed trend value is below the value defined in the
"Value" input field, the value is shown in the configured color.
– High Limit Value. Whenever a displayed trend value is above the value defined in the
"Value" input field, the value is shown in the configured color.
– Value with uncertain status. Values, whose start value is unknown on activating runtime
or for which a substitute value is used, have an uncertain status. These values are
displayed in the configured colors.
6. Save the configuration.
Note
In WinCC V7 or higher, the display of trend values with uncertain status in trend controls
differs to their display in trend controls in earlier versions of WinCC V7: The trend values
with uncertain status will not be displayed in the control until they have returned to a reliable
state.

How to Configure the Data Connection of Trends
Introduction
The trends are provided with values from various tags to display a tag as a function of another
tag in a certain time range. The values of the trends can also originate from a user archive
independent of time, to e.g. display a setpoint trend.
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Time range of the trend display
Basically, there are two different time references in the trend display:
● Static display. The time range of the trend display is determined by a pre-defined, fixed
time interval, independent of the current system time.

● Dynamic display. The time range of the trend display is determined retrospectively from the
most current values. The display is continuously updated. The configured time range follows
the current system time.

You have three different ways to define the time range of a time range for each of the two time
references:
● The trend is displayed within a defined time interval. You define a start time and an end
time. In a dynamic display, the end time corresponds with the current system time. The
time difference between the start time and the end time is the time range for the trend
display.
● The trend is displayed from a start time throughout a defined time range, e.g. 30 minutes
from the start time. In the dynamic display, the defined time range up to the current system
time is used, e.g. 30 minutes to the current system time.
● Starting from a start time, a defined number of values are shown, e.g. 100 values from the
start time. With the dynamic display, the last values up to the current system time are shown.
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Requirement
● You have opened a picture with the FunctionTrendControl in the Graphics Designer.
● You have defined one or more trends.
● The following prerequisites apply for the basic data:
– If you want to connect data of online tags, you have to have defined process values in
the tag management.
– If you want to connect the data from archive tags, you have to have configured a process
value archive with archive tags.
– If you want to connect the data from an archive tag, you have to have configured a user
archive with columns.
– If you want to use a script to supply the trend values with data in runtime, you will require
a script through the API interface. E.g. the display of a tag as a time function if you do
not want to use the WinCC OnlineTrendControl.

1482

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values

Procedure
1. Go to the "Data connection" tab.

2. Define the data source for each trend. You can select the following:
– Archive tags of a process value archive
– Online tags from the tag management
– User archive columns
– No configured data source to establish a connection in runtime via a script.
3. Click on
to select the tags for the X axis and the Y axis. The online tags connected to
a trend must have the identical update cycle. The archive tags connected with a trend must
originate from the process archive of a server and be acquired in a continuous cycle.
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4. If the data is connected with a user archive, select columns of the user archive for the X
axis and Y axis. Define the "ID" for each column, starting from which the values of the
column will be used.
5. If the trends in the trend window are always updated, activate the "Update" option. If you
e.g. want to compare a current trend display with an earlier trend display, deactivate the
"Update" option for the comparison trend.
6. Configure the time range in which the trend will be displayed:
– If you want to define a fixed time interval, select setting "Start to end time". Enter the
date and time for each.
– If you want to define a time period, select the setting "Time range". Define the date and
time for the start time. The time range is the result of a multiplication of the "Factor" and
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and
the time unit in the "Time range" field.
– If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.
– If the trend will be provided via a user archive, define the number of value pairs for the
area to be displayed. Enter the desired number in the "Number of measurement points"
field.
7. Save the configuration.

How to configure the toolbar and the status bar
Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The
status bar contains information pertaining to the current status of the WinCC control. You can
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The WinCC control is assigned the "Configuration dialog" button function for opening the
configuration dialog in Runtime.
● The configuration dialog of the WinCC control is open.
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How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in
Runtime. For information on the button functions, refer to the description of the
corresponding WinCC control at "Operation in runtime".
3. Determine the sorting order for displaying the button functions in the toolbar. Select the
button functions from the list and the move the functions using the "Up" and "Down" buttons.
4. Define a shortcut key for the functions of the toolbar buttons.
5. Any button functions assigned operator authorizations are only available in Runtime to
authorized users.
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6. An activated button function is displayed during runtime if you deactivate its "Active" option,
however, it cannot be operated.
7. You can set separators between the button functions. Activate the "Separator" option for
the button function to be restricted by separator.
8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status Bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required during runtime in the list of status bar elements. For further
information on status bar elements, refer to the descriptions of the corresponding WinCC
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements
from the list and move these using the "Up" and "Down" buttons.
4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a
pixel value for the width.
5. Configure the general properties of the status bar, e.g. alignment or background color.

How to configure the Ruler window/Statistics window/Statistics area window
Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a
statistics area window. The ruler window/statistics window/statistics area window are
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:
● WinCC OnlineTrendControl
● WinCC OnlineTableControl
● WinCC FunctionTrendControl
Depending on the data evaluation, there are three different types of windows for displaying
values. The following window types are available:
● The ruler window displays the coordinate values of trends on the ruler.
● The statistics area window shows the values of the lower limit and upper limit of the trends
between two rulers or the selected area in the table. The statistics area window is not
planned for the WinCC FunctionTrendControl.
● The statistics window shows the statistic evaluation of the trends between two rulers or the
selected values in the table. The statistics window is not planned for the WinCC
FunctionTrendControl.
All windows can also display additional information on the connected trends or columns.
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Requirement
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or
FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.
2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.
4. Go to the "General" tab in the field "Source" and select the object name of the control that
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be
operated in runtime, you can change the window type in runtime.
6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the
assigned control. Columns for the basic data and columns that are only for the selected
window type or the assigned control are available. Define the column sequence with buttons
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected
columns, click on the respective blocks.
9. If a special format exists for a block, you can configure the format of the block. Deactivate
the option "Apply from source" if the format settings of the connected control are not to
apply in this case. Define the desired format.
10.Define whether the data for the column and the column heading is to be displays as text or
as an icon in the table under "Display".
11.Save the configuration.
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12.Configure the properties and the display of the table for the RulerControl in the "Parameter,"
"Effects" and "Selection" tabs.
For details on configuring the table display, please refer to "Configuration of
OnlineTableControl > How to configure the table display (Page 1380)" in the WinCC
OnlineTableControl documentation.
13.You can export the evaluated data. This requires activating the "Export data" key function
on the "Toolbar" tab.
For details on data export, please refer to "Configuration of OnlineTableControl > How to
export runtime data (Page 1393)" in the WinCC OnlineTableControl documentation.
14.Configuring the TrendRulerControl is possible in runtime.
For more detailed information, please refer to "Configuration of OnlineTableControl > How
to apply online configuration (Page 1395)" in the WinCC OnlineTableControl
documentation.

See also
How to configure the display for the table (Page 1380)
How to export runtime data (Page 1393)
How to define the effect of the online configuration (Page 1395)

How to export runtime data
Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set
up operation of the data export during runtime in the configuration dialog.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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How to configure the operation of the data export
1. Go to the "Export" tab.

2. A standard file name and a standard directory are already entered in the "Data export default
settings". In this case for AlarmControl. If necessary, define a file name and a directory for
the export file.
The file name can be made up of the freely defined name and the following placeholder:
@OBJECTNAME - Object name of the controls
@CURRENTDATE - Current date
@CURRENTTIME - Current time
3. CSV is currently available as data format. Click
in the CSV file.

to specify the delimiter and data format

4. Define the scope of the data export:
– All runtime data is exported
– Selected runtime data is exported. This data export is only possible in WinCC controls
with tabular display.
5. Configure the operation of the data export during runtime. Define:
– whether users are allowed to rename the file, or change the directory.
– whether to display the "Data export default settings" dialog in Runtime.
6. If "Show dialog" is deactivated, the data for operation of the "Export data" button function
is immediately exported to the defined export file.
7. Save the configuration.
8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results
You can export all or selected data to a defined file at runtime using the
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How to define the effect of the online configuration
Introduction
Users can parameterize the WinCC controls in Runtime. You must define the Runtime effects
of the online configuration.
Changes configured in Runtime are saved for the specific user separately from the picture in
the configuration system. The original picture configuration is retained in the configuration
system.
Note
The picture is also replaced at Runtime if you save it in Graphics Designer, or when loading
deltas in online mode. All online changes are lost.
The different configurations are only activated for new users after you performed a picture
change.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults
are only available in the configuration system. The option buttons are not available in
Runtime.
Select one of the three effects of the online configuration:
– "Do not retain". The online configurations are not retained in Runtime. This default
setting disables all options for Runtime users. Online configurations are lost at the next
picture change and on activation/deactivation of the project.
– "Retain during Runtime". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the
project.
– "Retain permanently". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
and on activation/deactivation of the project if the "retain" option is enabled.
3. Define corresponding user authorizations for online configuration.
4. The option buttons of the "Online configuration on next picture change" can be enabled for
operation in the configuration system and at Runtime by setting the "retain at Runtime" and
"retain permanently" defaults. The "reset" operation is only available in Runtime, because
the configuration system contains the original configuration.
Select one of three effects of the online configuration at the next picture change:
– Select "discard" if to discard the online configuration at the next picture change.
– Activate "retain" to activate the online configuration based on default settings at the next
picture change or on activation/deactivation of the project.
– Activate "Reset" if you want to apply the picture saved in the configuration system in
Runtime. All online changes are lost.
5. Save the configuration.

How to make the toolbar for the FunctionTrendControl dynamic
Introduction
The default functions for operating the WinCC FunctionTrendControl are no longer supported
for the new WinCC FunctionTrendControl as of WinCC V7.0. You can use the WinCC types
of dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC Controls as of V7.0 you do not need special functions to implement operation of
the control by assigning dynamic properties to the toolbar. The previously used standard
functions "TrendToolbarButton" are no longer supported.
If you do not want to operate the control via the toolbar, you can write the "ID" for the desired
button in the "ToolbarButtonClick" object property with an optional type of dynamics.
The "ID" of a button of the toolbar can be determined:
● with the table on page "Operation of the FunctionTrendControl in runtime".
● in the configuration dialog of the FunctionTrendControl on the "Toolbar" tab via field "Object
ID".
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Example: Open the configuration dialog for the control
In order to open the configuration dialog of the control, dynamics are possible as follows:
● VBScript:
– ScreenItems("Control1").ToolbarButtonClick = 2
– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog
– Or, with the following notation with the support of "Intellisense":
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog
● C script:
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);
● Direct connection
– In the dialog for the direct connection for the source, enter "2" as a constant
– Select the property "ToolButtonClick" for the object "Control1" for the target "Object in
picture"

See also
Operating the FunctionTrendControl in runtime (Page 1496)

Operation in Runtime
Operating the FunctionTrendControl in runtime
Introduction
The trend window is operated in runtime via the buttons in the toolbar. If you do not want to
operate the trend window via the toolbar, you can write the "ID" for the desired button in the
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview
The overview shows all symbols in "standard" style. If you create a design of the controls with
the "Simple" style, the representation of the symbols is the same as with FunctionTrendControl
before WinCC V7. You can find an overview on the page "Before WinCC V7: Output process
values as function of another tag > Operation in Runtime > Operation of Function Trend Control
in Runtime".
Icon

Description

ID

"Help"

1

Calls up the help on WinCC FunctionTrendControl.
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"Configuration dialog"

2

Opens the configuration dialog, in which you can change the properties of
the FunctionTrendControl.
"Zoom area"

4

Define an area by dragging with the mouse in the trend window. This cut-out
of the trend window is made larger. The "Original view" button brings back
the original size of the view.
"Zoom +/-"

5

Zooms in on or out off the trends in the trend window. . The left mouse button
increases the size of the trends. By holding the "Shift" button down, the left
mouse button zooms out of the trends. The "Original view" button brings
back the original size of the view.
"Zoom X axis +/-"

6

Zooms in on or out off the X axis in the trend window. The left mouse button
increases the size of the X axis. By holding the "Shift" button down, the left
mouse button zooms out of the X axis. The "Original view" button brings back
the original size of the view.
"Zoom Y axis +/-"

7

Zooms in on or out off the Y axis in the trend window. The left mouse button
increases the size of the Y axis. By holding the "Shift" button down, the left
mouse button zooms out of the Y axis. The "Original view" button brings back
the original size of the view.
"Move trend area"

8

The button moves the trend along the X axis and Y axis in the trend window.
"Move axis area"

9

This button moves the trends along the value axis in the trend window.
"Original view"

10

This button exits the zoomed trend display and restores the original view.
"Select data connection"

11

This button opens a dialog for the archive selection and tag selection.
"Select trends"

12

This button opens the dialog for toggling between visible and invisible trends.
You can also define which trend is displayed in the foreground.
"Select time range"

13

This button opens a dialog where you can specify the time range to be
displayed in a trend window.
"Previous trend"

14

This button is used to display the previous trend of the trend window in the
foreground.
"Next trend"

15

This button is used to display the next trend of the trend window in the
foreground.
"Stop"

16

The updated display is stopped. The data is saved to the clipboard and
added the next time you click on the button in the trend window.
"Start"

16

Resume updated display.
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"Print"

17

Click this button to print the trend shown in the trend window. The print job
used for printing is defined in the configuration dialog on the "General" tab.
"Export data"

20

This button is used to export all or the selected runtime data to a "CSV" file.
If the option "Display dialog" is active, a dialog will open in which you can
view the export settings and start the export. You can also select the export
file and directory, provided you have the required authorizations.
If no dialog is displayed, the export of data to the preset file will be started
immediately.
"Ruler"

3

The coordinate points of a trend are queried with this button. The trend data
is displayed in the ruler window. The button is only functional if a ruler window
is connected with the FunctionTrendControl.
"Connect backup"

18

This button opens a dialog in which you can connect selected archives to
WinCC Runtime.
"Disconnect backup"

19

This button opens a dialog in which you can disconnect selected archives
from WinCC Runtime.
"User-defined 1"

1001

Shows the first key function created by the user. The function of the button
is user-defined.

Possible elements of the status bar
The following elements can appear in the status bar of the trend window:

Icon

Name

Description

Connection status

Shows the status of the data connections:
● No faulty connections
● Faulty connections
● All connections are faulty

Date

Shows the system date.

Time

Shows the system time.

Time base

Shows the time base used in the display of times.

Double click on the icon for the connection status to open the window "Status of the data
connections", in which the name, status and tag name of the data connection are listed.
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Online configuration of the FunctionTrendControl
Introduction
In runtime, you can configure online and change the display of the WinCC
FunctionTrendControl. Configuring the WinCC FunctionTrendControl defines how to proceed
with a picture change or after ending runtime with online configurations.

Overview
The following buttons functions make online configuration possible in FunctionTrendControl:
● With key function "Configuration dialog"
● With key function "Select trends"
● With key function "Select time range"

Key function "Configuration dialog"
Use the key function "Configuration dialog"
example to change the trend display.

to access the configuration dialog tabs, for

Key function "Select trends"
The key function "Select trends"
opens a dialog in which you can show or hide trends. You
can move trends to the foreground by changing the sequence of the trends.
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Key function "Select time range"
Select the time range in which the trend is to be displayed with the key function "Select time
.
range"

Field

Description

Trends

Select the trend for which you want to define a time range.

time range

Set the time range:
● If you want to define a fixed time interval, select setting "Start to end time". Enter
the date and time for each.
● If you want to define a time period, select the setting "Time range". Define the date
and time for the start time. The length of the time interval to be displayed is
determined by multiplying the "Factor" by the "Time unit".
● If you want to display a certain number of values, select the setting "Number of
measurement points". Define the date and time for the start time. Enter the desired
number of measurement points in the input field.

The entry format of the date and time depends on the Runtime language used.

Starting and Stopping Update
Introduction
The update of the trend in the trend window can be started and stopped with the "Start/Stop"
key function.
The button indicates whether the update is stopped or not:

1500

●

: Update has been stopped. Click on the button to continue updating.

●

: Update has been started. Click on the button to stop updating.
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How to display the trend in the foreground
Introduction
If more than one trend are to be displayed in a trend window, you can use key functions to
define which trends will be displayed in the foreground.

Requirement
● You have configured key functions "Select trends", "Previous trend" and "Next trend".

Procedure
●

is used to open a dialog for displaying or hiding trends. You can also define which trend
is in the foreground.

●

is used to display the next trend of the trend window in the foreground.

●

is used to display the previous trend of the trend window in the foreground.

How to Determine the Coordinates of a Point
Introduction
Key function "Ruler" is used for defining the coordinates of a point on the trend with cross-hairs
or the rulers. You can zoom in on an area of the trend to make coordinate finding easier. You
can also read many trend parameters in the trend window with the mouse on the trend.

Requirement
● You have configured a WinCC FunctionTrendControl. In order to highlight the ruler in the
trend window, you can increase the line weight on the "Trend window" tab and configure
the color.
● You have configured the "Ruler" key function. If you want to zoom in on a section of the
trend, configure key functions "Zoom area" and "Original view".
● You have configured a WinCC RulerControl as a ruler window and connected it with the
FunctionTrendControl.
● You have activated runtime.

How to display the coordinates
1. In FunctionTrendControl, click on

.

2. Move the cross-hairs or the ruler to the desired position with the mouse.
3. If you want to zoom in on an area, click on
the mouse.

. Move the ruler to the desired position with

4. If you want to return to the original view, click on
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Result
Two rulers or the cross-hairs appear in the trend window. In the ruler window, besides the X
value and the Y value, the data that you have configured in WinCC RulerControl is shown in
the columns.
The displayed values can be assigned an additional attribute in the form of a letter:
● Letter "i." : The displayed value is an interpolated value.
● Letter "u." : The displayed value has an uncertain status. The value is not certain if the initial
value is not known after runtime has been activated, or when a substitute value is used.

Other values can be determined by positioning the mouse pointer on the cross-hairs or the
ruler and moving it to the desired position while holding the left mouse button pressed.
Note
The "uncertain" status of a value can also be indicated in the displayed trend characteristic.
You must activate the "Value with uncertain status" option on the "Trends" tab under "Limit
values".
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How to use the zoom functions in trend windows
Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view
for trends, axes and various zoom areas of the trend window.

Overview
The following zoom functions are available in the trend window:
● "Zoom area"
● "Original view"
● "Zoom +/-"
● "Zoom X axis +/-"
● "Zoom Y axis +/-"
● "Move trend area"

Requirement
● You have configured a WinCC FunctionTrendControl.
● You have configured the buttons for the required zoom functions for the toolbar.
● You have activated runtime.

How to zoom in on a segment of a trend window
1. Click on

.

2. In the trend window, click one corner of the area that you wish to enlarge.
3. Hold down your left mouse button and drag the area you want to enlarge until it reaches
the desired size. If the highlighted area contains at least two measured values, the selected
trend area is displayed in the trend window.
4. Release the left mouse button. The selected segment is magnified. If you want to increase
the size further, repeat the process.
5. Click on

. The trend window is shown in the originally configured view again.

How to zoom in and zoom out of the trends
1. Click on

.

2. Click in the trend window with the left mouse button to zoom in on the trends in the trend
window. If you want to increase the size further, repeat the process.
3. If you want to zoom out of the trends, press the "Shift" button while clicking with the left
mouse button.
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4. While zooming in or zooming out with trends, the 50% value of the trends is always in the
middle of the value axes.
5. Click on

. The trend window is shown in the original view again.

Note
If you change the value area on the "X Axes" or "Y Axes" tab in the configuration dialog
while zooming, the visible zoom area is set to the new value area.

How to zoom the X axis and the Y axis
1. Click on

to zoom in on the X-axis or on

to zoom in on the Y-axis.

2. Click in the trend window with the left mouse button to zoom in on the X axis or Y axis. If
you want to increase the size further, repeat the process.
3. If you want to zoom out of the X axis or Y axis, press the "Shift" button while clicking with
the left mouse button.
4. While zooming with axes, the 50% value of the trend is always in the middle of the axes.
5. Click on

. The trend window is shown in the original view again.

How to move the trend area
1. Click on

.

2. While holding the left mouse button down, move the cursor in the desired direction in the
trend window. The displayed area in the trend window is adapted on the X axis and on the
Y axis.
3. If you click on

again, the original trend window view will be restored.

6.5.3

Process value output in reports

6.5.3.1

Process value output in reports

Introduction
You have the option to output process values in the form of a report. At the end of each shift,
you can for example load the achieved production figures from the process value archive and
print them out in report format. You create reports in the Report Designer.
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Report Designer:
The Report Designer contains a number of preset layout templates that you can change to
suit your needs. The Report Designer is also used to create print jobs to initiate the output.

For the output of process values in report format, you can make use of many preset layout
templates.
Layouts on the basis of WinCC Controls as of WinCC V7
Use the new layouts that are based on the "WinCC Control Runtime Printprovider" layout
templates in WinCC V7 or higher. The output of the report object depends on the layout of the
control in Runtime.
● @Online Table Control - Picture.RPL and @Online Table Control - Table.RPL: Process
value output on the basis of WinCC Online Table Control.
● @Online Trend Control - Picture.RPL: Process value output on the basis of WinCC
OnlineTrendControl.
● @Function Trend Control - Picture.RPL: Process value output on the basis of WinCC
FunctionTrendControl.
Layouts on the basis of WinCC Controls prior to WinCC V7
You have detailed parameterization options in the following layouts. You can configure many
setting options of the tabs and the dynamizable parameters of the WinCC Controls prior to
WinCC V7.
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● @CCOnlineTableCtrl-CP.RPL: Process value output on the basis of WinCC Online Table
Control.
● @CCOnlineTrendCtrl-Curves-CP.RPL: Process value output on the basis of WinCC Online
Trend Control.
● @CCFunctionTrendCtrl-CP.RPL: Process value output on the basis of WinCC Function
Trend Control.

General Procedure
The configuration procedure for reports consists of the following steps:
1. Selection of process data and adjustment layout: Select the process data that will be
displayed in the report. If necessary, modify the report layout.
2. Configuring the Print Job Configure the print output of the report by defining the time period,
the number of pages and the output medium.

See also
Output of Process Values (Page 1370)
How to Configure the Static Parameters of WinCC Online Table Control (Page 2012)
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
How to Configure the Static Parameters of WinCC Online Trend Control (Page 2017)
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
How to Configure the Static Parameters of WinCC Function Trend Control (Page 2022)
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)
Introduction to Runtime Documentation (Page 1840)
How to create print jobs for the Runtime documentation (Page 1846)

6.5.4

Process value output before WinCC V7

6.5.4.1

Process value output in process pictures before WinCC V7

Introduction
You have the option to output archived and current process values in Runtime. For this, WinCC
provides two ActiveX Control that can be inserted into a process picture, which consists of a
table or trend window.
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Process Value Output in Tables
To output process values in table format in Runtime, use the WinCC Online Table Control.
You can display the archive tags:

Process Value Output as Trends
To output process values in trend format in Runtime, use the WinCC Online Trend Control.
You can then fill the table with archived or process tags:

Use the WinCC Online Trend Control to display process trends, etc. You also have the option
to show more than one trends in a window, and to highlight areas that are outside the limit
range in a different color.
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6.5.4.2

Before WinCC V7: Process Value Output in Table Format

WinCC Online Trend Control
Introduction
In order to process data in table form, WinCC uses Online Table Control to offer the option of
displaying process data in a table. You have the option to display either current or archived
values.
Display of tag values during Runtime takes place in ActiveX Control, inserted and configured
in a picture in Graphics Designer. In order to facilitate access to the tags to be displayed,
process value archives and the tags contained therein must be configured in Tag Logging.

Requirement
The following prerequisites apply to the display of trends in WinCC Online Table Control:
● Only archive tags can be used for tables.
● Each table can contain maximum 30,000 values.
● Archive tags in a table must originate from the same process value archive of a server,
must have the same update cycle, and must be recorded in a continuous cycle.

Representation Formats
Introduction
Two basic display types are available for displaying tag values in tabular format.
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Shared time column
In this display type, the table contains only one time column. This column displays the archived
times of the tag output in the first column. A table to display the values of three tags will therefore
consist of four columns in Runtime.
Note
The display of tags with different acquisition times in a table with a shared time column is
problematic, since the tag values might not correspond to the indicated archived times of the
time column. These values are displayed as crossed out.

Separate time columns
In this display type, the archived times of each tag are displayed in separate columns. A table
to display the values of three tags will therefore consist of six columns in Runtime.
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Configuration
The table display type to be used is specified on the "General" tab of the "Properties of WinCC
Online Table Control" dialog.

See also
Time Range of a Table Display (Page 1511)
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Time Range of a Table Display
Introduction
With respect to time ranges to be displayed, the table display of tags can be shown in various
ways:

Static Display
In a static display the archived tag values are shown for a defined time period.

In the "Column" tab of the "WinCC Online Table Controls" property dialog, the static display
type is configured by deactivating the "Update" option. The time range to be displayed is set
either
● by entering a start time and a time range.
● by entering a start time and an end time.
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Dynamic Display
In a dynamic display the end time in a table always corresponds to the current system time.
New measurement values coming in will be included in the display.

In the "Column" tab of the property dialog of "WinCC Online Table Controls" the dynamic
display type is configured by activating the "Update" option. The time range to be displayed is
set either
● by entering a time range.
● by the time difference between the specified start and end times.

Note
Upon starting Runtime the tag values to be displayed are either read from the archive or are
set to zero. This function is set in the "General" tab of the "Properties" dialog.

See also
Representation Formats (Page 1508)

1512

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values

Configuration
Configuration of WinCC Online Table Control
Introduction
In order to display process values in Runtime using WinCC Table Control, you must execute
the following steps:
In Tag Logging
1. Use the Archive Wizard to create a process value archive.
2. Configure the process value tags it will contain.
In Graphics Designer
1. Link the WinCC Table Control to a Graphics Designer picture.
2. Link the columns to be displayed in Table Control to the tags of the process value archive.
Note
The table window can be influenced by means of standard functions. If you do not wish to
use the toolbar functions to operate the table window, any Graphics Designer objects can be
made dynamic using the appropriate functions.

See also
How to Create a Process Value Archive (Page 1514)
How to Insert the Online Table Control in a Picture (Page 1513)

How to Insert the Online Table Control in a Picture
Introduction
Tags are displayed in runtime in an ActiveX Control, which is inserted in a picture and
configured with the aid of the Graphics Designer.
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Procedure
1. Start Graphics Designer and open a new picture.
2. Click the "WinCC Online Table Control" object on the "Controls" tab in the object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the control to the desired size.
The "Insert a Control" dialog is opened.
5. Select the WinCC Online Table Control and confirm your selection by clicking "OK".
The "Properties of WinCC Online Table Control" quick configuration dialog box opens.
6. Configure the table properties according to your specifications.
7. Close the dialog with the "OK" button.

See also
How to Display Process Value Tags (Page 1515)

How to Create a Process Value Archive
Introduction
In order to display tags in a WinCC Online Table Control, you must configure a process value
archive. A process value archive is created most easily with the help of the Archive wizard.
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Procedure
1. Start Tag Logging and select the "Archive Wizard ...". command in the archive pop-up menu.

2. In the second step of the Archive Wizard, assign a meaningful name to the process value
archive.
3. In the third step of the Archive Wizard, include the desired tags in the process value archive.
4. Close the Wizard by clicking "Apply".
Note
Provided that the process tags contained in an archive were not defined within the Archive
Wizard, new tags can be added by using the pop-up menu of a process value archive.

See also
Configuration of WinCC Online Table Control (Page 1513)

How to Display Process Value Tags
Requirement
● Configure tags of data type "Signed 16-bit value".
● Create a process value archive using the configured tags as process value tags.
● Insert the Online Table Control in a picture of Graphics Designer.

Procedure
1. Open a picture in Graphics Designer using Online Table Control.
2. Double-click the Online Table Control.
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3. Click the "Columns" tab.

4. In the "Archive/Tag Selection" section, use the "Selection" button to select the process
value tag for the selected column.
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5. Click the "General" tab.

6. Define the behavior of the control in Runtime.
7. Configure additional properties using the "Control" tabs.
8. Close the dialog with the "OK" button.
9. Save the picture.

See also
How to Insert the Online Table Control in a Picture (Page 1513)
How to Create a Process Value Archive (Page 1514)
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Operation in Runtime
Operation of Online Table Control in Runtime
Introduction
In Runtime, the table window is operated by means of the toolbar buttons.
"Online Help System"
Calls up the online help
"Open the Configuration Dialog"
Select dialog to assign display parameters.
"First Data Record"
The table displays the tag values within a specified time range, beginning with
the first archived value.
"Previous Data Record"
The table displays the tag values within the previous time interval, based on
the currently displayed time interval.
"Next Data Record"
The table displays the tag values within the next time interval, based on the
currently displayed time interval.
"Last Data Record"
The table displays the tag values within the specified time interval, ending with
the last archived value.
"Edit"
Upon activating this button, you can double-click any table cell to edit its
contents This will stop the updated display.
"Dialog for Archive and Tag Selection"
This button will open the dialog for archive and tag selection.
"Dialog for Selecting Columns"
This button will open the dialog for toggling visible and invisible column view.
"Select Time Range"
This button will open the dialog to specify the time range displayed in a table
window.
"Previous Column to Front"
This button allows you to display the current last column of the table window
as the first data column of the table. In a joint selection the corresponding
archived times are displayed in the time column. In a joint selection the
corresponding archived times are displayed in the time column
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"Next Column to Front"
This button allows you to display the current last column of the table window
as the first data column of the table. In a joint selection the corresponding
archived times are displayed in the time column. In a joint selection the
corresponding archived times are displayed in the time column
"Start/Stop the Update"
The updating for the display is stopped. The values are stored in interim
memory and resupplied after reactivating the button.
"Start/Stop the Update"
Resume display.
"Print Log"
Initiates printing of columns displayed in table window. Print job used during
printing can be specified in the control properties on the "General" tab.
"Select Statistics Area"
Enables mouse-based specification of time frame for calculation of statistics in
table window.
"Calculate Statistics"
Opens a statistics window to display minimum, maximum, average and
standard deviation for a specified time frame and a specified column.

See also
Starting and Stopping Update (Page 1524)
How to Generate Statistics of Runtime Data (Page 1527)
Display Column in Front (Page 1524)
How to Edit a Table Cell in Runtime (Page 1525)
Online Configuration for Online Table Control (Page 1519)

Online Configuration for Online Table Control
Introduction
In order to change the configuration of Online Table Control in Runtime, you have four options
available.
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Key function "Open the Parameter Dialog"
The key function "Open Set Configuration Dialog"
for table display.
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Key function "Dialog for Archive and Tag Selection"
The key function "Dialog for Archive and Tag Selection"
tags linked to the columns of a table window.

allows for the specification of the

Array

Description

Column

Here, you can select one of the configured columns.

Selectio
n

Using the "Selection" button, you open the dialog to select an archive and the tags contained
therein.

Persiste
nce

If the "Persistence in RT and CS" option is not activated, any changes made to the settings
are only effective within Runtime. Whether or not any changed settings remain effective
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also
transferred to the configuration system. To do this, you must open the picture in Graphics
Designer and save it once again. The changed settings are also used when the project is
reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with PCS
7 projects or TIA projects. When you completely load the ES to the OS, the changed settings
on the OS will be overwritten.
Configure the properties of the controls on the ES.
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Key Function "Dialog for Selecting Trends"
The key function "Dialog for Selecting Columns"
visible and invisible columns.

opens the dialog for toggling between

Array

Description

Column to
Front

If a shared time column is used, the archived timers of the first column of the table will
be displayed. The first column can be changed either in this dialog or by using the
"Previous column in the front" and "Next column in the front" buttons in the toolbar.

Column
visible/
invisible

In this area, you can specify which configured columns are not to be shown.

Persistence

If the "Persistence in RT and CS" option is not activated, any changes made to the
settings are only effective within Runtime. Whether or not any changed settings remain
effective after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also
transferred to the configuration system. To do this, you must open the picture in
Graphics Designer and save it once again. The changed settings are also used when
the project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the
changed settings on the OS will be overwritten.
Configure the properties of the controls on the ES.

Note
The first column of a table window cannot take the "invisible" attribute.
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Key Function "Select Time Range"
opens a dialog to specify the time range to be
The key function "Select Time Range"
displayed. If the columns of a table window are to be displayed with a common time axis, the
specified time range applies to all columns.

Array

Description

Column

Here, you can select one of the configured columns.

Time
Selection

The time interval to be displayed in the table window can be set
● by entering a start and an end point (the "Time Range" setting not activated).
● by entering a start time and a time range. ("Time Range" setting activated). The length
of the time interval to be displayed is determined by multiplying the "Factor" by the
"Range".

Persistenc
e

If the "Persistence in RT and CS" option is not activated, any changes made to the settings
are only effective within Runtime. Whether or not any changed settings remain effective
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also
transferred to the configuration system. To do this, you must open the picture in Graphics
Designer and save it once again. The changed settings are also used when the project
is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the changed
settings on the OS will be overwritten.
Configure the properties of the controls on the ES.
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The entry format of the date and time depends on the Runtime language used.
Note
The WinCC Online Table Control cannot display more than 1000 values within a selected
time range. This has to be taken into account when setting the time range.

See also
Configuration of WinCC Online Table Control (Page 1513)
Operation of Online Table Control in Runtime (Page 1518)

Starting and Stopping Update
Introduction
With the key function "Start/Stop Update", you can stop or continue the updates of the columns
contained in the table window. When updates are stopped, you can change the displayed time
frame and therefore display measurement values from the process value archive in the table
window.
When updates are stopped, you can change the displayed time frame and therefore display
measurement values from the process value archive in the table window.
●

: When updates are stopped, you can change the displayed time frame and therefore
display measurement values from the process value archive in the table window.

●

: When updates are started, you can change the displayed time frame and therefore
display measurement values from the process value archive in the table window.

See also
Operation of Online Table Control in Runtime (Page 1518)

Display Column in Front
Introduction
If a shared time column is used, the archived times of the first column of the table will be
displayed in the time column.
The sequence of columns in the table window can be changed in Runtime:
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● using the

button (key function "Dialog for Column Selection")

● using the

button: (key function "Next Column to Front")

● using the

button: (key function "Previous Column to Front")
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Configuration
The sequence of columns is configured on the "Column" tab of the "Properties of WinCC Online
Table Control" dialog. It can be changed via the "Up" and "Down" buttons.

See also
Operation of Online Table Control in Runtime (Page 1518)

How to Edit a Table Cell in Runtime
Introduction
With the key function "Edit" you have the option of manually inserting laboratory or correction
values into a process value archive.

Requirement
● Configuration of Online Table Control.
● Configure the display of a toolbar by using the "Edit" key function.
● Start Runtime.
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Procedure
, the table display is halted. Double-click any cell in the table
By clicking the "Edit" button
to change the content of that cell. Values that occur during the edit process are archived.
Note
Values occurring during the edit process can be viewed in the static display. The static display
is configured on the "Column" tab of the "Properties" dialog by deactivating the "Update"
option.
If the time stamp for a joint selection is changed by editing, the new value will only be written
in the first column of the database. The time stamp for the other columns will remain
unchanged.
Return to the table display in Runtime mode by clicking the "Edit" button again.

See also
Operation of Online Table Control in Runtime (Page 1518)

Display of Archived Values
Introduction
The buttons in the toolbar of a table window and the respective keyboard shortcuts allow you
to "page" through the archive.
In the table window, the values archived for a tag will be displayed within a time interval. The
width of this interval is determined by the time range to be displayed or results from the time
difference of entered start and end times.

Buttons for Archived Values
The table displays the tag values within a specified time range, beginning with
the first archived value.
The table displays the tag values within the previous time interval, based on the
currently displayed time interval.
The table displays the tag values within the next time interval, based on the
currently displayed time interval.
The table displays the tag values within the specified time interval, ending with
the last archived value.
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Note
The WinCC Online Table Control cannot display more than 1000 values within a selected
time range.

See also
Operation of Online Table Control in Runtime (Page 1518)
Online Configuration for Online Table Control (Page 1519)
Configuration of WinCC Online Table Control (Page 1513)

How to Generate Statistics of Runtime Data
Introduction
You can generate a statistical evaluation of Runtime process data in the table window. The
following results are displayed in a statistics window for all selected columns and a specified
time frame:
● Minimum
● Maximum
● Average
● Standard deviation

Requirement
● Configuration of Online Table Control.
● Configure the display of a toolbar by using the key functions "Select statistics area",
"Calculate statistics" and "Start/stop update". If you wish to calculate statistics for all values
of a table, you do not need the key function "Select statistics area".
● Configure the display by using the key function "Select time range" if you wish to choose
a statistics area outside of the time range displayed in the columns.
● You can specify the font for the table that is displayed with the key function "Calculate
statistics" in the "Font" tab and via the property "StatisticsFont".
● Start Runtime.
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Procedure
button. If you wish to calculate statistics for all table values,
1. In the toolbar, click the
click
.
The updated display is stopped, while process data archiving is continued.
2. In order to specify the time period for the calculation, use the mouse to select the table lines
for the desired time frame. For different columns with different time frames you can select
different time ranges for the calculation of statistics.

3. In the toolbar, click the

button.

4. The "Statistics" window opens with results of the calculation for the specified time frame of
one column.

5. If you wish to display the results of additional table columns, select the appropriate column
in the "Column" field.
6. In order to continue with the display of Runtime data in the table, close the statistics window
and click the
button in the toolbar.
7. If you require a statistical analysis of process data not displayed in the table window, click
the
button. Enter the desired time frame in the "Select time range" dialog. The process
data will be displayed for the specified time frame, and statistics can be calculated.
Note
For additional statistical analysis of process data and archiving of results you must write the
scripts yourself.
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See also
Operation of Online Table Control in Runtime (Page 1518)
Online Configuration for Online Table Control (Page 1519)
Configuration of WinCC Online Table Control (Page 1513)

6.5.4.3

Before WinCC V7: Process Value Output in the Form of Trends in Process Pictures

WinCC Online Trend Control
Introduction
In order to process data in graphic form, WinCC uses Online Trend Control to offer the option
of displaying process data as a trend. The trend type to be used can be selected. Furthermore
you have the option of displaying current or archived values.
Display of tag values during Runtime takes place in ActiveX Control, inserted and configured
in a picture in Graphics Designer.

Requirement
The following requirements apply to the display of trends in WinCC Online Trend Control:
● In a WinCC Online Trend Control any number of trends can be displayed. However, it is
recommended to configure no more than 8 trends.
● A trend can represent a maximum of 30000 value pairs. Depending on the screen resolution
and the settings, the display might however vary.
● The trends can be based on online tags or archived tags.
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● Online tags of a trend must have the identical update cycle.
● In order to display tags as a function of other tags, you should use the WinCC Function
Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen
resolution and selected size of the trend window. Therefore, when displaying trends, it is
possible that fewer values are displayed in the trend window than are actually archived.
If, for example, in an area of 100 pixels 200 measured values are archived, each pixel
represents 2 measured values. The value shown on the screen is that of the most recent data
(most recent time stamp).

Representation Trend Lines
Representation Trend Lines
Introduction
WinCC Online Trend Control has a multitude of options to display a trend.

See also
Representation of Staggered Trends (Page 1534)
Identification of Time Jumps and Time Overlaps (Page 1537)
Time Range of Trend Display (Page 1535)
Write direction (Page 1534)
Representation Using Common Axes (Page 1532)
Representation formats (Page 1531)
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Representation formats
Introduction
Three basic trend format are available for the graphic display of tag values.

Single Values
Value of measurement points are shown as dots.

Linear Interpolation
The trend line is interpolated on a linear basis from values of measurement points. The trend
is represented as either a solid line or a dashed line. The area under the curve can also be
displayed in a solid color.

Stepped trend
The trend line is interpolated as a stepped curve from the values of measurement points. The
trend is represented as either a solid line or a dashed line. The area under the curve can also
be displayed in a solid color.

Configuration
You configure the trends in the Graphics Designer in the Properties dialog on WinCC Online
Trend Control in the Trends tab.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1531

Archiving Process Values
6.5 Output of Process Values

See also
Representation Trend Lines (Page 1530)

Representation Using Common Axes
Introduction
If multiple trends are to be displayed in a trend window, you have the choice of using individual
axes for each trend or using shared X/Y axes for all trends.

Representation Using Different Axes
If the tag values to be displayed in a tag window differ greatly, the use of shared axes for the
trend display is not recommended. The tag values can be read more easily if different axial
scales are used. You can singly display the Y-axis for the trend in the foreground.

Representation Using Common Axes
If comparison of trend characteristics is important, it is recommended to display trends with
common axes. You can assign a color for the common X-axis.
You can determine the exact tag values Runtime through zoom or coordinate inquiry.
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Configuration
You configure the display options of the axes in the Graphics Designer in the Properties dialog
on WinCC Online Trend Control in the General tab.
Note
When configuring an Online Trend Control, only tags with an identical updating cycle should
be displayed in a trend window in the case of several trends with a common time axis. In the
case of tags with different updating cycles, the length of the time axis is not identical for all
tags. Since the tag trends are updated at different times due to the different updating cycles,
a minimal different in the end time for the time axis occurs on each change. As a result, the
trends displayed skip slightly to and fro on each change.

See also
Representation Trend Lines (Page 1530)
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Representation of Staggered Trends
Introduction
In a staggered display, the trends are displayed offset over each other in the trend window.
For each trend, the value range to be displayed can be set for the Y axis.

Configuration
You configure the display of the staggered curves in the Graphics Designer in the Properties
dialog on WinCC Online Trend Control in the General tab.

See also
Representation Trend Lines (Page 1530)

Write direction
Introduction
With the "Write Direction" option, you can specify where the current measurement values are
to be displayed. Setting "From the bottom" means that the current measurement values are
processed from downward.
If you select for the write direction the "From the top" or "From the bottom" setting, you must
use a True-Type font for the best display of the time axes labels in the trend window.
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Configuration
You configure the write direction of the data in the Graphics Designer in the Properties dialog
on WinCC Online Trend Control in the General tab.

See also
Representation Trend Lines (Page 1530)

Time Range of Trend Display
Introduction
With regard to the time ranges to be displayed, there are a number of ways to present a trend
display of tags:

Static Representation of a Trend
Static representation presents the course of a tag within a defined time interval, based on the
archived values.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1535

Archiving Process Values
6.5 Output of Process Values
The static display is configured on the "Time Axis" tab of the "Properties" dialog by deactivating
the "Update" option. The time range to be displayed is set either
● by entering a start time and a time range.
● by entering a start time and an end time.
● by entering a start time and the number of measurement points to be displayed.

Note
This type of display can only be used for archive tags.

Dynamic Representation of a Trend
In a dynamic display, the end time of a trend always corresponds to the current system time.
New measurement values coming in are included in the display.

The static display is configured on the "Time Axis" tab of the "Properties" dialog by deactivating
the "Update" option. The time range to be displayed is set either
● by entering a time range.
● by entering the number of measurement points to be displayed.
● by the time difference between the specified start and end times.
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Note
Upon opening the trend window in Runtime, the tag values to be displayed are either read
from the archive or are set to zero. This function is set in the "General" tab of the "Properties"
dialog.

See also
How to Dynamize a Time Range in a Sript (Page 1544)
Representation Trend Lines (Page 1530)

Identification of Time Jumps and Time Overlaps
Introduction
By changing the time, e.g. by switching from daylight saving to standard time or vice versa,
time jumps or time overlaps may occur in the archive.
In a trend display of archived values, the time axis labeling is modified and marked with a
vertical line in the presence of time gaps or time overlaps.
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Configuration
On the "Limit Values" tab of the "Properties of WinCC Online Trend Control" dialog, the marker
line can be assigned a color.

See also
Representation Trend Lines (Page 1530)

Configuration
Configuration of WinCC Online Trend Control
Introduction
The steps necessary for configuration of WinCC Online Trend Control depend on the tags you
wish to display.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1539

Archiving Process Values
6.5 Output of Process Values
Display of Online Tags
1. The tags you wish to display need to be configured in WinCC Explorer.
2. Link WinCC Online Trend Control to a picture in Graphics Designer and modify the
properties of ActiveX Control.
Display of Archive Tags
1. The tags you wish to display need to be configured in WinCC Explorer.
2. Use the Archive Wizard to create a process value archive.
3. Configure the process value tags it is to contain.
4. Link WinCC Online Trend Control to a picture in Graphics Designer and modify the
properties of ActiveX Control.

See also
How to Insert an Online Trend Control in a Picture (Page 1540)
How to Configure Trends in Online Trend Control (Page 1542)
How to Dynamize a Time Range in a Sript (Page 1544)
How to Activate the Example for Online Trend Control (Page 1547)

How to Insert an Online Trend Control in a Picture
Introduction
The trends are displayed during Runtim in an ActiveX Control that you can configure in
Graphics Designer.
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Procedure
1. Start Graphics Designer and open a new picture.
2. Click the "WinCC Online Trend Control" object on the "Controls" tab in the object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the control to the desired size.
The "Properties of WinCC WinCC Online Trend Control" quick configuration dialog is
opened.
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5. Configure the properties of WinCC Online Trend Control in the General tab.

6. Close the dialog with the "OK" button.

See also
How to Configure Trends in Online Trend Control (Page 1542)

How to Configure Trends in Online Trend Control
Introduction
Define the trend properties in the tabs of the WinCC Online Trend Control configuration dialog.
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Requirement
● You have inserted the tags for data supply to the trends in Tag Management.
● You have configured the process value archive while supplying archive tags as data.
● You have inserted WinCC Online Trend Control in a picture in Graphics Designer and
defined the properties of Control.

Procedure
1. Double-click WinCC Online Trend Control.
2. Click the "Curves" tab.

3. Use "+" key to define the desired number of trends.
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4. Define the sequence of trends in control using "Up" and "Down" keys.
5. Select in the Trends section: one trend to define the trend properties and data supply.
6. In the "Archive/ Tag selection" define the data supply to the trend. In the "Data supply" field,
define whether the data is to be provided online or from an archive. Select the corresponding
tag via the "Selection" button.
7. Specify the display type and line weight of the trend.
8. Configure additional properties of the trend on the WinCC Online Trend Control tab.
– In the Time Axis tab, you can define the time range for accessing the archived values.
– In the Value Axis tab define the value range properties, for e.g. scaling.
9. Close the dialog with the "OK" button. Configuration of WinCC Online Trend Control is
saved.

See also
How to Configure the Value Range of Trends (Page 1545)

How to Dynamize a Time Range in a Sript
Introduction
With WinCC Online Graph Control, the properties for "EndTime" and "BeginTime" can be
dynamically configured using a C script.
In the example, the values for EndTime and BeginTime are defined in two I/O fields. The entry
is of the following format: "dd.mm.yyyy hh.mm.ss" e.g. 04.09.2002 10:20:00.
The time range in WinCC Online Trend Control is updated using a C script. The C script is
triggered by clicking the button control. To update the time range, the C script deactivates and
reactivates the WinCC Online Trend Control.

Procedure
1. In Tag Management, configure the tags "strVar_1" and "strVar_2" of data type "text tag 8bit value" and the tag "TagLog" of data type"unsigned 16-bit value".
2. Start Tag Logging and create a process value archive by using the Archive Wizard and
configure the process value tag contained therein.
3. Start Graphics Designer and open a picture. Insert a WinCC Online Trend Control into the
picture and link it to the process value tag.
4. Insert two I/O fields into the picture and link it to the tags "strVar_1" and "strVar_2",
respectively. In object properties "Output/Input" of the I/O fields, enter "String" as data
format and "*" as output format.
5. Insert a button into the picture and save the picture as “NewPDL0.PDL“.
6. Open the "Object Properties" dialog of the button and click the "Event" tab.
7. In the left pane, select "Mouse click" as the trigger of the event.
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8. Right-click the "Mouse click" event and select the "C Action..." command from the pop-up
menu.
9. The StartTime and EndTime properties are dynamized with the following script. Copy this
script into the edit field of the "Edit Action" dialog and click "OK".
//Set index for Trend1
SetPropWord("NewPdl0.Pdl","Control1","Index",0); //return type :BOOL
SetPropBOOL("NewPdl0.PDL","Control1","Online",FALSE);
SetPropBOOL("NewPdl0.PDL","Control1","TimeRange",FALSE);
SetPropBOOL("NewPdl0.PDL","Control1","Activate",FALSE);
//Sets BeginTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","BeginTime",GetTagChar("strVar_1"));
//Sets EndTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","EndTime",GetTagChar("strVar_2"));
//Set Index for Trend2
SetPropWord("NewPdl0.Pdl","Control1","Index",1); //return type :BOOL
SetPropBOOL("NewPdl0.PDL","Control1","Online",FALSE);
SetPropBOOL("NewPdl0.PDL","Control1","TimeRange",FALSE);
SetPropBOOL("NewPdl0.PDL","Control1","Activate",FALSE);
//Sets BeginTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","BeginTime",GetTagChar("strVar_1"));
//Sets EndTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","EndTime",GetTagChar("strVar_2"));
//Activate BeginTime and EndTime at Trend Control
SetPropBOOL("NewPdl0.PDL","Control1","Activate",TRUE);
10.Save the picture and start Runtime.
11.In the I/O fields, enter the values for "EndTime" and "StartTime" in format "dd.mm.yyyy
hh.mm.ss". Confirm each entry with "Enter".
12.By clicking the button, the time range is updated in WinCC Online Trend Control.

See also
How to Activate the Example for Online Trend Control (Page 1547)
Time Range of Trend Display (Page 1535)

How to Configure the Value Range of Trends
Introduction
For each trend, you can customize the value range and the scaling for the trend display in the
Value Axis tab of the Configuration Dialog of WinCC Online Trend Control.
When you have inserted a trend, the value range and the scaling to be displayed is preconfigured as follows:
● The value range is automatically based on the minimum and maximum value of the selected
curve. If you use a common value axis, the minimum and maximum values of all trends of
the trend window are dtermined.
● The value axis scale is linear to the value range.
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Requirement
● You have inserted the trends and configured the data supply.

Procedure
1. Click the configuration dialog of WinCC Online Trend Control on the Value Axis tab.

1. In Trend: select the trend whose value axis you want to change.
2. In the Range Selection, deactivate the Automatic option button if you want to define a fixed
value range and a separate scaling of the value axis.
3. In the "From:" and "To:" input fields enter the minimum and maximum value of the value
range.
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4. For configuring the scaling, activate the User Scaling option button. Click "..." to define a
scaling for the selected value range.
5. You must define segments without gaps for the entire value range and assign areas on the
value axis. If you have defined a value range, say "0 - 100000" you can divide this value
range into three sections that you can display as follows on the value axis:

For e.g. value range "0 - 50000" is displayed during Runtime on the value axis in the "100 500" range if the User Scaling option box is activated.

How to Activate the Example for Online Trend Control
Requirement
Before activating the WinCC Online Trend Control example, you must complete the following
steps:
● Save the picture configure by you.
● Use the pop-up menu in the WinCC Explorer to select the stored picture as the start picture.
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● Check whether "Graphics Runtime" and "Tag Logging Runtime" are selected in the startup
list of WinCC Explorer ("Computer Properties" dialog).

Procedure
You have several options to start Runtime:
● From the toolbar of the WinCC Explorer
● From the menu bar of the WinCC Explorer
During configuration you can call individual pictures in Runtime:
● From the toolbar of the Graphics Designer
● From the menu bar of the Graphics Designer

How to apply the configuration of trend parameters from PCS 7
Introduction
In PCS 7, you can use the SIMATIC Manager to configure the properties of tags that have an
effect on the display in Trend Controls. The specified parameters can be transferred to WinCC
Online Trend Control.

Automatic configuration of trend parameters from PCS 7 data
In WinCC Online Trend Control, the properties for tags planned in PCS 7 are applied as trend
parameters. The following parameters are configured automatically:
● The low limit of the trend range
● The high limit of the trend range
● The units of measurement for the trend
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In runtime, the tag values are shown as a trend within these limits. The unit of measurement
is shown on the "Y axis".

Procedure
1. Add a new trend in WinCC Online Trend Control.
2. Select an archive tag or online tag that has already been configured in PCS 7. If the
properties indicated above are configured for these tags, the following parameters are
configured in the "Value Axis" tab:
– The "Label" field contains the unit of measurement for the tag. You can change the label.
– In the "Range selection" area, the "Apply the properties of the tag display" option is
activated and the "Automatic" option is deactivated.
– The tag names for the high limit and the low limit of the variables are entered in the fields
"From" and "To" in the "Range selection" area. These limits cannot be changed.
– The "User Scaling" option is deactivated in the "Scaling" area.
3. If you want to change the limits for the trend range and configure a user scale, deactivate
the "Apply tag properties" option.

Operation in Runtime
How to Operate Online Trend Control in Runtime
Introduction
The trend window is operated in runtime via the buttons in the toolbar.

Overview
"Online-Help-System"
Opening the online help
"Open the Configuration Dialog"
Selecting the dialog to assign display parameters.
"First Data Record"
Click this button to display the tag trend in the trend window, starting with the first
archived tag.
"Previous Data Record"
Click this button to display the tag trend of the previous time interval in the trend
window, based on the currently displayed time interval.
"Next Data Record"
Click this button to display the tag trend of the next time interval in the trend window,
based on the currently displayed time interval.
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"Online-Help-System"
Opening the online help
"Last Data Record"
Click this button to display the tag trend ending with the last archived value in the
trend window, based on the currently selected time interval.
"Display Value at this Position"
Click this button to query the coordinate points of a trend.
"Zoom Area"
Click this button to zoom in on any section of the trend window.
"Activate Original View"
Click this button to return to the configured normal view (after zooming).
"Dialog for Archive and Tag Selection"
This button opens the dialog for archive and tag selection.
"Dialog for Trend Selection"
Click this button to open the dialog for the selection of visible and invisible trends.
"Select Time Range"
Click this button to open the dialog where you can specify the time range to be
displayed in a trend window.
"Previous trend in foreground"
Click this button to display the previous trend in the foreground of the trend window.
"Next trend in the front"
Click this button to display the next trend in the foreground of the trend window.
"Start/Stop update"
The updated display is stopped. The values are buffered and updated when the
button is clicked again.
"Start/Stop update"
Resume display.
"Print Log"
Click this button to print the trend shown in the trend window. Print job used during
printing can be specified in the control properties on the "General" tab.
"Select Statistics Area"
Click this button to define the time period for the calculation of statistics in trend
window using vertical lines.
"Calculate Statistics"
Click this button to open the statistics window where the minimum, maximum,
average and standard deviation for a specified time frame and trend are shown.
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"Online-Help-System"
Opening the online help
"Save report"
Saves the current data of the control for the displayed trends in the time frame
indicated. The updated display must be stopped.
The report will be saved as a ".csv" file in the WinCC project directory under "Export/
TagLogging". The file name consists of window title of Control and the timestamp.
If you import the file into MS Excel, the local language settings are used. The "List
separator" and the "Comma sign" can then lead to an incorrect display. In order to
ensure a correct display, give the ".csv" file the extension "*. txt". You then have
the ability to select the "List separator" and the "Comma sign" manually during the
import.
"Zoom out"
Decreases the zoom factor.
"Zoom in"
Increases the zoom factor.
"Relative scale"
Switches from displaying the absolute values to the percentage display of value
axis. The high and low limits for the trend correspond with a range of 0 to 100%.
The following requirements apply to the "Relative scale" keyboard function:
● All trends displayed are assigned a fixed value range.
● The trends have no user scaling.
● The trends are scaled linearly.
Right-click trend

When the update is stopped, right-click the trend to display the archive name, the
tag name and the coordinates of the respective point.

Note
Click the "Display value at this position" button in the toolbar to display the coordinate points
of a trend. The displayed tag values can be assigned an additional attribute in the form of a
letter. Where:
● Letter "i" : The displayed tag value is interpolated.
● Letter "u" : The displayed value is of uncertain status. This attribute is displayed when the
initial value is not known after Runtime has been activated, or when a substitute value is
used.
The "Page" buttons in archives are only available, if the trend to be displayed originates in a
process value archive.

See also
How to Generate Statistics of Runtime Data (Page 1563)
Starting and Stopping Update (Page 1557)
Trend to Front (Page 1557)
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How To Enlarge a Segment of a Trend (Page 1561)
How to Determine the Coordinates of a Point (Page 1559)
Online Configuration of Online Trend Control (Page 1552)

Online Configuration of Online Trend Control
Introduction
There are four options available to change the configuration of the Online Table Control in
Runtime:
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Key function "Open the Parameter Dialog"
The "Open Set Configuration Dialog"
for trend display.
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Key function "Dialog for Archive and Tag Selection"
The "Dialog for Archive and Tag Selection"
tags linked to the trends in a trend window.

key function allows for the specification of the

Array

Description

Trend

Select a configured trend.

Selectio
n

Use the Selection button to open the dialog for selecting the linked tags.

Persiste
nce

If the "Persistence in RT and CS" option is not activated, any changes made to the settings
are only effective within Runtime. Whether or not any changed settings remain effective
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also
transferred to the configuration system. To do this, you must open the picture in Graphics
Designer and save it once again. The changed settings are also used when the project is
reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with PCS
7 projects or TIA projects. When you completely load the ES to the OS, the changed settings
on the OS will be overwritten.
Configure the properties of the controls on the ES.
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Key Function "Dialog for Selecting Trends"
The "Dialog for Trend Selection"
and invisible trends.

key function opens the dialog for the selection of visible

Array

Description

Trend in the
foreground

If a common axis is used, the settings for the display of the first trend are applied for
the display of the axis. You can configure a uniform color for the common X-axis. The
first trend can be changed either in this dialog or by using the "Previous trend in
foreground" and "Next trend in the front" buttons in the toolbar.

Trend visible/ In this area, you can specify the trends that are not to be shown.
invisible:
Persistence

If the "Persistent in RT and CS" option is not activated, any changes made to the
settings are only effective within Runtime. Whether or not any changed settings remain
effective after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also
transferred to the configuration system. To do this, you must open the picture in
Graphics Designer and save it once again. The changed settings are also used when
the project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the
changed settings on the OS will be overwritten.
Configure the properties of the controls on the ES.

Note
The first trend in a trend window cannot be made "invisible".
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Key Function "Select Time Range"
opens a dialog to specify the time range to be
The key function "Select Time Range"
displayed. If the trends in the trend window are to be displayed with a common time axis, the
specified time range applies to all trends.

Array

Description

Trend

Select a configured trend.

Time
Selection

The time interval to be displayed in the trend window can be set
by entering a start and an end point (the "Time Range" setting not activated).
by entering a start time and a time range. ("Time Range" setting activated). The length of
the time interval to be displayed is determined by multiplying the "Factor" by the "Range".

Persistenc
e

If the "Persistent in RT and CS" option is not activated, any changes made to the settings
are only effective within Runtime. Whether or not any changed settings remain effective
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also
transferred to the configuration system. To do this, you must open the picture in Graphics
Designer and save it once again. The changed settings are also used when the project
is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the changed
settings on the OS will be overwritten.
Configure the properties of the controls on the ES.

The entry format of the date and time depends on the Runtime language used.
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See also
Configuration of WinCC Online Trend Control (Page 1539)
How to Generate Statistics of Runtime Data (Page 1563)
How to Operate Online Trend Control in Runtime (Page 1549)

Starting and Stopping Update
Introduction
The update of the trend window can be started and stopped with the "Start/Stop" key function.
If updating has stopped, you can:
● change the displayed time range and thus display the measured values from the process
value archive in the trend window.
● save the data of the displayed trends for the displayed time range in a report.
Certain functions, such as the "Zoom Area" keyboard function automatically stop the update
of value of measurement points.
You will recognize the status of the update by the appearance of the button.
●

: When updates are stopped, you may change the displayed time frame and therefore
display measurement values from the process value archive in the table window.

●

: When updates are started, you may change the displayed time frame and therefore
display measurement values from the process value archive in the table window.

See also
How to Operate Online Trend Control in Runtime (Page 1549)

Trend to Front
Introduction
You can modify the trend displayed on top in runtime:
● by clicking the

button ("Dialog for Trend Selection" key function)

● by clicking the

button: ("Next trend to Front" key function)

● by clicking the

button: ("Previous Trend to Front")

If common axes are used, the settings for the trend displayed in the foreground are used for
displaying the axes. You can however configure a uniform color for the common X-axis.
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Configuration
You define the sequence of the trends in the Trends tab of the Properties dialog in WinCC
Online Trend Control. Select a trend and click "Up" or "Down" button.

See also
How to Operate Online Trend Control in Runtime (Page 1549)

1558

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values

How to Determine the Coordinates of a Point
Introduction
You can use the "Display Value at this Position" key function to determine the coordinates of
a point in the trend. To make it easier to determine the coordinates, you can also enlarge a
particular segment of the trend lines.

Requirement
● Configure the Online Trend Control.
● Configure the display of a toolbar, using the key functions "Zoom Area" and "Activate
Original View".
● You can specify the font for the tag value table that is displayed with the key function
"Display value here" in the "Font" tab and via the property "RulerFont".
● Start Runtime.

Procedure
button for "Display Value at This Position" a vertical line, a ruler, is
When activating the
added to the trend window. Below the trend window, the X and Y coordinates of the measured
value are displayed together with the archive and tag names.
The displayed tag values can be assigned an additional attribute in the form of a letter. Where:
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● Letter "i" : The displayed tag value is interpolated.
● Letter "u" : The displayed value is of uncertain status. This attribute is displayed when the
initial value is not known after Runtime has been activated, or when a substitute value is
used.

Other measurement values can be determined by positioning the mouse pointer on the ruler
and moving it – while keeping the left mouse button pressed – to the desired position.
Note
The "uncertain" status of a tag value can also be identified in the displayed trend
characteristic. To do this, you must activate the "Value with uncertain status" option on the
"Limit Values" tab of the "Properties of WinCC Online Trend Control" dialog.
If you do not wish to display the tag link in the table, you must set "HideTagNames" in the
object property dialog to "Yes".

See also
How to Operate Online Trend Control in Runtime (Page 1549)
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How To Enlarge a Segment of a Trend
Introduction
You can use the "Enlarge Area" key function to zoom in on any segment of the trend window.
You may then find that the keyboard function "Display Value at this Position" is easier to use
within the enlarged display to determine the coordinates of a particular measurement point.
Use the "Activate Original View" key function to switch back from an enlarged display to normal
display mode.

Requirement
● Configure the Online Trend Control.
● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area"
and "Activate Original View".
● Start Runtime.

Procedure
button in the toolbar.
1. Click the "Enlarge Area"
The display stops being updated and the mouse pointer changes to a cross-hair.
2. In the trend window, click one corner of the area that you wish to enlarge.
3. Hold down your left mouse button and drag the area you want to enlarge until it reaches
the desired size. If the highlighted area contains at least two measured values, the selected
trend area is displayed in the trend window.
4. Release the left mouse button.
The section you selected is now shown enlarged.
in the toolbar.
5. Click the "Activate Original View" button
The trend window is displayed again in normal view as originally configured.
6. Click the "Start/Stop the Update" button in the toolbar to restart updating the display in the
trend window. For the value ranges of the X and Y axes, the preset values is used by default.

See also
How to Operate Online Trend Control in Runtime (Page 1549)

Expanded zoom functions
Introduction
Using the "Zoom area", "Zoom in" and "Zoom out" keyboard functions, a segment of the trend
window can be made larger or smaller in WinCC Online Trend Control.
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"Zoom in" and "Zoom out" keyboard functions
Updating the trend values is stopped when zooming with the "Zoom area" keyboard function.
The trend values can be updated while zooming as well by activating the "Zoom in" and "Zoom
out" keyboard functions.

Requirement
The following requirements apply to "Zoom in" and "Zoom out.
● All trends displayed are assigned a fixed value range.
● The trends have no user scaling.
● The trends are scaled linearly.

"Zoom in", "Zoom out" and original view buttons
The following buttons have been added to the toolbar of WinCC Online Trend Control for new
keyboard functions:
Zoom in. Increases the zoom factor.
Zoom out. Decreases the zoom factor.
While zooming in or zooming out, the 50% value of the trend is always shown in the center of
the value axis.
If you change the limits in the "Value Axis" tab in the configuration dialog while zooming, the
visible zoom area is set to the new limits.
If you want to view the trend window in the original configured view again, click "Activate original
view" in the tool bar:
Activate original view.

Display of archived values
Introduction
Use the buttons in the toolbar of a trend window or the corresponding key combinations to
browse through an archive.
The values archived of a tag are thereby displayed within a time interval in the trend window.
The width of this interval is determined by the time range to be displayed or results from the
time difference of entered start and end times.

Requirement
The buttons for browsing in archive are available only if data is supplied through archive tags.
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Buttons for Archived Values

The trend displays the tag values within a specified time range, beginning with the first
archived value.
The trend displays the tag values within the previous time interval, based on the currently
displayed time interval.
The trend displays the tag values within the next time interval, based on the currently
displayed time interval.
The trend displays the tag values within a specified time range, ending with the last
archived value.

See also
How to Operate Online Trend Control in Runtime (Page 1549)
Online Configuration of Online Trend Control (Page 1552)
Configuration of WinCC Online Trend Control (Page 1539)

How to Generate Statistics of Runtime Data
Introduction
You can generate a statistical evaluation of Runtime process data in the trend window. The
following results are displayed in a statistics window for all displayed trends and a specified
time frame:
● Minimum
● Maximum
● Average
● Standard deviation

Requirement
● Configure the Online Trend Control.
● Configure the display of a toolbar by using the key functions "Select statistics area",
"Calculate statistics" and "Start/stop update".
● Configure the display with the "Select Time Range" keyboard function, if you wish to choose
a statistics area outside of the time range displayed in the columns.
● You can specify the font for the tables that is displayed with the key functions "Select
statistics range" and "Calculate statistics" in the "Font" tab and via the property
"StatisticsFont".
● Start Runtime.
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Procedure
button.
1. In the toolbar, click the
The updated display is stopped; process data continues to be archived. The updated display
is stopped, process data continue to be archived. Two vertical lines are displayed at the
left and right edge of the trend window. A window containing the statistics area shows the
current upper (OG) and lower (UG) limits of the trends.
2. Specify the time frame for calculation by dragging both lines to their desired x axis position,
using the mouse.

3. In the toolbar, click the

button.

4. The "Statistics" window opens showing the results of the calculation for the specified time
frame of one trend.

5. If you wish to display the results of an additional trend in the trend window, select the
appropriate trends in the "Trends" field.
6. In order to continue with the display of Runtime data in trends, close the statistics window
and click the
button in the toolbar.
7. If you require a statistical analysis of process data that are not displayed in the trend window,
click the
button. Enter the desired time frame in the "Select time range" dialog. The
process data are displayed for the specified time frame, and statistics can be calculated.
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To view the process value and the X/Y coordinates of a point in the trend, right-click it. The
information is shown in a tooltip window.
Note
For additional statistical analysis of process data and archiving of results you must write the
scripts yourself.

See also
How to Operate Online Trend Control in Runtime (Page 1549)
Online Configuration of Online Trend Control (Page 1552)
Configuration of WinCC Online Trend Control (Page 1539)

6.5.4.4

Before WinCC V7: Process Value Output as a Function of Another Tag

WinCC Function Trend Control
Introduction
For a graphic processing of tags, Function Trend Control in WinCC offers the option of
displaying one tag as a function of another tag. For example, temperature may be shown as
a function of pressure. Furthermore, trends may be compared to target trends.
Display of trends during Runtime takes place in ActiveX Control, inserted and configured in a
picture in Graphics Designer.
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Requirement
For the display of trends in WinCC Function Trend Control the following prerequisites apply:
● In a WinCC Function Trend Control any number of trends may be displayed. However, it
is recommended to configure no more than 8 trends.
● A trend can represent a maximum of 10000 value pairs.
● For these trends, either online tags, archive tags or data from user archives may be used.
● Online tags of a trend must have the identical update cycle.
● Archive tags of a trend must have the same update cycle and must be recorded in a
continuous cycle.
● Data from user archives can be used for target trends.
● The representation of tags in the form of functions over time is only possible, if the values
of the trend are supplied through the API interface. In order to display tags as a function of
time, you should use the WinCC Online Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen
resolution and selected size of the trend window. Therefore, when displaying trends, it is
possible that fewer values are displayed in the trend window than are actually archived.
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If, for example, in an area of 100 pixels 200 measurement values are archived, each pixel will
represent 2 measurement values. The value shown on the screen is that of the most recent
data (most recent time stamp).

Display of Trends
Representing Trend Lines
Introduction
WinCC Function Trend Control provides a number of options for representing a trend line.

See also
Comparison with an Ideal Trend (Page 1581)
Identification of Special Values (Page 1579)
Time Range of Trend Display (Page 1578)
Write Direction (Page 1576)
Display of Staggered Trends (Page 1574)
Display with Logarithmic Axes (Page 1572)
Display with common axes (Page 1570)
Forms of Display (Page 1567)

Forms of Display
Introduction
To graphically display tag values, three basic representation types are available.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1567

Archiving Process Values
6.5 Output of Process Values

Single Values
Value of measurement points are shown as dots.

Linear Interpolation
The trend line is interpolated on a linear basis from values of measurement points. The trend
is represented as either a solid line or a dashed line. The area under the curve can also be
displayed in a solid color.

Stepped Trend
The trend line is interpolated as a stepped curve from the values of measurement points. The
trend is represented as either a solid line or a dashed line. The area under the curve can also
be displayed in a solid color.
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Configuration
The display of trends is configured on the General tab of the Properties of WinCC Online Trend
Control dialog.

See also
Properties of Function Trend Control - Trends Tab (Page 1612)
Representing Trend Lines (Page 1567)

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1569

Archiving Process Values
6.5 Output of Process Values

Display with common axes
Introduction
If multiple trends are to be displayed in a trend window, you have the choice of using individual
axes for each trend or using shared X/Y axes for all trends.

Display with Different Axes
If the tag values to be displayed in a tag window differ greatly, the use of shared axes for the
trend display is not recommended. The tag values can be read more easily if different axial
scales are used.
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Display with Common Axes
If comparison of trend characteristics is important, it is recommended to display trends with
common axes. The exact tag values may be determined in Runtime through zoom or
coordinate inquiry.

Configuration
The display of common axes is configured in the General tab of the Properties of WinCC
Function Trend Control dialog.
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See also
Properties of Function Trend Control - General Tab (Page 1608)
Representing Trend Lines (Page 1567)

Display with Logarithmic Axes
Introduction
The axes in the trend window can be scaled on either a logarithmic or a linear basis.
Representation using logarithmic axes means that no negative values can be displayed, and
representation using negative logarithmic axes means that no positive values can be displayed.
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Configuration
Representations using logarithmic axes are configured in the X axis or Y axis tab of the
Properties of WinCC Function Trend Control dialog.

See also
Representing Trend Lines (Page 1567)
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Display of Staggered Trends
Introduction
In a staggered display, the trends are displayed offset over each other in the trend window.
For each trend, the value range to be displayed can be set for the Y axis.
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Configuration
The display of staggered trends is configured in the General tab of the Properties of WinCC
Online Trend Control dialog.

See also
Properties of Function Trend Control - General Tab (Page 1608)
Representing Trend Lines (Page 1567)
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Write Direction
Introduction
The write direction defines the direction in which the positive values on the axes are depicted.
Thus the setting from the bottom means that positive values on the Y axis will be shown in the
downward direction.
If a setting of From the top or From the bottom is selected for the write direction, only TrueType fonts should be used inside the Trend window to ensure a clear display of labels on the
vertical axis.
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Configuration
The write direction configured in the General tab of the Properties of WinCC Function Trend
Control dialog.

See also
Properties of Function Trend Control - General Tab (Page 1608)
Representing Trend Lines (Page 1567)
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Time Range of Trend Display
Introduction
With regard to the time ranges to be displayed, there are a number of ways to present a trend
display of tags:

Static Representation of a Tag
Static representation presents the course of a tag within a defined time interval, based on the
archived values.

If display updating is stopped in runtime, the Data Linking tab of the Properties of WinCC
Function Trend Control dialog can be used to configure the time range that needs to be
represented. This time range is derived either by defining a starting time and end time or by
defining a starting time and the number of value pairs to be represented.
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Dynamic Display of Tags
When displaying one tag as a function of another tag in dynamic mode, the value of
measurement point associated with the current system time changes along the function graph.
New measurement values coming in will be included in the display.

The time range to be represented is configured in the Data Linking tab of the Properties of
WinCC Function Trend Control dialog. This time range is derived either by defining a starting
time and end time or by defining the number of value pairs to be represented.

See also
Representing Trend Lines (Page 1567)

Identification of Special Values
Introduction
In any trend, values may occur which are above or below a limiting value, or which have an
uncertain status. Such special values can be highlighted in color. Values with an uncertain
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status are those whose initial value is not known after runtime has been activated, or for which
a substitute value is used.

Configuration
Color-coded identification of special values is configured in the Limiting Values tab of the
Properties of WinCC Function Trend Control dialog.

See also
Representing Trend Lines (Page 1567)
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Comparison with an Ideal Trend
Introduction
Any trend can be configured with an ideal trend. It is then possible to make an effective
comparison between the actual trend line and the specified ideal trend. The values for the ideal
trend must be held in a user archive. You can create user archives with the aid of WinCC option
User Archives.

Configuration
The values for the ideal trend are configured in a user archive.
The display for an ideal trend is configured in the Trends tab of the Properties of WinCC
Function Trend Control dialog box.
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See also
Properties of Function Trend Control - Trends Tab (Page 1612)
Representing Trend Lines (Page 1567)
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Configuration
Configuration of WinCC Online Trend Control
Introduction
The steps you need to take in order to configure WinCC Function Trend Control are dependent
on the tags you wish to display.
Display of Online Tags
1. The tags you wish to display need to be configured in WinCC Explorer.
2. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the
properties of the ActiveX Control.
Display of Archive Tags
1. The tags you wish to display need to be configured in WinCC Explorer.
2. Use the Archive Wizard to create a process value archive.
3. Configure the process value tags it will contain.
4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the
properties of the ActiveX Control.
Display of Values from User Archive
1. Create a user archive.
2. Configure the fields it will contain.
3. Link the WinCC user archive table element to a Graphics Designer picture and edit the
properties of the ActiveX Control.
4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the
properties of the ActiveX Control.
5. Enable runtime and input the display values into the user archive or import them from a csv
file.
Comparison with an Ideal Trend
1. Create a user archive.
2. Configure the fields it will contain.
3. Link the WinCC user archive table element to a Graphics Designer picture and edit the
properties of the ActiveX Control.
4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the
properties of the ActiveX Control.
5. Enable runtime and input the ideal trend values into the user archive or import them from
a csv file.
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See also
How to Display Archive Tags (Page 1585)
How to Compare Tag Values with an Ideal Trend (Page 1588)
How to Display Data from User Archives (Page 1586)
How to Display Online Tags (Page 1584)
How to Insert Function Trend Control in a Picture (Page 1584)

How to Insert Function Trend Control in a Picture
Introduction
Tags are displayed in runtime in an ActiveX Control, which is inserted in a picture and
configured with the aid of the Graphics Designer.

Procedure
1. Start Graphics Designer and open a new picture.
2. In the Object Palette Default tab, click the smart object Control.
3. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Drag the control to the desired size.
The Insert a Control dialog is opened.
5. Select WinCC Function Trend Control and confirm your selection by clicking OK.
The Properties of WinCC Function Trend Control quick configuration dialog box opens.
6. Click OK to close the dialog.

See also
How to Compare Tag Values with an Ideal Trend (Page 1588)
How to Display Data from User Archives (Page 1586)
How to Display Online Tags (Page 1584)
How to Display Archive Tags (Page 1585)

How to Display Online Tags
Requirement
● Configure two tags (Tag1, Tag2) with data type signed 16-bit value.
● Insert the Function Trend Control into a Graphics Designer picture.
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Procedure
1. In Graphics Designer, open a picture using Function Trend Control.
2. Double-click the Function Trend Control.
3. Click the "Data Linking" tab.
4. For "Data Source", select the "Online Tags" setting.
5. In the "Select Archive/Tag" area, use the button marked "..." and select Tag1 for the X axis.
6. In the "Select Archive/Tag" area, use the button marked "..." and select Tag2 for the Y axis.
7. To define the time range you wish to display, specify a starting time and the number of
value pairs to be represented.

8. Close the dialog with the "OK" button.
9. Save the picture.
10.Enable runtime and start the WinCC Tag Simulator.
Note
The tags to be displayed within a trend must have the same updating cycle.

See also
How to Use the Simulator (Page 1593)
How to Insert Function Trend Control in a Picture (Page 1584)

How to Display Archive Tags
Requirement
● Configure two tags (Tag1, Tag2) with data type signed 16-bit value.
● Create a process value archive containing Tag1 and Tag2.
● Insert the Function Trend Control into a Graphics Designer picture.
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Procedure
1. In Graphics Designer, open a picture using Function Trend Control.
2. Double-click the Function Trend Control.
3. Click the "Data Linking" tab.
4. For "Data Source", select the "Archive Tags" setting.
5. In the "Select Archive/Tag" area, use the button marked "..." and select Tag1 stored in
process value archive PW1 for the X axis.
6. In the "Select Archive/Tag" area, use the button marked "..." and select Tag2 stored in
process value archive PW2 for the Y axis.
7. To define the time range you wish to display, specify a starting time and the number of
value pairs to be represented.

8. Close the dialog with the "OK" button.
9. Save the picture.
10.Enable runtime and start the WinCC Tag Simulator.
Note
The tags to be displayed in a trend must originate from an archive on a server and be acquired
in a continuous cycle.

See also
How to Use the Simulator (Page 1593)
How to Insert Function Trend Control in a Picture (Page 1584)
How to Create a Process Value Archive (Page 1604)

How to Display Data from User Archives
Introduction
You can use WinCC Function Trend Control to display value pairs from user archives. You
can create user archives with the aid of WinCC option User Archives.
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Requirement
● Configure a user archive with the columns "Setpoint X" and "Setpoint Y".
● In runtime, input values for "Setpoint X" and "Setpoint Y".
● Insert the Function Trend Control into a Graphics Designer picture.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.
2. Double-click the Function Trend Control.
3. Click the "Data Linking" tab.
4. Go to "Provider" and select the setting "User Archive".
5. In the "User Archive" area, use the button marked "..." and select user archive UA1.
6. In the "Column for X Values" area, select the "Setpoint X" column.
7. In the "Column for Y Values" area, select the "Setpoint Y" column.
8. To define the time range you wish to display, specify the number of value pairs to be
represented and the ID of the first value pair.

9. Close the dialog with the "OK" button.
10.Save the picture.
11.Enable runtime and start the WinCC Tag Simulator.

See also
How to Use the Simulator (Page 1593)
How to Insert Function Trend Control in a Picture (Page 1584)
How to Create a User Archive (Page 1605)
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How to Compare Tag Values with an Ideal Trend
Requirement
● Configure a user archive with the columns "Setpoint X" and "Setpoint Y".
● In runtime, input values for "Setpoint X" and "Setpoint Y".
● Insert the Function Trend Control into a Graphics Designer picture.
● Configure the data linking for the Function Trend Control.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.
2. Double-click the Function Trend Control.
3. Click the "Trends" tab.
4. Select the "Ideal Trend" check box.
5. Click the "Properties..." button.
The "Properties of the Ideal Trend" dialog box opens.
6. In the "User Archive" area, use the button marked "..." and select user archive UA1.
7. In the "Column for X Values" area, select the "Setpoint X" column.
8. In the "Column for Y Values" area, select the "Setpoint Y" column.
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9. To define the time range you wish to display, specify the number of value pairs to be
represented and the ID of the first value pair.

10.Select the color and representation type for the ideal trend.
11.Click "OK" to close all open dialogs.
12.Save the picture.
13.Enable runtime and start the WinCC Tag Simulator.

See also
How to Use the Simulator (Page 1593)
How to Insert Function Trend Control in a Picture (Page 1584)
How to Create a User Archive (Page 1605)
How to Create a Process Value Archive (Page 1604)
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How to Display a Tag as a Function of Time
Introduction
You can also use Function Trend Control to display tags as a function of time. However, this
is only possible if the data source for the trends is connected over the application programming
interface (API). For this the setting none must be selected (as Provider) in the Data Linking
tab of the Properties of WinCC Function Trend Control dialog box.

Note
In order to display tags as a function of time, you should use the WinCC Online Trend Control.

Example
The example shows the supply of values for a trend using the API interface. The third trend
(index = 2) of Control1 in a picture is supplied with data. This results in a sine curve, consisting
of 1440 value pairs:
// Definitions for the calculation of sine
#define NUMVALUES 1440 // Number of value pairs
#define PI

3.14159265359 // PI

// Variant for supply of DataXY property
VARIANT vtDataXY;
// Variant that contains a single data pair
VARIANT vtPair;
// Represents the X value of a data pair
VARIANT vtDataX;
// Represents the Y value of a data pair
VARIANT vtDataY;
// For faster access to the SAFEARRAY data that is contained in the
Variants.
VARIANT* pvtDataXY = NULL;
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VARIANT* pvtPair = NULL;
int i = 0;
long lIndex = 0;
double dAngle = 0;
HRESULT hr = 0;
SAFEARRAYBOUND rgsabound[1];
// Initializing of the DataXY Variant
VariantInit( &vtDataXY );
// Creation of the SAFEARRAY for the DataXY property
rgsabound[0].cElements = NUMVALUES; // NUMVALUES - value pairs
rgsabound[0].lLbound = 0;
vtDataXY.u.parray = SafeArrayCreate( VT_VARIANT, 1, rgsabound );
if( vtDataXY.u.parray )
{
vtDataXY.vt = (VARTYPE)( VT_ARRAY | VT_VARIANT );
}
else
{
// No memory left
return;
}
// Set the trend index
SetPropBOOL( lpszPictureName, Control1, Index, 2 );
// Delete all trend data
SetPropBOOL( lpszPictureName, Control1, DeleteData, TRUE );
// Obtain direct access to values of the DataXY-SAFEARRAYS
hr = SafeArrayAccessData( vtDataXY.u.parray, &pvtDataXY );
if( hr == 0 && pvtDataXY )
{
for( i = 0; i < NUMVALUES; ++i )
{
// Initializing of the Variants in order to fill the DataXYSAFEARRAY
VariantInit( &vtPair );
VariantInit( &vtDataX );
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VariantInit( &vtDataY );
// Generation of a single value pair SAFEARRAY
// Always two values, respectively for the X and Y value.
rgsabound[0].cElements = 2;
vtPair.u.parray = SafeArrayCreate( VT_VARIANT, 1, rgsabound );
if( vtPair.u.parray )
{
vtPair.vt = (VARTYPE)(VT_ARRAY | VT_VARIANT );
// Obtain direct access to the data of the DataXY-SAFEARRAY
SafeArrayAccessData( vtPair.u.parray, &pvtPair );
if( pvtPair )
{
// Set the X value
vtDataX.vt = VT_R8;
vtDataX.u.dblVal = (double)( i - NUMVALUES/2 );
dAngle = ( i - NUMVALUES/2 ) * 2 * PI / 360;
// Set the Y value
vtDataY.vt = VT_R8;
vtDataY.u.dblVal = sin( dAngle );
// Write values into the value pair SAFEARRAY
VariantCopy( &pvtPair[0], &vtDataX

);

VariantCopy( &pvtPair[1], &vtDataY

);

// Re-enable the value pair SAFEARRAY data
SafeArrayUnaccessData( vtPair.u.parray );
pvtPair = NULL;
// Copy the value pair into DataXY-SAFEARRAY
VariantCopy( &pvtDataXY[i], &vtPair );
}
}
// Enable the used SAFEARRAYs
VariantClear( &vtDataX );
VariantClear( &vtDataY );
VariantClear( &vtPair );
}

1592

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Archiving Process Values
6.5 Output of Process Values
// Enable access to the DataXY-SAFEARRAY data.
SafeArrayUnaccessData( vtDataXY.u.parray );
// Set the DataXY property
PDLRTSetPropEx( PDLRT_AM_DEFAULT, lpszPictureName, Control1,
DataXY,
VT_VARIANT, (void*)&vtDataXY, NULL, NULL, 0, NULL, NULL );
// Add value pairs at the end
SetPropBOOL( lpszPictureName, Control1, InsertData, TRUE );
}
VariantClear( &vtDataXY );

How to Use the Simulator
Introduction
To familiarize yourself with the functionality of the WinCC Function Trend Control in runtime,
you can use the Tag Simulator to simulate the tags configured in the examples.

Requirement
● Configure a WinCC Function Trend Control in the Graphics Designer.
● Enable runtime.
● Start the Tag Simulator.

Procedure
1. In the Edit menu, click the New Tag command.
2. Select Tag 1 and confirm your selection by clicking OK.
3. Click the Properties tab and input the following values for Tag 1.
Amplitude: 50
Offset: 50
Vibration period: 25
4. Click the Tags tab.
5. In the Edit menu, click the New Tag command.
6. Select Tag 1 and confirm your selection by clicking OK.
7. Click the Properties tab and input the following values for Tag 1.
Amplitude: 50
Offset: 50
Vibration period: 50
8. Click the Tags tab.
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9. Click the Start Simulation button.
10.In WinCC runtime, track the display of the tags in the WinCC Function Trend Control.

Operation in Runtime
How to Operate Function Trend Control in Runtime
Introduction
The trend window is operated in runtime via the buttons in the toolbar.
"Online-Help-System"
Calling up the Online help
"Open the Configuration Dialog"
Selecting the dialog to assign display parameters.
"Display Value at this Position"
Click this button to query the coordinate points of a trend.
"Zoom Area"
Click this button to zoom in on any section of the trend window.
"Activate Original View"
Click this button to return to the configured normal view (after zooming).
"Opens the dialog for selecting a trend"
Opens a dialog to configure the settings for the selected trends
"Previous trend in foreground"
Click this button to display the previous trend in the foreground of the
trend window
"Next trend in the front"
Click this button to display the next trend in the foreground of the trend
window
"Start/Stop update"
Updates are stopped/started and can be continued/stopped by clicking
the button.
"Print Log"
Click this button to print the trend shown in the trend window. Print job
used during printing can be specified in the control properties on the
"General" tab.

See also
Properties of Function Trend Control - Toolbar Tab (Page 1606)
Starting and Stopping Update (Page 1597)
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Displaying a Trend on Top (Page 1598)
How To Enlarge a Segment of a Trend (Page 1602)
How to Determine the Coordinates of a Point (Page 1600)
Online Configuration of Function Trend Control (Page 1595)

Online Configuration of Function Trend Control
Introduction
There are two possible methods by which you can modify the configuration of the Function
Trend Control in runtime.
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Keyboard function Open the Parameter Dialog
Keyboard function Open the Configuration Dialog allows you to access virtually all Function
Trend Control settings including data linking for the trends that are to be displayed. Only the
input privileges configured for persistence cannot be amended in runtime.
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Keyboard function Opens the dialog for selecting a trend
Keyboard function Opens the dialog for selecting a trend allows you to access certain Function
Trend Control settings.

See also
How to Operate Function Trend Control in Runtime (Page 1594)

Starting and Stopping Update
Introduction
You can use keyboard function Start/Stop the Update to halt or restart the update in the trend
window. When the update is stopped you can modify the time range being displayed, and
display value of measurement points from the process value archive in the trend window.
Certain functions, such as keyboard function Enlarge Area automatically stop the update of
value of measurement points.
When updates are stopped, you may change the displayed time frame and therefore display
measurement values from the process value archive in the table window.
: When updates are stopped, you may change the displayed time frame and therefore
display measurement values from the process value archive in the table window.
: When updates are started, you may change the displayed time frame and therefore
display measurement values from the process value archive in the table window.

See also
How to Operate Function Trend Control in Runtime (Page 1594)
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Displaying a Trend on Top
Introduction
If a common axis is used, the settings for the trend displayed displaying the axis.
You can modify the trend displayed on top in runtime:
● with the
● with the
● with the

1598

button: (keyboard function Opens the dialog for selecting a trend)
button: (keyboard function Next trend on top)
button: (keyboard function Previous trend on top)
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Configuration
The sequence to be used for the trends is configured in the Limiting Value tab of the Properties
of WinCC Function Trend Control dialog box. It can be changed via the Up and Down buttons.

See also
How to Operate Function Trend Control in Runtime (Page 1594)
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How to Determine the Coordinates of a Point
Introduction
You can use the "Display Value at this Position" key function to determine the coordinates of
a point in the trend. To make it easier to determine the coordinates, you can also enlarge a
particular segment of the trend lines.

Requirement
● Configure a Function Trend Control.
● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area"
and "Activate Normal View".
● You can specify the font for the tag value table that is displayed with the key function
"Display value here" in the "Font" tab and via the property "RulerFont".
● Start Runtime.

Procedure
1. In the toolbar, click the "Display Value at this Position" button.
A cross-hair appears in the trend window. The coordinates for the center point of the crosshair are displayed below the trend window.
2. Move the mouse over one of the axes or the center point of the crosshair.
3. Hold down your left mouse button and drag the center point of the crosshair to the position
of the value of measurement point whose coordinates you wish to know.
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4. Release the left mouse button.

5. Read off the coordinates for the value of measurement point from the area below the trend
window.
6. In the toolbar, click the "Display Value at this Position" button.
The cross-hair disappears.
Note
Points which lie between two measured value pairs and have therefore interpolated are
identified with an "i".

See also
How to Operate Function Trend Control in Runtime (Page 1594)
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How To Enlarge a Segment of a Trend
Introduction
You can use the "Enlarge Area" key function to zoom in on any segment of the trend window.
You may then find that the keyboard function "Display Value at this Position" is easier to use
within the enlarged display to determine the coordinates of a particular measurement point.
Use the "Activate Original View" key function to switch back from an enlarged display to normal
display mode.

Requirement
● Configure a Function Trend Control.
● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area"
and "Activate Normal View".
● Start Runtime.

Procedure
1. Click the "Enlarge Area" button in the toolbar.
The display stops being updated and the mouse pointer changes to a cross-hair.
2. In the trend window, click one corner of the area that you wish to enlarge.
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3. Hold down your left mouse button and drag the area you want to enlarge until it reaches
the desired size.

4. Release the left mouse button.
The section you selected is now shown enlarged.
5. Click the "Activate Original View" button in the toolbar.
The trend window is once more displayed in normal view as originally configured.
6. Click on the "Start/Stop the Update" button in the toolbar to restart updating the display in
the trend window.

See also
How to Operate Function Trend Control in Runtime (Page 1594)

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1603

Archiving Process Values
6.5 Output of Process Values

Appendix
How to Create a Process Value Archive
Introduction
In order to display archive tags in a WinCC Function Trend Control, you must configure a
process value archive. A process value archive is created most easily with the help of the
Archive wizard.

Procedure
1. Start Tag Logging and select the "Archive Wizard ...". command in the archive pop-up menu.

2. In the second step of the Archive Wizard, assign a meaningful name to the process value
archive.
3. In the third step of the Archive Wizard, include the desired tags in the process value archive.
4. Close the Wizard by clicking "Apply".
Note
For the other examples of Function Trend Control, you require process value archive PW1
with the three tags Tag 1, Tag 2 and Tag 3, each with data type signed 16-bit value.

See also
How to Display Archive Tags (Page 1585)
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How to Create a User Archive
Introduction
To display ideal trends or values from user archives in a WinCC Function Trend Control, you
need to configure a user archive. You can create user archives with the aid of WinCC option
User Archives.

Procedure
1. Start User Archives and from the Archives pop-up menu select the command New Archive.

2. Give the user archive a meaningful name and click the Finish button.
3. Answer the question about creating a field in the archive with Yes.
4. Give the first field a meaningful name and click the Finish button.
5. Answer the question about creating another field in the archive with Yes.
6. Give the second field a meaningful name and click the Finish button.
7. Answer the question about creating another field with No.
8. Answer the question about creating another archive with No.
9. Click the Save button in the toolbar.
Note
For the other examples of Function Trend Control, you require user archive UA1 with columns
Setpoint X and Setpoint Y.

WinCC: Working with WinCC
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See also
How to Insert the User Archive Table Element into a Picture (Page 1611)
How to Compare Tag Values with an Ideal Trend (Page 1588)
How to Display Data from User Archives (Page 1586)

Properties of Function Trend Control - Toolbar Tab
Introduction
On the Toolbar tab, define the toolbar buttons which may be used to operate the trend window
in runtime.

Display
Defines whether a toolbar can be used to operate the trend window in runtime.

Alignment
Defines at which edge of the trend window the toolbar will be displayed.

Keyboard Functions
This attribute defines which keyboard functions will be displayed as buttons in the toolbar and
be available for operating the trend window.
Online-Help System
Open the Configuration Dialog
Display Value at this Position
Enlarge Area
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Activate Original View
Opens the dialog for selecting a trend
Next Trend to the Front
Previous Trend to the Front
Start/Stop the Update

Key, Hot Key
Specifies the hot key with which a chosen keyboard function can be triggered.

See also
How to Operate Function Trend Control in Runtime (Page 1594)
Properties of the Function Trend Control (Page 1613)

Properties of Function Trend Control - Font Tab
Introduction
On the Font tab, you can set the font to be used in the trend window. If you select either from
the top or from the bottom as the direction to be written, you should use True-Type fonts within
the trend window to ensure a clean display of the X axis labeling.
Note
The appearance of this tab and the names of the different fields depend on other installed
programs.

Font
Specifies the name of the character set which is to be used.

Font Size
Sets the size of the selected character set.

WinCC: Working with WinCC
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Display
Sets the font style for the selected character set (e.g. bold, italic, underline).

Sample Text
Shows a preview using the chosen settings.

See also
Properties of the Function Trend Control (Page 1613)

Properties of Function Trend Control - General Tab
Introduction
On the General tab, you can define the general appearance and behavior of the trend window.

Window Title - Display
Defines whether the title bar of the trend window will be displayed in Runtime.

Window Title - Input Field
Defines the text that will be displayed in the title bar of the trend window in Runtime.

Background Color
Defines the background color that will be used in the trend window in Runtime.

Open Picture - Display Ruler
Defines whether the ruler for querying the coordinate points will automatically be displayed in
the trend window every time there is a picture exchange in Runtime.
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Open Picture - Load archive data
Defines whether archived values should be loaded or currently occurring values should be
displayed when the picture is opened.

Display - Status Bar
Defines whether the status bar of the trend window will be displayed in Runtime.

Display - Toolbar
Defines whether the toolbar of the trend window will be displayed in Runtime.

Display - Write Direction
Defines the direction in which the positive values on the axes are dipicated.
From the Right Positive values run to the right and upwards.
From the Left
Positive values run to the left and upwards.
From the Top
Positive values run to the right and upwards.
From the Bottom Positive values run to the right and downwards.

Display - Common X Axis
Defines whether the common X axis will be used for all the trends in the trend window. The
first trend in the list of trend window elements (Trends tab) determines the color and the range
of the axis.

Display - Common Y Axis
Defines whether the common Y axis will be used for all the trends in the trend window. The
first trend in the list of trend window elements (Trends tab) determines the color and the range
of the axis.

Display - Sizable
Defines whether the size of the trend window can be changed in Runtime.

Display - Can Be Closed
Defines whether the trend window can be closed in Runtime.

Persistence in RT
Specifies in Runtime whether changes made to the Function Trend Control settings should
also be effective after a picture exchange.

WinCC: Working with WinCC
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In the Configuration System you can use the "Selection..." button to select one of the
authorizations configured in the User Administrator. Should you assign an operator
authorization, the persistence setting can only be changed in runtime if the logged in user has
the authorization to do so.

Persistence in RT and CS
Specifies in runtime whether changes made to the Function Trend Control settings will also
be applied to the Configuration System and be used when the project is reactivated.
In the Configuration System you can use the "Selection..." button to select one of the
authorizations configured in the User Administrator. Should you assign an operator
authorization, the persistence setting can only be changed in runtime if the logged in user has
the authorization to do so.
Changes to the control properties in Runtime are not persistently accepted in CS with PCS 7
projects or TIA projects. When you completely load the ES to the OS, the changed settings
on the OS will be overwritten.
Configure the properties of the controls on the ES.

Time Base
Defines the base for the time setting in WinCC.

See also
Properties of the Function Trend Control (Page 1613)
Setting Time in WinCC (Page 97)

Quick Configuration of Function Trend Control
Introduction
After inserting a Function Trend Control into a picture in the Graphics Designer, the Quick
Configuration dialog box opens. This simplifies the configuration task by bringing together the
main features of Function Trend Control in a single dialog box.
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See also
Properties of the Function Trend Control (Page 1613)

How to Insert the User Archive Table Element into a Picture
Introduction
To display ideal trends or values from user archives in a WinCC Function Trend Control, you
need to configure a user archive. You can create user archives with the aid of WinCC option
User Archives. Values are entered in the user archive in runtime in the WinCC User Archive Table Element, which is inserted in a picture and configured with the aid of the Graphics
Designer.

Requirement
● Configure a user archive UA1 with the columns Setpoint X and Setpoint Y.

Procedure
1. Start Graphics Designer and open a new picture.
2. In the Object Palette, Controls tab, click the object WinCC User Archive - Table Element.
3. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the control to the desired size.
5. Double-click the User Archive - Table Element.
6. In the Source area, click the Select button.
7. Select the user archive.
8. Click OK to close the dialog.
9. Save the picture.
10.Enable runtime and enter values in the Setpoint X and Setpoint Y columns.

See also
How to Compare Tag Values with an Ideal Trend (Page 1588)
How to Display Data from User Archives (Page 1586)
How to Create a User Archive (Page 1605)
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Properties of Function Trend Control - Trends Tab
Introduction
On the Trends tab, you can define the tags you wish to display and the appearance of the
trends.

Trends
Defines the trends to be displayed. Use the + and - buttons to add new or delete existing trends.
Use the Up and Down buttons to change the order of the trends. The order of the trends is
analyzed in runtime by the keyboard functions Previous trend on top and Next trend on top.
When using shared axes, the first trend in the list determines the color and value range of the
axes.
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Name
Defines the name of the trend. This name is used in the list of elements.

Display - Visible
Defines whether the trend selected in the list of elements is to be displayed in runtime. With
this setting, you can suppress the display of configured trends without actually having to delete
them.

Display - Color
Defines the color with which the trend selected in the list of elements and its associated axes
will be displayed in runtime.

Ideal Trend
Defines whether an ideal trend is to be displayed with the trend selected in the list of elements.
Use the Properties button to set the properties of the ideal trend.

See also
Displaying a Trend on Top (Page 1598)
Properties of the Function Trend Control - Setpoint Trend Properties (Page 1614)
Properties of the Function Trend Control (Page 1613)

Properties of the Function Trend Control
Introduction
The properties of WinCC Function Trend Control can be modified by using either the Quick
Configuration dialog, the Configuration dialog or the Properties.

Quick Configuration
The Quick Configuration dialog box opens automatically when you insert a Function Trend
Control into a picture in the Graphics Designer.

Configuration Dialog
The Configuration dialog box opens when you double-click or use the Configuration dialog...
command in the Function Trend Control pop-up menu.

Properties
The Properties dialog box opens when you use the Properties command in the Function Trend
Control pop-up menu.
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See also
Properties of Function Trend Control - Font Tab (Page 1607)
Properties of Function Trend Control - Toolbar Tab (Page 1606)
Properties of Function Trend Control - Trends Tab (Page 1612)
Properties of Function Trend Control - General Tab (Page 1608)
Quick Configuration of Function Trend Control (Page 1610)

Properties of the Function Trend Control - Setpoint Trend Properties
Introduction
In the Setpoint Trend Properties dialog, select the color, layout and data basis of the setpoint
trend.

Archive Linking - Source
Defines the name of the user archive in which the value pairs of the setpoint trend are stored.
Click ... to select a configured user archive.
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Archive Linking - Column for X-Values
Defines the column in the user archive that contains the X coordinates of the value pairs for
the setpoint trend.

Archive Linking - Column for Y-Values
Defines the column in the user archive that contains the Y coordinates of the value pairs for
the setpoint trend.

Archive Linking - Number of Values
Defines the number of values on which the setpoint trend is based.

Archive Linking - from ID
Defines the record in the user archive in which the value pairs of the setpoint trend are stored.

Display - Color
Defines the color in which the trend is displayed in runtime.

Display of Format
Defines the format in which the trend is displayed in runtime.

See also
Properties of the Function Trend Control (Page 1613)
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6.6

Direct Access to the Archive Database

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also
enable you to directly access the WinCC archive databases. Direct access lets you, for
example, read process values for editing in spreadsheet programs.

Requirement
The project is loaded on the configuration computer and is located in Runtime.

Access to archive databases with ADO/OLE DB
The process values are partially saved in compressed format to the archive databases. Use
the WinCC OLE DB Provider to access such compressed process values. You can use the
Visual Basic or Visual C++ programming languages, for example.
Note
Note that the table structure may vary in a new WinCC version when directly accessing the
archive database using ADO/OLE DB.
For additional information, refer to the Microsoft MSDN Library at "Win32 and COM
Development > Data Access and Storage > Windows Data Access Components SDK" on the
Internet:
● http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/
library/default.aspx)

Access to the archive database using OPC
OPC (OLE for Process Control) provides interfaces for communication with process
automation systems. The OPC interface enables harmonized interconnection of devices and
applications from different manufacturers. You can use WinCC as an OPC client to access
process data or messages of an OPC server. WinCC can by used as OPC server to manage
archive data.
For further information, refer to:
● "WinCC Information System", "Communication" > "OPC",
● "WinCC Information System", "System Overview" > "Open Source"
● On the Internet at "http://www.opcfoundation.org"

Access to the archive database using C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions
by means of open source programming interfaces.
For further information, refer to:
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● Documentation of the WinCC Open Development Kit

See also
http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/library/
default.aspx)
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6.7

Function Call Templates

6.7.1

Function Call Templates
In different dialogs of the Tag Logging" configuration system, you can specify functions to be
executed when certain events occur. These functions must be developed by you in the Global
Script editor and must comply with the nomenclature of the respective template.
The following templates for function calls are available in WinCC:
● Function During Start of Archiving
● Function for Conversion of Tag Values
● Function to Start Archiving
● Function to Stop Archiving

See also
Function to Stop Archiving (Page 1620)
Function to Start Archiving (Page 1620)
Function for Conversion of Tag Values (Page 1619)
Function During Start of Archiving (Page 1618)

6.7.2

Function During Start of Archiving
void function name (Boolean fFlag);

Description
This function is triggered during the start of an archiving process. It can be assigned on the
"General" tab in the "Properties" dialog in the Archiving group.

Parameters
fFlag
TRUE Lock Archive
FALSE Unlock Archive

Application Example
You can for example use this function to obtain information on the status of an archive.
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6.7.3

Function for Conversion of Tag Values
double function name (double doLmtValue,
double doValue,
int dwCount,
int archiving);

Description
This function can be used to convert a tag value prior to archiving. The value of the process
tag (here: doValue) can be recalculated according to the requirements. The result is returned
as a return value of the function to Tag Logging for archiving. The function is assigned under
Edit/Action in the Properties Process Tag dialog in the Parameter tab .

Parameters
dLmtValue:last acquired value (from last acquisition cycle)
doValue :currently acquired value
dwCount: number of acquisition cycles since the last archiving
Logging: TRUE when archiving is performed

Application Example
The current process value should be divided by 10 and archived.
double Norm_PDE(double doLmtValue, double doValue, int dwCount, int
Archiving)
{
return (doValue/10);
}
Note
Note that the transfer parameter is declared in exactly the same way as in this example. The
parameters are transferred from Tag Logging to the function.
What happens within an action is the responsibility of the user.
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6.7.4

Function to Start Archiving
int function name ( );

Description
The function must return value "0" (corresponds to FALSE) or "1" (corresponds to TRUE).
Other values are not permissible. An archiving process is triggered, depending on the archiving
method and the value returned by the function.
For cyclic archiving, the archiving is always triggered, if the return value of the function is "1".
For acyclic archiving, the archiving is always triggered, if the returned value has changed since
the last function call. The first function call must return value "1".
The function is assigned in the Properties Process Tag dialog in the Archiving tab in the Actions
group.

6.7.5

Function to Stop Archiving
int function name ( );

Description
The function must return value "0" (FALSE) or "1" (TRUE). Upon a return value of "1" a running
archiving process can be stopped.
The function is assigned in the Properties Process Tag dialog in the Archiving tab in the Actions
group.

6.7.6

Appendix

6.7.6.1

Action for Swap-Out
void function name (
LPTSTR lpszArchivName
LPTSTR lpszVariablenName,
DWORD dwNumberOfRecords);

Description
With this function you can specify how to swap out your short-term archive.
Upon reaching the upper limit of your short-term archive, this function is called for each tag of
the archive.
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Once the function is triggered, the call to this function is cyclic whenever the respective tag
writes new values to the short-term archive.
This function can be assigned on the "Archive Parameters" tab in the "Process Value Archive
Properties" dialog.

Parameters
lpszArchivName
Pointer on Name of Archive.
lpszVariablenName
Pointer on Name of Tag.
dwNumberOfRecords
Number of measured values saved in short-term archive.
Note
The function is also executed if the archive is locked.

6.7.6.2

Action upon Sending
void function name (
bool fFlag);

Description
This function is triggered after a tag is sent. It can be assigned on the "Raw Data Tag" tab of
the "User Archive Properties" dialog.

Parameters
fFlag
The parameter has the value "FALSE" and is reserved for future extensions.

Application example
This function can be used to ensure that a message is displayed when a raw data tag is sent.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1621

Archiving Process Values
6.7 Function Call Templates

6.7.6.3

Action upon Reception
void function name (
bool fFlag);

Description
This function is triggered after a tag is received. It can be assigned on the "Raw Data Tag" tab
of the "User Archive Properties" dialog.

Parameters
fFlag
The parameter has the value "FALSE" and is reserved for future extensions.

Application example
This function can be used, for example, to evaluate a raw data tag immediately after it is
received.
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7.1.1

Introduction to archives/user archives

7

Introduction
User archives allow you to assemble data resulting from production or machine parameter
assignment. The data records are transferred between user archives and the automation
system continuously or upon demand.
You can use the "User Archive" editor to define the structure of the user archive. You configure
views to combine data from different user archives.

Using user archives
User archives can be used in the following scenarios:
● The user archive sends modified recipes or production parameters to the automation
system online with the press of a button.
● The batch data or data for product quality is continuously recorded in the user archive to
fulfill legal requirements for complete documentation.
● The operating data of the automation system is analyzed via the user archive.
● You can import production data stored in an external database into the user archive in
Runtime via a CSV file and then transfer it to the automation system.
● The data of the user archive is selected with SQL to represent a selection in a view.
● The data of the user archive is shown as reference trends in a WinCC Function Trend
Control to enable setpoints to be compared to values from the process value archive.

Configuring a user archive
Once you have defined the structure of the user archive, you configure the user archive in the
"User Archive" editor:
● You create and edit the user archive and the associated data fields.
● You configure the communication and control between the archive and automation system.
● You enter new data records or import the values from a CSV file. If necessary, modify
existing Runtime data.
● If you want to merge user archives, you configure a view.
Alternatively, you can use user archive scripts to configure user archives or operate them in
Runtime.
WinCC: Working with WinCC
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Displaying and changing Runtime data from user archives
The WinCC UserArchiveControl displays the data from the user archive or the view in table
form in a process picture. You configure the UserArchiveControl in the "Graphics Designer"
editor. In the UserArchiveControl, you can change the data or create new data records which
are then copied into the user archive.
Note
Prior to WinCC V7, the display of the user archives was configured in a user archives table
element.

7.1.2

Properties of a user archive
In WinCC Configuration Studio, you edit the properties of a user archive in the "Properties"
area of the "User Archive" editor.

General properties
Name

The name can only include numeric and alphabetic characters and the underscore
character "_". The first character must be a letter.

Alias

Any Unicode characters can be used as alias.

Multilingual alias

Option selected:
The alias is copied into the TextLibrary.
When the language is changed in Runtime, the alias of the archive name is also
displayed in the corresponding language.
The fields can be edited in the "Translation Alias" section. Translations are displayed
here.

Type

The "Limited" option can be used to restrict the number of data records in the archive.

Max. number

Number of data records in the archive if "Limited" is selected as type.

Last change

Display only: Time stamp of last change

Communication
Communication type

Raw data tag:
Enter a freely selectable "PLCID" as unique name of the user archive.
Select a raw data tag under "Tag name".
Data manager tags:
Configure the assignment of tags when creating the user archive fields.

PLCID

The "PLCID" must consist of exactly 8 ASCII characters and must be unique within the
WinCC project.
The "PLCID" is required in order for the automation system to send the process data
back to the correct user archive. Do not use the "R_ID" configured in the raw data tag,
since "R_ID" is only relevant for communication with the automation system.

Tag name
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Authorizations and flags
Read rights

By default, the user archive has no access protection.

Write rights

Here you configure the access rights for read and write access to the user archive.
Select an authorization provided by the "User Administrator" from the drop-down list.
If you want to use a separate authorization, you must first create the authorization in
the User Administrator.
Access protection for the user archive is queried in Runtime on opening the screen of
a UserArchiveControl.

Field - last access

Option activated:
In the archive, a field is generated where the time stamp of the last access is stored.
The field is displayed in the table area under "Archive data". The field values and
properties cannot be edited.
If the user archive is synchronized through a redundant system, the "Field - last access"
option must be selected.

Field - Last user

Option selected:
In the archive, a field is generated where the name of the last user is stored.
The field is displayed in the table area under "Archive data". The field values and
properties cannot be edited.

Sequence
The property "Position" cannot be edited.

Control tags
Control tags

Function

Data type

ID

The data record number of the user archive

Signed 32-bit value

Job

The following jobs are possible:

Signed 32-bit value

"6" = Read a data record from the tags in the user archive
"7" = Write a data record from the user archive to the tags
"8" = Delete a data record in the user archive
After the job has been carried out, an error ID can be
seen in "Request":
"0" = No error
"-1" = Error
Field

The specific field of the user archive

Text tag, 8-bit

Value

The value of a particular user archive field

Text tag, 8-bit

Additional combinations of the control tags "ID" and "Job":
ID

Job = "6"

Job = "7"

Job = "8"

-1

Attach data record

-

Delete data record with the lowest ID
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-6

Read data record with the lowest
ID

Write data record with the lowest
ID

Delete data record with the lowest ID

-9

Read data record with the highest
ID

Write data record with the highest
ID

Delete data record with the highest ID

Translation Alias
If the option "Alias multilingual" is selected under "Properties" - "General", the translated texts
for the "Alias" are displayed here. You can edit the texts here.
The field "Alias(ID)" displays the ID of the text for the input language alias in the "Text Library"
editor.

7.1.3

Properties of a user archive field
In WinCC Configuration Studio, you edit the properties of a user archive field in the "Properties"
area of the "User Archive" editor.

General properties
Name

The name can only include numeric and alphabetic characters and the underscore character
"_". The first character must be a letter.

Alias

Any Unicode characters can be used as alias.

Multilingual alias

Option selected:
The alias is copied into the TextLibrary.
When the language is changed in Runtime, the alias is also displayed in the corresponding
language.
The fields can be edited in the "Translation Alias" section. Translations are displayed here.

Type

Selection of the data type from a drop-down list:
● Number (integer):
Signed 32-bit value
● Number (float):
Floating-point number 32-bit IEEE 754
● Number (double):
Floating-point number 64-bit IEEE 754
● Character string:
Text tag, 8-bit
● Date/time:
The input format or output format depends on the project setting.

Length

Only for "Character string" data type: Length of the character string.

Last change

Display only: Time stamp of last change

Archive

Display only: Name of the archive in which the field was created.
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Values
Minimum value

Only if "Number" is selected as data type under "Type":

Maximum value

Lowest/highest value that can be stored in the field.

Start value

Start value for the field when Runtime is started.
For tags of the "Character string" type, you can, for example, enter a text to be displayed
when Runtime is started.

Tag name

Only if the property "Communication Type" - "Data Manager Tags" is selected for the archive:
Selection of the tags through which the field communicates with the AS.

Authorizations and flags
Read rights

By default, the user archive field has no access protection.

Write rights

Here you configure the access rights for read and write access to the user archive field.
Select an authorization provided by the "User Administrator" from the drop-down list. If you
want to use a separate authorization, you must first create the authorization in the User
Administrator.
Access protection for the user archive field is queried in Runtime on opening the screen of a
UserArchiveControl.

Value required

Option selected:
The field must not be empty.

Unique value

Option selected:
A value cannot be assigned more than once. The value for the field must differ from the values
for other fields.

with index

Option selected:
The field is supported by an index for quick searches.

Sequence
Displays the position of the field.
The position may be changed by using the shortcut menu of the row header.
When this column is shown in the table area, the "Position" property can be used to sort and
filter.

Translation Alias
If the option "Alias multilingual" is selected under "Properties" - "General", the translated texts
for the "Alias" are displayed here. You can edit the texts here.
The field "Alias(ID)" displays the ID of the text for the alias in the "Text Library" editor.

7.1.4

Properties of a view
In WinCC Configuration Studio, you edit the properties of a user archive view in the "Properties"
area of the "User Archive" editor.
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General properties
Name

The name can only include numeric and alphabetic characters and the underscore
character "_". The first character must be a letter.

Alias

Any Unicode characters can be used as alias.

Multilingual alias

Option selected:
The alias is copied into the TextLibrary.
When the language is changed in Runtime, the alias is also displayed in the
corresponding language.
The fields can be edited in the "Translation Alias" section. Translations are displayed
here.

Last change

Display only: Time stamp of last change

Relation
Relation

Here, you establish a link between fields of various user archives. Define the relations
of the field contents. The fields that are related to each other must be of the same data
type.
Enter the relation in SQL.

Sequence
The property "Position" cannot be edited.

Translation Alias
If the option "Alias multilingual" is selected under "Properties" - "General", the translated texts
for the "Alias" are displayed here. You can edit the texts here.
The field "Alias(ID)" displays the ID of the text for the alias in the "Text Library" editor.

7.1.5

Properties of a user archive column
In WinCC Configuration Studio, you edit the properties of the column of a user archive in the
"Properties" area of the "User Archive" editor.

General properties
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Name

The name can only include numeric and alphabetic characters and the
underscore character "_". The first character must be a letter.

Alias

Any Unicode characters can be used as alias.
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Multilingual alias

Option selected:
The alias is copied into the TextLibrary.
When the language is changed in Runtime, the alias is also displayed
in the corresponding language.
The fields can be edited in the "Translation Alias" section. Translations
are displayed here.

Archive

Selection from a drop-down list:
User archive where the linked field is defined.

Field

Selection from a drop-down list:
Field whose data are copied to the view.

Last change

Display only: Time stamp of last change

View

Display only: View containing the user archive column.

Sequence
Displays the position of the user archive column.
The position may be changed by using the shortcut menu of the row header.
When this user archive column is shown in the table area, the "Position" property can be used
to sort and filter.

Translation Alias
If the option "Alias multilingual" is selected under "Properties" - "General", the translated texts
for the "Alias" are displayed here. You can edit the texts here.
The field "Alias(ID)" displays the ID of the text for the alias in the "TextLibrary" editor.

7.1.6

User archives and redundancy

Introduction
You can integrate user archives in a redundant system using WinCC redundancy. With parallel
operation of two servers, if one server fails, the data of the user archives is synchronized online.
Find out more about the operation and configuration of WinCC redundancy for user archives
in the chapters on "Redundant Systems" in the WinCC Information System .

Requirements for the use of redundant user archives
● The user archives are only synchronized if WinCC components are used, for example,
functions of the UA API, control tags, WinCC UserArchiveControl. The user archives are
not synchronized if the database is accessed through ODBC and the Connectivity Pack.
● The user archives to be synchronized require the same structure on both servers. The
configuration of the user archives and the properties must therefore be identical. You can
ensure this by exporting and importing the configuration data.
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● The archive property "Field - last access" must be activated for online synchronization. You
activate the option in the user archive under the "Authorizations and Flags" property in the
"Properties" area of the archive.
● When raw data tags are used for communication of the user archives, the name of the raw
data tags used must be identical on both servers.
● Configuration changes can only be saved during Runtime when no redundancy
synchronization is being performed at that time in the user archives.

7.1.7

Overview of unusable names

Introduction
The names of archives, views, and fields in the user archives may only contain letters,
numbers, and "_" and must not exceed a maximum of 25 characters. The first character must
always be a letter.
You may not use the following names:
● Archives
● View
● Field
● ViewCol

Overview of SQL keywords
You may not use the following keywords or reserved words in SQL as the names in the user
archive:
Keywords used in SQL
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add

all

alter

and

any

as

asc

begin

between

binary

break

by

call

cascade

cast

char

char_convert

character

check

checkpoint

close

comment

commit

connect

constraint

continue

convert

create

cross

current

cursor

date

dba

dbspace

deallocate

dec

decimal

declare

default

delete

desc

distinct

do

double

drop

else

elseif

encrypted

end

endif

escape

exception
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Keywords used in SQL
exec

execute

exists

fetch

first

float

for

foreign

from

full

goto

grant

group

having

holdlock

identified

if

in

index

inner

inout

insert

instead

int

integer

into

is

isolation

join

key

left

like

lock

long

match

membership

message

mode

modify

named

natural

noholdlock

not

null

numeric

of

Off

on

open

option

Options

or

order

others

out

outer

passthrough

precision

prepare

primary

Print

privileges

proc

procedure

raiserror

readtext

Real

reference

references

release

remote

rename

resource

restrict

return

revoke

right

rollback

save

savepoint

schedule

select

set

share

smallint

some

sqlcode

sqlstate

start

stop

subtrans

subtransaction

synchronize

syntax_error

table

temporary

then

time

tinyint

to

tran

trigger

truncate

tsequal

union

unique

unknown

update

user

using

validate

values

varbinary

varchar

variable

varying

view

when

where

while

with

work

writetext
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7.2

Configurations in the user archive

7.2.1

The "User Archive" editor

Introduction
You can create user archives or views in the user interface of the "User Archive" editor. You
can supply the archive with data in the editor.
Notes on the operation of editors in the "Configuration Studio" are available here: Interface
(Page 53).
Note
"Undo" not possible.
The functions "Undo" and "Restore" are not available in the "User Archive" editor.

Structure of the "User Archive" editor
The "User Archive" editor is divided into three working areas:
● Navigation area
– Tree view showing objects as folders
– Navigation bar for switching between the editors
● Table area
– Creation and editing of multiple objects
– View and input of archive data
● Properties area
– Properties of a selected object
– "What's this?" for the selected property.
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① Navigation area
In the navigation area, the objects of the "User Archive" are displayed in a tree view.
The folders of the top level are:
● Archives
● Views
The elements (e.g. archives, views, fields...) assigned to a selected folder are displayed in the
table area.

② Selection of the editors
The navigation bar is displayed in the area below the tree view. From here, you have access
to additional WinCC editors (e.g. Tag Management, Tag Logging)... You can adjust the display
of the navigation bar.

③ Table area
The table displays the elements that are assigned to the folder selected in the tree view. You
can, for example, choose to have all fields of an archive displayed.
You create new fields in the table area. You can enter or edit data directly here.
Additional functions are available in the table area via the shortcut menu of the column headers:
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● Sort
● Filtering
● Hide column, show additional columns
Tabs are displayed below the table depending on the selected folder. You can use these tabs
to display the lower-level elements in table format.
Navigation keys allow you to select tabs. You select a tab by clicking on it, with the navigation
keys, or from the shortcut menu of the navigation keys.

④ What's this?
Displays an explanation of the selected property. You can drag this area to zoom in and out.

⑤ Properties
Here, the properties of a selected object are displayed and can be edited.
Status bar
At the bottom edge of the editor is the status bar.
Here, you will find the following information:
● Current input language
● Status of the system (ready, etc.), status of Caps Lock key, NUM Lock key, etc.
● Number of objects, e.g. archives, data records, views… in the selected folder
● Number of selected objects if this is more than one
● Display of the zoom status, slider for zooming in and out of the display
Alternatively, you can change the size of the display by pressing the <Ctrl> key while moving
the mouse wheel.

7.2.2

Configuration of a User Archive

7.2.2.1

How to create a user archive

Introduction
In WinCC Configuration Studio, you create a user archive in the table area of the "User Archive"
editor.

Procedure
Note
You may not use keywords or reserved words in SQL as the archive name.
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1. Select the "Archive" folder in the navigation area of the "User Archive" editor.
2. Click in the top empty cell of the "Name" column in the table area. The cell is marked by a
yellow symbol.

3. Enter an archive name. The name can only include numeric and alphabetic characters and
the underscore character "_". The first character must be a letter.
Create a multilingual alias to represent archive names in all project languages in a userfriendly way.
4. Edit the properties of the archive.
5. If you select the "Limited" option for the "Type" property, you can determine the maximum
number of data records in the user archive.

Creating multiple archives
1. Create a new archive.
2. Select the cell in the "Name" column.
3. Drag down the selection at the bottom right corner while keeping the left mouse button
pressed.
A new archive is created in each row over which you drag the selection.

7.2.2.2

How to edit properties of a user archive

Introduction
The properties of archives are displayed in the table area and in the "Properties" area of the
"User Archive" editor.

Procedure
1. Select the "Archives" folder in the navigation area.
2. In the table area, select the row of the archive whose properties you wish to display and
edit.
3. Edit the properties in the table area or in the "Properties" area.
Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
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In the table area, you can use the shortcut menu of a column header to show or hide specific
columns (and therefore properties). You can display archives in a user-friendly manner using
filtering and sorting options. The table area allows you to edit a large number of archives at
the same time. To do this you can use, for example, the "Select and pull selection down"
function or the shortcut menu commands "Deselect all" and "Select all".
The "Properties" area shows all the properties of the archive which is selected in the table area.

7.2.2.3

How to configure the communication to tags

Introduction
By configuring the communication, you define how data are transferred between WinCC tags
or the automation system and the user archive. You can configure one connection to the
automation system per user archive.
The following types of communication are possible:
● No communication with the user archive.
● Whole data records are transferred between the automation system and user archive via
a WinCC raw data tag.
● Individual data fields of a data record are transferred via WinCC tags.

Procedure
1. Select the archive in the navigation area or in the table area.
2. Edit the properties of the archive in the "Communication" section in the "Properties" area.
– Select a communication type.
If you select the "Via a raw data tag" option, enter a freely selectable "PLCID" as a unique
name for the user archive. The "PLCID" must consist of exactly 8 ASCII characters and
must be unique within the WinCC project. The "PLCID" is required in order for the
automation system to send the process data back to the correct user archive. You cannot
use the "R_ID" configured in the raw data tag, since "R_ID" is only relevant for
communication with the automation system. Multiple user archives can also be supplied
by the same raw data tag.
– Select a raw data tag using

.

– If you select the "Data Manager Tags" option, you configure the assignment of tags
when creating the user archive fields using the "Values/Tag name" property.

7.2.2.4

How to configure the control tags

Introduction
You use the control tags to access user archive fields in a user archive. If you use control tags,
you always have to configure all four control tags.
The control tags provide two methods to access the user archives:
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● You can use the control tags of the data record ID and job to read, write or delete specific
target values in a data record.
● You can use the control tags of the archive field and the value of the archive field to find a
data record. You can use the control tag of the job to write, read or delete selected data
records.

Procedure
Note
The data type of the control tags may not be changed.
1. Select the archive in the navigation area or in the table area.
2. Edit the properties of the archive in the "Control Tags" section in the "Properties" area.
3. Select a tag using the tag selection dialog. Pay attention to the data type you need to use:
– ID and job: Signed 32-bit value
– Field and value: Text tag, 8-bit
The control tags are created in the form @UA_[archive name]_ID, @UA_[archive
name]_Job etc.

7.2.2.5

Example for the use of control tags

Introduction
The following example depicts the use of control tags for the communication between the
internal WinCC tags and the user archive. A WinCC UserArchivControl represents the content
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of the user archive. I/O fields are used to enter or output the values of the control tags and
WinCC tags.

Requirement
● You are familiar with the fundamentals of the "User Archive" and "Graphics Designer"
editors.

Configurations in the user archive
1. Create a user archive. Select "Data Manager Tags" as communication type.
2. Create the control tags and select them.
3. Create the "Name" field ("string" type) and the fields "red," "green," "blue" ("integer" type)
for the user archive.
4. In the "Values"field property, create an internal tag with the data type "Unsigned 8-bit value"
for the fields "red," "green," "blue."
5. Then save the configured user archive.
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Configurations in the Graphics Designer
1. Open a new screen and create a WinCC UserArchiveControl.
2. Link the control on the "General" tab in the "Properties of WinCC UserArchiveControl" dialog
with the configured user archive. Enable the access types "Change," "Insert" and "Delete."

3. Configure additional control properties as desired. Close the dialog.
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4. For the configured fields "red," "green," "blue," add a "static text" object for the label and
an I/O field to the screen. Select the internal tag from the I/O field configuration dialog linked
with the corresponding archive field. Select the "With change" property in the "Update" field.

5. For the configured control tags, add a "static text" object for the labels and an I/O field to
the screen. Now select the corresponding control tag from the I/O field configuration dialog.
Select the "With change" property in the "Update" field. Specify the following settings in the
"Output/Input" property group:
Control tag

Data Format

Output format

@UA_xx_ID

Decimal

s999

@UA_xx_Job

Decimal

S9

@UA_xx_Field

String

*

@UA_xx_Value

String

*

6. Save the configured screen.

Operator input in Runtime
1. Activate WinCC Runtime.
2. In the UserArchiveControl, enter several data blocks as depicted in the example shown
above.
3. Test the following examples and additional combinations of the "ID" and "Job" control tag.
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Writing a data block to the tags
1. Enter "3" into the "ID" I/O field and "7" into the "Job" I/O field.
2. Click the "Enter" key.
The values of the data block with "ID 3" are written to the tags and output in the linked "red,"
"green," "blue" I/O fields.
If the action was successful, the error number "0" is displayed in the "Job" I/O field. In case
of an error, the error number "-1" is displayed.

Writing a specific data block to the tags
1. Enter "Name" into the "Field" I/O field and for example "silver" into the "Value" I/O field.
2. Enter the value "7" into the "Job" I/O field.
The control tag "ID" is not needed. This is why "0" must be entered into the "ID" I/O field.
The data block with the value "silver" is written to the tags and output in the corresponding
I/O fields.

Changing an existing data block by reading the tags
1. Change the values in the "red," "green," "blue" I/O fields.
2. For example, enter "5" into the "ID" I/O field and "6" into the "Job" I/O field.
The changes values are written from the I/O fields of the archive fields and the linked tags
to the data block with the "ID" "5." The values previously contained in this data block are
overwritten.

Adding data block by reading the tags
1. Enter values into the "red," "green," "blue" I/O fields.
2. Enter "1" into the "ID" I/O field and "6" into the "Job" I/O field.
The values of "red," "green" and "blue and the linked tags are appended to the end of the
table of the user archive and depicted as the last data block in the UserArchiveControl.

7.2.2.6

How to specify the authorizations for the archive

Introduction
By default, a user archive has no access protection. The "Authorizations and Flags" properties
determine the access rights for the user archive. Access protection for an archive in Runtime
is queried on opening the screen of a UserArchiveControl. You configure access protection
for the control tags of a protected archive through the object properties in the Graphics
Designer, for example, the I/O field.

Procedure
1. Select the archive in the navigation area or in the table area of the "User Archive" editor.
2. Edit the properties of the archive in the "Authorizations and Flags" section in the "Properties"
area.
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Note
If the user archive is synchronized through a redundant system, the "Field - last access"
option must be selected.

7.2.2.7

How to create user archive fields

Introduction
In WinCC Configuration Studio, you create the fields for a user archive in the table area of the
"User Archive" editor.
Note
You can create 500 fields for each user archive.
You may not use special characters or reserved words in SQL as the field name.
If you change the properties of the user archive fields after completing configuration, data
can be lost in the following circumstances:
● When a modified consistency condition can no longer be fulfilled for existing data, for
example, the "Field must have a value" option.
● When you change a field name.
● When data from the source can no longer be converted due to a new data type.
Note
Limitation by the SQL database
The maximum size of a data record in bytes is limited by the lower-level database system.
An archive data record corresponds to a series. Maximum number of bytes per series: 8060.
You receive an error message if this limit is exceeded.

Procedure
1. Select the folder of an archive in the navigation area of the "User Archive" editor.
2. Select the "Fields" tab in the table area.
3. Click in the top empty cell of the "Name" column in the table area. The cell is marked by a
yellow symbol.
4. Enter a name. The name can only include numeric and alphabetic characters and the
underscore character "_". The first character must be a letter.
5. Edit the properties of the field.
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6. If you specify an alias, the alias is used in Runtime as the column name. You can now
select the option "Alias multilingual" to specify the alias in the respective languages in the
"Translation Alias" section.
7. If you created several user archive fields, you can determine the sequence of the fields in
the user archive using the "Sequence/Position" property. The columns are displayed in the
determined field sequence in the UserArchiveControl. The order affects the assignment of
indices for access via the functions of the WinCC script language.

Creating multiple fields
1. In the case of an already created field, select the cell in the "Name" column.
2. Drag down the selection at the bottom right corner while keeping the left mouse button
pressed.
A new user archive field is created in each row over which you drag the selection.

7.2.2.8

How to edit properties of a user archive field

Introduction
The properties of user archive fields are displayed in the table area and in the "Properties"
area of the "User Archive" editor.

Procedure
Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
1. Select the folder of a user archive in the navigation area.
2. Select the "Fields" tab in the table area.
3. Select the row of a field.
4. Edit the properties in the table area or in the "Properties" area.
In the table area, you can use the shortcut menu of a column header to show or hide specific
columns (and therefore properties). You can display user archive fields in a user-friendly
manner using filtering and sorting options. The table area allows you to edit a large number of
user archive fields at the same time. To do this you can use, for example, the "Select and pull
selection down" function or the shortcut menu commands "Deselect all" and "Select all".
The "Properties" area shows all the properties of the user archive field whose column is
selected in the table area.

7.2.2.9

How to edit the position of a user archive field
You edit the position of a user archive field in the "User Archive" editor using the shortcut menu
in the table area.
The position determines the sequence in which the fields are displayed in Runtime.
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Procedure
1. Select the folder of an archive in the navigation area.
2. Select the "Fields" tab in the table area.
3. Select the row header of a field.
4. Select "Move up" or "Move down" command in the shortcut menu.
The field is moved by one position.

7.2.2.10

How to configure multilingual text

Introduction
When naming user archive fields, you are restricted by the requirements of the database. To
be able to organize the display and the input of data in a user-friendly way, you can create the
"Alias" name of a field in all project languages.

Procedure
Note
For client projects, you need to use the same text ID for the text in the text library of the server
and client. Otherwise, an incorrect text will appear on the client in Runtime.
1. Enter an alias for the field under "Properties" - "General". You can enter all Unicode
characters.
2. Select the option "Alias multilingual".
3. Enter the texts for the alias under "Properties" - "Translation Alias".
4. Alternatively, enter the texts in the "TextLibrary" editor.
Alias (ID): You can find the entries in the TextLibrary under this ID.
If you change the language in Runtime, the corresponding text is displayed in the selected
language.

7.2.2.11

How to make changes in the user archive

Introduction
If you want to modify or extend a user archive, existing data can be lost in the archive. This is
especially true for changes to the structure of a user archive or changes to the properties of a
field.
Changes are applied directly. Not all changes can be reversed in the editor.
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Procedure
In order to avoid data loss, follow these steps:
1. Select the folder you wish to modify in the navigation area.
2. Select "Export" in the shortcut menu.
3. Select a descriptive name for the export file and a storage location in the "Export" dialog.
To backup all archives, select the command "Edit" > "Export" in the main menu of WinCC
Configuration Studio.
The format is irrelevant for re-import to WinCC.
The data of the selected folder are backed up in an export file.
4. To restore archives, select the command "Edit" > "Import" in the main menu of WinCC
Configuration Studio.

7.2.3

Configuring a view

7.2.3.1

How to create a view

Introduction
A view assembles data from multiple user archives. For example, you can create links via the
fields of various user archives with SQL to see Runtime relationships in a single view. The
linked user archives must then have at least one common data field.
In WinCC Configuration Studio, you create a view in the table area of the "User Archive" editor.

Procedure
1. Select the "Views" folder in the navigation area.
2. Click in the top empty cell of the "Name" column in the table area. The cell is marked by a
yellow symbol.
3. Enter a name. The name can only include numeric and alphabetic characters and the
underscore character "_". The first character must be a letter.
A new view has been created.
4. Edit the properties of the view.
5. Add columns to the view.

7.2.3.2

How to edit properties of a view

Introduction
The properties of a view are displayed in the table area and in the "Properties" area of the
"User Archive" editor.
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Procedure
Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
1. To display all views in the table area, select the "Views" folder in the navigation area.
To display the properties of a view, select the view in the table area.
2. Alternatively, select the folder of a view in the navigation area.
The properties of the selected view are displayed in the "Properties" area.
3. Edit the properties in the "Properties" area.
In the table area, you can use the shortcut menu of a column header to show or hide specific
columns (and therefore properties). You can obtain a user-friendly display of views using
filtering and sorting options. The table area allows you to edit a large number of views at one
time. To do this you can use, for example, the "Select and pull selection down" function or the
shortcut menu commands "Deselect all" and "Select all".

7.2.3.3

How to create the user archive columns of a view

Introduction
In WinCC Configuration Studio, you create columns of a view in the table area of the "User
Archive" editor.
A user archive column uses the values of a field from a configured user archive. Each user
archive column can be linked to a different user archive.

Procedure
1. Select the folder of a view in the navigation area.
2. Select the "Columns" tab in the table area.
3. Click in the top empty cell of the "Name" column in the table area. The cell is marked by a
yellow symbol.
4. Enter a name. The name can only include numeric and alphabetic characters and the
underscore character "_". The first character must be a letter.
A new user archive column has been created.
5. Edit the properties of the user archive column.

7.2.3.4

How to edit properties of a user archive column

Introduction
The properties of a user archive column are displayed in the table area and in the "Properties"
area of the "User Archive" editor.
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Procedure
Fields highlighted in color cannot be edited. Whether you can edit properties may depend on
the activation or deactivation of individual options or a selection for another property.
1. Select the folder of a view in the navigation area.
2. Select the "Columns" tab in the table area.
3. Select the row of a user archive column in the table area.
4. Edit the properties of the selected user archive column in the "Properties" area.
In the table area, you can use the shortcut menu of a column header to show or hide specific
table columns (and therefore properties). You can display properties in a user-friendly manner
using filtering and sorting options. The table area allows you to edit a large number of properties
at the same time. To do this you can use, for example, the "Select and pull selection down"
function or the shortcut menu commands "Deselect all" and "Select all".

7.2.3.5

How to edit the position of a user archive column
You edit the position of a user archive column in the "User Archive" editor using the shortcut
menu in the table area.
The position determines the sequence in which the columns are displayed in Runtime.

Procedure
1. Select the folder of a view in the navigation area.
2. Select the "Columns" tab in the table area.
3. Select the row header of a user archive column.
4. Select "Move up" or "Move down" command in the shortcut menu.
The user archive column is moved by one position.
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7.2.3.6

How to display the data of a view
In WinCC Configuration Studio, you display the data of a view in the table area of the "User
Archive" editor.

Requirement
● You configured at least two user archives.
● You have configured a view. The view contains user archive columns which are linked to
fields of the user archives.
● The fields of the user archives contain values.

Procedure
1. Select the folder of a view in the navigation area.
2. Select the "View data" tab in the table area
The data of the view are displayed in the table area.
No data can be edited in this view.
Use the commands from the shortcut menus, e.g. Sort, Filter, Hide Column, to adjust the
display.

7.2.3.7

Example for relation

Example for relation
2 archives were configured with the names Archive1 and Archive2:
Archive1 has the fields named A1Field1, A1Field2 and A1Field3.
Archive2 has the fields named A2Field1 and A2Field2.
2 views were configured with the names View1 and View2:
View 1 has a column that is linked to field A1Field3 and a column that is linked to
A2Field2.
Here, you can set up the following relation, for example:
● ~Archive1.A1Field3 >= ~Archive2.A2Field1
View 2 has a column that linked to field A1Field1 and a column that points to A2Field2.
Here, you can set up the following relation, for example:
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● ~Archive1.A1Field1 < ~Archive2.A2Field2 and ~Archive2.A2Field2 >
~Archive1.A1Field1

7.2.4

Export and import

7.2.4.1

How to export the configuration data of the user archive

Introduction
You can export user archives and views of the open WinCC project in order to, for example,
use the data in other projects or make a backup.

Procedure

1. Select the folder you wish to export in the navigation area:
– the "Archives" folder to export all archives
– the folder of an archive to export the archive
– the "Views" folder to export all views
– the folder of a view to export the view
Select one or several rows in the table area to export the selected entries.
2. Select "Export" in the shortcut menu.
To backup all archives, select the command "Edit" > "Export" in the main menu of WinCC
Configuration Studio.
3. Select a descriptive name for the export file and a storage location in the "Export" dialog.
4. Select the format:
– Unicode text (*.txt)
– Excel workbook (*.xlsx)
The selected data are backed up in an export file.
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7.2.4.2

How to import the configuration data of the user archive

Introduction
The data for user archives and views that were exported from a WinCC project can be reimported to a WinCC project.
Note
Existing data are supplemented during an import; that is, archives, views or fields that are
configured in the editor remain if they do not exist in the export file.
Items of data with identical names are overwritten, i.e. archives, views or fields that are
configured are overwritten by the export file data item if it has the same name.

Procedure

1. To import data, select the command "Edit" > "Import" in the main menu of WinCC
Configuration Studio.
2. Select the export file in the "Import" dialog.
Once the import is complete, a dialog is displayed for confirmation including a link to the
log file. Any errors are listed in the log file.
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7.2.5

Runtime data

7.2.5.1

How to edit the Runtime data in the user archive

Introduction
The Runtime data of a user archive are displayed in the table area of the "User Archive" editor.
You can modify or supplement values here as required.

Requirement
● You have created at least one user archive.
● You have configured fields for the user archive.

Procedure
1. Select the folder of the user archive in the navigation area.
2. Select the "Archive data" tab in the table area.
The Runtime data of the user archive are displayed. Each table column corresponds to one
field.
3. Edit the displayed values.
4. To create a new data record, click in the top free cell of a column. Input fields are marked
with a yellow symbol.
Creation of a new data record is complete once a value has been entered for a field.

7.2.5.2

How to export runtime data of the user archive

Introduction
You can export the Runtime data of a selected user archive in order to, for example, edit the
data in a spreadsheet program or make a backup.

Requirement
● You have created at least one user archive.
● You have configured fields for the user archive.
Note
Date fields when exporting Runtime data
During further processing of the exported Runtime data, the date fields must always be
changed into the language and format in which the date fields will be exported. Otherwise,
an import of the data into the user archive can no longer be performed.
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Procedure

1. Select the "Archive data" tab in the table area of the "User Archive" editor.
2. Select the folder of an archive in the navigation area.
3. Select the "Archive data" > "Save to file" command in the folder shortcut menu.
The current archive data are stored in a file with the format *csv.
Note
If, in the case of a client-server project, the user archive is located on the server, for example
under "C:\Projects\Test\UA", the archive will be shared under this default path. The client
maps the share via a network drive e.g. "I:\Test\UA". Thereafter, the standard path of the
User Archive is "I:\Test\UA" on the client. However, there is no directory on the server with
this designation. If you want to export user archive data to the server, you have to change
the default path on the client, for example to "C:\Projects\Test\UA".
Note
Exporting configuration data from user archives and views
To export configuration data of user archives and views, select the corresponding folder in
the navigation area and select the "Export" command from the shortcut menu.

7.2.5.3

How to import runtime data of the user archive

Introduction
You can import Runtime data originating from a WinCC database back to a user archive.
Data record IDs are entered for the export data during export, in order to provide clear mapping
of the imported data for the import. If WinCC detects during the import that one of the IDs to
be imported already exists in the user archive, an error message is generated and an entry is
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made in the "UALogFile.txt" log file. The data with a new data record ID are added as new
data records into the user archive.

Requirement
● The file which you wish to import does not contain information about the data type and
number of the fields. Therefore, the structure of import data and the target archive must
match.
● Alternatively, you can import data into the user archive from which you have previously
exported data.
Note
You have edited the exported Runtime data of a user archive outside WinCC and you now
want to overwrite the data of this user archive. If you want to import the changed data, you
must first delete all data records of the user archive. Otherwise, you will get error messages
during the import because of identical data record IDs.
Note
If, in the case of a client-server project, the user archive is located on the server, for example
under "C:\Projects\Test\UA", the archive will be shared under this default path. The client
maps the share via a network drive e.g. "I:\Test\UA". Thereafter, the standard path of the
User Archive is "I:\Test\UA" on the client. However, there is no directory on the server with
this designation. If you want to import user archive data to the client, you have to change the
default path on the client, for example to "C:\Projects\Test\UA".

Procedure
1. Select the "Archive data" tab in the table area of the "User Archive" editor.
2. Select the folder of an archive in the navigation area.
3. Select the "Archive data" > "Load from file" command in the folder shortcut menu.
4. Select the csv file containing the data in the "Import" dialog.
The data are loaded to the user archive.
Note
Importing the configuration data from user archives and views
To import configuration data and views, select the command "Edit" > "Import" in the main
menu of WinCC Configuration Studio.
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7.3

Data communication with automation systems

7.3.1

SIMATIC interfaces

Introduction
Runtime data can be exchanged between the user archive and S5/S7 automation systems via
WinCC tags and also via raw data tags with S7-400. All SIMATIC interfaces are available, with
the exception of the AS511 programming interface.

Data communication via WinCC tags
Data communication via WinCC tags with S5 or S7 automation systems is simple. You should
be aware that only certain data types of the WinCC Tag Management can be used for user
archives.
For the data types "Integer", "Double", "String" and "Date/Time" in the user archive, the
following data types of the tag management must be used.
Selection in the User Archive editor

WinCC tag in the Tag Management

Number (integer)

Signed 32-bit value

Number (float)

Floating-point number 32-bit IEEE 754

Number (double)

Floating-point number 64-bit IEEE 754

Character string (string)

Text tag, 8-bit character set

Date/time

Date/time

The following pages provide a detailed description of data communication via raw data tags.

7.3.2

Data communication with S7 via raw data tags

7.3.2.1

How to configure data communication via raw data tags

Introduction
The "BSEND/BRCV" function of S7 communication is used for data communication between
the user archive and the automation system via WinCC raw data tags. The raw data tags are
sent from the automation system as an active partner.

Principle
The message frames of the raw data tags include one or more read or write jobs for the user
archive. In response to these requests, WinCC sends back the requested data and a
processing acknowledgment. This is why a "BRCV" must always be configured in the STEP
7 program.
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Since the automation system is the active partner, a user-initiated job must be triggered directly
in the automation system, for example, by an external WinCC tag. The "Request type"
parameter used in the job header and acknowledgment header of the message frame cannot
be used for triggering functions of the automation system, since the request type is only used
for user archive functions.

Requirement
● You have background information on raw data tags.
● You have configured the STEP 7 program for the automation system.
● The "SIMATIC S7 Protocol Suite" channel is integrated in the WinCC project.
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Procedure
1. Create a new connection for a channel unit in the "SIMATIC S7 Protocol Suite", for example,
"Industrial Ethernet" in the "Tag Management" editor. You can also use an existing
connection.
2. Select the command "Connection Parameters" in the connection shortcut menu.

This opens the "Connection properties" dialog.

3. Enter the parameters and select the "Send/receive raw data block" check box. Use the
hexadecimal value from the STEP 7 configuration as the "Connection resource".
4. Create a new tag with the data type "Raw data type" for the connection.
– To do so, assign a name to the tag in the table area of the "Tag Management" editor.
– In the tag properties, select the data type "Raw data type" under "General".
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5. Click in the field for the "Address" property under "General".
6. In the field, click on the button

to open the "Tag properties" dialog.

7. Select the "BSEND/BRCV" option as "Raw data type".
8. Select the option "Raw data". Use the "R_ID" from the STEP 7 configuration. The same
"R_ID" must always be configured in the STEP 7 program with regard to "BSEND" and
"BRCV" for the user archive.
9. Save the configuration.
Note
Always use the "BSEND/ BRCV" option as the raw data type, not the "Send/receive block"
option.

7.3.2.2

Data format differences between WinCC and S5/S7

Introduction
The data formats in WinCC differ fundamentally from data formats in the S7 automation
systems. You need to take this into consideration to avoid errors.
WinCC keeps to the data formats of Intel and Microsoft, in which the least significant bytes are
stored first and most significant bytes last. This data format is very common and is known as
the "Intel format".
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Intel format
With the Intel format, the decimal number 300 is stored as follows:
Bit

15

14

13

12

11

10

9

8

7

6

5

4

3

2

1

0

Binary

0

0

0

0

0

0

0

1

0

0

1

0

1

1

0

0

Hex

0

1

2

C

According to the Intel format, the decimal number "300" corresponds to the hexadecimal
number "12C" ( 1*256 + 2*16 + 12 ).

SIMATIC format
In the SIMATIC format the least significant bytes are stored on most significant places. In the
SIMATIC format, the decimal number "300" is stored as follows:
Bit

15

14

13

12

11

10

9

8

7

6

5

4

3

2

1

0

Binary

0

0

1

0

1

1

0

0

0

0

0

0

0

0

0

1

Hex

2

C

0

1

According to the SIMATIC format, the decimal number "300" corresponds to the hexadecimal
number "2C01". If "2C01" is erroneously interpreted according to the Intel format, you would
get "11265" as a decimal number.
For the automation systems, there are function block available which can carry out
corresponding data conversions. You must always call the function blocks before and after
data transfer between S7 and WinCC. You can download the function blocks at "http://
support.automation.siemens.com/".
Enter "Function blocks ANSI_S5" as the search term. The compressed file "ANSI_S5.EXE" is
offered for download. The file contains the function block "IEEE:GP".
Active sending is described in the reference manuals of the PLCs or the "Communication
Processors".

7.3.2.3

Sending jobs and data from S7 to WinCC

Structure of the raw data tag
Below you can see the structure of the raw data tags, which are used to send jobs and data
from the S7 automation system to the WinCC user archive. The data is configured in the PLC
by STEP 7.
Message frame from S7 to WinCC user archive
Message frame header
Job header 1
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Data of the job 1
Possible job header 2
Possible data of the job 2
Job n

7.3.2.4

Receiving data and processing acknowledgment in S7

Structure of the raw data tag
Below you can see the structure of the raw data tags, which are used to receive processing
acknowledgments and data from the WinCC user archive to the S7 automation system. The
data is configured in the PLC by STEP 7.
Raw data tag for receiving in S7
Processing acknowledgement
Acknowledgement header
Acknowledgement data

7.3.2.5

Structure of the message frame header

Structure of the message frame header
The message frame header consists of the following individual parts (distribution in bytes):
Function of the field

Comment

Message frame length in bytes LSB *)

Length of the field 4 bytes

.

Max. length 4091 bytes

.

(due to S7 transport)

Message frame length in bytes MSB **)

.

Transfer type

1 from WinCC, 2 from the PLC

Reserved
Number of jobs in the message frame LSB

Length of the field 2 bytes

Number of jobs in the message frame MSB

.

PLCID 1.character

Name in ASCII

.

Length of the field 8 bytes

.

.

.

.

.

.

.

.

.

.

PLCID 8th character

.

*) LSB = Least Significant Byte (lowest value byte)
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**) MSB = Most Significant Byte (highest value byte)

7.3.2.6

Job Header

Structure of the job header
The job header consists of the following individual parts (distribution in bytes):
Function of the field

Comment

Job length in bytes LSB *)

Length of the field 2 bytes

Job length in bytes MSB**)

.

Job type

See description of the job types

Reserved
Field number LSB

Length of the field 2 bytes

Field number MSB

.

Data record number LSB

Length of the field 4 bytes

.

.

.

.

Data record number MSB

.

Selection Criterion LSB

Selected according to field number, if you want to use a
selection.

Selection criterion MSB

Selected according to field number, if you want to use a
selection.

Data of the selection criterion LSB

Selected according to field content, if you want to use a
selection.

Data of the selection criterion MSB

Selected according to field content, if you want to use a
selection.

*) LSB = Least Significant Byte (lowest value byte)
**) MSB = Most Significant Byte (highest value byte)

7.3.2.7

Data of the job

Data of the job
Depending on the job type, the data of the job corresponds to the contents of a data record or
of an addressed field.
Note the following:
● Text fields are not \0-terminated.
● The numbers must be transferred in Intel format, LSB first, MSB last.
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● A field with data type "Integer" has a length of 4 bytes, "Float" has 4 bytes and "Double"
has 8 bytes.
● If you want to use a selection criterion in the job header, shift the data of the job back by 2
bytes for the field number plus the number of bytes for the field contents.
For example, the data records are selected according to the field number with "Integer"
data type. The data of the job is then shifted back by 2 bytes for the field number plus 4
bytes for the integer.
If you not want to use selection criteria, omit "Selection criteria" and "Data of the selection
criterion" in the job header. The data of the job then starts directly after the data record
number of the job header.

7.3.2.8

The acknowledgement header

Structure of the acknowledgment header
The acknowledgment header consists of the following individual parts (distribution in bytes):
Function of the field

Comment

Message frame length in bytes LSB*)

Length of the field 4 bytes

.

.

.

.

Message frame length in bytes MSB**)

.

Transfer type

1 from WinCC, 2 from the PLC

Reserved
Error code

See description of the error codes

Job type

See description of the job types

Reserved
Reserved
Field number LSB

Length of the field 2 bytes

Field number MSB

.

Data record number LSB

Length of the field 4 bytes

.

.

.

.

Data record number MSB

.

PLCID 1.character

Name in ASCII

.

Length of the field 8 bytes

.

.

.

.

.

.

.

.

.

.

PLCID 8th character

.

*) LSB = Least Significant Byte (lowest value byte)
**) MSB = Most Significant Byte (highest value byte)
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Data of the Acknowledgement
The acknowledgement contains either the data record or the addressed field (during a read
request) or it is empty (write job, archive job).

7.3.2.9

Description of the job types

Description of the job types
Below, the jobs with which you can access the user archive are listed:

7.3.2.10

Type

Description

4

Check if user archive exists

5

Delete all of the records in the User Archive

6

Read data set

7

Write data record

8

Delete record

9

Read data record field

10

Write data record field

Description of the error codes

Description of the error codes
Below, the error codes that can occur when jobs are executed are listed:
Group

No.

Description

Possible fault causes

General

0

The function has been executed

--

archive

2

Data not available

No archive is configured with this PLCID

Data record

101

Data not allowed

- Data record layout does not match,
e.g. number or data type of fields
- Adding or updating data records failed,
for example because the archive has
the type "limited", or a minimum or
maximum value is configured for a field
- The filter criterion is incorrect

Data record

102

Data not available

(only for job type 6)
- No data available
- The filter criterion is incorrect

Field

201

Data not allowed

(only for job type 10)
The filter criterion is incorrect, for
example because the field does not
exist or a minimum or maximum value
is configured for a field
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Field

202

Data not available

(only for job type 9)
The filter criterion is incorrect or no field
was found which meets the filter
criterion

General

254

Function not available

--

General

255

Undefined error

--
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7.4

User archive functions

7.4.1

General information

Introduction
You use the functions for user archives to configure user archives and to operate archives in
runtime. WinCC provides a number of standard functions that enable the user to implement
user archives in a flexible manner.

Overview
The standard functions require handles that are returned by the functions
"uaQueryConfiguration", "uaConnect" "uaQueryArchive" and "uaOpen".
All functions for user archives begin with "ua", for example, "uaConnect". The runtime functions
always begin with "uaArchive", for example, "uaArchiveOpen".
A distinction is made between two prefixes for the API calls:
● "ua" for scripts, such as Global Script and programming of actions.
● "UA" for programs that run outside of WinCC. If you use calls for user archives in a Dynamic
Wizard, you have to use the "UA" prefix.
Note
When a data record is created, no check is made for completeness or correctness of the data
record. In particular, a field must not be left blank.
Within a script, it must be ensured that the data is up-to-date.
In the following scenario, the script is not informed of changes, for example. A script has
opened a user archive. A data record has been inserted into or deleted from the user archive
via UserArchiveControl or via a "User Archive" editor. The changes in the script become
known only after a "requery".

7.4.2

How to use the functions of the user archive

Introduction
To efficiently use the functions of the user archive in runtime for configuration of user archives,
you must consider the relationship of the functions.
You must always comply to the following levels of connection to user archives when using
runtime functions:
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● uaConnect <--> uaDisconnect
● uaQueryArchiveByName or uaQueryArchive <--> uaReleaseArchive
● uaArchiveOpen <--> uaArchiveClose
After the three-step opening of the connections, you have access to the user archive with the
runtime functions. Then, you must close the open connections again in three steps.

Functions for configuring user archives
The "uaQueryConfiguration" function introduces the section of the configuration and returns
the handle "UAHCONFIG" for the configuration functions. The handle is used, for example, to
call the "uaAddArchive" or "uaAddField" functions in order to create a new user archive or a
new data field. The configuration section must be closed with the "uaReleaseConfiguration"
function.

Establishing a connection to the user archive for runtime functions
To access in runtime, you need to call the "uaConnect" function in order to establish a
connection to "User Archive". "uaConnect" creates the "UAHCONNECT" handle, which is
needed to open the user archive. You have to close the connection to "User Archive" again
with the "uaDisconnect" function.

Opening a user archive for the runtime functions
A configured user archive is required to use runtime functions. The "uaQueryArchive" or
"uaQueryArchiveByName" functions establish a connection to the current user archive and
provide a handle for the runtime functions. You can use the runtime functions after opening
the user archive with the "uaArchiveOpen" function.
After access with the runtime functions, you first need to close the user archive using the
"uaArchiveClose" function. Then close the connection to the current user archive with the
"uaReleaseArchive" function.

Using runtime functions
You use the runtime functions to operate the user archives in runtime, as the following example
with "uaArchiveSetFieldValueLong" shows. A unique assignment to a data record of the user
archive is generated via the "hArchive" handle. The assignment also allows indirect
addressing, for example, for the user interface.
The "uaArchiveNext", "uaArchivePrevious", "uaArchiveFirst" and "uaArchiveLast" functions
move the pointer. The "uaArchiveUpdate" function stores the temporary data record in the user
archive and overwrites the data record to which the pointer is currently pointing. The data
record must previously be read by the "uaArchiveNext", "uaArchivePrevious", "uaArchiveFirst"
or "uaArchiveLast" functions.

Example of a runtime function

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
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{
UAHCONNECT hConnect = 0;
UAHARCHIVE hArchive = 0;
if ( uaConnect( &hConnect ) )
{
if ( uaQueryArchiveByName( hConnect, "VarTest", &hArchive ) )
{
if ( uaArchiveOpen( hArchive ) )
{
//----------------------------------------------------------------uaArchiveSetFieldValueLong( hArchive, 1,
GetTagSDWord("UA_VarTest_Int1"));
uaArchiveSetFieldValueLong( hArchive, 2,
GetTagSDWord("UA_VarTest_Int2"));
if (! uaArchiveInsert( hArchive ) )
{
printf("Error (%d) with uaArchiveInsert\r
\n",uaGetLastError() );
}
//----------------------------------------------------------------uaArchiveClose( hArchive );
}
else
{
printf( "Open failed.<%d>\r\n",uaGetLastError() );
}
uaReleaseArchive( hArchive );
}
else
{
printf( "Query failed.<%d>\r\n",uaGetLastError() );
}
uaDisconnect( hConnect );
}
else
{
printf( "Connect failed.<%d>\r\n",uaGetLastError() );
}
}
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7.4.3

Example of a user archive script

Introduction
The following is an example of a script that uses some of the standard functions of user
archives. The example includes functions for reading and writing a user archive in runtime
which can be accessed by clicking the buttons:
● The "UAReadFromArchive" function reads the first record of the user archive.
● The "UAWriteToArchive" function writes a data record to the user archive.
The data is displayed in the WinCC UserArchiveControl and the script output is shown in the
diagnostic window.
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Requirement
● You are familiar with the fundamentals of the "User Archive", "Graphics Designer" and
"Global Script" editors.
● You have created a user archive, for example, "color", from the example on the page
"Example for the use of control tags".
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● You have opened the Graphics Designer and configured a screen with a WinCC
UserArchiveControl, for example, from the example on the page "Example for the use of
control tags."
● You have enabled the "Global Script Runtime" option in the startup list in the WinCC
properties of the computer.

Procedure
1. Open the C editor of "Global Script" in the WinCC Explorer.
2. Click on the "New Project Function" command in the "File" menu of the editor.
3. Copy one of the example scripts below into the editor window. Click on
function.
4. Click

to compile the

to save the compiled, error-free function with the name "UAReadFromArchive".

5. Proceed with the second script using the same procedure.
6. Insert the "Application window" smart object from the object palette into the screen in the
Graphics Designer. The application window serves as a diagnostic window for the scripts.
7. In the "Window Contents" dialog , select the entry "Global Script" and select "GSC
Diagnostics" as a template. Set all the properties to "yes" in the "Miscellaneous" tab in the
properties of the application window.
8. Create the "Read" and "Write" buttons with the "Button" object from the object palette under
"Windows Objects".
9. Right-click on the "Read" button and select the "Properties" menu item.
10.Open the "Event" tab. Click "Mouse".
11.At "Mouse click", right-click in the "Action" column and select "C-action". The "Edit action"
window opens.
12.In the editor window, click in the "OnClick" action between "{" and "}".
13.Double-click on "UAReadFromArchive" in the "Project functions" directory in the navigation
window.
and then "OK" at the bottom right. The example script is now integrated in the
14.Click
action for the mouse click on the button.
15.Proceed with the "Write" button using the same procedure.
16.Save the screen in Graphics Designer.
17.Activate the example project for runtime.

Example script "UAReadFromArchive"

#include "apdefap.h"
void UAReadFromArchive()
{
UAHCONNECT hConnect = 0;
UAHARCHIVE hArchive = 0;
LONG IndexArchive;
LONG FieldLength;
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LONG FieldType;
LONG NumberOfFields;
LONG Index;
long IntValue;
float FloatValue;
double DoubleValue;
char ArchivName[255], StringField[255];
SYSTEMTIME SysDate;
//******* Connect to Component User Archives
****************************
if (uaConnect( &hConnect ) == FALSE )
{
printf("uaConnect error: %d\n", uaGetLastError() );
return;
}
if (hConnect == NULL)
{
printf("Handle UAHCONNECT equals NULL\n" );
return;
}
//******* Connect to Archive via Archive Name
****************************
if (uaQueryArchiveByName( hConnect, "color", &hArchive ) == FALSE )
{
printf("uaQueryArchive Error: %d\n", uaGetLastError() );
goto finish;
}
//******* Opens Archive
******************************************************
if ( uaArchiveOpen( hArchive ) == FALSE )
{
printf("uaArchive Open Error\n" );
goto finish;
}
//******* Move to first record set
****************************************************
if (uaArchiveMoveFirst(hArchive) == FALSE )
{
printf("uaArchiveMoveFirst Error = %d\n" , uaGetLastError() );
goto finish;
}
//******* Get Number of Fields
**********************************************
NumberOfFields = uaArchiveGetFields( hArchive );
printf("Number of Fields = %u\n", NumberOfFields );
//******* Read and show Data Fields
****************************************
for ( Index = 1; Index < NumberOfFields; Index++ )
{
printf("Data of Field %u: \n", Index );
FieldType = uaArchiveGetFieldType( hArchive, Index );
switch ( FieldType )
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{
case UA_FIELDTYPE_INTEGER :
printf("Field Type = Integer\n");
if ( uaArchiveGetFieldValueLong ( hArchive, Index, &IntValue ) ==
TRUE )
printf( "Field Value = %u\n", IntValue );
else
printf("Error callinguaArchiveGetFieldValueLong: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_FLOAT :
printf("Field Type = Float\n");
if (uaArchiveGetFieldValueFloat ( hArchive, Index, &FloatValue ) ==
TRUE )
printf("Field Value = %f\n", FloatValue );
else
printf("Error callinguaArchiveGetFieldValueFloat: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_DOUBLE :
printf("Field Type = Double\n");
if (uaArchiveGetFieldValueDouble (hArchive, Index, &DoubleValue ) ==
TRUE )
printf("Field Value = %g\n", DoubleValue );
else
printf("Error calling uaArchiveGetFieldValueDouble: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_STRING :
printf("Field Type = String\n");
if (uaArchiveGetFieldValueString ( hArchive, Index, StringField,
20 ) == TRUE )
printf("Field Value = %s\n", StringField );
else
printf("Error callinguaArchiveGetFieldValueString: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_DATETIME :
printf("Field Type = Date & Time\n");
if (uaArchiveGetFieldValueDate ( hArchive, Index, &SysDate ) ==
TRUE )
printf("%d.%d.%d\n ",SysDate.wDay, SysDate.wMonth, SysDate.wYear );
else
printf("Error calling uaArchiveGetFieldValueLong: %d\n",
uaGetLastError() );
break;
case -1 :
default:
printf("Error executing uaArchiveGetFieldType\n");
}
//******* Read and show Field Length
**************************************
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FieldLength = uaArchiveGetFieldLength( hArchive, Index );
if ( FieldLength != -1 )
printf("Field Length = %u\n", FieldLength );
else
printf("Error executing uaArchiveGetFieldLength\n");
}
//******* Close all handles and connections
***************************
finish:;
//******* Close Archive
*******************************************************
if( NULL != hArchive )
{
if (uaArchiveClose ( hArchive ) == FALSE )
{
printf("error on closing archive\n" );
}
}
//****** Release Connection to Archive
*************************************
if( NULL != hArchive )
{
if (uaReleaseArchive ( hArchive ) == FALSE )
{
printf("error on releasing archive\n" );
}
hArchive = 0;
}
//******* Disconnect to Component User Archives
*************************
if( NULL != hConnect )
{
if (uaDisconnect ( hConnect ) == FALSE )
{
printf("error on disconnection\n" );
}
hConnect = 0;
}
}

Example script "UAWriteToArchive"

#include "apdefap.h"
void UAWriteToArchive()
{
UAHCONNECT hConnect = 0;
UAHARCHIVE hArchive = 0;
LONG IndexArchive;
LONG FieldLength;
LONG FieldType;
LONG NumberOfFields;
LONG Index;
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long IntValue;
char StringField[255];
SYSTEMTIME SysDate;
//******* Connect to Component User Archives
****************************
if (uaConnect( &hConnect ) == FALSE )
{
printf("uaConnect error: %d\n", uaGetLastError() );
return;
}
if (hConnect == NULL)
{
printf("Handle UAHCONNECT equals NULL\n" );
return;
}
//******* Connect to Archive via Name ****************************
if (uaQueryArchiveByName( hConnect, "color", &hArchive ) == FALSE )
{
printf("uaQueryArchive Error: %d\n", uaGetLastError() );
goto finish;
}
//******* Opens Archive
******************************************************
if ( uaArchiveOpen( hArchive ) == FALSE )
{
printf("uaArchive Open Error\n" );
goto finish;
}
//******* Get Number of Fields
**********************************************
NumberOfFields = uaArchiveGetFields( hArchive );
printf("Number of Fields = %u\n", NumberOfFields );
//******* Read Last Data Set
************************************************
if (uaArchiveMoveLast( hArchive ) == TRUE )
printf("Number of Fields = %u\n", NumberOfFields );
else
{
printf("uaArchiveMoveLast Error: %d\n", uaGetLastError() );
goto finish;
}
//******* Write into Data Fields
*********************************************
IntValue = 105;//RGB for darkgray
strcpy(StringField, "darkgray" );
GetSystemTime( &SysDate );
for ( Index = 1; Index < NumberOfFields; Index++ )
{
printf("Data of Field %u: \n", Index );
FieldType = uaArchiveGetFieldType( hArchive, Index );
switch ( FieldType )
{
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case UA_FIELDTYPE_INTEGER :
printf("Field Type = Integer\n");
if (uaArchiveSetFieldValueLong ( hArchive, Index, IntValue ) ==
TRUE )
printf( "Field Value = %u\n", IntValue );
else
printf("Error callinguaArchiveSetFieldValueLong: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_FLOAT :
printf("Field Type = Float\n");
if (uaArchiveSetFieldValueFloat ( hArchive, Index, FloatValue ) ==
TRUE )
printf("Field Value = %f\n", FloatValue );
else
printf("Error callinguaArchiveSetFieldValueFloat: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_DOUBLE :
printf("Field Type = Double\n");
if (uaArchiveSetFieldValueDouble (hArchive, Index, DoubleValue ) ==
TRUE )
printf("Field Value = %g\n", DoubleValue );
else
printf("Error calling uaArchiveSetFieldValueDouble: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_STRING :
printf("Field Type = String\n");
if (uaArchiveSetFieldValueString ( hArchive, Index, StringField ) ==
TRUE )
printf("Field Value = %s\n", StringField );
else
printf("Error callinguaArchiveSetFieldValueString: %d\n",
uaGetLastError() );
break;
case UA_FIELDTYPE_DATETIME :
printf("Field Type = Date & Time\n");
if (uaArchiveSetFieldValueDate ( hArchive, Index, &SysDate ) ==
TRUE )
printf("%d.%d.%d\n ",SysDate.wDay, SysDate.wMonth, SysDate.wYear );
else
printf("Error calling uaArchiveSetFieldValueLong: %d\n",
uaGetLastError() );
break;
case -1 :
default:
printf("Error executing uaArchiveSetFieldType\n");
}
FieldLength = uaArchiveGetFieldLength( hArchive, Index );
if ( FieldLength != -1 )
printf("Field Length = %u\n", FieldLength );
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else
printf("Error executing uaArchiveGetFieldLength\n");
}
// ******* Update Archive *******************************************
if (uaArchiveUpdate(hArchive) == FALSE )
{
printf("uaArchiveUpdate Error:\n" );
}
//******* Close all handles and connections
***************************
finish:;
//******* Close Archive
*******************************************************
if( NULL != hArchive )
{
if (uaArchiveClose ( hArchive ) == FALSE )
{
printf("error on closing archive\n" );
}
}
//****** Release Connection to Archive
*************************************
if( NULL != hArchive )
{
if (uaReleaseArchive ( hArchive ) == FALSE )
{
printf("error on releasing archive\n" );
}
hArchive = 0;
}
//******* Disconnect to Component User Archives
*************************
if( NULL != hConnect )
{
if (uaDisconnect ( hConnect ) == FALSE )
{
printf("error on disconnection\n" );
}
hConnect = 0;
}
}
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7.4.4

Functions for Configuring User Archives

7.4.4.1

Functions for Configuring User Archives

Overview
To configure user archives, you must first call the "uaQueryConfiguration" function that creates
the "UAHCONFIG" handle. The handle enables you to use the following functions. You need
to call "uaReleaseConfiguration" after completing configuration.

7.4.4.2

Function

Description

uaAddArchive

Add a new user archive

uaAddField

Add a new field

uaGetArchive

Read archive configuration

uaGetField

Read field configuration

uaGetNumArchives

Read number of archives created

uaGetNumFields

Read number of fields

UaQueryConfiguration

Establish a connection to the user archive configuration

uaReleaseConfiguration

Close connection after configuration

uaRemoveAllArchives

Delete all archives

uaRemoveAllFields

Delete all fields

uaRemoveArchive

Delete particular archive

uaRemoveField

Delete particular field

uaSetArchive

Write archive configuration

uaSetField

Write field configuration

uaAddArchive

Description
Creates a new user archive. This corresponds to the configuration of a new user archive using
the "User Archive" editor.
LONG uaAddArchive (
UAHCONFIG hConfig,
UACONFIGARCHIVE* pArchive )

Parameter
UAHCONFIG hConfig,
Handle for configuration of a user archive. The handle is set up with "uaQueryConfiguration".
UACONFIGARCHIVE* pArchive
Pointer to the buffer for storing the user archive configuration.
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Return value
Index of the new user archive. "-1" in the case of an error.

See also
Structure of the user archive configuration "uaCONFIGARCHIVE" (Page 1685)

7.4.4.3

uaAddField

Description
Adds a new data field.
LONG uaAddField (
UAHCONFIG hConfig,
long lArchive,
UACONFIGFIELD* pField )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))
UACONFIGFIELD* pArchive
Pointer to the buffer of the field configuration.

Return value
Index of the new data field. "-1" in the case of an error.

See also
Structure of the field configuration "uaCONFIGFIELD" (Page 1685)

7.4.4.4

uaGetArchive

Description
Reads the user archive configuration.
BOOL uaGetArchive (
UAHCONFIG hConfig,
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long lArchive,
UACONFIGARCHIVE* pArchive )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))
UACONFIGARCHIVE* pArchive
Pointer to the buffer for receiving the user archive configuration.

Return value
TRUE: Access to the user archive was successful
FALSE: Error

See also
Structure of the user archive configuration "uaCONFIGARCHIVE" (Page 1685)

7.4.4.5

uaGetField

Description
Reads the field configuration.
BOOL uaGetField (
UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))
long lField,
The field number, where "lField = 0" addresses the first field.
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UACONFIGFIELD* pArchive
Pointer to the buffer for receiving the field configuration.

Return value
TRUE: Access to the user archive was successful
FALSE: Error

See also
Structure of the field configuration "uaCONFIGFIELD" (Page 1685)

7.4.4.6

uaGetNumArchives

Description
Reads the number of user archives currently configured.
LONG uaGetNumArchives (
UAHCONFIG hConfig )

Parameter
UAHCONFIG hConfig
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".

Return value
Number of user archives currently configured. "-1" in the case of an error.

7.4.4.7

uaGetNumFields

Description
Supplies the number of the configured fields. The "ID", "Last User" and "Last Access" fields
are not included. The indexes are specified with "0 to uaGetNumFields() -1" in the configuration
calls.
LONG uaGetNumFields (
UAHCONFIG hConfig,
long lArchive )
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Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))

Return value
Number of the configured fields. "-1" in the case of an error.

7.4.4.8

UaQueryConfiguration

Description
Establishes the connection to the user archive for the configuration.
BOOL uaQueryConfiguration (
UAHCONFIG* phConfig )

Parameter
UAHCONFIG* phConfig,
Pointer to the handle of the archive.

Return value
TRUE: Access to the user archive was successful
FALSE: Error

7.4.4.9

uaReleaseConfiguration

Description
Closes the connection after configuration of the user archive.
BOOL uaReleaseConfiguration (
UAHCONFIG hConfig,
BOOL bSave )

Parameter
UAHCONFIG hConfig
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
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BOOL bSave
Saves the configuration changes before closing the connection to the user archive.
TRUE: Save changes
FALSE: Discard changes
Note
You can only use the "BSAVE = TRUE" command when WinCC Runtime is not active!
Check if runtime is active using the "uaIsActive" function.

Return value
TRUE: Connection successfully closed
FALSE: Error

See also
uaIsActive (Page 1689)

7.4.4.10

uaRemoveAllArchives

Description
Deletes all user archives that are not used in views.
BOOL uaRemoveAllArchives
( UAHCONFIG hConfig )

Parameter
UAHCONFIG hConfig
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".

Return value
TRUE: Successful deletion
FALSE: Error
Note
After calling the function, you can use "uaGetNumArchives()" to query whether all archives
were deleted.
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7.4.4.11

uaRemoveAllFields

Description
Deletes all data fields of a user archive.
BOOL uaRemoveAllFields (
UAHCONFIG hConfig,
long lArchive )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archiv Index (0 to (uaGetNumArchives()-1))

Return value
TRUE: Data fields successfully deleted
FALSE: Error

7.4.4.12

uaRemoveArchive

Description
Deletes the specified user archive.
BOOL uaRemoveArchive (
UAHCONFIG hConfig,
long lArchive )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))

Return value
TRUE: User archive has been deleted successfully
FALSE: Error
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7.4.4.13

uaRemoveField

Description
Removes a specific data field of a user archive.
BOOL uaRemoveField (
UAHCONFIG hConfig,
long lArchive,
long lField )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))
long lField,
The field number, where "lField = 0" addresses the first data field.

Return value
TRUE: Field has been deleted successfully
FALSE: Error

7.4.4.14

uaSetArchive

Description
Sets the configuration of a user archive.
BOOL uaSetArchive (
UAHCONFIG hConfig,
long lArchive,
UACONFIGARCHIVE* pArchive
)

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
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Archive Index (0 to (uaGetNumArchives()-1))
UACONFIGARCHIVE* pArchive
Pointer to the buffer of the user archive configuration.

Return value
TRUE: Access to the user archive was successful
FALSE: Error

See also
Structure of the user archive configuration "uaCONFIGARCHIVE" (Page 1685)

7.4.4.15

uaSetField

Description
Sets the data field configuration.
BOOL uaSetField (
UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameter
UAHCONFIG hConfig,
Configuration handle of the user archive. The handle is set up with "uaQueryConfiguration".
long lArchive,
Archive Index (0 to (uaGetNumArchives()-1))
long lField,
The field number, where "lField = 0" addresses the first field.
UACONFIGFIELD* pField
Pointer to the buffer of the field configuration.

Return value
TRUE: Access to the user archive was successful.
FALSE: Error
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See also
Structure of the field configuration "uaCONFIGFIELD" (Page 1685)

7.4.4.16

Structure of the field configuration "uaCONFIGFIELD"

Structure "uaCONFIGFIELDA"
typedef struct tagUACONFIGFIELD
{
LONG lArchiveId; // Unique ID of the user archive
LONG lFieldId; // Unique ID of the data field
LONG lPosition; // Position of the user archive
CHAR szName[UA_MAXLEN_NAME+1]; // Archive name max. 20 characters
CHAR szAlias[UA_MAXLEN_ALIAS+1]; // Alias name max 50 characters
LONG lType; //Archive type
LONG lLength; /* Maximum number of characters if the data field is of STRING type; else
not used */
LONG lPrecision; // Is used internally; need not be populated
CHAR szMinValue[UA_MAXLEN_VALUE+1]; /* Minimum for data fields that are not
STRING or DATE type; else not used */
CHAR szMaxValue[UA_MAXLEN_VALUE+1]; /* Maximum for data fields that are not
STRING or DATE type; else not used */
CHAR szStartValue[UA_MAXLEN_VALUE+1]; // Start value
CHAR szDMVarName[UA_MAXLEN_DMVARNAME+1]; /* Tag from the Data Manager (is used
for archives with communication via WinCC tags) */
DWORD dwReadRight; // Read access rights
DWORD dwWriteRight; // Write access rights
DWORD dwFlags; // Last access
} UACONFIGFIELD;

See also
uaAddField (Page 1677)

7.4.4.17

Structure of the user archive configuration "uaCONFIGARCHIVE"

Structure type "uaCONFIGARCHIVE"
typedef struct tagUACONFIGARCHIVE
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{
LONG lArchiveId; // Unique ID of the user archive
LONG lPosition; // Position of the user archive
CHAR szName[UA_MAXLEN_NAME+1]; // Archive name max. 20 characters
CHAR szAlias[UA_MAXLEN_ALIAS+1]; // Alias name max 50 characters
LONG lType;UA_ARCHIVETYPE_UNLIMITED // Archive type "unlimited"
UA_ARCHIVETYPE_LIMITED // Archive type "limited"
LONG lNumRecs; // max. number of data sets
LONG lCommType;
UA_COMMTYPE_NONE // no communication
UA_COMMTYPE_RAW // Communication via raw data
UA_COMMTYPE_DIRECT //Communication via Data Manager tags
CHAR szPLCID[UA_MAXLEN_PLCID+1];// PLCID of raw data tags
CHAR szDMVarName[UA_MAXLEN_DMVARNAME+1]; // Name of the raw data tags
CHAR szIDVar[UA_MAXLEN_DMVARNAME+1]; // Control tag "ID"
CHAR szJobVar[UA_MAXLEN_DMVARNAME+1]; // Control tag "Job"
CHAR szFieldVar[UA_MAXLEN_DMVARNAME+1]; // Control tag "Field"
CHAR szValueVar[UA_MAXLEN_DMVARNAME+1]; // Control tag "Value"
DWORD dwReadRight; // Read access rights
DWORD dwWriteRight; // Write access rights
DWORD dwFlags; UA_ARCHIVEFLAG_ACCESS // "Last access" flag
UA_ARCHIVEFLAG_USER // "Last user" flag
} UACONFIGARCHIVE;
Note
LONG lArchiveId; //Unique ID of the user archive
With "0", a unique ID is automatically used and returned for "uaGetArchive". This returned
"ID" is then specified for "uaSetField". If ID "-1" is returned, the archive was not created.

See also
uaAddArchive (Page 1676)
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7.4.5

General runtime functions

7.4.5.1

General runtime functions

Overview
The general Runtime functions are used for opening and closing user archives in Runtime.
You must first call the "uaConnect" function for access in Runtime. "uaConnect" creates the
"UAHCONNECT" handle, which is needed to open the user archive. The handle enables you
to use the following functions. You have to close the connection to "User Archive" again with
the "uaDisconnect" function.
The "uaQueryArchive" or "uaQueryArchiveByName" functions create the "UAHARCHIVE"
handle. The handle is required for using the "uaArchiveOpen" function. The user archive is
opened in Runtime with "uaArchiveOpen".
After access with the Runtime functions, you first need to close the user archive using the
"uaArchiveClose" function. Then close the connection to the current user archive with the
"uaReleaseArchive" function.

7.4.5.2

Function

Description

uaConnect

Establish a connection to the user archive. This
connection is valid for all user archives in Runtime

uaDisconnect

Closes the connection to the user archive

uaGetLocalEvents

Reads local events

uaIsActive

Determines, if Runtime is active

uaOpenArchives

Determines the number of user archives open

uaOpenViews

Determines the number of open views

uaQueryArchive

Establishes a connection to a user archive

uaQueryArchiveByName

Establishes a connection to a user archive via the archive
name

uaReleaseArchive

Closes the connection to the user archive.

uaSetLocalEvents

Sets local events

uaUsers

Finds the number of active connections or active users

uaConnect

Description
Establishes a connection to user archives in runtime.
BOOL uaConnect (
UAHCONNECT* phConnect )
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Parameter
UAHCONNECT* phConnect
Pointer to handle for the connected user archives.

Return value
TRUE: Connection to user archive successful
FALSE: Error

7.4.5.3

uaDisconnect

Description
If a connection exists to user archives in runtime, it is closed.
BOOL uaDisconnect (
UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. The handle is set up with "uaConnect".

Return value
TRUE: Connection to user archive successfully closed
FALSE: Error

7.4.5.4

uaGetLocalEvents

Description
The local events are read.
BOOL uaGetLocalEvents
( UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. The handle is set up with "uaConnect".
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Return value
The local event "bLocalEvents"

7.4.5.5

uaIsActive

Description
Checks whether the user archive is active in runtime.
BOOL uaIsActive (
UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. This handle is set up with "uaConnect".

Return value
TRUE: The user archive is active in runtime
FALSE: The user archive is not active in runtime

7.4.5.6

uaOpenArchives

Description
Queries how many user archives are open in runtime.
LONG uaOpenArchives (
UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. This handle is set up with "uaConnect".

Return value
Number of user archives currently open
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7.4.5.7

uaOpenViews

Description
Queries how many views are open in runtime.
LONG uaOpenViews (
UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. This handle is set up with "uaConnect".

Return value
Number of views currently open

7.4.5.8

uaQueryArchive

Description
Establishes the connection to a user archive. "uaQueryArchive" creates the handle
"UAHARCHIVE".
BOOL uaQueryArchive (
UAHCONNECT hConnect,
LONG lArchive,
UAHARCHIVE* phArchive )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. The handle is set up with "uaConnect".
LONG lArchive
Archive ID (1... uaGetNumArchives). A continuous numbering of the archive IDs cannot be
ensured, because there may be gaps during ID assignment, e.g., by deleting archives.
UAHARCHIVE* phArchive
Pointer to handle for the connected user archive.

Return value
TRUE: Successful generation of the handle to the user Archive
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FALSE: Error
Note
If you use user archive functions in a client project which views redundant server pairs, the
user archive connection does not automatically switch to the new master when masters
change. In this case, all user archive calls return the error
"UA_ERROR_SERVER_UNKNOWN = 1004". You have to call the functions
"uaQueryArchive" or "uaQueryArchiveByName" and "uaArchiveOpen" again.

7.4.5.9

uaQueryArchiveByName

Description
Establishes the connection to a user archive via the archive name. "uaQueryArchiveByName"
creates the handle "UAHARCHIVE".
BOOL uaQueryArchiveByName (
UAHCONNECT hConnect,
LPCSTR pszName,
UAHARCHIVE* phArchive )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. The handle is set up with "uaConnect".
LPCSTR pszName
Name of the user archive. If the standard server is not used in a client project, you can add a
server prefix and "::" to the archive name.
UAHARCHIVE* phArchive
Pointer to handle for the connected user archive.

Return value
TRUE: Handle to the user archive has been generated successfully
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FALSE: Error
Note
If you use user archive functions in a client project which views redundant server pairs, the
user archive connection does not automatically switch to the new master when masters
change. In this case, all user archive calls return the error
"UA_ERROR_SERVER_UNKNOWN = 1004". You have to call the functions
"uaQueryArchive" or "uaQueryArchiveByName" and "uaArchiveOpen" again.

7.4.5.10

uaReleaseArchive

Description
Closes the connection to the currently connected user archive.
BOOL uaReleaseArchive (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: Connection to user archive successfully closed.
FALSE: Error
Note
You must set the handle "hArchive" to "ZERO" once the connection is successfully closed.
This ensures that the error "UA_ERROR_INVALID_HANDLE" will be generated if the handle
that is no longer valid continues to be used. This avoids unnecessary memory load.

7.4.5.11

uaSetLocalEvents

Description
Sets local events.
void uaSetLocalEvents (
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UAHCONNECT hConnect
BOOL bLocalEvents )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. This handle is set up with "uaConnect".
BOOL bLocalEvents
Local Event

7.4.5.12

uaUsers

Description
Returns the number of all users connected to the user archive using "uaConnect". Note that
this will also include internal WinCC calls to the user archive, in addition to calls initiated by
the user (for example, from scripts).
LONG uaUsers (
UAHCONNECT hConnect )

Parameter
UAHCONNECT hConnect
Handle for the connected user archives in runtime. This handle is set up with "uaConnect".

Return value
Number of active connections or users

7.4.6

Archive-specific runtime functions

7.4.6.1

Archive-specific runtime functions

Overview
After opening a user archive with the "uaArchiveOpen" function, you can use the following
functions for operating the user archive in runtime.
The "uaQueryArchive" or "uaQueryArchiveByName" general runtime functions create the
"UAHARCHIVE" handle. The handle is required for using the "uaArchiveOpen" function.
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After access with the runtime functions, you need to close the user archive using the
"uaArchiveClose" function. Then close the connection to the current user archive with the
"uaReleaseArchive" general runtime function.
Note
You can use the "uaArchiveSetSort" and "uaArchiveSetFilter" functions without opening the
user archive with "uaArchiveOpen".
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Description

uaArchiveClose

Closes the connection to the current user archive

uaArchiveDelete

Deletes a data record from the current user archive

uaArchiveExport

Exports the current user archive

uaArchiveGetCount

Reads the number of data records.

uaArchiveGetFieldLength

Reads the length of the current field

uaArchiveGetFieldName

Reads the name of the current field

uaArchiveGetFields

Reads the number of fields

uaArchiveGetFieldType

Reads the type of the current field

uaArchiveGetFieldValueDate

Reads date and time of the current data field

uaArchiveGetFieldValueDouble

Reads the double value of the current data field

uaArchiveGetFieldValueFloat

Reads the float value of the current data field

uaArchiveGetFieldValueLong

Reads the long value of the current data field

uaArchiveGetFieldValueString

Reads the string of the current data field

uaArchiveGetFilter

Reads the filter of the current data field

uaArchiveGetID

Reads the ID of the current data field

uaArchiveGetName

Reads the name of the current data field

uaArchiveGetSort

Reads the sorting of the current data field

uaArchiveImport

Imports the user archive

uaArchiveInsert

Inserts a new data record into the user archive

uaArchiveMoveFirst

Goes to the first data record

uaArchiveMoveLast

Goes to the last data record

uaArchiveMoveNext

Goes to the next data record

uaArchiveMovePrevious

Goes to the previous data record

uaArchiveOpen

Establishes a connection to the current user archive

uaArchiveReadTagValues

Reads the tag values

uaArchiveReadTagValuesByName

Reads the tag values based on the name

uaArchiveRequery

New Query

uaArchiveSetFieldValueDate

Writes the current data field

uaArchiveSetFieldValueDouble

Writes the double value of the current data field

uaArchiveSetFieldValueFloat

Writes the float value of the current data field

uaArchiveSetFieldValueLong

Writes the long value of the current data field

uaArchiveSetFieldValueString

Writes the sting of the current data field

uaArchiveSetFilter

Sets the filter

uaArchiveSetSort

Sets the sort criterion
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7.4.6.2

uaArchiveUpdate

Updates the user archive which is open.

uaArchiveWriteTagValues

Writes the values of the current data record to the tag

uaArchiveWriteTagValuesByName

Writes the values of the current data record to the tag
based on the name

uaArchiveClose

Description
Closes the currently open user archive.
BOOL uaArchiveClose (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: User archive has been closed successfully
FALSE: Error

7.4.6.3

uaArchiveDelete

Description
Deletes the data from a user archive. The configured user archive is retained.
BOOL uaArchiveDelete (
UAHARCHIVE hArchive,
LPCSTR pszWhere )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszWhere
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String with the SQL selection of data records to be deleted. The string corresponds to the SQL
statement "DELETE FROM <archive> WHERE pszWhere".
Note
If "pszWhere" is empty, the entire user archive is deleted.

Return value
TRUE: User archive has been deleted successfully
FALSE: Error

7.4.6.4

uaArchiveExport

Description
Exports the current user archive to a CSV file.
BOOL uaArchiveExport (
UAHARCHIVE hArchive,
LPCSTR pszDestination,
LONG lType,
LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszDestination
Name of the destination file. When calling the function on clients, the path specification refers
to the server computer.
LONG lType
Data format of the destination file. Two formats are available:
● "UA_FILETYPE_DEFAULT = 0": The default file format "CSV".
● "UA_FILETYPE_CSV = 1": CSV file format
LONG lOptions
Options reserved for future expansion. "lOptions" must have the value "0".
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Return value
TRUE: User archive has been exported successfully
FALSE: Error

7.4.6.5

uaArchiveGetCount

Description
Reads the number of data records.
LONG uaArchiveGetCount(
UAHARCHIVE hArchive,
LONG * plCount )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG plCount
Pointer to a tag in which the number of data records is to be stored.

Return value
Number of data records. With "0", the archive is empty or an error has occurred. The
"uaGetLastError" query is required.

7.4.6.6

uaArchiveGetFieldLength

Description
Reads the length of a field in the current data record.
LONG uaArchiveGetFieldLength(
UAHARCHIVE hArchive,
LONG lField )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
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The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.

Return value
Length of the current field

7.4.6.7

uaArchiveGetFieldName

Description
Reads the name of a field in the current data record.
VOID uaArchiveGetFieldName (
UAHARCHIVE hArchive,
LONG lField,
LPCSTR pszName,
LONG cMaxLen )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LPCSTR pszName
Field Name
LONG cMaxLen
Maximum Length

7.4.6.8

uaArchiveGetFields

Description
Reads the number of configured data fields. The "ID", "Last user" and "Last access" fields are
included. In the runtime calls, the indices of the configured fields are indicated with "1" to "N".
The "ID" field has the index "0". The "Last user" and "Last access" fields are appended to the
end of the configured fields.
LONG uaArchiveGetFields (
UAHARCHIVE hArchive )
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Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
Number of the configured fields.

7.4.6.9

uaArchiveGetFieldType

Description
Reads the type of a field in the current data record.
LONG uaArchiveGetFieldType (
UAHARCHIVE hArchive,
LONG lField )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.

Return value
Type of the current field.
The symbolic definitions of the field types are:
● UA_FIELDTYPE_INTEGER
● UA_FIELDTYPE_FLOAT
● UA_FIELDTYPE_DOUBLE
● UA_FIELDTYPE_STRING
● UA_FIELDTYPE_DATETIME
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7.4.6.10

uaArchiveGetFieldValueDate

Description
Reads the date and time of a field in the current data record.
BOOL uaArchiveGetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField,
LPSYSTEMTIME pstDateTime )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LPSYSTEMTIME pstDateTime
Pointer to the tag of the "SYSTEMTIME" type

Return value
TRUE: Successful reading of date and time
FALSE: Error

7.4.6.11

uaArchiveGetFieldValueDouble

Description
Reads the "double" value of a field in the current data record.
BOOL uaArchiveGetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField,
double* pdValue )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
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LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
double* pdValue
Pointer to the tag of the current field content.

Return value
TRUE: Value successfully read.
FALSE: Error

7.4.6.12

uaArchiveGetFieldValueFloat

Description
Reads the "float" value of a field in the current data record.
BOOL uaArchiveGetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField,
FLOAT* pfValue )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
FLOAT* pfValue
Pointer to the tag of the current field content.

Return value
TRUE: Value successfully read
FALSE: Error
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7.4.6.13

uaArchiveGetFieldValueLong

Description
Reads the "long" value of a field in the current data record.
BOOL uaArchiveGetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField,
LONG* pdValue )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LONG* pdValue
Pointer to the tag of the current field content.

Return value
TRUE: Value successfully read.
FALSE: Error

7.4.6.14

uaArchiveGetFieldValueString

Description
Reads the string of a field in the current data record.
BOOL uaArchiveGetFieldValueString (
UAHARCHIVE hArchive,
LONG lField,
LPSTR pszString,
LONG cMaxLen )

Parameter
UAHARCHIVE hArchive
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Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LPCSTR pszString
Value as string.
LONG cMaxLen
Maximum length of the string.

Return value
TRUE: Value successfully read
FALSE: Error

7.4.6.15

uaArchiveGetFilter

Description
Reads the selection criteria of the current data record.
VOID uaArchiveGetFilter (
UAHARCHIVE hArchive,
LPSTR pszFilter,
LONG cMaxLen )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPSTR pszFilter
Selection criterion in SQL.
LONG cMaxLen
Maximum length.

7.4.6.16

uaArchiveGetID

Description
Reads the "ID" of the user archive.
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LONG uaArchiveGetID (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
"ID" of the user archive

7.4.6.17

uaArchiveGetName

Description
Reads the name of the user archive.
VOID uaArchiveGetName (
UAHARCHIVE hArchive,
LPSTR pszName,
LONG cMaxLen )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPSTR pszName
Pointer to the buffer for the user archive name.
LONG cMaxLen
Maximum length.

Example
char tank [40];
uaArchiveGetName( hArchive, tank, 39 );
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7.4.6.18

uaArchiveGetSort

Description
Reads the sorting criteria of the user archive.
VOID uaArchiveGetSort (
UAHARCHIVE hArchive,
LPSTR pszSort,
LONG cMaxLen )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszSort
Selection criteria in SQL.
LONG cMaxLen
Maximum length.

7.4.6.19

uaArchiveImport

Description
Imports a user archive with the CSV data format. The structure of the target archive must be
identical to the imported CSV archive.
BOOL uaArchiveImport (
UAHARCHIVE hArchive,
LPCSTR pszSource,
LONG lType,
LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszSource
File name of the source archive.
LONG lType
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Data format of the source archive. Two formats are available:
● "UA_FILETYPE_DEFAULT = 0": The default file format "CSV".
● "UA_FILETYPE_CSV = 1": CSV file format
LONG lOptions
Options reserved for future expansion. "lOptions" must have the value "0".

Return value
TRUE: User archive has been imported successfully
FALSE: Error

7.4.6.20

uaArchiveInsert

Description
Inserts the local data record buffer into the archive. To have useful data in the new data record,
you need to fill the fields of the local data record buffer using "uaArchiveSetFieldValue..."
functions before calling "uaArchiveInsert".
You need to fill the internal "ID" field with an ID not yet used in the archive or with 0 using the
"uaArchiveSetFieldValueLong" function.
BOOL uaArchiveInsert (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: Successful insertion of the data record

7.4.6.21

uaArchiveMoveFirst

Description
Goes to the first data record.
BOOL uaArchiveMoveFirst (
UAHARCHIVE hArchive )

1706

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

User archive
7.4 User archive functions

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: Successful jump in the user archive
FALSE: Error

7.4.6.22

uaArchiveMoveLast

Description
Goes to the last data record.
BOOL uaArchiveMoveLast (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: Successful jump in the user archive
FALSE: Error

7.4.6.23

uaArchiveMoveNext

Description
Goes to the next data record.
BOOL uaArchiveMoveNext (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
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Return value
TRUE: Successful jump in the user archive
FALSE: Error

7.4.6.24

uaArchiveMovePrevious

Description
Goes to the previous data record.
BOOL uaArchiveMovePrevious (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: Successful jump in the user archive
FALSE: Error

7.4.6.25

uaArchiveOpen

Description
Opens an existing user archive. Calling "uaArchiveOpen" is required if you use read or write
operations in the user archive, for example before calling the functions "uaArchiveMoveNext",
"uaArchiveDelete" or "uaArchiveUpdate".
BOOL uaArchiveOpen (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".

Return value
TRUE: User archive has been opened successfully
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FALSE: Error

7.4.6.26

uaArchiveReadTagValues

Description
Reads the current value from the field tag.
BOOL uaArchiveReadTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG* pnFields
Reserved for later expansions. "pnFields" must have the value "0".
LONG cFields
Number of transferred field indices. Corresponds to the size of the array "pnFields". Reserved
for later expansions. "cFields" must have the value "0".
LONG lOptions
Options. Reserved for later expansions. "lOptions" must have the value "0". For all other values
of "lOptions", the data is inserted at the position of the pointer.

Return value
TRUE: Successful reading in the user archive
FALSE: Error

7.4.6.27

uaArchiveReadTagValuesByName

Description
Reads the tag values in the current data.
BOOL uaArchiveReadTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
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LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszFields
Reserved for later expansions. "pszFields" must have the value "ZERO".
LONG lOptions
Options. Reserved for later expansions. "lOptions" must have the value "0".

Return value
TRUE: Successful reading in the user archive
FALSE: Error

7.4.6.28

uaArchiveRequery

Description
After calling "uaArchiveSetFilter" and "uaArchiveSetSort", you need to reload the user archive
using "uaArchiveRequery".
Also call "uaArchiveRequery":
● If you have entered values in the UserArchiveControl.
● If you have entered values in the "User Archive" editor which were applied in the table
window.
Note
You can use the "uaArchiveSetSort" and "uaArchiveSetFilter" functions without opening
the user archive with "uaArchiveOpen". In case, do not call the "uaArchiveRequery"
function.
BOOL uaArchiveRequery(
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
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Return value
TRUE: Data successfully queried
FALSE: Error

7.4.6.29

uaArchiveSetFieldValueDate

Description
Writes the date and time into a field of the current data record.
BOOL uaArchiveSetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField,
LPSYSTEMTIME pstDateTime )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LPSYSTEMTIME pstDateTime
Date and time for the particular field.

Return value
TRUE: Successful writing of date and time
FALSE: Error

7.4.6.30

uaArchiveSetFieldValueDouble

Description
Writes a "double" value into a field of the current data record.
BOOL uaArchiveSetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField,
double dValue )
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Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
double dValue
Value for the particular field.

Return value
TRUE: Value successfully written
FALSE: Error

7.4.6.31

uaArchiveSetFieldValueFloat

Description
Writes a "float" value into a field of the current data record.
BOOL uaArchiveSetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField,
float fValue )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
float fValue
Value for the particular field.

Return value
TRUE: Value successfully written
FALSE: Error
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7.4.6.32

uaArchiveSetFieldValueLong

Description
Writes a "long" value into a field of the current data record.
BOOL uaArchiveSetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField,
LONG dValue )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LONG dValue
Value for the particular field.

Return value
TRUE: Value successfully written
FALSE: Error

7.4.6.33

uaArchiveSetFieldValueString

Description
Writes a String into a field of the current data record.
BOOL uaArchiveSetFieldValueString (
UAHARCHIVE hArchive,
LONG lField,
LPCSTR pszString )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
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LONG lField
The field number, where "lField = 1" addresses the first configured field. "lField = 0" addresses
the "ID" field.
LPCSTR pszString
String for the particular field.

Return value
TRUE: String successfully written
FALSE: Error

7.4.6.34

uaArchiveSetFilter

Description
Sets the selection criteria for the user archive. You can also call the function without opening
the archive using "uaArchiveOpen".
Note
If you have opened the user archive using "uaArchiveOpen", reload it after filtering it with
"uaArchiveRequery".
VOID uaArchiveSetFilter (
UAHARCHIVE hArchive,
LPSTR pszFilter )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPSTR pszFilter
Selection criterion in SQL.
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7.4.6.35

uaArchiveSetSort

Description
Sets the sorting of the user archive. You can also call the function without opening the archive
using "uaArchiveOpen".
Note
If you have opened the user archive using "uaArchiveOpen", reload it after sorting it with
"uaArchiveRequery".
BOOL uaArchiveSetSort (
UAHARCHIVE hArchive,
LPSTR pszSort )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszSort
Selection criteria in SQL.

Return value
TRUE: Sorting successful
FALSE: Error

7.4.6.36

uaArchiveUpdate

Description
Updates the user archive which is open. All data changes of a user archive are applied in the
database. The configuration of the user archive remains unchanged.
BOOL uaArchiveUpdate (
UAHARCHIVE hArchive )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
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Return value
TRUE: User archive successfully updated
FALSE: Error "Update_failed = 106". This error occurs with a consistency violation, for
example, when the "Field must possess a value" option is set for a field, but there is no value
in the field.

7.4.6.37

uaArchiveWriteTagValues

Description
Writes the values of the current data record to the tag. The execution of subsequent scripts
only continues when this synchronous write request has been processed.
BOOL uaArchiveWriteTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LONG* pnFields
Reserved for later expansions. "pnFields" must have the value "0".
LONG cFields
Number of transferred field indices. Corresponds to the size of the array "pnFields". Reserved
for later expansions. "cFields" must have the value "0".
LONG lOptions
Options. Reserved for later expansions. "lOptions" must have the value "0".

Return value
TRUE: Writing to the user archive successfully completed
FALSE: Error
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7.4.6.38

uaArchiveWriteTagValuesByName

Description
Writes the values of the current data record to the tag.
BOOL uaArchiveWriteTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
LONG lOptions )

Parameter
UAHARCHIVE hArchive
Handle of the User Archive. This handle is generated with "uaQueryArchive" or
"uaQueryArchiveByName".
LPCSTR pszFields
Reserved for later expansions. "pszFields" must have the value "ZERO".
LONG lOptions
Options. Reserved for later expansions. "lOptions" must have the value "0".

Return value
TRUE: Writing to the user archive successfully completed
FALSE: Error

7.4.7

Troubleshooting functions

7.4.7.1

uaGetLastError

Description
Many users archive functions return a BOOL value. The "TRUE" value means error-free
execution of the function. If the "FALSE" value is returned, the error of the most recently used
function can be read with the "uaGetLastError()" and "uaGetLastHResult" functions.
If "uaGetLastError" is called after several functions have been executed, it returns the error
that occurred last. In order to know exactly with which function the error occurred, you need
to call the "uaGetLastError" and "uaGetLastHResult" functions after each call to a function with
a BOOL value.
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Example
if ( uaArchiveGetFieldValueLong ( hArchive, Index, &IntValue ) ==
TRUE )
printf( "Field Value = %u\n", IntValue );
else
printf("Error calling uaArchiveGetFieldValueLong: %d / %08lx\n",
uaGetLastError(), uaGetLastHResult());
For functions that do not return a value (VOID), you must in any case call the "uaGetLastError"
function:
uaArchiveGetFilter(hArchive, pszFilter, cMaxLen);
INT nUAError = uaGetLastError (

);

if ( UA_ERROR_SUCCESS != nUAError)
{
printf( "Filter = [%s]\n", pszFilter );
}
else
{
printf("Error calling uaArchiveGetFilter: %d, hr=0x%08lX\n",
nUAError, uaGetLastHResult());
}
INT uaGetLastError()

Return value
Error status of the last function executed. The error constants and the "Predefines" of the user
archive functions are located in "CCUACAPI.H".
The following errors can be returned with "uaGetLastError":
● UA_ERROR_SUCCESS
● UA_ERROR_GENERIC
● UA_ERROR_CONNECT_FAILED
● UA_ERROR_OPEN_FAILED
● UA_ERROR_CLOSE_FAILED
● UA_ERROR_REQUERY_FAILED
● UA_ERROR_MOVE_FAILED
● UA_ERROR_INSERT_FAILED
● UA_ERROR_UPDATE_FAILED
● UA_ERROR_DELETE_FAILED
● UA_ERROR_IMPORT_FAILED
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● UA_ERROR_EXPORT_FAILED
● UA_ERROR_READ_FAILED
● UA_ERROR_WRITE_FAILED
● UA_ERROR_GET_FAILED
● UA_ERROR_SET_FAILED
● UA_ERROR_INVALID_NAME
● UA_ERROR_INVALID_TYPE
● UA_ERROR_INVALID_NUMRECS
● UA_ERROR_INVALID_COMMTYPE
● UA_ERROR_INVALID_LENGTH
● UA_ERROR_INVALID_PRECISION
● UA_ERROR_NULL_POINTER
● UA_ERROR_INVALID_POINTER
● UA_ERROR_INVALID_HANDLE
● UA_ERROR_INVALID_INDEX
● UA_ERROR_SERVER_UNKNOWN

7.4.7.2

uaGetLastHResult

Description
Reads the COM error which occurred most recently. The function is used primarily for
diagnostics of incompatibilities in the employed COM implementation or for detecting
registration and communication problems.
This function should also be used in addition to "UaGetLastError", when a user archive function
returns a "FALSE".
LONG uaGetLastHResult()

Return value
Most recently occurred COM error
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7.5

WinCC UserArchiveControl

7.5.1

WinCC UserArchiveControl

Functional scope
The WinCC UserArchiveControl provides access capability to archives and views of user
archives. In Runtime, you can:
● Create, delete or modify new data records
● Browsing in user archives
● Read and write tags for direct tag link
● Import and export user archive
● Define selection criteria to display a certain portion of the user archive only
● Define sorting conditions for the displayed user archive columns

Properties
You connect a UserArchiveControl with a selected user archive or a view in the configuration.
For access, the user archive or the view must be enabled. If you remove the access protection,
you must connect the WinCC UserArchiveControl with the user archive again in the
configuration dialog.
Access protection for a user archive or field is queried on opening a screen of the
UserArchiveControl:
● If the user has no authorization for reading the user archive, no data are shown but the
column headings in the table are shown.
● If the user has no read access to a field, the respective user archive column is not shown
in the table.
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● If the user has no authorization for writing in the user archive, the user cannot edit the data
in the table.
● If the user has no write access to a field, the user cannot edit the respective user archive
column in the table.
Access protection for the control tag of a protective archive must be configured separately with
the object properties e.g. a picture, an IO field or a button.

See also
Short Description of the WinCC Controls and Additional Controls (Page 368)

7.5.2

Configuring the UserArchiveControl

7.5.2.1

How to configure the UserArchiveControl

Introduction
The values of the user archive are shown in runtime in an ActiveX control. You can configure
a WinCC UserArchiveControl for this in the Graphics Designer.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1721

User archive
7.5 WinCC UserArchiveControl

Requirements
● You have configured an archive or a view in the user archive.

Configuration steps
1. Link the WinCC UserArchiveControl to a Graphics Designer picture.
2. Configure the basic properties for the UserArchiveControl on the "General" tab.
– The table window properties
– The general properties of the control
– The time base of the control
– The editing capabilities of the contents in control

3. Connect the UserArchiveControl with an archive or a view of the user archive.
4. Define the content of the table of the UserArchiveControl, in which you configure the
selected columns from the user archive.
5. Configure the display and properties of the table on the "Parameter", "Display" and "Marker"
tabs.
6. Configure the toolbar and the status bar of the table window on the respective tabs
7. Save the configuration.
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7.5.2.2

How to define the contents of the UserArchiveControl

Introduction
The WinCC UserArchiveControl shows the data of the connected user archive in a table. The
displayed content of the table is determined by the selected columns of the user archive and
the selection of column content.

Requirement
● You have created one or more user archives or views.
● You have connected the UserArchiveControl with a user archive or a view.
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Configures the columns of the user archive.
1. Go to the "Columns" tab.

2. In the "Columns" list, you will see the fields of the connected archive or view. If a checkmark
is set in the column in front of the name, the column is displayed in the table. Deactivate
the check box if you do not want it to appear.
3. Determine the order of the columns in the table using the "Up" and "Down" buttons.
4. Select a column to configure the properties and the format.
5. If necessary, change the width of the column in the table. Enter a value in the "Length in
chars" field.
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6. Some columns can also show the content and the header as a symbol. Determine how
these columns are displayed in the "Display" field. Text and symbols can be displayed at
the same time.
7. Save the configuration.

Selection of column content that will be displayed in the table
Configure criteria used to display the content in the columns in the "Selection" area.

Procedure
1. Click "Edit...". The selection dialog is opened.

2. Specify the criteria for the display. More information on the selection of columns can be
found under How to select the data of the user archive.
3. Click "OK" to close the selection dialog. The selection is applied at runtime start in the table
of the UserArchiveControl.
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Configuring the Sorting of Columns
You configure the sorting of the columns in the table of the UserArchiveControl in the "Sorting"
area. You can also specify the sorting criteria in runtime using the key functions.
1. Click "Edit...". The sorting dialog opens.

2. Set a sorting sequence. More information on the sorting of columns can be found under
How to sort the display of user archive data.
3. Click "OK" to close the sorting dialog.
4. Save the configuration of the content of the UserArchiveControl.

7.5.2.3

How to configure the display for the table

How to configure the properties of the table elements
Introduction
You can adjust the properties of the table elements in the WinCC controls to suit requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Parameter" tab.

2. Specify the properties for
– Column Header
– Row label
– Sorting
– Table Content
3. Save the configuration.

How to configure the colors of the table elements
Introduction
You can adjust the colors of the table elements in the WinCC controls to suit requirements.

Requirement
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Effects" tab.

2. Define the colors for the background or text here for:
– Table content. You can define different colors for even and odd line numbers to improve
differentiation between both.
– Contents of the table header
– Separating lines in the table and for table headers
3. Define the color and the line weight in the "General" area in terms of:
– Control borders
– Window dividers for control elements
4. Save the configuration.
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How to configure the marking of the selected cells and lines
Introduction
You can customize the marking of the selected cells and rows in the WinCC control to suit
requirements.

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Selection" tab.

2. Define whether to select rows or only cells using the mouse.
3. Configure the properties of the selection rectangle that can be displayed around selected
table cells or rows.
4. Configure the marking color for selectable cells and/or rows. The system colors are used
for marking with "Automatic coloring" property.
5. Save the configuration.

How to configure sorting via the column heading
Introduction
You can adjust the sorting order by means of table column header in the WinCC controls to
suit requirements.
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Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.
● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameter" tab.

2. Define whether to enable sorting and the sorting method by column header. In WinCC
AlarmControl, you can only sort by column header if the "Auto-scrolling" is disabled. You
can deactivate "Auto-scrolling" either in the "General" tab, or using the "Autoscroll" toolbar
icon of the WinCC AlarmControl.
3. Determine the sorting order by mouse click on the column header. Select ascending,
descending or no sorting order.
4. Configure the sorting icon and index to be displayed in the column header with right
justification. These show the sorting order and sequence of the columns.
5. Activate the "Use sorting key" to display the sorting icon as sorting button above the vertical
scroll bar. Click this sorting key to activate a configured sorting order for the column
selected. The sorting key is not displayed if a vertical scroll bar is missing.
6. Save the configuration.

7.5.2.4

How to configure the toolbar and the status bar

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The
status bar contains information pertaining to the current status of the WinCC control. You can
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime.
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Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The WinCC control is assigned the "Configuration dialog" button function for opening the
configuration dialog in Runtime.
● The configuration dialog of the WinCC control is open.

How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in
Runtime. For information on the button functions, refer to the description of the
corresponding WinCC control at "Operation in runtime".
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3. Determine the sorting order for displaying the button functions in the toolbar. Select the
button functions from the list and the move the functions using the "Up" and "Down" buttons.
4. Define a shortcut key for the functions of the toolbar buttons.
5. Any button functions assigned operator authorizations are only available in Runtime to
authorized users.
6. An activated button function is displayed during runtime if you deactivate its "Active" option,
however, it cannot be operated.
7. You can set separators between the button functions. Activate the "Separator" option for
the button function to be restricted by separator.
8. Configure the general properties of the toolbar, e.g. alignment or background color.
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How to configure the status bar
1. Go to the "Status Bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required during runtime in the list of status bar elements. For further
information on status bar elements, refer to the descriptions of the corresponding WinCC
control at "Operation in runtime".
3. Determine the sorting order for displaying of the status bar elements. Select the elements
from the list and move these using the "Up" and "Down" buttons.
4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a
pixel value for the width.
5. Configure the general properties of the status bar, e.g. alignment or background color.
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7.5.2.5

How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set
up operation of the data export during runtime in the configuration dialog.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab.

2. A standard file name and a standard directory are already entered in the "Data export default
settings". In this case for AlarmControl. If necessary, define a file name and a directory for
the export file.
The file name can be made up of the freely defined name and the following placeholder:
@OBJECTNAME - Object name of the controls
@CURRENTDATE - Current date
@CURRENTTIME - Current time
3. CSV is currently available as data format. Click
in the CSV file.

to specify the delimiter and data format

4. Define the scope of the data export:
– All runtime data is exported
– Selected runtime data is exported. This data export is only possible in WinCC controls
with tabular display.
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5. Configure the operation of the data export during runtime. Define:
– whether users are allowed to rename the file, or change the directory.
– whether to display the "Data export default settings" dialog in Runtime.
6. If "Show dialog" is deactivated, the data for operation of the "Export data" button function
is immediately exported to the defined export file.
7. Save the configuration.
8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results
You can export all or selected data to a defined file at runtime using the

7.5.2.6

button function.

How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the Runtime effects
of the online configuration.
Changes configured in Runtime are saved for the specific user separately from the picture in
the configuration system. The original picture configuration is retained in the configuration
system.
Note
The picture is also replaced at Runtime if you save it in Graphics Designer, or when loading
deltas in online mode. All online changes are lost.
The different configurations are only activated for new users after you performed a picture
change.

Requirement
● A picture showing a WinCC control is opened in Graphics Designer when configuring.
● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults
are only available in the configuration system. The option buttons are not available in
Runtime.
Select one of the three effects of the online configuration:
– "Do not retain". The online configurations are not retained in Runtime. This default
setting disables all options for Runtime users. Online configurations are lost at the next
picture change and on activation/deactivation of the project.
– "Retain during Runtime". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the
project.
– "Retain permanently". This default setting enables the "discard", "retain" or "reset"
options for Runtime users. Online configurations are retained at the next picture change
and on activation/deactivation of the project if the "retain" option is enabled.
3. Define corresponding user authorizations for online configuration.
4. The option buttons of the "Online configuration on next picture change" can be enabled for
operation in the configuration system and at Runtime by setting the "retain at Runtime" and
"retain permanently" defaults. The "reset" operation is only available in Runtime, because
the configuration system contains the original configuration.
Select one of three effects of the online configuration at the next picture change:
– Select "discard" if to discard the online configuration at the next picture change.
– Activate "retain" to activate the online configuration based on default settings at the next
picture change or on activation/deactivation of the project.
– Activate "Reset" if you want to apply the picture saved in the configuration system in
Runtime. All online changes are lost.
5. Save the configuration.

7.5.2.7

How to make the toolbar for the UserArchiveControl dynamic

Introduction
The default functions for operating the WinCC UserArchiveControl are no longer supported
for the new WinCC UserArchiveControl as of WinCC V7.0. You can use the WinCC types of
dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC controls as of V7.0, special functions are no longer required for operating the
control with toolbar dynamics. The previously used standard functions "Tlg..." are no longer
supported.
If you do not want to operate the control via the toolbar, you can write the "ID" for the desired
button in the "ToolbarButtonClick" object property with an optional type of dynamics.
The "ID" of a button of the toolbar can be determined:
● with the table on page "Operation of the UserArchiveControl in runtime".
● in the configuration dialog of the UserArchiveControl on the "Toolbar" tab via field "Object
ID".
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Example: Open the configuration dialog for the control
In order to open the configuration dialog of the control, dynamics are possible as follows:
● VBScript:
– ScreenItems("Control1").ToolbarButtonClick = 2
– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog
– Or, with the following notation with the support of "Intellisense":
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog
● C script:
– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);
● Direct connection
– In the dialog for the direct connection for the source, enter "2" as a constant
– Select the property "ToolButtonClick" for the object "Control1" for the target "Object in
picture"

See also
Operating the UserArchiveControl in runtime (Page 1738)

7.5.3

Operation in runtime

7.5.3.1

Operating the UserArchiveControl in runtime

Introduction
The buttons on the toolbar are used to operate the WinCC UserArchiveControl during runtime.
If you do not want to operate the table window via the toolbar, you can write the "ID" for the
desired button in the "ToolbarButtonClick" object property with an optional type of dynamics.
Note
If the "Error while connecting the data!" error message appears when you start runtime, the
UserArchiveControl is not connected to a user archive or a view. Check the following potential
error sources:
● Is the connection specified correctly?
● Has the configuration been changed?
● Does the associated user archive or view still exist?
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Navigation in the table of the WinCC UserArchiveControl
You can navigate in the table as follows:
● You enter the next cell with the "ENTER" key or with the "Right" cursor key.
● You enter the previous cell with "SHIFT+ENTER" key or with the "Left" cursor key.
● You enter the next line by clicking with the mouse in the line or with the "Down" cursor key.
● You enter the previous line by clicking with the mouse in the line or with the "Up" cursor
key.

Overview
The overview shows all symbols in "standard" style. If you want to create a design of the
controls with "Simple" style, the representation of the symbols corresponds to the
UserArchiveControl prior to WinCC V7. You can find an overview on the page, "Before WinCC
V7: WinCC User Archives Table Element > User Archives Table Elements in Runtime > The
toolbar of the user archive table element".
Symbol

Description

ID

"Help"

1

Calls up the help on WinCC UserArchiveControl.
"Configuration dialog"

2

Opens the configuration dialog, in which you can change the properties of
the UserArchiveControl.
"Select data connection"

3

Opens a dialog box in which you can select a user archive. The content of
the selected user archive is displayed in the table of the UserArchiveControl.
"First line"

4

The first value of the user archive is displayed in the table via the button.
"Previous line"

5

The previous value of the user archive is displayed in the table via the button.
"Next line"

6

The next value of the user archive is displayed in the table via the button.
"Last line"

7

The last value of the user archive is displayed in the table via the button.
"Delete lines"

8

The content of the marked lines are deleted.
"Cut lines"

9

The content of the marked lines are cut out.
"Copy lines"

10

The content of the marked lines are copied.
"Insert lines"

11

The content of the copied or cut-out lines is inserted starting from the marked
line.
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12

"Read tags"
This button is used for reading the content of the connected WinCC tags and
writing to the columns. In order to use the button, the communication type
"Communication via WinCC tags" must be activated in the user archive. The
columns must be connected with tags.
"Write tags"

13

This button is used for writing the content of the columns into the connected
WinCC tags. In order to use the button, the communication type
"Communication via WinCC tags" must be activated in the user archive. The
columns must be connected with tags.
"Import Archive"

14

The content of a user archive is imported into the table of the
UserArchiveControl with the button. The user archive must exist as a CSV
file in the "ua" directory of the project folder.
"Export archive"

15

This button exports the content of the table of the UserArchiveControl. The
user archive exists as a CSV file in the "ua" directory of the project folder.
"Sort dialog"

16

Opens a dialog for setting user-defined sort criteria for the displayed user
archive columns.
17

"Selection dialog"
Defining selection criteria for the columns of the user archive to be displayed
in the table.
"Print"

18

Starts the printout of the displayed values. The print job used for printing is
defined in the configuration dialog on the "General" tab.
"Export data"

20

This button is used for exporting all or the selected runtime data into a "CSV"
file. If the option "Display dialog" is active, a dialog opens in which you can
view the settings for exporting and can start the export. You can also select
the export file and directory, provided you have the corresponding
authorizations.
If no dialog is displayed, the export of the data to the preset file is started
immediately.
19

"Time base dialog"
Opens a dialog for setting the time base for the times used in the user archive.
"User-defined 1"

1001

Shows the first key function created by the user. The function of the button
is user-defined.

Possible elements of the status bar
The following elements can appear in the status bar of the UserArchiveControl:
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Symbol

7.5.3.2

Name

Description

Archive name

Displays the name of the selected user archive.

Row

Shows the number of the marked line.

column

Shows the number of the marked column.

Date

Shows the system date.

Time

Shows the system time.

Time Base

Shows the time base used in the display of times.

To process the data in the UserArchiveControl:

Introduction
You can edit data in the WinCC UserArchiveControl. The following options are available:
● Enter new data
● Change existing data
● Delete lines
● Cut-out, copy and insert lines

Requirement
● You have permitted editing in the configuration dialog on the "General" tab.
● You have deactivated the "Write-protected" property for the column to be edited in the
configuration dialog on the "Columns" tab.
● The "ID" column cannot be edited.
● If the UserArchiveControl is connected with a view, you cannot delete or cut out a line.

Entering new data in the table.
1. Click on

to move to the last line. The line is marked.

2. Double-click on the first cell of the marked line. You can also press on "F2", "Alt+Enter" or
Ctrl+Enter" in the cell.
3. You enter the values in the cells one after the other and confirm each time by pressing
Enter. After you have entered all values in the line and have marked another line, the new
data record is written to the user archive. You move to another line by clicking with the
mouse, with the "ENTER" key or with the "Up" and "Down" cursor keys.
4. You can copy the data of a marked line with "CTRL+C" or "CTRL+X" into the clipboard.
The copied data is inserted into a marked line with "CTRL+V".
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Changing existing data in the table
or
1. Click on
the desired line.

to move to the desired line. You can also use the scrollbars to move to

2. Double-click on the desired cell of the marked line. You can also press on "F2", "Alt+Enter"
or Ctrl+Enter" in the cell.
3. You enter the values in the cells one after the other and confirm each time by pressing
Enter. After you have entered all values in the line and have marked another line, the
changed data record is written to the user archive.

Deleting a line in the table
or
1. Click on
the desired line.
2. Click on

to move to the desired line. You can also use the scrollbars to move to

to delete the marked line.

Cutting, copying and inserting lines
1. Click on
or
the desired line.

to move to the desired line. You can also use the scrollbars to move to

2. Click on
or
to cut or copy the data of the line. As an alternative, you can also use
key combination "CTRL+ALT+X" or "CTRL+ALT+C".
3. Go to the desired line into which you want to copy the data. Click on
to insert the cutout or copied data. If you do not want to overwrite the data of the marked line, move into
the last line to insert the data.

7.5.3.3

How to select the data of the user archive

Introduction
The content of the user archive that you want to display or export into the table of the WinCC
UserArchiveControl can be defined in runtime via the selection dialog. You define the selection
criteria concerning the displayed user archive columns in the selection dialog.
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Requirement
● You have configured the button function "Selection dialog" on the "Toolbar" tab of the
UserArchiveControl.

Procedure
1. Click on

in runtime. The "Selection" dialog opens.

2. Double-click in the first empty line in the "Criteria" column. The list with the columns of the
user archive is displayed. Select the desired columns, e.g. "field1".
3. Double-click in the "Operand" column to select an operand.
4. Double-click in the "Setting" column to enter a comparison value.
5. Double click in the "Logic operator" column to select an "AND" or "OR" function.
6. Repeat the procedure if you want to define further criteria.
7. Click "OK" to close the selection dialog. The selection is displayed in the table of the
UserArchiveControl.
Note
Ensuring the display of column content
Make sure of proper use of the settings and connections of criteria.
Incorrect links can lead to data of the connected user archive not being displayed in the
UserArchiveControl.
Each criteria must be tested separately and then each of the linked criteria needs to be
tested before linking criteria. Check that all expected contents are also displayed in
combination.
This ensures that the selection is completely displayed in the UserArchiveControl.
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7.5.3.4

How to sort the display of user archive data

Introduction
During runtime, you can sort the data in the UserArchiveControl by column. You sort the
columns either via the "Sort dialog" button function or directly via the column headers.
Note
You can also specify the sort criteria during configuration in the UserArchiveControl by
clicking the "Edit..." button under "Sorting" on the "Columns" tab.

How to sort with the Sort dialog
Requirement
● You have configured the button function "Sort dialog" on the "Toolbar" tab of the
UserArchiveControl.

Procedure
1. Click the "Sort Dialog" button

.

2. In the "Sort By" field, select the column of the connected user archive, by which to sort first.
Select the relevant check box to specify sorting in ascending or descending order. If you
want to sort by more than one column, select the other columns in the desired order in the
"Then sort by" lists.
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How to sort the column contents with the column heading
When sorting using the column header, you are able to specify the sort order for more than
four columns. A sorting icon and sorting index, displayed with right-justification in the column
heading, show sorting order and sorting sequence of the column contents.

Requirement
● You have permitted the sorting in the list field "Sorting with column heading" by clicking or
double clicking on the WinCC UserArchiveControl on the "Parameter" tab.
● You have activated the "Show sorting icon" and "Show sorting index" checkboxes.

Procedure
1. Click the column header of the column you want to sort as first column. The sorting index
"1" is displayed, and the sorting icon points upwards for ascending sort order.
2. If you want to sort in descending order, click the column header again.
3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the
column with a third click.
4. If you want to sort several message blocks, click the respective header columns in the
desired sequence.
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7.6

Before WinCC V7: WinCC User Archives Table Element

7.6.1

Functionality

Functional scope
The User Archives Table element provides options to access user archives and views of the
user archives. Using the User Archives Table Element, in Runtime you can:
● Create, delete or modify new data records
● Browse in user archive
● Read and write tags for direct tag link
● Import and export user archive and
● Define filter and sorting conditions

Views
The User Archives Table Element offers two views: the table view and the form view.
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● The Table View
The Table View is used for a tabular display of the User Archive. Each record occupies one
row, the data fields of a record are displayed as columns.
● The Form View
The Form View offers a user interface that can be designed by the user. The Form View of
User Archives offers three field types: static texts, input fields and buttons.
Note
During configuration, a User Archives Table Element is connected to a selected user archive
or form and can then only access that user archive or form. For access, the user archive /
form must be enabled (access protection). Specific authorizations can be assigned to the
control in the User Administrator.
If this access protection is canceled, the control must be reconnected in the Graphics
Designer to the user archive so that control detects the canceled access protection.
Access protection for an archive or field is queried on opening a screen of a User Archive
Table Elements. Access protection for the control tags of a protected archive must be
implemented separately via the object properties, e.g. of the picture, I/O field or button.

See also
Configuring a User Archives Table Element (Page 1747)

7.6.2

Configuration of User Archives Table Element

7.6.2.1

Configuring a User Archives Table Element

Procedure
To configure a WinCC User Archives Table Element, proceed as follows:
1. Configure a user archive using the Editor User Archives or by using the functions of the
WinCC script language. In the description of the Editors User Archives, you can know how
the user archive "Cola" has been configured.
2. Place a new User Archives Table Element in an image of the Graphic Designer.
3. Configure the properties of the User Archives Table Element.
4. Configure a User Archives Form View.

See also
Working with Controls (Page 368)
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7.6.2.2

Place the User Archive Table Element in a process screen

Procedure
To set up a User Archives Table Element in a process screen, you need to configure it in the
Graphics Designer. This is done through the following steps:
1. Select the "Smart Objects" object group from the object palette.
2. Click the "Control" object and drag a window of an adequate size into the image area.
3. In the "Add Control" selection dialog that is now displayed, select the "WinCC User Archive
Table Element" option and confirm the selection with OK.
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Alternative Procedure
● In the "Controls" tab of the object palette, some standard controls will be displayed to you
for selection in the Object Palette window.
● Select the WinCC User Archive Table Element.

See also
Define properties of the User Archives Table Element (Page 1749)
Working with Controls (Page 368)

7.6.2.3

Define properties of the User Archives Table Element

Procedure
The following guideline gives you details of how you can configure a User Archives Table
Element for the user archive "Cola" in the Graphics Designer using the "Properties of WinCC
User Archive Table Element" dialog box.
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1. Double-click in the area of the "WinCC User Archive Table Element". You will see the
"WinCC User Archive Table Element Properties" dialogbox with the "General" tab.

2. In the Source input field, define the archive or the view that is to be displayed in the Control.
Click "Select" and select the user archive "Cola" in the Package Browser dialog.
3. You can define the access type during runtim in the Edit field. The "Add", "Modify" and
"Delete" access types are enabled by default. Instead, you can also activate "Ready-Only".
4. Using the "Border" checkbox you can define whether the Control dialog is to be displayed
with or without frame. Activate these options.
5. You can accept all the pre-settings in the other tabs without making any changes.

See also
"General" tab (Page 1753)
Delete the User Archives Table Element (Page 1751)
Working with Controls (Page 368)
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7.6.2.4

Delete the User Archives Table Element

Procedure
The User Archives Table Element is deleted in two steps in the Graphic Designer:
1. Click to select the User Archives Table Element to be deleted
2. Press Delete key or select "Edit - Delete" menu.
Note
The delete action is executed immediately without any warning! You can undo the delete
action only using "Edit - Undo" menu or "Ctrl+Z".

7.6.3

Properties of WinCC User Archives Table Element

7.6.3.1

Properties of WinCC User Archives Table Element

Procedure
1. You can modify the attributes of a User Archives Table Element by right-clicking the object
and selecting the "Properties" menu item from the pop-up menu which opens.
You can edit the statics of the Filter, Form, PressTBButton and Sort attributes. To avoid
inconsistencies in the database, make changes to the other object properties via the
"Properties of WinCC User Archive - Table Element" dialog box (double-click Control).
2. In the "Properties" tab of the opened "Object Properties" box, select the group "Control
Properties".
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The User Archives Table Element is normally configured in the Graphics Designer by doubleclicking one of the controls. You can make the desired changes in the dialog box that opens.
As the existing user archives, views, tags, etc. in the dialog boxes of the different tabs are
offered for selection, you can easily and safely make all the changes.

See also
Configuring a User Archives Table Element (Page 1747)
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7.6.3.2

"General" tab

Configuration

Icon

Description

Title Bar

Define the window title in the "Title bar" field. You define here whether the title
bar can be displayed, the window can be closed or moved.

Source

Click the "Select" button to go to the Package Browser where you can select a
user archive or view that has been configured earlier.

Edit

You can define the access type during runtime in the Edit field. The access types
"Add", "Modify" and "Delete" are released for the user archives when you
uncheck the "Read-Only" checkbox. For views, only the "Modify" checkbox is
released.

Border

Using the "Border" checkbox you can define whether the Control dialog is to be
displayed with or without frame.

Form

Use this checkbox to define whether the form view should be the start view in
the control window.
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Icon

Description

Time base for the
Last Access field

In this selection field you define the time basis for the time display in the Last
Access field.

Print job for quick
printing

In this field you define the print job that is to be used for printing the displayed
data.

Note
If the configuration of the user archive is changed in the Editor User Archives, for e.g. the
access protection is removed, then the Control in the Graphics Designer must be linked again
to this user archive. The Control can then detect the modified archive configuration.

The Package Browser
The Package Browser is activated by clicking the Select button in the Properties dialog of the
User Archives Table Element. You can select from the user archives and views that have
already been configured.

In a WinCC client, you can select in the Navigation field of the Package Browser those servers
whose packages have been loaded and where a user archive has been configured using tags.
In a project of the WinCC client, you can access the user archives of all the servers linked in
the project. Some user archives are not meant for WinCC Client. The path to the selected
server is displayed in the Hierarchy area. It can be edited so that you can manually enter the
path to the desired server.

1754

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

User archive
7.6 Before WinCC V7: WinCC User Archives Table Element
If the required server is not in the default list, a package of this server must be loaded by using
the server data function. You can find additional information about WinCC Client functionalities
in the WinCC Explorer Help.
Note
If the Control is not linked to an existing user archive or view, then the error message "Error
while connecting the data!" is displayed when you change to Runtime.

See also
List of properties for the User Archives Table Element (Page 1776)

7.6.3.3

"Columns" tab

Configuration

Icon

Description

Columns

In the Columns input field you can define which fields inserted in the Editor User
Archives are to be displayed in the process screen.

Properties

In the Properties input field, you can define the properties of the field currently
selected in the Columns field.

Blocked

You can use the Blocked checkbox to protect the select field from being
overwritten.
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Icon

Description

Format

Use the Format field to define the way the values are displayed:
● Fixed

(Fixed point number "%.2f")

● Scientific

(Exponential display "%e")

● Date

(only date output "%x")

● Time

(only time output "%X")

● TimeStamp

(Output date and time "%c")

A date field is displayed in the date format that is set in the operating system.
Alignment

In the "Alignment" field you can select between Left, Centered and Right.

Reset

Use Reset button to reestablish the previous setting.

Note
In the Format field you can also format the decimal places (for e.g. "%3f" for three decimal
lplaces) or the hexa-decimal format "%x" for integer values.

See also
List of properties for the User Archives Table Element (Page 1776)

7.6.3.4

"Toolbar" Tab

Configuration
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Icon

Description

Icons

Under "Icons" you define the icons that are to be included in the toolbar.

Access rights

The access rights for the selected symbol are displayed in the "Access Rights"
field.

Selection

Click the "Selection" button to display the "Authorizations" dialog box where you
can define the desired access.

Switch off

The "Turn Off" field is used to turn or turn off the toolbar display.

Hotkey

You can assign hotkeys to individual functions in the Hotkey field.

Authorizations

You can define the desired authorizations in the Authorizations dialog box. The authorizations
displayed in the dialog have earlier been configured in the User Administrator.

See also
List of properties for the User Archives Table Element (Page 1776)
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7.6.3.5

"Status Bar" Tab

Configuration

Icon

Description

Areas

In the "Ranges" checkbox you can define which elements are to be included in the
status bar of the control.

Switch off

The "Turn Off" field is used to turn or turn off the status bar display.

The status bar is displayed as follows when all the areas of the status bar are activated:

See also
List of properties for the User Archives Table Element (Page 1776)
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7.6.3.6

"Filter/ Sorting" tab

Configuration

Filter criterion
You define the filter criteria in the "Filter Criterion" dialog. Enter directly the rules for the filter
criteria. The conditions are formulated in the database programming language SQL (Structured
Query Language). You will find a description of the SQL with many practical examples in the
Appendix.
Example: FieldC > 100
All data sets which have a value greater than 100 in the "FieldC" column are selected.
When you click the "Create..." button you will get an automated filter screen where you can
define the filter criteria.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1759

User archive
7.6 Before WinCC V7: WinCC User Archives Table Element

In the "Filter by" row you can define the filter criteria; in the left selection field you will see a
display of all data fields of the user archive. You can use the "Followed by" and "Lastly after"
rows to define the following filter criteria. The filters are processed in this sequence.

Sort order
You define the sort criteria in the "Sort..." dialog. Enter the sorting rules directly in the database
programming language SQL.
When you click the "Create..." button you will get an automated filter screen where you can
define the sort criteria.

In the "Sort By" selection field you can define the sort criteria; all data fields of the user archive
are offered for selection. You can use the "Followed by" and "Lastly after" selection fields to
define the following sort criteria. The filters are processed in this sequence. Sorting is done in
an ascending order when you click "Ascending"; in a descending order when you click
"Descending".
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See also
List of properties for the User Archives Table Element (Page 1776)

7.6.3.7

"Fonts" Tab

Configuration

In the "Fonts" tab you define the font to be used in the Control.

See also
List of properties for the User Archives Table Element (Page 1776)
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7.6.3.8

"Colors" tab

Configuration

In the "Colors" tab you define the colors to be used in the Control.

See also
List of properties for the User Archives Table Element (Page 1776)

7.6.4

Configuring a Form View

7.6.4.1

Configuring a Form View

Procedure
The form of the User Archive Table Element may be configured by the user himself in Graphics
Designer and is used for editing and displaying user archive data in Runtime.
A configured User Archives Table Element is a prerequisite for creating a form view.
The following guideline will show you the configuration of a new form view in the Graphics
Designer.
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1. Press the Control key and simultaneously double-click the User Archives Table Element.
You will get a table view of the Controls. You can now define the width of the individual
columns for Runtime.

2. Use the
view.

icon to switch between form and table view. Click this icon to go to the form

You can now start configuring a form.
We will now create a form:
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Note
With a right-click in the empty form you can use the function "Create, all" from the pop-up
menu to automatically generate the form fields for all the data fields existing in the user
archive. For each data field, a text field with the corresponding alias name is also inserted
for each data field. The "Create, selected" option is used to generate form fields only for the
columns that are selected in the "Columns" tab.
Note
The User Archive Table Element does not support zooming functionality. The configuration
of the zoom functionality can lead to display problems in runtime.

7.6.4.2

Insert "Text" form field

Procedure
1. Open the Form view if you haven't already done so.
2. To insert a new "Text" form field, click with the right mouse key in the working area of the
User Archives Table Element in the Graphics Designer at the place where you want to
position the text. You will see the following list box:

3. When you select "Add Text Field" you will go to the "Text Field Properties" dialog box.

4. You can enter the desired text in the Text field. Enter here text "Input form Cola" as title for
the form.
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Note
If you expand the selection field via "Text" you will get a display of all field names of an archive
as static text. If text references for language switching have already been entered as Text
References in the Text library, the same are offered for selection.

See also
Insert "Edit" form field (Page 1765)

7.6.4.3

Insert "Edit" form field

Procedure
1. Open the Form view if you haven't already done so.
2. To insert a new "Edit" form field, click with the right mouse key in the working area of the
User Archives Table Element in the Graphics Designer at the place where you want to
position the Edit field. You will see the following list box:

3. When you select "Add Edit Field" you will go to the "Edit Field Properties" dialog box:

In the dialog of the selection field, you can select from all the configured fields of the user
archive.
4. Select "Water". You can now insert other editing fields such as Sugar, Dyestuff 7, Caffeine
and Phosphoric Acid.
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See also
Insert "Button" form field (Page 1766)

7.6.4.4

Insert "Button" form field

Procedure
1. Open the Form view if you haven't already done so.
2. To insert a new "Button", click with the right mouse key in the working area of the User
Archives Table Element in the Graphics Designer at the place where you want to position
the button. You will see the following list box:

3. When you select "Add Button" you will go to the "Button Properties" dialog box:

4. In the Text field you can define the text that is to be displayed as label on the new button.
Enter the text "Table View".
5. In the Action field you can select an icon of the Form view. Your newly configured button
will execute the same action as the corresponding icon in the toolbar. Select "Form" to
switch to table view.
Note
You can link all functions of the toolbar from the form view to a button. You can also design
the size and layout of the buttons to operate some functions of the toolbar via a touch screen.
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See also
Edit form fields subsequently (Page 1767)

7.6.4.5

Edit form fields subsequently

Procedure
1. To subsequently modify a form field, click the pre-configured form field with the right mouse
key and then click the "Properties" button.
or
Double-click the pre-configured form field.
You will see the corresponding dialog for modifying the form field as described in the chapters
on Text, Edit and Button form fields.

See also
Delete form fields (Page 1767)

7.6.4.6

Delete form fields

Procedure
1. To delete a form field, click the pre-configured form field with the right mouse key.
2. Click on the menu item "Delete".
The form field is deleted. Do not use the Delete key as this will delete the entire Control.

7.6.5

User Archives Table Elements in Runtime

7.6.5.1

Table of User Archives Table Element

Application
The table of the User Archive Table Element is used for displaying and entering user archive
data during Runtime in table format. Several lines of text within one cell may be accessed by
hitting the key combination <CTRL+ ENTER>. Several lines of text within one cell will be
displayed as one line in the table view, all lines are summarized in one single line.
The table and form window of the control is operated using the toolbar:
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Processing inside a table takes place in the same way as the processing of the table window
in the Editor User Archive.
Note
If one or more values are changed in the control table, you must exit the data record, i.e.
change to another table cell or row so the value is accepted into the database and be updated
in other displays.
Actions in the WinCC script language must take care of the selection of records. You cannot
select records using the control.

See also
Configuring a User Archives Table Element (Page 1747)

7.6.5.2

The User Archives Table Element Form

Application
The form of the User Archive Table Element may be configured by the user himself in Graphics
Designer and is used for displaying and entering user archive data in Runtime. Text may be
accessed and displayed in several lines.

Note
If you change one or more values in a user archive table element form, then you must scroll
to another record after completing the data entry so that the value is accepted in the database
and updated in other displays.
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7.6.5.3

Toolbar of WinCC User Archives Table Element

Functions
The toolbar offers the following options:

Icon

Description
Switching
Delete record
Insert a new record
Modify existing field
Browse in Table window
Read and write tags
Import and export user archive
Define filter criterion
Define sort criterion
Time base for the "LastAccess" field
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Icon

Description
Printing
Request Help

Switching
Use the icon to switch between form and table view.
Delete record
The selected record is deleted.
Insert a new record
You enter the values of the data fields one after the other and confirm each time by pressing
Enter. After entering all data fields, the new record is created with the inserted values.
Modify existing field
After clicking this icon, click the field you want to modify. This will display the text marker - you
can now see that the field can be edited. As soon as the "Modify existing field" is active, you
can modify the Used Archives Table Element in the Modify mode. You can then move the
cursor in the table and make the changes immediately. If the "Modify" mode is switched off,
you can make changes only by pressing the F2 hotkey or double-clicking the field to be
modified.
Browse in Table window
You can use these buttons to scroll or browse backward and forward in the table window and
jump to the start or end of the user archive.
Read and write tags
These buttons are used to read and write WinCC tags.
While setting up the user archive in the "Communication" tab of the "Archive Properties" dialog
box, you can select the communication type "Communication via WinCC tags".
Import and export archives
After clicking one of these buttons, the user archives are imported or exported in CSV format
(Coma Seperated Value).
Note
Before reading them in Excel, you need to specify data type as CSV because otherwise Excel
will not read the CSV file exported from WinCC correctly.
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Note
With a multi-user project the following has to be considered: If there is a user archive on the
server, e.g. at "c:\Projects\Test\UA", it is enabled with this specified path. The client maps
the enablement via a network drive e.g. "I:\Test\UA". Thereafter, the standard path of the
User Archive is on the client "I:\Test\UA". However, this directory does not exist on the server
with this description. If you want to import / export user archive data, you have to change the
standard path on the client, in our example to "C:\Projects\Test\UA".

Define filter criterion
Use this option to enter filter criteria. All displayed data is exported. To export a subset, you
need to formulate the filter criteria in such a way that only the desired data is displayed. You
can then export this filtered data.

The conditions are formulated in the database programming language SQL (Structured Query
Language). You will find a description of the SQL with many practical examples in the
Appendix. For more details refer concernd technical literature.
Example: ID < 100
Only data fields with IDs 1 to 99 are selected; all other data fields are not displayed.
When you click the "Create..." button you will get an automated filter screen where you can
define the filter criteria.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1771

User archive
7.6 Before WinCC V7: WinCC User Archives Table Element

In the "Filter by" row you can define the filter criteria; in the left selection field you will see a
display of all data fields of the user archive. You can use the "Followed by" and "Lastly after"
rows to define the following filter criteria. The filters are processed in this sequence.
Note
The filter conditions defined here are temporary, i.e. after building up a fresh screen, the filter
criteria defined in the Properties dialog are again valid.

Define sort criterion
Use this option to enter sort criteria.

The rules for sorting are directly specified in the database programming language SQL.
Also refer the description of SQL in the Appendix. For more details refer concernd technical
literature.
When you click the "Create..." button you will get an automated filter screen where you can
define the sort criteria.
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In the "Sort By" selection field you can define the sort criteria; all data fields of the user archive
are offered for selection. You can use the "Followed by" and "Lastly after" selection fields to
define the following sort criteria. The filters are processed in this sequence. Sorting is done in
an ascending order when you click "Ascending"; in a descending order when you click
"Descending".
Note
The sort conditions defined here are temporary, i.e. after building up a fresh screen, the filter
criteria defined in the Properties dialog are again valid.
Time base for the Last Access field
You can use this option to change the time base for the "Last Access" field.
Printing
This option starts printing the displayed values.
Request Help
Click the Help button to request Help for the User Archives Table Element.

7.6.5.4

Operating the Control using Dynamized Objects

Operating options
The User Archives Table Element offers you the option of shifting the functions of all the toolbar
buttons to self-defined buttons or I/O fields. You can define the size and appearance of each
of the buttons so that you can operate the Table Element say by using a touch screen.
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Example for using the "Press TB Button" attribute
You need to run the following steps to connect the User Archives Table Element with a button:
1. Create a button in the Graphics Designer and call it by right-clicking the object properties.
2. In the "Event" tab, select the Mouse option. Click in the right window to select "Mouse click".
After right-clicking the arrow in the "Action" column, you see a dialog box; select the "Direct
Connection" option.

3. In the "Source" area, select "Constants" and enter a constant here, for e.g. "Form" (see
further below for an overview of the constants available for the User Archives Table
Element).
4. In the "Target" area, click the "Object in Image" option and select the table element to be
linked in the Object Selection field. In the Properties box, select "PressTBButton" and
confirm the dialog by clicking OK.
5. Save the picture in the Graphics Designer and go to Runtime. When you now activate the
configured button "Form", the control display changes from the table view to the form view
and vice-versa.

Constants for direct link to the User Archives Table Element
For the above direct links to the User Archives Table Element you have one constant for each
button of the control. You can assign the individual buttons according to the following table.
Constant

Corresponding button

Form
Delete
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Constant

Corresponding button

New
Edit
First
Previous
Next
Load
WriteVar
ReadVar
Import
Export
Filter
Sort
Timezone
Print
Help

Note
While operating the table window using the keyboard, the cell cursor for the selected record
cell is no longer visible when you press the keys "Tab" and "Position 1". To bring back the
display to the last edited record, insert a button according to the steps mentioned above and
select the "VTB_Focus" constant. When you press this button, the cell cursor jumps back to
its last position.

See also
List of properties for the User Archives Table Element (Page 1776)
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7.6.5.5

List of properties for the User Archives Table Element

Overview
You can set the following properties for the user archives table control:
Attribute

Description

can be made dynamic

BackColor

Defines the background color of the table window in the user archives
table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

Border

Determines whether the form view of the User Archives Table Elements
in Runtime is displayed with or without a border.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"General" you can edit these settings.

no

Buttons

Defines that the pointers generated by the software of the buttons
activated in the toolbar are output.
In order to avoid inconsistencies in the database, the static of this attribute
must not be edited.

no

Caption

Defines the labeling of the title bar in the user archives table element.

no

Closable

Determines whether the user archives table element can be closed via
the "X" in the title bar.

no

Delete

Determines whether deletion processes are allowed in the user archives
table element in Runtime.

no

In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox for this in the area "Edit" on the "General" tab.
Filter

Defines filter conditions for the database. The conditions are formulated
in the database programming language SQL (Structured Query
Language).

yes, with the name
Filter

Example: FieldC>100
All data sets, which have a value greater than 100 in the "FieldC" column,
are selected.
You can also enter these filter conditions in the tab "Filter/Sort".
Form

Defines the view of the user archives table elements when starting in
Runtime:
Status "Yes": Outputs the form view
Status "No": outputs the table view.
You can also change these settings in the "General" tab

yes, with the name
Form

GridBackColor

Defines the background color of the data set in the user archives table
element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

GridFont

Defines the font in the user archives table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Fonts" you can edit these settings.

no
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Attribute

Description

can be made dynamic

GridForeColor

Defines the font color of the data set in the user archives table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

HeaderBackColor

Defines the background color of the header and the column with the
consecutive line number in the user archives table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

HeaderForeColor

Defines the font color of the header and the column with the consecutive
line number in the user archives table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

Insert

Defines whether entries can be made in the user archives table element. no
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox for this in the area "Edit" on the "General" tab.

LocaleSpecificSettings

Defines the language-specific response of the texts and fonts, which you
configure in the properties dialog.

yes, with the name
LocaleSpecificSettings

Value = "Yes": You can assign separate texts and fonts for each Runtime
language.
To do so, select a language in the "View/Language" menu of the Graphics
Designer and choose the desired font in the controls.
Value = "No": You cannot define language-specific texts and fonts.
The configuration of the control always applies to all available Runtime
languages.
Movable

Defines whether the user archives table element can be moved.

no

Name

Defines which user archive or which view is displayed.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the area
"Source" of the tab "General" you will see a selection of all configured
user archives and views.

no

PressTBButton

Connects all buttons of the toolbar of the table elements with self-defined
buttons or I/O fields.

yes, with the name
Press TB Button

PrintJob

Specifies which layout should be used for the print output.

no

PrintVisColsOnly

Defines whether only the currently visible columns should be printed in
draft print mode.

no

Read only

Defines whether the user archives table element can be edited or only
read in Runtime.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox for this in the area on the "General" tab.

no

SelBackColor

Defines the background color of the selected data set in the user archives
table element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1777

User archive
7.6 Before WinCC V7: WinCC User Archives Table Element
Attribute

Description

can be made dynamic

SelForeColor

Defines the font color of the selected data set in the user archives table
element.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the tab
"Colors" you can edit these settings.

no

SelectedID

Displays the ID of the data set selected in the control window.
SelectedID = "0": if no valid data set has been selected, e.g. during the
connection error
SelectedID = "-1", if the edit line is selected.

no

Sort

Defines the sorting conditions for the database. The conditions are
formulated in the database programming language SQL (Structured
Query Language).
You can also enter your filter conditions in the "Filter/Sort" Tab.

yes, with the name Sort

StatusbarDisabled

Defines whether the status bar in the user archives table element is
activated in Runtime.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox "Turn Off" for this in the area on the "Status Bar" tab.

no

StatusbarShowArc

Defines whether the archive name is shown in the status bar of the user
archives table element.

yes, with the name
StatusbarShowArc

StatusbarShowCol

Defines whether the consecutive number of the currently selected data
set column is shown in the user archives table element status bar.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. You can
change this setting in "Current column" in the "Status Bar" tab.

no

StatusbarShowRecord

Defines whether the field coordinates of the currently selected data set
column is shown in the user archives table element status bar.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. You can
change this setting in "Current Data Record" in the "Status Bar" tab.

no

StatusbarShowRow

Defines whether the consecutive number of the currently selected data
record line is shown in the user archives table element status bar.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. You can
change this setting in "Current Line" in the "Status Bar" tab.

no

StatusbarShowText

Defines whether the current status of the database is shown in the user
archives table element status bar.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. You can
change this setting in "Status text" in the "Status Bar" tab.

no

Titleline

Defines whether the title bar is shown in the user archives table element. no

TimeZone

Determines the time base used for the display of times in Runtime.
The time base is set via the following numeric values:
Value = 0: Apply project settings
Value = 1: Server's time zone
Value = 2: Local time zone
Value = 3: Coordinated Universal Time (UTC)

no

We recommend applying the default configuration "Apply Project
Settings". This means that the display is operated at same time zone as
the rest of the project.
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Attribute

Description

can be made dynamic

TimeZoneMark

Determines whether the column heading of the LastAccess field should
include the set time zone.
The following acronyms are used for the time zone:
LOC: Local time zone
UTC: Coordinated universal time
SVR: Server's time zone

no

ToolbarDisabled

Defines whether the toolbar in the user archives table element is activated
in Runtime.
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox "Turn Off" for this in the area on the "Toolbar" tab.

no

Type

Defines whether a user archive or a view is displayed in the user archives
table element
Value Type= 0: Stands for a user archive
Value Type= 1: Stands for a view.

no

In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. In the area
"Source" of the tab "General" you will see a selection of all configured
user archives and views.
Defines whether changes can be made in the user archives table element. no
In order to avoid inconsistencies in the database, the static of this attribute
should only be edited in the dialog box of the property dialog. There is a
checkbox for this in the area "Edit" on the "General" tab.

Update

7.6.5.6

Overview of the dynamizable properties in the layout

Filter
You can use the "Filter" property to define filter conditions for the database. The conditions
must be formulated in the database programming language SQL.
Format: SQL text
Tag type: Text Tag
Sort
You can use the "Sort" property to define sorting criteria for the database. The criteria must
be formulated in the database programming language SQL.
Format: SQL text
Tag type: Text Tag
TimeZone
Determines the time base used for the display of times in runtime.
Format: Number
Value

Description

0

Local time zone

1

Server Time Zone

2

Coordinated Universal Time (UTC)

3

Apply project Settings
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8.1

8

The functionality of Cross Reference

Introduction
The "Cross Reference" editor provides an overview of all tags, pictures, functions and layouts
that you have used in your project. When you open the editor, updated lists will be generated
automatically.
The search for tags takes place in the following editors:
● Graphics Designer
● Alarm Logging
● Tag Logging
● Global Script
● Report Designer
● User Archive
● Horn

Overview
Cross Reference offers the following functions:
● All referenced objects of the WinCC project are referenced in the list of project objects.
● You use filters to limit the display of project objects.
● The places of use of project objects are displayed in the list of places used.
● You can directly access the place of use of a project object to change or delete the object
there.
● For tags in pictures, you can use the "Link" function to change the names of one or several
tags, without any inconsistencies occurring in the project. You can search for and replace
individual characters in the tag names.
● You can search for the places of use of non-existing tags to change or delete the places
of use.
● You can find relationships between the existing process pictures of a project in order to
apply the existing structure of the process visualization for a project extension.
● You can print the list of the project objects and the places of use, or export or copy list
entries for further processing.
● If you change the configuration in the WinCC editors while Cross Reference is open, you
can update the lists manually.
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List of project objects
The listed project objects are differentiated by name, type and status.
The following types will be displayed:
● Process tags and internal tags
● Pictures, picture windows and WinCC controls
● Actions in pictures (C and VBS)
● Layouts (RPL files)
Project objects can have the following status:
Status of the project objects

Description

Used

Project objects that exist and are used in an object.

Not used

Project objects that exist but are not referenced in any object. Unused, existing tags are
not displayed in the list of places used.

Non-existing

Project objects that have a reference to a non-existing object, for example, a deleted tag
that is referenced in a picture.
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List of the places of use
The list contains:
● Names of the project objects
● WinCC editors and file names of pictures and scripts.
● Places of use in the files and editors
● Used objects in the files and editors.
● Used properties and actions in the files and editors. For pictures, the name of the property
is the "WinCC Automation Name" that you use to dynamize the property.
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Limitations for project objects
● In Cross Reference, configured messages will be searched for used variables. The search
for messages is not supported.
● The tags in the scripts are found only if they conform to the configuration rules for tag and
picture names. The configuration rule also applies to the linking of tags in C actions in
pictures.
● Cross Reference displays the places of use of objects exclusively in the context of WinCC.
Mapped WinCC tags are also displayed.
● The listing of standard objects, such as lines, and Windows objects in pictures is not
supported.
Note
Converting project data of pictures and layouts for projects prior to WinCC V7.3
Before you start Cross Reference, you have to convert certain data for projects that were
created prior to V7.3. In the WinCC Explorer, select the menu command "Convert project
data" in the "Options" menu. Select the check boxes "Pictures and faceplates" and "Page
and line layouts". Click "OK".
You can no longer use the XFC files.
The reference lists saved in the XFC files are no longer supported. They are not displayed
in WinCC Explorer. Create new filters and save these filters.
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8.2

How to filter the lists of the Cross Reference

Introduction
The lists of all project objects and all places of use are displayed after the start of "Cross
Reference". You use filter and selection to limit the listed objects.

How to filter list entries
Above the lists, an input box for the filter criterion is available for each column. The default
setting is "No filter" or
.
1. Start by filtering the list of project objects. Enter a letter string in the "Name" column and
press "Enter". The letter string you are looking for is highlighted in the listed names.
2. Limit the display of project objects further with the type or status.
3. If necessary, limit the entries in the list of places used further.
4. If you do not want to filter directly according to specific names in the list of places used,
use "File/Editor" to limit the display. Select an editor or enter a file name and press "Enter".

How to display the places of use for selected project objects
You can use a selection of project objects to define the entries in the list of places used. Only
the used objects are displayed in the list of places used.
1. In the list of project objects, select the entries whose places of use you want to display. Use
the mouse and keyboard to access all selection options in a list, for example:
– Select eight lines in a row
– Select the first and the fourth line with <CTRL> and the mouse
– Select all entries with <CTRL + A>.
between the tables. In the list of places used, only the entries of the selected
2. Click on
project objects will be displayed. Use the columns of the list to filter and further delimit the
list entries.
3. Click "Connect"

to once again display the complete or filtered list of places used.

Note
Number of maximum selected lines
To connect the selected entries, you cannot select more than 1,000 lines in the list of project
objects.
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8.3

How to jump to a place of use

Introduction
In the list of places used, you can jump to the corresponding WinCC editor of the project object.

Overview
The following table shows which editor is opened when jumping to the place of use:
Place of use

Editor

Action during jump to the place of use

Process value archive

WinCC Configuration
Studio / Tag Logging

Start of the editor. No further action

User archive

WinCC Configuration
Studio / User Archive

Start of the editor. No further action

Message
Limit monitoring

WinCC Configuration
Studio / Alarm Logging

Start of the editor. No further action

Project function
Standard function

Global Script

Start of the editor and display of the function

Picture object
OCX control

Graphics Designer

Start of the editor and focusing of the object

Layout

Report Designer

Start of the editor. No further action

Message Assignment
Signal Assignment

WinCC Configuration
Studio / Horn

Start of the editor. No further action

Procedure
1. Select the appropriate project object in the list of places used.
2. In the shortcut menu, select the "Go to" command or press the <F4> key.
The corresponding editor opens.

1786

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Working with Cross Reference
8.4 How to link tags in the pictures

8.4

How to link tags in the pictures

Introduction
Use the linking function to change the names of the tags in the places of use of the project
without inconsistencies arising in the names of the tags used. Only the names of tags in pictures
can be changed. You search for and replace individual or multiple characters in the tag names.

How to replace a tag name with another name
1. In the list of places used, select the tag name that you want to replace.
2. Select the "Link" command in the shortcut menu or in the "Edit" menu. The link dialog opens.
The selected tag is displayed in the "Tag name" column. The name is copied to the "Search
for" input box.

3. Enter the new name in the "Replace with" input box. Alternatively, click
from the tag management in the tag selection dialog.

to select a tag

4. Click "Preview". The new tag name is displayed in the "Preview" column.
5. To replace the name, click the "Apply" button. The linking of the tags is applied in the project.
If the new tag does not exist in the tag management yet, you must subsequently create the
tag.
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How to replace individual characters in multiple tag names
1. In the list of places used, select the tag names in which you want to replace characters.
2. Select the "Link" command in the shortcut menu or in the "Edit" menu. The link dialog opens.
The selected tags are displayed in the "Tag name" column.

3. In the "Search for" input box, select the characters that you want to replace. You are not
permitted to use wildcard characters.
4. Enter the new characters in the "Replace with" input box.
5. Click "Preview". The new tag names are displayed in the "Preview" column.
6. To replace the names, click the "Apply" button. The linking of the tags is applied in the
project. If the new tags do not yet exist in the tag management, you must subsequently
create the tags.
Note
Number of maximum selected lines
Do not select more than 10,000 lines in the list of places used for linking.
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8.5

How to export the lists of Cross Reference

Introduction
You can use the lists of Cross Reference in the editors outside of WinCC. Cross Reference
provides two options for this:
● You can export the lists in the "csv", "xml" or "xls" formats.
● Copying the selection of list entries.

How to export the lists
1. Click

and select the menu command "Edit > Export".

2. Select the options for the scope of export:
– Project objects: The list of project objects is exported.
– Places used: The list of places used is exported.
– Current context: The exports includes the entries that you have delimited via the filter.
– Selection only: Only the selected entries are exported.
3. Specify the format of the export file.
4. Use
to select the folder in which you want to save the export file. Enter an appropriate
name for the file.
5. Click "Export". The exported list is saved in the specified folder.

How to copy a selection of list entries
1. In one of the lists, select the entries that you want to copy. You can use all selection options
in a table with mouse and keyboard, for example, all columns, the first and the fourth
column, or the third row and the eighth row.
2. Select the "Copy" command in the shortcut menu.
3. Open an editor, such as Excel, and paste the copied data.
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Note
Number of maximum selected lines
Do not select more than 100,000 lines in the list of places used for copying.
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8.6

Example: Filtering and jumping to places of use

Introduction
The following example shows how you can use the filtering and the jump to place of use
functions to quickly modify the configuration. The example uses the WinCC demo project, but
customers can use other WinCC projects.
Initial situation
The demo project contains numerous project objects. For the example, you will use an
application from the project. In runtime you can find the application under "Applications/AST2/
Mining".

An explanatory text for the I/O fields is displayed in the picture. The display of the texts is
dynamized and you want to change the assigned tag. The objective is to use the filter to find
this tag with all places of use and to change a specific assignment of the tag there.
You can download the demo project at the following URL:
● WinCC demo project (http://www.siemens.com/automation/service&support)
In the "Search for product information" field, search for the search term "WinCC demo project".

Requirement
● You have opened the demo project.
● Alternatively, you can for example use one of your own WinCC projects and adapt the
procedure accordingly.
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Procedure
1. Open the "Cross Reference" editor. The updated lists show all of the project objects and
places of use of the project.
2. In the list of projects, write the text "tag" in the filter input box above the "Type" column.
3. Select "Used"

as filter for the status.

4. Click in the left table and press <CTRL + A>. All used tags are selected.
5. Click on

. The places used for all used tags are displayed in the list of places used.

6. In the list of places used, write the picture name in the filter input box above the "File/Editor"
column and press "Enter".
7. Write "StaticText" in the filter input box above the "Object" column and press "Enter". The
names of the tags and all places of use are displayed by the filtering.

8. Make a selection in the list of places used, for example, the first entry.
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9. In the shortcut menu, select the "Go to" command or press the <F4> button. The Graphics
Designer opens. The static text selected in the list will be selected in the picture. The
affected property is displayed in the object properties.

10.The green lamp in the object properties indicates the dynamics of the property via a tag.
11.Right-click on the green lamp. Select the command "Tag..." to select a different tag already
created in the tag selection dialog.
12.The new tag is now linked to the text at this place of use.
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See also
Internet: Service and Support (http://www.siemens.com/automation/service&support)
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8.7

Example: Linking of tags

Introduction
The following example shows the linking of tags in the WinCC demo project. Customers can
use this example or other WinCC projects.
Initial situation
The demo project contains numerous tags. To get a better overview of which tag belongs to
which picture in the project, the tag names should contain a part of the picture name. Using
the example of the demo page for "tag persistence", we want to change the name of the tags
"Data_Tag_1" to "Data_Tag_6 " in all places of use. The new names are
"Data_Tag_Persistence_1" etc.
You can download the demo project at the following URL:
● WinCC demo project (http://www.siemens.com/automation/service&support)
In the "Search for product information" field, search for the search term "WinCC demo project".

Requirement
● You have opened the demo project.
● Alternatively, you can, for example, use one of your own WinCC projects and adapt the
procedure accordingly.

Procedure
1. Open the "Cross Reference" editor. The updated lists show all of the project objects and
places of use of the project.
2. In the list of projects, write the text "tag" in the filter input box above the "Type" column.
3. Select "Used"

as filter for the status.

4. To find the entries with the tag name you are looking for, enter a part of the file name as a
filter using the "Name" column and press "Enter".
5. Select all entries with "Data_Tag_x".
6. Click on
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7. Click in the right table and press <CTRL + A>. All tags with "Data_Tag_x" will be selected.

8. Select the "Link" command in the shortcut menu. The link dialog opens. The selected tags
are displayed in the "Tag name" column.
9. Enter the string "Tag" in the "Search for" input box.
10.Enter the string "Tag_Persistence" in the "Replace with" input box.
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11.Click "Preview". The new tag names are displayed in the "Preview" column.

12.The linking of tags is applied in the project by means of the "Apply" button. If the new tags
do not exist in the tag management yet, you must create them subsequently.

See also
Internet: Service and Support (http://www.siemens.com/automation/service&support)
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8.8

Configuration instructions for tags and picture names in actions

Introduction
In Cross Reference you can filter the tags and picture names used in actions.
In the pictures you can also link the tags in the actions. To do this, you must structure scripts
as follows.

Overview
At the start of the script, declare all used tags and picture names in two sections.
The sections are structured as follows:
// WINCC:TAGNAME_SECTION_START
// syntax: #define TagNameInAction "DMTagName"
// next TagID : 4// to enter the next free ID
#define TAG_1 "name_1" // where "name_1" is the original tag name
#define TAG_2 "name_2"
#define TAG_3 "name_3"
// WINCC:TAGNAME_SECTION_END
// WINCC:PICNAME_SECTION_START
// syntax: #define PicNameInAction "PicName"
// next PicID : 4
#define PIC_1 "pict1.pdl"
#define PIC_2 "pict2.pdl"
#define PIC_3 "pict3.pdl"
// WINCC:PICNAME_SECTION_END
The standard functions for the reading or writing of the tags are called via the defined tags and
pictures.
GetTagDWord (TAG_1);
OpenPicture(PIC_1)
SetPictureName( PIC_2, "Picture Window1",PIC_3);
When you create a new action in the Graphics Designer, the corresponding prepared sections
will be inserted into the script.
You supplement existing scripts accordingly. The SmartTool "WinCC
CrossReferenceAssistant" supports you in this.
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Documentation of Configuration and Runtime Data

Introduction
Reports and logs are created in WinCC to document the configuration data and runtime data.
The layouts supplied by WinCC cover most of the cases in which you need to document data.
You can edit the supplied layouts or create new ones with the Report Designer.
The documentation of the configuration data and runtime data is language-dependent and
must be observed for multi-lingual WinCC projects. For more information see the chapter "Logs
for multi-lingual projects".

Overview
The documentation of configuration data or the project documentation serves to output
configuration data of a WinCC project in a report. You can output the reports in all Runtime
languages for multi-lingual projects.
The documentation of Runtime data or Runtime documentation serves to output process data
in a log in Runtime. For multi-lingual projects, the log is output in the currently set Runtime
language.
The dynamic objects of the Report Designer are used for the Runtime documentation. These
dynamic objects are associated with the corresponding applications. The dynamic objects are
supplied with the current values during output of the logs.
Selection of data for output is application-dependent and is carried out when the layout is
created, when the print job is created, or when printing is initiated. The current view or the table
content is output in the WinCC V7 controls and the corresponding layouts and print jobs.
Report Designer makes print jobs available for outputting the reports and logs. The scheduling,
output medium and extent of the output is defined in the print jobs.

Output Media
The reports and logs can be output:
● To a printer
● To a file
● To the screen
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Output Formats
The reports and logs can be output:
● with a page layout,
● with a line layout for the message sequence report.

Editors for the Layouts
Report Designer provides the page layout editor for editing page layouts. Both the page layouts
for the project documentation reports and the logs for Runtime documentation are configured
in the page layout editor.
Report Designer provides the line layout editor for editing line layouts. You configure the output
of the message sequence report in the line layout editor.

See also
Introduction to Runtime Documentation (Page 1840)
Introduction to Project Documentation (Page 1815)
How to Create Reports in Line Layout (Page 1803)
How to Set Up Reports in the Page Layout (Page 1801)
Reports for Multilingual Projects (Page 2179)
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9.2

How to Set Up Reports in the Page Layout

How the Areas of a Page Layout Are Divided Up
Page layouts are divided up geometrically into a number of different areas. The page range
corresponds to the total area of the layout. The print margins can be specified for this area. It
makes sense to begin by configuring the margins of the printable area for the header, footer
or a company logo and only then to configure the rest of the printable area for the output of
report data. The printable area inside the margins is referred to as the "body of the page".

The report and log layout contain a static layer and a dynamic layer. The static layer contains
the header and footer of a layout for outputting the company name, company logo, project
name, layout name, page number, time, etc. The dynamic layer contains the dynamic objects
for outputting the configuration and Runtime data.
In the static layer, only static and system objects can be inserted. In the dynamic layer, static
and dynamic objects can be inserted.
Objects that are inserted in the dynamic part of a page layout are extended dynamically, if
required. If an object of the type dynamic table is supplied with data, for example, this table is
extended to allow all data in the table to be output. If there are other objects in the dynamic
part of the layout, these are moved accordingly. Objects that are to have a fixed position must
therefore be inserted in the static part of the layout.

Pages in the Page Layout
Each page layout consists of three pages:
● Cover sheet
● Report contents
● Final page
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Cover sheet

The cover sheet is a fixed component of a page layout. It is therefore possible to design
a separate cover sheet for each report.

Report
contents

The structure and contents of the report for output are defined in this part of the page
layout. system objects available for defining the report contents.
The report contents have a static and a dynamic component (configuration layer).
If necessary, the dynamic part of the contents of the report is spread across the various
subsequent pages at output, since it is not known until the time of output how much
data there is.

Final page

The final page is a fixed part of a page layout. It is therefore possible to design a
separate final page for each report.

The creation and output of the cover sheet and final page are optional. By default, a cover
sheet is output, but a final page is not output. You edit a page layout in the page layout editor.
The cover sheet and final page also have a static and a dynamic component (configuration
layer).
Important:
If you use dynamic objects on the cover sheet or final page, only some of this data may be
included at output. This happens when the data of dynamic objects do not fit on a single page.
The cover sheet and final page only ever consist of a single page and never contain a page
break.

Displaying Layout Properties
You can display the properties of a page layout in WinCC Explorer.
1. If you select the Report Designer entry in the navigation window of WinCC Explorer, the
Layouts and Print Job subentries are displayed.
2. If you select the Layouts entry, all available layouts are displayed in the data window.
3. Select the Properties command from the pop-up menu of the relevant page layout. The
creation date and the data of the last change are displayed. If the layout is opened in the
page layout editor, the message "Currently being edited" is displayed.

See also
How to Create Reports in Line Layout (Page 1803)
Print Jobs in WinCC (Page 1805)
Introduction to Runtime Documentation (Page 1840)
Introduction to Project Documentation (Page 1815)
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9.3

How to Create Reports in Line Layout

How the Areas of a Line Layout Are Divided Up
Line layouts are divided up geometrically into a number of different areas. The page range
corresponds to the total layout area. The print margins can be defined for this area. It makes
sense to begin by configuring the margins of the printable area for the header and footer or
for a company logo and only then to configure the rest of the printable area for the output of
the log data. The printable area inside the margins is referred to as the "body of the page".

The line layouts contain a static layer and a dynamic layer. The static layer contains the header
and footer for outputting the company name, project name, layout name, etc. as pure text. The
dynamic layer contains a dynamic table for outputting Alarm Logging messages.

How a Page Is Divided Up
Each line layout consists of three areas:
● Header
● Log contents (table)
● Page footer
Header

The header is a fixed component of a line layout that is output together with every
page. A header in the line layout can consist of up to 10 lines. Graphics cannot be
inserted.

Log content
(table)

The structure and contents of the log for output are defined in this part of the line layout.
The Alarm Logging selection options and filter criteria for defining the contents of the
log are available to you for alarm output.
The design depends on the width of the individual columns and of the font size set.

Page footer

The footer is a fixed component of a line layout that is output together with every page.
A footer in the line layout can consist of up to 10 lines. Graphics cannot be inserted.
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The creation and output of a header and footer are optional. By default, 3 lines each are output
for the header and footer.

Use of the Line Layout
The layout in line format is used exclusively for the message sequence report. You edit it in
the line layout editor. For a line layout there is only one valid print job, which is integrated in
the WinCC on a fixed basis. In order to be output, the message sequence report must be
activated in the startup list of the computer carrying out the logging.

Displaying Layout Properties
You can display the properties of a line layout in WinCC Explorer.
1. If you select the Report Designer entry in the navigation window of WinCC Explorer, the
Layouts and Print Job subentries are displayed.
2. If you select the Layouts entry, all available layouts are displayed in the data window.
3. Choose the Properties command from the pop-up menu of the relevant line layout. The
creation date and the data of the last change are displayed. If the layout is opened in the
line layout editor, the message "Currently being edited" is displayed.

See also
How to Output Online Data with Message Sequence Report (Page 1858)
Print Jobs in WinCC (Page 1805)
How to Create a User-Defined Message Sequence Report (Page 1861)
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9.4

Print Jobs in WinCC

9.4.1

Print Jobs in WinCC

Introduction
Print jobs in WinCC are of central importance to the output of project and Runtime
documentation. In the layouts you configure the external appearance and data supply for
output. In the print jobs you configure the output medium, how much is to be printed, the time
at which printing is to start, and other output parameters.
For the output, each layout has to be linked to a print job. Various print jobs are provided in
WinCC for the purpose of project documentation. These system print jobs are already
associated with the corresponding WinCC applications. The system print jobs can therefore
not be deleted. If necessary, you can rename the system print jobs.
You can create new print jobs in WinCC Explorer in order to output new page layouts. A special
print job is provided in WinCC for outputting line layouts. Line layouts can only be output using
this print job. It is not possible to create a new print job for a line layout.

See also
Introduction to Runtime Documentation (Page 1840)
Introduction to Project Documentation (Page 1815)
How to Change Output Options in Runtime (Page 1848)
How to Change an Existing Print Job (Page 1821)
How to Create a New Print Job (Page 1819)
Print Job Properties (Page 1806)
Defining a Printer (Page 1811)
Selecting the Print Range (Page 1809)

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1805

Documentation of Configuration and Runtime Data
9.4 Print Jobs in WinCC

9.4.2

Print Job Properties

Introduction
You enter the name, the layout used, and the start parameters on the "General" tab. You also
set additional options that determine what happens when the print job is called on the "General"
tab.

Name of the Print Job
The name of the print job is displayed in the "Name:" field. You can rename a print job you
have just created in the "Name:" field . You cannot rename the system print jobs provided with
the product because they are associated directly with the different applications of WinCC.

Layout
There are line layouts and page layouts. In the "Layout file:" selection field you can select the
desired layout for the output.
Page layout
There are language-neutral and language-dependent line layouts. Further information can be
found in the "Creating Page Layouts" and "Setting Up Multilingual Projects" documents.
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Line layout
You can only select a line layout in the "@Report Alarm Logging RT Message sequence" print
job. Line layouts do not contain language-dependent text; thus, no language-dependent layout
files are needed.
Only in this job can the Line Layout for Line Printer option be selected. If the check box is
checked, then the message sequence report is output to the locally installed line printer. If the
check box is not checked, the message sequence report is output to a selectable printer in
page format.
The system print jobs provided and the layouts set in them are for outputting the project
documentation. Do not connect the system print jobs with other layouts, since otherwise the
project documentation will no longer function correctly.

Selection for print job list
The "Graphics Designer" editor contains an application window belonging to the reporting
system, the print job list. If this print job list is integrated into a WinCC picture, then the print
jobs for the configurations are displayed in Runtime and you can start the output. In the print
job list you can set the display of print jobs. The following views are available for selection:
● All print jobs
● System print jobs only
● User-defined jobs only
● Print jobs for which Selection for print job list option is selected
The "Selection for print job list" option allows you to compile a list of print jobs that you require
in Runtime.

Displaying the Parameter Dialog
To make Runtime documentation more flexible, a number of log parameters have been
dynamized. This allows you to change log output in Runtime. To do this, select the "Display
Parameter Dialog" option in the "Dialog" field. When the print job is called in Runtime, a
parameter dialog is called, in which you can change the parameters for output in Runtime.
This dialog also allows you to select or change the printer for output. You find more information
and a list of the relevant log objects in chapter Changing Output Options in Runtime.
Note
The system layouts and the self-configured layouts based on the "WinCC Control Runtime
Printprovider" layout have no protocol parameters that can be made dynamic. Thus, you
cannot edit the parameters of these layouts with the parameter dialog.

Calling the Printer Setup Options
To output logs in a page layout, you can change the printer for output in Runtime. To do this,
select the Printer Setup option in the Dialog field. When the print job is called in Runtime, a
dialog is called for selecting the printer.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1807

Documentation of Configuration and Runtime Data
9.4 Print Jobs in WinCC

Setting Start Parameter
In the Start Parameter area, you can set the start time and an output cycle. This setting is used
primarily to output logs regularly in Runtime documentation (e.g. for shift reports). The start
parameters are not required for project documentation, since project documentation is not
executed cyclically. The following print jobs are indicated by a different symbol in the list of
print jobs in WinCC Explorer:
● Print jobs for which start parameters are configured.
● Print orders for which a cyclical call is configured.

See also
How to Change Output Options in Runtime (Page 1848)
How to Change an Existing Print Job (Page 1821)
How to Create a New Print Job (Page 1819)
Defining a Printer (Page 1811)
Selecting the Print Range (Page 1809)
Print Jobs in WinCC (Page 1805)
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9.4.3

Selecting the Print Range

Introduction
On the Selection tab you can specify how much is to be printed. You can specify a selection
of the page range or a time range for the data to be output.

Note
If you print out online data using a message sequence log, all settings on the Selection tab
are deactivated.

Selecting a Page Range
In the Page Range area you can specify how much is to be printed at output. You can output
individual pages, a page range, or all pages.

Selecting a Time Range for the Data
You can use the Relative option to specify a relative time range for output (going back from
the print start time). For the relative time range, you have the following time intervals available:
All, Years, Months, Weeks, Days and Hours.
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The Absolute option allows you to specify an absolute time range for the data to be output.
Note
If the time range is configured in the layout of a print job, this setting has priority over the
settings in the print job. The selection of a time range is only relevant to Runtime
documentation in Alarm Logging and Tag Logging.
If filter criteria can be set for the selection of the output data, these filter criteria are taken into
account in addition to the settings in the Print Job Properties dialog. Exception: If filter criterion
DATETIME is used, the time range settings in the print job are ignored.
If the @ReportAlarmLoggingRT... print jobs are started via the button in the Alarm Control,
the settings from the layout and the print job are ignored, since the selection of the output
data is transferred from the Alarm Control.

See also
How to Change Output Options in Runtime (Page 1848)
How to Change an Existing Print Job (Page 1821)
How to Create a New Print Job (Page 1819)
Defining a Printer (Page 1811)
Print Job Properties (Page 1806)
Print Jobs in WinCC (Page 1805)
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9.4.4

Defining a Printer

Introduction
On the Printer Setup tab you can specify the printer or printers for output. You can use the lists
in the Printer Priorities area to specify the order in which they are to be used. You also specify
the settings for the print buffer and for output to a file here.

Output to a Printer
On the Printer Setup tab you can specify the printer or printers for output. The printers are
arranged in order of priority. Reports and logs are output to the printer set under 1.). If this
printer fails, they are automatically output to the printer set under 2.). The same procedure
applies to a third printer. If no printer is found that is ready for operation, the print data is saved
to a file on the hard disk. The files are stored in the project directory in the PRT_OUT folder.
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In the event of a printer failure, the operating system outputs an error message. In this case,
you have the following options:
1. Ignoring error message (Recommended)
Once printer is operational again, the pending messages (print jobs still in the spooler) will
be printed automatically.
2. Repeat
If the Repeat button is clicked, the operating system tries to output the print jobs in the
spooler again. This is only useful if the printer is ready for operation.
3. Cancel
If the Cancel button is clicked, the print job causing the error will be deleted. The print data
is thus lost. The operating system then tries to print the next print job in the spooler.
Note
It is strongly recommended that you acknowledge the message from the operating system
by clicking the Ignore button. If you click the Cancel button, all pending print jobs of the
printer that has failed are lost.
In the event of a fault affecting the line printer for the message sequence report, you can
disable the printer by clicking Cancel. You may have to restart the WinCC project to enable
the printer again.
The time taken to detect a printer failure depends on the configured timeout setting for
the printer connection. The timeout can be set by means of the properties for the printer
connection in the operating system.

Two substitute printers can also be configured for the line-based message sequence report.
The line printers must be connected to and installed on the computer carrying out the logging.
The switchover is takes place as described above. If no printer is found that is ready for
operation, a WinCC dialog is displayed in addition to the operating system message. The dialog
provides information on the status of the print job and outputs the printer's fault. The message
sequence report can be switched off in this dialog. If the message sequence report is switched
off in this dialog, it is switched on again automatically as soon as one of the configured printers
is ready for operation again.

Output to a File
If you like, you can output the reports and logs to a file. You find more information in the chapter
Creating a New Print Job.
Note
If you print a message sequence log in line layout, the output as a file is deactivated.
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Setting a Minimum Value for Disk Space
For log output there is a buffer area for output to a printer and a buffer area for output to a file.
On the Printer Setup tab you can configure two limit values for the free space on a disk for
each buffer area. If the limit values are violated, the following actions are triggered:
Limit value

Triggered Action

Generate
warnings

If the free disk space on the hard disk being used is below the value set here, an
entry is created in the WinCC_SStart_01.log file. If Runtime is activated, a system
message is generated. The message informs you about the imminent resource
bottleneck.

Discard trigger for
logging

If the free disk space on the hard disk being used falls under the value set here,
log triggering is rejected. In addition, an entry is created in the
WinCC_SStart_01.log file. If Runtime is activated, a system message is generated
that brings your attention to the lost log.

Recommendations and Limiting Conditions
● The timeouts for the printers should be kept low (approx. 10 seconds).
● Only one printer can be installed on each LPT port.
● When a computer is used for the line-based message sequence report, the substitute printer
must be configured in the print job of the message sequence report.
● Mixed use of line- and page-based message sequence reports is not supported. The
substitute printers must also be line printers.

Effect of the Printer Driver
When a report or a log is printed, the printout can be affected by the properties of the printer
driver used. If you have just installed a printer, it is advisable to check the first few printouts in
the preview.

Behavior and Time Requirements for Print Jobs
If there is a problem communicating with a WinCC component, a print job may hang at the
stage of reading data from the application, and it may not be possible for the user to cancel it.
A hung print job that is to print Runtime data is canceled after a waiting time of 30 minutes.
Data preparation for project documentation can take considerably longer. Project
documentation is therefore not canceled automatically.
If a print job stays in the printer spooler for longer than the specified time when there is an
error (no paper, for example), the output is automatically redirected to the next printer in
accordance with the specified printer priorities. The basic setting for the waiting time is 5
minutes. If there is no substitute printer configured or ready, the output is redirected to a file.
The file is stored in the project directory under Prt_Out$_<Jobname><DateTime>.
If a print job remains in the print spooler for longer than 13 minutes without its status changing,
it is assigned an error status. Automatic print redirection is then initiated after a further 5
minutes.
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See also
How to Change an Existing Print Job (Page 1821)
How to Change Output Options in Runtime (Page 1848)
How to Create a New Print Job (Page 1819)
Selecting the Print Range (Page 1809)
Print Job Properties (Page 1806)
Print Jobs in WinCC (Page 1805)
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9.5

Project Documentation

9.5.1

Introduction to Project Documentation

Introduction
In order to create project documentation in WinCC, you can start the output of the reports from
within the various WinCC editors. For this purpose, the editors are associated with print jobs,
which call a predefined layout for output. Default parameters for output are already set in the
predefined layouts. You can find more information on the output parameters in the the project
documentation of the various WinCC components.

Components from which project documentation can be called
You can start project documentation directly from the following components of WinCC:
● WinCC Explorer
● Graphics Designer
● Tag Management - WinCC Configuration Studio
● Alarm Logging - WinCC Configuration Studio
● Tag Logging - WinCC Configuration Studio
● Text Library - WinCC Configuration Studio
● User Administrator - WinCC Configuration Studio
● Horn - WinCC Configuration Studio
● Global Script
● Cross Reference
● Time Synchronization
● Picture Tree Manager
● Lifebeat Monitoring
● OS Project Editor
● Component List Editor
The reports for project documentation are output by the user. You can the following entries for
this in the File menu of the various WinCC components:
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Menu command

Function

Special features

Print Project
Documentation

Prints a report immediately. The layout set in
the print job will be used as the layout. The
printout is sent to the printer/file that is
configured in the "Print Job Properties" dialog.

A printer selection dialog is not displayed;
printing starts immediately. Depending on the
size of the project, this process can take
some time. The process cannot be canceled
while the data is being read from the system.

Opens a preview of the report to be output.

Depending on the size of the project, this
process can take some time. The process
cannot be canceled while the data is being
read from the system.

Set Up Project
Documentation

Opens the "Print Job Properties" dialog to set
the following:

Project Documentation Setup

You can find more information in sections
Print Jobs in WinCC and Changing an
Existing Print Job.

● The printer or file for printing

Project Documentation Print
Preview Project
Documentation
Project Documentation Preview

● The layout to be used
● The pages to be printed

See also
How to Create a New Print Job (Page 1819)
How to Change an Existing Print Job (Page 1821)
Print Jobs in WinCC (Page 1805)
How to Output Project Documentation (Page 1816)
How to Set Up Reports in the Page Layout (Page 1801)

9.5.2

How to Output Project Documentation

Introduction
The basic procedure for outputting project documentation is described below. You can use the
page layouts provided with the product for project documentation.

Procedure
1. Open the desired WinCC editor in the WinCC Explorer.
2. Select the "Print Project Documentation" or "Project Documentation - Print" command from
the File menu in the editor
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Alternative operation
If the print job used is known, you can start the project documentation directly:
1. Select the "Report Designer" entry in the navigation window of WinCC Explorer. The layouts
and print job are displayed in the data window.
2. Double-click the "Print Jobs" entry. All available print jobs are displayed.
3. Open the pop-up menu of the desired print job, and choose the Print the Print Job command.
Note
A printer selection dialog is not displayed by default; printing starts immediately. Depending
on the size of the project, this process can take some time. The process cannot be canceled
while the data is being read from the system.
In some editors the output of project documentation from the application differs from the
output of project documentation that is started directly via the print job in WinCC Explorer.
You can find more information on this in sections Project Documentation... for the various
WinCC editors.

Changing the output options
To change the printer or file for output, or to output a particular page range, you have to change
the settings in the Print Job Properties dialog. To do this, choose the Project Documentation
Setup... command from the File menu in the relevant editor. You can find more information on
this in section Changing an Existing Print Job.
To make changes to the contents of a report, you can edit or create page layouts and call them
in a print job. This allows you to design project documentation to suit your requirements. You
can find more information on this in section Changing Predefined Layouts.

See also
System Layouts for Project Documentation (Page 1884)
How to Change an Existing Print Job (Page 1821)
Project Documentation in the Component List Editor (Page 1838)
Project Documentation in the OS Project Editor (Page 1837)
Project Documentation in Lifebeat Monitoring (Page 1836)
Project Documentation in the Picture Tree Manager (Page 1835)
Project documentation in the horn (Page 1834)
Project Documentation in the Time Synchronization Editor (Page 1834)
Project Documentation in the User Administrator (Page 1832)
Project Documentation in the Text Library (Page 1831)
Project Documentation in Global Script (Page 1829)
Project Documentation in Tag Logging (Page 1828)
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Project Documentation in Alarm Logging (Page 1827)
Project Documentation in the Graphics Designer (Page 1824)
Project documentation in the WinCC Explorer/Tag Management (Page 1823)

9.5.3

How to Open a Project Documentation Preview

Introduction
You can open project documentation reports in a preview. This enables you to check that the
report meets your requirements before you print it.

Procedure
1. Open the desired WinCC editor in the WinCC Explorer.
2. Select the "Preview Project Documentation" or "Project Documentation - Preview"
command from the File menu in the editor

Alternative operation
1. Select the "Report Designer" entry in the navigation window of WinCC Explorer. The layouts
and print job are displayed in the data window.
2. Double-click the "Print Jobs" entry. All available print jobs are displayed.
3. Open the pop-up menu of the desired print job, and choose the Preview Print Job command.
The preview is opened.

Printing from the Preview
In the preview window you can print the report directly by clicking the Print... button. The print
settings from the associated print job are used for this.

See also
Project Documentation in the Text Library (Page 1831)
System Layouts for Project Documentation (Page 1884)
Project Documentation in the Component List Editor (Page 1838)
Project Documentation in the OS Project Editor (Page 1837)
Project Documentation in Lifebeat Monitoring (Page 1836)
Project Documentation in the Picture Tree Manager (Page 1835)
Project documentation in the horn (Page 1834)
Project Documentation in the Time Synchronization Editor (Page 1834)
Project Documentation in the User Administrator (Page 1832)
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Project Documentation in Global Script (Page 1829)
Project Documentation in Tag Logging (Page 1828)
Project Documentation in Alarm Logging (Page 1827)
Project Documentation in the Graphics Designer (Page 1824)
Project documentation in the WinCC Explorer/Tag Management (Page 1823)

9.5.4

How to Create a New Print Job

Introduction
In order to output a report to a printer or a file, the page layout used must be associated with
a print job. The options for output are specified in the print job.

Requirements
You must have specified a page layout that can output the desired data. This can be a
predefined WinCC layout or a layout you have created or edited yourself in which the desired
objects are integrated for data output.
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Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The
"Layouts" and "Print Job" entries are displayed in the data window.
2. Select the Print Jobs entry. Choose the New Print Job command from the pop-up menu of
the print job. A new print job called "Print Job001" is created. The number in the print job
name is incremented each time a new print job is created. After the print job is created, all
existing print jobs are displayed in the data window.
3. Select the newly created print job in the file window, and use the pop-up menu to open the
"Print Job Properties" dialog.
4. In input field "Name:" You can rename the print job. When you click "OK" to apply the
change, the print job is renamed and the previous name overwritten.
5. Under "Layout file:" Select the page layout using the selection field. The layouts are
provided with a symbol:
Icon

Description
Layout is language-dependent.
Layout files exist in all runtime languages. No language-neutral layout file exists.
Layout is language-dependent.
Layout files do not exist in all runtime languages. You can use the layout. If you change
to a runtime language, for which there is no layout file available, the English layout file
is used.
The layout is language-neutral. In Runtime, the language-neutral layout is always
printed, regardless of whether there are also language-specific layout files for the
selected layout.

1. Change to the "Printer Setup" tab, and select output to a printer or a file. It is also possible
to select both output types at the same time.
2. If you select output to a file, you have to specify a folder name in the Location text box. The
folder PRT_OUT is created in the project path of the WinCC project. A folder with the name
you entered is created in this folder, and a creation date and time are added to the folder
name. When output is started, the report is saved in this folder page by page in the form
of emf files.
3. Click the OK button to apply the settings.
4. Select the print job in the file window, and use the pop-up menu to start output.

Note
If you select output to a file, the data is saved in the form of EMF files. A documentation viewer
is provided for these files with the WinCC Smart Tools.
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Output options
On the Selection tab you can specify under Page Range whether you want to output all or only
some of the pages.
Note
The output type of the log is indicated in the file window of WinCC Explorer in the Type column
by the abbreviation (F), (F, P), or (P). (F) stands for output to a file, and (P) output to a printer.
If (F, P) is displayed, the log is output both to a file and a printer.
If a start time is configured in a print job, this print job is shown with the symbol in WinCC
Explorer.
If a cycle is configured in a print job, this print job is shown with the symbol in WinCC Explorer.

9.5.5

How to Change an Existing Print Job

Introduction
The layouts provided with WinCC are already associated with print jobs. The print jobs have
basic settings. The output options of these print jobs can be changed.
If a print job is renamed, the original print job is overwritten. Changes therefore cannot be
undone. A print job cannot be copied. It is therefore advisable to create a new print job to
prevent any unwanted changes being made to a system print job.
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Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed in the data window.
2. Double-click the "Print Job" entry in the data window. All existing print jobs are displayed
in the data window. Choose the Properties command from the pop-up menu of the desired
print job. The Print Job Properties dialog is displayed.
3. In the Name text box you can change the name of the print job. When you click OK to apply
the change, the print job is renamed and the previous name overwritten.
4. On the General tab, select the desired layout under Layout by using the selection dialog.
5. Change to the Printer Setup tab, and select output to a printer or a file. It is also possible
to select both output types at the same time.
6. If you select output to a file, you have to specify a folder name in the Location text box. The
folder PRT_OUT is created in the project path of the WinCC project. A folder with the name
you entered is created in this folder, and a creation date and time are added to the folder
name. When output is started, the report is saved in this folder page by page in the form
of emf files.
7. Click the OK button to apply the settings.
8. Select the print job in the file window, and use the pop-up menu to start output.
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To change the print job properties for project documentation, you can use the File/Project
Documentation Setup... command in the editor to call the integrated print job directly.
Note
If you select output to a file, the data is saved in the form of EMF files. A documentation viewer
is provided for these files with the WinCC Smart Tools.

Output options
On the Selection tab you can specify under Page Range whether you want to output all or only
some of the pages.
On the Printer Setup tab you can specify a number of printers for output. If the first printer
cannot be reached, the second printer is used. If this cannot be reached either, the third printer
is used.

9.5.6

Project documentation in the WinCC Explorer/Tag Management

Introduction
WinCC Explorer is prepared for project documentation.
The following commands are available in the "File" menu of the WinCC Explorer for this
purpose:
● Print Project Documentation
● Preview Project Documentation
● Project Documentation - Setup...
The following commands are available in the "File" menu in the "Tag Management - WinCC
Configuration Studio" for this purpose:
● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print
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Data for output
The following data are available for project documentation in WinCC Explorer:
Object

Output options

Function

Computer

-

Serves to output the name of the computer whose
data is to be documented.

Tags

Selection of tags
Selection of tag groups
Selection of tag parameters
Format

Serves to output tags, tag groups, and tag
parameters from the tag management system.
Formats the tag list.

Connections

Selection of connections in a
selection dialog.

Serves to output the configured connections to
subordinate controllers.

Elements of the standard project documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation Control Center

@mcpcs.RPL

Computers, tags, connections

Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.7

Project Documentation in the Graphics Designer

Introduction
Graphics Designer is prepared for project documentation. The following commands are
available in the File menu for this purpose:
● Print Project Documentation
● View Project Documentation
● Project Documentation Setup...
The print jobs for project documentation can be started from the menu of the WinCC component
or directly in WinCC Explorer. However, there is an important difference to note in the case of
Graphics Designer project documentation. When a print job is started in Graphics Designer,
the data of the open picture are output. If the print job is started in WinCC Explorer, the data
of all Graphics Designer pictures in the project are output. This applies to all documentable
parameters of Graphics Designer pictures.
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Data for Output
The following data are available for project documentation in Graphics Designer:
Actions in Graphics Designer
Object

Output options

Function

Info

The object is available for:
- Actions on the property
- Actions on the object

Serves to output general
information such as the picture
name, object name, and property
name.

Trigger description

The object is available for:
- Actions on the property

Serves to output the trigger type.

Source text

The object is available for:
- Actions on the property
- Actions on the object

Serves to output the source text of
an action.

Graphics Designer Picture Data
Object

Output options

Function

General display

Selecting Elements:
All available elements
The selected element

Serves to output the view of a
Graphics Designer picture in a
report.

Picture statistics

Selection of statistics data for
the picture

Serves to output statistics data on
a Graphics Designer picture.

Attributes

Selection of attributes
Selection of table data

Serves to output the attributes of a
Graphics Designer picture

Embedded objects

Object selection

Serves to output the embedded
objects in a Graphics Designer
picture.

Actions

Selection of action types

Serves to output the actions in a
Graphics Designer picture.

Trigger

Object selection
Selection of actions

Serves to output the triggers for the
actions in a Graphics Designer
picture.

Source text

Selection of actions

Serves to output the source text of
actions in a Graphics Designer
picture.

Direct connections

Selecting Elements:
All available elements
The selected element

Serves to output the direct
connections in a Graphics Designer
picture.
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Graphics Designer Object Data
Object

Output options

Function

Object statistics

Object selection
Selection of statistics on the
object

Serves to output statistics data on
objects in a Graphics Designer
picture.

Attributes

Object selection
Selection of attributes
Selection of table data

Serves to output the attributes of
objects in a Graphics Designer
picture.

Actions

Object selection
Selection of actions

Serves to output the actions on
objects in a Graphics Designer
picture.

Trigger

Object selection
Selection of actions

Serves to output the triggers for the
actions on objects in a Graphics
Designer picture.

Source text

Object selection
Selection of actions

Serves to output the source text of
actions for the selected objects.

Direct connection

Object selection

Serves to output the direct
connections of objects

Points to Note About Object Data Output
● Control-Object slider:
The following applies to the PictureBack and PictureThumb attributes in project
documentation:
If there is no picture entered, a hyphen (-) is output in the project documentation.
If a picture is entered, "none" is output.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.
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Print job

Layout used

Objects contained

@Documentation Graphics
Designer Dynamics

@PDLPicDyn.RPL

Nested layout for outputting the
dynamization data of a Graphics
Designer picture.

@Documentation Graphics
Designer Overview

@PDLPicOvr.RPL

Picture statistics, general display.

@Documentation Graphics
Designer

@PDLPic.RPL

Nested layout for outputting the
general display, statistics data,
objects in the picture, picture
attributes, actions on the picture,
direct connections to the picture,
object statistics, attributes of the
objects, actions on the objects, and
direct connections to objects. The
data is output on a separate page
for each picture.
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Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.8

Project Documentation in Alarm Logging

Introduction
The Alarm Logging editor is prepared for project documentation.
The following commands are available in the "File" menu in the "Alarm Logging - WinCC
Configuration Studio" for this purpose:
● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print

Data for output
The following data are available for project documentation in Alarm Logging:
Object

Output options

Function

Message classes

-

Serves to output the existing message classes with
their properties.

Messages

Selection of messages

Serves to output the selected messages with their
properties.

Archives

-

Serves to output the existing message archives with
their properties.

Data of the message blocks:
Object

Output options

Function

System blocks

-

Serves to output the existing system blocks with their properties.

User text blocks

-

Serves to output the existing user text blocks with their properties.

Process value blocks

-

Serves to output the existing process value blocks with their
properties.
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Data of the message groups
Object

Output options

Function

Message class

-

Serves to output the message groups of message
classes.

Message groups

-

Serves to output message groups.

Elements of the standard project documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation Alarm
Logging

@AlgCS.RPL

Message blocks, message classes, messages,
message groups, archives, and logs

Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects. You can find a description of the selection of messages in section
"Changing Output Options for Messages from Alarm Logging CS".

9.5.9

Project Documentation in Tag Logging

Introduction
The Tag Logging editor is prepared for project documentation.
The following commands are available in the "File" menu in the "Tag Logging - WinCC
Configuration Studio" for this purpose:
● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print

Data for output
The following data are available for project documentation in the Tag Logging editor:
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Object

Output options

Function

Timers

-

Serves to output the existing timers with their properties.
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Data of the archives
Object

Output options

Function

Process value archive

Archive names
Process value
archive data

Serves to output the configuration data of process
value archives

Compressed archive

Archive names
Process value
archive data

Serves to output the configuration data of
compressed archives

Process value archive
tag

Tag
Tag data

Serves to output configuration data of the selected
process value archive tags

Compressed archive
tag

Tag
Tag data

Serves to output configuration data of the selected
compressed archive tags

Elements of the standard project documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation Tag
Logging

@tlgcs.RPL

Message blocks, message classes, single messages,
group messages, archives, and logs

Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.10

Project Documentation in Global Script

Introduction
There are two editors available in Global Script, the C editor and the VBS editor. Both of these
editors are prepared for project documentation. If you open an action, a function, or a module
in one of these editors, the following commands are available to you in the File menu of the
editor:
● Print Project Documentation
● View Project Documentation
● Project Documentation - Setup...
The output applies to the open function, action, or module.
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Documentation of all actions, project functions, and standard functions can be output by means
of three of the print jobs listed below. The output is started in WinCC Explorer.
The same predefined layouts are used to output the project documentation in the C editor and
the VBS editor. The identifier Language: C Script or Language: VB Script is output in the
information box at output. This indicates which of the two editors the documentation comes
from.
Note
The documentation of all actions, functions, and modules can be very extensive. To check
the number of pages, open the print preview of the print job, and check the page number
there (format: page 1 of x).

Data for Output
The following data are available for project documentation in the Global Script editor:
Object

Output options

Function

Info

The object is available for:
- Actions
- Standard functions
- Project functions
- Standard modules
- Project modules

Serves to output general
information such as who it was
created/changed by, the creation
date, data of change, version, and
a comment.

Trigger description

The object is available for:
- Actions

Serves to output the trigger type.

Source text

The object is available for:
- Actions
- Standard functions
- Project functions
- Standard modules
- Project modules

Serves to output the source text of
an action/function or a module.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.
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Print job

Layout used

Objects contained

@Documentation Global Script
Project Function

@GSC_RPFC.RPL

Nested layout for outputting the
information and source text of the
project functions. Output is started
in WinCC Explorer.

@Documentation Global Script
Standard Function

@GSC_RSFC.RPL

Nested layout for outputting the
information and source text of the
standard functions. Output is
started in WinCC Explorer.
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Print job

Layout used

Objects contained

@Internal Global Script Action

@GSC_ACT.RPL

Layout for outputting information, a
trigger description and the source
text for an action open in the C
editor or VBS editor or a module
open in the VBS editor.

@Internal Global Script Project
Function

@GSC_PFC.RPL

Layout for outputting information
and the source text for a project
function open in the Global Script
editor.

@internal Global Script
Standard Function

@GSC_SFC.RPL

Layout for outputting information
and the source text for a standard
function open in the Global Script
editor.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.11

Project Documentation in the Text Library

Introduction
The Text Library is prepared for project documentation.
The following commands are available in the "File" menu in the "Text Library - WinCC
Configuration Studio" for this purpose:
● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print

Data for output
The following data are available for project documentation in the Text Library:
Object

Output options

Function

General data

-

Serves to output the configuration data of
the Text Library.

Text table

Language selection for selecting the
languages for output

Serves to output the texts from the Text
Library.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1831

Documentation of Configuration and Runtime Data
9.5 Project Documentation

Elements of the standard project documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.
Print job

Layout used

Objects contained

@Documentation Text @Textlibrary.RPL General data and text table. The texts of the different
Library
languages are output line by line one after the other.

Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.12

Project Documentation in the User Administrator

Introduction
The User Administrator editor is prepared for project documentation.
The following commands are available in the "File" menu in the "User Administrator - WinCC
Configuration Studio" for this purpose:
● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print

Data for output
The following data are available for project documentation in the User Administrator editor:
Object

Output options

Function

Groups

-

Serves to output the user groups from the User Administrator.

functions

-

Serves to output the texts from the configured functions from the User
Administrator.

Elements of the standard project documentation
A predefined page layout and a print job are supplied with for the project documentation.
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Print job

Layout used

Objects contained

@Documentation User Administration

@UACS.RPL

Groups and functions
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Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.13

Project documentation in the Cross Reference

Introduction
The "Cross Reference" editor supports project documentation. The following commands are
available in the File menu for this purpose:
● Print Project Documentation
● Project Documentation view
● Set up project documentation
Set the focus on the list in the Cross Reference that you want to print out.
Note
Do not call print jobs directly from the WinCC Explorer
The system print jobs are designed only for internal use. Do not call these print jobs directly
from the WinCC Explorer, as the required data supply is missing. Select "Print" or "Print
project documentation" in the Cross Reference.

Elements of Standard Project Documentation
The following predefined page layouts and print jobs are provided with WinCC for project
documentation.
Print job

Layout used

Objects contained

@XREFPrintSrc

@XREFPRINTSRC.RPL

Entries in the list of project
objects

@XREFPrintRef

@XREFPrintRef.RPL

Entries in the list of places of
use

See also
How to Create a New Print Job (Page 1819)
How to Open a Project Documentation Preview (Page 1818)
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9.5.14

Project Documentation in the Time Synchronization Editor

Introduction
The Time Synchronization editor is prepared for project documentation. The following buttons
are available in the editor's dialog:
● Printing
● Preview
● Setup

Data for Output
The following data are available for project documentation in the Time Synchronization editor:
Object

Output options

Function

Devices

-

Serves to output the devices and services used.

General

-

Serves to output the general settings in the Time Synchronization editor.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation Time
Synchronization

@TimeSync(landscape).R
PL

HornTags, general settings, horn signals,
and additional reset tags.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.15

Project documentation in the horn

Introduction
The horn is prepared for project documentation.
The following commands are available in the "File" menu in the "Horn - WinCC Configuration
Studio" for this purpose:
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● Project Documentation - Setup
● Project Documentation - Preview
● Project Documentation - Print

Data for output
The following data are available for project documentation in the horn:
Object

Output options

Function

HornTags

-

Serves to output the assignment of tag and message class.

General settings

-

Serves to output the general settings in the Audio Alarm
Editor.

Horn signals

-

Serves to output the assignment of signals or signal modules
to tags.

Additional reset tags -

Serves to output multiple acknowledgment via additional
acknowledgment tags.

Elements of the standard project documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation
Horn

@Horn(landscape).RP
L

HornTags, general settings, horn signals, and
additional reset tags.

Changing the output options
You can find more information on how to create a report in sections Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.16

Project Documentation in the Picture Tree Manager

Introduction
The Picture Tree Manager is prepared for project documentation. The following commands
are available in the File menu for this purpose:
● Print Project Documentation Hierarchy
● View Project Documentation Hierarchy
● Setup Project Documentation Hierarchy...
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● Print Project Documentation Group display
● View Project Documentation Group Display
● Project Documentation Group Display Setup...

Data for Output
The following data are available for project documentation in Picture Tree Manager:
Object

Output options

Function

PTN table

-

Serves to output the configured container hierarchy and
the pictures it contains.

Group displays table

-

Serves to output the configuration data of the Group
Display.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.
Print job

Layout used

Objects contained

@Documentation Picture Tree Manager

@ptmcs.RPL

Picture Tree Manager table

@Documentation Signal Collection

@SCollect.RPL

Group displays table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

See also
How to Output Project Documentation (Page 1816)

9.5.17

Project Documentation in Lifebeat Monitoring

Introduction
The Lifebeat Monitoring editor is prepared for project documentation. The following commands
are available on the File menu for this purpose:
● Printing
● View
● Printer Setup...
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Data for Output
The following data are available for project documentation in the Lifebeat Monitoring editor:
Object

Output options

Function

Lifebeat
Monitoring
table

-

Serves to output the configuration data from Lifebeat Monitoring.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation Lifebeat Monitoring

@lbmcs.RPL

Lifebeat Monitoring table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

9.5.18

Project Documentation in the OS Project Editor

Introduction
The OS Project Editor is prepared for project documentation. The following buttons are
available for it on the General tab:
● Printing
● View
● Printer Setup...

Data for Output
The following data are available for project documentation in the OS Project Editor:
Object

Output options

Function

ProjectEditor table

-

Serves to output the coordinate settings of the monitor,
overview area, working area, and key area.

TopField table

-

Serves to output the settings for the display of circular
pictures in the Runtime window.

TopfieldConfig2
table

-

Serves to output the settings for the display of group pictures
and general pictures in the Runtime window.

TopfieldConfig3
table

-

Serves to output the settings for the display of trend groups
in the Runtime window.
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Object

Output options

Function

AlarmConfig table

-

Serves to output the settings for the display of the small alarm
window.

AreaButton table

-

Serves to output the settings for the buttons for switching
between areas.

HiddenArea table

-

Serves to output the settings for hidden areas.

RestData table

-

Serves to output the general settings in the OS Project Editor.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation OS
Projecteditor

@Projecteditor.RP
L

ProjectEditor table, TopField table, TopfieldConfig2
table, TopfieldConfig3 table, AlarmConfig table,
AreaButton table, HiddenArea table, and RestData table.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.

9.5.19

Project Documentation in the Component List Editor

Introduction
The Component List Editor is prepared for project documentation. The following commands
are available in the File menu for this purpose:
● Project Documentation Setup...
● View Project Documentation
● Print Project Documentation

Data for Output
The following data are available for project documentation in the Component List Editor:
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Object

Output options

Function

Attribute table

-

Serves to output information on the connections between internal
IDs and texts for display in the Component List Editor.

Measuring
point table

-

Serves to output the type, entry point picture (Loop In Alarm),
and area assignments of a component and their designations.
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Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.
Print job

Layout used

Objects contained

@Documentation LTO
Component List

@LTO
Bausteinliste(landscape).RPL

Attribute table, measuring point
table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and
Working with Objects.
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9.6

Runtime Documentation

9.6.1

Introduction to Runtime Documentation

Introduction
A number of options are available for logging Runtime data in WinCC. The WinCC controls
have a button for output of the runtime data logs. You can also output runtime date outside of
the WinCC controls, for example, data from the user archives with the
"CCAxUserArchiveControl" report object.

Overview
The following WinCC controls have a configurable interface for the log output:
● WinCC OnlineTableControl
● WinCC OnlineTrendControl
● WinCC FunctionTrendControl
● WinCC RulerControl
● WinCC AlarmControl
● WinCC UserArchiveControl
Note
As of WinCC V7, the "Print message report" button is no longer available in the
AlarmControl.
For the independent logging of Runtime data, you must configure the corresponding layouts
in Reports Designer and connect them with a print job.
For the "WinCC Control Runtime Printprovider" layout, you configure only the basic properties
of the layout in Report Designer. The report parameters for the output are determined by
properties of the WinCC control and cannot be made dynamic. Configure the static and
dynamic report parameters for all other runtime documentation layouts.
You specify scheduling and how much is to be printed in the print job associated with the layout.
You can re-use one layout for several print jobs, for example, for output on different media or
with a different time selection of the data.
The print jobs can be called up as follows:
● with a configurable button in WinCC controls
● with a configurable button in a WinCC picture
● with the "print job list" application window in a WinCC picture
● with a configured cycle in the print job
● with configured start parameters in the print job
● with a script function
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Report objects for the runtime documentation
You can output the runtime data with the following WinCC report objects:
WinCC Control Runtime Printprovider
Report object

Function

Table

The entire contents of the table of the control is output in the table. The output of the
report object depends on the display of the control in Runtime and is only initiated
using the button in the control. You cannot dynamize report parameters. The report
object is not available for the WinCC OnlineTrendControl and WinCC
FunctionTrendControl.

Text

In addition to the "Table" and "Picture" report objects, the window caption, the name
and the picture name of the control is output.

Picture

The current control display is output in the picture. The output of the report object
depends on the display of the control in Runtime and is only initiated using the button
in the control. You cannot dynamize report parameters.

Note
The Runtime data of a WinCC RulerControl and of an interconnected WinCC control can be
output in a single report. Insert two report objects of "WinCC Control Runtime Printprovider"
in the page layout; for example, a "picture" for OnlineTrendControl and a "table" for
RulerControl. In the properties of the RulerControl report object you must activate the "WinCC
RulerControl" option on the "Link" tab.
CCAxAlarmControl
Report object

Function

Table

The table outputs the contents of the alarm control from outside the WinCC
AlarmControl. You configure the properties of the control and the dynamic
parameters for output in the Report Designer.

CCAxFunctionTrendControl
Report object

Function

Table

The table outputs the contents of the FunctionTrendControl from outside the WinCC
FunctionTrendControl. You configure the properties of the control and the dynamic
parameters for output in the Report Designer.

CCAXOnlineTableControl
Report object

Function

Table

The table outputs the contents of the OnlineTableControl from outside the WinCC
OnlineTableControl. You configure the properties of the control and the dynamic
parameters for output in the Report Designer.
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CCAXOnlineTrendControl
Report object

Function

Table

The table outputs the contents of the OnlineTrendControl from outside the WinCC
OnlineTrendControl. You configure the properties of the control and the dynamic
parameters for output in the Report Designer.

CCAxUserArchiveControl
Report object

Function

Table

The table outputs the contents from the user archives outside the WinCC
UserArchiveControl. You configure the properties of the WinCC UserArchiveControl
and the dynamic parameters for output in the Report Designer.

WinCC Online Table Control (Classic)
Report object

Function

Table

The table contains the contents of the tags from the process value archives and
compressed archives. You configure the static and dynamic parameters of the
WinCC Online Table Control (Classic) for output in the Report Designer.

WinCC Online Trend Control (Classic)
Report object

Function

Picture

The contents of the tags from process value archives and compressed archives are
output in trend form in the picture. You configure the static and dynamic parameters
of the WinCC Online Trend Control (Classic) for output in the Report Designer.

WinCC Function Trend Control (Classic)
Report object

Function

Picture

The picture shows the process values as a function of another tag from process value
archives, compressed archives or user archives in trend format. You configure the
static and dynamic parameters of the WinCC Function Trend Control (Classic) for
the output in the Report Designer.

WinCC Alarm Control (Classic)
Report object

Function

Table

The message lists are output in the table. In contrast to the "Message report" and
"Archive report" report object, all message lists are accessed. You configure the
static and dynamic parameters of the WinCC Alarm Control (Classic) for output in
the Report Designer.

User archive runtime
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Report object

Function

Table

The table contains the contents of the user archives.
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Alarm Logging Runtime
Report object

Function

Message Report

The message report outputs all messages in the current message list in Alarm
Logging.

Archive report

The archive log serves to output messages that are stored in the message archive.

Further Runtime Documentation Options
Logging of CSV Files
Report object

Function

CSV provider
table

The CSV provider table logs data from a file in CSV format. The data is output in
table form.

CSV provider
trend

The CSV provider trend logs data from a file in CSV format. The data is output in
trend form.

Logging Data by Means of ODBC
Report object

Function

ODBC database field

Serves to output data from a data source field by means of ODBC. The data
is output as text.

ODBC database table Serves to output data from a data source table by means of ODBC. The data
is output in table form.

Logging of Own COM Servers
Report object

Function

COM server

The COM server object allows you to integrate your own COM object in WinCC and
log the data from this object. The COM object can be in the form "Text", "Table" or
"Picture".

Output of a Hard Copy
Report object

Function

Hard copy

Serves to output the current screen content, a part of it or a currently selected picture
window.
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The hardcopy can also be output with the "PrintScreen" application. You find more information
in chapter How to Output a Hard Copy.
Note
Simultaneous printing of identical log objects
When you create a layout with the same log objects of the Runtime documentation, you must
open the properties dialog for each of the same log objects, set the required parameters and
confirm your entries with "OK". This action ensures that all identical log objects are printed
simultaneously.

Dynamic log parameters
You can influence the logging of runtime data before the output by using dynamic logging
parameters, for example, through scripts. In addition to a configured value, you can configure
WinCC tags from which the parameters are taken for output in Runtime.
To change the parameters for output immediately before you start printing, a dialog for
changing the log parameters can be displayed. The display of this dialog can be controlled by
the respective print job. The Configuration Dialog option must be set in the Dialog field on the
General tab.

See also
How to Create Layouts for Runtime Documentation (Page 1844)
How to Create Reports in Line Layout (Page 1803)
How to Set Up Reports in the Page Layout (Page 1801)

9.6.2

How to Create Layouts for Runtime Documentation

Introduction
You create new layouts or adapt existing ones for Runtime documentation. First you save a
layout supplied by WinCC under a new name before you change the layout. This way you can
always access these layouts again.
Specify in the layouts,
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● which data is logged in Runtime.
● the output form.
● whether the output can be changed before printing starts.
Note
The system layouts and system print jobs included in the scope of delivery are used by
the WinCC components. This means you may not delete the system print jobs. If
necessary, you can rename the system print jobs. Changes to the dynamic part of system
layouts affect logging in Runtime. The system layouts can be identified by the prefix "@"
in the layout name.

Editing a Layout
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed.
2. First double-click the "Layouts" entry in the file window and then the desired language. All
existing layouts for the language are displayed in the file window.
3. Select a layout according to the required output. Double-click to use the pop-up menu to
open the layout. The page layout editor is opened to allow you to edit the layout. You find
a list of the layouts provided for Runtime documentation in the appendix.
4. Select the first report object in the open layout and open the properties dialog by doubleclicking it or using the pop-up menu.
5. In the properties dialog, select the "Connect" tab and then the report object in the left
window. The list of things you can do is displayed on the right.
6. As of WinCC V7 use the "WinCC Control Runtime Printprovider" layout for output of the
data form the controls. The output depends on the representation of the controls in Runtime.
Define the control elements for the "Table" and "Picture" report objects to be excluded from
printing in the "Connect" tab. If you want to output a RulerControl via the report object,
activate the "WinCC RulerControl" option.
7. If you use the report objects prior to WinCC V7, open the dialogs for setting parameters
and dynamization on the "Connect" tab. You find a description of the possible output options
for the various objects in chapter Working with Objects for Runtime Documentation.
8. Select the next report object in the layout and repeat steps 4 to 7.
9. Modify the external form of the object, if necessary, by changing the attribute values on the
"Properties" tab.
10.Save the changes and close the layout.
11.Then edit the associated print job.
Please also note the behavior of dynamic tables during output. You find more information on
this in chapter Changing Predefined Layouts.

Alternative Procedure
You can also create new layouts for Runtime documentation and use them for logging. A newly
created layout must be connected with a print job for the output. You can use an existing print
WinCC: Working with WinCC
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job or create a new one. The system print jobs provided are used for the log functions integrated
in WinCC. This means you should only use a system print job if you want to use a self-defined
layout instead of the preset system layout.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
How to create print jobs for the Runtime documentation (Page 1846)
How to Change Output Options in Runtime (Page 1848)
Changing Predefined Layouts (Page 1930)

9.6.3

How to create print jobs for the Runtime documentation

Introduction
Predefined print jobs are provided with WinCC for logging Runtime data. These system print
jobs are used by various WinCC components for Runtime documentation. The system print
jobs can therefore not be deleted. If necessary, you can rename the system print jobs.
When you use system print jobs for Runtime documentation, you can specify output options,
how much is to be printed, and the layout to be used. Additional information can be found in
the chapter "Print Jobs in WinCC".
For user-defined Runtime documentation you can create new print jobs and configure their
calls. In this way, you can output Runtime data without negatively affecting the preset log
functions.
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Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed.
2. Double-click the Print Jobs entry in the data window. All existing print jobs are displayed in
the data window. Choose the Properties command from the pop-up menu of the desired
print job. The Print Job Properties dialog is displayed. You find a list of the print jobs provided
for Runtime documentation in the appendix.

3. Use the three tabs in the dialog to set the parameters of the print job. Additional information
can be found in the chapter "Print Jobs in WinCC".
4. To create a new print job, select the Print Jobs entry in the navigation window of WinCC
Explorer, and choose the New Print Job command from the pop-up menu. A new print job
is created with a consecutive number in its name. To assign parameters, proceed as
described above.

Online Logs for a Client Without Project
If you wish to output Runtime logs in a distributed system using a client without its own project,
you must activate the option Report Runtime in the startup list of this client.
In addition, you must set the parameter /CLIENT for Report Runtime. In the startup list, select
the application Report Runtime and click the Edit... button. Add the necessary parameters in
the Parameters entry field.
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If cyclic print jobs are supposed to be excluded from the output, add the /NO_CYCLE parameter
to the Parameters entry fields.

See also
Reporting Messages in Runtime (Page 1856)
Print Jobs in WinCC (Page 1805)
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Data from Other Data Sources (Page 1865)
Reporting Process Values in Runtime (Page 1862)
How to Change Output Options in Runtime (Page 1848)
How to Output Online Data with Message Sequence Report (Page 1858)

9.6.4

How to Change Output Options in Runtime

Introduction
To make Runtime documentation more flexible, a number of log parameters can be dynamized.
This way you can change the report output in Runtime.
The report parameters for output from the WinCC V7 controls are determined by the properties
of the WinCC Control and cannot be dynamized in the Report Designer. You can also output
Runtime data outside of WinCC controls, for example, data from the user archives with the
"CCAxUserArchiveControl" report object. You can change the properties and the dynamic
parameters in the Report Designer for this purpose.

1848

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Documentation of Configuration and Runtime Data
9.6 Runtime Documentation

How to change the parameters for report objects
You can change the parameters in two different ways:
● Connect the dynamizable parameters with WinCC tags. For a print job, the assigned WinCC
tags are provided with the current values in Runtime.
You configure the value supply of the WinCC tags with:
– Scripts
– Input fields and output fields in a WinCC picture
– Configured buttons with fixed values
– Process-controlled actions
– The supply through other applications of WinCC.
An overview of the Runtime documentation parameters that can be dynamized is included
in chapter Dynamizable Parameters for Runtime Documentation.
● When starting a print job you can open a parameterization dialog that lists all dynamic report
elements. A configuration dialog appears when you double-click a parameter; in it you can
change the settings for the current output. If WinCC tags are configured to the report
objects, the tags are read out and the values entered in the associated fields of the static
parameters. The tag fields themselves are deactivated and cannot be changed in Runtime.

How to dynamize the parameters for report objects
1. Open the desired layout in the page layout editor and call the object properties dialog of
the log object.
2. In the Object Properties dialog, select the Connect tab and then the log object in the left
section of the tab. The list of things you can do is displayed on the right.
3. Double-click to open the Dynamizable Parameters configuration dialog. The object
properties that can be dynamized are shown in the parameter list.
4. In the list of properties, select the parameter you want to dynamize.
5. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.
6. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
7. Apply the settings by clicking OK and save the layout.
8. Before the log is started in Runtime, the WinCC tag must be supplied with values.

How to dynamize the parameters with other report objects of Runtime documentation
1. Open the required layout in the page layout editor.
2. Call up the object properties dialog of the report object.
3. Activate the "Connect" tab in the object properties dialog and select the report object in the
left window. The list of things you can do is displayed on the right.
4. In the list of things you can do, open the configuration dialog by means of a double-click or
the pop-up menu.
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5. Select the Tag check box for the parameter to be dynamized, and click the folder button.
The tag selection dialog is displayed.
6. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
7. Accept the changes with "OK" and save the layout.
8. Before the log is started in Runtime, the WinCC tag must be supplied with values.

How to dynamize the report parameters with the configuration dialog
You can change the report parameters in Runtime in the configuration dialog. The configuration
dialog displays the object names of the report objects. Assign meaningful names to the report
objects. Otherwise, the objects are displayed in the configuration dialog with the standard
names assigned by WinCC, e.g. "Dynamic table 1". A numbered selection of dynamic tables
is then displayed in the configuration dialog, which is not suitable if the user wants to make a
specific selection.
1. Select the required print job in WinCC Explorer.
2. Open the properties dialog with the pop-up menu.
3. Activate the "Configuration dialog" option in the "Dialog" selection field on the "General"
tab.
4. Accept the change with "OK". If the print job is started, the configuration dialog is displayed
with the linked report objects.
5. Use a double-click to open the configuration dialog of the desired log object, and then set
the output options.

6. You can change the selected printer using the "Printer Setup" button.
7. You can delete a selection you have made using the "Delete" button.
8. You can start the report after selecting the report element in the table.
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How to select the printer in Runtime
You can configure the printer selection with the print job. If the default settings in the "Print Job
Properties" dialog remain unchanged, you cannot change the printer in Runtime. It is possible
to select the printer in Runtime by activating the option "Printer Selection Dialog". The option
must be configured separately for each print job.
1. Select the required print job in WinCC Explorer and use the pop-up menu to open the
properties dialog.
2. On the General tab, select the Printer Selection Dialog option in the Dialog field.
3. Click OK to apply the change.
4. If the print job is started, the printer selection dialog is displayed with the available printers.
5. Use the dialog to specify the printer for the output. If necessary, change the order of priority
of the printers. You can also print to a file.
6. Confirm the selection with "OK". Printing is started.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Data from Other Data Sources (Page 1865)
Dynamizable Parameters for Runtime Documentation (Page 1851)
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 2028)
How to Change the Output Options for Message Reports from Alarm Logging Runtime
(Page 2032)
How to Change the Output Options for User Archive Tables (Page 2038)

9.6.5

Dynamizable Parameters for Runtime Documentation

Introduction
To make Runtime documentation more flexible, a number of report object parameters can be
dynamized. The tables below show the parameters that can be dynamized.
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CCAxUserArchiveControl
Dynamizable Parameters

Explanation

FilterSQL

Filter criteria for database access by means of SQL statements

ColumnSort

Sort criteria for database access by means of SQL statements

TimeBase

Time base of the table

Parameters of report objects for WinCC Controls created in a version older than WinCC V7 which
support dynamization
WinCC Alarm Control (Classic)
Dynamizable Parameters

Explanation

MsgFilterSQL

Selection of message by means of SQL statements

ServerNames

Server selection in distributed systems

TimeBase

Time base of message lists

WinCC Online Table Control (Classic)
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Dynamizable Parameters

Explanation

Archives

Archive linked to a column

BackColor

Background color of the table

BeginTime

Start time of the column time range
If the "Update" checkbox is activated in the "Column" tab, the start
time will refer to the current time. The previous values are then
output in the defined time interval.

Color

Color of the column

CommonTime

Common time column to be used for the table

EndTime

End time of the column time range The "Time range" checkbox
in the "Column" tab must be deactivated. The value depends on
TimeAxisX.

ItemVisible

Hide/show column

Name

Name in column header

Precisions

Number of decimal places in a value column

TimeColumnAlignment

Alignment of time column

TimeFormat

Format of time in column

TimeRangeBase

Time range of a column. The time range is calculated by
multiplying TimeRangeBase with TimeRangeFactor. The
"TimeRangeBase" and "TimeRangeFactor" properties are only
evaluated when the "Time range" checkbox in the "Column" tab
is activated.Format:

TimeRangeFactor

Repeat rate of the column time range. The time range is
calculated by multiplying TimeRangeBase with
TimeRangeFactor. The "TimeRangeBase" and
"TimeRangeFactor" properties are only evaluated when the
"Time range" checkbox in the "Column" tab is activated.Format:

TimeZone

Time base of the table
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Dynamizable Parameters

Explanation

ValueColumnAlignment

Alignment of value column

Variable

Archive tag linked to a column

WinCC Online Trend Control (Classic)
Dynamizable Parameters

Explanation

BackColor

Background color of trend graphic

BeginTime

Start time of a trend.
If the "Update" checkbox is activated in the "Time axis" tab, the
start time will refer to the current time. The previous values are
then displayed for a fixed time range or for a fixed number of
measured points.
If CommonX is set to Yes, the set BeginTime applies to all trends.

BeginValue

Lower limit of value of the range of a trend. Only available if
Autorange option is deactivated.

Color

Color of the trend

CommonX

Shared X axis of the trend graphic

CommonY

Shared Y axis of the trend graphic

CurveForm

Representation of measurements in the form of a trend

EndTime

End time of a trend. The "Time Range" and "Number of
Measuring Points" checkboxes on the "Time Axis" tab must be
unchecked.

EndValue

Upper limit of value of the range of a trend. Only available if
Autorange option is deactivated.

GraphDirection

Direction of current values in trend graphic

ItemVisible

Hide/show trend

LineWidth

Line width of trend

MeasurePoints

The number of measuring points that are output since start time.
The "Time range" checkbox in the "Time Axis" tab must be
unchecked.

Relay Curves

Staggered display of trends

TagName

Tags linked by a trend

TimeRangeBase

Time range of a trend. The time range is calculated by multiplying
TimeRangeBase with TimeRangeFactor. The "TimeRangeBase"
is evaluated only when the "Time range" checkbox in the "Time
Axis" tab is activated.

TimeRangeFactor

Repeat rate of the time range of a trend. The time range is
calculated by multiplying TimeRangeBase with
TimeRangeFactor. The "TimeRangeFactor" is evaluated only
when the "Time range" checkbox in the "Time Axis" tab is
activated.

TimeZone

Time base of trend graphic

WinCC Function Trend Control (Classic)
Dynamizable Parameters

Explanation

AutorangeX

Automatic selection of value range along X axis

AutorangeY

Automatic selection of value range along Y axis
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Dynamizable Parameters

Explanation

BackColor

Background color of trend graphic

BeginX

Lower limit of X axis value range. Only available if
AutorangeX is set to No. The value range is determined
by CommonX.

BeginY

Lower limit of Y axis value range. Only available if
AutorangeY is set to No. The value range is determined
by CommonY.

Color

Color of the trend

CommonX

Shared X axis of the trend graphic

CommonY

Shared Y axis of the trend graphic

CurveForm

Representation of measurements in the form of a trend

DesiredCurveColor

Color of setpoint trend of a trend. The value depends
on DesiredCurveVisible.

DesiredCurveCurveForm

Representation of measurements of setpoint trend of a
trend. The value depends on DesiredCurveVisible.

DesiredCurveSourceNumberOfUAValues

Number of values of a setpoint trend of trend that can
be loaded from the user archive. The value depends on
DesiredCurveVisible.

DesiredCurveSourceUAArchive

Name of the user archive to which the setpoint trend of
a trend is linked. The value depends on
DesiredCurveVisible.

DesiredCurveSourceUAArchiveStartID

ID of the record of the user archive from which values
are to be loaded to the setpoint trend of a trend. The
value depends on DesiredCurveVisible.

DesiredCurveSourceUAColumnX

Column of the user archive from where the X values of
a setpoint trend of a trend are to be read. The value
depends on DesiredCurveVisible.

DesiredCurveSourceUAColumnY

Column of the user archive from where the Y values of
a setpoint trend of a trend are to be read. The value
depends on DesiredCurveVisible.

DesiredCurveVisible

Hide/show setpoint trend

EndX

Upper limit of X axis value range. Only available if
AutorangeX is set to No. The value range is determined
by CommonX.

EndY

Upper limit of Y axis value range. Only available if
AutorangeY is set to No. The value range is determined
by CommonY.

GraphDirection

Direction of positive values in trend graphic

ItemVisible

Hide/show trend

LabelX

Label of X axis of a trend. The value depends on
TimeAxisX.

LabelY

Label of Y axis of a trend

Name

Name of a trend

Relay Curves

Staggered display of trends

SourceBeginTime

Start time of a trend.

SourceEndTime

End time of a trend. The "Time range" checkbox in the
"X-Axis" tab must be checked.
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Dynamizable Parameters

Explanation

SourceNumberOfUAValues

Number of value pairs of a trend that are loaded from
the user archive

SourceNumberOfValues

Number of value pairs of a trend that are retrieved from
archive tags. The "Time range" checkbox in the "X-Axis"
tab must be unchecked.

SourceTagNameX

Archive tag linked to the X axis of a trend

SourceTagNameY

Archive tag linked to the Y axis of a trend

SourceUAArchive

Name of user archive linked to a trend

SourceUAArchiveStartID

ID of the record of the user archive from which values
are to be loaded to a trend.

SourceUAColumnX

Column of the user archive from where the X values of
a trend are to be read.

SourceUAColumnY

Column of the user archive from where the Y values of
a trend are to be read.

TimeAxisX

Use time range of the X axis for a trend

TimeZone

Time base of trend graphic

Dynamizable Parameters for other Report Objects
Report object

Dynamizable Parameters

Message reports

Selected servers
Filter criterion for alarm output

User archives table

Archive name/view name
Filter condition
Sorting

ODBC database field

ODBC data source
Users
Password
SQL statement

ODBC database table

ODBC data source
Users
Password
SQL statement

Hard copy

Range selection
Size and position of a subarea

CSV provider table

CSV file name

CSV provider trend

CSV file name

See also
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 2028)
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9.6.6

Reporting Messages in Runtime

9.6.6.1

Reporting Messages in Runtime

Overview
You can log all messages occurring in the system using the WinCC reporting system. The
following options are available:
● Output of Runtime data from the message lists.
● Output of a message sequence report.
You print the messages from the message lists directly via a configurable interface in the
WinCC AlarmControl. The messages from the archive lists are output in accordance with the
selection configured in the WinCC Alarm Control.
To output messages, you have to do the following things:
● Configure the button in the WinCC AlarmControl for starting the report in Runtime.
● Select "Alarm Logging Runtime" and "Graphics Runtime" in the startup list of the WinCC
project.
● Select the project, and start the log.
You have the option of logging messages with a selection independent of the WinCC
AlarmControl. The report system provides layouts, in which you can determine parameters
that can be made dynamic. For more information, please read Introduction to Runtime
Documentation , Modify output options for WinCC Alarm Control and Changing Output Options
for Message Reports from Alarm Logging.
Note
Color conversion when printing messages
You can use the "Options" tab in the project properties dialog of the WinCC project to define
the color properties for messages to be printed. If the "Color conversion when printing
messages" option is activated, the settings in the "AlgLoggingPrinterColorConversion.XML"
file will be taken into account. Black-white is the default setting. If the "Color conversion when
printing messages" option is deactivated, the settings in AlarmLogging will be used.

Points to Note About the Message Sequence Report
The message sequence report outputs the messages that occur in the system in chronological
order in accordance with the specified selection criteria. To this end, the message sequence
report in the startup list of the WinCC project must be activated. The message sequence report
is generally output to a line printer, but it can also be output page by page.

See also
How to Create a User-Defined Message Sequence Report (Page 1861)
How to Output Online Data with Message Sequence Report (Page 1858)
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How to Output Runtime Data from the Message Lists (Page 1857)
How to Configure the Static Parameters of WinCC Alarm Control (Page 2026)
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 2028)

9.6.6.2

How to Output Runtime Data from the Message Lists

Introduction
In WinCC AlarmControl, you configure a button for the report call for the output of the messages
from the message lists. In Runtime, you must activate the desired message list in AlarmControl
and press the "Print" button. You determine how the data is output using the print job in
AlarmControl.

Overview
When messages from the message archive lists are output, you must select the messages
(e.g. all messages of the last shift) before outputting the report. When outputting a report
without selection of messages, the scope of the output can be too great and the system can
become overloaded.
For the output of the messages, the "@Alarm Control - Picture.RPL" or "@ Alarm Control Table.RPL" system layouts are provided with the WinCC V7 AlarmControl. If you want to output
the messages in WinCC V6.2 and in the Classic Controls of WinCC V7, use the
"@CCAlarmCtrl-CP.RPL" system layout.
However, you can create a new layout to configure desired settings (e.g. landscape format,
other aspects of the layout). In this case, you must link the print job to the layout.
Further information on the layouts and print jobs of the WinCC AlarmControl can be found
under System Layouts and Print Jobs for Runtime Documentation (Page 1887).

Procedure
1. Open the WinCC picture with the WinCC AlarmControl in Graphics Designer.
2. Double-click the control to open the properties dialog.
3. Go to the "Toolbar" tab and activate the "Print" button function.
4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If
button.
you want to use a different print job, select the desired print job using the
5. Confirm the setting with "OK". Save and close the WinCC picture.
6. Select the "Graphics Runtime" and "Alarm Logging Runtime" options in the computer's
startup list.
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7. Activate the project.
8. Click the "Print" button in the WinCC AlarmControl for the print output. The current view or
the full contents of the selected message list of the WinCC AlarmControl is output on the
printer set in the print job.
Note
When the application starts log output, the system print jobs are used. The system print
jobs cannot be deleted. If necessary, you can rename the system print jobs.
In the WinCC Alarm Control before WinCC V7, you can also activate the "Print message report"
key function. In this case, the
button is displayed in Runtime. This button is for outputting
logs with a standard layout from WinCC V5 and has been retained in the system for
compatibility reasons. The contents of this log depend on the configuration settings in the
layout called and the selection made in the WinCC Alarm Control. When messages from the
message archive lists are output, you must select the messages (e.g. all messages of the last
shift) before outputting the report. When outputting a report without selection of messages, the
scope of the output can be too great and the system can become overloaded.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Data from Other Data Sources (Page 1865)
Reporting Process Values in Runtime (Page 1862)
How to Change Output Options in Runtime (Page 1848)

9.6.6.3

How to Output Online Data with Message Sequence Report

Introduction
The message sequence report allows you to output a chronological list of all messages that
occur in a project. It is generally output on a line printer. The messages are output in the order
in which they occur.
If a line printer is used for output, it must be connected locally to the logging computer. The
Line layout for Line Printer check box in the print job must be selected. However, the message
sequence report can also be output in a page layout.
The printer does not have to be connected locally to the logging computer in order to output
the report with a page layout. A message sequence report in a page layout can also be output
on a network printer. Upon output in page layout, the printout is generated when incoming
messages have filled a page or if you initiate the printout of the page by clicking the operation
button.
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Print Job and Layout
For the message sequence report there is a set print job that also has to be used for a message
sequence report you define yourself. It is not possible to create your own print job for a line
layout.
Print job

Layout

Remarks

@Report Alarm Logging RT
Message Sequence

@CCAlgRtSequence.R
P1

System print job for a message sequence
report in line format.

@Report Alarm Logging RT
Message Sequence

@CCAlgRtOnlineMessa Print job for the printing of a message
ges.RPL
sequence log in the page layout

Creating a Line Layout
Before a message sequence report is output in a line layout, the layout has to be adjusted.
You edit a line layout in the line layout editor.
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed.
2. Double-click the Layouts entry in the file window. All existing layouts are displayed in the
file window.
3. Double click on line layout "@CCAlgRtSequence.RP1". The layout is opened in the line
layout editor.
4. In the Page Size area, specify the number of lines per page and the number of columns
(characters per line).
5. In the Margins section, specify the number of characters for the width of the margins.
6. Edit the contents of the header and footer. These are output on every page.
7. Click the Selection button to open the Log Tables Selection dialog. Use the dialog to specify
the data for output. You find more information in chapter "Changing Output Options for
Message Reports from Alarm Logging". When you close the dialog, the selected columns
and their widths are displayed in characters per line in the Table area. If the number of
characters per line is too large, a message to this effect is displayed.
8. Save the changes to the line layout, and close the editor.

Prerequisites for Output
● The line printer on which the message sequence report is output must be connected locally
to the computer carrying out the logging.
● The message sequence report must be activated in the startup list of the computer carrying
out the logging.

Starting the Message Sequence Report
The message sequence report must be activated in the startup list of the computer carrying
out the logging. The message sequence report is started automatically when the WinCC project
is activated.
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Interrupting the Message Sequence Report
To interrupt the output of the message sequence report on a line printer, proceed as follows:
● Suspend the output of the message sequence report by calling the
MSRTActivateMProt(False,Null) function.
To resume output of the message sequence report, proceed as follows:
● Restart output of the message sequence report by calling the
MSRTActivateMProt(TRUE,NULL) function.
Note
If the message sequence report is interrupted, the incoming messages for the message
sequence report are lost.

Printout of Message Sequence Log in Page Layout
Before a message sequence report is output in a page layout, the print job has to be adjusted.
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed.
2. Double-click the Print Jobs entry. All existing print jobs are displayed in the file window.
3. Double click on print job "@Report Alarm Logging RT Message sequence" marked in
yellow. The Print Job Properties dialog is displayed.
4. Clear the Line Layout for Line Printer check box on the General tab.
5. From the list of layouts, select layout "@CCAlgRtOnlineMessages.RPL".
6. Select the "Printer Setup" tab. Acknowledge the displayed dialog window "CcPJobApi" with
"OK".
7. In the "Print output to..." section, select the default printer and the substitute printer. Click
"OK". After closing the dialog, the yellow marking for the print job "@Report Alarm Logging
RT Message sequence" disappears in the file window.
The message sequence log in page layout will be printed automatically as soon as the incoming
messages have filled a page. If you wish to print a page before it is filled, proceed as follows:
● With a call to function MSRTPrintMProt (pointer to page number, pointer on error message),
start the message sequence log printout.
● If you use Basic Process Control, the key set of the message lists include a printer button
with which you can print out a page that is not full.
For troubleshooting instructions, refer to chapter Printer Setup.

See also
Defining a Printer (Page 1811)
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Data from Other Data Sources (Page 1865)
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Reporting Process Values in Runtime (Page 1862)
How to create print jobs for the Runtime documentation (Page 1846)

9.6.6.4

How to Create a User-Defined Message Sequence Report

Introduction
To create a user-defined message sequence report, you can create a new line layout or page
layout or save an existing layout with a new name and edit it. Always use the @Report Alarm
Logging RT Message Sequence print job to output the message sequence report.

Output in a Line Layout
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Job entries are displayed.
2. Select the Layouts entry, and use the pop-up menu to create a new line layout. A blank
layout is created and stored under Layouts. The layout is saved with the name
"NewRP100.RP1". If several layouts are created, the number in the layout name is
incremented each time a new one is created.
3. Open the new line layout by means of a double-click in the line layout editor.
4. Configure the layout as described in chapter How to Output Online Data with Message
Sequence Report.
5. Save and close the layout.

Output in a Page Layout
The message sequence report can also be output in a page layout.
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the Runtime Documentation tab, select the Message Report object,
and drag it to the desired size in the working area.
3. Open the Object Properties dialog by double-clicking the object, and select the Connect
tab.
4. In the list of possible things to do, double-click Selection. The Alarm Logging Runtime:
Report Table Selection dialog is opened.
5. Use the dialog to specify the data for output. You find more information in chapter Changing
Output Options for Message Reports from Alarm Logging.
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Editing the Print Job
There is only one print job for the message sequence report, so you have to call the line layout
or page layout you have created in this print job.
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts
and Print Jobs entries are displayed.
2. Double-click the Print Jobs entry in the file window. All existing print jobs are displayed in
the file window.
3. Open the @Report Alarm Logging RT Message Sequence print job by double-clicking it.
The Print Job Properties dialog is displayed.
4. On the General tab, select the layout you have created in the Layout field.
5. If you are using a line layout, select the Line layout for Line Printer check box on the General
tab. If you are using a page layout, clear this check box.
6. On the Printer Setup tab, specify the printer to be used for output, and then close the dialog.

See also
Print Jobs in WinCC (Page 1805)
How to Output Online Data with Message Sequence Report (Page 1858)
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Data from Other Data Sources (Page 1865)
Reporting Process Values in Runtime (Page 1862)

9.6.7

Reporting Process Values in Runtime

Introduction
You can output process values from the Logging tag using the WinCC report system. The
following options are available:
● Output of process values in table form from process value archives and compressed
archives via the WinCC OnlineTableControl.
● Output of process values in trend curve form from process value archives and compressed
archives via the WinCC OnlineTrendControl.
● Output of process values in trend curve form as a function of another tag from process
value archives, compressed archives and user archives via the WinCC
FunctionTrendControl.
The data can be output directly in the relevant WinCC control using the "Print" button.

Overview
For the output of the data, the new WinCC V7 controls provide new system layouts for each
WinCC control. If you output the process values outside of the WinCC controls and you want
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to dynamize the report parameters, continue to use the previous system layouts of the
respective WinCC control.
However, you can create a new layout to configure desired settings (e.g. landscape format,
other aspects of the layout). In this case, you must link the print job to the layout.
Further information on the layouts and print jobs of the controls can be found under System
Layouts and Print Jobs for Runtime Documentation.

Procedure
1. Open the WinCC picture with one of the aforementioned WinCC controls in Graphics
Designer.
2. Double-click the control to open the properties dialog.
3. Go to the "Toolbar" tab and activate the "Print" button function.
4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If
button.
you want to use a different print job, select the desired print job using the
5. Confirm the setting with "OK". Save and close the WinCC picture.
6. Select the "Graphics Runtime" and "Tag Logging Runtime" options in the computer's startup
list.
7. Activate the project.
8. Click the "Print" button in the displayed WinCC AlarmControl for the print output. The current
view or the trend curves or the full contents of the table is output on the printer set in the
print job.
Note
When the application starts report output, the system print jobs are used. The system print
jobs can therefore not be deleted. If necessary, you can rename the system print jobs.

See also
How to Output Data from User Archives (Page 1863)
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)

9.6.8

How to Output Data from User Archives

Introduction
You authorize output of the table of the Win CC UserArchiveControl in Runtime using the "Print"
button. You determine how the data is output using the print job in the WinCC control. You can
also arrange the output of the user archive data outside of the control.
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Overview
For output of the data, the "@User Archive Control - Picture.RPL" or "@User Archive Control
- Table.RPL" system layouts are provided with the WinCC UserArchiveControl.
If you want to output the user archive data outside of the WinCC UserArchiveControl, use the
"CCAxUserArchiveControl" layout in the Reports Designer. Additional information on
configuration is available at How to Change Output Options in Runtime (Page 1848).
However, you can create a new layout to configure desired settings (e.g. landscape format,
other aspects of the layout). In this case, you must link the print job to the layout.
Further information on the layouts and print jobs of the WinCC UserArchiveControl can be
found under System Layouts and Print Jobs for Runtime Documentation (Page 1887).

Procedure
1. Open the WinCC picture with the WinCC UserArchiveControl in Graphics Designer.
2. Double-click the control to open the properties dialog.
3. Go to the "Toolbar" tab and activate the "Print" button function.
4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If
button.
you want to use a different print job, select the desired print job using the
5. Confirm the setting with "OK". Save and close the WinCC picture.
6. Select the Graphics Runtime option in the computer's startup list.
7. Activate the project.
8. Click the "Print" button in the WinCC UserArchiveControl for the print output. The current
view or the full contents of the table of the WinCC UserArchiveControl is output on the
printer set in the print job.
Note
When the application starts report output, the system print jobs are used. The system print
jobs can therefore not be deleted. If necessary, you can rename the system print jobs.

See also
Reporting Data from Other Data Sources (Page 1865)
System Layouts and Print Jobs for Runtime Documentation (Page 1887)
Reporting Messages in Runtime (Page 1856)
How to Change Output Options in Runtime (Page 1848)
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9.6.9

Reporting Data from Other Data Sources

9.6.9.1

Reporting Data from Other Data Sources

Overview
The WinCC reporting system also allows you to log data that do not come from a WinCC
project. There are various log objects available for integrating this kind of data in a WinCC log.
In addition, WinCC provides a hard copy log object, by means of which the screen or a section
of the screen showing the current Runtime status can be output in a report.
The following log objects are available for output:
ODBC database field Serves to output data from a database field in a WinCC log by means
of ODBC.
ODBC database
Serves to output data from a database table in a WinCC log by means
tables
of ODBC.
CSV table
Serves to output data from a file in CSV format in a WinCC log. The data
is output in tabular form.
CSV trend
Serves to output data from a file in CSV format in a WinCC log. The data
is output in the form of a trend.
Hard copy object
Serves to output a view of the screen or a section of the screen in a
WinCC log.
COM server object Permits the integration of a user-specific COM server to output its data
in a WinCC log.
Detailed knowledge is required in order to configure these logs. Creating a COM server, in
particular, requires appropriate background knowledge. Information on database accesses by
means of ODBC, COM servers, and CSV files is not provided here. You find more information
on these subjects in the relevant technical literature.

See also
How to Output Data from a COM Server in a Report (Page 1882)
How to Output a Hard Copy by Means of a Log Object (Page 1874)
How to Output Data from a CSV Table in a Log (Page 1867)
How to Output Data from an ODBC Database in a Report (Page 1865)

9.6.9.2

How to Output Data from an ODBC Database in a Report

Introduction
Special log objects are provided in the reporting system for integrating data from user-specific
data sources. It is possible to use two of these log objects to access data sources by means
of ODBC and to output the data that is read out in a WinCC log. These report objects allow for
access to these data and output in a WinCC log. This gives the reports and logs uniformity,
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even if the data do not come from WinCC. If WinCC tags are integrated, the selection of the
data can be dynamized. In other words, the data selection can be changed online before output.

Available ODBC Log Objects
Database field
Database table

Serves to output data from a field of a data source by means of ODBC.
Serves to output data from a table of a data source by means of ODBC.

Requirements
● Knowledge of how to create layouts and insert report objects
● Knowledge of how to access data sources by means of ODBC
● Access authorization for the ODBC data source
● Knowledge of SQL
● If WinCC tags are used for dynamization, the WinCC project must be activated for testing
and output.

Procedure
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the Standard Objects tab, select the log object Database Field or
Database Table, depending on your requirements, and drag it to the required size in the
working area.
3. Open the object properties dialog by double-clicking the object, and select the Connect tab.
4. In the list of possible things to do, double-click Database Link. The Data Connection dialog
is displayed.
5. In the ODBC Data Source area of the selection dialog, select an existing data source, or
enter a data source in the text box.
6. Edit the other text boxes in accordance with the requirements of your data source.
7. Click "OK" to close the dialog and save the layout.
8. Create a print job, and select the configured page layout there.
9. Start output by means of the print job in WinCC Explorer or by means of a configured call
in a WinCC picture, for example.

Output options
You can use any SQL statement to select the data. Enter it in the SQL Statement field. You
can use WinCC tags to dynamize the selection of data by means of a SQL statement. For full
dynamization, select the Tag check box, and integrate a tag. You can also dynamize a
substring of the SQL statement. To do this, use the Insert Tag button. Select the tag you require
from the tag selection dialog that is displayed. The tag will be inserted at the current cursor
position in the text box. The syntax for this is $tagname$.
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You can use the Test SQL Statement button to check whether the SQL statement is correct.
Access to the data source is required in order to carry out the test. If there are WinCC tags in
the SQL statement, WinCC must be activated for the test. The result of the test is displayed
in a dialog. If the test is successful, the number of fields is entered automatically for a data
table.
Errors that occur in Runtime are written to a log file.
You find more information in chapters Changing Output Options for the ODBC Database Field
and Changing Output Options for the ODBC Database Table.
NOTICE
The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible
to destroy or delete the data source.

9.6.9.3

How to Output Data from a CSV Table in a Log

Introduction
Two log objects are provided in the reporting system for the integration of data in CSV format.
These report objects allow for access to these data and output in a WinCC log. This gives the
reports and logs uniformity, even if the data do not come from WinCC. If WinCC tags are
integrated, the selection of the data can be dynamized. In other words, the data selection can
be changed in Runtime before output.

Available CSV Log Objects
CSV provider tableServes to output data from a file in CSV format. The data is output in tabular
form.
CSV provider trendServes to output data from a file in CSV format. The data is output in the
form of a trend.

Requirements
● Knowledge of how to create layouts and insert report objects
● Knowledge of the structure of CSV tables.
● If WinCC tags are used for dynamization, the WinCC project must be activated for testing
and output.

Procedure
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the Runtime Documentation tab, select the log object CSV-Provider
Table or CSV-Provider Trend, depending on your requirements, and drag it to the desired
size in the working area.
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3. Open the object properties dialog by double-clicking the object, and select the Connect tab.
4. In the list of possible things to do, select CSV Table Selection or CSV Trend Selection. A
dialog is displayed in which you can select the data source.
5. In CSV File Name area of the selection dialog, select an existing data source, or enter a
data source in the text box.
6. Click "OK" to close the dialog and save the layout.
7. Create a print job, and select the configured page layout there.
8. Start output by means of the print job in WinCC Explorer or by means of a configured call
in a WinCC picture, for example.

Using the Data Source
To output the log correctly, the data must be stored in the CSV file used on the basis of a
predefined structure. If current data are to be output, the CSV file must be created before
output is started. The user is responsible for deleting the CSV file after output. You find more
information in chapter Requirements to Be Met by a CSV File for Logging.

See also
Requirements to be Met by a CSV File for Reporting (Page 1871)
Example of the Output of CSV Files in a Report (Page 1868)

9.6.9.4

Example of the Output of CSV Files in a Report

Introduction
To illustrate the output of CSV files in a WinCC log, an example is provided of output in tabular
form, and another is provided of output in the form of a trend. The notation must be rigorously
adhered to. If the CSV file is created using a spreadsheet program, please check the notation
before outputting it for the first time. To this end, open the CSV file in a text editor and check
the contents. You find more information on this in chapters How to Output Data from a CSV
Table in a Log and Requirements to Be Met by a CSV File for Logging.

Procedure
1. Create a CSV file in which the data are stored as in the examples described below.
2. Configure a page layout for the output. Proceed in the same way as for configuration
described in chapter How to Output Data from a CSV Table in a Log.
3. Create a print job, and associate it with the page layout. Proceed in the same way as for
configuration described in chapter Creating Print Jobs for Runtime Documentation.
4. Start the print job. The log is output.
5. Delete the CSV file after output.
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Example of Output in Tabular Form
Contents of the CSV file to be printed:
#Table; Name; Columns; Font; Font size
"testfile";4;"Arial";14
#Column; Num; Header; Width; Alignment
0;"Date";10;C
1;"Time";10;C
2;"Number";6;L
3;"Status";16;R
#Data; Color; Col1; Col2; Col3; Col4;
0xFF00FF;"05/06/02";"15.55.52";85;"+/-"
0xFF00FF;"05/06/02";"15.55.53";86;"+/-"
0x32b400;"05/06/02";"15.55.54";87;"+/-"
0x32b400;"05/06/02";"15.55.55";88;"+/-"
0xFFFFFF;"05/06/02";"15.55.56";89;"+/-"
0xFFFFFF;"05/06/02";"15.55.57";90;"+/-"
0x0000FF;"05/06/02";"15.57.12";100;"+/-"
0x0000FF;"05/06/02";"15.58.01";85;"+/-"
0xFF0000;"05/06/02";"15.58.02";86;"+/-"
0xFF0000;"05/06/02";"15.58.03";87;"+/-"
Output file
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Example of Output in the Form of a Trend
Contents of the CSV file to be printed:
#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize
"TrendControl1";3;"2001-10-10 16:30:00.000";"2001-10-10 16:40:00.000";0;"Arial";10
#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType; Filling
0;"Temperature";3;10;30;0x00ff0000;1;STEP;0
1;"Pressure";
2;"Force";

5; 0;50;0x0000ff00;2;DOTS;0

10; 0;50;0x000000ff;5;LINE;1

#Data; Num; Date; Value; Flags; Color
0;"2001-10-10 16:30:00.000";22;0;0x000000FF
0;"2001-10-10 16:31:00.000";24;0;
0;"2001-10-10 16:32:00.000";27;0;
1;"2001-10-10 16:30:00.000";10;0;0x0000FF00
1;"2001-10-10 16:30:30.000";20;0;
1;"2001-10-10 16:31:00.000";20;0;
1;"2001-10-10 16:31:30.000";30;0;
1;"2001-10-10 16:32:00.000";10;0;
2;"2001-10-10 16:30:00.000";20;0;
2;"2001-10-10 16:31:00.000";27;0;
2;"2001-10-10 16:32:00.000";34;0;0x00FF00FF
2;"2001-10-10 16:33:00.000";45;0;0x00FF0000
2;"2001-10-10 16:34:00.000";20;0;
2;"2001-10-10 16:35:00.000";27;0;
2;"2001-10-10 16:36:00.000";34;0;0x00FF00FF
2;"2001-10-10 16:37:00.000";45;0;0x00FF0000
2;"2001-10-10 16:38:00.000";20;0;
2;"2001-10-10 16:39:00.000";10;0;
2;"2001-10-10 16:40:00.000";25;0;
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Output file

See also
Requirements to be Met by a CSV File for Reporting (Page 1871)
How to Output Data from a CSV Table in a Log (Page 1867)

9.6.9.5

Requirements to be Met by a CSV File for Reporting

Introduction
To permit the data from a CSV file to be output in a WinCC log, the data must correspond to
a set structure. The data in a CSV file are prepared by the user. You find more information in
chapters How to Output Data from a CSV Table in a Log and Example of the Output of CSV
Files in a Report.

Requirements for CSV File to be Output in Tabular Form
Each section must begin with the name of the corresponding file structure, followed by one or
more lines containing the elements of the file structure. All parameters must be separated by
a semicolon (;), regardless of country-specific settings. The following file structures are defined:
File Structure for Output in Tabular Form
The table, columns, and data must be defined as follows:
#Table; Name; Columns; Font; Font size
- Name = name of the table control or file
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- Columns = number of columns
- Font = font of the table
- Font size = font size of the table
#Column; Num; Header; Width; Alignment
- Num = number of the column
- Header = header of the column
- Width = width of the column in characters
- Alignment = left aligned/centered/right aligned
#Data; Color; Col1; Col2; Col3; Col4; ...
- Color = color attribute of the line (0xbbggrr)
- Col1 = data of column 1
- Col2 = data of column 2
- etc.
Points to Note About the Data in the CSV File
The control characters for colors, alignment, etc. are always at the beginning of the output text
and can be combined with each other (e.g. "<B><U>output text"). No distinction is drawn
between upper and lower case.
The Width parameter indicates the relative width of the columns. The effective width of the
column in the table is calculated as follows:
[ Table width as a number of characters ] x [ relative width of the column in % ] / [ sum of all
relative widths of the column ]
The line defined for tables in the CSV file contains one more column than the data lines. If a
spreadsheet program such as Excel is used to edit the data, the columns for the headings and
the data will no longer match up. To prevent this from happening, you can enter a semicolon
(;) as the first character in the data lines of the CSV file. The data blocks of the CSV file may
not contain blanks. When you open the CSV in Excel, the data columns are shifted one column
to the right. The columns for the headings and data will then match up. If the first column does
not contain anything, you have to insert a blank (;blank;first data value;...).
Control Characters for Table Output
<END>

Concludes the interpretation of control sequences. The rest of the text is
accepted as specified.

<COLOR=#rrggbb>

Font color in hexadecimal notation (default = as set for the table)

<BGCOLOR=#rrggbb Background color in hexadecimal notation (default = as set for the table)
>
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<B>

Bold

<U>

Underlined

<I>

Italic
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<STRIKE>

Strike-through

<ALIGN=left>

Left aligned

<ALIGN=center>

Centered

<ALIGN=right>

Right aligned

Note
The definition of the Color attribute conforms to the Intel byte format. The notation is 0xbbggrr
(hex blue blue green green red red). The control characters for formatting the table cells
conform to the HTML standard. The notation for <color=> is #rrggbb.

Each section must begin with the name of the corresponding file structure, followed by one or
more lines containing the elements of the file structure. The following file structures are defined:
File Structure for Output in the Form of a Trend f(t)
#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize
- Name = name of the trend control or file
- Curves = number of trends
- DateFrom = start of time range, notation: 2000-10-30 10:15:00.000
Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- DateTo = end of time range, notation: 2000-10-30 10:15:00.000
Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- Common Y-Axis = common y-axis
- Font = font
- Fontsize = font size
#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType; Filling
- Num = number of the trend
- Name = trend name
- Count = number of values
- dMin = lower limit of the trend (for scaling)
- dMax = upper limit of the trend (for scaling)
- Color = color attribute of the trend (0xbbggrr)
- Weight = line weight in points (e.g. 1.5)
- CurveType = trend type ( LINE, DOTS, STEP)
- Filling = filling color for areas ( 0=no, 1=yes). The Filling parameter is currently not in use.
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#Data; Num; Date; Value; Flags; Color
- Num = number of the trend
- Date = X coordinate of the trend, notation: 2000-10-30 10:15:00.000
Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- Value = y coordinate of the trend
- Flags = limit values/time overlap etc.
- Color (if an empty string is specified here, the color is taken from #Curve ...)

9.6.9.6

How to Output a Hard Copy by Means of a Log Object

Introduction
For outputting a hard copy in a log, the page layout editor provides the Hardcopy log object.
This log object allows you to create a hard copy of the entire screen, a section of the screen,
or the current window. In contrast to output by means of a key combination, this can be output
in a defined page layout. It is also possible to insert the log object in a different log and output
it together with other data.

Available Hard Copy Log Object
Hard copy

Serves to output current screen views.

Requirements
● Knowledge of how to create layouts and insert report objects
● If WinCC tags are used for dynamization, the WinCC project must be activated for testing
and output.

Creating a Hard Copy Using the Hardcopy Log Object
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the Standard Objects tab, select the Hardcopy log object. In the
working area, drag it to the required size.
3. Open the object properties dialog by double-clicking the object, and select the Connect tab.
4. In the list of possible things to do, double-click Area Selection. A dialog that allows you to
select the part of the screen to be output is displayed.
5. Select your preferred option in the Areas section of the selection dialog. If you select Copy
of a Subarea, you have to specify the position of the upper-left corner and the size of the
section in pixels in the corresponding text boxes.
6. Click "OK" to close the dialog and save the layout.
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7. Create a print job, and select the configured page layout there.
8. Start output by means of the print job in WinCC Explorer or by means of a configured call
in a WinCC picture, for example.

Output options
The selection of the area and the position and size specifications can also be dynamized by
means of WinCC tags. To do this, select the relevant Tag check box, and use the folder button
to select a tag from the Tag Selection dialog. If you know the tag name, you can enter it directly
instead.
You configure tag supply in Graphics Designer.

See also
How to Output a Hard Copy by Means of a Key Combination (Page 1875)
How to Change Output Options in Runtime (Page 1848)

9.6.9.7

How to Output a Hard Copy by Means of a Key Combination

Introduction
In WinCC Explorer you can use the project properties to specify a key combination for
outputting a hard copy. It is possible to create a hard copy of the entire screen, a section of
the screen, or the current window. For this purpose, command-line parameters have to be
transferred to the executing application PrintScreen. In contrast to output of a hard copy via a
log object, output via PrintScreen is directly to the default printer. A defined page layout is not
used. Output can be started in two ways:
1. By means of a configured key combination in the project properties
2. By starting the PrintScreen application in the computer's startup list
In the startup list you can pass parameters for output. The parameters are taken into account
in both of the above ways of starting output. If a hot key has been configured both in the project
properties and in the parameters in the startup list, the hot key from the project properties is
used. Additional output parameters from the startup list are nevertheless still taken into account.
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Configuring a Key Combination in the Project Properties
The output of a hard copy via a key combination can be set globally in WinCC. The output is
directly to the default printer. For the output, the PrintScreen application is used instead of a
layout from the logging system.
1. Select the name of the project in the navigation window of WinCC Explorer, and use the
pop-up menu to open the Project Properties dialog.
2. Select the HotKeys tab, and then select Hard Copy in the Actions area.

3. Click in the text box below the Assign button, and enter the key combination. The key
combination is displayed in the text box.
4. Apply the setting by clicking the Assign button, and close the dialog.
5. The hard copy is output by entering the specified key combination.

Starting the Print Screen Application in the Startup List
The PrintScreen application is entered in the computer's startup list under Additional Tasks/
Applications. The application can be supplied with parameters in command-line format that
specify the output You find an overview of the parameters and the applicable conditions in
chapter Output Parameters for Hard Copies.
1. Select Computer in the navigation window of WinCC Explorer. In the data window, select
the computer on which you want the hard copy to be output. Use the pop-up menu to open
the Computer Properties dialog.
2. Select the Startup tab.
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3. Click the Add... button. The Add Application dialog is displayed.

4. Click the Browse... button, and navigate to the bin folder in the WinCC installation directory.
Select the PrtScr.exe application, and click Open.
5. Enter the desired parameters in the Parameters field.
6. The Working Directory and Window at Open fields are not required for PrintScreen.
7. Confirm your entries with "OK."
The PrintScreen application can also be called by means of a script. The parameters for output
also apply when a script is used.

See also
Output Parameters for Hard Copy (Page 1877)
How to Output a Hard Copy by Means of a Log Object (Page 1874)

9.6.9.8

Output Parameters for Hard Copy

Introduction
When you output a hard copy by means of a key combination or a WinCC Script, you can pass
parameters for the output. If the output is to be started by means of a key combination, this
does not have to be specified in the project properties. The key combination can also be passed
as a parameter.
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Parameter for Output
The following parameters can be passed:
No parameters

The PrtScr.exe application is started and waits for the key combination for
the printout to be pressed. In this case, the key combination must be
specified in the project properties.
-end
Terminates a current instance of PrtScr.exe
-hardcopy
Starts PrtScr.exe, starts a hard copy immediately, and then waits for the
key combination for the next printout to be pressed.
-nomcp
Starts PrtScr.exe, starts a hard copy immediately, and then terminates
PrtScr.exe.
-C=
Starts PrtScr.exe, immediately starts a hard copy for the specified area,
left;top;right;botto and then terminates PrtScr.exe (the blank after -C= is important!). Example:
prtscr.exe -C= 50;50;300;400 (Starting position 50 pixels from top, 50 pixels
m
from left, End position 300 pixels from right, 400 pixels from bottom).
-l
Prints the hard copy in landscape format.
-infinit
Serves as a parameter for starting PrtScr.exe on a system without WinCC
(e.g. a Web client). The key combination for the printout and the parameters
for the printout are not obtained from the WinCC project; instead, they are
passed in the command line. The PrtScr.exe application is started and
waits for the key combination for the printout to be pressed. The parameters
are passed once only at startup. If you want to change the parameters, you
have to terminate the PrtScr.exe application and restart it with the changed
parameters.
-SpoolerLevels= a = SpoolerLevelWarning, b= SpoolerLevelStop. Defines the limit value at
a,b
which a warning is generated or the print job is rejected, if the required
spooler capacity is not available. If no parameters is specified, the limit
values are150 MB for warnings and 100 MB for rejection of print job.
Example: -SpoolerLevels= 50,30. if the available capacity of the spooler is
less than 50 MB, system message 1004006 Spool full is generated. If less
than 30 MB are available, the print job is rejected. System message
1004007 No hard copy printed. Spool full is generated.
-hotkey=x
Parameters for specifying the key combination for starting the output. The
following key combinations are permitted:
{<ALT>, <SHIFT>,<CTRL>} + {0-9, A-Z, 0xXX}
The parameters must be entered in upper casing. The keys <ALT>,
<SHIFT> and <CTRL> can be combined with each other, but it is not
essential. By means of the hexadecimal value 0xXX, all virtual key codes
can be expressed for XX. See the table below.
The parameters must be separated by blanks. In addition, a distinction must be drawn between
upper and lower case.
Examples of the "-hotkey" parameter:
-hotkey=<CTRL+P>
-hotkey=0x2C
-hotkey=<ALT>+0x2C
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Key combination CTRL and P
Print screen (sometimes referred to as the Print key)
Key combination of ALT and Print
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Each time a key combination is pressed, PrtScr.exe prints a hard copy of the section of the
screen specified (at program startup) on the default printer.

Parameter Combinations for Hard Copy Output on a Web Client
One-Time Starting
PrtScr.exe –infinit –
hotkey="<Alt>+p"
PrtScr.exe –infinit –
hotkey="<Alt>+p" –C=
10;10;100;100

Starts PrtScr and waits for key combination <ALT+P>. If the
key combination is triggered, the entire screen is printed.
Starts PrtScr and waits for key combination <ALT+P>. If the
key combination is triggered, the selected partial area is printed.

Starting in a Script
PrtScr.exe –nomcp
PrtScr.exe –C=
10;10;100;100

Starts PrtScr, starts a hard copy immediately, and then terminates
PrtScr.
Starts PrtScr, starts a hard copy of the specified subarea immediately,
and then terminates PrtScr.

The parameter –l can be added to any parameter combination.

Virtual Key Codes
The following table shows the symbolic constant names, hexadecimal values, and keyboard
equivalents for the virtual-key codes used by the Microsoft Windows CE operating system.
The codes are listed in numeric order.
Symbolic constant name

Value (hexadecimal)

Touch screen or keyboard equivalent

VK_LBUTTON

01

Touch screen

VK_CANCEL

03

Control-break processing

--

05-07

undefined

VK_BACK

08

BACKSPACE key

VK_TAB

09

TAB key

--

0A-0B

undefined

VK_CLEAR

0C

CLEAR key

VK_RETURN

0D

ENTER key

--

0E-0F

undefined

VK_SHIFT

10

SHIFT key

VK_CONTROL

11

CTRL key

VK_MENU

12

ALT key

VK_CAPITAL

14

CAPS LOCK key

--

15-19

Reserved for Kanji systems

--

1A

undefined

VK_ESCAPE

1B

ESC key

--

1C-1F

Reserved for Kanji systems
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Symbolic constant name

Value (hexadecimal)

Touch screen or keyboard equivalent

VK_SPACE

20

SPACEBAR key

VK_PRIOR

21

PAGE UP key

VK_NEXT

22

PAGE DOWN key

VK_END

23

END key

VK_HOME

24

HOME key

VK_LEFT

25

LEFT ARROW key

VK_UP

26

UP ARROW key

VK_RIGHT

27

RIGHT ARROW key

VK_DOWN

28

DOWN ARROOW key

VK_SELECT

29

SELECT key

--

2A

Original equipment manufacturer-specific (OEMspecific)

VK_EXECUTE

2B

EXECUTE key

VK_SNAPSHOT

2C

PRINT SCREEN key for Windows 3.0 and later

VK_HELP

2F

HELP key

VK_0

30

0 key

VK_1

31

1 key

VK_2

32

2 key

VK_3

33

3 key

VK_4

34

4 key

VK_5

35

5 key

VK_6

36

6 key

VK_7

37

7 key

VK_8

38

8 key

VK_9

39

9 key

--

3A-40

undefined

VK_A

41

A key

VK_B

42

B key

VK_C

43

C key

VK_D

44

D key

VK_E

45

E key

VK_F

46

F key

VK_G

47

G key

VK_H

48

H key

VK_I

49

I key

VK_J

4A

J key

VK_K

4B

K key

VK_L

4C

L key

VK_M

4D

M key

VK_N

4E

N key

VK_O

4F

O key

VK_P

50

P key

VK_Q

51

Q key
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Symbolic constant name

Value (hexadecimal)

Touch screen or keyboard equivalent

VK_R

52

R key

VK_S

53

S key

VK_T

54

T key

VK_U

55

U key

VK_V

56

V key

VK_W

57

W key

VK_X

58

X key

VK_Y

59

Y key

VK_Z

5A

Z key

--

5B-5F

undefined

VK_NUMPAD0

60

Numeric keypad 0 key

VK_NUMPAD1

61

Numeric keypad 1 key

VK_NUMPAD2

62

Numeric keypad 2 key

VK_NUMPAD3

63

Numeric keypad 3 key

VK_NUMPAD4

64

Numeric keypad 4 key

VK_NUMPAD5

65

Numeric keypad 5 key

VK_NUMPAD6

66

Numeric keypad 6 key

VK_NUMPAD7

67

Numeric keypad 7 key

VK_NUMPAD8

68

Numeric keypad 8 key

VK_NUMPAD9

69

Numeric keypad 9 key

VK_MULTIPLY

6A

Asterisk (*) key

VK_ADD

6B

Plus sign (+) key

VK_SEPARATOR

6C

Separator key

VK_SUBTRACT

6D

Minus sign (-) key

VK_DECIMAL

6E

Period (,) key

VK_DIVIDE

6F

Slash mark (/) key

--

88-8F

unassigned

--

92-B9

unassigned

--

BA-C0

OEM-specific

--

C1-DA

unassigned

--

DB-E4

OEM-specific

--

E5

unassigned

--

E6

OEM-specific

--

E7-E8

unassigned

--

E9-F5

OEM-specific

VK_ATTN

F6

VK_CRSEL

F7

VK_EXSEL

F8

VK_EREOF

F9

VK_PLAY

FA

VK_ZOOM

FB

VK_NONAME

FC

VK_PA1

FD
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9.6.9.9

Symbolic constant name

Value (hexadecimal)

VK_EM_CLEAR

FE

VK_LWIN

5B

VK_RWIN

5C

VK_APPS

5D

VK_LSHIFT

A0

VK_RSHIFT

A1

VK_LCONTROL

A2

VK_RCONTROL

A3

VK_LMENU

A4

VK_RMENU

A5

Touch screen or keyboard equivalent

How to Output Data from a COM Server in a Report

Introduction
To integrate user-specific data in a WinCC log, you can integrate a COM server in the reporting
system. This COM server makes a log object available in the object palette that can be selected
in the page layout editor and inserted in a page layout. The COM object then provides the userspecific data for output in the log. You find more information in section COM Provider in the
Page Layout Editor.

Available Log Objects
COM object defined by the
user

Serves to output data from data sources of the user in a WinCC log.

Requirements
● Knowledge of how to create layouts and insert log objects

Procedure
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the COM Server tab, select a COM object integrated by the user,
and drag it to the desired size in the working area.
3. The creator of the COM object makes specifications available on the connection and
selection of the data.
4. Configure the COM object in accordance with the specifications made there.
5. Save the layout.
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6. Create a print job, and select the configured page layout there.
7. Start output by means of the print job in WinCC Explorer or by means of a configured call
in a WinCC picture, for example.

Output Options
You receive information on possible output options from whoever wrote the COM object.
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9.7

Appendix

9.7.1

System Layouts for Project Documentation

Introduction
WinCC provides you with a number of system layouts that have fixed associations with print
jobs and are used for project documentation.

Print jobs and layouts in the basic WinCC system
You can start project documentation in the application or by starting the corresponding print
job in WinCC Explorer.
Name of the print job

Layout name

@Documentation Alarm Logging

@AlgCS.RPL (P)

Used for the output of the configuration data of the Alarm Logging.
@Documentation Alarm Center

@MCPCS.RPL (P)

Used for the output of the configuration data of the WinCC Explorer.
@Documentation Global Script Actions

@GSC_RACT.RPL (P)

Used for the output of the Global Script actions.
@Documentation Global Script Project function

@GSC_RPFC.RPL (P)

Used for the output of the Global Script project functions.
@Documentation Global Script Standard function

@GSC_RSFC.RPL (P)

Used for the output of the Global Script standard functions.
@Documentation Graphics Designer

@pdlpic.RPL (P)

Used for the output of the configuration data of the Graphics Designer.
@pdlpicDyn.RPL (P)

@Documentation Graphics Designer Dynamics
Used for the output of the dynamization data of Graphics Designer pictures.
@Documentation Graphics Designer Overview

@pdlpicOvr.RPL (P)

Used for the output of the picture statistics and the general display of
Graphics Designer pictures.
@Documentation Tag Logging

@TlgCS.RPL (P)

Used for the output of the configuration data of the Tag Logging.
@Documentation Text Library

@Textlibrary.RPL (P)

Used for the output of the configuration data of the Text Library.
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Name of the print job

Layout name

@Documentation User Administrator

@UACS.RPL (P)

Used to output the configuration data of the User Administrator.
@Internal Global Script Actions

@gsc_act.RPL (P)

This print job is started internally.
@Internal Global Script Project-function

@gsc_pfc.RPL (P)

This print job is started internally.
@Internal Global Script Standard-function

@gsc_sfc.RPL (P)

This print job is started internally.
@Internal Graphics Designer Actions at the object

@akt_obj.RPL (P)

This print job is started internally.
@Internal Graphics Designer Actions at the property

@akt_prop.RPL (P)

This print job is started internally.
@XREFPrintSrc
This print job is started internally.

@XREFPRINTSRC.RP
L

@XREFPrintRef

@XREFPrintRef.RPL

This print job is started internally.

Print jobs and layouts of the WinCC option Basic Process Control
Name of the print job

Layout name

@Documentation Horn

@Horn(landscape).RPL (P)

Used for the output of the configuration data of the horn
editor.
@Documentation Lifebeat Monitoring

@LBMCS.RPL (P)

Used for the output of the configuration data of the Lifebeat
Monitoring.
@Documentation LTO Component List

@LTOBausteinliste(landscape).RPL (P)

Used for the output of the configuration data of the
component list editor.
@Documentation OS Project Editor

@Projecteditor.RPL (P)

Used to print the configuration data of the OS project editor.
@Documentation Picture Tree Manager

@PTMCS.RPL (P)

Used for the output of the configuration data of the Picture
Tree Manager.
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Name of the print job

Layout name

@Documentation Signal Collection

@SCollect.RPL (P)

Used for the output of the configuration data of the signal
collection.
@Documentation Time Synchronization

@TimeSync(landscape).RPL (P)

Internal system page layouts
The page layouts listed in the table below are involved in the standard project documentation
and should not be edited. If you change these layouts, it affects project documentation.
Note
These system print jobs have fixed associations with the applications. The system print jobs
can therefore not be deleted. If necessary, you can rename the system print jobs.
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Name of the print job

Layout name

Involved in project documentation

@Global Script single Action (landscape).RPL

Involved in project documentation

@Global Script single Project Function (landscape).RPL

Involved in project documentation

@Global Script single Standard Function (landscape).RPL

Involved in project documentation

@gscract.RPL

Involved in project documentation

@gscrpfc.RPL

Involved in project documentation

@gscrsfc.RPL

Involved in project documentation

@INC-PDL object actions.RPL

Involved in project documentation

@INC-PDL object attributes.RPL

Involved in project documentation

@INC-PDL object direct interconnections.RPL

Involved in project documentation

@INC-PDL object statistics.RPL

Involved in project documentation

@INC-PDL picture actions.RPL

Involved in project documentation

@INC-PDL picture attributes.RPL

Involved in project documentation

@INC-PDL picture direct interconnections.RPL

Involved in project documentation

@INC-PDL picture drawing.RPL

Involved in project documentation

@INC-PDL picture embedded objects.RPL

Involved in project documentation

@INC-PDL picture single action.RPL

Involved in project documentation

@INC-PDL picture statistics.RPL

Involved in project documentation

@INC-PDLOBJ object actions.RPL

Involved in project documentation

@INC-PDLOBJ object attributes.RPL

Involved in project documentation

@INC-PDLOBJ object direct interconnections.RPL

Involved in project documentation

@INC-PDLOBJ object single action.RPL

Involved in project documentation

@INC-PDLOBJ object statistics.RPL

Involved in project documentation

@PDL object actions.RPL

Involved in project documentation

@PDL object attributes.RPL

Involved in project documentation

@PDL object direct interconnections.RPL

Involved in project documentation

@PDL object statistics.RPL
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9.7.2

Name of the print job

Layout name

Involved in project documentation

@PDL picture actions.RPL

Involved in project documentation

@PDL picture attributes.RPL

Involved in project documentation

@PDL picture direct interconnections.RPL

Involved in project documentation

@PDL picture drawing.RPL

Involved in project documentation

@PDL picture embedded objects.RPL

Involved in project documentation

@PDL picture statistics.RPL

Involved in project documentation

@PDLOBJLT.RPL

Involved in project documentation

@PDLPICLT.RPL

Involved in project documentation

@ptmcs (landscape).RPL

System Layouts and Print Jobs for Runtime Documentation

Introduction
WinCC provides you with a number of system layouts that have fixed associations with print
jobs and are used to log Runtime data.

Print jobs and layouts in the basic WinCC system
Name of the print job

Function of the print job

Layout name

@AlarmControl - Picture

Output the current display of the AlarmControl
in Runtime (WinCC V7 or higher).

@Alarm Control - Picture.RPL

@AlarmControl - Table

Output all messages of the select list in a table
from the AlarmControl in Runtime (WinCC V7
or higher).

@Alarm Control - Table.RPL

@FunctionTrendControl

Output the current display of the
FunctionTrendControl in Runtime (WinCC V7
or higher).

@Function Trend Control Picture.RPL

@OnlineTableControl - Picture

Output the current display of the
OnlineTableControl in Runtime (WinCC V7 or
higher).

@Online Table Control Picture.RPL

@OnlineTableControl - Table

Output of all values in a table from the
OnlineTableControl in Runtime (WinCC V7 or
higher).

@Online Table Control Table.RPL

@OnlineTrendControl - Picture

Output the current display of the
OnlineTrendControl in Runtime (WinCC V7 or
higher).

@Online Trend Control Picture.RPL

@Report Alarm Logging RT Locked
Messages

Output the locked messages

@CCAlgRtOnline
MessagesLocked.RPL

@Report Alarm Logging RT Message
Sequence

Output the message sequence report on a line
printer (WinCC V5.0 SP2 or higher).

@CCAlgRtSequence.RPL

@Report Alarm Logging RT
OnlineMessages

Output the current messages

@CCAlgRtOnline
Messages.RPL
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Name of the print job

Function of the print job

Layout name

@Report Alarm Logging RT Revolving
archive

Output the revolving archive
(prior to WinCC V5.0 SP2).

@ALRtUmA.RPL

@Report Alarm Logging RT Sequence
archive

Output the sequence archive
(prior to WinCC V5.0 SP2).

@ALRtFoA.RPL

@Report Alarm Logging RT Sequence
archive New

Output the sequence archive
(as of WinCC V5.0 SP2).

@CCAlgRtSequence
Archive.RPL

@Report Alarm Logging RT Short Term
archive New

Output the revolving archive
(as of WinCC V5.0 SP2).

@CCAlgRtShortTerm Archiv
e.RPL

@Report AlarmControl-CP

Output the messages of Alarm Control in
Runtime (in WinCC V6.2 and Classic
Controls).

@CCAlarmCtrl-CP.RPL

@Report Curve Control Contents

Is started internally and is based on a CSV
Provider (as of WinCC V6.2 as standard print
job, replaced by @Report
OnlineTrendControl-Curves-CP).

@CCCurveControlContents
(P).RPL

@Report FunctionTrendControl-CP

Output the trends of Function Trend Control in
Runtime (in WinCC V6.2 and Classic
Controls).

@CCFunctionTrendCtrlCP.RPL

@Report OnlineTableControl-CP

Output the tables of Online Table Control in
Runtime (in WinCC V6.2 and Classic
Controls).

@CCOnlineTableCtrl-CP.RPL

@Report OnlineTrendControl-Curves-CP

@CCOnlineTrendCtrl-CurvesOutput the trends of Online Trend Control in
CP.RPL
Runtime (in WinCC V6.2 and Classic
Controls; replaces the @Report Curve Control
Contents as standard print job).

@Report Runtime Message List

Output the current message list in Runtime

@Report Table Control Contents

Is started internally based on a CSV Provider. @CCTableControlContents
(P).RPL

@Report Tag Logging RT Curves New

Output Tag Logging Trends in Runtime (as of
WinCC V5.0 SP2).

@CCTlgtRtCurves.RPL

@Report Tag Logging RT Tables New

Output Tag Logging Tables in Runtime (as of
WinCC V5.0 SP2).

@CCTlgRtTables.RPL

@RulerControl - Picture

Output the current display of the RulerControl
in Runtime (WinCC V7 or higher).

@Ruler Control - Picture.RPL

@RulerControl - Table

Output all values in a table by the RulerControl
in Runtime (WinCC V7 or higher).

@Ruler Control - Table.RPL

@UserArchiveControl - Picture

Output the current display of the
UserArchiveControl in Runtime (WinCC V7 or
higher).

@User Archive Control Picture.RPL

@UserArchiveControl - Table

Output all values in a table from the
UserArchiveControl in Runtime (WinCC V7 or
higher).

@User Archive Control Table.RPL

1888

@Runtime Message List.RPL
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Print jobs and layouts of the WinCC option Basic Process Control
Note
The system print jobs provided with the WinCC scope of delivery may not be deleted. If
necessary, you can rename the system print jobs. These system print jobs have fixed
associations with the applications.

Name of the print job

Function of the print job

Layout name

@Report Alarm Logging RT
OnlineMessages Active

Output list of active messages

@CCAlgRtOnlineMessagesActive.RPL (P)

@Report Alarm Logging RT
OnlineMessages Gone

Output messages of the Gone
Out List

@CCAlgRtOnlineMessagesGone.RPL (P)

@Report Alarm Logging RT
OnlineMessages Hidden

Output Hidden Messages

@CCAlgRtOnlineMessagesHidden.RPL (P)

@Report Alarm Logging RT
OnlineMessages Hiding

Output messages to be hidden @CCAlgRtOnlineMessagesHiding.RPL (P)

@Report Alarm Logging RT
OnlineMessages New

Output messages of the New
List

@CCAlgRtOnlineMessagesNew.RPL (P)

@Report Alarm Logging RT
OnlineMessages Old

Output messages of the Old
List

@CCAlgRtOnlineMessagesOld.RPL (P)

@Report Alarm Logging RT Sequence
archive Journal

Output messages of the
Journal List

@CCAlgRtSequenceArchiveJournal.RPL (P)

@Report Alarm Logging RT Sequence
archive Operation

Output messages of the
Operation List

@CCAlgRtSequenceArchiveOperation.RPL
(P)

@Report Alarm Logging RT Sequence
archive Process

Output messages of the
Process List

@CCAlgRtSequenceArchiveProcess.RPL
(P)

@Report Asset Faceplate

Output diagnostics results of
Faceplates

@AssetFaceplate.RPL (P)

9.7.3

Filter criteria for alarm output

Introduction
When the selection criteria are transferred from the selection dialog, the filter criteria for alarm
output are transferred to the Filter Criteria for Alarm Output area. The filter criteria can be edited.
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The following conditions apply to WinCC:
● The structure consists of the elements Field, Operand and Value, with the individual
parameters separated by blanks.
Example: DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 (all messages as of
21.12.2006 with a message number greater than and equal to 100)
● Strings, date, and time must be passed in single quotation marks.
● In the DATETIME argument, the date and time of day are separated by a blank. Regardless
of the time base setting in the object properties, the output of DATETIME is based on the
time base Local Time. Exception: UTC is set as the time base: in this case, the output is
based on time base UTC.

Permissible Arguments:
Name

Type

data

Example:

DATETIME

Date

'YYYY-MM-DD
hh:mm:ss.msmsms'

DATETIME >= '2007-05-03 16:00:00'
Output of message from 05.03.2007
16:00 hours.

MSGNR

Integer

Message number

MSGNR >= 10 AND MSGNR <= 12
Output of messages with
message number 10 -12.

CLASS IN
AND
TYPE IN

Integer

- Message class ID 1-16 and
system message classes 17
+ 18

CLASS IN ( 1 ) AND TYPE IN ( 2 )
Output of messages of message class
1
message type 2.

- Message type ID 1-256 and
system message types 257,
258, 273, 274
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Name

Type

data

Example:

STATE

Integer

Value of
ALARM_STATE_xx
Only the operands
"=" and "IN(...)" are
permitted

STATE IN(1,2,3)
Output of all message that came in,
went out and were acknowledged.

ALARM_STATE_1
ALARM_STATE_2
ALARM_STATE_3
ALARM_STATE_4
ALARM_STATE_5(*)
ALARM_STATE_6(*)
ALARM_STATE_7(*)
ALARM_STATE_10
ALARM_STATE_11
ALARM_STATE_16
ALARM_STATE_17

Possible values:
1 = Came In messages
2 = Went Out messages
3 = acknowledged messages
4 = locked message
5 = released messages
6 = messages that came in and have
been acknowledged
7 = messages that came in and went
out
10 = hidden messages
11 = displayed messages
16 = messages acknowledged by the
system
17 = emergency-acknowledged
messages
The "ALARM_STATE_5",
"ALARM_STATE_6" and
"ALARM_STATE_7" states can only
be output via the "Alarm Logging
Runtime" layout. These states cannot
be selected in the AlarmControl.
(*)

PRIORITY

Integer

Message priority 0 - 16

PRIORITY >= 1 AND PRIORITY =< 5
Outputs messages that have a priority
between 1 and 5.

AGNR

Integer

PLC number

AGNR >= 2 AND AGNR <= 2
Output of messages with
AG number = 2.

AGSUBNR

Integer

AG sub-number

AGSUBNR >= 5 AND AGSUBNR <=
5
Outputs messages with AG subnumber 5.

TEXTxx

Text

Search text for
'Text1'-'Text10'

TEXT2 = "Error"
Outputs the messages whose Text2
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the messages whose Text2
corresponds with the text "Error" or
"Fault".
TEXT2 LIKE 'Error'
Outputs the messages whose Text2
includes the text "Error".

PVALUExx

Double
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Search text for
PVALUE1PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Output of process value 1 with
start value 0 and stop value 50.
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The following operands are permissible:
>= , <= , = , > , < ,IN(...),LIKE
IN(...): several values in Array separated by commas, e.g. CLASS IN( 1 ,2 ,3 ) AND TYPE
IN( 1 ,2 ,19 ,20 ,37 ,38 )
LIKE: Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1 contains
the search text Error.
The operand LIKE is only permissible for TEXT arguments.
Arguments and operands other than those mentioned above are not permissible.
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10

Creating Page Layouts

Contents
The page layout editor is a component of the Report Designer and is used to create and
dynamize page layouts for the output of reports. The page layout editor can only be used for
the project currently open in the WinCC Explorer. The layouts are saved are the basis of their
projects.
This online help will show you
● how to set up the page layout editor
● how to create and edit page layouts
● how to use objects in the object palette
● how to adapt the object properties to the requirements of your project
how to change the output options for reports and logs
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10.2

How to Start the Page Layout Editor

Introduction
The page layout editor can be opened in several standard Windows ways. The page layout
editor can only be used for the project currently open in the WinCC Explorer.

Requirement
● A project must be opened in WinCC Explorer.

Opening the Page Layout Editor
The page layout editor is called from the WinCC Explorer. The following options are available:
Navigation Window/Data Window of WinCC Explorer:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.
Double-click the "Layouts" entry in the navigation window or select "Layouts" in either the
navigation or data windows in WinCC and select "Open Page Layout" from the context menu.
The page layout editor is started and a new layout is opened.
WinCC Explorer Data Window:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.
In the navigation window, select "Layouts". The available layouts are displayed in the data
window. Double-click a page layout or select "Open Page Layout" from the context menu.
The page layout editor starts and the selected page layout is opened.

See also
The Page Layout Editor (Page 1895)
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10.3

The Page Layout Editor

10.3.1

The Page Layout Editor

Introduction
The page layout editor offers objects and tools for creating page layouts. Start the page layout
editor in WinCC Explorer.

Structure of the Page Layout Editor
The page layout editor follows the conventions set by Windows. It possesses a workspace,
toolbars, menu bar, status bar and various palettes. After opening the page layout editor, the
workspace is displayed with the default settings. You can arrange the palettes and bars to your
liking and also hide them.
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(1) The Menu Bar
The menu bar is always visible. Depending on the context, the functions in the menus are
active or inactive.

(2) The Toolbar
The toolbar provides buttons to quickly perform common commands of the page layout editor.
The toolbar can be hidden if required or moved to any location on the screen.

(3) The Font Palette
The font palette is used to change font type, size and color of text objects as well as the line
color of standard objects.

(4) The Color Palette
The color palette is used to color selected objects. In addition to the 16 standard colors, custom
colors can be defined.

(5) The Workspace
The gray area represents the printable area, the white area the page body. Each screen in the
workspace represents a layout and is saved as a separate rpl file. The layouts can be enlarged
and reduced according to the Windows standard.

(6) The Object Palette
The object palette contains the standard objects, objects for the runtime documentation, COM
server objects and objects for the project documentation. The objects are used to form a layout.

(7) The Alignment Palette
The alignment palette is used to change the absolute position of one or more objects, change
the position of selected objects relative to each other or unify the height and width of several
objects.

(8) The Zoom Palette
The zoom palette offers two options to enlarge or reduce the objects of the active layout: either
via buttons of the standard zoom factors or via a slider.

(9) The Style Palette
The style palette is used to change the appearance of a selected object. Depending on the
object, the line type, line strength or fill pattern can be changed.
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(10) The Status Bar
The status bar is located at the bottom of the screen and can be hidden if required. Among
other things, it displays tips, information about the position of the selected objects and the
keyboard setting.

See also
The Alignment Palette (Page 1908)
The Status Bar (Page 1913)
The Color Palette (Page 1911)
The Zoom Palette (Page 1910)
The Style Palette (Page 1907)
The Object Palette (Page 1899)
The Font Palette (Page 1912)
The Standard Toolbar (Page 1897)

10.3.2

The Standard Toolbar

Usage
The toolbar is located in its default position under the menu bar, on the upper edge of the page
layout editor. The buttons arranged on the toolbar allow quick and comfortable access to the
offered functionality of the page layout editor.

Contents
The standard toolbar contains buttons with the following functions:
Button

Function

Key combination

Creates a new page layout.

<CTRL+N>

Opens an existing page layout.

<CTRL+O>

Saves the current page layout.

<CTRL+S>

Cuts out the highlighted object (text or drawing object) and copies
it to the clipboard. Therefore the function is only available when an
object is highlighted.

<CTRL+X>

Copies the highlighted object (text or drawing object) to the
clipboard. Therefore the function is only available when an object
is highlighted

<CTRL+C>
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Button

Function

Key combination

Pastes the contents of the clipboard at the location of the cursor.
This function is only available, when the clipboard is not empty.

<CTRL+V>

Undoes the last actions (maximum of 30). This function is only
available when an action has been carried out.

<CTRL+Z>

Redoes the last undone action. This function is only available when <CTRL+A>
an action has been undone.
Prints the contents of the current page layout. Therefore, the
function is only available when a page layout is open.

<CTRL+P>

Makes the static part of a layout active and the dynamic part
inactive. If the static part is already active, it remains active. The
static part can be individually defined for the cover sheet, the
succeeding pages and for the closing page. The same static part
will be repeated on all of the succeeding pages.

-

Makes the dynamic part of a layout active and the static part
inactive. If the dynamic part is already active, it remains active.

-

Makes the cover sheet of a layout active and the contents of the
report and the closing page inactive. If the cover sheet page type
is already active, it remains active.

-

Makes the report contents of a layout active and the cover sheet
and closing page inactive. If the report contents page type is
already active, it remains active.

-

Makes the closing page of a log active and the cover sheet and
report contents inactive. If the closing page page type is already
active, it remains so.

-

Puts the highlighted objects in the layer in the foreground of the
layout. The objects in the foreground cover objects which lie under
them.

-

Puts the highlighted objects in the layer in the background of the
layout. Objects in the background are covered by objects lying in
front of them.

-

Switches the grid in the active window on or off.

-

Switches the "Snap to Grid" function on or off.

-

Increases the zoom factor in steps of 50%; the layout is shown
enlarged. This function is only active until the largest zoom factor
(400%) has been reached.

-

Decreases the zoom factor in steps of 50%; the layout is shown
smaller. This function is only active until the smallest zoom factor
(6.25%) has been reached.

-

Zooms to any picture section you choose. This will be adjusted to
fit the picture window.

-

Copies the properties of an object to apply them to another object. -
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Applies the previously copied properties of an object to another
object. The function is only active when properties have been
previously copied.

-

Opens a window in which the properties of the highlighted object
or object group are displayed.

-

Activates the direct help (What's this?).

<SHIFT+F1>
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Characteristics
The toolbar can be hidden or shown. It can be attached under the menu bar. When it is not
attached it can be positioned anywhere on the screen with the mouse.

See also
How to Change the Standard Toolbar (Page 1916)
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)

10.3.3

The Object Palette

10.3.3.1

The Object Palette

Usage
The object palette contains object types that can be inserted into the page layout. Static objects
and system objects are available for the visual construction of the page layout. Dynamic objects
are available for data output.

Contents
The objects in the object palette can be summarized in the following 4 object groups:
● Standard objects: static objects, dynamic objects and system objects
● Objects of the runtime documentation: for example Alarm Logging RT, user archive runtime,
CSV provider,etc.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1899

Creating Page Layouts
10.3 The Page Layout Editor
● COM server objects
● Project documentation objects: for example actions in the Graphics Designer, Alarm
Logging CS, Global Script, etc.

Operation
Click one of the tabs and select the object you want.

Characteristics
The object palette can be shown and hidden. It can be moved anywhere on the screen with
the mouse.

See also
Standard Objects (Page 1900)
Objects for the Project Documentation (Page 1906)
COM Server Objects (Page 1905)
Objects for the Runtime Documentation (Page 1904)

10.3.3.2

Standard Objects

Standard Objects
Usage
Standard objects contain object types that are used to visually construct the page layout.
Dynamic object types can also be used for this, unlike objects for runtime documentation and
project documentation, which are not connected to the WinCC components.

1900
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Overview
Standard objects can be divided into three object classes:
● Static objects are used for the visual creation of a page layout. You can insert static objects
into both the static and dynamic parts of a page layout.
● Dynamic objects can be connected with data sources which have a valid data format for
the current object. That way these data can be output in a WinCC layout. You can only
insert dynamic objects in the dynamic part of the page layout.
● System objects are used as placeholders for the system time, the current page number
and the project and layout names. You can only use system objects in the static part of the
page layout. The required entries are described in the "Format" attribute in the
"Miscellaneous" property of the system object.

Shared Properties
● The object properties (e.g. geometry, color) of the individual standard objects are preset.
However, these defaults can be changed. The objects are displayed with the standard
object properties.
● The properties of the displayed objects can be changed at any time.

See also
How to Change an Attribute (Page 1953)
Working with Standard Objects (Page 1966)
Overview of the System Objects (Page 1903)
Overview of the Dynamic Objects (Page 1902)
Overview of the Static Objects (Page 1901)

Overview of the Static Objects
Introduction
Static objects are used for the visual creation of a page layout. You can insert standard objects
in both the static and dynamic parts of a page layout.

Overview
Icon

Object

Description

Line

The line is an open object. The length and angle of a line are determined
by the height and width of the rectangle around the object.

Polygon

The polygon is a closed object that can be filled with a color or pattern.
A polygon can have any number of corner points; these are numbered
in the order of their creation and can be changed individually, or even
deleted.
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Icon

Object

Description

Polyline

The polyline is an open object. Even if the start and finish point have
the same coordinates, the area cannot be filled. A polyline can have
any number of corner points; these are numbered in the order of their
creation and can be changed individually, or even deleted.

Ellipse

The ellipse is a closed object that can be filled with a color or pattern.
The height and width of an ellipse can be modified as desired to allow
it to be aligned horizontally or vertically.

Circle

A circle is a closed object that can be filled with a color or pattern. A
circle can be resized at will.

Ellipse segment

The ellipse segment is a closed object that can be filled with a color or
pattern. The height and width of an ellipse segment can be modified as
desired to allow it to be aligned horizontally or vertically.

Pie segment

The pie segment is a closed object that can be filled with a color or
pattern. A pie segment can be resized at will.

Ellipse arc

The ellipse arc is an open object. The height and width of an ellipse arc
can be modified as desired to allow it to be aligned horizontally or
vertically.

Circular arc

The circular arc is an open object. A circular arc can be resized at will.

Rectangle

The rectangle is a closed object that can be filled with a color or pattern.
The height and width of a rectangle can be modified as desired to allow
it to be aligned horizontally or vertically.

Rounded
rectangle

The rounded rectangle is a closed object that can be filled with a color
or pattern. The height and width of a rounded rectangle can be modified
as desired to allow it to be aligned horizontally or vertically. The corners
of a rounded rectangle can rounded as much as desired.

Static text

The field for static text is a closed object that can be filled with a color
or pattern. The static text is entered into a field of any desired size. The
text can be entered on one or more lines.

OLE object

You can import the contents of a file or new object into a layout with
any data type, e.g. an Adobe Acrobat document.

Static metafile

You can insert graphic data into a layout with the "Static Metafile"
object. The graphic files must be in the *.emf (Enhanced Meta File)
format.

See also
Overview of the System Objects (Page 1903)
Overview of the Dynamic Objects (Page 1902)
Standard Objects (Page 1900)

Overview of the Dynamic Objects
Introduction
With dynamic objects, you can set the data you want to output in a report/log from different
data sources. You can only insert dynamic objects in the dynamic part of the page layout.
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Overview
Icon

Object

Description

Embedded layout Layouts for the project documentation can be nested with the
"Embedded Layout" dynamic object. The object is only used for the
project documentation in ready-made layouts for WinCC.
Hard copy

With the "Hard Copy" object type, you can output a picture of the
current screen, contents or a defined section of it, in a log. You can
also output a currently selected picture window.

ODBC database
field

With the "ODBC Database Field" object type, you can output texts
from some data sources into a log via the ODBC interface.

ODBC database
table

With the "ODBC Database Table" object type, you can output tables
from some data sources into a log via the ODBC interface.

Tag

Output the "Variable" values in runtime with the Tag object type. Tag
values can only be output if the project is activated. In runtime you can
also call a script for the output.

See also
Overview of the System Objects (Page 1903)
Overview of the Static Objects (Page 1901)
Standard Objects (Page 1900)

Overview of the System Objects
Introduction
System objects are used as placeholders for the system time, current page number of the
report and project and layout names. You can only use system objects in the static part of the
page layout.

Overview
Icon

Object

Description

Date/time

Insert a placeholder for the date and time of the output in the page layout
with the "Date/Time" system object. During printing, the system date and
time are added by the computer.

Page number

Insert a placeholder for the current page number of the report or log in
the page layout with the "Page Number" system object.

Project name

Insert a placeholder for the project name in the page layout with the
"Project Name" system object.

Layout name

Insert a placeholder for the layout name in the page layout with the
"Layout Name" system object.
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See also
Standard Objects (Page 1900)
Overview of the Static Objects (Page 1901)
Overview of the Dynamic Objects (Page 1902)

10.3.3.3

Objects for the Runtime Documentation

Usage
The runtime documentation objects are for outputting logs of the runtime data. The output
options can be configured using the "Object Properties" dialog. The data for the logs are taken
from the linked data sources at the time of the output. You can only insert the runtime
documentation objects in the dynamic part of the page layout.

Overview

1904

Object

Description

Alarm Logging RT
Archive Log

The "Archive Report" object is connected to the message system and outputs
the messages saved in the message archive to a table.

Alarm Logging RT
Message Log

The "Message Report" object is connected to the message system and outputs
the current messages in the message list to a table.

User archive
Runtime
Table

The "User Archive Runtime Table" object is connected to the User Archive and
outputs the runtime data from the user archives and views to a table.

CSV provider table

The "CSV Provider Table" object can be linked to a CSV file. The data contained
in the file are output to a table. The data must be in a predefined structure.
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Object

Description

CSV Provider
Trend

The "CSV Provider Trend" object can be linked to a CSV file. The data contained
in the file are output in a curve. The data must be in a predefined structure.

WinCC Alarm Control The "WinCC Alarm Control/Table" object is used to output the message lists in
Table
a tabular format. You configure the static and dynamic parameters of the control
for the output in Reports Designer.
WinCC Control
Runtime
Printprovider
Table

The entire contents of the table of a WinCC control is output in the table. The
report object is not available for the WinCC OnlineTrendControl and WinCC
FunctionTrendControl. The report can only be output via the button in the
WinCC control.

WinCC Control
Runtime
Printprovider
Picture

The current control display is output in the picture. The report can only be output
via the button in the WinCC control.

WinCC Function
Trend Control
Picture

The "WinCC Function Trend Control/Picture" object is used to output process
data as function of another tag from the process value, compression and user
archives in the form of a trend. You configure the static and dynamic parameters
of the control for the output in Reports Designer.

WinCC Online Table
Control
Table

The "WinCC Online Table Control/Table" object is used to output process data
from the associated process value archives and compressed archives in a
tabular format. You configure the static and dynamic parameters of the control
for the output in Reports Designer.

WinCC Online Trend
Control
Picture

The "WinCC Online Trend Control/Picture" object is used to output process data
from the associated process value archives and compressed archives in trend
curve format. You configure the static and dynamic parameters of the control
for the output in Reports Designer.

Shared Properties
● The object properties (e.g. font) of the individual objects are preset. However, these defaults
can be changed. The objects are displayed with the default object properties.
● The properties of the displayed objects can be changed at any time.

See also
How to Change an Attribute (Page 1953)
Working with Objects for the Project Documentation (Page 2046)
Working with Objects for the Runtime Documentation (Page 2011)

10.3.3.4

COM Server Objects

Usage
In order to use a COM server object, a COM server projector must be integrated into WinCC.
This COM server makes the object for logging data available. This way, it is possible to
integrate user-specific data in a WinCC log. The form and properties of a COM server object
are determined by the COM server writer. The description of the COM server object is delivered
with the COM server writer. The options for selecting the output data are determined by the
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current COM server object. The COM server objects can only be inserted into the dynamic
part of a page layout. Additional information can be found in chapter "Working with COM Server
Objects".

10.3.3.5

Objects for the Project Documentation

Usage
The project documentation objects are provided for the report output of configured data. The
objects for project documentation can only be inserted into the dynamic part of a page layout.

The objects for project documentation are closely connected with the WinCC components.
The object types are fixed. Depending on the type and size of the configuration data for the
output, the "Static Text", "Dynamic Metafile" or "Dynamic Table" object types are used. A
detailed description of the objects used and the output data can be found in chapter "Outputting
Project Documentation".
For some of the objects used with the "Dynamic Metafile" and "Dynamic Table" object types,
you can change the selection of the configuration data for output. Additional information can
be found in chapter "Working with Objects for Project Documentation".

Shared Properties
● The object properties (e.g. font) of the individual objects are preset. However, these defaults
can be changed. The objects are displayed with the default object properties.
● The properties of the displayed objects can be changed at any time.

See also
How to Change an Attribute (Page 1953)
Working with Objects for the Runtime Documentation (Page 2011)
Working with Objects for the Project Documentation (Page 2046)
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10.3.4

The Style Palette

Usage
The line type, line weight and background pattern of the selected object can be changed with
the style palette. Depending on the object type, different style forms are available.

Contents
● The "Line Type" style group contains different line types, such as dashed, dotted, etc.
● The "Line Weight" style group contains different line weights. The line weight is given in
pixels. 1 mm = 4.73 pixels.
● The "Fill Pattern" style group contains fill patterns for the background of closed objects,
such as transparent, checkered, diagonal lines, etc.

Displaying the Current Settings
The currently selected settings are displayed in "bold" font.

Characteristics
The style palette can be shown or hidden. It can be placed anywhere on the screen with the
mouse.

See also
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)
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10.3.5

The Alignment Palette

Usage
The alignment palette is used to:
● change the absolute position of one or more objects
● change the position of the selected objects relative to one another
● align the heights and widths of several objects.

Requirements
The palette buttons are enabled when at least two objects are highlighted.

Overview
Button

Function
Align objects left.
The type of selection determines which object is used as reference for alignment.
If the objects are selected with a selection frame (lasso), the object lying farthest out
will be used as reference. If the objects are selected with the left mouse button, the
object selected first will be used as reference for alignment.
Align objects right.
See section "Align Objects Left" to determine which object will be used as reference for
alignment.
Align objects top.
See section "Align Objects Left" to determine which object will be used as reference for
alignment.
Align objects bottom.
See section "Align Objects Left" to determine which object will be used as reference for
alignment.
Align objects on horizontal center.
The objects are moved to be aligned along a common central horizontal axis.
Align objects on vertical center.
The objects are moved to be aligned along a common central vertical axis.
Distribute objects evenly in horizontal direction.
The objects maintain the same horizontal distance from one another.. The location of
the outer objects remains unchanged.
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Button

Function
Distribute objects evenly in vertical direction.
The objects maintain the same vertical distance from one another.. The position of the
upper and lower objects remains unchanged.
Standardize width of objects.
If the objects were selected with the left mouse button, they receive the width of the first
object selected. The width of lines remains however unchanged.
If the objects were selected using a selection frame (lasso), the widths will be adjusted
to the largest width in the group.
Standardize heights of objects.
If the objects were selected with the left mouse button, they receive the height of the
first object selected.
If the objects were selected using a selection frame (lasso), the heights will be adjusted
to the largest height in the group.
Standardize width and height of objects.
The objects receive the width and height of the first object configured in the group.

Characteristics
The alignment palette can be show and hidden. It can be placed anywhere on the screen with
the mouse.

See also
How to Select Multiple Objects (Page 1944)
How to Align Multiple Objects (Page 1945)
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)
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10.3.6

The Zoom Palette

Usage
The zoom factor for the objects in the active layout is set with the zoom palette. The current
zoom factor is displayed under the slider. The zoom palette offers two options for enlarging or
reducing the objects:
● using buttons with standard zoom factors (e.g. 8, 1/2)
● using a slider.

Characteristics
The zoom palette can be shown and hidden. It can be placed anywhere on the screen with
the mouse.
Note
The zoom factor can also be set incrementally using the
toolbar.

and

buttons in the standard

See also
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)
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10.3.7

The Color Palette

Usage
Selected objects can be assigned one of the 16 standard colors, a primary color or a selfdefined color with the color palette. For example, one mouse click in the color palette can
change:
● the fill color for area objects (e.g. rectangle),
● the line color for line objects (e.g. polyline),
● the background color of text objects.

Characteristics
The color palette can be shown and hidden. It can be placed anywhere on the screen with the
mouse.

See also
The Colors Property Group (Page 1956)
How to Create Custom Colors (Page 1914)
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)
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10.3.8

The Font Palette

Usage
A new text object or another object which contains text will be created with preset text
properties. The font palette contains tools for changing the font, size and color of text objects,
as well as the line color of standard objects, at any time.

Overview
Button

Description
Changing font
Change font size
Change font color
Change line color.
For area objects, this function influences the color of the borderline
and for line objects it influences the line color.

Characteristics
The font palette can be shown and hidden. It can be placed anywhere on the screen with the
mouse.
Note
Additional text properties, such as orientation, italic, bold, underline, are changed in the
"Object Properties" window.

See also
The Font Property Group (Page 1961)
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Arrange the Toolbar and Palettes (Page 1915)
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10.3.9

The Status Bar

Usage
The status bar provides you with the following information:
● help text for a selected functions, menu commands and buttons
● information about the name, position and size of a highlighted object
● information about the keyboard status (e.g. the NUM LOCK key).

Characteristics
The status bar can be shown or hidden.

See also
How to Show and Hide the Toolbar and Palettes (Page 1915)

10.3.10

Customizing the Working Environment

10.3.10.1 Customizing the Working Environment
Operator Elements of the Page Layout Editor
You can adjust the following operator elements to your personal needs:
● The toolbars can be shown and hidden.
● Icons can be added to and removed from the standard toolbar.
● Changes to the standard toolbar can be blocked or allowed.
● Toolbars and palettes can be arranged elsewhere on the screen.
● The appearance of the toolbar can be changed.
● The display of the keyboard shortcuts in the menus can be switched off.

Basic Page Layout Editor Settings
You can adjust the following functions in the page layout editor to your personal needs:
● Snap objects to the grid or not
● Hide or show the grid
● Grid width and height in pixels, centimeters or inches
● Defining the type of object selection surrounding or touching
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● Object types in the object palette can be selected or deselected according to the insertion
of an object
● Configuration settings for the page layout editor can be saved or not when quitting the
program
● Storage type and path for the objects' default settings

See also
The Basic Settings of the Page Layout Editor (Page 1918)
How to Change the Appearance of the Toolbar and Palettes (Page 1922)
How to Change the Standard Toolbar (Page 1916)
How to Arrange the Toolbar and Palettes (Page 1915)
How to Show and Hide the Toolbar and Palettes (Page 1915)

10.3.10.2 How to Create Custom Colors
Introduction
In addition to the 16 basic colors from the Color Palette, you are free to define other colors.

Procedure
1. On the color palette, click

. The "Colors" dialog is opened.

2. Click the primary color that comes closest to the color to be created.
3. To change the selected color, open the color matrix using the "Define Colors" button.
4. Change the brightness of the selected color with the slider to the right of the color matrix.
5. Change the saturation of the selected color by vertically moving the cross.
6. Change the color by horizontally moving the cross.
7. To define the properties of the color more precisely, enter the values for the color,
saturation, brightness, and the red, green and blue amounts.
8. To accept the color in the user-defined palette, click the "Add Colors" button.
9. Close the dialog by clicking "OK". The newly defined color is saved.
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See also
The Colors Property Group (Page 1956)
The Color Palette (Page 1911)

10.3.10.3 How to Show and Hide the Toolbar and Palettes
Introduction
Normally, the standard toolbar and palettes are shown. In order to obtain a larger working area,
you can hide palettes that you do not need and the standard toolbar and show them again as
required.

Procedure
1. Open the "View" menu and select the "Toolbars..." option. The "Toolbars" dialog is opened.
2. Clear the check box for the toolbar to be hidden. Alternatively, select the check box for the
toolbar to be shown.
3. If the dialog should remain open so that you can make additional settings on other tabs,
click "Apply".
4. If you would like to restore the most recently saved settings, click the "Restore" button.
5. Apply the new settings with "OK". The settings will be saved and the dialog is closed.

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1922)
How to Change the Standard Toolbar (Page 1916)
How to Arrange the Toolbar and Palettes (Page 1915)

10.3.10.4 How to Arrange the Toolbar and Palettes
Introduction
The standard toolbar and the palettes are normally arranged along the edge of the screen.
You can remove them from their anchoring, change their size and move them anywhere you
like. The toolbar and palettes can be reanchored in any location.
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Special features
● The size of a palette can only be changed when it is not anchored.
● When you reanchor a palette, its size will not be adjusted to the free space on the edge of
the screen. Therefore, you must adjust the size of the palette to fit the free space before
anchoring it.
● When you close the page layout editor, the changed palette positions are saved and used
again the next time the program is started.

How to Undock the Palette
1. Click on the narrow, outer edge of the palette, hold down the mouse button and drag the
palette into the working area. Now you can resize the palette as desired in the normal
Windows way.

Procedure for Restoring the Original Position
1. Open the toolbar dialog by selecting the menu "View" > "Toolbars...".
2. Click the "Restore" button.

Procedure for Docking the Palette
1. Adjust the size of the palette to the free space on the edge of the screen.
2. Click on the title bar of the palette, hold down the mouse button and drag the palette to the
free space on the edge of the screen. The position of the cursor determines the place where
the palette will be anchored. If the palette is to be moved between two others, the cursor
should be placed on the lower edge of the upper palette.
Note
The changes in position can be undone, so long as the page layout editor is open; changes
you have made will be saved when the program is closed.

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1922)
How to Show and Hide the Toolbar and Palettes (Page 1915)

10.3.10.5 How to Change the Standard Toolbar
Usage
You can use drag and drop to adjust the standard toolbar to your requirements, that is adding,
removing or rearranging buttons.
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Requirements
On the "Menu/Toolbars" tab in the "Settings" window of the "Tools" menu, all of the checkboxes
in the "Standard Toolbar" area must be marked.

Procedure for Removing Buttons
1. Hold down the "Alt" key.
2. Use the mouse to drag the button from the toolbar.

Procedure for moving buttons
1. Hold down the "Alt" key.
2. Use the mouse to drag the button to another place on the toolbar.

Procedure for Adding/Removing Buttons
1. Hold down the "Alt" key.
2. Double-click a button. The "Customize Toolbar" window opens.

3. Add: Drag the desired button from the Available buttons list to the Current Buttons list.
Remove: Drag the desired button from the Current Buttons list to the Available Buttons list.
4. Set the order of the buttons on the toolbar using the "Move up" and "Move down" buttons
in this dialog.
5. You can restore the original state by clicking on the "Reset" button.
6. The changes will be applied and the dialog closed when you click on the "Close" button.

See also
How to Arrange the Toolbar and Palettes (Page 1915)
How to Show and Hide the Toolbar and Palettes (Page 1915)
How to Change the Appearance of the Toolbar and Palettes (Page 1922)
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10.3.10.6 The Basic Settings of the Page Layout Editor
The Basic Settings of the Page Layout Editor
Usage
In the Settings window, you can make basic settings in order to adjust the appearance and
behavior of the page layout editor to meet your needs. The settings will be saved and retained
when you open the page layout editor again.

Calling:
The window can be called
● from the menu Tools > Settings and
● from the menu View > Grid.

Setting Options
Tab

Description

Grid

This is where you can set:
● whether the objects should snap to the grid,
● whether the grid should be visible,
● the distance between the grid points

Options

1918

This is where the fundamental program settings are changed, for example what should
happen with altered program settings when the program is closed, or how objects should
be selected and edited.
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Tab

Description

Units

This is where you choose which units of measurement you would like to use for entering
the size of coordinates, text height and line width.

Menu /
Toolbars

This is where the appearance and properties for the menu bar, toolbar and palettes can
be set, for example whether the standard toolbar should be configurable, whether the
keyboard shortcuts should be shown, etc.

See also
How to Paste an Object into a Layout (Page 1939)
How to Set the Options for the configuration settings (Page 1920)
How to Set the Grid (Page 1919)

How to Set the Grid
Usage
In order to be able to work precisely in the working area, you can show a grid on the working
area with the "Display Grid" function. If you also have the "Snap to Grid" function switched on,
all newly created objects will be automatically aligned to the grid points.

Possible settings
Snap to Grid Determines whether the objects should be positioned anywhere on the drawing
area or aligned to the grid.
Display grid Determines whether the grid should be visible or not. If the grid is invisible,
objects still align to it when the "Snap to Grid" option is switched on.
Width in/
Changes the distance between grid points as necessary. Set the units for the
Height in
size entry in the "Units" tab. The grid width to be set is oriented to the size and
variety of objects and to the desired positioning precision.

Procedure
1. In the "Options" menu, select the "Settings" entry. The "Settings" dialog opens.
2. Change the individual settings as required by marking or clearing the check boxes.
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3. If you want to keep the dialog open to make changes in other tabs, confirm the changes
you have made with the "Apply" button.
4. Save the settings with "OK".
Note
The minimum grid separation that can be displayed on the screen is 10 pixels. If you set
a smaller value (e.g. 6 pixels), you can still align your objects to this grid, but the next even
numbered multiple of this value > 10 pixels will be displayed on the screen (in this case
12 pixels).

See also
How to Set the Options for the configuration settings (Page 1920)
How to Change the Appearance of the Toolbar and Palettes (Page 1922)

How to Set the Options for the configuration settings
Usage
On the options tab, you can set whether the configuration settings in this dialog are saved
when the program is closed. This is also where you can choose the method of selecting objects.
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Possible settings
Save settings on exit
Object selection
Surrounding/touching

Always reset object type
selection

Determines whether the settings for the page layout editor are
saved when the program closes.
Surrounding: A frame will be drawn when the left mouse button is
held down, so that all objects that are completely within this frame
will be selected.
Touching: A frame will be drawn when the left mouse button is
held down, so that all objects touched by this frame will be
selected.
If this option is enabled, an object will be deselected as soon as it
is pasted into the layout. If the option is disabled, the object will
remain selected after it has been pasted into the layout. With this
method, you can paste the same object several times without
having to reselect the object.

Procedure
1. In the "Options" menu, select the "Settings" entry. The "Settings" dialog opens.
2. Click the Options tab.
3. Change the individual settings as required by marking or clearing the check boxes.
4. If you want to keep the dialog open to make changes in other tabs, confirm the changes
you have made with the "Apply" button.
5. Save the settings with "OK".

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1922)
How to Set the Grid (Page 1919)
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How to Change the Appearance of the Toolbar and Palettes
Usage
The appearance of the standard toolbar and the palettes in the page layout editor can be
adjusted to meet your requirements and preferences.

Possible settings
Flat style for toolbars Determines whether the buttons on the toolbar and palettes are
displayed with a border or without.
Display move handles Determines whether the buttons on the toolbar and palettes are
displayed with move handles or without.
Display buttons in the Determines whether the buttons on the toolbar will be shown in the
menu
menus on the menu bar.
Display all shortcuts Determines whether the keyboard shortcuts for the menu commands
will be shown in the menus on the menu bar.
Deactivated buttons in Determines whether deactivated buttons on the toolbar and palettes
color
are displayed in color or grayed out.
Standard toolbar:
Determines whether the standard toolbar can be changed. If this option
customizable
is enabled, the "Toolbar" dialog can be opened with [ALT+double-click].
Standard toolbar:
If this option is enabled, the icons on the toolbar can be moved or
Drag&drop with ALT removed with the mouse by holding down the ALT key.
key active
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Procedure
1. In the "Options" menu, select the "Settings" entry. The "Settings" dialog opens.
2. Click the Menu/Toolbars tab.
3. Change the individual settings as required by marking or clearing the check boxes.
4. If you want to keep the dialog open to make changes in other tabs, confirm the changes
you have made with the "Apply" button.
5. Save the settings with "OK".

See also
How to Change the Standard Toolbar (Page 1916)
How to Arrange the Toolbar and Palettes (Page 1915)
How to Show and Hide the Toolbar and Palettes (Page 1915)
The Standard Toolbar (Page 1897)
How to Set the Options for the configuration settings (Page 1920)
How to Set the Grid (Page 1919)
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10.4

Working with Layouts

10.4.1

Working with Layouts

Introduction
The difference between a layout in the sense of a file and a layout as an object must be clearly
understood. In this chapter, we will describe dealing with a layout in the form of a file. A layout
opened in the page layout editor is treated as an object. The layout object has object properties
and can be edited accordingly. Additional information can be found in the chapter "Working
with the layout object".
In this chapter we will show you how to create layouts, display the properties of layouts and
how to work with several layouts. WinCC comes with several ready-made layouts for most
standard applications. So it is often simpler and less time consuming to save one of these
layouts under a new name and adapt it to your own requirements, than to create a new layout.
Note
Language-Neutral and Language-Dependent Layouts
There are language-neutral and language-dependent layouts. Language-neutral layouts
have the following designation: "<Name of the layout>.rpl". Language-neutral layouts are
saved in folder "\\<Name of system on which the layout was created>\Project name\PRT".
Language-dependent page layouts contain layout files with the following designation:
"<Name of the layout>_XXX.rpl". "XXX" stands for the language code of the layout file. The
language-specific layout file is saved in a language-specific folder in folder "\\<Name of the
system on which the layout was created>\Project name\PRT".
Create layout files in all Runtime languages for a language-dependent layout. If the layout
file of a Runtime language is missing, the English layout file will be used.
The following table shows the language code and the designations of the folders in folder "\
\<Name of the system on which the layout was created>\Project name".
Language

Language Code in File Names

Language-neutral
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Language-specific folder
\PRT

German

DEU

\PRT\DEU

English

ENU

\PRT\ENU

French

FRA

\PRT\FRA

Italian

ITA

\PRT\ITA

Spanish

ESP

\PRT\ESP

Simplified Chinese

CHS

\PRT\CHS

Traditional Chinese

CHT

\PRT\CHT

Korean

KOR

\PRT\KOR

Japanese

JPN

\PRT\JPN

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.4 Working with Layouts

Configuration steps
1. Create a new page layout.
2. Design the outward appearance in the static part of the layout and save the newly designed
layout as a template.
3. Apply the design in the layout for the output.

Editing Options
In order to configure quickly, use the various program functions such as:
● Save Layout under New Name
● Applying Object Properties to Other Objects
● Coping or Transferring Objects in Other Layouts
● Adopting Fully Designed Objects and Layouts from Other Projects
Note
This path of the layouts is retained when you duplicate a project or load it on a target
machine. While printing, the system first tries to load the layout using the entered path. If
that is not possible, the system searches the layout in the project path of the local computer.

See also
Working with Objects (Page 1935)
Working with Multiple Layouts (Page 1932)
Changing Predefined Layouts (Page 1930)
How to Display the Layout Properties (Page 1929)
Layout File Operations (Page 1925)

10.4.2

Layout File Operations

Introduction
Because layouts are saved as independent files with the extension .rpl, you can carry out the
usual file operations in the page layout editor or in WinCC Explorer. Many file operations can
be carried out in the page layout editor and the WinCC Explorer. Layouts are saved as separate
files.

Layout files of language-neutral layouts
The layout file of a language-neutral layout is saved in the "PRT" folder of the WinCC project.
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Layout files of language-dependent layouts
You must create layout files in the Runtime languages for a language-dependent layout. The
name of the layout file contains the language code, e.g. NewRPL01_ENU.RPL and
NewRPL01_ESP.RPL.
The "PRT" folder of the WinCC project contains a folder for each language installed with
WinCC. The language-specific layout files must be saved in the corresponding languagespecific folder. The current Runtime language determines which layout file is used.
1. Single-language configuration
You are making configurations in English for English-speaking operators.
New layouts are saved e.g. under the file name "NewRPL01_ENU.RPL". The layout file is
saved in folder "\\<Name of computer>\Project name\PRT".
Alternatively, create your own new layouts as language-neutral layouts.
2. Multilingual configuration
You are making configurations for English-speaking and Spanish-speaking operators. The
"NewRPL01" layout must be saved in 2 layout files:
– "NewRPL01_ENU.RPL" in folder "\\<Name of the computer>\Project name\PRT\ENU"
– "NewRPL01_ESP.RPL" in folder "\\<Name of the computer>\Project name\PRT\ESP"
In the case of multi-language configurations, be sure to make all changes, copies and
deletions to all layout files of a layout.
You can also create language-neutral layouts.

Adding a Layout Language
If you need reports and documentation in other languages, you must create languagedependent layouts. To do this, you must add the language.
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry and open its context menu.
3. Select the "Add Language ..." command.
4. Select the desired layout language from the list.
In WinCC <V7.2 you can only add language-specific folders that use the same code page.
If you need to edit layout files in languages that need another codepage, you must set up
the associated system locale (operating system language) in the system control of your
operating system.
WinCC as of V7.2 supports Unicode. This means that you can edit layout files in languages
that belong to different system locales.
The new language folder is created under the "Layouts" entry. Layout files of the current
language are listed in the right window.
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Creating Layout
To create a new report, you first have to create a new layout. Page layouts contain layout files
with ending ".rpl".
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry and open its context menu.
3. If necessary, create a new layout language with the "Add Language ..." command.
The layout files of the current language are listed in the right window.
4. Select the desired layout language or the "Language neutral" entry.
5. Select the command "New page layout" from the context menu. A new file with the name
"NewRPLxx.RPL" is created. The numbers in the file names increase consecutively.
6. In order to open the file select "Open page layout" from the layout context menu.
7. The newly created layout is opened in the page layout editor.

Alternative Operation
You can also create a new layout file in the open page layout editor. To do this, select "New"
from the "File" menu. The page layout editor creates an empty layout file. Save the layout file
under the desired name and in the correct folder.

Saving Layout
Note
Language Code in the Layout File
When saving the file, enter the correct language code in the file name, e.g.
NewRPL01_ENU.RPL. Save the layout file in the correct language folder.
1. Select "Save as..." from the "File" menu in the page layout editor.
2. If you choose "Save as...", a dialog will open.
– Navigate to the correct folder.
– Enter a file name and a language code and save the layout file.
3. The layout file receives extension .rpl.

Opening Layout
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry.
The existing language directories are displayed in WinCC Explorer.
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3. Select the desired language folder and open its context menu.
The layout files of the current language are listed in the right window.
4. Select the desired layout file and select the "Open page layout" command from the context
menu.

Alternative Operation
If the page layout editor has already been started, you can select "Open" from the "File" menu.
In the file selection dialog, navigate to the desired language directory. Select the desired layout
file and then click on "Open".

Copying a Layout File
You can save layout files under other names and thus copy them, for example to create
variants.
1. Open the layout file to be copied in the page layout editor.
2. To do this, select "Save As..." from the "File" menu.
The Save As... dialog opens.
3. Give the layout file a new name and save the layout file.

Renaming a Layout File
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer.
3. Select the desired language folder.
All project layout files in the selected language are listed.
4. Select the desired layout file and select the "Rename page layout" command from the
context menu.
The New Name dialog: is opened.
5. Change the name of the selected layout file and click on the "OK" button. Please pay
attention to the note below.

Deleting a Layout File
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer.
3. Select the desired language folder.
All project layout files in the selected language are listed.
4. Select the desired layout file and select the "Delete page layout" command from the context
menu. The layout file will be deleted without a confirmation.
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Note
The system layouts supplied with WinCC are integrated into the project documentation. To
use one of the system layouts for your own purposes, simply save it under a new name. You
can recognize the system layouts by the "@" suffix in the file name. Do not use this symbol
to name custom layouts.
If you wish to create a page layout using the SIMATIC Manager, you cannot rename or delete
this layout in WinCC Explorer. This also applies to a page layout created in WinCC and
subsequently imported into SIMATIC Manager using the function "Import WinCC Object".
This import transforms the WinCC object into a TIA object.
If you copy a page layout using the Report Designer, the copy is created as a WinCC object.
You may rename or copy this copy as a WinCC object.

See also
Working with Multiple Layouts (Page 1932)
Changing Predefined Layouts (Page 1930)
How to Display the Layout Properties (Page 1929)
Working with Layouts (Page 1924)

10.4.3

How to Display the Layout Properties

Usage
For each layout file, you can call the creation date, the date of last change and the file size.

Requirements
The WinCC project must be open.

Procedure
1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.
2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer.
3. Select the desired language folder.
All project layout files in the selected language are listed.
4. Select the desired layout file and select the "Properties" entry from the context menu.
The "Properties" window opens.
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See also
Working with Multiple Layouts (Page 1932)
Changing Predefined Layouts (Page 1930)
Working with Layouts (Page 1924)
Layout File Operations (Page 1925)

10.4.4

Changing Predefined Layouts

Introduction
You can change the predefined layouts in order to fit your needs better. It is advisable to save
an existing layout file with a new name first and only then to edit the layout file. If you do this,
you can always fall back on the layouts provided with WinCC if you need to.
The system layouts and system print jobs delivered with WinCC are used by the WinCC
components when the report output is triggered (e.g. project documentation in the Graphics
Designer). The system print jobs can therefore not be deleted. If necessary, you can rename
the system print jobs.
The system files are located in the WinCC directory in the language-specific folders under
folder "..\WinCC\syslay". The language-specific folders in a new project are copied to the
corresponding project directory in the "..\<Project name>\PRT" folder the first time it is
accessed.
The system layouts and system print jobs are created for every new project.

How to Make Changes to the Static Part of a Layout
The header and footer are defined in the static part of a page layout. You can also change the
appearance of the report without changing the dynamic properties of the layout. The static part
of a page in the page layout extends across the entire printable area of the report. You can
individually define the static part for the cover sheet, the report contents and the closing page.
Static objects and system objects are available to you for the design.
The same static part will be repeated on all the succeeding pages of the report contents.
How to activate the static report part:
1. Select "Static Part" from the "View" menu.
Or
activate the static report part using the toolbar.
2. Next add static objects or system objects.

Changes in the dynamic part of a layout
You put together the structure and content of the report for output in this part of the page layout.
There are static, dynamic, and system objects available for defining the report contents. If
necessary, the dynamic part of the contents of the report is spread across the various
subsequent pages at output, since it is not known until the time of output how much data there
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is. The first object in the vertical direction in a layout is automatically moved to the upper
dynamic edge during output.
Important:
During the definition of a page layout, you can not predict with absolute certainty on how many
pages the dynamic part will require. The size of the dynamic tables and text fields is determined
by the data which is used at the moment of output. Succeeding objects are moved downward
according to the dynamic size changes.
Generally no line breaks are provided for the output of data in table cells. However, you can
output large amounts of data in a table cell without the data being cut off by:
1. Select the output of the report in landscape format.
2. Select the "Vertical" table format in the table object properties.
3. Set the relative column width of all columns as narrowly as possible.
4. Use the smallest font size possible.
Static objects which are pasted into the static part of a page layout are in a layer below the
dynamic objects. Thus, it can happen that the static objects will be covered by the dynamic
objects, especially by the dynamic extension of a table.
How to enable the report contents for editing:
1. Select "Dynamic Part" from the "View menu".
Or
activate the dynamic report part using the toolbar.
2. Next add static, dynamic or system objects.
3. For dynamic objects, then select the data for output from the "Connect" tab in the
"Properties" dialog.
Note
If you use the "WinCC Control Runtime Printprovider" layout as of WinCC V7, the dynamic
portion of the report is determined by the underlying control. In the "Link" tab, configure
the properties of the picture or table in the layout.

Editing the Objects
Objects in the layout are edited using the "Object properties" dialog. This can be opened using
the toolbar, the pop-up menu for the objects or by double-clicking an object. Please see
"Working with Objects" for more information.

See also
Changing Predefined Layouts (Page 1930)
How to Display the Layout Properties (Page 1929)
Working with Layouts (Page 1924)
Layout File Operations (Page 1925)
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10.4.5

Working with Multiple Layouts

Introduction
The page layout editor offers your some options for efficient configuration. In order not to have
to keep repeating the same configuration steps, you can
● Save Layout under New Name
● Applying Object Properties to Other Objects
● Coping or Transferring Objects in Other Layouts
● Adopting Fully Designed Objects and Layouts from Other Projects
Note
Language-Neutral and Language-Dependent Layouts
There are language-neutral and language-dependent layouts.
Language-neutral layouts have the following designation: "<Name of the layout>.rpl".
Language-neutral layouts are saved in folder "\\<Name of system on which the layout was
created>\Project name\PRT".
Language-dependent page layouts contain layout files with the following designation:
"<Name of the layout>_XXX.rpl". "XXX" stands for the language code of the layout file.
The language-specific layout file is saved in a language-specific folder in folder "\\<Name
of the system on which the layout was created>\Project name\PRT".
In the case of multi-language configurations, be sure to make all changes, copies and
deletions to all layout files of a layout.
See chapter " Working with Layouts (Page 1924) " for further instructions.

Save Layout under New Name
If you want to configure several projects, it is recommended that you first save a layout as a
template. Set the elements which remain the same, such as headers and footers, in this layout.
Set the page format and the orientation. Set the print margins and the dynamic margins. Save
the finished layouts as often as you want under new names. Then you can add the log objects
you want to the individual layouts and set their parameters. You will find more information in
the "Layout File Operations" chapter.

Applying Object Properties to Other Objects
If you have an object with certain properties in a layout, then you can easily apply these
properties to another object. Use the eyedropper function for this. You will find more information
in the "Transferring Object Properties" chapter.
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Coping or Transferring Objects in Other Layouts
This is a very useful function in order to paste already configured objects or object groups into
another layout. In this way, you can, for example, design a complete header and transfer it to
other layouts.
In order to copy an object or object group, highlight the object(s) and copy the selection to the
operating system clipboard. Next open the target layout and paste in the contents of the
clipboard. The contents of the clipboard can be pasted into as many other layouts as desired.
The next time an object is copied, the data in the clipboard will be overwritten.
In order to transfer an object or object group, highlight the object(s) and cut the selection out.
The selection will be copied to operating system clipboard. Then you can proceed with this
selection as with copying.

Adopting Fully Designed Objects and Layouts from Other Projects
If you have already created a project with WinCC, then you can transfer existing layouts to the
new project. You can also transfer objects from an existing layout to a layout in the new project.
There are two options for transferring a complete layout:
1. Navigate to the root directory of the old project using Windows Explorer. Open the "PRT"
folder.
– For language-neutral layouts:
Copy the desired layout file and add it to the folder "PRT" of the new project.
– For language-dependent layouts:
Open the desired language-dependent folder. Copy the desired layout file and add it to
the language-dependent folder in folder "PRT" of the new project.
Repeat the process for all Runtime languages, if necessary.
2. Open the page layout editor in the new project and click the folder button in the toolbar.
The "Open" dialog will appear.
– For language-neutral layouts:
Use this dialog to navigate to the "PRT" folder of the old project. Open the desired layout
file in the page layout editor. Save the layout file in the "PRT" folder of the new project
using the "Save" or "Save as..." function.
– For language-dependent layouts:
Use this dialog to navigate to the language-dependent folder in the "PRT" folder of the
old project. Open the desired layout file in the page layout editor. Save the layout in the
language-dependent folder in the "PRT" folder of the new project using the "Save" or
"Save as..." function.
Repeat the process for all Runtime languages, if necessary.

Requirements
In order to transfer a fully defined object from another project, open the layout which contains
this object in one of the two ways described above. Select the object or group of objects that
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you want and copy the selection to the clipboard. Open the target layout and paste in the
contents of the clipboard.
Note
If you are copying system layouts, we recommend creating a backup copy of the new system
layout before overwriting it in the "PRT" folder.

See also
How to Transfer Object Properties (Page 1954)
Changing Predefined Layouts (Page 1930)
How to Display the Layout Properties (Page 1929)
Layout File Operations (Page 1925)
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10.5

Working with Objects

10.5.1

Working with Objects

Introduction
In this chapter, you will learn
● which basic functions of the page layout editor can be used for working with objects
● what characteristics the individual objects have
● how to use objects to create layouts
● how to specifically change object properties
You will find a description of the available objects in the chapter on the "Object Palette".

See also
The Properties of an Object (Page 1947)
Working with Objects for the Project Documentation (Page 2046)
Working with Objects for the Runtime Documentation (Page 2011)
Working with Standard Objects (Page 1966)
The Object Palette (Page 1899)

10.5.2

The coordinate system in the Report Designer

Introduction
The basis for the definition of position and size entries in the page layout editor is a twodimensional coordinate system. The two axes of the coordinate system, x-axis and y-axis, are
perpendicular to one another and intersect at the coordinate origin. The coordinate origin lies
with the coordinates (X = 0 / Y = 0) in the top left corner of the desktop. Extending from the
coordinate origin, the horizontal X-axis runs in the positive direction to the right edge of the
working area, and the vertical Y-axis runs in the positive direction to the lower edge of the
working area. Thus the values for X and Y displayed in the status bar of the page layout editor
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increase when the mouse is moved from the upper left to the lower right of the working area.
Coordinates are displayed in the units set in the "Tools/Settings" menu in the "Units" tab.

The position and size of objects in a layout are determined by the coordinates which an object
has in the coordinate system. For example, the position of the object origin is determined by
the attributes "Position X" and "Position Y"; thus, it has the coordinates (X = "Position X"/Y =
"Position Y"). The values of these attributes describe the distance of the object origin from the
coordinate axes.
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Definition of Origin
The "origin" is defined as the point of an area or an object that is used as the reference point
for entering position and size specifications. For creating a layout in the page layout editor, the
following reference points are significant:
● Coordinate system origin (X = 0/Y = 0)
= Top left corner of the working area
● Picture origin (X = 0/Y = 0)
= Top left corner of the layout
● Object origin (X = "Position X"/Y = "Position Y")
= Top left corner of the rectangle surrounding the object

Internal Coordinate System of an Object
The validity of the normal coordinate system is canceled for displays within an object. The
following special form is used for the internal coordinate system of an object:
The positive direction of the Y-axis points downward, the positive direction of the X-axis points
to the right.

See also
The Status Bar (Page 1913)
The Rectangle Surrounding the Object (Page 1937)

10.5.3

The Rectangle Surrounding the Object

Introduction
The "rectangle surrounding an object" is defined as a rectangular frame which lies on the outer
borders of an object. The rectangle surrounding an object is not visible in the page layout
editor. When an object is selected, however, the handles which are used to grab an object for
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changing its size are shown. These handles identify the central axes and corner points of the
rectangle surrounding the object.

The special significance of the rectangle surrounding the object for determining the position
can be illustrated with a circular or ellipse-shaped object as an example:
The position of an object is defined by means of the position of its origin relative to the
coordinate system. The object origin has the coordinates ("Position X"/"Position Y") and is
defined as the upper left corner of the rectangle surrounding the object. Specified in this way,
the position of a circular or ellipse-shaped object can be set clearly.

The handles of the rectangle surrounding the object
The handles of the rectangle surrounding the object appear as soon as an object is selected.
By dragging with the mouse, the size of an object can be modified by shifting a handle to a
new position.
If the mouse pointer is positioned on a handle, it turns into a double arrow. The alignment of
the double arrow indicates the directions in which the handle can be moved:
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● Horizontal double arrow: The handles on the horizontal center axis can be used to change
the width of the object.
● Vertical double arrow: The handles on the vertical center axis can be used to change the
width of the object.
● Diagonal double arrow:The handles on the corners of the object can be used to change
the height and width of the object.
Note
Circular objects can only be changed in terms of their whole size; they do not have handles
for their center axes.

See also
Multiple Selection of Objects (Page 1942)
How to Paste an Object into a Layout (Page 1939)
The coordinate system in the Report Designer (Page 1935)
How to Edit Objects (Page 1940)

10.5.4

How to Paste an Object into a Layout

Introduction
A layout is created in the page layout editor by pasting objects from the object palette into a
layout.
In the page layout editor, the various object types have predefined properties. When added,
objects take on these defaults, with the exception of individual geometric properties. After
insertion the properties of an object can be modified. In the same way the default settings for
the object types can be modified as required.
When an object is inserted, the object name assigned as standard is the description of the
object type with a consecutive number. This name can be changed using the "Object Name"
attribute.

Requirement
The display of the object palette must be enabled.
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Procedure
The "Rectangle" standard object is shown here as an example for the general procedure for
pasting an object into a layout. Some object types require additional steps. You can learn more
about these additional steps in the detailed description of the individual objects.
1. Open the layout in which you want to insert an object.
2. Click the "Rectangle" standard object in the object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rectangle to the required size.
As soon as you release the mouse, the rectangle is added.

Alternative Operation
Using the "Paste" command, the current contents of the clipboard can be pasted into the active
layout as often as you like. If an object has been copied to the clipboard, this command can
be used to paste as many copies of the object as you like, also into different layouts. The
"Paste" command can be executed via the button in the toolbar, via the context menu, using
the key combination "CTRL+V" or by selecting "Edit/Paste" in the menu bar.

See also
The Properties of an Object (Page 1947)
Working with Objects for the Project Documentation (Page 2046)
Working with Objects for the Runtime Documentation (Page 2011)
Working with Standard Objects (Page 1966)
The Object Palette (Page 1899)
How to Edit Objects (Page 1940)

10.5.5

How to Edit Objects

Introduction
You can select, position, scale, delete, cut, copy, duplicate and change the properties of objects
in a layout.

Selecting Objects
Select an object of any type by clicking it. As an alternative, you can select the object you want
from the object selection list in the "Object Properties" window.
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Positioning Objects
1. Select the object you want.
2.

The mouse pointer changes to a crosshair with arrowheads.
The handles of the rectangle surrounding the object appear as soon as an object is
selected.

3. Hold down the mouse button and move the object to the desired position.
You can also select the object using the arrow keys or by changing the values for the geometric
attributes "Position X" and "Position Y" in the "Object Properties" window.

Scaling objects
1. Select the object you want.
2. Position the mouse pointer on one of the handles of the object. The mouse pointer will
change to a double arrow. The orientation of the double arrow indicates the direction in
which you can move the handles.
3. Use the mouse to drag the handle to the position you want.
You can also resize the object by changing the values for the geometric attributes "Width" and
"Height" in the "Object Properties" window.

Deleting Objects
1. Select the object you want.
2. Press the "DEL" key. The selected object is deleted.
You can also delete the selected object by selecting "Delete" from the context menu or by
selecting "Edit/Delete" from the menu bar.

Cutting Objects
1. Select the object you want.
button in the toolbar. The selected object will be cut from the layout and copied
2. Click the
to the clipboard.
You can also cut the selected object using the "Cut" command in the context menu, the key
combination "CTRL+X" or by selecting "Edit/Cut" from the menu bar.

Copying Objects
1. Select the object you want.
2. Click the

button in the toolbar. The selected object will be copied to the clipboard.

You can also copy the selected object using the "Copy" command in the context menu, the
key combination "CTRL+C" or by selecting "Edit/Copy" from the menu bar.
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Duplicating Objects
1. Select the object you want.
2. Select "Duplicate" from the context menu. A copy of the selected object will be created
directly in the active layout. Position X and Position Y of the copy are approximately 20
pixels higher than Position X and Y of the original object.
You can also duplicate the selected object by selecting "Edit/Duplicate" from the menu bar.

See also
Multiple Selection of Objects (Page 1942)
The Rectangle Surrounding the Object (Page 1937)

10.5.6

Multiple Selection of Objects

10.5.6.1

Multiple Selection of Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed
must be selected. This procedure is called "multiple selection".
During a multiple selection, the attributes held by at least one of the selected objects are
displayed in the "Object properties" window. The value of an attribute will only be displayed,
however, if it is the same for all selected objects.
Along with "selection frames" and the "reference object", a multiple selection has two
characteristics which play an important role, for example for the common alignment of the
selected objects. However, these characteristics are not visibly displayed in the page layout
editor.

Making multiple selections
The multiple selection of objects can be made in several ways in the page layout editor:
● Multiple selection while pressing the Shift key. Click the objects you want, one after the
other, while holding down the Shift key.
● Multiple selection by dragging a selection frame with the mouse. While dragging, a frame
will be shown to help with orientation. The selection is dependent on the type of object
selection set in the page layout editor. For "surrounding object selection", all objects which
are inside the displayed frame are selected. For "touching object selection", all objects
touched by the frame will be selected, in addition to those inside of it.
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Selection Frame of a Multiple Selection
The selection frame encloses all objects in a multiple selection, comparable to the rectangle
surrounding individual objects.

The position and size of the selection frame are dependent on the position of the selected
object. The midpoint of the selection frame corresponds to the common midpoint of the
selected objects. The limit line of the selection frame touches the outer edges of the objects
which have the greatest distance from the common midpoint.
The selection frame is not visible. After finishing the multiple selection, only the handles of the
individual objects will be shown.

Reference Object of a Multiple Selection
During a multiple selection, one of the selected objects will be set as a reference object. For
example, if the "Same width" function is selected in the Alignment palette, then all selected
objects will be set to the same width as the reference object.
If the multiple selection is made by dragging a frame, the first object created is set as the
reference object.
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If the multiple selection is made with the Shift key, the first object selected is set as the reference
object.

See also
The Rectangle Surrounding the Object (Page 1937)
The Alignment Palette (Page 1908)
How to Align Multiple Objects (Page 1945)
How to Select Multiple Objects (Page 1944)

10.5.6.2

How to Select Multiple Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed
must be selected. This procedure is called "multiple selection".

Requirements
The layout must contain at least two objects.

Procedure
1. On the keyboard hold down the SHIFT key.
2. With the mouse, click the objects you want, one after the other.
The handles of the rectangle surrounding the object appear for every selected object.
The mouse pointer will change to a crosshair with arrow points when it is positioned over
a selected object.
The reference object in this type of multiple selection is the object that was selected first.
Note
If an object has been selected accidentally, it can be removed from the multiple selection by
clicking it again while holding down the Shift key.

Alternative Procedure
The multiple selection can also be made by dragging a selection frame with the mouse. The
objects will be selected in accordance with the setting for the type of object selection. The
procedure described here is for the "surrounding object selection" type.
1. Hold down the mouse button and drag a frame around the objects you want.
2. As soon as you release the mouse button, the handles for the rectangles surrounding the
objects will be shown for every selected object.
The reference object in this type of multiple selection is the object that was created first.
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See also
The Rectangle Surrounding the Object (Page 1937)
Multiple Selection of Objects (Page 1942)
How to Set the Options for the configuration settings (Page 1920)
How to Align Multiple Objects (Page 1945)

10.5.6.3

How to Align Multiple Objects

Introduction
The objects in a multiple selection can be edited together using the functions of the Alignment
palette. These functions can also be called from the "Arrange / Align" menu.

The Alignment Palette contains the following functions for processing the objects in a multiple
selection:
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● Align:The selected objects are aligned on the border line of the selection frame (up, down,
left, right).
● Center:The selected objects are centered on a middle axis of the selection frame
(horizontally, vertically).
● Space: The selected objects are distributed evenly across the height or width of the
selection frame (horizontally, vertically).
● Align: The size of the reference object is assigned to the selected objects (height, width or
height and width).
A detailed description of these functions can be found in the section "The Alignment palette".

Requirement
Select at least two objects of any type.

Procedure
1. Click the icon you want in the Alignment Palette.
The alignment or the size of the selected objects changes.

Alternative Procedure
1. Select the entry you want from the Arrange / Align menu.
The alignment or the size of the selected objects changes.

See also
Multiple Selection of Objects (Page 1942)
The Alignment Palette (Page 1908)
How to Select Multiple Objects (Page 1944)
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10.5.7

The Properties of an Object

10.5.7.1

The Properties of an Object

Introduction
The shape, appearance, position and application linking of an object are set by the "Object
Properties". These properties can be changed in the page layout editor as needed.
The properties of an object are described by a large number of "attributes". An object property
can be changed by assigning a new value to its attribute.
The Properties tab of the "Object Properties" window contains all the attributes of a selected
object or objects in a multiple selection. The attributes are divided into property groups, such
as "Geometry" or "Colors". The type and number of the available property groups and attributes
are dependent on the type of the selected objects. So, for example, the "Font" property group
is only shown for the object types which can be displayed with text.
As an alternative to changing the attributes in the "Object Properties" window, objects can also
be adjusted with the mouse and keyboard or by using the toolbar and palettes. However, in
this way only certain object properties, such as the basic geometric size, color and line style,
can be changed.

See also
How to Change an Attribute (Page 1953)
How to Transfer Object Properties (Page 1954)
The Object Palette (Page 1899)
How to Access the Object Properties Window (Page 1948)
The Object Properties Window (Page 1947)

10.5.7.2

The Object Properties Window

The Object Properties Window
Introduction
The "Object Properties" window represents the central dialog for changing object properties
in the page layout editor.
For creating a layout, it is first important to adjust the static values of the attributes, in order,
for example, to set the form, appearance or position of an object. Change the static values on
the Properties tab.
With dynamic report objects, you can edit the selection of data for output using the "Object
Properties" dialog. You can open the dialogs for editing on the link tab.
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The "Object Properties" Window
As an example, the "Object Properties" window can have the following appearance for a
rectangle with the object name "Rectangle1":

The "Object Properties" window can be kept in the foreground of the page layout editor. The
position and size of the window can be changed as you like.
The "Object Properties" window is subdivided into the Elements toolbar, and the Properties
and Link tabs. You can find more about these elements in their detailed description.

Keeping the "Object Properties" window in the foreground
By activating the button, the "Object Properties" window can be set so that it is always in the
foreground of the page layout editor. Clicking the button again deactivates the function.

See also
How to Access the Object Properties Window (Page 1948)
The Link tab in the Object Properties Window (Page 1952)
The Properties tab in the Object Properties window (Page 1950)
The Toolbar in the Object Properties Window (Page 1949)
The Properties of an Object (Page 1947)

How to Access the Object Properties Window
Introduction
The Properties tab of the "Object Properties" window contains all the attributes of a selected
object or objects in a multiple selection. The changes are made to an object property by
assigning a new value to accompanying attribute.
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Requirement
Select an object of any type.

Procedure
You can open the "Object Properties" window in the following ways:
● In the standard toolbar, click the

button.

● Double-click the selected object.
● Select "Properties" from the context menu of the object.
● Select "Properties" from the "View" menu.
Note
If you want to make changes to several objects, you can lock the display of the "Object
.
Properties" window with the

See also
How to Change an Attribute (Page 1953)
The Link tab in the Object Properties Window (Page 1952)
The Properties tab in the Object Properties window (Page 1950)
The Toolbar in the Object Properties Window (Page 1949)
The Object Properties Window (Page 1947)
The Properties of an Object (Page 1947)

The Toolbar in the Object Properties Window
Introduction
You can make the following settings with the toolbar in the "Object Properties" window:
● The display of the "Object Properties" window can be kept in the foreground of the page
layout editor.
● Object properties can be transferred.
● Individual objects in the active layout can be selected.
As an example, the toolbar can have the following appearance for a rectangle with the object
name "Rectangle1":
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Elements of the toolbar in the "Object Properties" window
Icon

Name

Function

Pin
activated/
deactivated

Deactivate: The "Object Properties" window will be
closed as soon as the mouse is clicked outside the
selected object.
Activate: The "Object Properties" window stays in the
foreground at all times. Different objects can be
edited without having to open the window again.

Eyedropper
The properties of a selected object are copied.
Copy properties
Eyedropper
Assign
properties

The previously copied properties are transferred to
the selected object without changing its geometric
attributes. For different object types, only those
attributes which both object types have are
transferred.

Object type

Displays the object type of the selected object. When
several objects are selected, a multiple selection and
the number of objects selected is displayed here.

Object
selection

Displays the name of the selected object.
Another object can be selected using the selection
list. If the dynamic part of the layout is enabled, the
selection list contains the names of all objects in the
dynamic part of the layout. This is also the case for
the static part of the layout.

See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Link tab in the Object Properties Window (Page 1952)
The Properties tab in the Object Properties window (Page 1950)
How to Access the Object Properties Window (Page 1948)
The Object Properties Window (Page 1947)
The Properties of an Object (Page 1947)

The Properties tab in the Object Properties window
Introduction
In the "Object Properties" window, the Properties tab represents the central dialog for changing
the static values of a selected object.
As an example, the Properties tab can have the following appearance for a rectangle with the
object name "Rectangle1":

1950

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.5 Working with Objects

The Properties tab is divided into two areas:
● Properties display: In the left-hand area, the selected object is displayed with its property
groups in the form of a directory tree. The selected object is displayed as a directory.
With a multiple selection or a user object, this folder only receives the shared property
groups of the contained individual objects. For a selected property group, the value of an
attribute will only be displayed if the value is the same for all selected objects or if the
attribute belongs to only one of the selected objects.
The name of the property groups cannot be changed. Directories and subdirectories can
be opened or closed by clicking on the "+" or "-" icons.
● Attribute display: The right-hand area contains all attributes which are available for the
selected property group. The attribute display is divided into two columns in which the static
values of the selected object are displayed.
The displayed values can be changed by double-clicking or opening the context menu in
the "Static" column.
The width of the two window areas and the columns in the attribute display can be changed
by moving the vertical dividing lines.

Attribute Display Columns
Column

Description

Attribute

Name of the attribute. All of the attributes from the selected property group that
are available for the selected object will be shown.
The name of the attribute cannot be changed. The static value of the attribute can
be changed by double-clicking the attribute name.

Static

Static value of the attribute. The current value of the attribute for the selected object
is displayed. The value will be displayed as a number, text or graphic display,
depending on the type of attribute.
The static value of the attribute can be changed by double-clicking the attribute
name. Further information can be found in chapter "Change Attribute".
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See also
The Object Properties Window (Page 1947)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Link tab in the Object Properties Window (Page 1952)
The Toolbar in the Object Properties Window (Page 1949)
How to Access the Object Properties Window (Page 1948)
The Properties of an Object (Page 1947)

The Link tab in the Object Properties Window
Introduction
The Link tab represents the central dialog for configuring links in the "Object Properties"
window.
The dynamic objects are already linked with the corresponding applications. Some of the
dynamic objects have one or more dialogs for selecting data for output.
For example, the Link tab in the "Object Properties" window for a database table with object
name "Dynamic Table 1" might look like this:

The Link tab is divided into two areas:
● In the left-hand area, the linked applications from which the data to be output are taken are
shown in the form of a directory tree.
● In the right-hand area, the editing options and, if they exist, the formatting options, are
shown in the "Name" column. You can open the appropriate configuration dialog with the
"Edit..." button.
The configured selections are reset with the "Delete..." button. The selection options remain.
The width of the two window areas and the columns in the event display can be changed by
moving the vertical dividing lines.
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See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties tab in the Object Properties window (Page 1950)
The Toolbar in the Object Properties Window (Page 1949)
How to Access the Object Properties Window (Page 1948)
The Object Properties Window (Page 1947)
The Properties of an Object (Page 1947)

10.5.7.3

How to Change an Attribute

Introduction
The properties of an object are defined in the page layout editor by the values of the object
attributes. Any change that is made to an object, for example using the mouse or via a
configuration dialog, automatically changes the value of the corresponding attributes.
The Properties tab of the "Object Properties" window displays all the attributes of a selected
object or objects in a multiple selection. The attributes are assigned to "property groups". The
type and number of available property groups and attributes depend on the type of object
selected. So, for example, the "Font" property group is only shown for the object types which
can be displayed with text.
An object property can be changed by assigning a new value to its attribute. Information about
changing a specific attribute can be found in the detailed description of the relevant attribute.

Procedure
1. Open the "Object Properties" window.
2. In the Properties tab, select the desired property group.
3. Double-click on the desired attribute. A dialog opens where you can change the attribute.
Enter a new value according to the table below.
4. Click "OK" to confirm your entries.
Alternatively, a dialog where you can change the attribute can also be called directly by doubleclicking in the "Static" column. You can call up direct help for each attribute by right-clicking
on it in the "Attribute" column.
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Dialogs for changing attributes
The table provides information about the possible dialogs for changing attributes and contains
an example for calling each dialog.
Dialog

Procedure

Value input

Enter a new value in the line.
Example:
Object: Static text; property group: Geometry; attribute: Width.

Text input

Click in the text field to edit the text or enter a new text.
Example:
Object: Static text; property group: Font; attribute: Text.

Switchover

Double-click to switch between the two available values.
Example:
Object: Static text; property group: Font; attribute: Bold.

Selection dialog in the
form of a button

Click on the buttons provided to specify the new value.
Example:
Object: Static text; property group: Font; attribute: X alignment.

Color selection

Select one of the 16 standard colors or open the palette with the user-defined
colors. In this palette, you can freely define additional colors.
Example:
Object: Static text; property group: Colors; attribute: Font color.

Picture selection

Select a picture from the selection dialog or, using the "Search in" dialog,
search for a directory containing additional pictures that can be selected.
Example:
Object: Static metafile; property group: Miscellaneous; attribute: Metafile
name.

See also
The Styles Property Group (Page 1964)
The Miscellaneous Property Group (Page 1962)
The Font Property Group (Page 1961)
The Geometry Property Group (Page 1958)
The Colors Property Group (Page 1956)
How to Rename Objects (Page 1955)
How to Transfer Object Properties (Page 1954)

10.5.7.4

How to Transfer Object Properties

Introduction
The properties of an object can be transferred to another object with the "eyedropper". The
following buttons can be used to transfer object properties in the page layout editor:
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to copy properties of the selected object

to apply copied properties to a selected object
These buttons are in the standard toolbar and in the "Object Properties" toolbar. Alternatively,
these functions can be called via the "Edit/Properties" menu.
The properties of any object can be copied with the eyedropper. You can apply the copies to
any object or multiple selection. The properties are transferred without changing the geometric
attributes of the object. For different object types, only the attributes held by both the original
and target objects will be changed.

Procedure
1. Select the object whose properties you want to copy.
2. In the standard toolbar, click
.
The properties of the selected object are copied.
3. Select the object to which you want to assign the copied properties.
4. In the standard toolbar, click
.
The selected object will be displayed with the new properties, but without changing its
geometric attributes.

See also
The Styles Property Group (Page 1964)
The Miscellaneous Property Group (Page 1962)
The Font Property Group (Page 1961)
The Geometry Property Group (Page 1958)
The Colors Property Group (Page 1956)
How to Rename Objects (Page 1955)
How to Change an Attribute (Page 1953)

10.5.7.5

How to Rename Objects

Introduction
The "Object Name" attribute specifies the name of an object in the layout. The object name is
unique within a layout.
When an object is inserted, the object name assigned as standard is the description of the
object type with a consecutive number. This name can be changed using the "Object Name"
attribute.
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The allocation of unique names is important when using objects whose output parameters can
be changed online. You can find more information in chapter "Changing Output Options in
Runtime".

Requirement
Select an object of any type.

Procedure
1. Open the "Object Properties" window.
2. In the Properties tab, select the entry for the selected object type to which the property
groups of the object are subordinate.

3. Double-click the "Object Name" attribute. The "Text Entry" dialog opens.
4. Enter the new name.
5. Click "OK" to confirm your entries.

Value area
The object name is freely selectable and can contain up to 128 characters. When entering the
name, please make note of the list of characters which are not permitted.

10.5.7.6

The Colors Property Group

The Colors Property Group
Introduction
The "Colors" property group contains attributes which you can use to change the color settings
of objects.
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Requirement
The "Colors" property group is available for all object types.
The availability of the attributes is dependent on the type of object selected. Only the attributes
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Colors" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

Fill pattern color

Color of the fill
pattern

Polygon, ellipse, circle, ellipse segment, pie segment,
rectangle, rounded rectangle, static text, static metafile, all
dynamic objects, all system objects, all objects for runtime
documentation and project documentation and the layout
object.

Background color

Background color of
the object

Polygon, ellipse, circle, ellipse segment, pie segment,
rectangle, rounded rectangle, static text, static metafile, all
dynamic objects, all system objects, all objects for runtime
documentation and project documentation and the layout
object.

Line color

Color of a line

All standard objects except static text, all dynamic objects,
all system objects, all objects for the runtime documentation
and the project documentation and the layout object.

Line background
color

Background color of
a line

All standard objects except static text, all dynamic objects,
all system objects, all objects for the runtime documentation
and the project documentation.

Font color

Color of the text in
an object

Static text, all dynamic objects except embedded layout and
hard copy, all system objects, all logs and tables in the
objects for runtime documentation, all objects for the project
documentation

See also
Working with the Colors Property Group (Page 1957)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Color Palette (Page 1911)

Working with the Colors Property Group
Introduction
In the "Colors" property group you can change the color settings for the background, lines, fill
pattern and font of an object. The following example "Changing the Background Color" explains
how to work with this property group.
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Requirement
Select an object of any type.

Procedure
1. Open the "Object Properties" window, for example using the context menu.
2. In the Properties tab, select the "Colors" property group.
3. Double-click the "Background Color" attribute. A selection dialog opens.
4. Select one of the 16 standard colors or open the palette with the user-defined colors. In
this palette, you can freely define additional colors.

See also
Working with the Colors Property Group (Page 1957)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Color Palette (Page 1911)

10.5.7.7

The Geometry Property Group

The Geometry Property Group
Introduction
The "Geometry" property group contains attributes, which you can use to change the geometric
properties of objects.

Requirement
The "Geometry" property group is available for all objects.
The availability of the attributes is dependent on the type of object selected. Only the attributes
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Geometry" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
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Attribute

Function

Object type

Current value X

Horizontal position of the currently selected
corner point, relative to the image origin.

Polygon, polyline

Current value Y

Vertical position of the currently selected
corner point, relative to the image origin.

Polygon, polyline
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Attribute

Function

Object type

Start angle

Start angle for the display of segment or arc
objects in "degrees".

Ellipse arc, ellipse segment,
circular arc, pie segment

Number of corners Number of corner points

Polygon, polyline

Width

Distance between the left and right borders of
an object, for the layout object the width of the
layout.

All objects

Corner radius X

Radius of the corner rounding

Rounded rectangle

Corner radius Y

Radius of the corner rounding

Rounded rectangle

End angle

End angle for the display of segment or arc
objects in "degrees".

Ellipse arc, ellipse segment,
circular arc, pie segment

Height

Distance between the upper and lower
borders of an object, for the layout object the
height of the layout

All objects

Index

Number of the currently selected corner points Polygon, polyline

Left print margin

Determines the width of the left print margin

Layout object

Left dynamic
margin

Determines the left margin of the dynamic
layout part.

Layout object

Top print margin

Determines the width of the top print margin

Layout object

Top dynamic
margin

Determines the top margin of the dynamic
layout part.

Layout object

Orientation

Determines the orientation of the printout in
portrait or landscape format.

Layout object

Position X

Horizontal distance of the object origin from
the image origin

All objects

Position Y

Vertical distance of the object origin from the
image origin

All objects

Radius

Radius of a circular object

Circle, circular arc, pie segment

Radius X

Horizontal radius of an elliptical object

Ellipse, ellipse arc, ellipse
segment

Radius Y

Vertical radius of an elliptical object

Ellipse, ellipse arc, ellipse
segment

Right print margin

Determines the width of the right print margin Layout object

Right dynamic
margin

Determines the right margin of the dynamic
layout part.

Layout object

Page format

Determines the paper format of the printout

Layout object

Columns

Number and width of the columns in a table

All table objects in the object
palette, recognizable by the
icon.

Bottom print
margin

Determines the width of the bottom print
margin

Layout object

Bottom dynamic
margin

Determines the bottom margin of the dynamic
layout part.

Layout object
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See also
Working with the Geometry Property Group (Page 1960)
How to Change an Attribute (Page 1953)
The Rectangle Surrounding the Object (Page 1937)
The coordinate system in the Report Designer (Page 1935)
The Properties of an Object (Page 1947)

Working with the Geometry Property Group
Introduction
You can change the geometric properties of an object in the "Geometry" property group. The
following example "Changing the Width" explains how to work with this property group.

Requirement
Select an object of any type. You have already set the units of the coordinates (e.g.
centimeters) in the Tools/Settings/Units menu.

Procedure
1. Open the "Object Properties" window, for example using the context menu.
2. In the Properties tab, select the "Geometry" property group.
3. Double-click the "Width" attribute. The "Value Input" dialog opens.
4. Enter the new value.
5. Click "OK" to confirm your entries.

Alternative Operation
Change the object size with the mouse by dragging one of the handles on the rectangle
surrounding the object to the width you want.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Rectangle Surrounding the Object (Page 1937)
The coordinate system in the Report Designer (Page 1935)
The Geometry Property Group (Page 1958)
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10.5.7.8

The Font Property Group

The Font Property Group
Introduction
The "Font" property group contains attributes which you can use to change the appearance
of text in objects.

Requirement
The "Font" property group is available for all objects. Static object "Static Text", dynamic
objects "ODBC Database" and "Tags", system objects and objects for online and project
documentation.
The availability of the attributes is dependent on the type of object selected. Only the attributes
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Font" property group. The function of an attribute
is described briefly and the object types for which the attribute is available are listed.
Attribute

Function

Object type

Bold

Text is displayed in
boldface

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation

Italic

Text is displayed in
italics

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation

Text

The object text

Static text

Underline

Text is displayed
underlined

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation

X alignment

Horizontal orientation
of the text in the object

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation which contain dynamic text

Y alignment

Vertical orientation of
the text in the object

Static text, dynamic object "Tag", system objects

Font

Font of the text

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation

Font size

Font size of the text in
points

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation

Text wrap

Automatic line
wrapping during output
of the text

Static text, dynamic objects "ODBC Database" and
"Tags", system objects and objects for online and project
documentation which contain dynamic text
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See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Font Property Group (Page 1962)

Working with the Font Property Group
Introduction
You can change the text display attributes of an object in the "Font" property group. The
following example "Changing the Font" explains how to work with this property group.

Requirement
Select one of the following objects: Static object "Static Text", dynamic objects "ODBC
Database" and "Tags", system objects and objects for online and project documentation.

Procedure
1. Open the "Object Properties" window, for example using the context menu.
2. In the Properties tab, select the "Font" property group.
3. Double-click the "Font" attribute. The "Font Selection" dialog opens.
4. Select the font you want in the dialog.
5. Click "OK" to confirm your entries.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Font Property Group (Page 1962)

10.5.7.9

The Miscellaneous Property Group

The Miscellaneous Property Group
Introduction
The "Miscellaneous" property group contains attributes which you can use to change the
miscellaneous settings of objects.
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Requirement
The "Miscellaneous" property group is available for all objects.
The availability of the attributes is dependent on the type of object selected. Only the attributes
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Miscellaneous" property group. The function of
an attribute is described briefly and the object types for which the attribute is available are
listed.
Attribute

Function

Object type

Output format

sets the appearance of the output value

Dynamic object "Tag"

Output value

sets the tags for the output

Dynamic object "Tag"

Calculation

calls a script for further editing of the tag value

Dynamic object "Tag"

Data type

sets the data type of the tags

Dynamic object "Tag"

Cover sheet

Sets whether a cover sheet should be output

Layout object

Format

sets the appearance of the output value

all system objects

Layout file

sets the layout to be embedded

Embedded layout

Metafile name

sets the name of the embedded file

Static metafile

Final page

Sets whether a closing page should be output

Layout object

Page break

inserts a page break in front of the object.

All objects

Polling list

If the output data is output in a single column per line,
this attribute can be used to output multiple columns per
line. The data will be written from left to right in the table
cells.

All table objects in the
object palette,
recognizable by the
icon.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Miscellaneous Property Group (Page 1963)

Working with the Miscellaneous Property Group
Introduction
You can change various properties of an object in the "Miscellaneous" property group. The
following example "Changing the Page Break" explains how to work with this property group.

Requirement
Select an object of any type.
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Procedure
1. Open the "Object Properties" window, for example using the context menu.
2. In the Properties tab, select the "Miscellaneous" property group.
3. Double-click the "Page Break" attribute. The entered value changes, for example from "No"
to "Yes". With "Yes", a page break is inserted in front of the object. The default setting is
"Yes".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Miscellaneous Property Group (Page 1963)

10.5.7.10 The Styles Property Group
The Styles Property Group
Introduction
The "Styles" property group contains attributes which you can use to change the style for the
appearance of objects.

Requirement
The "Styles" property group is available for all objects.
The availability of the attributes is dependent on the type of object selected. Only the attributes
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Styles" property group. The function of an
attribute is described briefly and the object types for which the attribute is available are listed.
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Attribute

Function

Object type

Corners

Representation of the corners of an
object, for example round, flat or
pointed
(associated with the "Line Style"
attribute)

all objects

Fill pattern

Pattern for the display of background
areas, for example solid or hatched

Polygon, ellipse, circle, ellipse segment, pie
segment, rectangle, rounded rectangle,
static text, static metafile,
all dynamic objects, all system objects, all
objects for runtime documentation and
project documentation and the layout object.
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Attribute

Function

Object type

Line termination Representation of the line ends of an
object, e.g. round, flat or pointed
(associated with the "Line Style"
attribute)

all objects

Line type

Display type of a line, for example
dotted or dashed

all objects

Line weight

Width of a line in points

all objects

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Styles Property Group (Page 1965)

Working with the Styles Property Group
Introduction
In the "Styles" property group, you can change the style for the display of objects. The following
example "Changing the Fill Pattern" explains how to work with this property group.

Requirement
Select an object of any type.

Procedure
1. Open the "Object Properties" window, for example using the context menu.
2. In the Properties tab, select the "Styles" property group.
3. Double-click the "Fill Pattern" attribute. The "Fill Pattern Selection" dialog opens.
4. Select the fill pattern you want in the dialog.
5. Click "OK" to confirm your entries.

Alternative Operation
You can also change the fill pattern with the style palette.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with the Styles Property Group (Page 1965)
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10.5.8

Working with Standard Objects

10.5.8.1

Working with Standard Objects

Introduction
Standard objects include geometric shapes, static text, OLE objects, static metafiles, the
dynamic objects and the system objects. You can use static objects to design the layout for
the output. System objects can be used, as an example, to inscribe the project name and page
numbers in the static part of the report.
In the page layout editor, the various object types have predefined properties. When they are
inserted the objects import these default properties, with the exception of individual geometric
properties. After insertion the properties of an object can be modified. In the same way the
default settings for the object types can be modified as required.

See also
Working with System Objects (Page 2008)
Working with Dynamic Standard Objects (Page 1995)
Working with Static Objects (Page 1966)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)

10.5.8.2

Working with Static Objects

Working with Static Objects
Introduction
In this chapter, you will learn the details of the static objects available in the page layout editor.
You will learn how to work with the objects, and what are the basic conditions for each object.
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Usage
Static objects are used for the visual design of a report. The static objects can be pasted into
the static and dynamic parts of a layout.

See also
How to Paste an Object into a Layout (Page 1939)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Rectangle Surrounding the Object (Page 1937)
The Properties of an Object (Page 1947)
Overview of the Static Objects (Page 1901)

How to Draw a Line
Introduction
The line is an open object. The length and angle of a line are determined by the height and
width of the rectangle around the object. Different line types, such as dashed or dotted, are
available.
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Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to paste a line.
2. Click the "Line" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the line.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the line to the length and direction you want.
When you release the mouse button, the line is finished.

Changing Lines with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing lines with value input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw a Polygon
Introduction
The polygon is a closed object that can be filled with a color or pattern. A polygon can have
any number of corners. The corners are numbered in their sequence of creation and can be
modified individually or deleted.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a polygon.
2. Click the standard object "Polygon" in the Object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the polygon.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Click the selected starting point with the left mouse button.
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5. Move the mouse pointer to the next corner point. Click with the left mouse button to set the
corner point. Set as many further corner points as you like in the same way.
6. Double-click with the left mouse button to set the last corner point and finish the polygon.

Changing Polygons with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Polygons with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)

How to Draw a Polyline
Introduction
The polyline is an open object. Even if the start and finish point have the same coordinates,
the area cannot be filled. A polyline can have any number of corners. The corners are
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numbered in their sequence of creation and can be modified individually or deleted. The line
ends of a polyline can for example be shown as arrows or points.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a polyline.
2. Click the "Polyline" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the polyline.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Click the selected starting point with the left mouse button.
5. Move the mouse pointer to the next corner point. Click with the left mouse button to set the
corner point. Set as many further corner points as you like in the same way.
6. Double-click with the left mouse button to set the last corner point and finish the polyline.
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Changing Polylines with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Polylines with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw an Ellipse
Introduction
The ellipse is a closed object that can be filled with a color or pattern. The height and width of
an ellipse can be modified as desired to allow it to be aligned horizontally or vertically.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert an ellipse.
2. Click on the "Ellipse" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the ellipse.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the ellipse to the size and direction you want.
When you release the mouse button, the ellipse is finished.

Changing an Ellipse with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing an Ellipse with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw a Circle
Introduction
A circle is a closed object that can be filled with a color or pattern. A circle can be resized at
will.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a circle.
2. Click the "Circle" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the circle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the circle to the size and direction you want.
When you release the mouse button, the circle is finished.

Changing Circles with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Circles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw an Ellipse Segment
Introduction
The ellipse segment is a closed object that can be filled with a color or pattern. The height and
width of an ellipse segment can be modified as desired to allow it to be aligned horizontally or
vertically.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert an ellipse segment.
2. Click the "Ellipse segment" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you wish to position the origin
of the ellipse segment.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the ellipse segment to the size and direction you want.
When you release the mouse button, the ellipse segment insertion is finished.
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5. The start and end points of the ellipse segment are shown by small gray squares. Place
the mouse pointer on one of these squares. The mouse pointer will change to a cross.
6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Ellipse Segments with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing ellipse Segments with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
Even if the values of the start and end angle are identical, an ellipse segment does not turn
into a closed ellipse.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw a Pie Segment
Introduction
The pie segment is a closed object that can be filled with a color or pattern. A pie segment can
be resized at will.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a pie segment.
2. Click in the "pie segment" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you wish to position the origin
of the pie segment.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the pie segment to the size and direction you want.
When you release the mouse button, the pie segment insertion is finished.
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5. The start and end points of the pie segment are shown by small gray squares. Place the
mouse pointer on one of these squares. The mouse pointer will change to a cross.
6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Pie Segments with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Pie Segments with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
Even if the values of the start and end angle are identical, a pie segment does not turn into
a closed circle.

See also
Working with Standard Objects (Page 1966)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
How to Paste an Object into a Layout (Page 1939)
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How to draw an Ellipse Arc
Introduction
The ellipse arc is an open object. The height and width of an ellipse arc can be modified as
desired to allow it to be aligned horizontally or vertically.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert an ellipse arc.
2. Click the "Ellipse arc" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you wish to position the origin
of the ellipse arc.
The mouse pointer changes into a crosshair with an object symbol attached.
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4. Hold down the mouse button and drag the ellipse arc to the size and direction you want.
When you release the mouse button, the ellipse arc insertion is finished.
5. The start and end points of the ellipse arc are shown by small gray squares. Place the
mouse pointer on one of these squares. The mouse pointer will change to a cross.
6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Ellipse Arcs with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Ellipse Arcs with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
Even if the values of the start and end angle are identical, an ellipse arc does not turn into a
closed ellipse.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw a Circular Arc
Introduction
The circular arc is an open object. A circular arc can be resized at will.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a circular arc.
2. Click the "Circular arc" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you wish to position the origin
of the circular arc.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the circular arc to the size and direction you want.
When you release the mouse button, the circular arc insertion is finished.
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5. The start and end points of the circular arc are shown by small gray squares. Place the
mouse pointer on one of these squares. The mouse pointer will change to a cross.
6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Circular Arcs with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Circular Arcs with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
Even if the values of the start and end angle are identical, a circular arc does not turn into a
closed circle.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)

1984

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.5 Working with Objects

How to Draw a Rectangle
Introduction
The rectangle is a closed object that can be filled with a color or pattern. The height and width
of a rectangle can be modified as desired to allow it to be aligned horizontally or vertically.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a rectangle.
2. Click the "Rectangle" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rectangle to the size and direction you want.
When you release the mouse button, the rectangle is finished.
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Changing Rectangles with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Rectangles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Draw a Rounded Rectangle
Introduction
The rounded rectangle is a closed object that can be filled with a color or pattern. The height
and width of a rounded rectangle can be modified as desired to allow it to be aligned horizontally
or vertically. The corners of a rounded rectangle can be rounded as much as desired.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a rounded rectangle.
2. Click the "Rounded rectangle" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the rounded
rectangle.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the rounded rectangle to the size and direction you
want.
When you release the mouse button, the rounded rectangle is finished.

Changing Rounded Rectangles with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Rounded Rectangles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
If the "corner radius X" and "corner radius Y" attributes are both set to the value of 100pt,
1cm or 1, depending on the units, the rounded rectangle will be displayed as an ellipse or
circle. If both attributes have a value of 0, a normal rectangle without rounded corners will be
displayed.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Insert Static Text
Introduction
The field for static text is a closed object that can be filled with a color or pattern. The static
text is entered into a field of any desired size. The text can be entered on one or more lines.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert static text.
2. Click the "static text" standard object in the Object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the static text.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the text field to the required size.
The field for the static text is complete as soon as you release the mouse button.
The word Text appears in the field.
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5. Overwrite the Text with your own text.
For text on multiple lines, create a line break by pressing the ENTER key, the key
combination SHIFT+ENTER or the key combination CTRL+M.
6. Clicking outside the object ends the text input.

Changing the Contents of the Static Text
Double-click the static text to open the input mode for text. The complete text is selected.
Position the insertion point with another click at the position in the text at which you want to
change something. For text on multiple lines, create a line break by pressing the Enter key,
the key combination "Shift"+"Enter" or the key combination "Ctrl"+"M".

Changing Static Text with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Static Text with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
Note
In the "Font" property, "Text" attribute a line break will be displayed as a control character in
the "Static" column. If the text is edited using the dialog for the "Text" attribute, no line breaks
can be added.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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How to Insert an OLE Object
Introduction
The OLE object enables you to insert files created with other programs into a layout. Therefore
all OLE elements registered in the Windows operating system can be integrated. The size and
properties taken on by an OLE object in runtime are defined in the page layout editor. No
changes can be made to OLE elements in runtime.

Requirements
● The display of the object palette must be enabled.
● The file type you wish to use must be registered in the Windows operating system.

Insert the OLE object, option "Create from file".
With the option "Create from file", an already existing file is chosen for display in the selected
OLE object. The selected file is edited in the OLE object with the program that is registered
for editing the selected file type in the Windows operating system.
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1. Open the layout in which you want to paste an OLE object, and click the standard object
"OLE object" in the Object palette.
2. Place the mouse pointer at the position in the layout where you want to insert the OLE object.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Drag the OLE object to the desired size.
The "Insert Object" dialog is opened.
4. Select option Create from File.
In the "Paste object" dialog, an input field, the "Browse..." button and the "Link" check box
are displayed.
5. Enter the directory path and the name of the desired file into the input field. Or click on the
"Browse..." button to select the file with the "Browse" dialog.
6. Mark the "Link" check box if the selected file should not be copied to the OLE object, but
rather should only be used as a reference.
7. Mark the "As icon" check box if only an icon for the associated file type should be displayed
and not the contents of the selected file.
8. Confirm your entry with "OK". The insertion process for the OLE object is finished.

Inserting the OLE object, "Create new" option.
The "Create new" option selects a file type for a new file that is created in the selected OLE
object. During editing, the file in the OLE object is edited with the program registered in the
Windows operating system for editing the selected file type.

1. Open the layout where you want to paste an OLE object, and click on the "OLE object" in
the Object palette.
2. Place the mouse pointer at the position in the layout where you want to insert the OLE object.
The mouse pointer changes into a crosshair with an object symbol attached.
3. Drag the OLE object to the desired size.
The "Insert Object" dialog is opened.
4. Select the option Create New.
The Insert Object dialog, a list of all file types registered in the Windows operating system
is displayed.
5. Select the object type for the file that you want to create in the selected OLE object.
6. Mark the "As icon" check box if only an icon for the associated file type should be displayed
and not the contents of the selected file.
7. Confirm your entry with "OK". The insertion process for the OLE object is finished.
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8. Double-click the OLE object to edit the embedded file in the OLE object.
The program registered in the Windows operating system for editing the associated file
type opens in the page layout editor.
9. Finish editing the embedded file by deselecting the OLE object.
The changes are accepted.

Changing OLE Objects with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing OLE Objects with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)

How to Insert a Static Metafile
Introduction
The static metafile field is a closed object that can be filled with a color or pattern. A graphic
file of any size is entered into the field.

Requirements
● The display of the object palette must be enabled.
● The graphic file must be in the *.emf format.
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Procedure
1. Open the layout in which you want to insert a static metafile.
2. Click the "Static Metafile" standard object in the object palette.
3. Place the mouse pointer at the position in the layout where you want to insert the static
metafile.
The mouse pointer changes into a crosshair with an object symbol attached.
4. Hold down the mouse button and drag the object to the size and direction you want.
When you release the mouse button, the static metafile is finished.
5. Double-click the "Metafile Name" attribute in the "Miscellaneous" property group of the
"Object Properties" window in order to enter the name of the graphic file.
6. A file dialog opens in which you can select the graphic file you want in the *.emf format.
7. Confirm the selected file with the "Open" button. The selected graphic file will be inserted
in the object.

Changing Static Metafiles with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Static Metafiles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Standard Objects (Page 1966)
How to Paste an Object into a Layout (Page 1939)
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10.5.8.3

Working with Dynamic Standard Objects

Working with Dynamic Standard Objects
Introduction
In this chapter you will learn details about the dynamic standard objects available in the page
layout editor. You will learn how to work with the objects, and what are the basic conditions
for each object.

Usage
With dynamic standard objects you link to tags, databases and screen contents that you wish
to output in a log. You can only paste dynamic standard objects in the dynamic part of a page
layout.

See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Rectangle Surrounding the Object (Page 1937)
The Properties of an Object (Page 1947)
How to Paste an Object into a Layout (Page 1939)
Overview of the Dynamic Objects (Page 1902)

Working with Embedded Layouts
Introduction
With the "Embedded layout" dynamic object you can embed one layout in another and output
both of them together. However, the layouts cannot be nested in just any fashion. A maximum
of one layer of embedded layouts can be used. An embedded layout within an embedded
layout is not permitted. If dynamic objects are used in an embedded layout, these also cannot
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be mixed in just any fashion. The following illustrations will clarify the options for using
embedded layouts.

Possible combinations: Layouts B1, B2 and a log object are directly embedded in Layout A1.
An embedded layout with several log objects of the same type is embedded in layout A2.
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Non-permitted combinations: The embedded layout B4 contains several dynamic tables of
different WinCC components. In layout A4 the nesting depth is too large.

Purpose
The functionality of the "Embedded layout" object is used, for example, with the project
documentation of pictures from the Graphics Designer. The configuration data of all pictures
in a WinCC project are output with the "@PdlPic" layout in this way. The data are output in
blocks for every picture. The output thus occurs in this form:
Picture 1
- output of all data for picture 1
Picture 2
- output of all data for picture 2
Picture n
- output of all data for picture n
If the objects for the project documentation are pasted from the object palette one after the
other into a layout, then the data of the current object will be collected and output. The output
then occurs in this form:
Object 1
- output of object data for picture 1, picture 2, picture n
Object 2

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

1997

Creating Page Layouts
10.5 Working with Objects
- output of object data for picture 1, picture 2, picture n
Object n
- output of object data for picture 1, picture 2, picture n
For the runtime configuration, the necessary log objects can be filed in a structure. Thus for
example, additional information you want can be configured in a separate layout and output
as an embedded layout.
Example:
The output of a tag logging - variable curve is configured in a page layout. Several report
objects of the "Tag" type, which are to be output in the log for the current measured values of
the curve, are configured in a layout to be embedded. Additionally, a WinCC tag will be
configured which forms a mean value via a script. The mean value will likewise be output with
the "Tag" log object.

Applications
Print job

Layout used

Function

@Documentation
Graphics Designer
Dynamics

@PDLPicDyn

Nested layout for outputting the dynamization data of a
Graphics Designer picture.

@Documentation
Graphics Designer

@PDLPic

Nested layout for outputting the general display, statistics
data, objects in the picture, picture attributes, actions on
the picture, direct connections to the picture, object
statistics, attributes of the objects, actions on the objects,
and direct connections to objects. The data is output on a
separate page for each picture.

@Documentation
Global Script Project
Function

@GSC_RPFC

Nested layout for outputting the information and source text
of the project functions. Output is started in WinCC
Explorer.

@Documentation
Global Script
Standard Function

@GSC_SFC

Layout for outputting information and the source text for a
standard function open in the Global Script editor.

How to Change the Output Options for the Hardcopy Object
Introduction
With the "Hardcopy" object type, you can paste a shot of the current screen contents, a portion
thereof, or a currently selected picture window in the dynamic part of a page layout.

Requirements
● The hardcopy object is already pasted into the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
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Procedure
1. Select "Area selection" from the "Name" column in the right area of the Link tab. Clicking
on the "Edit..." button opens the "Area selection" dialog.

2. From the selection list, choose the area from which you want to prepare a hard copy for
the report.
3. The configured area is static. You can, however, link a WinCC tag in order to change the
area to dynamic in runtime. The report system reads the value from the variable at runtime.
If the variable cannot be read, the configured value is used.
The WinCC tag must be of the Number type. The numbers have the following significance:
0 – Hard copy of the entire screen
1 – Hard copy of the current window
2 – Hard copy of a section
4. If you have selected "Hardcopy of a section", you must enter the X and Y positions of the
upper left corner of the area in the lower part of the dialog, as well as set the width and
height of the section in pixels.
5. The numeric values for setting the section can also be dynamized using WinCC tags. The
WinCC tags must be of the number type. The report system reads the value from the
variable at runtime. If the variable cannot be read, the configured value is used.
6. If you want to maintain the proportions of the screen contents during printing, select the
appropriate check box.
Dynamizing with WinCC tags
In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag
management. WinCC tags can be provided with new values in runtime. You can find further
information on this subject in the section "Changing output options online".
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Changing Hardcopy Objects with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Hardcopy Objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Dynamic Standard Objects (Page 1995)
How to Paste an Object into a Layout (Page 1939)

How to Change the Output Options for the ODBC Database Field
Introduction
With the "ODBC database field" object, you can paste the contents of a database field as text
in the dynamic part of a page layout via the ODBC interface. If the content of the database
field concerns a text object, only the first value of the first line will be returned, independent of
the size of the volume of results.

Requirements
● The "ODBC database field" object is already pasted into the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● A valid ODBC data source exists and is registered
● Knowledge of ODBC and SQL
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Procedure
1. Select "Database link" from the "Name" column in the right area of the Link tab. Click the
"Edit..." button to open a configuration dialog.

2. Use the selection list in the "ODBC data source" area to select the desired data source. All
registered ODBC data sources are available for selection. The project creator is responsible
for the registration and validity of the data sources.
3. If the data source has any database-specific access limitations, enter the necessary
information in the fields for the user and password.
4. The selection of the data for output takes place using an SQL statement. Enter the required
statement in the SQL statement area. Using the "Insert tag..." button, you can insert a tag
into the SQL statement in order to complete it at runtime.
5. You can check your entries by using the "Test SQL statement" button. The project must be
activated for the check when using WinCC tags.
6. Confirm your entries by clicking "OK". The dialog closes.
7. Save the layout.
Dynamizing with WinCC tags
All the tasks in this dialog can also be dynamized with WinCC tags. To do so, activate the
"Tag" checkbox in the "Data connection" dialog and select a tag form the tag selection dialog
using the folder button. If you know the tag name, you can enter it directly instead. The tags
must all be of the "Text" type.
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In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag
management. WinCC tags can be provided with new values in runtime. You can find further
information on this subject in the section "Types of dynamization".
NOTICE
The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible
to destroy or delete the data source.

Changing the ODBC database field with the mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing the ODBC database field by entering values
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Paste an Object into a Layout (Page 1939)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Dynamic Standard Objects (Page 1995)

How to Change the Output Options for the ODBC Database Table
Introduction
With the "ODBC database table" object, you can paste the contents of a database table as
text in the dynamic part of a page layout via the ODBC interface.
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Requirements
● The "ODBC database table" object is already pasted into the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● A valid ODBC data source exists and is registered
● Knowledge of ODBC and SQL

Procedure
1. Select "Database link" from the "Name" column in the right area of the Link tab. Click the
"Edit..." button to open a configuration dialog.

2. Use the selection list in the "ODBC data source" area to select the desired data source. All
registered ODBC data sources are available for selection. The project creator is responsible
for the registration and validity of the data sources.
3. If the data source has any access limitations, enter the necessary information in the fields
for the user and password.
4. The selection of the data for output takes place using an SQL statement. Enter the required
statement in the SQL statement area. The example refers to the MCPTVARIABLEDESC
table from the WinCC database. Using the "Insert tag..." button, you can insert a tag into
the SQL statement in order to complete it at runtime.
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5. You can check your entries by using the "Test SQL statement" button. If the test is
successful, then the number of columns found in the "Number of columns" field will be
applied. The project must be activated for the check when using WinCC tags.
6. If the column headings are to be output, then confirm this by marking the accompanying
check box. Confirm your entries by clicking "OK". The dialog is closed.
7. Save the layout.
Dynamizing with WinCC tags
All the tasks in this dialog can also be dynamized with WinCC tags. To do so, activate the
"Tag" checkbox in the "Data connection" dialog and select a tag form the tag selection dialog
using the folder button. If you know the tag name, you can enter it directly instead. The tags
must all be of the "Text" type.
In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag
management. WinCC tags can be provided with new values in runtime. You can find further
information on this subject in the section "Types of dynamization".

Formatting the table output
You can format the table output by including the formating instructions in the SQL statement
with the help of control characters. The formating is as follows for the example of the text
alignment in the table:
Format statement

Representation

SELECT tag name FROM MCPTVARIABLEDESC aligns by default the column text to the left
SELECT tag name as '<ALIGN=right> tag name '
FROM MCPTVARIABLEDESC

aligns the column text including column title to the
right

SELECT '<ALIGN=right>' + tag name as Name'
FROM MCPTVARIABLEDESC

aligns the column title towards the left and the
column text to the right

SELECT '<ALIGN=left>' + tag name as
'<ALIGN=center> Name' FROM
MCPTVARIABLEDESC

aligns the column title in the center and the column
text to the left

Control Characters for Table Output
<END>

If the interpretation of control sequences is done, the rest of the text
will be transferred as it is given.
<COLOR=#rrggbb>
Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb> Background color in hexadecimal notation (default = as set for the
table)
<B>
Bold
<U>
Underlined
<I>
Italic
<STRIKE>
Strike-through
<ALIGN=left>
Left aligned
<ALIGN=center>
Centered
<ALIGN=right>
Right aligned
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NOTICE
The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible
to destroy or delete the data source.

Change Column Width
The width of the columns for output can be set individually for every column.
1. Enable the properties tab in the "Object properties" window.
2. In the "Geometry" property group double-click the "Columns" attribute to open the "Table
columns" dialog.

3. Use the dialog to define the column width of the individual columns. The widths of the
columns can be changed relative to one another. Every column will receive its assigned
share of the total width.
4. Confirm your entries with "OK".

Changing ODBC Database Tables with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing the ODBC Database Table by Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".
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See also
How to Change an Attribute (Page 1953)
How to Transfer Object Properties (Page 1954)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Dynamic Standard Objects (Page 1995)
How to Paste an Object into a Layout (Page 1939)

Working with the Tag Object
Introduction
With the "Tag" dynamic object, you can output the tag value or the return value of a C action
during reporting in runtime.

Procedure
1. Open the layout in which you want to insert a "Tag" object.
2. In the object palette, click the standard object "Tag".
3. Place the mouse pointer at the position in the layout where you want to insert a tag.
The tag selection dialog is displayed.
4. Select the tag you want from the list of WinCC tags and confirm your selection with the
"OK" button. The "Output Value" attribute now contains this tag.

Linking a Script
Using the "Calculation" attribute in the "Miscellaneous" object property, you can call a script
for the output. Then a tag must not be selected.
1. If no script has been specified, then the "Create a New Script" option field is enabled. After
confirmation of this dialog, the "Edit Action" dialog opens. In this dialog you can formulate
an action in the high-level language ANSI-C.
2. Set the data type for the return value in the "Return Value" field. You can only set the data
type while creating the script; it is not possible to change it later.
The following data types are available for selection: "long", "double" and "char".
3. If a script has already been specified, then you can edit this script by selecting the option
"Edit an Existing Script".
4. Select the option "Delete an Existing Script" to delete the specified script without a query
when the dialog is confirmed.
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Note
Setting the script compilation language
The C compiler does not support Unicode. Use the toolbar to set the language for compilation
of the respective script.

Setting the Output Format
You can set the display of the output value with the "Output Format" attribute. The display
depends on the data type.
Data type

Format

Description

Binary

1

Every "1" stands for a character of the output value. A preceding "0"
indicates that a leading zero (corresponding to the number position) will
be added if necessary.

String

*

The existing string is output

String

?

n characters are output, starting from the left.

Hexadecimal

f

Every "f" stands for a character of the output value. A preceding "0"
indicates that a leading zero (corresponding to the number position) will
be added if necessary.

Decimal

s

the sign will be output

Decimal

e

Exponent display

Decimal

9

digit between 0 and 9

Decimal

0

Leading zero will be output

Decimal

.

Decimal point

Example for the Output
The example shows the different output formats for the output of the value 1.0 of the "Decimal"
data type.
Output format

Display

9.9

1.0

s9.9

+1.0

s9.99e

+1.0e+000

099.99

01.00

Changing "Tag" Objects with the Mouse
Rectangle surrounding the object
Drag the rectangle enclosing the object to a new position to arrange the object in the layout.
Drag the handles on the rectangle enclosing the object to a new position to resize the object.
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Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing "Tag" objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
Working with Dynamic Standard Objects (Page 1995)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
How to Paste an Object into a Layout (Page 1939)

10.5.8.4

Working with System Objects

Introduction
The following system objects can be output in a report:
● date and time
● Page number
● Project name
● Layout name
You can only paste system objects into the static part of a page layout.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to paste a system object.
2. Select "Static Part" from the "View" menu.
3. Click the system object you want in the "Standard Objects" tab in the object palette.
4. Place the mouse pointer at the position in the layout where
5. Hold down the mouse button and drag the object to the size and direction you want.
When you release the mouse button, the system object is finished.
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Format Options
You can set the display of the output value with the following format options. The representation
is dependent on the data format. If no format is set, a predefined format will be used for all
system objects during the report output. Please note that the specification of the parameters
is case-sensitive.
System object

Format

Description

Layout name

%L or %l

the layout name

Project name

%R or %r

the project name

Page number

%N or %n

the current page number

Page number

%T or %t

the total page count

Date/Time

%a

Weekday, short form

Date/time

%A

Weekday, written out

Date/time

%b

Month, short form

Date/time

%B

Month, written out

Date/time

%c

Date and time in standard format

Date/time

%d

Day and month as decimal number (01-31)

Date/time

%H

Hours in 24 hour format (00-23)

Date/time

%I

Hours in 12 hour format (01-12)

Date/time

%j

Day of the year as a decimal number (000-366)

Date/time

%m

Month as decimal number (01-12)

Date/time

%M

Minute as decimal number (00-59)

Date/time

%p

P.M./A.M. code for 12-hour format

Date/time

%S

Seconds as decimal number(00-59)

Date/time

%U

Week of the year as decimal number (01-51)

Date/time

%x

Date in standard format

Date/time

%X

Time in standard format

Date/time

%y

Year without century as decimal number (00-99)

Date/time

%Y

Year with century as decimal number

Date/time

%z

Time zone as name

Date/time

%%

Percentage sign

Changing System Objects with the Mouse
Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in
the layout.
Drag the handles on the rectangle surrounding the object to a new position in order to resize
the object.
Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.
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Changing System Objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will
find more information in the section entitled "Change Attribute".

See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
How to Paste an Object into a Layout (Page 1939)
Overview of the System Objects (Page 1903)

10.5.8.5

Working with the Layout Object

Introduction
A layout opened in the page layout editor is treated as an object. The layout object has object
properties and can be edited using the "Object Properties" dialog. However, the properties of
the layout object cannot be transferred to another layout object using the eyedropper.
The layout object has the following property groups:
● Colors
● Geometry
● Miscellaneous
You can obtain further information in the descriptions of the individual property groups in
chapter "Properties of an Object".

Requirements
A layout must be open in the page layout editor.

Procedure
1. Click with the mouse on any free space in the working area. Click the "Properties" button
in the toolbar. The "Object Properties" dialog opens.
2. Click the Properties tab.
3. Select the property group you want from the left area. The available attributes are shown
in the right area.
4. Edit the attributes you want.
5. Save your changes.
In principle, changes to the properties of a layout object effect the cover sheet, the report
contents and the closing page.
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The object name of the layout object is not displayed in the object selection of the "Object
Properties" dialog. Therefore, the layout object cannot be selected in the "Object Properties"
dialog using the object selection. If the "Object Properties" dialog is already open and fixed
with the pin, then simply click any free area of the work area for selection.

See also
The Miscellaneous Property Group (Page 1962)
The Geometry Property Group (Page 1958)
The Colors Property Group (Page 1956)

10.5.9

Working with Objects for the Runtime Documentation

10.5.9.1

Working with Objects for the Runtime Documentation

Introduction
The following chapters provide details regarding the Page Layout Editor objects available for
the runtime documentation.

Application
The runtime documentation objects are available for the output of runtime data in logs. The
objects are linked with the pertinent WinCC applications and provide the output data in runtime.
The objects for runtime documentation can only be inserted in the dynamic part of a page
layout.
Configure only the basic properties of the layout for the "WinCC Control Runtime Printprovider"
object. The report parameters for the output are determined by properties of the WinCC Control
and cannot be assigned dynamic properties.
In addition to the basic properties, configure the static and dynamic report parameters of the
layout for all other objects of the Runtime documentation. The objects provide dialogs for the
selection of output data.

See also
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 2028)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Rectangle Surrounding the Object (Page 1937)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
How to Configure the Static Parameters of WinCC Online Table Control (Page 2012)
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How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
How to Configure the Static Parameters of WinCC Online Trend Control (Page 2017)
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
How to Configure the Static Parameters of WinCC Function Trend Control (Page 2022)
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)
How to Configure the Static Parameters of WinCC Alarm Control (Page 2026)
Objects for the Runtime Documentation (Page 1904)

10.5.9.2

Modify output options for WinCC Online Table Control

How to Configure the Static Parameters of WinCC Online Table Control
Introduction
The "WinCC Online Table Control/Table" report object is used to output process data from the
associated Tag Logging Archives in a tabular format.
You can define static parameters for each column of the table and for some proper properties
of Control.

Requirements
● The WinCC Online Table Control/Table object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives or compression archives are inserted
● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The
dialog with the Control properites is displayed.
2. Configure in the Columns tab the columns you want to output. Select an archive tag for
each column.
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3. Define the table properties in the General tab. Only the non-grayed options can be
customized for report output.

4. Configure the time range to be considered for each column in the Column tab.
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You can enter a start time and an end time or a start time with a time range. If the "Update"
checkbox is activated, the start time refers to the current time. The previous values are then
output in the defined time interval.
1. Configure the time and value display formats in the Column tab.

See also
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 2015)
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How to Configure the Dynamic Parameters of WinCC Online Table Control
Introduction
The "WinCC Online Table Control/Table" report object is used to output process data from the
associated Tag Logging Archives in a tabular format.
You can define dynamic parameters for each column of the table and for some proper
properties of Control.
For a print order, the dynamizable parameters of WinCC Online Table Control are provided
with the current values of the assigned WinCC tags during runtime.
Value are supplied to WinCC tag through scripts, process-controlled actions or via other
WinCC applications. An overview of the dynamizable Runtime documentation parameters is
included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Online Table Control/Table object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives or compression archives are inserted
● Archive tags have been inserted
● You have inserted the columns for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized
Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click with the
mouse the "?" icon, you will get the following information:
– Description of the properties
– Format of the properties
– Suitable tag type
3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.
4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Online Table Control (Page 2012)
Dynamizable Parameters for Runtime Documentation (Page 1851)
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10.5.9.3

Modify output options for WinCC Online Trend Control

How to Configure the Static Parameters of WinCC Online Trend Control
Introduction
The "WinCC Online Trend Control/Picture" report object is used to output process data from
the associated Tag Logging Archives in the form of a trend.
You can define static parameters for each trend and for some properties of Control.

Requirements
● The WinCC Online Trend Control/Picture object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives or compression archives are inserted
● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The
dialog with the Control properites is displayed.
2. Configure in the Columns tab the columns you want to output.
– Select an archive tag for each trend
– Define the display format for each trend
– Define the display line weight for each trend
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3. Define the Control properties in the General tab. Only the non-grayed options can be
customized for report output.

4. Configure the time range or measurement range for each trend in the "Time Axis" tab.
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To output values for a time range, either define the start time or the end time or a start time
with a time range. To output values for a measurement range define the start time and the
number of measuring points.
If the "Update" checkbox is activated, the start time refers to the current time. The previous
values are then output in the defined time interval or measurement range.
1. For each trend, comfigure the properties of the value axis in the Value Axis tab.

See also
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 2020)
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How to Configure the Dynamic Parameters of the WinCC Online Trend Control
Introduction
The "WinCC Online Trend Control/Picture" report object is used to output process data from
the associated Tag Logging Archives in the form of a trend.
You can define dynamic parameters for each trend and for some properties of Control.
For a print order, the dynamizable parameters of WinCC Online Trend Control are provided
with the current values of the assigned WinCC tags during runtime.
Value are supplied to WinCC tag through scripts, process-controlled actions or via other
WinCC applications. An overview of the Runtime documentation parameters that can be
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Online Trend Control/Picture object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives or compression archives are inserted
● Archive tags have been inserted
● You have inserted the trends for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized
Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click in the list the
"?" icon, you will get the following information:
– Description of the properties
– Format of the properties
– Suitable tag type
3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.
4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Online Trend Control (Page 2017)
Dynamizable Parameters for Runtime Documentation (Page 1851)
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10.5.9.4

Modify output options for WinCC Function Trend Control

How to Configure the Static Parameters of WinCC Function Trend Control
Introduction
The "WinCC Function Trend Control/Picture" report object is used to output process data as
function of another tag from the process value, compression and user archives in the form of
a trend.
You can define static parameters for each trend and for some properties of Control.

Requirements
● The WinCC Function Trend Control/Picture object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives, compression archives or user archives are inserted
● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The
dialog with the Control properites is displayed.
2. Configure in the Columns tab the columns you want to output.
– Configure, if required, the setpoint trend for each trend
– Define the display format for each trend
– Define the display line weight for each trend
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3. Define the Control properties in the General tab. Only the non-grayed options can be
customized for report output.

4. In the Data Link tab, configure the data supply for the trends with archive tags or from user
archives.
5. In the X-Axis and Y-Axis tabs, configure the axis properties for each trend.

See also
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 2024)
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Configuring the dynamic parameters of the WinCC Function Trend Control
Introduction
The "WinCC Function Trend Control/Picture" report object is used to output process data as
function of another tag from the process value, compression and user archives in the form of
a trend.
You can define dynamic parameters for each trend and for some properties of Control.
For a print job, the dynamizable parameters of WinCC Function Trend Control are provided
with the current values of the assigned WinCC tags during runtime.
Value are supplied to WinCC tag through scripts, process-controlled actions or via other
WinCC applications. An overview of the Runtime documentation parameters that can be
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Function Trend Control/Picture object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Process value archives, compression archives or user archives are inserted
● Archive tags have been inserted
● You have inserted the trends for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized
Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property of a trend or control you want to dynamize. When
you click with the mouse the "?" icon, you will get the following information:
– Description of the properties
– Format of the properties
– Suitable tag type
3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.
4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Function Trend Control (Page 2022)
Dynamizable Parameters for Runtime Documentation (Page 1851)
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10.5.9.5

Modify output options for WinCC Alarm Control

How to Configure the Static Parameters of WinCC Alarm Control
Introduction
The "WinCC Alarm Control/Table" report object is used to output the message lists in a tabular
format.
For the output, define a message list and configure the static parameters of the message list.

Requirements
● The "WinCC Alarm Control/Table" object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Message configuration has been carried out in Alarm Logging

2026

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.5 Working with Objects

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The
dialog with the Control properites is displayed.
2. Define the message list you want to output in the General tab. Configure the Control
properties. Only the non-grayed options can be customized for report output.
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3. In the Message Blocks tab, configure the message blocks that are to be considered for the
message list output.
4. Assign the message blocks to the table columns of the message list in the Message List
tab. Click the "Selection..." button to open a dialog where you define the messages you
want to output.

See also
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 2028)

How to Configure the Dynamic Parameters of WinCC Alarm Control
Introduction
The "WinCC Alarm Control/Table" report object is used to output the message lists in a tabular
format.
You can define dynamic parameters for output to message lists.
In Runtime, the dynamic parameters are read from the system and written to the WinCC tags.
The start values of the tags are overwritten.
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Value are supplied to WinCC tag through scripts, process-controlled actions or via other
WinCC applications. An overview of the Runtime documentation parameters that can be
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The "WinCC Alarm Control/Table" object is pasted into the layout.
● The inserted object has been selected.
● The "Object properties" window is open
● Message configuration has been carried out in Alarm Logging
● You have configured the message list for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized
Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click with the
mouse the "?" icon, you will get the following information:
– Description of the properties
– Format of the properties
– Suitable tag type
3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.
4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Alarm Control (Page 2026)
Dynamizable Parameters for Runtime Documentation (Page 1851)
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10.5.9.6

Change output options for WinCC UserArchiveControl

How to configure the properties of the WinCC UserArchiveControl
Introduction
The report object "CCAxUserArchiveControl" serves for output of data from user archives
outside of the WinCC UserArchiveControl.
You specify the properties of the control in the Report Designer using the tabs of the WinCC
UserArchiveControl.

Requirements
● The "CCAxUserArchiveControl" object is inserted in the layout.
● The inserted object is selected.
● The "Object properties" window is open.
● A user archive is created using the "User Archive" editor.

Procedure
1. Double-click the "Properties" entry on the "Connect" tab in the "Object properties" window.
The dialog with the properties of the control opens.
2. Specify the user archive that you want to use on the "General" tab.
3. Configure the properties of the control that you need to output or adapt the user archive on
the tabs, for example, which columns you want to output or the representation of the table.

See also
How to configure the dynamic parameters of the WinCC UserArchiveControl (Page 2031)

How to configure the dynamic parameters of the WinCC UserArchiveControl
Introduction
The report object "CCAxUserArchiveControl" serves for output of data from user archives
outside of the WinCC UserArchiveControl.
You can dynamize the selection of the data in the user archive, the sorting of columns and the
time base.
The parameters of the WinCC UserArchiveControl that can be dynamized are provided with
the current values of the assigned WinCC tags in Runtime for a print job, for example, via
scripts.
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Requirements
● The "CCAxUserArchiveControl" object is inserted in the layout.
● The inserted object is selected.
● The "Object properties" window is open.
● A user archive is created using the "User Archive" editor.
● You have specified the columns you want to output by configuring the properties of the
control.

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized
Parameterization". The dialog with the list of properties that can be dynamized opens.
2. In the Parameter list, click the property you want to dynamize. When you click with the
mouse the "?" icon, you will get the following information:
– Description of the properties
– Format of the properties
– Suitable tag type
3. Click the tag selection symbol on the upper right side. The tag selection dialog appears.
4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection
dialog. If necessary, specify a start value for the tag.
5. Apply the settings you have made by clicking "OK" and save the layout.

See also
How to configure the properties of the WinCC UserArchiveControl (Page 2031)

10.5.9.7

Changing Output Options for Message Reports from Alarm Logging

How to Change the Output Options for Message Reports from Alarm Logging Runtime
Introduction
You can control the output of messages from the message list or from the message archive
in Runtime in advance via a user-specific selection of messages.
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Overview
The following layouts are available for alarm logging in Runtime in the page layout editor:
Archive report
Message report

The layout is linked to the Alarm Logging message archive and serves to
display the messages recorded there in a log.
The layout is linked to the Alarm Logging Runtime and serves to display the
current message list in a log. The layout also provides a message sequence
report in a page layout.

The output data selection procedure is the same for both layouts. In the following, the steps
are described for the message report.
In order to return a user-specific selection of messages, you can use a pre-defined layout, or
create your own layout. You can also create multiple layouts, filter the messages through the
selection criteria, and return them in separate logs. For the layout output, you need to configure
a job. See How to create print jobs for the Runtime documentation for more information.

Requirements
● The object "Message report" has already been inserted in the layout
● The inserted object has been selected
● The "Object properties" window is open
● You are familiar with the Link tab.
● Message configuration has been carried out in Alarm Logging.

Editing Options
For the objects "Archive report" and "Message report", you can select the data from the
message system as well as the time base.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "Selection"
in the list of editing options. The "Alarm Logging Runtime: Log Tables - Selection" dialog
opens.
2. Select the output data using the dialog. The dialog is described under "Selection of data
for a message report".
3. Apply the settings by clicking "OK".

See also
How to Modify the Time Range (Page 2034)
Filter Criteria for the Alarm Output (Page 2080)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
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The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)
Selection of the Data for a Message Report (Page 2036)

How to Modify the Time Range
Introduction
By changing the base for time specifications, you can convert the indicated time in the time
stamp to a different time base. These indicated times are only converted for output in the log;
they are not written back to the Alarm Log or Tag Log, or user archives. If, for example, you
want to output the data of a remote computer in another time zone, you can use this function
to ensure that the data is output with a comparable time. If, in this case, both computers worked
with the time base "Local Time", the two systems would contain logs with different time
specifications. The results would not be directly comparable. You can find additional
information in the section "Adjusting the Time Settings in the Project".
If you change the time base for the output, ensure that the time reference is also output in the
report. For example, specify an identifier in the alias for the "Time" message block. For more
details, please refer to "Selection of data for a message report".

Requirements
● The object "Message report" has already been inserted in the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● Message configuration has been carried out in Alarm Logging.

Edit Options
For the objects "Archive report" and "Message report", you can select the data from the
message system as well as the time base.
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Procedure
1. In the "Object Properties" window, you can also change the base for time specifications.
To do that, double-click the entry "Base for time specifications" in the list of editing options.
The following dialog will open.

2. Select the required time base and confirm your selection with "OK".
3. Modify the external form of the object, if necessary, by changing the attribute values in the
Properties tag.
4. Close the "Object Properties" dialog and save the layout.

See also
How to Change the Output Options for User Archive Tables (Page 2038)
How to Change the Output Options for Message Reports from Alarm Logging Runtime
(Page 2032)

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2035

Creating Page Layouts
10.5 Working with Objects

Selection of the Data for a Message Report
Data Selection
The "Alarm Logging Runtime: Report Table Column Selection dialog is used to select the data
to output in the message report or the message archive report. It allows you to select the
servers, message blocks, and filter criteria for alarm output.

Selecting the Servers
Server selection is only necessary if you:
● generate the message reports on a WinCC Client.
or
● in distributed systems, generate the message reports for one server on another server.
In the "Selection: Server from the Project Data" area, you can select the servers whose
messages are to be logged. Only those servers whose "packages" have been loaded are
offered. The selected servers are displayed in the window. In the case of a single-user and
multi-user project this selection is not required.
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Dynamization of Server Selection by Means of a WinCC Variable
You can dynamize server selection in order to select servers when a project is activated directly
before logging is started. The report system reads the value from the variable at runtime. If the
variable cannot be read, the configured value is used.
1. Select the "Variable" check box. The text box and the folder button are activated.
2. Use the folder button to open the variable selection dialog. Select the desired variable there,
and close the variable selection dialog. Alternatively, enter the variable name directly in the
text box.
Configure value assignment to the WinCC variable. You will find more information in the section
"Types of Dynamization".

Selecting Message Blocks
In the "Assignment: Message Blocks -> Table Columns" area, you can define the message
blocks for output in the report. In the "Message Blocks" area, select the desired message
blocks from the list of existing message blocks. Insert the message blocks, individually or in
groups, in the current column sequence list using the controls provided in the dialog.

Editing the Properties of the Message Blocks
From the list of the current column sequence of the report you can select individual message
blocks and edit their properties. To do this, select a message block from the current column
sequence of the report and click the "Properties" button. You can now assign an alias to the
block name and change the format for the date and time message blocks. The appearance of
the dialog that opens depends on the type of message block selected. The changes are only
effective for the output of the report and are not written back to the Alarm Logging.
If the "Use Aliases" check box is selected, the configured aliases are output as the column
headings. The aliases cannot be configured for multiple languages. If the check box is cleared,
the names of the message blocks are used as column headings. If the language is changed,
the names stored for the message blocks in the text library are output. By default, the check
box is cleared. If the "Use Aliases" check box is selected and there are no aliases configured,
the names of the message blocks are output.

Setting Filter Criteria for Alarm Output
In the "Filter Criteria for Alarm Output" area you can use the "Selection..." button to display the
dialog for setting criteria for alarm output. In the selection dialog, choose your selection criteria
by checking the appropriate boxes. When you apply the settings by clicking the "OK" button,
the selected selection criteria are displayed in the "Filter Criteria for Alarm Output" area. The
individual arguments are always ANDed. You will find more information in the section "Filter
Criteria for Alarm Output".
You can also make a selection in the print job by means of the size or time range. Additional
information can be found in the chapter "Print Jobs in WinCC".
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Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected
print job. At the start of the runtime output, the configuration dialog will then be launched.
Through this configuration dialog, you can open the dialog Alarm Logging Runtime: Report
Table Selection described above, and modify the settings directly before the output. For further
details, please see the chapter "Changing output options in runtime".

See also
Filter Criteria for the Alarm Output (Page 2080)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)

10.5.9.8

Changing Output Options for User Archive Tables

How to Change the Output Options for User Archive Tables
Introduction
The report object "User Archive Runtime/Table" is available for the output of runtime data from
a user archive or a view. The object is linked to user archives and provides data output from
the selected user archive/view.
The output data selection procedure is the same for user archives and views. In the following,
the steps are described for a user archive.
To return the current view of the User Archive Table Control, you only need to activate a predefined button in this control. For more details, please refer to chapter "Data Output from User
Archives".
In order to return a user-specific selection of data, you can use a pre-defined layout, or create
your own layout. For the layout output, you need to configure a job. For more details, please
refer to chapter "Creating Print Jobs for Runtime Documentation".

Requirements
● The object "User Archive Runtime Table" has already been inserted in the layout.
● The inserted object has been selected.
● The "Object Properties" window is open
● You are familiar with the Link tab.
● At least one user archive has been created

2038

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.5 Working with Objects

Editing Options
For the object "User Archive Runtime/Table", you can select the data from a user archive or
a view, as well as the time base.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "Table
Selection" in the list of editing options. This opens the "Table Selection" dialog.
2. Use the dialog to configure the selection of data for output. The dialog is described under
"Selection of Data for User Archive Tables".
3. Apply the settings by clicking "OK".

See also
How to Modify the Time Range (Page 2041)
How to Modify the Time Range (Page 2034)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)
Selection of Data for the User Archive Table (Page 2040)
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Selection of Data for the User Archive Table
Data Selection
The "Table selection" dialog serves to choose a user archive/view, select the table columns,
and specify the filter conditions and sorting.

Selecting a user archive/view
In the "Archive/View" area, you can select one of the user archives/views that are available in
the project. Clicking on the Folder button will open the Package Browser which lets you select
a user archive/view. You can choose from all user archives/views of the servers whose
packages were loaded.
Selecting the columns
Following the selection of an archive/view, you can choose the desired columns from the
archive/view. When a column is selected, its properties become unlocked. Use the dialog to
specify the format, orientation, number of places returned in the output, etc., for each column.
Setting filter conditions
In the "Filter condition" area, you can use SQL statements to set the filter conditions for the
output values from the archive database. To write up the filter conditions, you need to be
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familiar with the database language SQL. For further information, please refer to the user
archive help.
Setting the sorting
In the "Sorting" area, you can use SQL statements to set the sorting conditions for the output
values from the archive database. To write up the sorting conditions, you need to be familiar
with the database language SQL. For further information, please refer to the user archive help.
Dynamization through a WinCC variable
You can make the archive/view selection as well as the filter and sorting conditions dynamic
with WinCC variables in order to carry out the selection directly before the logging is triggered
with an activated project. The report system reads the value from the variable at runtime. If
the variable cannot be read, the configured value is used.
1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the
folder button are activated.
2. Use the folder button to open the variable selection dialog. Select the desired variable there,
and close the variable selection dialog. Alternatively, enter the variable name directly in the
text box.
Configure value assignment to the WinCC variable. You will find more information in the section
"Types of Dynamization".
Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected
print job. At the start of the runtime output, the configuration dialog will then be launched.
Through this configuration dialog, you can open the dialog "Table selection" described above,
and modify the settings directly before the output. For further details, please see the chapter
"Changing output options in runtime".

See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)

How to Modify the Time Range
Introduction
By changing the base for time specifications, you can convert the indicated time in the time
stamp to a different time base. These indicated times are only converted for output in the log;
they are not written back to the Alarm Log or Tag Log, or user archives. If, for example, you
want to output the data of a remote computer in another time zone, you can use this function
to ensure that the data is output with a comparable time. If, in this case, both computers worked
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with the time base "Local Time", the two systems would contain logs with different time
specifications. The results would not be directly comparable. You can find additional
information in the section "Adjusting the Time Settings in the Project".
If you change the time base for the output, ensure that the time reference is also output in the
report. For example, specify an identifier in the alias for the "Time" message block. For more
details, please refer to "Selection of data for a message report".

Requirements
● The object "Message report" has already been inserted in the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● Message configuration has been carried out in Alarm Logging.

Edit Options
For the objects "Archive report" and "Message report", you can select the data from the
message system as well as the time base.

Procedure
1. In the "Object Properties" window, you can also change the base for time specifications.
To do that, double-click the entry "Base for time specifications" in the list of editing options.
The following dialog will open.

2. Select the required time base and confirm your selection with "OK".
3. Modify the external form of the object, if necessary, by changing the attribute values in the
Properties tag.
4. Close the "Object Properties" dialog and save the layout.

See also
How to Change the Output Options for User Archive Tables (Page 2038)
How to Change the Output Options for Message Reports from Alarm Logging Runtime
(Page 2032)
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10.5.9.9

How to Change the Output Options for CSV Provider Tables

Introduction
The log object "CSV provider table" is available for the output of user-specific data from a data
source in CSV format. The object can be linked to a data source in CSV format and returns
the data from this source as a table in a WinCC protocol.

Requirements
● The object "CSV Provider Table" has already been inserted in the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● A CSV file is provided, or the file name is known

Edit Options
For the object "CSV provider table", you can select a CSV file for the output.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "CSV table
selection" in the list of editing options. This opens the "CSV table selection" dialog.

2. Use the "..." button to open the file selection dialog. Navigate to the desired CSV data source
and select it, or enter the path and file name directly in the input field.
3. To take over the font and font size from the file, enable the corresponding check boxes in
the dialog. If those boxes are not checked, the settings will be taken from the attributes of
the object properties.
4. Confirm your entries with "OK."
5. You can modify the external form of the object, if necessary, by changing the attribute values
in the Properties tab of the "Object properties" window.
6. Close the "Object Properties" window and save the layout.
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Changing the Output Options
Dynamization through a WinCC variable
To render the selection of output data more flexible, you can make the file selection dynamic.
This way, you can select the CSV file whose content is to be returned in runtime directly before
the output. The report system reads the value from the variable at runtime. If the variable
cannot be read, the configured value is used.
1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the
folder button are activated.
2. Use the folder button to open the variable selection dialog. Select the desired variable there,
and close the variable selection dialog. Alternatively, enter the variable name directly in the
text box.
Configure value assignment to the WinCC variable. You will find more information in the section
"Types of Dynamization".
Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected
print job. At the start of the runtime output, the configuration dialog will then be launched.
Through this configuration dialog, you can open the dialog "CSV table selection" described
above, and modify the settings directly before the output. For further details, please see the
chapter "Changing output options in runtime".
Changing the format options
You can modify the external form of the object, if necessary, by changing the attribute values
in the Properties tab of the "Object properties" dialog. The font and font size settings are applied
only when the corresponding checkboxes in the "CSV table selection" dialog have not been
activated.
If the above mentioned check boxes are activated, the formatting information will be taken
from the CSV file. In the CSV data source, you can add control characters for font size, font,
color and alignment, etc. For information regarding formatting with control characters, please
refer to chapter Reporting Requirements for a CSV Data Source.

See also
Requests to a CSV File for Reporting (Page 2078)
How to Change the Output Options for CSV Provider Trends (Page 2045)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)
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10.5.9.10 How to Change the Output Options for CSV Provider Trends
Introduction
The "CSV provider trend" report object is available for the output of user-specific data from a
data source in CSV format. The object can be linked to a data source in CSV format and returns
the data from this source as a curve in a WinCC protocol.

Requirements
● The object "CSV Provider Trend" has already been inserted in the layout
● The inserted object has been selected.
● The "Object properties" window is open
● You are familiar with the Link tab.
● A CSV file is provided, or the file name is known

Edit Options
For the object "CSV Provider Trend", you can select a CSV file for the output.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "CSV table
selection" in the list of editing options. This opens the "CSV table selection" dialog.

2. Use the "..." button to open the file selection dialog. Navigate to the desired CSV data source
and select it, or enter the path and file name directly in the input field.
3. Confirm your entries with "OK."
4. You can modify the external form of the object, if necessary, by changing the attribute values
in the Properties tab of the "Object properties" window.
5. Close the "Object Properties" window and save the layout.

Changing the Output Options
Dynamization through a WinCC variable
To render the selection of output data more flexible, you can make the file selection dynamic.
This way, you can select the CSV file whose content is to be returned in runtime directly before
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the output. The report system reads the value from the variable at runtime. If the variable
cannot be read, the configured value is used.
1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the
folder button are activated.
2. Use the folder button to open the variable selection dialog. Select the desired variable there,
and close the variable selection dialog. Alternatively, enter the variable name directly in the
text box.
Configure value assignment to the WinCC variable. You will find more information in the section
"Types of Dynamization".
Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected
print job. At the start of the runtime output, the configuration dialog will then be launched.
Through this configuration dialog, you can open the dialog "CSV trend selection" described
above, and modify the settings directly before the output. For further details, please see the
chapter "Changing output options in runtime".
Changing the format options
In the CSV data source, you can add control characters for the layout of the trend output.
Numerous options are available. For information regarding formatting with control characters,
please refer to the chapter "Reporting requirements for a CSV data source".

See also
Requests to a CSV File for Reporting (Page 2078)
How to Change the Output Options for CSV Provider Tables (Page 2043)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Runtime Documentation (Page 2011)

10.5.10

Working with Objects for the Project Documentation

10.5.10.1 Working with Objects for the Project Documentation
Introduction
In this chapter, you will find details regarding the available objects of the page layout editor for
the project documentation. You will learn how to work with the objects, and what are the basic
conditions for each object.
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The project documentation objects are provided for the report output of configured data. The
objects are linked to the corresponding WinCC applications and return the configuration data
of the WinCC project for output in a report. The objects for project documentation can only be
inserted in the dynamic part of a page layout.

Some objects provide an option to select output data. This allows you to restrict the output to
the data you currently need. For some of these objects, the selection options are identical. For
each type of selection, this chapter will describe the changes that can be made to the output
options. The relevant objects are listed with the descriptions.
The other objects do not offer an option to select output data. There are 3 types of these
objects. The editing steps to change the output options are identical for objects of the same
type and are described once for each object type.

Objects without data selection
The following object types are available:
Dynamic text
Dynamic metafile
Dynamic table
The modification of output options is described for each of these object types.
● Changing output options for dynamic texts
● Changing output options for dynamic metafiles
● Changing output options for dynamic tables without data selection
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See also
How to Change an Attribute (Page 1953)
How to Change the Output Options for the Dynamic Tables without Data Selection
(Page 2076)
How to Change the Output Options for the Dynamic Metafiles (Page 2075)
How to Change the Output Options for the Dynamic Texts (Page 2074)
How to Call up the Selection Dialogs (Page 2048)

10.5.10.2 How to Call up the Selection Dialogs

Selection dialogs are called in the same way for all project documentation objects. The
selection options depend on the object in question.

Requirements
● A project documentation object has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Procedure
1. Open the branching node(s) on the left of the Link tab. Choose and entry and select it. The
list of editing options will then show the item "Selection...". The available selection type
depends on the object which was chosen from the object tree.
2. Double-click on the entry "Selection...". This will open the corresponding selection dialog.

Depending on the object, you may be given several selection options in the area on the right.
In this case, make your selections one after the other. When a selection has been made, its
symbol on the right will be checked with a red mark. The entry "Element" is used for internal
purposes only.

2048

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Page Layouts
10.5 Working with Objects
If the left side of the window contains several hierarchical entries, the subentries may offer
various selection options, too. This depends on the object in question. It allows you to carry
out a hierarchical selection.
In the picture above, for example, the entry "Object" was marked in the window on the left; the
objects can now be selected in the window on the right. The entry "Attributes" is then marked
on the left. The attributes can now be selected on the right.

In the output, only the selected attributes for the objects chosen in the previous step will be
returned.
For an overview of available objects and output options for each component of WinCC, please
refer to the chapter "Project documentation".

See also
How to Change the Output Options for the Selection of Connection List (Page 2072)
How to Change the Output Options for the Tag Table of WinCC Explorer (Page 2070)
How to Change the Output Options for the Language Selection from the Text Library
(Page 2068)
How to Change the Output Options for the Selection of the Archive Tags from Tag Logging
(Page 2065)
How to Change the Output Options for the Selection of Archives from Tag Logging
(Page 2062)
How to Change the Output Options for the Selection of Action types (Page 2061)
How to Change the Output Options for the Selection of Object Statistics (Page 2059)
How to Change the Output Options for the Selection of Attributes (Page 2057)
How to Change the Output options for the Selection of the Picture Statistics (Page 2055)
How to Change the Output Options for the Selection of Views (Page 2053)
How to Change the Output Options for the Selection of User Archives (Page 2051)
How to Change Output Options for Single Message from Alarm Logging CS (Page 2050)
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10.5.10.3 How to Change Output Options for Single Message from Alarm Logging CS
Introduction
The object "Single Messages" allows you to output all, or individually selected, messages from
Alarm Logging in a report. The object is located in the Page Layout Editor object tree, in the
"Project documentation" tab under "Alarm Logging CS".

Requirements
● Messages must be configured in Alarm Logging.
● The object "Single Messages" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
Of all the objects for the Alarm Logging project documentation, the object "Single Messages"
is the only one that provides the option to select your output data.
For further information, please see the chapter "Project documentation in Alarm Logging".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Single messages".
The list of editing options will then show the item "Selection".
2. Double-click on the entry "Selection". The Alarm Logging CS dialog: Selecting Single
Messages dialog is opened.

If the "All single messages" checkbox is checked, all configured single messages that are
available at the time the report is generated will be returned. The buttons for accepting the
messages will only be enabled when the checkbox "All single messages" has been
deactivated.
3. Select the desired items from the list of available single messages and add them individually
or in groups, using the dialog buttons, to the list of selected single messages.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Single Messages", if necessary, by changing the
attribute values in the Properties tab.
6. Close the "Object Properties" window and save the layout.
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See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.4 How to Change the Output Options for the Selection of User Archives
Introduction
The object "Archive" allows you to output the configuration data of user archives in a report.
The object is located in the Page Layout Editor object tree, in the "Project documentation" tab
under "User archive configuration".

Requirements
● A user archive must have been created.
● The object "Archives" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
The objects "Archive" and "Views" are available for the project documentation of the user
archive configuration. Both objects offer options to select data for output. For further
information about the "Views" object, please see the chapter "Changing output options for the
selection of views".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Archives". The list of
editing options will then show the item "Archive selection".
2. Double-click on the entry "Archive selection". This will open the Archive selection dialog.

If the "All" checkbox is checked, all configured archives that are available at the time the
report is generated will be returned.
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3. From the list of available archives, select one or more for output.
4. Activate the check boxes for the archive attributes which you want to appear in the report.
5. To include archive field information in the output, activate the checkbox "Display fields".
6. Activate the check boxes for the field attributes which you want to appear in the report.
7. Confirm the selection with "OK".
8. Modify the external form of the object "Views", if necessary, by changing the attribute values
in the Properties tag.
9. Close the "Object Properties" window and save the layout.
Note
If multiple user archives were selected, the selection of archive attributes will be applied
to all selected user archives. If the checkbox "All" is activated, the configuration data of
all user archives within the WinCC project will be returned. The selection of archive
attributes applies to all user archives in this case as well.
The following table shows all the attributes that can be returned. The functions of the attributes
are briefly described.
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Attributes

Description

ID

ID of the user archive or field.

Name

Name of the user archive or field.

Alias

Alias name of the user archive or field.

Type

Shows whether a user archive belongs to the type Limited or Unlimited (maximum
number of data records limited or unlimited).
With fields, the type is the same as the tag type.

Size

The size of the user archive.

Changed

The date of the last change.

Com. Type

Communication type of the connection between user archive and automation
level.

PLCID

Identification number for the connection between user archive and automation
level.

Variable

For archives, the name of the WinCC tag for the connection to the automation
level.
For fields, the value in the user archive field.

ID tag

Name of the control tag "ID".

Job tag

Name of the control tag "Job".

Field tag

Name of the control tag "Field".

Value tag

Name of the control tag "Value".

Reading rights

Reading rights allocated for an archive or archive field.

Write protection

Writing rights allocated for an archive or archive field.
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Attributes

Description

Flags)

Information about set flags.
For archives:
Flag for last access, output = LA
Flag for last user, output = U
For fields:
Flag for Field must possess a value, output = NN
Flag for Field must possess a unique value, output = U
Flag for Field should be supported by an index, output = I

Length

Length of the user archive field.

Decimal places

Number of decimal places in the user archive field.

Minimum

Configured minimum value of the user archive field.

Maximum

Configured maximum value of the user archive field.

Start value

Configured start value of the user archive field.

See also
How to Change the Output Options for the Selection of Views (Page 2053)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.5 How to Change the Output Options for the Selection of Views
Introduction
The object "Views" allows you to return the configuration data for views of user archives in a
report. The object is located in the Page Layout Editor object tree, in the "Project
documentation" tab under "User archive configuration".

Requirements
● A view must have been created.
● The object "Views" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
The objects "Archive" and "Views" are available for the project documentation of the user
archive configuration. Both objects offer options to select data for output. For further
information about the object "Archives", please see the chapter "Changing output options for
the selection of user archives".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Views". The list of
editing options will then show the item "View selection".
2. Double-click on the entry "View selection". This will open the View selection dialog.

If the "All" checkbox is active, all configured views that are available at the time the report
is generated will be returned.
3. From the list of available views, select one or more for output.
4. Activate the check boxes for the view attributes which you want to appear in the report.
5. To include view column information in the output, activate the checkbox "Display columns".
6. Activate the check boxes for the columns which you want to appear in the report.
7. Confirm the selection with "OK".
8. Modify the external form of the object "Views", if necessary, by changing the attribute values
in the Properties tag.
9. Close the "Object Properties" window and save the layout.
Note
If multiple views were selected, the selection of view attributes will be applied to all selected
views. If the checkbox "All" is activated, the configuration data of all views within the WinCC
project will be returned. The selection of view attributes applies to all views in this case as
well.

The following table shows all the attributes that can be returned. The functions of the attributes
are briefly described.
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Attributes

Description

ID

ID of the view or column.

Name

Name of the view or column.

Alias

Alias name of the view or column.

Relation

Shows the relation between the user archive fields in a view.

Changed

Date and time of the last change.

Archive ID

ID of the user archive.

archive

Name of the user archive.

Field ID

ID of the user archive field.

Array

Name of the user archive field.
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See also
How to Change the Output Options for the Selection of User Archives (Page 2051)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.6 How to Change the Output options for the Selection of the Picture Statistics
Introduction
The object "Picture Statistics" allows you to output the statistics data for the pictures of the
Graphic Designer in a report. The object is located in the Page Layout Editor object tree, in
the "Project documentation" tab under "Graphics Designer/Picture".

Requirements
● A Graphics Designer picture must have been created.
● The object "Picture statistics" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the object "Picture statistics", you can select the statistic data.
For an overview of available objects for the product documentation of the Graphics Designer
and their output options, please refer to the chapter "Project documentation in the Graphics
Designer".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Picture Statistics".
The list of editing options will then show the item "Statistics data for the picture".
2. Double-click on the entry "Statistics data for the picture". This will open the dialog "Selection
of picture statistics".

If the checkbox "with descriptive column" is checked, a descriptive column will be returned
along with the statistics data.
3. Choose the desired items from the list of selection options and add them individually or in
groups, using the dialog buttons, to the list of selected data.
4. Using the "Up" and "Down" buttons, specify the output sequence of the tags.
5. Confirm the selection with "OK".
6. Modify the external form of the object "Picture Statistics", if necessary, by changing the
attribute values in the Properties tag.
7. Close the "Object Properties" window and save the layout.

Output with descriptive column
Picture name
Creation date
Number of objects in the picture
Number of objects with tag connection

PictureDocumentation.Pdl
23.07.2002 13:33:47
1
0

Output without descriptive column
PictureDocumentation.Pdl
23.07.2002 13:33:47
1
0

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
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The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.7 How to Change the Output Options for the Selection of Attributes
Introduction
The object "Attributes" facilitates the output of configuration data for the attributes of Graphics
Designer pictures and objects within in a report. The provided selection options allow you to
limit the output to relevant information.
You have two choices:
● All with tag connection – Returns all attributes which are linked to a tag.
● All with action connection – Returns all attributes which are linked to an action.
● All not interconnected – Returns all attributes which are not dynamic.
The object is located in the Page Layout Editor object tree, in the "Project documentation" tab
under "Graphics Designer/Picture," and under "Graphics Designer/Picture/Object".

Requirements
● A Graphics Designer picture must have been created.
● The object "Attributes" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the "Attributes" object of a picture, you can select the attributes as well as the table data.
For the "Attributes" object of an object within a picture, you can additionally select the objects.
Only the table data of the selected objects will be returned then. For further information, please
see the chapter "Calling the selection dialogs".
For an overview of available objects for the product documentation of the Graphics Designer
and their output options, please refer to the chapter "Project documentation in the Graphics
Designer".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2057

Creating Page Layouts
10.5 Working with Objects

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Attributes". The list
of editing options will then show the entries "Selection of attributes" and "Table data".
2. Double-click on the entry "Selection of attributes". This will open the dialog "Selection of
attributes".

Make your choices from the list of selection options.
3. Click on the "Default Attributes" button. This will open the dialog "List of default attributes".

Select the attributes that are to be returned always. Confirm the selection with "OK".
4. In the "Link" tab of the "Object Properties" window, double-click the entry "Table data". This
will open the dialog "Selection of table data".

5. From the list of selection options, choose the info columns which are to appear in the
attribute data table.
6. Confirm the selection with "OK".
7. Modify the external form of the object "Attributes", if necessary, by changing the attribute
values in the Properties tag.
8. Close the "Object Properties" window and save the layout.
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See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
How to Call up the Selection Dialogs (Page 2048)

10.5.10.8 How to Change the Output Options for the Selection of Object Statistics
Introduction
The object "Object Statistics" allows you to output the statistics data for the objects within the
pictures of the Graphic Designer in a report. The object is located in the Page Layout Editor
object tree, in the "Project documentation" tab under "Graphics Designer/Picture/Object".

Requirements
● A Graphics Designer picture must have been created.
● The object "Object Statistics" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the object "Object Statistics", you can select the objects as well as the statistics data. Only
the statistics data of the selected objects will be returned then. For further information, please
see the chapter "Calling the selection dialogs".
For an overview of available objects for the product documentation of the Graphics Designer
and their output options, please refer to the chapter "Project documentation in the Graphics
Designer".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Object". The list of
editing options will then show the item "Selection of Objects".
2. Double-click on the entry "Selection of objects". This will open the dialog "Selection of
objects".

Specify whether all objects should appear in the output, or only dynamic objects from
Graphics Designer pictures. Confirm the selection with "OK".
3. On the left of the "Object Properties" window, select the entry "Object statistics". This will
open the dialog "Statistics on the Object".

If the checkbox "with descriptive column" is checked, a descriptive column will be returned
along with the statistics data.
4. Choose the desired items from the list of selection options and add them individually or in
groups, using the dialog buttons, to the list of selected data.
5. Using the "Up" and "Down" buttons, specify the output sequence of the tags.
6. Confirm the selection with "OK".
7. Modify the external form of the object "Picture Statistics", if necessary, by changing the
attribute values in the Properties tag.
8. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
How to Call up the Selection Dialogs (Page 2048)
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10.5.10.9 How to Change the Output Options for the Selection of Action types
Introduction
The objects "Trigger" and "Source text" facilitate the output of configuration data for the actions
within Graphics Designer pictures and objects in a report.
You have two choices:
● All – Returns all elements with actions. Also returns all elements which have not yet been
configured at the time of this selection.
● Assignment actions – Returns all elements with assignment actions.
● No assignment actions – Returns all elements without assignment actions.
The objects are located in the Page Layout Editor object tree, in the "Project documentation"
tab under "Graphics Designer/Actions", and under "Graphics Designer/Picture/Actions".

Requirements
● A Graphics Designer picture must have been created.
● One of the objects "Trigger" or "Source text" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
You can select the actions for the objects "Trigger" and "Source text" of a picture.
For the objects "Trigger" and "Source text" of an object within a picture, you can additionally
select the objects. Only the action data of the selected objects will then be returned. For further
information, please see the chapter "Calling the selection dialogs".
For an overview of available objects for the product documentation of the Graphics Designer
and their output options, please refer to the chapter "Project documentation in the Graphics
Designer".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Actions". The list of
editing options will then show the item "Selection of actions".
2. Double-click on the entry "Selection of actions". This will open the dialog "Selection of action
types".

Select the action types you want.
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3. Confirm the selection with "OK".
4. Modify the external form of the object, if necessary, by changing the attribute values in the
Properties tag.
5. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
How to Call up the Selection Dialogs (Page 2048)

10.5.10.1 How to Change the Output Options for the Selection of Archives from Tag Logging
0
Introduction
The objects "Process value archive" and "Compressed archive" facilitate the output of
configuration data for process value and compressed archives in a report.
The objects are located in the Page Layout Editor object tree, in the "Project documentation"
tab under "Tag Logging CS/Archives".

Requirements
● A process value or compressed archive must have been created.
● One of the objects "Process value archive" or "Compressed archive" has been inserted in
the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the objects "Process value archive" and "Compressed archive", you can select both the
archives and the archive data.
For an overview of available objects for the Tag Logging product documentation and their
output options, please refer to the chapter "Project documentation in Tag Logging".
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Selection of Archives
1. Open the branching node on the left of the Link tab. Select an entry, either "Process value
archive" or "Compressed archive". The list of editing options will then show the item "Archive
names".
2. Double-click on the entry "Archive names". The Tag Logging CS: Archive Selection dialog
is opened.

If the "All archives" checkbox is checked, the data of all archives will be returned. An existing
selection will be preserved in the dialog.
3. Choose the desired items from the list of available archives and add them individually or in
groups, using the dialog buttons, to the list of selected data.
4. Confirm the selection with "OK".

Selection of Process Value Archive Data
1. In the "Object Properties" window, select the entry "Process value archive". The list of
editing options will then show the item "Process value archive data".
2. Double-click on the entry "Process value archive data". The Tag Logging CS: Process
Archive Data Selection dialog is opened.

3. Choose the configuration data you want to appear in the output.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Process value archive", if necessary, by changing
the attribute values in the Properties tag.
6. Close the "Object Properties" window and save the layout.
The following table shows all the attributes that can be returned. The functions of the attributes
are briefly described.
Attributes

Description

Comment

Brief description or comments about the archive.

Archive type

Type of the selected archive, here: Process value archive.

Server name

Server which is accessed by the archive.

Authorization

Authorization for read or write access.

Action During archive start/Enable Specified action which is triggered by certain events.
Archiving at system start
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Attributes

Description

Archive type

Type of the selected archive, short-term or long-term archive.

Fill level message

Edited fill level messages for the archive.

Size in data records

Specified number of data records which can be stored in a shortterm archive.

Memory location

Storage location for swap-out.

Action for relocating the shortterm archive

Specified action for swap-out.

Variable

The configured archive tags.

Selection of compressed archive data
1. In the "Object Properties" window, select the entry "Compressed archive". The list of editing
options will then show the item "Compressed archive data".
2. Double-click the entry "Compressed archive data". The Tag Logging CS: Compressed
Archive Data Selection dialog is opened.

3. Choose the configuration data you want to appear in the output.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Compressed archive", if necessary, by changing the
attribute values in the Properties tag.
6. Close the "Object Properties" window and save the layout.
The following table shows all the attributes that can be returned. The functions of the attributes
are briefly described.
Attributes

Description

Comment

Brief description or comments about the archive.

Archive type

Type of the selected archive, here: Compressed archive.

Server name

Server which is accessed by the archive.

Authorization

Authorization for read or write access.

Action During archive start/Enable

Specified action which is triggered by certain events.

Archive type

Type of the selected archive, short-term or long-term archive.

Compressed archive

Name of the compressed archive.

Archiving at system start

Returns the starting type of the archive.

Variable

The configured archive tags.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
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The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
How to Call up the Selection Dialogs (Page 2048)

10.5.10.1 How to Change the Output Options for the Selection of the Archive Tags from Tag Logging
1
Introduction
The objects "Process value archive tag" and "Compressed archive tag" facilitate the output of
configuration data for process value and compressed archive tags in a report.
The objects are located in the Page Layout Editor object tree, in the "Project documentation"
tab under "Tag Logging CS/Archives".

Requirements
● A process value or compressed archive must have been created.
● One of the objects "Process value archive tag" or "Compressed archive tag" has been
inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the objects "Process value archive tag" and "Compressed archive tag", you can select the
archives, tags and tag data.
For an overview of available objects for the Tag Logging product documentation and their
output options, please refer to the chapter "Project documentation in Tag Logging".

Selection of the Process Value Archive Tag
1. Open the branching node on the left of the Link tab. Select an entry, either "Process value
archive tag" or "Compressed archive tag". The list of editing options will then show the item
"Tag".
2. Double-click the "Tag" entry. The Tag Logging CS: Archive Tag Selection dialog is opened.

In the "Archive" area, select one or more tag types.
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3. In the "Archive" area, choose a process value archive from the selection list. The process
tags of the selected type which are available in the system are shown in the "Available"
window.
4. Choose the desired items from the list of available tags and add them individually or in
groups, using the dialog buttons, to the list of selected data.
5. Confirm the selection with "OK".

Selection of Process Value Archive Tag Data
1. In the "Object Properties" window, select the entry "Process value archive tag". The list of
editing options will then show the item "Tag data".
2. Double-click the "Tag data" entry. The Tag Logging CS: Tag Data Selection dialog is
opened.

3. Choose the configuration data you want to appear in the output.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Process value archive tag", if necessary, by changing
the attribute values in the Properties tag.
6. Close the "Object Properties" window and save the layout.
The following table shows all the attributes that can be returned. The functions of the attributes
are briefly described.
Attributes
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Description

Archiving at system start

Returns the starting type of the archive tag.

Archiving type

Archiving type: acyclic, cyclic-continuous or cyclic-selective
archiving.
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Attributes

Description

Process tag name

Names of the corresponding WinCC tags.

Tag supply

Returns the assignment type of the tag. Specifies whether the tag
is supplied with data manually, or through the system.

Also put archived value in tag

Outputs the WinCC tag in which an archived value is additionally
written.

Cycle

Time cycle used for archiving and data display.

Number of values

Output of values for leader and trailer.

Save on error

Returns the saving behavior in case of errors. Specifies whether,
in case of an error, the last value is saved, or rather a substitute
value.

Events

Events which trigger archiving.

Editing

Returns the processing type. Specifies how data is preprocessed,
e.g., by calculating an average.

Unit

Returns the unit of the specified time value.

Scaling

Returns the scaling type.

Name of statuses

Returns the names of status 0 and status 1.

Archiving on signal change

Returns the behavior which has been specified for a signal change.

Comment

Comments regarding archive tags.

Raw data tags

Name or ID of the raw data tags.

Selection of Compressed Archive Tag Data
1. In the "Object Properties" window, select the entry "Compressed archive tag". The list of
editing options will then show the item "Tag data".
2. Double-click the "Tag data" entry. The Tag Logging CS: Tag Data Selection dialog is
opened.

3. Choose the configuration data you want to appear in the output. For attribute descriptions,
please refer to the table above.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Compressed archive tag", if necessary, by changing
the attribute values in the Properties tag.
6. Close the "Object Properties" window and save the layout.
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See also
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.1 How to Change the Output Options for the Language Selection from the Text Library
2
Introduction
The object type "Text Library text table" allows you to insert text from the WinCC text library
in the dynamic part of a page layout. The object is located in the Page Layout Editor object
tree, in the "Project documentation" tab under "Text Library". Select the languages for which
text is to be returned in a table in the "Language selection" dialog.

Requirements
● User texts must be configured in the Text Library.
● The object "Text Library text table" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
Of all the objects for the Text Library project documentation, the object "Text Library text table"
is the only one that provides the option to select your output data.
For further information, please see the chapter "Project documentation in the Text Library".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Text Library text table".
The list of editing options will then show the item "Language selection".
2. Double-click the "Language selection" entry. This will open the dialog "Text Library
language selection".

If the "All" checkbox is checked, all configured languages will be returned. An existing
selection in this dialog will be preserved.
3. Choose the desired items from the list of designed languages and add them individually or
in groups, using the dialog buttons, to the list of selected languages.
4. Using the "Up" and "Down" buttons, specify the output sequence of the tags.
5. Use the option buttons to specify whether the different languages should appear in the
output separately, or arranged horizontally or vertically.
6. Confirm the selection with "OK".
7. Modify the external form of the object "Text Library text table", if necessary, by changing
the attribute values in the Properties tag.
8. Close the "Object Properties" window and save the layout.
Specify a table format
The layout of the report is specified using the table format option buttons. You can view the
effect of your settings in the preview window. The following table formats are available:
● If you choose "Separate", each language will be returned in its own table in the report.
● If you choose "Horizontal", the text in the selected languages that belongs to one text ID
will be returned in one row. With long text or several designed languages, this may well
exceed the width of the row.
● If you choose "Vertical", the text in the selected languages that belongs to one text ID will
be returned in separate rows.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
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10.5.10.1 How to Change the Output Options for the Tag Table of WinCC Explorer
3
Introduction
The object "Tags" allows you to return the tags from WinCC Tag Management in a report. The
object is located in the Page Layout Editor object tree, in the "Project documentation" tab under
"WinCC Explorer".

Requirements
● The Tag Management contains some tags.
● The object "Tags" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the object "Tags", you can select the tags, the tag groups and tag parameters. For the Tag
data type, you can also select the output format.
For an overview of available objects for the product documentation of the WinCC Explorer and
their output options, please refer to the chapter "Project documentation in the WinCC Explorer".

Selection of Tag Parameters
1. Open the branching node on the left of the Link tab. Select the entry "Tags". The list of
editing options will then show the item "Selection of tag parameters".
2. Double-click on the entry "Tag parameters". The WinCC Explorer: Selecting Connections
dialog is opened.

If the "Compact" checkbox is activated, all parameters of a tag will be returned in one row.
Else, each parameter will be returned in its own row. If, with output in "Compact" form, the
lines are too long for the rows, the rest will be cut off.
3. Activate the check boxes for the output parameters you want to use.
4. Confirm the selection with "OK".
The following table shows all the tag parameters that can be returned. The functions of the
parameters are briefly described.
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Parameters

Description

Data type

Returns the data type of a tag.

Group

Includes the allocation to a tag group in the output.

Parameters

Returns the address parameters of a tag.

External tag data

Returns information about the external linkage of a tag (e.g., connection,
channel unit, channel).

Limit values

Returns the designed limit values of a tag.

Start value

Returns a designed start value of a tag.

Substitute value

Returns a designed substitute value of a tag.

Protocol entry

Returns information about the type of a configured log entry.

Selection of Tag Groups
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will
then show the item "Selection of tag groups".
2. Double-click on the entry "Selection of tag groups". The WinCC Explorer: Select Tag
Groups dialog is opened.

3. Select the desired items from the list of available tag groups and add them individually or
in groups to the list of selected tag groups, using the dialog buttons.
4. Confirm the selection with "OK".

Selection of Tags
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will
then show the item "Selection of tags".
2. Double-click the entry "Selection of tags". The WinCC Explorer: Select Tags dialog is
opened.

If the "All tags" checkbox is active, all available tags will be returned. An existing selection
in this dialog will be preserved.
3. To be able to select specific tags, deactivate the checkbox "All tags". This will enable the
"Select" button.
4. Click on the "Select" button to open the WinCC tag selection dialog.
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5. Select the desired tags individually or in groups. Confirm the selection with "OK". The
selected tags will be added to the selection dialog.
6. Confirm the selection with "OK".

Formatting the Tag List
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will
then show the item "Format".
2. Double-click the "Format" entry. The WinCC Explorer: Format Tag List dialog is opened.

If the check box is active, the data type of the tag is returned in short form.
Long formats: Unsigned 32 bit value; floating point number 64 bit IEEE 754
Short formats: 32 bit value, without sign; 64 bit IEEE 754
3. Select the output form you want.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Tags", if necessary, by changing the attribute values
in the Properties tag.
6. Confirm the selection with "OK".
7. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.1 How to Change the Output Options for the Selection of Connection List
4
Introduction
The object "Connections" allows you to output the configured connections via WinCC
communication drivers in a report. The object is located in the Page Layout Editor object tree,
in the "Project documentation" tab under "WinCC Explorer".

Requirements
● A connection via a WinCC communication driver has been configured.
● The object "Connections" has been inserted in the layout, and selected.
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● The Object Properties window is open, and the Link tab is active.
● You are familiar with the Link tab.

Edit Options
For the object "Connections", you can select the connections.
For an overview of available objects for the product documentation of the WinCC Explorer and
their output options, please refer to the chapter "Project documentation in the WinCC Explorer".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Connections". The
list of editing options will then show the item "Selection of connection list".
2. Double-click on the entry "Selection of connection list". The WinCC Explorer: Select
Connections dialog is opened.

If the "All connections" checkbox is active, all available connections will be returned. An
existing selection in this dialog will be preserved.
3. Select the desired items from the list of available connections and add them individually or
in groups, using the dialog buttons, to the list of selected connections.
4. Confirm the selection with "OK".
5. Modify the external form of the object "Connections", if necessary, by changing the attribute
values in the Properties tag.
6. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
The Link tab in the Object Properties Window (Page 1952)
Working with Objects for the Project Documentation (Page 2046)
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10.5.10.1 How to Change the Output Options for the Dynamic Texts
5
Introduction
Some of the objects in the object tree "Project documentation" are of the type "Dynamic text"
and do not offer an option to select data for output. These objects are firmly linked to the WinCC
applications and provide the designated configuration data as text for output in a report.
Objects of the dynamic text type are marked in the object tree with the symbol

.

The external form of the objects can be influenced by changing their attributes. The procedure
is the same for all objects of this type. You can call up direct help for each attribute by rightclicking on it in the "Attribute" column.

Requirements
● The relevant object of the type "Dynamic text" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Properties tab is active.

Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the
branching node. The property groups of the object are shown in a directory tree.
2. Select a property group. The attribute of this group are shown in the area on the right.
3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the
attribute properties.
4. Specify the settings you want and confirm your entries with "OK".
5. Close the Object Properties window and save the layout.
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See also
How to Change the Output Options for the Dynamic Tables without Data Selection
(Page 2076)
How to Change the Output Options for the Dynamic Metafiles (Page 2075)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.1 How to Change the Output Options for the Dynamic Metafiles
6
Introduction
Some of the objects in the object tree "Project documentation" are of the type "Dynamic
metafile" and do not offer an option to select data for output. These objects are firmly linked
to the WinCC applications and provide the designated configuration data as an image for output
in a report.
Objects of the dynamic metafile type are marked in the object tree with the symbol

.

The external form of the objects can be influenced by changing their attributes. The procedure
is the same for all objects of this type. You can call up direct help for each attribute by rightclicking on it in the "Attribute" column.

Requirements
● The relevant object of the type "Dynamic metafile" has been inserted in the layout, and
selected.
● The Object Properties window is open, and the Properties tab is active.
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Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the
branching node. The property groups of the object are shown in a directory tree.
2. Select a property group. The attribute of this group are shown in the area on the right.
3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the
attribute properties.
4. Specify the settings you want and confirm your entries with "OK".
5. Close the Object Properties window and save the layout.

See also
How to Change the Output Options for the Dynamic Tables without Data Selection
(Page 2076)
How to Change the Output Options for the Dynamic Texts (Page 2074)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Objects for the Project Documentation (Page 2046)

10.5.10.1 How to Change the Output Options for the Dynamic Tables without Data Selection
7
Introduction
Some of the objects in the object tree "Project documentation" are of the type "Dynamic table"
and do not offer an option to select data for output. These objects are firmly linked to the WinCC
applications and provide the designated configuration data as a table for output in a report.
These dynamic tables do not offer any editing options in the "Link" tab of the "Object Properties"
dialog.
Objects of the dynamic table type are marked in the object tree with the symbol
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The external form of the objects can be influenced by changing their attributes. The procedure
is the same for all objects of this type. You can call up direct help for each attribute by rightclicking on it in the "Attribute" column.

Requirements
● The relevant object of the type "Dynamic table" has been inserted in the layout, and selected.
● The Object Properties window is open, and the Properties tab is active.

Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the
branching node. The property groups of the object are shown in a directory tree.
2. Select a property group. The attribute of this group are shown in the area on the right.
3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the
attribute properties.
4. Specify the settings you want and confirm your entries with "OK".
5. Close the Object Properties window and save the layout.

See also
How to Change the Output Options for the Dynamic Metafiles (Page 2075)
How to Change the Output Options for the Dynamic Texts (Page 2074)
How to Transfer Object Properties (Page 1954)
How to Change an Attribute (Page 1953)
The Properties of an Object (Page 1947)
Working with Objects for the Project Documentation (Page 2046)
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10.6

Appendix

10.6.1

Requests to a CSV File for Reporting

Introduction
To permit the data from a CSV file to be output in a WinCC log, the data must correspond to
a set structure. The data in a CSV file are prepared by the user. You will find more information
in chapters "Outputting Data from a CSV Table" and "Example of Reporting CSV Files".

Requirements for CSV File to be Output in Tabular Form
Each section must begin with the name of the corresponding file structure, followed by one or
more lines containing the elements of the file structure. The following file structures are defined:
File Structure for Output in Tabular Form
The table, columns, and data must be defined as follows:
#Table; Name; Columns; Font; Font size
- Name = name of the table control or file
- Columns = number of columns
- Font = font of the table
- Font size = font size of the table
#Column; Num; Header; Width; Alignment
- Num = number of the column
- Header = header of the column
- Width = width of the column in characters
- Alignment = left aligned/centered/right aligned
#Data; Color; Col1; Col2; Col3; Col4; ...
- Color = color attribute of the line (0xbbggrr)
- Col1 = data of column 1
- Col2 = data of column 2
- etc.
Points to Note About the Data in the CSV File
The control characters for colors, alignment, etc. are always at the beginning of the output text
and can be combined with each other (e.g. "<B><U>output text"). The entry is not casesensitive.
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The "Width" parameter indicates the relative width of the columns. The effective width of the
column in the table is calculated as follows:
[ [ Table width as a number of characters ] x [ relative width of the column in % ] / [ sum of all
relative widths of the column ]
The line defined for tables in the CSV file contains one more column than the data lines. If a
spreadsheet program such as Excel is used to edit the data, the columns for the headings and
the data will no longer match up. To prevent this from happening, you can enter a semicolon
(;) as the first character in the data lines of the CSV file. The data blocks of the CSV file may
not contain blanks. When you open the CSV in Excel, the data columns are shifted one column
to the right. The columns for the headings and data will then match up. If the first column does
not contain anything, you have to insert a blank (;blank;first data value;...).
Control Characters for Table Output
<END>

If the interpretation of control sequences is done, the rest of the text
will be transferred as it is given.
<COLOR=#rrggbb>
Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb> Background color in hexadecimal notation (default = as set for the
table)
<B>
Bold
<U>
Underlined
<I>
Italic
<STRIKE>
Strike-through
<ALIGN=left>
Left aligned
<ALIGN=center>
Centered
<ALIGN=right>
Right aligned
Note
The definition of the "Color" attribute conforms to the Intel byte format. The notation is
0xbbggrr (hex blue blue green green red red). The control characters for formatting the table
cells conform to the HTML standard. The notation for <color=> is #rrggbb.

Each section must begin with the name of the corresponding file structure, followed by one or
more lines containing the elements of the file structure. The following file structures are defined:
File Structure for Output in the Form of a Trend f(t)
#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize
- Name = name of the trend control or file
- Curves = number of trends
- DateFrom = start of time range, notation: 2000-10-30 10:15:00.000
Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- DateTo = end of time range, notation: 2000-10-30 10:15:00.000
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Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- Common Y-Axis = common y-axis
- Font = font
- Fontsize = font size
#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType; Filling
- Num = number of the trend
- Name = trend name
- Count = number of values
- dMin = lower limit of the trend (for scaling)
- dMax = upper limit of the trend (for scaling)
- Color = color attribute of the trend (0xbbggrr)
- Weight = line weight in points (e.g. 1.5)
- CurveType = trend type ( LINE, DOTS, STEP)
- Filling = filling color for areas ( 0=no, 1=yes). The Filling parameter is currently not in use.
#Data; Num; Date; Value; Flags; Color
- Num = number of the trend
- Date = X coordinate of the trend, notation: 2000-10-30 10:15:00.000
Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
- Value = y coordinate of the trend
- Flags = limit values/time overlap etc.
- Color (if an empty string is specified here, the color is taken from #Curve ...)

10.6.2

Filter Criteria for the Alarm Output

Introduction
The filter criteria for alarm output are transferred with the transfer of the selection criteria from
the selection dialog in the "Filter criteria for alarm output" area. The filter criteria can be edited.
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The following conditions apply to WinCC:
● The structure consists of the elements Field, Operand and Value, with the individual
parameters separated by blanks.
Example: DATETIME >= 2000-12-21 00:00:00' AND MSGNR >= 100 (all messages since
12.20.2000 with message number greater than 100)
● Strings, date, and time must be passed in single quotation marks.
● In the DATETIME argument, the date and time of day are separated by a blank. Regardless
of the time base setting in the object properties, the output of DATETIME is based on the
time base Local Time. Exception: UTC is set as the time base: in this case, the output is
based on time base UTC.

Permissible Arguments:
Name

Type

data

Example:

DATETIME

Date

'YYYY-MM-DD
hh:mm:ss.msmsms'

DATETIME >= '1999-05-03 16:00:00'
Output of message from 05.03.1999
16:00 hours.

MSGNR

Integer

Message number

MSGNR >= 10 AND MSGNR <= 12
Output of messages with
message number 10 -12.

CLASS IN
AND
TYPE IN

Integer

Message class ID 1-16
and
message type ID 1-256

CLASS IN ( 1 ) AND TYPE IN ( 2 )
Output of messages of message class
1
message type 2.

STATE

Integer

Value of
ALARM_STATE_xx
Only operands
= and IN(...) are
permitted

STATE IN(1,2,3)
Output of all message that came in,
went out and were acknowledged.

ALARM_STATE_1
ALARM_STATE_2
ALARM_STATE_3
ALARM_STATE_4
ALARM_STATE_5
ALARM_STATE_6
ALARM_STATE_7
ALARM_STATE_16
ALARM_STATE_17

Possible values:
1 = Came In messages
2 = Went Out messages
3 = acknowledged messages
4 = locked message
5 = released messages
6 = messages that came in and have
been acknowledged
7 = messages that came in and went
out
16 = messages acknowledged by the
system
17 = emergency-acknowledged
messages

AGNR

Integer

PLC number

AGNR >= 2 AND AGNR <= 2
Output of messages with
AG number = 2.

AGSUBNR

Integer

AG subnumber

AGSUBNR >= 5 AND AGSUBNR
<= 5
Output of messages with
AG subnumber = 5.
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Name

Type

data

Example:

TEXTxx

Text

Search text for
'Text1'-'Text10'

TEXT2 = error
Output of messages with
Text2 = "error".

PVALUExx

Double or text Search text for
PVALUE1PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Output of process value 1 with
start value 0 and stop value 50.

The following operands are permissible:
>= , <= , = , > , < ,IN(...),LIKE
IN(...): several values in Array separated by commas, e.g. CLASS IN( 1 ,2 ,3 ) AND TYPE
IN( 1 ,2 ,19 ,20 ,37 ,38 )
LIKE: Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1 contains
the search text Error.
The operand LIKE is only permissible for TEXT arguments.
Arguments and operands other than those mentioned above are not permissible.
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Creating Line Layouts

Contents
The line layout editor is an editor provided by WinCC that allows you to create and dynamize
line layouts for the output of a message sequence report. As part of WinCC, it can only be
used to edit line layouts belonging to the project that is open in WinCC.
This section shows you
● How to use the line layout editor
● How to create and edit line layouts
● How to design a line layout
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11.2

How to Start the Line Layout Editor

Introduction
In accordance with Windows conventions, there are various ways of opening the line layout
editor. The line layout editor can only be opened for the current project that is open in WinCC
Explorer.

Requirement
● A project must be open in WinCC Explorer.

Opening the Line Layout Editor
The line layout editor is always called in WinCC Explorer.

The following options are available:
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Navigation window/data window of WinCC Explorer:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.
In the navigation or data window of WinCC Explorer, select "Layouts" and choose the "Open
Line Layout Editor" command from the pop-up menu.
The line layout editor is started, and a new layout is opened.
WinCC Explorer data window:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.
In the navigation window, select "Layouts". The available layouts are displayed in the data
window. Double-click a line layout or choose "Open Line Layout" from the pop-up menu.
The line layout editor is started, and the selected line layout is opened.

See also
The Line Layout Editor (Page 2086)
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11.3

The Line Layout Editor

11.3.1

The Line Layout Editor

Introduction
The line layout editor is used only to create and edit line layouts for a message sequence
report. Each line layout contains a dynamic table that is connected to the WinCC message
system. Additional objects cannot be added to a line layout. Text can be entered in the header
and footer. Start the line layout editor in WinCC Explorer.

Layout of the Line Layout Editor
The line layout editor has a toolbar, menu bar, status bar, and various different areas for editing
a line layout. When opened, the line layout editor appears with the default settings.

(1) The Menu Bar
The menu bar is always visible. Depending on the context, the functions in the menus are
active or inactive.
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(2) The Toolbar
The toolbar is always visible in the line layout editor. There are different buttons on the toolbar
that allow you to activate the functions of the menu commands quickly. The buttons are either
active or inactive, depending on the situation.

(3) The Header Area
The Header area allows you to enter text in order to create the header of a line layout.

(4) The Table Area
The design of the table for output is displayed in the Table area. The configured column
headings and the width of the columns (number of characters per column) are displayed. The
table can be configured for output using the buttons in this area.

(5) The Footer Area
The Footer Area is used to enter text in order to create the footer of a line layout.

(6) The Page Size Area
The Page Size area is used to set the number of lines and columns for a line layout.

(7) The Margins Area
The Margins area is used to set the margins for the output of a line layout.

(8) The Status Bar
You will find the status bar along the lower edge of the screen. It contains tips on the buttons
on the toolbar, on menu commands, and on keyboard settings, for example.

See also
The Table Area (Page 2090)
The Header and Footer Areas (Page 2090)
The Page Size and Margins Areas (Page 2089)
The Standard Toolbar (Page 2088)
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11.3.2

The Standard Toolbar

Usage
The toolbar is located under the menu bar along the top of the line layout editor. The buttons
arranged on the toolbar enable you to access the functionality of the line layout editor quickly
and easily.

Contents
The standard toolbar contains buttons with the following functions:
Button

Function

Key combination

Creates a new line layout.

<CTRL+N>

Opens an existing line layout.

<CTRL+O>

Stores the active line layout.

<CTRL+S>

<CTRL+X>
Cuts the selected text from the header or footer and copies it to
the clipboard. The function is only available when a text is selected.
Copies the selected text from the header or footer to the clipboard.
The function is only available when a text is selected.

<CTRL+C>

Pastes the contents of the clipboard at the location of the cursor.
The function is only available if there is a text on the clipboard.

<CTRL+V>

The "Print" function is deactivated in the line layout editor.
Activates the direct help (What's this?).

<SHIFT+F1>

Characteristics
The toolbar in the line layout editor is always activated. You cannot hide it.

See also
The Page Size and Margins Areas (Page 2089)
Working with the Line Layout Editor (Page 2092)
The Table Area (Page 2090)
The Header and Footer Areas (Page 2090)
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11.3.3

The Page Size and Margins Areas

Introduction
Line-by-line printing is used in practice for current and synchronous documentation. WinCC
allows for "line-by-line printing" on appropriate printers. The output to the printer is only possible
via a local, parallel interface on the computer. You can set the page size and margins for each
line layout within the permissible limits.

Page Size in the Line Layout
The page size of a line layout can be set within the following limits:
● You can set between between 20 and 400 lines.
● The number of columns can be between 20 and 400.
The value for the number of columns is defined as the number of characters per line.

Margins in the Line Layout
Because most printers cannot print right up to the edge of the page, the margins must be set
accordingly in the line layout. The margins of a line layout can be set within the following limits:
● The value for the margins (left, right, top, bottom) can be between 0 and 30 characters.

Printer Settings
The number of columns set in a line layout under "Page Size" (= characters per line) must be
supported by the printer used. If the number of columns is greater than the number of
characters a printer can print per line, a line break is inserted. This overflow of the column text
into a new line disturbs the column formatting. To remedy this, a narrower font or a smaller
character width must be set for the printer.
Setting the font or character width depends on the printer used. Please check the printer
manual for further information.
Note
If the suitable font is not set as the default font on the printer, it will have to be set again each
time the printer is reset or switched off and on again.

See also
Working with the Line Layout Editor (Page 2092)
The Table Area (Page 2090)
The Header and Footer Areas (Page 2090)
The Standard Toolbar (Page 2088)
How to Set the Page Size (Page 2092)
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11.3.4

The Header and Footer Areas

Introduction
You can define a different header and footer for each line layout. The number of headers and
footers can be between 0 and 10. You can enter any text you like in them. You can output as
many headers as the number of lines you have set. You do not have to output the header and
footer.

Usage
The headers and footers are output with each page of the message sequence report. The
width of the headers and footers is based on the number of columns (= characters per line)
set under "Page Size". Text in the header or footer that is longer than the configured number
of columns is truncated at output.

See also
Working with the Line Layout Editor (Page 2092)
The Table Area (Page 2090)
The Header and Footer Areas (Page 2090)
The Standard Toolbar (Page 2088)
How to Create Headers and Footers (Page 2093)

11.3.5

The Table Area

Introduction
You can define a table for the output of reports and measured values for each line layout. The
number and contents of the columns are defined using the "Selection..." button. The number
of columns can be between 1 and 40 and depends on the number of selected message blocks.

Usage
The configured columns with the associated headings and the set column width are displayed
in the Table area. You can configure the column heading and the column width for each column
separately.
Use the "Selection..." button to open the "Alarm Logging Runtime: Report - Table Column
Selection" dialog. In this dialog, you can select the server(s) whose reports you want to log.
You can assign the message blocks to the table columns and set the filter criteria for the alarm
output. These changes are only effective for the output of the message sequence report and
are not written back to the alarm logging. You can find additional information in the sections
"Outputting Runtime Data with the Message Sequence Report" and "Changing Output Options
for the Message Sequence Report".
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See also
The Time Range (Page 2091)
Working with the Line Layout Editor (Page 2092)
The Table Area (Page 2090)
The Header and Footer Areas (Page 2090)
The Standard Toolbar (Page 2088)
How to Change the Output Options for the Message Sequence Report (Page 2096)

11.3.6

The Time Range

Introduction
By changing the base for the time settings you can convert the time specified in the time stamp
of the report data to a different time base. The time settings are only converted for the output
in the report and are not written back to the alarm logging. If, for example, you want to output
the data of a remote computer in another time zone, you can use this function to ensure that
the data is output with a comparable time. If the two computers in this case were working with
the "Local Time" time base, you would receive reports on the two computers with different
times. The results would not be directly comparable. You can find additional information in the
section "Adjusting the Time Settings in the Project".
If you change the time base for the output, ensure that the time reference is also output in the
report. For example, specify an identifier in the alias for the "Time" message block. You can
find additional information "Changing the Output Options for the Message Sequence Report".

Usage
You can change the time base in the "Table" area. To do this, click the "Time Base..." button.
The "Time Base Entry" dialog appears. Select the time base from the list.

See also
The Header and Footer Areas (Page 2090)
The Table Area (Page 2090)
Working with the Line Layout Editor (Page 2092)
The Standard Toolbar (Page 2088)
How to Change the Output Options for the Message Sequence Report (Page 2096)
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11.4

Working with the Line Layout Editor

11.4.1

Working with the Line Layout Editor

Introduction
The line layout editor is only used to create and change line layouts for the message sequence
report. It therefore has a very simple layout and is easy to use. This section describes how
you can do the following:
● Set the page size of a line layout
● Create the header and footer
● Create a table in the line layout
● Change the output options for the message sequence report

See also
How to Change the Output Options for the Message Sequence Report (Page 2096)
How to Create a Table in the Line Layout (Page 2094)
How to Create Headers and Footers (Page 2093)
How to Set the Page Size (Page 2092)

11.4.2

How to Set the Page Size

Introduction
You can set the page size and margins for each line layout within the permissible limits. You
can set the desired values either by using the controls or by entering them directly in the fields.
The following limits apply to the line layout:
Number of lines

Values between 20 and 400 are valid.

Number of columns

Values between 20 and 400 are permissible.

Margin width

Values between 0 and 30 are permissible.

Procedure
1. Select an existing line layout in WinCC Explorer or create a new line layout and open it in
the line layout editor.
2. Set the number of lines per page in the "Page Size" area by using the corresponding
controls or by entering a value.
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3. Set the number of columns (= characters per line) in the "Page Size" area by using the
corresponding controls or by entering a value.
4. Set the width of the margins for output in the "Margins" area by using the controls or entering
values.
5. Save the changes and close the line layout editor.

See also
How to Change the Output Options for the Message Sequence Report (Page 2096)
How to Create a Table in the Line Layout (Page 2094)
How to Create Headers and Footers (Page 2093)

11.4.3

How to Create Headers and Footers

Introduction
You can create a header and footer for each line layout in the line layout editor. They are then
output with each page. Headers and footers consist of text only and can have a maximum of
10 lines each. You can set the number of lines for headers and footers separately by using
the corresponding controls or by entering values directly. Lines of text that are longer than the
page width set in the "Page Size" area (number of columns =characters per line) are truncated
at output.

Procedure
1. Open the desired line layout in the line layout editor.
2. Set the number of lines in the "Header" area by using the corresponding control or entering
a value.
3. Enter the text for the header in the text box. Note the number of characters per line. Press
the return key to insert a line break.
4. Edit the footer in the same way.
5. Save and close the layout.
If you enter more lines during input than are specified for "Number of Lines", a message to this
effect appears. Only the number of lines set for "Number of Lines" are output. Excess lines
are not output.

See also
How to Change the Output Options for the Message Sequence Report (Page 2096)
How to Create a Table in the Line Layout (Page 2094)
How to Set the Page Size (Page 2092)
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11.4.4

How to Create a Table in the Line Layout

Introduction
The table object for the output of reports in the message sequence report is a fixed part of the
line layout. The static object properties for this table object are predefined. Click the
"Selection..." button to open the "Alarm Logging Runtime: Report - Table Column Selection"
dialog. In this dialog you can specify the assignment of the message blocks to the columns for
output. You also assign the column headings here and set the width of the individual columns
for output.

Requirements
● The desired layout must be open in the line layout editor.
● Alarm logging must be configured.

2094

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Creating Line Layouts
11.4 Working with the Line Layout Editor

Procedure
1. Click the "Selection..." button to open the "Alarm Logging Runtime: Report Table Column
Selection" dialog.

2. Use the dialog to specify the data for output. You can find additional information in the
section "Changing the Output Options for the Message Sequence Report". When you close
the dialog, the selected columns and their widths are displayed in characters per line in the
"Table" area. If the number of characters per line is too large, a message to this effect
appears.
3. Change the time base for times, if necessary. You will find more information in the section
"Table Area".
4. Save the line layout, and close the editor.

See also
How to Create Headers and Footers (Page 2093)
How to Set the Page Size (Page 2092)
The Table Area (Page 2090)
How to Change the Output Options for the Message Sequence Report (Page 2096)
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11.4.5

How to Change the Output Options for the Message Sequence Report

Introduction
To output a user-specific selection of messages, you can either use a predefined line layout
or create your own line layout. The layout must be called in the "@Report Alarm Logging RT
Message Sequence" print job.
For the output of a message sequence report in a page layout, changes to the output options
must be configured in the page layout editor. You will find more information in the section
"Creating a User-Defined Message Sequence Report".
Note
You cannot output a Message Sequence Report in line layout as a file.

Requirements
● The desired layout must be open in the line layout editor.
● Message configuration has been carried out in Alarm Logging.

Procedure
1. Click the "Selection" button in the "Table" area. The "Alarm Logging Runtime: Report Table
Column Selection" dialog is opened.
2. Use the dialog to configure the selection of data for output. You will find a description of
the dialog in the section "Data Selection" below.
3. Apply the settings by clicking "OK".
4. Save the line layout, and close the editor.
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Data Selection
The "Alarm Logging Runtime: Report Table Column Selection" dialog is used to select the data
to output in the message sequence report. It allows you to select the servers, message blocks,
and filter criteria for alarm output.

Selecting the Servers
Server selection is only necessary if you:
● want to log the messages on a WinCC client,
or
● want to log the messages of one server on another server in a distributed system
In the "Selection: Server from the Project Data" area, you can select the servers whose
messages are to be logged. Only those servers whose "packages" have been loaded are
offered. The selected servers are displayed in the window. In the case of a single-user and
multi-user project this selection is not required.
Dynamization of Server Selection by Means of a WinCC Variable
You can dynamize server selection in order to select servers when a project is activated directly
before logging is started. The report system reads the value from the variable at runtime. If the
variable cannot be read, the configured value is used.
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1. Select the "Variable" check box. The text box and the folder button are activated.
2. Use the folder button to open the variable selection dialog. Select the desired variable there,
and close the variable selection dialog. Alternatively, enter the variable name directly in the
text box.
Configure value assignment to the WinCC variable. You will find more information in the section
"Types of Dynamization".
Selecting Message Blocks
In the "Assignment: Message Blocks -> Table Columns" area, you can define the message
blocks for output in the report. In the "Message Blocks" area, select the desired message
blocks from the list of existing message blocks. Use the control elements in the dialog to add
the message blocks to the list of the current column sequence of the report either individually
or in groups.
Editing the Properties of the Message Blocks
From the list of the current column sequence of the report you can select individual message
blocks and edit their properties. To do this, select a message block from the current column
sequence of the report and click the "Properties" button. You can now assign an alias to the
block name and change the format for the date and time message blocks. The appearance of
the dialog that opens depends on the type of message block selected. The changes are only
effective for the output of the report and are not written back to the Alarm Logging.
If the "Use Aliases" check box is selected, the configured aliases are output as the column
headings. The aliases cannot be configured for multiple languages. If the check box is cleared,
the names of the message blocks are used as column headings. If the language is changed,
the names stored for the message blocks in the text library are output. By default, the check
box is cleared. If the "Use Aliases" check box is selected and there are no aliases configured,
the names of the message blocks are output.
Setting Filter Criteria for Alarm Output
In the "Filter Criteria for Alarm Output" area you can use the "Selection..." button to display the
dialog for setting criteria for alarm output. Use the check boxes in the dialog to select the
desired selection criteria. When you apply the settings by clicking the "OK" button, the selected
selection criteria are displayed in the "Filter Criteria for Alarm Output" area. The individual
arguments are always ANDed. You will find more information in the section "Filter Criteria for
Alarm Output".
You can also make a selection in the print job by means of the size or time range. Additional
information can be found in the chapter "Print Jobs in WinCC".
Note
In a message sequence report, the messages from the report system are logged as soon as
they arrive. It therefore does not make sense to select the time range for the output.
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See also
How to Create a Table in the Line Layout (Page 2094)
How to Create Headers and Footers (Page 2093)
How to Set the Page Size (Page 2092)
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12

COM Provider in the Layout Editor

Contents
In the report system of WinCC, an user-specific report object can be integrated with the aid of
a COM interface. Therefore data which does not originate in WinCC can be output in a WinCC
report. The documentation provides information about:
● Application options of the COM Provider
● Integration of COM Provider into WinCC
● Outputing data with the aid of a COM object
● Details of the COM interface for reporting
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12.2

Working with COM Server Objects

Introduction
To integrate user-specific data in a WinCC log, you can integrate a COM server in the report
system. This COM server provides a COM object in the object selection that is selected in the
page layout editor and added to a page layout. The COM object then provides the user-specific
data for output in the log. The COM object can be of the type text, table, or picture.
At this point, no comment can be made about the COM object itself. Information about it is
provided by the writer of the COM server.

Integration of COM Server Objects
The following steps are necessary to use a COM object in the report system:
1. Register COM object
2. If necessary, depending on the COM object, run the Registry file of the COM object.
3. Insert COM object in the object palette of the page layout editor by entering it in the registry
4. Select COM object in the object selection
5. Position COM object in the layout and parameterize it
Steps 1 to 3 must be carried out on every server and WinCC client on which you want to use
such a COM object. These steps must also be carried out if the COM object should only be
used in Runtime.
To create a COM server for the report system of WinCC, the Type Library
"WinCCProtProvider.tlb" must be registered on the development computer. The Type Library
is automatically registered on a computer with WinCC installed. To register on a computer
without WinCC installed there is the following option:
Copy the "WinCCProtProvider.tlb" file from a computer with WinCC installed. The file is located
in directory "..\Siemens\WinCC\Interfaces. Add the file to the target computer and register it.
A correctly integrated COM object is displayed in the object selection of the page layout editor
on the "COM Server" tab. From there it can be selected and added to the layout.
For more information, refer to chapter "Details of the COM Interface for Reporting".

See also
How to Output Data from a COM Server in a Report (Page 2103)
Example of an integration of a COM server (Page 2104)
Details of the COM Interface for Reporting (Page 2105)
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How to Output Data from a COM Server in a Report

Introduction
To integrate user-specific data in a WinCC log, you can integrate a COM server in the report
system. This COM server makes a log object available in the object palette that can be selected
in the page layout editor and inserted in a page layout. The COM object then provides the userspecific data for output in the log.

Available Log Objects
COM object defined by the Serves to output data from data sources of the user in a WinCC
user
log.

Requirements
● Knowledge of how to create layouts and insert log objects

Procedure
1. Create a new page layout, and open it in the page layout editor.
2. In the object palette on the COM Server tab, select a COM object integrated by the user,
and drag it to the desired size in the working area.
3. The creator of the COM object makes specifications available on the connection and
selection of the data.
4. Configure the COM object in accordance with the specifications made there.
5. Save the layout.
6. Create a print job, and select the configured page layout there.
7. Start output by means of the print job in WinCC Explorer or by means of a configured call
in a WinCC picture, for example.

Output options
You receive information on possible output options from whoever wrote the COM object.

See also
Working with COM Server Objects (Page 2102)
Details of the COM Interface for Reporting (Page 2105)
Example of an integration of a COM server (Page 2104)
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12.4

Example of an integration of a COM server

Introduction
There two examples provided on the WinCC CD-ROM, each containing a COM server. One
example is written in Visual Basic, the second one is written in Visual C. The examples are in
zip format under "Options\ODK\Samples" on the WinCC CD-ROM. The
"CCProtTableServerExampleVB.zip" file contains the example in Visual Basic.
"CCProtPicturerExampleCPP.zip" file contains the example in Visual C++.

Procedure
Unpack the compressed file into a temporary directory. Integrate the files into the system.
1. Provide the Type Library
2. Compile example
3. Register COM server
4. Integrate COM server in the report system
To integrate the COM Server in the system, you require extensive programming skills that
cannot be provided in this documentation. Chapter "COM Interface Requirements for
Reporting" contains instructions regarding the formal COM server requirements.
The "*.REG" files supplied with the examples are not part of the sample projects in Visual
Basic or Visual C. Instead they are used to insert the COM Servers into the object palette of
the page layout editor.
Note
The ClassId for Visual Basic exists only in the compiled DLL. This this file is not included, a
new ClassID will be generated during compilation. This new ClassID must then be entered
in the RegFile of the Report Provider.
You will find the new ClassID using the "OLEView" tool. Search the ProgID.

See also
Details of the COM Interface for Reporting (Page 2105)
How to Output Data from a COM Server in a Report (Page 2103)
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Details of the COM Interface for Reporting

Introduction
This chapter provides information and the requirements of a COM Interface for reporting.
Further instructions can be found in the chapters "COM Server Data Output" and "Example of
the Integration of a COM Server".

Call Interface
An object can/must provide the following COM interfaces so that the WinCC report system can
use this object:
interface IWinCCProtProvider : IDispatch
{
HRESULT Register([in]IDispatch* pIDispWinCCProtReportParams);
HRESULT Unregister();
HRESULT GetName([out, retval]BSTR* pName);
HRESULT ShowPrivateDialog([in]long hwndParent, [out, retval]BOOL* pfOK);
HRESULT SetPrivateData([in]VARIANT PrivateInfo);
HRESULT GetNameOfPrivateData([out, retval]BSTR* pPrivateInfoName);
HRESULT GetPrivateData([out, retval]VARIANT* pPrivateData);
};
interface IWinCCProtProviderText : IDispatch
{
HRESULT GetText([out, retval]BSTR* pName);
};
interface IWinCCProtProviderTable : IDispatch
{
HRESULT GetNumCols([out, retval]int* pnNumCols);
HRESULT GetNumLines([out, retval]int* pnNumLines);
HRESULT GetText([in]int nLine, [in]int nCol, [out, retval]BSTR* pName);
HRESULT HasHeader([out, retval]BOOL* pfHasHeader);
HRESULT GetHeader([in]int nCol, [out, retval]BSTR* pName);
};
Ìnterface IWinCCProtProviderPicture : IDispatch
{
HRESULT Draw( [in]long hdc, [in]int lef, [in]int top,
[in]int right, [in]int bottom);
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};
The object must support the interface IWinCCProtProvider and one of the interfaces
IWinCCProtProviderText, IWinCCProtProviderTable and IWinCCProtProviderPicture.
CR+ is used as line feed characters at the IWinCCProtProviderText interface.
LF (CR = "Carriage return" and LF = "line feed").

Interface IWinCCProtProvider
Register

Is called after starting the COM Server to pass a pointer to
IWinCCProtReportParams to the server.
Unregister
Is called to instrct the COM Server to rerelease the pointer to the
interface IWinCCProtReportParams.
GetName
Returns the name of the COM Server to display it on the
configuration interface.
ShowPrivateDialog
Open the COM Server selection dialog box.
SetPrivateData
Passes on the SelCrit data saved in the layout to the COM Server.
GetPrivateData
Reads the SelCrit data from the COM Server to save it in the layout.
GetNameOfPrivateData Returns the name of the selection criterion to display it on the
configuration interface.

Interface IWinCCProtProviderTable
GetNumCols
GetNumLines
HasHeader
GetHeader
GetText

Returns the number of columns to be printed in the report.
Returns the number of rows which should be printed in the report.
Returns the information as to whether a table header should be printed in the
report.
Returns the table header text to be printed in the report.
Returns the text to be printed in the report.

Special aspects of the data:
The control characters for colors, alignment, etc. always precede the output text and can be
combined with each other (e.g. "<B><U>output text"). They are not case-sensitive.
<END>

Concludes the interpretation of control sequences. The rest of the
text is accepted as specified.
<COLOR=#rrggbb>
Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb> Background color in hexadecimal notation (default = as set for the
table)
<B>
Bold
<U>
Underlined
<I>
Italic
<STRIKE>
Strike-through
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<ALIGN=left>
<ALIGN=center>
<ALIGN=right>

Left aligned
Centered
Right aligned

Interface IWinCCProtProviderText
GetText

Returns the text to be printed in the report

Interface IWinCCProtProviderPicture
Draw

Hands over a handle to the device connect to the COM Server and coordinated in
which you can draw.

Draw the output field here in the specified device context. It is an enhanced metafile. Drawing
is done in MM_HIMETRIC mode.

Interface to Read Parameters from the Report Context
The report system provides an interface to read parameters from the report context (settings
from the report system and the job properties).
Interface IWinCCProtReportParams : IDispatch
{
HRESULT GetParameter ( [in]BSTR PropertyName, [out]VARIANT* Value );
};
Currently the following properties can be read:
TimeFrom
TimeTo
PrivateSelCrit

ProjectName
LCID_APP

LCID_RT

Parameter from the print job
Parameter from the print job
Is used e.g. when the "Print" button in WinCC Control is pressed. Using this
PrivateSelCrit, the current selections of the WinCC Control are sent to the
COM server.
WinCC project name
Currently set language in the application which the COM server calls (PrintIt/
ProtCS). The WinCC system language might be different because the
Runtime language is not actively supported by WinCC.
Current Runtime language of WinCC. This setting is only visible in Runtime.

Registry Entries
The entries in the Registry are made automatically depending on the COM object or must be
made in the Registry by calling a Registry file. The Registry file must be supplied by the COM
object. Without these Registry entries, a COM object is not available to the report system, even
if the COM object is registered. The COM objects are registered by the user.
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Example of Registry entries of COM server:
HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\WinCC\Report Designer
\ReportClientDLLs\{4BF175C2-8BFF-11D0-840D-0080AD1374C8}] (GUI-ID of the COM
object as a unique key)
"DllClientGUID"="{4BF175C2-8BFF-11D0-840D-0080AD1374C8}" (GUID of the COM object)
"DllFileName"="CCPComProvider.dll"
"NeedsRuntime"="NO"
"RunsOnServer"="YES"
"RunsOnClient"="YES"
"RunsOnMultiClient"="YES"
"UseReportDesignerObjTab"="COM-Server"

Behavior of the Application Objects
The calls in the COM Server are timed.
Debugging support:
So that debugging COM servers is not unnecessarily made more difficult by the timeout
behavior, the timeout period can be set. If the Registry Key is not defined, the default value
(10000 milliseconds) is used.
HKEY_CURRENT_USER\Software\SIEMENS\WINCC\ReportSystem\TimeOuts\
InvokeTimeOut (vom Typ DWORD) --> TimeOut period in milliseconds
If timeout period 0xffffffff (-1) is entered as value, the report system waits infinitely for the
function.

See also
How to Output Data from a COM Server in a Report (Page 2103)
Example of an integration of a COM server (Page 2104)
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Setting Up Multilingual Projects

Content
WinCC offers the following possibilities:
● Different languages can be set for the project interface.
● Create projects that run in multiple languages in Runtime.
WinCC provides the following tools for creating multilingual projects:
● Text Library editor:
– Managing and maintaining almost all texts of your project
– Exporting and importing texts of the project
● Text Distributor
The Text Distributor provides all editors with user-friendly export and import options for
translating the configured text records.
● WinCC Configuration Studio
Direct input of the translated texts in the Alarm Logging, User Administrator and User
Archive editors in the properties with translatable texts
This chapter shows you:
● How to export texts for translating and import them again with the Text Distributor.
● How to manage texts centrally with the "Text Library" editor, export texts for translating and
import them again.
● How to configure multilingual pictures in the "Graphics Designer" editor.
● How to configure multilingual messages in "Alarm Logging" editor.
● How to configure reports for multilingual projects.
● How to configure multilingual date and time displays.
● How to configure changes of language in Runtime.
Note
Observing migration instructions
Observe the "Migration" instructions for old projects, process pictures and scripts.
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Language support in WinCC

13.2.1

Language support in WinCC

Multilingual Configuration in WinCC
WinCC enables you to configure your projects in multiple languages. For this purpose WinCC
supports the multilingual configuration of almost all objects containing text that is visible in
Runtime.
In addition to direct text entry, WinCC provides you with user-friendly export and import options
for translating your configuration with the Text Library and the Text Distributor. This is
especially advantageous if you are configuring large projects with a high text content.

Supported Languages
In principle WinCC allows you to create projects for every language installed on your operating
system. During installation WinCC also offers you a set of languages that you can use to set
up your WinCC configuration interface.
● German
● English (US)
● Spanish (Traditional)
● Italian
● French
● Japanese
● Chinese (Simplified, PR China)
● Chinese (Traditional, Taiwan)
● Korean
You can set up the WinCC Configuration interface in the installed languages. In addition, once
a language has been installed all standard texts are available in that language.
If a project should be used on another computer, then WinCC must be installed on the target
computer in the same language as on the source computer. You should always install WinCC
with all available languages.
Note
Asian languages
You need a dongle to work with Asian languages.
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Standard texts
Standard texts are all texts that already exist in the languages installed in WinCC, e.g. default
names of message classes in the "Alarm Logging" editor, WinCC system messages, and the
title bar captions and column titles in WinCC Control.

Configuration Scenarios
When configuring in other languages the following scenarios can occur:
● You are configuring a project for a language with which you are unfamiliar.
Example:
You are an English speaking project engineer and configuring for an Asiatic market: Display
the project user interface of WinCC in your preferred language.
There are two procedures for configuration:
– Configure the project in a language with which you are familiar, export the texts, translate
the texts externally and import the translated texts back into the WinCC project.
– You enter all text for your project directly in the language that is intended to be displayed
later in Runtime. Direct text entry is recommended only in cases where you have
configured just a small amount of text in your project.
● You are configuring a project for a number of languages with which you are unfamiliar.
Example:
You are a French speaking project engineer and configuring a project for a system which
must be operated by Russian, English and German speaking users: Display the project
user interface of WinCC in your preferred language. Configure the project in a language
you are familiar with and export all the text. Distribute the export files to translators for the
respective language. Following translation, import the translated texts back into your
WinCC project. Configure a change of language facility for the operators as well, so that
they can use it in Runtime to select the desired language for the operator interface.

13.2.2

Language expressions in WinCC

Principle of Language Expressions in WinCC
When using WinCC to create multilingual projects, you can set up languages at multiple system
levels. It is therefore helpful to distinguish between these various levels by using clearly defined
language expressions.
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Operating System Language
The operating system language (system locale) is the language environment set in the
operating system in which applications such as WinCC run. This setting defines, for example,
the used "Code Page" in character sets.
Note
WinCC-GUI language and operating system language
Set the operating system language corresponding to your WinCC user interface so that the
correct code page is used and all character sets are correctly displayed. Alternatively you
can use an operating system in the corresponding language.
Information about the operating system language and code pages can be found in your
Windows documentation.
Note
WinCC as of V7.2 under Windows 7 and as of V7.3 also under Windows 8
Set the language in the operating system of your computer whose code page is used for nonUnicode program parts. For more information, please consult your operating system
documentation.

Operating system user interface language
The operating system user interface language is the language in which the GUI of operating
system is displayed. All Windows menus, dialogs and help text are displayed in this language.
During configuration, some system dialog boxes are displayed in WinCC Configuration in the
operating system user interface language, for example, standard dialogs such as "Open file"
and "Save as".
The operating system user interface language can only be switched with multilingual operating
systems.

WinCC GUI Language
The WinCC GUI language is the language of the project interface in WinCC Configuration, i.e.
the language in which the WinCC menus, dialog boxes and help are displayed during
configuration. You can set any language as the WinCC GUI language installed during setup.
The maximum installation includes: German, English, Italian, Spanish, French, Japanese,
Korea, Chinese (Simplified), and Chinese (Traditional).
You need a dongle to work with Asian languages.
The language that you selected for the installation of WinCC is set as the WinCC GUI language
when you first start WinCC. The next time you start WinCC the interface is displayed in the
WinCC GUI language that you set up last.
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Set dialog language for the WinCC user interface centrally in WinCC Explorer, "Extras" menu.
Select a language you are familiar with as the WinCC GUI language for configuration.
Note
User interface language of WinCC and of the operating system
If the current WinCC GUI language is not the same as the operating system user interface
language, the standard dialog elements of certain WinCC editors remain unchanged and
continue to be displayed in the operating system user interface language. This applies to
standard buttons, such as "Cancel", and standard system dialogs, such as "Save as", "Open
file" or "Print".
In order to display these elements in the desired language, you need to set the operating
system user interface to the same language as you are using for the WinCC GUI language.

Project language
The project language is the language to be used for the project you are creating. You can
create a project containing multiple project languages in order to make several languages
available in runtime.
Note
Operating system languages as configuration languages
In addition to the languages installed with WinCC you can select any other language
supported by your operating system as the project language.
Of the operating system languages, WinCC <V7.2 only supports the respective primary
languages, e.g. English (USA) but not English (GB), Chinese Traditional (Taiwan) but not
Chinese Simplified (PR China).
In each case set up the project language directly in the editor you are using for configuration,
for example, in the "Alarm Logging" editor or the "Graphics Designer" editor. After switching
the configuration language, the user interface remains the same in WinCC Configuration. Only
the language of the texts which you create for your project is switched. The current project
language is displayed in the status bar of the respective editor.

Runtime language
The Runtime language is the language in which the project is displayed in Runtime. You may
set a Runtime language in WinCC in which the project will start in Runtime. The language must
be set up in the text library.
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When creating a project containing multiple languages, configure operating elements which
will allow the operator to change the Runtime language.
Note
Runtime language
Always select one of your configuration languages, or the Runtime standard language, as
the Runtime language.

Runtime Default Language
In the computer properties in WinCC Explorer, a Runtime default language may be set which
applies to graphics objects.
If, for a specific text, there is no translation available into the current Runtime language, the
text is shown in the configured Runtime default language. If the text is not available in this
language "???" is displayed.

Default Runtime Language for Objects
The default Runtime language is English. The default Runtime language is the language used
for texts of a WinCC object, such as AlarmControl or TableControl, if no translation of the
respective Runtime language is available. In the main this affects the title bar captions and
column titles in WinCC Control if the Runtime language is not one of the languages installed
with WinCC. In the languages installed with WinCC the controls are displayed correctly. This
does not apply to texts and their translations stored in the Text Library.

13.2.3

Configuring Multiple Languages

Operating system requirements
When configuring projects for multiple languages, your operating system must meet the
following requirements:
● The project languages must be installed.
● The correct system regional setting (operating system language) must be specified as
default in the operating system of your computer.
This is particularly important if you are configuring for languages which are not Western
European, e.g. Asian.
WinCC as of V7.2 supports Unicode. This means that a project may contain several
languages of different regional schemes. Set the code page or code pages in the operating
system of your computer that are used for programs that do not support Unicode.
● Any special fonts that you use must be available on your operating system. This applies
particularly to non-Latin fonts used for example in Cyrillic or Asian languages.
● You must install input methods on your operating system to input e.g. Asian fonts.
For each running application, select the input methods independently of one another.

2114

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting Up Multilingual Projects
13.2 Language support in WinCC

Note
How to make the corresponding settings or installation in your operating system is described
in your Windows documentation.

Language combinations
Due to the various language setting options in WinCC and your operating system, a number
of different language combinations can occur, for example:
● Configure a single-language project in the language preferred:
Operating system language, operating system user interface language, WinCC user
interface language and configuration language are all the same.
● Configure a single-language project in but not in your preferred language:
Operating system user interface language and WinCC GUI language are your preferred
language. The project language is the language in which you subsequently display the
project in Runtime.
If you configure for Asian languages, define the operating system language so that the
character set to be used is displayed in the respective code page.
If all languages are from one regional area (e.g. Western European), this setting is not
necessary because it was already made implicitly.
Make sure that you use a font that contains all necessary characters for your project.
● You are configuring a multilingual project. One of the languages is your preferred language:
Operating system user interface language and WinCC GUI language are your preferred
language. The project languages are the languages in which you subsequently display the
project in Runtime. Configure the project in your preferred language and hand over the text
for translation when the project is complete.
● Several project engineers who prefer different languages and configure on one computer:
A neutral language, e.g. English, is selected as the operating system user interface
language. Each configuration engineer can set the WinCC GUI language to his preferred
language. The languages that will subsequently be displayed in Runtime are set as the
project languages.
If you configure for Asian languages, define the operating system language so that the
character set to be used is displayed in the respective code page.
If all languages are from one regional area (e.g. Western European), this setting is not
necessary because it was already made implicitly.
Make sure that you use a font that contains all necessary characters for your project.
Note
If you are using a multilingual operating system, the configuration engineer can also set
the operating system user interface language to his preferred language.
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Configuring for multiple languages - main editors
When configuring for multiple languages use the following editors:
● Text Distributor:
The text distributor is a comfortable tool for exporting language-dependent text of the
WinCC project. The exported data is translated in an external program. You then import
the texts again following translation.
● Text Library:
All project texts are managed centrally in the "Text Library" editor except for texts from
"Graphics Designer" editor. You export centrally the texts of one or all languages for the
translation. As an alternative, you can translate the text directly in the "Text Library" editor
or the respective editor.
● Graphics Designer:
Configure the pictures for the project in the "Graphics Designer" editor. Pictures can contain
different text elements, such as Static Text, Tooltips or Labels for ActiveX Controls. The
test is saved in the respective picture. You export the text with the text distributor for the
translation or you enter the translated text directly.
● Alarm Logging:
The "Alarm Logging" editor is used to configure messages that are issued in Runtime. The
texts for the message system are managed centrally in the Text Library.
To translate the text, you have the following possibilities:
– Export the text for translation from Alarm Logging
– Translation in the "Text Library" editor
– Translation in the "Alarm Logging" editor
If there is a large number of message text records, it is to your advantage to export them.
Configuring with SIMATIC STEP 7: Alarm logging texts from the SIMATIC Manager are
stored in the Text Library when transferred and must be translated there.
● Report Designer:
The following is configured in the "Report Designer" editor:
– Language-dependent layouts for reports to be output in Runtime
– Language-dependent layouts for the project documentation of your project
● User Administrator:
The authorizations that you configure in the User Administrator are language-dependent.
These text records are managed centrally in the "Text Library" editor.
You export the text records from the User Administrator or you translate them in the "Text
Library" editor.
The User Administrator supports the languages which can be defined for the user interface.
In order that the texts are created in the project Text Library, you must open the User
Administrator in the respective language.
● User Archive:
All the texts in the user archives are managed centrally in the "Text Library" editor. You
export the text records from the user archive or you translate them in the "Text Library"
editor.
● Picture Tree Manager (optional):
The container names are administered centrally in the Text Library. You export the text
records or you translate them in the "Text Library" editor.
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Note
The project language can be set up separately for the "Graphics Designer" editor and the
"Alarm Logging" editor. By default the editors start with the set Runtime language as the
project language.
WinCC elements such as archive names, tag names and script functions are unique and
cannot be configured for multiple languages.
Do not use any national special characters or Asian fonts in language-dependent WinCC
elements. These characters are illegible or prevent WinCC from working properly after
switching languages.
Exception:
In tag names you may also use non-ASCII characters, e.g. Asian characters.
WinCC as of V. 7.2 supports Unicode. Projects may contain several languages with different
code pages. Exceptions are ActiveX components, channels, and the C compiler. For this
reason, C-scripts and VB scripts can only contain text in a single language.

Non-translated texts
Non-translated texts are displayed differently in Runtime. For more information, refer to
"Language expressions in WinCC (Page 2111)".

13.2.4

How to Create a Multilingual Project

Introduction
The following section gives you an overview of the steps you need to take in order to configure
multilingual projects. The optimal procedure is described in this chapter. Alternative procedures
are described in the respective segments of this help.

Basic procedure
1. Install all required fonts and input methods on your operating system.
If you are configuring in non-Latin fonts, the relevant fonts must be available as Small Fonts.
2. Activate the languages to be configured in your operating system.
Your Windows documentation will tell you exactly how to do this.
3. Use the operating system of your computer to set the language that is used for programs
and program parts that do not support Unicode.
4. Install WinCC with all languages that are available as dialog language for the WinCC user
interface.
If you install languages at a later point in time, the standard text for these languages is not
automatically put into the Text Library.
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5. When you create a new project, the WinCC GUI language is the language you selected for
the installation of WinCC. When launched again, WinCC opens in the WinCC GUI language
last set.
If you use a language that is not provided with WinCC as the configuration language:
– Make sure that the standard text records of these languages do not exist as translations
in WinCC. In this case, the standard text records are entered in the current WinCC GUI
language in the Text Library. You can translate these texts later or directly enter the
language in the "Text Library" editor before changing to the project language.
6. Specify whether to export text files in Unicode in the "Project properties" > "Options" dialog.
7. Configure your project in a language with which you are familiar. This project language later
serves as a basis for translation of the texts.
8. Export the text records with the Text Library.
If you have created picture objects with multilingual texts in the Graphics Designer, export
the texts with the Text Distributor. You then have several files to translate.
9. Translate the texts in an external editor.
10.Re-import the translated texts.
11.Test your translated project in runtime.
Note
Creating the WinCC languages when copying a project
If you copy your project to another computer, all WinCC languages must be installed in the
project's Text Library of the target computer. You may have to install the missing languages
in the project's "Text Library" editor and may have to configure the language entries for these
languages.

13.2.5

How to Switch the Language of the Operating System

Introduction
Windows makes all languages and fonts available. You install languages when you install
Windows. If you activate a language that is not actually installed, you are prompted to install
it from the Windows CD. Activate the necessary languages and fonts in your operating system
as follows.
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Activating languages in the operating system
Windows 7 / Windows Server 2008
● In "Start > Control Panel > Clock, Language and Region Settings > Region and Language
Options", press the "Change keyboards" button in the "Keyboard and Languages" tab.
In the "Text Services and Input Languages" dialog that appears, add the required input
language and keyboard layout in the "General" tab.
In the "Advanced key settings" tab, you can also define a keyboard shortcut for changing
the input language. For example if you are creating an Asian-language project in an English
operating system, you can use a keyboard shortcut to change the input language if you are
switching to another Windows application.
Windows 8 / Windows Server 2012
Change the language setting in the "Control Panel > Clock, Language, and Region >
Language". Add the required keyboard layout in the "Options". You can define key
combinations that are easy to remember in the "Default Settings" to change the input language.
In the "Control Panel > Clock, Language, and Region > Region", you set the language for nonUnicode programs in the "Administrative" tab.
Note
If you work with the "Chinese (simplified)" operating system, for example, and you want to
set English language support in the WinCC Explorer, you need to set "English" for menus
and dialogs:
● In Windows 7, "Start > Control Panel > Region and Language" > "Keyboard and
languages" tab, "Display language".
This field is only available if several language packs are installed on your computer.
● In Windows 8, in the "Control Panel > Clock, Language, and Region > Language" in
"Options".
This will correctly display the fonts in the dialogs and menus.
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13.2.6

How to Change Languages in WinCC

Requirements
When setting up languages in WinCC, observe the following requirements:
● If you are configuring with non-Latin fonts, the necessary fonts and input methods must be
installed in your operating system.
● All configuration languages you wish to use must be installed in your operating system.
● If you are configuring Asian languages, the proper system locale (operating system
language) must be set to change the WinCC GUI language in the operating system Control
Panel so that the used character sets are displayed with the matching code page.
If all languages originate from one language region (e.g. Western European), this setting
is not necessary because this was already done implicitly.
WinCC as of V. 7.2 supports Unicode. For this reason, you only need to make these settings
for programs that do not support Unicode.
Note
For information on how to enter the appropriate settings and installation in your operating
system, please refer to your Windows documentation.

Recommendations
In order to configure efficiently, please note the following:
● Always configure for one language at a time if possible.
● Set the Runtime language to be the language to be configured. The editors always start
with the set Runtime language as the configuration language.

Changing the WinCC GUI Language
To change the WinCC GUI language, the language must have been installed with WinCC.
Select "Tools > Language" in WinCC Explorer to change the WinCC user interface language.
In the selection window, you will be offered all installed WinCC languages with the exception
of the current WinCC GUI language.
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Following the change, the operating elements, menus and dialogs in WinCC Configuration are
changed to the selected language.
Note
Operating system user interface language
If the current WinCC GUI language is not the same as the operating system user interface
language, the standard dialog elements of certain WinCC editors remain unchanged and
continue to be displayed in the operating system language. This applies to standard buttons
such as "Cancel", and standard system dialogs such as "Save as", "Open file" or "Print".
In order to display these elements in the desired language, you need to set the operating
system language to the same language as you are using for the WinCC GUI language.
Note
Asian languages
If you are configuring for Asian languages and the current WinCC user interface language
does not correspond to the operating system language, a large part of the Asian user interface
will not be displayed correctly in WinCC < V7.2.

Changing the configuration language in the editors
You can set the configuration language separately for the "Graphics Designer" editor and the
"Alarm Logging" editor.
To change the configuration language, open the editor concerned and select the menu
command "View > Language" or "View > Input language". A selection window offers you all
languages available on your system.
Following the change, all configured texts are displayed in the selected configuration language.
If you have not configured the language yet, all texts in the "Graphics Designer" editor will be
displayed as "???", and the "Alarm Logging" editor will not display any texts.
The set configuration language is displayed in the status bar of the Graphics Designer editor.

Setting Runtime language and Runtime standard language
Set the Runtime language and Runtime standard language in WinCC during centralized
configuration in the starting configuration of the Runtime computer. For more information, refer
to "How to Set the Runtime Computer Starting Configuration (Page 2190)".

13.2.7

Fonts in Multilingual Projects

Introduction
In WinCC you can set a custom font for each configured language. The fonts that you wish to
use must be installed in your operating system. You need special fonts if you use project
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languages containing non-Latin characters, such as Cyrillic, Greek or Asian character sets.
For further information please refer to "Configuring with Non-Latin Fonts".

Setting fonts in WinCC
WinCC as of V7.2 supports Unicode. You may now set a font that contains all necessary
characters for all or several languages. In WinCC you set fonts in the following places:
● In the "Graphics Designer" editor: You can set the font for all objects containing a text
display in the properties dialog of the respective object, or in the configuration dialog for
certain objects.
Non-Latin text is not correctly displayed in certain input windows, regardless of whether or
not the font was properly set. The display is correct in runtime. In such an event you may
enter the text in another editor (e.g. Word) and transfer it to the input field using copy &
paste.
Objects containing nonadjustable font:
● Tooltips: In order to display tooltips in runtime in a non-Latin font, go to the Control Panel
of your operating system and set the font for tooltips in Display Properties. Note that when
you make this change, the fonts for the tooltips of all the other applications on your Windows
system are also changed.
● Window and column headings of ActiveX Controls: If the current Runtime language is not
a WinCC language, text is always displayed in the default Runtime language (English).
● In some text input windows of the "Graphics Designer" editor, you cannot set the font. In
this event select an input dialog in which the font can be set.
Note
If your configuration permits it, set the same language for operating system language,
operating system user interface language, WinCC GUI language and project language.

13.2.8

Prohibited Characters in WinCC

General procedure
Depending on the language and the component, only certain characters are permitted in
WinCC.
A complete overview of all the prohibited characters can be found in the WinCC documentation
under "Prohibited characters".
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13.2.9

Configuring with Non-Latin Fonts

Non-Latin Fonts
When configuring your project in languages that use non-Latin fonts, such as Asian or Cyrillic
character sets, you need the corresponding fonts on your operating system and in WinCC.
In your operating system activate the corresponding languages and keyboard layouts as
described under "Switching Operating System Languages".
To display the Asian characters in Runtime, you absolutely require the Asian version of WinCC.
With the Asian version, in addition to the texts configured by you, WinCC standard texts such
as e.g. the Runtime dialog boxes, system messages are also available in Asian languages.

Using non-Latin fonts
For the majority of non-Latin fonts you can use the Input Method Editor (IME) in Windows. For
further information on using the IME please refer to your Windows documentation.

Special Characteristics of Non-Latin Fonts in WinCC
When entering text in graphic objects there are some input windows in which non-Latin text is
incorrectly displayed even though the font was correctly set. The characters are displayed
correctly in Runtime. You can get round this by entering the text in another editor and then
using Copy & Paste to add it to the input field.
Note
Depending on the operating system and language settings, carry out copy & paste actions
may not be executed properly. To solve this problem, set the same input methods in the
source and target application.
With certain objects in WinCC the font either cannot be set or can only be set in special
circumstances. For further information on objects that cannot be changed see "Fonts in
Multilingual Projects".
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Notes regarding Configuration with Non-Latin Fonts
● Always configure a language in a uniform font.
– For Alarm Logging editor texts, set the input language in the Alarm Logging editor.
– In the "Graphics Designer" editor you configure the font directly in all the objects that
contain text.
● The title and column headings for the following objects are only available in the languages
installed with WinCC and the languages cannot be switched between:
– A few WinCC controls
– Trend control axes labels
If the current Runtime language is not a language installed with WinCC, labels are always
displayed in the default Runtime language English.
● If you create records in non-Latin fonts:
Basically, language-specific layouts are used. Possible languages for the layouts are those
installed with WinCC.
If a printout is started, the layout of the current Runtime language is used. If the current
Runtime language is not a language installed with WinCC, the English layout is used.
If you want to generate a printout with a non-Latin font, define the respective font in the
English layout. Select the whole layout and then set the font.
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13.3

Text export and text import with the Text Distributor

13.3.1

Text export and text import in the Text Distributor

Introduction
WinCC allows the configuration of projects for many languages. The texts are displayed in
runtime based on the configured language.

Overview
The project texts created by WinCC are centrally managed in the text library, except for most
text from the "Graphics Designer" editor. Referenced texts in the "Text list" and "WinCC
AlarmControl" objects are also managed in the text library.
The Text Distributor is a comfortable tool for exporting and importing all language-dependent
text. Here you can export and import targeted languages, individual objects or groups of
objects. The exported data is processed with an external program.

Starting the Text Distributor
You have the following options for starting Text Distributor:
● Double-clicking in WinCC Explorer
● Selecting the menu command "Tools > Text Import & Export..." in the "Graphics Designer"
editor
Note
Special characters changed by saving in Excel
Be aware of the following when you export texts to TXT files using the "Text Distributor" editor,
edit the texts in Excel, save and reimport them:
● Texts in quotation marks are enclosed in additional quotation marks (" "). You cannot
change this characteristic of Microsoft Excel.
● Texts with "+" or "-" prefix are interpreted as numerical values. An error is written in the
cell.
● Texts with "=" prefix are interpreted as cell references. The error or the text contained in
the cell will be written to the cell.
To affect the way in which Microsoft Excel handles special characters, format the column or
cells as "Text".
Use the "File Conversion Wizard" when opening a TXT file for this purpose.
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13.3.2

How to export language-dependent texts

Introduction
Use the Text Distributor to export language-dependent texts to CSV files or TXT files. The Text
Distributor creates several files that all begin with the same name.
Note
No import of texts with WinCC V6 format to WinCC as of version V7.2
WinCC V7.2 supports Unicode:
● You cannot import texts in WinCC V6 format to WinCC as of version V7.2.
● Texts that you export from WinCC as of version V7.2 cannot be imported with an older
version.

Text file export settings
Check the export settings for text files. For this purpose, select the project in WinCCExplorer
and then select "Project properties" > "Options" from the shortcut menu. "Export Text files as
Unicode" is set automatically by default.

Example
Enter the name "Mixing_station" in the "File prefix" field. Select the "*.txt" format in the "File
format" field. The following files will be created among others:
● Mixing_station_Languages.txt
● Mixing_station_AlarmLogging.txt
● ...
NOTICE
Invalid file format
If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.
If you want to edit the exported data with Excel, select the "*.txt" file format during export.

Languages available for export and import
The Text Distributor offers all languages that are listed in the Text Library. You can export and
import languages that originate from different regions.
For example, if you want to export Asian text from WinCC < V7.2, the corresponding system
locale (operating system language) must be set in your operating system. Only then will the
associated languages be available.
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"English" is always available.
Note
WinCC V6 format
If you want to obtain an export file compatible to WinCC V6 when exporting, select the "Export"
command in the "Tools > TextLibrary V6.x format".
Unknown objects
If a picture contains "unknown objects", the export or import of the picture is aborted
immediately and "Unknown" appears in the information window.

Procedure
1. Open the Text Distributor by double-clicking in the WinCC Explorer or select the menu
command "Tools > Text Import & Export..." in Graphics Designer.
2. Select or clear the editors from which you want to export text. If necessary, check or uncheck
the individual objects of the editors.

3. In the "Export files" area, select the path where the export files are to be saved.
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4. Enter a meaningful name in the "File prefix" field.
All export files are created with a name that begins with this description.
5. Select the desired format,"*.txt" or "*.csv", in the "File format" field.
6. Specify the settings for the text export in the "Graphics Designer" editor.
–

Activate the "Select pictures" option if you only want to export the text from selected
pictures. Select the desired pictures using the "Selection" button.

–

Activate "One file per picture" to create a separate export file for each picture.

–

Activate the "Update referenced texts" option after having edited or configured the "Text
list" and "AlarmControl" in Graphics Designer. This updates the texts linked to the Text
Library prior to the export.

7. If you want to export individual languages, select the languages in the "Languages" section
using the "Selection" button.
8. Specify how to handle existing texts in the "Existing texts" section.
–

Activate the "Delete existing texts" option to delete existing export files.

–

Activate the "Replace existing texts" option to replace existing export files.

–

Activate the "Keep existing texts" option to prevent overwriting of existing export files.

9. Start the text export by clicking the "Export" button.

Result
The export files are created and saved in the select path.

13.3.3

Structure of the Export Files

13.3.3.1

Export File Overview

Overview
Use the Text Distributor to export language-dependent texts to CSV files or TXT files. During
export, the Text Distributor creates several files that all begin with the same description.
Example:
You enter description "Mixing_station" in the "File prefix" field. In the "File format:" field select
"*.txt". The following files are created:
● Mixing_station_Languages.txt
● Mixing_station_AlarmLogging.txt
● ...
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Export Files
A different number of files are created depending on which objects you select during export.
The following types of files exist:
● Files for text from the "Text Library" editor
● Files for text from the "Graphics Designer" editor
● File for references texts of the "Graphics Designer" editor
● File "<Description>_Languages.csv" or "<Description>_Languages.txt"
This file is always created.
This file specifies the following for the text:
– Language-specific font type
– Language-specific font size
– ...
If font type, font size, etc. are configured for the language-dependent text in the "Graphics
Designer", the settings in the "Graphics Designer" editor apply.

13.3.3.2

Construction of files with text from the Text Library

Overview
Use the Text Distributor to export language-dependent texts to CSV files or TXT files. During
export, the text from the Text Library is saved in the following files:
● <Description>_AlarmLogging.txt or <Description>_AlarmLogging.csv
● <Description>_DataManager.txt or <Description>_DataManager.csv
● <Description>_LifeBeatMonitoring.txt or <Description>_LifeBeatMonitoring.csv
● <Description>_PictureTreeManager.txt or <Description>_PictureTreeManager.csv
● <Description>_NoSystemtext.txt or Description>_NoSystemtext.csv
● <Name>_UserAdministrator.txt or Name>_UserAdministrator.csv
● <Description>_GraphicsDesignerReferences.txt or
<Description>_GraphicsDesignerReferences.csv
The associated files are created depending on which editors you select during export.
Note
Information on the font type, font size, etc. of a language is entered in the
"<Description>_Languages.csv" or "<Description>_Languages.txt" file. Change the entries if
necessary.
You can also generate the "<Description>_NoSystemtext.txt", or
"<Description>_NoSystemtext.csv" file. This file can contain the following:
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● Text that was not found in the configuration.
This can happen for the following reasons:
– The text is no longer used in the configuration.
– The text is used e.g. in the Global Script.

Structure of the Files
A separate block is created for each object type. Each block has the following structure:
● [Header]
The object type is entered here: e.g.: <MessageClassName> and a header line consisting
of [ID] and the respective languages, e.g. English, German.
● Exported texts
The text ID from the Text Library is entered in the following rows in the first column. The
following columns contain the text in the respective language.
Example: File "Example_AlarmLogging.txt" with object blocks <MessageClassStateCome>,
<MessageTypeName> and <MessageBlocks>
<MessageClassStateCome>
ID

English

German

Spanish

2

+

+

+

ID

English

German

Spanish

8

Alarm

Alarm

Alarma

<MessageTypeName>

9

Warning

Warnung

Advertencia

10

Failure

Fehler

Error

11

Process control
system

Leittechnik

Sistema de control de
procesos

12

System messages

Systemmeldungen

Avisos de sistema

13

Operator input
messages

Bedienmeldungen

Avisos de operador

<MessageBlocks>

13.3.3.3

ID

English

German

Spanish

14

Date

Datum

Fecha

Construction of files with text records from the "Graphics Designer" editor

Overview
When exporting, the text records of the "Graphics Designer" editor are stored in file
"<Description>_GraphicsDesigner". If you have activated "One file per picture" for the export
procedure, another file is created for every picture.
Per picture, the file contains a header, an object description and the objects.
Example:
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● [Header]
The picture name is entered here, e.g.: <PIC_1.PDL>
● [Object]
Object description: Indicates what is contained in the respective columns.
– Column "Object"
Object name of the object that contains language-dependent text.
– Column "Property"
Language-dependent property of the object.
– The language column, e. g. "English".
– Format information and text for every existing language in the columns:
"FontName", "FontSize", "FontBold", "FontItalic", "FontUnderline"
● [Objects]
The objects are defined with the existing text records and properties in the following lines.
If the text does not exist, "??????" is entered.
Example: Export file "Example_GraphicsDesigner" with pictures PIC_1.PDL and PIC_2.PDL
The German text records are not translated yet and are entered as "??????".
PIC_1.PDL
Object

Property

English

English
Font
Name

English
FontSiz
e

English
FontBold

English
FontItalic

English
Font
Underline

German

German
Font
Name

....

Static Text1 Text

Valve

Arial

12

False

False

False

??????

Arial

....

Static Text2 Text

Motor

Arial

12

False

False

False

??????

Arial

....

Text list

Assignm
ent

closed

Arial

12

False

False

False

??????

Arial

....

Property

English

English
Font
Name

English
FontSiz
e

English
FontBold

English
FontItalic

English
Font
Underline

German

German
Font
Name

....

Static Text1 Text

Engine

Arial

12

False

False

False

??????

Arial

....

.....

....

....

...

....

...

....

....

....

...

PIC_2.PDL
Object

.....

Line breaks
If language-dependent text contains line breaks, the placeholders {CR} {LF} are entered. Do
not change or delete the placeholders. The placeholders must be included in the translated
text at the identical positions.

Referenced texts of the "Graphics Designer" editor
The referenced texts from the text lists and AlarmControl are stored in the text library. The
texts are exported to the following files:
● "<Description>_GraphicsDesigner" or respective picture file
● "<Designation>_GraphicsDesignerReferences"

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2131

Setting Up Multilingual Projects
13.3 Text export and text import with the Text Distributor
If you import the file "<Name>_GraphicsDesignerReferences" again, make sure that the texts
of the text lists and AlarmControl are translated exactly as in the respective export file of the
"Graphics Designer" editor.
You can find mapping for the exported, referenced texts in the pictures and objects of the
Graphics Designer in the "GraphTextRefs.xml" file located in the in the "GraCS" project folder.

13.3.3.4

Structure of the "_Languages" Files

Overview
The "<Description>_Languages.csv" file is created. The file specified the default settings for
font type, font size, etc. for each language.
Note
If font type, font size, etc. are configured for the language-dependent text in the "Graphics
Designer", the settings in the "Graphics Designer" editor are applied.
The "*_Languages.csv" is structured as follows:
● [Header]
The header has two lines.
The file type is entered in the first line: <Languages>.
The headers are entered in the second line. This line indicates which information is entered
in the following columns:
– LanguageName: Name of the language
– LanguageID: Language code
– FontName: Name of the font type used
– FontSize: Size of the font type
– FontBold: "Bold" font type
– FontItalic: "Italics" font type
– FontUnderlined: Underline
● Information for each language
The following lines contain the corresponding entries for each language created.
Example:
<Languages>

2132

LanguageName

LanguageID

FontName

FontSize

FontBold FontItalic FontUnderlined

English

1033

Arial

9.75

False

False

False

German

1031

Arial

9.75

False

False

False

French

1036

Arial

9.75

True

False

False

Italian

1040

Arial

9.75

False

False

False

Spanish

1034

Arial

9.75

False

False

False
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13.3.3.5

Status bar for the export and import
After the export or import, a dialog appears in which all export or import procedures are
handled.
The "Info" dialog lists messages in the following categories:
● "OK" (Successful export or import)
● "Warning"
● "Error" (An error has occurred during export or import.)
● "Info" (With export: Object contains no language-dependent text records, with import: No
text records have been imported for this object.)
You filter the output of the dialog by clicking on the respective buttons by the categories.
Example:

13.3.4

How to edit and translate exported text files

General procedure
The exported TXT or CSV files can be edited e.g. in Excel, Access or in a text editor like
Notepad. This chapter describes the process for editing in Excel.
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Start by checking the settings for text file export. For this purpose, select the project in WinCC
Explorer and then select "Project properties" > "Options" from the shortcut menu. "Export Text
files as Unicode" is set automatically by default.
NOTICE
Invalid file format
If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.
If you want to edit the exported data with Excel, select the "*.txt" file format during export.
Please note the following:
Only permitted changes can be made in the exported files and before import to WinCC.

Impermissible Changes
The following changes are not permitted:
● Structural changes to the export file.
● Swapping, deleting or duplicate use of IDs or object descriptions.
● Text changes in the header area. This text is generally identified by angled brackets: <>.
● Text changes in WinCC if text is in the translation. New text can be added in the editors. If
you change exported text, it is overwritten with the original text depending on the setting
during import.
Line breaks
If language-dependent text contains line breaks, the placeholders {CR} {LF} are entered. Do
not change or delete the placeholders. The placeholders must be included in the translated
text at the identical positions.
Note
Editing texts with non-Latin fonts
To edit texts containing non-Latin fonts, use a software package that can save Unicode. Excel
is not suitable for this purpose. Use Access instead or use the programming interface from
WinCC to access picture text. Alternatively, use a version of Excel in the respective language.
Note
Information on the fonts of a language
Information on the font type, font size, etc. of a language are available in the
"<Name>_Languages" file and in the export files of the "Graphics Designer" editor. Change
the entries if necessary.
If a language was not created in the Text Library before export, add the language entry for
this language in the "<Description>_Languages" file.
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NOTICE
Text Import Not Possible
Do not double-click in Windows Explorer to open the files. Otherwise the file will be loaded
to Excel incorrectly. It is then no longer possible to import the file to WinCC.
When using Excel, open the file as follows.

Procedure
1. Open Excel.
2. Select "File > Open". The "Open" dialog is displayed.
3. Select the path where the export files are saved.
4. Select type "Text files (*.txt)" from the "File type" list.
5. Select your export file and click "Open". The file is correctly opened in Excel.
6. Edit and translate the required texts. Note the aforementioned information.
7. To avoid changing the format of the file when saving with Excel, all of the required fields
must be marked off:
–

Mark all necessary rows and columns.

–

Select "Format cells" from the shortcut menu. Open the "Border" tab.

–

Click "Outer" and "Inner".

8. Save the file in "*.txt" format again using the "File" > "Save As" command.

Results
The TXT file contains the translated text. You can import the TXT file into the WinCC project
using the Text Distributor.

13.3.5

How to import language-dependent texts

Introduction
After you have translated the exported text, import the text to the WinCC project using the Text
Distributor.
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Example
During export, the text distributor creates several files that all begin with the same description.
Enter the name "Mixing_station" in the "File prefix" field and "*.txt" in the "File format" field. The
following files will be created among others:
● Mixing_station_Languages.txt
● Mixing_station_AlarmLogging.txt
● ...
If you specify this name again in the "File prefix" field during import, all available objects will
be listed in the left window. You can select from the existing languages and objects.

Languages available for export and import
The Text Distributor offers all languages that are listed in the Text Library. You can export and
import languages that originate from different regions.
For example, if you want to export Asian text from WinCC < V7.2, the corresponding system
locale (operating system language) must be set in your operating system. Only then will the
associated languages be available.
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"English" is always available.
Note
WinCC V6 format
If you want to import a Text Library export file created with the WinCC V6, select the "Import"
command in the "Tools > TextLibrary V6.x format". As was the case with WinCC V6, however,
the complete Text Library is deleted before the import.
Unknown objects
If a picture contains "unknown objects", the export or import of the picture is aborted
immediately and "Unknown" appears in the information window.

Procedure
1. Open the text distributor by double-clicking in WinCC Explorer. As an alternative, you can
select the "Tools > Text Import & Export..." menu command in the Graphics Designer.
2. Go to the "Import text" tab.
3. Navigate to the path where the imported files are saved using "Path" in the "Import files"
area.
4. Enable or disable the desired editors from which you want to import text.
5. In the "File prefix" field, enter the name with which the text was exported.
All export files were created with a name that starts with this string.
The objects that you can import are listed.
6. In the "File format" field, select the format of the text.
7. Specify the settings for the text import in the "Graphics Designer" editor.
- If you want to import texts from individual pictures only, select the "Select pictures" option.
Select the desired pictures using the "Selection" button.
- If you created one picture per file when exporting, select "One file per picture".
- If you have subsequently configured the "Text list" and "AlarmControl" objects in the
Graphics Designer, select the "Update referenced texts" option. The referenced texts
thereby maintain a consistent data inventory in the Text Library following the import. The
filter in the Text Library is up-to-date once again.
8. If you want to import individual languages, select the languages in the "Languages" section
using the "Selection" button.
9. Specify how to handle existing texts in the "Existing texts" section.
- If you want to replace existing text entries, select the "Replace existing texts" option.
- If you do not want to overwrite existing text entries, select the "Keep existing texts" option.
10.Start the import process by pressing "Import".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2137

Setting Up Multilingual Projects
13.3 Text export and text import with the Text Distributor

Note
Avoiding overwriting of modified texts
Texts that you export and then edit before their re-import, for example in the Text Library, will
be overwritten with the modified import text.
Remedy:
● Edit the text before you run the export.
● Wait for completion of the import, and then edit and export the text again for compilation.
● V7 exports are handled separately for each component. This may possibly cause texts
with the same ID to be stored in different files. Store the modified text with the same ID in
all import files. Make sure that you apply the changes in all respective languages.

Result
The content of the files is written to the corresponding language columns in the Text Library
or to the language-dependent objects in the Graphics Designer.
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13.4

The WinCC Configuration Studio

13.4.1

Introduction

Introduction
WinCC Configuration Studio provides a simple and efficient means of configuring bulk data
for WinCC projects. The user interface is divided into two areas: a navigation area similar to
Microsoft Outlook and a data area similar to Microsoft Excel. This setup lets you configure bulk
data for a WinCC project, while taking operational benefits that you already from spreadsheet
programs. The WinCC Configuration Studio replaces the previous procedure for the following
editors and functions:
● Tag management
● Tag Logging
● Alarm Logging
● Text Library
● User Administrator
● Horn
● User Archive
This chapter will provide you with an overview of the functionality and operation of
WinCC Configuration Studio.

13.4.2

System requirements

Introduction
System requirements for WinCC Configuration Studio are the same as for WinCC. Since
WinCC Configuration Studio is an integral component of the WinCC configuration system, you
cannot use WinCC Configuration Studio without WinCC.

Compatibility
WinCC Configuration Studio is compatible with all WinCC versions 7.2 and higher.
Note
WinCC Configuration Studio is an integral component of the WinCC configuration system.
Separate Installation is not possible.
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13.4.3

Interface

Introduction
The user interface consists of a navigation area and a data area with tables. More information
about the user interface is provided in the following chapters.

Introduction
The user interface consists of a navigation area with navigation bar, the data area with tables
and the "Properties" area.

①
②
③
④
⑤
⑥
⑦

Menu bar
Fast search in data area
Navigation area
Data area
"Properties" window
Navigation bar
Information bar with information on the status of the editor, selected input language, and number of data records in
the data area.

Menu bar
With the menu bar, you can activate the following functions:
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● "File > Exit": Exit Configuration Studio.
● "Edit > Copy": Copy selected data.
● "Edit > Paste": Paste previously copied data.
Additional information on copying and pasting data is available under Copying and pasting
in the data area (Page 73).
● "Edit > Import": Import data records
Additional information on importing data records is available under Importing data records
(Page 74).
● "Edit > Export": Export data records
Additional information on importing data records is available under Exporting data records
(Page 74).
● "View > Input language": Switch the input language. You are offered all languages available
on your system in a selection menu.
Additional information on configuring multilingual projects is available under Language
support in WinCC (Page 2110).
● "View > Color scheme": Change the color scheme of the Configuration Studio.
● "? > Contents and Index": Call the online help
● "? > Info about WinCC Configuration Studio": Information on version and system.
Fast search in data area
Use the "Search (Find)" field to look for entries in the data area. If one or more fields were
selected in the data area, the search is limited to the selected fields. For additional information
on fast search, refer to Fast search in data area (Page 67).
Navigation area
The objects of the selected editor or the selected function are displayed in the navigation area
as tree view. The structure of the tree view includes all elements that are displayed in the data
area.
For information on operating the navigation area, see How to operate the navigation area
(Page 55).
Data area
The data area consists of a table view that you will be familiar with from spreadsheet programs.
The data records of the selected editor or the selected function are configured in the data area.
For information on operating the data area, see How to operate the data area (Page 58).
"Properties" window
The data records of the selected editor or the selected function can be edited in the "Properties"
window. Details on operation of the "Properties" window are described in the corresponding
sections of the respective editors or functions.

See also
Fast search in data area (Page 67)
Importing data records (Page 74)
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Exporting data records (Page 74)
Copying and pasting in the data area (Page 73)
How to operate the navigation area (Page 55)
How to operate the data area (Page 58)
Language support in WinCC (Page 2110)

13.4.4

How to operate the navigation area

13.4.4.1

Operating the navigation area

Introduction
You access the navigation area of an editor or a function with the navigation bar.
The navigation area displays the tree view of the selected editor or the selected function. Select
an element from the tree view in the navigation area to display the corresponding data records
in the data area.

Navigation bar
You can access all available editors and functions by means of buttons in the navigation bar.

You access hidden buttons with a mouse click on the corresponding symbol in the bottom part
of the navigation bar.
Symbol

Editor/Function
Tag management
Alarm Logging
Tag Logging
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Symbol

Editor/Function
Text Library
User Administrator
Horn
User Archive

Showing or hiding buttons in the navigation bar
You use the drop-down menu in the bottom part of the navigation bar to show or hide buttons
in the navigation bar.
1. Click on the symbol for the drop-down menu.

The drop-down menu opens.
2. Select "Show additional buttons" to show buttons.
Or:
Select "Show fewer buttons" to hide buttons.

Opening an editor
Click the required editor in the navigation bar or select "Open" from the shortcut menu.

Opening individual editors
To open a required editor in a new window, open the shortcut menu of the editor in the
navigation bar.
1. Right-click on the required editor in the navigation bar.
2. Select "Open in new window" in the shortcut menu.
The editor opens in a new window.

Releasing the editor
You must release the editor after finishing your work so that other users can work with the
editor in a project.
1. Right-click on the editor in the navigation bar.
2. Select "Release" in the shortcut menu.
The editor is released. Other users can now edit the data in the project.
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Tree view

Select all data records
Select the top element from the tree view ( for example ""Tag Management") to display all
configured data records of the editor or the function in the data area.
Show structured data records
The structured display of the data records in the tree structure depends on the selected editor.

13.4.4.2

Copying, pasting and deleting data in the navigation area

Introduction
You can copy, paste, and delete elements in the tree view of the navigation area.

Procedure
Copying and pasting an element in the tree view
1. You can copy the element to the clipboard by selecting it from the tree view and clicking
"Copy" in the shortcut menu.
Alternative procedure: Select the element and then press the <CTRL + C> keystroke
2. You paste the element to the corresponding position by selecting the element below the
paste position and clicking "Paste" in the shortcut menu.
Alternative procedure: Select the element below the paste position and then press <CTRL +
V>.
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Deleting elements from the tree view
1. Select the element to delete in the tree view and then click "Delete" in the shortcut menu
to delete it.
Alternative procedure: Select the element to delete in the tree view and press the <DEL>
key.

13.4.5

How to operate the data area

Operator controls in the data area

Number

Name

Description

"Mark all" button

Click this button to select all displayed data records in the data area.

Title bar of the data area

Indicates the directory that stored the displayed data records.

Column headers

The data records are sorted in the data area by information type, e.g. name or data
type. You can sort/filter the data records based on this information and hide/show
selected columns.

①
②
③

④

Line number

Consecutive numbering of the lines.
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13.4.5.1

Operating the data area

Introduction
The following options are available in the data area:
● Entering and changing data in the respective editors
● Configuring structure types
● Filtering, finding, copying and importing data records
Note
All inputs and changes in the data area become effective without saving and have an
immediate effect in Runtime.

Cell types in the data area
The data area contains two cell types:
● Cells for text input (or text display)
● Cells with check box input (or check box display)
Cells can be edited, or are read only. There are two types of read only cells:
● Cull write protection (e.g. ID, last change, etc.)
● Context-dependent write protection (e.g. address of internal tags)
Text input cells can be distinguished based on their data type and available input options.

Data input options
You can enter data in the data area in three different ways:
● Input in the text field
● Drop-down list
● Automatic continuation ("drag-down")
An additional input dialog is provided for cells of the "Address" column, see Data input help by
means of dialog.
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13.4.5.2

Data entry in the data area

Entering data in the text field
Introduction
You can use the text field to enter data in the data area. Several data types are available for
the text fields:
Data type

Valid entries

Text

All entries, except line break

Multi-line text

All entries

Unsigned integer

Numerical input only

Signed integer

Input of numbers and characters "+" and "–"

Floating-point number

Input of numbers, characters "+" and "–", decimal
point, and the "e" or "E" character for exponential
notation

Input restrictions
● WinCC DataGridControl validate compliance with data input restrictions and rejects
incorrect entries. Users are informed accordingly by means of tool tip.
● Specific cells are subject to additional input restrictions on character basis. Data typedependent limitations are checked by the WinCC DataGridControl at the time data is
entered; invalid entries are rejected. Users are informed accordingly by means of tool tip.

Procedure
1. Select the table cell for text input.
2. Enter the text in the cell.

Data entry via drop-down list
Introduction
You can select the cell data from a drop-down list. A drop-down list is offered for the following
columns:
● Data type
● Format change
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● Connection
● Group

Procedure
1. Select a table cell
2. Click the icon

to open the drop-down list.

3. Select the entry from the drop-down list.

Note
The drop-down list content may be context-specific.
Example: Only the groups that are available for the set connection will be available.

Automatic continuation ("drag-down")
Introduction
You can drag the small fill box to selected cells to accelerate the filling of cells with data sets.
Position the mouse pointer over the bottom right corner of a table cell. Transformation of the
mouse pointer indicates that automatic continuation is available.

Note
● Automatic continuation is only possible for cells below the pointer position.
● Automatic continuation only completes text in the table cells if these text are already
contain numerical values.
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Procedure
1. Select the table cells for continuation.
2. Drag the small fill box over the cells to be filled automatically and then release the mouse
button.
The table cells will be filled automatically with corresponding values.

Assisted data entry by means of dialog
Introduction
An input dialog is provided for the cells in the "Address" table column.
Note
The settings you can make are determined by the communication driver used for the
respective connection. For more information about the optional connection settings, refer to
the documentation of the communication driver.
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Procedure
1. Select the cell from the table column.
2. Set the values in the input dialog.
3. Click the "OK" button to confirm your entries.

13.4.5.3

Filtering in the data area

Filtering in the data area
Introduction
A filter can be set for each column of the data area. The filter criterion is set using the shortcut
menu of the respective table column.
Note
The filter functions are not case sensitive with respect to the cell contents.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
You have the following options for setting the filter criterion:
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● Filtering using the filter list box
● Filtering using the text filter

Filtering using the filter list box
Introduction
The filter list box is one means of setting the filter criterion. The filter list box lists all cell contents
of the respective table column.

Procedure
1. Right-click the column header to open the shortcut menu.
2. Click "Filter".

3. Select the filter criteria for the table column by activating the corresponding check boxes.

4. Click "OK" to confirm your entries.

Filtering by means of text filter
Introduction
The shortcut menu of the text filter provides additional options for setting filter criteria for
columns with .
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Procedure
1. Right-click a column header and select the "Filter" shortcut menu command.
2. Select the "Text filter" entry.
3. The submenu provides the following options:

Filter option

Description

Matches...

Use this filter option to filter column entries by text
elements that match or mismatch the criterion.

Mismatches...
Begins with...
Ends with...
Contains...
Does not contain...

Use this filter option to filter column entries by text
elements that match or mismatch the start or end
criterion
Use this filter option to filter column entries by text
elements that match or mismatch the content
criterion.

User-defined filter...

4. Select the option and enter the corresponding text elements in the next dialog.
5. Click "OK" to confirm your entries und to run the filter.

Filtering by means of number filter
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter option

Description

Equal to...

You may use this filter option to to synchronize the
column entries with defined values.

Unequal to...
Greater than...
Greater than or equal to...
Less than...

Use this option to filter out column entries that
match or mismatch the greater than/less than
value criterion.

Less than or unequal to..
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

Filtering by date
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter options

Description

Equivalent to...

Use this filter option to display all entries made on
a specific date.

Before...

Use this filter option to display all entries made
before or after a specific date.

After...
Today
Yesterday

Use this filter option to display all entries made
today, yesterday, or last week.

This week
Last week
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

13.4.5.4

Fast search in data area

Introduction
You can run a fast search of data records in the "Name" column. Matches are highlighted in
color while you are entering the search text, while mismatching data records are hidden.
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Performing the fast search
Note
The fast search function is only used to scan data records in the "Name" table column.
Note
Search text input is not case sensitive.
1. Click in the search box in the title bar of the data area.

2. Enter a search term.
Data records that mismatch your entry are hidden in the data area. Matches are highlighted
in color.
3. Select the data record.
4. You can return to the normal view of the data area by deleting the entry and clicking the
icon in the search box.

Refining the fast search
You can refine the fast search using the following search options:

Search option

Description

Matches search text

This search option returns data records that match the search
text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option returns data records that contain the
search text at any position.
This search option is set by default.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2155

Setting Up Multilingual Projects
13.4 The WinCC Configuration Studio
1. Open the search option by means of the

drop-down menu.

2. Left click the search option to select it.
3. Enter a search string.
The hitlist will be displayed.

13.4.5.5

Selecting cells, areas, rows and columns
You can select cells, areas, rows, columns or all data in the data area in order to, for example,
copy the selected data or paste contents. Specific applications are described in the
documentation of the corresponding editors.

Selection

Action

One individual cell

Select the cell with a mouse click or use the arrow keys to get
to the respective cell.

One cell area

Select the first cell of the area and drag the mouse pointer to
the last cell while pressing the mouse button, or hold down
the Shift key while pressing the arrow buttons to expand the
selection.

One large cell area

Select the first cell of the area and keep the Shift key pressed
while selecting the last cell of the area. You can scroll down
to make the last cell visible.

All cells in the data area

Click the "Select All" button.

You can also select one cell in the data area and press <Ctrl
+ A>.
Cells that are not next to each other

Select the first cell and keep the <Ctrl> key pressed while
selecting additional cells.

Columns

Click the column header with the mouse button. To select
additional columns, keep the <Ctrl> key pressed while
clicking additional column headers.

Lines

Click the line number with the mouse button. To select
additional lines, keep the <Ctrl> key pressed while clicking
additional line numbers.

13.4.5.6

Search and replace in the data area

Introduction
You can find and replace text in the data records managed in Configuration Studio. You may
also continue in the data area while the "Find and Replace" dialog is open.
You can refine your search using the following search options:

2156

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting Up Multilingual Projects
13.4 The WinCC Configuration Studio
Search option

Description

Matches search text

This search option only returns data records that match the
search text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option only returns data records that contain the
search text at any position.
This search option is set by default.

Procedure
Note
The current selection in the data area specifies the location for the search and/ or replace
operation:
● Select any cell to run the search in all data records.
● Select all cells of this area to find a specific area.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
Text search
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + F> key combination.
The "Find and Replace" dialog opens with the selected "Find" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Select a search option in the "Search result" field to refine your search.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2157

Setting Up Multilingual Projects
13.4 The WinCC Configuration Studio
5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.

Finding and replacing text.
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + H> key combination.
The "Find and Replace" dialog opens with the selected "Replace" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Enter the string that is to replace the search result in the "Replace with" field.
Leave the "Replace with" blank if you only want to delete the string defined in the "Find
what" field,
5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.
7. Click "Replace" to replace only the marked match.
Note
A click on "Replace all" replaces all matches without the output of further messages.
8. Click "Replace all" to replace all matches.
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13.4.5.7

Sorting in the data area

Introduction
You can sort text in one or several columns by text (characters A to Z, or Z to A), by numbers
(ascending or descending), or by data and time (oldest to most recent, or most recent to oldest).
The sorting order is inherited by all nodes in the tree view. You can modify or cancel sorting
orders.
Numerical values are treated separately in the sorting order. This ensures that the numeral 1
is followed by the numeral 2, and not the numeral 10, in a sorted column.

Procedure
Sorting using the shortcut menu of the table column
1. Right-click the table header of the column to be sorted.
2. Select the sorting option from the shortcut menu.
– Ascending sorting order
– Descending sorting order

Sorting using the table header
1. The data records are sorted in ascending order with double-click on a column header.
The column representing the sorting order origin is marked by an icon next to the column
header .

X

2. Click the column header once again to set the ascending sorting order.
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Note
● Press "CTRL" when double-clicking to include multiple columns in the sorting operation.
The sorting order is indicated by a number in the table header of the column. The sorting
order number is only displayed if more than one column is sorted.

13.4.5.8

Copying and pasting in the data area

Introduction
In WinCC Configuration Studio, you can copy text from table cells and paste these to different
table cells. This lets you exchange data between WinCC Configuration Studio and other
programs such as text editors or spreadsheet programs. You may also copy and paste data
records within WinCC Configuration Studio.
Note
It is not possible to cut an entire table row from the data area.

Procedure
Copying and pasting in the data area
1. Select the data records to copy.
2. Select "Copy" from the shortcut menu, or press <CTRL+C>.
3. Click the position in the data area where you want to paste the data records.
4. Select "Paste" from the shortcut menu, or press <CTRL+V>.
Copying and pasting in external applications
1. Select the data records to copy to the external application and then select "Copy" from the
shortcut menu, or press <CTRL + C>.
2. Open the external application where you want to paste the data records.
3. Click the position in the external application area where you want to paste the data records.
4. Use the commands of the external application to paste the data records from the clipboard.

13.4.5.9

Undoing an action
You can undo entries and changes in the data area with the <Ctrl + Z> shortcut.
Note
Certain actions cannot be undone. These exceptions are described in the respective editors.
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13.4.5.10 Importing data records
Introduction
You can import data records from third-party applications or other WinCC projects in the
WinCC Configuration Studio. These data records must be available in "Office Open XML
Workbook" format. Files of this format have the ".xlsx" extension and can be opened and edited
in spreadsheet programs.
Note
You cannot undo the import of data records.

Requirements
● The data records you load may not be in use by any other application.
● The connections contained in the data records must be available by their name in
WinCC Configuration Studio.

Procedure
1. Select the required editor in the navigation area.
2. Select "Import" from the shortcut menu of the editor.
The "Select file" dialog opens.
3. Select the file to import.
The data records will be loaded. A progress bar is displayed.

13.4.5.11 Exporting data records
You can either export all data records of a node selected in the navigation area during export
or only export the data records selected in the data area.
Exporting all data records of the node
1. Select the required node in the navigation area.
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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Exporting selected data records
1. Select the required data records in the data area.
For selection options, see Selecting cells, areas, rows and columns (Page 69).
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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13.5

Text Management with the "Text Library" Editor

13.5.1

Text management with the "Text Library" editor

Principle
All texts for your project are centrally managed in the Text Library except for most text from
the Graphics Designer. Each text entry is assigned a unique ID, by which the texts in WinCC
are referenced.

Links Between the WinCC Editors and the Text Library
The following WinCC editors store your texts in the Text Library:
● Alarm Logging:
– All user-defined texts, for example, messages, points of error and standard texts.
– Names for message classes, message status or message blocks.
– Message text of system messages
● Graphics Designer:
– Only the referenced texts from configured text lists and AlarmControl
● User Administrator:
– Authorizations
● User Archive:
– All configured alias names
● Picture Tree Manager (optional):
– All configured text

Languages in the Text Library
You can create languages with different code pages in the Text Library.
Note
With languages not installed with WinCC, note that the standard texts are entered in the
current WinCC GUI language because these other languages are not stored in WinCC. If the
project language and the WinCC GUI language are different, you must also translate the
standard texts.
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Translating the text
You have the following possibilities for translating texts:
● External translation of exported texts via the Text Library
● External translation of exported texts via the Text Distributor
● Direct input of the translated texts in the respective language columns of the Text Library
editor.
● Direct input of the translated texts in the Alarm Logging, User Administrator and User
Archive editors in the properties with translatable texts

Font Administration
You set the font in the Graphics Designer at the individual objects for specific languages. This
is particularly important if you are configuring in non-Latin fonts and to create, say, a Cyrillic
font. The set font is applied at the referenced locations in WinCC. WinCC V7.2 or higher lets
you set a font that contains all necessary characters for all languages.

See also
How to export language-dependent texts (Page 2126)
How to import language-dependent texts (Page 2135)
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13.5.2

Operator's overview of the Text Library

Operating the Text Library
You will find the editor language entries created in the project listed in clear table form in the
Text Library. Each language entry is provided with an ID which is its unique reference in the
WinCC database.

Overview of operation
The following sections give you an overview of the most important options for operating the
"Text Library" editor. Some menu commands can be executed via the shortcut menu or via
shortcuts.
Note
Inputs or changes are automatically saved to the WinCC database when you exit from a field.
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Translating text
Objective

Solution

Export the texts of the languages from the Text
Library for translation.

"Edit > Export..."

Import translated text into the Text Library.

"Edit > Import..."

Language administration
Objective

Solution

Add a new language.

Data area > "Languages" tab > Next free row,
"Language" column > Select language from dropdown list

Delete a language.

Data area > "Languages" tab > Delete the
language row

NOTICE
Unintentional deletion of text
The "Delete" function deletes a selected area without prior warning in the "Text Library >
'Texts' tab". If you do not undo the deletion with the "Edit > Undo" menu command before
closing the editor, these texts are irretrievably lost.
Unintentional overwriting of existing texts during copying
As in MS Excel, existing texts are overwritten when pasting copied cells in a selected area.
If you do not undo the deletion with the "Edit > Undo" menu command before closing the
editor, these texts are irretrievably lost. Pay close attention into which cells you are copying
which text.
Find and replace
Objective

Solution

Search and replace text in the selected language "Shortcut menu > Find and Replace >Find" or <Ctrl
in the highlighted area or in the entire Text Library. + F>
"Shortcut menu > Find and Replace > Replace" or
<Ctrl + H>
"Shortcut menu > Find and Replace > Find Next"
Find specific text in entire data area or in a specific
language.
Find specific ID in the entire data area or in the
"ID" column
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Filter Text Library
Objective

Solution

● Ascending sorting order

Select column and "Shortcut menu > Filter" or
arrow next to a language column.

● Descending sorting order
● Select all
● Select specific text entries

Select filter conditions, for example "(empty"), to
list missing texts

● Missing translated texts

View of the Text Library
Objective

Solution

Set input language

"View > Input language"

Set color scheme

"View > Color scheme"

Generating reports
Objective

13.5.3

Solution

Print contents of the Text Library as a report.

"File > Project Documentation - Print"

Check a report prior to printing.

"File > Project Documentation - Preview"

Set parameters of a report, e.g. select the
template.

"File" > "Project Documentation - Setup"

This is how you perform an external translation of the texts

External translation
External translation provides an easy and comfortable option for creating multilingual projects.
For precise information about translation costs and times, contact your external translation
provider or translator.
External translation has 3 steps:
1. Export the text
2. Translating the text
3. Import the translated text
Perform the export and import using the Text Library.

Procedure - exporting texts
1. Open the Text Library in the WinCC Explorer.
2. Select the "Edit > Export" menu command.
The "Export" dialog opens.
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3. Navigate to the path in which the export files are stored.
4. Enter a meaningful file name in the "File name" field.
An export file with this name is created.
5. In the "File format:" field, select the desired format.
6. Start the export process using the "Export" button.
When the export process is complete you will receive a message with the number of
exported texts.

Translating the text
The exported texts are saved to files with <.xlsx> or <.txt> format. Observe the information
about translation of the texts in section "How to edit and translate exported text files
(Page 2133)".

Procedure - Importing texts
1. Open the Text Library in the WinCC Explorer.
The Text Library opens.
2. Select the "Edit > Import" menu command.
The "Import" dialog opens.
3. Navigate to the path where the files you want to import are saved.
4. In the "File name" field, enter the file name with which the text was exported.
5. In the listbox, select the format of the text.
6. Start the import process by pressing "Import".
You then receive a message about the number of imported texts. You will receive
information on how the existing texts have been treated.

Checking the Translation
After the import, check the translation of the text in Runtime or in the "Alarm Logging" editor.
Reset the Runtime language accordingly.

13.5.4

Multilingual messages

Language-Dependent Message Objects
Translations in the WinCC installation languages are provided for messages and other
message objects provided by WinCC during installation. You can change these default texts
as you wish.
The Alarm Logging editor is where you can find texts which are stored in the Text Library
immediately after input:
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● User texts
You configure the user texts yourself or you accept the default names:
– Names of message classes
– Names of message blocks
– Names of message types
– Message text
– Point of error
– Other user text blocks
● Standard texts
Standard text records are delivered in the languages installed with WinCC. Standard texts
and WinCC system messages are entered in the appropriate language column of the Text
Library. Standard text records can be changed in the "Alarm Logging" editor or in the "Text
Library" editor.
● Info texts
Help texts are user texts which are not stored in the Text Library and whose language
cannot be changed. Only use help texts if you are configuring just one language or enter
the texts in a "neutral" language, e.g. English.
● Texts of the message system from the SIMATIC Manager are also stored in the Text Library
during transmission
Note
If you set up a language not installed with WinCC as the project language, the standard texts
are not entered in the selected project language, but in the current interface language. You
must therefore take special care that these texts are translated.

Compile message texts
You have the following options for translating the texts:
● External translation following an export and subsequent import of the translated texts in
WinCC Configuration Studio.
External translation is recommended for a large amount of text.
● Direct input of the translated texts in the respective language columns of the Text Library
editor
● Direct input of the translated texts in the Alarm Logging editor
Note
To the greatest possible extent, set the WinCC GUI and the configuration language the same
in the "Alarm Logging" editor to prevent non-uniform languages in the GUI in the "Text Library"
editor.
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Entering the translated texts in the Alarm Logging editor
You select the input language for the editors in WinCC Configuration Studio using the menu
"View" > "Input language".
In the Alarm Logging editor, the texts are displayed in the input language and in the available
translations. You can edit each of these properties.
Note
If you are configuring messages for multiple languages, be aware of the different text lengths
in the various languages. Set the length of your messages accordingly.
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13.6

Multilingual Pictures in the "Graphics Designer" Editor

13.6.1

Multilingual pictures in the "Graphics Designer" editor

Languages in the "Graphics Designer" editor
In the "Graphics Designer" editor, you can create text for graphic objects in the languages that
are configured in the "Text Library" editor.
The text that you configure in the "Graphics Designer" editor is saved with each picture. You
can export the text, translate it outside WinCC and import it again. You can export and import
the text records with the Text Distributor. If you have configured only a few texts for your
pictures, you can enter the translated texts in each picture as required.
The "Text list" and "AlarmControl" objects are special. With the "Text list" object, you can select
whether you want to store the configured text in the picture itself or in the text library. The text
is stored in the picture as default. With the "AlarmControl" object, the texts are stored by default
in the text library.
Note
Operating system support-Languages
Of the operating system languages, WinCC < V7.2 only supports the primary languages, i.e.
English (USA) but not English (GB). WinCC as of V7.2 supports Unicode and sub-languages.

Language switching in the "Graphics Designer" editor
When you open the Graphics Designer, the selected runtime language is set as the
configuration language. If you want to check a translation or enter text directly in another
language, change the configuration language in the "Graphics Designer" editor. The required
configuration language must be configured in the "Text Library" editor.
To change the project language, select the menu "View > Language...".
After changing, all configured texts are displayed in the selected language. If you have not yet
configured a language, its texts are displayed with characters "???" instead of the text.
The current project language is displayed in the status bar of the "Graphics Designer" editor.
Note
Different linguistic regions
If the newly selected language originates from another linguistic area as the previous one,
you must also change the operating system language (system locale).
Start your operating system again afterwards.
WinCC as of V 7.2 supports projects that contain languages that originate from different
regions.
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Displaying the text for the controls
The text display for the Controls in the "Graphics Designer" editor is based on the configuration
language set in the WinCC Explorer.
Example:
The configuration e.g. in the "Graphics Designer" editor is in an Asian language. In order to
display the text of an inserted control correctly, you must also select this Asian language in
the WinCC Explorer.
Restrictions for WinCC <V7.2
National special characters from different linguistic regions (e.g. Western European and Asian)
should not be used together in the same picture. When storing a picture under another
operating system language, these characters can be changed based on the code page.
Remedy
● Option 1:
Use different pictures for different linguistic regions. Edit and save the pictures with the
appropriate language setting.
● Option 2:
Select an Asian operating system language for Latin fonts, too. By modifying the registry,
automatic font association can be manipulated in such as way that Latin national special
characters can also be displayed. Further information can be found on the Microsoft support
pages.
Change the registry entry from [HKEY LOCAL MACHINE\System\CurrentControlSet
\Control\fontassoc\Associated CharSet] "ANSI(00)="yes" to "no".
NOTICE
Influence of the operating system
Always carry out the changes in the Registry carefully because this can otherwise lead
to unwanted problems with the operating system!
WinCC as of V7.2 supports the creation of picture texts in languages from different regions.

13.6.2

Language-dependent properties of picture objects

Language Input Options for Picture Objects
Depending on the picture object, you have different options for entering text:
● In the object itself, such as in the case of static text
● In the Configuration dialog, for example for the label on a button
● Object Properties dialog:
In the object properties, enter the major part of the text directly or in other dialogs such as
tooltips, output text, text attributes.
Additional information on configuring graphic objects can be found in the WinCC information
system in section "Creating process pictures".
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Language-Dependent Object Properties
The objects of the "Graphics Designer" editor have different object properties with different
language properties. With the exception of the window titles of the "Picture Window/Application
Window" smart objects and certain properties of the WinCC controls, you can change the
language of all object properties.
"Text" property
Objects: Static text, Text list, Button, Checkbox, Radio button, Multiple row text, List field,
Combo-box
"Font" property
Objects: Static text, I/O field, Bar, Group display, Text list, Multiple row text, List field, Combobox
"Tooltip" property
Objects: All objects except Picture Window and Application Window
Special Features: Tooltips can certainly be configured in multiple languages, but without any
special setting for the font. When configuring tooltips in non-Latin fonts, you must set the
corresponding font in Runtime in your operating system's Control Panel, for example Windows
7:
1. Select the "Advanced appearance settings" button under "Start > Control Panel >
Appearance and Personalization > Change window colors".
2. Select the "Quickinfo" element from the list.
3. Define the font.
Note that when you change the operating system language, the tooltips in all the other Windows
applications are also changed.
"Window Header" property
Objects: Picture Window, Application Window
ActiveX controls
Certain ActiveX Controls have text properties such as Column Name, Window Title or Axis
Label for which the language cannot be changed. In WinCC these properties are stored in all
languages installed with WinCC and are correctly displayed in Runtime. If you are configuring
in a language that was not installed via WinCC, these elements are displayed in Runtime in
the default Runtime language (English).
When configuring language changes to languages with non-Latin fonts, use a neutral language
for these ActiveX Control properties, such as English without a special font. If you have
configured a non-Latin font for these object properties, this font is used for each displayed
language.
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13.6.3

How to export and import text from pictures

Introduction
You have the following options for translating text in the "Graphics Designer" editor:
● External translation
External translation is recommended for a large amount of text.
● Direct input of the translated text in the "Graphics Designer" editor.
You can enter the translated text directly in the object properties dialogs for the languages
created in the "Text Library".

Requirement
All languages that you wish to translate into must be created in the "Text Library" editor. The
text to be translated in all pictures and picture objects is configured in at least one language.
Observe the following points during configuration:
● Text length
If you are configuring picture objects for multiple languages, be aware of the different text
lengths in the various languages. A French text is about 50% longer than the equivalent
German text. Dimension your graphic objects accordingly.
● Adapt border
For the "Static Text" object, use the Object Properties dialog box to set the attribute
"Properties > Miscellaneous > Adapt Border" to "Yes". The text border is then automatically
adapted to the contents.

Procedure
You can export and import the texts via the Text Distributor. You can export all target languages
or create a separate file for each language. This is advantageous if you want to give the text
to several translators. Make sure that no structural changes whatsoever are made in the files,
e.g. to the order of columns.
1. Export the texts.
– You can export all the pictures from a project or just individual pictures. A separate file
can be generated for each picture.
– Activate the "Update referenced texts" function if you have configured text lists or WinCC
Alarm Controls since the last update.
2. Translate the texts.
3. Import the translated texts.
For more information on procedures, refer to section " Text export and text import with the Text
Distributor (Page 2125) "
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After import, check your translations in Runtime or in the "Graphics Designer" editor. Change
the Runtime language accordingly.
Note
Texts from "Text list" and "AlarmControl" objects
Texts from text lists and AlarmControl stored in the text library are saved in the
"<Name>_GraphicsDesignerReferences" file.

See also
How to edit and translate exported text files (Page 2133)
Text export and text import in the Text Distributor (Page 2125)

13.6.4

How to configure picture objects for more languages in the "Graphics Designer"
editor

Introduction
Texts that you configure in your pictures are not stored in the Text Library, but with the picture
itself.
This section provides a description of procedures used to directly enter the translated text in
the "Graphcis Designer" editor. These procedures are mainly suitable for small amounts of
text.
Observe the following points during configuration:
Text length
If you are configuring picture objects for multiple languages, be aware of the different text
lengths in the various languages. A French text is about 50% longer than the equivalent
German text. Dimension your graphic objects accordingly.
Adapt border
For the "Static Text" object, use the Object Properties dialog box to set the attribute "Properties
> Miscellaneous > Adapt Border" to "Yes". The text border is then automatically adapted to
the contents.
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Certain graphic objects have elements for which you cannot set the font. For these elements
select a neutral language such as English for the text entries.
Note
Text list
The object known as Text List is a special case. If you are configuring a Text List for multiple
languages, please refer to "Configuring a Text List in Multiple Languages".
When configuring an I/O field, please note that WinCC only supports numbers for value input
in the form of Arabic numerals (1, 2, 3, ...).

Basic procedure
In order to configure picture objects for multiple languages, proceed as follows:
1. First configure all pictures and picture objects in your preferred language.
2. Enter the translated text directly on the objects in the respective language.
Untranslated texts are displayed as "???".

Alternative Procedures
In most cases you have several options for entering labels in picture objects, for example:
● In the "Object Properties" dialog, under "Font" in "Text" field.
The font can be set.
● In the "User object configuration dialog".
The font can be set.
The input window is still available which you can open from the Object Properties dialog:
● For inputting text (an alternative to direct input).
The font cannot be set.
● For inputting Tooltips.
The font cannot be set.
● For inputting text for the Text List.
The font cannot be set.
Note
In the case of non-Latin fonts the text in the input box is sometimes incorrectly displayed even
though the font was correctly set, but the appearance in the picture is correct in runtime. You
can remedy this by entering the text in another application (such as Word) and then using
Copy & Paste to transfer it to the input box. If necessary, set the same input methods in the
source and target applications to properly carry out copy & paste.
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Note
The font for Tooltips cannot be set in WinCC. Text in non-Latin fonts is correctly displayed in
runtime if the corresponding font for tooltips is set in your operating system's Control Panel.
When you are configuring a project for Latin and non-Latin fonts, after a change of language
the font for tooltips must be correspondingly set in the operating system.
Additional information on configuring graphic objects can be found in the WinCC information
system in section "Creating process pictures".

13.6.5

Configuring a Text List in Multiple Languages

Special characteristics of the text list
Select whether the configured text should be stored in the picture or in the text library for the
text list object.
For exporting with the text distributor, the text of the text lists is entered in the following export
files:
● When storing the text directly in the picture
– Only in the export file of the Graphics Designer or in the respective picture file
● When storing the text in the text library
– In the export file of the Graphics Designer or in the respective picture file
– In the export file "<Description>_GraphicsDesignerReferences"

Procedure
1. Open the "Graphics Designer" editor.
2. Open the "Object Properties" dialog box of the text list from the shortcut menu.
3. On the "Properties" tab activate the "Output/Input" group.
4. Double click on "Assignments".
The "Textlist assignments" dialog box appears.
5. Enter the "Range type", "Value range" and the desired text for every value/value range.
6. Confirm your entries with "OK".
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7. If you want to save text in the picture:
– Export the text with the text distributor and translate the text externally.
For more information on the text distributor, refer to the section " How to export languagedependent texts (Page 2126) ".
– As an alternative, change the configuration language in the "Graphics Designer" editor
and enter the translated text respectively.
8. If the texts are to be stored in the text library and translated:
– On the "Properties" tab activate the "Miscellaneous" group.
– Then double-click "Text Reference".
The default setting "no" switches to "yes". This stores the text records in the text library.
– Export the text with the text distributor and translate the text externally.
For more information on the text distributor, refer to the section " Text export and text
import for translations".
– As an alternative, start the "Text Library" editor and translate the text directly in the
respective language columns.
You can find additional information on translating text in the text library in the section
" Text management with the "Text Library" editor (Page 2163) ".
You can find additional information on planning and configuring the text list in the WinCC
information system in the section "Creating process pictures".
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13.7

Reports for Multilingual Projects

13.7.1

Reports for Multilingual Projects

General procedure
There are two types of report in WinCC:
● Project documentation
The project documentation contains reports that are output during the configuration. These
reports contain overviews of the configured data. You can output the project documentation
in all runtime languages.
In the project documentation you document all multilingual texts you configured.
● Logs that are output in runtime, such as regular printouts of measurement data. These
reports can be output in the respectively defined set runtime language.

13.7.2

Layout and layout file

Print Job and Layout
A print job just be stored for every report or every log in WinCC. Every print job is connected
with a layout. There are language-neutral and language-dependent layouts.

Layout and layout file
A language-neutral layout contains one layout file. Stored in language-neutral layout files \
\<Name of computer>\Project name\PRT".
A language-dependent layout contains several language-dependent layout files.

Layout files
The designation of language-dependent layout files contains a language ID. The languagespecific layout files are stored in language-specific folders in folder \\<Name of computer>
\Project name\PRT". The following table shows the language IDs and language folder with
languages that can be installed with WinCC.
Language

Language ID in file names

Folder

German

DEU

PRT\DEU

English

ENU

PRT\ENU

French

FRA

PRT\FRA

Italian

ITA

PRT\ITA

Spanish

ESP

PRT\ESP

Chinese (simplified)

CHS

PRT\CHS
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Language

Language ID in file names

Folder

Chinese (Traditional)

CHT

PRT\CHT

Korean

KOR

PRT\KOR

Japanese

JPN

PRT\JPN

Language-neutral

PRT\

If you add other runtime languages in the "Layouts" pop-up menu, the language-specific folder
is created in the PRT folder in the project folder.

System print jobs
WinCC provides various system print jobs. The respective layout files are available in all
languages that can be installed with WinCC.
The system print jobs cannot be deleted. You may rename the system print jobs, if necessary.
For the page layouts installed with WinCC, the layout files for the languages installed with
WinCC are installed in language-specific folders in the project folder.
Example:
The following layout files belong to the "Documentation_Alarm_logging" print job:
Language

Layout file

German

@algcs_DEU.rpl

English

@algcs_ENU.rpl

French

@algcs_FRA.rpl

Italian

@algcs_ITA.rpl

Spanish

@algcs_ESP.rpl

Chinese (simplified)

@algcs_CHS.rpl

Chinese (Traditional)

@algcs_CHT.rpl

Korean

@algcs_KOR.rpl

Japanese

@algcs_JPN.rpl

Language-dependent layout files
The layout files are only available if you have completed the following:
● You have clicked on the "Report Designer" entry.
More information on creating and configuring logs and log layouts can be found in the WinCC
Information System in chapter "Documentation of configuration and runtime data".

13.7.3

How to change or create layouts

Introduction
A layout is assigned to each print job. You edit page layouts in the page layout editor.

2180

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting Up Multilingual Projects
13.7 Reports for Multilingual Projects
The layout files of the layout are saved in a folder structure in the WinCC Explorer.

When printing print jobs with language-dependent layouts, WinCC uses the layout file with the
language code of the current WinCC Runtime language.

Adding Additional Languages to System Print Jobs
If you want to print system print jobs in languages other than that installed with WinCC, you
must add the layout file of the new language to the system layout.

Print Jobs with Your Own Layout
You can create print jobs with your own page layouts. The easiest thing to do is copy an existing
layout and change it based on your needs.
If you want to create print jobs with a language-neutral layout, you must create a layout file
and save it in the \\<Computer name>\Project name\PRT folder.
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If you want to create print jobs with a language-dependent layout, you must create a layout
file for each Runtime language. You must save the language-dependent layout file in the
correct folder.

Procedure - Creating a language-neutral layout file
1. Click on the "Report Designer" entry.
The "Layouts" and "Print Jobs" sub-entries are displayed in the data window.
2. Click on the "Layouts" entry.
The "Language-neutral" entry and one or more language-specific folders are located under
the "Layouts" entry.
3. Click on the "Language-neutral" entry and open the shortcut menu.
4. Select the "Open page layout editor" command in pop-up menu.
5. Create the language-neutral layout file and use "Save as" to save it in the \\<Computer
name>\Project name\PRT" folder.

Procedure - Adding a new Runtime language for a layout
Note
WinCC <V7.2 display dependent on system locale
You can only add the language-specific folders that use the same codepage. If you need to
edit layout files in languages that need another codepage, you must set up the associated
system locale (operating system language) in the system control of your operating system.
Note
Unicode as of WinCC V7.2
WinCC as of V. 7.2 supports Unicode. This dispenses with restrictions in terms of Chinese
(Simplified) and Chinese (Traditional). You can open layouts that were created in older
WinCC versions. However, you cannot use these without code page restrictions until you
have completed a migration. For this purpose, select the "Layouts" entry in WinCC Explorer
and start migration from the shortcut menu.
1. Click on the "Report Designer" entry.
The "Layouts" and "Print Jobs" sub-entries are displayed in the data window.
2. Select the "Layouts" entry and select the "Add language..." command in the pop-up menu.
3. Select the desired Runtime language.
The language must be defined in the text library to make it available in Runtime.

Results
The folder of the new Runtime language is saved in the "\\<Computer name>\Project name
\PRT" folder. The folder of the new Runtime language is displayed in WinCC Explorer.
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Procedure - Creating a language-dependent layout file
Note
As soon as there is a language-dependent layout file for a layout, the layout is languageneutral. This does not depend on whether language-dependent layout files also exist.
If necessary, delete the language-neutral layout file is in the "\\<Computer name>\Project
name\PRT" folder.
Language-dependent layout files are saved in a language-specific folder in the "PRT" folder
of the project folder.
1. Click on the "Report Designer" entry.
The "Layouts" and "Print Jobs" sub-entries are displayed in the data window.
2. Double-click on the "Layouts" entry.
The "Language-neutral" entry and one or more language-specific folders are located under
the "Layouts" entry.
3. Open the folder of the desired language.
4. Create a new page layout or change an existing layout.
5. When saving the layout file, specify the language code, e.g. "DEU" or "ENU".
6. Save the language-dependent layout file in the corresponding language folder.
7. Also create the layout file for the rest of the Runtime languages.

13.7.4

How to change or create print jobs

Introduction
There must be a layout for every print job.

Procedure - Creating a print job
1. Click on "Print jobs" in the navigation window.
The available print jobs are listed in the data window.
2. Create a new page job or change an existing print job.
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3. From the "Layout:" selection field select the desired format.

4. Save the print job with "OK".

Results
The print job has been created.
If a language-neutral layout or a language-dependent layout that is not available in all Runtime
languages is used in the print job, this is displayed by the
symbol.

Identifying the Layout File
In the "Layout:" selection field the layouts are indicated by a symbol.
Icon

Description
Layout is language-dependent.
Layout files exist in all runtime languages. No language-neutral layout file exists.
Layout is language-dependent.
Layout files do not exist in all runtime languages. You can use the layout. If you change
to a runtime language, for which there is no layout file available, the English layout file
is used.
The layout is language-neutral. In runtime, the language-neutral layout is always active.
This does not depend on whether language-specific layout files exist for the selected
layout.
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13.7.5

How to create the multilingual project documentation

Introduction
You use project documentation in WinCC to document your configured data. You can create
project documentation with data from the following editors:
● WinCC Explorer
● Graphics Designer
● Tag Management
● Alarm Logging
● Tag Logging
● Text Library
● User Administrator
● Global Script
● Cross Reference
● Horn
● Time Synchronization
● Picture Tree Manager
● Lifebeat Monitoring
● OS Project Editor

Rules for multilingual project documentation
The following rules apply to reports involving project documentation:
● Captions, table names and object properties are printed in the current WinCC language.
The text is output in English if it is not available in the current language.
● Configured text is output in the WinCC user interface language that you have set up in
WinCC Explorer under "Tools ...".
If no text is configured for this language, "???" are output.

Procedure
1. Exit Runtime.
2. Set a WinCC user interface language that you also want to use to create the project
documentation.
All languages initially installed along with WinCC are available for use as WinCC user
interface language.
3. Check the project documentation by selecting the menu command "Preview Project
Documentation" in the respective editor.
4. Output the project documentation by selecting the menu command "Print Project
Documentation".
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More information on creating and configuring logs and log layouts can be found in the WinCC
Information System in section "Documentation of configuration and Runtime data".

13.7.6

Multilingual logs in runtime

Introduction
In runtime you can output reports for process values, for instance regular measurement data
reports, curves or message reports. If your project runs in runtime in multiple languages, logs
in runtime will always be output in the current runtime language.
If a log is output in runtime, the layout file of the current runtime language is used.
Note
Layout file does not exist in current runtime language
If the layout file does not exist in the current runtime language, the English layout file is used.

Output of message sequence reports
Message sequence reports are always output in runtime in the language in which Runtime
was started. This also applies if e.g. the language was changed using the Set Language
function.
More information on creating and configuring logs and log layouts can be found in the WinCC
Information System in chapter "Documentation of configuration and runtime data".
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13.8

Displaying Regional Date and Time

Principle
Regional date and time displays are language-dependent. In some countries the European
format is displayed (Day.Month.Year), and the American format (Year/Month/Day) is used in
others. You must also pay attention to this display format for multilingual objects.
Date and time displays are configured in Alarm Logging and in Graphics Designer.
Note
If the central date and time format according to ISO 8601 is entered in the "Computer
Properties" dialog, it will have an effect on the configurable time formats and on the display
of time during Runtime. The date display is unambiguously set by the ISO 8601 format. You
may find additional information on ISO 8601 format under "Working with Projects" > "Setting
Time in WinCC".

Alarm Logging
You can select different formats for the "Time" and "Date" system blocks in Alarm Logging.
The configured format applies to the whole project and is not affected by changing the runtime
language.
If you insert an Alarm Control in Graphics Designer, it accepts the date and time setting that
you configured in Alarm Logging.

Graphics Designer
The following objects, which you can configure in Graphics Designer, display the date and
time:
● WinCC Alarm Control: The format of date and time is configured in Alarm Logging. The
configured setting applies to the entire project.
● WinCC TrendControl, WinCC TableControl: The format of date and time may be configured
directly under Control Properties. The settings apply to the current picture.
● D/A Clock: The WinCC ActiveX Control Digital/Analog Clock accepts the local computerspecific settings from your operating system settings. They cannot be changed in the
Control.
Note
When configuring a Chinese project, you must set China (Taiwan) as the input locale and
then adjust the date and time display format in the Control Panel of your operating system.
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Report Designer
Report Designer lets you adapt the date and time format by parameterizing the "Format"
attribute in the "Miscellaneous" group in the "Object Properties" dialog of the "Date/Time"
system object. You can get an overview of the possible parameters and settings from the Direct
Help on this attribute.

Display in Runtime
The date and time display in Runtime is determined by the settings in:
● Object properties of the computer > "Parameters" tab
● Graphics Designer
● Report Designer
● Alarm Logging
In runtime, the date and time displays are not changed in the event of a language change.
For more information, refer to the Graphics Designer, Alarm Logging and Report Designer
online help, as well as to "Working with projects" > "How to set the timebase for the Runtime
documentation".
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13.9

Languages in Runtime

13.9.1

Languages in Runtime

Runtime language
Set the language for displaying your project in Runtime centrally in WinCC Explorer under
computer properties.
You can select as the runtime language any language for which a language column has been
created in the Text Library.

Runtime Default Language
You can set a Runtime language that is globally valid for all graphic objects in the computer
properties dialog of WinCC Explorer.
A specific text for which no translation is available is displayed in the configured default runtime
language. If the text is not available in this language "???" is displayed.

Displaying Non-Translated Texts in Runtime
Non-translated texts of graphics objects are displayed in runtime as "???" as long as no
translated text exists in the runtime default language either.
If message system texts are not translated, nothing is displayed. By this means you can test
your project in runtime to check whether all texts are present.
If you have configured a change to a language that has not been created in the Text Library,
the previously set language continues to be displayed.

Changing languages in Runtime
When you have configured a project in multiple languages, configure an operating element
which will allow the operator to change the language in runtime. WinCC offers you several
preconfigured operating elements that you can use in your project. Of course, you may also
assign language change functions to custom picture objects, e.g. buttons.
WinCC <V7.2:
If the new language originates from another linguistic area as the previous one, you must also
change the operating system language (system locale). This is necessary so that the character
set works with the proper code page. Restart your operating system after changing the
language.
WinCC as of V7.2 supports Unicode. This means that you can use different system locales in
a project.
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13.9.2

How to Set the Runtime Computer Starting Configuration

Requirements
You can only select languages as runtime languages if they have been created in the Text
Library.

Procedure
1. In WinCC Explorer, select "Computer" with the right mouse button and select "Properties"
in the pop-up menu.
2. Select the required computer from the list (for multi-user projects only) and click the
"Properties" button.
3. In the "Computer Properties" dialog, select the Parameters tab.
4. In the "Language Setting at Runtime" field, select the language in which to start the project
in runtime.

In the "Default Language at Runtime" field, select the language in which to display texts
from graphics objects instead. The texts will be displayed in this Runtime default language,
if translations into the language set in "Language Setting at Runtime" do not exist.
5. Confirm your settings with "OK".
Results
In runtime, the project will be started in the set language. Non-translated texts of graphics
objects are displayed as "???" as long as no translated text exists in the runtime default
language either.
If message system texts are not translated, nothing is displayed.

13.9.3

Configuring Language Changes

Introduction
You can configure language changes within operating elements yourself, or use preconfigured
WinCC objects for changing languages.
The following preconfigured WinCC objects are available:
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● Buttons for each WinCC language for operating using mouse or finger (touch screen
operation).
● Hot key symbols for each WinCC language for operating with the keyboard.
● Radio box lists for changing between two or all available WinCC languages.
Drag & drop WinCC objects for changing languages into your picture from the WinCC library
("Operation" group, "Language Change" subgroup).

If you are configuring a language change in a picture object and decide not to use any of the
preconfigured WinCC objects, the following picture objects are recommended:
● A button for changing between two languages.
If using a button, you must also configure a button that operators can use to return to the
previous language. By using a toggle function, you can change to a language and back
with just one button.
● An input/output field in which the operator inputs the language directly. This solution
requires script programming.
● Radio buttons or check boxes for selecting a language. This solution requires script
programming.
The following section contains an example to show you how you can configure a language
change on a single button.

Requirement
Always configure a change to a language for which texts have already been configured. If
these texts are not available during Runtime, graphics objects will display "???" after the
language change as long as no translated text is available in the runtime default language
either. If message system texts are not translated, nothing is displayed.
Language changes must always have a target language that has been created in the Text
Library. If the target language is not present, the language change has no effect and the
previously set language continues to be displayed.
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Procedure
1. In the Graphics Designer open the picture in which you wish to configure a language change.
2. Configure a button.
3. Double-click the "Language Change" wizard in the Dynamic Wizard dialog.
The Dynamic Wizard for language changes opens.
4. Click "Continue" to move on from the opening screen.
5. Select a language change trigger such as mouse click in the "Select Trigger" dialog.
6. Select the target language in the "Set Options" dialog.
Source language is always the current Runtime language or the current project language
if this is different to the Runtime language.
7. Click "Continue" to view your chosen options, and click "Finish" to finish configuring.
Results
If operator clicks the button in runtime, the language is changed from the current runtime
language to the language you specified.
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13.10

Example of Configuration

13.10.1

Example of Configuration

Overview
The following example shows you how to create a small multilingual project in a few steps:
● You configure a graphic object in multiple languages.
● You configure a language change.
● You run the project and change the language in runtime.
● You export the texts for translation and import the translated texts.

See also
Example: How to translate the text records in different linguistic regions (Page 2200)

13.10.2

Example: How to Configure a Multilingual Graphic Object

Introduction
In the following section, you configure a button for the "End Runtime" function with labels in
the configurable languages.

Procedure
1. Open the Graphics Designer.
2. Create a new picture for the example, e.g. "language.pdl". In a project you position the
language change as a rule on the starting page.
3. Create a button from the group of Windows objects in the Object Palette.
4. After creating this, the Configuration dialog opens. In the Configuration dialog, enter the
button label in the configuration language of the Graphics Designer, e.g., "End Runtime".
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5. Input a font such as Arial Black and click OK to close the dialogs.

6. Use the appropriate Dynamic Wizard to load the button with the "End Runtime" function.
7. Open the "Object Properties" dialog box of the button using the shortcut menu command
"Properties".
8. In the Properties tab, double-click the "Text" field in the "Font" group. The "Text Input" dialog
opens. You can now enter the text for the respective languages for all languages that are
created in the "Text Library".
9. Save your picture.

Result
When you change the project language in the Graphics Designer between English, French
and Italian, the text is displayed on the button in the current project language in each case.

13.10.3

Example: How to Configure Language Changes

Introduction
Below you configure a language change with which you can change between English, French
and Italian in runtime.

2194

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting Up Multilingual Projects
13.10 Example of Configuration

Requirement
You must have configured the button as described under "Example": "Configuring a
Multilingual Graphic Object".

Procedure
Note
In the following example you configure a Language change by means of an object from the
WinCC library. These objects are already preconfigured and ready for use. If you wish to
create a dedicated operating element for changing languages, select the "Language Change"
Dynamic Wizard.
1. Open the picture "languages.pdl".
2. Click the
"Library".

button to open the WinCC library or select the menu command "View" >

3. In the Global Library, open the folder "Operation" > "Language Change".
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4. Select the object "Change all Languages" and drag & drop it into your picture. The WinCC
Library object automatically adapts its label to the current project language; in this case
French.

5. Save your picture.

13.10.4

Example: How to Change Language in Runtime

Introduction
In the following section you execute your example project in Runtime.

Requirement
You have configured the button and the language change as described under "Example":
"Configuring Multilingual Graphic Object" and "Example": "Configuring Language Change".

Procedure
Note
Before starting Runtime, you must go to the Text Library and create the languages to be
used. The texts of the pictures are not stored in the Text Library. A language must, however,
be created in the Text Library so that it may be selected as Runtime language.
1. Open the WinCC Text Library.
2. Check whether the Runtime language is set. Your project starts in the Runtime language.
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3. If the Runtime language is missing, enter it in the data area in the "Languages" tab. Open
the drop-down list in the top free row in the "Languages" column and select the desired
language.
4. Close the Text Library.
5. Select the computer in the WinCC Explorer. Click the "Properties" shortcut menu command
to open the "Object properties" dialog.
6. Click the "Parameter" tab.
7. Select the Runtime language in the "Language Setting at Runtime" field, such as "Italian"
and select as Runtime default language under "Default Language at Runtime", such as
"English". Close the dialog by clicking OK.

8. Open the picture "language.pdl" in the Graphics Designer.
9. Click
to start the picture in Runtime. The picture starts in the set Runtime language,
which is Italian.
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10.Change the language to one of the configured languages (English or French):

2198

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Setting Up Multilingual Projects
13.10 Example of Configuration
11.For demonstration purposes, switch to a language that is in the Text Library but for which
you have not yet configured text for the button, for example, German. The text that is not
configured is displayed as "???":

12.For demonstration purposes, switch the language back to English, and then to a language
that is neither configured nor registered in the Text Library, for example, Spanish. Since
the language is not available in the Text Library, the language is not changed. The
previously set language, in this case English, is kept:
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Using the system dialog to change the language in Runtime
Another option for changing the language in Runtime is outlined in "Working with projects" in
the flowing chapters:
● "How to set up system dialogs"
● "How to change the language in Runtime".

13.10.5

Example: How to translate the text records in different linguistic regions

Principle
If you are translating to a language that originates from a different linguistic region, the
respective system locale must be defined in the control panel of your operating system.
When translating the text records in other linguistic regions, you must therefore consider the
settings for your computer.
WinCC as of V7.2 supports Unicode. In your operating system, you therefore only set the
system locale for programs that do not support Unicode. Select a font that contains all
necessary characters. Depending on the character input language and medium you are using,
it may be necessary to make additional settings in the Control Panel of your OS, e.g. dialog
language and keyboard settings.
The following example shows how you translate from English to Chinese (Simplified, PR
China).
The example assumes that the text exists in English.

Procedure
1. Export the English text records with the Text Library.
– In the "File name" field, enter the file name "ENU_CHS_Languages".
– Select the "Unicode Text (*.txt)" file type.
2. Export the English picture texts with the Text Distributor.
– In the "File prefix" field, enter "ENU_CHS".
– Select the "Text file (*.txt)" file format.
3. Set the system locale for Chinese in the operating system of your computer.
The Input Method Editor (IME) is available in Windows for configuring Asian text.
4. Restart the operating system.
5. Open the file "ENU_CHS_Languages.txt".
6. Expand the file by the language Chinese. Enter 1028 in the column "Language ID". In
column "FontName", enter "Ming Lui". Change the other parameters for the font if
necessary.
7. Save the file "ENU_CHS_Languages.txt".
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8. Open the file with the exported text records of the Text Library.
– Create another column for Chinese in the file.
– Write the text "Chinese" in every object block in line "ID" in the new column.
– Enter the correct translation for every Text ID in the Chinese column.
– Save the file once again in "Unicode Text (*.txt)" format.
– Repeat these steps for all files with exported text records of the Text Library, if necessary.
9. Open the file <ENU_CHS_GraphicsDesigner.txt> or one of the picture files.
For every line that begins with "Object":
– Enter the following text records in the next free cells: "Chinese", "Chinese FontName",
"Chinese FontSize", "Chinese FontBold", "Chinese FontItalic", "ChineseFontUnderline".
– Change the entries in column "Chinese FontName" to "Ming Lui" and the other properties
as desired.
– Enter the translated text in column "Chinese".
– Save the file.
– If you have individual picture files, repeat these steps for every file.
10.Start WinCC.
11.Open the Text Library.
12.Select the "Edit > Import" menu command.
13.Select the file "ENU_CHS_Languages.txt.
14.Start the import with a double-click on the "Import" button.
15.Start the Text Distributor.
16.Change to the "Import text" tab.
17.Select Chinese (Simplified, PR China) under "Select language".
18.Start the import with a double-click on the "Import" button.

Result
The Chinese text records are available in the WinCC project. The text records can be displayed
in the configuration and in Runtime.
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Setting up user administration

Overview
You use the User Administrator to assign and manage access rights for operation in runtime
and configuration in the configuration system.
All of the operator stations are included in the user administration system, including WinCC/
Web Navigator clients and WinCC/DataMonitor clients.
The User Administrator also supports centralized user administration, integrated in Windows,
via SIMATIC Logon.

Principles of user administration
The User Administrator contains predefined default authorizations and system authorizations.
You can if necessary add or remove authorizations.
You create user groups and users and assign them joint or individual authorizations. You can
also assign authorizations in runtime.
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When a user logs on, the User Administrator checks whether he is registered and what
authorizations he holds. A user who is not registered does not have the rights to access or
display data. If the user accesses a WinCC object with access protection, the User
Administrator checks whether the user has the required operator authorization.
You open the User Administrator with the WinCC Explorer. If you have already opened another
editor in the WinCC Configuration Studio, you can change to the User Administrator with the
editor selection on the bottom left.

Advanced user administration functions
● You configure the web options for the users for operation via the Intranet/Internet.
● If necessary, you can configure automatic logout for user groups or individual users.
● WinCC supports logon to a computer using a tag value, e.g. using a key-operated switch.
● Logon with a chip card is possible using the "Chip card" option.
● The option "Basic Process Control" supports those authorizations and areas which
correspond to the PCS 7 user hierarchies.
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Performance data
Object

Maximum number

Authorizations

999

Users

128

User groups

128

Ranges

256

Operating the "User Administrator" editor
You configure the user administration in the WinCC Configuration Studio using the "User
Administrator" editor .
The basic functions and general operation are described in section "The WinCC Configuration
Studio".
Special types of configuration are described in the corresponding function descriptions.

See also
Central user administration with SIMATIC Logon (Page 2251)
Logon with a chip card (Page 2250)
Configuring logon with a tag (Page 2246)
Configuring automatic logout (Page 2245)
Administering authorizations (Page 2231)
Administering users (Page 2239)
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14.2

Overview of the configuration steps

Basic steps in WinCC user administration
1. If necessary, create more authorizations in addition to those predefined.
2. Create the necessary user groups.
3. Assign the authorizations to the user groups.
4. Save the users in the corresponding user groups. The group properties can be imported.
5. Assign specific authorizations to individual users.
6. If necessary, configure web access for user groups or individual users.
7. If necessary, set a time for user groups or individual users after which the system
automatically logs out a logged on user.
8. If necessary, configure user logon with a tag, for example so that the users log in with a
key-operated switch instead of the logon dialog.
9. If necessary, authorize user groups or individual users to log on using a chip card.
10.The data configured is applied without being stored.
11.You configure the operator authorizations in the editors of the WinCC project.
For example, you specify the authorization to operate a button in a picture in the Graphics
Designer.

Alternative procedure using SIMATIC Logon
You can set up central user administration with SIMATIC Logon instead of WinCC user
administration. The basic package for the "SIMATIC Logon Service" must be installed on all
computers involved. Select the "SIMATIC Logon" option in the User Administrator.

See also
Adding authorizations (Page 2231)
Creating a user group (Page 2239)
Setting up users (Page 2239)
Administering users for web access (Page 2244)
Configuring automatic logout (Page 2245)
Configuring operator authorization (Page 2248)
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The WinCC Configuration Studio

14.3.1

Introduction

Introduction
WinCC Configuration Studio provides a simple and efficient means of configuring bulk data
for WinCC projects. The user interface is divided into two areas: a navigation area similar to
Microsoft Outlook and a data area similar to Microsoft Excel. This setup lets you configure bulk
data for a WinCC project, while taking operational benefits that you already from spreadsheet
programs. The WinCC Configuration Studio replaces the previous procedure for the following
editors and functions:
● Tag management
● Tag Logging
● Alarm Logging
● Text Library
● User Administrator
● Horn
● User Archive
This chapter will provide you with an overview of the functionality and operation of
WinCC Configuration Studio.

14.3.2

System requirements

Introduction
System requirements for WinCC Configuration Studio are the same as for WinCC. Since
WinCC Configuration Studio is an integral component of the WinCC configuration system, you
cannot use WinCC Configuration Studio without WinCC.

Compatibility
WinCC Configuration Studio is compatible with all WinCC versions 7.2 and higher.
Note
WinCC Configuration Studio is an integral component of the WinCC configuration system.
Separate Installation is not possible.
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14.3.3

Interface

Introduction
The user interface consists of a navigation area and a data area with tables. More information
about the user interface is provided in the following chapters.

Introduction
The user interface consists of a navigation area with navigation bar, the data area with tables
and the "Properties" area.

①
②
③
④
⑤
⑥
⑦

Menu bar
Fast search in data area
Navigation area
Data area
"Properties" window
Navigation bar
Information bar with information on the status of the editor, selected input language, and number of data records in
the data area.

Menu bar
With the menu bar, you can activate the following functions:

2208

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Structure of the User Administration
14.3 The WinCC Configuration Studio
● "File > Exit": Exit Configuration Studio.
● "Edit > Copy": Copy selected data.
● "Edit > Paste": Paste previously copied data.
Additional information on copying and pasting data is available under Copying and pasting
in the data area (Page 73).
● "Edit > Import": Import data records
Additional information on importing data records is available under Importing data records
(Page 74).
● "Edit > Export": Export data records
Additional information on importing data records is available under Exporting data records
(Page 74).
● "View > Input language": Switch the input language. You are offered all languages available
on your system in a selection menu.
Additional information on configuring multilingual projects is available under Language
support in WinCC (Page 2110).
● "View > Color scheme": Change the color scheme of the Configuration Studio.
● "? > Contents and Index": Call the online help
● "? > Info about WinCC Configuration Studio": Information on version and system.
Fast search in data area
Use the "Search (Find)" field to look for entries in the data area. If one or more fields were
selected in the data area, the search is limited to the selected fields. For additional information
on fast search, refer to Fast search in data area (Page 67).
Navigation area
The objects of the selected editor or the selected function are displayed in the navigation area
as tree view. The structure of the tree view includes all elements that are displayed in the data
area.
For information on operating the navigation area, see How to operate the navigation area
(Page 55).
Data area
The data area consists of a table view that you will be familiar with from spreadsheet programs.
The data records of the selected editor or the selected function are configured in the data area.
For information on operating the data area, see How to operate the data area (Page 58).
"Properties" window
The data records of the selected editor or the selected function can be edited in the "Properties"
window. Details on operation of the "Properties" window are described in the corresponding
sections of the respective editors or functions.

See also
Fast search in data area (Page 67)
Importing data records (Page 74)
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Exporting data records (Page 74)
Copying and pasting in the data area (Page 73)
How to operate the navigation area (Page 55)
How to operate the data area (Page 58)
Language support in WinCC (Page 2110)

14.3.4

How to operate the navigation area

14.3.4.1

Operating the navigation area

Introduction
You access the navigation area of an editor or a function with the navigation bar.
The navigation area displays the tree view of the selected editor or the selected function. Select
an element from the tree view in the navigation area to display the corresponding data records
in the data area.

Navigation bar
You can access all available editors and functions by means of buttons in the navigation bar.

You access hidden buttons with a mouse click on the corresponding symbol in the bottom part
of the navigation bar.
Symbol

Editor/Function
Tag management
Alarm Logging
Tag Logging
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Symbol

Editor/Function
Text Library
User Administrator
Horn
User Archive

Showing or hiding buttons in the navigation bar
You use the drop-down menu in the bottom part of the navigation bar to show or hide buttons
in the navigation bar.
1. Click on the symbol for the drop-down menu.

The drop-down menu opens.
2. Select "Show additional buttons" to show buttons.
Or:
Select "Show fewer buttons" to hide buttons.

Opening an editor
Click the required editor in the navigation bar or select "Open" from the shortcut menu.

Opening individual editors
To open a required editor in a new window, open the shortcut menu of the editor in the
navigation bar.
1. Right-click on the required editor in the navigation bar.
2. Select "Open in new window" in the shortcut menu.
The editor opens in a new window.

Releasing the editor
You must release the editor after finishing your work so that other users can work with the
editor in a project.
1. Right-click on the editor in the navigation bar.
2. Select "Release" in the shortcut menu.
The editor is released. Other users can now edit the data in the project.
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Tree view

Select all data records
Select the top element from the tree view ( for example ""Tag Management") to display all
configured data records of the editor or the function in the data area.
Show structured data records
The structured display of the data records in the tree structure depends on the selected editor.

14.3.4.2

Copying, pasting and deleting data in the navigation area

Introduction
You can copy, paste, and delete elements in the tree view of the navigation area.

Procedure
Copying and pasting an element in the tree view
1. You can copy the element to the clipboard by selecting it from the tree view and clicking
"Copy" in the shortcut menu.
Alternative procedure: Select the element and then press the <CTRL + C> keystroke
2. You paste the element to the corresponding position by selecting the element below the
paste position and clicking "Paste" in the shortcut menu.
Alternative procedure: Select the element below the paste position and then press <CTRL +
V>.
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Deleting elements from the tree view
1. Select the element to delete in the tree view and then click "Delete" in the shortcut menu
to delete it.
Alternative procedure: Select the element to delete in the tree view and press the <DEL>
key.

14.3.5

How to operate the data area

Operator controls in the data area

Number

Name

Description

"Mark all" button

Click this button to select all displayed data records in the data area.

Title bar of the data area

Indicates the directory that stored the displayed data records.

Column headers

The data records are sorted in the data area by information type, e.g. name or data
type. You can sort/filter the data records based on this information and hide/show
selected columns.

①
②
③

④

Line number

Consecutive numbering of the lines.
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14.3.5.1

Operating the data area

Introduction
The following options are available in the data area:
● Entering and changing data in the respective editors
● Configuring structure types
● Filtering, finding, copying and importing data records
Note
All inputs and changes in the data area become effective without saving and have an
immediate effect in Runtime.

Cell types in the data area
The data area contains two cell types:
● Cells for text input (or text display)
● Cells with check box input (or check box display)
Cells can be edited, or are read only. There are two types of read only cells:
● Cull write protection (e.g. ID, last change, etc.)
● Context-dependent write protection (e.g. address of internal tags)
Text input cells can be distinguished based on their data type and available input options.

Data input options
You can enter data in the data area in three different ways:
● Input in the text field
● Drop-down list
● Automatic continuation ("drag-down")
An additional input dialog is provided for cells of the "Address" column, see Data input help by
means of dialog.
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14.3.5.2

Data entry in the data area

Entering data in the text field
Introduction
You can use the text field to enter data in the data area. Several data types are available for
the text fields:
Data type

Valid entries

Text

All entries, except line break

Multi-line text

All entries

Unsigned integer

Numerical input only

Signed integer

Input of numbers and characters "+" and "–"

Floating-point number

Input of numbers, characters "+" and "–", decimal
point, and the "e" or "E" character for exponential
notation

Input restrictions
● WinCC DataGridControl validate compliance with data input restrictions and rejects
incorrect entries. Users are informed accordingly by means of tool tip.
● Specific cells are subject to additional input restrictions on character basis. Data typedependent limitations are checked by the WinCC DataGridControl at the time data is
entered; invalid entries are rejected. Users are informed accordingly by means of tool tip.

Procedure
1. Select the table cell for text input.
2. Enter the text in the cell.

Data entry via drop-down list
Introduction
You can select the cell data from a drop-down list. A drop-down list is offered for the following
columns:
● Data type
● Format change
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● Connection
● Group

Procedure
1. Select a table cell
2. Click the icon

to open the drop-down list.

3. Select the entry from the drop-down list.

Note
The drop-down list content may be context-specific.
Example: Only the groups that are available for the set connection will be available.

Automatic continuation ("drag-down")
Introduction
You can drag the small fill box to selected cells to accelerate the filling of cells with data sets.
Position the mouse pointer over the bottom right corner of a table cell. Transformation of the
mouse pointer indicates that automatic continuation is available.

Note
● Automatic continuation is only possible for cells below the pointer position.
● Automatic continuation only completes text in the table cells if these text are already
contain numerical values.
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Procedure
1. Select the table cells for continuation.
2. Drag the small fill box over the cells to be filled automatically and then release the mouse
button.
The table cells will be filled automatically with corresponding values.

Assisted data entry by means of dialog
Introduction
An input dialog is provided for the cells in the "Address" table column.
Note
The settings you can make are determined by the communication driver used for the
respective connection. For more information about the optional connection settings, refer to
the documentation of the communication driver.
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Procedure
1. Select the cell from the table column.
2. Set the values in the input dialog.
3. Click the "OK" button to confirm your entries.

14.3.5.3

Filtering in the data area

Filtering in the data area
Introduction
A filter can be set for each column of the data area. The filter criterion is set using the shortcut
menu of the respective table column.
Note
The filter functions are not case sensitive with respect to the cell contents.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
You have the following options for setting the filter criterion:
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● Filtering using the filter list box
● Filtering using the text filter

Filtering using the filter list box
Introduction
The filter list box is one means of setting the filter criterion. The filter list box lists all cell contents
of the respective table column.

Procedure
1. Right-click the column header to open the shortcut menu.
2. Click "Filter".

3. Select the filter criteria for the table column by activating the corresponding check boxes.

4. Click "OK" to confirm your entries.

Filtering by means of text filter
Introduction
The shortcut menu of the text filter provides additional options for setting filter criteria for
columns with .
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Procedure
1. Right-click a column header and select the "Filter" shortcut menu command.
2. Select the "Text filter" entry.
3. The submenu provides the following options:

Filter option

Description

Matches...

Use this filter option to filter column entries by text
elements that match or mismatch the criterion.

Mismatches...
Begins with...
Ends with...
Contains...
Does not contain...

Use this filter option to filter column entries by text
elements that match or mismatch the start or end
criterion
Use this filter option to filter column entries by text
elements that match or mismatch the content
criterion.

User-defined filter...

4. Select the option and enter the corresponding text elements in the next dialog.
5. Click "OK" to confirm your entries und to run the filter.

Filtering by means of number filter
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter option

Description

Equal to...

You may use this filter option to to synchronize the
column entries with defined values.

Unequal to...
Greater than...
Greater than or equal to...
Less than...

Use this option to filter out column entries that
match or mismatch the greater than/less than
value criterion.

Less than or unequal to..
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

Filtering by date
Introduction
The shortcut menu of the number filter provides additional options for setting filter criteria for
columns with numerical content.
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Procedure
1. Select a column header and click the "Filter" shortcut menu command.
2. Select the "Numbers filter" entry.
The submenu provides the following options:

Filter options

Description

Equivalent to...

Use this filter option to display all entries made on
a specific date.

Before...

Use this filter option to display all entries made
before or after a specific date.

After...
Today
Yesterday

Use this filter option to display all entries made
today, yesterday, or last week.

This week
Last week
User-defined filter...

3. Select the option and enter the corresponding values in the next dialog.
4. Click "OK" to confirm your entries und to run the filter.

14.3.5.4

Fast search in data area

Introduction
You can run a fast search of data records in the "Name" column. Matches are highlighted in
color while you are entering the search text, while mismatching data records are hidden.
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Performing the fast search
Note
The fast search function is only used to scan data records in the "Name" table column.
Note
Search text input is not case sensitive.
1. Click in the search box in the title bar of the data area.

2. Enter a search term.
Data records that mismatch your entry are hidden in the data area. Matches are highlighted
in color.
3. Select the data record.
4. You can return to the normal view of the data area by deleting the entry and clicking the
icon in the search box.

Refining the fast search
You can refine the fast search using the following search options:

Search option

Description

Matches search text

This search option returns data records that match the search
text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option returns data records that contain the
search text at any position.
This search option is set by default.
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1. Open the search option by means of the

drop-down menu.

2. Left click the search option to select it.
3. Enter a search string.
The hitlist will be displayed.

14.3.5.5

Selecting cells, areas, rows and columns
You can select cells, areas, rows, columns or all data in the data area in order to, for example,
copy the selected data or paste contents. Specific applications are described in the
documentation of the corresponding editors.

Selection

Action

One individual cell

Select the cell with a mouse click or use the arrow keys to get
to the respective cell.

One cell area

Select the first cell of the area and drag the mouse pointer to
the last cell while pressing the mouse button, or hold down
the Shift key while pressing the arrow buttons to expand the
selection.

One large cell area

Select the first cell of the area and keep the Shift key pressed
while selecting the last cell of the area. You can scroll down
to make the last cell visible.

All cells in the data area

Click the "Select All" button.

You can also select one cell in the data area and press <Ctrl
+ A>.
Cells that are not next to each other

Select the first cell and keep the <Ctrl> key pressed while
selecting additional cells.

Columns

Click the column header with the mouse button. To select
additional columns, keep the <Ctrl> key pressed while
clicking additional column headers.

Lines

Click the line number with the mouse button. To select
additional lines, keep the <Ctrl> key pressed while clicking
additional line numbers.

14.3.5.6

Search and replace in the data area

Introduction
You can find and replace text in the data records managed in Configuration Studio. You may
also continue in the data area while the "Find and Replace" dialog is open.
You can refine your search using the following search options:
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Search option

Description

Matches search text

This search option only returns data records that match the
search text.

Begins with search text

This search option returns data records that begin with the
search text.

Ends with search text

This search option returns data records that end with the
search text.

Contains search text

This search option only returns data records that contain the
search text at any position.
This search option is set by default.

Procedure
Note
The current selection in the data area specifies the location for the search and/ or replace
operation:
● Select any cell to run the search in all data records.
● Select all cells of this area to find a specific area.
Note
No support of wildcards (* ?)
The search and filter functions in WinCC Configuration Studio do not support wildcards. If *
(asterisk) or ? (question mark) is entered for a search or filter, no results are displayed.
Text search
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + F> key combination.
The "Find and Replace" dialog opens with the selected "Find" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Select a search option in the "Search result" field to refine your search.
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5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.

Finding and replacing text.
1. Select the range of cells you want to search.
If the entire data area is to be searched, click on any cell.
2. Press the <Ctrl + H> key combination.
The "Find and Replace" dialog opens with the selected "Replace" tab.

3. Enter the search text in the "Find what" field, or select a previous search string from the
"Find what" drop-down list.
4. Enter the string that is to replace the search result in the "Replace with" field.
Leave the "Replace with" blank if you only want to delete the string defined in the "Find
what" field,
5. If you want to run a case-sensitive search, select the "Match case" check box.
Note
The data records are searched in descending order by default. To search the data records
in ascending order, select the "Search up" option.
6. Click "Find next" to search for the next match.
The cell containing the next match found will be marked. Matches are highlighted in color.
7. Click "Replace" to replace only the marked match.
Note
A click on "Replace all" replaces all matches without the output of further messages.
8. Click "Replace all" to replace all matches.
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14.3.5.7

Sorting in the data area

Introduction
You can sort text in one or several columns by text (characters A to Z, or Z to A), by numbers
(ascending or descending), or by data and time (oldest to most recent, or most recent to oldest).
The sorting order is inherited by all nodes in the tree view. You can modify or cancel sorting
orders.
Numerical values are treated separately in the sorting order. This ensures that the numeral 1
is followed by the numeral 2, and not the numeral 10, in a sorted column.

Procedure
Sorting using the shortcut menu of the table column
1. Right-click the table header of the column to be sorted.
2. Select the sorting option from the shortcut menu.
– Ascending sorting order
– Descending sorting order

Sorting using the table header
1. The data records are sorted in ascending order with double-click on a column header.
The column representing the sorting order origin is marked by an icon next to the column
header .

X

2. Click the column header once again to set the ascending sorting order.
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Note
● Press "CTRL" when double-clicking to include multiple columns in the sorting operation.
The sorting order is indicated by a number in the table header of the column. The sorting
order number is only displayed if more than one column is sorted.

14.3.5.8

Copying and pasting in the data area

Introduction
In WinCC Configuration Studio, you can copy text from table cells and paste these to different
table cells. This lets you exchange data between WinCC Configuration Studio and other
programs such as text editors or spreadsheet programs. You may also copy and paste data
records within WinCC Configuration Studio.
Note
It is not possible to cut an entire table row from the data area.

Procedure
Copying and pasting in the data area
1. Select the data records to copy.
2. Select "Copy" from the shortcut menu, or press <CTRL+C>.
3. Click the position in the data area where you want to paste the data records.
4. Select "Paste" from the shortcut menu, or press <CTRL+V>.
Copying and pasting in external applications
1. Select the data records to copy to the external application and then select "Copy" from the
shortcut menu, or press <CTRL + C>.
2. Open the external application where you want to paste the data records.
3. Click the position in the external application area where you want to paste the data records.
4. Use the commands of the external application to paste the data records from the clipboard.

14.3.5.9

Undoing an action
You can undo entries and changes in the data area with the <Ctrl + Z> shortcut.
Note
Certain actions cannot be undone. These exceptions are described in the respective editors.
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14.3.5.10 Importing data records
Introduction
You can import data records from third-party applications or other WinCC projects in the
WinCC Configuration Studio. These data records must be available in "Office Open XML
Workbook" format. Files of this format have the ".xlsx" extension and can be opened and edited
in spreadsheet programs.
Note
You cannot undo the import of data records.

Requirements
● The data records you load may not be in use by any other application.
● The connections contained in the data records must be available by their name in
WinCC Configuration Studio.

Procedure
1. Select the required editor in the navigation area.
2. Select "Import" from the shortcut menu of the editor.
The "Select file" dialog opens.
3. Select the file to import.
The data records will be loaded. A progress bar is displayed.

14.3.5.11 Exporting data records
You can either export all data records of a node selected in the navigation area during export
or only export the data records selected in the data area.
Exporting all data records of the node
1. Select the required node in the navigation area.
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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Exporting selected data records
1. Select the required data records in the data area.
For selection options, see Selecting cells, areas, rows and columns (Page 69).
2. Select "Edit > Export" in the menu bar.
The "Export" dialog opens.
3. Select the storage location and enter a file name.
4. Select a file format under "File type".
Two file formats are available for the export:
– "Office Open XML Workbook" format
– "Text file" format
5. Click the "Export" button.
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14.4

Administering authorizations

14.4.1

Adding authorizations

Introduction
The User Administrator provides predefined default authorizations and system authorizations.
The number and type of the authorizations displayed depends on whether the option "Basic
Process Control" has been installed.
You can, if necessary, add additional authorizations in the User Administrator.

Procedure
1. Open the User Administrator in the WinCC Configuration Studio.
2. Select "User Administration" in the navigation area.
3. Select the "Authorization levels" tab in the data area.
The existing authorizations are displayed.
4. Enter the ID of the new authorization.
The ID must be between "1" and "999".
5. Enter the name of the new authorization.
The name can be no longer than 70 characters.
6. Enter the translation of the name in the corresponding columns, if necessary.
You can also manage the translations by means of the "Text Library" editor.
7. Select a user or a user group in the navigation area.
8. Assign the new authorization in the data area in the "Authorization" tab.

14.4.2

Deleting authorizations

Introduction
You can delete created authorizations in the "User Administrator" editor. You cannot delete
authorizations during runtime.
Deleted authorizations are lost for all registered users.
You cannot delete system authorizations numbered 1000 -1099.

Procedure
1. Select "User Administration" in the navigation area.
2. Select the "Authorization levels" tab in the data area.
The existing authorizations are displayed.
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3. Select the line containing the authorization you wish to delete.
4. Select "Delete" from the shortcut menu.
The authorization is deleted.

14.4.3

Plant-specific authorizations

Introduction
In PCS 7 projects, or in WinCC projects with "Basic Process Control", you may grant
authorizations for access to the entire plant, or limit these to specific areas.
Authorizations which are not plant-specific can only be granted to the user or group for the
entire plant.
Authorizations which are plant-specific can be granted to a user or group either for the entire
plant or for specific areas only.
Note
Making good use of authorization for individual areas
If it makes no sense to grant an authorization for individual areas, you cannot grant the
authorization for individual areas.
The authorization "System change", for example, should only be granted for the entire plant.

Requirement
● The OS Project Editor has been run for the WinCC project.
● Areas have been created for a WinCC project using the Picture Tree Manager.

2232

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Structure of the User Administration
14.4 Administering authorizations

Procedure
1. Select "User Administration" in the navigation area.
2. Select the "Authorization levels" tab in the data area.
The existing authorizations are displayed.

3. Select the authorizations that you want to enable for a specific plant.
4. Select each option in the "Plant-specific" column.
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5. Select a user or group in the navigation area.
In the data area, you can see the individual areas and authorizations in the "Authorizations"
tab.

6. For selected functions, activate the general enable or the enable for individual areas, for
example Area_1. Authorizations that are not configured plant-specific are grayed out in the
areas.

14.4.4

Overview of Authorizations

14.4.4.1

Default Authorizations

Introduction
The User Administrator contains predefined default authorizations and system authorizations.
Authorizations with lower numbers are not included in authorizations with higher numbers.
Each authorization functions independently. Authorizations are only effective in runtime.
The name of each authorization indicates the influence of the corresponding authorization.
However, the names do not indicate how the authorizations are actually used.

Accessing the authorizations
You can delete or edit all authorizations with the exception of "User administration". A member
of the "Administrator Group" always receives access to the "User Administration" authorization.
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Overview of default authorizations
No. 1: User administration
Users can access user administration and make changes.

No. 2: Value input
Users can enter values manually, for example in I/O fields.

No. 3: Process controlling
Users can operate processes.

No. 4: Picture editing
Users can change pictures and picture elements.

No. 5: Picture change
Users can trigger a picture change and open another configured picture.

No. 6: Window selection
Users can switch application windows in Windows.

No. 7: Hard copy
Users can make a hardcopy of the current process picture.

No. 8: Confirming messages
Users can acknowledge messages.

No. 9: Locking messages
Users can lock messages.

No. 10: Unlocking messages
Users can unlock messages.

No. 11: Message editing
Users can edit messages in the "Alarm logging" editor, for example with ODK.
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No. 12: Starting archive
Users can launch an archiving process.

No. 13: Stopping archive
Users can end archiving.

No. 14: Archive value editing
Users can configure the evaluation of archive tags.

No. 15: Archive editing
Users can control and change archiving.

No. 16: Action editing
Users can run and edit scripts, for example with ODK.

No. 17: Project manager
Users have unrestricted access to WinCC Explorer.

14.4.4.2

System authorizations

Introduction
System authorizations are generated automatically by the system. A user cannot edit, delete
or create new system authorizations. System authorizations can only be assigned to users.
System authorizations take effect in the configuration system and in runtime. In the
configuration system, for example, they prevent project access by a user not registered for
that project.

Overview of system authorizations
No. 1000: remote activation
Users can start and terminate runtime from another computer.

No. 1001: Remote configuration
Users can configure and edit the project from another computer.
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No. 1002: Web access - monitoring only
Users can open the project from another computer but cannot change or control it.

14.4.4.3

Basis Process Control Authorizations

Introduction
If the option "Basic Process Control" is installed, you can define area-specific access rights
for the users in the User Administrator. Predefined authorizations and areas of the configured
hierarchy from PCS 7 are available following processing by the OS project editor.
You can add, delete and change authorizations. The predefined authorizations cannot be
deleted or changed. Authorizations with lower numbers are not included in the authorizations
with higher numbers. Each authorization functions independently. Authorizations are only
effective in runtime.

Overview of authorizations with the "Basic Process Control" option
No. 1: User administration
Users can access user administration and make changes.

No. 2: Authorization for area
User can enable the selection of pictures in the authorized system areas.

No. 3: System change
Users can trigger a change of state, for example end runtime.

No. 4: Monitoring
Users can monitor but not control the process, for example selection of batch visualization.

No. 5: Process controlling
Users can operate processes.

No. 6: Higher process controlling
Users can perform control operations with permanent effects on the process, for example
modify the limit values of a controller.

No. 7: Report system
No longer used by the system.
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14.4.4.4

PCS 7 system authorizations

Introduction
System authorizations are generated automatically by the system. A user cannot edit, delete
or create new system authorizations. System authorizations can only be assigned to users.

No. 1100: Highest process controlling
Used with PCS 7 in combination with the Advanced Process Library only.

No. 1101: Extended operation 1
Used with PCS 7 in combination with the Advanced Process Library only.

No. 1102: Extended operation 2
Used with PCS 7 in combination with the Advanced Process Library only.
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14.5

Administering users

14.5.1

Creating a user group

Introduction
Users with the same access rights or areas are grouped together.
The User Administrator permits only one single group level. You cannot create any subgroups.

Inheriting authorizations
The authorizations of a group are inherited by the group members.
When you create a user in a group, the authorizations of the group are automatically applied
with your settings to the user. You can adapt the authorizations for individual users later.
Changes of the group authorizations at a later time are not inherited by the users.

Procedure
1. Select "User Administration" in the navigation area.
2. Select the "Groups" tab in the data area.
3. Enter the name of the new group in the "Group name" column.
The name must consist of at least four characters.
A group name can only be assigned once.
4. Select the new group in the navigation area.
5. Assign the required authorizations in the "Authorization" tab.

14.5.2

Setting up users

Introduction
You add a user to a group so the user can log on in Runtime with his logon.
The assigned authorizations grant the user access to functions and areas in Runtime.
All authorizations of a group are inherited by the group members when you create the user.
Changes of the group authorizations at a later time are not inherited by the users. If you want
to apply group authorizations, copy the lines of the relevant authorizations and paste them for
the user.
After creating a user, you can assign individual authorizations to this user.
You may use Unicode characters for the user name and password. For restrictions, refer to
"Working with projects > Appendix > Illegal characters".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2239

Structure of the User Administration
14.5 Administering users

User names
A user name can only be assigned once.
The length of the user name is limited to a maximum of 24 Unicode characters.
If you wish to display the user names in messages, limit the user names to a maximum of 16
characters. The length in the "User name" system block is limited to 16 characters in the
message system.

Passwords
The password must be between 6 and 24 Unicode characters in length.
Make sure that the passwords meet the standard security guidelines, for example:
● Use of uppercase and lowercase letters
● Use of special characters
● Minimum number of characters.

Procedure
1. In the navigation area, select the group in which you want to create a new user.
2. In the "User" tab, enter the user name or the login in the "User name" column.
A color coding in the "Password" column indicates that you have not yet assigned a
password for the user.
3. Click the field and the "..." button displayed in it
The "Change password" dialog opens.
4. Enter the password. Enter the password again to confirm.
The quality of the password is displayed during the input.

5. Close the dialog with the "OK" button.
The currently set authorizations of the group are applied to the user.
To change the user authorizations, select the user in the navigation area and enable the
required authorizations in the data area.
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14.5.3

Administrating users

Introduction
The following user-related management tasks are available in the User Administrator:
● Changing the user name.
● Changing the password of a user.
● Copying a specific user with settings.
● Moving a user to another group.
● Deleting a user.
● Defining a user for WinCC service mode
Note
A user name can only be assigned once.

Management of user data
To configure the properties of a user in the User Administrator, select one of the following
procedures:
● Configure in the shortcut menu of the user in the navigation area.
● Configure in a table column of the "User" tab if "User Administrator" is selected in the
navigation tree.
● Configure the properties viewlet of the user.
In the described procedures, use the shortcut menu or configure the settings in the "Properties
- User" viewlet.
Activity

Shortcut menu in the
navigation area

Column in the data area

"Properties - User" viewlet

Copying and pasting users

X

X

---

Deleting a user

X

X

---

Renaming a user

X

X

X

Changing a password

---

X

X

Changing a group

---

X

X

Configuring automatic logoff

---

X

X

Configuring logon with a tag

---

X

X

Configuring web access

---

X

X

Exporting user data

X

X

---
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Activity

Shortcut menu in the
navigation area

Column in the data area

"Properties - User" viewlet

Specifying WinCC
ServiceMode

X

---

---

Specifying "Write to Chip
Card"

X

X

X

1) Select the line of the user or multiple users and "Export" in the shortcut menu.

Requirement
The user was selected in the navigation area.

Changing a user name
1. Select the user in the navigation area.
2. Change the name in the "User names" field.
After changing the name, you must enter a new password.

Changing a password
1. Select the user in the navigation area.
2. Click the "Password" field and the "..." button displayed in it. The "Change password" dialog
opens.

3. Enter the new password. Enter the password again to confirm.
The quality of the password is displayed during the input.
4. Close the dialog with the "OK" button.

Copying Users
1. Select the user you wish to copy in the navigation area.
2. Select the "Copy" option from the shortcut menu.
3. To create a copy of the user, select the "Paste" option in the shortcut menu of the required
group.
4. Configure the password of the new user.
5. Change the properties and authorizations, if necessary.
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Moving a user to another group
1. Select the group with the user in the navigation area.
2. In the "Group name" column of the data area, select the desired group from the drop-down
menu.
The user is moved. The settings and authorizations are retained.

Deleting a user
1. Select the user in the navigation area.
2. Delete the user with the <Del> key or select the "Delete" option in the shortcut menu.

Defining users for WinCC service mode
WinCC Runtime can also be run on the computer in WinCC ServiceMode when no Windows
user is logged on to the computer. Interactive user inputs are not possible. Authorizations are
not checked.
If you still need an authorization check in WinCC ServiceMode, you can define a special user
for this purpose. The authorizations of this user are checked in Runtime if no Windows user
is logged on.
Requirement
The WinCC ServiceMode is configured.
Procedure
1. Select the user in the navigation area.
2. In the shortcut menu, select the "User in Service Context" option.
The user receives his own icon.

14.5.4

Administrating user groups

Introduction
The following user group-related management tasks are available in the User Administrator:
● Changing the group name.
● Deleting a group.
Note
A group name can only be assigned once.
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Changing a group name
1. In the navigation area, click the group to which you want to assign a new name.
2. Click on the group name again. The name appears in a text window. Enter the new name.
3. Confirm the new name by pressing the ENTER key.

Deleting a group
1. In the navigation area, click the group you want to delete.
2. Select the "Delete" option in the shortcut menu.
If users are created in the group, a dialog opens in which you confirm the deletion. Confirm
with "OK".
The group and the users included in it, if any, are deleted.

14.5.5

Administering users for web access

Introduction
You will have to configure the web options in the User Administrator if users are to access the
WinCC project via the Internet/Intranet.

Requirement
● The WinCC process pictures were published using Web View Publisher.
● The user or user group has been created.
● The user or user group authorizations have been specified.

Procedure
1. Select a user or a group in the navigation area.
2. Select the "WebNavigator" option in the "Properties" viewlet.
3. Click "..." to select the start picture for the user or group.
You can only select published pictures as start pictures.
4. Select the desired Runtime language for the user or group.
The languages configured in the Text Library are available for selection.
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14.6

Configuring automatic logout

Introduction
You can define a period of time after which a logged in user is automatically logged out. This
prevents unauthorized persons from having unlimited access to the system following control
operations by the user currently logged in.
Note
If you have selected the "SIMATIC Logon" option, you will only be able to set automatic logout
for the group. The setting will automatically be applied to each user in this group.
Automatic logout is deactivated if a user logs on with a chip card.

Overview
You can configure automatic logout for a user with one of the following scenarios:
● The user remains logged on until the system is shut down or another user logs on.
Select the setting "None" for the logout. Automatic logout is deactivated.
● The configured time until automatic logout is counted from the time the user logs on.
The time will expire irrespective of user actions during this time. Activate the "Absolute"
option and enter a time in minutes.
● The configured time is counted from the last time the user operates keyboard or mouse.
The user is automatically logged out after this pause.
Select the "Inactive" option for automatic logout and enter a time in minutes.

Procedure
1. Select a user or a group in the navigation area.
2. Select the value "Absolute" or "Inactive" in the field "Type of automatic logoff" of the
"Properties" viewlet.
3. Enter a time in minutes in the field "Period of time before automatic logoff".
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14.7

Configuring logon with a tag

Introduction
A user can log on with a key-operated switch, for example, instead of via the logon dialog.
Configure the "Tag logon" function to allow a user to log on or off a WinCC computer with a
tag.
If a user is logged on to the system with a tag, it is not possible for a user to log on at the same
computer using the logon dialog.
Note
Tag logon is not possible if you are using SIMATIC Logon.

Configuration steps
Follow the configuration steps below to log on via a tag:
1. Assign a configured tag to a computer. You have two options:
– Assign the same tag to all computers
– Assign a separate tag to each computer
2. Define the tag value range.
3. Assign a specific tag value to a user.

Properties of the logon tag
Tag types
The following tag types are permitted:
● Binary
● 8-bit value
● 16-bit value
● 32-bit value
Limits
Each user who logs on using a tag is assigned a separate tag value. The number of users with
"Tag logon" is therefore limited by the number of tag values.
To specify the number of possible values, configure a low and a high limit of the tag value. The
value range depends on the tag defined.
● Low limit: The maximum value range possible ranges from "0" to "32767".
● High limit: The maximum value range possible ranges from "1" to "32768".

2246

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Structure of the User Administration
14.7 Configuring logon with a tag

Procedure
1. Select the "User Administration" entry in the navigation area.
2. Select a computer in the "Computer name" field of the "Properties - User Administrator"
viewlet.
The list includes the computers available in the project.
3. Open tag management with the "..." button in the "Tag name" field.
4. Select the tag you want to use.
5. Enter the minimum value of the tag in the "Low limit" field.
6. Enter the maximum value of the tag in the "High limit" field.
7. Select a user in the navigation area.
8. Select a tag value in the field "Value of the tag logon".

Result
The assigned user is logged on to the system when the tag equals the configured value.
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14.8

Configuring operator authorization

Introduction
An operator authorization is configured for an object property to protect the object from access.
Only users with this authorization can operate the object.

Example: Operator authorization for a button
1. Create a button in the Graphics Designer.
2. Open the "Authorizations" dialog in the configuration dialog or in the "Miscellaneous"
properties via "Authorization".
The created authorizations are displayed in numerical order.

3. Select an authorization.
Operation of the button in runtime is now only possible for users with the corresponding
authorization.
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14.9

Logging on as user

Introduction
The logon dialog appears in runtime if there is no user logged on in runtime.
Note
Logging on can take several minutes if a large number of authorizations have been assigned
per user.

Requirements
● You have created users with user name and password in the User Administrator.
● You have assigned the users authorizations in the User Administrator.
● You have defined shortcut keys for logon. Shortcut keys are configured in WinCC Explorer
on the "Hotkeys" tab under project properties.

Procedure
1. Start WinCC Runtime.
2. Press the shortcut keys you have defined for logon. The logon dialog opens.
3. Enter the logon name and the password in the dialog.
Note
Passwords are case-sensitive.

Result
The system checks the rights assigned against the authorizations of the editors and configured
objects. It releases the objects for use if the authorizations correspond.
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14.10

Logon with a chip card

Introduction
In the "Properties" viewlet in the User Administrator, you can define whether the user or a
group is to be able to log on with a smart card.

Requirements
● The "Chip card" option has been installed.
● An interface has been assigned to the chip card reader.
● The "SIMATIC Logon" option is not activated in the User Administrator.

Reference
You can find additional information on the "Chip card" option in the WinCC information system
under "Options > Options for Process Control > Chip Card Reader".

Logon with chip card
To log on in WinCC, the user inserts his chip card into the card reader. The required data is
read out. The user remains logged on to the system until he removes the card from the card
reader.
It is not possible to log on manually while there is a card in the card reader.
The automatic logoff function is disabled when you use the chip card.
Note
No Windows administrator rights are required to write to, check or use chip cards.
For writing to and reading a chip card, the chip card reader must be connected to the computer
before WinCC is started.
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14.11

Central user administration with SIMATIC Logon

14.11.1

Overview of SIMATIC Logon

Introduction
SIMATIC Logon enables central and system-wide user administration. This simplifies system
validation for access protection pursuant to FDA 21 CFR Part 11.
Install the basic package "SIMATIC Logon Service" on all participating computers if you wish
to implement SIMATIC Logon for WinCC.
Note
Detailed information on function and installation of the SIMATIC Logon Service may be found
in the respective current manual "SIMATIC Logon and Electronic Signature".

Principle
The user groups and their authorizations are configured in the User Administrator. You must
give the user groups the same names in WinCC as on the SIMATIC Logon server. The
authorizations are then assigned to the user groups in runtime.
You do not create users in WinCC as the users are dynamically imported from the SIMATIC
Logon server during the logon process. Each logon and each password change is transferred
to SIMATIC Logon from WinCC and processed.
The users already saved in the User Administrator are ignored. Only the user groups together
with their settings are used.
Note
With WinCC V7.3, SIMATIC Logon is used in version V1.5 SP2. SIMATIC Logon is fully
integrated in WinCC.
Prior to WinCC V6.2, SIMATIC Logon had to be entered as "wincclogonconnector_x.exe" in
the WinCC startup list. The entry "wincclogonconnector_x.exe" is deleted from the startup list
when you open the migrated project with WinCC V7.3.
You are not permitted to manually re-insert the "wincclogonconnector_x.exe" entry into the
startup list.

See also
How to use SIMATIC Logon with WinCC (Page 2253)
Windows settings for SIMATIC Logon (Page 2252)
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14.11.2

Windows settings for SIMATIC Logon

Introduction
Access protection of "SIMATIC Logon Service" is based on mechanisms of the Windows
operating system. The following section summarizes what you need to watch for in Windows
settings. Windows administrator rights are required to make settings.

Windows Settings for SIMATIC Logon Service
Make the following Windows settings to ensure the smooth operation of SIMATIC Logon:
● If you have configured a "Logon Computer of the SIMATIC Logon Group" as the work
environment, you must enable access to the computer via the network.
● If you have configured a "Windows Domain" as the work environment, you must assign
"Read" and "Change Password" rights to authenticated domain users.
● No specific settings are necessary if a single-user computer is used.
● If you wish to display and log the user names in WinCC, enter the user name of each user
under "Local Users and Groups/Complete Name".
● If logon processes are to be recorded, you must specify the following settings in the "Audit
Policy" of the "Local Security Policy":
– Audit logon events
– Audit logon attempts
● The following settings for user accounts may be specified in the "Account Policy" of the
"Local Security Policy":
– Password policy: e.g. maximum password age, minimum password length
– Account lock policy
Note
Users of SIMATIC Logon must be direct members of a Windows group. Users may not be
members of a sub-group of a Windows group.

Failure of a SIMATIC Logon server
If you work with a logon server for the SIMATIC Logon Service, we recommend the following
measures are taken in case the server fails:
● Install all users with the necessary authorizations on a second computer, e.g. the local
computer.
● Select the relevant computer under "Logon to" in the "Configure SIMATIC Logon" logon
dialog.
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14.11.3

How to use SIMATIC Logon with WinCC

Introduction
To use the "SIMATIC Logon Service" with WinCC, follow these steps:
1. Configure settings in Windows user administration.
2. Configure settings in the User Administrator.
3. Configure visualization of logged-on user.
4. Configure logon with SIMATIC Logon.
Note
The option "Basic Process Control" must be installed if you wish to use the
"PASSLoginDialog" function.
If you are using "SIMATIC Logon" in PCS 7 projects and the users want to logon by means
of chip card, you must first configure the following items:
● Open the picture "@Welcome.PDL".
● Customize the C script in the object properties under "Event/Picture-Object/Others/Select
Picture" by commenting out the "PASSLoginDialog (Screen);" line.
● Save the "@Welcome.PDL" picture.

Requirements
● SIMATIC Logon Service has been installed.

Configuring settings in Windows user administration
The connection between Windows user administration and WinCC user administration is
based on identical user group names.
1. Create the user groups, for example, "GroupOperator".
2. Create the users and assign them to a group. Users must be direct members of a user
group and may not be members of a sub-group.

Configuring settings in the User Administrator
1. Create groups with the same names, for example, "GroupOperator", in the User
Administrator.
2. Select the entry "User Administrator" in the navigation area and activate the "SIMATIC
Logon" option in the properties.
3. Define the authorizations for the groups.
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Configuring visualization of the logged-on user in runtime
Visualization during WinCC projects
If you wish to display the logged-on user in a process picture or report in a WinCC project, use
one of the following two tags:
Tag

Display in WinCC

Names in
Windows User Administration

@CurrentUser

User ID

User name

@CurrentUserName

User name

Full Name

Note
If you do not use the "SIMATIC Logon" option, the user ID of the logged-in user is entered in
both tags.
Visualization in LTO-/PCS 7 projects
In the OS project editor, select whether the full user name or the user ID of the logged-in user
is to be shown in the system summary display.
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Configuring logon with SIMATIC Logon
1. Configure a button in any picture in the Graphics Designer to call the logon dialog "SIMATIC
Logon Service" in runtime.
2. Link the event "Mouse Click" with a C action. If you call the function "PASSLoginDialog"
within this C action, a click of the button opens the registration dialog.

Once his data has been entered, a user is assigned to the WinCC group with the same name
as the Windows group. The user then receives the access rights of the WinCC group.
Note
Passwords are case-sensitive.

14.11.4

How to configure an electronic signature

Introduction
You can use an electronic signature to make the execution of critical operation dependent on
the electronic signature of the user. A given action can only be carried out when the configured
user is authenticated with a password. If the user is not authorized or enters an incorrect
password, the action is not performed. Passwords are case-sensitive.
Successfully and aborted signing procedures are documented with a message.

Requirements
● The basic package for the "SIMATIC Logon Service" is installed on all computers involved.
● The "SIMATIC Logon" option has been activated in the "User Administrator".
● The user must be a direct member of a Windows group and be included the WinCC User
Administration.

Configuring an electronic signature
● You can configure an electronic signature for any WinCC object events. For example, a
click of the mouse on a button opens the dialog for operator authentication.
● Use the "CCESigDlg" object and call the "ShowDialog" function to set event dynamization.
A VBS action and C action is then created on the pages that follow.
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● Configure the desire action by evaluating the return value. For example, make the output
command dependent on the success of authentication.
● Configure a WinCC alarm control to have the authentication attempt messages displayed.

Result
Messages documenting all authentication attempts are generated in runtime following operator
authentication.

If you use the "WinCC/Audit" option, the messages for all authentication attempts are also
written to audit trail databases.

14.11.5

Creating an electronic signature in a VBS action

Introduction
The VBS example shows you how to protect a process control operation from unauthorized
execution with an electronic signature. Calling the "ShowDialog" function opens a dialog in
runtime in which the user can be authenticated. Make the output command dependent on the
success of authentication.

Syntax of the "ShowDialog" function

Expression.ShowDialog(User As String, DisplayedUser As String,
Domain As String, LangID As Long, Comment As String) Long
Expression
Required. An expression that returns an object of the "CCEsigDlg.ESIG" type.
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Parameter
Parameter

Description

User

User name that is used to authenticate the user.

DisplayedUser

Name of the user that is displayed in the "User name" field of the "SIMATIC Logon
– Electronic Signature" dialog box.

Domain

Name of the computer that authenticates the user:
- Name of the computer that administers the users centrally (SIMATIC Logon
server)
- Name of the local computer
The local computer is entered automatically if no other name is entered.

LangID

ID for the language variant of the dialog:
1028 – Chinese (traditional)
1031 – German
1033 – English
1034 – Spanish
1036 – French
1040 – Italian
1041 – Japanese
1042 – Korean
2052 – Chinese (simplified)

Comment

Comment entered by the user.

Return values
Return value

Identifier

Description

1

IDOK

The user has been successfully authenticated.

2

IDCANCEL

The user has closed the dialog box using the "Cancel" button.

3

IDABORT

The user has failed 3 times to authenticate himself.

Example: Output of a dialog for authenticating the user without forced comment

Sub
Dim
Dim
Dim

OnClick(ByVal Item)
myesig
mycomment
ret

Set myesig = CreateObject("CCEsigDlg.ESIG")
'comment optional
myesig.forcecomment = false
ret = myesig.showDialog("winccadmin","winccadmin","SIMLOGSERV",1031,mycomment)
.
.
.
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End Sub

Result
The following dialog for authenticating the user is displayed when the VB script is executed in
runtime:

The input of a comment in the entry field is optional.
You can set various different reactions to the mouse event of the WinCC object depending on
the transferred return value "ret".
A message documenting authentication or the authentication attempt is also generated.
Note
Protect the VBS action with a password from unauthorized modification and viewing of the
program code.

14.11.6

Creating an electronic signature in a C action

Introduction
The C script example shows you how to protect a process control operation from unauthorized
execution with an electronic signature. Calling the "ShowDialog" function opens a dialog in
runtime in which the user can be authenticated. Make the output command dependent on the
success of authentication.
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Syntax of the "ShowDialog" function

INT ShowDialog(char* lpszUserName, char* lpszDisplayedUserName,
char* lpszDomainName, int intLangID, variant* vtComment);

Parameter
lpszUserName
User name that is used to authenticate the user.
lpszDisplayedUserName
Name of the user that is displayed in the "User name" field of the "SIMATIC Logon – Electronic
Signature" dialog box.
lpszDomainName
Name of the computer that authenticates the user:
- Name of the computer that administers the users centrally (SIMATIC Logon server)
- Name of the local computer
The local computer is entered automatically if no other name is entered.
intLangID
Identifier for the desired language variant of the dialog box:
1028 – Chinese (traditional)
1031 – German
1033 – English
1034 – Spanish
1036 – French
1040 – Italian
1041 – Japanese
1042 – Korean
2052 – Chinese (Simplified)
vtComment
Comment entered by the user.

Return value
Return value = 1
The user has been successfully authenticated.
Return value = 2
The user has closed the dialog box using the "Cancel" button.
Return value = 3
The user has failed 3 times to authenticate himself.
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Example: Output of a dialog for authenticating the user with forced comment

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
int nRet = 0;
VARIANT vtComment;
__object* EsigDlg = __object_create("CCESigDlg.ESIG");
if (!EsigDlg)
{
printf("Failed to create Picture Object");
return;
}
nRet = EsigDlg->ShowDialog("winccadmin","winccadmin","SIMLOGSERV",1033 ,&vtComment);
__object_delete(EsigDlg);
.
.
.
.
}

Result
The following dialog for authenticating the user is displayed when the C script is executed in
runtime:

In this example, the entry of a comment is mandatory. If a comment is not mandatory, you
must include the property in the function with "EsigDlg->forcecomment =FALSE".
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You can set various different reactions to the mouse event of the WinCC object depending on
the transferred return value "nret".
A message documenting authentication or the authentication attempt is also generated.
Note
Protect the C action with a password to prevent unauthorized modification and viewing of the
program code.

14.11.7

Notes on WinCC/PCS7-OS integration

Access rights of the logged-on user
Access rights are defined by the group membership in the User Administrator:
● If the user can be authenticated, he is automatically assigned to the "Emergency_Operator"
group by SIMATIC Logon.
● If the user belongs to one or more Windows groups and
– One of the groups has the same name as a group in the User Administrator, the user
is assigned the rights of this group.
– Multiple groups have the same names as groups in the User Administrator, the user is
assigned the rights of all of these groups.
Note
If a user belongs to multiple Windows groups and the groups have different values for
the automatic logoff, the user is logged off after the longest configured time.

Group "DefaultGroup"
In the configuration dialog of SIMATIC Logon, you can activate the "Use following data without
explicit logon" in the "General" tab. If there is no user logged into Runtime at a workstation,
the selected user is automatically logged on in the "User" field. The "Default user" from the
"DefaultGroup" is preset by default.
Note
The "DefaultUser" is a virtual user belonging to the "DefaultGroup". That is why you may not
add this user to the Windows user administration.
If the names are identical, the "DefaultGroup" is assigned to the corresponding group in the
User Administrator. You should therefore create a group in the User Administrator with the
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name which was entered for the "DefaultGroup" user group in the logon dialog. Assign this
group authorization level "No. 2 Authorization for area".
Note
Defaults settings for message filtering in the OS project editor
Any user can acknowledge the messages on the message pages if you run the OS project
editor with the default message display setting "Messages with area release".
The default setting applies even for the "Default user" logged on via SIMATIC logon, who
generally has authorization level "No. 2 Authorization for area". You should therefore activate
the option "Acknowledgeable messages in separate list" on the "Message display" tab before
processing by the OS project editor.
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Integration of WinCC in SIMATIC Manager

Content
WinCC projects can be created and managed in STEP 7 within the framework of Totally
Integrated Automation. This results in connections between the AS configuration and WinCC
configuration. The advantages of this "WinCC in STEP 7 integration" are described in this
chapter.
The subjects covered in this chapter are:
● Managing WinCC Projects and Objects in STEP 7
● Transferring Tags and Texts to WinCC
● Selection of STEP 7 Symbols
Diagnostic Support in the Event of Faults
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15.2

Advantages and Prerequisites of Integration

Introduction
The goal of an integration of automation components is the configuration and management of
a shared platform. STEP 7 makes such a platform available to the SIMATIC Manager.
Configuration is made a lot easier with the integration of SIMATIC WinCC and processes can
be automated.

Advantages of Integration
The configuration of SIMATIC WinCC in an integrated environment provides the following
advantages:
● Simple transfer of tags and texts into the WinCC project
● Direct access to STEP 7 symbols during process connection
● Uniform message configuration
● Loading the configuration data on the Runtime OS
● Extended diagnostic support

Advantages of integration for redundant systems
Integration simplifies the administration of master and standby:
● Inserting and Parameterizing Master and Standby
● Configuring Master and Standby
● Overall Loading of Master and Standby
Integration enables loading online changes in case of redundant system:
● Loading online changes is automatically enabled after overall loading.
● Automatic checking of settings and requirements with detailed error messages.
● Both partners must be in Runtime. Standby is loaded first.
● Automatic cancellation while loading on redundant system if the initial load on standby has
failed

Notes on installation
If you wish to integrate WinCC in STEP 7, you must implement an installation of WinCC as
well as an installation of SIMATIC STEP 7. For a new installation we recommend the following
sequence of installations:
● Installation of SIMATIC STEP 7
● User Defined Installation of WinCC
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In the described sequence you may install the required WinCC components at the same time.
You may also install SIMATIC STEP 7 at any time thereafter. You might then have to install
individual WinCC components afterwards.
Note
For the installation of SIMATIC STEP 7 and WinCC, please read the notes in the installation
manual.

Required Software Components
You must install the following communication components for integration of WinCC in STEP
7:
● SIMATIC Device Drivers
● Object Manager
● AS-OS Engineering
● STEP7 Symbol Server
You must also install the WinCC option "Basic Process Control".
If you wish to use a chip card reader, you must activate the option Chip Card during the
installation of SIMATIC STEP 7 and during the installation of WinCC.
Note
Prior to implementing any WinCC-specific configurations in SIMATIC Manager, you must
ascertain that the language used in SIMATIC Manager is installed in WinCC as well.
Note
Starting with version V6.2, WinCC evaluates the project-related access protection that is used
to protect STEP 7 or PCS7 projects.
Independent of access protection:
WinCC Projects that are integrated in a STEP 7/PCS7 project cannot be opened using an
ES where only WinCC has been installed. For that you also need STEP 7 or NCM PC Edition
of SIMATIC NET CD on the ES.
If project-related access protection has been activated for WinCC project, then you must also
enter the STEP 7 project password while opening the project.
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15.3

Managing WinCC Projects and Objects in the SIMATIC Manager

15.3.1

Managing WinCC Projects and Objects in the SIMATIC Manager

Introduction
The SIMATIC Manager can be used to organize and administrate all the components belonging
to the automation solution. Accessing these components in a common data management
system makes system configuration much easier and allows a number of configuration
processes to be automated.
WinCC projects as WinCC application or OS
You can create WinCC projects directly in the SIMATIC Manager. In this case, you have to
differentiate between the following storage options:
● WinCC project as WinCC application within a PC station
● WinCC project as operator station OS
When creating new projects, you should use WinCC applications. They have the following
advantages compared to the OS:
● The PC station can be displayed and parameterized in the network configuration.
● The interfaces and access point of the operator station are determined automatically.
OS reference
Using OS references offers the advantage of loading one WinCC project, the so called basis
OS, onto several target systems. One target system is attached to each basis OS as well as
for each individual reference.
The basis OS must have the following properties:
● Object type OS in the STEP 7 project
● Project type "Single-User" or "Multi User"
● No redundant partner
● The OS reference and the basis OS must be created in the STEP 7 sub-project.
After processing, you must transfer the project to the target system of basis OS along with all
the references. Select the "Download to CPU" function for the selected basis OS or OS
reference.
The objects "WinCC Appl. Ref." und "OS Ref." are used for configuration.
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An OS reference supports neither clients with own project nor clients without own project.
Note
How to configure the PC station is described in the STEP 7 help.
It is recommended not to store and edit STEP 7 projects with integrated WinCC projects at
an operator station.
If you work in SIMATIC Manager with technological views, all WinCC editors must be closed.
WinCC projects created or managed using SIMATIC Manager should not be copied using
the Project Duplicator.
Multi-projects have the following restriction:
Do not move any basis OS from a STEP 7 sub-project to another STEP 7 sub-project. While
moving, you will lose all associated OS reference stations their reference to basis OS.
Integration allows you to execute functions in the WinCC project directly from the SIMATIC
Manager. These include:
● Opening the WinCC project
● Loading the WinCC project on the target computer
● working with the WinCC objects "Pictures" and "Report Templates"
The Import OS function in the SIMATIC Manager allows to import independent WinCC projects
into a STEP 7 project.
Prohibited project constellations
No all theoretically imaginable project constellations are practical or allowed in the SIMATIC
Manager. The following constellations are prohibited on the engineering station:
● A multi-user project to be operated in Runtime, although its package is loaded on another
server.
● A single-user project or multi-user project to be operated in Runtime, but has been swapped
out to the central archive server.

Activating Runtime on ES
Activating Runtime with integrated WinCC project on the ES can be influenced centrally.
In WinCC Explorer select the item "Project Properties" in the shortcut menu of the current
project. In the Options tab, activate the "Allow activation on ES" checkbox .
The checkbox is unchecked when you insert a new WinCC project.
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You can activate the WinCC project on the ES if the checkbox is activated.
Requirements
● The WinCC project is a TIA Project.
i.e. the WinCC project is integrated in a STEP 7 project or PCS7 project.
● The corresponding destination path is configured.
If the WinCC project is not a TIA project or the corresponding destination path has not been
configured in ES, then the checkbox does not have any effect. In such a case, the project can
be activated at any time.
Editing orders in SIMATIC Manager in parallel
You can edit several orders in SIMATIC Manager in parallel. You can use SIMATIC Manager
to load a target system and simultaneously create a new WinCC application in the "HW Config"
dialog. The parallel editing of a WinCC project with WinCC Explorer is also permitted.
If one of the orders cannot be executed at the current time, you will be notified via an error
message. You can then trigger the cancelled job again at a later point in time.
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See also
Working With WinCC Objects (Page 2295)
Operator Station OS (Page 2284)
WinCC Application (Page 2269)

15.3.2

WinCC Application

15.3.2.1

WinCC Application

Introduction
In a STEP 7 project, the SIMATIC PC station represents a PC which, similar to the automation
station AS, contains the software and hardware components required for automation. Apart
from communication processors and slot or soft PLCs, these components also include
SIMATIC HMI components.
If a PC station is to be implemented as an operator station, you must add a WinCC application
during configuration. You can choose between various project types, depending on the
respective requirements:
● Master server in the multi-user project. The name in the PC station is "WinCC Appl.".
● Standby server as redundancy partner in the multi-user project. The name in the PC station
is "WinCC Appl. (Stby.)".
● Client in the multi-user project. The name in the PC station is "WinCC Appl. Client".
● Reference to a so-called basis OS. The name in the PC station is "WinCC Appl. Ref".
● Reference to a so-called base client. The name in the PC station is "WinCC Appl. Client
Ref.".
● Central archive server (master server or non-redundant archive server). The name in the
PC station is "WinCC CAS Appl.".
● Central archive server (standby server). The name in the PC station is "WinCC CAS Appl.
(Stby.)".
● Connectivity station, or Open_PCS7_Station. The name in the PC station is "SPOSA Appl.".
The screenshot below shows an example of how the WinCC applications appear in the
SIMATIC Manager:
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Note
If you use the PROFIBUS or Industrial Ethernet for communication between AS and OS, you
should configure an appropriate connection. Only then can you utilize the advantages of the
PC station, e.g. automatic setting of the unit name.

See also
How to Create an Operator Station (Page 2285)
Operator Station OS (Page 2284)
How to Create a Reference to a WinCC Application (Page 2281)
How to Load the Project on the Target Computer (Page 2280)
How to Set the Path to the Target Computer (Page 2273)
How to Create a WinCC Application (Page 2270)

15.3.2.2

How to Create a WinCC Application

Introduction
This section shows you how to create the WinCC application in a PC station.
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Requirements
● A PC station must have been created in the STEP 7 project.

Procedure
1. Open the hardware configuration for the PC station. To do so, click the PC station in the
navigation window. Select the Open Object option on the pop-up menu.
This will open the HW Config dialog.
2. Click the object PC in the contents window.
Open the hardware directory using the menu item View > Catalogue and navigate to the
folder SIMATIC PC Station > HMI.
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3. Select the desired type of WinCC application and drag it onto a free slot of the PC object.

4. Save and close the hardware configuration.
Upon saving the newly created WinCC application, a subordinate OS is created.

See also
How to Create an Operator Station (Page 2285)
Operator Station OS (Page 2284)
How to Load the Project on the Target Computer (Page 2280)
How to Select the Standby Computer (Page 2277)
How to Set the Path to the Target Computer (Page 2273)
WinCC Application (Page 2269)
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15.3.2.3

How to Set the Path to the Target Computer

Introduction
To be able to load the WinCC project, you must set the path to the target computer in the object
properties.
The following description refers to an OS in a WinCC application. For other OS types, the
dialog structure might differ.
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Requirements
● The OS is created as an object of a WinCC application.

Procedure
1. Select the WinCC project and open the "Object Properties" using the pop-up menu.
2. If you wish to configure an OS of type OS, select the Target OS and Standby OS tab.
If you wish to configure an OS of type OS (Client), select the Target OS tab.
The following figures refer to an OS of type OS created in a WinCC application.
You can enter the path to the target computer directly as shared directory in the format \
\<Computer name>\<Enable>. Following the direct entry, click the Apply button. The WinCC
project directory and the project file will be supplemented.
Alternatively, you can open a selection dialog by clicking the Browse button.
If you have entered the path directly, continue with step 4.
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3. Click the "Browse..." button. In the Select Target OS dialog, select the network drive and
the folder you require. Click "Open".

4. Check the path to the target computer and then close the Properties dialog.
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Note
The function "Generating/Updating Archive Tags" may only be used jointly with PCS7.
Additional information on this function may be found in the configuration manual Process
Guidance System PCS7, Operator Station in the PCS7 documentation.

See also
How to Create an Operator Station (Page 2285)
Operator Station OS (Page 2284)
How to Load the Project on the Target Computer (Page 2280)
How to Select the Standby Computer (Page 2277)
How to Create a WinCC Application (Page 2270)
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15.3.2.4

How to Select the Standby Computer

Introduction
If you configure a redundant system, the master server and the standby server must be
connected to each other. You set up this connection in the object properties for the master
server.
Note
The WinCC project of the standby server is a copy of the WinCC project on the master server.
Both projects must be identical to ensure correct data synchronization in Runtime. For this
reason, direct configuration of the standby project is not possible in the SIMATIC Manager.

Requirements
● The master server must have been created as WinCC Application.
● The standby server must have been created as WinCC Application (Stby.).

Procedure
1. Select the master project and open the "Object Properties" using the shortcut menu.
2. Select the "Target OS and Standby OS Computer" tab.
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3. Select the standby OS and then close the dialog with "OK".

2278

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Integration of WinCC in SIMATIC Manager
15.3 Managing WinCC Projects and Objects in the SIMATIC Manager
4. Check the name of the assigned standby OS in the SIMATIC Manager: It must consist of
the name of the master OS with the add in "_StBy".

5. Please note that the path to the target computer must also be set in the properties of the
standby OS. In the properties of the standby OS, check the assignment to the master OS.
The field for the master OS must display the name of the master OS.
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Note
In the master OS project, the redundancy is given default settings by the system. You have
to perform different settings from this in the master OS project. You use the "Redundancy"
editor for this purpose. It is advisable to make these settings on the creation system; no
configuration is then necessary on the target computers.

See also
How to Create an Operator Station (Page 2285)
Operator Station OS (Page 2284)
How to Load the Project on the Target Computer (Page 2280)
How to Create a WinCC Application (Page 2270)

15.3.2.5

How to Load the Project on the Target Computer

Introduction
When you have completed configuration, you must load the WinCC project on the target
computer. To do so, use the "Load Target System" function of SIMATIC Manager.
If you have built-up a redundant operator station, then Master server and Standby server will
be loaded one after the other. The standby server is loaded together with a copy of the WinCC
project of the master server. Both projects must be identical to ensure correct data
synchronization in Runtime. For this reason, direct configuration of the standby project is not
possible in the SIMATIC Manager.

Requirements
● The path to the target computer must have been set.
● The path must be set for Master and Standby for redundant system.

Procedure
1. Select the WinCC project in the WinCC application.
2. Start the "Target System > Load" function using the context menu.
3. In the dialog, select the scope of the load operation using the options Entire WinCC Project
or Modifications.
Under the following conditions, only the Entire WinCC Project option is available:
- When the project is loaded onto the target system for the first time.
- As a result of configurations in the WinCC project that lead to the loss of the online
modification capability.
- When the standby server has not yet loaded the WinCC project of the master server.
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Note
Do not open the project on the target computer until the load operation has been completed.

See also
How to Create a WinCC Application (Page 2270)
How to Create an Operator Station (Page 2285)
Operator Station OS (Page 2284)
How to Select the Standby Computer (Page 2277)
How to Set the Path to the Target Computer (Page 2273)
WinCC Application (Page 2269)

15.3.2.6

How to Create a Reference to a WinCC Application

Introduction
Using OS references offers the advantage of loading one WinCC project, the so called basis
OS, onto several target systems. The objects "WinCC Appl. Ref." und "OS Ref." are used for
configuration.
Apart from the WinCC application and its OS, each additional destination system needs an
application reference and an OS reference. The configuration is performed in several steps.
1. Creating the application reference.
2. Configuring the OS reference.
This section shows you how to create a reference to a WinCC application in a PC station.

Requirements
● A PC station must have been created in the STEP 7 project.
● The basis OS is of object type OS, of project type single-user or multi-user, and does not
have a redundant partner.
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Procedure
1. Open the hardware configuration for the PC station. To do so, click the PC station in the
navigation window. Select the Open Object option on the shortcut menu. This will open the
HW Config dialog.
2. Click the object PC in the contents window.
Open the hardware directory using the menu item View > Catalogue and navigate to the
folder SIMATIC PC Station > HMI.
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3. Select the application type "WinCC Appl. Ref." and drag the object onto a free slot of the
PC in the PC object.

4. Save and close the hardware configuration.
5. The navigation window of SIMATIC Manager displays the just created object WinCC Appl.
Ref(n) displayed.
In order to complete the configuration of an OS reference, the OS Ref. object must still be
configured. Additional information may be found in the section Configuring a Reference to an
OS.

Note
You can use the same method to configure the reference to a WinCC application client. The
corresponding project is then of the project type "Client".
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See also
How to Configure a Reference to an OS (Page 2290)
Managing WinCC Projects and Objects in the SIMATIC Manager (Page 2266)

15.3.3

Operator Station OS

15.3.3.1

Operator Station OS

Introduction
The OS represents a WinCC project in the SIMATIC Manager. Unlike the WinCC application,
the OS is not integrated in the configuration of the target computer. This means that you have
to carry out additional configuration steps on the target computer, e.g. setting the unit name.
You can create two different project types:
● Multi-user project
● Client project
The illustration below shows how the operator station appears in the SIMATIC Manager:

Note
Further information on the advantages of the WinCC application can be found under WinCC
Application.
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See also
How to Configure a Reference to an OS (Page 2290)
How to Create an Operator Station (Page 2285)
How to Load the Project on the Target Computer (Page 2289)
How to Select the Standby Computer (Page 2277)
How to Create a WinCC Application (Page 2270)
WinCC Application (Page 2269)
How to Set the Path to the Target Computer (Page 2285)

15.3.3.2

How to Create an Operator Station

Introduction
This section shows you how to create an operator station in the SIMATIC Manager.

Requirement
● The STEP 7 project must have been opened using the SIMATIC Manager.

Procedure
1. Open the Navigation Window and select the project or library in which the OS should be
set up.
2. Select the entry Insert New Object in the pop-up menu. You can now select either OS (for
a server) or OS (client).

See also
How to Load the Project on the Target Computer (Page 2289)
How to Create a WinCC Application (Page 2270)
How to Set the Path to the Target Computer (Page 2285)

15.3.3.3

How to Set the Path to the Target Computer

Introduction
To be able to load the WinCC project, you must set the path to the target computer in the object
properties.
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Requirements
● The OS is inserted as object of a WinCC application or as OS (client) directly in the S7
project.

Procedure
1. Select the OS and open the "Object Properties" using the shortcut menu.
2. If you wish to configure an OS in a WinCC application, select the "Target OS" and "Standby
OS" tab.
If you wish to configure an OS of type OS (Client), select the "Target OS" tab.
The following illustrations refer to an OS in a WinCC application.
You can enter the path to the target computer directly as shared directory in the format \
\<Computer name>\<Enable>. Following the direct entry, click the Apply button. The WinCC
project directory and the project file will be supplemented.
Alternatively, you can open a selection dialog by clicking the Browse button.
If you have entered the path directly, continue with step 4.
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3. To select a path via a selection dialog, click the "Browse..." button. In the "Select Target
OS" dialog, select the network drive and the folder you require. Click "Open".

4. Check the path to the target computer and then close the Properties dialog.
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Note
Enter the computer name and the symbolic computer name and not the IP address of the
computer.
Note
The function "Generating/Updating Archive Tags" may only be used jointly with PCS7.
Additional information on this function may be found in the configuration manual Process
Guidance System PCS7, Operator Station in the PCS7 documentation.

See also
How to Create a WinCC Application (Page 2270)
How to Load the Project on the Target Computer (Page 2289)
How to Create an Operator Station (Page 2285)
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15.3.3.4

How to Load the Project on the Target Computer

Introduction
When you have completed configuration, you must load the WinCC project on the target
computer. To do so, use the "Load Target System" function of SIMATIC Manager.
Persistence in CS with integrated WinCC projects
Changes to the control properties in Runtime are not persistently accepted in CS with PCS 7
projects or TIA projects. During an overall loading of the ES to the OS, the changed settings
on the OS are overwritten.
Configure the properties of the controls on the ES.
Note
If STEP 7 and the WinCC project are on the operator station, the WinCC project does not
have to be loaded.

Requirements
● The path to the target computer must have been set.

Procedure
1. Select the OS.
2. Start the "Target System > Load" function using the shortcut menu.
3. In the dialog, select the scope of the load operation using the options Entire WinCC Project
or Modifications.
Under the following conditions only the option "complete WinCC project" is available:
- When the project is loaded to the target system for the first time.
- In case of configurations in the WinCC project that would result in the loss of the ability
to load online changes.

Result
For loading OS changes, you can call up the Deltaloader status by means of the "Details"
button. The Deltaloader status indicates the following:
● Type:
The components of WinCC in which the changes were made.
● Sort:
What sort of changes were made.
● Number:
How many changes were made.
● Limit:
Shows the limit value of changes for online change loading.
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If the number of changes is greater than the limit value, a complete upload is recommended.
In this case a note is shown in the "Load OS" dialog.
Note
Open the project on the target computer only after the loading is complete.

See also
How to Create an Operator Station (Page 2285)
How to Select the Standby Computer (Page 2277)
How to Create a WinCC Application (Page 2270)
How to Set the Path to the Target Computer (Page 2285)

15.3.3.5

How to Configure a Reference to an OS

Introduction
Using OS references offers the advantage of loading one WinCC project, the so called basis
OS, onto several target systems. The objects "WinCC Appl. Ref." und "OS Ref." are used for
configuration.
Apart from the WinCC application and its OS, each additional target system needs an
application reference and an OS reference. The configuration is performed in several steps.
1. Creating the application reference.
2. Configuring the OS reference. You must create the OS reference in STEP 7 sub-project of
basis OS.
This section shows how to configure an OS reference.
The "WinCC Appl. Ref." application reference to this basis OS was previously created.
Additional information may be found in the section Creating a Reference to a WinCC
Application.
After processing, you must transfer the project to the target system of basis OS along with all
the references. Select the "Download to CPU" function for the selected basis OS or OS
reference.

Requirements
● A PC station must have been created in the STEP 7 project.
● The basis OS is of object type OS, of project type single-user or multi-user, and does not
have a redundant partner.
● The "WinCC Appl. Ref." application reference to this basis OS was previously created.
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Procedure
1. In the navigation window of SIMATIC Manager, navigate to the desired object WinCC Appl.
Ref(n). Select the subordinate object OS Ref.
2. Select Object properties from the shortcut menu of the object. The Properties - OS
Reference dialog opens.
3. Change over to the tab OS Ref: Options for OS Reference Objects.
4. Select the basis OS for this reference object in the basis OS field. The name of the
associated basis OS is applied to the name of the OS reference object in the format
<name_basic_os>_Ref(n).
Enter the associated OS path in the field Path to Target OS Computer. Alternatively, you
can open a selection dialog by clicking the "..." button and select the path in this dialog.
5. Close the dialog with the "OK" button.
The project of the basis OS must now be transferred to the associated OS by using the
Download to CPU function.
When you make changes in the WinCC project of the basis OS you need to transfer the same
to the target system of basis OS and to each target system of references.

Note
Multi-projects have the following restriction:
Do not move any basis OS from a STEP 7 sub-project to another STEP 7 sub-project. While
moving, you will lose all associated OS reference stations their reference to basis OS.

See also
How to Create a Reference to a WinCC Application (Page 2281)
How to Load the Project on the Target Computer (Page 2280)
Managing WinCC Projects and Objects in the SIMATIC Manager (Page 2266)

15.3.4

How to Import a WinCC Project with the SIMATIC Manager

Introduction
You can use the SIMATIC Manager to import a previously independent WinCC project into a
STEP 7 project.
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Requirements
● The WinCC project to be imported is closed.
● On the computer used for the import into the STEP 7 project, there are no open WinCC
projects.

Procedure
1. In the SIMATIC Manager, open the STEP 7 project in which to import the WinCC project.
2. In the Tools menu, select Import OS .... The Import OS dialog opens.
3. . 3 Click the ... button to select the path of the WinCC project you want to import in the Open
selection dialog. The selected path is shown in the field OS to import.
If the name of the WinCC project has more than 24 characters without file name extension
or if it is not unique within the STEP 7 project, a message appears. In this case, you can
specify another name.
4. Start the import by clicking the Import OS button.
When the import has been successfully completed, a message is displayed.
Exit the dialog by clicking the Exit button.
In errors occurred during the import, an error message is given and the respective errors
are written into the log file import.log. The log file is stored in the WinCCOM folder under
the project directory of the imported WinCC project.
During the import, a PC station with subordinate WinCC application is created for the WinCC
project to be imported in the SIMATIC Manager. The imported WinCC project is created as
subordinate OS object with the name specified for the import.
In the imported WinCC project, the following actions are performed:
● Existing packages are deleted.
● The computer name is set.
● An activated redundancy is deactivated.

See also
How to Create an Operator Station (Page 2285)
How to Load the Project on the Target Computer (Page 2280)
How to Select the Standby Computer (Page 2277)
How to Create a WinCC Application (Page 2270)
How to Set the Path to the Target Computer (Page 2285)
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15.3.5

Handling WinCC Projects Between STEP 7 Projects and Libraries

Introduction
The following actions can be executed on WinCC projects using the SIMATIC Managers:
● Copying or moving a WinCC project within a STEP 7 project
● Copying or moving a WinCC project between STEP 7 projects
● Copying or moving a WinCC project from a STEP 7 project to a library
● Copying or moving a WinCC project from a library to a STEP 7 project
● Renaming a WinCC project
● Deleting a WinCC project

Requirements
● A WinCC project must have been created in the STEP 7 project.

Copying
1. Open the STEP 7 project into which the WinCC project is to be copied, using the "File >
Open" option.
2. Select the WinCC project you want to copy and drag it onto the STEP 7 project selected
as the destination.

Moving
1. Open the STEP 7 project into which the WinCC project is to be moved, using the "File >
Open" option.
2. Select the WinCC project you want to move and drag it onto the STEP 7 project selected
as the destination, holding down the Shift key as you do so.

Renaming
1. Select the WinCC project.
2. Select the "Rename" option on the pop-up menu and enter the new name.
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Deleting
1. Select the WinCC project you want to delete.
2. Select the "Delete" option on the pop-up menu and acknowledge the warning with "Yes".
Note
In the same way, a WinCC project can be copied within a STEP 7 project or between a
STEP 7 project and a library. If the WinCC project is open, Rename, Move and Delete are
not executed.

15.3.6

Accepting Language Settings from SIMATIC Managers

Introduction
If a WinCC project is opened in SIMATIC Manager, WinCC Explorer will accept the current
language setting from SIMATIC Manager. The language settings of SIMATIC Manager will
only take effect on the language setting of the CS (Configuration System).

Behavior
There are three scenarios during opening of a WinCC project:
Scenario

Behavior

The current language of
If WinCC Explorer or one of the editors (Graphics Designer, Load Online
SIMATIC Manager was also Changes or similar) is started, the language set in SIMATIC Manager is
installed in WinCC.
loaded. This also applies if the project is opened by using ProAgent, for
example.
The current language of
SIMATIC Manager was not
installed in WinCC.

If WinCC Explorer or one of the editors (Graphics Designer, Load Online
Changes or similar) is started, the language stored as default language
is loaded. This also applies if the project is opened by using ProAgent,
for example.

The WinCC project was
most recently configured in
a language not installed in
SIMATIC Manager.

If WinCC Explorer or one of the editors (Graphics Designer, Load Online
Changes or similar) is started, its language setting is retained. In this
case the current language setting of SIMATIC Manager has no effect on
the language setting of WinCC Explorers or the respective editor.

You can change the language setting in the open WinCC Explorer at any time. When this editor
is closed and restarted, the current language setting of SIMATIC Manager is loaded again.

See also
How to Open the WinCC Project (Page 2303)
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15.3.7

Working With WinCC Objects

15.3.7.1

Working With WinCC Objects

Introduction
Apart from the WinCC project, the associated WinCC objects are also displayed in the
SIMATIC Manager. These objects are pictures and report templates of the project.
If you have created pictures and report templates using the Graphics and Report Designer,
they are not automatically visible in the SIMATIC Manager. They must be imported first.
You can also create pictures and report templates using the SIMATIC Manager. These objects
are empty initially and can be processed further using the Graphics Designer and Report
Designer.
The SIMATIC Manager also provides functions for handling these objects, e.g. copy, move,
and delete.
In addition, the SIMATIC Manager provides functions for managing model solutions of WinCC
objects in libraries.
The illustration below shows how the WinCC objects appear in the SIMATIC Manager.

See also
How to Import WinCC Objects (Page 2298)
How to Handle WinCC Objects (Page 2296)
How to Create WinCC Objects (Page 2296)
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15.3.7.2

How to Create WinCC Objects

Introduction
In the SIMATIC Manager, you can create the WinCC objects pictures and report templates
without having to open the WinCC project. These WinCC objects have no content initially. You
can, however, process them further using Graphics Designer and Report Designer.

Requirement
● A WinCC application or OS must have been created in the SIMATIC Manager.

Procedure
1. Select the WinCC project in the WinCC application or the OS.
2. Select the entry Insert New Object in the pop-up menu. You can now create either a picture
or a report template.

See also
How to Import WinCC Objects (Page 2298)
How to Handle WinCC Objects (Page 2296)
Working With WinCC Objects (Page 2295)

15.3.7.3

How to Handle WinCC Objects

Introduction
You can use the SIMATIC Manager to copy, move, rename, and delete pictures and report
templates. It is possible to copy and move objects between WinCC projects which have been
created either in the same STEP 7 project or in different STEP 7 projects or libraries.
Configured dynamics are also copied when objects are copied and moved to other WinCC
projects. The process connection is lost since the used tags do not exist in the target project.
You can compile a list of nonexistent tags using the CrossReference Editor. This also allows
process connections to be linked.
Copying and moving is then mainly used if you want to duplicate certain system sections of a
template project. You copy the pictures which do not contain any dynamics or contain a
dynamic prepared with prototypes, to the target project and perform process connection there.
Note
The names of pictures and report templates must be unique within a WinCC project.
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Copy
1. Select the WinCC object.
2. Drag the object onto the WinCC project you selected as the destination. If the object is
copied between two WinCC projects in different STEP 7 projects and an object with the
same name already exists, the existing object is only overwritten after confirmation.

Moving
1. Select the WinCC object.
2. Drag the object onto the WinCC project you selected as the destination, holding down the
Shift key as you do so. If the object is moved between two WinCC projects in different STEP
7 projects and an object with the same name already exists, the existing object is only
overwritten after confirmation.

Rename
1. Select the WinCC object.
2. Select the "Rename" option on the shortcut menu and enter the new name.

Delete
1. Select the WinCC object.
2. Select the "Delete" option on the shortcut menu and acknowledge the warning with "Yes".
Note
If the object was opened by the Graphics Designer or Report Designer, renaming, moving
or deleting is not executed.
If you create WinCC objects in SIMATIC Manager, you can neither rename nor delete
these objects in WinCC Explorer. This is also true for WinCC objects that were created in
WinCC and were then imported with the function "Import WinCC objects" into the SIMATIC
Manager. This import makes a TIA object out of the WinCC object.
If you copy a TIA object with the Graphics Designer or Report Designer, the copy is created
as a WinCC object. You may rename or copy this copy as a WinCC object.
Note
If you rename a picture in WinCC Explorer, the new picture name must not have the same
name as an existing object in the picture. The software does not check whether the name
already exists. Using a name that is already in use can lead to conflicts during access via
VBA or during dynamization.

See also
How to Import WinCC Objects (Page 2298)
How to Create WinCC Objects (Page 2296)
Working With WinCC Objects (Page 2295)
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15.3.7.4

How to Import WinCC Objects

Introduction
You can create pictures and report templates using the Graphics Designer and Report
Designer editors. However, these WinCC objects are not displayed automatically in the
SIMATIC Manager. You can update the view in the SIMATIC Manager using the "Import WinCC
objects" function.

Requirement
● Pictures and report templates must have been created using the associated editors.

Procedure
1. Select the WinCC project in the WinCC application or the OS.
2. Select the entry "Import WinCC objects" in the pop-up menu. The pictures and report
templates are displayed in the SIMATIC Manager.
Note
You can only import pictures into the Simatic Manager, if the picture name does not exceed
24 characters.

See also
How to Handle WinCC Objects (Page 2296)
How to Create WinCC Objects (Page 2296)
Working With WinCC Objects (Page 2295)

15.3.7.5

Setting Up and Monitoring of Server Assignment

Introduction
Using the SIMATIC Manager, you can assign various OS servers to a selected OS. The
selected OS may be an OS client, an OS server or a central archive server.
If you have selected an OS object, the "Assignment OS Server for <OS> dialog" displays a list
of servers available in this project. An existing archive server is also listed.
If the selected OS project contains packages of servers unknown to the S7 project and the
multi-project, respectively, the list will be expanded by entries of these servers not found. The
"OS Information" column contains the entry "Unknown" in these cases.

The OS Server Assignment for <OS> Dialog
Open the "OS Server Assignment for <OS>" dialog by selecting the OS in SIMATIC Manager.
Select the "Assign OS Server..." entry in the pop-up menu.
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Alternatively, you may open the dialog in SIMATIC Manager in the Tools menu by using the
"OS > Assign OS Server..." entry.

The dialog will display all OS servers accessible and belonging to the S7 project and the multiproject, respectively. The list might be amended by entries containing the OS information
"Unknown". The following OS objects are not displayed:
● Selected OS for which a dialog was opened
● Standby OS server
● Clients
● OS of single user project
● OS References
● Client References
An entry may contain the following information:
● Check box to setup or delete an assignment to a selected OS project. Displays upon
opening of the dialog whether or not an assignment exists.
● OS information consisting of the name of the S7 project and the description of the OS object.
● Symbolic computer name
In order to set up an assignment, select the check box of the OS object and finish the dialog
with OK. Thus, a package will be imported into the OS for all newly selected OS objects.
In order to delete an existing assignment, clear the check box of the OS object and finish the
dialog with OK. Thus, the corresponding package will be deleted from the OS for all newly
deselected OS objects.
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Significance of Colors in List Entries
Using the color of an entry, you obtain information on each OS object.
Type

Color

Additional information

Significance of information

1

black

Check box not selected

Assignment to server may be established.
Server has exported package.

2

black

Check box selected

Assignment to server is established.
OS has loaded package.

3

gray

No check box

Assignment to server cannot be established.
Reason: Server does not have exported package.

4

red

No check ox
OS information and symbolic
computer name are entered

Assignment to server cannot be established.
Reason: Exported package of server does not
have unique name.
There are several reasons for this:
● The project already contains a server with an
identical symbolic computer name.
● The OS object contains an imported package
with an identical symbolic computer name.

5

2300

red

Check box selected
OS information contains the
entry "Unknown" and the
symbolic computer name has
been entered

The server named in the imported package of the
selected OS object cannot be found in the S7
project and multi-project, respectively.
Reason: OS server no longer belongs to the multiproject, or package has been deleted.
In this case you should uncheck the checkbox for
this entry and exit the "OS Server Assignment for
<OS>" dialog by clicking OK. Thus, you delete the
imported package which could not be assigned.
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Note
If you execute one of the following actions in an S7 project, you should subsequently check
the OS server assignment in the "OS Server Assignment for <OS>" dialog:
● Dearchiving an S7 project with "Dearchiving"
●
●
●
●
●

Storing an S7 project with "Save As..."
Removing an S7 project with "Delete for Editing"
Picking up an S7 project with "Picking up after Editing"
Copying an S7 project with Windows Explorer
Moving an S7 project with Windows Explorer

If red entries of Type 5 occur in the list during the "OS Server Assignment for <OS>" dialog,
proceed as follows:
1. Regenerate all packages by starting the "Compiling Multiple OS" wizard Compilation of
minimum scope suffices. Therefore, select the check box Changes Only and deactivate
other options, such as Tags, Messages and SFC.
If the red entry is concerned with the central archive server, you must additionally trigger
the generation of server data.
2. For all OS objects, open the "OS Server Assignment for <OS>" dialog and check for
possible "Unknown" error entries.
3. In these cases, make note of the symbolic computer name.
4. Delete the "Unknown" entries by deactivating the respective checkboxes and by finishing
the dialog with OK.
5. Open the dialog and search for the symbolic computer name noted in Item 3. Assign these
computers to the selected OS objects by selecting the respective check box and by
finishing the dialog with OK.

15.3.7.6

How to Create Model Solutions of WinCC Projects or WinCC Objects

Introduction
Using the SIMATIC Manager, complete WinCC projects can be copied or moved to a library.
These WinCC projects can then be edited n the library. The model solutions thus created serve
as templates for several uses in WinCC projects. The copying or moving processes to or from
a library behave in the same way as between two Step 7 projects.
Individual screens and report templates can also be copied or moved from a WinCC project
to an OS within a library and used as a model template.
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Requirement
● Copying and moving individual screens and report templates:
An OS is set up in the library as destination.
● Copying or moving WinCC projects:
The source project is not activated.
Note
When copying or moving WinCC projects, screens and report templates to and from
libraries, name conflicts may occur. This means that the library or STEP 7 project already
contains a WinCC object with this name. To prevent the target object being overwritten,
a new name is assigned for the inserted object. The name of the object is assigned a
consecutive number meaning, for example, "Picture1" becomes "Picture1(1)".

Copying a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.
2. Open the STEP 7 project to be used as the source using the menu items "File > Open".
3. Open the library in which the model solution should be copied using menu items "File >
Open".
4. Select the OS, screen or report template to be copied in the STEP 7 project. Drag the object
per Drag & Drop onto the target library or OS in the library.

Moving a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.
2. Open the STEP 7 project to be used as the source using the menu items "File > Open".
3. Open the library in which the model solution should be copied using menu items "File >
Open".
4. Select the OS, screen or report template to be copied in the STEP 7 project. Drag the object
per Drag & Drop, with the Shift key pressed, onto the target library or OS in the library.

Copying a WinCC Project or WinCC Object from a Library
1. Open the SIMATIC Manager.
2. Open the library from which the model solution should be copied using menu items "File >
Open".
3. Open the STEP 7 project to which the model solution should be copied using menu items
"File > Open".
4. Select the OS, screen or report template to be copied in the library. Drag the object per
Drag & Drop onto the S7 project selected as target or OS selected as target.

2302

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Integration of WinCC in SIMATIC Manager
15.3 Managing WinCC Projects and Objects in the SIMATIC Manager

Moving a WinCC Project or WinCC Object from a Library
1. Open the SIMATIC Manager.
2. Open the library from which the model solution should be copied using menu items "File >
Open".
3. Open the STEP 7 project to which the model solution should be copied using menu items
"File > Open".
4. Select the OS, screen or report template to be copied in the library. Drag the object per
Drag & Drop onto the S7 project selected as target or OS selected as target.

Renaming a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.
2. Select the OS, screen or report template to be renamed.
3. Select the "Rename" option on the pop-up menu and enter the new name.

Deleting a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.
2. Select the OS, screen or report template to be deleted.
3. Select the "Delete" option on the pop-up menu and acknowledge the warning with "Yes".

15.3.8

How to Open the WinCC Project

Introduction
You can start WinCC directly from the SIMATIC Manager and then open the WinCC project.

Requirement
● The WinCC project must have been created in the SIMATIC Manager.

Procedure
1. Select the WinCC project in the WinCC application or the OS.
2. Select the "Open Object" option on the context menu.
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Note
Starting with version V6.2, WinCC evaluates the project-related access protection that is used
to protect STEP 7 or PCS7 projects.
Independent of access protection:
WinCC Projects that are integrated in a STEP 7/PCS7 project cannot be opened using an
ES where only WinCC has been installed. For that you also need STEP 7 or NCM PC Edition
of SIMATIC NET CD on the ES.
If project-related access protection has been activated for WinCC project, then you must also
enter the STEP 7 project password while opening the project.

See also
How to Create a WinCC Application (Page 2270)
WinCC Application (Page 2269)

15.3.9

Starting a Simulation in STEP 7

Introduction
The "Start OS simulation" function creates a temporary copy of the selected project on the
local computer. This copy of the project is then started in runtime.
The temporary copy is always created locally. In this case, a new directory "OS_Simulation"
is created in the existing directory structure parallel to the STEP 7 project already open.
If the selected project is on a different computer, the temporary copy is still created on the local
computer. In this case, the "OS_Simulation" directory is set up in the STEP 7 installation path
under "S7Proj".
This function is required in order to test the changes made in the WinCC project or STEP 7
project.
Note
With connections configured on both sides, it is important to ensure that the connections
between the local computer and the AS as well as between the target computer and the AS
have the same name. If this is not the case, no connection will be set up between the local
computer and the AS.
During simulation, communication to other computers is restricted. The following functions, for
example, are not available:
● Server-Server communication
● Client-Server communication
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● Redundancy
● Communication with a central archive server

Procedure
1. Select the WinCC project in the WinCC application or the OS.
2. Select the "Start OS Simulation" option from the context menu.
Note
If a WinCC project is already in runtime, the "Start OS simulation" cannot be executed. A
corresponding message is issued.
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15.4

Transferring Tags, Texts and Reports to WinCC

15.4.1

Transferring Tags, Texts and Reports to WinCC

Introduction
This chapter shows you the function "Compiling OS", informs you about the configuration data
affected by the transfer and how this data is stored in the WinCC project. It familiarizes you
with the dialogs and procedures associated with the transfer operation.
You must transfer the AS configuration data relevant for operator control and monitoring, to
the data of WinCC so that it is available to you during WinCC configuration and in Runtime.
Use the function "Compile OS" for this purpose.
During the transfer operation, process tags are stored in the tag management system, user
texts are stored in the text library, and messages are stored in the alarm logging system of the
WinCC project.
You need "PCS 7" to create archive tags by setting the property "S7_archive" in data elements
of a data block and starting compilation of the OS.

See also
Compilation log (Page 2317)
How to Compile Changes (Page 2313)
How to Compile the Entire OS (Page 2308)
Compiling OS (Page 2307)
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15.4.2

Compiling OS

15.4.2.1

Compiling OS

Introduction
You use the "Compile OS" function to create the structures and data in the WinCC project that
are required for operator control and monitoring.

Note
You may compile one OS or several OS. If you wish to compile one OS, use the "Compile OS"
wizard. If you wish to compile multiple OS, use the "Compile multiple OSs" wizard.
Both wizards differ only by the number of OS to be compiled. The statements of the wizard
"Compile OS" therefore apply equally to the wizard "Compile multiple OSs".

Scope of Compilation
The "Compile OS" function has three compile modes:
● The "Entire OS with memory reset" mode is the default mode. All AS data in the operator
station is erased and the data for the S7 programs selected for compilation is transferred
again.
● The "Entire OS" mode is appropriate if with several assigned S7 programs you have not
selected all for compilation. This mode ensures that the already transferred data of the S7
programs not selected for compilation is retained in the operator station.
● The "Changes" mode should be used if you have only made minor changes in the S7
program. If you make changes to a structure tag where one structure element is used as
message tag, then online changes cannot be loaded for messages.
Note
If you perform a "Save As" in SIMATIC Manager and have selected "with reorganization",
the option "Entire OS" is the default setting. You cannot select an different compilation
range.

Functions
The following functions are executed with "Compile OS":
● Creation of the communication driver SIMATIC S7 PROTOCOL SUITE
● Creation of the WinCC units, e.g. Industrial Ethernet, PROFIBUS and so on
● Creation of a logical connection for each S7 program
● Creation of raw data tags for the message system and archive system
● Creation of structure types for the component types to be transferred in WinCC and for the
global data blocks
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● Creation of the process tags in the tag management system
● Generation of the messages
● Transfer of the message and user texts

When Should Compilation Be Performed?
Compilation of OS should be performed:
● before WinCC Runtime is started for the first time
● after new component instances are added or component names are changed
● after operator texts and unit texts are changed
● after the operator control and monitoring attributes of an instance are changed
● after message and user texts are changed
Note
Simulation of the OS is only possible if the OS was compiled without errors.
Note
Additional information can be found in the STEP 7 help and in the "Compile OS" Wizard
help.

See also
Compilation log (Page 2317)
How to Compile Changes (Page 2313)
How to Compile the Entire OS (Page 2308)

15.4.2.2

How to Compile the Entire OS

Introduction
You compile the configuration data using the Compile OS wizard. Compilation of the entire
OS can be performed in two different compilation modes:
● The "Entire OS with memory reset" mode is the default mode. All AS data in the operator
station is erased and the data for the S7 programs selected for compilation is transferred
again.
● The "Entire OS" mode is appropriate if with several assigned S7 programs you have not
selected all for compilation. This mode ensures that the already transferred data of the S7
programs not selected for compilation is retained in the operator station.
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Starting the "Compile OS" Wizard
You can start the "Compile OS" wizard in SIMATIC Manager in different ways.
● If you wish to compile the configuration data of a certain operator station, first select the
OS and start the assistant by using the menu item "Edit" > "Compile". Alternatively, you
can also select the "Compile" option in the pop-up menu of the OS.
● If you wish to compile the configuration data of several or all operator stations, start the
wizard from the menu item "Options > "'Compile Multiple OSs' wizard" > "Start...".
Note
Please note that compiling the entire OS will lead to a loss of online loadability.
Further information on "Compile OS" can be found in the "STEP 7 Help" and "Compile
OS" wizard Help.
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Requirements
● The WinCC project must have been created.

Procedure
The compilation of a particular operator station is described in this procedure. The compilation
of several operator stations is performed in the same way.
1. Select the OS, and then select "Compile" in the pop-up menu, or select the menu item "Edit"
> "Compile".
2. Select the appropriate S7 program in the list of S7 programs (left) and then drag the S7
program (holding down the left-hand mouse button) onto the desired operator station in the
list of operator stations (right). Click "Next".

This page is only displayed if there is more than one operator station and more than one S7
program in your project. Assignment is otherwise performed automatically.
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1. Using the check box, select the S7 programs that you want to transfer. Data is only
transferred for the selected S7 programs.

2. Select which network connections are to be used. When you select the operator station in
the left-hand field, the associated S7 programs together with the configured network
connections are listed in the right-hand field. To change the network connection, select the
S7 program and press the "Connection..." button. Select the network connection you
require. Press "OK" and then "Next".
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3. Select the compilation mode "Entire OS". If you want to delete all the AS data in the operator
station, select "With memory reset". Click "Next".

4. Check the compilation options and click Compile.
5. When the compilation procedure has been completed, a message may appear informing
you of errors and warnings that have occurred. If this is the case, check the compilation
report.
Note
You should not work on the project during compilation.
You may use the option Archive Tags only jointly with PCS7. Additional information on this
function may be found in the configuration manual Process Guidance System PCS7,
Operator Station in the PCS7 documentation.

See also
Compilation log (Page 2317)
How to Compile Changes (Page 2313)
Compiling OS (Page 2307)
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15.4.2.3

How to Compile Changes

Introduction
You should compile changes if you have made only minor changes to the S7 programs. In
contrast to compiling the entire OS, compiling the changes has the advantage of maintaining
the online loadability.

Starting the "Compile OS" Wizard
You can start the "Compile OS" wizard in SIMATIC Manager in different ways.
● If you wish to compile the configuration data of a certain operator station, first select the
OS and start the wizard by using the menu command "Edit > Compile". Alternatively, you
can also select the "Compile" option in the shortcut menu of the OS.
● If you wish to compile the configuration data of several or all operator stations, start the
wizard from the menu command "Options > Compile Multiple OSs' wizard > Start...".
Further information on "Compile OS" can be found in the "STEP 7 Help" and "Compile OS"
wizard Help.

Requirements
● The operator station must have been configured.
● Operator control and monitoring data which has been changed must exist in the AS
configuration.
● An entire compilation or an implicit compilation (with selection of connection) must have
been performed for the first time.
● If you make changes to a structure tag where one structure element is used as message
tag, then online changes cannot be loaded for messages.
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Procedure
The compilation of a particular operator station is described in this procedure. The compilation
of several operator stations is performed in the same way.
1. Select the OS, and then select "Compile" in the shortcut menu, or select the menu command
"Edit > Compile".
2. If you have no changes, click Next.
If you have changes, select the appropriate S7 program in the list of S7 programs (left) and
then drag the S7 program (holding down the left-hand mouse button) onto the desired
operator station in the list of operator stations (right). Click "Next".

This page is only displayed if there is more than one operator station and more than one
S7 program in your project. Assignment is otherwise performed automatically.
3. If you have no changes, click "Connection".
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4. If you have changes, enable the check boxes to select the S7 programs that you want to
transfer. Data is only transferred for the selected S7 programs. Click "Connection".

5. If you have no changes, click "Cancel".
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6. If you have changes, select the network connections that you want to use. When you select
the operator station in the left-hand field, the associated S7 programs together with the
configured network connections are listed in the right-hand field. To change the network
connection, select the S7 program and press the "Connection..." button. Select the network
connection you require. Press "OK" and then "Next".

7. Select the compilation mode "Changes". Click "Next".
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8. Check the compilation options and click Compile.
9. When the compilation procedure has been completed, a message may appear informing
you of errors that have occurred. If this is the case, check the compilation report.
Note
You should not work on the project during compilation.
You may use the option Archive Tags only jointly with PCS7. Additional information on this
function may be found in the configuration manual Process Guidance System PCS7,
Operator Station in the PCS7 documentation.

See also
Compilation log (Page 2317)
How to Compile the Entire OS (Page 2308)
Compiling OS (Page 2307)

15.4.2.4

Compilation log

Introduction
During compilation, logs are created that provide information about:
● AS-OS connections
● Tag names
● Assignment of messages
● Errors and warnings that occurred during compilation

Compilation log
The compilation log contains entries on all objects.
Once you have compiled an OS using the Compile OS wizard, open the compilation log using
the menu command "Options > OS > Display compilation log..." directly in SIMATIC Manager.
Alternatively, you may also open the compilation log "transfer.log" in the WinCC project path
with a text editor.
Once you have compiled multiple OS with the wizard Compile Multiple OSs, open the
compilation log by clicking the menu command "Options > Compile Multiple OSs wizard >
Open Log..." directly in SIMATIC Manager. Alternatively, you may also open the compilation
log "transfer.log" in the STEP7 project path with a text editor.

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2317

Integration of WinCC in SIMATIC Manager
15.4 Transferring Tags, Texts and Reports to WinCC

See also
How to Compile Changes (Page 2313)
How to Compile the Entire OS (Page 2308)
Compiling OS (Page 2307)

15.4.3

How to Display Transferred Tags

Introduction
The result of the "Compile OS" function can be checked in the WinCC project.

Procedure
1. Open the Tag Management and then navigate to the configured WinCC unit.
2. Open the logical connection that it contains. All compiled process tags are now displayed.
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Note
In the Tag Management, the compiled tags can be recognized by the structure of their name.
Their name is made up of the S7 program followed by "/".
Compiled tags are write-protected and cannot be deleted from the Tag Management. This is
only possible with the Compile "OS wizard".
In the dialog box Which S7 Programs Do You Want to Transfer with Which Network
Connections? you must disable the S7 programs whose tags are to be deleted in WinCC. To
do this, remove the check mark in front of the program name. Choose the "Entire OS With
Reset" option for the compilation mode. During the compilation operation that follows, al the
tags, connections and messages not created in WinCC are deleted.

See also
Displaying Transferred Messages and Texts (Page 2319)
Compilation log (Page 2317)
How to Compile Changes (Page 2313)
How to Compile the Entire OS (Page 2308)
Compiling OS (Page 2307)

15.4.4

Displaying Transferred Messages and Texts

Introduction
The result of the "Compile OS" function can be checked in WinCC.
Blocks of user and message text are stored in the text library, and messages are stored in
Alarm Logging.
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User and Message Texts
1. Select the "Text Library" editor in the WinCC Explorer.
2. Select the "Open" option on the shortcut menu.
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Messages
1. Open the "Alarm Logging" editor in WinCC Explorer.
The transferred messages can be recognized by the 10-digit number.

See also
How to Display Transferred Tags (Page 2318)
Compilation log (Page 2317)
How to Compile Changes (Page 2313)
How to Compile the Entire OS (Page 2308)
Compiling OS (Page 2307)

15.4.5

How to Configure Messages in STEP7

Introduction
To ensure a consistent message configuration, two points must be observed when creating
the message texts in STEP7 in order to guarantee the correct response in WinCC.
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Assigning the Message Texts According to "Compile OS"
The following example a configuration of the message texts in the STEP7 message editor.

The standard texts "Message text" and "Info text" as well as the additional texts are assigned
to the following user text blocks of a message after "Compile OS" in Alarm Logging from
WinCC.
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Note
"Compile OS" enables messages to be created in Alarm Logging whose message class and
message type are invalid in WinCC. Invalid messages are prevented by starting the OS
project editor.
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Creating a Message Group After "Compile OS"
If an additional text 2 is entered in the STEP7 message editor, a message group is created
using "Compile OS" in the Alarm Logging.
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15.5

Compiling and Loading Objects

Introduction
Objects can be compiled and loaded in just one step. The SIMATIC Manager provides the
Compile and Load Object dialog box for this. Further information on this topic can be found in
STEP 7 Help and Compile and Load Objects Help.

Objects table
In this area you specify which objects are to be compiled and loaded into the target system.
Objects column
Displays the objects.
Status column
Displays the status of the object.
There are the following statuses:
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● undetermined: The status could not be determined.
● modified: The object has been modified. The object must be recompiled and loaded onto
the system.
● compiled: The object has already been compiled but still needs to be loaded onto the
system.
● loaded: The object has already been compiled and loaded onto the system already.
Operating status column
Displays the operating status of the system.
Compile/Load column
Here you define the objects that have to be compiled and loaded onto the system. Only the
check boxes having a white background can be enabled or disabled.
If this check box is selected, the column Load in the Table Objects is hidden.

Settings for Compile/Load
Edit button
The Edit button opens the Settings: Compile OS dialog. You ca use this dialog box to modify
the settings for compiling and loading the selected object.
You will find more information about compilation at Compile OS and about loading at Loading
the project onto the destination computer.
Compile Only check box
If this check box is selected, the column Load in the Table Objects is hidden. The objects are
compiled only.
Do Not Load upon Compilation Error check box
If this check box has been selected, the object will not be loaded onto the system when a
compilation error occurs.

Displaying Log
Single Object button
Opens the log for a specific object.
Overall button
Opens the Overall Log. The overall log contains entries about all objects.
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Start button
Start the compile and load operation.
Note
You should not work on the project during compilation and loading.

See also
Compiling OS (Page 2307)
How to Load the Project on the Target Computer (Page 2289)
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15.6

How to use multiuser engineering in SIMATIC Manager

Introduction
Under certain circumstances, multiple users can edit a WinCC project simultaneously from
different computers and use different resources. This is also true for WinCC projects in
SIMATIC Manager.

Requirement
● At least one WinCC OS project or one OS client must be present in the STEP 7 project or
STEP 7 multiproject.
● The STEP 7 project or STEP 7 multiproject must not contain an OS server in which a client
computer is entered.

How to enable multiuser engineering
1. Select the "Enable/disable OS multiuser engineering" command in the "Tools" menu of
SIMATIC Manager. The "OS multiuser engineering" dialog opens.
2. Click the "Activate" option. The computers connected to the project can now use various
resources of the STEP 7 project or STEP 7 multiproject in parallel.
Note
If there is no longer an OS in the STEP 7 project or multiproject, multiuser engineering is
deactivated automatically.

For details of the multiuser engineering process, refer to the description on page "How to use
multiuser engineering" under "Working with projects > Creating and editing a project".
To find out if multiuser engineering is activated, select the "Object properties" entry from the
shortcut menu of the project. The activation or deactivation of the multiuser engineering is
indicated there.
Note
Depending on the number of WinCC projects within the STEP 7 project or STEP 7
multiproject, it may take some time for the "OS Multiuser Engineering" dialog to open or for
changes to be saved.

Restrictions on multiuser engineering in SIMATIC Manager
The following configuring steps require that a computer has sole access to the WinCC project:
● Compile OS
● Generate server data

2328

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Integration of WinCC in SIMATIC Manager
15.6 How to use multiuser engineering in SIMATIC Manager
● Assign OS server
● Start OS simulation
● Download to target system
● Rename
● Copy
● Move
If one of these project steps is carried out, the project cannot be opened with multiuser
engineering, either. In the "Multi-user resources" dialog, "Project locked" is displayed - except
during OS compilation or when the "s7omwinx.lck" file was accidentally not deleted.
You cannot carry out the following configurations in the object properties if the WinCC project
is open on another computer:
● On the "General" tab:
– Change name
– Change author
– Change comment
● On the "Target OS and Standby OS Computer" tab:
– Change destination path of standby OS if the assigned master OS is open
– Assignment of a standby OS
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15.7

Selection of STEP 7 Symbols

15.7.1

Selection of STEP 7 Symbols

Introduction
During WinCC configuration, you connect WinCC objects, e.g. I/O fields or archive tags, to
tags which are used in Runtime to supply the objects with the current process values.
For process linking, you have the option to choose between two groups of tags: WinCC tags
and STEP 7 symbols.

WinCC Tags
These include the internal and external tags of the Tag Management.

STEP 7 Symbols
These are all inputs, outputs, and bit memories from the symbol list as well as all global data
blocks of the assigned S7 programs.
You can access STEP 7 symbols directly by means of:
● the tag selection dialog
● the tag bar of the Graphics Designer
Unlike the external WinCC tags, you can access the STEP 7 symbols without having previously
performed Compile OS and without selecting with the operator control and monitoring attribute.
During process connection, an implicit compilation is performed and the symbol is transferred
to the Tag Management of the WinCC project.

See also
Tag Bar (Page 2339)
Tag Selection Dialog (Page 2331)
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15.7.2

Tag Selection Dialog

15.7.2.1

Tag Selection Dialog

Introduction
The tag selection dialog allows you to display tags or symbols from various data sources in a
selection window and to link these tags or symbols to, for example, picture objects of the
Graphics Designer. You determine the displayed data in the Data Source area.
The tag selection dialog is opened automatically when a tag needs to be selected during
configuration.

See also
Tag Bar (Page 2339)
How to Transfer STEP 7 Symbols (Page 2336)
How to Select STEP 7 Symbols (Page 2334)
How to Display STEP 7 Symbols (Page 2332)
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15.7.2.2

How to Display STEP 7 Symbols

Introduction
If you activate the STEP 7 Symbol Server check box, a list of all transferable STEP 7 symbols
are displayed in the data window. These symbols are all inputs, outputs, and bit memories
from the STEP 7 symbol list as well as the global data blocks.
The tag selection dialog has a tag filter. In this field you can use the placeholders "*" and "?"
to specify a search condition for the tag name. Only alphanumeric characters can be used for
the name search. Exit the field using the Tab or Enter key. Only those tags which match your
search criterion are then displayed.

Requirement
● The tag selection dialog must be open.

Procedure
1. Activate the STEP 7 Symbol Server check box.
2. Open the STEP 7 Symbol Server folder in the navigation window.
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3. Open and select the desired S7 program. The global data blocks and all symbols in the
symbol list are now displayed.

4. Open and select the global data block to display its contents.

Note
Only the following data types of a global data block are displayed and can be transferred:
BOOL, BYTE, WORD, DWORD, INT, DINT, REAL, CHAR and STRING.
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See also
Tag Bar (Page 2339)
How to Transfer STEP 7 Symbols (Page 2336)
How to Select STEP 7 Symbols (Page 2334)
Tag Selection Dialog (Page 2331)

15.7.2.3

How to Select STEP 7 Symbols

Introduction
In the tag selection dialog you can select STEP 7 symbols directly for process connection
purposes. The selected symbol is then labeled in STEP 7 as operator-controllable and
monitorable and transferred to the Tag Management of WinCC by implicitly running the
"Compile OS" function.
Note
If you select the symbol of a global data block, all elements provided with the operatorcontrollable and monitorable attributes of this block are transferred implicitly to Tag
Management of WinCC.
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Requirement
● STEP 7 symbols must be displayed.

Procedure
1. Select the desired symbol.
2. Select the symbol in the Select Tag dialog box and click "OK" to close the Tag Selection
dialog box.
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3. If the "Compile OS" function or the implicit transfer has not yet been performed, you must
select the desired channel unit (once only) via which communication with the AS is to be
set up. In this case, you select the desired network connection.

4. Check the created dynamic in the Object Properties.

See also
How to Transfer STEP 7 Symbols (Page 2336)
How to Display STEP 7 Symbols (Page 2332)
Tag Selection Dialog (Page 2331)

15.7.2.4

How to Transfer STEP 7 Symbols

Introduction
In the tag selection dialog, you can transfer STEP 7 symbols in the Tag Management without
direct process connection being carried out.
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Requirement
● STEP 7 symbols must be displayed.

Procedure
1. Select the desired symbols. Several symbols can be selected at the same time using the
CTRL or SHIFT keys and clicking with the mouse.
2. Click the "Transfer Data" button.
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3. If the "Compile OS" function or the implicit transfer has not yet been run, you must select
the desired channel unit (once only) via which communication with the AS is to be set up.
In this case, you select the desired network connection.

4. Check the result of the transfer in the Tag Management.

See also
Tag Bar (Page 2339)
How to Select STEP 7 Symbols (Page 2334)
How to Display STEP 7 Symbols (Page 2332)
Tag Selection Dialog (Page 2331)
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15.7.3

Tag Bar

15.7.3.1

Tag Bar

Introduction
Using the tag bar, you can connect tags directly to object attributes and thus dynamize the
affected attributes. The tag bar is part of the Graphics Designer and is similar in layout to the
tag selection dialog.
Unlike the tag selection dialog, the tag bar remains open after an assignment operation and
allows a tag to be connected to an object attribute by means of simple drag and drop.
There are two locations where you can drop the tag:
● on an object in the picture (see below for object types)
● on an attribute in the Properties tab of the Object Properties dialog

Dropping on Object in Picture
If you drop the tag on a graphic object, you do not specify the attribute to be dynamized. The
following rules therefore apply:
The attribute to be dynamized is specified in the case of objects which have a simplified
configuration dialog. The table shows the objects and the dynamized attribute.
Object

Attribute

I/O Field

Output value

Bar

Process driver connection

Status display

Current status

Text list

Output value

Check box

Selected fields

Option button

Selected fields

Slider object

Process driver connection

The used update cycle is the default cycle set in the Default Object Settings tab of the Settings
dialog. You open the Settings dialog under the Extras ->Settings... menu.
No tags can be dropped on standard objects, e.g. circles and lines.

Dropping on Attribute:
Drop the tag on an attribute in the Properties tab of the Object Properties dialog. This attribute
is then dynamized by the tag.

See also
How to Transfer STEP 7 Symbols (Page 2336)
How to Select STEP 7 Symbols (Page 2342)
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Tag Selection Dialog (Page 2331)

15.7.3.2

How to Display STEP 7 Symbols

Introduction
The tag bar is part of the Graphics Designer. Unlike the tag selection dialog, the tag bar remains
open after an assignment operation.
The tag bar has a tag filter. In this field you can use the placeholders £*£ and £?£ to specify
a search condition for the tag name. Only alphanumeric characters can be used for the name
search. Exit the field using the Tab or Enter key. Only those tags which match your search
criterion are then displayed.
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Requirement
● The Graphics Designer must be open.

Procedure
1. Open the list of toolbars by choosing View > Toolbars from the menu. Select Tags and
acknowledge with OK.
2. Click on the plus sign in front of the FDLCP5412/A2 icon S7 icon. Select the DB directory.
The global data blocks are then displayed.

3. Open and select the global data block to display its contents.

See also
Tag Bar (Page 2339)
How to Transfer STEP 7 Symbols (Page 2336)
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How to Select STEP 7 Symbols (Page 2342)
Tag Selection Dialog (Page 2331)

15.7.3.3

How to Select STEP 7 Symbols

Introduction
You can perform process connection by simply dragging the STEP 7 symbol onto an object
or an object attribute.
The selected symbol is then labeled in STEP 7 as operator-controllable and monitorable and
transferred to the Tag Management of WinCC by implicitly running the "Compile OS" function.
Note
If you select the symbol of a global data block, all elements provided with the operatorcontrollable and monitorable attributes of this block are transferred implicitly to Tag
Management of WinCC.

Requirements
● The tag bar must be open.
● The STEP 7 symbols must be displayed.

Procedure
1. Select the desired symbol.
2. Drag the symbol onto the desired object or the object attribute.
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3. If the "Compile OS" function or the implicit transfer has not yet been run, you must select
the desired channel unit (once only) via which communication with the AS is to be set up.
In this case, you select the desired network connection.

4. Check the created dynamic in the Object Properties.

See also
Tag Bar (Page 2339)
How to Transfer STEP 7 Symbols (Page 2336)
How to Display STEP 7 Symbols (Page 2340)
Tag Selection Dialog (Page 2331)
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15.8

Diagnostic Support

15.8.1

Diagnostic Support

Introduction
With the network entry jump and the entry jump into the hardware diagnostics, you can jump
directly into STEP 7 from WinCC Runtime. This allows you to diagnose faults quickly and easily.
You can configure the following jumps:
● Network entry jump into the program editor LAD/FBD/STL of STEP 7. You can perform the
entry jump with or without the operator authorization check.
● Network return jump from the STEP 7 program editor into the picture in which the process
tag belonging to the symbol is used.
● Entry jump to the STEP 7 Hardware Diagnosis function of the respective AS. The entry
jump can be completed with or without check of the access authorization.

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 2351)
Jump to Hardware Diagnosis (Page 2351)
How to Configure the Network Entry Jump (Page 2345)
Network Entry Jump (Page 2344)
Network Return (Page 2348)

15.8.2

Network Entry Jump

15.8.2.1

Network Entry Jump

Introduction
With the network entry jump, you can jump directly from WinCC Runtime into the appropriate
program editor LAD / FBD / STL of STEP 7 with the focus on the STEP 7 symbol belonging
to the process tag. This allows you to diagnose faults quickly and easily.
You can configure the network entry jump with or without operator authorization check.

With Operator Authorization Check
For full access to the program editor of STEP 7, you must be logged on at the system and
have the authorization required for the network entry jump in Runtime. If you do not have this
authorization, you are only granted read access to the blocks in the program editor.
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Without Operator Authorization Check
You have read and write access to all blocks in the program editor.

See also
How to Configure the Network Entry Jump (Page 2345)
How to Configure the Entry Jump into the Hardware Diagnostics (Page 2351)
Jump to Hardware Diagnosis (Page 2351)
Network Return (Page 2348)

15.8.2.2

How to Configure the Network Entry Jump

Introduction
In WinCC, you use the Dynamic Wizard to configure the network entry jump at an object created
in the Graphics Designer.

Requirements
● The "Compile OS" function has been executed.
● A reference list has been generated in the S7 program.
● If you want to configure an operator authorization with its own user level, you must have
created the level with the User Administrator beforehand.
● Because the entry jump takes place by a process tag, the process tag has to exist in the
S7 connection generated during "Compile OS". STEP 7 icons can be "compiled" implicitly
in the tag selection dialog.

Procedure
1. Insert a graphic object such as a "button" into the picture.
2. Select the object.
3. Start the Dynamic Wizard by choosing "View >Toolbars" from the menu.
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4. Open the "Network Entry Jump" wizard on the "Standard Dynamics" tab by double-clicking.

5. The wizard then guides you through the necessary configuration steps. Select the trigger
with which the network entry jump is to be executed. Then click "Continue".
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6. Select an attribute of the object such as "ToolTipText". This attribute is connected to the
tag selected in the following step.

7. Now set the tag for which the network entry jump is to apply. Click the selection button to
open the tag selection dialog. Select a tag and then close the dialog box by clicking "OK".
Then click "Continue".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2347

Integration of WinCC in SIMATIC Manager
15.8 Diagnostic Support
8. Set whether the STEP 7 write authorization is to be checked when the network entry jump
is performed. If you want a check to be performed, you must also set the authorization level.
Then click "Continue".

9. An overview of the options you have selected is displayed. Check the options and then
click "Finish".
If in Runtime you then select the button you have just configured, the program editor LAD /
FBD / STL of STEP 7 is opened and the place of use of the selected tags is displayed.

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 2351)
Jump to Hardware Diagnosis (Page 2351)
Network Entry Jump (Page 2344)
Network Return (Page 2348)

15.8.3

Network Return

Introduction
Use the network return to jump from a STEP 7 symbol to the entry point picture.
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Configuration Rule
Note the following during configuration of your WinCC pictures or picture windows in which
you have also used STEP 7 tags:
● It is advisable to use only basic pictures in the entire WinCC project.
● If you want to use picture window systems, you must ensure that all calls of the network
entry jump and all possible return jump destinations are configured on the same picture
level. That is to say, either within basic pictures, or within picture windows in basic pictures,
or within picture windows in picture windows. Possible return jump destinations are all
pictures in which tags are used that are also used in STEP 7.

Requirements
● The WinCC pictures and picture windows must observe the configuration rule.
● A network entry jump out of WinCC must have been performed.
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Procedure
1. Select the desired symbol in the program editor LAD / FBD / STL.

2. Select the entry "Show picture" in the shortcut menu.
3. If the symbol is used in just one picture, this picture is opened and displayed in Runtime.
If the symbol is used in more than one picture, you can select the desired picture using a
selection list.

If the selected symbol is not used in any picture, you can view the current picture in Runtime.

See also
How to Configure the Network Entry Jump (Page 2345)
How to Configure the Entry Jump into the Hardware Diagnostics (Page 2351)
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Jump to Hardware Diagnosis (Page 2351)
Network Entry Jump (Page 2344)

15.8.4

Jump to Hardware Diagnosis

15.8.4.1

Jump to Hardware Diagnosis

Introduction
The entry jump into the hardware diagnostics enables you to jump directly from WinCC
Runtime into the STEP 7 function Hardware Diagnostics of the associated AS. It therefore
allows faults to be diagnosed quickly and easily.
You can configure the entry jump into the hardware diagnostics with or without operator
authorization check.

With Operator Authorization Check
For full access to the hardware diagnostics of STEP 7, you must be logged on at the system
and have the authorization required for the entry jump in Runtime. If you do not have this
authorization, only read access is possible.

Without Operator Authorization Check
You have full access to the hardware diagnostics.

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 2351)
How to Configure the Network Entry Jump (Page 2345)
Network Entry Jump (Page 2344)
Network Return (Page 2348)

15.8.4.2

How to Configure the Entry Jump into the Hardware Diagnostics

Introduction
You can configure the entry jump into the hardware diagnostics at an object created in the
Graphics Designer. A separate wizard for the entry jump into the hardware diagnostics is not
available which means that you have to use and modify the "Network Entry Jump" wizard.
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Requirements
● The "Compile OS" function has been executed.
● If you want to configure an operator authorization with its own user level, you must have
created the level with the User Administrator beforehand.
● The connection parameters to the automation system are determined by means of a
process tag. A process tag therefore has to exist in the S7 connection generated during
"Compile OS". STEP 7 icons can be "compiled" implicitly in the tag selection dialog.

Procedure
1. Insert a graphic object such as a "button" into the picture.
2. Select the object.
3. Start the Dynamic Wizard by choosing "View >Toolbars" from the menu.
4. Open the "Network Entry Jump" wizard on the "Standard Dynamics" tab by double-clicking.
5. The wizard then guides you through the necessary configuration steps. Select the trigger
with which the network entry jump is to be executed. Then click "Continue".
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6. Select an attribute of the object such as "ToolTipText". This attribute is connected to the
tag selected in the following step.

7. Set the tag via which the entry jump is to be performed. Click the selection button to open
the tag selection dialog. Select a tag and then close the dialog box by clicking "OK". Then
click "Continue".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2353

Integration of WinCC in SIMATIC Manager
15.8 Diagnostic Support
8. Specify whether or not to check the STEP 7 write authorization upon network entry jump.
If you want a check to be performed, you must also set the authorization level. Then click
"Continue".

9. An overview of the options you have selected is displayed. Check the options and then
click "Finish".
10.When the entry jump is configured, a script is created which executes the jump. You must
rewrite this script for a jump into the hardware diagnostics. To do so, open the Pop-up menu
of the objects which you are using, and choose the "Properties" option to open the "Object
Properties" dialog box.
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11.Open the "Event" tab and navigate to "Button > Mouse > Mouse Action".

12.Double-click the symbol in the "Action" column. The editor opens and displays the script.

13.Replace the entry "GetKopFupAwl" with "HWDiag".
14.Close the dialog box and compile the changed script.
You can return to WinCC after entering hardware diagnostics by closing the hardware
diagnostic program, or by pressing <ALT>+<TAB>.
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See also
Jump to Hardware Diagnosis (Page 2351)
How to Configure the Network Entry Jump (Page 2345)
Network Entry Jump (Page 2344)
Network Return (Page 2348)
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16.1

16

Overview

Content
Smart Tools is a collection of programs which are useful when working with WinCC.
It contains the following programs and files:
● Tag Simulator
● Dynamic Wizard Editor
● Documentation Viewer
● WinCC CrossReferenceAssistant
Note
Smart Tools are supplementary tools. Bear in mind that they may have an impact on how
WinCC works, such as on its Runtime behavior and memory requirements.
As far as user friendliness and functionality are concerned, the same criteria as for the WinCC
Basis software do not necessarily apply.

See also
The Tag simulator (Page 2358)
Dynamic Wizard Editor (Page 2364)
WinCC Documentation Viewer (Page 2440)
WinCC CrossReferenceAssistant (Page 2443)
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16.2

Tag simulator

16.2.1

The Tag simulator

Short description
The tag simulator is used to simulate internal tags and process tags.
A typical area of application for the tag simulator is the testing of a configuration without
connected process peripherals or with connected process peripherals but without a running
process.
Without a connected process, only internal tags may be simulated.
In case of connected process peripherals, the process tags may be directly supplied with
values by the tag simulator. This allows you to perform a function test of the HMI system using
the original hardware.
The updating time for tag values is one second. Any changes take effect only upon activation
of the functions or changes of the project folder.
A maximum number of 300 tags may be configured.
Another possible application for the tag simulator is the implementation of a project for
demonstration purposes.
There is often no system connection for the presentation of the HMI system. In these cases,
the simulation will control the internal tags.
A detailed description of the tag simulator is to be found in the respective online help.
WARNING
The tag simulator writes the process values into the connected automation system. This
means that a possible reaction of connected process peripherals has to be taken into account.

16.2.2

Using the tag Simulator
A typical area of application for the tag simulator is the testing of a configuration without
connected process peripherals or with connected process peripherals but without a running
process.
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Simulation of process tags without process peripherals
Without a connected process, only internal tags may be simulated. In order to simulate the
process off-line, the following procedure is recommended:
1. Make a backup copy of your project by copying your project folder and renaming it to, for
example, xxx_sim. Use this backup copy as your test object. Open WinCC with this copied
project.
2. Use the functions "Cut" and "Paste" to add the tags to be simulated to the internal tags. Do
not use "Copy" and "Paste", otherwise WinCC Explorer will automatically generate an
extension to the tag name to ensure that tag names are unique in the project. The address
information of tags declared as internal tags will thus be lost.
3. With the aid of the simulator, the tags can now be supplied with values.
4. Once the test phase is over, you can continue your work with the original project.

Simulation of process tags With connected process peripherals
In case of connected process peripherals, the process tags may be directly supplied with
values by the tag simulator. This allows you to perform a function test of the HMI system using
the original hardware, such as e.g.:
● Checking limit value levels, message output.
● Testing the continuity of alarms, warnings, error messages and checking status displays.
● Presetting, reading and modifying digital and analog inputs and outputs.
● Alarm simulation.

16.2.3

Functions of the simulator

Introduction
The simulation provides the configurator with six different functions. These functions allow to
supply the configured objects with realistic values.
To test different cases, the simulation offers 6 functions. Each tag can be assigned one of
these 6 functions.

Sine
As periodic non-linear function.

Oscillation
For simulating jumps of a reference variable.
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Random numbers
The "Randon numbers" function makes randomly created values available to the user.

Increment
An up counter beginning with the minimum value again after reaching the maximum value.

Decrement
A down counter beginning with the maximum value again after reaching the minimum value.

Slider
A slider allowing the user to set a fixed value.

16.2.4

Installing the simulator
The tag simulator can be installed in two different ways:

Procedure
1. During WinCC setup, select "WinCC V7 Typical" from the "Programs" dialog.
WinCC is installed with the SmartTools.
Start the tag simulator by selecting "SIMATIC > WinCC > Tools > WinCC Tag Simulator".

Alternative procedure
You can also install the tag simulator application from the WinCC DVD.
1. Switch to the WinCC DVD directory "WinCC\InstData\Smarttools\Setup".
2. Double-click setup.exe.
3. Select the entry "WinCC Tag Simulator" in the "Components" dialog.
4. Click "Next". Follow the on-screen instructions.

Starting the simulator
The simulator Simulation.exe can either be started via Windows Explorer, or you can enter it
in the startup list of WinCC Explorers, whereby it will automatically start whenever a project is
activated.
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An activated project in WinCC Explorer is required for the proper operation of the simulator. If
the simulator has been added to the startup list of the project, this prerequisite is satisfied
automatically.

16.2.5

Adding/deleting tags

Adding new tags
Using the menu commands "Edit/New Tag", tags can be added to the simulation. For this
purpose, the tag selection dialog of the WinCC Explorer will be called, in which the desired
tags from the active project can be selected. If new tags are to be created, this can be
performed in the tag selection dialog as well. By confirming the selection with the "OK" button,
the previously selected tag is entered in the "Properties..." tab of the simulator. There you may
specify how the tag value is to be changed.
For final acceptance into the simulator the tag tab control must be clicked before the next tag
is added.
The configured tag simulation can be saved in a configuration file with the file extension "sim".

Removing tags
If a tag is to be removed from the simulator list, it must be selected and deleted by clicking the
menu item "Edit/Delete Tag". The selected tag will then be deleted from the list of tags to be
simulated without confirmation dialog.

16.2.6

Parameter assignment of the functions
The function parameters can be set individually for each tag.

Sine wave
For the sine function the value range can be set by means of the Amplitude parameter.
The zero point for the value range can be defined with Offset.
The period is set by means of the parameter Period of oscillation (set value * cycle time).

Oscillation
The parameter Setpoint is used to define the value kept after the transient reaction.
The parameter Overshoot specifies how much the values may deviate from the setpoint value
if the attenuation is set to zero.
The parameter Period of oscillation defines the time interval. After the time interval has elapsed,
the oscillation begins anew.
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Random numbers
The parameters Lower limit and Upper limit specify the interval for the random numbers.

Increment
The parameters Start value and Stop value specify the interval for the up counter.

Decrement
The parameters Start value and Stop value specify the interval for the down counter.

Slider
The parameters Start value and Stop value define the adjustment range of the slider.

16.2.7

Activating/deactivating tags
For a smooth transition from offline configuration to online configuration the tags can be
individually activated and deactivated via an own check box.
If the tag is enabled, the simulation calculates the values and transfers them to the WinCC
Explorer.
If the check box is not activated, the simulation does not transfer values to the WinCC Explorer.

16.2.8

Display of the tags
In the configuration phase, tag control is facilitated for the configurator by displaying the
following information in the Tags tab:
● current WinCC project
● name of the tag
● assigned function
● status (active / inactive)
● present value
Upon selecting the name of a tag, the other parameters are entered in the "Properties" tag.

16.2.9

Loading/saving simulation data
The simulation data can be saved so that they are available when restarting the simulator.
This is done by selecting the menu items "File/Save" or "File/Save as...".
A simulation configuration already saved is loaded by means of the menu commands "File/
Open".
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When starting the simulator the last used configuration related to a WinCC project is
automatically loaded.

16.2.10

FAQ

Error with DM-API, DLL not found
Errors occuring when calling the simulator in connection with DLLs are due to a missing path
instruction in the file AUTOEXE.BAT. Check this file for the following entry in the path
instruction:
SET PATH = .....;<WinCC drive>:\<WinCC directory>\bin
e.g.: SET PATH=C:\SIEMENS\WINCC\BIN;
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16.3

Dynamic Wizard Editor

16.3.1

Dynamic Wizard Editor

Short description
The Dynamic Wizard Editor is a tool for creating own Dynamic Wizards. Dynamic Wizards
allow frequently reoccuring configuration processes to be automated.

16.3.2

Overview

Introduction
The Dynamic Wizard brings additional functionality to Graphics Designer. It assists the user
in handling frequently reoccurring configuration sequences. This reduces the configuration
effort and the risk of configuration errors.
The Dynamic Wizard consists of a variety of Dynamic Wizard functions. A large number of
Dynamic Wizard functions are already supplied. And these can be further extended with
functions that you create yourself.
An editor is included for creating your own Dynamic Wizard functions. This editor is the program
dynwizedit.exe.
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All of the Dynamic Wizard functions are stored in a data basis (...\WinCC\wscript\Dynwiz.cwd)
on the hard disk. The Dynamic Wizard has a standardized display and user interface for
selecting and parameterizing the Dynamic Wizard functions. After a Dynamic Wizard function
has been selected, Dynamic Wizard will load it into memory and start it.
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Interface between Dynamic Wizard and Dynamic Wizard function
The link between Dynamic Wizard and the Dynamic Wizard function is made using a system
interface in the Dynamic Wizard function. The structure of this interface is defined. This
interface contains information, which Dynamic Wizard can evaluate.
Essential content of the interface:
Reference to the process function
The process function is the intended main function of the Dynamic Wizard. It contains the
"service", which a Dynamic Wizard function provides for the user, e.g. the creation of an action
on a graphic object.
The options list defines the parameters, which are required for the process function. It also
defines how they are specified using the dialog's user interface.
The trigger list List defines the triggers to be linked to the generated object. It also defines how
they are specified using the dialog's user interface.

See also
Trigger list (Page 2380)
Options list (Page 2377)

16.3.3

Installation of the Dynamic Wizard Editor
The Dynamic Wizard Editor can be installed in two different ways:

Procedure
1. During WinCC setup, select "WinCC V7 Typical" from the "Programs" dialog.
WinCC is installed with the SmartTools.
Start the Dynamic Wizard Editor by selecting "SIMATIC > WinCC > Tools".

Alternative procedure
You can also install the Dynamic Wizard Editor from the WinCC DVD.
1. Switch to the WinCC DVD directory "WinCC\InstData\Smarttools\Setup".
2. Double-click setup.exe.
3. Select "Dynamic Wizard Editor" in the "Components" dialog.
4. Click "Next". Follow the on-screen instructions.
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16.3.4

Structure

16.3.4.1

Structure
The Dynamic Wizard Editor comprises the following elements:
Menu bar
The menu bar contains the functions of the Dynamic Wizard Editor. The menu bar is always
visible.
Toolbar
The tool bar can be made visible as needed and dragged to any place on the screen with the
mouse.
Editor window
The Editor window is only visible if a Dynamic Wizard function has been opened to be edited
or a new one is created. Each function will be opened in its own editing window. Several editing
windows can be open at the same time.
Output window
The output window can be made visible as required. It shows the result of the functions "Create
CWD", "Read Wizard Script" and "Compile Script".
Status bar
The status bar can be made visible as required. It informs about the keyboard setting and the
position of the cursor in the editing window.
Dynamic Wizard
With the Dynamic Wizard, you can dynamize an object using C actions. When executing
wizards, preconfigured C actions and trigger events are defined and transferred to the object
properties.

See also
Output window (Page 2371)
Editor window (Page 2369)
Toolbar (Page 2368)
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16.3.4.2

Toolbar

Introduction
The toolbar allows you to execute actions more rapidly. You do not have to make several
selections through the menus until you reach the required function.

Icons
Icon

Description
Creates a new Dynamic Wizard function.
Opens an existing Dynamic Wizard function (*.wnf).
Saves the Dynamic Wizard function.
Cuts the selected text and copies it to the clipboard.
Copies the selected text to the clipboard.
Pastes the contents of the clipboard at the location of the cursor.
Prints the contents of the current editing window.
Displays additional information on the Dynamic Wizard Editor.
Creates the Dynamic Wizard data (CWD). This function is used to
read all wizard scripts available for the language that is currently
set and to condition these for processing in the Dynamic Wizard.
The file that is generated is stored in the WinCC installation path
(installation path\wscripts\dynwiz.cwd).
Reads in the wizard scripts and makes them available to the
Dynamic Wizard.
Sets the language for which the wizard script is configured. This
includes all languages known in WinCC, independent on the
installed languages.
A change of the wizard language has no effect on the overall system
or configuration interface.
Changes the object. The Dynamic Wizard is also available in the
editor for debugging actions and depends on the different
properties of an object in Graphics Designer.
You can debug a new or existing wizard script in the editor by using
this function to change to an existing object in an existing picture.
Based on this new object setting, the Dynamic Wizard is set up to
display only the wizard scripts that are suitable for this object.
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Icon

Description
Shows all Dynamic Wizard scripts for the selected language.
Moreover, wizard scripts existing in the dialog can be deleted from
the list.
Opens the Help Editor.
Compiles the script.

See also
Help Editor (Page 2370)

16.3.4.3

Editor window

Introduction
The editor window serves to create and edit Dynamic Wizard functions.
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Color coding
The C code is displayed with the following colors:

16.3.4.4

Color

Significance

blue

Keywords

green

Comments

red

Strings

black

other C code

Example

Help Editor

Introduction
Within this dialog a help text can be entered for each page created via the wizard script. Only
help texts for Dynamic Wizards already created can be entered.
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Elements of the Help Editor

16.3.4.5

Element

Description

Wizard group

This field is used to specify the group (=tab) containing the Dynamic Wizard.

Wizard name

This field is used to select the Dynamic Wizard for which a help text is to be created.

Page

This field is used to select the dialog page for which the help text is to be created.

Help text

In this field the help text will be entered.

Output window

Introduction
The output window shows the result of the functions "Create CWD", "Read Wizard Script" and
"Compile Script".

The output window helps to find errors in the scripts.
If there is an error in the script, the following message appears:
...\WinCC\wscripts\wscripts.deu\DemoWiz1.wnf(6):error(003a): 'include': invalid function
definition
Description
...\WinCC\wscripts\wscripts.deu\

Directory containing the wnf file.

DemoWiz1.wnf(6)

File name and line number where the error occurs

error(003a): 'include': invalid function definition

Error number and error description.
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16.3.5

Structure of a Dynamic Wizard function

16.3.5.1

Structure of a Dynamic Wizard function

Introduction
A Dynamic Wizard function must have a certain specified strructure. It corresponds to the
required components.
1. Integrating header files and DLLs
2. Language-dependent definitions
3. Wizard flags
4. Property list
5. System interface
6. Global variables
7. Options list
8. Trigger list
9. Display of parameter assignment

See also
Display of parameter assignment (Page 2382)
Trigger list (Page 2380)
Options list (Page 2377)
Global variables (Page 2377)
System interface (Page 2376)
Property list (Page 2375)
Wizard flags (Page 2374)
Language-dependent definitions (Page 2373)
Integrating header files and DLLs (Page 2373)

16.3.5.2

Dynamic Wizard dialog

Introduction
Each Dynamic Wizard option has its specific functionality. However, due to the predefined
function structure all functions have a similar sequence and a similar dialog interface. The
Dynamic Wizard dialog consists of several dialog pages.
● "Welcome to the Dynamic Wizard" dialog
● "Select trigger" dialog
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● "Set options" dialog
● "Finished !" dialog

16.3.5.3

Integrating header files and DLLs

Introduction
A header file contains declarations of constants, data types, tags and functions.
The header files are integrated into the function by means of an #include instruction. The most
important file to be integrated is the dynamic.h file, in which, among others, the functions for
designing the Dynamic Wizard interface are declared.

DLL files (Dynamic Link Library) are executable routines which can be loaded by a program if
this program requires so.
To be able to use DLL files, they are integrated into the function by means of a #pragma
instruction.

In the Dynamic Wizard Editor the following paths are defined:
WinCC header files: ...\WinCC\aplib\
WinCC DLLs: ...\WinCC\bin\
Should the files be stored in another directory, the complete path is to be specified in the
#include- and #pragma instructions.

16.3.5.4

Language-dependent definitions

Introduction
The Dynamic Wizard standard functions exist in the three languages German, English, and
French. When the language is changed in the WinCC Explorer, the respective language
version is also selected for the Dynamic Wizard functions.
Within the paths
..\WinCC\wscripts\wscripts.deu
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..\WinCC\wscripts\wscripts.enu
..WinCC\wscripts\wscripts.fra
a WNF file must exist for each wizard function.
Upon creation, all language-dependent definitions should be arranged in this section. This
facilitates the creation of other language versions.

16.3.5.5

Wizard flags

Introduction
These Flags are used to define configuration type for which the Dynamic Wizard function
applies.
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Flags
FLAG
WIZARD_FLAG_OCX

For all OCX files

WIZARD_FLAG_ALL_PROJECT_TYPES

For all projects

WIZARD_FLAG_SINGLEUSER_PROJECT For single-user projects only

16.3.5.6

WIZARD_FLAG_MULTICLIENT_PROJEC
T

For client projects

WIZARD_FLAG_MULTIUSER_PROJECT

For clients without project data only

Property list

Introduction
The property list defines the object types for which a Dynamic Wizard function can be used.
This is done by specifying a list of object properties. If an object has at least one of the listed
properties, the Dynamic Wizard function can be applied to it.

Each entry in the property list consists of two parameters:
● Property name, e.g., Backcolor in the English version.
● WinCC Data type
If an empty property list is used, the Dynamic Wizard function can be applied to all object types.
In any case, there must be a property list, even if it is empty.
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16.3.5.7

System interface

Introduction
The system interface is used to define the properties of the new Dynamic Wizard function.

Parameter description
1. The first parameter defines the tab on which the Dynamic Wizard function is to appear.
2. The second parameter defines the name under which the Dynamic Wizard function is to
appear.
3. The third parameter is always NULL.
4. The fourth parameter designates the name of the icon to be used for the Dynamic Wizard
function.
5. The fifth parameter is a help text with a more detailed description of the functionality of the
Dynamic Wizard function.
6. The sixth parameter is a list with the names of the functions created for the individual option
pages. This list is to be concluded by a NULL entry. A maximum of five option pages can
be created. Additional information on this topic may be found under "Options list".
7. The seventh parameter ist the name of the process function called after clicking on the
"Complete" button. The process function is the intended main function of the Dynamic
Wizard. It contains the "service", which a Dynamic Wizard function provides for the user,
e.g. the creation of an action on a graphic object.
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8. The eighth parameter is the name of the function which summarizes the setting on the
option pages and displays them for the user before the latter clicks on the Complete button.
Additional information on this topic may be found under "Display of parameter assignment".
9. The ninth parameter is a list of the triggers to be displayed on the trigger page. For the most
common applications, macros are available to fill this trigger list. Additional information on
this topic may be found under "Trigger list".

16.3.5.8

Global variables

Introduction
For each parameter to be set on the option pages a global variable must be defined. This is
to make sure that the set parameters are known in all created functions and can be utilized.
Data transfer between system functions is only possible by means of global variables. This is
always required when trigger and/or option parameters have to be transferred to the process
function.

16.3.5.9

Options list

Introduction
Options are parameters needed for the functionality of the Dynamic Wizard function. Options
do not require a trigger.
Options are defined in the options list of the system interface. For each option, the options list
contains the name of the assigned options function, e.g. "OnOption1".
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The options list is concluded by a NULL pointer. A maximum of five options may be defined
in the list.

Option functions
The Dynamic Wizard calls the option functions successively, according to their sequence in
the options list. For each option function the "Set options" dialog is displayed where the function
programs its specific entry.
There are wizard system functions available for programming the entry. Additional information
on this topic may be found under "Wizard system functions."
The "Set options" dialog makes available a defined area for arranging static texts, input fields
and other input boxes.
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In the "Set options" dialog, the area is completely filled with lines 1 to 15.
The corresponding option function is as follows:
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16.3.5.10 Trigger list
Introduction
Triggers are only required in connection with actions on a graphic object.
Triggers are defined in the trigger list of the system interface. The trigger list contains an entry
for each trigger.

The entry consists of two parameters. The first parameter is the designation of the trigger which
is shown in the interface, such as Click left mouse button. The second parameter gives the
name of the assigned trigger function.
The trigger list is concluded by a NULL pointer pair. A maximum of 50 triggers may be defined
in the list.
For the triggers used most frequently, predefined macros are available.
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Macro
JCR_TRIGGERS

Trigger events
DECLARE_JCR_TRIGGERS
Mouse click, Left mouse button, Right mouse button

JCR_ZYCL_TRIGGERS

cyclic triggers
DECLARE_JCR_ZYKL_TRIGGERS
Picture cycle, Window cycle, Upon change, 250 ms, 500 ms, 1 second,
2 seconds , 5 seconds, 10 seconds, 1 minute, 5 minutes, User cycle
1, User cycle 2, User cycle 3, User cycle 4, User cycle 5

JCR_ACTION_TRIGGERS

Action triggers
DECLARE_JCR_ACTION_TRIGGERS

The "Select trigger" dialog is created from the trigger list. All trigger designations are displayed
in a list box for selection.
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After selecting a trigger, the Dynamic Wizard calls the assigned trigger function.

16.3.5.11 Display of parameter assignment
Introduction
Trigger and option parameters can be displayed in the "Finished !" dialog. This allows the user
to recheck the parameterization and change it, if required.
In the display field of the "Finished !" page, a text can be displayed using the Windows function
SetWindowText The height of the display field is 12 lines.
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16.3.5.12 Wizard Functions for parameter input
CreateStatic
Introduction
In the "Set options" dialog a static text is displayed for the x,y coordinates.

Syntax
HWND CreateStatic (int x, int y, char* "Text")

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

char* Text

Shows the displayed text.
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Return value
Return value
HWND

returns the object handle.

Example
The following excerpt from the file "Demo.wnf" shows the use of this function.

char* DynWizEditStatic = "Enter a text:";
...
..
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
strcpy(g_szEdit,DynWizEdit);
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bFirst = FALSE;
}
//Static text
CreateStatic(0,5,DynWizEditStatic);
.....
......
}

CreateEdit
Introduction
In the "Set options" dialog an input field is displayed for the x,y coordinates. A text can be typed
in this input field.

Syntax
HWND CreateEdit ( int x, int y, char* pText )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

char* pText

Pointer to an input buffer. The input buffer may have a predefined value. This is
displayed in the input field.

Return value
Return value
HWND

Returns the object handle

pText

Input buffer contains the entered text.
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function.
An input field is displayed in the "Set options" dialog of the "Demo Wizard".

char* DynWizEditStatic = "Enter a text:";
char* DynWizEdit = "Sample text";
...
..
char g_szEdit[256];
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
strcpy(g_szEdit,DynWizEdit);
bFirst = FALSE;
}
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//Static text for the input field
CreateStatic(0,5,DynWizEditStatic);
//Input field
hWnd = CreateEdit(0,20,g_szEdit)
GetWindowRect(GetParent(hWnd), &rect);
MoveWindow(hWnd,0,20,(rect.right-rect.left),21,TRUE);
.....
......
}

CreateSpinEdit
Introduction
In the "Set options" dialog an input field with controls is displayed for the x,y coordinates.
This input field is used to enter an integer value into an entry variable.

Syntax
HWND CreateSpinEdit (int x, int y, int* pValue, int Min, int Max, int Base )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

int* pValue

Pointer to an integer entry variable. The entry variable may have a predefined
default value.

int Min

Lower limit for the input value

int Max

Upper limit for the input value

int Base

Input number format:
10 = decimal input
16 = hexadecimal input

Return value
Return value
HWND

Returns the object handle.

pValue

Entry variable contains the entered value.
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function.
An input field with controls is displayed in the "Set options" dialog of the "Demo Wizard". You
can select a value between 0 and 1000 there.

char* DynWizSpinStatic= "Enter a value (0 - 1000):";
char* DynWizEdit = "Sample text";
...
...
char g_szEdit[256];
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
strcpy(g_szEdit,DynWizEdit);
bFirst = FALSE;
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}
...
...
//Static text for the input field with controls
CreateStatic(0,50,DynWizSpinStatic);
...
//Input field with controls
hWnd = CreateSpinEdit(0,65,&g_iSpinEdit,0,1000,10);
MoveWindow(hWnd,0,65,(rect.right-rect.left)/4,21,TRUE);
...
...
}

CreateListBox
Introduction
In the "Set options" dialog a selection field is displayed for the x,y coordinates. The selection
field allows listing several entries. By clicking the mouse, one entry can be selected.

Syntax
HWND CreateListbox (int X, int Y, char* Headline, int NumLines, int* pSelect )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

char* Headline

Header of the selection field

int NumLines

Number of lines in the selection field. The following must be specified:
NumLines = Number of lines + 1 (1 =< NumLines = <16)

int* pSelect

Pointer to the result variable
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Return value
Return value
HWND

Returns the object handle.

pSelect

Number of the selected entry. The number is the index in the list (beginning with
0).

Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" a selection field is displayed. The possible size of the
selection field is three lines. As more than three entries exist, a scroll bar is displayed.
Note
With the function "CreateListbox" only the selection field itself is created. The line content
must be entered using the function "SendMessage".

char* DynWizListStatic= "Select an entry:";
...
int g_iListBox = 0;
//Type definition of the elements in the selection field
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typedef struct listboxItem
{
int iIndex;
char szItemText[256];
}LB_ITEM, *PLB_ITEM;
#define LB_NUM_LINES 5
LB_ITEM g_itemListBox[LB_NUM_LINES] =
{
{ 0, "First Element"},
{ 1, "Second Element"},
{ 2, "Third Element"},
{ 3, "Fourth Element"},
{ 4, "Fifth Element"}
};
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
strcpy(g_szEdit,DynWizEdit);
bFirst = FALSE;
}
...
...
//Static text for the selection field
CreateStatic(0,162,DynWizListStatic);
...
//Selection field
hWnd = CreateListbox(0,177,"Headline",LB_NUM_LINES,&g_iListBox);
MoveWindow(hWnd,0,177,(rect.right-rect.left),50,TRUE);
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//With the function "CreateListbox" only the box itself is created. The line content must be
entered using //the function "SendMessage".
for (i=0; i<LB_NUM_LINES; i++)
{
SendMessage(hWnd,LB_INSERTSTRING,(WPARAM)-1,
(LPARAM)g_itemListBox[i].szItemText);
}
}

CreateCheckBox
Introduction
In the "Set options" dialog a check box is displayed for the x,y coordinates. This check box
allows enabling an option. In a dialog, several check boxes can be used.

Syntax
HWND CreateCheckBox (int x, int y, char* Text, BOOL* pSelect )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

char* Text

Text displayed right of the check box.

BOOL* pSelect

Pointer to the result variable. The result variable should be preassigned a default
value (True/False).

Return value
Return value
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HWND

Returns the object handle.

pSelect

Activation status
FALSE = not activated
TRUE = activated
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" three check boxes are displayed, each one representing
an option. Each option can be independently activated.

BOOL g_bCheck1 = TRUE;
BOOL g_bCheck2 = TRUE;
BOOL g_bCheck3 = TRUE;
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
...
}
...
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...
//Check box
iMid = (rect.right-rect.left)/2 ;
CreateCheckBox(iMid,100,"CheckBox 1",&g_bCheck1);
CreateCheckBox(iMid,116,"CheckBox 2",&g_bCheck2);
CreateCheckBox(iMid,132,"CheckBox 3",&g_bCheck3
}

CreateFrame
Introduction
In the "Set options" dialog a rectangular border is displayed. The left upper corner of the frame
is defined by the x,y coordinates. The right lower corner of the frame is identical to the right
lower corner of the option window.

Syntax
HWND CreateFrame (int x, int y, char* Title )

Parameters
Parameters

Description

int x

Shows the value of the X coordinate.

int y

Shows the value of the Y coordinate.

char* Title

Label at the top edge of the rectangle

Return value
Return value
HWND
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Returns the object handle.
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" a frame bearing the title "Frame" is displayed.

void OnOption2(void)
{
//Frame
CreateFrame(0,150,"Frame");
}
...
...

CreateRadioButton
Introduction
In the "Set options" dialog a radio button is displayed for the x,y coordinates. This radio button
allows enabling an option.
Using radio buttons is only useful if there are several of them in a dialog. There is only one
radio button active at a time.
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Syntax
HWND CreateRadioButton (int x, int y, char* Text, BOOL* pSelect )

Parameters
Parameters

Description

int x

Shows the value of the X coordinate.

int y

Shows the value of the Y coordinate.

char* Text

Name of the option activated with the radio button. The text is displayed to the
right of the radio button.

BOOL* pSelect

Pointer to the result variable. The result variable should be preassigned a default
value (True/False).

Return value
Return value
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Returns the object handle.

pSelect

Activation status:
FALSE = not activated
TRUE = activated
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" three radio buttons are displayed, each one representing
an option. Only one option can be activated.

BOOL g_bOption1 = TRUE;
BOOL g_bOption2 = FALSE;
BOOL g_bOption3 = FALSE;
void OnOption1(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
.....
if (bFirst == TRUE)
{
...
}
...
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...
//Radio buttons
CreateRadioButton(0,100,"RadioButton 1",&g_bOption1);
CreateRadioButton(0,116,"RadioButton 2",&g_bOption2);
CreateRadioButton(0,132,"RadioButton 3",&g_bOption3);
}

CreateFileBrowser
Introduction
In the "Set options" dialog an input field with a Browse button is displayed for the x,y
coordinates. A file name can be typed in this input field.

Clicking the Browse button opens a file selection dialog.

Syntax
HWND CreateFileBrowser (int x, int y, DWORD Flags, char* Filter, char* Dateiname )

Parameters
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Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.
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Parameters

Description

DWORD Flags

Control flag of the selection window:
FB_WITHPATH = File name with path
FB_SAVE_AS = Instead of the Open dialog the "Save as" dialog appears.

char* Filter

Filter for the data type display in the selection field of the file selection dialog.
By specifying the extension, the data types to be shown in the selection field
are defined.
A filter consists of a string pair. The first string is the filter name. The second
string is the filter function in the format *.typ, 'typ' being a file extension. The
selection field only shows files with this extension. 1. and second string are
separated by |. Several filters can be stringed by |. The last filter is delimited
with ||.
Examples:
char* Filter1 = "Graphic pictures (*.PDL) | *.PDL||";

char* Filter2 = "Documents (*.doc) | *.doc|"
"Text files *.txt | *.txt|"
"WNF files | *.wnf|"
"All files (*.*) | *.*||";

No blanks are allowed at the end of the filter function.
char* File name

Input buffer for the file name. A path name can be defined as default value.
This standard value has the following effect:
The path name is displayed in the input window by default.
Clicking on the Browse button sets the path in the file selection dialog. If the
file name has the extension '*.typ', all files of this type are shown in the
selection field of the selection dialog.

Return value
Return value
HWND

Returns the object handle.

File name

Input buffer contains the file name.
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Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" an input field with a Browse button is displayed. Clicking
on the Browse button opens the file selection dialog.

char* DynWizFileBrowserStatic = "Select a file:";
char* DynWizFileBrowser = "C:\\Sample file";
char* DynWizFilter = "Text files (*.txt) | *.txt|"
"All files (*.*) | *.*||";
...
char g_szFileBrowser[256];
...
void OnOption2(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
RECT rect;
...
if (bFirst == TRUE)
{
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...
strcpy(g_szFileBrowser,DynWizFileBrowser);
First = FALSE;
}
...
...
// Static text for the input field with Browse button
CreateStatic(0,95,DynWizFileBrowserStatic);
//File selection dialog
hWnd =
CreateFileBrowser(0,110,FB_WITHPATH,DynWizFilter,g_szFileBrowser);
MoveWindow(hWnd,0,110,(rect.right-rect.left),21,TRUE);
}

CreateVarBrowser / CreateVarBrowserEx
Introduction
In the "Set options" dialog an input field with a Browse button is displayed for the x,y
coordinates. A tag name can be typed in this input field. Clicking on the Browse button opens
the WinCC tag selection dialog. The function "CreateVarBrowserEx" allows the additional
parameterization of a tag filter. This filter limits the tags displayed in the tag selection dialog.
Filtering is possible by data type, tag group, tag name and connection.

Syntax
HWND CreateVarBrowser (int x, int y, char* VarName )
HWND CreateVarBrowserEx (int x, int y, LPDM_VARFILTER VarFilter, char* VarName )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

LPDM_VARFILTER VarFilter

Optional indication of a pointer to the tag filter. When specifying a
NULL pointer no filter is active.
The tag filter must be defined by means of the structure
DM_VARFILTER. Additional information on this topic may be
found in the WinCC ODK documentation.

char* VarName

Contains the tag name. The tag name may have a predefined
default value. This entry is always displayed.
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Return value
Return value
HWND

Returns the object handle.

VarName

Input buffer contains the tag name

Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" an input field with a Browse button is displayed. Clicking
on the Browse button opens the WinCC tag selection dialog.

char* DynWizVarBrowser = "Sample tag";
char* DynWizPicBrowserStatic = "Select a picture:";
...
char g_szVarBrowser[256];
...
void OnOption2(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
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RECT rect;
...
if (bFirst == TRUE)
{
...
strcpy(g_szVarBrowser,DynWizVarBrowser);
First = FALSE;
}
...
...
// Static text for the input field with Browse button
CreateStatic(0,95,DynWizFileBrowserStatic);
//Tag selection dialog
hWnd =
CreateFileBrowser(0,110,FB_WITHPATH,DynWizFilter,g_szFileBrowser);
GetWindowRect(GetParent(hWnd), &rect);
MoveWindow(hWnd,0,110,(rect.right-rect.left),21,TRUE);
}

CreatePackageBrowser/CreatePackageBrowserEx
Introduction
In the "Set options" dialog an input field with a Browse button is displayed for the x,y
coordinates. A name can be typed in this input field. The package browser is enabled by clicking
on the Browse button at the right edge of the input field. The flag or the ProgID defines the
type of data to be shown from the package.
With the function "CreatePackageBrowserEx" a ProgID can be transferred instead of a flag.

Syntax
HWND CreatePackageBrowser (int x, int y, DWORD flags, char* Name )
HWND CreatePackageBrowserEx (int x, int y, char* ProgID, char* Name )

Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.
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Parameters

Description

DWORD flags

Currently only PB_PICTURE can be used. This enables picture
selection.

char* ProgID

Programmatic ID of the component used for building the selection.
By transfering "WinCC.CCFileASOStub.1" the picture selection is
addressed.

char* Name

Contains the name. The name may have a predefined default
value. This entry is always displayed.

Return value
Return value
HWND

Returns the object handle.

Name

Input buffer contains the name

Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" an input field with a Browse button is displayed. Clicking
on the Browse button opens the picture selection dialog.

char* DynWizPicBrowserStatic = "Select a picture:";
char* DynWizPicBrowser = "Sample picture";
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...
char g_szPicBrowser[256];
...
void OnOption2(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
RECT rect;
...
if (bFirst == TRUE)
{
...
&#9;strcpy(g_szPicBrowser,DynWizPicBrowser);
First = FALSE;
}
...
...
// Static text for the input field with Browse button
CreateStatic(0,50,DynWizPicBrowserStatic);
//Picture selection dialog
hWnd = CreatePackageBrowser(0,65,PB_PICTURE,g_szPicBrowser);
MoveWindow(hWnd,0,65,(rect.right-rect.left),21,TRUE);
}

CreateObjectBrowser
Introduction
In the "Set options" dialog an input field with a Browse button is displayed for the x,y
coordinates. An object or property name can be typed in this input field. Clicking on the Browse
button opens a selection dialog. In this selection dialog an object or property name can be
searched and selected.

Syntax
HWND CreateObjectBrowser (int x, int y, char* Title, DWORD flags, char* ObjectName )
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Parameters
Parameters

Description

int x

Shows the value of the x coordinate.

int y

Shows the value of the y coordinate.

char* title

Label of the selection dialog.

DWORD flags

Two different flags can be transferred:
OB_OBJECTS Display of all objects
OB_PROPERTIES Additionally the property selection is offered.

char* ObjectName

Input buffer for the object or property name. The input buffer can
be set to a default value.

HWND

Returns the object handle.

ObjectName

Input buffer contains the object or property name

Return value
Return value

Example
The following excerpt from the file "Demo.wnf" shows the use of this function. In the "Set
options" dialog of the "Demo Wizard" an input field with a Browse button is displayed. Clicking
on the Browse button opens the window objet selection dialog.
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char* DynWizObjectBrowserStatic = "Select an object:";
char* DynWizObjectBrowser = "Object";
char* DynWizObject = "Window object selection";
;
...
char g_szObjectBrowser[256];
...
void OnOption2(void)
{
static BOOL bFirst = TRUE;
HWND hWnd = NULL;
RECT rect;
...
if (bFirst == TRUE)
{
...
strcpy(g_szObjectBrowser,DynWizObjectBrowser);
First = FALSE;
}
...
...
// Static text for the input field with Browse button
CreateStatic(0,50,&#9;CreateStatic(0,140,DynWizObjectBrowserStatic);
);
//Window selection dialog
hWnd =
CreateObjectBrowser(0,155,DynWizObject,OB_OBJECTS,g_szObjectBrowser)
;
MoveWindow(hWnd,0,155,(rect.right-rect.left),21,TRUE);
}
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16.3.5.13 Wizard functions for generating dynamics
GenerateBLOB
Introduction
The GenerateBLOB function (BLOB = Binary Large OBject) creates an action which can be
appended to a graphic object property. An action comprises 3 parts.
Prologue: This is the header of the C function.
Example:
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName,char* lpszObjectName,char*
lpszPropertyName, UINT nFlags, int x, int y)
{
The prologue depends on the trigger starting the action (in the above example: clicking the left
mouse button).
Epilogue: This is the end of the C function made up of the '}' symbol.
Core: This part contains the actual functionality of the C function. Example:
ProgramExecute("notepad.exe");
This function creates and compiles the C code of the action. The compilation results in a P
code. This code is interpreted and processed by the WinCC runtime system. In case of an
incorrect C code no P code is created.
The function creates a BLOB in which the parts of the action (C code, P code, trigger...) are
stored. Before the end of the wizard function the BLOB has to be deleted again. More detailed
information on deleting the BLOB function may be found unter "DeleteBLOB".

Syntax
AP_BLOB GenerateBLOB (char* Prolog, char* Epilog, char* Format, ... )

Parameters
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Parameters

Description

char* Prologue

Prologue of the action as ASCII string.

char* Epilogue

Epilogue of the action as ASCII string.

char* Format

Core of the action as ASCII string or format string according to the standard
function "printf".
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Note
The C codes are created by means of the C function sprintf. The parameter is processed as
format string, i.e. format control characters (e.g. \ % ") are evaluated. If these are to be
transferred into the C code (e.g. as format string for a printf call in an action), they must be
provided with a \.
Example:
\\
\
%
\%
"

\"

Return value
The function returns a structured tag of the type AP_BLOB with the following structural
components:
Structural component

Return value

DWORD dwPCodeSize

Length of the created P code in bytes

LPVOID lpPCode

Pointer to the created P code

int nErrors

Number of compiler errors

int nWarnings

Number of compiler warnings

Example
The following excerpt from the file "Execute Programm.wnf" shows the use of this function.
The wizard function creates a C script which starts another application (in this example:
notepad.exe).
...
...
void OnGenerate(void)
{
PCMN_ERROR pError;
AP_BLOB *blob;
char code[500];
char sError[500];
..
Slash2DblSlash(g_Picture, strlen(g_Picture));
..
sprintf(code,"%sProgramExecute(\"%s\");",ifcode,g_Picture);
..
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//Prologue
blob = GenerateBLOB("#include \"apdefap.h\"\r\n"
"void OnClick(char* lpszPictureName," "char*lpszObjectName,char*
lpszPropertyName,"
"UINT nFlags,int x, int y) {",
//Epilogue
"}",
//Core
code);
BEGIN_JCR_BLOBERRORS
SetAction(NULL, blob, g_Trigger);
END_JCR_BLOBERRORS
DeleteBLOB(blob);
}

Created C script
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName,
char* lpszObjectName,
char* lpszPropertyName,
UINT nFlags, int x, int y)
{
ProgramExecute("notepad.exe");
}

DeleteBLOB
Introduction
The GenerateBLOB function creates a BLOB. At the end of the wizard function the BLOB has
to be deleted again. The BLOB is deleted with the DeleteBLOB function.
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Syntax
void DeleteBLOB (AP_BLOB* blob)

Parameters
Parameters

Description

AP_BLOB* blob

Pointer to the result variable of the "GenerateBLOB" function.

Example
DeleteBLOB(blob);

SetAction
Introduction
An action is appended to the selected graphic object at the specified trigger.
If the trigger is an event, it is directly specified as calling parameter.
If the trigger is the dynamization of a property, it must be entered into the BLOB beforehand
using the functions AddVarTrigger or AddTimeTrigger.
Note
If the action is not to be appended to the selected object but to another one, the API function
PDLCSSetAction must be used. Further information on the function PDLCSSet Action may
be found in the WinCC ODK manual.

Syntax
BOOL SetAction (char* Property, AP_BLOB* Blob, DWORD Trigger )
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Parameters
Parameters

Description

char* Property

Property name. Always use the English name of the property. For
a trigger on an event a NULL pointer has to be transferred.

AP_BLOB* Blob

Pointer to the result variable of the "GenerateBLOB" function.

DWORD TriggerID

ID of the trigger:
NOTDEFINED = trigger is entered in the BLOB
MOUSECLICK = mouse click
MOUSELBUTTONDOWN = click left mouse button
MOUSELBUTTONUP = release left mouse button
MOUSERBUTTONDOWN = click right mouse button
MOUSERBUTTONUP = release right mouse button
KEYBOARDDOWN = press key
KEYBOARDUP = release key
OBJECTCHANGE = object change
PROPERTYCHANGE = property change
PICTUREOPEN = picture selection
PICTURECLOSE = closing of picture

Return value
Return value
BOOL return value

TRUE = Function completed successfully.
FALSE = Function not completed successfully.

Example
See example in GenerateBLOB function.

See also
GenerateBLOB (Page 2408)

AddTimeTrigger
Introduction
The function supplements the action with a trigger of the type "cyclic trigger".

Syntax
BOOL AddTimeTrigger (AP_BLOB* Blob, char* Name, DWORD TriggerType, DWORD
GraphCycleType, DWORD CycleID )
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Parameters
Parameters

Description

AP_BLOB* Blob

Pointer to the result variable of the "GenerateBLOB" function.

char* Name

Name of the event. This can be any ASCII string. The name is
shown as event name in the action window.

DWORD TriggerType

Type of cyclic trigger:
2 = time cycle (standard cycle)
4 = graphic object cycle

DWORD GraphCycleType

Type of graphic object cycle:
2 = window cycle
1 = picture cycle

DWORD CycleID

Trigger cycle:
0 = upon change
1 = 250 ms
2 = 500 ms
3=1s
4=2s
5=5s
6 = 10 s
7 = 1 min
8 = 5 min
9 = 10 min
10 = 1 h
11 = user cycle 1
12 = user cycle 2
13 = user cycle 3
14 = user cycle 4
15 = user cycle 5

Return value
Return value
BOOL
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Example
The time passing between two action triggerings is 1s.

BOOL FctRet;
..
FctRet = AddTimeTrigger(blob, "1 sec", 2, 0, 3);

AddVarTrigger /AddVarTriggerEx
Introduction
The function supplements the action with a trigger of the type "tag trigger".

Syntax
BOOL AddVarTrigger (AP_BLOB* Blob, char* EventName, char* VarName )
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BOOL AddVarTriggerEx (AP_BLOB* Blob, char* EventName, char* VarName, DWORD
CycleID )

Parameters
Parameters

Description

AP_BLOB* Blob

Pointer to the result variable of the "GenerateBLOB" function.

char* EventName

Name of the event. This can be any ASCII string. The name is
shown as event name in the action window.

char* VarName

Name of the WinCC tag initiating the triggering or participating in
it.

DWORD CycleID

Trigger cycle:
0 = upon change
1 = 250 ms
2 = 500 ms
3=1s
4=2s
5=5s
6 = 10 s
7 = 1 min
8 = 5 min
9 = 10 min
10 = 1 h
11 = user cycle 1
12 = user cycle 2
13 = user cycle 3
14 = user cycle 4
15 = user cycle 5
For the function AddVarTrigger the value CycleID = 4 ist
predefined.

Return value
Return value
BOOL
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Example
You have entered the tag 'StartTurbine1' as trigger in the trigger type "Tag". The action is
started as soon as the value of one of these tags changes.

BOOL FctRet
FctRet = AddVarTriggerEx(blob,"Turbine Start","StartTurbine1",0);

SetValidateFct
Introduction
The name of a check function is communicated to the Dynamic Wizard. The check function
allows ckecking the options and trigger parameters. In case of a negative test result a reentry
can be initiated.
The check function is called when the button "Continue" is clicked in the "Select options" or
"Set trigger" dialogs. In case of a positive test result the dialog is closed an the next page
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appears. In case of a negative test result the dialog remains active. A continuation is only
possible after entering the correct parameters.
The check function takes effect as soon as it is set in the Dynamic Wizard. It is also effective
for subsequent option pages. If no or another check function is to take effect, either a dummy
function (with positive test result) or another check function must be set.

Syntax
BOOL SetValidateFct (LPCSTR FctName)

Parameters
Parameters

Description

LPCSTR FctName

Name of the check function as ASCII string.

Return value
Return value
BOOL

Result of the test
TRUE = positive test result.
FALSE = negative test result.

Example
The following excerpt from the file "Instanzobjekt.wnf" shows the use of this function.
The wizard function has been expanded with a check function.
...
...
// Validation option 1
BOOL ValidateOpt1(void)
{
// Property selected
return (strcmp(g_NewInst, ""));
}
void OnOption1(void)
{
HWND hWnd;
RECT rect;
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DM_VARFILTERdmFilter = {DM_VARFILTER_TYPE, 1, NULL, NULL, NULL,
NULL };
SetValidateFct("ValidateOpt1");
sprintf(g_NewInst, "");
..
}

EnumProperty/EnumPropertyEx
Introduction
The EnumProperty function lists the object properties of an object. The EnumPropertyEx
function allows specifying the object properties to be listed.

Syntax
BOOL EnumProperty (char* FName, LPVOID pItem, DWORD dwFlags );
BOOL EnumPropertyEx (LPCTSTR Projectname, LPCTSTR Picturename, LPCTSTR
Objectname, char* FName, LPVOID pItem, DWORd dwFlags );

Parameters
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Parameters

Description

LPCTSTR Projectname

Pointer to the name of the project, including directory and file
extension.

LPCTSTR Picturename

Pointer to the name of the picture whose objects are to be listed.
Distinction is made between upper and lower case.

LPCTSTR object name

Pointer to the name of the object

char* FName

Name of your callback function called once for each object
property.

LPVOID pItem

Pointer to application-specific data passed on to the callback
function. This pointer is not evaluated by the function but made
available in the callback function again.

DWORD dwFlags

dwFlags specifies the property types to be listed. Presently the
following specifications are possible:
PropertyHasDynamic (Value: 0x0001)&#9;Only object properties
with dynamics are enumerated.
PropertyHasEvents (Value: 0x0002)&#9;Only object properties
with events are enumerated.
PropertyIsDynamicable (Value: 0x0003)&#9;Only object
properties that can be made dynamic are enumerated.
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Return value
Return value
BOOL

TRUE = Object properties of an object type listed
FALSE = Error

Example
The following excerpt from the file "Dynamic Property.wnf" shows the use of this function.
...
...
// Callback function
BOOL EnumFct(char *property, VARTYPE vt, LPVOID pItem)
{
sprintf(g_prop[SendMessage((HWND)pItem,LB_INSERTSTRING,(WPARAM)-1,
(LPARAM)property)],property);
return TRUE;
}
void OnOption1(void)
{
HWND hWnd,LBHwnd;
RECT rect;
static BOOL bFirst = TRUE;
if(bFirst)
{
...
}
...
CreateStatic(0, 10,"Properties of the current object :");
LBHwnd=CreateListbox(0, 30, g_Headline, 8, &g_indexProperty);
EnumProperty("EnumFct", LBHwnd, 3);
GetWindowRect(GetParent(LBHwnd), &rect);
...
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16.3.5.14 Wizard WinCC functions
GetProjectName
Introduction
The path of the current WinCC project is determined.

Syntax
LPCSTR GetProjectName ( void )

Return value
Return value
LPCSTR

Pointer to the ASCII string of the MCP file

Example
LPCSTR Name;
Name = GetProjectName();
The function provides e.g. the following result: C:\Siemens\WinCC\WinCCProjects
\Example.mcp

GetPictureName
Description
The name of the current picture (*.pdl) is determined.

Syntax
LPCSTR GetPictureName ( void )

Return value
Return value
LPCSTR
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Example
LPCSTR Name;
Name = GetPictureName();
The function provides e.g. the following result: TurbineControl.PDL

GetDefaultWNFPath
Description
The path of the current WNF directory is determined.

Syntax
LPCSTR GetDefaultWNFPath ( void )

Return value
Return value
LPCSTR

Pointer to the ASCII string of the path name

Example
LPCSTR Name;
Name = GetDefaultWNFPath();
The function provides e.g. the following result: C:\Siemens\WinCC\wscripts\wscripts.deu\

GetObjectName
Introduction
The name of the selected graphic object in the current picture is determined.

Syntax
LPCSTR GetObjectName ( void )
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Return value
Return value
LPCSTR

Pointer to the ASCII string of the object name

Example
LPCSTR Name;
Name = GetObjectName();
The function provides e.g. the following result: Button1

InsertXRefSection
Description
The function inserts into the transferred source code a section according to the Xref notation,
so that the transferred tags and picture names are entered as define.

Syntax
BOOL InsertXRefSection (char * SourceCode, char* TagName[], int TagCount, char*
PictName[], int PictCount)

Parameters
Parameters

Description

char *SourceCode

CodeBuffer in which to insert the Xref section

char *TagName[]

NULL or field of tag names inserted into the Xref section.

int TagCount

Number of tag names in the field DayName[]

char *PictName[]

NULL or field of picture names inserted into the Xref section

int PictCount

Number of picture names in the field PictName[]

Return value
Return value
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BOOL

The result value indicates whether the function has been
completed successfully.

char *TagName[]

Field of the defines for the tags passed at the same position

char *PictName[]

Field of the defines for the pictures passed at the same position
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Example
char* szPictureArray[1];
char szPictName[255];
char szSourceCode[1100];
strcpy(szPictName, "Newpdl.pdl");
szPictureArray[0] = szPictName;
strcpy(szSourceCode, "");
InsertXrefSection(szSourceCode,NULL,0,szPictureArray,1);
The function returns the following result:
szSourceCode:
// WINCC:TAGNAME_SECTION_START
// syntax: #define TagNameInAction "DMTagName"
// next TagID : 1
// WINCC:TAGNAME_SECTION_END
// WINCC:PICNAME_SECTION_START
// syntax: #define PicNameInAction "PictureName"
// next PicID : 1
#define PIC_0 " Newpdl.Pdl"
// WINCC:PICNAME_SECTION_END
szPictureArray[0]: "PIC_0"

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2423

SmartTools
16.3 Dynamic Wizard Editor

16.3.5.15 Wizard progress functions
Wizard progress functions
Introduction
The progess functions serve to show the progress (in %) of a procedure in a "progress box".

Upon creation of the progress bar (CreateProgressDlg) a start and end value and an increment
are specified. The start value corresponds to 0% progress and the end value to 100% progress.
The increment defines the progress change steps.
Typically, the start value is =0 and the increment =1. The end value corresponds to the number
of executed actions in the process.
During the procedure the progress is incremented (Progress_Steplt) or set to a defined value
(Progress_SetPos).
At the end of the procedure the progress display has to be removed again
(DestroyProgressDlg)
It is possible to display a text in the progress bar (Progress_SetStatus), such as "Creating
graphic objects". This can also be changed during processing to differentiate various partial
procedures.
In most cases it is not possible to divide the procedure in a way that allows a chronologically
linear progress display. However, this is not really necessary. Displaying the progress as such
is sufficient.

See also
DestroyProgressDlg (Page 2426)
Progress_SetPos (Page 2426)
Progress_Steplt (Page 2426)
Progress_SetStatus (Page 2425)
CreateProgressDlg (Page 2425)
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CreateProgressDlg
Introduction
A progress bar shows the progress of a processing procedure from 0 to 100%.

Syntax
PROGRESS_DLG CreateProgessDlg (int nLower, int nUpper, int nStepInc )

Parameters
Parameters

Description

int nLower

Progress start value (corresponds to 0 %)

int nUpper

Progress end value (corresponds to 100 %)

int nStepInc

Progress increment

Return value
°Return value
PROGRESS_DLG

Object handle

Progress_SetStatus
Description
A text is entered as header into the progress bar.

Syntax
void Progress_SetStatus (PROGRESS_DLG hDlg, char* ActionName )

Parameters
Parameters

Description

PROGRESS_DLG hDlg

Object handle

char* ActionName

Header text

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2425

SmartTools
16.3 Dynamic Wizard Editor

Progress_Steplt
Description
The progress of a processing procedure is incremented by one step.

Syntax
void Progress_Steplt (PROGRESS_DLG hDlg )

Parameters
Parameters

Description

PROGRESS_DLG hDlg

Object handle

Progress_SetPos
Description
In the progress bar the progress is set to a defined value. The value must lie between start
and end value.

Syntax
void Progress_SetPos (PROGRESS_DLG hDlg, int nPos )

Parameters
Parameters

Description

PROGRESS_DLG hDlg

Object handle

int nPos

Progress value

DestroyProgressDlg
Introduction
The progress bar will be closed.
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Syntax
void DestroyProgressDlg (PROGRESS_DLG hDlg )

Parameters
Parameters

Description

PROGRESS_DLG hDlg

Object handle

16.3.5.16 Wizard Windows functions
Wizard Windows functions
Introduction
The following is a short description of Windows functions which must or can be used in
connection with the Wizard system functions (especially with the window functions for
parameter input).
More detailed information may be found in the Programmer's Reference of Microsoft
Developers Studio /Win32 SDK.

See also
MessageBox (Page 2431)
ShowWindow (Page 2431)
GetWindow (Page 2430)
SendMessage (Page 2429)
MoveWindow (Page 2429)
GetWindowRect (Page 2428)
GetParent (Page 2427)

GetParent
Introduction
The handle of the parent window is determined for a window, e.g. the handle of the options
window.

Syntax
HWND GetParent (HWND hWnd )
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Parameters
Parameters

Description

HWND hWnd

Handle of the window for which to determine the parent window

Return value
Return value
HWND

Handle of the parent window
NULL = No parent window exists.

GetWindowRect
Introduction
Size and coordinates of a window are determined, e.g. the size of the options window.

Syntax
BOOL GetWindowRect (HWND hWnd, LPRECT lpRect )

Parameters
Parameters

Description

HWND hWnd

Window handle

LPRECT lpRect

Pointer to a structured result variable

Return value
Return value
BOOL

TRUE = Function completed successfully.
FALSE = Function not completed successfully.

LPRECT lpRect

Structured result variable of the LPRECT structure with the
structural components:
LONG left: X coordinate of the left upper corner
LONG top: Y coordinate of the left upper corner
LONG right: X coordinate of the right lower corner
LONG bottom: Y coordinate of the right lower corner:

See also
Adding the "Motor.wnf" script to the database (Page 2437)
CreateEdit (Page 2385)
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MoveWindow
Introduction
Position and dimension of a window are changed, e.g. the position and the size of the input
fields in the options window.

Syntax
BOOL MoveWindow (HWND hWnd, int x, int y, int nWidth, int nHeight, BOOL bRepaint )

Parameters
Parameters

Description

HWND hWnd

Window handle

int x

X coordinate of the left upper corner

int y,

Y coordinate of the left upper corner

int nWidth

Width

int nHeight

Height

BOOL bRepaint

TRUE = The window is redrawn.

Return value
Return value
BOOL

TRUE = Function completed successfully.
FALSE = Function not completed successfully.

See also
Creating the Dynamic Wizard function for the Motor (Page 2436)

SendMessage
Introduction
A message is sent to a window. The function is used for filling a selection field, for example.

Syntax
LRESULT SendMessage (HWND hWnd, UINT Msg, WPARAM wParam, LPARAM lParam )
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Parameters
Parameters

Description

HWND hWnd

Window handle

UINT Msg,

Message type:
LB_INSERTSTRING = Insert text in a ListBox

WPARAM wParam

1. message parameter:
-1 = The text is appended at the end.

LPARAM lParam

2. message parameter:
Pointer to the text

Return value
Return value
LRESULT

Object handle

GetWindow
Introduction
The handle of a window is determined which has a certain relation to another window (original
window).

Syntax
GetWindow (HWND hWnd, UINT uCmd )

Parameters
Parameters

Description

HWND hWnd

Handle of the original window

UINT uCmd

Relation
GW_HWNDFIRST = upper window

Return value
Return value
HWND
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ShowWindow
Introduction
The display type of a window is specified.

Syntax
ShowWindow (HWND hWnd, int nCmdShow )

Parameters
Parameters

Description

HWND hWnd

Window handle

int nCmdShow

Display status of the window
SW_HIDE = not visible

Return value
Return value
BOOL

TRUE = Window was visible
FALSE = Window was not visible

MessageBox
Introduction
The function serves to display a message for the user if an error has occurred or a user action
is required.
The message is displayed with a user specific text, title and button.
Note
"MB_SYSTEMMODAL" parameter
Execution of a message box function with parameter "MB_SYSTEMMODAL" ensures that
the message box is displayed in the foreground. If this parameter is not specified, the
message box is no longer visible to users (hidden in the background) and cannot be operated.
Mouse clicks outside the message box are saved to a buffer and processed after the message
box has been closed.
Example: MessageBox(NULL, "Welt", "Hallo", MB_SYSTEMMODAL | MB_OK);
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Syntax
int MessageBox (HWND hWnd, LPCTSTR lpText, LPCTSTR lpCaption, UINT uType )

Parameters
Parameters

Description

HWND hWnd

Handle of the parent window
NULL = Message has no parent window.

LPCTSTR lpText

Message text

LPCTSTR lpCaption

Title text

UINT uType

MB_SYSTEMMODAL = prevents the system from being blocked
as long as the MessageBox is opened.
Box type:
MB_OK = Message with an 'OK' button
MB_OKCANCEL = Message with the buttons 'OK' and 'Cancel'

Return value
Return value
int

ID of the button operated:
IDOK = 'OK' button operated
IDCANCEL = 'Cancel' button operated

Example

int RetMsg;
RetMsg = MessageBox (NULL, "Error calling the API functions", "System error", MB_OK);
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16.3.6

Examples

16.3.6.1

Examples

Introduction
In the context of this description two examples of Dynamic Wizard functions are given:
● Demo Wizard
● Dynamic motor

See also
Dynamic motor (Page 2436)
Demo Wizard (Page 2433)

16.3.6.2

Demo Wizard

Demo Wizard
Introduction
In the "Demo.wnf" file, a Dynamic Wizard called "Demo Wizard" is created. This Dynamic
Wizard shows the basic functions available to make the entry of data convenient for the user.
However, the Demo Wizard does not perform an action.

See also
How to Add the Script "Demo.wnf" to the Database (Page 2435)
How to Create the Help Text (Page 2434)
Creating the Dynamic Wizard function for the Demo Wizard (Page 2433)

Creating the Dynamic Wizard function for the Demo Wizard
Requirements
A WinCC project must be open.

Procedure
1. In the Windows Explorer copy the "Demo.wnf" file from the directory "Siemens\ WinCC\
documents\ german" to the directory "Siemens\ WinCC\ wscript\ wscript.deu".
2. Start the Dynamic Wizard Editor.
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3. In the File menu of the Dynamic Wizard Editor select "Open". The file selection dialog box
opens.
4. Mark the "Demo.wnf" file. Click "Open". The "Demo.wnf" file is shown in an editor window.
5. Click the icon
window.

in the toolbar to compile the script. The result is displayed in the output

See also
How to Add the Script "Demo.wnf" to the Database (Page 2435)

How to Create the Help Text
Introduction
In this section a help for the dialog "Select trigger" is created.

Procedure
1. Click the icon

in the toolbar. The help editor opens.

2. In the "Wizard - Group" field, select "Example".
3. In the "Wizard - Name" field, select "Demo Wizard".
4. In the "Page" field, select "TriggerPage".
5. In the "Help - Text" field, enter the following text: "Select trigger
In this dialog you can specify the result for which the action is to be executed."
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6. Close the help editor by clicking on the "OK" button.
7. Run the Demo Wizard. In the "Select trigger" dialog, click the "Help" button.

How to Add the Script "Demo.wnf" to the Database
Introduction
To be able to use the Dynamic Wizard function "Demo.wnf" in the Graphics Designer, it must
be integrated into the database of the Dynamic Wizard.
To do this, the following steps are necessary,
1. Importing the Wizard scripts
2. Creating the cwd file

Procedure
1. Click the icon

in the toolbar. The file selection dialog box opens.

2. Select the "Demo.wnf" file. Click "Open".
3. Click the icon
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4. In the "View" menu of the Dynamic Wizard Editor select "Dynamic Wizard".

5. Click on the "Example" tab. Double-click on the entry "Demo Wizard".

16.3.6.3

Dynamic motor

Dynamic motor
Introduction
In the "Motor.wnf" script file, a Dynamic Wizard called "Make Motor Dynamic" is created.
Note
This was created especially to make a user object called Motor dynamic and cannot be
applied to any other kind of object.

See also
How to Specify the Customized Object "Dynamic Motor" (Page 2438)
Adding the "Motor.wnf" script to the database (Page 2437)
Creating the Dynamic Wizard function for the Motor (Page 2436)

Creating the Dynamic Wizard function for the Motor
Requirements
A WinCC project must be open.
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Procedure
1. In Windows Explorer open the "Motor.zip" Winzip file in the directory "Siemens\ WinCC\
documents\ german".
2. Extract the "Motor.wnf" file into the directory "..\WinCC\wscripts\wscripts.deu".
3. Extract the "Motor_dyn.pdl" file into the directory "..\WinCC\WinCCProjects\Name of the
WinCCProject\GraCs".
4. Start the Dynamic Wizard Editor.
5. In the File menu of the Dynamic Wizard Editor select "Open". The file selection dialog box
opens.
6. Mark the "Motor.wnf" file. Click "Open". The "Motor.wnf" file is displayed in an editor window.
7. Click the icon
window.

in the toolbar to compile the script. The result is displayed in the output

See also
Adding the "Motor.wnf" script to the database (Page 2437)

Adding the "Motor.wnf" script to the database
Introduction
To be able to use the Dynamic Wizard function "Motor.wnf" in the Graphics Designer, it must
be integrated into the database of the Dynamic Wizard.
To do this, the following steps are necessary,
1. Importing the Wizard scripts
2. Creating the cwd file

Procedure
1. Click the icon

in the toolbar. The file selection dialog box opens.

2. Select the "Motor.wnf" file. Click "Open".
3. Click the icon

in the toolbar to newly create the database.

See also
How to Specify the Customized Object "Dynamic Motor" (Page 2438)
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How to Specify the Customized Object "Dynamic Motor"
Introduction
The Motor customized object is linked to a WinCC structure tag of the structure type
"MotorStruct" via the "Dynamic Motor" dynamic wizard. In this context, various C-actions and
tag connections are created on this object. This wizard cannot be used on other object types.

Requirement
● Create an internal tag "T08i_course_wiz_selected" of the data type "Text tag 8-bit character
set".
● Create a structure with the name "MotorStruct" and three internal elements called "Active",
"Hand" and "Error" of the data type BIT.
● Create an internal tag named "STR_Course_wiz1" of the data type "MotorStruct".

Procedure
1. Open the Graphics Designer. Select the "Open" item in the "File" menu. Select the
"Motor_dyn.pdl" picture in the file selection dialog.
2. Select the Motor customized object. The "Example" tab offers the "Dynamic Motor" wizard.

3. Start the Dynamic Wizard. Click on the "Continue" button in the "Welcome to the Dynamic
Wizard" dialog. The "Set options" dialog opens up.
4. Click on the Browse button in the "Set options" dialog. The tag selection dialog opens.
Select "STR_Course_wiz1" as the structure tag. Close the dialog by clicking on the "OK"
button.
5. Click on the Continue button in the "Set options" dialog. The "Finished!" dialog opens. Close
the dialog by clicking on the "OK" button.
6. Save the picture. Start the Graphics Designer Runtime.
7. The buttons can be used to simulate the tag values of the selected motor.
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See also
Creating the structure and the structure tag (Page 2439)

Creating the structure and the structure tag
Introduction
This section illustrates how to configure the "MotorStruc" structure and the "STR_Course_wiz1"
structure tag. The structure and the structure tag are used in the example "Dynamic motor".

Procedure
1. Select "New structure type" from the structure types context menu. The structure properties
dialog will be displayed.
2. Rename the structure into "MotorStruc". Click "New element" and create the internal tag
"Active" of the data type BIT.
3. Click "New element" and create the internal tag "Hand" of the data type BIT.
4. Click "New element" and create the internal tag "Error" of the data type BIT. Close the dialog
by clicking on the "OK" button.
5. In the navigation frame, click the plus sign in front of the icon for tag management. Select
"New tag" from the internal tags context menu. Create a WinCC tag "STR_Course_wiz1"
of the data type "MotorStruc".

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

2439

SmartTools
16.4 Documentation Viewer

16.4

Documentation Viewer

16.4.1

WinCC Documentation Viewer

Short description
Print jobs of the WinCC report system can be redirected to a file. In case of large amounts of
date one file is created for each report page.
The WinCC Documentation Viewer allows to display and print these files.

16.4.2

Installing WinCC Documentation Viewer
The WinCC Documentation Viewer can be installed in two different ways:

Procedure
1. During WinCC setup, select "WinCC V7 Typical" from the "Programs" dialog.
WinCC is installed with the SmartTools.
Start the WinCC Documentation Viewer by selecting "SIMATIC > WinCC > Tools".

Alternative procedure
You can also install the WinCC Documentation Viewer from the WinCC DVD.
1. Switch to the WinCC DVD directory "WinCC\InstData\Smarttools\Setup".
2. Double-click setup.exe.
3. Select the entry "WinCC Documentation Viewer" in the "Components" dialog.
4. Click "Next". Follow the on-screen instructions.

Note
If a WinCC project is activated, only the "emf" files of this project can be viewed and printed
out. If WinCC is not active, all "emf" files can be opened and printed out with the WinCC
Documentation Viewer.
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16.4.3

Description

Introduction
Print jobs can be redirected to a file. In case of large amounts of date one file is created for
each report page.
The WinCC Documentation Viewer allows to display and print these files.
Note
If a WinCC project is already activated when starting the WinCC Documentation Viewer, only
the "emf" files of this project can be viewed and printed out.
If WinCC has been opened but not activated when starting the Viewer, all "emf" files can be
opened and printed out with the Viewer.
Upon deactivating runtime, the Viewer is closed in any case.

The WinCC Documentation Viewer consists of three areas.
The top border of the screen contains the menu bar. The menu items are described in the
direct help.
The toolbar is directly under the menu bar. Frequently used functions, such as page up and
page down, are loaded as icons on this bar. The functions of the individual icons are described
in the direct help.
The window shows the current document. The display can be enlarged in two steps by clicking.
The screen is limited at the bottom by the status bar displaying information on the current
operation.
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16.4.4

Creating the .emf file(s)

Introduction
Print jobs can be redirected to a file. In case of large amounts of date one file is created for
each report page. The print output is routed to one or several .emf files. The files are stored
with the name Page <nnnnnn>.emf in the path, <nnnnn> representing a five-character
consecutive number.
The path name is composed as follows: from the project path (e.g. "C:\VFSWinCC\PRT\") and
<storage> + <YYYYMMDDHHMM> (YYYY = year, MM = month, DD = day, HH = hour, MM =
minute).
If you enter "PDdata" in the "Storage" field, the following path structure is created for the print
job within the project directory.

Procedure
1. Choose the "Project documentation setup" command from the File menu in the WinCC
editors.
2. Click on the "Printer setup" tab in the "Print job properties" dialog.
3. Activate the "File (*.emf)" check box on the "Printer setup" tab. If you do not wish a
simultaneous output to the printer, deactivate the "Printer" check box.
4. In the "Storage" field, enter the name of the path in which the file is to be stored. Close the
dialog by clicking on the "OK" button.
5. Select the "Print project documentation" item in the "File" menu. The print output is routed
to one or several .emf files. The files are stored with the name Page <nnnnnn>.emf in the
path, <nnnnn> representing a five-character consecutive number.
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16.5

WinCC CrossReferenceAssistant

16.5.1

WinCC CrossReferenceAssistant

Short description
WinCC CrossReferenceAssistant is a tool which searches scripts for picture names and tags
and supplements the scripts so that the WinCC component Cross Reference finds the picture
names and tags and lists them in the cross reference list.

16.5.2

Installation of the CrossReferenceAssistant
The WinCC CrossReferenceAssistant has a German, English and French user interface.

Procedure
1. During WinCC setup, select "WinCC V7 Typical" from the "Programs" dialog.
WinCC is installed with the SmartTools.
Start the WinCC CrossReferenceAssistant by selecting "SIMATIC > WinCC > Tools".

Alternative procedure
It is also possible to install the WinCC CrossReferenceAssistant from the WinCC DVD.
1. Switch to the WinCC DVD directory "WinCC\InstData\Smarttools\Setup".
2. Double-click setup.exe.
3. Select the "CrossReferenceAssistant" entry in the "Components" dialog.
4. Click "Next". Follow the on-screen instructions.

16.5.3

General
WinCC is able to create CrossReference lists. To ensure the tags in the function calls are
recognized properly when creating these lists, WinCC was extended by a configuration rule
which provides the following:
To be able to search and replace the tag and picture names ued in the C actions, the script
must be written as follows:
At the start of the script, all tags and picture names must be declared in two sections. Within
the sections no further instructions must be entered.
The sections are structured as follows:
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// WINCC:TAGNAME_SECTION_START
// syntax: #define TagNameInAction DMTagName
// next TagID : 1
#define ApcVarName1 "VarName1"
// WINCC:TAGNAME_SECTION_END
// WINCC:PICNAME_SECTION_START
// syntax: #define PicNameInAction PictureName
// next PicID : 1
#define ApcPictureName1 "PictureName1"
#define ApcPictureName2 "PictureName2"
#define ApcPictureName3 "PictureName3"
// WINCC:PICNAME_SECTION_END
Calling the standard functions for the reading or writing of the tags must then be done through
the defined tags and pictures.
GetTagDWord (ApcVarName1);
OpenPicture(ApcBildname1);
SetPictureName( ApcPictureName2, "PictureWindow1",ApcPictureName3);
If the configuration rule is not followed, no CrossReference lists can be created because the
tag and picture references in the scripts cannot be resolved.
With the aid of the WinCC CrossReferenceAssistant all function calls known in the Script
Managment are replaced by the format described above. Only project functions, pictures and
actions are converted.
The Runtime environment for the WinCC CrossReferenceAssistant is WinCC. If WinCC is not
running or the project to be converted is not loaded, WinCC is started by the WinCC
CrossReferenceAssistant or the project is loaded.

See also
Known functions (script management) (Page 2444)

16.5.4

Known functions (script management)
The following functions are known to the Wizard by default and are implemented during
conversion:

Functions with tags as parameters:
GetTagBit()
GetTagByte()
GetTagChar()
GetTagDouble()
GetTagDWord()
GetTagFloat()
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GetTagRaw()
GetTagSByte()
GetTagSDWord()
GetTagSWord()
GetTagWord()
SetTagBit()
SetTagByte()
SetTagChar()
SetTagDouble()
SetTagDWord()
SetTagFloat()
SetTagRaw()
SetTagSByte()
SetTagSDWord()
SetTagSWord()
SetTagWord()
GetTagBitWait()
GetTagByteWait()
GetTagCharWait()
GetTagDoubleWait()
GetTagDWordWait()
GetTagFloatWait()
GetTagRawWait()
GetTagSByteWait()
GetTagSDWordWait()
GetTagSWordWait()
GetTagWordWait()
SetTagBitWait()
SetTagByteWait()
SetTagCharWait()
SetTagDoubleWait()
SetTagDWordWait()
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SetTagFloatWait()
SetTagRawWait()
SetTagSByteWait()
SetTagSDWordWait()
SetTagSWordWait()
SetTagWordWait()
GetTagBitState()
GetTagByteState()
GetTagCharState()
GetTagDoubleState()
GetTagDWordState()
GetTagFloatState()
GetTagRawState()
GetTagSByteState()
GetTagSDWordState()
GetTagSWordState()
GetTagWordState()
SetTagBitState()
SetTagByteState()
SetTagCharState()
SetTagDoubleState()
SetTagDWordState()
SetTagFloatState()
SetTagRawState()
SetTagSByteState()
SetTagSDWordState()
SetTagSWordState()
SetTagWordState()
GetTagBitStateWait()
GetTagByteStateWait()
GetTagCharStateWait()
GetTagDoubleStateWait()
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GetTagDWordStateWait()
GetTagFloatStateWait()
GetTagRawStateWait()
GetTagSByteStateWait()
GetTagSDWordStateWait()
GetTagSWordStateWait()
GetTagWordStateWait()
SetTagBitStateWait()
SetTagByteStateWait()
SetTagCharStateWait()
SetTagDoubleStateWait()
SetTagDWordStateWait()
SetTagFloatStateWait()
SetTagRawStateWait()
SetTagSByteStateWait()
SetTagSDWordStateWait()
SetTagSWordStateWait()
SetTagWordStateWait()

Functions with picture names as parameters:
SetPictureName()
GetPictureName()
GetVisible()
SetVisible()
GetLink()
SetLink()
Set_Focus()
OpenPicture()
GetLinkedVariable()
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16.5.5

Project selection

Clicking "..." opens the OpenFile dialog box which enables you to select any project. When
clicking "Current project, the WinCC CrossReferenceAssistant tries to import and display the
project currently loaded in WinCC. If WinCC is not running or no project is loaded, it is started
or the required project is loaded.
If a different project has been loaded but is not activated, the project is closed and the required
project is opened. This process may take some time.
As soon as text is entered in the input line at the "Select a WinCC project" prompt, you can
click the button "Next >". Then the specified project is checked to see whether it is a valid
WinCC project. If the project is not valid, the focus is set on the input line and a message
window opens with an explanation of the corresponding error.
"Clicking Cancel exits the WinCC CrossReferenceAssistant.
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16.5.6

File selection
All pictures, project functions and C actions belonging to the project are displayed in the right
list of the dialog box. In the default setting, all files belonging to the project are converted.

The user can decide to exclude certain files from the conversion to possibly add them later.
Deleting files from the conversion list is done by (multiple) selection of the corresponding files
in the "Files to be converted" list and clicking the"<--Remove" button.
Deleted files are displayed in the left list and can be added to the conversion again. To do so,
these files must be selected in the "Select files" list. By clicking "Add-->" they are then added
to the right list "Files to be converted".
After selecting the files, click "Next >". The specified files are then read and analyzed.
„Clicking "< Previous" takes you back to the project selection. Clicking "Cancel" exits the
WinCC CrossReferenceAssistant.

See also
Project selection (Page 2448)
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16.5.7

Conversion

Introduction
The last page of the Wizards one the one hand enables you to make "Advanced Settings" (see
Advanced Settings), and on the other hand to view the progress and the file currently being
processed after starting the conversion.

Description

Clicking "< Back" takes you back to the File Selection. Clicking "Cancel" exits the WinCC
CrossReferenceAssistant.
To start script conversion, click "Finish". After conversion begins, you cannot go back ("<
Back"), or click "Advanced Settings".
During conversion, a progress bar displays what percentage of the conversion has been
completed. You can also see which file is being currently converted.
The conversion is performed as follows: The scripts are examined for function calls which
expect picture or tag parameters. If such a function is found in the script, the character string
passed on as parameter is replaced by a define (see configuration rules).
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A script management file checks which functions expect picture or tag parameters. This is why
all of these functions must be entered in this file and thereby introduced to the system. The
script conversion can also be used to extend the list of these functions with project functions
and standard functions which also expect picture and tag parameters (advanced settings).
When the conversion is finished, a summary is displayed which provides information about
how many functions, pictures and scripts in the pictures and how many tags have been
converted.
If an error occurs, you can find more detailed information about the error cause by viewing the
log file created during conversion. This file is located in the project directory and is called
CCCrossReferenceAssistant.log.

See also
Expanded settings (Page 2451)
General (Page 2443)
File selection (Page 2449)

16.5.8

Expanded settings
If required you can activate functions you created yourself.
In the "Select a function with tag and picture parameters:" list, all project functions are
displayed. If the "Display standard functions check box is activated, the default functions in
WinCC are also displayed.

The user can select a function from the function list which expects a tag or a picture as
parameter at a certain position. All functions selected here are included in a project-specific
script management file.
WinCC: Working with WinCC
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The CrossReferenceAssistant only recognizes those functions as functions with picture and
tag parameters which have been introduced to the system as such. To make sure calls of
customized functions expecting tag parameters can be adapted in accordance with the
configuration rules, these must be included in the script management in the course of the
conversion.
The "Functions of the script management" dialog box displays all functions already added to
the script managment. When this dialog is displayed, the standard and project configuration
files are read out and the common contents of both files are displayed.
To name a function expecting a tag or picture parameter, you must first select it from the "Select
a function with tag or picture parameters:" combination field.
Using the parameter list you can then define whether the special parameter represents a tag
or a picture. When clicking "..." a popup menu opens which lets the user choose whether the
selected parameter is a tag or a picture.
This process must be repeated for all parameters to which one of the criteria applies.
"Add function -->" confirms the input and adds the selected function to the list on the right side
of the dialog box. If you make a mistake, you can undo it by selecting the functions to be deleted
in the "Functions of the script management" list and then removing them from the list by clicking
"<-- Remove selected functions".
When clicking "Close" the group information is written to the configuration files, the modified
information is taken into account during conversion and the dialog is closed.

See also
General (Page 2443)
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Attribute
Customized objects, 664
Button, 627
Group
Create, 654
Hide manually, 1138
I/O field
Configuring, 563, 564, 566, 567, 569, 570
Tag connections, 563
Runtime documentation
CSV files, 2078
Smart object
Application window, 550

"
"Menus and toolbars" editor, 690
Configuring menus and toolbars, 697
Creating menus, 693
Creating toolbars, 695
Operator controls, 698
Specifying fonts, 700

.
.emf, 2442
.emf file, 2442
.NET Control, (See Control)
.NET Framework, 423, 424

A
Access right, (See Authorization)
Acknowledgment, 1130
Central signaling device, 1114
Configuring, 1114
Acknowledgment bit, 1121, 1129, 1130, 1143, 1144,
1147
Acknowledgment philosophy, 1084, 1114

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Acknowledgment Status
System block, 1102
Acknowledgment tag, 1084, 1121, 1130, 1141, 1143,
1147
Acquisition cycle, 1304
Configuring time series, 1347
Configuring timers, 1346
Continuous cyclic archives, 1325
Cycles, 1324
Cyclic selective archives, 1326
Events, 1324
ActiveX control
Registration, 380
ActiveX Control, 368, 546, 1371
Configuring control selection, 266, 377
Inserting, 370
Languages, 2172
Select, 261
Settings in the Graphics Designer, 309
Third-party ActiveX Control, 370
Address
Tag, 209
Alarm Control, 1201, 1257, 1271
Column properties, 1271
Configuration of message tags, 1262
Configuring in the Graphics Designer, 1264
Configuring message blocks, 1264
Configuring the message line, 1264
Configuring the parameters, 1264
Configuring the toolbar, 1264
Emergency Acknowledgment of Messages, 1289
Example of configuration, 1258
Format, 1271
Hit list, 1271, 1293
integer, 1271
Locking messages, 1283
Message blocks, 1259
Operation in Runtime, 1278
Parameters of message window, 1264
Selection of messages, 1281
Toolbar, 1264, 1278
Alarm log
Output, 1857
Reporting, 1856
Alarm Logging, 1091
Acknowledging messages, 1114
Archive backups, 1190
Archive reports, 1904, 2032, 2034, 2036, 2041
Archives, 1189
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Configuring messages, 1090
Configuring status texts, 1116
Editing messages, 1126
Exporting messages, 1139
Filter criteria for alarm output, 1889, 2080
Hide messages, 1135
Importing messages, 1140
Loop In Alarm, 1134
Message blocks, 1101
Message classes, 1107
Message groups, 1141, 1148
Message reports, 1904, 2032, 2034, 2036, 2041
Message sequence reports, 2094, 2096
Message system, 1101
Message texts, 1131, 1133
Message type, 1111
Messages, 1120, 1121
Monitoring limits, 1167
Multilingual projects, 2114, 2168, 2187
Project documentation, 1815, 1827, 2050
Reloading messages after power failure, 1194
Structure of editor, 1091
System blocks, 1102
System message class, 1110
System messages, 1152, 1155
Tag, 1128, 1129, 1130
Alarm message, 1084
Alarm window, 1257
Configuring, 1192
output of archive data, 1192
AlarmControl, 368, 1192, 1201
Buttons, 1229
Configuring, 1202
Configuring a hit list, 1216
Configuring operator messages, 1219
Configuring table elements, 1209, 1210, 1211,
1212, 1380, 1381, 1382, 1383, 1726, 1727, 1729
Display of messages in Runtime, 1201
Dynamization, 1228
Example of configuration, 1244, 1245, 1247,
1248, 1254, 1255
Message blocks, 1203, 1205
Message lists, 1856, 1857
Messages, 1205, 1234, 1236, 1239, 1240
Messages , 1243
Online configuration, 1224, 1229, 1395, 1439,
1493, 1735
Operation, 1228, 1229
Runtime data, 1222, 1393, 1437, 1491, 1734
SQL statements, 1226
Status bar, 1213, 1233, 1384, 1430, 1484, 1730
Symbols, 1233
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Toolbar, 1213, 1228, 1229, 1384, 1430, 1484,
1730
Alias
Column, 1628
ID, 1644
User archive, 1624
User archive field, 1626
View, 1628
Alignment
Message block, 1105
Alpha cursor, 157, 706, 707
Amplitude, 2361
Analog alarm, 1084, 1167
Creating multiple, 1168
Examples, 1172
Hysteresis, 1172
Messages, 1171
New, 1168
Properties, 1169
Removing, 1172
Specifying a message number, 1167
analog archive tag, 1318
Analog display
Extended, 620
Application window, 546
Create, 507, 550
Applying tag properties, 1548
PCS 7, 1548
Archive, 1084, 1348
Archive databases, 1334, 1616
Archive system, 1304
Archiving methods, 1323, 1325, 1326, 1327,
1328
Backups, (See Archive backup)
create, 1634
Cyclic archive, 1334
Data buffer, 1334, 1349
Disconnect, 1190
Flags, 1337
Link, 1189
Properties, 1635
Archive backup, 1335
Configuring, 1363
Disconnect, 1368
Link, 1366
Server, (See Long-term archive server)
Sign file, 1363
Archive configuration, 1183
Calculating memory requirements, 1358
Archive Contents, 1361
Archive data, 1651
Archive database, 1616
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Archive server, 1198
Archive tag, 1309, 1351
binary, 1352
Compress, 1332, 1355
Configuring, 1352, 1353
Configuring cycle time, 1346
Configuring time series, 1347
Properties, 1353
Archive tag name, 1321
Archive tags, 1515, 1585
Properties, 1318
Archives
Properties, 1359
Archiving
Memory requirement, 1358
System block, 1102
Archiving cycle, 1304
Configuring time series, 1347
Configuring timers, 1346
Continuous cyclic archives, 1325
Cycles, 1324
Cyclic selective archives, 1326
Events, 1324
Area
Navigation, 1632
Properties, 1632
Table, 1632
AS messages, 1175
AS number, 1124
Associated value data
Extended, 1123
Attribute, 470, 479, 1947
"Object Properties" window, 472, 1950
C actions, (See C action)
Changing, 476, 1953
Customized objects, 660, 666
Dynamic dialog, (See Dynamic dialog)
Dynamic Wizard, (See Dynamic Wizard)
Dynamizing, 454
Property groups, (See Property group)
Tag connections, (See Tag connection)
VBS actions, (See VBS action)
Authorization, 2248
Configure, 2231, 2232
Default authorizations, 2234
Overview, 2234, 2236, 2237, 2238
System authorizations, 2236, 2238
User archive field, 1627
User archives, 1641
Authorizations and flags
User archive, 1624
Autostart, 36, 170, 173
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Average, 1527, 1563
Axes, 1530, 1532, 1534
Display of Staggered Trends, 1574
Display with common axes, 1570
Display with Different Axes, 1570
Display with logarithmic axes, 1572
Representation of Staggered Trends, 1534
Representation Using Common Axes, 1532
Representation Using Different Axes, 1532

B
backup, 1649
Archive backups, 1187, 1190
Archives, 1189, (See Archive backup)
Segment change, 1187
Bar, 546
3D bar, 546, 607
Changing, 572
Configuration dialog, 647
Configuring, 574, 575, 577
Inserting, 572
Basic Process Control, 83
Authorizations, 2237
binary archive tag, 1318
Button, 625
AlarmControl, 1229
Configuration dialog, 647
Configuring, 629
Configuring a hotkey, 630
FunctionTrendControl, 1496
OnlineTableControl, 1398
OnlineTrendControl, 1442
Selecting pictures, 650
UserArchiveControl, 1738
Button function, (See Button)

C
C action, 1009, 1073, 1074
Configuring, 459
Create, 1075
Creation in the Dynamic Dialog, 1042
Dynamic Wizard, (See Dynamic Wizard)
Editor, 1074, 1075, 1077, 1081
Transferring actions, 1081
Triggers, 1079
Calculating memory requirements, 1183, 1358
Calculating statistics, 1527, 1563
Central color palette, (See Color palette)
Central signaling device, 1114
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Changing archive values, 1391, 1404
Changing language
By means of system dialog, 2200
Channel unit, 216
Connection parameters, 238
Create, 234
System parameters, 236
Check box, 625, 631
Chip cards, 2250
Chronological messaging, 1084
Class priority
System block, 1102
Client
Runtime documentation, 1846
Client project, (See Project)
Clock control
Time base, 101
Clock Control, 368, 393
Inserting, 393
Settings, 394, 395, 396, 397
Color
Message type, 1118
Color conversion when printing messages, 1856
Color palette, 289, 1911
Central color palette, 300, 302, 304
Custom colors, 1914
Column
Position, 1647
Column of a view
Properties, 1628
COM server
COM server objects, 1905, 2102, 2103
Examples, 2104
Interface for reporting, 2105
Runtime documentation, 1882
Combo box, 546, 598
Comment
System block, 1102
Communication
User archive, 1624
Communication driver, 216
Create, 234
Communication type
User archive, 1624
Comparison, 1170
Comparison tag, 1169
Comparison value, 1167, 1169
Compilation
Display log, 2317
Revisions, 2313
Component list editor
Project documentation, 1838
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Compressed archive, 1306, 1332, 1348
Backups, 1363
Configuring, 1350, 1355, 1361
Data buffer, 1334, 1349
Manual input, 1350
Project documentation, 2062, 2065
Properties, 1317
Compressed tag, 1357
Compressed tags
Properties, 1322
Compression, 1329
Compression properties, 1318
Compression time period, 1318
Computer
Start configuration, 2190
Computer name
System block, 1102
Computer properties
Configuring, 88
Cursor Control, 162
Hotkeys, 157
Parameters, 149
Renaming, 146
Runtime, 137
Runtime settings, 145, 166
Start picture, 160
Startup list, 139, 148
Time settings, 100
Zoom functions, 164
Computer settings; System dialogs, 152
Configuration dialog, 647
Customized objects, 660
Option "Use configuration dialog", 309
Configuration file, 690, 693, 695, 697
Configuration station
Load online changes, 108, 110, 112
Configuration Tool
Load online changes, 112
Configuration: of User Archives Table Element, 1747
Configure
Authorizations, 2232
configuring
of a Form View, 1762
of a User Archives Control, 1747, 1748, 1749
of User Archives Table Element, 1748, 1749
Configuring OS reference, 2281, 2290
Connection
Creating, 235
Project documentation, 2072
Status in Runtime, 233
Connection parameters, 238
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Control
.NET controls, 368, 371, 423, 546, 604
ActiveX controls, (See ActiveX Control)
AlarmControl, 1201, (See AlarmControl)
Changing properties, 382
Configuring control selection, 266, 377
Digital/Analog Clock Control, (See Clock Control)
FunctionTrendControl, (See
FunctionTrendControl)
Gauge Control, (See Gauge Control)
Inserting, 373, 556
Media Control, (See Media Control)
OnlineTableControl, (See OnlineTableControl)
OnlineTrendControl, (See OnlineTrendControl)
Positioning, 376
Push Button Control, (See Push Button Control)
Rectangle surrounding the object, 374, 376
RulerControl, (See RulerControl)
Scaling, 374
Slider Control, (See Slider Control)
Symbol Library, (See Symbol Library)
Time settings, 101
UserArchiveControl, (See UserArchiveControl)
WPF controls, 368, 371, 424, 546, 605
Control tag, 1636
Example, 1637
User archive, 1624
Controls
WinCC Alarm Control, 1257
WinCC Online Trend Control, 1508
Coordinate system, 277, 279, 1935
Copy
Cross Reference, 1789
Message, 1125
Message class, 1108
Message type, 1113
CPU number, 1121
Creating archive values, 1391, 1404
Cross reference, 2443
Cross Reference, 1781
Copy, 1789
Example, 1791, 1795
Export, 1789
Filter, 1785
Linking, 1787
Place of use, 1786
Project documentation, 1833
Replace, 1787
Tags, 1798
CSV file
Runtime documentation, 1867, 1868, 1871, 2043,
2078
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CSV files
Runtime documentation, 2045
CSV provider, 1904
Cursor
Cursor control, 162
Curve parameter, 1548
Customized object, 653, 657
Attributes, 664, 666
Configuring, 660
Connect with Structure tags, 667
Creating, 659
Edit, 670
Events, 668, 669
Example, 672
Properties, 660, 662
Ungroup, 671
Cycle, 319, 321
Cycle time, 320, 1345
Properties, 1314

D
Data
Backup, 1649
View, 1648
Data compression, 1329
Data format
Differences to S5/S7, 1657
Data records
Exporting data records, 74, 2161, 2229
Import, 74, 254, 2161, 2229
Data source, 230, 2331, 2339
Data type, 209, 216
Binary tag, 217
Bit, 217
Byte, 219
Char, 218
Date/time, 229
Double, 225
Dword, 223
float, 224
Floating-point number 32-bit, 224
Floating-point number 64-bit, 225
Format adaptations, 218, 219, 220, 221, 222, 223,
224, 225, 229
Internal tag, 206
Long, 222
Process tag, 207
Raw data tag, 227
Short, 220
Signed 16-bit value, 220
Signed 32-bit value, 222
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Signed 8-bit value, 218
Signed byte, 218
signed Dword, 222
Signed word, 220
Text reference, 228
Text tag, 227
Unsigned 16-bit value, 221
Unsigned 32-bit value, 223
Unsigned 8-bit value, 219
Unsigned byte, 219
Unsigned Dword, 223
Unsigned word, 221
Word, 221
Data window, 258, 269
Display Column Information, 261
Tag Logging, 1339
WinCC Explorer, 49
Data Window
WinCC Explorer, 41
Database segment, 1181
DataSet, 546
Date, 97, 2187
System block, 1102
Date/time
Data type, 229
Daylight saving time
System block, 1102
Debugger, 166
Decrement, 2359, 2361
Default cycle, 458, 463
Default trigger, (See Triggers)
Delay time, 1169
Delete
Analog alarm, 1172
Message, 1127
Message class, 1110
Message group, 1152
Message type, 1119
Delta loading, (See Load online changes)
Diagnosis, 2344, 2351
Diagnostic support, 2344, 2348, 2351
Diagnostics, 2344, 2348
Diagnostics window, 189
Load online changes, 115
Direct connection, 1009, 1036
Configuring, 468, 1038
Copying objects, 1036
Examples, 1036, 1039
Discrete alarm method, 1084
Display in front, 1524
Display in trend form, 1530
Display of archived values, 1526, 1530
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Display of messages, 1264
Colors, 1118
Message blocks, 1264
Selection of messages, 1281
Displaying
Tag value, 253
DLL parameters, 1121
Duplicating projects, 180
Duration
System block, 1102
Dynamic dialog, 1009, 1042
Configuring, 457, 1043, 1045, 1049, 1053, 1054,
1056
Creating C actions, 1042
Example, 1058
Expressions, 1045
Quality codes, 1054
Tag status, 1053
Triggers, 1056
Value ranges, 1049
Dynamic display, 1511
Dynamic metafile
Project documentation, 2075
Dynamic object, 1900, 1902, 1966, 1995
Embedded layout, 1902, 1995
Hard copy, 1902, 1998
ODBC database field, 1902, 2000
ODBC database table, 1902, 2002
Tag, 1902, 2006
Dynamic table
Project documentation, 2076
Dynamic text
Project documentation, 2074
Dynamic Wizard, 296, 1017
Import functions, 1023
Picture components, 1022
Picture Functions, 1018
SFC, 1031
Standard Dynamics, 1023, 1027
System functions, 1030
Dynamic Wizard Editor, 2345, 2364
Editor window, 2369
Help Editor, 2370
Installation, 2366
Output window, 2371
Structure, 2367
Toolbar, 2368
Dynamic Wizard function, 2372
Dynamization, 454
Action icons, 456
C actions, (See C action)
Configuring Events, 456
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Creating dynamic attributes, 457, 459, 461, 463
Direct connections, (See Direct connection)
Displaying statistics, 273
Dynamic dialog, (See Dynamic dialog)
Dynamic Wizard, 296
Dynamization icons, 454
Dynamization of events, 459, 461, 468
Dynamization of faceplate types, 361
Log parameters, 1848, 1851
Making Attributes Dynamic, 454
Picture window, 552
Tag connections, 563, 649, (See Tag connection),
(See Tag connection)
Triggers, (See Triggers)
VBS actions, (See VBS action)

E
Edit
Archive data, 1651
Selecting a process value block, 1132
Editing, 1525
Editor, 2294
Changing language settings, 2294
Illegal characters, 191
Opening, 2294
Overview of editors, 185
Emergency acknowledgment, 1239, 1289
Empty text
Property, 1131
Engineering station
Activating runtime, 85
Entry jump, 2344, 2351
Event, 456
"Object Properties" window, 474
Action icons, 456
C actions, (See C action)
Customized objects, 668, 669
Direct connections, (See Direct connection)
Specifying faceplate types, 356, 357
Triggers, (See Triggers)
VBS actions, (See VBS action)
Event nodes, 356, 357
Example
Analog alarm, 1172
COM server, 2104
Configuring AlarmControl, 1244, 1245, 1247,
1248, 1254, 1255
Configuring OnlineTrendControl, 1455, 1456,
1458, 1461, 1463
Creating electronic signatures, 2256, 2258
Customized objects, 672
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Direct connections, 1036, 1039
Dynamization with the Dynamic dialog, 1058
Filter in Cross Reference, 1791
Linking, 1795
Multilingual projects, 2193, 2194, 2196, 2200
Place of use, 1791
Tag connections, 1034
User archive functions, 1667
Using control tags, 1637
existing tag, 1781
Explorer, (See WinCC Explorer)
Export, 330
Central color palette, 304
Cross Reference, 1781, 1789
Entire configuration, 254, 1139
Export user archive data, 1651
Messages, 1139
Runtime data, 1222, 1393, 1437, 1491, 1734
Tag, 254
User archive data, 1649
Extended analog display, 620
Extended associated value data, 1123
Extended status display, 614

F
Faceplate instance, 344, 546, 603
Update, 362, 365
Use, 362
Faceplate tag
Defining, 359
Dynamization of faceplate types, 361
Edit, 360
Faceplate type, 344
Change, 362, 365
Configuring, 348
Copying, 344
Create, 347
Creating, 346
Dynamization, 361
Events, 344, 356, 357
Faceplate tags, 359, 360
Inserting objects, 348
Name, 344
Password protection, 366
Properties, 344, 349, 352, 354
Settings in the Graphics Designer, 309
Falling edge, 1121
Favorites; pictures, 151
Field
Position, 1644
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Fields
Creating, 1642
Properties, 1626
Figure
Displaying user ID, 2253
File selection, 2449
Filter, 1781, 1785, 1791, 2332, 2340
Filter criteria, 1759
FindFast.exe, 143
Flashing
Message block, 1105
Font
Multilingual projects, 2121, 2123
Form field
Button, 1766
Deleting, 1767
Edit, 1767
Editing Box, 1765
Text field, 1764
Form Field:Delete, 1767
Form Field:Edit, 1767
Form view, 1746, 1747, 1762, 1768
Defining, 1753
Form View:Define, 1753
Format
Message block, 1105
Format adaptation, 209
Format DLL, 1124, 1309, 1321, 1328, 1353
Format Function of the Analog Display, 624
Format specification, 1131
Formatting
Process value block, 1132
Forms of Display, 1567
Frame, 1084, 1310
Frame tag, 1309
Frequency, 1271
Function
User archive functions, 1664, 1667, 1676, 1687,
1693
Function block, 1657
Function test, 2358
Function Trend Control, 1565
Archive tags, 1585
Changing configuration, 1595
Common axes, 1570
Data from user archives, 1586
Determining coordinates, 1600
Dynamic display, 1578
Enlarging area, 1602
Forms of Display, 1567
Function of time, 1590
Ideal trend, 1581
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Ideal Trend, 1588
Inserting, 1584
Linear interpolation, 1567
Logarithmic scaling, 1572
Online tags, 1584
Operation in runtime, 1594
Properties, 1613
quick configuration, 1610
Resolution, 1565
Single values, 1567
Staggered trends, 1574
Starting update, 1597
Static display, 1578
Stepped trend, 1567
Stopping update, 1597
Time range, 1578
Trend on top, 1598
Values of uncertain status, 1579
Values outside the limit range, 1579
write direction, 1576
Functions, 2444
FunctionTrendControl, 368, 1465
Axes, 1473
Buttons, 1496
Configuring, 1426, 1468, 1469, 1470, 1473, 1475,
1477, 1480
Configuring RulerControl, 1387, 1433, 1487
Data connections, 1480
Online configuration, 1224, 1395, 1439, 1447,
1448, 1493, 1496, 1499, 1500, 1501, 1503, 1735
Output of process values, 1862
Representation formats, 1466, 1468
Runtime data, 1222, 1393, 1437, 1491, 1734
Screen resolution, 1465
Status bar, 1213, 1384, 1430, 1484, 1496, 1730
Toolbar, 1213, 1384, 1430, 1484, 1495, 1496,
1730
Trends, 1426, 1470, 1475, 1477
Zoom functions, 1503

G
Gauge Control, 368, 399
Inserting, 399
Settings, 400, 402, 404, 405, 406, 408
Gear ratio, 2307
Entire OS, 2308
Global design
Configuring, 127, 130, 135
Design Features, 126
Limit, 166
Global Design, 125

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Index

Global library, (See Library)
Global Script, 1062
Project documentation, 1815, 1829
Global Scripts
Inserting an application window, 550
Graphic
Linked with message, 1134
Graphic object, 546
Changing, 579
Configuration dialog, 647
Inserting, 579
Selecting pictures, 650
Graphic OLL
Select, 261
GraphicOLL
Select, 264
Graphics Designer, 257, 259, 277
Action editor, 1063
Adapting the working environment, 321
Alignment palette, 286
Central color palette, (See Color palette)
Color palette, (See Color palette)
Configuring a message window, 1202
Configuring AlarmControl, 1202
Coordinate systems, 277, 279
Dynamic Wizard, 296
Font palette, 290
Languages, 2171, 2172
Layer palette, 287
Multilingual projects, 2114, 2130, 2132, 2133,
2171, 2172, 2174, 2175, 2187
Objects, (See Object)
Open, 258, 261
Options, 309
Palettes, (See Palette)
Picture types, 259
Pop-up menu, 271, 273
Project documentation, 1815, 1824, 2055, 2057,
2059, 2061
Runtime, 170
Selecting ActiveX controls, 261
Selecting Graphic OLL, 261
Settings, 307, 309, 313, 314, 317, 319
Shortcut menu, 261, 269
Standard and controls, 295, 298
Start screen, 283
Status bar, 293
Style palette, 299
Tag palette, 299
Toolbars, (See Toolbar)
Zoom palette, 294
Group, 653
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Administrating, (See User Administrator)
Changing properties, 655
DefaultGroup, 2261
Ungrouping Groups, 657
Group acknowledgment, 1084
Group Display, 546
Configuring, 609
Inserting, 609
Group value, 614, 620

H
Hard copy
Output, 1874, 1875, 1877
Hardware diagnostics, 2344, 2351
Configuring, 2351
Entry jump, 2351
Hide
automatic, 1122
Manual, 1135
Hide manually
Messages, 1135
Hide mask, 1121, 1135, 1148
Hide system pictures, 84
Hide tag, 1135, 1141, 1148, 1243
Hit list, 1084, 1201, 1257, 1271
Configure, 1216
HitlistRelTimeFactorType, 768
Horn, 1121
Project documentation, 1815, 1834
Hotkey, 142, 157, 162
Event-driven triggers, 1016
Hard copy, 1875
Hotkeys, 630
Hysteresis, 1169

I
I/O field, 546
Changing, 561
Configuration dialog, 647
Inserting, 561
Ideal trend, 1581
Ideal Trend, 1588
Import
Central color palette, 304
Import tag, 205
Import user archive data, 1650, 1652
Importing data records, 74, 254, 2161, 2229
Messages, 1140
In trends, 1529
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Inconsistent entries, 201, 1094
Increment, 2359, 2361
Info text, 1131
System block, 1102
Initial-value message, 1084
Integration, 2264
Notes on installation, 2264
Required software components, 2264
Interface
Archive databases, 1616
SIMATIC, 1654
Internal tag, 206
Interpolation, 1531, 1567
Linear interpolation, 1567
ISO 8601, 97
IXDiskSpace.DiskSpace, (See Disk Space Control)

J
Jump to place of use, 1786, 1791

K
Key combination, 149

L
Language, 149
For texts, 1152
Layout languages, 1925, 2070
Multilingual projects, (See Multilingualism)
Last access
User archive, 1624
Layer, 334
Assignment, 338
Changing the arrangement of objects, 450
Setting, 287, 313, 314, 339
Layout, 1924
Showing properties, 1929
Changing, 1930
Create, 1844
File operations, 1925
Languages, 1924, 1925
Layout objects, 1924, 2010
Line layouts, (See Line layout)
Message archive report, 1195
Multilingual projects, 2179, 2180, 2183
Multiple layouts, 1932
Objects, (See Object )
Page layout editor, (See Page layout editor)
Page layouts, (See Page layout)
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Print jobs, 1805
LDF file, 1363
Length of the tag, 209
Library, 682, 2301
Convert, 261
Customized objects, 682
Inserting objects, 686, 687
Library objects, 653
Siemens HMI Symbol Library, 383
Toolbar, 684
License
Communication driver, 216
License information, 189
Power Tags, 207
Lifebeat monitoring
Project documentation, 1836
Lifebeat Monitoring
Project documentation, 1815
Limit, 1170
Limit value monitoring
Color identification, 1426, 1477
Limits
Tag, 209
Line layout, 1803, 2083
Create, 1858
Output of message sequence reports, 1858,
1861
Time base, 102
Line layout editor, 1799, 2083, 2092
Creating tables , 2094
Creating headers and footers, 2090, 2093
Creating tables, 2090
opening, 2084
Page Setup, 2089, 2092
Printer Settings, 2089
Standard toolbar, 2088
Structure, 2086
Time Base, 2091
Linear scaling, 209
Linking, 1781, 1787, 1952
Example, 1795
Linking fields, 1628
List box, 546, 600
List of Hidden Messages, 1287
List of messages to be hidden, 1201
ListView Control, 552
Load online changes, 104, 108
Diagnostics, 115
Download, 119
enable, 117
Limitations, 112
Requirements, 110

WinCC: Working with WinCC
System Manual, 06/2014, A5E34373625-AA

Index

Resetting, 123
Lock bit, 1143, 1146
Lock list, 1084, 1201, 1236, 1257
Lock tag, 1141, 1143, 1146
Lock window, 1283
Locking messages, 1283
Alarm Control, 1283
Persistence, 1283
Log, 2317
Showing, 2317
Logging
System block, 1102
Logon, 2203
Connect WinCC/PCS7-OS, 2261
Electronic signatures, 2255, 2256, 2258
Runtime, 2249
SIMATIC Logon, (See SIMATIC Logon)
Tag logon, 2246
Logout
Automatic logout, 2245
Long-term archive list, 1084, 1192, 1201, 1243,
1257
Long-term archive server, 1335
Loop In Alarm, 1134
System block, 1102
Lower limit, 2361
LTO
Load online changes, 119

M
Manual hiding, 1287
Maximum , 1527, 1563
MDF file, 1363
Media Control, 368, 409
Configuring, 411
Inserting, 409
Memory requirements of messages, 1180
Menu
Customized menus, (See Editor )
Menu bar
WinCC Explorer, 44
Message, 1084, 1120, 1259
Acknowledgment Of Messages, 1114
Acknowledgment tag, 1130
Archiving, 1183
Assigning a message group, 1150
Collapse, 1287
Colors, 1118
Configuration, 1090
Configuring, 1090
Configuring a hit list, 1216
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Configuring a message, 1262
Configuring messages, 1101
Copy, 1125
Create, 1125
Creating multiple, 1125
Delete, 1127
Display in runtime, 1257
Editing multiple, 1126
Emergency acknowledgment of messages, 1239
Export, 1139
Hide, 1135, 1243
Import, 1140
Information text, 1131
Linking to picture, 1134
Lock, 1283
Locking in Alarm Control, 1283
Loop In Alarm, 1134
Message blocks, 1101
Message classes, 1107
Message group, 1141
Message number, 1121
Message system, 1101
Message tag, 1128
Message texts, 1131, 2168
Monitoring limits, 1167
Multilingual projects, 2168
Next free number, 1098
Parameter, 1121
Priorities, 1121
Process values in the message text, 1133
Properties, 1121
Reload after power failure, 1194
Selecting, 1234
Selection, 1271, 1281
Shared, 1168
Show, 1243
Sorting messages, 1205, 1240
Status tag, 1129
Status texts, 1116
System blocks, 1102
System message class, 1110
System messages, 1152, 1155
Tag, 1128, 1129, 1130, 1148
Visualization in Runtime, 1201
Message archive, 1084, 1180, 1181
Access to the archive database, 1197
AlarmControl, 1192
Archive files, 1183
Archive partitions, 1181
Archive server, 1198
Backups, 1187, 1189, 1190
Configuring, 1181, 1183
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Message archive report, 1195
Message server, 1198
Output in Runtime, 1191, 1192
Reloading messages after power failure, 1194
Segments, 1181, 1183
Signature, 1187
Message bit, 1121
Message block, 1084, 1090, 1203, 1205, 1259
For message text, 1169
Configuring a hit list, 1216
Configuring message blocks, 1259, 1264
For a tag, 1169
For message text, 1152
Properties, 1105
Use, 1104
Working with message blocks, 1101
Message class, 1084, 1107, 1259
Add, 1107
Adding message type, 1112
configuring, 1259
Configuring, 1109
Create copy, 1108
Export, 1139
Removing, 1110
Message event, 1084, 1180
Message group, 1084, 1141
Assigning a message, 1150
Assigning a message group, 1150
Assigning a new message, 1151
Create, 1142
Delete, 1152
Hide, 1148
Message class, 1107
Properties, 1143
Removing a message, 1151
Status tag, 1144
Tag, 1143, 1144, 1146, 1147
Message line, 1084, 1201, 1205, 1264
Message list, 1084, 1201, 1257
Output, 1857
Reporting, 1856
Message procedure, 1084
Message sequence report, 1084, 1799, 1856
Create, 1861
Creating print jobs, 1858
Creating tables, 2094
Line layouts, (See Line layout)
Output options, 2096
Message server, 1198
Message status, 1084
Came In, 1116
Message system, 1084, 1090
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Configuring, 1101
Message tag, 1084, 1121, 1128
Message text, 1131
Inserting process values, 1133
Message type, 1084, 1111, 1259
Acknowledging messages, 1114
Add, 1112
Changing properties, 1113
Colors, 1118
Configuring status texts, 1116
Configuring the message type, 1259
Create copy, 1113
Delete, 1119
Export, 1139
Message window, 1084, 1090, 1201, 1205
Status texts, 1116
Messages
Analog alarm, 1171
AS messages, 1175
Editing multiple messages at the same time,
1094
Filtering, 1094
Finding, 1094
Memory requirements, 1180
Minimum, 1527, 1563
Modify
selected areas, 1098
Monitor keyboard, 166, 702
Configuring, 703
Operating, 704
Monitoring event, 1084
Mouse pointer, 166
Mouseless operation, 706, 707, 709
Multilingualism
Alarm Logging, 2114, 2168, 2187
Configuring, 2114, 2117
Date and time settings, 2187
Editing texts, 2133
Editors, 2114, 2120
Example configurations, 2193, 2194, 2196, 2200
Exporting texts, (See Text Distributor)
Fonts, 2121
Graphics Designer, 2114, 2171, 2172, 2174,
2175, 2187
Importing texts, (See Text Distributor)
Language combinations, 2110, 2114
Language terms, 2111
Layouts, 2179, 2180
Operating system languages, 2111, 2118
Project documentation, 2185
Report Designer, 2187
Runtime languages, 2111, 2189, 2190
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Supported languages, 2110
Text Distributor, (See Text Distributor)
Text Library, (See Text Library)
Translating text, 2133
User archives, 1644
WinCC languages, 2111, 2120
Multiple languages
Configuring text list, 2177
Exporting files, 2128, 2129, 2130, 2132, 2133
Fonts, 2122
Project documentation, 2179
Runtime documentation, 2179, 2186
Runtime languages, 2190
Multiple row text object, 546, 597
Multiple selection, 433, 435
Multiuser engineering, 2328
Multiuser engineering , 90
Multi-user project, 1306, (See Project)
Multi-user system, 77, 81
Load online changes, 108
Runtime, 170, 174
Startup list, 139
Time settings, 97

N
Navigation
Area, 1342
Navigation area, 198, 201, 1091, 1632
Navigation bar, 198, 1091
Navigation window, 258, 261
Tag Logging, 1339
WinCC Explorer, 41, 49
Network entry jump, 2344, 2345
Configuring, 2345
Network return, 2348
New
Compressed archive, 1350
Connection, 235
Internal tag, 239
Process value archive, 1348
Tag group, 247
User archive, 1634
View, 1645
New value message, 1084
Non-existing tag, 1781

O
Object, 425, 1935
Application window, 507
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Basic dynamic operations, 454, 456, 457, 459,
461, 463, 465, 468
Basic static operations, 428, 429, 432, 435, 437,
439, 440, 442, 443, 445, 446, 447, 448, 449, 450,
452
Central color palette, (See Color palette)
Characteristics, (See Object property)
Color palette, (See Color palette)
Combined objects, 425, 653
Configuring operator authorizations, 508
Configuring the object selection, 264
Coordinate systems, 279, 1935
Copying, 341, 342, 1940
Customized objects, (See Customized object)
Deleting, 201
Dynamic objects, (See Dynamic object)
Editing in the page layout editor, 1940
Exporting, 330
Global design, 126, 135
Layout objects, 1924, 2010
Library objects, (See Library)
Linking, 452, 465, 1952
Mouseless operation, (See Mouseless operation)
Multiple selection, 433, 435, 439
Multiple selections, 1942, 1944, 1945, 1947
Object name, 429, 430, 1955
Object palette, 1899
Object types, 426
Origin, 277
Pasting, 1939
Picture window, 507
Positioning, 437, 1940
Project documentation, (See Project
documentation)
Properties, (See Object property)
Rectangle surrounding the object, 281, 437, 1937
Rotate, 506
Runtime documentation, (See Runtime
documentation)
Selection marks, 281, 1937
Setting transparency, 512
Settings in the Graphics Designer, 309, 314, 317,
319
Smart objects, (See Smart object)
Standard objects, (See Standard object), (See
Standard object)
Static objects, (See Static object)
System objects, (See System object)
Tube objects, (See Tube object)
Use in faceplate types, 348, 349, 356
Windows objects, (See Windows object)
Object OLL, (See Graphic OLL)
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Object palette, 290, 1899
Changing the default settings of object types, 426
Configuring control selection, 266, 377
Configuring the object selection, 264
Object groups, 295, 298, 425
Smart objects, 546
Standard objects, 512
Object property, 470, 1947
"Object Properties" window, 471, 472, 474, 476,
478, 1947, 1948, 1949, 1950, 1952
Attributes, 476, (See Attribute)
Changing attributes, 1953
Dynamization, (See Attribute)
Events, 474
Property groups, (See Property group)
Transferring, 1954
Object type
Changing default settings, 426
Configuration dialog, 647
Global design, 126
Object name, 429, 430
Property groups, (See Property group)
Settings, 309
OCX, (See ActiveX Control)
ODK
Archive databases, 1616
Offset, 2361
OLE DB Provider
Archive databases, 1616
OLE object, 546
Edit, 558
Inserting, 558
Online configuration, 1224, 1395, 1439, 1493, 1735
AlarmControl, 1229
FunctionTrendControl, 1447, 1448, 1496, 1499,
1500, 1501, 1503
OnlineTableControl, 1398, 1401, 1403, 1405,
1406
OnlineTrendControl, 1442, 1445, 1447, 1448,
1450, 1452, 1455, 1500, 1501
Online Table Control, 1508
Changing configuration, 1519
configuration, 1513
display of archived values, 1526
dynamic display, 1511
dynamizing time range, 1511
Inserting, 1514
operation in Runtime, 1518
representation formats, 1508
starting update, 1524
static display, 1511
stopping update, 1524
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time range, 1511
Online tags, 1584
Online Trend Control, 1549
Changing configuration, 1552
Common axes, 1532
Determine co-ordinate points, 1559, 1600
Display of archived values, 1562
Inserting, 1540
Linear Interpolation, 1531
Online tags, 1543, 1546
Representation formats, 1531
Resolution, 1529
Single values Online Trend Control:step curve,
1531
Staggered trends, 1534
Starting update, 1557
Stopping update, 1557
Trend on top, 1557
Writer function, 1534
Online Trend Control:configuration, 1539
Online Trend Control:dynamic display, 1535
Online Trend Control:dynamizing time range, 1544
Online Trend Control:enlarging section, 1561
Online Trend Control:static display, 1535
Online Trend Control:time jumps, 1537
Online Trend Control:time overlap, 1537
Online Trend Control:time range, 1535
OnlineTableControl, 368, 1373
Buttons, 1398
Changing archive values, 1404
Configuring, 1373, 1374, 1377
Configuring operator messages, 1391
Configuring RulerControl, 1387, 1433, 1487
Configuring table elements, 1209, 1210, 1211,
1212, 1380, 1381, 1382, 1383, 1726, 1727, 1729
Creating archive values, 1404
Online configuration, 1224, 1395, 1398, 1401,
1403, 1405, 1406, 1439, 1493, 1735
Output of process values, 1862
Runtime data, 1222, 1393, 1437, 1491, 1734
Status bar, 1213, 1384, 1398, 1430, 1484, 1730
Time columns, 1374
Toolbar, 1213, 1384, 1397, 1398, 1430, 1484,
1730
Value columns, 1377
OnlineTrendControl, 368, 1410, 1414
Archives, 1455
Buttons, 1442
Configuring, 1413, 1414, 1415, 1418, 1421, 1424,
1426, 1477
Configuring RulerControl, 1387, 1433, 1487
Example, 1455, 1456, 1458, 1461, 1463
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Online configuration, 1224, 1395, 1439, 1442,
1445, 1447, 1448, 1450, 1452, 1455, 1493, 1500,
1501, 1735
Output of process values, 1862
Representation formats, 1411, 1413
Runtime data, 1222, 1393, 1437, 1491, 1734
Screen resolution, 1410
Status bar, 1213, 1384, 1430, 1442, 1484, 1730
Time axes, 1418
Toolbar, 1441, 1442
Toolbar , 1213, 1384, 1430, 1484, 1730
Trend window, 1415
Trends, 1424, 1426, 1477
Value axes, 1421
Zoom functions, 1450
OPC
Access to the archive database, 1197
Archive databases, 1616
Operating system
Languages, 2111
Multilingual projects, 2111, 2114, 2118
Operating the User Archive Control, 1769
Operating the User Archive Table Element, 1769
Operation in Runtime, 1278, 1518, 1549, 1773
Operational message, 1084
Operator authorization, 2344, 2345, 2351
Operator input messages, 1110
Operator input messages upon archive value
changes, 1391
Operator message, 1084, 1178, 1219
Operator station
Creating, 2285
Load online changes, 108, 110, 112
Operator Station, 2284
Option
Overview of editors, 185
Origin, (See Coordinate system)
OS, 2284
Compiling, 2307
Creating, 2285
OS properties, 2273, 2285
Standby OS properties, 2277
OS project editor
Project documentation, 1837
OS Project Editor
Project documentation, 1815
OS properties, 2273, 2285
OS ref.WinCC application
ObjectWinCC Appl. Ref.WinCC
application:creating reference , 2281, 2290
OS simulation, 2304
Starting, 2304
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Oscillation, 2359, 2361
Output window, 294
Overshoot, 2361

P
Package, 2298
Assigning OS server, 2298
Page layout, 1801
Output of message sequence reports, 1858,
1861
Time base, 102
Page layout editor, 1799, 1893, 1895
Adapting the workspace, 1913, 1914, 1915, 1916
Alignment palette, 1908
Color palette, (See Color palette)
COM server objects, (See COM server)
Font palette, 1912
Linking objects, 1952
Object palette, 1899
Objects, (See Object )
Opening, 1894
Output of user-specific data, (See COM server)
Settings, 1918, 1919, 1920, 1922
Standard toolbar, 1897
Status bar, 1913
Structure, 1895
Style palette, 1907
Zoom palette, 1910
Palette, (See Toolbar)
Alignment palette, 286, 439, 1908, 1945
Arranging, 1915
Color palette, (See Color palette), (See Color
palette)
Font palette, 290, 1912
Layer palette, 287, 339
Show/hide, 1915
Standard and controls, 295, 298
Style palette, 299, 1907
Tag palette, 299
Zoom palette, 294, 1910
Parameter dialog, 1848
Parameters
Archive tag, 1353
Compressed tag, 1357
Process-controlled tag, 1355
PC station, 2269, 2270, 2281, 2290
PCS 7
Applying tag properties, 1548
Period of oscillation, 2361
Persistence, 1236
Picture, 323, 2295, 2301
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Assigning menus and toolbars, 697
Basic dynamic operations, 454, 456, 457, 459,
461, 463, 465, 468
Basic settings, 307
Basic static operations, 428, 429, 432, 435, 437,
439, 440, 442, 443, 445, 446, 447, 448, 449, 450,
452
Configuring operator authorizations, 508
Configuring the background picture, 331
Converting libraries, 261
Coordinate systems, 277, 279
Copy, 2296
Copying to library, 2301
Create, 261, 324
Creating, 2296
Creating model solutions, 2301
Defining picture properties, 331
Delete, 269, 2296
Deleting in library, 2301
Displaying properties, 261, 269, 271
Displaying statistics, 271, 273
Edit, 325, 326, 327, 328
Editing multiple pictures, 339, 340, 341, 342
Embedding in objects, 650
Exporting, 330
Importing, 2298
Inserting controls, 556
Mouseless operation, (See Mouseless operation)
Moving, 2296
Moving to library, 2301
Multiple selection, 433, 435
Objects, 279, 286, 317, 341, 342, 452, 465
Origin, 277
Password protection, 333
Picture Cache, 166
Project documentation, 2055, 2057, 2059, 2061
Project Planning Notes, 323
Rectangle surrounding the object, 281, 374, 376,
437
Rename, 269, 2296
Rename picture, 261
Renaming in library, 2301
Runtime, 689
Screen navigation, 157
Selection marks, 281, 374, 376
Setting layers, 287, 313, 314
Setting the grid, 307
Setting the transparency of objects, 512
Setting the zoom factor, 294
Start picture, 160
Start screen, 269, 697
Style groups, 299
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Transferring picture properties, 340
Using library objects, 686
Picture Change
Configuring, 629, 630
Picture cycle, 320, 458, 463, 963
Picture name
Configuration instructions, 1798
Picture Tree Manager
Multilingual projects, 2114
Project documentation, 1815, 1835
Picture window, 546
Assigning menus and toolbars, 697
Configuring, 94, 509
Create, 507, 552
Selecting pictures, 650
Pictures; favorites, 151
Place of use, 1781, 1786, 1791
PLCID, 1624
Point of error, 1131
Position
Field, 1644
User archive column, 1647
Power failure, 1194
Power tag, 207
Print job, 1805
Attitudes, 1806
Create, 1846
Creating, 1819, 1821
Defining printer, 1811
Defining printing ranges, 1809
Hard disk capacity, 1811
Message lists, 1857
Message sequence reports, 1858
Multilingual projects, 2179, 2180, 2183
Properties, 1806
Runtime documentation, 1840, 1848
Settings, 1809, 1811
System print jobs, 1805, 2179
Print job properties, 2442
Print jobs, 2441
Printing messages
Color conversion, 1856
Priorities, 614, 620
Priority
System block, 1102
Process control system, 1110
Process peripherals, 2359
Process picture, (See Fig.), (See Fig.)
Process pictures; Changing languages, 154
Process pictures; favorites, 151
Process pictures; Navigation, 155
Process tag, 207, 1308, 1309, 2359
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Archiving, 1352
Create, 240
Data types, 207
Licensing, 207
Process value archives, 1325, 1326, 1327, 1328
Structure type, 211, 242
Text tag, 227
Process value, 1308
Backups, (See Archive backup)
Displaying, 1370, 1371, 1373
Inserting in message text , 1133
Reporting, 1862
Reports, 1504
Process value archive, 1303, 1304, 1306, 1334,
1348, 1514
Acyclic archives, 1327
Archive tag, (See Archive tag)
Archiving methods, 1323, 1361
Backups, 1363
configuring, 1514
Configuring, 1339, 1348, 1361
Continuous cyclic archives, 1325
Cycles, 1323, 1324
Cyclic selective archives, 1326
Data buffer, 1334, 1349
Events, 1324
Manual input, 1348
Multi-user projects, 1306
Process-controlled archives, 1328
Project documentation, 2062, 2065
Properties, 1316
Term definitions, 1304
Process value block, 1084, 1219, 1391
Formatting, 1132
Maximum number of characters, 1101
Working with message blocks, 1101
Process value output
As table, 1506
As trend, 1506
In process picture, 1506
Process-controlled tag, 1309
Properties, 1321, 1355
Processing
Undo, 201, 1094, 1342
Project, 35, 36, 170, 2294
Autostart, 173
Basic Process Control, 83
Changing project type, 79
Client projects, 77
Computer properties, 88
Configuring, 81, 85, 88, 94, 509
Copy, 177
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Duplicate, 36, 177, 180, 183
File structure, 195
Global design, (See Global design)
Hotkeys, 142
Illegal characters, 191
Load online changes, (See Load online changes)
Multi-user projects, 76, 177
Not opened with WinCC Explorer, 36
Online configuration, 104
Opening, 2294
Picture window, 94, 509
Remote projects, 170, 174
Runtime, 170, 174
Runtime settings, 137, 145, 146, 148, 149, 157
Single-user projects, 76
Startup list, 139
Time setting, 97
Time settings, 100
WinCC Explorer, 36, 39
WinCC status, 188
Project documentation, 1799, 1815
Alarm Logging, 1827, 2050
Changing layouts, 1930
Component list editor, 1838
Compressed archives, 2062, 2065
Connection lists, 2072
Creating print jobs, 1819, 1821
Cross Reference, 1833
Displaying user ID, 2253
Dynamic metafiles, 2075
Dynamic tables, 2076
Dynamic text, 2074
Editors, 1815
Global Script, 1829
Graphics Designer, 1824
Horn, 1834
Lifebeat monitoring, 1836
Multilingual projects, 2179, 2180, 2183, 2185
Objects, 1906, 2046, 2048
OS project editor, 1837
Output, 1816
Output options, 2050, 2051, 2053, 2055, 2057,
2059, 2061, 2062, 2065, 2068, 2070, 2072, 2074,
2075, 2076
Page layouts, (See Page layout)
Picture Tree Manager, 1835
Preview, 1818
Print jobs, 1884
Process pictures, 2055, 2057, 2059, 2061
Process value archives, 2062, 2065
Selection dialogs, 2048
System layouts, 1884
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Tag Logging, 1828, 2062, 2065
Tags, 2070
Text Library, 1831, 2068
Time Synchronization, 1834
User Administrator, 1832
User archives, 2051, 2053
Views, 2053
WinCC Explorer, 1823
Project Duplicator, 177, 180, 183
Project library, (See Library)
Project object, 1781
Project properties
Global design, 125, 135
Hotkeys, 142
Project selection, 2448
Project settings; System dialogs, 152
Properties
Archive, 1635
Archive tag, 1318, 1353
Area, 201, 1342, 1632
Column, 1646
Column of a view, 1628
Compressed archive, 1317
Compressed tags, 1322
Cycle time, 1314
Edit, 1094
Editing, 201, 246, 1342
Message block, 1105
Message class, 1109
Message type, 1113
Process value archive, 1316, 1348
Process-controlled tag, 1321
Structure tag element, 214
Tag, 209
Time series, 1315
User archive, 1624
User archive field, 1626
View, 1628, 1645
What's this?, 198
Properties area, 198, 201, 1091
Properties nodes, 354
Properties of User Archives Table Elements, 1776
Property group, 479, 1953
Assignment, 503
Axis, 480
Background picture, 493
Colors, 487, 1956, 1957
Connected Objects, 502
Customized objects, 662
Display, 486
Filling, 489
Flashing, 484
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Font, 495, 1961, 1962
Geometry, 490, 1958, 1960
Limits, 492
Lock, 500
Message types, 493
Miscellaneous, 496, 1962, 1963
Output/Input, 481
Picture, 482
Pictures, 483
State, 504
Styles, 500, 1964, 1965
Property nodes, 349, 352
Push Button Control, 368

Q
Quality code, 233, 1318, 1323
Displaying, 209, 253
Quality code , 1169
Quality codes, 1054
Compressed archive, 1333
Quantity limitation, 1271
Quantity structure, 110, 1180

R
Radio box, 625, 634
Random numbers, 2359
Random numbers , 2361
Raw data tag, 1309, 1321, 1328, 1353
Data communication, 1654
Data communication with SIMATIC, 1654, 1658,
1659, 1660, 1661, 1662
Data formats, 1657
Frames, 1310
User archives, 1636
Read rights
User archive, 1625
User archive field, 1627
Redundant system
Duplicating projects, 180, 183
Load online changes, 112
Redundant user archives, 1629
Runtime, 170
Reference, 1781
Reference object, 433, 435, 1942
Relation, 1628
Example, 1648
Relevant long term, 1321, 1322
Reload after power failure, 1194
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Replace
Cross Reference, 1787
Report, 1504, 2295, (See Runtime documentation)
Copy, 2296
Creating, 2296
Delete, 2296
Importing, 2298
Message archive report, 1195
Moving, 2296
Rename, 2296
Report Designer, 1799
Message archive report, 1195
Multilingual projects, 2114
Page layouts, (See Page layout editor)
Report object, 1840
COM server, 1865, 1882
Hard copy, 1865, 1874
ODBC databases, 1865
Output of CSV data, 1865, 1867, 1868, 1871
Report page, 2441
Report system, 2102
Report objects, (See Report object)
Report template, 2301
Copying to library, 2301
Creating model solutions, 2301
Deleting in library, 2301
Moving to library, 2301
Renaming in library, 2301
Representation formats, 1508
Representation in trend format, 1531
Representation of process values, 1529
Representation of process values in tables, 1508
Reset, 1183
Resolution, 1565
Return, 2348
Round button, 625, 636, 650
Ruler window, 1387, 1406, 1433, 1452, 1487
RulerControl, 368, 1387, 1433, 1487
Configuring, 1387, 1433, 1487
Configuring table elements, 1209, 1210, 1211,
1212, 1380, 1381, 1382, 1383, 1726, 1727, 1729
Online configuration, 1224, 1395, 1439, 1493,
1735
Runtime data, 1222, 1393, 1437, 1491, 1734
Status bar, 1213, 1384, 1430, 1484, 1730
Toolbar, 1213, 1384, 1430, 1484, 1730
Runtime, 697, 1278, 1518, 1594
Activate, 689
Application window, 507
bringing to front, 1524
Buttons, 1738
Configuring in Runtime, (See Online configuration)
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Connection, 233
Deactivate, 689
defining time range, 1511
Display in front, 1557
display of archived values, 1526
Display of archived values, 1562
editing fields, 1525
Emergency Acknowledgment of Messages, 1289
Exiting, 174
External applications, 143
Form view, 1768
Language switching, 2189, 2190
Languages, 2111
Load online changes, (See Load online changes)
Locking messages, 1283
Menus and toolbars, (See Editor ), (See Editor )
Monitor keyboard, 702, 703, 704
Mouseless operation, (See Mouseless operation)
Multilingual projects, 2111, 2189, 2190
Online configuration, 104
Operating the User Archive Control, 1769
Operating the User Archive Table Element, 1769,
1773
Operation of Alarm Control, 1278
operation of Online Table Control, 1518
Operation of Online Trend Control, 1549
Operation of the Function Trend Control, 1594
Operation of Trend Control, 1549
Output of message archive, 1191, 1192
Parameterization dialogs, 1519, 1552
Performance, 457, 459, 468
Picture window, 507
Representation of process values, 1515
Rotation of objects, 506, 541
Selecting archive, 1519, 1552
selecting columns, 1524
Selecting tags, 1519, 1552
Selection of messages, 1281
Settings, 137, 145, 146, 148, 149, 157, 160, 162,
164, 166, 505
Sorting messages, 1291
Starting, 137, 170, 173
Startup list, 139
Table View, 1767
Tag, 252
Testing pictures, 689
Trend Control, 1549
Runtime data
edit, 1651
Exporting, 1651
Importing, 1652
Runtime documentation, 1799, 1840
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Archive reports, 2032, 2034, 2036, 2041
COM server objects, 1905
Configuring dynamic parameters, 2015, 2020,
2024, 2028, 2031
Configuring static parameters, 2012, 2017, 2022,
2026, 2031
Creating layouts, 1844
CSV file requirements, 1871
CSV files, 2043, 2045
Displaying user ID, 2253
Dynamization of log parameters, 1848, 1851
Line layouts, (See Line layout)
Message lists, (See Message list)
Message reports, 2032, 2034, 2036, 2041
Message sequence reports, (See Message
sequence report)
Multilingual projects, 2179, 2180, 2183, 2186
Objects, 1904, 2011
Output options, 1848, 1998, 2000, 2002, 2012,
2015, 2017, 2020, 2022, 2024, 2026, 2028, 2031,
2032, 2034, 2036, 2038, 2040, 2041, 2043, 2045
Page layouts, (See Page layout)
Parameter dialog, 1848
Print jobs, 1846, 1887
Process values, 1862
Report objects, (See Report object)
System layouts, 1887
Time settings, 102
User archive tables, 2038, 2040
User archives, 1863
WinCC UserArchiveControl, 2031
Runtime:defining time range, 1535
Runtime:Form View, 1768
Runtime:representation of process values, 1530
Runtime:selecting trend, 1530
Runtime:Table View, 1767
Runtime; Changing languages, 154
Runtime; Process picture navigation, 155
Runtime; System dialogs, 152

S
Screen Navigation, 157
Screen saver, 143
Script, 2443
Example with user archive functions, 1667
Script management, 2451
Selecting statistics range, 1527, 1559
Selection
Importing, 1205
Selection dialog, 1205, 1234, 1742
Selection borders, 433, 435, 1942
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Selection of messages, 1271, 1281
Sequence
Column, 1629
User archive field, 1627
View, 1628
Server
Server prefixes, 1011
Server data, 2298
Assigning OS server, 2298
Setpoint value, 2361
Shared message, 1168
Shared time column, 1509
Shortcut menu, 1120
Short-term archive list, 1084, 1192, 1201, 1243,
1257
Siemens HMI Symbol Library, (See Symbol Library)
Signature, 1187
Electronic signatures, 2255, 2256, 2258
SIMATIC Logon, 2203, 2251
Connect WinCC/PCS7-OS, 2261
Electronic signatures, 2255
SIMATIC Logon Service, 2252, 2253, 2255
WinCC startup list, 2251
SIMATIC Manager, 2264, 2266, 2269, 2284, 2291,
2294, 2295, 2303, 2304
Adopting language settings, 2294
SimaticDate, 229
SimaticDateAndLTime, 229
SimaticDateAndTime, 229
SimaticDTL, 229
SimaticLTimeOfDay, 229
SimaticTimeOfDay, 229
Simulation, 2304, 2358
SIMATIC Manager, 2304
Starting, 2304
Simulator, 2358
Sine, 2359
Sine wave, 2361
Single acknowledgment, 1084, 1121
Single message, 1262
Configuring a message, 1262
Hiding Messages, 1287
Project documentation, 2050
Selection, 1281
Single values, 1567
Single-user project, (See Project)
Single-user system, 81
Slider, 625, 638, 640, 641, 2359, 2361, (See Slider
Control), (See Slider)
Slider Control, 368, 414
Inserting, 414
Settings, 415, 416, 418, 419, 420, 421
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Smart object, 546
.NET controls, 371, 546, 604
3D bar, 546, 607
ActiveX controls, 370, 546
Analog display (extended), 546
Application window, 546
Bar, 546, 572, 574, 575, 577
Combo box, 546, 598
Controls, 373, 380, 556
Descriptions, 546
Faceplate instance, 546, 603
Graphic object, 546, 579
Group Display, 546, 609
I/O field, 546, 561, 563, 564, 566, 567, 569, 570
List box, 546, 600
Multiple row text, 546, 597
OLE object, 546, 558
Picture window, 546, 552
Status display, 546, 582, 584, 586
Status display (extended), 546
Text list, 546, 589, 591, 592, 593, 595, 596
WPF controls, 371, 546, 605
Sort
Default sorting, 1205
Sort dialog, 1240
Sort ...
Sort dialog, 1744
Sort Criteria, 1759
Sorting messages, 1271, 1291
Source archive, 1322
Source tag, 1322
SQL, 1226, 1759, 1769, 1771, 1772
SQL statement used to filter messages, 1299
Standard and controls, 295, 298
Standard deviation, 1527, 1563
Standard function, 1293
Example of use, 1295
Standard object, 512, 1900, 1966
Circle, 512, 526
Circular arc, 512, 535
Connector, 512, 543
Dynamic objects, (See Dynamic object)
Ellipse, 512, 524
Ellipse arc, 512, 532
Ellipse segment, 512, 527
Line, 512, 515
Pie segment, 512, 530
Polygon, 512, 518
Polyline, 512, 520
Rectangle, 512, 537
Rounded rectangle, 512, 539
Static objects, (See Static object)
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Static text, 512, 541
System objects, (See System object)
Standard objects, 1966
Standard time
System block, 1102
Standard trigger, (See Triggers)
Standby computer, 2277
Selecting, 2277
Standby OS properties, 2277
Start Picture, 160
Start time, 1314, 1315
Start value, 2361
Startup list, 139
Integrating the PrintScreen application, 1875,
1877
Message sequence reports, 1858
Static display, 1511
Static object, 1900, 1901, 1966
Circle, 1901, 1975
Circular arc, 1901, 1983
Ellipse, 1901, 1973
Ellipse arc, 1901, 1981
Ellipse segment, 1901, 1977
Line, 1901, 1967
OLE object, 1901
OLE project, 1991
Pie segment, 1901, 1979
Polygon, 1901, 1969
Polyline, 1901, 1970
Rectangle, 1901
Rounded rectangle, 1901, 1987
Square-wave, 1985
Static metafile, 1901, 1993
Static text, 1901, 1989
Statistics area window, 1387, 1406, 1433, 1452,
1487
Statistics of Runtime data, 1563
Statistics range, 1563
Statistics window, 1387, 1406, 1433, 1452, 1487
Status
System block, 1102
Status bar, 1091, 1213, 1278, 1339, 1384, 1430,
1484, 1730
AlarmControl, 1233
FunctionTrendControl, 1496
Graphics Designer, 293
OnlineTableControl, 1398
OnlineTrendControl, 1442
Page layout editor, 1913
UserArchiveControl, 1738
WinCC Explorer, 48
Status bit, 1121, 1129, 1143, 1144
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Status display, 546
Changing, 582
Configuration dialog, 647
Configuring, 584, 586
Extended, 614
Inserting, 582
Selecting pictures, 650
Status tag, 1084, 1121, 1129, 1141, 1143, 1144
Status text, 1116
STEP 7, 2321
Message configuration, 2321
STEP 7 symbol, 2331
STEP 7 symbols, 2339
Selecting, 2334, 2342
Showing, 2340
Transferring, 2336
window, 2332
STEP 7 Symbols, 2330
STEP7 message configuration, 2321
Stepped trend, 1567
Stop value, 2361
Structure, 2372
Structure element, 211, 242
Structure instance, 211
Structure tag, 211, 242
Creating, 245
Customized objects, 667
Editing properties, 246
Properties, 214
Rename, 251
Structure tag element, 211
Properties, 214
Structure tag element
Editing properties, 246
Structure tag elements, 245
Structure type, 205, 211
Configuring, 241
Creating, 242
Data types, 242
Deleting, 201
Rename, 251
Structure type element
Creating, 244
Editing properties, 246
Properties, 214
Substitute value
Tag, 209
Swapping out, (See Archive backup)
Swinging Door, 1329
Symbol Library, 368, 383
Inserting, 383
Selecting symbols, 384
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Settings, 386, 388, 390
Symbols
AlarmControl, 1233
System block, 1084, 1102
Overview, 1102
Working with message blocks, 1101
System dialog
Changing language, 2200
System dialogs, 152
System dialogs; Changing languages, 154
System logon, (See Logon)
System message, 1084, 1110
Descriptions, 1155
refresh, 1152
Use, 1152
System message class
Requires acknowledgment, 1110
without acknowledgment, 1110
System object, 1900, 1903, 1966, 2008
Date/time, 1903
Layout name, 1903
Page number, 1903
Project name, 1903
System parameters, 236
System shutdown, 1314
System startup, 1314
System status, 1135
System tag, 206

T
Tab order, 157, 706, 709
Tab sequence, (See Mouseless operation)
Table, 1094, 1342
Configuring table elements, 1209, 1210, 1211,
1212, 1380, 1381, 1382, 1383, 1726, 1727, 1729
Displaying process values, 1371
OnlineTableControl, (See OnlineTableControl)
separate time columns, 1509
shared time column, 1509
Table area, 198, 201, 1091, 1632
Table display formats, 1509
Table View, 1746, 1747, 1767
Defining, 1753
Table View:Define, 1753
table window
Tag Logging, 1339
Tables, 1508
dynamic display, 1509, 1512
static display, 1511
time range, 1511
Tabs, 1091, 1339
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Tag, 205, 2331, 2339
Acknowledgment tag, 1130, 1147
Assigning to groups, 248
Compressed tag, 1309, 1332, 1355
Control tag, 1636
Create, 239, 240
Create structure tags, 241
current value, 209
Data types, 216, 217, 218, 219, 220, 221, 222,
223, 224, 225, 227, 228, 229
Deleting, 201
Diagnostics tag, 1313
Editing, 249
Editing properties, 241
Export, 254
External tag, (See Process tag)
Faceplate tags, 359, 360
Frame tag, 1309
Hide tag, 1135, 1148
Internal tag, 206, 228, 239
Lock tag, 1146
Message tag, 1128
Naming conventions, 205
Process tag, (See Process tag)
Process-controlled tag, 1309, 1353
Project documentation, 2070
Properties, 209
Raw data tag, 1309
Rename, 251
Runtime, 252
Start value, 240
Status tag, 1129, 1144
Structure tag, 211
Structure type, 211
System tag, 206
Tag connections, (See Tag connection)
Tag groups, 215, 247
Tag logon, (See logon)
Tag prefixes, 1011
Tag selection dialog, 230
Transferring, 2306
Tag assignment
Configuring, 1033
Tag bar, 2339, 2340, 2342
Tag connection, 1009, 1033
Configuring, 463
Example, 1034
Linking, 465
Selecting tags, 649
Tag filter, 2332, 2340
Tag group, 215
assigning tag, 248
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Creating, 247
Editing, 249
Rename, 251
Tag Logging, 1334, 1339
Compressed archives, 1350
Archive backup, 1363, 1366, 1368
Archive backups, (See Archive backup)
Archive configuration, 1359, 1361
Archive tag, 1351, 1353
Compressed archives, 1306
Compressed tag, 1357
Configuring cycle time, 1346
Configuring time series, 1347
Cycle time, 1345
Data buffer, 1349
Diagnostics tag, 1313
Fast, 1358
Flags, 1337
Output of process values, 1862
Process value archives, 1304, 1306, 1348
Process-controlled tag, 1355
Project documentation, 1815, 1828, 2062, 2065
Slow, 1358
Time series, 1345
Tag Logon, (See Logon)
Tag management
Communication driver, 216
Tag Management, 197, 198
Creating a tag, 239, 240
Tag groups, 215
Tag name, 1321, 1322
Tag prefix, 211
Tag selection dialog, 230, 2331, 2332, 2334, 2336
Tag simulator, 2358
Tag status
Displaying, 253
Monitoring, 1053
Tag supply, 1322
Tag value
Displaying, 253
TagLogging
Function calls, 1618, 1619, 1620, 1621, 1622
Properties, 1359
TagLogging Fast
Settings, 1361
TagLogging Slow
Settings, 1361
Tags
Configuration instructions, 1798
Deleting, 251
Editing multiple tags at the same time, 201
Filtering, 201
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Finding, 201
Target computer, 2273, 2280, 2285, 2289
Load project, 2280, 2289
Setting path, 2273, 2285
Target system, 2280, 2289
Loading, 2280, 2289
Text, 2306
Displaying transferred text, 2319
Transferring, 2306
Text Distributor, 2125
Exporting files, 2128, 2132, 2133
Exporting texts, 2126
Importing texts, 2135
Multilingual projects, 2110, 2114
Translating text, 2174
Text library
Exporting files, 2129, 2132, 2133
Translating text, 2174
Text Library, 2163
Editors, 2163
Managing texts, 2163
Multilingual projects, 2114
Overview of operation, 2165
Project documentation, 1815, 1831, 2068
Text list, 546
Changing, 589
Configuration dialog, 647
Configuring, 591, 592, 593, 595, 596
Inserting, 589
Multilingual projects, 2171, 2177
Text lists, 1175
Time, 97, 149, 2187
System block, 1102
Time axis, (See OnlineTrendControl)
Time base, 97, 1315
Controls, 101
Projects, 100
Runtime documentation, 102
Time factor, 1315
Time range, 1511, 1578
Time series, 1345
Properties, 1315
Time series base, 1316
Time Synchronization
Project documentation, 1815, 1834
Time zone, 97
Timer name, 1314, 1315
Tips and Tricks
Option "Show Tips and Tricks", 309
Tips from the real world, 1098
Toolbar, 1213, 1228, 1264, 1278, 1384, 1430, 1484,
1518, 1730
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"Edit action" dialog, 459
"Edit VBS action" dialog, 461
"Object Properties" window, 1949
AlarmControl, 1229
Customized toolbars, (See Editor )
FunctionTrendControl, 1495, 1496
Graphics Designer, 283, 286, 287, 289, 290, 291,
293, 294, 295, 296, 298, 299
Library, 684
OnlineTableControl, 1397, 1398
OnlineTrendControl, 1441, 1442
Operating the User Archive Control, 1769
Operating the User Archive Table Element, 1769
Operation of Alarm Control, 1278
Page layout editor, 1899, 1907, 1908, 1910, 1911,
1912, 1913, 1915, 1916
Standard toolbar, 291, 1897, 1916, 2088
Table Control, 1518
UserArchiveControl, 1737, 1738
WinCC Explorer, 47
Tooltip, 198
Transfer, 2336
STEP 7 symbols, 2336
Translation
Message block, 1106
no, 1098, 1132
Translation Alias
Column, 1629
User archive field, 1627
View, 1628
Tree structure
Alarm Logging, 1091
Trend
Displaying process values, 1371
FunctionTrendControl, (See
FunctionTrendControl)
OnlineTrendControl, (See OnlineTrendControl)
Representation formats, 1411, 1413, 1466, 1468
Trend Control, 1529
Configuring in the Graphics Designer, 1540
Display in front, 1557
Operation in Runtime, 1549
Paramterization dialogs in Runtime, 1552
Runtime:Determine co-ordinates, 1559
Toolbar, 1549
Trend Control:enlarged display Runtime:enlarged
display, 1561
Trend Control:example of configuration, 1544
Trend Control:representation of archived values,
1530
Trend display, 1578
Trend representation, 1535
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Trends
Common axes, 1532
Linear Interpolation, 1531
Representation formats, 1531
Single Values, 1531
Staggering, 1534
Stepped trend, 1531
Trends:staggering, 1534
Trends:dynamic display, 1535
Trends:resolution of curve display, 1535
Trends:static display, 1535
Trends:time jump, 1537
Trends:time overlaps, 1537
Trends:time range, 1535
Triggers
C actions, 1079
Cyclic triggers, 1013
Dynamic dialog, 1056
Event-driven triggers, 1013, 1016
Settings in the Graphics Designer, 319
Tag triggers, 1014
Tag Triggers, 1013
VBS actions, 1070
Triggers an action, 1121
Tube object, 642
Double T-piece, 642, 645
Polygon tube, 642, 643
T-piece, 642, 644
Tube bend, 642, 646

U
uaAddArchive, 1676
uaAddField, 1677
uaArchiveClose, 1695
uaArchiveDelete, 1695
uaArchiveExport, 1696
uaArchiveGetCount, 1697
uaArchiveGetFieldLength, 1697
uaArchiveGetFieldName, 1698
uaArchiveGetFields, 1698
uaArchiveGetFieldType, 1699
uaArchiveGetFieldValueDate, 1700
uaArchiveGetFieldValueDouble, 1700
uaArchiveGetFieldValueFloat, 1701
uaArchiveGetFieldValueLong, 1702
uaArchiveGetFieldValueString, 1702
uaArchiveGetFilter, 1703
uaArchiveGetID, 1703
uaArchiveGetName, 1704
uaArchiveGetSort, 1705
uaArchiveImport, 1705
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uaArchiveInsert, 1706
uaArchiveMoveFirst, 1706
uaArchiveMoveLast, 1707
uaArchiveMoveNext, 1707
uaArchiveMovePrevious, 1708
uaArchiveOpen, 1708
uaArchiveReadTagValues, 1709
uaArchiveReadTagValuesByName, 1709
uaArchiveRequery, 1710
uaArchiveSetFieldValueDate, 1711
uaArchiveSetFieldValueDouble, 1711
uaArchiveSetFieldValueFloat, 1712
uaArchiveSetFieldValueLong, 1713
uaArchiveSetFieldValueString, 1713
uaArchiveSetFilter, 1714
uaArchiveSetSort, 1715
uaArchiveUpdate, 1715
uaArchiveWriteTagValues, 1716
uaArchiveWriteTagValuesByName, 1717
uaConfigArchive "Structure for Programming the
Handles", 1685
uaConnect, 1687
uaDisconnect, 1688
uaGetArchive, 1677
uaGetField, 1678
uaGetLastError, 1717
uaGetLastHResult, 1719
uaGetLocalEvents, 1688
uaGetNumArchives, 1679
uaGetNumFields, 1679
uaIsActive, 1689
uaOpenArchives, 1689
uaOpenViews, 1690
uaQueryArchive, 1690
uaQueryArchiveByName, 1691
UaQueryConfiguration, 1680
uaReleaseArchive, 1692
uaReleaseConfiguration, 1680
uaRemoveAllArchives, 1681
uaRemoveAllFields, 1682
uaRemoveArchive, 1682
uaRemoveField, 1683
uaSetArchive, 1683
uaSetField, 1684
uaSetLocalEvents, 1692
uaUsers, 1693
Undo, 201, 1094, 1342
Unicode, 1926, 2137, 2182
Universal Time Coordinated, 97
Unlocking messages, 1283
Alarm Control, 1283
Update, 1549, 1594
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starting, 1524
Starting, 1597
stopping, 1524
Stopping, 1597
Update cycle, 319, 458, 463, 473, 613
Update Cycle, 963
Updating, 1518, 1781
Start, 1557
Stop, 1557
Upper limit, 2361
Used
Message block, 1104
System message, 1152
used existing tag, 1781
User administration
WinCC, (See User Administrator)
Windows, 2253
User Administrator, 2203
Administrating groups, 2239, 2243, 2261
Administrating users, 2206, 2239, 2241, 2243,
2253, 2261
Authorizations, (See Authorization)
Automatic logout, (See Logout)
Connect WinCC/PCS7-OS, 2261
Defining users for WinCC service mode, 2241
Logon, (See Logon)
Multilingual projects, 2114
Options, 2250, 2251
Overview of authorizations, 2234, 2236, 2237,
2238
Project documentation, 1815, 1832
SIMATIC Logon, (See SIMATIC Logon)
Tag logon, 2246
User interface, 2244
WinCC Logon, (See Logon)
User archive, 1586, 1623, 1904
Authorizations, 1641
Changing, 1644
Communication, 1636, 1654
Configuring, 1634, 1644
Control tag, 1636
Data communication with SIMATIC, 1654, 1658,
1659, 1660, 1661, 1662
Displaying data, 1586
Exporting, 1649, 1651
Functions, 1664, 1667, 1676, 1687, 1693
Importing, 1650, 1652
Multilingual projects, 2114
Multilingual text, 1644
Naming conventions, 1630
Output of data, 1863
Project documentation, 1815, 2051, 2053
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Properties, 1624
Raw data tag, (See raw data tag)
Runtime data, 1651, 1652
Runtime documentation, 2038, 2040
SIMATIC interfaces, 1654
User archive functions, 1664, 1667, 1676, 1687,
1693
User archives, 1634
UserArchiveControl, 1741, 1742, 1744
Views, 1623, 1645
User Archive, 1632
User archive column
Create, 1646
Editing properties, 1646
User archive field
Authorizations, 1627
Communication, 1627
Editing properties, 1643
Properties, 1626
User Archives Control, 1746
configuring, 1747, 1748, 1749
Define Columns, 1755
Define Fonts, 1761
Defining colors, 1762
Defining output format, 1755
Deleting, 1751
Filter criteria, 1759
Form view, 1762, 1768
Operation in Runtime, 1769
Sort Criteria, 1759
Status bar, 1758
Table View, 1767
Toolbar, 1756
User Archives Table Element, 1746
configuring, 1748, 1749
Define Access Types, 1753
Define User Archive, 1753
Define View, 1753
Form view, 1762
Form View:Define, 1753
Object properties, 1751
Operation in Runtime, 1769, 1773
Properties, 1751
Table View:Define, 1753
User Archives Table Element:Configuration, 1747
User Archives Table Element:Define Access Types,
1753
User Archives Table Element:Define Colors, 1762
User Archives Table Element:Define Columns, 1755
User Archives Table Element:Define Fonts, 1761
User Archives Table Element:Define Form View,
1753
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User Archives Table Element:Define Output Format,
1755
User Archives Table Element:Define Table View,
1753
User Archives Table Element:Define User Archive,
1753
User Archives Table Element:Define View, 1753
User Archives Table Element:Delete, 1751
User Archives Table Element:Filter Criteria, 1759
User Archives Table Element:Form View, 1768
User Archives Table Element:Sort Criteria, 1759
User Archives Table Element:Status Bar, 1758
User Archives Table Element:Table View, 1767
User Archives Table Element:Toolbar, 1756
User cycle, 321
User group
Create, 2239
User name
System block, 1102
User text block, 1084, 1121, 1219
Empty text, 1131
Inserting process values, 1133
Maximum number of characters, 1101
No translation, 1098
Working with message blocks, 1101
UserArchiveControl, 368, 1720
Buttons, 1738
Configuring, 1721, 1723
Configuring table elements, 1209, 1210, 1211,
1212, 1380, 1381, 1382, 1383, 1726, 1727, 1729
Online configuration, 1224, 1395, 1439, 1493,
1735
Output of data, 1863
Processing data, 1741, 1742, 1744
Runtime data, 1222, 1393, 1437, 1491, 1734
Status bar, 1213, 1384, 1430, 1484, 1730, 1738
Toolbar, 1213, 1384, 1430, 1484, 1730, 1737,
1738
Users
Creating, 2239
UTC, 97

V
Value axis, (See OnlineTrendControl)
Values, 1627
Values outside the limit range, 1579
Variable
Displaying transferred tags, 2318
VB script
Dynamization of faceplate types, 361
VBS action, 1009, 1061, 1062
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Action editor, 1063, 1066
Configuring, 461
Create, 1068
Triggers, 1070
View, 1623
Column, 1646
Editing properties, 1645
Project documentation, 2053
Properties, 1628
Relation, 1628
User archive, 1645
View data, 1648
Virus scan, 143

W
Warning
Option "Display performance warnings", 309
Web browser, 369
Web Navigator
Web Options, 2244
WinCC
Languages, 2111
Multilingual projects, 2111, 2120
Project status, 36
SIMATIC interfaces, 1654
WinCC Alarm Control, 1257
WinCC AlarmControl, 1201, (See AlarmControl)
WinCC application, 2269
create, 2270
WinCC Client, 77
WinCC Control, (See Control)
WinCC CrossReferenceAssistant, 2443
WinCC Digital/Analog Clock Control, (See Clock
Control)
WinCC Explorer, 41
Basic Process Control, 83
Closing, 39
Illegal characters, 191
Menu bar, 44
opening, 36
Overview of editors, 185
Project documentation, 1815, 1823
Projects, (See Project)
Runtime, 170, 174
Search, 49
Status bar, 48
Title bar, 48
Toolbar, 47
User interface, 41, 44, 47, 48
Window, 41
WinCC Function Trend Control, 1565
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WinCC FunctionTrendControl, (See
FunctionTrendControl)
WinCC Gauge Control, (See Gauge Control)
WinCC Logon, (See Logon)
WinCC Media Control, (See Media Control)
WinCC object, 2266, 2295, 2301
Copy, 2296
Copying to library, 2301
Creating, 2296
Creating model solutions, 2301
Delete, 2296
Deleting in library, 2301
Importing, 2298
Moving, 2296
Moving to library, 2301
Rename, 2296
Renaming in library, 2301
WinCC Online Trend Control, 1508, 1529
Applying tag properties, 1548
Automatic trend parameter configuration, 1548
Curve parameter, 1548
Zoom in, 1561
Zoom out, 1561
Zooming, 1561
WinCC OnlineTableControl, (See
OnlineTableControl)
WinCC OnlineTrendControl, (See
OnlineTrendControl)
WinCC project, 2266, 2269, 2284, 2294, 2301, (See
Project)
Copying to library, 2301
create, 2270
Creating, 2285
Creating model solutions, 2301
Deleting in library, 2301
Importing to the SIMATIC Manager, 2291
Loading, 2280, 2289
Moving to library, 2301
opening, 2303
Opening, 2294
Renaming in library, 2301
WinCC Project Duplicator, (See Project Duplicator)
WinCC Push Button Control, (See Push Button
Control)
WinCC redundancy
Redundant user archives, 1629
WinCC report system, 2441
WinCC RulerControl, (See RulerControl)
WinCC server
Load online changes, 112
WinCC Slider Control, (See Slider Control)
WinCC User Archives Control, 1746
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WinCC User Archives Table Element, 1746
WinCC UserArchiveControl, 1720, (See
UserArchiveControl)
WinCC WebBrowser Control, 369
Window Cycle, 320, 458, 463
Windows object, 625
Button, 625, 627, 629, 630
Check box, 625, 631
Radio box, 625, 634
Round button, 625, 636
Slider, 625, 638, 640, 641, 647
Wizard
Dynamic Wizard, 296
WPF Control, (See Control)
Write direction, 1534, 1576
Write rights
User archive, 1625
User archive field, 1627

X
X axis, (See FunctionTrendControl)
XFC files, 1781

Y
Y axis, (See FunctionTrendControl)

Z
Zoom
Activating, 164
Settings in the Graphics Designer, 314
Zoom in, 1561
Zoom out, 1561
Zooming, 1561
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